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CHAPTER 1 WELCOME

Welcome

This Help file provides detailed information on application functionality and use. To quickly locate infor-
mation on a specific command/option, such as Enable enterprise presence and chat integration, click the 
Search button, type the command name, and click Search.
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CHAPTER 2 GETTING STARTED

Getting Started

After MiContact Center Business has been installed on the Enterprise Server and clients, you can launch 
CCMWeb and configure user preferences and email contacts. All other client configuration is done at the 
administrative level and described in the MiContact Center Business Installation and Administration 
Guide.

Setting up user preferences
You can change your preferences at any time. They are found in CCMWeb under My options. From this 
menu, you can:
• Specify your language preference
• Change your password
• View your security role properties
• Configure email contacts

Specifying your language preference

NOTE: MiContact Center Business applications, such as YourSite Explorer and Contact Center Client, all 
leverage the language settings of the operating system in addition to the language preference set for 
MiContact Center Business. Ensure that if you adjust the language settings of MiContact Center Busi-
ness, you also adjust the language settings of your operating system to match.
To specify your language preference 
1. Hover over My options and select My preferences.
2. After Display this language, select a language.

3. Click Save.

Changing your password

To change the password for your login
1. Hover over My options and select My password.
2. After Old password, type your old password.

3. After New password, type your new password.

4. After Confirm new password, type your new password.

5. Click Save.
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Viewing security role properties

You can view your security role properties. They describe the application areas which you can access. 
Only employees with access to YourSite Explorer and whose security role permits managing security can 
change the security role properties of employees.
To view the security role properties associated with your login ID
• Hover over My options and select My security role.

Configuring email contacts

You can create a list of email contacts and email contact groups to whom you email reports. Contact 
groups can contain both user-configured contacts from MiVoice Analytics as well as all existing 
employees from YourSite Explorer.
To create a contact group 
1. Add email contacts
2. Add contact groups

3. Add email contacts to the groups

Adding email contacts

To add an email contact 
1. Hover over My options and select Contacts > My email contacts.
2. Click Add.

3. After First name, type the first name of your contact.

4. After Last name, type the last name of your contact.

5. After Email address, type the email address of your contact.

6. To save this contact, click Save.

7. To save this contact and add another contact, click Save & Add.

Adding contact groups

To add a contact group
1. Hover over My options and select Contacts > My email contacts group.
2. Click Add.

3. After Name, type the name of the contact group.

4. After Description, type the description of the contact group.

5. To share this contact group with other CCMWeb users, select Shared Contact Group.

A shared contact group can be viewed, used, and edited by other users.
6. To save this contact group, click Save.

7. To save this contact group and add another contact group, click Save & Add.
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Adding email contacts to contact groups

To add an email contact to a contact group 
1. Hover over My options and select Contacts > My email contacts group.
2. Click Members for the contact group with which you want to associate agents.

3. If you want to add members from your contacts configured in CCMWeb, click Contacts. 

If you want to add members from the employees configured in YourSite Explorer, click Employees.
Both contacts and employees can be added to the same contact group.

4. Under Available contacts, select the check boxes of the members you want to add to the group and 
click Add >>.
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MiContact Center Business

Mitel MiContact Center Business integrates with MiVoice Business platform to provide contact centers 
with the tools they need to efficiently and effectively measure and manage contact center operations. 
Interactions are routed intelligently across all media types (voice, email, chat, SMS, and open media), 
increasing customer satisfaction and streamlining agent calls. Contact center efficiency and agent perfor-
mance can be monitored both historically and in real time and can be measured using a wide variety of 
reports. Flexible licensing packages provide access to specific features and applications and enable you 
to build a contact center package that best suits your business needs.

Contact Center and Workgroup
There are two licensing bundles available for MiContact Center Business: Contact Center and Work-
group.
Contact Center is the licensing level of choice for businesses with more than 100 concurrent agents, who 
want resiliency, and requiremore than 10 IVR ports.
Workgroup is geared toward contact centers with fewer than 100 concurrent agents, requiring a maximum 
of 10 IVR ports, with no need for resiliency. Workgroup supports single-node ACD environments only.
Both licensing bundles offer general business and contact center reporting and real-time monitoring, 
client desktops, and IVR Routing capabilities, and support voice, email, chat, SMS, and open media 
communication. They include feature-rich, web-based applications for streamlining contact center 
management and enabling agent productivity. There are several options available to further customize 
your contact center solution.
For detailed licensing information, see the MiContact Center Business and MiVoice Analytics System 
Engineering Guide.
MiContact Center Business includes the following applications, depending on your licensing bundle: 
• CCMWeb
• Contact Center Client
• Interactive Contact Center
• Interactive Visual Queue
• Contact Center PhoneSet Manager
• Contact Center Softphone
• Multimedia Contact Center
• Contact Center Screen Pop
• Flexible Reporting
• IVR Routing
• Workforce Scheduling
• Employee Portal
• Schedule Adherence
• Traffic Analysis
• Ignite
• MiCollab Client
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• MiVoice Border Gateway
• CTI Developer Toolkit

Licensing
An employee is a physical person you track in your contact center. In the YourSite database, you must 
create an employee ID for each employee who works in your contact center. Employees can have multiple 
agent IDs, but only one employee ID. You can run reports on licensed employees only. The number of 
employees you license in YourSite Configuration must be consistent with your software license.
To view details on your software license 
• Hover over Help and select About your Mitel applications.

Troubleshooting assistance
For the latest frequently asked questions and troubleshooting information, see the Mitel Knowledge Base 
at Knowledge Management System available on MiAccessmitel.com.
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Contact Center Call Accounting Concepts

Contact centers process a high volume of contacts to meet marketing, sales, customer service, technical 
support, and other business objectives. A fine-tuned contact center distributes contacts efficiently and 
optimizes the use of agents and other resources. This section describes the inbound contact center envi-
ronment and how resources interact to process voice contacts.
Call Accounting ensures businesses have a true picture of how and where their telecommunication 
budgets are spent. This chapter discusses how Call Accounting can be used to track phone use, reconcile 
carrier bills, and bill back departments, and how it costs calls and detects toll fraud.
• Tracking phone use

You can use Call Accounting to track phone use and to determine
The average duration of calls.
Generate the Employee Group Accounting Summary report. This report provides the average dura-
tion and cost of calls made by each employee of an employee group.
Where most of your long-distance budget is spent, and which employees make the most and longest 
calls.
Generate the Employee Accounting by Phone number/Location report. If you have added these 
phone numbers and names to your database (YourSite ExplorerPhone numbers), they will also ap-
pear in the report. This report also provides you with a list of the 100 most often dialed phone numbers 
by employee, and the 100 longest calls by employee.
If your telephone system is being abused, in real time
Monitor call costs and other call statistics by extension in real time. You can set alarms, for any or all 
extensions, for all call statistics, including caller ID information (such as caller name and number). You 
can also set alarms based on call cost thresholds and toll fraud parameters. Alarm notifications alert 
you when event thresholds are reached. You can choose to be notified by visual changes in the mon-
itor, sound prompts, pop ups, or email. By setting alarms based on the thresholds you define, you can 
monitor telephone system abuse and stop it as it occurs.

• Reconciling carrier bills
You can set up Call Accounting to detect billing errors. When you configure Call Accounting to mimic 
your phone carrier charges, you might notice discrepancies between your amounts and your carrier 
amounts.

• Billing back departments
To bill back departments, your call costing information must be accurate. If your call costing informa-
tion is inaccurate, and you charge your subscribers less than you yourself are charged by the phone 
company, then you are losing money. Of course, you do not have to assign the same rates to sub-
scriber calls that the phone company charges you for your calls. You can modify the rate to include a 
markup or intentionally provide a discount.

• Monitor telephone system use in real time
You can set alarms, for any or all extensions, for all call statistics, including caller ID information (such 
as caller name and number). You can also set alarms based on call cost thresholds and toll fraud pa-
rameters. Alarm notifications alert you when event thresholds are reached. You can choose to be no-
tified by visual changes in the monitor, sound prompts, pop ups, or email. By setting alarms based on 
the thresholds you define, you can monitor telephone system abuse and stop it as it occurs.
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Automatic Call Distribution (ACD)
Automatic Call Distribution (ACD) is a specialized mechanism for distributing incoming calls. The primary 
goal of ACD is to ration calls to agents in a cost-effective manner that provides acceptable service to 
callers.
To optimize the use of agents, you cross-train them so they can handle a variety of inquiries. Rather than 
distributing calls to a number of small, specialized agent or extension groups, ACD distributes them effi-
ciently among the entire pool of available agents. When you consolidate resources (use the Pooling Prin-
ciple), the same number of contact center agents handle more calls while maintaining Service Levels.
Typically, you program ACD to ensure the first call to arrive reaches the first available agent or the agent 
who has been idle the longest. However, you can vary the order of calls and agents to provide superior 
service to preferred customers, and skills-based routing.

Understanding ACD call flow

The path of an incoming call is as follows. A caller telephones your contact center via the Public Switched 
Telephone Network (PSTN). (The PSTN is a global collection of Central Offices (COs) interconnected by 
long-distance telephone switching systems.) The local CO directs the call to one of your trunk groups. An 
available trunk picks up the call. Typically, calls from the PSTN arrive to the contact center over incoming 
trunks and calls from the contact center to the PSTN travel over outgoing trunks. If no trunks are available 
the call does not get through to the system (it is blocked) and the caller receives a busy signal.
When a trunk picks up a call, it forwards it through to a group of agents handling calls, or to some other 
answering point. The call arrives at the ACD queue of an agent group. The queue delays the call rather 
than blocking the call from entering the system. The length of time the caller waits in queue is the queue 
time. While waiting in queue, the caller listens to product features, announcements, or other messages 
provided by a Recorded Announcement Device (RAD). The caller can wait patiently in queue for an avail-
able agent, leave a voice mail message, or hang up (abandon) the call. (See the following figure.)
An agent handles the call. The time the caller spends talking to the agent is the ACD Handling Time 
(including the hold time). If the agent calls the supervisor in search of more information (while the caller 
is on hold) and/or transfers or conferences the call, these times are added to the ACD Handling Time 
value.
For example, an agent speaks to a caller for two minutes and then puts the caller on hold for three minutes 
and tries to solve the problem. This may include a call to the supervisor. The agent then initiates a confer-
ence call with the caller and a third party and they speak for three minutes and resolve the issue. There-
fore, the ACD Handling Time for the agent is 2 + 3 + 3 = 8 minutes.
When the call is completed, the agent might need to perform additional work associated with the call. The 
time taken to perform this work is the Wrap Up Time.

Figure 4.1: Call flow
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Monitoring the call flow process

Second-by-second (real-time) statistics presented on wall signs and desktop monitors enable you to 
monitor the service provided to callers. You can monitor the number of incoming calls, the time it takes to 
process them, the queue load, and the availability of agents using a Management Information System 
(MIS). The MIS refers processes data produced by the telephone system. The MIS uses telephone 
system records to provide forecasting, real-time monitoring, and reporting functions.

Ensuring traffic-carrying efficiency

To optimize traffic-carrying efficiency ensure
• Sufficient trunks are available to carry incoming calls.
• Callers experience a delay in queue.
• There is a random distribution of calls among available agents.

Scheduling to optimize call flow

You schedule agents so the number of incoming calls at any given time typically exceeds the number of 
agents currently available. The intent is that callers experience a slight delay before agents answer their 
calls. The expected number of incoming calls forecasted for the time of day, and day of the week influence 
scheduling decisions.

Routing calls

Call routing options you program in the telephone system provide a set of instructions that automate the 
movement of calls to their intended answering points. You can define options—for example, if the caller 
dials 1, the system forwards the caller to customer service. You can specify re-routing for calls not 
answered after a set period of time and parse incoming Automatic Number Identification (ANI) and Dialed 
Number Identification Service (DNIS) data to direct call routing. (See the follwoing figure.)

Figure 4.2: Call routing
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Dialing an agent’s extension

In the simplest call scenario, a single trunk picks up an incoming call to your contact center. The telephone 
system presents the caller with options to dial various answering points. The caller dials an individual 
agent at an extension through a queue number. A queue number is an address mechanism for a queue 
or other answering point. The programming associated with the queue number defines the routing and 
timing features of the call. The telephone system collects data on the agent and trunk involved in the call. 
The ACD management reporting application produces reports on agent and trunk activity.

Dialing a queue

In the next call scenario a trunk group picks up an incoming call to your contact center. The system pres-
ents the caller with options to dial various answering points. The caller dials queue number 1 to reach 
queue 1 (Customer Service). The system forwards the call to the first available agent in the agent or 
extension group associated with queue 1. The call is an ACD call because one dialable number 
represents all of the agents in the group. The telephone system collects data records for the call. The ACD 
management software produces Queue Reports on queue 1.

Overflowing calls

An ACD call that is not answered immediately is placed in a queue. If an agent does not pick up the call 
after a set amount of time (the overflow time) the system places the call in the queue of another agent 
group, in addition to keeping it in the first queue. The first available agent in either group handles the call. 
The overflow feature limits the delay faced by callers by queuing calls against two or more agent groups. 
(See the following figure.)

Figure 4.3: Multiple queue routing
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Interflowing calls

You can program the ACD routing system to direct a queue delayed call to voice mail or to another 
answering point. The interflow timer runs independently of the overflow timer. If the interflow timer expires, 
the system removes the call from the queue and re-directs it to another answering point, such as a trunk 
or voice mail.

Ring Groups
MiContact Center Business and MiVoice Analytics support Ring Groups. Ring Groups are a call distribu-
tion mechanism that offers an alternative to ACD for distributing calls in your business. While ACD is 
focused on rationing calls to pools of available agents, Ring Groups are configured to distribute calls to a 
pool of specific extensions. Users can configure Ring Groups within YourSite Explorer, monitor them in 
Contact Center Client, and report on them.
When an incoming call rings the Ring Group, the member extensions configured in the Ring Group are 
rung until one extension answers. Ring Groups can be programmed to offer calls to extensions using five 
different algorithms: 
• Ring All: Rings all available extensions in the Ring Group simultaneously.
• Terminal: Starting from the first extension in the member list, rings the first available extension.
• Terminal Cascade: Starting from the first extension in the member list, rings the first available exten-

sion for the duration of the Cascade Ring Timer before calling the next available extension in the 
member list.

• Circular: Starting from the last member to handle a call, rings the next available extension in the 
members list

• Circular Cascade: Starting from the last member to handle a call, rings the next available extension 
in the member list for the duration of the Cascade Ring Time before calling the next available extension 
in the member list.

Ring Groups enable a business to ensure that in settings where employees may not have a set physical 
location or mobile device, such as a warehouse or back office, calls can be effectively distributed to an 
answering extension. Calls to Ring Groups can be ACD or Non ACD in Mi Contact Center Business 
real-time and reporting.
Incoming calls are handled differently than ACD path queues as well. If a call comes in, it will be queued 
if any one of the Ring Group’s extensions are available. Available extensions are those that are: 
• Idle
• Busy (ACD, Non ACD, or Out)

If the Ring Group’s extensions are not available, the call is overflowed immediately (if an overflow point 
has been configured) or receives no answer. Extensions in the following states are not available: 
• Do Not Disturb
• Out of Service
• Not Present
• Reseize Timer

For more information about extension states, see "Extension states".
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The inbound call environment
The inbound contact center environment has unique characteristics that must be considered in effective 
planning and management.
Predicting call arrivals
Calls arrive randomly to contact centers. You cannot predict the minute-to-minute arrival of calls. This 
results in unanticipated increases in workload, and impacts staffing calculations and the load carried by 
system and network resources.
You can predict the pattern of call arrivals for 15-minute or longer intervals. For example, you can predict 
that next Monday between 1:00 P.M. and 1:30 P.M. you will receive 60 phone calls. However, you cannot 
predict how many calls will arrive in the first five minutes, the second five minutes, and so on.
Understanding caller tolerance
Several factors influence a caller’s tolerance to queue delays:
• The immediacy of the caller’s requirement
• The availability of similar products or services
• The caller’s expectations for service
• The time available to make the call
• Whether or not the caller is paying for the call
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Contact Center Planning and Management

Effective contact center management involves having the right resources in place at the right times to 
handle an accurately fore casted workload at the desired level of service. Commitment to a systematic 
planning and management strategy is essential. The strategy is based on corporate objectives that you 
continually assess and refine. Whether you are managing a start-up contact center or refining the perfor-
mance of an existing operation, the process illustrated in the following figure applies. It is the basic frame-
work for achieving and maintaining your service objectives.

Figure 5.1: Planning cycle
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The objective of contact center management is to find the right balance between the agents scheduled 
and the service provided to customers. This involves assessing and re-assessing trade-offs between the 
Service Level, agents scheduled, and average call duration for a known Call Load for each 15-minute or 
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half-hour interval of the day. Collecting, properly interpreting, and applying ACD and other information 
allows you to accurately forecast the workload and schedule sufficient agents to meet your service objec-
tives.

Step #1 Establish a corporate service objective
The Service Level % is a performance metric contact center managers use to determine what proportion 
of customers, who contact you by voice/email/chat, receive 'good' service. Using the Service Level %, you 
can gauge the level of service customer's experience, from a historical and a real-time perspective.
Defining and adequately funding a service objective should be closely tied to your corporate mission. The 
service objective identifies the average length of time a caller who has obtained a trunk waits for an avail-
able agent. It is the basis for planning and budgeting and links the resources you require to your service 
objectives. Choosing a service objective is the first step in a comprehensive planning and management 
solution. Once you set a service objective, you should routinely access it to see how consistently you are 
meeting it, on a 15-minute or half-hour basis.
Contact centers in different industries use different criteria for measuring service. Your service objective 
should reflect the type of service being provided and the expectations of callers seeking the service. For 
example, a company that sells magazine subscriptions has less to lose in the outcome of any one call 
than a car dealership does. A caller to a credit card 'lost or stolen' line might expect different service than 
a caller to a customer service department at a bank. Contact center metrics across industries are 
designed to reflect this.
Performance targets must suit the primary function of a contact center. In revenue-based contact centers 
where agents sell products or services, the net revenue per call is considered when defining a service 
objective. Revenue-based contact centers strive to provide a high level of service with minimal blocking 
and delays.

Understanding the Service Level

The Service Level applies to all of the media types (voice, email, chat, SMS, and open media).
The Service Level is expressed as X percent of calls handled in Y seconds or less, such as 80 percent of 
calls handled in less than 20 seconds. Why is Service Level the standard measurement of service? 
Service Level provides the most accurate representation of the callers’ experience. It is ultimately the 
caller who decides what constitutes good service, and whether or not to end a call. It applies to inbound 
transactions that must be addressed as they arrive.
When a caller enters a queue, the call is processed in one of three ways:
• An agent answers the contact (handled contact).
• The client disconnects before an agent answers (abandoned contact).
• The contact is removed from the queue, and sent to another handling point (for example, to voice mail, 

an automated attendant, or another queue), (Interflowed contact).

For detailed information on Calls Offered, Calls Handled, Calls Abandoned, Calls Interflowed, and other 
Service Level parameters see "Choosing a Service level goal".
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Understanding why the Service Level is the most meaningful statistic

The Service Level is one of many ACD statistics used to measure performance. Each statistic has its 
purpose. For example, the Grade of Service (GOS) statistic relates trunk use to the level of traffic and 
indicates the likelihood an attempted call will receive a busy signal. It is expressed as a decimal fraction. 
For example, a GOS of P.02 means a caller will have a two percent chance of receiving a busy signal. 
Since trunk costs are insignificant compared to agent costs contact centers are well advised to schedule 
sufficient trunks, abandons should be minimal.
A delayed call is a call placed in the ACD queue because it cannot be answered immediately by an agent. 
The probability of delay statistic relates the number of agents or extensions to the level of traffic carried 
by the trunks and indicates the likelihood and amount of delay experienced. The GOS, probability of 
delay, and Quality of Service rendered by agents provide vital information about the callers’ experience. 
(See the following figure.)

Figure 5.2: Service criteria
 

The GOS and probability of delay contribute to our understanding of what happens to the calls not 
answered in Y seconds, and give meaning to Service Level. Service Level is the primary statistic used in 
planning and budgeting because it is the most stable measurement of queue activity.
The following statistics are also meaningful contact center indicators:
ASA
The Average Speed of Answer (ASA) is an ACD statistic that measures how long the average caller waits 
on hold before the call is picked up by an agent. ASA is a valuable measure of service quality, but is often 
misinterpreted. The average does not represent what is typically experienced by individual callers. Most 
calls are answered by agents more quickly than the average, but a small percentage of callers wait 
several minutes in queue. ASA is a useful parameter, but Service Level is a more reliable indicator of what 
callers experience.
Abandonment
ACDs collect statistics on how long callers wait before abandoning calls, and what percentage of calls are 
abandoned. Unfortunately, abandonment is difficult to forecast because it is impossible to predict caller 
behavior with any reliability. Sometimes when the Service Level is high more callers abandon than 
expected. There are no industry standards for abandonment. It is a somewhat unreliable measure of 
contact center performance. However, abandonment statistics assist in planning Service Levels, and 
provide valuable information used to create in-queue and message-on-hold announcements.
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Choosing a Service Level goal

Contrary to popular belief, there is no industry standard Service Level. Some contact centers base their 
Service Level goal on the targets of similar companies in the same industry. In doing so, they assume 
these companies are actually meeting their intended targets. Companies are setting increasingly rigorous 
Service Level targets in sectors where outstanding customer service is the norm. In a survey of over 100 
UK contact centers, Opta Consulting was surprised to find an average performance target of 90 percent 
of calls answered in 15 seconds. They found that companies setting extremely rigorous targets did not 
necessarily meet them, and the investment required to achieve 'best in class' targets was difficult to justify.
Setting an appropriate Service Level goal for your contact center is not easy. The motivation and expec-
tations of your customers, the availability of similar goods or services, the Service Level targets of 
same-industry companies, and the value of calls are things to consider. It may be useful to run some 
calculations to determine the trade-offs in Service Level associated with adding or removing an agent, 
and implement customer satisfaction surveys. When defining your corporate Service Level, consider 
several factors and rate their relative importance.
An appropriate Service Level is one that
• Satisfies callers’ expectations for service
• Minimizes the number of abandoned calls (ideally under five percent)
• Minimizes expenses and maximizes revenue
• Satisfies the expectations of support staff, supervisors, and senior management

Consider this modest objective. For a Service Level of 80 percent of calls answered in less than 20 
seconds, callers receive the following service:
• Approximately 30 percent of callers experience a delay in queue.
• The longest wait time is approximately three minutes.
• The average speed of answer is approximately 12 seconds.

Is this acceptable service for you and for your callers?

Understanding Quality of Service

Agent statistics reflect the time agents spend in various states and are used to assess agent performance. 
The average time an agent spends handling interactions, and in the Make Busy, Do Not Disturb, Unavail-
able, and Wrap Up states directly affects the agent’s availability and the Service Level provided to callers.
Service Level alone does not ensure customer satisfaction. The quality of the interaction between the 
caller and agent leaves a lasting impression. Quality of Service reflects an agent’s ability to provide excel-
lent service to each customer. The knowledge of the agent, the accuracy and completeness of the infor-
mation provided, and the courtesy extended to the caller contribute to the caller’s experience.

Monitoring call handling techniques

Silent monitoring systems complement ACD statistics by providing a snapshot of quality and productivity 
in your contact center. You can track call handling techniques and determine where improvements can 
be made in individual performance. Advanced systems capture the voice interactions between agents 
and callers and record agent data tables for a complete picture of call handling. They provide online eval-
uation forms so you can annotate recordings with feedback.
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Silent monitoring takes the bias out of performance evaluation. Silent monitoring provides a systematic 
process for monitoring and grading agent calls. You can schedule sessions across different times of the 
day, days of the week, and evaluators promoting fairness and consistency. Showing agents where 
improvement is needed is more effective than just telling them. Silent monitoring can contribute to a 
reduction in call time, a reduction in monitoring time and personnel, and increased training efficiency.
You can use pre-recorded interactions between agents and customers to train agents and for ongoing 
evaluation.
You can use the information to 
• Provide recorded examples of exceptional service and unacceptable service to agents in training.
• Record, review, annotate with feedback, and forward call records to agents who then review your 

comments within the context of the actual call.
• Calibrate and routinely access the scoring consistency of call monitors.
• Assess the effectiveness of current training programs.
• Assess the efficiency of the monitoring and assessment process.

Defining scoring parameters
The parameters used to evaluate how well agents handle calls are based on the purpose of the calls. 
Goals vary across calls for inbound and outbound services. For example, in an outbound sales environ-
ment quality may be based on whether or not the agent made the sale, took advantage of cross-sell 
opportunities, and adhered to a pre-defined script. In an inbound environment quality may be based on 
the completeness and accuracy of the information and whether or not the caller’s questions were 
answered satisfactorily. Agents are also evaluated on 'soft skills', such as voice quality, pausing at regular 
intervals, rate of speech, use of positive language, and other listening and communication skills.
Setting performance standards and goals
Once you determine appropriate scoring parameters, you define standards for exceptional and accept-
able levels of performance. Assessment standards are based on consensus and must be clearly defined 
and communicated to monitors and agents. Collaborate with agents in setting performance goals and 
clearly define exceptional service and interim performance steps. Determine a baseline of current perfor-
mance and set performance steps for an agent group. Provide agents in the group who meet or exceed 
the interim target with rewards and recognition commensurate with their performance. When systemati-
cally used in training and coaching recorded sessions positively impact productivity. Fair assessment is 
good for moral and motivation, and contributes to an environment in which agents can learn and grow.
Monitoring frequency
The frequency of monitoring sessions is determined by individual companies and ranges from once a 
month to 15 or 20 sessions a month. Implementing five to 10 monitoring sessions per month is common 
practice. Trainees and agents with consistently low scores are monitored more frequently than other 
agents. Resource limitations typically influence the frequency of monitoring.

Monitoring systems and tools

The following monitoring systems and tools help you evaluate the performance and manage the quality 
of service of your contact center.
Silent monitoring systems
Silent monitoring systemsrange from tape recorders to client/server based recording systems. Advanced 
systems schedule, record, and store voice files in a compressed digital format using a real-time link to 
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your telephone system. They capture any data tables accessed by the agent in addition to voice data. 
Silences are eliminated to optimize monitoring efficiency. Recording sessions can be played back from 
any telephone, anywhere, at any time. You can customize agent evaluation forms and define parameters 
for quality with advanced systems. They provide activity, status, and management reports for evaluating 
agents and observation practices.
IT support systems
Information Technology(IT) support systems are commonplace in contact centers. Contact center agents 
divide their time between listening to customer requests, entering and updating customer information and 
other entries, searching for required information, and providing feedback to customers. In order to provide 
prompt and complete information, agents must have immediate online access to information including 
customer records and case histories, products and services, and company policies and procedures.
The push to increase agent efficiency and customer service has placed new demands on computer infor-
mation systems and information technology. Information products that enhance agent productivity are 
continually being developed. Contact center systems are designed to incorporate some, or all of the 
following specialized support functions.
CTI
Computer telephony integration (CTI) is the merging of computers and telephone systems. Today’s 
computer-based telephone systems deliver synchronized voice and data, voice and data conferencing, 
automatic information retrieval for calls, caller-based messaging and routing, and desktop productivity 
tools. You can use customer databases in call handling to enhance customer service and agent produc-
tivity. When databases are shared between contact center departments each agent can access a caller’s 
contact information, purchasing records, call history, and preferences by a caller ID number.
ANI
Automatic Number Identification (ANI) identifies the telephone numbers of callers to your contact center, 
so agents can receive screen pops with calls. You can connect a database to your telephone system to 
simultaneously send calls and caller information. The telephone system forwards the caller’s telephone 
number to a software application that relays database records on the caller to the agent. Alternately, the 
caller enters an ID number that the database associates with a set of records for the caller and the agent 
is sent the information.
ANI saves agents time since they do not have to ask for and enter a name for a caller, and wait for the 
database to respond. This time savings significantly impacts staffing requirements and telephone service 
charges. ANI also identifies telephone numbers of callers who abandon calls so they can be contacted 
later for potential business.
Reports can identify the volume of usage and costs of internal line numbers, and help you track the long 
distance distribution per line number and maximize long distance efficiency.
DNIS
Dialed Number Identification Service (DNIS) is a feature of toll-free lines that identifies the telephone 
number the caller dials. This assists agents who handle calls for more than one business or product line. 
Each business or product line has its own toll-free number. When a caller dials a toll-free number, the 
telephone system forwards information to the agent so the agent can identify who the caller dialed. For 
example, a caller dials a toll-free number for a cruise line. The telephone system sends a script to the 
agent along with the call. The agent then knows to answer 'Good morning. Thank you for calling Southern 
Cruises', instead of the name of another cruise line serviced by the center.
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Automating help desk workflow

Agents at IT help desks require quick access to customer information and call history, and the ability to 
rapidly log all of the support calls and incidents. Advanced help desk packages offer automated desk help 
workflow systems. They assist agents in logging service requests (tickets), dispatching them to prioritized 
queues or agents, tracking them, and documenting activities.
External applications, help desk operators, or end users (in web-based applications) generate tickets. The 
system generates them manually, or in some cases automatically, in response to system events. It can 
correlate multiple incidents with single tickets, and multiple problems with a single call.
Automated help desk workflow systems track each step taken in answering a call, with automatic time 
stamping of all of the referrals, escalations, reminders, alerts, and email notifications. Calls are prioritized 
and referred to other departments without reassignment, reassigned (escalated) to other technicians or 
specialized staff, and placed in an alert condition when they are not resolved promptly. Activities are date 
and time stamped automatically. Most help desks offer outgoing email notification and paging. Some help 
desks offer automated logging of incoming emails, and automated call acknowledgment emails to clients.

Step #2 Collect data
Telephone systems generate an enormous amount of real-time and historical data used in planning and 
management of your contact center. You use real-time data to monitor the current Call Load and agent 
availability so minute-to-minute adjustments can be made. You use historical information in forecasting, 
staffing, and scheduling. Other critical management information comes from customer surveys, market 
studies, employees, external departments, telephone networks, workforce management systems, 
competitors, and the media. Data collection is a continuous process you implement as soon as your tele-
phone system is up and running.;
Telephone systems provide detailed report data on every aspect of call transactions. You can program 
computer-based telephone systems connected to a Local Area Network (LAN). Users on the LAN can 
view or print real-time and historical reports. Using web-enabled telephone systems, you can view and 
generate reports in a Web browser. You can monitor contact center activities remotely, and distribute 
reports to people on different networks.

Collecting data on call handling

Contact center reporting software displays real-time telephone system data on desktop monitors and wall 
signs. Using real-time data, you can manage current conditions and ensure agents respond to changing 
contact center events. The telephone system provides information on call activity, agent activity, and 
queue activity.
You can use historical data in forecasting and in assessing the performance of your resources. Historical 
reports provide vital information on load activity, resource activity, and queue activity.
CTI provides in-depth information on call transactions. Detailed information on keystroke sequences, 
databases searched on, and on-screen assistance provides a clear picture of agent activities. Using ANI 
data, you can identify callers by area code and collate information on demographic trends in caller 
behavior.
Workforce management systems use telephone system data to forecast and schedule agents. Some 
packages monitor the real-time adherence of agents to scheduled activities, so you know the number of 
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agents currently logged on and available to handle calls. Workforce management systems collect and 
store real-time adherence data. This data provides a historical account of adherence used in agent 
assessment.
Customer surveys provide valuable supporting information on callers’ tolerance to delay, and expecta-
tions for service. They address some of the following questions: Was the agent accessible? Was the caller 
put on hold for too long? Was the agent courteous and responsive to my request? Was the agent well 
informed? Did the agent provide the correct information and keep commitments? Contact centers use this 
information to estimate the repercussions of poor service: escalated costs, duplication of work, lost 
customers.
As the economy moves towards individual, personalized services, new ways of handing calls continue to 
emerge. These new features add to the complexity of collecting and measuring information. It is vital you 
establish an integrated, reliable system for measuring the key indicators of performance: the efficiency of 
call handling, the service that callers experience, and their perceptions of that service.

Step #3 Forecast the Call Load
Finding the right balance between resources and traffic volumes is a critical step in effective contact 
center management. Estimating resource requirements is particularly challenging as the number of calls 
and the total duration of calls expected for a given time interval is difficult to predict.
Forecasting impacts contact center operations and performance in the following ways:
• The number of blocked and abandoned calls
• The level of service provided to callers and callers’ perception of service
• Agent workload, call behavior, and retention
• The accuracy and usefulness of schedules
• The success of periodic sales campaigns

Forecasting accurately

Forecasting is an imprecise science. The accuracy of your forecast increases markedly with the size of 
your data sample. You take a year (or preferably two or three years) of ACD queue traffic data, examine 
trends in Call Load patterns, break down the information, and determine the ACD Handling Times of the 
calls. You then modify the forecast based on current contact center activities and other considerations, 
such as absenteeism, agent breaks, holidays, and training.
The range of forecast dates you specify depends on the purpose of the forecast. Using long-term fore-
casts, you can estimate future budgets and expansion opportunities, and establish corporate objectives. 
Using short-term forecasts (of one to three months) you can determine seasonal staffing requirements, 
plan for short-term sales campaigns, and assess upcoming hiring needs. You can use weekly, daily, 
hourly and half-hour forecasts to tweak agent schedules and adjust for absenteeism.

Conducting forecasts

Conducting a forecast involves accurately estimating the three components of Call Load: the ACD 
Handling Time, Wrap Up Time, and Calls Offered. After you run a forecast, it is useful to examine the data 
and make adjustments based on present contact center conditions. You tweak the forecast by adding or 
reducing calls based on your intuition and on information gathered by yourself and others.
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To forecast the agent requirement, you
1. Examine trends in Call Load patterns.
2. Break the information down in to monthly, weekly, daily, half-hour, and 15-minute intervals that reflect 

Call Load patterns.

3. Determine the handling times of calls.

4. Modify the forecast based on current contact center activities and other considerations, such as 
absenteeism, agent breaks, holidays, and training.

You may need to consider the following issues: hardware or software system changes, expected callers, 
advertising and media, changes to your products, services, or pricing, new products, product perfor-
mance, competitors' actions, and international, national, and corporate events. It is vital to have a system-
atic forecasting process in place that all of the departments support. For detailed information on Call Load, 
ACD Handling time, Wrap Up Time parameters, see "Forecasting terms".

Step #4 Calculate the resources required
You calculate the agent requirement in conjunction with the trunking requirement. The number of avail-
able agents affects the likelihood and length of delay experienced by callers. The delay affects the load 
trunks must carry. Because the number of available agents impacts the number of trunks required, you 
calculate the agent requirement first.
The Erlang C formula uses your historical Call Load and Average Talk Time data to predict the agent 
requirement for the time interval and date range in the forecast. The resultant spreadsheet displays the 
Call Load and agents required across time intervals.

Predicting agent requirements

Agent costs account for over 60 percent of all of the contact center costs. Accurately predicting the agent 
requirement, making the most effective use of agents, and standardizing and monitoring agent activities 
are paramount to achieving your service objectives. Agents are your most valuable resource: make team 
building and team management a high priority.
You can predict the agent requirement for your Service Level Percentage and Service Level Time targets 
by applying the Erlang C equation to the estimated Call Load and Average Talk Time.

Understanding Erlang C

Staffing models consider important factors unique to the inbound contact center environment:
• Call arrival is random.
• Consolidating resources allows the same number of contact center agents to handle more calls while 

maintaining Service Levels.
• Maintaining high Service Level targets requires staffing a large number of agents that will be idle a 

significant portion of the day.

The industry standard Erlang C equation operates on these principals. Most contact center reporting 
packages use Erlang C. An Erlang measures telephone traffic, or the flow of calls and call attempts to 
your contact center during a given period. One Erlang equals one hour or 60 x 60 = 3,600 seconds of 
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telephone interaction. This could be one call lasting one hour, six calls lasting 10 minutes, or any combi-
nation of calls and call durations that equal 60 minutes. The Erlang formulas provide a mathematical basis 
for making predictions about randomly arriving workloads.
Agent and delay calculations use the Erlang C equation. It predicts the resources required to keep delay 
times within your Service Level objective. Three variables influence the delay time: the number of agents, 
the number of waiting callers, and the average time it takes to handle each call.
Limitations of Erlang C
Erlang C has fundamental principles that do not reflect real-world circumstances. It assumes all of the 
calls reach the contact center and all of the callers wait indefinitely to reach agents. Because Erlang C 
assumes no blocking or abandons, it may overestimate the agents you need. Erlang C requires accurate 
information on call flow where voice messaging and call overflow are employed, assumes your Call Load 
prediction is extremely accurate, and assumes you have the same number of agents handling calls the 
entire half hour.
Although Erlang C has its limitations, it is the preferred planning tool as it provides reasonable traffic esti-
mates for contact centers that maintain good service-and few abandons.

Considerations when predicting resource requirements

Erlang C provides theoretical numbers for staffing that you need to assess in light of the following contact 
center realities:
• The contact center blocks a certain proportion of calls and some callers abandon their calls.
• Talk time is unpredictable, and although most calls may last two to three minutes, a few calls can last 

upwards of an hour.
• Agents in training may require more time to process calls.
• Agents may use wrap up (after-call paperwork) time inconsistently during busy periods.
• Not all of the agents within an agent group are available at all times to handle calls offered to the agent 

group.

Erlang C predicts staffing needs fairly accurately. However, contact centers that use skills-based routing, 
overflow, interflow, and advanced routing options need to use intuition and experience in adjusting the 
final numbers.
The Erlang C formula uses your historical Call Load and Average Talk Time data to predict the agent 
requirement for the time interval and date range in the forecast. The resultant spreadsheet displays the 
Call Load and agents required across time intervals.

Performing 'what-if' scenarios

After you run a forecast, you can perform 'what-if' scenarios on the resultant data by changing the value 
of forecast parameters and recalculating the results. You can enter values for the ACD Calls Offered, 
average ACD Handling Time, Wrap Up Time, and Service Level Percent and Time and recalculate the 
number of agents required. For example, you can reduce the average handling time and recalculate the 
agents required and the calls handled across 15-minute time intervals for the shift.
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Understanding the relationship between agents and trunks

You are already familiar with the terms GOS (probability of blockage) and Service Level (average wait 
time).
The following definitions are essential to understanding the relationship between agents and trunks.
Delay
Trunk calculations assume no queueing. For trunk calculations, the delay includes the time from when a 
trunk picks up a call until an agent answers it.
Agent Load
The Agent Load includes the ACD Handling Time and Wrap Up Time.
Trunk Load
The Trunk Load includes the time from when a trunk picks up a call until the agent finishes speaking to 
the caller and disconnects. The Trunk Load does not include Wrap Up Time.
Callers expect to have a 95 percent or better chance of obtaining a free trunk in to your contact center, 
and expect to connect to an agent within a reasonable amount of time. There must be sufficient trunks 
available to pick up calls, and sufficient agents available to handle the level of traffic carried by the trunks. 
The more agents handling a given Call Load, the less delay callers’ experience. Callers experience a 
delay if there are insufficient agents available. If the delay is considerable, calls back up and some calls 
do not reach the contact center.
Traffic engineering involves estimating the number of trunks and amount of communications equipment 
needed to service an anticipated number of callers. It revolves around basic questions concerning the 
relationships between service parameters and trunk and agent resources. How much traffic can a partic-
ular number of trunks handle for a particular GOS? What is the GOS for a particular number of trunks and 
traffic level? How many trunks are required to handle a particular traffic level and GOS? What is the prob-
ability of delay and length of delay experienced for a particular traffic level and number of agents? How 
many agents are required to handle a particular traffic level for a given set of delay characteristics?

Understanding Erlang B

Contact centers use the Erlang B equation to estimate the number of trunks required. Erlang B assumes 
calls are not queued and that callers who receive a busy signal do not attempt to call again. It can under-
estimate the trunks required. One Erlang equals one hour or 60 x 60 = 3,600 seconds of telephone inter-
action.
Predicting your trunk requirement involves
• Determining your Busy Hour Traffic (BHT)
• Deciding how many blocked calls you can tolerate, or Grade of Service (GOS)

BHT
The Busy Hour Traffic (BHT) statistic, measured in Erlangs, is the number of hours of call traffic (or trunk 
traffic) you experience during the busiest hour of operation. It is important that your busy hour figure repre-
sent the busiest Call Load your trunks will ever receive, and not just today’s peak traffic. BHT is the 
(average call duration+ average delay) x calls per hour ÷ 3600. This value represents the highest Trunk 
Load (occupancy) in hours.
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The call center traffic is the average number of trunks busy during the hour in question. One Erlang equals 
one hour, or 60 x 60 = 3,600 seconds of telephone interaction. If a contact center experiences 6.12 
erlangs (or 6.12 hours of telephone interaction) during an hour, an average of six trunks were busy.
GOS
The Grade of Service (GOS) value is a decimal fraction. A GOS of P.02 means a caller has a two percent 
chance of receiving a busy signal. Contact centers use GOS in calculating the number of trunks required. 
It is important to specify a GOS that is right for you in order for the trunk calculation to be realistic.

Predicting trunk requirements

The number of trunks you require reflects the level of traffic expected during your busiest hour of opera-
tion. The busy hour is the hour during the workday in which a trunk group carries the most traffic. You 
calculate the Trunk Load after you forecast the Call Load for the busiest hour and determine the number 
of agents required to handle the Call Load for your Service Level objective.
Traffic calculators used to predict contact center resource requirements are available on the Web from 
companies such as erlang.com. You can obtain basic calculators at no cost. Calculators that display and 
print results or calculations made during the previous week are available at a modest cost.
To calculate the trunks required you simply input two of the figures and calculate the third. For example, 
if you know that your Busy Hour Traffic is 10 erlangs and you want to determine how many trunks are 
required when two calls are blocked in every 100 call attempts, you input the busy hour time (10) and your 
target rate of blocking (0.02). The calculator displays a value for the trunks required (17).
The following figure illustrates the trunks required across a spectrum of GOS values. Whether you chose 
a GOS of 0.01, 0.05, or somewhere in between these values reflects how may calls per 100 call attempts 
you can afford to lose. In revenue-based contact centers minimal blocking and delay is a priority.

Figure 5.3: Estimating the trunk requirement
 

Although some contact centers base the trunk requirement on a staff-to-trunk ratio, such as 1.5 trunks per 
agent, many use the Erlang B equation. Whatever ratio results will be the right one for you.
It is better to slightly overestimate than slightly underestimate the number of trunks required: trunks are 
inexpensive, compared to agent costs. You can always cancel a trunk if periodic Trunk Load calculations 
show low occupancy on the trunk.
No staffing approach is absolute. You need to acknowledge the assumptions implicit in your calculations 
and use common sense when estimating your resource requirements. When you schedule resources, 
they must be closely monitored to ensure you are making full use of them.
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Step #5 Schedule agents
Scheduling involves accurately forecasting the workload and determining which agents should work 
which shifts. This has traditionally been a labor-intensive manual process for contact center supervisors. 
You can schedule agents for breaks, split shifts, ACD and Non ACD work periods, repeating work 
patterns, holidays, and on call work. You can categorize agents by pay level, overtime eligibility, skill level, 
employment status (part time or full time), and scheduling preferences. Matching these shift and agent 
variables to the anticipated workload, and re-allocating agents in response to employee absenteeism can 
be a daunting task.
Scheduling is becoming increasingly challenging, as contact centers support a wider range of products 
and services, and agents require more frequent and specialized training. Advances in technology have 
automated many agent tasks and have resulted in more varied and challenging calls and responsibilities.
Accurately forecasting and building schedules that reflect the workload as it changes across intervals for 
days of the week, weeks of the month, and seasons of the year is essential in meeting your service objec-
tives. You need a schedule that accurately matches agents to the anticipated workload and agents who 
aspire to adhere to the activities scheduled.
You can track the availability and activities of agents throughout the day and verify agents are performing 
the duties for which they are scheduled. Not adhering to the schedule, such as forgetting to log out for a 
break, or performing Non ACD work when scheduled to perform ACD work adversely affects your Service 
Level and the moral of other agents who must compensate for the unavailable agent.

Understanding the Shrinkage Factor

Accurately forecasting the workload and scheduling agents to satisfy your Service Level objective is a 
good start, but does not account for the activities that prevent agents from sitting at their desks and 
handling telephones.
Agents scheduled for ACD work can be involved in some of the following activities:
• On a bathroom break
• Making or receiving personal calls
• Conferring with the supervisor or another agent
• On the phone with other departments
• Sending emails
• Involved in a lengthy, difficult call
• Prolonged in after-call work
• Absent due to illness or compassionate leave

To account for short-term or daily unscheduled absences, you can calculate the rostered staff factor 
(Shrinkage Factor). The Shrinkage Factor is a numerical value that defines the percentage of time agents 
are scheduled to work but are unavailable to handle calls. It tells you the number of agents you must 
schedule in addition to the base number of agents required to meet your Service Level.
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Calculating the Shrinkage Factor

You calculate the Shrinkage Factor for one or more agent groups as follows:
1. Determine the base staff forecasted by hour or half hour for the day.
2. Make a list of activities that prevent ACD agents from handling calls.

3. Add the base staff to the number of agents who are unavailable to handle calls because they are 
absent, on break, at an unanticipated meeting, etcetera.

4. Calculate the Shrinkage Factor for each time interval by dividing the scheduled staff by the base staff 
required to handle telephones.

The result is a set of Shrinkage Factors that represent the expected shrinkage by half hour.
See the following figure.

Figure 5.4: Calculating the Shrinkage 

Factor
You multiply shrinkage values against the base staff required on telephones when setting future sched-
ules. If your agent requirements vary considerably on certain days of the week, you can calculate a sepa-
rate set of Shrinkage Factors for these days. You must use your good judgment in identifying absences 
that are relevant to include in your Shrinkage Factor calculations. Anticipating higher absenteeism on 
Fridays and Mondays is a safe bet while factoring in daily compassionate leave is not. As with all of the 
steps in contact center planning, routinely assess the accuracy of your shrinkage predictions and adjust 
them as required.

Optimizing schedules

Now that you have adjusted your agent requirement to account for unanticipated absences, the next step 
is to design a schedule that makes the most of your resources.
The following examples illustrate ways to adequately staff a contact center without having agents sit idle 
during slower periods.
Scheduling split shifts
Although not everyone likes to take a long break in the middle of a shift, for some agents split shifts fit well 
with priorities outside of work. For contact centers that experience heavy call traffic in the morning and 
evening, split shifts prevent overstaffing during these periods.
Staggering shifts
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Staggering shifts allows you to maintain staffing levels over busy periods or periods when agents are on 
breaks. For example, one set of agents could start at 8:00 A.M., a second group at 9:00 A.M., and a third 
group at 10:00 A.M. so the contact center is fully staffed when it starts getting busy mid-morning. Alter-
nately, you could schedule morning and afternoon shifts that overlap from noon until 1:00 P.M. to enable 
the morning shift to break for lunch while the afternoon shift handles calls.
Staggering breaks
Making slight adjustments to the timing of morning, lunch, and afternoon breaks has a tremendous effect 
on call handling. The Erlang C equation predicts 28 agents can handle 300 calls, each lasting 280 
seconds and delayed 20 seconds. (See the following figure.)
The following figure illustrates that changing the availability by one agent decreases the average delay 
time by five seconds, and allows the contact center to handle 16 additional calls.

Figure 5.5: Staggering breaks to optimize call handling
 

Forecasting Non ACD work
Not all of the Non ACD work must be performed immediately. For example, call-backs to clients, emails, 
and discussions with staff and supervisors can sometimes wait until less busy periods. Forecast and 
schedule Non ACD work for slow times to ensure sufficient agents are available during peak periods. Set 
availability priorities and regularly communicate them to agents.
Scheduling part-time agents and agents on call
When practical, scheduling part-time agents and agents on call can be an effective strategy for topping 
up your pool of available agents. Scheduling agents on call is particularly useful for days of the week and 
seasons when absenteeism is noticeably higher.

Routing calls to optimize coverage

To optimize service, you can use the following routing strategies that involve resources outside of the 
target agent group.
Overflowing calls to less busy agent groups
You can overflow calls from busy agent groups to less busy agent groups during peak periods. You can 
route calls to agents who primarily perform Non ACD work but act as reinforcements during busy periods, 
and to supervisors.
Employing call-back messaging
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You can program the ACD to forward calls to voice mail so callers can leave messages instead of waiting 
for live agents. Call-back messaging helps to balance agent workloads between peak call periods and 
slow periods.
Contracting calls to customer care bureaus
Contracting calls is a growing industry. During peak periods, you can route simple, routine calls externally 
to customer care bureaus. Service bureaus collaborate with contact centers to set up scheduling and 
monitoring practices, and train agents to handle calls that vary in complexity.
Employing ACD enterprise call routing
Contact centers that provide extended, or around-the-clock service, can interflow calls to other sites. For 
example, you can interflow mid-day calls received by a busy center in San Francisco to agents working 
the late-afternoon shift at a center in Philadelphia. This optimizes call handling without scheduling addi-
tional agents.

Scheduling considerations

Scheduling should be a collaborative effort. Agents have schedule preferences, and want to know when 
they are working well in advance. Agents are more likely to adhere to schedules if they are involved in 
defining the conditions of schedule adherence and non-adherence, and in other areas of the planning 
process.
Producing long-term schedules is less efficient than producing monthly schedules, as contact center 
conditions and agent availability are continually changing. Short-term scheduling is more accurate, but 
less popular with agents. It is important to find a good balance.
Measuring scheduling accuracy
You can measure the effectiveness of your scheduling process. Create a line graph of the Service Level 
for each half-hour interval for each day over the past week. Draw a horizontal line across the graph to 
indicate your service objective. Look for inconsistencies in the service provided for different time intervals 
across days, and how far you stray from your service objective.
If the Service Level is erratic, you may have enough resources in place, but they may not be consistently 
available to handle calls. If the Service Level is inconsistent at certain time intervals across the week, or 
you are not meeting your Service Level objective, investigate to see if you are adequately staffed at these 
times and are making the best use of resources. Try to assess how consistently the agents are 
responding to real-time information displays. Determine if they are restricting Non ACD activities to slow 
periods and adhering to the schedule.
Scheduling agents with workforce management tools
Workforce management tools assist you in scheduling agents for work and holiday periods. Many pack-
ages offer an integrated forecasting component that uses historical data to partially automate the sched-
uling process for established agents. Scheduling is not entirely automated: you must tweak agent 
schedules and enter shift and agent variables for agents manually.

Step #6 Determine contact center costs
An effective budget conveys what is currently happening in the contact center, projections for the 
upcoming year, and business objectives. It is important to highlight the trade-offs between the service 
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provided to callers and costs to the organization by developing at least two budgets that reflect different 
scenarios.
You need to provide a clear indication of how the money is being spent, what you are doing to reduce or 
curb spending, and what equipment is required to meet service objectives and expected growth over the 
next year. Budgeting is on-going process that needs continuous refinement.

Breaking down expenses

The costs associated with contact center operations include 
• Loaded labor costs 

Loaded labor costs include wages, fringe benefits, and facilities, and account for over 60 percent of 
contact center costs. This is a significant cost and underlines the importance of accurate forecasting 
and scheduling.

• Equipment and automation costs 
Equipment and automation costs include the cost of the telephone system, computer systems, and 
furniture, and account for about five percent of total expenses.

• Transmission costs 
Transmission costs include costs incurred for voice (telephone lines) and data transmission, and ac-
count for 25 to 30 percent of contact center costs. Transmission costs have decreased considerably 
in the past few years and are continuing to drop. In revenue-based contact centers, toll-free lines cost 
approximately 15 cents per minute, or nine dollars per hour, per line.

The following statistics help you breakdown and analyze your contact center costs: 
• Cost of Delay 

When insufficient agents are available to handle a given Call Load, the delay increases as does the 
Trunk Load. Calls are queued. For toll-free services each call delayed in queue is a cost to the orga-
nization. You are charged for the toll-free service from the time a trunk picks up a call until an agent 
completes the call and hangs up. The expense of queueing callers is known as the Cost of Delay. 
Staffing affects toll-free service costs: if insufficient agents are available and the Service Level is con-
tinually low, network costs will be high. You need to consider the Cost of Delay when estimating the 
agent requirement, and closely monitor it.

• Cost per Call 
You use a cost-per-call analysis to measure contact center profitability and performance. The cost per 
call measures labor, communication, and equipment costs against the revenue generated. You cal-
culate it by dividing the total cost by the total calls for a particular period of time.

• Average Call Value 
You use the Average Call Value in revenue-based contact centers. You calculate it by dividing the 
total revenue by the number of calls received for a given period. Sales and reservations environments 
use the Average Call Value. The value of each call is balanced against the service provided to cus-
tomers.

Anticipating growth

Predicting company growth is a challenging and essential aspect of contact center costing. Growth 
predictions impact budgeting considerations and must be clearly communicated to senior management. 
It is useful to map out your projected costs and time frames for the upcoming year and substantiate them 
with statistics and graphs. Determine when and how many resources you require, and lead-time issues.
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Enterprise Server installation and upgrades

This section describes how to install MiContact Center Business software on the Enterprise Server, either 
as a new installation or as an upgrade, including requirements and recommendations for before and after 
installing or upgrading.
When you install MiContact Center Business, the applications for which you are licensed are installed and 
activated. The installation wizard guides you through the installation of the Enterprise Server, Remote 
Server, and client software.
The Enterprise Server installation includes all applicable services, help files and user documentation, and 
the following applications: 
• CCMWeb
• MiCC Setup
• YourSite Explorer
• Contact Center Client
• Workforce Scheduling, Schedule Adherence, and Employee Portal
• Flexible Reporting
• MiCC Office Data Import Tool
• MiVoice Border Gateway Connector
• MiVoice Integration for Salesforce
• Ignite

NOTE: The applications that are accessible depend on your licensing.
NOTE: Before you start the MiCC Server Installation, you must complete the process of golden rules 
programming for each PBX. For more information for this setup, refer to http://micc.mitel.com/kb/Knowl-
edgebaseArticle52448.aspx.
NOTE: MiVoice Integration for Salesforce (via Mitel OIG) is a licensable feature, no installation procedure 
is required for this integration. For documentation on Mitel's other CRM connector options, such as, 
Professional Services CRM Connector or InGenious Connector Enterprise, consult the product-specific 
documentation.
For information on remote server installations, see "Remote Server installation".
For information on client installations, see "Client installation".

Handling Enterprise Server installation
This section recommends and explains the steps to follow for a new installation.
Step 1: Prepare your server before installation. See "Preparing the server before installation".
Step 2: RegisterMiContact Center Business product. See "MiContact Center Business product registra-
tion".
Step 3: InstallMiContact Center Business software on the server.
NOTE: You can run a silent install for new installations or during repair installations.

http://micc.mitel.com/kb/KnowledgebaseArticle52448.aspx
http://micc.mitel.com/kb/KnowledgebaseArticle52448.aspx
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For detailed information, refer to the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000648/loc/en_US.

Preparing the server before installation

Before running the server installation, read and adhere to the following notes:
Table 6.1: Pre-Installation Procedures  (Sheet 1 of 4)

Pre-installation procedures

Item Tasks Reference / Recommendation

Hardware, Software and 
Disk Space Requirements

Refer the MiContact Center 
Business and MiVoice Analytics 
System Engineering Guide before 
you start installation to 
understand requirements.

Ensure you have sufficient space 
on your C drive before you begin 
the installation. If you 
installMiContact Center Business 
software on the Enterprise Server 
on a drive other than the C drive, 
you must ensure you have 
sufficient space on the C drive to 
allow for file decompression 
before installing the software to 
the final location.

Licensing Procure licenses from AMC. See "Registering the software"

Windows Updates Complete all Windows updates.

Antivirus Software Configure your anti virus software 
to exclude the 
<installation_drive>:\Program 
Files(x86)\Mitel\MiContact Center 
folder (or whichever folder you 
chose for your installation files).

This is to ensure your MiContact 
Center Business applications are 
able to write files without error.

Ports There are specific ports that must 
be unblocked during the 
installation. The installer takes 
care of unblocking the ports for 
Windows, but for others, see the 
following Knowledge Base article: 
https://mitel.custhelp.com/app/an
swers 
/answer_view/a_id/1002573/loc/e
n_US.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000648/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002573/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002573/loc/en_US
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Non-English language 
operating system

If you are installing MiContact 
Center Business on a supported 
non-English language operating 
system, you must uninstall the 
following: 
• .NET components before 

installing our software. 
Language Pack for Microsoft 
.NET Framework 4 Client 
Profile.

• Language Pack for Micro-
soft.NET Framework 4 
Extended

Failure to uninstall these 
components before installing 
MiContact Center Business may 
impact IVR Routing and 
Multimedia Contact Center 
workflow and subroutine 
functionality

Remote SQL Server If you will use MiContact Center 
Business in conjunction with a 
remote SQL Server, you must 
have an instance of SQL Server 
2014, or 2016 Express (or a full 
version of SQL Server 2014, or 
2016) installed on the Enterprise 
Server.

Server components Before you install the server 
software you must install the 
server components.

See "Installing Enterprise Server 
components".

Disable DEP TheMiContact Center Business 
installer requires Data Execution 
Prevention to be disabled during 
installation. It is recommended 
that if your Group Policy requires 
Data Execution Prevention to be 
on, that you manually turn them 
off before installation.

See "Disabling Data Execution 
Prevention".

Install SQL Server Install SQL Server 2014 or 2016 
Express Edition or Enterprise 
Edition.

See "Installing SQL Server".

SSL Requirements If the Enterprise Server is 
configured to use SSL, you must 
configure SSL in IIS.

See "SSL Requirements".

Table 6.1: Pre-Installation Procedures (Continued) (Sheet 2 of 4)

Pre-installation procedures
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Server Administrative 
Account

During the installation you will be 
required to log on to the 
Enterprise Server using an 
administrative account. 
• If applicable, add the Enter-

prise Server to the domain 
before beginning the installa-
tion. We recommend using a 
domain account, which must 
have local administrator privi-
leges on the server. For 
example, you can call this 
account as CCMSETUP.

• During installation, the 
MCCWa application pool and 
the MiContact Center 
Reporter, MiContact Center 
Configuration Manager, 
MiContact Center Synchroni-
zation, and MiContact Center 
Storage services are set to run 
under this administrative 
account.

• All other services run under 
LOCAL SYSTEM. If you will 
use email distribution, ensure 
the account is an allowed 
sender from your SMTP 
server.

• If you are using Windows 
Authentication to connect to 
SQL, the Authorization Server 
application pool and MiContact 
Center SQL Writer service will 
also run under this administra-
tive account.

Server Administrative 
account’s password

Set this account’s password to 
never expire.

If the password is changed, the 
installer will need to be rerun to 
reconfigure all services.

Table 6.1: Pre-Installation Procedures (Continued) (Sheet 3 of 4)

Pre-installation procedures
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NOTE: 
• For MiContact Center Business/MiVoice Analytics, the enterprise server should not be installed on a 

publicly accessible network.

Installing the Server components

The Enterprise Server has a number of components that must be installed before MiContact Center Busi-
ness can be installed.
When you install MiContact Center Business software on your Windows server, it becomes the Enterprise 
Server.
NOTE: Prior to Version 7.0, users had to manually enable IIS and MSMQ before the installation. In Version 
7.0 and greater, the installer automatically enables IIS and MSMQ on the Enterprise Server.
Before you install the server software you must 
1. Verify the hard drive is formatted and ensure partitioning leaves sufficient space for required applica-

tions.
2. Verify the Windows operating system is installed. 

When installing Windows Server, ensure the name you assign to the computer does not exceed the 
15 character NetBIOS limitation.

3. Install a network card and verify it works.

4. Configure TCP/IP networking and verify it is enabled. 

We recommend you use a static IP address.
5. Install Microsoft Excel (Optional). 

Federal Information 
Processing Standards 
(FIPS) environment

If you are installingMiContact 
Center Business in a FIPS 
environment, the Enterprise 
Server requires a configuration 
change be made to the Windows 
.NET Framework files on the 
Enterprise server following 
installation.

Refer to the following Knowledge 
Base Article: 
https://mitel.custhelp.com/app/an
swers/answer_view/a_id/1000611
/loc/en_US.

Telephone systems Program the telephone systems 
before you begin installation.

See "Programming telephone 
systems".

Software Package Download the MiContact Center 
Business software package.
See "Downloading the MiContact 
Center Business software 
package"

MiContact Center Business 
software is packaged inside a 
self-extracting executable file. 
When the file is extracted, it will 
save to a default location. It is 
highly recommended that you do 
not change the default extraction 
location.

Table 6.1: Pre-Installation Procedures (Continued) (Sheet 4 of 4)

Pre-installation procedures

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000611/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000611/loc/en_US
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Microsoft Excel 2010 or greater is required to both view reports and automatically distribute reports 
for printing. If you intend to use the Enterprise Server as both a server and a client, you require Excel 
2010, 2013, or 2016 on the server. Optionally, Microsoft Excel Viewer may be installed as an alterna-
tive to Microsoft Excel to view reports, but it cannot be used to automatically distribute reports for print-
ing.

NOTE: Protected View is a Microsoft Office security feature that can impact the ability to view Excel reports 
in CCMWeb. If you use Excel on the server to view reports, configure the following Excel options: 

– Ensure the following Protected View options are not enabled: 
• Enable Protected View for files originating from the Internet
• Enable Protected View for files located in potentially unsafe locations
• Enable Protected View for Outlook attachments
• Enable Data Execution Prevention mode

– Ensure that the following Trusted Location option is selected: 
• Allow Trusted Locations on my network (not recommended)

6. Disable Data Execution Prevention. 

Data Execution Prevention must be disabled during installation. It is recommended that if your Group 
Policy has Data Execution Prevention enabled, you manually disable Data Execution Prevention be-
fore installation.
See "Disabling Data Execution Prevention".

7. Install SQL 2014, or 2016 Express (or a full version of SQL Server 2014, or 2016). 

See "Installing SQL Server".
8. Run Windows Update and install the most recent service pack.

Installing the Server components

The Enterprise Server has a number of components that must be installed before MiContact Center Busi-
ness can be installed.
When you install MiContact Center Business software on your Windows server, it becomes the Enterprise 
Server.
NOTE: Prior to Version 7.0, users had to manually enable IIS and MSMQ before the installation. In Version 
7.0 and greater, the installer automatically enables IIS and MSMQ on the Enterprise Server.
Before you install the server software you must 
1. Verify the hard drive is formatted and ensure partitioning leaves sufficient space for required applica-

tions.
2. Verify the Windows operating system is installed. 

When installing Windows Server, ensure the name you assign to the computer does not exceed the 
15 character NetBIOS limitation.

3. Install a network card and verify it works.

4. Configure TCP/IP networking and verify it is enabled. 

We recommend you use a static IP address.
5. Install Microsoft Excel (Optional). 

Microsoft Excel 2010 or greater is required to both view reports and automatically distribute reports 
for printing. If you intend to use the Enterprise Server as both a server and a client, you require Excel 
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2010, 2013, or 2016 on the server. Optionally, Microsoft Excel Viewer may be installed as an alterna-
tive to Microsoft Excel to view reports, but it cannot be used to automatically distribute reports for print-
ing.

NOTE: Protected View is a Microsoft Office security feature that can impact the ability to view Excel reports 
in CCMWeb. If you use Excel on the server to view reports, configure the following Excel options: 

– Ensure the following Protected View options are not enabled: 
• Enable Protected View for files originating from the Internet
• Enable Protected View for files located in potentially unsafe locations
• Enable Protected View for Outlook attachments
• Enable Data Execution Prevention mode

– Ensure that the following Trusted Location option is selected: 
• Allow Trusted Locations on my network (not recommended)

6. Disable Data Execution Prevention. 

Data Execution Prevention must be disabled during installation. It is recommended that if your Group 
Policy has Data Execution Prevention enabled, you manually disable Data Execution Prevention be-
fore installation.
See "Disabling Data Execution Prevention".

7. Install SQL 2014, or 2016 Express (or a full version of SQL Server 2014, or 2016). 

See "Installing SQL Server".
8. Run Windows Update and install the most recent service pack.

Disabling Data Execution Prevention

To disable Data Execution Prevention on Windows Server 2008 R2, 2012, 2012 R2, or 2016. 
1. In Windows, open the command prompt window.
2. After the command prompt, type bcdedit.exe /set {current} nx AlwaysOff and press Enter.

3. Restart the computer.

Verifying the status of Data Execution Prevention
To verify the status of Data Execution Prevention on Windows Server 2008 R2, 2012, 2012 R2, or 2016. 
1. In Windows, open the command prompt window.
2. After the command prompt, type wmic OS Get DataExecutionPrevention_SupportPolicy and 

press Enter. 

The command prompt will return a number that maps to the status of Data Execution Prevention, as 
defined by the following table.

Table 6.2: Data Execution Prevention status  (Sheet 1 of 2)

0 AlwaysOff DEP is disabled for all processes.

1 AlwaysOn DEP is enabled for all processes.

2 OptIn DEP is enabled only for Windows system 
components and services that have DEP 
applied.
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Installing SQL Server

Before you install MiContact Center Business, you must install SQL Server 2014, or 2016 Express. If you 
need full version of SQL to be installed onto a remote server, see the System Engineering Guide. Your 
SQL Server version must include Management Tools (available as a separate download for SQL Server 
2016 Express Edition).
Before installing SQL Server, you must configure the appropriate default collation settings. See the 
following Mitel Knowledge Base article for details: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000779/loc/en_US.
NOTE: 
• You must disable SQL Replication on the SQL Server.
• Ensure you use the SQL Server edition that will support your required data storage needs. SQL Server 

2014, or 2016 Express. If you need full version of SQL to be installed onto a remote server, see the 
System Engineering Guide. This can store up to 10 GB of data per database. If you require more than 
10 GB of data per database, you must purchase a licensed copy of SQL Server. For data storage 
examples and SQL Server guidelines, see the MiContact Center Business and MiVoice Analytics 
System Engineering Guide.

You can download SQL Server Express Editions free from the Microsoft website.
NOTE: You must install BluStar server for Line State monitoring. 
• For MiVoice Connect, install BluStar on the DVS server.
• For MiVoice Office 400 and MiVoice 5000, install BluStar on the MiCC Server or any remote machine.

Adding SQL Server security roles to the administrative account
In order to properly create and configure databases, the administrative account being used to install 
MiContact Center Business must have the dbcreator role on the SQL server.
If you have installed SQL Server 2014, or 2016 Express (or a full version of SQL Server 2014, or 2016), 
you must also verify that the NT AUTHORITY\SYSTEM server role also has these permissions. For more 
information, see the following KB article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002628/loc/en_US.
NOTE: If you do not want the administrative account being used to install MiContact Center Business to 
be configured with those SQL permissions, there are two alternatives: 
• Add the local system account as dbcreator.
• Set the following services, application pools, and local databases to run under the identity account: 

– Services: 
• MiContact Center Media Router
• MiContact Center Mass Transit Runtime

– Application Pool: 
• CCMWa

– Local databases: 

3 OptOut DEP is enabled for all processes. 
Administrators can manually create a list of 
specific applications that do not have DEP 
applied.

Table 6.2: Data Execution Prevention status (Continued) (Sheet 2 of 2)

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000779/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002628/loc/en_US
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• CCMRouting
• CCMRuntimeServices
• Ccmwa

SQL Server best practices
If you are installing SQL Server 2014, or 2016 Express (or a full version of SQL Server 2014, or 2016), 
ensure you follow these best practices: 
• On the Server Configuration window, ensure you provide a local server administrator account name 

in the Account Name fields and have the service Startup Type fields set to Automatic.
• On the Database Engine Configuration window, on the Account Provisioning tab, ensure you 

specify a local server administrator in the Specify SQL Server administrators pane. If the current 
user has local administrator privileges on the server, click Add Current User.

SSL Requirements

The Enterprise Server enabled for SSL requires a valid certificate assigned to port 443. If the Enterprise 
Server is configured to use SSL and there is no valid certificate assigned to this port, the server fails to 
connect to this port. If there are valid certificates in the Enterprise Server's local certificate store, you can 
assign a valid certificate to this port during the installation process; if not, you can configure the port before 
installation. For more information about configuring your Enterprise Server and SSL, see the whitepaper 
Securing Connections in MiContact Center: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1010137/loc/en_US.
NOTE: 
• In the SSL-enabled MiContact Center Business setup, ensure that the speech-grammar URI 

path(https://<<FQDN>>/MiccConfig/api/v1/SpeechGrammars/<<grXML file>>) is accessible to the 
Nuance Speech Server (NSS), because, the grXML files (speech-grammar files) are hosted on the 
config service.

• The FileSyncServer web application is no longer hosted by the config service on port 7004. It is now 
hosted by the MiCCConfig web application in IIS, under the default website, and is covered by the 
certificate assigned to port 443.

To assign the certificate to port 443: 
1. Open Internet Information Service (IIS) Manager.
2. Expand the list across your PC name.

3. Expand the list at Sites. This displays Default Web Site.

4. Right-click Default Web Site and from the drop-down list, select Edit Bindings….

5. In the Site Bindings window, click Add….

6. From the Type: drop-down list, select https. 

The IP address field displays All Unassigned.
7. In the Port: field, enter 443.

8. From the SSL certificate: drop-down list, select your preferred certificate. This certificate must be 
valid one and issued by a trusted certificate authority.

9. Click OK. The Site Bindings window now lists the new binding.

10. Click Close.
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11. From the File menu exit IIS Manager.

12. Restart the IIS.

Programming telephone systems

Refer to the Golden Rules when configuring your telephone system. See the relevant KB article at 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002335/loc/en_US..
NOTE: The SX-200, Axxess, and 5000 media servers are not supported with Version 7.x, Version 8.x, and 
Version 9.x, except as historical media servers. When upgrading to Version 7.x, 8.x, and 9.x SX-200 
media servers, along with their associated extensions, agents, agent groups, queues, trunks, and trunk 
groups, are set to historical. Axxess and 5000 media servers must be marked as historical before 
upgrading to Version 7.x, 8.x, and 9.x to retain historical data.

Downloading the MiContact Center Business software package

You can download MiContact Center Business software and optional components from the Mitel website.
To download the software package from Mitel website 
1. Using a web browser, browse to http://www.mitel.com/.
2. Click Login.

3. Click Sign In button under Mitel Connect.

4. Type your Username and Password and click Login.

5. Click Software Download Center in the left menu.

6. Expand MiContact Center Business.

7. Expand the sub-headers for the version you need.

8. Select the version to view the available downloads.

9. Download the software and the components you need.

MiContact Center Business product registration

When you install MiContact Center Business software, you have the option of implementing a demo with 
temporary license files in order to activate the software. You must register the software with Mitel within 
seven days of installing a demo or you will no longer be able to log on to the system.
NOTE: 
• Licensing packages and components were significantly modified in Version 8.0. When you upgrade 

from a pre-Version 8.0, you will be migrated to the new licensing model.
• For information on how to apply AMC licensing, refer to the following Knowledge Base Article: 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000797/loc/en_US.

Registering your software

The Mitel Applications Management Center (AMC) is a web-based service that provides licensing, moni-
toring, management, and a variety of other services for installations of software applications. An Applica-

http://www.mitel.com/
http://micc.mitel.com/kb/knowledgebasearticle52408.aspx
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tion Record is the license profile of a specific Mitel product. To register the MiContact Center Business 
software, follow the steps: 
1. Log in to AMC.
2. Create an ARID for the MiContact Center server.

3. Associate the appropriate licenses.

4. Make a note of the application record ID (ARID) and License Key provided in AMC.

Migrating, activating, or updating to current version license files

If an active Internet connection is available and you can access the license server, you must activate or 
update your license online. If you are upgrading your MiContact Center server from a previous major 
release, the license migration will be done automatically.
If you do not have access to the Internet or if you cannot access our license server, you can migrate, acti-
vate, or update your license offline. To migrate the license to current version, activate and sign an offline 
license (CCMv5.dlsc). If you have any licensing questions, please choose the appropriate contact option. 
See " If you need Help".
Note that you can manually sign your DLSC file in AMC in preparation for an offline installation.
NOTE: If you plan to perform an offline installation, you can manually sign the offline license (CCMv5.dlsc) 
in the AMC.
NOTE: To ensure you are able to activate your license files online, any firewalls and proxies must be 
configured to allow traffic over port 80 to IP address 216.191.234.231.
If you have a valid license key you can update your license files and activate your software online using 
the MiCC Setup wizard.
To update the license files online 
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Update License.

3. Read the license agreement and click the check box to agree with its contents. 

To continue with the update, you must accept the license agreement.
4. Click Next.

5. Enter your license key and click Next. 

Your license has been updated.
If your license components have changed since the last upgrade, run the MiCC Setup wizard, choose 
the Repair Enterprise Server option, and select the check boxes to choose which license compo-
nents will be installed.

6. Click Finish. 

Your software is now activated and licensed.

If you are unable to access the licensing server, you can update your license files offline. You must have 
a valid license key and current license file to do so. See "Registering the software" for options.
To update the license files offline 
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Update License.
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3. Read the license agreement and click the check box to agree with its contents.

4. Enter your license key and click Next.

5. If you have a registered license file, skip to step 10. Otherwise, go to step 6.

6. If you do not have a registered license file, click Create license package for registration.

7. Select the directory where the license files will be saved and click OK.

8. Email the license files to Mitel to obtain a product key. 

Email miccrenewal@mitel.com(North American customers) or your approved Mitel vendor (for cus-
tomers residing outside of North America).

9. After receiving the product key from Mitel, relaunch the MiCC Setup wizard and follow the steps to 
proceed to step 10.

10. Click Apply registered license file.

11. Select the directory where the license files are located and click OK. 

A message displays advising that your software is now registered and licensed.
If, after completing the activation process, you need to change your license key, you can do so by 
running the MiCC Setup wizard and, when prompted, click the Change key check box.

Installing MiContact Center Business Version 9.3

This section describes the installation procedure using the install wizard. Before you begin the installation 
procedure, we recommend that you read and complete the instructions listed in "Preparing the server 
before installation" and "MiContact center Business product registration".
Based on the type of installation you plan – Online or Offline, you can follow the instructions to transfer 
the software package on to the server. MiCC Setup wizard guides you through the installation process.

Offline Installation

To install the MiContact Center Business software (offline installation) 
1. On a PC that is connected to the Internet, ensure all the Windows programs are closed.
2. Follow the instructions to download the software, either using Software Download Manager or HTTP, 

onto a USB key or network share. For detailed download instructions, see "Downloading the MiCon-
tact Center Business software package".

3. You are now ready to transfer the downloaded software onto your Enterprise Server.

4. Log on to the Enterprise Server with a Windows administrator account. The account must have full 
administrative privileges.

5. Copy the previously downloaded file to the Enterprise Server’s hard drive. We do not recommend 
installing MiContact Center Business from a removable drive or network share.

6. Run the executable file and browse to select the location to which the install files will be extracted. By 
default, this is <installation drive>:\MiCC_8XXX.

7. Complete the MiContact Center Business installation by following the instructions described in the 
following section, under "Installing MiContact Center Business using the MiCC Setup Wizard" .
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Online Installation

To download MiContact Center Business software (online installation)
1. Select the location to which the install files will be extracted. 

We recommend you do not alter the default path to which the files are extracted.
2. Log on to the Enterprise Server with a Windows administrator account.

3. The account must have full administrative privileges.

4. Ensure all the Windows programs are closed.

5. Follow the instructions to download the software. For download instructions, see "Downloading the 
MiContact Center Business software package".

6. Complete the MiContact Center Business installation by following the instructions described in the 
following section, under "Installing MiContact Center Business using the MiCC Setup Wizard".

Installing MiContact Center Business using the MiCC Setup wizard

To install MiContact Center Business using the MiCC Setup wizard
After downloading the software package on the Enterprise server, the MiCC Setup wizard guides you 
through the installation process. 
1. Run the Setup wizard as an administrator.
2. When the MiCC Setup Installer Workflow page displays, click Deploy Enterprise Server. 

The Product Announcements page displays.
3. We strongly recommend you read the notices on the Product Announcements page as they pertain 

to the software version you are about to install.

4. Click Next. 

The Installation Paths page displays.
5. Select the I want to customize what features are enabled on this deployment check box to 

choose the features you want to install on the Enterprise Server. 

NOTE: If you select this check box, the Enable Features page will display after the Licensing and 
Registration page has been processed and completed.

6. If you want to install the Enterprise Server software in a location other than the default, click Browse 
and select the alternate destination.

7. Select the I want to specify shared folders for logs and data check box to designate where you 
want to store log files, data directory files, backup files, persisted report files, and search storage files. 

NOTE: 
– The storage path can be either a local drive or a network drive (UNC path). The Local administrator 

account set during installation must have read/write permission to that path.
– MiContact Center does not support UNC path for Backup folders.

8. If you want to choose alternate destinations for logs and data files, click Browse, otherwise click Next 
to accept the default locations. 

The License and Registration page displays.
9. Read the license agreement and click the check box to agree with its contents. 
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To continue with the installation, you must accept the license agreement.
10. Enter your license key or choose to register later. 

If you choose to register later, you will be granted a temporary seven-day demo license. See "Regis-
tering the software".

11. Click Next. 

If, on the Installations Path page, you selected the option to customize which features are enabled on 
the Enterprise Server during the installation, the Enable Features page displays.

12. Toggle the switches to On or Off to select the features you want to install on the Enterprise Server. 

– Selectable options depend on your licensing.
13. Click Next. 

The pre-requisite software is now installed. You may receive warnings if pre-installation steps were 
not completed prior to initiating this installation or if the hardware and software requirements, as noted 
in the Mi Contact Center Business and MiVoice Analytics System Engineering Guide were not met. 
In some cases, the installation will be aborted and you will be advised to update your server hardware 
and software and rerun the installation.
You can view the installation log files to view the warnings and errors.

14. Click Next. 

The Enterprise Server settings page displays.
15. On the Enterprise Server settings page, specify the following settings: 

– After What is the IP address or Host Name of this server, verify the IP address of the Enterprise 
Server. If it is not correct, type the correct IP address or DNS name. Note that if you are using the 
high availability environment, you have to type the host name and not the IP address.

– If you use Secure Sockets Layer, select the check box beside I would like to use SSL. 
CAUTION: If you select this check box, ensure you enter the Fully Qualified Domain Name(FQDN) that is 
used when applying the SSL certificate. For more information on planning, deploying, and securing 
communications with MiContact Center Business, please refer to the "SSL Requirements".

– After What is the desired language for the Enterprise, select the language in which you want 
MiContact Center Business applications to display. 

NOTE: MiContact Center Business applications, such as YourSite Explorer and Contact Center 
Client, use the language settings of the operating system in addition to the language prefer-
ence set for MiContact Center Business. Ensure that the language selected matches the 
language settings of the operating system.

– After In what country is this server situated, select the country in which your Enterprise Server is 
located.

– After In what time zone is this server situated, select the time zone for the area in which your 
Enterprise Server is located.

16. Click Next. If you have not chosen the SSL option, the SQL Server page is displayed. 

If you have chosen I would like to use SSL option, the SSL Validation page is displayed. Allow the 
SSL validation page to verify the SSL configured. If the SSL is not verified, select a preferred certifi-
cate from the drop down list, add a valid certificate to the enterprise server's local store and click Retry 
to resume the processing. If there is no valid certificate in the drop down list, add a valid certificate to 
the enterprise server's local store and click Retry to resume the processing. After the SSL validation 
is complete, the SQL Server page is displayed.
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17. From the drop-down list, select the SQL Server instance that will be used to store the MiContact 
Center Business databases. 

If you are using a remote version of SQL Server, ensure you enter the computer name of the remote 
SQL Server.

18. Select the method that SQL Server will use to authenticate user credentials: Windows Authentica-
tion or SQL Authentication (recommended if you are using a remote version of SQL Server).

19. If you choose Windows Authentication, the Windows credentials of the currently logged in user will be 
applied. If you choose SQL Authentication, enter the username and password that are used to 
connect to SQL.

20. Click Next.

21. Enter the username and password that will be used for MiContact Center BusinessMiVoice Analytics 
services.

22. From the drop-down list, select the authentication method that will be used when employees log in to 
MiContact Center Business applications. 

NOTE: In Basic Authentication models, the system administrator manages the login accounts of each 
employee from YourSite Explorer. Windows Authentication leverages Windows Active Directory for 
user logins. You can synchronize with Active Directory post-installation using Active Directory 
synchronization within YourSite Explorer. Windows Authentication is available as an option only if 
you use Active Directory.

23. Click Next. 

The MiContact Center Business software is installed.
24. Select the Launch the YourSite Explorer now  check box if you want YourSite Explorer to open 

when the installation is complete. 

If you choose this setting, when YourSite Explorer opens, log in with the default administrator creden-
tials if you choose to use basic authentication: 

– Username: _admin
– Password: _password

If you choose to use Windows authentication, you need not enter any credentials.
We recommend you change the default password after the install process has completed. See 
"Changing the default administrator password".

25. If you want to review the release notes for this software version, select the I would like to review the 
release notes check box. 

NOTE: You require Adobe Acrobat Reader on your server to be able to read the release notes.
26. Click Finish. 

After you have completed the installation, you can rerun the MiCC Setup wizard at any time to modify 
the Enterprise Server installed components and features and to update license files.

Modifying Enterprise Server installed components and features

The MiCC Setup wizard can be rerun at any time to modify the components and feature choices you 
selected during the installation of MiContact Center Business.
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CAUTION: If the MiCC Setup wizard has already been run successfully, re-running it will undo the Enter-
prise Server configuration settings you previously specified. You must complete the MiCC Setup wizard 
each time you run it or the Enterprise Server will not function properly.
To modify Enterprise Server installed components and features 
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Repair Enterprise Server.

3. Follow the steps as described in "Installing MiContact Center Business Version 9.3", ignoring the 
download instructions and modifying components and features as needed during the installation 
process.

Changing the default administrator password

We recommend you change the default password for the administrator account to prevent unauthorized 
users from gaining access.
The default user name and password are
• Username: _admin
• Password: _password
• Security Role: Enterprise Administrator

NOTE: The default user name and password apply to installations using Basic Authentication, and not 
those using Windows Authentication.
For more information on security roles, see "Configuring security settings".
To change the password
1. In the YourSite Explorer > Devices > Employee, select the default Administrator.
2. Under General, in the Password field, type the new password.

3. Click Save.

NOTE: You can also change the password from CCMWeb interface.

Enterprise Server upgrades
When you upgrade MiContact Center Business to latest Version, you run the MiCC Setup wizard to 
upgrade the Enterprise Server.

Before upgrading to the latest Version of MiContact Center Business

Before upgrading the server installation, read and adhere to the following recommendations:
When upgrading to this latest Version, you may choose to stage your deployment and provision a second 
Enterprise Server with MiContact Center Business, move clients over in stages, and retain a server that 
is running the previous release until you are confident that this Version is providing the stability you 
require. Ensure client software has been updated to the appropriate version. We do not support an older 
version of a client connecting to a newer release on a server. Certain reports and real-time data may not 
line up in a co-existence scenario.
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For more information, see https://mitel.custhelp.com/app/answers/answer_view/a_ 
id/1011100/loc/en_US.
If your existing deployment includes Multimedia Contact Center, consult the Mitel Multimedia Contact 
Center Installation and Deployment Guide for additional considerations for upgrades.
Before upgrading, read the following notes as well as reviewing the notes under "Preparing the server 
before installation".
CAUTION: Deleting the hidden .msi install files will result in the failure of upgrades to later versions of 
MiContact Center Business.
NOTE: 
• The installer alerts you if the available space falls below 60 GB.
• If you have MiContact Center Business clients that are connected from a remote site, you can program 

these clients to update from a Remote Server rather than the Enterprise Server. This will reduce traffic 
across the network. Remote Servers will be prompted with an update by the MiContact Center Updater 
following the upgrade of the Enterprise Server. The MiContact Center Updater will download the files 
located in CCM\Websites\CCMWeb\Applications on the Enterprise Server and place them in a virtual 
directory on the Remote Server with the same name (CCMWeb\Applications). Clients will then update 
using these files from the Remote Server.

• Repackaging the Client Component Pack with the MiContact Center Business Redistributable 
Repackager uses a large amount of processor and memory as the files are zipped into the package. 
While this will not destabilize the server and interrupt contact center operations, on systems with 
limited performance overhead it may cause slow performance in Remote Desktop Sessions and for 
applications being run directly on the server. We recommend you avoid performing additional tasks on 
the MiContact Center Server until repackaging has completed.

• We strongly recommend you close Computer Management Console before upgrading, otherwise 
some files may not update correctly.

• To view Lifecycle report data from before the upgrade, it is recommended that you re-summarize the 
data.

• Microsoft CRM 2007 is not supported with MiContact Center Business. If your IVR Routing workflows 
contain Execute activities that point to CRM 2007, the preinstall checker will stop the upgrade. Micro-
soft CRM 2011 and 2013 are supported for use with MiContact Center Business.

• If you are installing MiContact Center Businesson a supported non-English language operating 
system, you must uninstall the following .NET components: 
– Language Pack for Microsoft .NET Framework 4 Client Profile
– Language Pack for Microsoft .NET Framework 4 Extended

Failure to uninstall these components before installing MiContact Center Businessmay impact IVR 
Routing and Multimedia Contact Center workflow and subroutine functionality.

• With Windows Server 2012, .NET 3.5 is a Windows feature, not a redistributable package, and can be 
installed from the Windows Features management panel.

• If you configured chat request forms in Version 7.0, your customizations will not be retained after 
upgrading to current version. For information on customizing the chat request forms, see the Multi-
media Contact Center Installation and Deployment Guide.

To upgrade to current Version: 
1. Back up the YourSite database and phone data 

See "Backing up the YourSite database and phone data".
2. Turn off automatic updates to client computers and remote servers 
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See "Turning off automatic updates to client computers and remote servers".
3. Upgrade MiContact Center Business 

See "Upgrading to MiContact Center Business current Version".
4. Restore telephone system and configuration data 

This step is only required if you are performing a side by side migration.
See "Restoring telephone system and configuration data".

5. Turn on automatic updates to client computers and remote servers 

See "Turning on automatic updates to client computers and remote servers".
6.   

Backing up the YourSite database and phone data

Backing up Enterprise Server configuration and telephone system data offers protection in case there are 
unexpected issues while upgrading from one version of MiContact Center Business to the next. The 
Enterprise Server configuration backup includes configuration items such as employees, agents, agent 
groups, queues, and security roles. This backup can be used to restore the configuration on the same 
MiContact Center Business version or on an upgraded version.
NOTE: 
• You must be licensed as a System Administrator to back up telephone system and configuration data.
• As a security measure, if backed up data is restored on an Enterprise Server with a different IP address 

than the Enterprise Server it was backed up on, all mail server incoming and outgoing usernames and 
passwords will be blank in YourSite Explorer. Ensure that any relevant mail server information is 
recorded for manual re-entry in YourSite Explorer.

To back up the YourSite database 
1. Start Contact Center Client.
2. Click Tools > Management.

3. Click Configuration.

4. Click Back up/Restore configuration data.

5. Select Back up and click Next.

6. Click Save and select a location to save the file. 

NOTE: A .zip file is created. Inside the .zip file is an XML file that contains the entire configuration.
7. Click Finish.

To back up raw telephone system data files 
1. On the Enterprise Server, right-click Start > Explore.
2. Copy the <drive>:\program files (x86)\Mitel\MiContact Center\DataDirectory folder to the 

desktop, a network share, or, optionally, store it on a CD.

Turning off automatic updates to client computers and remote servers

By default,remote servers and client computers are configured to automatically apply upgrades from the 
Enterprise Server. This can be turned off to allow for the upgrade to be completed and verified as 
successful before the new version is taken and applied by client computersand remote servers. We 
recommend when upgrading between versions of the software that you turn off the automatic update.
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To turn off automatic update 
1. Open YourSite Explorer.
2. Click Enterprise.

3. In the Enterprise tab, clear Auto update client applications.

4. Click Save.

Upgrading to MiContact Center Business current version

The following versions can be upgraded to Version 9.3: 
• Version 7.1.3.3
• Version 8.0.1.0 9.2
• Version 8.1.x
• Version 9.1 x
• Version 9.2 x

If you do not have one of the supported versions, you must install a supported version before upgrading 
to Version 9.3.
NOTE: If your existing deployment includes Multimedia Contact Center, consult the Multimedia Contact 
Center Installation and Deployment Guide for additional considerations for upgrades.
To upgrade to MiContact Center Business Current Version 
1. Ensure all Windows programs and Mitel applications are closed.
2. Run the MiContact Center Business installation on the Enterprise Server. 

See "Installing MiContact Center Business Version 9.3".
When installing MiContact Center Business on the Enterprise Server, you log on to the Enterprise 
Server with a Windows administrator account. Ensure this account has full administrative privileges.
After you install MiContact Center Business on the Enterprise Server, the MiContact Center Updater 
Service updates all applications and services for client computers and Remote Servers.

NOTE: Deployment changes, such as additional services and firewall rules, cannot be made by the 
Updater Service. For these, you must open the setup wizard on the Remote Server and run the Repair 
Remote Server option.

The length of time it takes for all client computersand Remote Servers to update varies depending on 
the number of machines being upgraded. The MiContact Center Updater uses a throttling mechanism 
to streamline the process and avoid Enterprise Server congestion. The number of concurrent down-
load connections is set to a default of 50 but is configurable. See the following Mitel Knowledge Base 
article: https://mitel.custhelp.com/app/answers/answer_view/a_id/1000654/loc/en_US for details.

3. When the MiCC Setup wizard opens, follow the steps to configure your system.

4. Navigate to the downloads (Mitel Connect > Downloads > MiContact Center) and install the latest fix 
pack.

5. Perform full synchronization in YourSite Explorer. 

See "Performing Synchronization".
6. If you want to restore your configuration from a backup file, see "Restoring telephone system and 

configuration data".

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000654/loc/en_US
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Restoring telephone system and configuration data

After installing the latest version on the designated Enterprise Server, add the data from your old server 
by restoring the previously backed-up data from the old server to the new server.
NOTE: 
• Remote restores are not supported.
• As a security measure, if backed up data is restored on an Enterprise Server with a different IP address 

than the Enterprise Server it was backed up on, all mail server incoming and outgoing usernames and 
passwords will be blank in YourSite Explorer. Administrators must manually re-enter mail server 
incoming and outgoing usernames and passwords.

To restore telephone system and configuration data 
1. In Contact Center Client, click Tools > Management.
2. In Management Console, click Configuration > Back up/Restore configuration data.

3. Select Restore.

4. Under Type, click the radio button beside the relevant restore method. 

'Lab Restore' pacifies aspects of the configuration to avoid interfering with a live environment. 'Live 
Restore' assumes a live environment and restores exactly as is. If you click on the 'Lab Restore' or 
'Live Restore' text, you will be directed to a Knowledge Base article with further details.

5. To restore a file saved to another location, select from this file > Browse, open the backup file, and 
click Next.

6. To restore a file from the server backup directory, select from the server backup directory, select a 
file, and click Next.

7. When prompted to restart Contact Center Client, click Yes.

8. Optionally, you can synchronize the Enterprise Server’s IP address and computer name after 
restoring data. Do so by selecting the appropriate check box and entering the Enterprise Server’s IP 
address in the field provided.

After restoring a backup, check the IP addresses configured in YourSite Explorer and the computer 
names associated to all media servers to ensure the local media servers are set to the local server name 
and remote collectors are also set correctly.

Turning on automatic updates to client computers and remote servers

After upgrading and verifying the success of the upgrade, ensure that you enable the automatic update 
option once more to ensure that client computersand remove servers are running the current version of 
the upgrade.
NOTE: 
• By default the MiContact Center Updater Service checks the Enterprise Server every 10 minutes to 

see if any updates are available and, if so, downloads and applies the updates to client computersand 
remote servers.

• The remote server and client computers will not update any applications that are currently in use. You 
must shut down all MiContact Center Business applications on client computersand remote servers in 
order for upgrades to occur.
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To turn on automatic updates 
1. Open YourSite Explorer.
2. Click Enterprise.

3. In the Enterprise tab, select Auto update client applications.

4. Click Save.

Uninstalling Enterprise Server software

To uninstall Enterprise Server software 
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Uninstall Enterprise Server.

3. When the warning displays, if you want to continue, click Yes to uninstall the product.

4. Select the check box beside I want to remove MiContact Center data. 

You are given options to remove various MiContact Center Business data files. You may choose to 
retain any or all of these file types in order to reduce configuration time for your next deployment.

5. Click Next. 

The MiCC Setup wizard uninstalls Enterprise Server applications.
NOTE: If SSL is configured as a part of the MiCC installation process, note that the port binding that 
is created will not be removed during the uninstall process.

6. Click Finish.
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Configuration

The following section focuses on configuration for Voice contact centers. For detailed information on 
configuring Multimedia Contact Center devices, see "Multimedia Contact Center Installation and Deploy-
ment Guide.".
You configure MiContact Center Business in the following order:
Basic Configurations 
• In YourSite Explorer, under Enterprise, set up your Enterprise structure by specifying Enterprise 

settings, adding sites, and media servers to the sites. 
See "Configuring enterprise settings", "Adding sites", and "Adding media servers".

• In YourSite Explorer, under Devices, configure the YourSite database to mirror the information on your 
telephone system. Add devices in the following order: 
– Add employees. Configure their general settings and licensing attributes and select the media types 

they will handle. When you select a media type, an agent of that media type is automatically created 
and associated to the employee.

– Add agent groups and associate employees to those groups.
– Add queues and associate agent groups to those queues.

Advanced Configurations

YourSite Explorer
YourSite database configuration takes place in YourSite Explorer.
YourSite Explorer streamlines configuration by providing a single interface for all device configuration in 
your contact center. You can multi-select devices and change their attributes in one step, view group 
membership in the same window as the selected device, and view multiple device windows simultane-
ously and tab between them.
NOTE: 
• Only one set of pending configuration changes can be saved at any time. If another user saves 

changes to the same element of YourSite Explorer that you are updating, you receive an error 
message when attempting to save your changes. In these instances you must refresh YourSite 
Explorer after the other user’s changes have been saved. You may then re-enter and save your 
changes. We recommend you save your configuration changes frequently, in order to avoid losing 
work.

• YourSite Explorer enables you to have multiple device tabs open simultaneously. However, as a best 
practice, we recommend you only have the device tabs open that you are currently using.

• We recommend you avoid modifying large data sets from within YourSite Explorer as performance 
levels will be negatively affected. As a best practice, all large dataset modifications should be made on 
the telephone switch directly and synchronized back to MiContact Center Business. If you prefer to 
perform modifications inside YourSite Explorer, we recommend you partition the changes into smaller 
chunks of data.
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Starting YourSite Explorer

NOTE: Launching client-side desktop applications from the task bar causes them to bypass the MiContact 
Center Updater Service process. To ensure successful updates from the Enterprise Server, after an 
upgrade close all client-side applications for 15 minutes or reopen them from the Start menu/Start screen.
To start YourSite Explorer
1. Open YourSite Explorer.
2. If prompted, type your Username and Password and verify the Enterprise Server IP address.

3. If you use Secure Socket Layer, select SSL.

4. Optionally, select Remember my credentials.

5. Click Login.

YourSite Explorer Start Page

The YourSite Explorer Start Page is a startup resource that provides links to both information resources 
for getting started as well as system information for MiContact Center Business. By default, if enabled, 
the Start Page opens automatically with each new session of YourSite Explorer.
The Start Page has two tabs: Getting Started and System Information. 
• Getting Started—provides configuration overviews for MiContact Center Business and includes the 

following tabs: 
– Welcome—details the contents of both the Getting Started tab and the System Information tab
– MiContact Center Business—overview of MiContact Center Business configuration
– MiVoice Analytics—overview of MiVoice Analytics and MiVoice Analytics configuration
– Workforce Scheduling—overview of Workforce Scheduling configuration for employees and 

schedules 
NOTE: You must be licensed for Workforce Scheduling to view this tab.

– IVR Routing—overview of IVR Routing configuration 
NOTE: You must be licensed for IVR Routing to view this tab.

• System Information—provides documentation as well as system and license information and 
includes the following tabs: 
– Documentation—provides links to MiContact Center Businessand MiVoice Analytics documenta-

tion
– About—provides system information, custom reports, and contact information for Mitel
– Alarms—provides information on currently active MiContact Center Business alarms, with links to 

corresponding Mitel Knowledge Base articles

Configuring the YourSite Explorer Start Page

You can configure the Start Page to open automatically when you start YourSite Explorer. You can also 
configure whether or not the Start Page automatically loads in the View tab of YourSite Explorer.
To prevent the Start Page from opening automatically
1. Start YourSite > Explorer.
2. On the Start Page, clear the Show page on startup check box.
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To configure whether the Start Page opens in the View tab
1. Click YourSite > View.
2. To load the Start Page automatically on startup, select the Show start page check box.

Searching

When you perform searches in YourSite Explorer, you can filter on specific criteria to narrow the search. 
YourSite Explorer searches on criteria you type into the Search box. The search result will consist of all 
instances of the search item. For example, if you ran a search for ma, your you search result could 
contain: mail, email, and manager.
After you perform an initial search, you can type additional criteria in the box to narrow the search. If no 
words or numbers match your search request, the resultant list will be blank.
YourSite Explorer can search several variables for devices. For example, for the following devices, the 
following variables can be searched 
• Employees, employee groups—first and last name
• Extensions, extension groups—reporting number
• Trunks, trunk groups, DNIS, DNIS groups, Account Codes, divisions—name and reporting number
• Phone numbers, phone number groups—search on information found in all columns except Created 

by, Created date, Last modified by, or Last modified.

To search for a specific word or number 
• Select a device, and, in the Search box, type the word or number.

Paging

Paging enables you to specify the number of items to be included per page. You can reduce the page 
size to increase the application speed. By default, the page size allows for 100 items. When changing the 
page size, you must close and re-open the device window.
To change the number of items viewed per page 
1. In YourSite Explorer, click YourSite.
2. Click the View tab.

3. After Page size, select the number of items to be viewed per page.

4. Click Save.

Filtering

The filtering bar enables you to access records alphabetically and numerically.
To filter records alphabetically
• On the filter bar, click the letter with which the record begins.
To filter numerically
• On the filter bar, click # to view records that start with numbers 0 through 9.
To reset filtering
• On the filter bar, click All to view all records.
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You can filter and then search within the filtered records. For example, click F to filter for all records that 
start with the letter F. Then type th to search within that list for any record with th.

Customizing the user interface

You can customize the user interface by minimizing aspects of it, changing the order of the columns, 
changing column options, and adjusting the page size. This customization is referred to as a profile. Your 
profile is associated with the username user name you use to access YourSite Explorer. Each time you 
close YourSite Explorer, your profile is automatically saved. When you reopen YourSite Explorer using 
the same username, the user interface displays your profile.

Minimizing aspects of the user interface

To add space to the user interface so you can view additional rows of data, you can minimize the following 
window elements. 
• Filter bar 

The filter bar is the bar on which the alphabet is displayed.
• Page bar 

The page bar is located above the filter bar. The page number is displayed on the left side of the page 
bar.

• Ribbon 
The ribbon is located at the top of the user interface. The ribbon includes Home, View, and Configu-
ration tabs, and enables you to add devices and change the view (horizontal or vertical). Ribbon attri-
butes change depending on the area you are viewing.

To hide the filter bar 
1. On the ribbon, click the View tab.
2. Clear the Show filter bar check box.

To hide the page bar 
1. On the ribbon, click the View tab.
2. Clear the Show paging bar check box.

Changing the order of the columns

You can reorder columns in either of two ways. You can drag a column heading to a different position on 
the table, or you can change column order using Column options. See "Changing column options".
To drag column headings
1. With the device window open, select the column heading to be moved.
2. Drag it to a different position on the table.

Changing column options

You can adjust the width and order of columns, and hide or show columns in device windows.
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To adjust column width
1. Drag the column to the left or right to adjust its width.
2. Click OK.

To hide a column
1. Right-click a column heading.

The Column options window opens.
2. Select Column options.

3. Select the column heading to be hidden.

4. Click <.

5. Click OK.

To change the order of columns
1. Right-click a column heading.

The Column options window opens.
2. Select Column options.

3. Select the column heading to be moved.

4. Use the arrows to change the order of the column headings.

The top column displays first in the device window.
5. Click OK.

Duplicating devices in YourSite Explorer

Devices in YourSite Explorer can be copied and pasted to create duplicate devices for the configuration 
of a resilient contact center. A copied device has the same configuration as the original and any unique 
fields must be changed to new values before the copied device can be saved. Duplicated devices will 
duplicate the membership of the original, so that a duplicate queue, for example, would have the same 
agent group members as the original queue.
NOTE: 
• Embedded RAD messages on 3300 media servers may not be copied as they need to be saved locally 

on that 3300 media server.
• YourSite Explorer does not support copying and pasting devices using CTRL+C and CTRL+V.

To duplicate a device in YourSite Explorer 
1. Select a device or range of devices.
2. In the ribbon, click the Home tab.

3. Click Copy.

4. Click Paste.

5. For any copied device, put new values into fields that must be unique to a single device.

6. Click Save.
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Alternatively, to duplicate a device in YourSite Explorer 
1. Right-click on the device and select Copy.
2. Right-click and click Paste.

3. For any copied device, put new values into the fields that must be unique to a device.

4. Click Save.

Making multiple changes

In one action, you can edit common information across multiple devices of the same type.
You can change information that is common across multiple devices only. For example, you cannot 
change Name and Reporting number across multiple employees because they are specific to each device 
item.

Changing the YourSite Explorer view

You can select from two window orientations: horizontal or vertical. The horizontal view displays informa-
tion in a horizontal layout. The vertical view displays information in a vertical layout.
When you close YourSite Explorer and then restart it, YourSite displays the view and device windows that 
were open the last time you used YourSite Explorer.
To select a particular view 
1. On the ribbon, click View.
2. Select Horizontal or Vertical.

Posting feedback and viewing our forums

Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on https://micon-
tactcenter.uservoice.com. When you post an idea to our feedback forum, others will be able to subscribe 
to it and make comments.
Our forums enable you to send feedback directly to the people building the product. While we cannot 
comment on every suggestion, feedback is analyzed and considered for future releases.
NOTE: Please do not use the forums to submit product defects. To submit product defects, please contact 
your administrator or dealer.
Feedback can also be submitted directly to Mitel without posting the suggestion on the forums. For more 
general feedback, you can also provide a rating of your experience with MiContact Center Business.
NOTE: Please do not use feedback for requesting customer assistance. For assistance with MiContact 
Center Business, please contact your dealer or Mitel Customer Support.
To post feedback and view our forums 
1. In YourSite Explorer, click File > Feedback.
2. Click Got an idea? Tell us. 

or
Access the following URL: https://micontactcenter.uservoice.com.

https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
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To submit feedback directly 
1. In YourSite Explorer, click File > Feedback.
2. Click Contact Us.

To rate your Mitel experience 
1. In YourSite Explorer, click File > Feedback.
2. Click Rate us.

Setting up your Enterprise
You set up your enterprise structure in YourSite Explorer, under YourSite > Enterprise. Depending on 
your system capabilities, customers might contact you by phone, email, chat, SMS, or open media. You 
set up your enterprise to reflect these possibilities and to view statistics and enable reporting on all of 
these forms of interaction.
For more information on starting and working with YourSite Explorer, see the "YourSite Explorer".
Your enterprise structure is made up of the following components: 
• Enterprise 

The enterprise is all of the sites that comprise your company.
See the following figure.

• Site 
A site is an office location with one or more voice media servers. It can be the office where the Enter-
prise Server is installed or a branch office.

• Media servers 
The media servers are the means by which customers communicate with you.

Figure 7.1: Enterprise structure
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Configuring enterprise settings

The Enterprise Server is the computer on which MiContact Center Business is installed. When program-
ming the enterprise, you configure Enterprise Server general settings, global system language settings, 
some maintenance services, email settings for alarm notifications, as well as settings for Contact Center 
Screen Pop (see "Configuring Contact Center Screen Pop") and Multimedia Contact Center (see "Config-
uring multimedia enterprise settings").

Configuring the Enterprise Server settings

To configure the Enterprise Server settings 
1. Click YourSite > Enterprise.
2. In the Enterprise tab, type the Name of the Enterprise.

3. Verify the IP address/DNS name of the Enterprise Server. If the IP address is incorrect, after IP 
address/DNS name, type the IP address of the Enterprise Server. 

NOTE: If you want to change the Enterprise IP address, use the Contact Center Client Update Server 
IP Wizard. See "Updating server IP addresses".

4. After Real-time port, type the real-time port number. 

The default real-time port is 5024.
The real-time port is used to communicate real-time events.

5. After Auditor port, type the Auditor port number. 

The default Auditor port is 5025.
The Auditor port is used to run Auditor events.

6. If you want to be notified when your warranty is about to expire, select the Display warranty warning 
and expiration message check box.

7. If you do not want client applications to be automatically updated, clear the Auto update client appli-
cations check box. 

By default, client applications are updated automatically.
8. After MiTAI proxy server port, type the MiTAI proxy server port number. 

The default MiTAI proxy server port is 5026.
9. If you want Lifecycle reports, select the Enable LifeCycle reports check box.

10. If you use Secure Socket Layer, select the This server uses Secure Socket Layer (SSL) check box.

11. Click Save.

Changing the global system language

Administrators can control the default global language of their system using enterprise settings. During 
the installation of MiContact Center Business, a default global system language is selected. This default 
language is applied to the alarming RSS feed and emails sent out by YourSite Explorer. Administrators 
can optionally change this default language post-installation, modifying the language of the alarming RSS 
feed and emails.
NOTE: MiContact Center Business applications, such as YourSite Explorer and Contact Center Client, all 
leverage the language settings of the operating system in addition to the language preference set for 
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MiContact Center Business. Ensure that if you adjust the language settings of MiContact Center Busi-
ness, you also adjust the language settings of the operating system to match.
To change the global system language 
1. Click YourSite > Enterprise.
2. Click the Enterprise tab.

3. After Language, select the global system language from the drop-down menu.

4. Click Save.

Configuring enterprise maintenance functions

The MiContact Center Business Maintenance Alarm Dispatcher Service runs nightly, at 2:00 A.M by 
default. This service performs the following nightly routines: 
• Backs up the YourSite database to the local data directory
• Shrinks and truncates the SQL transaction log
• Purges the ANI database table and retains only 10,000 records or 30 days' worth of ANI data
• Re-summarizes the previous days data into the SQL database
• Zips data files in the data directory
• Deletes old files in the data directory as required (when the disk space is low)
• Purges error message queues populated by the MiContact Center Mass Transit Runtime Services

You can determine enterprise maintenance settings, including selecting when to run the maintenance 
service, by following the steps in the following procedure.
To configure enterprise maintenance functions 
1. Click YourSite > Enterprise.
2. Click the Maintenance tab.

3. After Zip files older than, select the number of days after which you want to zip data files.

4. After Purge reports older than, select the age after which reports will be discarded.

5. After Delete maintenance logs older than, select the age after which maintenance logs will be 
discarded.

6. After Delete configuration backup files older than, select the age after which configuration backup 
files will be discarded.

7. After Time Maintenance Service runs, select the time the maintenance service summarizes data. 

The maintenance service is set to run at 2:00 A.M. by default. Select a time for the maintenance man-
ager to run when your contact center is closed or is the least busy.

8. After Purge Life cycle reports older than, select the age after which Life cycle reports will be 
discarded.

9. After Purge CDR reports older than, select the age after which CDR reports will be discarded.

10. After Purge IVR Data older than, select the days after which IVR reporting data and call backs will 
be discarded. The default days is 30 days.

11. Click Save.
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Configuring email settings

You configure email alarms so you are notified by email about Enterprise Server and real-time perfor-
mance issues. You must have configured a mail server before configuring your email settings. See 
"Adding mail servers".
To configure email alarms 
1. Click YourSite > Enterprise.
2. Click the Email settings tab.

3. After Mail Server Address, click the Browse button.

4. Select a mail server and click OK.

5. After Email notification interval minutes, select the interval (in minutes) that the Enterprise will 
check for alarms and send out email notifications. 

NOTE: Notifications of critical alarms are sent immediately after the issue is detected.
6. After Send Enterprise Server alarms to the following address(es), type the email address of the 

employee(s) who will receive the email notification. 

Separate multiple email addresses with commas.
7. Click Save.

Adding sites

A site is an office location with one or more media servers. It can be the office where the Enterprise Server 
is installed or a branch office.
Your site structure determines how you view statistics and reports. When you add a site, you add the 
name of the site and the time zone. By making each site distinct, you can restrict user access to sites. For 
more information on restricting user access, see "Configuring security roles". The site’s language deter-
mines the default language setting for new employees associated to it.
Administrators can limit whether or not the Make Busy and Do Not Disturb reason codes used by 
employees are visible in communication tools such as MiCollab and Microsoft Skype for Business.
Administrators can also enable agent greeting and whisper announcement functionality for all agents in 
the site. Agents record messages from Ignite and assign them to specific queues, so that they are played 
on each incoming ACD call. See the MiContact Center Business User Guide for more information on 
agent recorded messages. For information on configuring agent greeting workflows, see "Configuring the 
Record Agent Greeting workflow" and "Configuring agent workflow settings".
Administrators can also restrict the site’s use of Contact Center Client’s Chat Integration, which enables 
employees to chat with each other in Contact Center Client. Prior to Version 7.0, there was an option to 
use Microsoft Skype for Business as the default chat client instead of Contact Center Chat. In Version 7.0 
and greater,YourSite Explorer automatically detects if you have Microsoft Skype for Business Server and 
enables it as the default chat client. If your contact center is a mixed environment where some users have 
Skype for Business and others do not, you may want to use Contact Center Chat to ensure all employees 
can communicate. For information on using Contact Center Chat in an environment with Skype for Busi-
ness on some systems, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000736/loc/en_US.
NOTE: Contact Center Chat requires server to client hostname resolution to properly function.
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If you are licensed for IVR Routing, you can configure callback requests on a site-by-site basis. For more 
information, see "Configuring callbacks".
Administrators can also configure the case management settings for each of the sites. For more informa-
tion, see "Configuring case management settings".
To add a site 
1. Click YourSite > Site.
2. Click Add.

3. After Site Name, type the name of the site.

4. After Time Zone, select the time zone and closest location from the drop-down list.

5. After Site Language, select the site language from the drop-down list.

6. After Default Server, click the Browse button.

7. Select a server and click OK.

8. If you want Make Busy and Do Not Disturb reason codes to display in communication tools, select 
Display Make Busy and DND Reason Codes in Communication Tools.

9. To enable agent greeting and whisper announcement functionality for the site, check Enable Agent 
Greetings. 

The system displays an information message advising you to ensure that the appropriate Class of 
Service options are configured for agents on the MiVoice Business telephone system.

NOTE: Ensure that Agent Greeting ports have the Class of Service 'ACD Silent Monitor allowed' 
enabled on the MiVoice Business telephone system.

10. To disable Contact Center Client Chat Integration, clear Chat Enabled. 

NOTE: If Contact Center Chat is disabled for a particular site all employees associated to that site 
will be unable to communicate with each other using Contact Center Client.

11. Click Save.

Adding mail servers

To add a mail server 
• Click YourSite > Mail servers > Add.
After adding the mail server, you must configure SMTP connections to MiContact Center Business.

Configuring SMTP connections to MiContact Center Business

The following configurations take place in YourSite > Mail servers > Outgoing.
Configuring an SMTP connection enables MiContact Center Business to send outgoing mail through a 
contact center’s email server. The following explains how to configure an SMTP connection between 
MiContact Center Business and email servers. The outgoing settings you configure are applied to any 
email your system sends, such as server alarms and reports.
NOTE: The following procedures require information on your business' email server. Consult the appro-
priate server documentation to retrieve this information.
Configuring an SMTP connection requires you to 



63

SETTING UP YOUR ENTERPRISE
CHAPTER 7 CONFIGURATION

• Add the mail server to YourSite Explorer 
If the mail server has not already been added, see "Adding mail servers".

• Specify the server information for outgoing emails
• Specify the email account's 'From' name and address
• Specify the email account's aliases (if any).
• Optionally, request logon credentials to send outgoing mail
• Test the servers' SMTP socket connection to MiContact Center Business 

NOTE: To test the connection, you must have an email address configured for the employee you are 
logged in as in the Employee page. This email address receives notification of whether the test was 
successful.

To specify the server information for outgoing emails 
1. After SMTP Server, type the server’s IP address or name.
2. Select the Use SSL check box if the server uses Secure Sockets Layer.

3. After SMTP Port, type the server’s SMTP port number. 

NOTE: Google Apps for Business’ port 465 is not supported.
4. After Connection Timeout, type how many seconds the system has to connect to the server before 

timing out.

To specify the email account’s ‘From’ name and address 
1. After From Name, type the name that appears on outgoing mail. 

For example, ‘XYZ Company Sales’.
2. After From Email Address, type the email address that appears on outgoing mail. 

For example, ‘xyzsales@example.com’.

To specify the email account's aliases. 
1. After Aliases, click the Browse button. 

NOTE: 
– If you are licensed for Multimedia Contact Center, include all queue email addresses that agents will 

select as the ‘From’ address in email responses and outbound emails, if these queues are not config-
ured as the ‘From Email Address’ for the mail server.

– If you are licensed for Multimedia Contact Center, failure to include all aliases will impact the ability 
of the Transfer activity to route inbound emails to all queues when using the <<Destination-
Queues>> variable.

2. Type the mail server’s alias and click Add. 

NOTE: An alias can only be associated to a single mail server.
3. If you want to associate additional aliases for the mail server, for each additional alias, type the alias 

and click Add.

4. Click Ok

To request logon credentials to send outgoing mail 
1. Select the SMTP Authentication Required check box.
2. Enter the Username, Password, and Domain information for the server’s email account.

3. Click Save.



64

SETTING UP YOUR ENTERPRISE
CHAPTER 7 CONFIGURATION

To test the server’s SMTP socket connection to MiContact Center Business  
• Click Test Outgoing Mail. If an error message is received, verify that the Outgoing Server, User, and 

Logon information is entered accurately. To troubleshoot, the default installation location for verbose 
logs is C:\Users\<current user>\Documents\CCMLogs\YourSiteExplorer.txt.

Adding media servers

NOTE: The SX-200, Axxess, and 5000 media servers are not supported with Version 7.x, Version 8.x, and 
Version 9.x, except as historical media servers. When upgrading to Version 7.x, 8.x, and 9.x SX-200 
media servers, along with their associated extensions, agents, agent groups, queues, trunks, and trunk 
groups, are set to historical. Axxess and 5000 media servers must be marked as historical before 
upgrading to Version 7.x, 8.x, and 9.x to retain historical data.
For information on adding email, chat, and SMS media servers, see the Multimedia Contact Center Instal-
lation and Deployment Guide "Adding media types to Multimedia Contact Center".
When you first install MiContact Center Business, a 3300 ICP media server is added to YourSite Explorer 
by default. If you do not plan to use this server, we recommend you delete it to avoid receiving unneces-
sary alarms or error messages. You can modify this default server based on your requirement. If you 
choose to add a new server, then you need to delete the default server.
To distinguish between the various types of media for management and reporting purposes, you must 
make each media server distinct when you set up your site. Each media server must have an unique 
name and IP address.
In YourSite Explorer Start Page, under System Information tab, you can click About link to verify the 
types of media servers and the number of employees for which you are licensed. You can access the 
same information in CCM Web you hover over Help and select About your Mitel Applications.
MiContact Center Business works with the following media server types:
3300 IP Communications Platform (ICP)
The 3300 ICP ACD system streams SMDR and ACD real-time data over TCP/IP.
See "Adding a 3300 ICP media server".
Multimedia Contact Center Email
The Multimedia Contact Center Email routing engine dynamically allocates emails from customers to 
agents. Email servers must support IMAP and maintain a reliable connection to the Enterprise Server. In 
addition, we recommend that the mail account from which Multimedia Contact Center retrieves emails 
supports aliases.
See "Adding email to Multimedia Contact Center" for more information.
Multimedia Contact Center Chat
The Multimedia Contact Center Chat routing engine dynamically allocates live chat sessions over the 
Web from customers to agents. The routing engine uses HTTP or HTTPS to communicate between 
customer and agent.
See "Adding chat to Multimedia Contact Center" for more information.
Multimedia Contact Center SMS
The Multimedia Contact Center SMS routing engine dynamically allocates SMS interactions from 
customers to agents. SMS media servers require integration with the SMS gateway service provider 
Twilio to provide SMS capabilities to a contact center.
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See "Adding SMS to Multimedia Contact Center" for more information.

Adding 3300 ICP media servers

You add the 3300 ICP media server and then configure its location settings, telephone system settings, 
data summary options, data collection settings, MiTAI options and, optionally, write-back functionality and 
call recording.
As a best practice, we recommend you perform Full Synchronization after adding and configuring a media 
server in YourSite Explorer and before configuring telephone system settings for the media server. If you 
are adding media servers as part of a new installation, we recommend you perform synchronization after 
all media servers have been added. For more information on synchronization, see "Configuring the Your-
Site database using synchronization""Configuring the YourSite database using synchronization".
To add a 3300 ICP media server
1. In YourSite Explorer, click YourSite > Media servers.
2. You can modify the default or add new one. To add new, click Add > 3300 ICP.

3. After Name, type the name of the media server.

NOTE: 
– To distinguish between the various types of media for management and reporting purposes, you 

must name each media server distinctly when setting up your site.
– The Media server ID field will be populated with a unique number after the media server has been 

saved.

4. After Site, select the site where the media server resides.

5. After Computer name, select the server that collects the data on your telephone system.

6. The field after Telephone System Version is read-only and is automatically populated after synchro-
nizing with the telephone system. It describes the active software load version on the telephone 
system.

7. To be informed of media server alarms, select the Enabled for alarms check box.

NOTE: Selecting this check box will inform you of media server alarms via RSS and email. For more 
information, see "Monitoring and alarming subsystem".

8. The SDS Mode check box is automatically selected, if applicable, after synchronizing with the tele-
phone system.

NOTE: In a network or cluster of elements, the System Data Synchronization (SDS) feature keeps 
programming data, such as Interconnect Handling Restrictions, Feature Access Codes, and Class 
of Service Options, identical at each element.

9. If you have Hot Desking Agents, select the Uses Hot Desking Agents check box.

NOTE: 
– If this is selected, all created agents will be Hot Desking Agents. You cannot mix hot desking and 

traditional agents.
– We recommend you configure Hot Desking Agents for your contact center instead of traditional 

agents.

10. Select Licensed for MiVoice Analytics if you are applying a MiVoice Analytics license.
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NOTE: This check box is selected by default when you add a 3300 ICP media server and have 
remaining MiVoice Analytics media server licenses. If you are licensed for MiContact Center Busi-
ness and MiVoice Analytics, you must select 'Licensed for MiVoice Analytics' to have access to 
MiVoice Analytics. If you are not licensed for a MiVoice Analytics product, you will not be able to 
select the check box for that product.

11. After IP address /DNS name, specify the IP/DNS address of the media server.

12. After Username, type the username used to connect to the telephone system.

13. After Password, type the password used to connect to the telephone system.

14. After Confirm password, type the password used to connect to the telephone system.

15. Click the Test Connection button to test the connection between the media server and the Enterprise 
Server.

This connection is required to ensure Synchronization functionality. If this test fails, you will not be able 
to synchronize.

16. Configure the location settings.

See "Configuring location settings for a 3300 ICP".
17. Under Data Summary Options, set the Maximum MiTAI monitors

18. Click Save.

At this point, you have completed adding your voice media server, you can further configure additional 
settings such as data summary options, data collection settings, MiTAI options, and telephone system 
settings. Optionally, you can configure write-back functionality and call recording.

Configuring location settings

To configure location settings for a media server 
1. Click YourSite > Media servers.
2. Select a 3300 ICPmedia server and click the Location tab.

3. After Country, click the Browse button and select the country where the media server is located.

4. Click OK.

5. After Area, click the Browse button and select the appropriate area code for the media server's loca-
tion.

6. Click OK.

7. After Minimum digits to dial locally, specify the minimum number of digits required for a local 
external call. 

NOTE: Digits less than the minimum are treated as internal calls.
8. After Maximum digits to dial locally, specify the maximum number of digits required for a local 

external call. 

NOTE: Digits exceeding the maximum are treated as long distance external calls.
9. After Outbound dialing prefix, specify the number dialed to access an outside line.

10. Configure the data summary optionsfor the 3300 ICP. 

See Configuring data summary options".
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Configuring data summary options

Contact centers operating over midnight should have ‘This enterprise operates 24 hours a day’ selected 
for the media server. This option provides more accurate reporting over midnight and determines when 
and how agent shifts are opened and closed after midnight.
If this option is selected, the system automatically closes and re-opens agent shifts at midnight. All agents 
remain logged into the system.Agent shift reporting is uninterrupted over this period.
If this option is not selected, the system closes agent shifts after the last agent event before midnight. The 
system re-opens agent shifts after the first agent events after midnight. All agents remain logged into the 
system. Agent shift reporting is not extended between the time agent shifts close and the time they 
re-open.
The agent state timeout audit has four options:
• Clear line if agent Hold Time exceeds: 

Select the number of minutes or hours an agent can be in Single Hold state, after which the Enterprise 
Server resets the state back to Idle.

• Clear line if agent primary Talk Time exceeds: 
Select the number of minutes or hours an agent can be in Single Talk state on the primary line (ACD 
line), after which the Enterprise Server resets the state back to Idle.

• Clear line if agent secondary Talk Time exceeds: 
Select the number of minutes or hours an agent can be in Single Talk state on the secondary line (Non 
ACD line), after which the Enterprise Server resets the state back to Idle.

• Change the agent state from Ringing to Idle after: 
Select the number of seconds, minutes, or hours an agent can be in Ringing state, after which the 
Enterprise Server resets the state back to Idle.

NOTE: These states do not affect the telephone system.

NOTE: If you set one media server as 24 hours then you should make sure that all of your multimedia 
media servers match the same or else all agents for an employee will not have consistent behavior.
To configure data summary options for a media server 
1. Click YourSite > Media servers.
2. Select a 3300 ICP media server and click the Data summary options tab.

3. To generate Trace reporting, select the Inbound/Outbound/Make Busy Trace reporting check box.

4. If your business operates over midnight, select This enterprise operates 24 hours a day. 

NOTE: If you do not select this option, but have agents logged in to MiContact Center Business appli-
cations overnight, you may experience difficulties with shift-related statistics, such as agent shift 
monitor and Make Busy Reason codes. For example, if agents are logged in to Contact Center 
Client overnight with a Make Busy Reason code, when you change the Make Busy Reason code 
the following day, Contact Center Client will display 'Unknown Make Busy code'. This can be reme-
died by logging out of the application and logging back in.

5. To track outbound calls that were not answered, select the Credit unanswered outbound calls 
check box.

6. If you want to display when calls ring at agents’ extensions, select the Monitor Agent Ringing state 
check box.

7. After Digits dialed prefix, type the digits that must precede a telephone number to make an outbound 
call.



68

SETTING UP YOUR ENTERPRISE
CHAPTER 7 CONFIGURATION

8. After Digits dialed postfix, type the digits that must follow a telephone number to make an outbound 
call.

9. After Maximum MiTAI monitors, specify the maximum number of MiTAI monitors.

10. Under Agent state timeout audit, after Clear line if agent Hold Time exceeds, specify the number 
of minutes or hours you are in a hold state before the telephone system clears the line.

11. After Clear line if agent primary Talk Time exceeds, select the number of minutes or hours an agent 
can be in a single state on the primary line (ACD line) before the system clears that line.

12. After Clear line if agent secondary Talk Time exceeds, specify the number of minutes or hours an 
agent can be in a single state on the secondary line (Non ACD) before the system clears that line.

13. After Change the agent state from Ringing to Idle after, specify the number of minutes or hours 
after which you want the agent state to change from Ringing to Idle.

14. If you do not want to report on the secondary line (Non ACD and outbound calls), select the Ignore 
agent secondary line activity check box.

15. Select the Reset MKB/DND time in realtime after call ends check box to enable the MKB/DND time 
to reset in real time when the call concludes.

16. Under ACD Options, to store ACD redundant events, select the File all ACD stream redundant 
events check box.

17. If you do not consider ACD real-time sequence errors as record errors, select the Ignore ACD 
real-time sequence errors as record errors check box.

18. Configure Data collection settings. 

See "Configuring data collection settings".

Configuring data collection settings

CAUTION: Selecting the TCP, Enterprise Manager (OPS Manager), or Simulation tabs will change the 
media server’s data collection mode. Ensure that you select the tab for the appropriate data collection 
mode. Be aware that Simulation mode halts data collection and is used for demonstration purposes only. 
We do not recommend you run media servers in simulation mode. However, if you want to simulate media 
server real-time data collection and reporting, see the following Mitel Knowledge Base 
article:https://mitel.custhelp.com/app/answers/answer_view/a_id/1000546/loc/en_US
To configure data collection settings for a media server 
1. Click the Data collection tab.
2. If you do not use Enterprise Manager (OPS Manager), click TCP. Otherwise, skip to step 8.

3. After SMDR, type the SMDR port number of the media server.

4. If you will be entering ACD information, select the ACD check box and type the ACD port number of 
the media server. 

5. If you use Traffic Analysis, select the Traffic Analysis check box and type 1754 in the text field. This 
is the recommended Traffic Analysis port number.

6. After Data Alarm Timeout Minutes, select the duration of the time lapse in minutes from when the 
data stops streaming to when you want the alarm to display. 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000546/loc/en_US
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NOTE: In a resilient environment, SMDR and ACD data timeout alarms may trigger unnecessarily. 
To prevent this, set Data Alarm Timeout Minutes to zero.

7. After Notify me during these business hours, click the Search button, select a schedule that 
reflects the hours of operation for the media server, and click OK.

8. If you use Enterprise Manager (OPS Manager), click Enterprise Manager (OPS Manager).

9. After IP address/DNS name, type either the IP address or the DNIS name of the Enterprise Manager 
(OPS Manager) computer.

10. After FTP port, type the FTP port number.

11. After FTP user name, type the FTP user name to gain access to Enterprise Manager (OPS Manager).

12. After FTP password, type the FTP password to gain access to Enterprise Manager (OPS Manager).

13. After Remote directory to data files, type the directory path where the data from the telephone 
system is stored by Enterprise Manager (OPS Manager).

14. Configure the media server's MiTAI options. 

See "Configuring MiTAI options for 3300 ICP media servers".

Configuring MiTAI options

To configure MiTAI options for a media server 
1. Click the MiTAI Options tab.
2. After Maximum messages per second, select the number of messages per second from the 

drop-down list. 

The default number of messages is 10 per second. The higher the version of MiTAI, the greater the 
number of messages per second.

3. After MiTAI auto-synchronization will occur at, select the time from the list that you want Automatic 
Synchronization to run.

4. To enable write-back functionality, see "Enabling write-back functionality".

Enabling write-back functionality

For changes that you make to the configuration settings in YourSite Explorer to be written back to the tele-
phone switch, you must enable the read/write option in YourSite Explorer.
To enable write-back functionality
1. In YourSite Explorer, click YourSite > Media servers.
2. Select the media server for which you want to enable read/write functionality.

3. On the ribbon, click the Telephone System tab.

4. In the Settings section, select Read/Write.

5. Configure the telephone system settings for the media server.

See "Configuring telephone system".



70

SETTING UP YOUR ENTERPRISE
CHAPTER 7 CONFIGURATION

Call recording

MiContact Center Business offers 24/7 call recording by integrating with MiVoice Call Recording , dvsAn-
alytics Encore, or Red Box Quantify call recording software. For enhanced call security, MiContact Center 
Business also integrates with the Mitel Secure Recording Connector service to facilitate the recording of 
Mitel encrypted voice streams by third party software. MiVoice Call Recording can optionally be used in 
conjunction with the Mitel Secure Recording Connector service. dvsAnalytics Encore and Red Box Quan-
tify must be used in conjunction with the Mitel Secure Recording Connector service. For information, see 
"Configuring the Mitel Secure Recording Connector service".
For specific information regarding supported third-party versions, see the relevant support statements in 
the MiContact Center Business and System Engineering Guide.
Configuring the Mitel Secure Recording Connector service
MiContact Center Business integrates with MiVoice Border Gateway’s Secure Recording Connector 
service, which facilitates the recording of Mitel encrypted voice streams by third-party call recording 
equipment. In order to use Contact Center Softphone in conjunction with the Mitel Secure Recording 
Connector service, you must complete the configuration process described below.
NOTE: 
• Before you can configure call recording in YourSite Explorer, you must configure the Secure Recording 

Connector service in MiVoice Border Gateway. See the MiVoice Border Gateway documentation for 
configuration information.

• If multiple MiVoice Border Gateways are used in a clustered environment to take advantage of load 
balancing and the soft phone is connected to the primary Secure Recording Connector when that 
connector goes offline, the soft phone will re-connect as determined by the cluster. New soft phones 
will attempt to connect to the first MiVoice Border Gateway configured in YourSite Explorer, then try 
the second MiVoice Border Gateway configured in YourSite Explorer and as a final attempt, try regis-
tering with the media server itself. If it registers with the media server, call recording will not be 
possible.

• For soft phone balancing in a Secure Recording Connector service environment to function properly, 
you must alter a configuration file on the MiVoice Border Gateway server. If you do not, you will have 
to restart Contact Center Client and the soft phone in the event of a failover. For instructions on how 
to make alterations, customers can contact their approved vendor. Certified channel technicians can 
contact Mitel Technical Support.

To configure the Secure Recording Connector service 
1. In YourSite Explorer, under Enterprise, click Media servers.
2. Select a 3300 ICP media server from the list.

3. Click the Call recording options tab.

4. Under Mitel Secure Recording, after IP address 1, type the primary IP address of the Secure 
Recording Connector.

5. If you use multiple Secure Recording Connectors, type the IP address of the secondary Secure 
Recording Connectors after IP address 2. 

If the soft phone fails to connect to the primary Secure Recording Connector, it will attempt to connect 
to the secondary. If that fails, then soft phone will use the IP address of the media server programmed 
in the data collection field. If it uses the IP address of the media server, call recording will not be pos-
sible.

6. Click Save.
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Configuring call recording integration
MiContact Center Business offers 24/7 call recording by integrating with MiVoice Call Recording, dvsAn-
alytics Encore, or Red Box Quantify call recording software.
NOTE: MiContact Center Business with MiVoice Connect does not support ASC as a call recorder.
Using the MiVoice Call Recording, MiContact Center Business can optionally record calls based on 
pre-defined schedules. With MiVoice Call Recording, call recording can be temporarily started or stopped 
in Contact Center Client to ensure customer confidentiality or to create a record of volatile or sensitive 
calls.
Indirect recording is not supported with Contact Center Client Softphone.
When a call recording is complete, a hyperlink to the recording is appended to call-specific Lifecycle 
reports. For more information about Lifecycle reporting, see the Reports Guide appropriate to your 
MiContact Center Business licensing level.
NOTE: 
• MiVoice Call Recording, dvsAnalytics Encore, and RedBox Quantify call recording integration is 

supported for use with the Mitel 3300 ICP only.
• Before you can configure call recording in YourSite Explorer, you must configure your MiVoice Call 

Recording, dvsAnalytics Encore, or RedBox Quantify by following the recommended installation and 
configuration guidelines included with these products. 
Contact your dvsAnalytics or RedBox approved vendor for all setup and troubleshooting issues.

• The dvsAnalytics Encore integration does not support External Hot Desking Agents.
• Contact dvsAnalytics or RedBox for information on integrating call recording with the Mitel Secure 

Recording Connector.
• Ensure call recordings are working properly for all configured extensions before activating the call 

recording integration in YourSite Explorer.
• If you use the Mitel Secure Recording Connector and Contact Center Softphone, you must enter the 

IP addresses of the Mitel Secure Recording Connector in YourSite Explorer.

To configure MiVoice Call Recording Connector 
1. In YourSite Explorer, under Enterprise, click Media servers.
2. Select a media server from the list.

3. Click the Call recording options tab.

4. Under Call recording provider options 

– After Recorder type, select MiVoice Call Recording from the drop-down list.
– After MiVoice Call Recording server address, type the IP address of the call recorder.
– After MiVoice Call Recording server port, specify the port of the call recorder.
– After Username, type the username to log into the call recorder.
– After Password, type the password to log into the call recorder.
– After Trace Web Services URL, if applicable to your deployment, enter the relevant URL for use 

with the latest Tracer API.

5. Click Save. 

Call recordings are enabled and can be accessed from hyperlinks in call-specific Lifecycle reports.
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To configure dvsAnalytics Encore 
1. In YourSite Explorer, under Enterprise, click Media servers.
2. Select a media server from the list.

3. Click the Call recording options tab.

4. Under Call recording provider options 

– After Recorder type, select dvs Encore from the drop-down list.
– After Encore Web API address, type http://<Encore Server IP address>/WebAPI/ECAPI.svc

5. Click Save. 

Call recordings are enabled and can be accessed from hyperlinks in call-specific Lifecycle reports.

To configure Red Box Quantify 
1. In YourSite Explorer, under Enterprise, click Media servers.
2. Select a media server from the list.

3. Click the Call recording options tab. 

– After Recorder type, select Red Box Recorder.
– After Recorder IP Address, type the IP address of the call recorder.
– After Username, type the username of the call recorder
– After Password, type the password of the call recorder.
– After Trace Web Services URL, type the Trace Web Services URL.

4. Click Save. 

Call recordings are enabled and can be accessed from hyperlinks in call-specific Lifecycle reports.

Configuring the Record Agent Greeting workflow

Agent Greeting allows agents to record messages that play automatically to callers when an incoming 
ACD call is answered. Agents can record multiple greeting messages and assign them to different 
queues, or use the same greeting message on all queues.
Agent Greeting messages are recorded and saved using an outbound workflow in the Record Agent 
Greeting tab on the voice media server.
NOTE: 
• By default, this workflow requires no additional configuration, but administrators can add additional 

activities to the workflow. For more information on this workflow, see "Default Record Agent Greeting 
Workflow".

• Agent greeting must be enabled at the site level for the Record Agent Workflow to be active. For more 
information, see "Adding sites".

To access the Record Agent Greeting workflow 
1. Select YourSite > Media servers.
2. Click the Record Agent Greeting tab.

Default Record Agent Greeting Workflow
The Record Agent Greeting workflow manages the recording and saving of agent greeting messages. 
When an agent clicks the 'Record' button in Ignite, the workflow is triggered and the system places a call 
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to the agent's extension and plays an interactive voice menu for message recording. When the message 
is successfully recorded, the system saves the message and makes it available to the agent to assign to 
a queue.
This workflow appears on the media server configuration page, and is only activated if agent greeting is 
enabled on the site to which the media server belongs. For more information on enabling agent greeting, 
see "Adding sites".
For a complete view of the workflow’s activity and operations, expand the entire workflow and all annota-
tions.
To expand the workflow 
• Click the Expand All button.
To expand all annotations 
• Right-click the workflow and select Annotations… > Show all.
Description
The first step in this workflow is a Make Call activity. The Make Call activity checks the value of the 
<<Agent DN>> variable (that is, the dialable number associated with the agent who clicks the 'Record' 
button in Ignite), and routes a call to that DN.
NOTE: Optionally a name and number can be assigned to the Make Call activity for visibility in real-time 
monitors. For more information, see "Configuring the Make Call activity".
The next step depends on the result when the Make Call activity calls the destination: 
• If the call to the destination times out, the call routes through the No Answer branch
• If the destination is busy, the call routes through the Destination Busy branch
• If the destination does not match an existing phone number, the call routes through the Invalid Desti-

nation branch
• If the Make Call activity encounters a failure and does not make the call, the call routes through the 

Failure branch
• If the destination answers, the call routes through the Success branch

The Success branch contains a Record activity. The Record activity allows the agent to record a .wav file. 
For detailed information on configuring the Record activity, see "Configuring the Record activity".
The Record activity contains three branches: 
• Save branch
• Discard branch
• Review branch

The Discard and Review branches are standard Record activity branches.
The Record activity’s Save branch contains a Save Agent Greeting activity that saves the recording to the 
Enterprise Server, and a Play activity that informs callers that the recording has been saved.
The final activity in the workflow is the Hang up activity, which ends the call.

Managing historical media servers

Media servers that are no longer in active use can be set as historical to retain data on the media servers 
associated devices. Historical data is retained on the media server but no new data is collected. When a 
media server is set to historical, it terminates all active licenses for devices associated with that media 
server. These historical devices are preserved for historical reporting.
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NOTE: The SX-200, Axxess, and 5000 media servers are not supported with Version 7.x, Version 8.x, and 
Version 9.x, except as historical media servers. When upgrading to Version 7.x, 8.x, and 9.x SX-200 
media servers, along with their associated extensions, agents, agent groups, queues, trunks, and trunk 
groups, are set to historical. Axxess and 5000 media servers must be marked as historical before 
upgrading to Version 7.x, 8.x, and 9.x to retain historical data.
Associated devices affected by setting a media server to historical include 
• Agents
• Agent groups
• Queues
• Extensions
• Hunt groups

A historical media server is enabled for 
• Historical reporting for associated devices
• Forecasting
• ACD andSMDR Inspector functionality

Once made historical, a media server cannot be returned to active service. A historical media server 
cannot be edited and can only be deleted.
To set a media server as historical 
1. Under Enterprise, click Media Servers.
2. Select a media server

3. In the General tab, click Make Historical.

4. Click OK.

To delete a historical media server 
1. Under Enterprise, click Media Servers.
2. Select a historical media server.

3. Click Delete.

Deleting media servers

CAUTION: If you delete a media server, you will delete all of the devices associated to the media server.
To delete a media server 
1. In YourSite Explorer, click Media servers.
2. Select the media server you want to delete.

3. Click Delete. 

A window opens with the message 'All of the data associated with this media server will be perma-
nently deleted. Are you sure you want to delete this media server?'

4. Click OK.
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Configuring the YourSite database
NOTE: YourSite Explorer enables you to have multiple device tabs open simultaneously. As a best prac-
tice, we recommend you only have the device tabs open that you are currently using.
In an ACD contact center using MiContact Center Business there are two main databases: the telephone 
system database and the YourSite database. Your dealer is responsible for assessing your contact center 
requirements and configuring the telephone system database accordingly. You are responsible for config-
uring the YourSite database to mirror the trunk, extension, agent, agent group, queue, Account Code 
numbers, and routing and timing options in use on the telephone system . This can be achieved quickly 
using synchronization for the 3300 ICP. See "Performing Synchronization".
Employees and employee groups can be synchronized with users in Active Directory through Active 
Directory synchronization. For more information, see "Running Active Directory synchronization"
In the YourSite database, you create associations between devices and device groups in order to view 
real-time data and run reports.
NOTE: Mitel refers to agent groups as agent skill groups on 3300 ICP assignment forms for versions 7 UR2 
and greater. The MiContact Center Business software refers to agent skill groups as agent groups.
To configure the YourSite database, you 
1. Add employees.
2. Add agent groups.

3. Associate employees with agent groups.

4. Add queues.

5. Associate the agent groups with the queues for which they answer calls.

6. Add all other devices for which you intend to run reports, for example, employee groups, Account 
Codes, Make Busy Reason Codes, etc.

Determining which devices to configure

Before you program devices and device groups in the YourSite database you must consider your needs. 
• Reporting 

Will you need to report on all of the devices and device groups, or only on agents, agent groups, 
queues, and queue groups? You must configure the devices and device groups you will use for re-
porting in the YourSite database.

• Real time 
Contact Center Client displays statistics on agents and agent groups, queues and queue groups, and 
employees and employee groups. You configure the individual devices and then associate them with 
their related groups in YourSite Explorer to enable them to be viewed in real time in Contact Center 
Client.
If an employee's licensing is set to 'None' the 'Disable real-time monitoring and data collection on this 
device' check box in YourSite Explorer for their associated agents will be automatically selected and 
they will not be visible in Contact Center Client real-time monitors or be reported on historically.
An agent group must be composed of agents who handle calls for the same media server type. A 
group of agents of mixed media types would produce a report comparing voice agents to email agents 
to chat agents. The comparison would not be valid. You want to compare apples to apples (email to 
email) not apples to oranges (email to chats).
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• Email, chat, SMS, and open media 
See the Multimedia Contact Center Installation and Deployment Guide for information.

Choosing the employee configuration method

There is one recommended configuration scenario for MiContact Center Business, where employees 
have a single voice agent and use agent group presence to control which queues they receive calls from. 
Prior to Version 7.0, there was also a scenario for employees having multiple voice agents, with each 
voice agent in a different agent group associated to a different queue. This configuration scenario is no 
longer recommended. For more information, see "Configuration scenario 2".

Recommended configuration scenario

In the recommended configuration scenario, an employee has one agent login ID. The employee belongs 
to four agent groups that handle calls for four queues. The employee is simultaneously available to handle 
calls to all four queues without having to log out of one queue and into another queue. (See the following 
figure.)

Figure 7.2: Recommended configuration scenario
 

In the recommended configuration scenario, you add your employees via synchronization, importation, or 
manual creation. For each employee, you enable them for voice media, which automatically creates an 
agent with the same name, reporting number, and other information as the employee, so that the 
employee with Employee ID 1000 has an agent with the reporting number of 1000. In the Agent groups 
device page, you add the employee to Agent Group 1-4. Employee 1000 would now be able to 
handle interactions for Agent groups 1, 2, 3, and 4.

Multiple voice agents for individual employees configuration scenario (not recom-
mended)

In configuration scenario 2, only a few agents are cross trained and most agents belong to only one 
agent group. The few agents who are cross trained vigilantly monitor call volumes in all of the queues for 
which they have been cross trained. As soon as they notice a busy queue, they log out of their current 
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queue and in to the busy queue. The advantage of this configuration is that you do not need to cross train 
many employees. Note, though, that your calls are not intrinsically evenly distributed.

YourSite database configuration methods

You can configure the YourSite database in the following ways: 
• Synchronization 

If you have a 3300 ICP, you can synchronize the YourSite database with the queues, agents (includ-
ing their skill level within each agent group), agent groups, agent skill groups, trunks, and extensions 
programmed on the telephone system using Synchronization. You can perform Synchronization on 
individual 3300 ICPs or all 3300 ICPs in your enterprise.
See "Configuring the YourSite database using synchronization".

• Active Directory synchronization 
If you specified the Windows Authentication model during installation, you can synchronize your sys-
tem with Active Directory at any time from within YourSite Explorer. When you run Active Directory 
synchronization, employees in YourSite Explorer are synchronized with users in Active Directory 
groups. If you use Windows Authentication and Active Directory synchronization, users will not be 
prompted to authenticate themselves with a username and password when they start MiContact Cen-
ter Business applications.
See "Running Active Directory synchronization".

• Quick Setup 
If you want to add a range of devices (such as employee groups or Make Busy Reason Codes, and 
teams) you can use Quick Setup.
See "Configuring devices and device groups using Quick Setup".

• Comma-separated value (.csv) import 
You can also add a range of devices (employee, employee groups, employee divisions, agents, agent 
groups, queues, queue groups, extensions, extension groups, extension divisions, trunks, trunk 
groups, DNIS, DNIS groups, Account Codes, Account Code groups, Make Busy Reason Codes, and 
teams) using .csv files.
See "Configuring devices using .csv files".

• Manual configuration 
See Configuring devices manually".

Configuring the YourSite database using synchronization

YourSite Explorer enables you to configure and write queues, agent skill groups, and agents (including 
skill level), and validate/edit contact center related Class of Service, Class of Restriction, System Options, 
and SMDR Options settings using synchronization.
This enhanced functionality enables you to configure MiContact Center Business applications from your 
desktop. Validation of device and assignment form settings ensures quality data collection and accurate 
reporting. After running synchronization, Class of Service and Class of Restriction settings programmed 
in the telephone system can be edited in YourSite Explorer.
During synchronization, administrators can preview device changes, identify devices that should be 
excluded from synchronization, and manage the business rules related to synchronization of device 
names and associated device creation.
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While synchronizing data, the telephone system continues to operate without experiencing downtime. 
After synchronization is complete, the Contact Center Client applications open on agent desktops will be 
refreshed with a device update. After synchronization is complete, all critical programming, such as 
SMDR Options, System Option, Class of Service, and Class of Restriction settings will be validated. We 
highly recommend that you correct invalid programming, as detailed on the Telephone system settings 
tab of media servers in YourSite Explorer, immediately.
Configuring your network using SDS Directory synchronization mode is mandatory for all sites operating 
with 20 nodes or less. For more information, see "Classic mode synchronization" and "SDS Directory 
synchronization mode".
Classic mode synchronization
Using YourSite Explorer and the 3300 ICP in Classic mode, you can add, edit, and delete standard 
agents, agent groups, and queues, as well as ACD related Class of Service (COS), Class of Restriction 
(COR), SMDR Options, and System Options. When not in a clustered environment, you can also continue 
to add hot desk agents and all synchronization device names. Adding hot desk agents in a clustered envi-
ronment requires the use of Mitel OPS Manager.
SDS Directory synchronization mode
Using YourSite Explorer and the 3300 ICP in SDS Directory synchronization mode, you can now add, edit 
and delete standard and hot desk agents, agent groups, queues, trunks, trunk groups, and extensions, 
synchronize device names, as well as ACD related Class of Service (COS), Class of Restriction (COR) 
SMDR options and System Options in both a single site and in a clustered environment. When operating 
in SDS Directory synchronization mode, you can configure Network ACD queue set up on the 3300 ICP 
without any manual configuration previously required using Mitel OPS Manager.
NOTE: 
• In order to use Synchronization to synchronize the YourSite database with resilient, Network ACD, and 

clustered telephone systems, you must enable the SDS Directory synchronization option on all of the 
telephone systems in your enterprise.

• If you edit the feature access code used for silent monitoring on the media server, you must also manu-
ally edit the feature access code on the telephone system. The feature access code entered in Your-
Site Explorer must be identical to that on the telephone system and be valid for use with silent 
monitoring. See "Editing System Options".

Preparing for Synchronization

NOTE: Only Mitel telephones that are programmed on the IP Multiline set assignment form will synchronize 
with the YourSite database. For details on the phones that are supported, please refer to your Mitel 3300 
ICP documentation.
Before you perform synchronization 
• In order to use Synchronization to synchronize the YourSite database with resilient, Network ACD, and 

clustered telephone systems, you must enable the SDS Directory synchronization option on all of the 
telephone systems in your enterprise.

• Ensure that you have completed programming the 3300 ICP and created a user name and password 
for synchronization (on the 3300 ICP User Authorization Profile form). The 3300 ICP User Authoriza-
tion Profile must include Application Access and System Admin Access. Desktop Admin and Group 
Admin options can be disabled. These steps must be completed for all 3300 ICPs in your Enterprise.

• Ensure your MiXML service is started by navigating to the Control Panel in Windows and selecting 
'MiXML'. Verify that port 18000 is entered on the Settings tab and click Start.
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• If you are synchronizing a single telephone system, agents and queues must be programmed on the 
same telephone system. Single node synchronization can disassociate agents and queues if agents 
and queues reside on separate telephone systems.

• Ensure that your Windows or Corporate firewall is not blocking the following ports 
– SOAP: 18000 (HTTPS)
– UDP: 53
– TCP: 7011
– TCP: 22
– TCP: 443 (SSH)

• If you have multiple NICs on your Enterprise Server, you must specify the NIC to use for synchronizing 
data to the telephone system. To do this, navigate to the Control Panel in Windows and select 'MiXML'. 
After NIC IP Address, specify the primary NIC from the drop-down menu.

• MiContact Center Business clusters and cluster element IDs must match what is programmed on the 
telephone system.

• If you are running 3300 ICP Release 9.x or earlier and you synchronized your network ACD assign-
ments and/or resilient agents using OPS Manager, you must synchronize all of the 3300 ICPs in your 
enterprise. Otherwise, agent group and queue group associations will be lost.

Specifying synchronization settings

YourSite Explorer enables you to specify the synchronization settings, read options, and write options 
used by synchronization. When you select a media server in YourSite Explorer, the following synchroni-
zation options are available from the ribbon, on the Telephone system tab:
Settings 
• Disabled 

This option will fully disable synchronization.
• Read 

This option will read devices programmed on your telephone systems and synchronize them with the 
YourSite database.

• Read/Write 
This option will read the devices programmed on your telephone systems and synchronize them with 
the YourSite database and enable devices programmed in YourSite Explorer to be written to the tele-
phone systems.

Read Options 
• Create employees with new agent 

For every new agent added to the YourSite database, a new employee will be created and associated 
with the agent.

• Create employees with new voice extensions 
For every new voice extension added to the YourSite database, a new employee will be created and 
associated with the agent.

• Use telephone system device names 
Override device names programmed in YourSite Explorer with the device names configured on the 
telephone system.

• Default employee license 
Select the default employee license that you want to be applied when synchronizing new agents.

• Default queue business hour schedule 
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Select the business hour schedule to be applied when synchronizing queues added on the telephone 
system.

Write Options 
• Update telephone directory names 

Override telephone directory names with agent, agent group, queue, and extension names configured 
in YourSite Explorer.

Performing Synchronization

There are two ways to perform synchronization: 
• Full synchronization 

Running full synchronization will synchronize the devices programmed on the telephone system and 
enable you to review all devices, and, optionally, exclude any devices, before committing changes to 
YourSite Explorer.

• Telephone system settings synchronization 
Running telephone system settings synchronization will read the current telephone system settings 
and enable you to view any errors or warnings related to the telephone system configuration.

NOTE: 
• In order to use Synchronization to synchronize the YourSite database with resilient, Network ACD, and 

clustered telephone systems, you must enable the SDS Directory synchronization option on all of the 
telephone systems in your enterprise.

• As a best practice, we recommend all new installations run Full synchronization to ensure the tele-
phone systems in your enterprise are synchronized with the YourSite database and that there are no 
critical telephone system programming errors.

• You must program your 3300 ICPs and perform synchronization before you can configure telephone 
system assignment form options in YourSite Explorer.

• We recommend you do not exchange the reporting number of one device with that of another device.
• Synchronization will not synchronize a device being added to the YourSite database with the telephone 

system if the device has the same reporting number as an existing device with a different dialable 
number.

• If you are synchronizing a single telephone system, agents and queues must be programmed on the 
same telephone system. Single node synchronization can disassociate agents and queues if agents 
and queues reside on separate telephone systems.

• If you are running 3300 ICP Release 9.x or earlier and you synchronized your network ACD assign-
ments and/or resilient agents using OPS Manager, you must synchronize all of the 3300 ICPs in your 
enterprise, Otherwise, agent group and queue group associations will be lost.

To perform full synchronization 
1. In YourSite Explorer, under Enterprise, click Media servers.
2. Select a 3300 ICP media server from the list.

3. Click the Telephone system tab.

4. In the ribbon, specify the settings to use with synchronization. 

See "Specifying synchronization settings".
5. In the ribbon, click Run. 

The Synchronization window opens.
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6. Select the media servers to synchronize.

7. Ensure Full synchronization is selected.

8. If this is the first time you have run synchronization, click Synchronize and continue to step 11. If you 
have already run full synchronization, click Next.

9. Optionally, select the telephone system media servers and devices to include with synchronization. 

All media servers and devices are selected by default.
10. Specify how you would like to proceed with synchronization: 

– Synchronize—selecting this option will synchronize the devices programmed on the telephone 
system and enable you to review all entries and optionally exclude any devices before committing 
them to YourSite Explorer. If you select this option, continue to step 11.

– Save settings—selecting this option will save the device settings you specified to be used for the 
next scheduled or on-demand synchronization. If you select this option, the synchronization window 
will close.

– Cancel—selecting this option will cancel the synchronization. No changes will be made to the Your-
Site database or the telephone systems. If you select this option, the synchronization window will 
close.

– Auto commit—selecting this option and clicking Synchronize will synchronize the devices 
programmed on the telephone systems and automatically commit them to YourSite Explorer. There 
will be no opportunity for you to review the entries and optionally exclude any devices before commit-
ting them to YourSite Explorer.

11. When the synchronization report displays, you have the following three options: 

– Commit—selecting this option will commit the specified changes and synchronize telephone system 
devices with YourSite Explorer.

– Cancel—selecting this option will cancel the specified changes. No devices will be synchronized 
and the synchronization window will close.

– Edit—selecting this option will rerun synchronization and enable you to modify the devices to be 
included in synchronization. If you select this option, return to step 9.

If this is the first time you have run synchronization, any telephone system errors and warnings will 
display in the synchronization report. You can correct any errors or warnings found in this report by 
clicking Edit, clicking the Telephone system settings tab and changing the telephone systems settings 
to the recommended settings. If this is not the first time you have run synchronization, the synchroni-
zation window will close once it is complete and you can review any telephone system setting errors 
and warnings on by selecting a media server in YourSite Explorer and clicking the Telephone system 
settings tab.

To perform telephone system synchronization 
1. In YourSite Explorer, under Enterprise, click Media servers.
2. Select a 3300 ICP media server from the list.

3. Click the Telephone system tab.

4. In the ribbon, specify the settings to use with synchronization. 

See "Specifying synchronization settings"
5. In the ribbon, click Run. 
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The Synchronization window opens.
6. Select the media servers to synchronize.

7. Ensure Telephone system settings is selected.

8. Click Synchronize. 

The Synchronization report window will open and display the progress and status of the synchroniza-
tion. Once synchronization is complete, any telephone system errors and warnings will display in the 
synchronization report. You can correct any errors or warnings found in this report by clicking Edit, 
clicking the Telephone system settings tab and changing the telephone systems settings to the rec-
ommended settings.

Ring Group synchronization

YourSite Explorer can synchronize Ring Groups with your telephone system, but there are several exclu-
sions. When synchronizing with the telephone system, YourSite Explorer only synchronizes with 
supported Ring Group members. Prime DNs and hot desking users are supported as members of Ring 
Groups. If your synchronization settings are set to Read, synchronization skips unsupported members on 
the telephone system when synchronizing with YourSite Explorer. If your synchronization settings are set 
to Read/Write, then synchronization will delete unsupported members during writeback to the telephone 
system.
Ring Groups and their attributes and members can be added, modified, and deleted in YourSite Explorer, 
but the following Ring Group attributes are not synchronized into YourSite Explorer:
• Local-only DN
• Ring Group Type
• Predictive Overflow
• Average Call Duration Minutes/Seconds
• Absent/Present for members

Scheduling synchronization during the nightly maintenance routine

We recommend you schedule Synchronization to run with the nightly maintenance routine to ensure the 
YourSite database and telephone system are properly programmed. If your synchronization is set to Read 
or Read/Write, synchronization will happen automatically during nightly maintenance. For more informa-
tion, see "Specifying synchronization settings".

Editing telephone system assignment forms in YourSite Explorer

After you run Synchronization for the 3300 ICP in YourSite Explorer, you can edit a subset of contact 
center related 3300 ICP System Options, SMDR Options, Class of Service, and Class of Restriction 
assignment forms. Any changes made to the telephone system assignment forms in YourSite Explorer 
are written to the telephone system when a user clicks Save.
After running synchronization, if the 3300 ICP System options, SMDR options, Class of Service options, 
or Class of Restriction assignment forms are incorrectly configured, alerts will display describing modifi-
cations that need to be made to achieve accurate telephone system settings. Alerts are ranked according 
to severity to display in the following order of importance: errors, warnings, and then informational 
messages. Only one message can display at a time in the information bar.
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In addition, you can automatically repair certain configuration errors by clicking the Fix it button in the 
information bar where errors, warnings, and information messages display. If the alert that is currently 
displayed in the information bar is not able to be resolved by the Fix it button, the button will not display. 
If the Fix it button displays, clicking it will automatically fix the warning or error that is displaying in the 
information bar as well as fixing any other current warning or error that is enabled to be automatically 
repaired.
NOTE: You must have read/write capabilities enabled in YourSite Explorer before running synchronization 
if you want to receive these alerts. See "Specifying synchronization settings".

Editing System Options

Using YourSite Explorer, you can configure access codes and select options for the ACD 2000, ACD 
Real-time Events Feature Level, and ACD Make Busy Walk Away Codes. Recommended values for 
these system options are displayed in YourSite Explorer.
To edit System Options 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Enterprise, click Media servers.

3. Under Media servers, select a 3300 ICP media server.

4. Click the Telephone system settings tab.

5. In the left pane, click System options.

6. After Feature access code for silent monitoring, type the feature access code used for silent moni-
toring, as programmed on the telephone system. 

NOTE: If you edit the feature access code on the media server, you must also manually edit the 
feature access code on the telephone system. The feature access code entered in YourSite 
Explorer must be identical to that on the telephone system and be valid for use with silent moni-
toring.

7. Specify remaining system options as required.

8. Click Save.

Editing SMDR Options

Using YourSite Explorer, you can edit a subset of contact center related SMDR options. YourSite Explorer 
displays the recommended value for these SMDR options.
To edit SMDR Options 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Enterprise, click Media servers.

3. Under Media servers, select a 3300 ICP media server.

4. Click the Telephone system settings tab.

5. In the left pane, click SMDR options.

6. Specify the SMDR options.

7. Click Save.
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Editing Class of Service options

Using YourSite Explorer, you can edit a subset of contact center related Class of Service options. Your-
Site Explorer displays the recommended value for these Class of Service options.
To edit Class of Service options 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Enterprise, click Media servers.

3. Under Media servers, select a 3300 ICP media server.

4. Click the Telephone system settings tab.

5. In the left pane, click Class of Service.

6. Under Name, select the Class of Service to edit.

7. In the right pane, after Default type, select a default class of service. Alternatively, select None and, 
after Comment, type a description for the Class of Service.

8. Specify the remainder of system options for each Class of Service.

9. Click Save.

Editing Class of Restriction options

Using YourSite Explorer, you can edit a subset of contact center related Class of Restriction options.
To edit Class of Restriction options
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Enterprise, click Media servers.

3. Under Media servers, select a 3300 ICP media server.

4. Click the Telephone system settings tab.

5. In the left pane, click Class of Restriction.

6. Under Number, select the Class of Restriction to edit.

7. After Do you want this Class of Restriction to be the default setting, click Yes or No

8. After Classes of restriction for the group, enter the Class of Restriction numbers to include in the 
group.

A range of numbers may be specified. Separate numbers using commas or dashes. For example, 1 
through 9 may be entered as 1-9 or a combination of individual numbers and ranges may be entered 
as 1,2,3,7-10,13.

NOTE: Class of Restriction numbers must be entered in ascending order within each group.
9. Click Save.

Adding resilient and/or Network ACD hot desking agents

Resiliency and network ACD functionality is configured in your Mitel telephone system. For information 
on configuring your telephone system for resilient and/or network ACD Hot Desking Agents, consult your 
Mitel telephone system documentation.
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When your telephone systems are set up correctly for resiliency and network ACD hot desking, you can 
configure your media servers in YourSite Explorer to use Hot Desking Agents. See "Adding 3300 ICP 
media servers".

Invalid ACD cluster programming

Combining traditional ACD agents and ACD Hot Desking Agents on the same telephone system is not 
supported. All media servers within a cluster must be configured with the same type of agents. If the tele-
phone systems within a cluster are configured with both ACD Hot Desking Agents and traditional ACD 
agents, agent states will not display correctly in Contact Center Client real-time monitors and you will 
receive an 'Invalid ACD cluster programming' error in YourSite Explorer.
NOTE: As a best practice, we recommend you perform Synchronization before attempting to resolve any 
invalid ACD cluster programming errors on the telephone system. This will ensure that your configuration 
is accurate and any errors being reported are valid.

Running Active Directory synchronization

You can synchronize your system with Active Directory at any time from within YourSite Explorer. Active 
Directory is a directory service created by Microsoft that is used for managing a domain. Active Directory 
Synchronization will align Active Directory security groups and users with Microsoft Skype for Business-
MiContact Center BusinessMiVoice Analytics employees and employee groups within selected organiza-
tional units.
At any time, you can optionally re-synchronize or reset all client computers running MiContact Center 
BusinessMiVoice Analytics applications and refresh them with the latest configuration changes. 
Re-synchronizing will send a delta of the latest configuration changes to client computers, while resetting 
will completely drop client computer configurations and send the latest configurations from YourSite 
Explorer.
When you run Active Directory synchronization, employees and employee groups in YourSite Explorer 
are synchronized with users in Active Directory groups. Existing employees can also be associated with 
specific Active Directory users.
To run Active Directory synchronization 
1. In YourSite Explorer, under YourSite, click Enterprise or Employees.
2. On the ribbon, click Active Directory.

3. Under Sync frequency (hh:mm), select how often you want automatic synchronization to occur.

4. Click Select Sync paths. 

The Select paths to sync window opens.
5. Click > or < to add or remove Active Directory entities from the Active Directory tree on the left to the 

selected items list on the right and click OK. 

The list of selected items on the right includes the Active Directory entities that will be synched.
NOTE: Ensure that the groups selected for synchronization contain less than 1500 members, as 
Active Directory only returns 1500 members.

6. Under Security Role, click the Browse button and select a default security role to apply to newly 
created employees.

7. Click OK.
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8. Under Sites, click the Browse button and select a default site to apply to newly created employees.

9. Click OK.

10. Click Run. 

Active Directory synchronization is initiated and pertinent information is updated in YourSite Explorer.

To send recent configuration changes to client computers 
1. In YourSite Explorer, under YourSite, click Enterprise or Employees.
2. On the ribbon, click Tools.

3. Click Re-synchronize clients.

To completely reset client computers with the latest YourSite database configuration information 
1. In YourSite Explorer, under YourSite, click Enterprise or Employees.
2. On the ribbon, click Tools.

3. Click Reset clients.

To associate an existing employee with an Active Directory user 
1. In YourSite Explorer, under YourSite, click Employee.
2. Select the employee you want to associate with an Active Directory user.

3. On the ribbon, click Active Directory.

4. Click Pick user.

5. Select a user from the Active Directory tree and click OK.

6. Click Save.

Configuring devices and device groups using Quick Setup

You can use Quick Setup to add ranges of the following devices and device groups: 
• Employee groupsand employee divisions
• Queue groups
• Extensions, extension groups, and extension divisions
• DNIS and DNIS groups
• Account Codes and Account Code groups
• Make Busy Reason Codes
• Teams

Extension Quick Setup

To add a series of extensions 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Extensions.

3. Click Quick Setup.

4. In the Active number from and Active number to boxes, type a range of device numbers.
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5. If you want to add a prefix or postfix to this range of device numbers, after Name prefix and/or Name 
Postfix type the prefix and/or postfix.

6. On the General tab, select a media server for the extension.

7. If the extension will be costed with MiVoice Analytics, select the Cost this extension check box.

8. Select the Disable real-time monitoring and data collection on this device check box if you do not 
want to enable the extension to be set with a MiTAI monitor, viewed in Contact Center Client, and use 
Contact Center Softphone. 

By default, this check box is not selected.
9. Under Advanced options, select the Extension type.

10. If you want to create an employee for each extension, on the Employee associations tab, select the 
Create an employee ID for each extension check box. 

NOTE: Select this check box only if you have not already added employee IDs to the database.
11. After Start the employee IDs at, type the first employee ID to associate to the extension number 

range.

12. After Increment the employee IDs by, type the increment by which the employee IDs will increase.

13. Click Run.

Trunk Quick Setup

To add a series of trunks 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Trunks.

3. Click Quick Setup.

4. In the Active number from and Active number to boxes, type a range of device numbers.

5. If you want to To add a prefix or postfix to this range of device numbers, after Name prefix and/or 
Name postfix type the prefix and/or postfix.

6. On the General tab, click Browse and select a media server for the trunk.

7. Click Run.

Trunk group Quick Setup

To add a series of trunk groups 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Trunk groups.

3. Click Quick Setup.

4. In the Active number from and Active number to boxes, enter a range of device numbers.

5. If you want to To add a prefix or postfix to this range of device numbers, after Name prefix and/or 
Name postfix type the prefix and/or postfix.

6. On the General tab, click the Browse button and select the voice media server associated with the 
trunk (for example, 3300 ICP Voice).
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7. If this trunk group uses an intra switch, select the Intra switch check box.

8. To  cost calls using this trunk, clear the Do not cost calls check box.

9. Click Run.

DNIS Quick Setup

To add a series of DNIS
1. Click YourSite > DNIS.
2. Click Quick Setup.

3. In the Active number from and Active number to boxes, type a range of device numbers.

4. If you want to add a prefix or postfix to this range of device numbers, after Name prefix and/or Name 
postfix type the prefix and/or postfix.

5. On the General tab, after Associate the devices to this media server, click Browse and select a 
media server.

6. After Short Abandon, type the Short Abandon threshold for the DNIS.

7. After Service Level, type the Service Level time for the DNIS.

8. Click Run.

Account Code Quick Setup

To add a series of Account Codes 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Account Codes.

3. Click Quick Setup.

4. In the Active number from and Active number to boxes, type a range of device numbers.

5. If you want to add a prefix or postfix to this range of device numbers, after Name prefix and/or Name 
postfix type the prefix and/or postfix.

6. If you want to create an employee for each Account Code, on the Employee Associations tab, select 
the Create an employee ID for each Account Code check box. 

NOTE: Select this check box only if you have not already added employee IDs to the database.
7. After Start the employee IDs at, type the first employee ID number to associate to the Account Code 

range.

8. After Increment the employee IDs by, type the increment by which the employee ID numbers will 
increase.

9. Click Run.

Make Busy Reason Codes Quick Setup

To add a series of Make Busy Reason Codes
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Make Busy Reasons.
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3. Click Quick Setup.

4. In the Active number from and Active number to boxes, type a range of device numbers.

5. If you want to add a prefix or postfix to this range of device numbers, after Name prefix and/or Name 
postfix type the prefix and/or postfix.

6. Click Run.

Team Quick Setup

To add a series of teams 
1. Click YourSite > Teams.
2. Click Quick Setup.

3. In the Active number from and Active number to boxes, type a range of device numbers.

4. If you want to add a prefix or postfix to this range of device numbers, after Name prefix and/or Name 
postfix type the prefix and/or postfix.

5. Click Run.

Device group Quick Setup

To add a series of Account Code groups, DNIS groups, employee groups and divisions, extension groups 
and divisions, and queue groups. 
1. Under Devices, click the device groupname.
2. Click Quick Setup.

3. In the Active number from and Active number to boxes, type a range of device numbers.

4. To add a prefix or postfix to the range of device numbers, after Name prefix and/or Name postfix 
type the prefix and/or postfix.

5. If you are adding an agent group, click Browse and select a media server and failover media server 
to associate with the agent group.

6. Click Run.

Configuring devices using .csv files

You can import devices to YourSite Explorer using comma-separated value (.csv) files. The following 
device types are currently supported for use with the YourSite Explorer .csv import tool: employees, 
employee groups, employee divisions, agents, agent groups, queues, queue groups, extensions, exten-
sion groups, extension divisions, trunks, trunk groups, DNIS, DNIS groups, Account Codes, Make Busy 
Reason Codes, teams, Do Not Disturb Reason Codes, traffic, and ANI.
A .csv file is used for the digital storage of data structured in a table of lists form, where each associated 
item (member) in a group is in association with others also separated by the commas or tabs of its set.
There are two ways to create .csv files: Notepad or Microsoft Excel. We recommend making .csv files in 
Excel, as adding and editing a large number of entries at once using auto-fill functions is much simpler 
and more convenient than using Notepad.
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Alternatively, you can also import tabbed delimited text files created in Excel. Tabbed delimited text files 
are almost identical to .csv files, but use tabs to differentiate data fields instead of commas.
NOTE: When creating .csv files, you must save the file as either a .csv or .txt file. Simply renaming an Excel 
file or changing a file type extension to .csv will not work and you will be unable to import device data into 
YourSite Explorer.
The following figures provide two examples of how .csv files can be formatted. The following figures 
display Microsoft Excel .csv formatting and Notepad .csv formatting. Both .csv examples contain the 
following data: first name, last name, agentlogin ID, and media server.
NOTE: To import configuration options that display in the YourSite Explorer grid view as a check box, you 
must enter True or False as the field data.

Figure 7.3: Microsoft Excel .csv formatting example
 

Figure 7.4: Notepad .csv formatting example

Importing a range of devices using a .csv file

Before you attempt to import a device using a .csv file, ensure
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• The .csv file contains data for all of the fields required to save a device in YourSite Explorer as detailed 
in the following table.

• If a device requires a dependency to be specified, for example specifying a media server is required 
in order to save a queue, the dependency must already exist in YourSite Explorer. The Import Wizard 
cannot create new dependencies and will fail if the dependency does not already exist in the database.

To import a range of devices using a .csv file
1. In YourSite Explorer, under Devices, click the name of the device you will add using a .csv file.
2. Click Import.

3. After Select file type, specify whether the .csv file uses Comma separated values or Tab separated 
values.

4. After Select file, click Browse and specify the location of the .csv file.

5. Under Options, specify how the Import Wizard will handle duplicate items.

If duplicates are found:
– Overwrite entries if duplicates are found will use the .csv file as the master and overwrite dupli-

cate entries in the YourSite database with data in the .csv file.
– Skip duplicate entries during import will retain data configured in YourSite Explorer as the master 

and import any new data entries from the .csv file into the YourSite database.
– Do not import if duplicates are found will scan the .csv and YourSite database for duplicates. If 

duplicates are found in either the .csv or the YourSite database, the import is cancelled and no data 
is imported to the YourSite database.

6. Click Next.

7. On the Field Mappings window, map the fields in the Available columns list to the Selected 
columns list using the arrow buttons, so they display in the same order as they do in your .csv file.

NOTE: The order in the Field Mapping window must match the order of fields in your .CSV file. Failure 
to import data in the order specified will result in import errors.

8. Click Next.

9. When the import has completed, click Finish.

NOTE: If the import fails, the Import Wizard will notify you of whether the YourSite database or .csv 
file contained the duplicate(s) and which row(s) of the .csv file contained the error(s) that resulted in 
the failure. Fixing these errors will allow devices to be successfully imported.

Fields required for successful .csv imports

The following table details the fields that are required in order to successfully import devices into YourSite 
Explorer using a .csv file.
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Table 7.1: Mandatory device fields for .csv imports  (Sheet 1 of 3)

Device Mandatory fields fields

Employees Reporting number, 
Last name, First 
name, Username, 
Password, Security 
role

Reporting number, Last name, First 
name, Username, Password, 
IsEnabledForVoice, 
IsEnabledForEmail, 
IsEnabledForChat, 
IsEnabledForSMS, 
IsEnabledforOpenMedia, Email 
address, Middle name, Suffix, 
Scheduling license, Nickname, Full 
time, Site, Is a supervisor, 
Activated, Supervisor, Security role, 
Use employee email for report 
distri…, Fax number, Hire date, 
Preferred printer, Birth date, Print 
locally, Business phone number, 
Emergency contact phone number, 
Emergency contact relationship, 
Emergency contact name, Country, 
ZIP or postal code, Street address, 
City, State or province, Pager 
number, Phone number, Is active, 
Supervisor license, Phone type 
license, MiVoice Analytics Client 
License, Licensed for Multimedia 
Contact Center, Licensed for 
Screen Pop

Employee groups Name, Reporting 
number

Name, Reporting number

Employee divisions Name, Reporting 
number

Name, Reporting number

Agents Reporting number, 
Last name, First 
name, Media 
server, Real time, 
Class of Service, 
Class of 
Restriction

Reporting number, Last name, First 
name, Media server, Failover media 
server, Employee, Real time, MiTAI 
enabled, Is active, Class of Service, 
Class of Restriction

Agent groups Name, Reporting 
number

Name, Reporting number, Failover 
media server, Real time, Voice, 
Chat, Email, SMS, Open Media, 
Employee Reporting
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Queues Dialable number, 
Name, Reporting 
number, Media 
server, 
Business-hour 
schedule

Dialable number, Name, Reporting 
number, Queue Type, Media server, 
Service Level goal, Short Handle, 
Real time, MiTAI enabled, Short 
Abandon, Service Level, Is active, 
Include work timer to handling time, 
Enable Classification Codes, 
Wrap-up time enabled, Wrap-up 
time expiry, Agent Group Member 
1, Agent Group Member 2, Agent 
Group Member 3, Agent Group 
Member 4

Queue groups Name, Reporting 
number

Name, Reporting number, Is Virtual

Extensions Name, Reporting 
number, Media 
server

Name, Reporting number, 
Extension type, Media server, 
Failover media server, Server 
Name, Workflow, Real time, MiTAI 
enabled, Licensed, Notes

Extension groups Name, Reporting 
number

Name, Reporting number

Extension divisions Name, Reporting 
number

Name, Reporting number

Trunks Name, Reporting 
number, Media 
server

Name, Reporting number, Media 
server

Trunk groups Name, Reporting 
number

Name, Reporting number, Media 
server, Do not cost calls, Carrier 
plan, Intra switch

DNIS Name, Reporting 
number, Media 
server

Name, Reporting number, Media 
server, Short Abandon, Service 
Level, Carrier plan, Call type, Call 
rate, Subscriber plan, Subscriber 
Call type, Subscriber Rate

DNIS groups Name, Reporting 
number

Name, Reporting number

Account Codes Name, Reporting 
number

Name, Reporting number, Use as 
Classification code

Table 7.1: Mandatory device fields for .csv imports (Continued) (Sheet 2 of 3)

Device Mandatory fields fields
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Configuring devices manually

CAUTION: 
• For reporting purposes, the trunk, extension, agent, agent group, queue, DNIS, dialable numbers, and 

Account Code numbers you configure in the YourSite database must be identical to those of the tele-
phone system.

• Print a copy of your telephone system assignment forms to use as a guide for programming YourSite 
Explorer. The numbers you enter in YourSite for extensions, trunks, and Account Codes must be iden-
tical to those of the telephone system.

You add contact center devices manually in YourSite Explorer.
NOTE: 
• When you configure numbers for groups in YourSite, use numerical characters only, such as 1 (for 

Queue group 1). Do not insert symbols, such as a star [*] or pound sign [#], in the number.
• If you attempt to add a device or device group to YourSite that is already in the database, the system 

notifies you that the device or device group is already present. When you add a series of devices or 

Make Busy Reason Codes Name, Reporting 
number

Name, Reporting number

Teams Name, Reporting 
number

Name, Reporting number

Do Not Disturb Reason Codes Name, Reporting 
number

Name, Reporting number

Traffic Reporting number, 
Name

Pkey, Reporting number, Name, 
Media server, Traffic Type

ANI Name, Ani Name, Ani

Call types Name Name

Rates Name Name, Cost boundary percent 
surcharge, cost boundary duration, 
Boundary crossing surcharge, 
Surcharge per call, Round to cost 
interval, CostPerMinute, 
CostInterval, FirstCost, 
FirstCostInterval, 
SubsequentCostIncrement, 
SubsequentCostInterval

Subscribers Name, Reporting 
number

Name, Reporting number, 
Subscriber plan

Subscriber groups Name, Reporting 
number

Name, Reporting number

Table 7.1: Mandatory device fields for .csv imports (Continued) (Sheet 3 of 3)

Device Mandatory fields fields
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device groups to YourSite, such as agent groups 5001 to 5005, if the system detects you have already 
added agent group 5002, then it will not add agent group 5002 or any subsequent agent groups in the 
series (that is, agent group 5003 to 5005) to the database.

Adding employees

Every employee configured in YourSite Explorer represents a unique member of a contact center. 
Employees handling interactions are configured with agents. These agents are tied to the media servers 
supported by MiContact Center Business.
You must add all contact center employees (agents, supervisors, and administrators) to YourSite Explorer 
so you can run reports on employee activities, view employee performance in real time, and enable 
employee access to MiContact Center Business applications.
NOTE: You must assign each employee a unique ID number.
Adding an employee requires you to: 
• Add an employee
• Configure general employee information 

See "Configuring general employee information".
• Manage the media types an employee can handle 

See "Managing the media types an employee can handle".
• Configure employee licensing 

See "Configuring Employee Licensing".
• Modify employee Workload 

See "Adding employee Workload".
NOTE: Modifying employee Workload is only required if the employee is licensed for Multimedia 
Contact Center.

Optionally, you can: 
• Manage employee extensions and Account Codes
• Configure employee Skype for Business settings 

Skype for Business attributes are only visible if you have a Microsoft Skype for Business Server in-
stalled.
See "Configuring employee skype for business settings".

• Configure employee report distribution settings 
See "Configuring employee report distribution settings"

• Configure employee personal information 
See "Configuring employee personal information".

• Configure employee scheduling preferences for Workforce Scheduling 
See "Configuring employee scheduling preferences".

To add an employee 
1. Click YourSite > Employee.
2. Click Add. 

Continue to "Configuring general employee information".

Configuring general employee information

The following procedures explain how to: 



96

CONFIGURING THE YOURSITE DATABASE
CHAPTER 7 CONFIGURATION

• Configure general information for an employee
The following procedures take place in YourSite > Employee.
To configure general information for an employee 
1. Select an employee and click the General tab.
2. After First name, type the employee’s first name. 

NOTE: Changes to the first name will carry over to any of the employee's associated agents and 
extensions.

3. After Last name, type the employee’s last name. 

NOTE: Changes to the last name will carry over to any of the employee's associated agents and 
extensions.

4. After Employee ID, enter a unique employee ID number for the employee. 

NOTE: The system creates default employee IDs for newly added employees, starting with ‘0’ and 
incrementing for each new employee

5. After Line URI, type the employee's Line URI. 

NOTE: If you enable an employee for voice without manually entering a Line URI, the system copies 
the Employee ID to the Line URI field. This will be the employee’s SIP address. If you manually enter 
a Line URI before enabling an employee for voice, the Line URI entered will be the employee’s SIP 
address.

6. After Email, enter the employee’s email address. 

NOTE: If the employee will use Contact Center Chat with Skype for Business, you must enter the 
Skype for Business SIP email address in the email field.

7. Enter the employee’s Username. 

NOTE: 
– By default, the Username field will be populated with the employee’s email, unless you are using 

Windows Authentication.
– In an environment with both a FQDN and NetBIOS name, the employee username that displays in 

YourSite Explorer is the domain name and may not match the NetBIOS name that employees use 
to log into Contact Center applications.

8. Enter the employee’s Password.

9. If you want to change the site the employee is associated with, after Site, click the Browse button. 

NOTE: 
– The default site assigned to new employees can be changed in the Configuration tab of YourSite 

Explorer.
– The site determines the employee’s default language. Employees can change their language 

settings in CCMWeb.

10. Select a site and click OK.

11. After Security role, click the Browse button. 

The default Local Administrator and Enterprise Administrator roles allow employees full access to all 
of the MiContact Center Business applications and devices (to which the contact center is 
licensed) including Write Back for synchronization.
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The default Agent Role role allows employees access to Contact Center Client, Employee Portal, and 
Ignite. This role also enables access to real-time monitors, monitor customization, access to Contact 
Center Chat, and the ability to control their own real-time presence and status.

NOTE: The default security role applied to new employees can be changed in the Configuration tab 
of YourSite Explorer.

12. Select a security role and click OK.

13. Click Save.

Managing the media types an employee can handle

Employees handle media through their associated agents. The General tab of an employee contains 
buttons representing each media type that has a configured media server. When a button is selected, an 
agent of that media type is automatically created and associated to the employee. The following table 
contains an explanation of which buttons correspond to which media type.

NOTE: Employees must be licensed to handle non-voice media. See "Configuring employee 
licensing"and  "Licensing requirements for employee multimedia capabilities".
When you remove the employee's ability to handle non-voicemedia, the employee's agents are made 
historical. Historical agents are disabled for real-time monitoring and data collection. If the employee is 
re-enabled to handle thatnon-voice media, then their agent will be made active again. Multimedia agents 
can be deleted to be removed entirely from the system.

Table 7.2: Media Buttons

MEDIA TYPE MEDIA BUTTON

Voice

Chat

Email

SMS

Open Media
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NOTE: Failover media servers for voice agents must be configured on your telephone system and synchro-
nized into YourSite Explorer. Workgroup does not support Contact Center resiliency. You cannot program 
failover media servers for ACD agents and extensions.
The following procedures explain how to: 
• Enable an employee to handle voice media
• Edit an employee’s voice agent
• Enable an employee's voice agent for external hot desking
• Enable an employee to handle voice media using an existing agent
• Remove a voice agent from an employee
• Enable an employee to handle multimedia
• Remove an employee's ability to handle multimedia
• Delete a multimedia agent

The following configuration takes place in YourSite > Employees.
To enable an employee to handle voice media 
1. Select an employeeand click the General tab.
2. Under Devices, click the Voice button 

A voice agent and extension are automatically created for the employee.
By default, the extension type is voice softphone, which emulates a 5020 IP set.
For information on configuring extensions for employees, see Managing employee extensions and 
Account Codes for employees
By default, the extension reporting number/dialable is populated with the employee’s business phone.

3. Optionally, change the agent’s First name.

4. Optionally, change the agent’s Last name.

5. Optionally, after Agent login ID, enter the reporting number for the voice agent.

6. After Media server, click the Browse button.

7. Select a media server and click OK.

8. If you want to disable real-time monitoring and data collection for this agent, select Disable real-time 
monitoring and data collection on this device.

9. If a 3300 media server was selected, after COS, select a Class of Service from the list.

10. If a 3300 media server was selected, optionally, after COR, select a Class of Restriction from the list.

11. Select a media server and click OK.

12. Click Save.

13. Click Save.

To edit an employee’s voice agent 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside the Voice button and click <agent ID> > Edit.

3. Edit the agent’s fields.

4. Click Save.
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5. Click Save.

To enable an employee’s voice agent for external hot desking 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside the Voice button and click <agent ID> > Edit.

3. Select External hot desk user enabled.

4. After External dialing prefix, type the dialing prefix for the device to which calls will be routed.

5. After External dialing number, type the dialing number for the device to which calls will be routed.

6. Click Save.

7. Click Save.

To enable an employee to handle voice media using an existing agent 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside the Voice button and click Associate existing voice 

agent.

3. Select an unassigned agent and click OK.

4. Click Save.

To remove a voice agent from an employee 
1. Select an employee and click the General tab.
2. Click the down arrow beside the Voice icon and click <agent ID> > Delete.

3. Select the delete option: 

– Make the device historical—sets the agent as historical, but leaves it associated to this employee
– Disassociate the device—disassociates the agent so it can be used with another employee
– Remove the device from the system—deletes the agent

4. Click OK.

5. Click Save.

To enable an employee to handle multimedia 
1. Select an employee.
2. Under Devices, click the media button to select which media this employee can handle.

3. Click Save.

To remove an employee's ability to handle multimedia 
1. Select an employee.
2. Under Devices, click the enabled media button.

3. Click Save.

To delete a multimedia agent 
1. Select an employee.
2. Click the down arrow beside the media button and click Delete.

3. Click Save.
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Configuring employee licensing

Employees have access to the features and components of the starter pack with which they are affiliated, 
but can be restricted, using security role settings, from accessing any or all of these applications.
Employees consume a Contact Center or Workgroup Agent voice license when enabled to handle voice. 
Employees consume a Multimedia Agent license when they are enabled to handle non-voice media 
types. Licenses are removed when an employee’s ability to handle a media type is removed.
Licensed employees are reported on historically, viewed in real time, and have access to real-time moni-
tors. Employees also have access to CCMWeb My options page to configure user options, such as 
language preference.
CAUTION: If data exists for an employee who was previously licensed but is currently unlicensed, that data 
can be accessed in reports. However, if a summarization is done after the employee is no longer licensed, 
there is a risk that the statistics currently calculated for the employee could be lost. Re-licensing the 
employee and performing a summarization will restore the statistics.
The following configuration takes place in YourSite > Employee.
To configure employee licensing 
1. Select an employee and click the Licensing tab.
2. If the employee is a supervisor, depending on licensing, under Supervisor license select from None, 

Advanced supervisor, or System Administrator. 

Only one type of supervisor license can be selected for each employee.
– None: use this option for employees who are agentsor general business extensions.
– Advanced supervisor: has access to CCMWeb (reporting, user preferences, and help resources), 

Contact Center Client (real-time monitoring), Ignite (search for interactions, view statistics, view 
interactions in queue), and YourSite Explorer (read-only access to the Enterprise section only). 
Advanced Supervisor abilities are determined by their employee and security role settings (as 
configured in YourSite Explorer). An Advanced Supervisor can be configured for supervisory duties 
only or can be enabled to also work as an agent. If an Advanced Supervisor is associated to a config-
ured extension, their telephone status is visible in extension monitors. 

NOTE: Supervisors requiring the ability to handle interactions in Ignite or search interactions in 
queue must be enabled to handle those media types. See "Managing the media types an 
employee can handle".

– System Administrator: has full access to all MiContact Center Business,MiVoice Analytics, Multi-
media Contact Center, and IVR Routing software for the purposes of configuration and system 
administration.

3. Under Phone type license, depending on licensing, select a phone type license. 

– Mitel desk phone: select this option if the employee will use a Mitel desk phone. This is the default 
option.

– Soft phone and/or Mitel desk phone: select this option if the employee will use and is licensed for 
Contact Center Softphone. 

NOTE: If the employee requires the use of Contact Center Softphone in addition to or in combi-
nation with a Mitel desk phone, select the Softphone phone type. If the employee is a Non ACD 
employee, you must select 'MiVoice Analytics Client license' to have access to Contact Center 
Softphone functionality. MiVoice Analytics Client license is an optional add-on to Contact 
Center and Workgroup.
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4. If you want the employee to be licensed for Workforce Scheduling, under Workforce Scheduling 
license, select Workforce Scheduling license. 

NOTE: Users must be licensed for Voice or Multimedia to be scheduled in Workforce Scheduling.
5. If this employee is a Non ACD employee who needs access to Contact Center PhoneSet Manager, 

CTI Developer Toolkit Client, Salesforce.com Client, or screen pop, select Business Reporter Client 
license. 

NOTE: MiVoice Integration for Salesforce is required to activate Salesforce.com Client.
6. Click Save.

Managing Employee Workload

Employees handling multimedia interactions must be associated with a Workload. Workloads determine 
the number and type of media interactions that can be pushed to an agent at any one time. When 
employees become licensed for Multimedia Contact Center, they are automatically assigned the default 
Workload, which allows concurrent handling of 1 interaction from each media type. For more information 
on Workloads, see Multimedia Contact Center Installation and Deployment Guide.
The following configuration takes place in YourSite > Employee.
The following procedures explain how to: 
• Associate a Workload to an employee
• Associate a new Workload to an employee
• Edit an existing Workload
• Delete a Workload 

NOTE: We recommend disassociating a Workload from all employees before deleting it.

To associate a Workload to an employee 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Select a Workload. 

Alternatively, if you want to create a new Workload to associate to the employee, click Add.
4. Click OK.

5. Click Save.

To associate a new Workload to an employee 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Click Add.

4. Type a Name for the Workload.

5. To apply the Workload to outgoing voice calls, select Apply rule to outgoing voice calls.

6. For each media type, under Concurrent contacts, select the maximum number of connections of that 
media type that can be handled concurrently.

7. For each media type, click the icons of the media you do not want employees to concurrently handle 
when handling that type of media. 
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NOTE: If you do not want agents to receive multiple ringing interactions of different media types, 
configure this option.

8. Click Save.

To edit an existing Workload 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Select a Workload and click Edit.

4. When you are done modifying the Workload, click Save.

To delete a Workload 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Click Delete.

4. Click OK.

Managing employee extensions and Account Codes

You can optionally assign extensions andAccount Codes to employees. If you are using MiVoice 
Analytics, Account Codes assigned to employees enable reporting on that Account Code to see the 
outbound costs associated to that employee. Account Codes can only be associated to one employee.
The following procedures explain how to: 
• Create a new extension and associate it with the employee
• Associate an existing extension
• Edit an existing associated extension
• Create an Account Code to associate to the employee
• Associate an existing Account Code
• Edit an existing associated Account Code

The following configuration takes place in YourSite > Employee.
To create a new extension and associate it with the employee 
1. Select an employee and click the General tab.
2. Under Devices, click the Extension button. 

Alternatively, click the down arrow beside Extension and click Add.
3. To configure the new extension, see "Adding extensions". 

The extension name is automatically populated with the employee’s name.
By default, the extension type is voice softphone, which uses a 5020 IP set.
By default, the extension reporting number/dialable is populated with the employee’s business phone.

4. Click Save.

To associate an existing extension 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside Extension and select Associate existing.

3. Select an extension and click OK.
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4. Click Save.

To edit an existing associated extension 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside the Extension button and click <extension> > Edit.

3. When you are finished editing the extension, click Save.

4. Click Save.

To create an Account Code to associate to an employee 
1. Select an employee and click the Devices tab.
2. Click the Account Code button.

3. If you want to change the Account Code name, type a Name.

4. If you want to change the Account Code reporting number, type the Reporting number.

5. If you want to use this Account Code as a Classification Code, select Use as a Classification Code.

6. Click Save. 

If this is a new employee, when you are done assigning Non ACD extensions or Account Codes, con-
tinue to "Configuring employee personal information (in YourSite Explorer)".

To associate an existing Account Code 
1. Select an employee and click the Devices tab.
2. Click the down arrow beside Account Code and select Associate existing.

3. Select an Account Code and click OK.

4. Click Save. 

If this is a new employee, when you are done assigning Non ACD extensions or Account Codes, con-
tinue to "Configuring employee personal information (in YourSite Explorer)".

To edit an existing associated Account Code 
1. Select an employee and click the Devices tab.
2. Click the down arrow beside the Account Code button and click <Account Code> > Edit.

3. When you are finished editing the Account Code, click Save.

4. Click Save. 

If this is a new employee, when you are done assigning Non ACD extensions or Account Codes, con-
tinue to "Configuring employee personal information (in YourSite Explorer)".

Configuring employee Skype for Business settings

The following procedures explain how to: 
• Configure Skype for Business attributes for an employee 

NOTE: Skype for Business attributes are only visible if you have a Microsoft Skype for Business 
Server installed.

The following procedures take place in YourSite > Employee.
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To configure Skype for Business attributes for an employee 
1. Select an employee and click the General tab.
2. Type the employee’s SIP address.

3. Type the employee’s Line URI.

4. Click Save.

Configuring employee report distribution settings

Optionally, you can configure employee report distribution settings to use non-default settings and enable 
local printing.
The following procedures take place in YourSite > Employee.
To configure an employee’s report distribution
1. Select an employee and click the Advanced tab.
2. If you want reports sent to a printer that is not the default printer of the Enterprise Server, type the file 

path of the Network printer.

The printer path name is case sensitive.
3. If you want the employee’s reports to print from their desktop printer, select Print reports to desktop.

NOTE: If you want to print locally, the employee must be running Contact Center Client on their 
personal computer and the desktop printer must be the default printer on that computer.

4. If you want to use the employee’s email address for report distribution, select Distribute reports from 
employee.

NOTE: By default, the From address assigned to the mail server is used.
5. Click Save.

Configuring employee personal information

The following procedures explain how to: 
• Configure employee personal information
• Change employee language

The following procedures take place in YourSite > Employee.
To configure employee personal information 
1. Select an employee and click the Profile tab.
2. Enter the employee's personal information in the relevant fields. 

NOTE: 
– In Multimedia Contact Center, nicknames may be used in chat sessions with customers.
– Optionally, after Activated, enter the date the employee became an active part of the enterprise. By 

default, the activated date is set to the date the employee was first added to YourSite Explorer. 
You must provide the date the employee became an active part of the enterprise if you want to gen-
erate administrative employee reports, or if you have Workforce Scheduling and will schedule em-
ployees based on seniority, or will manage time off entitlements and business rules based on time 
off allocation.

3. Click Save.
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To change employee language 
1. Select an employee and click the Profile tab.
2. Select a language from the Language drop-down menu. 

NOTE: MiContact Center Business applications, such as YourSite Explorer and Contact Center 
Client, all leverage the language settings of the operating system in addition to the language pref-
erence set for MiContact Center Business. Ensure that if you change the language settings of 
MiContact Center Business, you also change the language settings of their operating system to 
match.

3. Click Save.

Adding employee groups

After adding employees, you add employee groups and associate employees to these groups. Employee 
groups enable you to report on specific groups of employees.
The following procedures explain how to: 
• Add an employee group
• Associate an employee with an employee group
• Remove an employee from an employee group

To add an employee group 
1. Click YourSite > Employee groups.
2. Click Add.

3. Type the employee group’s Name.

4. Type the Employee group ID.

5. Click Save.

To associate an employee with an employee group 
1. Click YourSite > Employee groups.
2. Select an employee group from the list.

3. On the Membership tab, under Available members, select an employee and click > to move the 
employee to the Selected members list.

4. Click Save.

To remove an employee from an employee group 
1. Click YourSite > Employee groups.
2. Select an employee group from the list.

3. On the Membership tab, under Selected members, select an employee and click < to move the 
employee to the Available members list.

4. Click Save.

Adding employee divisions

A division is composed of several employee groups. The Division tab shows the employee groups that 
belong to the division currently selected. When you create employee divisions in YourSite, you 
can run reports for several employee groups simultaneously.



106

CONFIGURING THE YOURSITE DATABASE
CHAPTER 7 CONFIGURATION

To add an employee division 
1. Click YourSite > Employee Divisions.
2. Click Add.

3. Type a Name and Reporting number for the employee division.

4. On the ribbon, click Save.

To associate an employee group with an employee division 
1. Click YourSite > Employee Divisions.
2. Select an employee division from the list.

3. On the Membership tab, under Available members, select an employee group and click > to move 
the employee group to the Selected members list.

4. On the ribbon, click Save.

Adding agents

Agent IDs enable employees to handle different media and to be reported on and tracked in real time. 
When an administrator enables an employee to handle a type of media, the employee has an agent ID of 
that media type automatically created. A contact center employee can have multiple voice agent IDs, but 
requires a unique agent ID for each of the other media types (email, chat, SMS, and open media) that 
they handle.
Voice and multimedia agent IDs are added in the Employee section of YourSite Explorer. To add different 
media agent IDs to an employee, see "Managing the media types an employee can handle". It is recom-
mended to create agents within the Employee section. Voice agents can be created in the Agent section 
of YourSite Explorer, but must be associated to employees in the Employee section of YourSite Explorer.
The Agent section also enables administrators to delete agent IDs. Deleting an active agent removes an 
employee's capabilities to handle the corresponding media. Historical multimedia IDs can only be deleted 
in the Agent section.
NOTE: 
• If agents are in a non-SDS clustered environment but not hot desking and not resilient, the agent 

names will not display on the telephone switch. You must enter these agent names outside of YourSite 
Explorer.

• We recommend you configure Hot Desking Agents for your contact center instead of traditional agents.
• Failover media servers for voice agents must be configured on your telephone system and synchro-

nized into YourSite Explorer. Workgroup does not support Contact Center resiliency. You cannot 
program failover media servers for ACD agents or extensions.

In order to provide Contact Center Work Timer functionality in Contact Center Client, every traditional 
agent’s extension or every Hot Desking Agent ID must be enabled with a MiTAI monitor.
In YourSite > Agents, administrators 
• Add voice agent IDs
• Delete agent IDs
• Associate unassociated voice agent IDs to employees
• Specify 3300 ICP Class of Service, Class of Restriction, and Failover media server options for voice 

agent IDs
• Enable a voice agent for external hot desking 
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See "Enabling external hot desk agents".

To add a voice agent ID 
1. Click YourSite > Agents.
2. Click Add.

3. Type the voice agent ID's First name.

4. Type the voice agent ID's Last name.

5. After Agent login ID, enter the reporting number for the voice agent ID.

6. After Media Server, click the Browse button.

7. Select a media server and click OK.

8. Click Save. 

NOTE: The Disable real-time monitoring and data collection on this device check box is automatically 
selected if the employee that is associated to this agent has their licensing attribute set to 'None'. See 
"Configuring employee licensing" for more information.
To configure 3300 ICP options for a voice agent ID 
1. Click YourSite > Agents.
2. Select an agent from the list.

3. Under 3300 ICP Options, after COS, select a Class of Service from the list.

4. After COR, select a Class of Restriction from the list.

5. Click Save.

To enable a voice agent for external hot desking 
1. Click YourSite > Agents.
2. Select an agent from the list.

3. Select External hot desk user enabled.

4. After External dialing prefix, type the dialing prefix for the device to which calls will be routed.

5. After External dialing number, type the dialing number for the device to which calls will be routed.

6. Click Save.

To delete an agent ID 
1. Click YourSite > Agents.
2. Select an agent.

3. Click Delete.

4. Click OK.

Enabling external hot desk agents

External hot desk agents can work remotely using, for example, a standard PSTN analog telephone or a 
cellular telephone. External hot desk agents are similar to regular hot desk agents with additional config-
uration available to specify external number information. To access external hot desk agent functionality 
you must configure the following options in the User and Device Configuration form for the 3300 ICP:
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• External Hot Desking Enabled: Select 'Yes' to enable external hot desk agent functionality.
• External Hot Desking Dialing Prefix: Type the prefix digit(s) required to dial out to the external hot 

desk device.
• External Hot Desking Number: Type the telephone number of the external hot desk device. This 

number will be used by the telephone system to route ACD calls to the external hot desk agent.
NOTE: The combined length of the external dialing prefix and external number cannot exceed 26 
digits.

An agent ID can be associated to only one external dialing number. If an external hot desk agent will use 
more than one external device for handling calls they must be associated to one agent ID for each 
external dialing number.
An external hot desk agent can either log in externally or internally. When they log in internally (locally) 
the telephone system recognizes them as a standard hot desk agent. When they log in externally the tele-
phone system recognizes them as an external hot desk agent.
NOTE: External hot desk agent functionality is only supported for use with hot desk agents, not traditional 
ACD agents.
The following options are available for external hot desk agent login:
• Log in locally from a MiNET phone: agent displays as a regular hot desk agent
• Log in locally from an analog, cellular, or MiNET phone and connect through a loopback trunk: agent 

displays as an external hot desk agent
• Log in externally from an analog or cellular phone: the agent ID is registered as an external pivot device 

number and the external number dialing that has been configured in the telephone system is overlaid 
on this external pivot device number. The external number is then used by the telephone system to 
deliver ACD calls to the external hot desk agent. The agent displays as an external hot desk agent.

NOTE: An external hot desk agent can also log in externally by directly contacting a specific trunk config-
ured for this purpose. In this case, the agent would not need to log in via Contact Center Client. For more 
information, log into Mitel Edocs, open the Mitel Communications Director System Administration Help 
Tool, and browse to 'External Hot Desking - Operation'.

Adding agent groups

Administrators must add agent groups to the YourSite database and associate employees to these agent 
groups. An employee and their agents can be associated to more than one agent group.
When agent groups are created, an employee’s agents are assigned a default group presence, either 
Present or Absent. An additional default group presence option (Last Known) is available for the voice 
agents on MiVoice Business platform. Employees whose agents’ default presence is Absent will not be 
present in the agent group after logging in their agents. To handle that media type, the employee must 
change their agent state manually in Contact Center Client orIgnite. Employees whose agents’ default 
presence is Present will be present in the agent group when they log in.
NOTE: 
• If you attempt to add a group to YourSite that is already in the database the system notifies you that 

the group is already present. When you add a series of groups to YourSite, such as Agent Groups 1 
to 5, if the system detects you have already added Agent Group 3, then it will not add Agent Group 3 
or any subsequent agent groups in the series (that is, Agent Group 4 or 5) to the database.

• Deleting an agent group that is currently the last member of a voice or multimedia queue will invalidate 
that queue. Deleting an agent group that is associated to an activity in an Inqueue workflow will create 
a validation error. The queue will not be able to be saved until another agent group is associated to it. 
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It is recommended that you disassociate agent groups from queues and their associated Inqueue 
workflows before deleting the agent group.

• If you want to remove Voice handling from an agent group previously enabled to handle Voice, you 
must delete the agent group, writeback the deletion to the voice media server, and then recreate the 
agent group.

To set up an agent group, administrators must: 
• Add an agent group
• Manage agent group membership, presence, and skill level
• Specify agent group options for the 3300 ICP media server

The following procedures explain how to: 
• Add an agent group
• Disable monitoring and device collection for an agent group
• Specify if the agent group uses skills

The following configuration takes place in YourSite > Agent groups.
To add an agent group 
1. Click Add.
2. Type a Name for the agent group.

3. Type a Reporting number for the agent group.

4. Select the media type(s) the agent group will handle. 

See the following table.
Table 7.3: Media icons  (Sheet 1 of 2)

Media Type Media Icon

Voice

 

Chat

Email

SMS
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5. If you select voice media and have multiple voice media servers, select the voice media server and 
click OK. 

NOTE: If this agent group is not handling voice interactions, then this option will not be available.
6. Click Save.

To disable monitoring and device collection for an agent group 
1. Select an agent group.
2. Select Disable real-time monitoring and data collection on this device.

3. Click Save.

To specify if the agent group uses skills 
1. Select an agent group.
2. Select The group uses skills.

3. Click Save.

Managing agent group membership, presence, and skill level

After configuring an agent group, administrators must associate employees to the agent groups and 
specify the default presence for each of the employee’s agent IDs for the media types the agent is config-
ured to handle. If the agent group uses skills, skill levels must be set for each employee. Skill levels range 
from 1, which is the most skilled, to 255, which is the least skilled. The skill level assigned to the employee 
is applied to each media the employee is capable of handling.
Some employees may have multiple voice agents associated to them. When these are added to an agent 
group, they are highlighted in yellow. Administrators can select which of an employee’s voice agents are 
in the agent group. It is recommended that an employee only have one voice agent associated to an agent 
group.
The following procedures explain how to 
• Add employees to an agent group
• Specify which of an employee’s multiple voice agents are in an agent group
• Specify a member's default presence in an agent group
• Specify a member's skill level
• Edit a member employee
• Remove a member from an agent group

The following configuration takes place in YourSite > Agent groups.
To add employees to an agent group 
1. Select an agent group and click the Membership tab.
2. To add employees to the agent group, click Add.

Open Media

Table 7.3: Media icons (Continued) (Sheet 2 of 2)

Media Type Media Icon
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3. Select the employees to add to the agent group and click OK.

4. Click Save.

To specify which of an employee’s multiple voice agents are in an agent group 
1. Select an agent group and click the Membership tab.
2. Select the employee with multiple voice agents click Voice agent options.

3. Select the voice agent to be present in this agent group and click OK.

4. Click Save.

To specify a member’s default presence in the agent group 
1. Select an agent group and click the Membership tab.
2. In the Default <media type> Presence column of the member's row, click the cell and select the 

default presence. 

– Absent—the employee’s agent ID will be put into the Logged in Not Present agent state when they 
join the agent group.

– Present— the employee’s agent ID will be put into Idle when they join the agent group.
– Last Known— the employee’s voice agent ID will be put into the state that was last set on the PBX. 

NOTE: This additional default group presence option is only available for the voice agents on 
MiVoice Business platform.

3. Repeat Step 2 for each media type the member can handle in the agent group.

4. Click Save.

To specify a member’s skill level 
1. Select an agent group and click the Membership tab.
2. In the Skill level column of the member's row, select a skill level from the drop-down list.

3. Click Save.

To edit a member employee 
1. Select an agent group and click the Membership tab.
2. Select an employee and click Edit.

3. When you are done editing the employee, click Save.

To remove a member 
1. Select an agent group and click the Membership tab.
2. Select a member and click Delete.

3. Click Save.

Specifying 3300 ICP options for agent groups

The following configuration takes place in YourSite > Agent groups.
Tospecify 3300 ICP options for an agent group
1. Select an agent group from the list.
2. Click the 3300 ICP options tab,

3. After Failover media server, click Browse.
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4. Click OK.

5. After Queue callers to this group when no agents are logged in, select Yes or No.

6. Click Save.

Adding teams

After adding agent groups, you can add teams and associate agent groups to these teams.
To add teams
1. Click YourSite > Teams.
2. Click Add.

3. Type a Name and Reporting number for the team.

4. Click Save.

Associating agent groups to teams

To associate agent groups to teams
1. Click YourSite > Teams.
2. Select a team from the list.

3. On the Membership tab, under Available members, select an agent group and click > to move the 
agent group to the Selected members list.

4. On the ribbon, click Save.

Adding queues

Voice queues receive inbound calls and then route them to either agents or extensions, depending on the 
kind of queue. Voice queues can be ACD paths, referred to as voice queues in YourSite Explorer, that 
route calls to agent groups, or Ring Groups, which route calls to a pool of extensions.
Non-voice multimedia queues receive inbound interactions, such as voice, email, chat, SMS, and open 
media, and route them to the agents in the associated agent groups to handle the interaction. The asso-
ciated agent groups handle the interactions from that queue and generate statistics for reports on the 
queue. Reports can be generated on queue activities and queue performance can be viewed in real time.
When you add a queue to the YourSite database, the configuration options available depend on the media 
server or type of queue. Media servers fall under four general categories: voice (a telephone system with 
or without MiTAI enabled), SIP (a voice gateway), voice, email, chat, SMS, and open media.
For instructions on adding multimedia queues, see the Multimedia Contact Center Installation and 
Deployment Guide .

Adding voice queues (ACD path)

The primary voice queue for MiContact Center Business is the ACD path, which distributes calls to groups 
of agents. When an administrator adds an ACD path voice queue, they: 
• Configure general information for voice queues
• Configure voice queue membership 
• Configure Inqueue routing
• Configure queue spectrum settings for voice queues
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• Configure performance settings for voice queues
• Configure agent workflow settings (if agent greeting is enabled for the site)
• Optionally, set voice queue options

For information on automatic queue control, including opening, closing, and putting queues in DND, see 
"Automatically opening and closing queues".
For instructions on how to configure IVR Routing options for queues, consult "Configuring queues". 
Option availability depends on whether you are licensed for Messaging and Routing or IVR. 
• For information on configuring a queue for web callbacks, see "Enabling web callbacks".
• For information on configuring a queue for abandon callbacks, see "Enabling abandon callbacks".
• For information on associating a queue to an UPiQ workflow, see "Configuring InQueue routing".
• For information on setting up UPiQ workflows, see "Default Inqueue UPiQ workflow and subroutine".
• For information on configuring a queue for RAD messages, see "Configuring RAD messages for 

queues".

To add a voice SIP queue 
1. Click YourSite > Queues.
2. Click Add and select Voice  Queue.

3. Continue to "Configuring general information for queues (in Your Site Explorer)". 

NOTE: New voice  queues cannot be saved until the general settings for the queue have been config-
ured.

Configuring general information for voice queues
When configuring general information for voice queues, administrators configure the basic settings for the 
queue that are required to be configured before the queue can be saved.
The following procedures take place in YourSite > Queues.
To configure general voice queue information 
1. Select a queue and click the General tab.
2. Type a Name for the queue.

3. Type a Reporting number for the queue.

4. After Dialable number, enter the path directory number listed on the telephone system assignment 
forms.

5. After Media server, click the Browse button. 

NOTE: Once a queue has been saved, the media server cannot be changed.
6. Select the media server and click OK.

7. If you do not want the queue to be viewed in Contact Center Client and Ignite, select Disable 
real-time monitoring and data collection on this device.

8. Click Save.

Configuring voice queue membership
Agent groups must be assigned to a queue to handle ACD calls. Calls are offered to agent groups in the 
order in which they are associated to the voice queue and are offered to the next agent group in the list 
when the set overflow timer for that group expires. When configuring overflow timers for associated agent 
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groups, the Total Time to Agent Group column is automatically populated to indicate how long a call will 
be waiting before being offered to that agent group. A maximum of four agent groups can be assigned to 
a queue.
The following procedures explain how to: 
• Associate an agent group to a queue
• Remove an agent group association from a queue
• Set the Overflow timer

The following procedures take place in YourSite > Queues.
To associate an agent group with a queue 
1. Select a queue from the list and click the Membership tab.
2. Under Available members, select an agent group and click > to move the agent group to the 

Selected members list. 

The order agent groups are added determines the order in which agent groups are offered calls.
3. To adjust the order of selected members, select an agent group and click ^ or ˅.

4. Click Save.

To remove an agent group association from a queue 
1. Select a queue from the list and click the Membership tab.
2. Under Available members, select an agent group and click < to move the agent group to the 

Selected members list.

3. Click Save.

To set the overflow timer 
1. Select a queue from the list and click the Membership tab.
2. Under Selected members, set the Overflow Timer for each agent group associated to the voice 

queue.

3. Click Save.

Configuring queue spectrum settings for queues
Queue spectrum reports provide valuable information on how calls are dispersed in your contact center. 
You configure thresholds for answer, abandon, interflow, handle, and ringing thresholds for queues in 
YourSite Explorer. The answer, abandon, interflow, and talk statistics will be distributed across the queue 
spectrum reports in the time intervals you specify.
The following procedures take place in Yoursite > Queues.
To configure queue spectrum settings for a queue 
1. Select a queue and click the Queue Spectrum tab.
2. Select the spectrum value(s) you want to include in reports and specify thresholds for each. 

All threshold values are in seconds.
3. Click Save.

To apply queue spectrum settings to all queues on the same media server 
1. Select a queue and in the ribbon, click the Queue Tools tab.
2. Select Apply queue spectrum to all.
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Configuring performance settings for voice queues
When configuring a queue, administrators set the queue priority, configure business hours for the queue, 
configure the work timer options, set the Service Level objectives, and set the handling times. Business 
hours control when the queue opens and closes.Agents are set in Reseize Timer to remove agents from 
ACD when a call fails to route to them. The Reseize Timer duration is set on a queue by queue basisThe 
following procedures explain how to: 
• Set the priority level for the queue
• Configure the business hours for a queue
• Apply the business hours to all queues on the same media server
• Configure the Queue Work Timer options
• Set the voice queue service level objectives
• Set the voice queue handling times

 To set the priority level for the queue 
1. Select a queue and click the Performance tab.
2. After Priority, select the priority level for the queue. 

The highest priority level is 1. The lowest priority level is 64. Queues with the same priority level route 
to agents based on longest waiting.

3. Click Save.

 To configure the business hours for a queue NOTE: Queues open and close in alignment with the busi-
ness hour schedule selected. To control queue states according to a different schedule you must create 
the schedule and assign it to the queue. See "Creating and modifying schedules". 
1. Select a queue and click the Performance tab.
2. After Business-hour schedule, click the Browse button.

3. Select a schedule and click OK.

4. If you want to restrict the production of real-time statistics and reports to only during business hours, 
select Generate statistics and reports only within business hours.

5. Click Save.

 To apply the business hours to all queues on the same media server 
1. Select a queue and in the ribbon, click the Queue Tools tab.
2. Select Apply business hours to all.

 To configure the Queue Work Timer options 
1. Select a queue and click the Performance tab.
2. If you want to add Contact Center Work Timer to handling time in reports, select Include Queue Work 

Timer as part of handling time. 

NOTE: When 'Include work timer as part of handling time' is enabled, the ACD handling time dura-
tions for reporting purposes span from ACD pick up to the end of the Work Timer time.

When this option is disabled, the ACD handling time duration spans from ACD pick up to hang up.
3. To enable the queue for Work Timer, select Use Queue Work Timer and set the Queue Work Timer’s 

duration. 

The default duration is 5 minutes.
NOTE: 
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– Queue Work Timer maximum duration is 4 hours.
– A queue’s work timer must not exceed the Class of Service Work Timer associated with any agents 

in agent groups who are associated with this queue. See Default Outbound Callback subroutines.

4. To force agents to enter call classification Account Codes, select Force entry of a classification 
code. 

This feature only displays if you use either Contact Center PhoneSet Manager or Contact Center Soft-
phone.

5. If you want Work Timer to end once the classification Account Code has been entered, select Cancel 
queue work timer once code is entered. 

This feature only displays if you use either Contact Center PhoneSet Manager or Contact Center Soft-
phone.

6. Click Save.

 To set the voice queue service level objectives 
1. Select a queue and click the Performance tab.
2. Specify the Service Level goal and Service Level time for the queue.

3. Click Save.

 To set the voice queue handling times 
1. Select a queue and click the Performance tab.
2. After Short Handle less than, type the duration that will define a call as a short handle call. 

For example, type 3 to define a short handle call as one that lasts less than 3 seconds. Short talk calls 
are included in Agent call statistics but not in Queue call statistics.

3. After Short abandon less than, type the duration that will define an abandoned call as ‘Abandoned 
(Short)’. 

For example, type 5 to define a short abandon call as one that is abandoned in less than 5 seconds.
4. Click Save.

 To set SIP queue Reseize Timer 
1. Select a queue and click the Performance tab.
2. Select Use Reseize Timer.

3. Set the Reseize Timer duration. 

The default Reseize Timer duration is 2 minutes.
4. Click Save.

 To enable Auto Answer for Agents 
1. Select a queue and click the Performance tab.
2. Select the Agent Auto Answer check box.. 

This check box is cleared by default.
3. Click Save. 

NOTE: 
– If the Agent Auto Answer check box is selected, the Accept button is not displayed in Web Ignite 

because the incoming conversation is auto answered.
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– The Agent Auto Answer option can be enabled for voice, chat, email, sms, and, open media queue 
types, but not for the Ring Groups

Configuring agent workflow settings
The Agent workflow tab contains the default workflow that manages the playback of recorded messages 
when an agent answers an incoming call from the queue. This workflow is activated when agent greeting 
is enabled. For more information on enabling agent greeting, see "Adding sites" NOTE: Agent greeting 
recording is available in both Ignite (DESKTOP) and WebIgnite. However, agents can only record one 
greeting which will be used on all greeting enabled queues. The workflow includes a Play Agent Greeting 
activity. If Agent Greeting is enabled for the site (see "Adding sites"), the Play Agent Greeting activity 
checks the value of the <<AgentGreetingRecording>> variable (populated with a .wav file, if the agent has 
recorded a greeting) and plays the recording.You can add activities to customize the workflow (for 
example, you can add a Scheduling activity if you want the greeting to play only during business hours), 
however, the default workflow is sufficient for playing an agent greeting message if present. The workflow 
is triggered when the agent accepts an incoming ACD call. NOTE: The Play Agent Greeting activity has 
the following specific properties: 
• The 'Broadcast To' attribute is set to Both (so that both agent and caller hear the recorded message)
• The 'Greeting Prompt' attribute is set to Agent Greeting (so that the prompt plays the agent's recorded 

.wav file, as specified in the <<AgentGreetingRecording>> variable, if one exists)

Configuring whisper announcements
The Agent workflow also controls whisper announcements. 
• There are two methods of announcements: Queue whisper announcements, and the heritage 

pre-announcement feature of Contact Center PhoneSet Manager or Contact Center Softphone. 
For more information on pre-announce for Contact Center PhoneSet Manager and Contact Center 
Softphone, see the MiContact Center Business User Guide. We recommend you do not configure 
pre-announcement and whisper announcements on the same system.

• Whisper announcement recording is Ignite (DESKTOP) only.

 A whisper announcement is a recording that is played to the agent when an agent answers an inbound 
call. The whisper announcement can provide useful information to the agent (for example, it can identify 
the incoming queue) to help the agent to handle the call more efficiently.The whisper announcement plays 
only to the agent. You can choose a .wav file from the IVR Prompts page, or a Text-to-Speech prompt (if 
licensed). NOTE: When the whisper announcement is playing, the caller is able to hear the agent 
speaking. To prevent the caller from hearing the agent or other contact center background noise during 
the whisper announcement, mute the agent's headset for the duration of the announcement. To add a 
whisper announcement to the queue 
1. Add the Play activity to the workflow and place it before the Play Agent Greeting activity.
2. Select the Play activity and click Properties to configure the following attributes: 

– The 'Broadcast To' attribute must be set to Agent (so that only the agent hears the recorded 
message)

– The 'Greeting Prompts' attribute must be set to the prompt that you want played

 For detailed information on setting properties for the Play activity, see "Configuring the Play activity".
Configuring voice options for queues
The voice options tab contains additional voice queue configuration options.The following procedures 
explain how to: 
• Set queue unavailable answer point directory number
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• Set interflow options

 The following procedures take place in YourSite > Queues.To set the queue unavailable answer point 
directory number 
1. Select a queue and click the Voice options tab.
2. Type the Queue unavailable answer point directory number.

3. Click Save.

 To set the queue’s interflow options 
1. Select a queue and click the Voice options tab.
2. To enable interflow, select Interflow enabled.

3. Select the Interflow timeout.

4. Type the Interflow point directory number.

5. Optionally, select Allow overflow to interflow before time out.

6. Optionally, select Interflow to this queue uses this queue’s priority.

7. Click Save.

Adding Ring Groups

With MiContact Center Business, you can configure Ring Groups, with the following limitations: 
• Ring Groups require a minimum of MiVoice Business 7.0 .
• MiContact Center Business and MiVoice Analytics Version 9.0 do not support Call Forward Always 

from Ring Groups. Call Forward Always to Ring Groups is supported.
• Clustered Ring groups are not supported. Ring Groups, their extensions, interflow points, and any IVR 

ports transferring to Ring Groups must be on the same media server.
• Prime DNs and hot desking users are supported as members of Ring Groups.
• Personal Ring Groups are not supported.

It is recommended that Ring Groups have a default Class of Service configured on the 3300 media server. 
For more information, see "Editing Class of Service options".
If you are licensed for IVR or Messaging and Routing, Ring Groups are not supported for callback or UPiQ 
workflows, subroutines, and related activities.
When an administrator adds a Ring Group, they 
• Configure general Ring Group queue information
• Configure Ring Group business hours
• Configure Ring Group membership
• Configure queue spectrum settings for Ring Group
• Configure Ring Group voice options

To add a Ring Group queue 
1. Click YourSite > Queues.
2. Click Add and select Ring Group.

3. Continue to "Configuring general information for Ring Group queues". 
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NOTE: New Ring Group queues cannot be saved until the name, reporting number, and media server 
have been configured for the queue.

Configuring general information for Ring Group queues
The following procedures take place in YourSite > Queues.
To configure common Ring Group queue information 
1. Select a Ring Group and click the General tab.
2. Type a Name for the Ring Group.

3. After Reporting number, type the Ring Group’s dialable number. 

NOTE: The reporting number cannot be changed after saving the Ring Group.
4. After Media server, click the Browse button.

5. Select the media server and click OK. 

NOTE: The media server cannot be changed after saving the Ring Group.
6. After Failover Media server, click the Browse button.

7. Select the Failover media server and click OK.

8. If you do not want the queue to be viewed in Contact Center Client and Ignite, select Disable 
real-time monitoring and data collection on this device.

9. Click Save.

Configuring membership for Ring Groups
Extensions or hot desking users must be assigned to a queue to handle calls sent to Ring Groups. 
Depending on how the Ring Group is configured to distribute calls, calls will be offered to extensions in 
their order in the member list.
NOTE: Prior to Version 8.1, all voice softphone extensions created in YourSite Explorer had the setting 
‘ACD Enabled’ applied when written back to the ACD routing system. In Version 9.0, this setting can be 
set or removed for the extension in YourSite Explorer. ACD Enabled extensions can be added as 
members of Ring Groups, but they cannot be made present in the Ring Group. This is a restriction 
imposed by Mi Voice Business. Ring Group Member extensions with ACD Enabled will not receive calls 
sent to the Ring Group. If a Hot Desking Agent logs into an ACD Enabled extension, they will go out of 
service and not be updated in the real-time monitors. To remove ‘ACD Enabled’ from extensions in Your-
Site Explorer, see "Adding extensions".
Ring group extension members must be located on the same node as the Ring Groups. Ring Groups do 
not support multi-node configurations.
You can program the following devices as Ring Group members 
• Multiline set prime numbers
• Single line sets
• Internal and external hot desk user

The following procedures explain how to: 
• Associate an extension to a Ring Group queue
• Remove an extension association from a Ring Group queue

The following procedures take place in YourSite > Queues.



120

CONFIGURING THE YOURSITE DATABASE
CHAPTER 7 CONFIGURATION

To associate an extension with a Ring Group 
1. Select a Ring Group queue from the list and click the Membership tab.
2. Under Available members, select an extension and click > to move the extension to the Selected 

members list. 

Depending on the algorithm selected, calls will be offered to a Ring Group’s extensions using the or-
der in the Selected members list.

NOTE: To ensure accurate reporting, hot desking users should be made members of the same Ring 
Groups as the extensions to which they log in.

3. To adjust the order of selected members, select an extension and click ^ or ˅.

4. Click Save.

To remove an extension association from a Ring Group 
1. Select a Ring Group from the list and click the Membership tab.
2. Under Available members, select an extension and click < to move the extension to the Selected 

members list.

3. Click Save.

Configuring performance settings for Ring Groups
The following procedures explain how to: 
• Configure business hours for a Ring Group
• Set the Ring Group service level objectives
• Set the Ring Group handling times

To configure the business hours for a Ring Group. 
1. Select a Ring Group and click the Performance tab.
2. After Business-hour schedule, click the Browse button.

3. Select a schedule and click OK.

4. If you want to restrict the production of real-time statistics and reports to only during business hours, 
select Generate statistics only within business hours.

5. Click Save.

To set the Ring Group service level objectives 
1. Select a Ring Group and click the Performance tab.
2. Specify the Service level goal and Service level time for the Ring Group.

3. Click Save.

To set the Ring Group handling times 
1. Select a Ring Group and click the Performance tab.
2. After Short handle less than, type the duration that will define a call as a short handle call. 

For example, type 00:00:03 to define a short handle call as one that lasts less than 3 seconds.
3.   

Short handle calls are included in call statistics.
4. After Short abandon less than, type the duration that will define an abandoned call as ‘Abandoned 

(Short)’. 
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For example, type 00:00:05 to define a short abandon call as one that is abandoned in less than 5 
seconds.

5. Click Save.

Configuring queue spectrum settings for Ring Groups
Queue spectrum reports provide valuable information on how calls are dispersed in your contact center. 
The answer, abandon, interflow, handle, and ringing statistics will be distributed across the queue spec-
trum reports in the time intervals you specify.
If you apply your queue spectrum settings on all queues on a media server, they are applied to both Ring 
Groups and ACD path queues.
The following procedures take place in YourSite > Queues.
To configure queue spectrum settings for a Ring Group 
1. Select a Ring Group and click the Queue Spectrum tab.
2. Select the spectrum value(s) you want to include in reports and specify thresholds for each. 

All threshold values are in seconds.
3. Click Save.

To apply a Ring Group’s queue spectrum settings to all queues on the same media server 
1. Select a Ring Group and in the ribbon, click the Queue Tools tab.
2. Select Apply queue spectrum to all.

Configuring voice options for Ring Group queues
Ring Group specific queue settings are configured in the Voice options tab.
The following procedures take place in YourSite > Queues.
To configure the voice options for a Ring Group queue 
1. Select a Ring Group and click the Voice options tab.
2. After Ring Algorithm, select the Ring Groups call distribution algorithm from the following: 

– Ring All: Rings all available extensions in the Ring Group simultaneously.
– Terminal Cascade: Starting from the first extension in the member list, rings the first available 

extension for the duration of the Cascade Ring Timer before calling the next available extension in 
the member list.

– Terminal: Starting from the first extension in the member list, rings the first available extension.
– Circular: Starting from the last member to handle a call, rings the next available extension in the 

members list.
– Circular Cascade: Starting from the last member to handle a call, rings the next available extension 

in the member list for the duration of the Cascade Ring Time before calling the next available exten-
sion in the member list.

3. After COS, select a Class of Service for the Ring Group. 

If you have configured a default Class of Service for Ring Groups, the default Ring Group Class of 
Service will be automatically applied.

4. If you selected a Cascade algorithm, after Cascade Ring Timer, set the time a call will ring an exten-
sion before ringing the next member extension in the Ring Group.
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5. After Call Queued Timer, set the maximum time a call will remain in queue for a Ring Group before 
redirecting to the overflow point.

6. After Call Ringing Timer, set the maximum time a call will ring an extension before the call is redi-
rected to the overflow point.

7. After Call Coverage Service Number, enter a configured Call Coverage Service Number.

8. If you want to redirect incoming calls to another directory number if the Ring Group extensions do not 
answer, after Overflow Point, type the dialable number for the overflow destination. 

The Overflow Point can be any Prime DN destination, such as an extension or queue.
NOTE: If a traditional agent logs into the overflow point, calls will never be offered

9. Click Save.

Setting a queue as historical

Voice and Ring Groupqueues can be set as historical, disabling real-time monitoring and data collection 
on the queue. Historical voice queues retain their data for reporting, but cannot handle interactions and 
are not available in Contact Center Client and Ignite. A historical queue can be restored to active service.
To set a queue as historical or to reactivate a historical queue 
1. Select a queue and click the General tab.
2. If you are setting the queue as historical, select Disable real-time monitoring and data collection 

on this device.

3. If you are reactivating the queue, clear Disable real-time monitoring and data collection on this 
device.

4. Click Save.

Deleting a queue

When you delete a queue, it is removed from both YourSite Explorer and the media server. No more data 
is collected for the deleted queue, but any collected data for the queue is preserved and can be reported 
on.
NOTE: If you restore a backup from before the queue was deleted, it will re-associate itself to the collected 
data for the queue.
To delete a queue
1. Click YourSite > Queues.
2. Select a queue and click Delete.

3. Click OK.

Automatically controlling voice queue states (ACD path)

Voice queue states can be automatically controlled using Interactive Contact Center queue control. Inter-
active Contact Center queue control automates queue availability to respond to hours of operation and 
queue conditions, ensuring that calls do not wait in queue after hours or during busy periods.
Interactive Contact Center queue control consists of business hour schedules and queue control plans.



123

CONFIGURING THE YOURSITE DATABASE
CHAPTER 7 CONFIGURATION

Business hour schedules open and close queues. For example, a 9-5 business hour schedule applied to 
the queue closes the queue at 5:00 pm. After 5:00 pm, calls route to the queue’s unavailable answer point, 
if one is configured. At 9:00 AM, the queue opens and calls again route to the queue.
Queue control plans put queues in DND when certain conditions are satisfied. For example, if the queue’s 
longest wait time has exceeded 30 minutes for more than one hour, the queue control plan will put the 
queue in DND. While the queue is in DND, calls route to the queue’s unavailable answer point, if one is 
configured.
The following procedures explain how to 
• Open and close queues with business hour schedules
• Set and remove queue DND with queue control plans

Opening and closing voice queues using business hour schedules
NOTE: If you do not want to open and close queues using business hour schedules, apply the Default 24/7 
schedule to the queue. You can open and close queues automatically by assigning them a business hour 
schedule. Schedules enable you to customize the hours of operation for individual queues. For example, 
if your business operates 24 hours a day, but specific queues are open from 9-5 only, you can create indi-
vidual business hour schedules that will open the queues at 9 and close them at 5.For information on 
creating business hour schedules, see "Creating and modfying schedules".To assign a business hour 
schedule to a queue 
1. Click YourSite > Queues.
2. Select the queue and click the Interactive queue control tab.

3. Select the Queue uses Interactive Contact Center queue control check box.

4. After Business-hour schedule, click the Browse button.

5. Select a schedule to apply to the queue and click OK.

6. Click Save.

Setting and removing queue DND with queue control plans
NOTE: DND can be set manually on a queue via the Queue Now monitor. Queue control plans and busi-
ness hour schedules do not override a DND state set manually on the queue. Queues put into DND manu-
ally must have DND removed manually before queue control plans and business hour schedules can 
come into effect for the queue, and vice versa, queues opened manually must be closed manually (with 
set DND command) before queue control plans and business hour schedules can come into effect.
Queue control plans specify conditions under which a queue is automatically put into and taken out of 
DND.
For example, if customers in queue are experiencing exceptionally high wait times, an administrator might 
want that queue automatically put into DND. This prevents additional calls from reaching the queue and 
prevents new callers from experiencing long wait times.
Each queue control plan monitors one queue and, based on the conditions specified, can set and remove 
DND states for either the queue being monitored, a Directory Number, or an alternate queue. Only one 
queue control plan can be applied to a queue, but a single queue control plan can be applied to multiple 
queues.
Setting and removing queue DND with queue control plans requires you to 
• Add a queue control plan to YourSite Explorer
• Specify conditions for setting queue DND
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• Specify how long conditions must be present until queue DND is removed
• Specify Monitor Settings
• Specify when queue control plan conditions are evaluated
• Associate the control plan to a queue

Optionally, you can 
• Remove a control schedule from a queue
• Remove a queue control plan from a queue
• Delete the queue control plan

To add a queue control plan to YourSite Explorer 
1. Click YourSite > Enterprise.
2. Select Queue Control Plans, click Add.

3. Under General, type a Name for the queue control plan.

4. Click Save. 

Follow the steps under 'To specify conditions for setting queue DND', below.

To specify conditions for setting queue DND 
1. Under Queue Condition Builder, click Add.
2. Under Name, select a criterion from the drop-down list. 

For example, ‘Longest Wait Time’.
3. Select an Operator. 

For example, '>'.
4. Specify a Value, or select a value from the drop-down list. 

For example, ‘0:30:00’ (30 minutes).
5. To join conditions, select a Join Type, click Add, and repeat the steps above. 

NOTE: 'And' means that all conditions must be met for the queue to go into DND. 'Or' means that only 
one of the conditions must be met for the queue to go into DND.

6. Click Save. 

Follow the steps under 'To specify how long conditions are present until queue DND is removed', be-
low.

To specify how long conditions are present until queue DND is removed 
1. Under DND Settings, after Place the device in DND when the following conditions are true for, 

type the amount of time for which the queue conditions must be met before the queue enters DND. 
For example, once the longest wait time has hit more than 30 minutes for ten minutes, the queue en-
ters DND.

2. Under DND Settings, after Remove the device from DND when the following conditions are false 
for, type the amount of time for which the queue conditions must be absent before queue DND is 
removed. 

For example, once the longest wait time drops below 30 minutes for at least one hour, DND;is re-
moved.

3. Click Save. 
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Follow the steps under 'To specify Monitor Settings', below.

To specify Monitor Settings
NOTE: This configuration requires you to select the queue being monitored for the queue control plan 
conditions. You then specify the queue or Directory Number upon which action is taken once the moni-
tored queue meets the specified conditions.
1. Under Monitor Settings, after Monitor, click the Browse button, select a queue to monitor and click 

OK.
2. Specify whether action will be taken on the Current Queue. 

The ‘Current Queue’ is the queue to which the plan is assigned.
3. Alternatively, specify whether action will be taken on a Directory Number.

4. Alternatively, for action to be taken on an Alternate queue, click the Browse button, select the queue, 
and click OK.

5. Click Save. 

Follow the steps under ‘To specify when queue control plan conditions are evaluated’, below.

To specify when queue control plan conditions are evaluated 
1. Click YourSite > Queues.
2. Select the queue and click the Interactive queue control tab.

3. Select the Queue uses Interactive Contact Center queue control check box.

4. After Interactive Contact Center queue control schedule, click the Browse button.

5. Select a schedule and click OK. 

To create a new schedule, see "Creating and modifying schedules".
6. Click Save. 

Follow the steps under ‘To associate the control plan to a queue’, below.

To associate the control plan to a queue 
1. Click YourSite > Queues.
2. Select the queue and click the Interactive queue control tab.

3. Select the Queue uses Interactive Contact Center queue control check box.

4. After Interactive Contact Center queue control plan, click the Browse button.

5. Select a queue control plan and click OK.

6. Click Save.

To remove a control schedule from a queue
NOTE: Removing control schedules prevents the queue control plan from running. If you remove a queue 
control schedule, you must add another in order to use the queue control plan.
1. Click YourSite > Queues.
2. Select the queue and click the Interactive queue control tab.

3. After Interactive Contact Center queue control schedule, click the Clear… button. 

To create a new schedule, see "Creating and modifying schedules".
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4. Click Save.

To remove a queue control plan from a queue 
1. Click YourSite > Queues.
2. Select the queue and click the Interactive queue control tab.

3. After Interactive Contact Center queue control plan, click the Clear... button.

4. Click Save.

To delete a queue control plan 
1. Click YourSite > Enterprise > Queue Control Plan.
2. Select the queue control plan and click Delete.

3. When prompted, click OK.

4. Click Save.

Adding queue groups

NOTE: Ring Groups are supported in Reporting queue groups only. Ring Groups can be grouped with ACD 
paths in Reporting queue groups. Ring Groups are not supported in Virtual and Unified Queue Groups.
Administrators can group queues for common purposes. There are three kinds of queue groups available: 
• Reporting—groups queues together for reporting and viewing their activities in real-time
• Mitel Virtual—groups queues across telephone systems that load balance ACD calls between 

multiple queues.
• Unified Queue Group—groups queues of different media types that handle interactions for the same 

service group in a contact center. For more information, see the Multimedia Contact Center Installation 
and Deployment Guide "Adding Unified queue groups".

Adding Reporting queue groups

Reporting queue groups enable administrators to run reports on activities for the grouped queues and 
view queue group activities in real time. Both voice queues and Ring Groups can be added to the same 
queue group, but ACD queue statistics that do not apply to Ring Groups will display as 0 in real-time moni-
tors and reporting.
The following procedures explain how to: 
• Add a Reporting queue group
• Associate a queue to a Reporting queue group
• Remove a queue from a Reporting queue group

To add a Reporting queue group 
1. Click YourSite > Queue groups.
2. Click Add > Reporting.

3. Type a Name.

4. Type a Reporting number.

5. Click Save.
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To associate a queue to a Reporting queue group 
1. Click YourSite > Queue groups.
2. Select a Reporting queue group from the list.

3. On the Membership tab, under Available members, select a queue and click > to move the queue 
to the Selected members list.

4. Click Save.

To remove a queue from a Reporting queue group 
1. Click YourSite > Queue groups.
2. Select a Reporting queue group from the list.

3. On the Membership tab, under Selected members, select a queue and click < to move the queue 
to the Available members list.

4. Click Save.

Adding Virtual queue groups

Virtual queue groups comprise two or more queues across multiple ACD routing systems, all of which 
send ACD voice interactions to the same pool of agent groups, in order to offer load balancing within the 
virtual queue.
When transferring a call to a virtual queue group, call routing occurs in either of the following two ways, 
depending on the configuration: 
• When the IVR ports are not on the same PBX as queues, the Virtual Queue Groups work as a 

load-balancing mechanism. When the call is routed to a Virtual Queue Group, the call is routed to the 
queue that has the lowest estimated wait time.

• When the IVR ports are on the same PBX as the queues, attempt is made to route the call to the 
queue on the local ACD routing system, and, if it is closed, then the call is routed to the remaining 
queues in the virtual queue group using the Lowest Estimated Wait Time algorithm.

NOTE: The local queue is considered to be in its last known state if the IVR does not get any information 
from the Enterprise server.
Queues within a Virtual queue group must have the same reporting numbers, the same agent groups, 
and different dialable numbers. For example, in the following figure, the virtual queue group is made from 
two queues on two different ACD routing systems: 
• PBX 1: Queue 7000: reporting number P700, dialable 7000 on PBX1, queue 700, 701, 702 assigned
• PBX 2: Queue 7001: reporting number P700, dialable 7001 on PBX2, queue 700, 701, 702 assigned

Figure 7.5: Virtual queue group
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Virtual queue groups provide the ability to merge multiple queues into a single visual representation in 
Interactive Visual Queue and provide callers with an accurate position in queue through the MiContact 
Center UPiQ Service.
If you are licensed for IVR or Messaging and Routing, virtual queue groups can be used to provide resil-
iency paths for activities such as Transfer.
NOTE: 
• Although Virtual queue groups are added and configured under Queue Groups in YourSite Explorer, 

a virtual queue group is treated as a singular entity.
• Ring Groups are not supported for virtual queue groups.

The following procedures explain how to: 
• Add a Virtual queue group
• Associate queues to a Virtual queue group
• Remove queues from a Virtual queue group
• Create a virtual queue group using the Virtual Queue Group button

To add a Virtual queue group 
1. Click YourSite > Queue groups.
2. Click Add > Mitel Virtual.

3. Type a Name.

4. Type a Reporting number.

5. Click Save.

To associate queues to a Virtual queue group 
1. Click YourSite > Queue groups.
2. Select a Virtual queue group from the list.

3. On the Membership tab, under Available members, select a queue and click > to move the queue 
to the Selected members list. 

Repeat as necessary.
4. Click Save.
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To remove queues from a Virtual queue group 
1. Click YourSite > Queue groups.
2. Select a Virtual queue group from the list.

3. On the Membership tab, under Selected members, select a queue and click < to move the queue 
to the Available members list. 

Repeat as necessary.
4. Click Save.

To create a virtual queue group using the Virtual queue group button 
1. Click YourSite > Queues.
2. Select the queues you want to be part of the Virtual queue group 

NOTE: Queues must be identically configured, with the exception of media servers and dialable 
numbers.

3. In the ribbon, click Queue Tools.

4. Click Create virtual queue group.

5. After Name, enter the name for the virtual queue group

6. If you want to change the reporting number of the virtual queue group, after Reporting number, enter 
the reporting number 

By default, the reporting number will be the same as the member queues.
7. Click Save.

Adding extensions

When you perform Synchronization, YourSite Explorer is configured to mirror the phone set extension 
numbers/base directory numbers (DNs) on the telephone system.
If you have traditional agents that can sit at multiple locations within your organization, Hot Desking 
Agents, or general business hot desking extensions, we recommend you give these base extensions 
generic names based on the position of the physical DNs (for example, Base DN: Floor 2, Desk 1). We 
recommend only general business hot desking extensions assigned to specific hot desking users be 
given user-based names (for example, Hot desking extension: John, Smith). If you have traditional ACD 
agents who sit at the same desk every day, or traditional extension phone sets that belong to single users, 
we recommend that the base DNs be configured with the user's names.
NOTE: 
• If you have enabled agent greeting functionality for a site, you must create one or more agent greeting 

ports on the same media server that your agents belong to. The Record Agent Greeting workflow 
(configured on the media server) uses this port to call the agent for message recording. There is no 
license required for agent greeting ports, but there is a limit of 120 simultaneously open agent greet-
ings and UPiQ ports for every MiVoice Business controller.

• Agents are programmed in YourSite Explorer. If agents are in a clustered environment but not hot 
desking and not resilient, the agent names will not display on the telephone switch.

In order to provide Contact Center Work Timer functionality in Contact Center Client, every traditional 
agent’s extension or every Hot Desking Agent ID must be enabled with a MiTAI monitor.



130

CONFIGURING THE YOURSITE DATABASE
CHAPTER 7 CONFIGURATION

When read/write is enabled on a media server, changes made to extensions may be written back to the 
media server depending on the type of extension being changed. Changes made by adding or deleting 
the following extension types are written back to the media server: 
• Agent greeting
• App server port
• Hot desk user
• Outbound port 5020 IP
• Messaging port 5020 IP
• RAD port 5020 IP
• UPiQ port 5020 IP
• Voice softphone

Changes made by adding or deleting the following extension types are not written back to the media 
server: 
• Attendant console
• Auto-attendant
• Voice
• Voice mail

For extensions that already exist on the media server, edits to any extension type in YourSite Explorer 
will update the Name and Class of Service of that extension on the media server.
For information about enabling read/write on the media server, see "Enabling write-back functionality".
NOTE: 
• Prior to Version 8.1, all voice softphone extensions created in YourSite Explorer had the setting ‘ACD 

Enabled’ applied when written back to the ACD routing system. In Version 9.0, this setting can be set 
or removed for the extension in YourSite Explorer. ACD Enabled extensions can be added as 
members of Ring Groups, but they cannot be made present in the Ring Group. This is a restriction 
imposed by Mi Voice Business. Ring Group Member extensions with ACD Enabled will not receive 
calls sent to the Ring Group. If a Hot Desking Agent logs into an ACD Enabled extension, they will go 
out of service and not be updated in the real-time monitors. To remove ‘ACD Enabled’ from extensions 
in YourSite Explorer, see the following procedures.

• You can run extension reports to cost attendant call activity (SMDR Attendant Extension reports). 
When you create the attendant extension in the YourSite database, you must use the attendant 
reporting number found on the switch (for example, ATT1) as the extension reporting number. The 
numbers must be identical. If the switch uses a capital letter, you must use a capital letter in the Your-
Site database. These SMDR attendant extension reports use data collected from the SMDR stream. 
If you want to report on traffic attendant activity, you must have the Traffic Analysis application. Traffic 
attendant reports use data collected from the traffic stream. See "MiCC Contact Center Reports Guide" 
for more information.

• For information on configuring extensions for IVR Routing, see "Configuring extensions".
• Workgroup does not support Contact Center resiliency. You cannot program failover media servers for 

ACD agents or extensions.

The following procedures explain how to: 
• Add an extension
• Configure 3300 ICP extension options 
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NOTE: Failover media servers for extensions must be configured on your telephone system and 
synchronized into YourSite Explorer.

• Enable a Hot Desk User for external hot desking 
See "Enabling external hot desk agents".

NOTE: Some fields and tabs are only available to certain extension types.
To add an extension 
1. Click YourSite > Extensions.
2. Click Add.

3. After Name, enter a name for the extension.

4. After Reporting/Dialable number, enter the extension’s dialable number.

5. After Extension type, select an extension type from the drop-down list.

6. After Media server, click the Browse button.

7. Select a media server and click OK.

8. Select the Disable real-time monitoring and data collection on this device check box if you do not 
want to enable the extension to be set with a MiTAI monitor, viewed in Contact Center Client, and use 
Contact Center Softphone. 

By default, this check box is not selected.
9. To license this extension, select License this Extension. 

Unlicensed extensions will not be updated in Contact Center Client real-time monitors and cannot be 
reported on or costed with MiVoice Analytics.

10. After Notes, enter any other information for administrators about the extension.

11. Click Save.

To configure 3300 ICP extension options 
1. Select an extension and click the 3300 ICP tab.
2. Select the Class of Service for the extension from the drop-down list.

3. If you want this extension enabled for ACD, select ACD enabled.

4. Click Save.

To enable a Hot Desk User for external hot desking 
1. Click YourSite > Extension.
2. Select a Hot Desk User extension and click the 3300 ICP tab.

3. Select External hot desk user enabled. 

Extensions that are enabled as external hot desk users can handle Non ACD calls while logged in 
externally.

4. After External dialing prefix, type the dialing prefix for the external device to which calls will be 
routed.

5. After External dialing number, type the dialing number for the external device to which calls will be 
routed.

6. Click Save.
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Adding extension groups

After adding extensions, you add extension groups and associate extensions with these groups.
To add an extension group
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Extension groups.

3. Click Add.

4. Type a Name and a Reporting number for the extension group.

5. On the ribbon, click Save.

Associating extensions with extension groups

To associate an extension with an extension group
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Extension groups.

3. Select an extension group from the list.

4. On the Membership tab, under Available members, select an extension and click > to move the 
extension to the Selected members list.

5. On the ribbon, click Save.

Adding trunks

NOTE: 
• If you want to report on SMDR information for SIP trunks you must ensure your SMDR tag is 

numbered.
• We recommend you name trunks and trunk groups in a way that helps you identify them as either SIP 

or TDM trunks, enabling the trunk type to be easily identified in reports.

To add a trunk 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Trunks.

3. Click Add.

4. Type a Name and a Reporting number for the trunk.

5. Click the Browse button and select a Media server to associate with the trunk.

6. On the ribbon, click Save.

Adding trunk groups

You add trunk groups and then associate trunks with the trunk groups.
NOTE: 
• If you have Traffic Analysis and/or MiVoice Analytics and use the same trunk group numbers across 

multiple telephone systems, you must associate each trunk group with a media server.
• We recommend you name trunks and trunk groups in a way that helps you identify them as either SIP 

or TDM trunks, enabling the trunk type to be easily identified in reports.



133

CONFIGURING THE YOURSITE DATABASE
CHAPTER 7 CONFIGURATION

If you have Traffic Analysis and/or MiVoice Analytics and use the same trunk group numbers across 
multiple telephone systems, you must associate each trunk group with a media server.
To add a trunk group 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Trunk groups.

3. Click Add.

4. Type a Name and a Reporting number for the trunk group.

5. Click ... and select a Media server to associate with the trunk group.

6. On the ribbon, click Save.

Associating trunks with trunk groups

To associate a trunk with a trunk group
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Trunk groups.

3. Select a trunk group from the list.

4. On the Membership tab, under Available members, select a trunk and click > to move the trunk to 
the Selected members list.

5. On the ribbon, click Save.

Adding DNIS

Dialed Number Identification Service (DNIS) is a feature of toll-free lines that identifies the telephone 
number the caller dials. This assists agents who handle calls for more than one business or product line. 
Each business or product line has its own toll-free number. When a caller dials a toll-free number, the 
telephone system forwards information to the agent allowing the agent to identify who the caller dialed. 
For example, a caller dials a toll-free number for a cruise line. The telephone system sends a script to the 
agent along with the call. The agent then knows to answer 'Good morning. Thank you for calling Southern 
Cruises', instead of the name of another cruise line serviced by the center.
To add a DNIS 
1. Click YourSite > DNIS.
2. Click Add.

3. Specify DNIS identification information and click the Browse button to select the media server for the 
DNIS.

4. After Short Abandon, type the duration for the call abandon parameter for DNIS call statistics. If the 
abandon time is less than the call abandon parameter, then the call is a short abandon call and is not 
included in the DNIS call statistics (for example, type 5 to define a short abandon call as a call that 
lasts less than 5 seconds).

5. After Service Level, type the Service Level time.

6. If you have MiVoice Analytics, select a carrier plan, call type, and call rate.

7. Click Save.
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Adding DNIS groups

After adding DNIS, you can create DNIS groups and then associate DNIS numbers for specific busi-
nesses or product lines to those groups.
To add a DNIS group
1. Click YourSite > DNIS groups.
2. Click Add.

3. Type a Name and a Reporting number for the DNIS group.

4. On the ribbon, click Save.

Associating DNIS to DNIS groups

To associate a DNIS with a DNIS group
1. Click YourSite > DNIS groups.
2. Select a DNIS group from the list.

3. On the Membership tab, under Available members, select a DNIS and click > to move the DNIS to 
the Selected members list.

4. Click Save.

Adding Account Codes

Account Codes can be verified, non-verified, or forced.
• Verified and Non-Verified Account Codes 

Verified and Non-Verified Account Codes allow callers to complete a call without entering a code. 
These codes are used to categorize calls or portions of calls. You define Account Codes in the Your-
Site database to generate reports for specific departments, services, and companies. For example, 
an agent who receives calls for three catalog companies enters Account Code 01 for calls to company 
X, Account Code 02 for calls to company Y, and Account Code 03 for calls to company Z. When you 
configure the Account Codes, MiContact Center Business generates reports on the number, origin, 
and handling of calls for each of the departments, services, or companies.

• Forced Account Codes 
Both Verified and Non-Verified verified Account Codes can be forced. With Forced Verified Account 
Codes, you must enter the Account Code as soon as the phone is off-hook. With Forced Non-Verified 
verified Account Codes, you must enter the Account Code after you dial the phone number.
For example, you might have 03 programmed on the telephone system as the trunk access code for 
calling England. Before you make a call to England, you must preface the telephone number with the 
Account Code 03, otherwise the call will not go through. To report on these verified Account Codes, 
you define them in the YourSite database.

NOTE: 
• If you will used Forced Account Codes and have a Make Busy button programmed on your Mitel phone 

set, you must remove the Make Busy button, or Forced Account Codes will not work with Interactive 
Contact Center and Contact Center PhoneSet Manager.

• If a Forced Verified verified Account Code is not entered in before Work Timer expires, then a -1 Non 
Compliant Code will be automatically assigned to the call.
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You can add Account Codes for accounting for a segment of an ACD interaction. For example, in a 
contact center helping callers with software issues, you could use Account Codes to identify the duration 
of discovery, reproduction, troubleshooting, and resolution for caller-found bugs. Agents can tag incoming 
calls or multimedia interactions with Account Codes for various services. Account Codes not associated 
to a specific employee can be used by all employees when handling interactions.
Agents who work for companies that use MiContact Center Business can use Account Codes to gain 
access to outside lines (see "Assigning Non ACD extensions and Account Codes for employees").
If you are adding Account Codes to be used by voice agents, you print a copy of your telephone system 
assignment forms to use as a guide for programming. If you are adding Account Codes to be used by 
email and chat agents, you enter Account Code reporting numbers of your choice.
You can label Account Codes as call classification codes. This option associates the entire handling time 
to calls of this Account Code type.
NOTE: Classification Codes are a type of Account Code, but you can apply them during or after a call. Clas-
sification Codes can be applied only to ACD calls, but account codes can be applied to any calls.
To add an Account Code 
1. Click YourSite > Account Codes.
2. Click Add.

3. Type a Name and Reporting number for the Account Code.

4. If the Account Code will be used as a call classification code, select the Use as Classification Code 
check box. 

NOTE: 
– When the 'Use as Classification Code' check box is selected, the Account Code duration spans from 

the time the call arrives until the call ends. When you deselect the 'Use as Classification Code' check 
box, the Account Code duration spans from the time the code was entered until the next code is 
entered or the call ends.

– As a best practice, we recommend you name all call classification codes for easy identification or 
group call classification codes in Account Code groups.

5. Click Save.

Adding Account Code groups

You can create Account Code groups to group similar Account Codes or to differentiate traditional 
Account Codes and call classification codes. Agents can readily identify and select appropriate Account 
Codes using the soft phone, Ignite, or Interactive Contact Center and supervisors can report on Account 
Code groups.
To add an Account Code group 
1. Click YourSite > Account Code groups.
2. Click Add.

3. Type a Name and Reporting number for the Account Code group.

4. Click Save.
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Associating Account Codes with Account Code groups

To associate an Account Code with an Account Code group
1. Click YourSite > Account Code groups.
2. Select an Account Code group from the list.

3. On the Membership tab, under Available members, select an Account Code and click > to move the 
Account Code to the Selected members list.

4. Click Save.

Adding Account Code categories

Account Code categories can be used to provide a hierarchical and grouped listing of the Account Codes 
available to agents and employees. Once you have configured Account Codes, they can be nested under 
specific Account Code categories. An Account Code can only be in one category. Classification Codes, 
which are treated the same way as Account Codes, can optionally be nested in Account Code categories.
Account Code category availability to agents and employees can optionally be controlled using MiContact 
Center Business security. When Account Code categories are enabled,MiContact Center Business 
reports will display the Account Code category path (for example, Sales > Automotive > Tires).
To enable Account Code categories 
1. Click YourSite > Account Codes.
2. In the ribbon, click the Configuration tab.

3. Select Enable Account Codes categories.

To add an Account Code category 
1. Click YourSite > Account Codes.
2. In the ribbon, click the Configuration tab.

3. Ensure the Enable Account Codes categories check box is enabled.

4. Click Edit categories. 

The Account Code category designer displays.
5. Using the Account Code category designer, add and name Account Code categories in the left pane 

and then add the Account Codes you have configured, which display in the left pane to the custom 
categories. 

Account Code categories are sorted by category name and Account Code reporting number.
Account Code categories will display in soft phone toolbarsor Ignite (DESKTOP) exactly as you have 
designed them in the Account Code category designer.

NOTE: Categories that do not contain Account Codes will not be saved when the Account Code cate-
gory designer closes.

Defining ANI data

Defining ANI data enables MiContact Center Business to gather information on area codes and 
geographic regions for incoming calls. ANI data can be given to agents in screen pops, used to route calls 
to appropriate endpoints, or used in reporting.
NOTE: ANI you want reported on for accounting purposes in MiVoice Analytics should be added as phone 
numbers as well. For more information on phone numbers, see "Adding phone numbers".
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The following procedures explain how to 
• Define ANI data
• Delete ANI data

To define ANI data 
1. Click YourSite and, under Devices, click ANI > Add.
2. After Name, type the geographical region to which the area code corresponds.

3. After ANI, type the area code for the geographical region.

4. To import ANI data from a .csv file, click Import and follow the steps under "Importing a range of 
devices using a .csv file".

5. Click Save.

To delete ANI data 
1. Click YourSite > Devices > ANI.
2. Select the ANI and click Delete.

3. When prompted, click OK.

4. Click Save.

Adding Make Busy Reason Codes

When a voice agent places themselves in Make Busy, they become unavailable for ACD calls. Agents 
enter Make Busy Reason Codes to indicate why they are placing themselves in Make Busy and not 
answering interactions.
Voice agents can place themselves in Make Busy using: 
• Their phone sets orContact Center Client or Ignite
Make Busy Reason Code capacities: 
• <= 12 Make Busy Reason Codes can be configured via the telephone system
• > 12 Make Busy Reason Codes can be configured via Contact Center in YourSite Explorer 

NOTE: If the first twelve Make Busy Reason Codes do not align between YourSite Explorer and the 
telephone system, delete and re-enter them to ensure they align.

Conditions: 
• MiVoice Business supports single digit Make Busy Reason Codes but has the capacity to configure a 

total of 12 codes using the digits 0-9 and the characters * and #. 
– The digit 0 has a fixed name (0 Make Busy) that cannot be changed. Naming is programmable for 

the single digits from 1 – 9 and for * and #
• When programming the first 12 Make Busy Reason Codes in MiContact Center Business, ensure they 

align with the single digit reason codes on the telephone system, as described above.
• MiContact Center Business enables you to configure double digit Make Busy Reason Codes. Double 

digit Make Busy Reason Codes can be any combination of numbers provided the first digit is not a 0.
• Make Busy Reason Codes >12 are configured in YourSite Explorer and are visible to all MiContact 

Center Business client users and included in MiContact Center Business reports.

In order for agents to place themselves in Make Busy using their phone sets, the Make Busy with Reason 
option must be enabled on the telephone system.
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Limitations: 
• Make Busy Reason Codes programmed on MiVoice Business are not synchronized with MiContact 

Center Business and must be added manually if you want to report on them and view their use in real 
time.

• Make Busy Reason Codes configured in YourSite Explorer are not written back to MiVoice Business.

Default Make Busy Reason Codes:
Four Make Busy Reason Codes are configured by default with MiContact Center Business and cannot be 
deleted from YourSite Explorer: 
• The -1 Make Busy Reason Code (System Make Busy Code) is allocated by the Enterprise Server 

when calls or multimedia interactions are requeued.
• The -2 Make Busy Reason Code (Resize Timer) is allocated when Hot Desking Agents are in a Non 

ACD call or are off hook. This Code applies to voice only.
• The -3 Make Busy Reason Code (Contact Center Work Timer) is allocated when agents are in Work 

Timer. This Code is specifically allocated for configurations that use Queue Work Timer instead of the 
default Class of Service Work Timer. 

NOTE: The -3 Make Busy Reason Code is no longer used in Version 8.1+. However, the Code 
remains in the system in order to summarize Version 6.x data in reporting.

• The -4 Make Busy Reason Code (Overloaded) is allocated when agents reach their Workload 
maximum for a media type. For more information on Workload, see "Adding employee Workload". 

NOTE: The default Make Busy Reason Codes listed above do not impact the alignment of the first 
twelve reason codes used on the telephone system and the first twelve reason codes manually 
entered in YourSite Explorer.

To add a Make Busy Reason Code 
1. Click YourSite > Make Busy Reasons.
2. Click Add.

3. Type a Name and Reporting number for the Make Busy Reason Code. 

Single digit reporting numbers can use any digit between 1-9. Make Busy Reason Code 0 is reserved 
for telephone system Make Busy. Double digit reporting numbers can use any combination of num-
bers provided the first digit is not a 0.

4. Click Save.

Adding Do Not Disturb (DND) Reason Codes

Interactive Contact Center enables supervisors to control the availability of agents and ACD queues. Like-
wise, agents can control their own availability, including placing themselves in or removing themselves 
from Do Not Disturb. There are many reasons why agents are placed in Do Not Disturb. You add these 
reasons in YourSite Explorer.
To add a Do Not Disturb Reason Code 
1. Click YourSite > DND Reason Codes.
2. Click Add.

3. Type a Name and Reporting number for the Do Not Disturb Reason Code.

4. Click Save.
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Adding phone numbers

Phone numbers are used for running MiVoice Analytics reports. The phone number device enables you to 
• Add area codes/city codes, city exchange information, and contacts.
• Edit location information that displays in reports.

NOTE: Area codes you want to use in MiContact Center Business to provide data to agents, route calls to 
appropriate end points, and use to report on contact center functions should be added as ANI. For more 
information on ANI, see "Defining ANI data".
When adding a phone number to the database, you select 
• Area/City code when you are adding or updating the area code for a province/state/city 

For the phone number 613-599-0045, 613 is the area code.
• City exchange when you are adding a new exchange 

For the phone number 613-599-0045, 599 is the city exchange (Kanata).
• Contact when you are adding a phone number with contact information 

For the phone number 613-599-0045, 5990045 is the contact.

To add a phone number area/city code 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Phone numbers.

3. Click Add > Add an area/city code.

4. Select a country and type an area/city name and area code. 

An area can be a city, region, province, or state.
5. Click Save.

To add city exchange information 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Phone numbers.

3. Click Add > Add a city exchange.

4. After Country, select a country.

5. After Area/City name, select a city, region, province, or state (for example, Greater Toronto Area).

6. After City name, type the name of a city or suburb (for example, Thornhill).

7. After City/Exchange, type a city exchange number (for example, 231). 

For the phone number 416-231-5555, 231 is the city exchange.
8. Click Save.

To add phone number contact information 
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Phone numbers.

3. Click Add > Add a contact.

4. After Country, select a country.

5. After Area/City name, select a city, region, province, or state (for example, Washington).
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6. After City name (optional), select a city or suburb (for example, Des Moines).

7. Type a contact name and number. 

This information displays in the Phone Number Accounting Trace and Phone Number Group Account-
ing Trace reports.

8. If you want to hide the contact name and number in reports select the Hide the name and number 
in reports check box. 

The hidden phone numbers appear as 10 zeros and the name/location field is blank.
9. On the ribbon, click Save.

Adding phone number groups

You can associate Phone numbers with Phone number groups. Phone number groups are added in Your-
Site Explorer and then Phone numbers are associated with them.
To add a Phone number group
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Phone number groups.

3. Click Add.

4. Type a Name and Reporting number for the Phone number group.

5. Click Save.

To associate a Phone number with a Phone number group
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Phone number groups.

3. Select a phone number group from the list.

4. On the Membership tab, under Available members, select a Phone number and click > to move the 
Phone number to the Selected members list.

5. Click Save.

Configuring business hour schedules
MiContact Center Business performs certain tasks during business hours and other tasks after business 
hours. You create schedules to specify your business' hours of operation and to apply these hours to 
devices. For example, a business schedule applied to a queue will open and close the queue in alignment 
with that schedule. You can create yearly or seasonal schedules.
For example, Multimedia Contact Center can send ‘business hour’ auto-response messages to 
customers contacting you during business hours, and ‘after hours’ auto-response messages to customers 
contacting you after hours. Applying a schedule to a Multimedia Contact Center workflow tells the system 
when to send each type of message.
MiContact Center Business ships with two default schedules: The default 24/7 schedule for businesses 
that operate 24 hours a day, seven days a week, and the default Monday to Friday 9:00 AM to 5:00 PM 
schedule. You can modify these schedules according to your business needs. You can also create 
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schedule exclusion lists, which enable you to omit days such as national holidays from schedules. See 
"Managing schedule exclusion lists".
The following procedures tell you how to 
• Create and modify schedules
• Manage schedule exclusion lists

Creating and modifying schedules

The schedules you create do not expire. The weekly schedule configuration applies week after week until 
you change the schedule or apply a different schedule to the device. You can exclude specific dates from 
the schedule for national holidays.
To create a schedule
1. Select YourSite > Schedules.
2. Click Add.

3. After Name, a descriptive name for the schedule.

4. To apply a schedule exclusion list, click the Browse button.

5. Select an exclusion list to apply and click OK.

NOTE: The Schedule exclusion list specifies days to be omitted from the schedule. To create a 
schedule exclusion list, or to edit an existing schedule exclusion list, see "Managing schedule exclu-
sion lists".

6. After Start time, type the business day start time for each day of the week.

7. After End time, type the business day end time for each day of the week.

8. After Disable for day, select the check box for each day your business is closed.

9. Click Save.

To modify a schedule
1. Select YourSite > Schedules.
2. Select the schedule to modify.

3. After Name, type a new name for the schedule. For example, ‘Monday to Friday 8:00 AM to 6:00 PM’.

4. After Schedule exclusion list, click the Browse button.

5. Select a schedule exclusion list to apply to the schedule and click OK.

NOTE: The Schedule exclusion list specifies days to be omitted from the schedule. To create a 
schedule exclusion list, or to edit an existing schedule exclusion list, see "Managing schedule exclu-
sion lists".

6. After Start time, type the new business day start time for each day of the week.

7. After End time, type the new business day end time for each day of the week.

8. After Disable for day, select the check box for day your business is closed.

9. Click Save.
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To set Time Zone for Schedule Activities
1. Select YourSite > Schedules.
2. Select the schedule to modify and click Properties.

3. Select the required timezone from Timezone Region drop down box and click OK.

Managing schedule exclusion lists

Schedule exclusion lists enable you to omit days from schedules you create. For example, you can use 
a schedule exclusion list to omit national holidays from a yearly schedule.
The following procedures show you how to 
• Create and apply new exclusion lists to schedules
• Apply existing exclusion lists to schedules
• Remove exclusion lists from schedules
• Edit and remove dates from schedule exclusion lists
• Delete exclusion lists from YourSite Explorer

NOTE: To edit or delete a list you must first select a schedule with an exclusion list already applied to it. 
You can then access schedule exclusion lists, and the buttons for editing and deleting lists, by clicking 
‘Manage schedule exclusion list’.
To create and apply a new exclusion list to a schedule 
1. Click YourSite > Schedules.
2. Click Add.

3. Click Manage schedule exclusion list.

4. After Name, type the name of the exclusion list. 

NOTE: To create a new list for a schedule with an exclusion list already applied to it, click 'Add' and 
follow steps 4 onward.

5. On the calendar, click the dates to exclude from the schedule.

6. Click Save.

7. To apply the exclusion list to the selected schedule, click Apply. Otherwise, close the schedule exclu-
sion list designer window.

8. Click Save.

To apply an existing exclusion list to a schedule 
1. Click YourSite > Schedules.
2. Select the schedule to which you will apply a schedule exclusion list.

3. After Schedule exclusion list, click the Browse button.

4. Select a schedule exclusion list and click OK.

5. Click Save.

6. Repeat these steps for other schedules to which you will apply the exclusion list.
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To remove an exclusion list from a schedule 
1. Click YourSite > Schedules.
2. Select the schedule from which you will remove a schedule exclusion list.

3. After Schedule exclusion list, click the Clear button.

4. Click Save.

To edit and remove dates from an exclusion list 
1. Click YourSite > Schedules.
2. Select a schedule with an exclusion list applied to it and click Manage schedule exclusion list.

3. Click Edit.

4. To add new dates, select the dates from the calendar.

5. To remove dates, select the dates from the list and click Remove.

6. To remove all dates, click Clear.

7. Click Save

8. To apply changes to the schedule, click Apply.

To delete an exclusion list from YourSite Explorer 
1. Click YourSite > Schedules.
2. Select a schedule with the exclusion list to delete. 

NOTE: If you are deleting exclusion lists as part of clean-up, select any schedule with an exclusion 
list applied to it and follow the steps below.

3. Click Manage schedule exclusion list.

4. From the drop-down list, select the exclusion list you want to delete.

5. Click Delete.

6. Click Save.

Applying schedules

You can apply the schedules you create to 
• Media servers
• Queues
• Workflows, if you are licensed for IVR or Messaging and Routing. 

See "Configuring the Schedule activity".
• Alarms
• WallBoarder sign plan business hour and scheduled messages
• Interactive Contact Center queue control 

See Opening and closing voice queues with business hour schedule".
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Monitoring and alarming subsystem
MiContact Center Business uses a centralized alarming system configured in YourSite Explorer. The 
MiContact Center Maintenance Alarm Dispatcher Service is located on the Enterprise Server and 
performs server maintenance activities as well as controlling all alarming in the network. Alarm notifica-
tions are sent for each device that is triggering an alarm and is distributed in the following ways: 
• Email: Summary emails are sent to valid email subscribers and list all current, active alarm statuses 

as well as a list of alarms that triggered the alert. Emails contain the most recent alarm changes 
followed by a list sorted by priority.

• RSS: An RSS feed is published on the server and can be subscribed to by any RSS reader that has 
been given access to the server.

• Start Page: A list of currently active MiContact Center Business alarms with a Knowledge Base article 
list of descriptions, severities, impacts on contact centers, and troubleshooting information can be 
viewed on the Start Page of YourSite Explorer. The Start Page displays alarms by priority. See "Your-
Site Explorer Start Page".

By default, alarms are configured to expire after 24 hours.
The MiContact Center Server Monitor is a standalone service that is deployed on each server in the enter-
prise. It monitors performance counter values based on alarm configuration, collects external alarm data 
from services, and notifies the MiContact Center Maintenance Alarm Dispatcher Service when alarm 
states surpass configured thresholds.
Alarms may also be viewed with the Enterprise Status icon and RSS feed link, located in the lower-right 
corner of the YourSite Explorer and Contact Center Client windows and in the upper-right corner of 
CCMWeb. In order to view the Enterprise Status icon and RSS feed link in all of the applications in which 
they are present, we recommend you log in as an Administrator.
The Enterprise Status icon is a circular, colored status indicator. The color indicates the highest level of 
severity for all alarms currently alerting (Normal = Green, Minor = Yellow, Major = Orange, Critical = Red, 
Unknown = Gray). If you subscribe to the RSS feed you will be notified with changes to alarm states in 
your RSS reader. If you don’t subscribe to the RSS feed, you can click the RSS feed link and view active 
alarms in your default browser. The RSS feed does not automatically refresh and must be refreshed 
manually.
In addition to receiving notification of alarms, you can quickly view Enterprise status and active alarms 
using the YourSite Explorer Start Page’s Alarms tab. The Alarms tab consists of two panes: the Feed 
Preview and the Mitel Knowledge Base pane. The Feed Preview contains an RSS feed of the active 
alarms. The Mitel Knowledge Base pane contains a table of contents linking to relevant Knowledge Base 
(KB) articles for each alarm. Each KB article contains a description of the reason for the alarm, the 
severity of the alarm, the impact on contact centers, and troubleshooting steps.
If you have multiple servers and you want to be able to determine which server is emailing an alarm, you 
can set up a unique 'From' address for the emails delivered from the MiContact Center Business server 
in the 'From Name' field of the Outgoing tab in the mail server configuration window in YourSite Explorer.
Alarms are categorized based on the type of data they analyze. There are three types of alarms: 
• Performance counter and Registered services performance counter alarms: based on perfor-

mance counters
• Media server alarms: independently tracked for each media server
• General alarms: all other alarms
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The following procedures explain how to 
• Configure Performance counter and Registered services performance counter alarms
• Configure Media server alarms
• Configure General alarms
• Disable or enable alarms
• Temporarily disable ('Snooze') alarms

These configurations take place in YourSite > Alarms.
To configure Performance counter and Registered services performance counter alarms 
1. Select the Performance counter or Registered services performance counter alarm you want to 

configure and click the General tab.
2. To specify an SNMP category in which the alarm displays, after Category, select a category type from 

the drop-down list. 

NOTE: SNMP Version V3 and above is not supported.
3. Set Minor, Major, and Critical thresholds and threshold alert delays for the alarm. 

NOTE: Thresholds determine the severity of the alarm when the specified condition is met. The 
threshold alert delay settings determine the how long an alarm state is active before an alarm is trig-
gered and notification is sent.

4. To disable a threshold, from the drop-down list next to the threshold select Disabled.

5. To be notified when the alarm value changes, select the Re-alert on value change check box.

6. Click the Actions tab.

7. To send subscribers emails of alarms when the alarm is triggered, under Email action, select the 
Enabled check box.

8. Click Browse and select a Business hours schedule to apply to the alarm.

9. To receive notifications of critical alarms, outside of business hours, select the Ignore business 
hours for critical alerts check box.

10. Click Save.

To configure Media server alarms 
1. Select the Media server alarm you want to configure and click the General tab.
2. To specify a category in which the alarm displays, after Category, select a category type from the 

drop-down list.

3. After Severity, select the level of severity to apply to this alarm (Minor, Major, or Critical).

4. After Alert delay, select how long the alarm state is active before an alarm is triggered and notification 
is sent.

5. To disable the alarm for specific media servers, after Disable media servers, click the … button, 
select the media server from the Select disabled media servers window, and click OK.

6. To clear a disabled media server selection, click Clear.

7. Click the Actions tab.

8. To send subscribers emails of alarms when the alarm is triggered, under Email action, select the 
Enabled check box.
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9. Click the Browse button and select a Business hours schedule to apply to this alarm.

10. To receive notifications of critical alarms, outside of business hours, select the Ignore business 
hours for critical alerts check box.

11. Click Save.

To configure General alarms 
1. Select the General alarm you want to configure and click the General tab.
2. To specify an SNMP category in which the alarm displays, after Category, select a category type from 

the drop-down list. 

NOTE: SNMP Version V3 and above is not supported.
3. After Severity, select the level of severity to apply to this alarm (Minor, Major, or Critical).

4. After Alert delay, select how long the alarm state is active before an alarm is triggered and notification 
is sent.

5. Click the Actions tab.

6. To send subscribers emails of alarms when the alarm is triggered, under Email action, select the 
Enabled check box.

7. Click the Browse button and select a Business hours schedule to apply to this alarm.

8. To receive notifications of critical alarms, outside of business hours, select the Ignore business 
hours for critical alerts check box.

9. Click Save.

To disable or enable an alarm 
1. To disable an alarm, select the alarm and click the General tab.
2. Click Disable.

3. Click Save.

4. To re-enable an alarm, select the alarm and click the General tab.

5. Click Enable.

6. Click Save.

To temporarily disable (‘Snooze’) an alarm 
1. Select the alarm to disable and select the General tab.
2. Click Snooze and, from the drop-down list, select how long the alarm will be disabled.

3. To customize the snooze duration, from the Snooze drop-down list select Custom… and set the date 
and time at which the alarm reactivates.

4. Click Save.

Validating configuration and clearing alarms

The Validate button manually triggers a validation of your contact center system configuration by going 
through Class of Service system options, SMDR options,agent groups, voice queues, and media servers, 
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firing or clearing alarms as appropriate. Validation automatically takes place with the synchronization that 
occurs during nightly maintenance, but manual validation is required to clear some alarms.
To validate YourSite Explorer configuration 
1. In YourSite Explorer, click the Tools tab.
2. Click the Validate button.

Configuring security settings
You create security roles if you want to restrict employees from specific devices and MiContact Center 
Business application areas that their licensing would otherwise enable them to access.
NOTE: In order for you to assign security roles, your account must be associated to a security role that has 
‘May manage security’ enabled.
Every time you run the MiContact Center Business installation, a default user is created. The default gives 
both the Mitel staff and the installer the assurance that there is at least one account with which to gain 
access to the CCMWeb website. After you install MiContact Center Business, you must change the 
default account password to a unique password. See "Changing the default administrator password".
MiContact Center Business has three default security settings: 
• Local administrator: These settings provide employees full access to all MiContact Center Business 

applications (to which the contact center and employees are licensed) and devices, and allow Write 
Back for synchronization.

• Enterprise administrator: These settings provide employees full access to all MiContact Center Busi-
ness applications (to which the contact center and employees are licensed) and devices, and allow 
Write Back for synchronization. Enterprise administrator security role assignments can only be 
changed by an employee who is assigned the role of an Enterprise administrator.

• Agent role: This setting provides employees with a restricted security role. It includes access to 
Contact Center Client, Employee Portal,and Ignite. Default Agents can access real-time monitors, 
customize the appearance of real-time monitors, access real-time online chat in Contact Center Client, 
and control their own real-time status and presence.

Employee access to applications is limited by their security role and their licensing. An employee’s secu-
rity role defines the application areas an employee can access and licensing limits what applications an 
employee can access. For example, an employee with the Enterprise administrator security role but no 
supervisor license would not be able to access YourSite Explorer.
The default user name and password are 
• Username: _admin
• Password: _password
• Security Role: Enterprise Administrator

The MiContact Center Business default security role ('Enterprise Administrator') allows employees full 
access to all of theMiContact Center Business applications (to which the contact center is licensed)and 
devices including Write Back for synchronization. 
Security roles have two components 
• Basic 

Basic security controls user access to the specific areas of MiContact Center Business.
• Advanced 
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Advanced security controls user access to customized lists of devices, real-time monitors, card de-
signs, reports, sites, and users.

Creating and applying security roles

You can create security roles that have a number of combinations of basic and advanced authorizations 
applied to them. For example, you can create a security role with minimal security restrictions, granting 
users access to as many reports and applications as you designate. Alternatively, you can create a secu-
rity role that has full access to some MiContact Center Business application areas but is restricted from 
accessing other sites, reports, devices, and application components.
To create and apply a security role, you must 
1. Ensure employees are configured in the YourSite database.
2. Create security lists (If you intend to use advanced security).

3. Configure security settings to provide access to applications under General tab. 

You can broadly restrict an employee from accessing an entire application area with the security set-
tings under General tab. For example, you could restrict an employee from configuring devices in 
YourSite Explorer.

4. Optionally, configure advanced security under specific application tabs. 

You can restrict the employee from specific application components with advanced security.
For example, you could specify supervisors only view only employee reports (specific report type) on 
the employees they manage (specific devices) through creating a report list and restricting access to 
a specific report type and creating a device list and restricting access to a specific group of employees

5. Assign the security role to one or more employees.

Creating security lists

You can use advanced security options to restrict user access to sites, reporting, and real-time functions.
Before you can specify advanced security, you must create security lists (device lists, real-time monitor 
lists, report lists, site lists, and user lists). Each list must contain the devices, real-time monitors, reports, 
sites, and users to which employees are granted access. You can combine these lists when you assign 
a security role. For example, you can specify advanced security that permits users to create Employee 
Group Performance by Employee reports (specific report list) on Kanata employees (specific device list) 
only.
Use the following security lists to define advanced security: 
• Device list—Device lists specify devices for which employees may view real-time information. You 

create device lists to restrict access to statistics on specific employees. For example, you might want 
a manager to view certain employees only (specific device - Kanata employees). The device list must 
contain the device (employee group - in this case, Kanata employees) to which the user may gain 
access. Devices include Account Code Group, Agent group, DNIS group, Employee Division, 
Employee group, Extension Division, Queue group, Team, Trunk Group, Voice extension group, and 
Voice mail extension group. 

NOTE: If you add an agent to a device list, you must also add the associated employee.
• Report list—You create report lists to restrict users from viewing specific report types. For example, 

you might want managers to view employee reports only (specific report category). The report list must 
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contain the reports the user may run. If you do not assign a report list to the employee, then the 
employee will see every YourSite group and team when running reports and monitoring real-time activ-
ities (unless a basic security role is assigned to that employee that does not permit the employee to 
gain access to any reports).

• Profile list—You create a profile list to restrict users from managing specific real-time monitor profiles.
• Site list—You create a site list to restrict users to accessing only certain sites.
• Real-time monitor list—The real-time monitor list specifies real-time monitors to which you are 

granted access. You create a real-time monitor list to restrict access to particular real-time monitors. 
The real-time monitor list must contain the monitors that the user will access.

• User list—You create a user list to restrict a user from chatting online with certain employees. The 
user list must contain the employees with which the user may chat. For example, you might want 
managers to chat online with only the employees they supervise. If Jane manages Bill, Sue, and 
George, then you assign Jane an advanced security role that permits Jane to chat with Bill, Sue, and 
George (the user list would contain Bill, Sue, and George).

• Card design list—You create a card design list to restrict users from managing card designs (card 
designs specify the information displayed on agent, employee, and extension real-time monitors).

If you are using Windows Authentication, you must also enable the following browser settings: 
• Under Internet Options > Security, enable ‘Automatic logon with current user name and password’
• Under Internet Options > Advanced, enable ‘Enable Integrated Windows Authentication’

To create a security list 
1. Under the Enterprise pane, click Security list. This displays a pane with the type of security list you 

want to create.
2. Select the security list you want to add and click Add. A selection dialog appears displaying the 

Device Type

3. Select the check boxes of the group you want to include in the device list. Click OK.

4. Enter the list Name.

5. Enter the list Description.

6. Click Save to save the changes.

To delete a security list 
1. Under the Enterprise pane, click Security list.
2. Select the security list you want to delete and click Delete.

Configuring security roles

You can configure security to restrict user access to specific areas of CCMWeb and the Contact Center 
Client, YourSite Explorer, Workforce Scheduling, Employee Portal, and Ignite applications.The following 
figure shows the security options available under General tab.
For example, if you want to restrict users from accessing Contact Center Client and Enterprise Configu-
ration, then you must create a security role with those characteristics.
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You can further configure security options under the specific tabs to restrict access to reports, real time 
and Interactive Contact Center statistics, Chat, sites, and real-time monitors. These security options often 
require that appropriate security lists be made. (See the following figure.)

The following table describes the specific setting options for YourSite Explorer synchronization for secu-
rity.
Table 7.4: YourSite Explorer synchronization - security setting options  (Sheet 1 of 2)

Option Description

None If None is enabled you cannot view or configure 
Enterprise settings or devices in YourSite 
Explorer.
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Figure 7.6: Security roles settings options for Yoursite Explorer

Advanced security role options require the creation of a security list before the role can be configured. 
Using these lists, you can define a security role's access to devices. See "Creating security lists".
Security roles are assigned to employees in their General tab. See "Configuring general employee infor-
mation".
To add a security role 
1. In the Enterprise pane, click Security role.
2. Click Add.

3. Type a role name in Name.

4. Type a description in Description.

Allow Read Access Allow Read Access enables you to read 
Enterprise and device configuration settings in 
YourSite Explorer.

Allow Read/Write Access Allow Read/Write Access enables you to read 
Enterprise and device configuration settings in 
YourSite Explorer and write them to the YourSite 
database.

Allow Full Control Allow Full Control enables you to read Enterprise 
and device configuration settings in YourSite 
Explorer, write them to the YourSite database, 
and write back devices programmed in YourSite 
Explorer to the telephone system.

Table 7.4: YourSite Explorer synchronization - security setting options (Continued) (Sheet 2 of 2)

Option Description
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5. Go to any specific components tabs to specify advanced security and clear the check boxes of the 
items the user is not permitted to use.

6. Click Save.

To verify the properties of a security role 
1. In the Enterprise pane, click Security role.
2. Click the security role for which you want to view properties. 

You can assign the security roles to new users and to existing users.

To edit a security role 
1. In the Enterprise pane, click Security role.
2. Select the security role and click Edit.

3. Make the desired changes to the security role.

4. Click Save. 

NOTE: Users who are currently logged on will not be affected by changes made to their associated 
role until the next time they log on.

Viewing your security role properties

Users with access to YourSite Explorer can view their own security role properties and determine the 
application areas to which they have access. Only employees with access to YourSite Explorer and 
whose security role permits managing security can change the security role properties of employees.
To view the security role properties for your login credentials in YourSite Explorer
• Under Enterprise, click My Role Allowed.
To view the security role properties for your login credentials in CCMWeb
• Hover over My options and select My security role.

Assigning security roles to employees

NOTE: Users who are currently logged on will not be affected by changes made to their associated role 
until the next time they log on.
To assign a security role to an employee 
1. Select an employee
2. Click the General tab.

3. After Security role, click the Browse button.

4. Select a security role. 

The default Local Administrator and Enterprise Administrator allows employees full access to all 
of the MiContact Center Business applications and devices (to which the contact center is licensed) 
and for Write Back for synchronization.

NOTE: The default security role applied to new employees can be changed in the Configuration tab 
of YourSite Explorer.

5. Click OK.
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6. Click Save.

Interactive Visual Queue
Interactive Visual Queue is a Contact Center Client real-time monitor that enables supervisors to both 
monitor and control the content in contact center queues.
Interactive Visual Queue includes a Queued media grid and an Abandoned media grid. In the Queued 
media grid, supervisors and agents can view calls within queues and then use a drag-and-drop operation 
to move calls from busy queues to less active queues. In the Abandoned media grid, supervisors can view 
abandoned call information, including the caller name, phone number, and time of the abandoned call. 
Agents can use the Abandoned media grid to call back abandoned callers.
NOTE: Ring Groups are not supported with Interactive Visual Queue and any queue groups displayed in 
Interactive Visual Queue will not display calls in the Ring Group queues.

Configuring Interactive Visual Queue

In YourSite Explorer, for each queue you want to monitor, you must configure the priority level and the 
method for handling interflowed calls. The values you configure must match the values specified on the 
Path Assignment form of your telephone system.
The YourSite Explorer settings for Interactive Visual Queue monitors do not affect workflow activity on the 
actual queues. These settings only affect the way Interactive Visual Queue displays the queue monitors 
in Contact Center Client. If you want to modify workflow on the actual queues, you must change the tele-
phone system settings.
• Add all other devices for which you intend to run reports or use in your contact center, for example, 

employee groups, Account Codes, Make Busy Reason Codes, etc. See "Configuring the YourSite 
database".

• In YourSite Explorer, under Enterprise, create schedules that specify the business hours of your oper-
ation that will be used for media servers, queues, and alarms.

• In YourSite Explorer, under Enterprise, specify alarm settings. See "Monitoring and alarming 
subsystem".

• In YourSite Explorer, under Enterprise, restrict user access to specific devices and MiContact Center 
Business application areas. See "Configuring security settings".

Calls interflowed automatically retain the original call priority, or adopt the priority of the new queue based 
on telephone system settings. The interflow options you specify for a queue in YourSite Explorer must be 
identical to those of the telephone system. For more information on configuring interflowed calls, see 
"Adding queues".
If the telephone system settings and Interactive Visual Queue settings do not match, Interactive Visual 
Queue will not display the correct call activity. For example, if Queue 1 is set to a priority of 10 on the 
telephone system and a priority of 20 in YourSite Configuration, Interactive Visual Queue will display calls 
in Queue 1 as priority 20. However, the actual queue will handle the calls as priority 10.
In order to use Interactive Visual Queue, you must enable all HCI options on Class of Service Assignment 
form 1 (COS 1)
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If you want Interactive Visual Queue to automatically insert 1 when calling back long distance phone 
numbers, you must program your telephone system ARS accordingly. For more information, see the Mitel 
3300 ICP System Administration Tool Help.

Configuring Workforce Scheduling
Workforce Scheduling enables supervisors to create customized employee schedules, forecast sched-
uling requirements, match employee skills to those skills required for jobs in each schedule, view the 
distribution of employees across each schedule, and access schedule reports.
You assign the May manage Workforce Scheduling security role to all employees who require access to 
supervisory Workforce Scheduling features. To enable employees to access Employee Portal (software 
included with Workforce Scheduling) features, you assign them the following security role permissions: 
May access Employee Portal, May trade shifts, May trade time off, May request changes to availability. 
The default security role Agent Role provides access to Employee Portal.
You enable Workforce Scheduling, if your contact center is licensed for it, during the MiContact Center 
Business software installation.
NOTE: Workforce Scheduling can only be enabled on client computers that are part of the same Windows 
domain as the SQL Server.

Before configuring Workforce Scheduling

Before you configure Workforce Scheduling, you must enable remote SQL Server connections and grant 
SQL Server permissions to Workforce Scheduling users.

Enabling remote SQL Server connections

To enable remote SQL Server 2014 connections
1. On the SQL Server, in the Microsoft SQL Server 2014 program folder, navigate to the SQL Server 

Configuration Manager.
2. Under SQL Server Configuration Manager (Local), expand SQL Server Network Configuration and 

click Protocols for <SQL Server instance name>.

3. In the right pane, right-click Named Pipes and click Enable.

4. In the right pane, right-click TCP/IP and click Enable.

5. Under SQL Server Configuration Manager (Local), click SQL Server Services.

6. In the right pane, right-click SQL Server (<SQL Server instance name>) and click Restart.

7. In the right pane, right-click SQL Server Browser and click Properties.

8. Click the Service tab and after Start Mode, select Automatic.

9. Click Apply.

10. Click OK.

11. In the right pane, right-click SQL Server Browser and click Start.
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Granting SQL Server permissions

NOTE: 
• If your enterprise uses remote SQL and SQL Authentication, you can skip this step, because the 

required credentials are provided during the configuration of MiContact Center Business
• If you do not currently have a copy of Microsoft SQL Server Management Studio installed, you can 

download a free copy from Microsoft: http://www.microsoft.com/en-ca/download/default.aspx.

To grant SQL Server 2014, or 2016 permissions 
1. In Windows, open the Microsoft SQL Server 2014, or 2016 program folder and go to SQL Server 

Management Studio.
2. Connect to the desired SQL Server.

3. In the left pane, expand the Security tree and select Logins.

4. If the desired user is not listed, right-click Logins and select New Login.

5. After Login name, type the name of the Windows user account. 

Optionally, click Search to search for the user name.
6. If you have the users configured in groups on your domain, you can optionally add the group to add 

all users at once. 

If you want to grant SQL Server permissions to a domain group, you must click Search, click Object 
Types, and select the Groups check box.

7. Click User Mapping.

8. Under Users Mapped to this login, select CCMData.

9. Click OK.

10. Under Database role membership for: CCMData, select db_owner.

11. Click OK. 

Repeat steps 5-11 for all Workforce Scheduling users.

Configuring employee scheduling preferences

Schedule Builder uses employee preferences/options as parameters when scheduling employees. You 
must configure employee scheduling preferences accurately in YourSite Explorer to create a meaningful 
schedule.
To configure employee information for scheduling
1. Select the employee or employees you want to configure.
2. Specify the employee role.

See "Configuring employee roles".
3. Specify employee work hours.

See "Configuring employee work hours".
4. Specify employment status.

See "configuring employment status".
5. Specify employee payroll information.
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See "Configuring employee payroll information".
6. Specify employee availability.

See "Configuring employee availability".
7. Specify time off information.

See "Configuring employee time off".
8. Specify employee skills.

See "Configuring employee skills".

Configuring employee roles

To configure an employee role
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Employees.

3. Select the employee to which you will add an employee role.

4. On the Workforce Scheduling tab, click General.

5. If the employee is a supervisor who will schedule employees, select the Is a supervisor of sched-
uled employees check box.

6. After Schedule supervisor name, select the name of the scheduling supervisor from the list.

7. On the ribbon, click Save.

Configuring employee work hours

To configure employee work hours
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Employees.

3. Select an employee.

4. On the Workforce Scheduling tab, click Work hours.

5. Enter the minimum and maximum number of hours the employee can work in a day, week, or year.

6. If you want to schedule the employee for an unlimited number of hours, click Unlimited.

7. After Minimum time required between shifts, enter the minimum number of hours required between 
the employee's shifts.

NOTE: Ensure you set a minimum time between shifts or Schedule Builder will schedule 
back-to-back shifts for employees.

8. If the employee is permitted to work overtime, under Available, select an overtime type from the list 
and click > to move the overtime type to the Assigned list.

9. On the ribbon, click Save.
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Configuring employment status

To configure employment status
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Employees.

3. Select an employee.

4. On the Workforce Scheduling tab, click Payroll.

5. If the selected employee is full-time, under Employment status, select Full time.

6. If the selected employee is part-time, under Employment status, select Part time.

7. On the ribbon, click Save.

Configuring employee payroll information

NOTE: If you want to schedule employees by seniority, the employee must be assigned a hire date.
To configure employee payroll information
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Employees.

3. Select an employee.

4. On the Workforce Scheduling tab, click Payroll.

5. Select the employee's employment status.

6. Under Salary, after Pay period, select the pay period for the employee.

7. If the employee is paid an hourly salary, next to Hourly salary, specify the employee's pay per hour.

8. If the employee is paid a yearly salary, next to Yearly salary, specify the employee's yearly salary 
and the typical number of hours the employee works in a week.

9. On the ribbon, click Save.

Configuring employee availability

NOTE: If you do not specify availability, Schedule Builder assumes the employees are available 24 hours 
a day, seven days a week.
To configure employee availability
1. In YourSite Explorer, in the left pane, click YourSite.
2. Under Devices, click Employees.

3. Select an employee.

4. On the Workforce Scheduling tab, click Availability.

5. Select the Uses availability check box.

6. Under New Availability, after Work day, select the day of the week the employee availability applies 
to from the list.

7. If the employee is available only during certain hours of the day, select Part of the day and specify 
the hours the employee is available.
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8. If the employee is available all day, select Full day.

9. Click Add availability.

10. On the ribbon, click Save.

Configuring employee time off

To configure employee time off
1. In YourSite Explorer, in the left pane, click Workforce Scheduling.
2. Click Employees.

3. Select an employee.

4. On the Workforce Scheduling tab, click Time off.

5. If the employee's time off is carried over based on their start date, under Carryover date, select 
Employee start date.

6. If the employee's time off is carried over based on a fixed date, under Carryover date, select Fixed 
date and specify the carryover date.

7. If the employee is permitted time off, under Available, select the time off type from the list and click > 
to move the time off type to the Assigned list.

8. On the ribbon, click Save.

Overriding employee time off

To override an employee time off type
1. In YourSite Explorer, in the left pane, click Workforce Scheduling.
2. Click Employees.

3. Select an employee.

4. On the Workforce Scheduling tab, click Time off.

5. Under Assigned time off, select a time off type to override.

6. If you want to override the total number of time off hours allowed, select the Override total hours 
allowed check box and specify the number of hours.

7. If you want to override a percent of time off hours based on time worked, select the Override % of 
hours worked check box and specify the number of hours.

8. If you want to override the number of hours that can be carried over, select the Override allowed 
carry over and specify the number of hours.

9. If you want to override the time off hours available to the employee, after Available as of, specify the 
date after which the time off hours are available and number of hours that will be available.

10. On the ribbon, click Save.

Configuring employee skills

NOTE: If you have selected multiple employees to edit, skills that are not available to these employees are 
grayed out and cannot be assigned.



159

CONFIGURING WORKFORCE SCHEDULING
CHAPTER 7 CONFIGURATION

To configure employee skills
1. In YourSite Explorer, in the left pane, click Workforce Scheduling.
2. Click Employees.

3. Select an employee.

4. On the Workforce Scheduling tab, click Skills.

5. After Name, type the name of the subscriber.

6. Under Available, select the skill type from the list and click > to move the skill type to the Assigned list.

7. Repeat step 5 for all skills the employee will use.

8. On the ribbon, click Save.

Configuring schedule options

NOTE: 
• If you associate a schedule with a queue group, only those employees included in the selected queue 

group can be configured in the schedule. (Agents are members of agent groups, which are associated 
with queues that are members of queue groups.)

• If you do not associate a schedule with a queue group, you can schedule any employee whose profile 
enables you to schedule them in Workforce Scheduling.

Before you can build a schedule, either manually or using Schedule Builder, you must create a new 
schedule.
On the New Schedule window, you must:
• Name the schedule
• Associate the schedule with a queue or queue group (optional)
• Add employees to the schedule
• Configure business hours for the schedule
• Activate/Deactivate the schedule

You can create new schedules and configure all Workforce Scheduling options using the Schedule 
wizard. Optionally, use the Schedule tool to add, delete, rename, and activate/deactivate schedules. 
Within the Schedule configuration window, you can click Apply at any time to apply changes to the 
schedule without closing the Schedule configuration window.

Configuring holidays

You configure holiday options on the Holidays window. You can add holidays that affect your contact 
center, specify which holidays give employees the day off, and specify which holidays are paid.
To configure a holiday
1. In YourSite Explorer, in the left pane, click Workforce Scheduling.
2. Click Holidays.

3. Click Add.

4. After Name, type the name of the holiday.

5. If this holiday is a company holiday and you want to receive warnings when trying to schedule 
employees for this day, select the This holiday is a company holiday check box.
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6. Specify the pattern of the holiday.

– If the holiday always falls on the same day of the month, select Every and specify the month and 
date the holiday falls on.

– If the holiday has a pattern of falling on a certain day, week, and month, select The and specify the 
pattern, day of week, and month.

– If the holiday is a calculated holiday, such as Good Friday or Easter Monday, select Calculated 
holiday and specify the holiday.

7. On the ribbon, click Save.

Configuring overtime types

You can configure the following overtime parameters:
1. Pay rate multiplier—The number of times by which the basic pay is increased to calculate the over-

time pay rate. For example, if the pay rate multiplier is 1.5 and applied to $10 per hour, the overtime 
pay rate is $15 per hour

2. Color—The color in which the job displays in the time bar pane

3. Hours worked in a given day are greater than—The number of hours in a day an employee must 
work before the employee is paid at the overtime pay rate

4. Hours worked in a given week are greater than—The number of hours in a week an employee must 
work before the employee is paid at the overtime pay rate

5. Days of the week worked—Any work done on these days will be considered overtime pay

6. Day of the year worked—Any work done on this specific date will be considered overtime pay

7. Holiday worked—Any work done on this specific holiday will be considered overtime pay

To configure an overtime type
1. In YourSite Explorer, in the left pane, click Workforce Scheduling.
2. Click Overtime.

3. Click Add.

4. After Name, type the name of the overtime type.

5. Under Effects, enter a pay rate modifier and select a color for the overtime type.

6. Under Conditions, select either Hours worked, Days of the week worked, Days of the year 
worked, or Holiday worked.

– If you select Hours worked, you must select either Hours worked on a given day are greater than or 
Hours worked on a given week are greater than and specify the number of hours.

– If you select Days of the week worked, select the days of the week to which this overtime type 
applies.

– If you select Days of the year worked, select the days of the year to which this overtime type applies.
– If you select Holiday worked, select the holiday to which this overtime type applies.

7. On the ribbon, click Save.



161

CONFIGURING WORKFORCE SCHEDULING
CHAPTER 7 CONFIGURATION

Configuring time off types

Employees might take time off work for a variety of reasons. Depending on the nature of time taken off, 
employees might be paid, employees might be required to take a full day as time off, and employees might 
accrue time off (for example, vacation).
Create time off types that reflect the time off that employees take at your contact center.
• Consider if the type of time off should accrue, such as vacation, time off for a medical procedure, or 

personal days.
• Consider when the time off is accrued. For example, an employee might accrue 1 day of paid sick leave 

per month.
• Consider if the type of time off must be taken as a full day.
• Consider if employees must qualify for the type of time off.
• Consider if employees can carry the time off over to the next year.

Workforce Scheduling can warn you when employees do not qualify for the time off or when the scheduled 
time off is not within the limits allowed.
To configure a time off type
1. In YourSite Explorer, in the left pane, click Workforce Scheduling.
2. Click Time off.

3. Click Add.

4. After Name, type the name of the time off type.

5. If employees will be paid for this time off type, under Effects, select the Paid time off check box and 
select a color for the time off type.

6. If employees can request this type of time off from Employee Portal, under Effects, select the Can be 
requested check box.

7. Under Employment duration qualification, select either the Employed for at least or Employed 
no more than check box and specify the number of months.

8. Under Scheduling limitations, select either the You must schedule this type in increments of at 
least or You must not schedule this type for more than check box and specify the number of hours 
per day/week.

9. If you want to limit the number of hours this time off type can be scheduled, select the Limit the 
number of hours that can be scheduled check box.

– If you want to fix the annual amount of this time off type, select Fixed annual amount of and specify 
the number of hours.

– If the annual hours of this time off type are accrued, select the Annual hours are accrued check 
box and select either Weekly, Biweekly, or Monthly.

– If you want to base this time off type on a percent of the number of hours worked, select Based on 
hours worked at a rate of and specify a percent.

– If you want to carry over a fixed amount of accumulated time off hours, select Percent of accumu-
lated hours, at a rate of and specify a percent.

– If you want to carry over a percent of accumulated time off hours, select Percent of accumulated 
hours, at a rate of and specify a percent.

10. On the ribbon, click Save.
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Configuring shifts

A shift represents work hours on a given day for an employee. You can assign shifts to specific employees 
for any day of the week. You can create several shifts for one or more schedules. There are two types of 
shifts: fixed shifts and variable shifts. Fixed shifts have a fixed start time and duration. Variable shifts are 
based on the following shift variables:
Typical hours—the number of work hours for the shift
Minimum hours—the minimum number of hours for the shift
Maximum hours—the maximum number of hours for the shift
Minimum start—the time of day after which the shift must start
Maximum start—the time of day by which the shift must start
Color—the color in which the shift appears in the time bar pane.
You configure the following shift options using the Schedule tool:
• Add fixed shifts
• Add variable shifts
• Rename shifts
• Delete shifts

Configuring Work Timer
Work Timer provides agents handling calls with a period of time after they finish a call to set classification 
codes, handle paperwork, or deal with other administrative tasks before returning to handling calls. The 
primary Work Timer, Class of Service Work Timer, is configured in the Class of Service options for agents, 
but a secondary Work Timer, the Queue Work Timer, may also be configured for individual queues that 
require agents handling calls from that queue to have less time for post-call work.
When configured, after call completion, Class of Service Work Timer places the agent into the Work Timer 
real-time state and ACD calls no longer route to them. As the agent enters into the Work Timer agent 
state, their timer in Contact Center PhoneSet Manager or Contact Center Softphone begins counting 
down the configured Class of Service Work Timer duration. (In real-time monitors in Contact Center 
Client, Work Timer will count up.) When the countdown reaches 00:00:00 or if the employee manually 
ends Work Timer, they are returned to the Idle real-time state where they can handle calls again.
Agents can cancel Work Timer manually in Ignite or by pressing the Cancel Work Timer buttonon their 
hard set or soft phone applications. If the 'Force entry of a classification code' is enabled, agents must 
enter a classification code first. If they do not, Work Timer cannot be ended manually and a non-compli-
ance classification code will be assigned to the call when Work Timer expires. Work Timer also automat-
ically ends if the agent enters a classification code when the ‘Cancel work timer once code is entered’ is 
enabled.
The maximum duration for Class of Service and Queue Work Timers is 4 hours.
You can set the Queue Work Timer duration to suit each individual queue, for example, agents answering 
calls for your Support queue may typically require a longer work timer duration than those answering calls 
for the Sales queue. You must set the Class of Service Work Timer to a duration that is equal to or greater 
than your longest Queue Work Timer setting to prevent agents' work timers from ending prematurely. For 
example, if your Class of Service Work Timer is set for 3 minutes and your Queue Work Timer for your 



163

CONFIGURING CONTACT CENTER SCREEN POP
CHAPTER 7 CONFIGURATION

Support queue is set for 4 minutes, agents answering calls for that queue will be removed from Work 
Timer after 3 minutes.
If no Queue Work Timer is set on the queue, the default value configured on the Class of Service Work 
Timer will be used for that queue's associated agents. Multimedia Queue Work Timer is not dependent 
on MiVoice Business Class of Service Work Timer and can be set to any duration of time.
NOTE: 
• When leveraging the Queue Work Timer feature, the Class of Service Work Timer value must be accu-

rately synchronized to the media server for Queue Work Timer to function.
• When an agent receives a transferred call and enters into Work Timer, regardless of the queue the 

agent is in, their Work Timer duration is taken from the Queue Work;Timer duration set on the queue 
the call originally came in on.

For information on configuring Work Timer as a Class of Service for Media Servers, see "Editing Class of 
Service options".
For information on configuring Work Timer for queues, see "Adding queues".

Preparing media server agent timeout options for MiVoice Business

By default, YourSite Explorer is configured to clear lines if an agent using that line remains in a single 
state for more than two hours. This can impact Work Timer’s functionality if Work Timer has been config-
ured to be greater than two hours. To make proper use of the four hour Work Timer feature available to 
MiVoice Business, you must configure the agent state timeout audit options for your media servers to 
ensure that they do not interfere with Work Timer.
To configure the media server agent state timeout audit option 
1. In YourSite Explorer, click Media Servers.
2. Select your media server from the list of media servers.

3. Click the Data summary options tab.

4. After Clear line if agent primary Talk Time exceeds, select 24 hours from the drop-down list.

5. If you are using multiple media servers, repeat steps 2-4 for all your contact center media servers.

6. Click Save.

Configuring Contact Center Screen Pop
Contact Center Screen Pop can be configured to launch applications or webpages when calls are 
received and to enable agents to automatically receive caller and account information via pop-ups for 
incoming calls.
Contact Center Screen Pop is an optional application that requires Contact Center Softphone or Contact 
Center PhoneSet Manager. If you want to screen pop based on caller entered digits, you require IVR 
Routing with the Collect Digits activity.
NOTE: When using IVR to populate screen pop information, you must configure IVR ports and queues on 
the same telephone system.
The following information can be configured to display in the pop-up: 
• Caller name: name of the caller
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• ANI: telephone number of the caller
• DNIS: telephone number the caller dialed
• DNIS name: the name associated to the DNIS number in the YourSite database
• Agent ID: agent who transferred the call
• Extension: extension from which the call originated
• Queue: queue from which the call originated
• Collect Caller Entered Digits: digits the caller enters for identification purposes, such as a customer 

site key (IVR Routing required)
• Customer Collected Information: information collected from a third party OBDC database (IVR 

Routing required)
• Call notes: notes added by an agent. Call notes are supported for inbound calls only

Enabling and disabling Contact Center Screen Pop

When you enable or disable Contact Center Screen Pop, the settings you select determine Contact 
Center Screen Pop accessibility on a per-agent profile basis.
To enable or disable Contact Center Screen Pop 
1. Start Contact Center Client.
2. Click Soft Phone > Configure. 

The Soft phone configuration window opens.
3. Click the Screen pop tab.

4. To enable, Contact Center Screen Pop, select the Display Contact Center Screen Pop check box.

5. To disable Contact Center Screen Pop, clear the Display Contact Center Screen Pop check box.

6. Click OK.

Configuring Contact Center Screen Pop options

To configure Contact Center Screen Pop options 
1. In YourSite Explorer, click YourSite > Enterprise.
2. Click the Screen pop tab.

3. If you want to launch an application or Web page when calls are answered, select the Launch an 
application or Web page when agents answer receive calls check box.

4. If you want to display call statistics for incoming ACD calls, select Display the caller-specific 
Inbound trace report Web page. The Inbound Trace report tells you the number of times the caller 
has called in the last seven days and contains the following fields: Call Start Time, Call Duration, DNIS 
name, Agent name, Extension, and Account Code. (See the following figure.) 

NOTE: The Contact Center Screen Pop will launch this application field is automatically populated 
with the URL of the Inbound Trace Report.

5. To launch a specific Web page or application when calls are answered, select the Display a specific 
application or Web page check box and, under Contact Center Screen Pop will launch this appli-
cation or Web page, type the path for the executable file or the URL of the webpage and indicate any 
variables that the screen pop will contain. 
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NOTE: For important information on how to configure this field, click the ? button.
6. If Mitel Professional Services has provided you with an integrated custom screen pop select Display 

this Professional Services custom executable file or Web page. Click Manage to review the 
Professional Services custom screen pop options.

7. To enable screen pop on Non ACD calls, select the Screen pop on non ACD calls check box.

8. Click Save.

Figure 7.7: Inbound Customer Trace Report
 

Configuring Contact Center Screen Pop display variables

The variables described in the following table are used by Contact Center Screen Pop to determine the 
application area or Web page that launches when an agent answers a call. Ensure the required IVR 
Routing activities are available in workflows to use these variables.
NOTE: The variable names are case-sensitive. For an application, variables must be in quotes and sepa-
rated by a space.

Table 7.5: Contact Center Screen Pop display variables  (Sheet 1 of 2)

Variable
IVR Routing activity 
required Description

%PFCALLERNAME% ANI activity Caller name as provided by 
the telephone carrier. For 
example, 'John Smith'

%PFANI% ANI activity Caller number (ANI), the 
telephone number of the 
calling party. For example, 
'6135990045'

%PFDNIS% DNIS activity Dialed Number Identification 
Service (DNIS), numbers 
passed from the public 
telephone network to identify 
what phone number the caller 
dialed. This is typically used to 
identify different 1-800 or 
1-900 numbers. For example, 
'9875'
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To launch an application
• Type the URL of the executable file followed by the required variables. 

For example, C:\MyProgram\CustomerManagement.exe "%PFCALLERNAME%" 
"%PFANI%""%PFDNIS%""%PFVERIFIEDCOLLECTEDDIGITS%""%Queue%"

NOTE: Variables must be in quotes and be separated by a space.

If John Smith calls 1-800-266-9875 from 613-599-0045, is prompted to enter his account number (78831), 
and is then routed to the Sales queue, the executable file will use the actual values of the call, for example, 
C:\MyProgram\CustomerManagement.exe "John Smith""6135990045""9875""78831""Sales".
To launch a Web page
• Type the URL of the Web page followed by the required variables, as per standard HTTP protocol. 

For example, http://myintranetsite.business.com?CALLERNAME=%PFCALLERNAME%&ANI=%
PFANI%&DNIS=%PFDNIS%&COLLECTEDDIGITS=%PFVERIFIEDCOLLECTEDDIGITS%=%
PFVERIFIEDCOLLECTEDDIGITS%&QUEUE=%Queue%

If John Smith calls 1-800-266-9875 from 613-599-0045, is prompted to enter his account number (78831), 
and is then routed to the Sales queue, the Web page will use the actual values of the call, for example, 
http://myintranetsite.business.com?CALLER-
NAME=John%20Smith&ANI=6135990045&DNIS=9875&COLLECTEDDIGITS=78831&QUEUE=Sales.

%PFVERIFIEDCOLLECTEDDIGI
TS%

Collect Digits activity The digits entered by the user 
during the call. For example, 
account number '78831'

%Queue% ANI and DNIS activities Name of the queue from which 
the call is answered. For 
example, 'Sales'

%ReceivingAgent% N/A Contains the Agent ID for the 
agent receiving the current call

%ReceivingExtension% N/A Contains the Extension ID for 
the extension receiving the 
current call

%SendingAgent% N/A Contains the Agent ID for the 
agent sending or transferring 
the call to the current recipient

%SendingExtension% N/A Contains the Extension ID for 
the extension sending or 
transferring the call to the 
current recipient

Table 7.5: Contact Center Screen Pop display variables (Continued) (Sheet 2 of 2)

Variable
IVR Routing activity 
required Description
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Enabling MiTAI event logging

The MiContact Center Enterprise Service receives MiTAI events from the MiContact Center Data Collec-
tion Service and stores these events in a log file located in the DataDirectory\ CallControlEventLog 
sub-folder under the main installation directory. The MiContact Center Enterprise Service logs all events 
across all nodes in one file and time stamps events based on arrival time, providing insight when trouble-
shooting MiTAI linking issues. Additionally, ANI, DNIS, collected digits, and other custom variables 
arriving from IVR Routing are logged.
Incorrectly configured devices and monitors will result in missing MiTAI eventsand IVR Routing port 
events, causing lost data and screen pop failures.
To enable MiTAI event logging 
1. Browse to <drive>:\Program Files (x86)\Mitel\MiContact Center\Services\EnterpriseServer.
2. Open prairieFyre.Services.EnterpriseServer.exe.config in Notepad.

3. Click Edit > Find.

4. In the Find what field, enter LogCallTrackingMiTAIEvents and click Find Next. 

NOTE: If the LogCallTrackingMiTAIEvents key does not exist, you must create one. Enter <add key=" 
LogCallTrackingMiTAIEvents " value="true" />

5. Save the file.

6. Browse to the DataDirectory\CallControlEventLog folder.

7. Verify that MiTAIEvents*.txt is present in the folder.

8. Open MiTAIEvents*.txt and verify that the file contains MiTAI events. (See the following figure.)

Figure 7.8: MiTAI events example
 

Additionally, you must ensure that 
• All relevant devices including queues and extensions (or Hot Desking Agents in a hot desking resilient 

environment) have been synchronized or manually programmed successfully.
• The Advanced Real time option is turned on.
• The MiContact Center Data Collection Service log monitors were correctly set and there are no MiTAI 

errors (MiTAI errors will be shown as SXERR_*).
• IVR Routing ports are configured and monitored correctly. 

IVR Routing monitoring problems are demonstrated by call flow failure.
• IVR Routing ports are not programmed as 5020 IP ports. 

The IVR Routing messaging service automatically writes IVR Routing ports into the Mi Contact Center 
Business database. If the IVR Routing ports have been manually programmed and enabled for re-
al-time and advanced real-time monitoring, screen pop will not display correct results.
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Ignoring MiTAI events on UPiQ and callback capture ports

MiTAI events arriving on UPiQ ports and callback capture ports should be ignored to reduce MiTAI linking 
overhead.
To ignore MiTAI events on UPiQ and callback capture ports
1. Browse to <drive>:\Program Files (x86)\Mitel\MiContact Center\Services\EnterpriseServer.
2. Open prairieFyre.Services.EnterpriseServer.exe.config in Notepad.

3. Click Edit > Find.

4. In the Find what field, enter MitaiLinkerPortIgnoreList and click Find Next.

NOTE: If the MitaiLinkerPortIgnoreList key does not exist, you must create one. Enter <add 
key="MitaiLinkerPortIgnoreList" value="2230 , 2250-2260, 2270" />

5. Save the file.

Testing Contact Center Screen Pop search functions

This test will confirm that Contact Center Screen Pop will function with the software you selected. See 
"Configuring Contact Center Screen Pop options".
To test the search function in Contact Center Screen Pop 
1. Start Contact Center Client.
2. On the ribbon, click Soft Phone.

3. Click the Soft Phone button.

4. Click Configure.

5. Click the Screen pop tab.

6. Click Test.

7. Type the variables using the described format 

PFCALLERNAME—first name followed by last name, separated by a space (for example, John 
Smith)
PFANI—phone number (including area code if relevant) with no spaces, dashes, or brackets (for ex-
ample, 6135558769)
PFDNIS—phone number (including area code if relevant) with no spaces, dashes, or brackets (for ex-
ample, 8005556598)
PFVERIFIEDCOLLECTEDDIGITS—all digits the caller has entered since entering the telephone sys-
tem, with no spaces, dashes or brackets (for example, 1113)
Queue—queue that the caller first entered (for example, P500)

8. Click OK. 

A screen pop that contains the test parameters you specified will display. The outcome of the Contact 
Center Screen Pop test will change depending on the type of screen pop you have configured and the 
test parameters you entered.
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Configuring Lifecycle reports
Lifecycle reports provide detailed information on all of the events related to the life of a specific call, from 
the moment the call enters the telephone system to call termination. You can generate Lifecycle reports 
on selected devices, and can filter the reports by a number of options. If you have clustered your enter-
prise into a single site, you can run a Lifecycle report onsite to report on your entire enterprise. Lifecycle 
reports also include call notes and links to call recordings. For more information on Lifecycle reporting, 
see the Reports Guide appropriate to your licensed version of MiContact Center Business.
NOTE: 
• Since Lifecycle reports detail all events related to calls, there are significant database storage implica-

tions. With Lifecycle reports enabled, your database can fill up rather quickly. If you are unable to store 
the amount of data required for Lifecycle reports, we recommend configuring the system to purge Life-
cycle reports older than a certain number of days or turning off the Lifecycle report option.

• Lifecycle reports containing data for internal transferred ACD calls will not link data properly unless the 
Call ID feature on the telephone system is enabled.

• For statistical accuracy in MiContact Center Business, all MiVoice Business controllers within a cluster 
must use the same time zone in the Date and Time form of the MiVoice Business configuration. Local-
ized time display for devices can then be configured using the Network Zones form.

To purge Lifecycle reports older than a specific number of days 
1. In YourSite Explorer, under Enterprise, click Enterprise.
2. Click the Maintenance tab.

3. After Purge Lifecycle reports older than, specify the number of days.

4. Click Save.

To turn off Lifecycle reporting 
1. In YourSite Explorer, under Enterprise, click Enterprise.
2. Click YourSite > Enterprise.

3. On the Enterprise tab, disable the Enable Lifecycle reports check box.

4. Click Save.

Configuring Workforce Management integration
Workforce Management integration bridges MiContact Center Business with third-party Workforce 
Management solutions, sending historical data on agents and queues and streaming real-time data on 
agent states. You can use Workforce Management integration to assist third-party Workforce Manage-
ment solutions in forecasting call volumes, adjusting contact center requirements, and mapping agent 
adherence to schedules.
NOTE: 
• In order to implement Workforce Management integration, you must ensure the MiContact Center 

WFM Connector Service is set to automatic and running.
• Verint Impact 360 requires additional configuration for Workforce Management integration. For more 

information, see "Configuring Verint Impact 360 for Workforce Management integration".

The following third-party Workforce solutions are supported: 
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• Verint – Blue Pumpkin
• Verint – Monet
• Verint – Impact 360
• NICE – IEX TotalView
• Netcall – Q-Max
• Calabrio - Teleopti WFM

NOTE: Only voice data is included, for all the third party CRM connectors except Teleopti CRM 
Connector. Teleopti CRM connector includes both Voice and Omnichannel data..
For supported versions of third party Workforce solutions, see the Mi Contact Center Business and 
MiVoice Analytics System Engineering Guide .
Before you can configure your Workforce Management integration, you must configure your Blue 
Pumpkin, Verint Impact 360, NICE IEX Workforce Management (TotalView), QMax, Monet, or Teleopti 
software by following the recommended installation and configuration guidelines included with these 
products. Contact your Blue Pumpkin, Verint Impact 360, NICE IEX Workforce Management, QMax, 
Monet, or Teleopti approved vendor for all setup and troubleshooting issues.
The Workforce Management configuration page is rendered from CCMWeb. To ensure proper configura-
tion functionality, ensure that CCMWeb has been added as a Trusted Site. Failure to add CCMWeb as a 
Trusted Site may result in the Workforce Management configuration page being disabled.
If you are using Windows Authentication, you must also enable the following browser settings: 
• Under Internet Options Security, enable ‘Automatic logon with current user name and password’.
• Under Internet Options Advanced, enable ‘Enable Integrated Windows Authentication’

To configure Blue Pumpkin integration 
1. In YourSite Explorer, under Enterprise, click Work Force Management.
2. After Type,select Blue Pumpkin from the drop-down list.

3. Under Historical Data Collecting Intervals 

– After Demand Data (minutes), select the number of minutes' worth of collected data for report 
creation.

– After Non-Demand Data (hours), select the number of hours' worth of collected data for report 
creation.

– After Offset (minutes), select the number of minutes to wait before collecting data. To ensure accu-
racy, the number of Offset minutes must be equal to or greater than 15 minutes.

4. Under Remote FTP Server 

– After Address, type the address of the FTP server to which you will send reports.
– After Port, verify the port number. The default port number is 21.
– After Root, type the FTP server root. The default FTP server root is /ftp/switches/.
– After Username, type the user name for the FTP server.
– After Password, type the password for the FTP server. 

NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

5. After Reports Folder, type <drive letter:>\Program Files (x86)\Mitel\MiContact Center\Exten-
sions\WFM\Collected Data.
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6. If you want to store a copy of files on the Enterprise Server, enable the Keep Local Files check box.

7. If you are saving configuration changes to a pre-existing configuration, re-enter the password for the 
FTP server and click Save.

8. If this is an initial configuration and you are not making changes to a pre-existing configuration, click 
Save.

9. Restart the MiContact Center WFM Connector Service. 

NOTE: If the only changes made were enabling/disabling the 'Keep Local Files' option or changes to 
the 'Reports folder', the MiContact Center WFM Connector Service does not need to be restarted.

To configure Impact 360 integration 
1. In YourSite Explorer, under Enterprise, click Work Force Management.
2. After Type, select Impact 360 from the drop-down list.

3. Under Historical Data Collecting Intervals 

– After Demand Data (minutes), select the number of minutes' worth of collected data for report 
creation.

– After Non-Demand Data (hours), select the number of hours' worth of collected data for report 
creation.

– After Offset (minutes), select the number of minutes to wait before collecting data. To ensure accu-
racy, the number of Offset minutes must be equal to or greater than 15 minutes.

4. Under Remote FTP Server 

– After Address, type the address of the FTP server to which you will send reports.
– After Port, verify the port number. The default port number is 21.
– After Root, type the FTP server root. The default FTP server root is /ftp/switches/.
– After Username, type the user name for the FTP server.
– After Password, type the password for the FTP server. 

NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

5. After Reports Folder, type <drive letter:>\Program Files (x86)\Mitel\MiContact Center\CCM\Exten-
sions\WFM\Collected Data.

6. If you want to store a copy of files on the Enterprise Server enable the Keep Local Files check box.

7. Under Real-Time Data Socket Settings, after Port, type the socket port number, typically 12000. No 
value less than 1024 is permitted.

8. If you are saving configuration changes to a pre-existing configuration, re-enter the password for the 
FTP server and click Save.

9. If this is an initial configuration and you are not making changes to a pre-existing configuration, click 
Save.

10. Restart the MiContact Center WFM Connector Service. 

NOTE: If the only changes made were enabling/disabling the 'Keep Local Files' option or changes to 
the 'Reports folder', the MiContact Center WFM Connector Service does not need to be restarted.
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To configure IEX TotalView integration 
1. In YourSite Explorer, under Enterprise, click Work Force Management.
2. After Type, select TotalView from the drop-down list.

3. Under Historical Data Collecting Intervals 

– After Demand Data (minutes), select the number of minutes' worth of collected data for report 
creation.

– After Non-Demand Data (hours), select the number of hours' worth of collected data for report 
creation.

– After Offset (minutes), select the number of minutes to wait before collecting data. To ensure accu-
racy, the number of Offset minutes must be equal to or greater than 15 minutes.

4. Under Remote FTP Server 

– After Address, type the address of the FTP server to which you will send reports.
– After Port, verify the port number. The default port number is 21.
– After Root, type the FTP server root. The default FTP server root is /ftp/switches/.
– After Username, type the user name for the FTP server.
– After Password, type the password for the FTP server. 

NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

5. After Reports Folder, type <drive letter:>\program files\Mitel\MiContact Center\Exten-
sions\WFM\Collected Data.

6. If you want to store a copy of files on the Enterprise Server, enable the Keep Local Files check box.

7. After Media Server Mapping, determine the destination for reports by entering a report folder identi-
fier for each media server. 

NOTE: You can use the same destination folder for all media server reports.
8. If you want to exclude media server(s) from collecting Workforce Management data, deselect the 

Reporting enabled check box, which is enabled by default.

9. Under Real-Time Data Socket Settings 

– After Port, type the socket port number, typically 6999.No value less than 1024 is permitted.
– After Username, type the socket user name. Socket user names must have an alphanumeric value 

of 15 characters or less with no spaces.
– After Password, type IEX. 

NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

– After Heartbeat Interval (seconds), select the interval in seconds between each Heartbeat Request 
message. 
Heartbeat Request messages are issued by the Enterprise Server to IEX clients to establish and 
maintain communication. IEX clients receive these Heartbeat Request messages and respond to 
them. If the server does not receive a response message after waiting at least twice the specified 
heartbeat interval, it may terminate the session with the IEX client without notification. Setting the 
interval to zero helps ensure communication between the server and the client.
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10. If you are saving configuration changes to a pre-existing configuration, re-enter the password for the 
FTP server and Real-Time Data Socket Settings, and click Save.

11. If this is an initial configuration and you are not making changes to a pre-existing configuration, click 
Save.

12. Restart the MiContact Center WFM Connector Service. 

NOTE: If the only changes made were enabling/disabling the 'Keep Local Files' option or changes to 
the 'Reports folder', the MiContact Center WFM Connector Service does not need to be restarted.

To configure QMax integration 
1. In YourSite Explorer, under Enterprise, click Work Force Management.
2. After Type,select QMax from the drop-down list.

3. Under Historical Data Collecting Intervals 

– After Demand Data (minutes), select the number of minutes' worth of collected data for report 
creation.

– After Offset (minutes), select the number of minutes to wait before collecting data. To ensure accu-
racy, the number of Offset minutes must be equal to or greater than 15 minutes.

4. After Reports Folder, type <drive letter:>\Program Files (x86)\Mitel\MiContact 
Center\CCM\Extensions\WFM\Collected Data.

5. Under Real-Time Data Socket Settings, after Port, type the socket port number, typically 6999. 

No value less than 1024 is permitted.
6. Click Save.

7. Restart the MiContact Center WFM Connector Service. 

NOTE: If the only changes made were to the 'Reports folder', the MiContact Center WFM Connector 
Service does not need to be restarted.

To configure Monet integration 
1. In YourSite Explorer, under Enterprise, click Work Force Management.
2. After Type, select Monet from the drop-down list.

3. Under Historical Data Collecting Intervals 

– After Demand Data (minutes), select the number of minutes' worth of collected data for report 
creation.

– After Non-Demand Data (hours), select the number of hours' worth of collected data for report 
creation.

– After Offset (minutes), select the number of minutes to wait before collecting data. To ensure accu-
racy, the number of Offset minutes must be equal to or greater than 15 minutes.

4. Under Remote FTP Server 

– After Address, type the address of the FTP server to which you will send reports.
– After Port, verify the port number. The default port number is 21.
– After Root, type the FTP server root. The default FTP server root is /ftp/switches/.
– After Username, type the user name for the FTP server.
– After Password, type the password for the FTP server. 
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NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

5. After Reports Folder, type <drive letter:>\program files\Mitel\MiContact Center\Exten-
sions\WFM\Collected Data.

6. If you want to store a copy of files on the Enterprise Server, enable the Keep Local Files check box.

7. After Media Server Mapping, determine the destination for reports by entering a report folder identi-
fier for each media server. 

NOTE: You can use the same destination folder for all media server reports.
8. If you want to exclude media server(s) from collecting Workforce Management data, deselect the 

Reporting enabled check box, which is enabled by default.

9. Under Real-Time Data Socket Settings 

– After Port, type the socket port number, typically 6999. No value less than 1024 is permitted.
– After Username, type the socket user name. Socket user names must have an alphanumeric value 

of 15 characters or less with no spaces.
– After Password, type Monet. 

NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

– After Heartbeat Interval (seconds), select the interval in seconds between each Heartbeat Request 
message. 
Heartbeat Request messages are issued by the Enterprise Server to Monet clients to establish and 
maintain communication. Monet clients receive these Heartbeat Request messages and respond to 
them. If the server does not receive a response message after waiting at least twice the specified 
heartbeat interval, it may terminate the session with the Monet client without notification. Setting 
the interval to zero helps ensure communication between the server and the client.

10. If you are saving configuration changes to a pre-existing configuration, re-enter the password for the 
FTP server and Real-Time Data Socket Settings, and click Save.

11. If this is an initial configuration and you are not making changes to a pre-existing configuration, click 
Save.

12. Restart the MiContact Center WFM Connector Service. 

NOTE: If the only changes made were enabling/disabling the 'Keep Local Files' option or changes to 
the 'Reports folder', the MiContact Center WFM Connector Service does not need to be restarted.

To configure Teleopti integration 
1. In YourSite Explorer, under Enterprise, click Work Force Management.
2. After Type, select Teleopti from the drop-down list.

3. Select the Use Employee based stats check box to use the Teleopti Employee based reports and 
Real Time streaming. 

This displays the Employee’s overriding state. All voice and multimedia agent and queue data will be 
included in a single report file for every interval.

NOTE: If you have enabled the Employee based stats option in YSE, then the Include Inter flowed In 
Offered Count configuration option in WFM Service's configuration file is displayed. By default, the Tele-
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opti Contact Queue reports do not include Interflowed calls in the calculation for received calls; the 
received column of the Contact Queue report includes only answered calls and abandoned calls.

If the Include Inter flowed In Offered Count configuration value is set to True in WFM service's, 
then the results in the contact queue Offered column displays the Interflowed calls along with the An-
swered and Abandoned calls.

4. Under Historical Data Collecting Intervals 

– After Demand Data (minutes), select the number of minutes' worth of collected data for report 
creation.

– After Non-Demand Data (hours), select the number of hours' worth of collected data for report 
creation.

– After Offset (minutes), select the number of minutes to wait before collecting data. To ensure accu-
racy, the number of Offset minutes must be equal to or greater than 15 minutes.

5. Under Remote FTP Server 

– After Address, type the address of the FTP server to which you will send reports.
– After Port, verify the port number. The default port number is 21.
– After Root, type the FTP server root. The default FTP server root is /ftp/switches/.
– After Username, type the user name for the FTP server.
– After Password, type the password for the FTP server. 

NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

6. After Reports Folder, type <drive letter:>\Mitel\MiContact Center\CCM\Exten-
sions\WFM\Collected Data.

7. If you want to store a copy of files on the Enterprise Server, enable the Keep Local Files check box.

8. After Media Server Mapping, determine the destination for reports by entering a report folder identi-
fier for each media server. 

NOTE: You can use the same destination folder for all media server reports.
9. If you want to exclude media server(s) from collecting Workforce Management data, deselect the 

Reporting enabled check box, which is enabled by default.

10. Under Real-Time Data Socket Settings 

– After Port, type the socket port number, typically 6999.No value less than 1024 is permitted.
– After Username, type the socket user name. Socket user names must have an alphanumeric value 

of 15 characters or less with no spaces.
– After Password, type Teleopti. 

NOTE: Make note of this password. Any configuration changes made to the connector after its 
initial save require you to re-enter this password and re-save.

– After Heartbeat Interval (seconds), select the interval in seconds between each Heartbeat Request 
message. 
Heartbeat Request messages are issued by the Enterprise Server to Teleopti clients to establish and 
maintain communication. Teleopti clients receive these Heartbeat Request messages and respond 
to them. If the server does not receive a response message after waiting at least twice the specified 
heartbeat interval, it may terminate the session with the Teleopti client without notification. Set-
ting the interval to zero helps ensure communication between the server and the client.
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11. If you are saving configuration changes to a pre-existing configuration, re-enter the password for the 
FTP server and Real-Time Data Socket Settings, and click Save.

12. If this is an initial configuration and you are not making changes to a pre-existing configuration, click 
Save.

13. Restart the MiContact Center WFM Connector Service. 

NOTE: If the only changes made were enabling/disabling the 'Keep Local Files' option or changes to 
the 'Reports folder', the MiContact Center WFM Connector Service does not need to be restarted.

Configuring Verint Impact 360 for Workforce Management integration

Verint Impact 360 requires additional components to be configured on the Impact 360 server to integrate 
with Workforce Management. To activate the Workforce Management plugin after making the necessary 
configurations on your Verint Impact 360 server, contact Verint for a technician to activate the plugin and 
verify in their logs that the integration is running properly.
NOTE: Before configuring Verint Impact 360 for Workforce Management integration, ensure the following 
are installed on the Verint Impact 360 server:
• .NET Framework 4.5
• Microsoft WSE 3.0 Runtime

To configure Verint Impact 360 for Workforce Management integration
1. On your Enterprise Server, create a .zip file of the following folder:

“<drive>:\Program Files (x86)\\Mitel\MiContact Center\Services\WFM
2. On your Impact 360 server, locate the prairieFyre plugins folder.

By default, this folder can be found at C:\Program Files\Verint Systems\Integration Serv-
er\Plugins\PrairieFyre.

3. Extract the contents of your .zip file to the prairieFyre plugins folder.

4. In the prairieFyre plugins folder, locate prairieFyre.WFM.Controller.Impact360.Real-
Time.exe.config and open it in an editor.

5. After EnterpriseServerIP, enter the IP of the Enterprise Server.

6. After BPFXServer, enter the name of Impact 360 server.

7. After BPFXDesc, enter the name configured for the adapter in Impact 360.

8. Save and close the editor.

9. In the Registry Editor on the Impact 360 server and add the following Registry entry:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\prairieFyre Software Inc\CCM\Enter-
prise\WFM]
"LogName"="WFMRealTime"
"LogLevel"="3"
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Setting up MiVoice Border Gateway on the Mitel Application 
Server
MiVoice Border Gateway enables MiContact Center Business applications to run from any remote 
computer, without the use of a Virtual Private Network (VPN). This solution offers the same trusted char-
acteristics as with standard MiVoice Border Gateway deployments (with a hard phone set): local 
streaming, secure RTP, jitter buffering and packet handling QoS, and G.729 and G.711 encoding.
For instructions on configuring MiVoice Border Gateway on the Mitel Application Server for MiContact 
Center Business, see the MiVoice Border Gateway documentation.
NOTE: The MiContact Center Business MiVoice Border Gateway Connector does not support TLS 1.2+ 
as the SSL Ciphers setting in MiVoice Border Gateway.

Configuring Microsoft Dynamics CRM Connector
Mitel® Microsoft Dynamics CRM Connector delivers real-time customer data to employee desktops as 
calls arrive with Contact Center Screen Pop. With critical customer information at hand, employees can 
reduce call response and duration times. By streamlining business processes, contact centers of any size 
can improve efficiency, increase revenues, and boost customer satisfaction.
NOTE: http://crm.dynamics.com/ 
• Microsoft Dynamics CRM Connector is a Mitel MiContact Center Consulting and Integration Services 

offering provided through Mitel Networks. You must contact micc_customdevelopment@mitel.com in 
order to receive the installation files for this product. You must include your site ID when contacting 
MiContact Center Consulting and Integration Services.

• Microsoft Dynamics CRM Connector functionality requires you to be licensed for Contact Center 
PhoneSet Manager, Contact Center Screen Pop and IVR Routing with Collected Digits (to screen pop 
based on Verified Collected Digits)

Please refer to the MiContact Center Business and MiVoice Analytics System Engineering Guide for a list 
of supported Microsoft CRM versions.
For details on Microsoft Dynamics CRM features and functionality and user documentation, see 
https://www.crmdynamics.com/.

Configuring Microsoft Dynamics CRM Connector

To configure Microsoft Dynamics CRM Connector, you must
• Specify CRM server settings

See "Specifying CRM server settings".
• Create search masks

See "Creating a search mask".
• Specify search fields

See "Specifying search fields".

Once you have completed specifying the CRM server settings, creating search masks, and specifying 
your search fields, you can then start specifying custom URLs and creating CRM screen pops. See 
"Create a Custom URL" and "Creating a CRM screen pop".

https://www.crmdynamics.com/
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Specifying CRM server settings

To specify CRM server settings
1. In YourSite Explorer, under Enterprise, click Proserv Plugins.
2. Click Microsoft CRM.

3. Click the CRM Server Settings tab.

4. In the Server Domain text box, enter the name of the domain on which the CRM server resides.

This is only required for On Premise installations of Microsoft CRM.
5. In the Server Address text box, enter the address used to browse to the CRM server. For example, 

http://appserver:1010/orgName/.

Ensure the organization name in Microsoft CRM is specified in the URL unless you have multiple or-
ganizations and wish to screen pop on different ones.
Web Service Address and Meta Data Address are static and pre-configured.

6. In the UserName text box, type the name used to connect to the CRM server. For internet-facing 
deployments of Microsoft CRM you must specify the domain and username (Example: 
user@domain.com)

CAUTION: Passwords cannot be changed.
7. In the Password text box, type the password used to connect to the CRM server.

8. Select the This is a Cloud Instance check box if the CRM instance is a Windows Live ID cloud 
instance.

9. Select the This is an IFD Instance check box if the CRM instance is an internet-facing deployment.

10. Click Save changes.

Creating and editing search masks

Search masks are used to identify the way phone numbers are configured in your CRM database and 
ensure that Microsoft Dynamics CRM Connector will display screen pops for each type of phone number 
configuration in your database.

Creating a search mask

To create a search mask
1. In YourSite Explorer, under Enterprise, click Proserv Plugins.
2. Click Microsoft CRM.

3. Click the Search Masks tab.

4. In the Pattern text box, enter number signs (#) to type the pattern of the phone number configured in 
your CRM database that you will use to display screen pops.

For example, if the phone numbers configured in your CRM database follow the patterns 1234567 and 
(123)456-7890, you would create two search masks: ####### and (###)###-####.

5. If you want the search mask to be active so screen pops will immediately display based on the search 
mask, select the Enabled check box.

If the search mask is not enabled, screen pops will not display based on the configured search mask 
pattern.
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6. Click Insert.

Editing a search mask

To edit a search mask
1. In the Search Masks tab, click Edit.
2. Enter number signs to type the new pattern and/or select (or deselect if it has been selected) the 

Enabled check box if you want to change whether the search mask is or is not active so screen pops 
immediately display based on the search mask.

3. Click Update.

Deleting a search mask

To delete a search mask
• Click Delete beside the search mask.

Specifying search fields

Search fields are used to specify the CRM entity that will screen pop based on the search masks you have 
created for contact phone numbers. You can screen pop CRM based on the following entities: Lead, 
Account, Case, Contact, and Opportunity.

Creating a search field

To create a search field
1. In YourSite Explorer, under Enterprise, click Proserv Plugins.
2. Click Microsoft CRM.

3. Click the Search Fields tab.

4. Select the CRM entity to screen pop from the Entity drop-down list.

5. In the Display Name text box, enter a name in the Display Name field for the search field.

NOTE: The display name must be unique.
6. Enter a name in the Schema Name text box.

NOTE: The schema name must be unique.
7. Click Insert.

Editing a search field

To edit a search field
1. In the Search Fields tab, click Edit.
2. Enter the new Display Name and/or Scheme Name.

3. Click Update.

The search field will save your changes.

Deleting a search field

To delete a search field
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• Click Delete beside the search field.

Specifying Custom URLs

Custom URLs are used to specify an external web page to pop instead of the stock Microsoft CRM URLs. 
This enables you to pop a completely different web application when searching and/or finding Microsoft 
CRM for entities. You can specify a custom URL for the following scenarios:
• When no entity is found
• When one entity is found
• When multiple entities are found

The URL can also be configured to pass the variable it search on (ANI or Collected Digits) as well as the 
entity ID that it found. The entity ID option to pass is only populated when one entity is found.

Creating a Custom URL

To create a search field
1. In YourSite Explorer, under Enterprise, click Proserv Plugins.
2. Click Microsoft CRM.

3. Click the Custom URLs tab.

4. In the Name text box enter a unique name for the URL.

5. In the URL text box, enter a URL that you wish to launch (Example: http://Example.com).

NOTE: You can pass some parameters to this URL by specifying the following variables: {0} will pass 
the screen pop variable you used to search (ANI or Collected Digits, {1} will pass the entity id of a 
found entity (this will only pass a value if one entity is found).

An example URL with parameters is as follows: http://Example.com?phone={0}&foundentity={1}
6. Click Submit.

Editing a Custom URL

To edit a search field
1. In the Custom URLs tab, click Edit next to an existing custom URL.
2. Enter the new Name and/or URL.

3. Click Update.

CRM screen pops

Once you have specified your CRM server settings, created search masks, and specified search fields, 
you can create a CRM screen pop that will display customer information to your contact center agents as 
calls come in. For each screen pop, you can create sub queries, which enable your screen pops to search 
other CRM entities if the primary entity cannot be located.

Creating a CRM screen pop

To create a CRM screen pop
1. In YourSite Explorer, under Enterprise, click Proserv Plugins.
2. Click Microsoft CRM.
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3. Click the Current Configurations tab.

4. Click Create Screen Pop.

The Screen Pop Wizard opens.
5. Type a name and description for the screen pop.

6. If you have multiple organizations in your Microsoft CRM instance and are creating multiple screen 
pops between different organizations, type the organization name in the MSCRM Organization text 
box.

7. Click Next.

8. Specify the parameter to use in the screen pop.

9. Click Next.

10. Specify whether you will screen pop on ACD calls or non ACD calls and select the queues that will be 
associated with this screen pop by selecting the queues from the Available queue(s) list and clicking 
> or >> to move them to the Selected queue(s) list.

11. Click Next.

12. After Entity, select the CRM entity field to search and then specify the search fields used to perform 
the search.

13. Click Next.

14. After Entity, select the CRM entity to screen pop. If you created a custom URL, select Custom URL 
in the Entity list and then specify the URL from the URL if One Result Found list. Optionally, you can 
select a custom URL if multiple results are found from the URL if Multiple Results Found list.

15. Click Next.

16. Select the search masks that will be associated to this screen pop by selecting the search masks from 
the Available search mask(s) list and clicking > or >> to move them to the Selected search mask(s) 
list.

17. Click Next.

18. Select the action to take when no CRM record is found based on your search criteria. If you created 
a custom URL select Custom URL in the Entity list and then specify the URL from the Select Custom 
URL list.

19. Optionally, to have the default action always create a screen pop, enable the Always Pop Default 
Action check box.

20. Optionally, to create a phone activity for each time a screen pop displays, select the Enable Phone 
Activity check box.

21. If you want this screen pop to be active immediately, select the Enable Screen Pop check box.

22. Click Next.

23. Click Finish.
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Editing a CRM screen pop

To edit a CRM screen pop
1. Click Edit.

The Screen Pop Wizard opens.
2. Specify the CRM screen pop options as required.

3. Click Finish when you reach the final page of the Screen Pop Wizard.

Deleting a CRM screen pop

To delete a CRM screen pop
1. Click Delete beside the screen pop you want to delete.

A confirmation message appears.
2. Click OK.

Sub queries

Sub queries enable your CRM screen pops to search for another CRM entity if the screen pop fails to 
locate the primary entity. If you had a CRM screen pop set up to find an account based on ANI, you could 
then create a sub query on that account screen pop to search Contact on that same ANI in case an 
Account entity is not found.
Creating a sub query
To create a sub query 
1. Click the Current Configurations tab.
2. Click Sub Queries beside the screen pop to which you want to add a sub query.

3. Click Create New Query. 

The Screen Pop Wizard opens.
4. Type a name and description for the screen pop.

5. If you have multiple organizations in your Microsoft CRM instance and are creating multiple screen 
pops between different organizations, type the organization name in the MSCRM Organization text 
box.

6. Click Next.

7. Beside Entity, select the CRM entity field to search and then specify the search fields used to perform 
the search.

8. Click Next.

9. Beside Entity, select the CRM entity to screen pop. If you created a custom URL please select 
Custom URL in the Entity list and then specify the URL from the URL if One Result Found list. You 
may also select a custom URL if multiple results are found from the URL if Multiple Results Found 
list.

10. Click Next.

11. Select the search masks that will be associated to this screen pop by selecting the search masks from 
the Available search mask(s) list and clicking > or >> to move them to the Selected search mask(s) 
list.
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12. Click Next.

13. If you want this screen pop to be active immediately, select the Enable Screen Pop check box.

14. Click Next.

15. Click Finish.

Editing a sub query
To edit a sub query 
1. Click Edit. 

The Screen Pop Wizard opens.
2. Specify the CRM screen pop options as required.

3. Click Finish when you reach the final page of the Screen Pop Wizard.

Deleting a sub query
To delete a sub query 
1. Click Delete beside the screen pop you want to delete. 

A confirmation message appears.
2. Click OK.

Installing the Microsoft Dynamics CRM Connector plugin

In order for agents to receive screen pops, they must have the client-side portion of the Microsoft 
Dynamics CRM Connector. This client-side portion of Microsoft Dynamics CRM Connector is a plugin 
(Add-on) to Contact Center Client and PhoneSet Manager. This plugin can be pushed out automatically 
to all Contact Center Client installations or installed manually on individual machines.
To install Microsoft Dynamics CRM Connector plugin automatically
1. On the MiContact Center Business Server, copy the file <drive>:\Program Files\Mitel\MiContact 

Center\Extensions\Client\CCCPlugin.zip to the folder <drive>:\Program Files (x86)\Mitel\MiCon-
tact Center\WebSites\CcmWeb\applications\ContactCenterClient.

2. Copy the file <drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\CcmWeb\applica-
tions\CCCPluginsManifest.xml to the desktop for backup purposes.

3. Copy the file <drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\CcmWeb\applica-
tions\ClientUpdaterManifest.xml to the desktop for backup purposes.

4. Open the file <drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\CcmWeb\applica-
tions\CCCPluginsManifest.xml with an editor.

5. Edit any number in the "manifestId" variable to be a different number.

For example,
manifestId="{c8a55a0f-3213-4fd1-b1cb-eacb89c1335f}"
could be edited to:
manifestId="{c9a55a0f-3213-4fd1-b1cb-eacb89c1335f}"

6. Save the file and exit Notepad.

7. After approximately 10 minutes, all Contact Center Client installations should have the Microsoft 
Dynamics CRM Connector client plugin installed and should be enabled for MS CRM screen pops.
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To install Microsoft Dynamics CRM Connector client-side plugin manually
1. On the MiContact Center Business server, copy the folder <drive>:\Program Files 

(x86)\Mitel\MiContact Center\Applications\ContactCenterClient\Plugins to a central location that 
client machines can access such as a network share, USB key, etc.

2. On the client machine, copy the plugins folder from the central location to the folder 
<<drive>:\Program Files (x86)\Mitel\MiContact Center\Applications\ContactCenterClient\. The 
plugin is now installed and the client machine is enabled for MS CRM screen pops.

3. Repeat step 2 for every machine you wish to enable for MS CRM screen pops.

Converting MiCC Office data
The MiCC Office Data Import Tool enables customers with historical MiCC Office data (collected using 
either a 5000 or 3300 media server) to convert their data when migrating to Mi Contact Center Business. 
The import tool is designed to process data from either Access or DB2 databases. Telephone system 
information, such as agents and extensions, will be imported and all historic records will be converted into 
ACD and SMDR files. A historical media server will be created, allowing you to retain data for reporting 
purposes.
Historical media servers enable 
• Historical reporting for queues, agents, and extensions
• Forecasting
• ACD and SMDR Inspector functionality
• Auditor functionality

MiCC Office summary-based options, such as service level and spectrum values, can be modified in 
YourSite Explorer. Summarize is performed on an on-demand basis from Management Console in 
Contact Center Client. Historical media servers have no real-time functionality. All devices associated 
with historical media servers are historical by default and cannot be edited or used to collect any new data.
NOTE: 
• If the MiCC Office server that houses the DB2 database is offline or not accessible through the 

network, you must install and configure a DB2 Server on the host machine. After installing the DB2 
Server, restore the DB2 databases onto this server. You will access the databases here using the 
import tool.

• For Access databases, the import tool requires the following files: System.mdw, config.mdb, and one 
or any combination of the following: Ha<MMYYYY>.mdb, Hc<MMYYYY>.mdb, Haday.mdb, 
Hcday.mdb, Hamonth.mdb, Hcmonth.mdb. For Version 4.11 or earlier, select cvgwcfg.mdb instead of 
config.mdb.

• You should run, save, and store a copy of your MiCC Office reports before decommissioning your 
MiCC Office server.

• Hunt groups and extensions in MiCC Office convert into paths, agent groups, and agents when 
migrating to MiContact Center Business.

To convert MiCC Office data 
1. If you are converting a DB2 database, you must first install the IBM utility called IBM Data Server 

Client. It is available for download from https://www.ibm.com/.
2. Open the MiCC Office Data Import Tool, located in <installation drive>:\Program Files 

(x86)\Mitel\MiContact Center\Applications\Intertel Import Tool\IntertelDatabaseMigrationTool.

https://www.ibm.com/support/pages/node/387577
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3. Under Database Source, select either Microsoft Access or DB2.

4. If DB2 is selected, in the MiCC Office Database text field, type the IP address of the machine where 
the DB2 database resides and the name of the DB2 database using the following format: <IP 
Address>\<Database Name>, and enter the login credentials of a DB2 Administrator on the host 
machine.

5. If Microsoft Access is selected, after MiCC Office Database, click Browse and browse to the location 
of the files to import/convert.

6. Click OK.

7. After Start Date, select the start date for the data you want to import.

8. After End Date, select the end date for the data you want to import. 

The Detected MiCC Office Version will update based on the version you are running.
9. If you want to retain historic MiCC Office data for reporting purposes, ensure the Create historic 

media server check box is selected. 

This option is selected by default. The files will be imported into <installation drive>:\Program Files 
(x86)\Mitel\MiContact Center\DataDirectory. You can optionally choose to import the files to an alter-
nate location, and not create a historical media server, by selecting the Target for Import check box. 
See step 11.

10. If you have multiple, interconnected 5000 media servers that are configured through a CT Gateway, 
select the Synchronized system uses CT Gateway check box. 

NOTE: If the Create historic media server check box is enabled, the Synchronized system uses CT 
Gateway option will be disabled.

11. If you want to summarize the data immediately after the conversion, select the Summarize on 
completion check box. 

This option is selected by default.
12. Optionally, to generate data files without creating a media server in the database, beside the Target 

for Import field, click Browse, and select a location to which you want to import the data. 

The Target for Import option is not available if you selected the Create historic media server check 
box.

13. Click Import.

Configuring WallBoarder
The WallBoarder application displays real-time performance statistics and text messages on one or more 
Spectrum Light Emitting Diode (LED) reader boards (wall signs).

WallBoarder parameters

WallBoarder consists of site(s), sign groups, signs, sign variables, sign messages, and sign plans.

Site

At the Site level, you 
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• Add sign groups to your site by clicking Add > Sign group.
• Specify the name of the computer on which the MiContact Center Wallboard Service is installed on the 

Edit WallBoarder Service for tab.
• Enable priority messages on the Priority message tab.
• View communications between the MiContact Center Enterprise Service and the MiContact Center 

Wallboard Service on the Database load log tab.
• Verify the serial addresses of your wall signs on the Query signs tab.
• Add sign variables to your site by clicking Add > Sign variable.
• Add sign messages to your site by clicking Add > Sign message.
• Add sign plans to your site by clicking Add > Sign plan.

Edit WallBoarder Service for tab

The Edit WallBoarder Service for tab provides the following function: 
• The WallBoarder Service is installed on the following computer specifies the computer on which the 

MiContact Center Wallboard Service is installed.

Priority message tab

NOTE: 
• You create priority messages on the Add sign message tab.
• Priority messages override all of the other messages.

The Priority message tab provides the following function: 
• Enable this priority message for this sign group immediately sends a message to all of the wall signs 

in the sign group immediately, overriding any business hour, or scheduled messages.

Database load log tab

Under Diagnostics, the Database load log tab records communications between the MiContact Center 
Data Collection Service and the MiContact Center Wallboard Service, and indicates if the MiContact 
Center Wallboard Service has loaded the sign plan configured by the MiContact Center Business user.

Query signs tab

Under Diagnostics, the Query signs tab lists the wall signs the MiContact Center Wallboard Service can 
locate, and information relating to these signs. It displays the serial addresses of the wall signs. This can 
come in handy.
For example, you have connected a wall sign to Com port 3, have configured the sign and specified the 
com port value in WallBoarder, and have reset the wall sign, but it does not display the messages in the 
sign plan. Most likely, the serial address of the sign is not the same as that configured in WallBoarder. 
The Query signs tab displays the true serial address of the wall sign. You can easily verify the address 
and amend the address on the Edit sign tab for the sign.

Sign groups

NOTE: You must create at least one sign group in order to register wall sign addresses. You can include 
all of the wall signs under one sign group, or create additional sign groups. Sign groups dictate which 
messages are displayed by particular wall signs.
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At the Sign group level, you can 
• Edit sign groups on the Edit sign group tab.
• Define the wall sign refresh interval and reset wall signs on the Advanced tab.
• Add signs to your sign groups by clicking > AddSign.

Sign addresses distinguish wall signs for messaging purposes. Each wall sign has a unique sign address. 
You add one or more signs to a sign group. For example, you could add Wall sign 1 to Sign group 1, and 
Wall signs 2 to 4 to Sign group 2. You associate each sign group with a sign plan. Using sign groups and 
sign plans you can display the same message on one or more wall signs, or display unique messages on 
all wall signs.

Edit sign group tab

The Edit sign group tab provides the following functions: 
• Name lists the name of the sign group.
• Site is the contact center site where WallBoarder is installed.

Advanced tab

The Advanced tab provides the following functions:
Reinitialize all of the wall signs every x seconds
The Reinitialize all of the wall signs every x seconds field restarts all of the wall signs in the sign group 
(clearing all of the sign memory) at the time interval you specify.
Refresh all of the sign messages every x seconds
The Refresh all of the sign messages every x seconds field resends all of the messages to all of the wall 
signs in the sign group at the time interval you specify. If you see question marks [???] instead of statistics 
on a wall sign, this means the MiContact Center Enterprise Service does not have a value for the variable. 
There are two reasons why the MiContact Center Enterprise Service does not have a value for the vari-
able: it is in the process of loading the variable or the telephone system has not sent any real-time infor-
mation yet.
Refresh all of the ACD sign variables every x seconds
The Refresh all of the ACD sign variables every x seconds field updates all of the variables on all of the 
wall signs in the sign group at the time interval you specify.
Update wall signs in serial for sign messages
The Update wall signs in serial for sign messages check box updates the wall signs in a sign group indi-
vidually for sign messages, at the refresh time interval you specify.
Update wall signs in serial for sign variables
The Update wall signs in serial for sign variables check box updates the wall signs in the sign group indi-
vidually for sign variables, at the refresh time interval you specify.
Minimum pause time between wall sign updates is x seconds
After WallBoarder sends a message or variable update to a wall sign, the Minimum pause time between 
wall sign updates is x seconds field suspends the transmission of subsequent information to the wall sign 
for x seconds. Typically you select a value greater than zero only if you have a small Spectrum reader 
board, such as the 251C reader board.
Minimum display time for a message is x seconds
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After WallBoarder sends a message to a wall sign, the Minimum display time for a message is x seconds 
field displays the message for a minimum of x seconds. This ensures you can view the message for a 
sufficient amount of time before a subsequent message displays.
Minimum pause time after beep is sent is x seconds
If you select the Beep check box on the Add sign plan tab, the wall sign produces an audible beep prior 
to displaying each message. It takes a few seconds for the beep to occur. Therefore, the wall sign is 
delayed in receiving messages by a few seconds.
The Minimum pause time after beep is sent is x seconds field suspends the transmission of messages to 
the wall sign for x seconds, to accommodate the beep.
Reinitialize all of the wall signs in this sign group
The Reinitialize all of the wall signs in this sign group command restarts all of the wall signs in the sign 
group instantly, clearing all of the sign memory.
Apply to all of the sign groups at this site
The Apply to all of the sign groups at this site command applies the configuration values on the Advanced 
tab to all of the sign groups at the site.

Signs

At the Sign level, you 
• Configure sign information on the Add sign tab.
• Configure sign connectivity information on the Connectivity tab.
• Reset the wall sign and send a test message to the wall sign on the Tools tab.
• Add signs to your sign groups by clicking Add > Sign.

Diagnostics

Under Diagnostics, the following tabs list information pertaining to wall sign function and are used for 
trouble shooting purposes: 
• General
• Properties
• Tool tab
• Error reporting
• Current message tabs

Tools tab

Under Diagnostics, the Tools tab displays wall sign settings and provides the following functions: 
• Reset sign restarts the wall sign and empties the sign memory.
• Get status displays the latest sign diagnostics.
• Send test message sends a message to the wall sign to test the connectivity.

Sign messages

At the Sign message level, you 
• Compose, test, and save message strings displayed on wall signs on the Add sign message tab 

Message strings indicate to the wall sign how messages are displayed. They are constructed of
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– Text
– Queue and queue group performance variables (Variables)
– Display characteristics (Position, Color, Effects, Special, and Miscellaneous)

• Add sign messages to your site by clicking Add.

Add sign tab

The Add sign tab provides the following functions:
Name
The Name field specifies the name of the sign.
Sign address
The Sign address field specifies the address of the wall sign. Each wall sign has a unique address. You 
use a keypad provided with the master sign to set the internal addresses of your signs. The addresses 
distinguish wall signs for messaging purposes. If you have one wall sign only, its address is 00. If you 
have more than one wall sign, then the address of the master sign is 01.
NOTE: When you assign serial addresses to your Spectrum wall signs using remote or software spectrum 
tools, you must specify sign addresses greater than 9 as hexadecimal variants. For example, the following 
decimals are converted to hexadecimal: 10 = a, 11 = b, 12 = c, 13 = d, 14 = e, 15 = f.
Sign group
The Sign group field specifies the sign group to which the sign belongs.
Connectivity tab
NOTE: The default data bits, parity bit, and stop bits Com port settings for newer Spectrum IP/Serial wall 
signs are 8, None, 1. In the past, the default Com port settings were: 7, Even, 2. If you select one set of 
Com port values and the wall sign does not display information, try selecting the other set of Com port 
values, or refer to the Spectrum documentation to verify the correct default Com port settings.
The Connectivity tab provides the following functions: 
• Com port or TCP/IP specifies the sign connectivity. The default value for Com port is 1.
• The default value for Baud rate is 9600.
• The default value for Data bits is 8.
• The default value for Parity bit is None.
• The default value for Stop bits is 1.
• TCP specifies the TCP/IP address of the wall sign.
• DNS specifies the name you assigned the wall sign on the network.
• Port specifies the port number used by the wall sign.
• Sign memory specifies the memory capacity of the sign (typically 32k).
• Reset this wall sign when it does not respond and at midnight resets the wall sign. When the MiContact 

Center Wallboard Service restarts, it queries the wall sign for the information listed on the sign Diag-
nostics tabs. If it does not get an answer, it resets the wall sign.

Add sign message tab

The Add message tab provides the following functions: 
• Name specifies the name of the message.
• Site is the contact center site where WallBoarder is installed.
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• Test message sends the message to the wall sign so you can verify it works.

Variables
You associate a queue, queue group, or agent group, and a performance variable with the sign variable 
on the Variable tab. You specify display characteristics and color-coded alarm thresholds. When you 
incorporate a sign variable, such as Sign Variable 6, in a message string, the real-time value of the asso-
ciated performance variable is displayed.
Position
The Position tab specifies the vertical position of the message string on the wall sign. If you do not specify 
the text position, the wall sign defaults to the fill mode. The message enters the wall sign from the upper 
left corner and scrolls to fill up to three rows of text. If you specify the text position, do so before you set 
other display features.
Color
The Color tab specifies the color of the text you type in the message string, and the color of any 
pre-defined text and graphics you select on the Special tab. You can specify different colors for each word 
in the text string. If you specify text coloring, do so after specifying text positioning, but prior to specifying 
other display features. Some Spectrum signs offer more color choices than other Spectrum signs. Please 
refer to the Spectrum product brochure for more information.
Effect
The Effects tab specifies how messages move across wall signs. If you do not specify effects, the wall 
sign defaults to the Automode option. Automode produces random message display formats, such as 
message strings that flash or roll to the left.
Special
The Special tab provides display features and illustrations you can add to message strings.
Misc
The Misc (Miscellaneous) tab specifies the speed at which WallBoarder displays message strings, the 
size of message string text, the display time and date, and other features.

Sign variables

At the Sign variable level, you 
• Associate a queue or queue group, and a performance variable with the sign variable on the Add sign 

variable tab.
• Define and save display characteristics for sign variables on the Advanced tab.
• Add sign variables to your site by clicking Add.

Add sign variable tab

The Add sign variable tab provides the following functions: 
• Name specifies the name of the sign variable.
• Site is the contact center site where WallBoarder is installed.
• Select a device type group specifies the device type (queue or queue group) you will associate with 

the sign variable.
• Select a device specifies the device you will associate with the sign variable (for example, Queue 

Group 1).
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• Select a variable type specifies the performance variable you will associate with the sign variable (for 
example, Agents on ACD).

Advanced tab

The Advanced tab provides the following functions: 
• Select display options for this variable specifies the number of characters reserved for a performance 

variable in the message string. It centers, left-justifies, or right-justifies the performance variable within 
the variable string position.

• Enable variable color based on these thresholds defines color-coded alarms for performance thresh-
olds for the variable.

Sign plans

The MiContact Center Wallboard Service displays messages in the following order: 
1. Priority messages
2. Business-hour messages

3. Scheduled messages

4. Sign plan messages

5. Default sign plan message

At the Sign plan level, you 
• Create a sign plan.
• Associate the sign plan with a sign group.
• Specify up to five statements (conditions) for the sign plan on the Add sign plan tab.
• Specify the hours of operation for your business on the Business hours tab.
• Schedule messages to be displayed on the Scheduled messages tab.

When you configure a sign plan, you can configure up to five messages for a sign group. The conditions, 
or values, of variables dictate which message strings WallBoarder displays, and the priority in which Wall-
Boarder displays them. If none of the conditions are satisfied, WallBoarder displays the default message 
on all of the wall signs. The default message can be a message congratulating agents, or informing them 
of an upcoming meeting or other need-to-know information.

Add sign plan tab

The Add sign plan tab provides the following functions: 
• Name specifies the name of the sign plan.
• Sign group specifies the sign group to which the sign plan applies.
• If check boxes activate conditional messages. You can specify up to five statements (conditions). 

Conditions dictate which message strings WallBoarder displays, and the priority in which WallBoarder 
displays them.

• Sign variable specifies the sign variable to display for the current (active) condition.
• Evaluates to specifies the value, above or below which, WallBoarder displays the message string 

associated with the sign variable for the current condition.
• Play message specifies the sign message to display for the current (active) condition.
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• Beep programs the wall sign to produce an audible beep prior to displaying a message for a satisfied 
condition.

• Default message to play if no variables have triggered a message to play specifies a default message 
to display on the wall sign. WallBoarder displays the message during periods when the defined condi-
tions ('If' statements) are not satisfied for the sign group. That is, when call center performance objec-
tives are being met.

Business hours tab

The Business hours tab provides the following functions: 
• Outside business hours display this message specifies which message is displayed on the wall signs 

after business hours.
• Business-hours schedule for this sign plan specifies the hours of the day for the sign plan
• Apply this business-hours schedule to all of the sign plans at this site applies the schedule to all of the 

sign plans at your contact center site.

The Scheduled messages tab provides the following function: 
• Play this message during these hours specifies the message to be displayed and the schedule for 

displaying the message.
NOTE: You create schedules under YourSite>Schedule.

Connecting Spectrum wall signs

If you have multiple wall signs, you can daisy chain the wall signs together. The following figure illustrates 
the connectivity between the Enterprise Server and the master sign (Wall sign 1). The Enterprise Server 
connects to the master sign over an RS-232 25-pin cable, an RS-485 converter, and RS-485 RJ-11 
cabling. The master sign connects to slave signs over RS-485 cabling. In this setup, one Enterprise 
Server com port is dedicated to your wall signs.

Figure 7.9: Setting up Spectrum wall signs
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If you do not want to dedicate an Enterprise Server com port to your wall signs (or you simply need 
another computer to connect to a wall sign), you can hook up your wall sign(s) to a client computer. In 
CCMWeb, hover over Help and select Software downloads/Installations > Remote Server Pack to install 
a remote media server (data collection point) on a client computer. The computer connects to the master 
wall sign over an RS-232 25-pin cable, an RS-485 converter, and RS-485 RJ-11 cabling, as in the 
proceeding setup. In this setup, one client computer com port is dedicated to your wall sign(s).
The new Spectrum IP wall signs plug into a network jack on the wall, just like your network printer.
Each wall sign has a unique sign address. You add one or more signs to a sign group. For example, you 
could add Wall sign 1 to Sign group 1, and Wall signs 2 to 4 to Sign group 2. Keep in mind that all of the 
signs in the same sign group, display the same messages. You associate each sign group with a sign 
plan. Using sign groups and sign plans, you can display the same message on one or more wall signs, 
or display unique messages on all of the wall signs.

Configuring wall signs and wall sign messages

To configure wall signs and wall signs messages 
1. For each site, select the computer on which the MiContact Center Wallboard Service is installed. 

See "Selecting the computer on which the MiContact Center WallBoard Service is installed".
2. Add sign group(s). (In the tree under Site, click Add > Sign group.) 

See "Creating sign groups".
3. Add sign(s) to sign group(s) and send a test message to test the sign connectivity. (In the tree under 

Sign group, click Add > Sign.) 

See "Adding signs to sign groups".
4. Configure sign variables to use in sign plans. (In the tree under Site, click Add > Sign variable.) 
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See "Configuring sign variables".
5. Configure sign messages to use in sign plans and test the messages. (In the tree under Site, click Add 

> Sign message.) 

See "Configuring sign messages".
6. Add and configure a sign plan for each sign group. (In the tree under Site, click Add > Sign plan.) 

See "Creating sign plans".

Optionally, users can 
• Activate priority messages 

See "Activating priority messages".
• Schedule messages 

See "Scheduling messages".

Selecting the computer on which the MiContact Center WallBoard Service is installed

To select the computer on which the MiContact Center WallboardService is installed 
1. Under Enterprise, click WallBoarder.
2. Expand the Enterprise tree and click the name of your site.

3. The Edit WallBoarder Service for tab opens. 

See the following figure.
4. Under Select the count down number, select the how often the MiContact Center Wallboard Service 

queries the Wallboard for information.

5. After The WallBoarder Service is installed on this computer, select the computer on which the 
MiContact Center Wallboard Service is installed.

6. Click Save.

Figure 7.10: Edit WallBoarder Service for Default Site Demo tab
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Creating sign groups

NOTE: You must create at least one sign group in order to register wall sign addresses. You can include 
all of the wall signs under one sign group or create additional sign groups. Keep in mind that all of the 
signs in the same sign group display the same messages.
Sign addresses distinguish wall signs for messaging purposes. Each wall sign has a unique address. You 
set the internal sign addresses using the keypad provided with the master sign and register the sign 
addresses in WallBoarder on the Edit sign tab.
Each sign group has one or more signs. For example, you can specify that Sign group 1 provide real-time 
displays for Wall sign 1, Sign group 2 provide real-time displays for Wall signs 2 to 4, and so on. You asso-
ciate each sign group with a sign plan. Using sign groups and sign plans, you can display the same 
message on one or more wall signs or display unique messages on all of the wall signs.
Sign groups dictate which messages are displayed by particular wall signs.
Sign groups dictate which messages are displayed by particular wall signs.
To add a sign group and specify sign group information 
1. Under Enterprise, click Wallboarder.
2. Click the name of your site. 

The Edit WallBoarder Service for tab opens.
3. Click Add > Sign group. The Add sign group tab opens. 

See the following figure.
4. After Name, type the sign group name.

5. After Site, select the contact center site where WallBoarder resides.

6. Click the Advanced tab.

7. After Reinitialize all wall signs every, select a time interval for restarting all of the wall signs in the 
sign group.

8. After Refresh all sign messages every, select a time interval for resending all of the messages to 
all of the wall signs in the sign group. 

If you see question marks [???] instead of statistics on a wall sign, this means the MiContact Center 
Enterprise Service does not have a value for the variable. The Enterprise Server does not have a val-
ue for the variable because it is in the process of loading the variable, or the telephone system has 
not sent any real-time information yet.

9. If you are using an older sign and want to send messages to signs in text format rather than binary, 
select Send sign messages in uncompressed format.

10. After Refresh all ACD sign variables every, select a time interval for updating all of the variables on 
all of the wall signs in the sign group.

11. If you are using an older sign and want to send ACD sign variables to signs in text format rather than 
binary, select Send sign messages in uncompressed format.

12. After Minimum pause time between wall sign updates is, select a time interval for pausing between 
wall sign updates.

13. After Minimum display time for a message is, select a time interval for displaying a wall sign 
message.
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14. After Minimum pause time after beep is sent in, select a time interval for pausing after a beep is 
sent.

15. If you want to reinitialize all of the wall signs, click Reinitialize all wall signs in this sign group.

16. Click Save.

To apply a sign group's settings to all sign groups at a single site 
1. Under Enterprise, click Wallboarder.
2. Click the name of the site.

3. Click the sign group.

4. Click the Advanced tab.

5. Click Apply to all sign groups at this site.

Figure 7.11: Add sign group tab
 

Adding signs to sign groups

NOTE: You can add one or more signs to a sign group. Keep in mind that all of the signs in the same sign 
group, display the same messages.
To add signs and specify sign information 
1. Under Enterprise, click Wallboarder.
2. Click a site.

3. Click a sign group.

4. Click Add > Sign. 

The Add sign tab opens.
5. After Name, type the sign name.

6. After Sign address, select the address for the sign (for example, type 1). 

You set the internal sign addresses using the keypad provided with the master sign, and register the 
sign addresses in WallBoarder in the Sign address field.

7. After Sign group, select the sign group to which the sign belongs.

8. Click the Connectivity tab. 

NOTE: The default data bits, parity bit and stop bits Com port settings for newer Spectrum IP/Serial 
wall signs are 8, None, 1. In the past, the default Com port settings were: 7, Even, 2. If you select 
one set of Com port values and the wall sign does display information, try selecting the other set of 
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Com port values, or refer to the Spectrum documentation to verify the correct default Com port 
settings.

9. If you click Com port, accept the default settings for Com port, baud rate, data bits, parity bit, and stop 
bits.

10. If you click TCP/IP, click TCP and specify the TCP/IP address of the wall sign, or click DNS and 
specify the name you assigned the wall sign on the network.

11. If you selected TCP/IP, after Port, specify the port number used by the wall sign.

12. After Sign memory, select the memory for the sign based on manufacturing specifications.

13. Optionally, select the Reset this wall sign when it does not respond and at midnight check box.

14. Click the Diagnostics tab.

15. Click the Tools tab. 

See the following figure.
16. To restart the wall sign and empty the sign memory, click Reset sign.

17. To display the latest sign diagnostics, click Get status.

18. To verify the wall sign setup, type a message and click Send test message.

19. Click Add > Sign and repeat steps 4 to 12 to add additional signs to the sign group.

20. Click Save.

Figure 7.12: Diagnostics tab
 

Configuring sign variables

You define and save display characteristics for sign variables (performance variables associated with a 
particular queue or queue group) on the Add sign variable tab.
To configure sign variables 
1. Under Enterprise, click Wallboarder.
2. Click +, located beside local site.

3. Click Sign variables. 

The Add sign variable tab opens.
See the following figure.

4. After Name, type a meaningful name for the sign variable (for example, type Calls waiting - P800). 
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The name will display in a list of sign variables on the Message tab.
5. After Site, select the contact center site where WallBoarder resides.

6. After Select a device type, click a device type.

7. After Select a device, select a device.

8. After Select a variable type, select a performance variable (for example, select Abandoned).

9. Click the Advanced tab. 

NOTE: Some performance variables require a display width of eight characters. For example, Wall-
Boarder displays the Average Speed of Answer Today in hh:mm:ss. If you select a value less than 
8 for the width, the at symbol @ will display on the wall sign in place of the Average Speed of Answer 
Today statistic.

10. After Select display options for this variable, click Left, Center, or Right to left-justify, center, or 
right-justify the performance variable within the variable string position, and accept the default value 
for the width of displayed characters.

11. After Width, select the width of displayed character.

12. To enable different colors to be displayed for different performance thresholds, select Active.

13. After If the value is less than, specify the threshold and select a color from the drop-down list.

14. If a second threshold is wanted, after the second If the value is less than, specify the threshold and 
select a color from the drop-down list.

15. After Otherwise use this color, select a color from the drop-down list for the variable when it is not 
within the thresholds.

16. Click Save.

Figure 7.13: Add sign variable tab
 

Configuring sign messages

You compose, test, and save message strings displayed on wall signs on the Add sign message tab. 
Message strings indicate to the wall sign how messages are displayed. They are constructed of perfor-
mance variables, text, display features, and optionally graphics.
Consider the message strings defined in the following figure. WallBoarder displays the first message 
string on the top line [PS02-Top Line] of the wall sign. It displays the Long Call Wtg = component of the 
message string in red [C001-Red]. The message string flashes [MO03-Flash] across the sign at display 
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speed 2 [MI06-Display Speed 2]. It is comprised of text you type (Long Call Wtg =) and Sign variable 1 
[VA01-Calls], that displays the real-time value for the longest waiting caller performance variable. The 
color of the sign variable statistic changes with the wait time of the longest waiting caller, as per the 
threshold settings defined on the Variable tab.
To create sign messages 
1. Under Enterprise, click Wallboarder.
2. Select a site.

3. Click Sign messages. 

See the following figure.
4. After Name, type the message name. 

The name will display in a list of sign messages on the Plan tab.
5. After Site, select the contact center site where WallBoarder resides. 

NOTE: If you do not select display attributes, WallBoarder will post the message using default display 
attributes.

6. Click the Position, Color, Effect, Special, and/or Misc tabs and double-click display attributes to 
select them.

7. Type a message.

8. Click the Variables tab and double-click a variable to select it.

9. Click Send test message. 

Confirm the message displays on the wall sign correctly.
10. Click Save.

Figure 7.14: Add Sign Message tab
 

Creating sign plans

You associate each sign group with a sign plan. Using sign groups and sign plans, you can display the 
same message on one or more wall signs, or display unique messages on all of the wall signs. All of the 
signs in a sign group display the same messages.
If you have two wall signs (that are not daisy chained together) and you want to display the same 
messages on both signs, you create one sign group, add both signs to it, and associate the sign group 
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with a sign plan. The serial addresses do not need to be unique in this case, as you are communicating 
with each sign on a dedicated connection (for example, one sign may be connected to a comport, and the 
other sign to the network using IP).
You dictate the messages displayed by particular wall signs on the Add sign plan tab. You can specify up 
to five statements (conditions) using sign groups. Conditions dictate which message strings WallBoarder 
displays and the priority in which WallBoarder displays them. If none of the conditions are satisfied, Wall-
Boarder displays the default message on all of the wall signs in the sign group. The default message can 
be a message congratulating agents, or a message informing them of an upcoming meeting or other 
need-to-know information.
Consider the conditions defined in the following figure: 
• The first condition specifies 'If Sign variable 1 (the calls waiting in P800) exceeds 10, play Sign 

message 01'.
• The second condition specifies 'If Sign variable 2 (the agents logged on to P008) exceeds 45 seconds, 

play Sign message 02'.
• The third condition specifies 'If Sign variable 3 (the longest waiting caller in P008) drops below 6, play 

Sign message 03.'

Figure 7.15: Add sign plan tab
 

Creating sign plans for daisy-chained signs
If your wall signs are daisy chained together and you want to display the same messages on all of the wall 
signs, you create one sign group, add your signs to it, and associate the sign group with a sign plan. The 
wall signs share the same com port, but have unique serial addresses.
If your wall signs are daisy chained together and you want to display unique messages on all of the wall 
signs, you must create one sign group for each sign in the chain, and associate each sign group with a 
unique sign plan. The wall signs share the same com port, but have unique serial addresses.
To create a sign plan 
1. Under Enterprise, click Wallboarder.
2. Select a site.

3. Click Sign plan. The Add sign plan tab opens. 

See the following figure.
4. After Name, type the plan name.

5. After Sign group, select the sign group to which you will apply the sign plan.

6. Select the If check box to define the first conditional message for the sign plan.
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7. Under Sign variable, select a sign variable.

8. Under Evaluates to, specify the threshold, above or below which, a sign message is displayed.

9. Under Play message, select a sign message.

10. If you want an audible alarm to accompany the message, select Beep.

11. If you want additional conditional messages for the sign plan, repeat steps 6-10.

12. Click the Business hours tab.

13. After Outside business hours display this message, select a message to be displayed on the wall 
signs after business hours. 

NOTE: Business-hour messages override scheduled messages.
14. After Business hours schedule for this sign plan, select a schedule that defines the hours of oper-

ation for your business.

15. If you want to apply the schedule to all of the sign plans at your contact center site, select Apply this 
business-hour schedule to all of the sign plans at this site.

16. Click Save.

Figure 7.16: Add sign plan tab

Creating sign plans for daisy-chained signs

If your wall signs are daisy chained together and you want to display the same messages on all of the wall 
signs, you create one sign group, add your signs to it, and associate the sign group with a sign plan. The 
wall signs share the same com port, but have unique serial addresses.
If your wall signs are daisy chained together and you want to display unique messages on all of the wall 
signs, you must create one sign group for each sign in the chain, and associate each sign group with a 
unique sign plan. The wall signs share the same com port, but have unique serial addresses.
To create a sign plan 
1. Under Enterprise, click Wallboarder.
2. Select a site.

3. Click Sign plan. The Add sign plan tab opens. 

See the following figure.
4. After Name, type the plan name.

5. After Sign group, select the sign group to which you will apply the sign plan.
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6. Select the If check box to define the first conditional message for the sign plan.

7. Under Sign variable, select a sign variable.

8. Under Evaluates to, specify the threshold, above or below which, a sign message is displayed.

9. Under Play message, select a sign message.

10. If you want an audible alarm to accompany the message, select Beep.

11. If you want additional conditional messages for the sign plan, repeat steps 6-10.

12. Click the Business hours tab.

13. After Outside business hours display this message, select a message to be displayed on the wall 
signs after business hours. 

NOTE: Business-hour messages override scheduled messages.
14. After Business hours schedule for this sign plan, select a schedule that defines the hours of oper-

ation for your business.

15. If you want to apply the schedule to all of the sign plans at your contact center site, select Apply this 
business-hour schedule to all of the sign plans at this site.

16. Click Save.

Figure 7.17: Add sign plan tab
 

Activating priority messages

NOTE: 
• You create priority messages on the Add sign message tab.
• Priority messages override all of the other messages.

To activate a priority message 
1. Under Enterprise, click Wallboarder.
2. Select a site.

3. Click the Priority message tab. 

See the following figure.
NOTE: When you enable a priority message, WallBoarder displays the message on all of the wall 
signs until you manually clear the Enable this priority message check box.
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4. To send a priority message, select Enable this priority message and select a priority message from 
the drop-down list to display on all of the wall signs at the site.

5. If you want an audible alarm to accompany the priority message, select Beep when this priority 
message is played.

6. Click Save.

Figure 7.18: Priority message tab
 

Scheduling messages

NOTE: 
• You can create schedules under YourSite > Schedule.
• Business-hour messages override scheduled messages.

You can schedule specific messages to play according to schedules.
To schedule a message 
1. Under Enterprise, click Wallboarder.
2. Select a site.

3. Select a sign plan.

4. Click the Scheduled messages tab. 

See the following figure.
5. Select a check box to activate a schedule.

6. Select Play this message to activate the message. 

NOTE: When you enable a scheduled message, WallBoarder displays the message on all of the wall 
signs in the sign group (associated with the sign plan) until you manually clear the Play this message 
check box.

7. After Play this message, select a message from the drop-down list.

8. After according to this schedule, select a schedule.

9. Click Save.

Figure 7.19: Scheduled messages tab
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Services and Database Administration

This section includes a description of how to back up data and of the functions available in Management 
Console (updating server IP addresses, running the maintenance routine immediately, summarizing data, 
creating a support package, controlling services, and converting Toolbox data files to Mitel data files). 
Accessing the diagnostics monitor, for viewing log and error monitors, is also described.

Backing up data
We recommend backing up Enterprise Server data on a regular basis as a preventive measure in case 
of events that could cause loss of data and necessitate system restoration. The frequency of backups 
depends on how important the data is to your business. If losing one week of data is acceptable, then 
backing up once a week is sufficient. If losing more than one day of data is unacceptable, then a daily 
backup strategy should be implemented.
NOTE: We strongly recommend storing backup files in a location outside of the Enterprise Server in order 
to maintain essential data in the case of a hardware failure or catastrophic event. We recommend you 
back up the SQL server data files, YourSite Database configuration data files, and raw telephone system 
data files to an off-board media type (DVD, CD, tape, alternate network drive).
The data files contained in the following default folders should be backed up using your corporate backup 
solution. Suggested backup tools include Symantec Backup Exec and Microsoft System Center Data 
Protection Manager: 
• <drive>:\Program Files (x86)\Mitel\MiContact Center\BackupFiles - This folder contains the nightly 

.xml backups of configuration data and IVR Routing and Multimedia Contact Center workflows and 
prompts that are created during nightly maintenance.

• <drive>:\Program Files (x86)\Mitel\MiContact Center\DataDirectory - This folder stores all raw 
telephone system data from the media servers. Using this data you can re-summarize your raw data 
to enable reporting. This folder also contains the Multimedia repository for all media, excluding voice.

In the event of server failure, you can restore your company history and configuration with 
• A backup copy of .xml files.
• A backup copy of the SQL server data files.
• A backup copy of the YourSite database.
• The raw telephone system data files stored on the local hard drive.

Backing up .xml files

The maintenance routine automatically backs up an .xml file of the YourSite database every night. This 
backup file is stored in the directory: <drive>:\Program Files (x86)\Mitel\MiContact Center\BackupFiles. 
The maintenance routine keeps an .xml file for each of the last 30 days maintenance ran.
To back up or restore the .xml files
1. Start Contact Center Client.
2. Click Tools > Management > Configuration.

3. Click Back up/Restore configuration data.
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4. Follow the steps in the Backup and Restore Wizard to back up or restore the database.

Backing up raw telephone system data files

To back up raw telephone system data files
1. On the Enterprise Server, right-click Start > Explore.
2. Copy the <drive>:\Program Files (x86)\Mitel\MiContact Center\DataDirectory folder to the 

desktop, a network share, or optionally store it on a CD.

Backing up Enterprise Server configuration data

CAUTION: Restoring the YourSite database deletes all of the current database table entries and replaces 
them with the entries defined at the time of your last database backup. Any changes made to the database 
in the interim are lost.
Backing up and restoring Enterprise Server configuration data offers protection in case you program the 
database incorrectly, or a careless user reconfigures it. Mitel recommends you perform this backup 
weekly, in addition to regular database maintenance. If required, you can later recover the YourSite data-
base data exclusively, rather than restoring the entire SQL database.
NOTE: As a security measure, if backed up data is restored on an Enterprise Server with a different IP 
address than the Enterprise Server it was backed up on, all mail server incoming and outgoing usernames 
and passwords will be blank in YourSite Explorer. Administrators must manually re-enter mail server 
incoming and outgoing usernames and passwords.
To back up or restore the YourSite database 
1. Start Contact Center Client.
2. Click Tools > Management > Configuration.

3. Click Back up/Restore configuration data.

4. Follow the steps in the Backup and Restore Wizard to back up or restore the database.

For any additional information, customers can contact their approved vendor. Certified channel techni-
cians can contact Mitel Technical Support.

Backing up SQL Server data files

You back up SQL Server data files to ensure you can replace corrupted or lost data as a result of media 
problems, user errors, hardware failures, and natural disasters. Please review the Microsoft procedure for 
creating a recovery model that controls the backup and restores restoration operations for a database.

Understanding SQL Server recovery models

The following section details SQL Server recovery models and how they relate to backups and disk space 
usage. There are three recovery models available for use with SQL Server: 
1. Simple
2. Full

3. Bulk logged
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For detailed information on backing up SQL Server through SQL Server Management Studio, see 
http://msdn.microsoft.com/en-us/library/ms187510.aspx.
For a complete overview of SQL Server recovery models, see https://msdn.micro-
soft.com/en-us/library/ms175987(v=sql.105).aspx
By default, SQL Server Express uses the Simple recovery model. Retail versions of SQL Server use the 
Full recovery model. There are two things you must consider when deciding which recovery model to use: 
1. The importance of the data being stored in the SQL Server database.
2. The amount of disk space used by the transaction log file.

The only way to recover a SQL Server database is to restore it from a SQL Server backup. The type of 
recovery model you use impacts the ability to restore the database.
The Simple recovery model is recommended for customers who do not have an IT department upon 
which to rely for regular backups and who believe the summarization process is sufficient to re-generate 
historical data. There are several things that should be considered when using the Simple recovery 
model: 
• The log file does not continually grow and is truncated each time a successful transaction is completed.
• When the log file is 80% full, the log will automatically clear out old transactions and rewrite the log file 

with the newer transactions.
• Point-in-time recovery is not supported with this model and the database can be restored only from the 

last full or differential backup.
• This model is ideal when the data in the database is not considered mission critical, is being backed 

up periodically, or can be restored from another means, such as summarization.

The Full recovery model is recommended for customers who have an IT department that can manage 
scheduled backups. There are several things that should be considered when using the Full recovery 
model: 
• The log file will grow until a transaction log backup is successfully completed against the SQL Server 

database. Transaction logs can be applied to full database backups to ensure point-in-time recovery, 
up to the time when the last transaction log backup was taken.

• Point-in-time recovery is supported with this model
• This model requires a regular backup schedule and sufficient disk space to house the log file as it 

grows between backups.

Frequency and scope of configuration changes may be a suitable indicator in determining which recovery 
model to use. If configuration changes are infrequent and point-in-time recovery is not critical, the Simple 
recovery model may be sufficient. However, when using the Simple recovery model, we highly recom-
mend that SQL Server backups are performed after any significant configuration changes have been 
made to the database.
Regardless of the recovery model used, it is strongly recommended that the data files collected by the 
MiContact Center Business applications are backed up on a regular basis, as these files are used in the 
summarization process to re-generate historical data.

http://msdn.microsoft.com/en-us/library/ms187510.aspx
https://msdn.microsoft.com/en-us/library/ms175987(v=sql.105).aspx
https://msdn.microsoft.com/en-us/library/ms175987(v=sql.105).aspx


208

MANAGEMENT CONSOLE
CHAPTER 8 SERVICES AND DATABASE ADMINISTRATION

Management Console
The Management Console application resides in Contact Center Client. Using Management Console, you 
can administer the database, perform maintenance functions, create support packages, and update your 
MiContact Center Business software.
Management Console consists of the following menus: 
• Configuration
• Maintenance
• Support
• System

You open Management Console in Contact Center Client. The Console is available to users whose secu-
rity permissions permit them to use Management Console.
To open Management Console 
1. Open Contact Center Client.
2. If prompted, type your user name and password.

3. Verify the Enterprise Server IP address.

4. Click Log on.

5. In the ribbon, click Tools > Management.

6. Access the Configuration, Maintenance, Support, and System options by clicking on the applicable 
icon in the Console.

Updating server IP addresses

To apply Enterprise Server or SQL Database Server IP address changes to all MiContact Center Busi-
ness applications, you use the Update Server IP Address Wizard.
To apply the IP address change to all MiContact Center Business applications 
1. In Management Console, Click Configuration.
2. Click Update server IP address.

3. Follow the steps in the wizard to apply the IP address change universally.

Running the maintenance routine immediately

MiContact Center Business runs the MiContact Center Maintenance Alarm Dispatcher Service automat-
ically by default at 2:00 A.M. However, you can manually invoke the MiContact Center Maintenance Alarm 
Dispatcher Service at any time with the Run maintenance command.
To run the maintenance routine 
1. In Management Console, Click Maintenance.
2. Click Run maintenance. 

A message notifies you that processing is complete.
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Summarizing data

The Summarize Data Wizard uploads historical telephone system data to the SQL database for a specific 
date range.
If you run a report and notice that data for a particular device is missing from the report output, verify the 
device is programmed in the telephone system and in the YourSite database. If you determine the device 
is missing from the database, add it to the database and use the Summarize command to update MiCon-
tact Center Data Collection Service and the SQL database with the complete raw telephone system data 
(stored on the local hard drive). You can then produce reports on the device.
CAUTION: If data exists for an employee who was previously licensed but is currently unlicensed, that data 
can be accessed in reports. However, if a summarization is done after the employee is no longer licensed, 
there is a risk that the statistics currently calculated for the employee could be lost. Relicensing the 
employee and performing a summarization will restore the statistics.
NOTE: 
• When a summarize is performed the devices not programmed in the telephone system or YourSite 

database are identified and logged to an XML file located in the Logs directory. The files are named 
as in the following example, summarizeInspection[29-01-2007][29-01-2007][29-01-2007].xml, where 
the first date is the current date, the second is the start date of the summarize, and the third is the end 
date of the summarize.

• If you attempt to summarize data and there is no data for that date an error opens. Please select 
another date.

To summarize data 
1. In Management Console, Click Maintenance.
2. Click Summarize data.

3. Follow the steps in the Summarize Data Wizard to summarize the data.

Creating an Enterprise Server support package

You can package your Enterprise Server telephone system records and YourSite configuration data to 
send to Mitel for troubleshooting issues using the Support Package Wizard. The Support package formats 
your data in a way that helps to resolve any problems.
To create an Enterprise Server support package
1. In Management Console, click Support.
2. Click Create support package.

3. Follow the steps in the Support Package Wizard to package your telephone system records and Your-
Site configuration data.

4. Click Finish.

Controlling services

Services Manager controls all MiContact Center Business services and mandatory system services. A 
complete list of these services displays in the Services Manager.
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To control services 
1. In Management Console, Click System.
2. Click Services Manager.

3. Select the service to control.

4. Right-click the service. 

The right-click menu opens. This enables you to control the service the following ways: 
– Start
– Stop
– Pause
– Resume
– Restart
– Refresh
– Restart All Running Services

5. Select the action to perform.

Converting data files

The Data file conversion tool enables you to convert Toolbox data files to Mitel data files. This enables 
you to restore all historical data from competitor products when changing your solution to MiContact 
Center Business 
1. In Management Console,Click System.
2. Click Data file conversion tool.

3. Select a media server from the list.

4. Click Browse and specify the location of the data files to be converted. 

NOTE: The path must be accessible from the server. We recommend you use a Universal Naming 
Convention (UNC) share.

5. Click Next 

The data file conversion will then process.
6. Click Finish to complete the data file conversion.

Diagnostics monitor
The log and error monitors are accessed via Contact Center Client.
To access log and error monitors 
1. Click Tools in the Contact Center Client ribbon.
2. Click either Log Monitor or Error Monitor, depending on what kind of log information you want to 

review. 

See the following figure
Figure 8.1: Diagnostics monitor
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IVR Routing

Mitel IVR Routing is an all-in-one, scalable, integrated voice processing solution that works in conjunction 
with MiContact Center Business.
IVR Routing enables you to rapidly and intuitively 
• Build workflows in a drag-and-drop graphical interface
• Create and relay static, dynamic, and custom recorded prompts to callers in queue
• Provide callers with Updated Position in Queue (UPiQ) messaging
• Guide callers to the destination that best meets their needs
• Allow customers to request a queued callback by leaving a voice message or using the Web
• Provide workflow branching based off multiple conditions including ANI, DNIS, schedules, and queue 

conditions
• Report on IVR activity

If you are licensed for IVR Routing, it is activated during the MiContact Center Business installation 
process.
NOTE: 
• To support IVR Routing resiliency and redundancy, you must have at least one non-resilient extension 

programmed on the queuing gateway and configured in the Mi Contact Center Business database 
(either manually or via synchronization). In addition, there must be a MiTAI monitor set on this exten-
sion. This is done in YourSite Explorer by ensuring the 'Disable real-time monitoring, data collection 
and call handling on this device' check box is not selected. (Note: This check box is deselected by 
default.) Having the MiTAI monitor set on the extension enables our software to recognize when the 
connection to the queuing gateway is restored following a network outage.

• As a limitation of the telephone system, dual-tone multi-frequency signaling (DTMF) digits are only 
detected if the SIP trunks are configured to send via DTMF 2833. If your SIP trunks are configured to 
send DTMF digits in-band, IVR Routing will not detect any DTMF digits.

• Call record data generated on remote instances of IVR Routing when the main IVR Routing server is 
offline will not be reported on.

IVR Routing enhancements
IVR Routing offers enhancements to navigation, workspace customizing, and existing functionality 
including 
• An Outline pane 

See "Viewing workflows at a glance: The Outline pane".
• Focusing and breadcrumbs 

See "Viewing specific portions of a workflow: Focusing and the Breadcrumb view".
• A MiniMap window and a Pan mode 

See "Navigating the Workflows Canvas: The MiniMap window and the Pan mode".
• A Zoom feature 

See "Resizing workflows: The Zoom feature".
• Expand All, Collapse All, and Restore buttons 

See "Manipulating all activities in a workflow: The Expand All, Collapse All, and Restore buttons".
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• The ability to save and copy workflows as images 
See .

• The ability to annotate activities and workflows 
See .

• Expanded troubleshooting for workflow configuration 
See .

Workflow navigation in IVR Routing

IVR Routing now makes it easier to view and navigate large workflows through several functionality 
enhancements, including
• The Outline pane
• Focusing and breadcrumbs
• The MiniMap window and Pan mode
• The Zoom feature
• The Expand All, Collapse All, and Restore buttons

Viewing workflows at a glance: The Outline pane

The Outline pane displays your workflow in a binary search tree format. You can selectively view the work-
flow and the parent-child relationships of activities and conditions by expanding or minimizing individual 
items in the tree. By providing an overview of the workflow in a compact space, the Outline pane enables 
you to efficiently view complex workflows and the relationships between activities.
You can configure activities or branches directly from the Outline pane by right-clicking in the search tree. 
Right-clicking also highlights the activity in the workflow, providing a clear means of referencing the 
specific activity you are configuring. If, for example, you have several similar activities in your workflow, 
highlighting minimizes errors by helping you confirm you are configuring the correct activity.
Double-clicking an item in the Outline pane brings that item into focus, enabling you to quickly identify and 
update nested activities in complex workflows.

Viewing specific portions of a workflow: Focusing and the Breadcrumb view

You can devote the entire Workflows Canvas to viewing specific portions of a workflow by double-clicking 
activities or branches on the Canvas. This feature enables you to focus on precise elements of compli-
cated workflows and minimizes the need to use subroutines to conserve viewing space.
When you focus on an activity or branch, the Canvas opens in breadcrumb view. Breadcrumbs at the top 
of the Canvas indicate the portion of the workflow you are viewing and the parent elements of those 
portions. After focusing on a specific portion of the workflow, you can incrementally expand your view of 
the workflow by tracing back through parent relationships using breadcrumbs. You can also right-click an 
activity and select 'Go To Parent'. The Breadcrumb view provides an ordered way of redirecting your 
focus in the workflow from precise elements to the bigger picture.
Note that when working in the Breadcrumb view, only the items in focus can be configured. In order to 
configure other items in the workflow, select the breadcrumb that brings the item into focus. (See the 
following figure.)

Figure 9.1: Focusing and the Breadcrumb view
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Navigating the Workflows Canvas: The MiniMap window and the Pan mode

The MiniMap window and the Pan mode enable you to navigate to sections of a workflow without manip-
ulating the horizontal and vertical scroll bars. The MiniMap window displays the workflow in a pop out that 
you can use to navigate the Workflows Canvas. The Pan mode enables you to 'grab' the Canvas and, 
using the mouse, choose what portion of the workflow is centered on the Canvas.
This feature enables you to navigate to specific sections of the workflow without manipulating the hori-
zontal and vertical scroll bars.
The following procedures explain how to 
• Navigate the Workflows Canvas using the MiniMap window
• Navigate the Workflows Canvas using the Pan mode

To navigate the Workflows Canvas using the MiniMap window 
1. Click IVR Routing > Workflows, and select a workflow.
2. Click the MiniMap button, located to the right of the plus sign at the bottom of the workflow.

3. Click and drag the highlighted section over the workflow, as it appears in the MiniMap window.

4. To exit out of the MiniMap window, click the MiniMap button.

To navigate the Workflows Canvas using the Pan mode 
1. Click IVR Routing > Workflows, and select a workflow.
2. Click the Toggle Pan Mode button, located to the left of the '100%' at the bottom of the workflow. 

The cursor displays as a hand icon.
3. Click anywhere on the Canvas to 'grab', and move the mouse to re-center the workflow.

4. To exit out of Pan mode, click the Toggle Pan Mode button.

Resizing workflows: The Zoom feature

You can adjust how large or small your workflow appears in the Workflows Canvas by manipulating the 
slider bar or the plus/minus buttons at the bottom of the Canvas. Using these features, you can zoom in 
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to focus on precise elements of your workflow, or zoom out to get a bird’s eye view. Expressed as a 
percentage, the Zoom feature also determines the size of the highlighted section of the Overview window. 
For more information, see "Navigating the Workflows Canvas: The MiniMap window and the Pan mode".

Manipulating all activities in a workflow: The Expand All, Collapse All, and Restore 
buttons

You can expand or collapse every activity and its corresponding branches in a single operation by clicking 
the Expand All or Collapse All buttons. Clicking the Restore button will return your workflow to the condi-
tion it was in before you expanded or collapsed the activities, enabling you to resume your work efficiently.

Customizing your IVR Routing workspace

Several enhancements in IVR Routing offer additional options for customizing your workspace. New 
workflows open as separate tabs in IVR Routing, freeing up visual space and showcasing individual work-
flows on screen. You can open an existing workflow in a tab by double-clicking the workflow, by 
right-clicking the workflow and selecting 'Open', or by selecting a workflow and clicking 'Edit'.
The Toolbar, Properties, and Outline panes can be minimized, expanded, or pinned to the workspace. 
This enables you to choose how much of your screen is comprised of the workflow versus configuration 
panes. These enhancements enable you to customize your workspace and manage your screen space 
to better facilitate your work.

Configuring IVR Routing
You configure all aspects of IVR Routing in YourSite Explorer.
We recommend you provision your IVR Routing environment in the following order: 
1. Media servers - select the media server type and set the media server settings and options. 

See "Adding 3300 ICP media servers".
2. Ports and extensions - select the extension type and set extension settings and options. 

See "Configuring extensions".
3. Hunt groups - select the phone lines associated to each hunt group and configure the destination 

point for each hunt group. 

See "Configuring hunt groups".
4. Workflows - add various activities and configure their properties and order of execution for incoming 

calls. 

See "Building workflows".

Viewing IVR Routing

You can view IVR Routing in two formats: Horizontal and Vertical.
To select a view type
1. Click IVR Routing.
2. In the ribbon, click View.
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3. In the Page layout pane, select Horizontal or Vertical.

Using the Import Wizard

The Import Wizard enables you to replicate the configurations by exporting a manually set activity and 
then importing it into another activity. The .csv file must have individual pieces of information separated 
by commas or by tabs. You can prepare a .csv file using Microsoft Notepad or Excel.
NOTE: You cannot build a CSV to import it into an IVR activity, but only import the CSV exported from an 
activity.

Changing multiple IVR Routing items at a time

You can change multiple IVR Routing items at a time using the multi-select feature. This feature saves 
you from having to make the same change to multiple devices of the same type. If items do not support 
the multi-select feature, a notification displays in the UI.
NOTE: Only information common across devices of the same type can be changed in one action.
To change multiple IVR Routing items at a time 
1. Click IVR Routing and select an item. 

For example, 'Queues'.
2. Select multiple items by holding Ctrl or Shift and clicking the individual items. Clicking 'Ctrl' enables 

you to select items one at a time and omit items from selection. Clicking 'Shift' selects a span of items.

3. Make any changes.

4. Click Save.

Viewing IVR Routing devices by category or type

You can selectively view IVR Routing devices by category or type by applying filters to the device page. 
For example, you can view only the contact center’s Inbound subroutines by applying the Inbound filter 
to the Subroutines page.
Multiple filters can be applied at a time, enabling you to selectively view devices by multiple categories or 
types. For example, you can view only Inbound and Outbound subroutines by applying these filters to the 
Subroutines page.
The following devices may be viewed by category or type 
• Extensions
• Hunt Groups
• Queues
• Rules
• Subroutines
• Variables
• Workflows

To view variables by category or type 
1. Click IVR Routing and select the device.
2. After Filter, select a device category or type from the drop-down list. 
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NOTE: Filters remain in place until a category is deselected. Selecting ‘None’ removes all filters.

Configuring media servers for IVR Routing

IVR Routing supports 3300 ICP media servers. For more information, see "Adding 3300 ICP media 
servers".

Configuring extensions

An extension is a telephone system answer point that handles calls. Each extension has a specific exten-
sion number. A caller to your contact center is presented with options to dial various answering points. 
The caller can dial an individual agent at an extension through a queue number.
Following is a list of the four extension types specific to IVR Routing and their functions: 
• RAD port 5020 IP: is used to play RAD (Recorded Announcement Device) messages for queue 

announcements.
• Messaging port 5020 IP: is used to process inbound workflows
• Outbound port 5020 IP: is used to process Outbound workflows, including Callbacks
• UPiQ port 5020 IP: is used to process UPiQ (Updated Position in Queue) messages

NOTE: 
• Any extensions configured on the telephone switch are retrieved during synchronization and are 

shown in the extensions list.
• The Outbound extension option is only available if you are licensed for IVR.

Configuring extension port options for IVR Routing

For procedures for adding extensions, see "Adding extensions"
The following procedure takes place in IVR Routing > Extensions.
To configure extension port options 
1. Select an extension and click the Port Options tab.
2. Configure the Port Options as follows:

3. After Workflow, click the Browse button and select the workflow to associate to the extension. 

NOTE: UPiQ ports do not allow you to select a workflow. Instead, you engage UPiQ ports by 
assigning an UPiQ subroutine to the Connect to Caller activity. See "Configuring the Connect to 
Caller activity".

4. After Port State, select either Normal or Emergency from the drop-down list. 

Select 'Emergency' as the port state only if this port is associated to a workflow that is configured to 
have an emergency path. You can configure a port state as 'Emergency' when applicable either within 
YourSite Explorer directly or by using a Management Plan remotely.

5. Select the Trusted Service Level check box to set the service level for the 5020 IP port to 'trusted'. 
This step is necessary if you are using MiVoice Business 5.0 or greater otherwise, do not select this 
check box. 

NOTE: In order to set the trusted service level in YourSite Explorer, you must have already enabled 
write-back functionality on the media server. (See "Enabling write-back functionality"). If you do not 
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have write-back enabled, you must set the trusted service level on the telephone system, instead of 
in YourSite Explorer, by logging in to the 3300 ICP, navigating to 'User and Device Configuration', 
clicking the extension for which you want to set the service level, and, on the Profile tab, selecting 
'Trusted' from the drop-down list beside Service Level.

6. After Remote Server, if this is a remote port, click the Browse button and select the remote media 
server on which IVR Routing is configured.

7. After MiTAI / MiAudio Local Binding IP Address; select the appropriate IP address from the 
drop-down list. 

NOTE: This option is used if you have more than one NIC and want to specify which one is used for 
MiTAI/MiAudio, for example, if you have a voice and data network split.

8. Click Save. 

NOTE: If, after you configure and save the extension, it does not come in to service, check to see if 
the appropriate services are installed and running. For Inbound and RAD ports, the appropriate 
service is the MiContact Center Inbound Router Service. For UPiQ ports, the appropriate service is 
the MiContact Center UPiQ Service. For Outbound ports, the appropriate service is the MiContact 
Center Outbound Router Service. If you discover the service is not installed, it may be that you were 
not licensed for IVR Routing at the time of installation. If that is the case, re-run the Mitel Contact 
Center Configuration Wizard to reinstall the required Routing services.

Deleting extensions

NOTE: You cannot delete an extension if it is associated to a hunt group.
To delete an extension
1. Click IVR Routing > Extensions.
2. Select the extension and click Delete.

3. When prompted, click OK.

Using Extension Quick Setup

The Extension Quick Setup enables you to import extensions into YourSite Explorer from the telephone 
switch. If Read/Write is enabled in 'YourSite > Media servers > Telephone system', the extensions are 
written back to the 3300 ICP.
To use quick setup to create extensions 
1. Click IVR Routing > Extensions, and click Quick Setup.
2. After Active number from, specify the first dialable number of the extension range.

3. After Active number to, specify the last dialable number of the extension range.

4. After Name prefix, enter the text you want prefixed to the name of the port.

5. After Name postfix, enter the text you want postfixed to the name of the port.

6. On the General tab, configure the Media server options as follows: 

– Extension type: Select the extension type from the drop-down list. 
NOTE: Ensure you select the correct extension type for the port. For example, if you want the 
extension to be a messaging port, select Messaging port 5020 IP.
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– Associate the devices to this media server: If you want to configure your ports to be resilient, click 
the Browse button, select a failover media server from the list, and click OK.

– Associate the devices to this failover media server: Click the Browse button, select a failover 
media server from the list, and click OK. 

NOTE: The failover media server will be used to handle the call load in the event the primary 
media server goes offline (only for voice extensions).

– Class of service: This field is automatically populated based on the Class of Service set during 
media server configuration, if there is a default Class of Service selected for the type of port you are 
creating.

– Disable real-time monitoring, data collection and call handling on this device: If you want to 
disable real-time monitoring, data collection, and call handling for this extension, select this check 
box. 

NOTE: 
• Selecting this option unlicenses the port and discontinues its use. Unlicensed extensions can be 

assigned to a workflow but will not go into service or be visible in Contact Center Client.
• Any ports created after you become overlicensed will have this option enabled.

7. Configure the Port Options as follows: 

– After Workflow, click the Browse button and select the workflow to associate to the extension. 
NOTE: UPiQ ports do not allow you to select a workflow. Instead, you engage UPiQ ports by 
assigning an UPiQ subroutine to the Connect to Caller activity. See "Configuring the Connect 
to Caller activity".

– After Port State, select either Normal or Emergency from the drop-down list. 
Select 'Emergency' as the port state only if this port is associated to a workflow that is configured 
to have an emergency path. You can configure a port state as 'Emergency' when applicable either 
within YourSite Explorer directly or by using a Management Plan remotely.

– Select the Trusted Service Level check box to set the service level for the 5020 IP port to 'trusted'. 
This step is necessary if you are using Mi Voice Business 5.0 or greater otherwise, do not select this 
check box. 

NOTE: In order to set the trusted service level in YourSite Explorer, you must have already 
enabled write-back functionality on the media server. (See "Enabling write-back functionality"). 
If you do not have write-back enabled, you must set the trusted service level on the telephone 
system, instead of in YourSite Explorer, by logging in to the 3300 ICP, navigating to 'User and 
Device Configuration', clicking the extension for which you want to set the service level, and, 
on the Profile tab, selecting 'Trusted' from the drop-down list beside Service Level.

– Select the This is a remote port check box, if applicable.
– After MiTAI / MiAudio Local Binding IP Address, select the appropriate IP address. 

NOTE: This option is used if you have more than one NIC and want to specify which one is used 
for MiTAI/MiAudio, for example, if you have a voice and data network split.

– The Port License area details how many IVR Routing port licenses remain and the total number of 
primary and redundant ports for which you are licensed.

8. To create an employee for each extension, on the Employee associations tab, select the Create an 
employee ID for each extension check box.

9. After Start the employee IDs at, type the first employee ID to associate to this extension.

10. After Increment the employee IDs by, type the increment by which the employee IDs will increase.
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11. Click Run.

Configuring hunt groups

A hunt group is a collection of extensions. When a call enters the system and is routed to a hunt group, 
the hunt group searches its members for an available extension and directs the call to that number. Calls 
are rotated through the hunt group until an available extension is found and the caller can be connected. 
Hunt groups can be configured to be resilient, using a failover media server if the primary server fails.
NOTE: 
• MiContact Center Business does not support remote members in a hunt group.
• Any hunt groups configured on the telephone switch are retrieved during synchronization and are 

shown in the hunt group list.
• For information on enabling ports shared by hunt groups to play different messages to different 

queues, see "Dynamic RAD messages".

Adding hunt groups

To add a hunt group
1. Click IVR Routing > Hunt Groups > Add.
2. Complete the following fields:

– Name–Type a name for the hunt group.
– Dialable–Type a dialable number for the hunt group.
– Media Server–Click the Browse button, select a media server from the list, and click OK.
– Failover media server—Click the Browse button, select a failover media server from the list, and 

click OK.
– Class of Service– This field is not mandatory. However, the field may be automatically populated 

based on the class of service for the selected media server.
– Phase timer ring– This option is only configured if you are using a RAD hunt group type and deter-

mines the delay required between successive recorded announcements If no delay is required, 
select '0'.

– Optionally, select Disable real-time monitoring, data collection and call handling on this 
device.

NOTE: If selected, this option disables the hunt group. Deselecting the check box enables the 
hunt group.

– Hunt Group Type–Select the type of extensions for this hunt group:
• Voice– handles messaging type extensions
• RAD – handles RAD type extensions
• Phantom – performs modified DND rerouting
• Voice Mail – handles voice mail type ports
• HCI Reroute – enables external applications to tell the system how to route calls
• Recorder – handles groups of devices using the Record-A-Call feature
• Emergency – identifies the group as an Emergency Call notification hunt group
• Name Tag – identifies the group as using destination-based name tags for display on the ringing 

sets
• Pre-Announce – handles agent greeting extensions
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– Hunt Group Mode–Select Terminal if you want the first line in the hunt group list to always be used, 
Select Circular if you want the next line in the hunt group to be used.

NOTE: RAD hunt groups must be terminal.
– Priority–Specify the hunt group priority level. The priority level ranges from 1 (highest) to 64 

(lowest).

3. Click Save.

Adding extensions to hunt groups

Hunt group members are extensions. To be a member of a hunt group, the extension and the hunt group 
must be of the same type. For example, you can only add RAD extensions to RAD hunt groups.
To add an extension to a hunt group
1. Click IVR Routing > Hunt Groups, and select a hunt group.
2. On the Membership tab, under Available members, select the extension to add to the hunt group.

NOTE: The Available members pane only displays extensions belonging to the same media server 
as the hunt group. Available members are also filtered by hunt group type.

3. Click the > button.

The extension displays in the Selected members window and is now part of the hunt group.
NOTE: 

– If you have assigned the hunt group a Terminal Mode, extensions are searched in chronological 
order and the first available extension is selected first. See "Adding hunt groups". If you have 
assigned the hunt group a Circular Mode, extensions are searched in the order in which they appear 
in the Selected members pane.

– If your workflow uses Dynamic RAD messages, configure each hunt group to begin its search 
starting on different extensions. You do this by changing the order in which extensions appear in the 
Selected members pane for each hunt group. For more information on Dynamic RAD messages, 
see "Dynamic RAD messages".

4. Repeat these steps for all additional extensions you want to add to the hunt group.

5. If your contact center uses a remote configuration, click the Interleave button to distribute the hunt 
group members equally throughout your servers.

6. Click Save.

Configuring hunt group IVR settings

Configuring hunt group IVR settings enables you to associate hunt groups to workflows and set the state 
of ports associated to the hunt group.
To configure hunt group IVR settings
1. Click IVR Routing > Hunt Groups, and select a hunt group.
2. Click the Options tab.

3. To associate the hunt group to a workflow, after Workflow click the Browse button, select a workflow, 
and click OK.

4. To set the state of the port associated to the hunt group, after Port State, select either Normal or 
Emergency from the drop-down list.
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NOTE: If ports are dialed directly, the port's state (Normal or Emergency) is executed. If the port is 
associated to a hunt group and the hunt groups is dialed directly, the port takes on the state config-
ured here.

Deleting hunt groups

To delete a hunt group
1. Click IVR Routing > Hunt Groups.
2. Select the hunt group and click Delete.

3. When prompted, click OK.

Configuring queues

A queue consists of a group of agentsor extension responsible for answering calls pertaining to a specific 
product, service, department, or functional area within your organization. Agentsand extensions can be 
members of multiple queues, handling calls for multiple departments, services etc., depending on agentor 
extension availability. For information on adding queues, see "Adding queues".
IVR Routing adds the ability to configure callbacks, associate UPiQ workflows, and configure RAD 
messages for queues. For information, see "Configuring callbacks", "Configuring UPiQ options", and 
"Configuring RAD messages for queues".
NOTE: Any queues configured on the telephone switch are retrieved during synchronization and are 
shown in the queues list.

Configuring Inqueue routing

You can select Inqueue workflows, such as the Default UPiQ Inqueue workflow, to run when a call enters 
into a queue. You can build your own workflow in the Workflows Canvas or you can associate an Inqueue 
workflow to the queue. For information on building workflows, see "Building workflows".
Inqueue workflows containing Connect to Caller activities require UPiQ ports provisioned for the system. 
Associating these workflows to queues without having UPiQ ports returns a validation error when saving 
the workflow or queue. To provision UPiQ ports for the system, see "Configuring extension port options 
for IVR Routing".
For information on the Default Inqueue and Callback workflows, see "IVR Routing default workflows and 
subroutines".
NOTE: Inqueue workflows cannot be associated to Ring Groups.
The following procedures explain how to: 
• Add and associate a new Inqueue workflow to a queue
• Associate an existing Inqueue workflow to a queue
• Remove an association to an Inqueue workflow

To add and associate a new Inqueue workflow to a queue 
1. Select a voice queue and click the Inqueue Workflow tab.
2. Click the Add button. 

The default Inqueue workflow is added to the queue.
3. Configure the Inqueue workflow. 
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For procedures, see "Building workflows".
4. Click Save.

To associate an existing Inqueue workflow to a queue 
1. Select a voice queue and click the Inqueue Workflow tab.
2. Click the Browse button.

3. Select a workflow and click OK.

4. Click Save.

To remove an association to an Inqueue workflow 
1. Select a voice queue and click the Inqueue Workflow tab.
2. Click the Clear button.

3. Click Save.

Configuring UPiQ options

Updated Position in Queue (UPiQ) messages inform customers of their initial queue position and dynam-
ically continue to inform them of their position in queue and estimated wait time.
NOTE: UPiQ is not available for Ring Groups.
UPiQ messages are configured via the default UPiQ subroutine and a default Inqueue workflow. We 
recommend you configure UPiQ messages by reconfiguring the default workflow and subroutine. See 
"IVR Routing default workflows and subroutines". For information on adding Expected Wait Time 
announcements to a UPiQ subroutine, see "Playing Expected Wait Time announcements".

Playing Expected Wait Time announcements

By default, the Default UPiQ subroutine only provides Updated Position in Queue announcements. 
Expected Wait Time announcements can be added to UPiQ subroutines through the addition of a Play 
activity with the Expected Wait Time prompt to an UPiQ subroutine.
The following procedure takes place in an open UPiQ subroutine.
To add an Expected Wait Time announcement to a UPiQ subroutine
1. Add a Play activity to the subroutine.
2. Select the Play activity and click Properties.

3. After Greeting Prompts, click the  button and select Select from an existing prompt.

4. Select Expected wait time and click OK.

5. Click Save.

Configuring RAD messages for queues

RAD messages are associated to queues and can broadcast to up to 50 callers in the queue. After a call 
is received and has traveled through a workflow to a queue, RAD messages can be configured to play at 
programmed intervals for all callers in that queue. Up to four RAD messages can be associated to each 
queue. A typical RAD message may greet the caller and thank them for holding.
RADs have been optimized in MiContact Center Business to minimize the number of RAD devices that 
IVR Routing requires. Previously, RADs were mapped to a specific queue and its position. RAD optimi-
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zation enables you to reduce the number of ports your system uses by configuring one port to play a 
message simultaneously to multiple queues.
Note that UPiQ and RAD messages are both played to callers in queue. If an UPiQ message plays, the 
RAD;timers reset to prevent both types of messages playing at once.
NOTE: Ring Groups cannot have RAD messages configured through IVR Routing.
To configure RAD messages for a queue
1. Click IVR Routing > Queues, and select a queue from the list.
2. Click the Recorded announcements tab.

3. Specify the following RAD messaging options:

– Dialable— click the Browse button and enter the dialable number of the port or hunt group you want 
to use to play the RAD message

– Start delay—specify the time that must pass after a caller enters the queue or from when the last 
message finished playing before playing the RAD message

– Interflow dialing list—select the interflow dialing list you have configured on the telephone system
– Release digit receiver after recording—select to limit callers to entering digits only while the RAD 

message is playing. If this option is not selected, the caller may still enter digits as prompted by the 
RAD after the RAD completes.

– Embedded music source—select the in-queue music list you have configured on the telephone 
system

– Alternative dialable—enter a secondary port or hunt group you want to use to play the RAD 
message

4. If you want to repeatedly play the RAD message, select Repeat recording enabled and specify the 
repetition interval.

5. After Repeat recording interval, specify the intervals at which the RAD message repeats.

6. After DTMF Receiver Unavailable Action, specify the action when a dial out from a RAD is 
programmed but no DTMF receiver can be seized to enable that functionality.

– Play recording—plays a RAD message. The caller may be prompted with the option to dial out
– Skip—does not play a RAD message but leaves the caller in the queue
– Divert—transfers the caller to the number programmed in the DTMF Receiver Unavailable Answer 

Point Directory Number field

7. After DTMF Receiver Unavailable Answer Point Dialable, enter the desired directory number. For 
numbers longer than seven digits, program this field as a speed call.

NOTE: To use the DTMF Receiver Unavailable Answer Point Dialable option, the DTMF Receiver 
Unavailable Action field must be set to 'Divert'.

8. Click Save.

Configuring queue groups

IVR Routing can use virtual queue groups to provide resiliency to destinations within workflows. For activ-
ities with queue destinations such as Transfer, virtual queue groups can be used as well. When a virtual 
queue group is used with an activity, any time IVR Routing attempts to route to the virtual queue group, 
it will route to the queue located on the same media server as the IVR Routing port running the workflow. 
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In the event that queue is unavailable, the call will be sent to the least busy queue in the virtual queue 
group on the other telephone system.
For IVR Routing devices or activities that use queue conditions, both reporting queue groups and virtual 
queue groups can be used. For queue conditions, a virtual queue group will be treated as a single queue. 
Reporting queue groups use a sum of their stats when used for queue conditions. For more information 
on how queue groups handle real-time queue statistics, see "Real-time queue conditions and queue 
groups".
For more information on configuring queue groups, see "Adding queue groups".

Building workflows

Workflows are the pathways callers use to reach areas and individuals in your organization. Workflows 
dictate the prompts callers hear, the inputs requested by the system, and the available routing options. 
Workflows can identify customers and determine their service needs by phone number, numbers dialed, 
and the digits entered to reach specific areas of your organization. Proper workflow configuration is 
necessary to direct callers to the agents, departments, and employees best qualified to handle their 
requests.
The following sections explain workflows available in IVR Routing, and general workflow configuration 
procedures.
NOTE: 
• The functions performed when a caller contacts your organization depend on the activities included in 

the workflow and how the activities are configured. For more information, see "Activities".
• If your contact center routinely handles a high volume of calls, for optimal traffic handling, we recom-

mend using subroutines in your workflowsor increasing the number of available ports for your work-
flows. For more information on subroutines, see "Building subroutines".

• Workflows must be associated to an extension, hunt group, or queue in order to go live in the system. 
For more information, see "Associating workflows to devices".

• The recommended maximum workflow size is 1 MB.

Workflow types

Workflows are categorized into five types. 
• Inbound—directs incoming calls to the agents, departments, and employees best qualified to handle 

their requests. Inbound workflows can also be used for self-service.
• Outbound—makes outgoing calls to external and internal numbers. Once connected, an Outbound 

workflow can play the connected party a greeting or ask them to enter information into IVR Routing. 
Outbound workflows can also transfer a connected party to a queue, agent, or extension automatically 
or based on responses to an option menu. 

NOTE: Outbound workflow and extension options in YourSite Explorer are only available when 
licensed for IVR.

• RAD—plays RAD messages to all callers in their associated queues
• Inqueue—plays UPiQ and Estimated Wait Time messages to callers in queue
• Agent—plays messages to callers and agents when an agent accepts an incoming ACD call.

Each workflow type offers a specific selection of IVR Routing activities with which to build the workflow. 
For more information, see "Activities".
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Workflow examples

The following workflow examples illustrate common call routing scenarios.
Example 1 — ANI routing
The ANI routing example shows a workflow that routes calls based on the phone number of the customer 
contacting your company. Incoming calls are answered and, based on configured telephone routing rules, 
routed to the Sales department in the incoming call's country of origin. (See the following figure.)

Figure 9.2: ANI routing workflow example
 

Example 2 — DNIS routing
The DNIS routing example shows a workflow that routes calls to separate product lines based on the 
toll-free line dialed by the customer. Incoming calls are answered and, based on the toll-free number 
dialed, routed to the queue responsible for handling call requests for that product line. (See the following 
figure.)

Figure 9.3: DNIS routing workflow example

Example 3 — Schedules and Menus
The schedules and menus routing example shows a workflow that first routes calls through a schedule. 
This determines the system's action based on the date and time that the call arrived. If within business 
hours, the workflow provides a user menu to the caller. If outside business hours, the caller hears an 
after-hours greeting, after which the system terminates the call. (See the following figure.)
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Figure 9.4: Schedules and menus workflow example

Example 4 — Collected Digits
The premium collected digits workflow example shows a workflow that routes calls based on the exten-
sion number inputted by the caller. The call is answered and the caller is prompted to enter the extension 
number of the party they want to reach. The call is routed based on the digits collected. (See the following 
figure.)

Figure 9.5: Collected digits workflow example

Adding new workflows

The following explains the procedure for adding new workflows to IVR Routing. For examples of work-
flows that ship with IVR Routing, see "IVR Routing workflow samples", and "IVR Routing default workflow 
and subroutines".
For information on using Dynamic RAD messages in workflows, see "Dynamic RAD messages".
To create a workflow 
1. Click IVR Routing > Workflows.
2. Click Add > Voice, and select either Inbound, Outbound, RAD,Inqueue, Media, or Agent.

3. In the Properties pane, type a Name for the workflow. The Name must be unique.

4. Type a System Name for the workflow. The System Name must be unique.

5. To disable validation, enabling you to save a workflow with configuration errors or stop a valid work-
flow from being executed, deselect the Validate workflow check box.

6. Select the Designer tab and, from the Toolbox, drag and drop activities to the Workflows Canvas. 
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NOTE: Inbound and RAD workflows must begin with an Answer activity if you intend to play a message or 
collect digits. Inbound, and Outbound, and RAD workflows must end with a Hang Up activity if they do not 
end with a Transfer activity.
7. To assign the workflow to a device, see "Associating workflows to devices". 

NOTE: All workflow configuration errors must be corrected before workflows can be assigned to 
devices. For more information, see "Troubleshooting workflow configuration with the Validation 
button".

8. Click Save.

Naming workflows

For administrative and reporting purposes, you must give workflows unique names and system names. 
A system name is used by IVR Routing to identify the workflow and is used in reporting. A name labels 
the workflow for the user.
To name a workflow
1. Click IVR Routing > Workflows.
2. Select the workflow and click Properties.

3. Type a Name for the workflow. The Name must be unique.

4. Type a System Name for the workflow. The System Name must be unique.

5. Click Save.

Copying workflows

You can reuse existing workflows as templates by copying them. A copied workflow retains all of the 
actions, menus, and conditions of the original workflow, but is not assigned to any device.
To copy a workflow
1. Click IVR Routing > Workflows.
2. Right-click the workflow and select Copy.

3. Right-click anywhere in the workflow list and select Paste.

4. Click Save.

Cutting, pasting, and copying workflow items

You can cut, paste, and copy activities and branches via the right-click menu, within and between work-
flows. This functionality enables you to create and edit workflows efficiently by duplicating, or removing, 
activities and branches and their configuration.
NOTE: Some activities are specific to workflow types. For example, an ANI activity is used in Inbound work-
flows but not Inqueue workflows. Some branches are specific to activity types. For example, the Record 
activity has a Discard branch, but the ANI activity does not. Only cut and paste activities and branches 
into the appropriate workflow and activity types.
To cut an activity or branch from a workflow
• Right-click the activity or branch and select Cut.
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To paste an activity inside a workflow
1. Right-click the activity and select either Copy or Cut.
2. Right-click the activity that will precede the pasted activity, and select Paste.

To paste a branch inside an activity
1. Right-click the branch and select either Copy or Cut.
2. Right click a different branch inside the activity and select Paste.

The copied branch is inserted to the right.

Deleting workflows

NOTE: You cannot delete a subroutine that is added to a workflow. Remove the subroutine from any work-
flow to which it is added, then delete the subroutine.
To delete a workflow 
1. Click IVR Routing > Workflows.
2. Select the workflow and click Delete.

3. When prompted, click OK.

Importing and exporting subroutines and workflows

IVR Routing enables you to import and export subroutines and workflows from, and to, machines and 
networks. Imported subroutines and workflows are automatically converted to IVR Routing's latest 
version. Exported subroutines and workflows can be saved to local hard drives and copied to computers 
and networks.
After importing a subroutine or workflow, please note the following 
• Subroutines and workflows must be validated and any configuration errors corrected in order to go live 

See "Troubleshooting workflow configuration with the Validation button".
• Workflows must be connected to devices specific to your system in order to go live 

See "Associating workflow to devices".

In addition, please see "Recommended practices for importing workflows and subroutines".
To import a workflow 
1. Click IVR Routing > Workflows.
2. Click the Import button, browse to the workflow .xaml file and click Open.

3. Click Save.

To export a workflow 
1. Click IVR Routing > Workflows.
2. Click the Export button, browse to the workflow .xaml file and select it.

3. Browse to the workflow save location and click Save.

Saving and copying workflows as images

You can save snapshots of workflows as images in JPG, PNG, GIF, and XPS formats. You can also copy 
and paste workflow images onto the clipboard, to paste into other programs. Saving or copying workflows 
enables you to easily reference, share, and print your workflow designs.
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Once saved, some portions of large workflows may not display clearly in the image
To save and copy a workflow as an image
1. To save a workflow as an image, right-click on the active portion of the Workflows Canvas and select 

Save As Image....
2. Select a location and a format for saving the image.

3. To copy a workflow as an image, right-click on the active portion of the Workflows Canvas and select 
Copy as Image.

4. You can paste this image into a word-processing or image editing program.

Validating workflows

IVR Routing validates workflows to ensure they do not contain programming or configuration errors before 
going live. To execute a workflow, workflow validation must be enabled. Workflow validation is also 
required to successfully offer interactions to agents. By default, workflow validation is not enabled. This 
allows administrators to configure and save workflows in progress.
If validation is enabled, workflows with errors cannot be saved until the errors are corrected. If validation 
is not enabled, workflow with errors can be saved.
Red exclamation marks on activities indicate configuration errors to be corrected. Yellow exclamation 
marks on activities indicate warnings. Clicking the ‘Validation’ button opens a pane explaining the work-
flow’s errors and warnings.
The pane lists the number of errors and warnings, the activity to which the error or warning is associated, 
and what is required to fix the problem. Double-clicking the error and warning information in the Validation 
pane brings the specific activity into focus, for ease of identification. For more information on focusing, 
see "Viewing specific portions of a workflow: Focusing and the Breadcrumb view".
To validate a workflow 
1. Select IVR Routing > Workflows.
2. Select the workflow and, in the Properties pane, select the Validate workflow check box.

3. Click Save.

Locating workflow items with the Search field

You can locate specific activities and branches in workflows using the Outline pane’s Search field. The 
Search field returns results based on workflow items’ names and system names.
Searches can be performed based on complete or partial search terms. For example, searching ‘sched’ 
will return results for all workflow items containing ‘Schedule’ in the name or system name.
After locating an item in the Search field, you can edit the item either by right-clicking it, toggling to the 
Properties pane, or right-clicking the item on the Canvas.
To locate workflow items using the Search field
1. Click IVR Routing > Workflows.
2. Select a workflow and click Outline.

3. In Search Outline, type the search term and click the Search icon.
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Associating workflows to devices

Workflows must be associated to a device in order to be active in the system. Workflows can, depending 
on their type, be associated to extensions, hunt groups, or queues.
You can only associate workflows to extensions or hunt groups that are of the same type as the workflow. 
For example, you cannot associate a RAD workflow to an Outbound extension type.
After associating Outbound workflows to a device, the ‘Always run' check box in the Workflows and Prop-
erties pane enables and disables workflow execution.
The following workflow types may be associated to the following devices. (See the following figure.)

NOTE: Inbound and RAD workflows may be assigned to an extension and a hunt group. We recommend 
you use one or the other.
The following procedures explain how to 
• Associate a workflow to an extension
• Associate a workflow to a hunt group
• Make an Outbound workflow live
• Associate a workflow to one or more queues

To associate a workflow to an extension 
1. Click IVR Routing > Extensions, and select an extension to associate to the workflow. 

NOTE: For IVR Routing sample workflows, you must select an extension with a Messaging port 5020 
IP extension type.

2. Under Port Options, after Workflow, click the Browse button.

3. Select the workflow to associate to the extension and click OK. 

NOTE: The 'Select a workflow' window displays workflows of the same type as the extension, without 
validation errors.

4. After Port State, select either Normal or Emergency from the drop-down list. Select Emergency only 
if this port is associated to a workflow that is configured to have an emergency path.

5. Click Save.

To associate a workflow to a hunt group 
1. Click IVR Routing > Hunt Groups, and select a hunt group to associate to the workflow.
2. Select the Options tab.

3. Under IVR Settings, after Workflow, click the Browse button.

Table 9.1: Workflows and associated devices, by type

Workflow type Device type

Inbound Extension or Hunt Group

Outbound Extension

RAD Extension or Hunt Group

Inqueue Queue

Agent Queue
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4. Select a workflow and click OK.

5. After Port State, select either Normal or Emergency from the drop-down list. Select Emergency only 
if this port is associated to a workflow that is configured to have an emergency path.

6. Click Save.

To make an Outbound workflow live 
1. Click IVR Routing > Workflows.
2. Select an Outbound workflow.

3. In the Properties pane, select Always run.

4. Click Save.

To associate a workflow to one or more queues
NOTE: Inqueue workflows containing Connect to Caller activities require UPiQ ports provisioned for the 
system. Associating these workflows to queues without having UPiQ ports returns a validation error when 
saving the workflow or queue. To provision UPiQ ports for the system, see Activities.
1. Select IVR Routing > Workflows, and select an Inqueueor Agent workflow.
2. Select the Queue Membership tab.

3. Under Available members, select the queue to associate the workflow to and click >. You can asso-
ciate multiple queues to a single workflow.

4. To associate all queues to the workflow, click >>.

5. Click Save.

Dynamic RAD messages

Dynamic RAD messages enable a group of IVR Routing ports, shared by multiple hunt groups, to play 
different RAD messages to callers waiting in queue. For example, if hunt groups for a Sales queue and a 
Customer Service queue share a port, a workflow using Dynamic RAD messages enables the shared port 
to play a Sales greeting to the Sales queue and a Customer Service greeting to the Customer Service 
queue. Because Dynamic RAD messaging reduces the number of ports required to play messages, it is 
a cost-effective means of tailoring greetings to queues. For more information on configuring RAD 
messages for playback, see "Configuring RAD messages for queues".
NOTE: 
• To ensure the expected Dynamic RAD functionality, we recommend that you configure each hunt 

group to begin its search starting on different extensions. See "Adding extensions to hunt groups".
• Dynamic RAD messages can only be used within RAD workflows.

To use Dynamic RAD messages in workflows, you must ensure that
• Media server configuration is complete. Dynamic RADs require that all hunt groups, extensions, and 

Class of Service options are populated with data from the 3300 ICP. For more information on config-
uring media servers, see "Adding 3300 ICP media severs".

• The Class of Service provisioned in the PBX for Dynamic RADs must have Do Not Disturb set to Yes. 
See "Editing Class of Service options".

• Full Synchronization is completed. For information, see "Performing Synchronization".
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• Extension configuration is complete. Dynamic RAD messages require that each IVR Routing port 
playing the messages is set to RAD port 5020 IP. You must also enable Trusted Service Level for the 
relevant extensions. See "Configuring extensions".

• Hunt group configuration is complete. Dynamic RADs require hunt groups to be configured as RAD 
hunt group types and that the appropriate RAD extensions have been added to the hunt groups you 
will use in your workflow. See "Configuring hunt groups".

• If you using are an IVR Routing instance on a Remote Server, ensure that remote configuration is 
complete. Dynamic RAD messages require that the relevant ports are specified as remote ports and 
assigned to the Remote Server. See "Configuring extensions".

• You have configured the necessary prompts for your RAD messages. See "Configuring prompts".
• You have associated the workflow to the ports (extensions) that will play the RAD messages and to 

the appropriate hunt groups. See "Associating workflows to devices".
• If you are using multiple, un-teamed NICs, you have selected the appropriate MiTAI Binding IP 

address. See "Configuring extensions".

For a demonstration on how to build a workflow that uses Dynamic RAD messages, please see the 
following Mitel Knowledge Base article: http://micc.mitel.com/kb/KnowledgebaseArticle51476.aspx.

Building resilient workflows

Many of IVR Routing’s workflow activities and configurations are dynamic, relying upon statistics and 
information from the Enterprise Server. In situations where the Enterprise Server is unavailable, such as 
during a reboot, the functionality of dynamic workflows is affected. IVR Routing enables contact centers 
to build resilient workflows that respond to disruptions in service to the Enterprise Server, routing calls to 
alternate branches that are not reliant upon statistics from the Enterprise Server. Resilient workflows rely 
on the queue condition statistic Last Queue Update Received and the system variable CCMOnlineStatus.
The Last Queue Update Received queue condition statistic is available in the Queue Condition builder for 
the Queue activity and Rules. In the Queue Condition builder, Last Queue Update Received is assigned 
a duration of time (with a minimum duration limit of 30 seconds) that defines the time that may pass 
between updates from the Enterprise Server before the statistics are considered to be stale. This real-time 
statistic is particularly useful for contact centers that consider a limited amount of stale statistic data to be 
acceptable, such as during the length of time it takes the Enterprise Server to reboot, but may want calls 
to be routed using the Queue activity to different workflow paths if the real-time data from the Enterprise 
Server remains unavailable beyond that timeframe. For information on configuring rules and Queue 
activity, see "Configuring rules" and "Configuring the Queue activity".
The CCMOnlineStatus is a system variable that detects whether or not any real-time data is coming from 
the Enterprise Server to the Routing services for IVR Routing. If data is available from the Enterprise 
Server, it is set to True. If the Enterprise Server’s real-time data is unavailable, it is set to False. In 
conjunction with the Variable Compare activity, calls can be routed down the appropriate True and False 
branches immediately if the availability of data from the Enterprise Server changes. For information on 
the Variable Compare activity, see "Configuring the Variable Compare activity".

Configuring prompts

Prompts are audio clips that provide callers with information during a call. Associated with activities, 
prompts play messages when callers reach the associated activity in a workflow. Prompts can be indi-
vidual wave files or multiple wave files joined together to form custom messages. To see a list of 
pre-configured prompts, go to 'IVR Routing > Prompts'.
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The default language for prompts will be taken from the site language and workflows will be executed in 
that language unless a Language activity has been included in the workflow. Individual prompts can be 
configured to handle multiple languages, working with the Language activity to support multiple 
languages in a single workflow. This reduces the number of prompts that must be created and allows for 
the same set of ports to be used for multiple languages. For more information on the Language activity, 
see "Configuring the Language Activity".
NOTE: The language preference is set to English US by default. To change it to your preferred language 
during the installation, do either of the following:
• Use a Language Activity to overwrite the default settings
• Go to YourSite Explorer and click Site, select the appropriate Site, and select the language you prefer 

as default.

If you want to use your own custom prompts with a callback, you must add your wave files by importing 
the files or recording wave files using a microphone on your computer or your telephone using a Record 
activity in a workflow. Files recorded using YourSite Explorer are added to the Custom category. Files 
recorded using the Record activity are added to the Recording category. You must then associate your 
custom wave files to your callback workflow. See "Configuring callbacks" for more information.
If IVR Routing is enabled for Text-to-Speech, you can add text or Speech Server Markup Language 
(SSML) files to prompts. Text and SSML files support variables entered between double angle brackets, 
such as <<EstimatedWaitTime>>. For information on configuring Text-to-Speech, see "Configuring a 
Text-to-Speech server".
NOTE: Agent prompts cannot be configured to play in a language that is different than the language 
selected as a preference in CCMWeb. Agent language preference settings override agent prompt 
language choices as IVR Routing aligns with agent language settings.

Adding prompts

NOTE: If you are adding prompts in a new language, you must add audio files that correspond to the 
existing audio files in IVR Routing's default language. Otherwise, the caller will not hear anything when 
the prompts are supposed to be playing.
To add a prompt 
1. Click IVR Routing > Prompts > Add.
2. After Language, select the primary language from the drop-down list. 

For Text prompts, Language determines the Voice to use.
NOTE: By default, the language is set to your default site language.

3. Type a Name for the prompt.

4. Type a Description for the prompt.

5. After Category, select one of the following categories from the drop-down list: 

– Callback
– Management
– Samples
– UPiQ
– Custom

Prompt categories are an organizational tool to help keep your prompts sorted and easily accessible. 
To create your own category, after Category, type a name for the new category.
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6. Click one of the following tabs: 

– Text—lists the SSML files added to IVR Routing. Users can add an SSML file or add text to the 
prompt. To add an SSML file, click Add and select SSML file. To add a text, click Add, select Text, 
enter the text, and click OK. To add text to the SSML library for reuse, click Export. 

NOTE: If adding variables to text, enclose them within double angle brackets. For example, the 
EstimatedWaitTime variable is formatted as <<EstimatedWaitTime>>. By default, variables 
are read as Numbers or, if they are currency, Dollars.

– System wave files—lists the system wave files callers hear while in the system or while waiting on 
hold. This pane displays the wave files that are available in your selected language.

– Custom wave files—lists imported and wave files you have recorded. 
To import or record a custom wave file, click Add, then you can do one of the following: 
• Select the Existing wave file option to browse the required folder and select an existing file.
• Select the Record wave file option to use your computer's microphone to record the file.

NOTE: Wave files must be 8khz, Mono, or ULAW format.
– Queue stats—lists up-to-date queue statistics that can be used in prompts
– Variables—lists variables that can be used in prompts 

NOTE: Read back on variables is based on the type of variable. Number variables read back 
the whole number, while digit variables read back individual numbers. For example, number 
variables would read 123 as 'one hundred and twenty-three', while digit variables would read 
123 as 'one, two, three'.

– Prompts used in workflows and subroutines—lists all prompts used in workflows and subrou-
tines

7. In the All SSML Files, All system wave files, All custom wave files, All queue stats, All variables, 
or Prompts used in workflows and subroutines pane, select the file(s) you want to add to the 
prompt.

8. Click > to add the file to the prompt. 

NOTE: The wave or SSML files play in the order they are added to the prompt. To change the order 
in which the files are played, select the file and click the up or down arrow buttons on the right-hand 
side of the dialog box.

9. To add another language’s version of the prompt, click the General tab, and select another language 
from the Language drop-down list. Repeat steps 6-8.

10. Click Save.

Adding files, queue statistics, or variables to prompts

NOTE: Variable readback is only available for numerical variables.
To add files, queue statistics, or variables to a prompt 
1. Click IVR Routing > Prompts, and select the prompt.
2. Click either the Text, System wave files, Custom wave files, Queue stats, or Variables tab.

3. Select either the file, queue stat, or variable to add to the prompt and click >.

4. Click Save.
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Deleting prompts

To delete a prompt
1. Click IVR Routing > Prompts.
2. Select the prompt and click Delete.

3. When prompted, click OK.

Playing prompts

The following explains how to
• Play a prompt
• Play an individual or selection of wave file in a prompt

To play a prompt
1. Click IVR Routing > Prompts, and select the prompt to play.
2. Click Play.

To play an individual or selection of wave file in a prompt
1. Select the prompt you want to play from the prompt list.
2. Select the System save files or Custom wave files tab.

3. Select the wave file(s) to play.

4. Click Play.

Using Prompts Quick Setup

Quick setup enables you to import previously created wave files.
To use quick setup to import prompts
1. Click IVR Routing > Prompts > Quick Setup.
2. After Folder Path, click Browse....

3. Browse to the folder containing the wave files and click OK.

4. After Language, select the primary language from the drop-down list.

NOTE: By default, the language is set to your default site language.
5. Click Run.

Building subroutines

Subroutines are portions of workflows that can be reused in multiple workflows. Subroutines create 
common workflow activity groups that can be easily reused, encapsulating common activity groups in one 
single activity. Subroutines can be reused across workflows or within a single workflow, which helps keep 
workflows manageable and enables rapid workflow creation. They also facilitate workflow updates by 
requiring only one change to affect all workflows that use the subroutine.
With a few exceptions, subroutines and workflows function almost identically. Subroutines are configured 
as Inbound, Outbound, RAD,Management, UPiQ, Media, Agent, and Callback Inbound. Subroutines are 
configured using activities, with specific activities available to each type of subroutine. This enables you 
to use subroutines to access activities not normally available to your workflow type.
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All workflows are associated to queues, ports or hunt groups, however, subroutines are contained within 
workflows and are not associated to queues, ports or hunt groups.
To build a subroutine 
1. Click IVR Routing > Subroutines.
2. Click Add > Voice, and select a type of subroutine.

3. In the Properties pane, type a Name for the subroutine. The Name must be unique.

4. Type a System Name for the subroutine. The System Name must be unique.

5. Select the Designer tab and, from the Toolbox, drag and drop activities to the Workflows Canvas.

6. Click Save.

Adding subroutines to workflows

You can add subroutines you have built or default subroutines to workflows. For more information on the 
default subroutines that ship with IVR Routing, see "IVR Routing default workflows and subroutines".
To add a subroutine to a workflow
1. Click IVR Routing > Workflows, and select the workflow to which you want to add a subroutine.
2. Click Toolbox, and drag and drop a Subroutine activity onto the Workflows Canvas.

3. Right-click the Subroutine and select Assign Subroutine.

4. Select a subroutine from the list and click OK.

5. Click Save.

Deleting workflows

NOTE: You cannot delete a subroutine that is added to a workflow. Remove the subroutine from any work-
flow to which it is added, then delete the subroutine.
To delete a workflow 
1. Click IVR Routing > Workflows.
2. Select the workflow and click Delete.

3. When prompted, click OK.

Configuring callbacks

Callbacks are specialized workflows and subroutines that enable customers to leave a request for a return 
call (callback) from the contact center. These requests sit in queue like a call and offer the agents the 
ability to call back the customer. When a callback is made, customers see the media server’s site name 
and the first endpoint dialable of the media server as the caller ID. For more information about the work-
flows and subroutines that enable your contact center to offer callbacks, see "Default callback workflow 
and subroutines".
For callbacks to function correctly, you must have configured location settings for your media server. If 
location settings are not configured, your callbacks will not be able to contact your customers. See 
"Configuring location settings".
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Supervisors can monitor and requeue, reject, or delete callbacks using the Global callback monitor in 
Contact Center Client and the Callback to be processed grid in Interactive Visual Queue. Alternatively, 
supervisors can use the Callback Requests monitor in Ignite (WEB).
NOTE: Ring Groups do not support handling callbacks. Ring Group queues will not be available when 
configuring callbacks or their associated workflows. Any callback that is routed to a Ring Group will fail.
Three kinds of callbacks are available with IVR Routing. 
• Abandon—Abandon callbacks are automatically generated when a customer hangs up while still in a 

queue, enabling contact centers to contact callers who might have otherwise been missed. Abandon 
callback subroutine workflows are enabled system-wide. For information about adding abandon call-
backs to queues, see "Enabling abandon callbacks".

• Voice—Voice callbacks are initiated by the customer. The customer’s call is removed from the queue 
and a callback request is resubmitted to the queue. This option can be provided by including a Callback 
Request in a workflow. For an overview of the default inbound voice subroutine workflow, see "Default 
Inbound Voice Callback subroutine".

• Web—Web callbacks enable customers to submit callback requests using a website, removing the 
need for customers to call the contact center in order to be placed in queue to speak to an agent. For 
information about enabling web callbacks, see "Enabling web callbacks".

Enabling callbacks

Voice, Abandon, and Web callbacks are enabled in different ways. Voice callbacks are enabled by placing 
a Callback Request activity into a workflow, configuring the activity’s inbound and outbound workflows, 
and then making the workflow available to a queue through a dial out option. For more information on the 
Callback Request activity, see "Configuring the Callback Request activity". For more information about 
the Default Inbound Voice Callback subroutine, see "Default Inbound Voice Callback subroutine". For 
more information about the Default Outbound Callback workflow and the Default Outbound Voice callback 
subroutine, see "Default Outbound Callback workflow" and "Default Outbound Callback subroutines".
Abandon callbacks are disabled by default and must be enabled for each site in MiContact Center Busi-
ness. Once enabled, the abandon callback settings are applied to all workflows associated to the devices 
belonging to that site. Individual queues may be configured to use different abandon callback workflows 
and queues. For more information on enabling abandon callbacks, see "Enabling abandon callbacks". For 
more information about the Default Outbound Callback workflow and the Default Outbound Abandon call-
back subroutine, see "Default Outbound Callback workflow" and "Default Outbound Callback subrou-
tines".
Web callbacks require a webpage to be set up to submit callbacks. IVR Routing includes a template to 
use as your web callback submission page. For details of the template and configuring the template for 
use, see "Configuring the web callback templates". For more information on enabling web callbacks, see 
"Enabling web callbacks". For more information about the Default Outbound Callback workflow and the 
Default Outbound Web callback subroutine, see "Default SIP Outbound workflow" and "Default Outbound 
Callback subroutines".

Enabling abandon callbacks

Abandon callbacks are applied to all of a site’s queues when enabled for the site. Unless configured with 
different abandon callback workflows and destination queues, all queues will use the default abandon 
callback options for the site. If no default queue is selected when abandon callbacks is enabled, abandon 
callbacks will only be generated for queues that have queue destinations set for their abandon callbacks. 
By default, abandon callback requests are only applied to calls that abandon with a time greater than the 
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'Short abandon less than' time specified in individual queues, but short abandon callbacks can be enabled 
for all queues.
NOTE: 
• To duplicate the functionality of the Version 6.0 queue condition builder, place a Queue activity into 

your Outbound abandon callback workflow before the Make Call activity, with a Save Callback activity 
placed in the No Match branch to requeue the callback request. See "Default Outbound Callback 
subroutines".

• Ring Groups do not support abandon callbacks and are not available to be selected for abandon call-
back default queues.

The following procedures explain how to: 
• Enable abandon callbacks
• Change the default Outbound abandon callback workflow
• Select the default queue
• Clear the default queue
• Change the default Outbound abandon callback workflow for a queue
• Change the abandon callback destination for a queue
• Clear the abandon callback destination for a queue
• Disable abandon callbacks

To enable abandon callbacks 
1. Click YourSite > Site.
2. Select a site.

3. Click the Callback Requests tab.

4. Select Submit callback requests when caller abandon a queue.

5. To enable short abandon callback requests, select Allow short-abandon callback requests.

6. After Default outbound subroutine, click the Browse button.

7. Select an outbound subroutine and click OK.

8. After Default queue destination, click the Browse button.

9. Select a queue and click OK.

10. Click Save.

To change the default Outbound abandon callback workflow 
1. Click YourSite > Site.
2. Select a site.

3. Click the Callback Requests tab.

4. After Default outbound subroutine, click the Browse button.

5. Select an outbound subroutine and click OK.

6. Click Save.
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To change the default queue 
1. Click YourSite > Site.
2. Select a site.

3. Click the Callback Requests tab.

4. After Default queue destination, click the Browse button.

5. Select a queue and click OK.

6. Click Save.

To clear the default queue 
1. Click YourSite > Site.
2. Select a site.

3. Click the Callback Requests tab.

4. After Default queue destination, click the Clear button

5. Click Save.

To change the default Outbound abandon callback workflow for a queue 
1. Click IVR Routing > Queues.
2. Select a queue and click the Voice options tab.

3. After Abandon callback subroutine, click the Browse button.

4. Select an outbound subroutine and click OK.

5. Click Save.

To change the abandon callback destination for a queue 
1. Click IVR Routing > Queues.
2. Select a queue and click the Voice options tab.

3. After Abandon callback queue, click the Browse button.

4. Select a queue and click OK.

5. Click Save.

To clear the abandon callback destination for a queue 
1. Click IVR Routing > Queues.
2. Select a queue and click the Voice options tab.

3. After Abandon callback subroutine, click the Clear button.

4. Click Save.

To disable abandon callbacks 
1. Click YourSite > Site.
2. Click the Callback Requests tab.

3. Clear Submit callback requests when caller abandon a queue.

4. Click Save.
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Enabling web callbacks

Web callbacks require a webpage configured to allow customers to submit callback requests to a contact 
center. 
1. Configure sites for web callback settings. 

See "Configuring sites for web callbacks".
2. Configure an Outbound Web Callback subroutine. 

IVR Routing includes the Default Outbound Web Callback subroutine. You can configure your own if 
you so choose. For more information on the Default Outbound Web Callback subroutine, see "Default 
Outbound Callback subroutines".

3. Configure a web callback request page for your contact center. 

See "Configuring the web callback template".
4. Enable the web callback page for callbacks. 

See "Enabling the web callback template for callbacks".

Configuring sites for web callbacks

For each site in your contact center, you must specify the maximum number of web callback requests that 
can be generated by a single IP address per hour. Ring Groups do not support handling web callbacks.
To configure the maximum number of web callback requests that can be generated by a single IP address 
per hour 
1. Click YourSite > Site.
2. Select a site.

3. Click the Callback Requests tab.

4. After Web callback hourly submission limit per user, select the number of callbacks that can be 
submitted from a single IP address per hour.

5. Click Save.

Configuring the web callback template

Web callback enables callers to submit callback requests using a callback request page accessed 
through a contact center’s website. Callers submit a telephone number, name, and time frame within 
which their call should be returned, as well as other optional information, which is then routed to the 
contact center.
IVR Routing includes a web callback template for use as the callback request page for your contact 
center. The following figure shows the web callback template. The web callback template must be manu-
ally configured as a part of your contact center’s corporate website. Experienced web developers can also 
use the template to construct their own web callback page.

Figure 9.6: Template - Default.html
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Viewing the web callback template

The web callback template is stored in a zip file in <installation drive>:\Program Files(x86)\Mitel\MiCon-
tact Center\WebSites\WebCallbackTemplate.zip.

Customizing the web callback templates

You can edit elements of the web callback template to meet your contact center’s needs, changing 
headers, customizing Cascading Style Sheets (CSS), customizing the available countries for the 
template, or even customizing the web callback template content.
Customizing the header
In the templates, Index.html has a header consisting of the text 'Get in touch with us' where you may insert 
a company logo or change the text. You can customize these headers for your contact center.
To customize the header 
1. Open Index.html in a text editor.
2. Replace the text with your own text or an image. 

NOTE: If you are using Notepad with Index.html, press CTRL+F and type <h1> to locate the header 
in the HTML.

3. Save and close the HTML editor.

Customizing the Cascading Style Sheet
The Cascading Style Sheet (CSS) defines how HTML elements are displayed. CSS enables you to 
control the style and layout of multiple Web pages all at once.
To customize the CSS 
1. Open \WebCallbackTemplate\css\main.css in a text editor.
2. Edit the heading and body font sizes and styles, or spacing.

3. Click Save.
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Customizing the content of the web callback template
You can change the content of the web callback template to reflect your business, however, we do not 
recommend changing fields as improper changes will result in a non-functioning webpage. If you have the 
experience, expertise, and resources to edit HTML, you can use the templates to build the webpage you 
desire.
Customizing the available countries in the template
Callbacks to the UK, the USA, and Canada are available by default. You can customize this template to 
include only the countries to which you will offer web callbacks. To do this, you must obtain the country 
GUIDs of the relevant countries from SQL and then add them to index.html.
To obtain country GUIDs from SQL 
1. Open SQL Server Management Studio or another SQL Management program.
2. Query the following select statement: 

SELECT [Pkey], [Name] FROM [CCMData].[dbo].[tblConfig_Country]
3. Record the country GUIDs you require.

To customize the available countries in the template 
1. Open index.html in a text editor.
2. To add a country, add the country GUID from the SQL database and the Country name you want to 

appear in the drop down in the following format: 

<option value=”countryGUID” selected>Country Name in Dropdown</option>
3. If you do not intend to offer web callbacks to Canada, delete <option 

value="A0A5E01E-1304-4893-840B-CFC30B65983F" selected>Canada</option>

4. Save and close the text editor.

Customizing the available queues in the template
Queues enabled for web callbacks are listed on the callback webpage. Contact Centers can select the 
queues which appear and limit customers from accessing certain queues on a given callback webpage. 
To do this, you must obtain the queues’ GUIDs and add them to index.html.
To obtain a queue GUID from YourSite Explorer 
1. In YourSite Explorer, click IVR Routing > Queues.
2. Select a queue.

3. In the ribbon, click Queue Tools.

4. Click Copy queue ID. 

The queue GUID is copied to your clipboard.

To obtain queue GUIDs from SQL 
1. Open SQL Server Management Studio or another SQL Management program.
2. Query the following select statement: 

SELECT [Pkey], [Name] FROM [CCMData].[dbo].[tblConfig_Queue]
3. Record the queue GUIDs you require.
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To customize the available queues in the template 
1. Open index.html in a text editor.
2. To add a queue, add the queue GUID and the queue name you want to appear in the drop down in 

the following format: 

<select name="queue" class="form-control" id="queue">
<option value="queue guid" selected>queue name</option>
</select>

3. Save and close the text editor.

Enabling the web callback template for callbacks

After you create a web callback request page, you need to enable your web callback page to generate 
callback requests for your queues. This is done by adding an application pool for web callbacks and 
adding web callbacks as an application for your website in IIS and specifying in config.js which web call-
back workflow to use. Optionally, the default messages contacts receive after successfully submitting a 
callback or if their callback request fails to submit can be changed.
Before the procedure, you must have 
• Configured a web callback request page using the template
• Added the web callback template files into the desired directory

To enable the web callback template for callbacks 
1. Add the web callback application pool and configure the application settings
2. Add the web callback as an application to your website

3. Set the Enterprise Server for callbacks

4. (Optional) Change the default web callback subroutine

5. (Optional) Change the default success and failure messages

To add the web callback application pool and configure the application settings 
1. Start IIS Manager.
2. Under Connections, select Application Pools.

3. In the Actions pane, select Add Application Pool….

4. Under Name, add a name for the pool.

5. Under .NET Framework version, select the most recent version of .NET Framework 4.5.

6. Under Managed pipeline mode, select Classic.

7. Click OK.

8. Select the Application Pool and in the Actions pane, select Advanced Settings….

9. Configure the settings to match the figure below. 

Figure 9.7: Web callback Application Pools Advanced Settings
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10. Click OK.

To add the web callback as an application to your website 
1. Start IIS Manager.
2. In the Connections pane, navigate to Default Web Site.

3. In the Actions pane, click View Applications.

4. In the Actions pane, click Add Application….

5. Under Alias, provide an alias.

6. Click Select….

7. Select the web callback application pool and click OK.

8. Under Physical path, click … and navigate to the folder containing web.config and click OK.

9. Click OK.

To set the Enterprise Server IP address for callbacks 
1. Navigate to config.js and open in a text editor.
2. Locate the following line of text: 

var Config.EnterpriseServerAddress = "localhost";
3. Replace localhost with your Enterprise Server's IP address.

4. If the Enterprise Server was configured to use SSL during installation, locate the following line of text: 

var Config.EnterpriseUsingSSL = false;
5. Replace false with true.

6. Save and close the text editor.

To change the default web callback subroutine 
1. Navigate to config.js and open in a text editor.
2. Locate the following line of text: 

var Config.OutboundCallbackSubroutineID = "B0AA4E0E-A97D-461E-A7F9-E32026C1FA40";
3. Replace the value with the GUID of the subroutine from SQL. 

The GUID can be obtained from tblConfig_VWM_Subroutine in SQL. See the procedure below for in-
structions on how to obtain this information.

4. Save and close the text editor.

To obtain web callback subroutine information from SQL 
1. Open SQL Server Management Studio or another SQL Management program.
2. Query the following select statement: 

select Pkey,Name from tblConfig_VWM_Subroutine
3. Find your value for your web callback subroutine.

To change the default success and failure message for the web callbacks 
1. Navigate to config.js and open in a text editor.
2. Locate the following lines of text: 
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var Config.SuccessMessage = "Thanks, we will get in touch with you shortly.";
var Config.FailureMessage = "Sorry, we are having difficulties right now. Please try again.";

3. Replace "Thanks, we will get in touch with your shortly." with the desired message for a 
successful callback submission.

4. Replace "Sorry, we are having difficulties right now. Please try again." with the desired message 
for a failed callback submission.

5. Save and close the text editor.

Configuring rules

Rules provide call conditions that are evaluated at the runtime of the workflow. They enable you to 
compare against a broad range of conditions in a single workflow activity, reducing workflow clutter and 
enabling more precise routing.
In a workflow, rules are assigned to a Rules activity. When an incoming call enters a workflow and 
encounters a Rules activity, the call is evaluated against the activity’s associated rules and is branched 
based on whether or not the call meets the rule’s routing rules’ conditions. Routing rules can be based on 
a number of different conditions: 
• ANI (Voice, Inqueue, and Agent )
• DNIS (Voice, Outbound, Inqueue, and Agent)
• Emergency (Voice, RAD, Outbound, Inqueue, and Agent)
• Hunt Group (Voice, RAD, Outbound, Inqueue)
• Queue (Voice, RAD, Outbound, Inqueue, and Agent) 

NOTE: Ring Groups are supported for queue routing rules
• Redirect (Voice, Outbound, Inqueue)
• Schedule (Voice, RAD, Outbound, Inqueue, and Agent)

If the call meets the routing rules’ conditions, then it is routed through the Success branch and has vari-
ables set to specific values based on the pre-configured variable options in the rule. If it does not meet 
the rule’s routing conditions, then the call is routed through the Failure branch. If the call is comparing 
against many routing rules in a single Rules activity, the variables will only be set once, by the first routing 
rule matched.
Rules are best used when you want to route calls based on multiple conditions. A site that has a Monday 
to Friday, 9 am to 5 pm French language queue and a 24-hour English queue could, using ANI and 
Schedule routing rules in a single rule, route calls from French area codes that are calling within business 
hours to the French queues and all other calls to the 24-hour English queue.
For more information on the Rules activity for workflows, see "Configuring the Rules activity".

Adding rules

Routing rules' conditions vary by rules type. See "Configuring rules". Note that you cannot save routing 
rules until after you add variables to your rules. See "Adding variables to rules".
To add a rule 
1. Click IVR Routing > Rules > Add.
2. Select either Voice, RAD,Outbound, Inqueue, or Agent.

3. Type a Name for the rule. 
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NOTE: The Expression field is automatically populated when routing rules have been configured. 
See Adding routing conditions to rules".

Adding routing conditions to rules

NOTE: 
• You cannot save routing rules until after you add variables to your rules. See "Adding variables to 

rules".
• For instructions on grouping rule conditions, see "Grouping expressions".

The following procedures explain how to 
• Add an ANI, DNIS, Hunt Group, or Redirect routing condition to a rule
• Add a Schedule routing condition to a rule
• Add a Queue routing condition to a rule
• Add an Emergency routing condition to a rule

To add an ANI, DNIS, Hunt Group, or Redirect routing condition to a rule 
1. Under Routing Rules, click Add.
2. From the second column, select one of the following routing rule types from the drop-down list: 

– ANI
– DNIS
– Hunt Group
– Redirect

3. From the third column, click the - button.

4. To add a value, click Add and enter a value for the routing rule.

5. Click the Add button.

6. Repeat the above steps to add additional values to the routing rule.

7. To test values, after Test, type the values. 'Pass' or 'Fail' displays depending on whether the test is 
successful.

8. Click OK.

To add a Schedule routing condition to a rule 
1. Under Routing Rules, click Add.
2. From the second column, select Schedule from the drop-down list.

3. From the third column, click the - button.

4. Click Add.

5. Select one of the following conditions from the drop-down list: 

– Date
– DOW (Day of Week)
– Holiday
– Schedule
– Time
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6. Select a value for the condition and click OK.

7. To add more schedule conditions, click Add and repeat the above steps.

8. To test the conditions, under Utilities, enter time and date information and click Test. 'Pass' or 'Fail' 
displays depending on whether the test is successful.

9. Click OK.

To add a Queue routing condition to a rule 
1. Under Routing Rules, click Add.
2. From the second column, select Queue from the drop-down list.

3. From the third column, click the - button.

4. After Queue, click the ... button.

5. Select either the Queue, Queue Group, or Variable tab. 

NOTE: For information on how queue groups use queue real-time statistics, see "Real-time queue 
conditions and queue groups".

6. Select a queue, queue group, or variable to add to the condition and click OK.

7. To add a new queue, see "Configuring Queues". 

NOTE: To configure a new queue for web callbacks, see "Enabling web callbacks".
8. To add a new queue group, select the Queue Group pane and click Add. 

– After Name, type a name for the queue group.
– After Reporting number, type a reporting number for the queue group.
– In the Available members pane, select a queue group and click the > button.

9. To add a new variable, see "Configuring variables"

10. Click Save.

11. To add conditions, at the top of the Queue Conditions dialog box, click Add.

12. From the second column, select a real-time statistic from the drop-down list: 

NOTE: Expected Wait Time requires at least one call waiting in queue for IVR Routing to calculate 
an Expected Wait Time value.

13. From the third column, select one of the following operators from the drop-down list. Options vary 
according to the real-time statistic selected: 

– ! = Not Equal to
– < Less than
– <= Equal to or less than
– = Equal to
– > Greater than
– >= Equal to or greater than

14. In the third column, from the drop-down list select either the Value, Queue Stats, or the Variable tab.

15. Under Value, type in a numeric value or enable the check box for the value.

16. Under Queue Stats, select a queue stat from the drop-down list.
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17. Under Variable, select a variable from the drop-down list.

18. Click OK.

19. If you want to add another condition, at the top of the dialog box, click Add.

20. Repeat the above steps for each additional condition to add to the Queue Condition builder.

21. To import queue conditions, click the Import button and navigate to a *.csv file.

22. To export queue conditions, click the Export button and navigate to a *.csv file. 

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

23. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test. 'Pass' 
or 'Fail' displays depending on whether the test is successful.

24. To delete a queue condition, from the drop-down list to the left of the condition select Delete.

25. Click OK.

To add an Emergency routing condition to a rule 
1. Under Routing Rules, click Add.
2. From the second column, select Emergency.

3. From the third column, select Yes or No.

Adding variables to rules

To add a variable to a rule 
1. Under Variables, click Add.
2. From the second column, select a variable from the drop-down list and click OK.

3. In the third column, select either Value or Variable.

4. If you selected 'Value', type the value.

5. If you selected 'Variable, select a variable from the list.

6. Click OK.

7. Click Save.

Deleting rules

To delete a rule 
1. Under IVR Routing > Rules, select the rule from the list provided.
2. Click Delete.

3. When prompted, click OK.
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Configuring holidays

Holidays can be configured for dates that affect your contact center functionality. For information on 
configuring holidays, see "Configuring holidays".
To configure a holiday 
1. In YourSite Explorer, in the left pane, click IVR Routing.
2. Click Holidays.

3. Click Add.

4. After Name, type the name of the holiday.

5. If this holiday is a company holiday and you want to receive warnings when trying to schedule 
employees for this day, select the This holiday is a company holiday check box.

6. Specify the pattern of the holiday. 

– If the holiday always falls on the same day of the month, select Every and specify the month and 
date the holiday falls on.

– If the holiday has a pattern of falling on a certain day, week, and month, select The and specify the 
pattern, day of week, and month.

– If the holiday is a calculated holiday, such as Good Friday or Easter Monday, select Calculated 
holiday and specify the holiday.

7. Click Save.

Configuring data providers

You can create a connection to a data provider located on a local or an external server to access infor-
mation about incoming callers. For example, the data providers query can be configured to retrieve 
customer information based on ANI, DNIS, collected digits, or variables.
IVR Routing can add the following as data providers to query for data: 
• Microsoft Excel worksheets
• Microsoft SQL servers
• Lightweight Directory Access Protocol (LDAP)

NOTE: If you plan to use the Microsoft Excel worksheets to query for data, you must install the appropriate 
version of Microsoft Access Database Engine Redistributable package. The version and architecture of 
the package should be same as that of the Microsoft Office installed on the system.
IVR Routing also supports the following platforms as generic data providers to query for data: 
• SAP
• Salesforce
• Microsoft Dynamics CRM
• Sugar CRM
• NetSuite
• Zendesk

IVR Routing can also import ODBC connections configured using the Windows ODBC Data Source 
Administrator. IVR Routing supports the following reference platforms for ODBC connections: 
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• IBM DB2
• Oracle Database
• MySQL
• Microsoft Access
• PostgreSQL

Adding a Microsoft SQL server as a data provider

To add a Microsoft SQL server as a data provider 
1. Click IVR Routing > Data providers.
2. Click Add and select Microsoft SQL Server from the drop down list.

3. Type a Name for the data provider.

4. Type the Server Name.

5. Under Log on credentials, select Windows Authentication or SQL Server Authentication.

6. If you select SQL Server Authentication, enter a Username and Password.

7. Click Test Connection.

8. After Database Name, select a database name from the drop down list.

9. Click Save.

Adding a Microsoft Excel worksheet as a data provider

Administrators can add Microsoft Excel worksheets as data providers the system can query.
To add a Microsoft Excel worksheet as a data provider 
1. In the left pane, click IVR Routing > Data providers.
2. Click Add and select Excel from the drop-down list. 

A new data provider is added to the data provider list.
3. Type a Name for the data provider.

4. After Workbook, click Select File and browse to the Excel worksheet you want to use as a data 
provider. 

NOTE: The Excel worksheet must be shared as a workbook and located on a UNC (Universal 
Naming Convention) path, also known as a shared network path. The syntax for a UNC path is 
\\ComputerName\SharedFolder\Resource. An example of the syntax format is \\IVRMA-
CHINE\IVRDIRECTORY\WORKSHEET.xls. Locating the worksheet on a UNC enables IVR 
Routing to access the data provider remotely.

5. Click Open.

6. Click Test Connection.

7. Click Save.
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Adding a LDAP as a data provider

To add a LDAP as a data provider 
1. Click IVR Routing > Data providers.
2. Click Add and select LDAP from the drop down list.

3. Type a Namefor the data provider.

4. Type the Domain of the LDAP.

5. Type the Username for the LDAP.

6. Type the Password for the LDAP.

7. Click Test Connection.

8. Click Save.

Adding a generic data provider

Salesforce, Microsoft Dynamics CRM, SAP, Sugar CRM, NetSuite and Zendesk can be added as generic 
data providers in YourSite Explorer. Generic data providers have certain limitations on the SQL language 
for queries. Consult the following Knowledge Base articles for the SQL language supported for these data 
providers: https://mitel.custhelp.com/app/answers/answer_view/a_id/1013095/loc/en_US.
To add a generic data provider 
1. Click IVR Routing > Data providers.
2. Click Add and select Generic from the drop-down list.

3. Type a Name for the data provider.

4. After Type, select a data provider.

5. Type the User Name of the data provider.

6. Type the Password for the data provider

7. After Other Settings, enter the data provider-specific information. 

– SAP: Enter the client number, the system number, and the connection type, separating the values 
by semi-colons. For example: 250;25;SOAP

– Salesforce: Enter your Salesforce security token. 
Contact your Salesforce administrator to obtain the Salesforce security token.

– Dynamics CRM: Enter the CRM version. For example, CRM Online Office 365.
– Sugar CRM: Enter your Sugar CRM credentials.
– NetSuite: Enter your NetSuite credentials.
– Zendesk: Enter your Zendesk credentials.

8. Enter the connection’s Url.

9. To test the connection, click Test Connection.

10. Click Save.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1013095/loc/en_US
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Adding an ODBC as a data provider

ODBC connections can be added as a data provider through the Windows ODBC Data Source Adminis-
trator. After adding an ODBC using ODBC Data Source Administrator, the ODBC will automatically 
appear in data source providers and will be made available for the Query activity.
You cannot edit an ODBC data provider in IVR Routing.
NOTE: When adding an ODBC connection for IVR Routing, you must use the 32-bit Windows Server tool. 
For more information, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1001249/loc/en_US
When adding third-party data providers for IVR routing, use 64-bit SQL ODBC drivers.
To install 64-bit drivers, use the ODBCAD32.EXE tool from the following location
C:\Windows\System32 folder to configure the System Data Service Name (DSN).
To obtain the required driver for ORACLE 11.x, use Oracle Instant Client Basic and ODBC 11.2.0.2 or 
later installation versions, or contact Oracle for support.

Deleting data providers

NOTE: You cannot delete ODBC data providers from the data providers list.
To delete a data provider 
1. Click IVR Routing > Data providers.
2. Select the data provider and click Delete.

3. When prompted, click OK.

Configuring variables

Variables are used in multiple activities and to perform various tasks, including 
• Storing information for later use
• Collecting user data
• Performing database queries
• Building simple or complex conditions

Variables can be used for different activities such as: 
• Transferring a call to a different queue based on customer class
• Playing different prompts based on account balance
• Holding collected digits for use later in a database query

Some variables can also be passed to agents in the form of a desk top screen pop, providing agents with 
call information generated in the workflow. For more information, see "Passing agents call information in 
screen pops" and "Populating screen pops with workflow variables".
Variables may be configured to mask their contents, enabling variables to be delivered either entirely 
masked or partially masked with a user-specified number of characters left unmasked. This limits the 
exposure of potentially sensitive information, such as credit card or SIN numbers, in logs, call notes, data-
bases, and screen pops. Masked variables cannot be used with the Set Variable activity, but can be used 
with the Variable Compare and Collect Digits activities. Variables that contain file paths to .wav files will 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1001249/loc/en_US
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also mask the .wav file. System variables cannot be masked. Masking is available to the following types 
of variables: 
• Unspecified
• Digits
• Number
• Dollars
• Euros
• Pounds
• DateTime

Masked variables are a component of building workflows in support of PCI compliant systems. For an 
example of a PCI compliant workflow, see "Workflow for PCI Complaint systems".
IVR Routing includes built-in variables that you can use in your workflows. To view these variables and 
to see a description of each, open YourSite Explorer and select IVR Routing > Variables.
Custom variables can be populated through queries and activities such as Set Variable and Execute. See 
"Configuring the Query activity", "Configuring the Set Variables activity", and "Configuring the Execute 
activity".

Adding variables

To add a variable 
1. Click IVR Routing > Variables > Add.
2. Type a Name for the new variable. 

NOTE: 
– The Name must be unique and cannot contain any spaces.
– A variable's name cannot be changed after you save.

3. After Description, provide a brief explanation of the variable function.

4. After VariableType, select the type of variable from the drop-down list. 

NOTE: A variable's type cannot be changed after you save.
5. If Mask Type is available to this type of variable, select the variable’s mask from the drop-down list. 

– NoMask– The variable will not be masked within IVR Routing and associated screen pops, data-
bases, etc.

– FullMask– The entire variable will be masked within IVR Routing and associated screen pops, data-
bases, etc.

– MaskAllExceptLastX– The variable will be masked except for the specified number of final charac-
ters

– MaskAllExceptFirstX– The variable will be masked except for the specified number of first charac-
ters

6. If you selected MaskAllExceptLastX or MaskAllExceptFirstX, specify the number of characters to 
be left unmasked.

7. To enable this variable to display in a toaster notification or screen pop select the Send to agent 
desktop check box.
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8. After Display Name, type the name this variable has when it appears in a toaster notification or screen 
pop.

9. If you selected Dollars, Euros, or Pounds as the variable type, after Currency Format, select the 
format from the drop-down list.

10. If you selected Date Time as the variable type, after Date Format, select the date format from the 
drop-down list. After Time Format, select the time format from the drop-down list.

11. Click Save.

Deleting variables

NOTE: Default variables are grayed out and cannot be deleted.
To delete a variable 
1. Click IVR Routing > Variables.
2. Select the variable and click Delete.

3. When prompted, click OK.

Configuring security

You can configure IVR Routing security settings in YourSite Explorer to allow or prevent users from 
making changes to workflows, devices, and prompts, and to the runtime operations of your business. See 
"Cofiguring security roles".

Configuring Automatic Speech Recognition

IVR Routing supports integration with an Automatic Speech Recognition server to provide Automatic 
Speech Recognition capabilities for collecting spoken caller input. Automatic Speech Recognition 
enables callers in IVR Routing workflows to provide information verbally rather than by entering digits or 
text using a phone keypad.
Automatic Speech Recognition can be added to a site and its media servers through associating an Auto-
matic Speech Recognition server to the site. For information on supported Automatic Speech Recognition 
servers, see the MiContact Center Business and MiVoice Analytics System Engineering Guide.
The following activities support Automatic Speech Recognition: 
• Collect Digits 

See "Configuring the Collect Digits activity".
• Menu 

See "Configuring the Menu activity".

Activities using Automatic Speech Recognition require a Confidence Threshold for speech input. The 
Confidence Threshold determines the threshold for accepting speech input and routing down the appro-
priate branch of the activity. A high Confidence Threshold improves the accuracy of the input while 
increasing the likelihood that speech input will be considered invalid. A low Confidence Threshold lowers 
the chance that speech input will be considered invalid, at the cost of accuracy. The default Confidence 
Threshold for activities using Automatic Speech Recognition is 50%. It is the responsibility of contact 
centers to determine the acceptable Confidence Threshold for speech input in their workflows.
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IVR Routing Automatic Speech Recognition works with IVR Routing Text-to-Speech. For more informa-
tion on Text-to-Speech, see "Configuring a Text-to-Speech server".

Configuring an Automatic Speech Recognition server

Automatic Speech Recognition servers are added on a site-by-site basis.
The following procedure takes place in YourSite > Site.
To configure an Automatic Speech Recognition server 
1. Select a site and click the Speech Recognition tab.
2. After MRCP Server IP, type the IP address of your Automatic Speech Recognition server.

3. After Server Port, type the port the Automatic Speech Recognition server is listening on. 

By default, this is port 5060.
4. Click Save.

Configuring Text-to-Speech

IVR Routing supports integrating with a Text-to-Speech server to provide Text-to-Speech capabilities for 
prompts and activities in IVR Routing.
Text-to-Speech enables textual content to be read to callers in prompts, such as information returned from 
a query, text updates on the status of a service or product queried information back to callers, enable busi-
nesses to provide a text update on the status of a service or product and be able to read this message 
back to customers calling in.
Text-to-Speech can be added to a site and its media servers through associating a Text-to-Speech server 
to the site and specifying the Text-to-Speech server voices (languages) that IVR Routing should use for 
corresponding MiContact Center Business supported languages.
NOTE: Not all languages and their dialects may align exactly to MiContact Center Business supported 
languages. Administrators should select the voice that best matches their region in cases when there is 
not an exact match.
For information about adding Text-to-Speech servers to sites, see "Configuring a Text-to-Speech server". 
For information on Text-to-Speech servers and supported languages, see the MiContact Center Business 
and MiVoice Analytics System Engineering Guide.
If Text-to-Speech capability has been added to IVR Routing, Speech Server Markup Language (SSML) 
files can be added to prompts. Text can also be added to prompts or saved as an SSML file for use in 
other prompts. For information on creating Text prompts, see "Configuring prompts".
Certain IVR Routing activities also support having Text added to them directly. For information on adding 
text-to-speech to activities, see "Configuring the Play activity", "Configuring the Collect Digits activity", and 
"Configuring the Menu activity".
Text-to-Speech for IVR Routing is available as an optional add-on to Contact Center or Workgroup.

Configuring a Text-to-Speech server

Text-to-Speech is configured on a site-by-site basis. To configure Text-to-Speech, you must provide 
server settings as well as associate the Text-to-Speech server’s voices to MiContact Center Business 
supported languages. Associating a voice to a language ensures that the correct voice is used for a work-
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flow's language settings. Voices must be configured on your Text-to-Speech server before they can be 
added to IVR Routing.
For information on supported Text-to-Speech servers, see the MiContact Center Business and MiVoice 
Analytics System Engineering Guide.
he following procedures take place in YourSite > Site.
To configure a Text-to-Speech server 
1. Select a site and click the Text-to-Speech tab.
2. After MRCP Server IP, type the Text-to-Speech server’s IP address.

3. After Server Port, type the port the Text-to-Speech server is listening on. 

By default, this is port 5060.
4. Click Save.

To configure Text-to-Speech server voices 
1. Select a site and click the Text-to-Speech tab.
2. After Voices, click Add.

3. Under Language, select the voice’s language.

4. Under Name, enter the voice’s name. 

The Name must match the name on your Text-to-Speech server.
5. Click Save.

Activities

You use IVR Routing's activities to build workflows and subroutines and configure the routing conditions 
that send customers to queues. Activities perform a range of functions, such as answering, transferring, 
and redirecting calls, collecting caller-entered digits, playing customized prompts, and running database 
queries to retrieve caller information. The following sections explain the activities available in IVR Routing 
and how you can configure activities to build workflows, subroutines, and routing conditions.
This section on Activities begins with "Activities available in IVR Routing" table, which lists IVR Routing's 
activities, displays the activities' icons, and lists activity availability by workflow and subroutine types. The 
section then explains how different activities are categorized based on the functions they perform and how 
they instruct IVR Routing to manage call routing. This Activities section concludes by explaining how to 
configure activities in order to build workflows, subroutines, and ultimately routing conditions. It provides 
procedures for configurations that are common to many activities and concludes with procedures for 
configuring individual activities.
NOTE: The following sections explain activities and their configuration, but do not explain how to use activ-
ities to create an entire workflow or subroutine. For information on how activities can be used to create 
workflows and subroutines, see "Workflow examples", "IVR Routing workflow samples","IVR Routing 
complex workflow configuration", and "IVR Routing default workflows and subroutines".

Activities available in IVR Routing

The following table lists the activities used to create IVR Routing workflows and subroutines. The table 
lists the activity, shows the activity's icon, and lists the activities' availability according to workflow and 
subroutine type. The table also contains links to the configuration procedures for each activity.
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Activity availability varies depending on whether you are licensed for Messaging and Routing or IVR. For 
detailed licensing information, see the MiContact Center Business and MiVoice Analytics System Engi-
neering Guide.
Table 9.2: Activities available in IVR Routing  (Sheet 1 of 8)

Activity Name Icon Details

ANI Available in Inbound, Inqueue 
and Agent workflows
Available in Inbound, 
Management, Callback 
Inbound, and Agent subroutines
For configuration procedures, 
see "Configuring the ANI 
activity".

Answer Available in Inbound and RAD 
workflows
Available in Inbound, RAD, 
Management, UPiQ, Callback 
Inbound, and Agent subroutines
For configuration procedures, 
see "Configuring the Answer 
activity".

Callback Request Available in Inbound workflows
Available in Inbound and UPiQ 
subroutines
For configuration procedures, 
see "Configuring the Callback 
Request activity".

Collect Digits Available in Inbound and 
Outbound workflows
Available in Inbound, Outbound, 
Management, UPIQ, and 
Callback Inbound subroutines
For configuration procedures, 
see "Configuring the Collect 
Digits activity".

Conference Available in Outbound 
workflows
Available in Outbound 
subroutines
For configuration procedures, 
see "Configuring the 
Conference activity".
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Connect to Caller Available in Inqueue workflows
For configuration procedures, 
see "Configuring the Connect to 
Caller activity".

Date Time Validation Available in Callback Inbound 
subroutines
For configuration procedures, 
see "Configuring the Date Time 
Validation activity".

Delay Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, Agent 
subroutines
For configuration procedures, 
see "Configuring the Delay 
activity".
  

DNIS Available in Inbound, Outbound, 
Inqueue, and Agent workflows
Available in Inbound, Outbound, 
Management, UPiQ, Callback 
Inbound, and Agent subroutines
For configuration procedures, 
see "Configuring the DNIS 
activity".

Email Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent 
subroutines
For configuration procedures, 
see "Configuring the Email 
activity".

Table 9.2: Activities available in IVR Routing (Continued) (Sheet 2 of 8)

Activity Name Icon Details
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Execute Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent 
subroutines
For configuration procedures, 
see "Configuring the Execute 
activity".

Go To Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent 
subroutines
For configuration procedures, 
see "Configuring the Goto 
activity".

Hang Up Available in Inbound, Outbound, 
and RAD workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, and 
Callback Inbound  subroutines
For configuration procedures, 
see "Configuring the Hang up 
activity".

Hold State Available in Inbound workflows
Available in Inbound 
subroutines
For configuration information, 
see "Configuring the Hold State 
activity".

Hunt Group Available in Inbound, RAD, and 
Inqueue workflows
Available in Inbound, RAD, and 
Callback Inbound subroutines
For configuration procedures, 
see "Configuring the Hunt 
Group activity".

Table 9.2: Activities available in IVR Routing (Continued) (Sheet 3 of 8)

Activity Name Icon Details
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Language Available in Inbound, Outbound, 
RAD, and Inqueue workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, and 
Callback Inbound subroutines
For configuration procedures, 
see "Configuring the Language 
Activity".

Make Call Available in Outbound 
workflows.
Available in Outbound 
subroutines
For configuration procedures, 
see "Configuring the Make Call 
activity".

Management Available in Inbound workflows
Available in Inbound, 
Management, and Callback 
Inbound subroutines
For configuration procedures, 
see "Configuring the 
Management activity".

Menu Available in Inbound and 
Outbound workflows
Available in Inbound, Outbound, 
Management, UPiQ, and 
Callback Inbound subroutines
Available in Inbound and 
Outbound workflows
Available in Inbound, Outbound, 
Management, UPiQ, and 
Callback Inbound subroutines
For configuration procedures, 
see "Configuring the Menu 
activity".

Mode of Operation Available in Inbound workflows
Available in Inbound and 
Management subroutines
For configuration procedures, 
see "Configuring the Mode of 
Operation activity".

Table 9.2: Activities available in IVR Routing (Continued) (Sheet 4 of 8)

Activity Name Icon Details
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Play Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent 
subroutines
For configuration procedures, 
see "Configuring the Play 
activity".

Query Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent 
subroutines
For configuration procedures, 
see "Configuring the Query 
activity".

Queue Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, UPiQ, Callback Inbound, 
and Agent subroutines
For configuration procedures, 
see "Configuring the Queue 
activity".

Queue Control Available in Management 
subroutines
For configuration procedures, 
see "Configuring the Set Queue 
State activity".

Record Available in Inbound workflows
Available in Inbound, 
Management, UPiQ, and 
Callback Inbound workflows
For configuration procedures, 
see "Configuring the Record 
activity".

Table 9.2: Activities available in IVR Routing (Continued) (Sheet 5 of 8)

Activity Name Icon Details
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Redirect Available in Inbound and Agent 
workflows
Available in Inbound, 
Management, Callback 
Inbound, and Agent subroutines
For configuration procedures, 
see "Configuring the Redirect 
activity".

Retrieve Callback Available in Outbound 
workflows
Available in Outbound 
subroutines
For configuration procedures, 
see "Configuring the Retrieve 
Callback activity".

Rules Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent 
subroutines
For configuration procedures, 
see "Configuring the Rules 
activity".

Save Agent Greeting Available only in the Default 
Record Agent Greeting 
workflow
For configuration procedures, 
see "Configuring the Save 
Agent Greeting activity".

Save Callback Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, UPiQ, Management, 
Callback Inbound, and Agent, 
subroutines
For configuration procedures, 
see "Configuring the Save 
Callback activity".

Table 9.2: Activities available in IVR Routing (Continued) (Sheet 6 of 8)

Activity Name Icon Details
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Schedule Available in Inbound, Outbound, 
RAD, and Inqueue workflows
Available in Inbound, Outbound, 
RAD, UPiQ, and Callback 
Inbound subroutines
For configuration procedures, 
see "Configuring the Schedule 
activity".

Set Device Mode of Operation Available in Management 
subroutines
For configuration procedures, 
see "Configuring the Set Device 
Mode of Operation activity".

Set System Mode of Operation Available in Management 
subroutines
For configuration procedures, 
see "Configuring the Set 
System Mode of Operation 
activity".

Set Variables Available in Inbound, Outbound, 
RAD, and Inqueue workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, and 
Callback Inbound subroutines
For configuration procedures, 
see "Configuring the Set 
Variables activity".

SMS Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, and 
Callback Inbound subroutines
For configuration procedures, 
see "Configuring the SMS 
activity IVR"

Table 9.2: Activities available in IVR Routing (Continued) (Sheet 7 of 8)

Activity Name Icon Details
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Configuring common activity options

Several of IVR Routing's activities share configuration procedures. This section explains procedures for 
configurations that are common to many activities, branches, and branching conditions.
NOTE: Branches route callers to different portions of the workflow. Branching conditions represent the 
circumstances a call must match in order to be sent to a particular branch.

Adding activities to workflows or subroutines

NOTE: The availability of activities varies depending on 

Subroutine Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent 
subroutines
For configuration procedures, 
see "Configuring the Subroutine 
activity".

Swap Prompt Available in Management 
subroutines
For configuration procedures, 
see "Configuring the Swap 
Prompt activity".

Transfer Available in Inbound, Outbound, 
and Inqueue workflows
Available in Inbound, Outbound, 
Management, and Callback 
Inbound subroutines
For configuration procedures, 
see "Configuring the Transfer 
activity".

Variable Compare Available in Inbound, Outbound, 
RAD, Inqueue, and Agent 
workflows
Available in Inbound, Outbound, 
RAD, Management, UPiQ, 
Callback Inbound, and Agent
For configuration procedures, 
see "Configuring the Compare 
Variables activity".

Table 9.2: Activities available in IVR Routing (Continued) (Sheet 8 of 8)

Activity Name Icon Details
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• The workflow or subroutine type you select. For example, you cannot use a Menu Activity in a RAD 
workflow.However, you can use subroutines to access activities from other workflow types. "Activities 
available in IVR Routing" lists the workflows and subroutines to which different activities are available.

• Whether you are licensed for Messaging and Routing or IVR. See the MiContact Center Business and 
MiVoice Analytics System Engineering Guide for more information regarding licensing and activity 
availability.

To add an activity to a workflow or subroutine 
1. Click either IVR Routing > Workflows or IVR Routing > Subroutines, and select the workflow or 

subroutine.
2. Select the Designer tab and, from the Toolbox, drag and drop activities to the Workflows Canvas.

3. Click Save. 

NOTE: A red exclamation mark icon shown in the top right corner of an activity signals a configuration 
error or missing information. You must correct any errors and add all required information before the 
workflow can be associated to a device and go live in the system. For more information, see "Trou-
bleshooting workflow configuration with the Validation button".

Deleting activities or branches from workflows

To delete an activity or branch from a workflow 
1. Right-click the activity or branch and select Delete.
2. When prompted, click OK.

Naming activities, activity configurations, and branches

For administrative and reporting purposes, we recommend you give activities, configuration settings 
within an activity, and branches unique names and system names. A system name is used by IVR Routing 
to identify an activity, activity condition, or branch and is used in reporting. A name labels an activity, 
activity condition, or branch for the user to see.
To name an activity, activity configuration, or branches 
1. Select the activity, activity configuration or branch and click Properties.
2. Type a Name for the activity, activity configuration, or branch.

3. Type a System Name for the activity, activity configuration, or branching condition. 

NOTE: System Names must be unique.
4. Click Save.

Configuring activities and branches for reporting

By configuring activities or branches for reporting, you can run reports on them. This enables you to 
analyze workflow traffic and see how callers are moving through your workflows.
NOTE: You must select ‘Child Reporting Enabled’ for any branches and conditions on which you want to 
run Workflow Condition reports. For more information on Workflow Condition reports, see the Reports 
Guide appropriate to your MiContact Center Business licensing level.
To configure an activity and branch for reporting 
1. Select the activity or branch to configure for reporting and click Properties.
2. Select the Reportable or the Child Reporting Enabled check box. 
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NOTE: Selecting 'Child Reporting Enabled' on parent activities selects all child activities.
3. Click Save.

Configuring an activity’s prompts

Many IVR Routing activities use prompts to play messages at specified points in the workflow or subrou-
tine. Some activities are pre-configured with prompts, while others require prompts to be specified. If an 
activity has configurable prompts, it will have a prompt section in its Properties pane.
If your system is licensed for Text-to-Speech, you can add a prompt as a text string. The system reads 
the text as voice output when the prompt is played.
Prompts can be configured in a number of different ways for activities. You can: 
• Add a new prompt
• Add a variable to a prompt
• Add a new variable to a prompt
• Clear a prompt
• Add a prompt using Quick Add Prompt
• Add text
• Change a prompt to an existing prompt

To add a new prompt 
1. Select the activity in the workflow or subroutine.
2. In the Properties pane, after the prompt you want to change, click the  button and select Add a 

new prompt.

3. After Language, select the primary language from the drop-down list. 

NOTE: 
– The language you select determines the system wave files available to you.
– By default, the language is set to the default site language.

4. Type a Name for the prompt.

5. Type a Description for the prompt.

6. Select a Category for the prompt from the drop-down list: 

– Callback
– Custom
– Management
– Samples
– UPiQ

7. To create your own category, after Category, type a name for the new category. 

NOTE: Prompt categories are an organizational tool to help keep prompts sorted and easily acces-
sible.

8. Select one of the following tabs: 

– Text—lists the SSML files added to IVR Routing. Users can add an SSML file or add text to the 
prompt. To add an SSML file, click Add and select SSML file. To add a text, click Add, select Text, 
enter the text, and click OK. To add text to the SSML library for reuse, click Export.
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– System wave files–lists the system wave files callers hear while in the IVR system or while waiting 
on hold. This pane will only show the wave files that are available in the language you have selected.

– Custom wave files–lists imported and recorded wave files. To import or record a custom wave file, 
click 'Add' and select 'Existing wave file' to import the file or 'Record wave file' to use the microphone 
on your computer to record the file. 

NOTE: Wave files must be 8khz, Mono, or ULAW format.
– Queue stats–lists up-to-date queue statistics for use in prompts
– Variables–lists all variables available for use in prompts 

NOTE: Read back on variables is based on the type of variable. Number variables read back 
the whole number, while digit variables read back individual numbers. For example, number 
variables would read 123 as 'one hundred and twenty-three', while digit variables would read 
123 as 'one, two, three'.

– Prompts used in workflows and subroutines–lists all prompts used in workflows and subroutines

9. In the All SSML Files, All system wave files, All custom wave files, All queue stats, All variables, 
or Prompts used in workflows and subroutines pane, select the files to add to the prompt.

10. Click > to add the file to the prompt. 

NOTE: The wave or SSML files play in the order they are added to the prompt. To change the order 
in which the files will be played, select the file and click the up or down arrow buttons on the 
right-hand side of the dialog box.

11. Click Save. 

NOTE: If you are adding prompts in a new language, you must add audio files that correspond to the 
existing audio files in IVR Routing’s default language. Otherwise, the caller will not hear anything 
when the prompts are supposed to be playing.

To add a variable to a prompt 
1. Select an activity in the workflow.
2. In the Properties pane, after the prompt you want to change, click the  button and select Add a 

variable to a prompt.

3. Select the variable and click OK.

4. Click Save.

To add a new variable to a prompt 
1. In the Properties pane, after the prompt you want to change, click the  button and select Add a 

variable to a prompt.
2. Click the Add button.

3. Type a Name for the variable. The name must be unique and cannot contain spaces.

4. Type a Description for the variable.

5. After Variable Type, select a type from the drop-down list. 

NOTE: A variable's type cannot be changed after you save.
6. If Mask Type is available to this type of variable, select the variable’s mask from the drop-down list. 

– NoMask– The variable will not be masked within IVR Routing and associated screen pops, data-
bases, etc.
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– FullMask– The entire variable will be masked within IVR Routing and associated screen pops, data-
bases, etc.

– MaskAllExceptLastX– The variable will be masked except for the specified number of final charac-
ters

– MaskAllExceptFirstX– The variable will be masked except for the specified number of first charac-
ters

7. If you selected MaskAllExceptLastX or MaskAllExceptFirstX, specify the number of characters to 
be left unmasked.

8. To enable this variable to display in a toaster notification or screen pop, select the Send to agent 
desktop check box.

9. Type the Display Name that this variable has when it appears in a toaster notification or screen pop.

10. If you selected Dollars, Euros, or Pounds as the variable type, after Currency Format, select the 
format from the drop-down list.

11. If you selected Date Time as the variable type, after Date Format, select the date format from the 
drop-down list. After Time Format, select the time format from the drop-down list.

12. Click Save.

To clear a prompt 
1. Select an activity in the workflow or subroutine.
2. In the Properties pane, after the prompt you want to change, click the  button and select Clear 

Prompt.

3. Click Save.

To add a prompt using Quick Add Prompt 
1. Select an activity in the workflow or subroutine.
2. In the Properties pane, after the prompt you want to change, click the  button and select Quick 

Add Prompt.

3. Navigate to the .wav file and click Open.

4. Click Save.

To add text 
1. Select an activity in the workflow or subroutine.
2. In the Properties pane, after the prompt you want to change, click the  button and select Add text.

3. Type the text to be read by Text-to-Speech and click OK. 

You can export the text to your SSML library for reuse by clicking Export.
4. Click Save.

To change a prompt to an existing prompt 
1. Select an activity in the workflow or subroutine.
2. In the Properties pane, after the prompt you want to change, click the  button and select Select 

from an existing prompt.

3. Select a prompt and click OK.
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4. Click Save.

Editing branches

You can edit branches by editing the conditions determining when calls follow the branch.
NOTE: You cannot add branches to the workflow from the edit menu. However, you can use the edit menu 
to add multiple conditions to an existing branch.
To edit a branch 
1. Expand the relevant activity.
2. Right-click the branch to edit and select Edit Condition.

3. Select the value to edit and type the new value.

4. Click Add.

5. To add another value to the condition, at the top of the pane, click Add and type the value or range 
of values.

6. To delete a value, select the value and click Delete.

7. Click OK.

8. Click Save.

Annotating activities in workflows and subroutines

You can tag activities and branches with visible notes using the annotation field. Similar to a sticky note, 
annotations enable you to mark workflows and subroutines with descriptive information. For example, you 
can annotate a Timeout branch to indicate, at a glance, how long before the system times out and where 
customers are directed in the workflow or subroutine once a timeout occurs.
You annotate an activity and open annotations by clicking the notepad icon on an activity or branch. To 
hide an individual, open annotation, click the notepad icon. You can right-click an activity to edit, delete, 
show all, and hide all annotations to provide custom descriptions of your workflow or subroutine.
To add an annotation 
1. Click the notepad icon on the activity or branch and type text in the annotation field.
To delete an annotation 
• Right-click the activity or branch and select Annotations... > Delete.
To expand an individual annotation 
• Click the notepad icon on the activity or branch.
To hide an individual annotation 
• On an open annotation, click the notepad icon.
To expand all annotations 
• Right-click the workflow and select Annotations… > Show All.
To hide all annotations 
• Right-click the workflow and select Annotations... > Hide All.
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Troubleshooting workflow configuration with the Validation button

IVR Routing validates workflows to ensure they do not contain programming or configuration errors before 
going live in your system. IVR Routing also warns you of configurations that are not recommended.
Red exclamation marks on activities indicate configuration errors to be corrected. Yellow exclamation 
marks on activities indicate warnings. Clicking the ‘Validation’ button opens a pane explaining your work-
flow’s Errors and Warnings.
The pane lists the number of Errors and Warnings, the activity to which the Error or Warning is associated, 
and what is required to fix the problem. Double-clicking the Error and Warning information in the Valida-
tion pane brings the specific activity into focus, for ease of identification. For more information on focusing, 
see "Viewing specific portions of a workflow: Focusing and the Breadcrumb view".
You can disable the validation function by deselecting the 'Validate workflow' check box in the Workflows 
pane
NOTE: 
• Workflows containing validation errors, or that have validation disabled, cannot be made active and 

will not run. This prevents improperly configured workflows from going live.
• Workflows that are already assigned to a device but become invalidated cannot be saved until the error 

is corrected.

Changing the order in which branches are evaluated

Administrators change the order in which they system evaluates branches by places the branches in 
sequence. The highest priority branch should be in the left-most position, as IVR Routing evaluates 
branches in the order of left to right.
To change the order in which branches are evaluated 
1. Expand the relevant activity.
2. Right-click a branch and select Move Left or Move Right. 

Alternatively, drag and drop the branches into the desired position
3. Click Save.

Building conditions in IVR Routing

Several features in IVR Routing, including activities, require users to build conditions. For example, users 
may build schedule conditions, queue conditions, and variable compare conditions. These conditions help 
determine how calls are routed through a workflow.
While the individual types of expressions that can be added to conditions may vary, the interface for 
adding, deleting, and grouping expressions remains consistent throughout IVR Routing.
Adding and removing expressions
To add an expression 
• When in a condition designer window, click the Add button.
To remove an expression 
• When in a condition designer window, select the expression you want to delete and click the Delete 

button.
Understanding operators

../../../newimport/visual_workflow_manager/breadcrumb_view.dita#Viewing_specific_portions_of_a_workflow__Focusing_and_the_Breadcrumb_view
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IVR Routing offers a number of different operators to use when building conditions. The following table 
outlines the operators available with IVR Routing.

Selecting expressions
To select an expression 
1. Click the expression's drop-down menu button.
2. Choose Select/Deselect Row.

Alternatively, 
• Click the expression's selector column on the left side of the expression's row.
Grouping expressions
IVR Routing enables users to group expressions, facilitating the easy construction of detailed and specific 
conditions. Expressions within a group may also be grouped together to create nested levels of 
sub-groups within a single group. While grouping is associated with a number of different activities, config-
urations, and dialogs, the grouping clauses are consistent throughout IVR Routing.
NOTE: We recommend you do not exceed eight nested levels of grouping within a group of expressions.
Expressions may be grouped by one of two clauses: 
• AND: Expressions grouped by the AND clause require that all the expressions in a group be met to 

successfully meet the condition. 
NOTE: If no grouping is selected, the AND clause is applied by default.

• OR: Expressions grouped by the OR clause require that only one of the expressions in a group be met 
to successfully meet the condition.

To group expressions 
1. Press the CTRL or Shift key and select the expressions you want to group. Clicking 'CTRL' enables 

you to select items one at a time and omit items from selection. Clicking 'Shift' selects a span of items.
2. Click either the Group AND or Group OR buttons. 

Table 9.3: Operators

Operator Use

!= With this operator the expression will only look for value that do not match 
the exact value entered. This operator is case-sensitive.

= With this operator the expression will looks only for the exact value entered 
in the expression. This operator is case-sensitive. If this operator is being 
used in a comparison, then the expression will look for an exact string match 
between the two items being compared.

Contains With this operator, the expression matches values that contain the entered 
string. It is not case-sensitive.

Length With this operator the expression will look for a value with the specified 
number of characters.

Starts With With this operator, the expression will look for any value that starts with the 
entered value.
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NOTE: You can change the grouping clause by selecting the drop-down beside 'And' or 'Or', and 
changing your selection.

To ungroup grouped expressions 
1. Click the group’s drop-down menu button.
2. Select Ungroup.

To add a new expression to a group 
1. Click the group’s drop-down menu button.
2. Select Add. 

NOTE: If you cannot add an expression to an existing group, ungroup the expression and then 
regroup it with the expression you want to add.

To remove a single expression from a group 
1. Click the expression’s drop-down menu button.
2. Select Ungroup.

Configuring the ANI activity

The ANI activity branches workflows based on all or part of a customer’s ANI. For example, you can 
configure an ANI activity to identify the area codes for callers from French-speaking locations and route 
all applicable calls to queues with French-speaking agents. The ANI activity enables customers to be effi-
ciently routed to the agents best suited to serve them.
You can add branching conditions to ANI activities to determine how IVR Routing directs callers through 
the workflow. You can also import and export ANI conditions in .csv files.
The ANI activity is available in 
• Inbound, Inqueue, and Agent workflows
• Inbound, Management, Callback Inbound, and Agent subroutines

Adding branching conditions to ANI activities

Branching conditions represent the criteria by which IVR Routing directs calls.
To add a branching condition to an ANI activity 
1. Right-click the ANI activity and select Add Condition.
2. Click Add and type a value or range of values for the ANI condition. 

NOTE: 
– To branch all calls from a specified area code, city exchange, or other number identification, include 

an 'x' at the end of the numeric value. 'x' indicates multiple wildcard characters.
– To indicate individual digits or to set branching conditions to match any ANI, include question marks 

instead of numeric values.

3. Click the Add icon.

4. To add more ANI conditions, at the top of the ANI dialog box, click Add.

5. If you want all ANI conditions in the same branch, deselect the Add each row in a separate branch 
check box.

6. Optionally, select the Enable reporting for this branch check box.
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7. To test the ANI conditions, under Utilities, enter a value. 

If the test is successful, 'Pass' displays.
If the test is unsuccessful, 'Fail' displays.

NOTE: You cannot test a range of values.
8. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.

9. Click Save.

To import and export ANI conditions 
1. Right-click the ANI activity and select Add Condition.
2. To import ANI conditions in *.csv format, click Import and navigate to the file name you want to import.

3. To export ANI conditions in *.csv format, click Export and navigate to the file name you want to export. 

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

4. Optionally, select the Enable reporting for this branch check box.

5. To test the ANI conditions, under Utilities, enter a value. 

If the test is successful, 'Pass' displays.
If the test is unsuccessful, 'Fail' displays.

NOTE: You cannot test a range of values.
6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.

7. Click Save.

Configuring the Answer activity

The Answer activity prompts a port to answer a ringing line and begin the workflow.
An internal timeout of 10 seconds determines how long the Answer activity has to answer the line. Once 
the timeout is reached, the workflow is terminated.
NOTE: Inbound and RADworkflows must begin with an Answer activity if you intend to play a message or 
collect digits.
The Answer activity is available in 
• Inbound and RAD workflows
• Inbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

Configuring the Callback Request activity

The Callback Request activity offers customers the ability to leave a callback request. For example, you 
can use the Callback Request activity to enable callers experiencing longer than average wait times to 
request a callback from an agent. Callback Request helps you meet your service level goals by reducing 
abandoned calls.
You can assign callback subroutines and destinations to Callback Request activities. You can also add 
devices to Callback Request destinations.
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The Callback Request activity is available in 
• Inbound workflows
• Inbound and UPiQ subroutines

NOTE: For callbacks to function correctly, you must have configured location settings for your media 
server. If location settings are not configured, your callbacks will not be able to interact your customers. 
See "Configuring location settings".

Assigning callback subroutines to Callback Request activities

The subroutines assigned to Callback Request activities tell the system which Callback Inbound subrou-
tine to offer the caller and which Outbound subroutine offers callback requests to agents.
NOTE: 
• IVR Routing provides default callback subroutines. For information on these default subroutines, see 

"Default Inbound Voice Callback subroutine" and "Default Outbound Callback routine".
• You must assign both Inbound and Outbound subroutines to Callback Request activities.
• You can only save Callback Request activities once you have assigned them subroutines and desti-

nations.

The following procedures explain how to 
• Assign a Callback Inbound subroutine
• Assign a Callback Outbound subroutine
• View associated Callback Inbound subroutine
• View associated Callback Outbound subroutine

To assign a Callback Inbound subroutine 
1. Right-click the Callback Request activity and select Inbound Callback Subroutine....
2. Select a subroutine and click OK.

To assign a Callback Outbound subroutine 
1. Right-click the Callback Request activity and select Outbound Callback Subroutine....
2. Select a subroutine and click OK.

To view the associated Callback Inbound subroutine 
• Right-click the Callback Request activity and select Open Inbound Subroutine.
To view the associated Callback Outbound subroutine 
• Right-click the Callback Request activity and select Open Outbound Subroutine.

Assigning destinations to Callback Request activities

The callback destination represents the agent groups responsible for answering callbacks.
NOTE: Ring Groups are not supported for handling callback requests.
To assign a destination to a Callback Request activity 
1. Right-click the Callback Request activity and select Destination....
2. Select a destination from one of the following devices: 

– Queue
– Queue group
– Variable
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– Agent
– Extensions

3. Click OK.

4. Click Save.

Adding new devices to Callback Request destinations

The following procedures explain how to 
• Add a new queue, queue group, extension, variable, or agent device to a Callback Request destination
To add a new queue, queue group, variable, extension, or agent device to a Callback Request destination 
1. Right-click the Callback Request activity and select Destination....
2. Select one of the following tabs: 

– Queue
– Queue Group
– Variable
– Extensions
– Agent

3. In the Queue, Queue Group, extension, or Agent tabs, at the top of the dialog box, click Add.

4. To add a new queue, in the Queue pane, follow the steps under "Adding queues". 

NOTE: 
– To configure a new queue for web callbacks, see "Enabling web callbacks".
– To configure a new queue for abandon callbacks, see "Enabling abandon callbacks".
– To associate a queue to an UPiQ workflow, see "Configuring Inqueue routing". For information on 

setting up UPiQ workflows, see "Default Inqueue UPiQ workflow and subroutine".

5. To add a new queue group, follow the corresponding steps in "Adding queue groups".

6. To add a new variable, follow the corresponding steps in "Adding variables".

7. To add a new extension, see "Configuring extension port options for IVR Routing".

8. To add a new agent, follow the corresponding steps in "Adding agents".

9. When you have configured the new device, click Save.

10. Click Save.

Configuring the Collect Digits activity

The Collect Digits activity prompts callers to enter, through their dial pad or by speech, information that 
can then be stored in a variable. For example, Collect Digits could enable a caller to enter their member-
ship number when they enter the workflow. If stored in a custom variable, this information can be sent to 
an agent to provide additional information about the customer.
You can configure options and collection settings for Collect Digits activities to determine how IVR 
Routing directs callers through the workflow.
The Collect Digits activity is available in 



279

CONFIGURING IVR ROUTING
CHAPTER 9 IVR ROUTING

• Inbound and Outbound workflows
• Inbound, Outbound, Management, UPiQ, and Callback Inbound subroutines

NOTE: Information acquired by a Collect Digits activity is stored within the <<LastCollectedDigits>> system 
variable. Subsequent Collect Digits actions overwrite this system variable. You can also select a variable 
in which to store customer-entered digits.

Configuring options for Collect Digits activities

The Collect Digits activity supports both dialed confirmation input as well as spoken confirmation input. 
Spoken input requires that a confidence threshold be set. For information on confidence thresholds, see 
"Configuring Automatic Speech Recognition".
The following procedures explain how to: 
• Configure options for the Menu activity
• Configure confirmation settings for the Collect Digits activity
• Configure speech confirmation settings for the Collect Digits activity
• Configure reporting for the Collect Digits activity

NOTE: The Collect Digits activity requires collection settings be configured before the activity can be 
saved. See "Configuring collection settings for Collect Digits activities" and "Configuring speech collection 
settings for Collect Digits activities".
To configure options for a Collect Digits activity 
1. Select the Collect Digits activity and click Properties.
2. After Invalid Attempts, type the number of times a caller can try to enter information.

3. After Multi Digit Delay, type how long a caller has to enter another digit. 

NOTE: Callers who take longer to enter a digit will be prompted again to enter their digits. After the 
maximum number of attempts is reached, the call follows the Failure branch.

4. After No digit timeout (sec), type how long the system waits for the caller to enter a digit before timing 
out.

5. Click Save.

To configure confirmation options for the Collect Digits activity 
1. Select the Collect Digits activity and click Properties.
2. To enable callers to skip the system's readback of the collected digits, select the Barge In check box.

3. After Confirm Digit, select a confirmation digit from the drop-down list. This is the digit a caller 
presses to confirm that their input is correct.

4. After Confirm Input, click the  button and follow the applicable steps under Default Outbound Call-
back subroutines. This sets the prompts callers hear asking them to confirm the digits they have 
entered.

5. Click Save.

To configure speech confirmation setting for the Collect Digits activity 
1. Select the Collect Digits activity and click Properties.
2. After Confirm Speech, click ….

3. Click Add and type the confirmation digit.
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4. Click the Add button.

5. To add more confirmation digits, click Add.

6. Click OK.

7. After Speech Confidence, set the confidence threshold. 

The default is 50.
8. Select Speech Enabled.

9. After Speech Language, set the language for the speech confirmation input from the drop-down list.

10. Click Save.

To configure reporting for the Collect Digits activity 
1. Select the Menu activity and click Properties.
2. Select the Child Reporting Enabled check box.

3. Click Save.

Configuring collection settings for Collect Digits activities

Collection settings assign: 
1. The variable in which collected digits are stored, if you do not want to use <<Last Collected Digits>>
2. The greeting callers hear when prompted to input digits

3. The digit callers enter when finished inputting digits

4. The maximum and minimum number of digits a caller can input

To configure a collection setting for a Collect Digits activity 
1. Select the Collect Digits activity and select Properties.
2. After Collection Settings, click the … button.

3. To store customer-entered digits in a variable other than <<Last Collected Digits>>, after Variable, 
click the … button.

4. To use an existing variable, select a variable and click OK.

5. To add a new variable, click Add and follow the applicable steps under "Adding variables". 

NOTE: The following variables are available to Collect Digits: Dollars, Euros, Pounds, Digits, 
Number, and DateTime.

6. Under Greeting, click the … button and select the greeting callers hear.

7. Click OK.

8. To add a new greeting, click Add and follow the corresponding steps in "Configuring prompts".

9. Under Terminating Digit, type the digit that callers enter when they are finished inputting digits.

10. Under Minimum digits to collect, type the minimum number of digits a caller can input.

11. Under Maximum digits to collect, type the maximum number of digits a caller can input. 

NOTE: When a caller reaches the maximum number of digits, IVR Routing will not wait for the termi-
nating digit.
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12. To configure another collection setting, click Add.

13. To delete a collection setting, select the setting and click Delete.

14. Click OK.

15. Click Save.

Configuring speech collection settings for Collect Digits activities

The Collect Digits activity can be used to collect speech and store it as data in variables. The Collect Digits 
activity will not pass through the Success branch until the collected speech has been recognized by the 
system. If the speech is not recognized, the activity will route down the Invalid branch.
In addition to the specified collection variable, collected speech and its confidence threshold are stored 
in the <<LastCollectedDigits>> and <<LastRecognitionConfidence>> variables by the Collect Digits 
activity.
Collecting speech requires two key additional elements be set on the Collect Digits collection settings: 
• Confidence Threshold
• Grammar type and speech grammar

The Confidence Threshold determines the threshold for accepting the speech and routing down the 
Success branch of the Collect Digits activity. For more information on Confidence Thresholds, see 
"Configuring Automatic Specch Recognition".
Collect Digits applies grammar to the collected speech to process it. Grammar type determine what set 
of speech grammar is available for use with Collect Digits. There are two sorts of grammar types 
supported with IVR Routing: 
• Builtin – Default ASR grammar file. Builtin provides speech grammar for the standard IVR Routing 

variables, selectable from the speech grammar drop-down list. Consult your Automatic Speech Recog-
nition server documentation for information on Automatic Speech Recognition grammar.

• GrXML – Custom grammar files in the GrXML format. GrXML can be used to provide grammar for 
names of employees so callers can say a name to get routed to that employee’s extension or for bank 
numbers. Speech grammar is specified in the GrXML file.

To configure speech collection settings 
1. Select the Collect Digits activity and select Properties.
2. After Collection Settings, click the … button.

3. To store customer-entered digits in a variable other than <<Last Collected Digits>>, after Variable, 
click the … button.

4. Under Variable, click the ... button, select a variable and click OK. 

To add a new variable, click Add and follow the applicable steps under "Adding variables".
NOTE: The following variables are available to Collect Digits: Dollars, Euros, Pounds, Digits, 
Number, and DateTime.

5. Under Greeting, click the … button and select the greeting callers hear.

6. Click OK. 

To add a new greeting, click Add and follow the corresponding steps in "Configuring prompts".
7. Under Terminating Digit, type the digit that callers enter when they are finished inputting digits.
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8. Under Minimum digits to collect, type the minimum number of digits a caller can input.

9. Under Maximum digits to collect, type the maximum number of digits a caller can input. 

NOTE: When a caller reaches the maximum number of digits, IVR Routing will not wait for the termi-
nating digit.

10. Select Recognition Enabled.

11. Under Configured Threshold, set the Confidence Threshold 

The default is 50.
12. Under Grammar Type, select the grammar type to apply to the collected speech.

13. If you are using Builtin Grammar Type, under Speech Grammar, select the Speech grammar 
matching the variable type.

14. If you are using GrXML Grammar Type, under Speech Grammar, click ….

15. Browse to a GrXML file and click Open.

16. To configure another collection setting, click Add.

17. To delete a collection setting, select the setting and click Delete.

18. Click OK.

19. Click Save.

Configuring the Conference activity

The Conference activity connects a call already in progress to a specified destination. For example, you 
can use the Conference activity as part of an outbound workflow to enable an agent, who has been 
offered a callback request from the queue, to connect to the customer who left the interaction request. 
The Conference activity’s destination can be retrieved from a data source, including a SQL database, an 
Excel file, a Web Service call, or a custom variable.
The Conference activity has seven branches: Success, Client Disconnected, Agent Disconnected, No 
Answer, Destination Busy, Invalid Destination, and Failure. Client Disconnected and Agent Disconnected 
enable workflow behavior to be configured when the client (the party called by the Conference activity) or 
the agent (the party who initiated the Conference) disconnects while the Conference activity is playing its 
prompts to both conference parties.
The Conference activity uses three prompts: 
• Pre connect—This prompt plays to the conference initiator, informing them that the call is being estab-

lished. The default prompt is Callback Agent Pre-Connect.
• Connecting to customer—This message indicates that the conference is being connected. The 

default prompt is Callback Agent Connecting.
• Greeting message to customer—This prompt plays to the destination (typically a customer) before 

the agent connects indicating that they are being connected to an agent. The default prompt is Call-
back Agent Callers Message.

Administrators can change the prompts if they want to use a Conference activity for something other than 
callbacks. For instructions on changing an activity’s prompts, see "Configuring an activity’s prompts".
The Conference activity is available in 
• Outbound workflows
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• Outbound subroutines

Setting the Conference activity’s destination and call behavior

You must set the Conference activity's destination. This destination can be internal or external, and may 
be set from an extension,a queue, a queue group, or a variable. A newextension, queue, queue group, 
or variable may be created to serve as the destination.
By default, the Conference activity’s call to the destination is defined as an external call using the 
outbound digits defined on the media server. This option can be disabled if the Conference activity is used 
to reach internal destinations.
The Conference activity will ring for a designated time (configurable but one minute by default) before 
routing down the No Answer branch.
The following procedures explain how to: 
• Specify a destination for the Conference activity
• Specify a newextension, queue, or queue group as a destination
• Specify a new variable as a destination
• Configure the Conference activity for internal calls
• Set how long the Conference activity will ring a destination

To specify a destination for a Conference activity 
1. Select the Conference activity and click Properties.
2. After Destination, click the … button.

3. Select one of the following from the drop-down list: 

– Extension
– Queue
– Queue group
– Variable

4. Click OK.

5. If the call to the destination will use the outbound digits defined on the media server, ensure External 
Call is selected.

6. Click Save.

To specify a newextension, queue, or queue group as a Conference activity’s destination 
1. Select the Conference activity and click Properties.
2. After Destination, click the … button.

3. Select one of the following from the drop-down list: 

– Extension
– Queue
– Queue group
– Variable

4. In theExtension, Queue, Queue Group, Variable tabs, at the top of the dialog box, click Add.

5. To add a new extension, see "Configuring extension port options for IVR Routing".
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6. To add a new queue, in the Queue pane, follow the steps under "Adding queues". 

NOTE: 
– To configure a new queue for web callbacks, see "Enabling web callbacks".
– To configure a new queue for abandon callbacks, see "Enabling abandon callbacks".
– To associate a queue to an UPiQ workflow, see "Configuring Inqueue routing". For information on 

setting up UPiQ workflows, see "Default Inqueue UPiQ workflow and subroutine".

7. To add a new queue group, follow the corresponding steps in "Adding queue groups".

8. To add a new variable, follow the corresponding steps in "Adding variables".

9. Click Save.

10. If the call to the destination will use the outbound digits defined on the media server, ensure External 
Call is selected.

11. Click Save.

To configure the Conference activity for internal calls 
1. Select the Conference activity and click Properties.
2. Clear the External Call check box.

3. Click Save.

To set the amount of time the Conference activity will ring a destination 
1. Select the Conference activity and click Properties.
2. After Timeout Duration, set the number of seconds the Conference will ring a destination.

3. Click Save.

Configuring the Connect to Caller activity

When a caller is waiting in queue, the Connect to Caller activity finds an available UPiQ port and enables 
the port to connect to the caller. The activity then executes a subroutine that plays UPiQ messages to 
callers waiting in queue, based on criteria you specify.
To specify this criteria, you can assign the Connect to Caller activity the default UPiQ subroutine, or a 
reconfigured version of the default UPiQ subroutine. If the caller hangs up or if the activity is not able to 
connect to the caller, the Failure branch is followed. If no available UPiQ port is found, the No Port Avail-
able branch is followed.
For information on configuring the Connect to Caller activity in UPiQ workflows, including the Failure and 
No Port Available branches, see "Default Inqueue UPiQ workflow and subroutine".
The Connect to Caller activity is available in Inqueue workflows.
NOTE: Inqueue workflows containing Connect to Caller activities require UPiQ ports provisioned for the 
system. Associating these workflows to queues without having UPiQ ports returns a validation error when 
saving the workflow or queue. To provision UPiQ ports for the system, see "Configuring extension port 
options for IVR Routing".

Assigning subroutines to the Connect to Caller activity

Assigning subroutines to the Connect to Caller activity enables callers to hear UPiQ messages while 
waiting in queue. You can only assign an UPiQ subroutine to the Connect to Caller activity.
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NOTE: If you want to create a subroutine for the Connect to Caller activity, we recommend you do so by 
reconfiguring the default subroutine shipped with IVR Routing. To access the subroutine, select IVR 
Routing > Subroutines > Default UPiQ.
To assign a subroutine to the Connect to Caller activity 
1. Right-click the Connect to Caller activity and select Assign.
2. Select a subroutine and click OK.

3. Click Save.

Configuring the Date Time Validation activity

The Date Time Validation activity is used in Callback Inbound subroutines to validate date and time infor-
mation stored in the <<<CallbackPreferredDateTime>> variable. The activity checks that the date and 
time entered in a previous Collect Digits activity (and collected in the <<CallbackPreferredDateTime>> 
variable) is accurate and displays in the day/month/year/time of day format of DDMMYYYYTTTTXX, 
where XX is either ‘26’ for AM or ’76’ for PM.
The Date Time Validation activity is available in: 
• Callback Inbound subroutines

Configuring the Delay activity

The Delay activity suspends a workflow for a predetermined time. For example, a customer calling the 
system will hear a welcome menu that lasts a certain number of seconds. To test your workflow and simu-
late the customer’s experience, you can insert a Delay activity suspending the workflow for a duration that 
matches the length of the prompt. The Delay activity also enables third-party applications to process a 
command before continuing to a step that requires the processing be complete.
You can set the duration of a Delay activity to determine for how long the IVR Routing will suspend the 
workflow.
The Delay activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, Agent subroutines

Setting the duration of Delay activities

To set the duration of a Delay activity 
1. Select the Delay activity and click Properties.
2. Set the Duration of the Delay activity, in seconds.

3. Click Save.

Configuring the DNIS activity

The DNIS activity branches workflows based on the number a customer has dialed. For example, you can 
configure DNIS activities to branch calls to a 'Service' section of the workflow as opposed to a 'Sales' 
section of the workflow. DNIS activities enable the use of a single workflow and port set for calls to multiple 
business lines.
You can add branching conditions to DNIS activities to determine how IVR Routing directs callers through 
the workflow. You can also import DNIS conditions from a .csv file or from a DNIS table.
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The DNIS activity is available in 
• Inbound, Outbound, Inqueue, and Agent workflows
• Inbound, Outbound, Management, UPiQ, Callback Inbound, and Agent subroutines

Adding branching conditions to DNIS activities

To add a branching condition to a DNIS activity 
1. Right-click the DNIS activity and select Add Condition.
2. Click Add and type a value or range of values for the DNIS condition.

3. Click the Add icon.

4. To add more DNIS conditions, at the top of the dialog box, click Add.

5. If you want all DNIS conditions in the same branch, deselect the Add each row in a separate branch 
check box

6. Optionally, select the Enable reporting for the Branch check box.

7. To test the DNIS conditions, under Utilities, enter a value or range of values. 

If the test is successful, 'Pass' displays.
If the test is unsuccessful, 'Fail' displays.

NOTE: You cannot test a range of values.
8. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.

9. Click Save.

To import and export DNIS conditions 
1. Right-click the DNIS activity and select Add Condition.
2. To import DNIS conditions in .csv format click Import > Import from file and navigate to the file name. 

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

3. To import DNIS conditions from a DNIS table, click Import > Import from DNIS table.

4. Select the DNIS conditions to import and click OK.

5. If you want all DNIS conditions in the same branch, deselect the Add each row in a separate branch 
check box.

6. To export DNIS conditions, click Export and navigate to the file name.

7. Optionally, select the Enable reporting for the Branch check box.

8. To test the DNIS conditions, under Utilities, enter a value. 

If the test is successful, 'Pass' displays.
If the test is unsuccessful, 'Fail' displays.

NOTE: You cannot test a range of values.
9. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.
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10. Click Save.

Configuring the Email activity

The Email activity enables IVR Routing to send emails, with or without attachments, to recipients via the 
SMTP connection configured in YourSite Explorer. You can populate Email fields with variables, and you 
can populate email attachments with variables or files. For example, you can use the Email activity to 
enable automated emailing of purchase orders and reports from within a workflow. The Email activity 
allows electronic information to be sent from within a workflow efficiently and accurately.
Email activity templates support HTML and text-based content. Template fields can be populated with 
variables, and attachments can be populated with variables or files.
You can configure Email activity templates and add and edit SMTP mail server connections to the Email 
activity.
The Email activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

NOTE: To configure the SMTP connection in YourSite Explorer, see "Configuring SMTP connections to 
MiContact Center BusinessMiVoice Analytics".

Populating Email activity templates

The following explains how to populate email templates.
NOTE: 
• To see a list of Email variables and their descriptions, go to Multimedia > Variables.
• You can populate fields in an Email activity template with a variable by typing the name of the variable 

between double-angle brackets. The text between the angle brackets will be replaced with the value 
of the variable currently executing in the workflow. 
For example, <<ANI>>. In this variable, ANI will be replaced with the number from which the caller is 
phoning.

• You can also right-click any field in the email template and select a variable from the dropdown list.
• Variables must be either populated with a value that points to a file path or populated by an activity 

within the workflow.

To populate an Email template
NOTE: Email content inserted via the <<Body>> variable in the Email activity is limited to 2MB. After 2 MB, 
content inserted via the <<Body>> variable is truncated.
1. Right-click the Email activity and select Edit Email Template.
2. Configure all email fields as applicable. 

NOTE: In the To:, Cc:, and Bcc: fields, separate multiple addresses with semi-colons.
3. In the body of the email, type the template’s text.

4. To populate fields with variables, right-click the field and select the variable from the dropdown list. 
You can also type the name of the variable between double angle brackets. For example, <<ANI>>.

5. To indicate the importance of the email message, after Priority: select a level from the drop-down list. 

NOTE: This option sets a visual indicator of the message’s importance in supporting email clients 
only.
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6. Click OK.

7. Click Save.

To add attachments 
1. Right-click the Email activity and select Edit Email Template.
2. After Attachments, click the Browse button.

3. To add a variable, click Attachments and select the variable.

4. Click Add.

5. To add additional variables, repeat steps 3-4.

6. To add a file, click Browse.

7. Navigate to the file and click Open.

8. To add additional files, repeat steps 6-7.

9. To change the order of the attachments, select the attachment and click Up or Down.

10. To remove an attachment, select the attachment and click Remove.

11. Click OK.

12. Click OK.

13. Click Save.

Adding and editing SMTP mail server connections to Email activities

To add and edit SMTP mail server connections to an Email activity 
1. Right-click the Email activity and select Edit SMTP Server.
2. Select an SMTP mail server connection and click OK.

3. To add a new SMTP mail server, click the Add button and follow the steps in "Configuring SMTP 
connections to MiContact Center Business".

4. To edit an SMTP mail server, select the mail server connection and click the Edit button.

5. Follow the steps in "Configuring SMTP connections to MiContact Center Business".

6. Click OK.

7. Click Save.

Configuring email send settings

By default, every time a contact reaches an Email activity in a workflow, an email is sent. Email activities 
can be configured to only send an email once per contact, so that if that contact reaches the same Email 
activity again, as a result of a requeue or transfer, the Email activity will not send a second email. New 
contacts from the same source will still trigger the Email activity to send an email.
To configure auto-response email settings 
1. Select the Email activity and click Properties.
2. Select the Only Send Once check box to avoid sending more than one email to the same contact with 

this activity.
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3. Click Save.

Configuring the Employee Control activity

The Employee Control activity enables workflows to interact with employee presence, either changing the 
presence and reason code of an employee or reading the current state and storing it in variables for use 
in the workflow. For example, a contact center could set up a workflow with the Employee Control activity 
that employees using mobile devices can call to change their presence when they do not have access to 
agent applications such as Ignite or Contact Center Client.
The Employee Control activity can perform two kinds of actions within a workflow: 
• Read—The Read action enables you to collect the employee state and reason code within the vari-

ables <<PresenceState>> and <<PresenceReason>>. Only one employee’s presence state and 
reason code can be stored in the variables at a time.

• Update—The Update action enables you to change the employee’s presence state and, if the state is 
Busy or Do Not Disturb, add a reason code.

NOTE: Updating an employee to Available will place the employee in Logged In, Not Present. Employees 
must log into their agent groups themselves
The Employee Control activity is available in: 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

The following procedures explain how to 
• Read an employee’s presence
• Update an employee’s presence

To read an employee’s presence 
1. Right-click the Employee Control activity and select Configure.
2. After Action, select Read.

3. After Employee, click ….

4. To select an employee, in the Employee tab, select the employee.

5. To select a variable, in the Variable tab, select the variable containing an employee’s ID.

6. Click OK.

7. Click Save.

To update an employee’s presence 
1. Right-click the Employee Control activity and select Configure.
2. After Action, select Update.

3. After Employee, click ….

4. To select an employee, in the Employee tab, select the employee.

5. To select a variable, in the Variable tab, select the variable containing an employee’s ID.

6. Click OK.

7. After State, select a state from the drop-down list.
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8. If you select Busy or Do Not Disturb, after Reason click ….

9. To select a reason code, in the Make Busy Reason or DND Reason, select a reason code and click 
OK.

10. To select a variable, in the Variable tab, select the variable containing a reason code and click OK.

11. Click OK.

12. Click Save.

Configuring the Execute activity

The Execute activity enables IVR Routing to interact with external systems by running one of the following 
four processes: 
• Executable/Script – Runs an *.EXE file or *.BAT script on the server and delivers return values or 

parameters if the script executes successfully. 
NOTE: The Execute activity requires *.EXE files and *BAT scripts to be on a UNC path.

• PowerShell – Runs a PowerShell script on the server and delivers return values or parameters if the 
script executes successfully. 

NOTE: 
– The Execute activity requires PowerShell scripts to be on a UNC path.
– The Execution Policy for PowerShell scripts must be set in the command prompt window of Power-

Shell to Set-ExecutionPolicy RemoteSigned.

• Web Service – Enables the Execute activity to retrieve a JSON or XML response from an external web 
service using SOAP or REST and delivers return values if the script executes successfully. 

NOTE: The data being returned must be valid XML characters. Any invalid characters (such as &, <, 
or >) will not return successfully and the workflow will route down the Failure branch. The XMLNode 
object type is not supported.

• CRM Service – Sends user-defined queries to a Microsoft CRM 2011, Microsoft CRM 2013, or Micro-
soft CRM Online system and delivers return values if the script executes successfully.

For example, you can use the Execute activity to retrieve customer information from a Web Service data-
base and store this information in a custom variable for use within the workflow or to pass on to agents in 
a screen pop for enhanced customer service. You could also use the Execute activity to run a PowerShell 
script enabling an authorized caller to run remote maintenance on the IVR Routing server. You can 
configure the options and the process types for Execute activities.
For an example of an IVR Routing workflow that uses the Execute activity to execute PowerShell and 
perform a web service SOAP call to a publicly accessible web service, see the following Mitel Knowledge 
Base article: https://mitel.custhelp.com/app/answers/answer_view/a_ id/1000724/loc/en_US.
The Execute activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

NOTE: In most instances, a success return value indicates the process executed without errors, and the 
Success branch is followed. A failure return value indicates the process exited with errors and did not 
complete as expected, and the Failure branch is followed. If a success return value contains errors, it is 
recommended to map the return value to a variable and then use a Variable Compare activity to confirm 
if the output is a Success.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000724/loc/en_US
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Configuring options for Execute activities

To configure the options for an Execute activity 
1. Select the Execute activity and click Properties.
2. To set waiting prompts to always play to completion before allowing the workflow to proceed, regard-

less of whether the process has completed executing, deselect the Barge Prompt check box. 

NOTE: The waiting prompt is what callers hear while they wait for the Execute activity process to 
complete. Barge Prompt signifies that the prompt will stop playing once the process has completed 
executing.

Barge must be driven through MiCCB and not through the native capability of the PBX.
3. To set the Execute activity to route to the Success branch without waiting for a process to complete, 

deselect the Wait for completion check box. 

NOTE: 
– We recommend you deselect 'Wait for completion' only if you do not require the Execute activity to 

retrieve information and return a result. For example, deselect Wait for completion if you are using 
the Execute activity to run maintenance.

– If the process fails to start, the activity will route to the Failure branch regardless of whether 'Wait for 
completion' is deselected.

4. After Waiting Prompt, click the  button and follow the steps under "Adding prompts to Play activi-
ties". 

NOTE: 
– Waiting prompts help keep callers engaged on the line during processes that take longer than usual 

to complete.
– If the Wait for completion check box is deselected, it is not necessary to configure a waiting prompt.

5. Optionally, select the Child Reporting Enabled check box.

6. After Timeout (sec), specify how long an associated process has to complete successfully before 
executing to the Failure branch.

7. Click Save.

Specifying the external processes to execute in workflows

The following procedures explain how to instruct the Execute activity to run 
• Executable/Script processes
• PowerShell processes
• Web Service processes
• CRM Service processes

To set an Executable/Script or PowerShell process 
1. Right-click the Execute activity and select New Process > Executable/Script or PowerShell script.
2. For Executable/Script processes, after Path, click the Browse button and navigate to the *.EXE or 

*BAT script. The script must be on a UNC path.

3. For Executable/Script processes, select the Separator required by the .exe file. The separator is the 
character separating the parameters in the process’ command line statement.
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4. For PowerShell processes, navigate to the PowerShell script.

5. To add a set of Input Parameters, click Add and select the Parameter the process uses to execute. 

NOTE: If batch files or Executable/Script processes require delimiters, they must be entered manu-
ally in the Parameter column.

6. Under Value, select a variable or type a static value. 

NOTE: 
– The variable is replaced when a contact progresses through the workflow.
– To configure the process to use a value not linked to a parameter, select a variable from the Value 

field and leave the Parameter field blank.

7. Repeat steps 5 and 6 for each set of input parameters the process uses. To delete a set of parame-
ters, click the arrow to the left of Parameter and click Remove.

8. Under Test Value, enter values to test the process and click Execute. 

NOTE: 
– For Executable/Script processes, the Results dialog box lists return values and output pipeline 

values.
– For PowerShell processes, the Results dialog box lists return values and PSObject[X] values.

9. Click OK to auto-populate the Output Mappings pane with Output values.

10. Leave the Process Setup window open and complete the steps under "Storing retrieved data as vari-
ables".

To set a SOAP Web Service process 
1. Right-click the Execute activity and select New Process > Web Service.
2. Type the Web Service URI.

3. After Http Action, select an action from the drop-down list.

4. After Web Service Type, select SOAP. 

CAUTION: If you are using the Execute activity with a web service as a part of a PCI compliant work-
flow, ensure that you 

– Use an HTTP Secure (https) address.
– If the return or input fields of the SOAP call contain sensitive information, use masked variables in 

the Input and Output parameters of the Execute activity.

Failure to do so could invalidate your PCI compliance.
5. If using a SOAP Web Service, click the Scan button to verify the Web Service.

6. Select a Web Method from the drop-down list. The Web Method populates the Parameters field. 

NOTE: SOAP Web Services populate the Web Methods field with a drop-down list of available func-
tions.

7. Under Value, select a variable or type a staticValue.

8. Under Test Value, enter values to test the process and click Execute.

9. On the results dialog box, click OK.

10. Click OK to auto-populate the Output Mappings pane with Output values.
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11. Leave the Process Setup window open and complete the steps under "Storing retrieved data as vari-
ables".

To set a REST Web Service process 
1. Right-click the Execute activity and select New Process > Web Service.
2. Type the Web Service URI and, for the Web Service Type, select REST. 

CAUTION: If you are using the Execute activity with a web service as a part of a PCI compliant work-
flow, ensure that you 

– Use an HTTP Secure (https) address.
– If the return or input fields of the SOAP call contain sensitive information, use masked variables in 

the Input and Output parameters of the Execute activity.

Failure to do so could invalidate your PCI compliance.
3. Type the Username and Password for the Web Service. Login credentials might not be necessary 

depending on the Web Service used.

4. To add a set of Headers, click Add and type the Parameter the process uses to execute.

5. Under Value, select a variable or type a static value.

6. Repeat steps 4 and 5 for each set of headers the REST Web Service process uses.

7. To add a set of Input Parameters, click Add and type the Parameter the process uses to execute.

8. Under Value, select a variable or type a static Value.

9. Repeat steps 7 and 8 for each set of input parameters the REST Web Service process uses. To delete 
a set of parameters, click the arrow to the left of Parameter and click Remove.

10. To test the headers and input parameters, enter values under Test Value in Headers and Input 
Parameters and click Execute.

11. In the XML Output pane of the Results dialog box, select the node containing the information the 
Execute activity retrieves.

12. After Selected Node, click the Show Results button.

13. Click OK to auto-populate the Output Mappings pane with Output values.

14. Leave the Process Setup window open and complete the steps under "Storing retrieved data as vari-
ables".

To configure a CRM Service process 
1. Right-click the Execute activity and select New Process > Microsoft CRM.
2. Type the CRM URI used to communicate with the CRM system.

3. Select the CRM Version.

4. Complete the following fields: 

– Domain – Type the domain name of the CRM site. 
NOTE: Domain name is only required for CRM 2011 or 2013.

– Operation – Select the operation the Execute activity is performing
– Username – Type the username for the CRM site login.
– Password – Type the password for the CRM site login.
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– Entity Name – Select the name of the CRM entity that the Execute activity queries.

5. To add a set of Input Parameters, click Add and select the Parameter the process uses to execute. 

The parameters depend on the Entity Name selected.
6. Under Value, select a variable or type a static Value.

7. Repeat steps 5 and 6 for each set of input parameters the CRM Service process uses. To delete a 
set of parameters, click the arrow to the left of Parameter and click Remove.

8. Under Test Value, enter values to test the process and click Execute. 

The results dialog shows mappings of the parameters to values.
9. Click OK.

10. Click Mapping to assign the output to variables, and click OK to store the data as variables.

11. Click Save.

Storing retrieved data as variables

The following procedure explains how to store data retrieved by the Execute activity as a variable. These 
variables can be used later in the workflow.
To store retrieved data as a variable 
1. In the Process Setup window, under Mapping, select a variable from the drop-down list to corre-

spond to each Output value.
2. Click OK. 

When a contact progresses through the workflow, each variable in the Mapping field is assigned the 
value indicated in the Output field.

3. Click Save.

Configuring the Go To activity

The Go To activity sends calls to its target activity and resumes workflow execution starting with that 
activity
For example, if a customer enters an invalid account number, the Go To activity sends them back through 
the workflow so they can enter their digits again. The Go To activity helps minimize the number of 
customers routed to the failure branch and helps callers route to the queues best able to help them.
You can configure destinations for Go To activities, determining the activities to which the Go To sends 
callers. Go To activities in subroutines can be pointed to destinations in parent workflows in conjunction 
with the Subroutine activity.
The Go To activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

Configuring destinations for Go To activities

To configure a destination for a Go To activity 
1. Right-click the Go To activity and select Target...
2. Select the activity to which the Go To returns callers and click OK.
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3. If you do not want to increase the repeat count of your workflow, for example if your workflow uses 
embedded menus or the Collect Digits activity, in the Properties pane, select the Reset Repeat 
Count  check box to give callers an unlimited number of attempts to enter information.

4. Click Save.

Configuring parent workflow destinations for subroutine Go To activities

If a Go To activity is placed in a subroutine, it can route contacts to the parent workflow to which the 
subroutine is assigned by setting its destination as ‘Go To Parent Workflow’. A target destination must be 
set on the Subroutine activity to set where the contacts are routed to in the Parent workflow.
To configure a parent workflow destination for a subroutine Go To activity 
1. In the parent workflow, select the Subroutine activity.
2. In the Properties, after Target Activity select the activity to which the subroutine Go To activity 

returns contacts from the drop-down list.

3. Click Save.

Configuring the Hang Up activity

The Hang Up activity instructs IVR Routing to end the workflow, preventing callers from waiting on a dead 
line and freeing up ports to take new calls. Hang Up activities are inserted at the end of a workflow or 
branch. For example, you can insert a Hang Up activity at the end of a 'Closed' branch in a Schedule 
activity to terminate the call after a customer hears that the contact center is closed.
The Hang Up activity is available in 
• Inbound, Outbound, and RAD workflows
• Inbound, Outbound, RAD, Management, UPiQ, and Callback Inbound subroutines

NOTE: We recommend you insert a Hang Up activity any place where the call could potentially end. This 
ensures the call is terminated correctly and the port is freed to accept a new call. Inbound, Outbound, and 
RAD workflows must end with a Hang Up activity if they do not end with a Transfer activity. UPiQ subrou-
tines should end with a Hang Up activity to free the UPiQ port.

Configuring the Hold State activity

The Hold State activity places an agent on hold. In calls between caller and agent, caller privacy can be 
ensured for private or sensitive activities, such as entering credit card information, without the agent moni-
toring them. The activity searches for the Agent ID and then places the corresponding extension on hold. 
While Hold State activity’s enforced Hold state is active, agents cannot remove themselves from hold. 
Hold is only removed when the call finishes routing through the Success branch of the Hold State activity. 
The Hold State activity requires no configuration.
Only agents configured in your contact center can be affected by the Hold State activity. Other callers in 
your workflows will not be affected.
For an example of how to use the Hold State activity in a workflow in support of PCI compliant systems, 
see "Workflow for PCI Compliant systems".
The Hold State activity is available in
• Inbound workflows
• Inbound subroutines
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Configuring the Hunt Group activity

The Hunt Group activity branches workflows based on the hunt group to which a call has been directed. 
For example, you can configure a Hunt Group activity to route a call towards 'Technical Assistance' tele-
phone lines and the queues that use these lines to provide technical support. The workflow will search 
the Technical Assistance hunt groups for the first available line and switch the call onto the line when one 
is found. The Hunt Group activity enables customers to be efficiently routed to the services they need. 
You can add branching conditions to Hunt Group activities to determine how IVR Routing directs callers 
through the workflow.
The Hunt Group activity is available in 
• Inbound, RAD, and Inqueue workflows
• Inbound, RAD, and Callback Inbound subroutines

Adding branching conditions to Hunt Group activities

Branching conditions represent the criteria by which IVR Routing directs calls.
The following procedures explain how to 
• Add a branching conditions to a Hunt Group activity
• Import branching conditions from a .csv file
• Export branching conditions into a .csv file

To add a branching condition to a Hunt Group activity 
1. Right-click the Hunt Group activity and select Add condition. 

The Hunt Group dialog box opens.
2. To add a hunt group value, click Add and type a value or range of values for the hunt group condition.

3. Click the Add icon. 

– To branch all calls from a specified area code, city exchange, or other number identification, include 
an 'x' at the end of the numeric value. 'x' indicates multiple wildcard characters.

– To indicate individual digits or to set branching conditions to match any Hunt Group, include question 
marks instead of numeric values.

4. To import hunt group conditions in .csv format, click Import, navigate to the file name, and click Open.

5. To export the hunt group conditions in .csv format, click Export, select a file location and file name 
and click Save. 

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

6. To add more hunt group conditions, at the top of the Hunt Group dialog box, click Add.

7. If you want all Hunt Group conditions in the same branch, clear the Add each row in a separate 
branch check box. 

By default, separate branches are added for each condition.
8. To enable reporting for the branch, select the Enable reporting for this Branch check box.

9. To test the hunt group conditions, under Utilities, enter a value or range of values. 
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If the test is successful, 'Pass' displays.
If the test is unsuccessful, 'Fail' displays.

NOTE: You cannot test a range of values.
10. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.

11. Click Save.

To import branching conditions from a .csv file 
1. Right-click the Hunt Group activity and select Import Conditions.
2. Navigate to the .csv file and click Open.

3. Click Save.

To export branching conditions into a .csv file 
1. Right-click the Hunt Group activity and select Export Conditions.
2. Navigate to the .csv file and click Save.

Configuring the Language Activity

The Language activity changes IVR Routing’s system language, enabling the IVR to provide an identical 
workflow in different languages. When the Language activity is reached in the workflow, all subsequent 
prompts play in the set language. For example, you can insert a Language activity into a menu to allow 
customers to choose the language in which they receive service. By supporting multiple languages in a 
single workflow, the Language activity reduces the number of prompts you must create and the number 
of duplicate activities in your workflow. The Language activity also reduces the number of ports that IVR 
Routing uses by allowing the same set of ports to be used for multiple languages. You can set and edit 
the languages for Language activities.
The Language activity is available in 
• Inbound, Outbound, RAD, and Inqueue workflows
• Inbound, Outbound, RAD, Management, UPiQ, and Callback Inbound subroutines

NOTE: The language value is stored within the <<Language>> system variable. Each subsequent 
Language action overwrites the value in the system variable.

Setting and editing languages for Language activities

The following procedures explain how to: 
• Set the language for a Language activity
• Edit the language for a Language Activity

To set the language for a Language activity 
1. Right-click the Language activity and select Select Language.
2. Select one of the following languages for the workflow 

– Chinese Simplified (zh-CN)
– Dutch Netherlands (nl-NL)
– English United Kingdom (en-GB)
– English United States (en-US)
– French Canada (fr-CA)
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– French France (fr-FR)
– German (de-DE)
– Italian (it-IT)
– Norwegian Norway (nb-No)
– Portuguese Brazil (pt-BR)
– Russian (ru-RU)
– Spanish Latin America (es-CL)
– Spanish Spain (es-ES)
– Swedish Sweden (sv-SE)
– Welsh (cy-GB)

3. Click Save.

To edit the language 
1. Right-click the Language activity and select Select Language.
2. Select a different language for the workflow.

3. Click Save.

Configuring the Make Call activity

The Make Call activity prompts an associated port to process an outbound call to a specified destination. 
This destination can be retrieved from a data source including a SQL database, an Excel file, a Web 
Service call, or custom variable. For example, you can use the Make Call activity as part of an outbound 
workflow designed to contact customers during an advertising campaign. You can assign the Make Call 
activity a destination, set the amount of time the port has to make the call before IVR Routing terminates 
the action, and add new devices to Make Call activity destinations.
The next step depends on the result when the Make Call activity calls the destination: 
• If the call to the destination times out, the call routes through the No Answer branch
• If the destination is busy, the call routes through the Destination Busy branch
• If the destination does not match an existing phone number, the call routes through the Invalid Desti-

nation branch
• If the Make Call activity encounters a failure and does not make the call, the call routes through the 

Failure branch
• If the destination answers, the call routes through the Success branch

The Make Call activity is available in 
• Outbound workflows
• Outbound subroutines

Configuring options for Make Call activities

The following procedures explain how to: 
• Set a destination for a Make Call activity
• Set a dialable number or SIP address as the destination
• Set the caller name and caller number of the Make Call activity
• Configure the Make Call activity for internal calls
• Set how long a Make Call activity will ring a destination
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To set a destination for a Make Call activity 
1. Select the Make Call activity.
2. In the Properties pane, after Destination click the … button.

3. Select one of the following from the drop-down list: 

– Extension
– Queue
– Queue group
– Variable

4. Click OK.

5. If the call to the destination will use the outbound digits defined on the media server, ensure External 
Call is selected.

6. Click Save.

To set a dialable number or SIP address as the destination 
1. Select the Make Call activity.
2. In the Properties pane, after Destination, type the dialable number or SIP address. 

A dialable number cannot include punctuation marks.
3. Click Save.

To set a caller name and caller number of the Make Call activity 
1. Select the Make Call activity.
2. In the Properties pane, after Caller Name, enter the name that will display as the call's name.

3. After Caller Number, enter the number that will display as the activity's ANI.

4. Click Save.

To configure the Make Call activity for internal calls 
1. Select the Make Call activity.
2. Clear the External Call check box.

3. Click Save.

To set how long a Make Call activity will ring a destination 
1. Select the Make Call activity.
2. After Timeout Duration, set the number of seconds the Make Call will ring a destination.

3. Click Save.

Adding new devices to Make Call destinations

To specify a new device as a destination 
1. Select the Make Call activity.
2. In the Properties pane, after Destination click the … button.

3. Select one of the following from the drop-down list: 

– Extension
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– Queue
– Queue group
– Variable

4. At the top of the dialog box, click Add.

5. To add a new extension, see "Configuring extension port options for IVR Routing".

6. To add a new queue, in the Queue pane, follow the steps under "Adding queues". 

NOTE: 
– To configure a new queue for web callbacks, see "Enabling web callbacks".
– To configure a new queue for abandon callbacks, see "Enabling abandon callbacks".
– To associate a queue to an UPiQ workflow, see "Configuring Inqueue routing". For information on 

setting up UPiQ workflows, see "Default Inqueue UPiQ workflow and subroutines".

7. To add a new queue group, follow the applicable steps in "Adding queue groups".

8. To add a new variable, follow the applicable steps in "Adding variables".

9. Click Save.

10. If the call to the destination will use the outbound digits defined on the media server, ensure External 
Call is selected.

11. Click Save.

Configuring the Management activity

The Management activity represents a management plan that is available to authorized callers, enabling 
them to manage the state of IVR Routing and its prompts over the phone. For example, if the contact 
center is unexpectedly closed due to severe weather, a manager working from home can use the 
Management activity to set the IVR to Emergency mode and record a prompt informing callers of the 
center’s closure. You assign subroutines to Management activities and if you are using the Default 
Management Subroutine, configure remote access options for authorized callers.
The Management activity is available in 
• Inbound workflows
• Inbound, Management, and Callback Inbound subroutines

Assigning subroutines to Management activities

IVR Routing provides a default Management subroutine. For information on building subroutines to assign 
to Management activities, see "Building subroutines".
To assign a subroutine to a Management activity 
1. Select the Management activity.
2. In the Properties pane, after Management Subroutine, click the ... button.

3. Click either the Subroutines or Variables tab and select a subroutine or a variable to assign to the 
activity.

4. If you want to assign a new variable, under the Variables tab, click Add and follow the corresponding 
steps in "Configuring variables".
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5. Click OK.

6. Click Save.

To view the assigned subroutine or variable 
• Right-click the Management activity and click Open. 

The assigned subroutine or variable opens.

Configuring properties for remote access to the Default Management Subroutine

To configure properties for remote access to the Default Management Subroutine 
1. Click IVR Routing > Subroutines.
2. Select the Default Management Subroutine.

3. Select the 'Enter Management Password' Menu activity.

4. To enable callers to skip instructions using a digit entry, select the Barge In check box.

5. After In Between Digit Delay, set time taken to reset each digit after it is pressed. 

NOTE: Between 1 to 5 seconds is recommended.
6. After Invalid Attempts, set the number of times a caller can enter incorrect digits before being routed 

down the Failure branch.

7. After No digit timeout (sec), set the amount of time that IVR Routing will wait for a caller to enter 
digits before routing the call to the Timeout branch. 

NOTE: If this time elapses, IVR Routing will send the caller back through the workflow.
8. After Timeout Attempts, set the number of times the No digit timeout (sec) can expire before routing 

the call through the Failure branch.

9. After Instructions, click the ▼ button and follow the steps under "Configuring an activity prompts". 

NOTE: Instructions play prompts and menu options to an authorized caller.
10. To enable reporting, select the Child Reporting Enabled check box.

11. Right-click the Menu condition branch '1234' and click Edit Condition.

12. Click the condition '1234' and enter the new management password.

13. Click the Add button.

14. Click OK.

15. Click Save.

Configuring the Menu activity

The Menu activity prompts callers with messages and manages routing based on caller input. For 
example, you can configure the Menu activity to ask customers to press '1' on their dial pad to reach Tech-
nical Support and '2' if they want to reach Sales. IVR Routing then directs callers to the appropriate queue 
based on the number they pressed. The Menu activity enables efficient routing to the appropriate queue. 
You can configure the prompts callers hear, input options, and digit options for Menu activities. If you are 
enabled for Automatic Speech Recognition, you can also configure the Menu activity to accept speech 
input.
The Menu activity is available in 
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• Inbound and Outbound workflows
• Inbound, Outbound, Management, UPiQ, and Callback Inbound subroutines

NOTE: Due to the inability to use Set Variable for specifying a masked variables value, the Menu activity 
cannot be used with a wildcard branch and a Set Variable activity with masked variables as the masked 
variables will be exposed in the Last Menu Collected Digits variable in the query string.

Configuring options for Menu activities

NOTE: If validation is enabled, the Menu activity cannot be saved until it has instructions and branches 
configured.
The following procedures explain how to:
• Configure options for the Menu activity
• Configure instructions for the Menu activity
• Configure reporting for the Menu activity

To configure options for the Menu activity
1. Select the Menu activity.
2. To enable callers to skip instructions using a digit entry, select the Barge In check box.

3. After In Between Digit Delay, set the time taken to reset each digit after it is pressed

NOTE: Between 1 to 5 seconds is recommended.
4. After Invalid Attempts, set the number of times callers can try to enter information.

NOTE: If this number is exceeded, IVR Routing sends the call to the Failure branch.
5. After No digit timeout (sec), set the time to wait if the user does not enter any digits.

NOTE: If this time elapses, IVR Routing will send the call to the Timeout branch
6. After Timeout Attempts, set the number of times users can timeout before being routed down the 

Failure branch.

To configure instructions for the Menu activity
1. Select the Menu activity.
2. After Instructions, click the  button and follow the steps under "Configuring an activity"s prompts".

NOTE: Instructions play prompts and menu options to callers.
3. Click Save.

To configure reporting for the Menu activity
1. Select the Menu activity.
2. To enable reporting for this branch, select the Child Reporting Enabled check box.

3. Click Save.

Configuring Menu activity branches

Menu branches are the numbers callers select to navigate the IVR Routing menu.
To configure digit options
1. Right-click the Menu activity and select Add branch.

The Menu dialog box opens.
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2. To add a digit option, at the top of the dialog box, click Add and type a value or range of values.

NOTE: 
– Adding question marks to a digit option enables callers to enter customer-specific information, of a 

set length, into IVR Routing. For example, you may have a menu asking callers who are members 
to enter their 10-digit membership number. Adding a digit option of '??????????' will route all callers 
entering a 10-digit number to the appropriate queue.

– Adding the letter 'x' to a digit option enables callers to enter customer-specific information of an 
unspecified length. For example, you may have a menu asking callers to enter their telephone 
number, including extensions. Adding a digit option of '613x' will route all callers phoning from a 613 
area code to the appropriate queue.

3. Click the Add icon.

4. To import branch conditions in .csv format, click Import, navigate to the file name, and click Open.

5. To export the branch conditions in .csv format, click Export, select a file location and file name and 
click Save.

NOTE: 
– Digit options on a single line and separated by a comma will be added to a single branch.
– Digit options on multiple lines and separated by a comma will be added to multiple branches.

6. To add more digit options, at the top of the Menu dialog box, click Add.

7. If you want all digit option conditions in the same branch, clear the Add each row in a separate 
branch check box.

By default, separate branches are added for each condition.
8. To enable reporting, select the Enable reporting for this Branch check box.

9. To test the digit options, under Utilities, enter a value or range of values.

If the test is successful, 'Pass' displays.
If the test is unsuccessful, 'Fail' displays.

10. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

11. Click Save.

Configuring speech recognition for Menu activities

If you have an Automatic Speech Recognition server configured, you enable callers to speak the Menu 
activity’s branch numbers rather than pressing numbers on their dialpad. When speech recognition is 
enabled, the callers will not be routed down the appropriate Menu branch until the system recognizes their 
speech or the callers enter the branch’s digits. The Confidence Threshold determines the threshold for 
accepting the speech and routing down the appropriate branch of the Menu activity. For more information 
on Confidence Thresholds, see "Configuring Automatic Speech Recognition".
To configure speech recognition 
1. Select a Menu activity and click Properties.
2. After Confidence Threshold, set the confidence threshold for the speech recognition.

3. Select Recognition Enabled.
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4. After Recognition Language, select the language for the Menu activity from the drop-down list.

5. Click Save.

Configuring the Mode of Operation activity

The Mode of Operation activity branches workflows to a secondary type of operation when the contact 
center is temporarily out of service. It can also change IVR Routing back to the Normal mode. For 
example, you can use the Mode of Operation activity to route calls to an Emergency branch if the contact 
center is closed due to severe weather. You can add activities to the Mode of Operation activity’s 
branches to determine how IVR Routing directs callers through the workflow in the event of an Emergency 
or in the case of Normal operations.
The Mode of Operation activity is available in
• Inbound workflows
• Inbound and Management subroutines

NOTE: For more information on setting IVR Routing to Emergency mode, see "Configuring Set Device 
Mode of Operation activity" and "Configuring the Set System Mode of Operation activity".

Configuring Mode of Operation activities for Emergency and Normal modes

Configure the Mode of Operation activity by specifying the actions a workflow will take in Emergency and 
Normal modes.
To configure a Mode of Operation activity for Emergency and Normal modes
1. In the Workflow Canvas, expand the Mode of Operation activity.
2. From the Toolbox pane, drag activities to the Emergency or Normal branch.

3. To enable reporting on the activity's branches, select the Child Reporting Enabled check box.

4. To enable reporting on a single branch, select the branch and select the Reportable check box.

5. Click Save.

Configuring the Play activity

The Play activity enables IVR Routing to play messages or read back the contents of variables to callers. 
The Play activity can play a prompt or a single wave file to customers. For example, you can use a Play 
activity to greet callers and ask them to hold for the next available agent. You can add a new prompt to a 
Play activity, add a prompt that you have previously recorded, or add a variable to a prompt. For more 
information on configuring prompts in workflows, see "Configuring Prompts".
The Play activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

NOTE: The duration of a prompt is stored within the <<LastWavePlayedDuration>> system variable. This 
value will be overwritten any time a wave file is played in the workflow.

Adding prompts to Play activities

Prompts are the messages played at specified points in the workflow. Prompts can be configured to be 
played to the caller only, to the agent only, or to both.
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If your system is licensed for Text-to-Speech, you can add a prompt as a text string. The system reads 
the text as voice output when the prompt is played.
To enable callers to skip prompts using a digit entry 
1. Select the Play activity and click Properties.
2. Select the Barge Enable check box.

3. Click Save.

To specify who you want to hear the prompt 
1. Select the Play activity and click Properties.
2. After Broadcast To, click the  button and select one of the following: 

– Both: the prompt plays to both the caller and the agent
– Caller: The prompt plays to both the caller and the agent
– Agent: the prompt plays to the agent only

3. Click Save.

To add an existing prompt to a Play activity 
1. Select the Play activity and click Properties.
2. After Greeting Prompts, click the  button and select Select from an existing prompt.

3. Select a prompt and click OK.

4. Click Save.

To add a new prompt 
1. Select the Play activity and click Properties.
2. After Greeting Prompts, click the  button and select Add a new prompt.

3. After Language, select the primary language from the drop-down list. 

NOTE: 
– The language you select determines the system wave files available to you.
– By default, the language is set to the default site language.

4. Type a Name for the prompt.

5. Type a Description for the prompt.

6. Select a Category for the prompt from the drop-down list: 

– Callback
– Custom
– Management
– Samples
– UPiQ

7. To create your own category, after Category, type a name for the new category. 

NOTE: Prompt categories are an organizational tool to help keep prompts sorted and easily acces-
sible.

8. Select one of the following tabs: 
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– Text—lists the SSML files added to IVR Routing. Users can add an SSML file or add text to the 
prompt. To add an SSML file, click Add and select SSML file. To add a text, click Add, select Text, 
enter the text, and click OK. To add text to the SSML library for reuse, click Export. 

NOTE: If adding variables to text, enclose them within double angle brackets. For example, the 
EstimatedWaitTime variable is formatted as <<EstimatedWaitTime>>. By default, variables 
are read as Numbers or, if they are currency, Dollars. You can specify how variables are read 
in SSML files. For more information, see the MiContact Center Knowledge Base.

– System wave files–lists the system wave files callers hear while in the IVR or while waiting on hold. 
This pane will only show the wave files that are available in the language you have selected.

– Custom wave files–lists imported and recorded wave files. To import or record a custom wave file, 
click 'Add' and select 'Existing wave file' to import the file or 'Record wave file' to use the microphone 
on your computer to record the file. 

NOTE: IVR Routing does not support 44.1 khz format for prompts. IVR Routing has been tested 
with 8khz, Mono, and ULAW formats.

– Queue stats–lists up-to-date queue statistics for use in prompts
– Variables–lists all variables available for use in prompts 

NOTE: Read back on variables is based on the type of variable. Number variables read back 
the whole number, while digit variables read back individual numbers. For example, number 
variables would read 123 as 'one hundred and twenty-three', while digit variables would read 
123 as 'one, two, three'.

– Prompts used in workflows and subroutines–lists all prompts used in workflows and subroutines

9. In the All SSML Files, All system wave files, All custom wave files, All queue stats, All variables, 
or Prompts used in workflows and subroutines pane, select the files to add to the prompt.

10. Click > to add the file to the prompt. 

NOTE: The wave or SSML files play in the order they are added to the prompt. To change the order 
in which the files will be played, select the file and click the up or down arrow buttons on the 
right-hand side of the dialog box.

11. Click Save. 

NOTE: If you are adding prompts in a new language, you must add audio files that correspond to the 
existing audio files in IVR Routing’s default language. Otherwise, the caller will not hear anything 
when the prompts are supposed to be playing.

To add a variable to a prompt 
1. Select the Play activity and click Properties.
2. After Greeting Prompts, click the  button and select Add a variable to a prompt.

3. Select the variable and click OK.

4. Click Save.

To add a new variable to a prompt 
1. Select the Play activity and click Properties.
2. After Greeting Prompts, click the  button and select Add a variable to a prompt.

3. Click the Add button.

4. Type a Name for the variable. The name must be unique and cannot contain spaces.
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5. Type a Description for the variable.

6. After Variable Type, select a type from the drop-down list. 

NOTE: A variable's type cannot be changed after you save.
7. If Mask Type is available to this type of variable, select the variable’s mask from the drop-down list. 

– NoMask– The variable will not be masked within IVR Routing and associated screen pops, data-
bases, etc.

– FullMask– The entire variable will be masked within IVR Routing and associated screen pops, data-
bases, etc.

– MaskAllExceptLastX– The variable will be masked except for the specified number of final charac-
ters

– MaskAllExceptFirstX– The variable will be masked except for the specified number of first charac-
ters

8. If you selected MaskAllExceptLastX or MaskAllExceptFirstX, specify the number of characters to 
be left unmasked.

9. To enable this variable to display in a toaster notification or screen pop, select the Send to agent 
desktop check box.

10. Type the Display Name that this variable has when it appears in a toaster notification or screen pop.

11. If you selected Dollars, Euros, or Pounds as the variable type, after Currency Format, select the 
format from the drop-down list.

12. If you selected Date Time as the variable type, after Date Format, select the date format from the 
drop-down list. After Time Format, select the time format from the drop-down list.

13. Click Save.

To add a Text-to-Speech prompt 
1. Select the Play activity and click Properties.
2. After Greeting Prompts, click the  button and select Add text. 

NOTE: The 'Add Text' option is only available if your system is licensed for Text-to-Speech.
3. In the Add Text window, type a message for the prompt and click OK.

4. Click Save.

To clear a prompt 
1. Select the Play activity and click Properties.
2. After Greeting Prompts, click the  button and select Clear Prompt.

3. Click Save.

To add a prompt to a Play activity using Quick Add Prompt 
1. Select the Play activity and click Properties.
2. After Greeting Prompts, click the  button and select Quick Add Prompt.

3. Navigate to the .wav file and click Open.

4. Click Save.
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Configuring the Query activity

The Query activity reads and writes information through a data provider, such as an MS SQL connection, 
ODBC connection, Excel sheet, or LDAP provider. Administrators can use the Query activity to retrieve 
information and store it in custom variables for use within workflows. Advanced queries return multiple 
records of information that can be stored in multiple variables.
For example, you can use the Query activity to retrieve customer account balances for the past year. 
Callers can then have their account history read back to them from within the workflow. You can configure 
the data providers for Query activities, configure simple or advanced queries, and define simple or 
advanced write statements for Query activities.
The Query activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

CAUTION: IVR Routing can mask variables to protect information used in queries but customers are 
responsible for implementing appropriate network security to encrypt information passing between IVR 
Routing and data providers.
NOTE: 
• By default, the query result is stored within the <<LastQueryResult>> system variable. Each subse-

quent Query action overwrites this variable. It is not recommended to use the <<LastQueryResult>> 
variable when expecting protected information to be contained within this variable.

• For more information on configuring data providers, see "Configuring data providers".

Connecting Query activities to data providers

Connecting Query activities to data providers enables the Query activity to access data and use this infor-
mation to route interactions. For more information on creating data providers, see "Configuring data 
providers".
To assign a data provider to a Query activity 
1. Select the Query activity.
2. In the Properties pane, after Data Provider, click the ... button. 

The Selection Connection window opens.
3. Select a data provider for the query and click OK. 

NOTE: The Query activity cannot be saved without a query or write statement configured.

Running simple queries in workflows

Running simple queries enables administrators to retrieve information from a database and store it in a 
variable.
To run a simple query in a workflow 
1. Select the Query activity and click Properties.
2. After Query statement, click the Browse button and, under Query Type, select Simple Query.

3. After Database Table Name, from the drop-down list, select the table to query. 

'Database table names' refer to the tables in the data source from which the Query activity retrieves 
information.
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4. After Column Return Name, from the drop-down list, select the column of data to query. 

'Column return names' refer to the columns in the selected table, from which the Query activity re-
trieves information.

5. After Variable Return Name, from the drop-down list, select the variable to populate with the return 
value. 

'Variable return names' refer to the variables populated as a result of the query.
6. After Column Where Name, from the drop-down list, select the name of the column of data to 

compare against. 

'Column where names' refer to the columns in the data source against which the Query activity com-
pares information.

7. After Variable Where Name, from the drop-down list, select the variable to use for comparison. 

'Variable where names' refer to the variables against which the Query activity compares.
8. To enable the activity to convert digits into text values, select the Dialpad Compare check box. 

For example, if a caller is trying to reach an employee’s telephone extension, dialpad compare en-
ables the caller to enter the letters of the employee’s name into their dialpad instead of entering an 
extension number.

9. To test the query, after Test with a value equal to, enter an existing value from the data provider and 
click Test Query. 

The Raw SQL window displays the SQL statement based on the selections from the drop-down lists.
10. To clear all fields and return to the Canvas, click Clear. To accept the query, click OK.

11. Click Save.

Configuring Query activities with advanced queries

Advanced queries enable administrators with knowledge of SQL to write SQL statements retrieving infor-
mation from a database provider. Advanced queries also support LDAP syntax for LDAP providers, and 
advanced queries for MS SQL Server and ODBC data providers support stored procedures.
To run an advanced query in a workflow 
1. Select the Query activity and click Properties.
2. After Query statement, click the Browse button, and under Query Type, select Advanced Query.

3. Under Query, type the SQL statements to be run directly against the data provider and click Execute. 

The Execute window opens displaying a list of detected input and output parameters.
4. Under Value, type the numbers corresponding to the values contained in the data provider.

5. To enable the activity to convert digits into text values, select the Use Dialpad Compare check box.

6. Click Run.

7. To assign variables to store information returned by the SQL statements, click the Variable Assign-
ment tab. 

Return Column will be populated with the column names in the data provider.
8. Under Variable Name, select the variables to store information returned by the SQL statements.
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9. To assign values to the parameters filled by the SQL statements, click the Parameter Assignment 
tab. 

Parameter Name will be populated with the SQL parameters used to query the data provider.
10. After Variable Name, select a variable from the drop-down list to store the information retrieved by 

the SQL parameter.

11. To translate parameters from a dial-pad digit, select the Dialpad check box.

12. To view the values returned from the query, click the Test Results tab.

13. To clear the variables and their parameters, click Clear. To accept the query, click OK.

14. Click Save.

Defining write statements

Write statements define a delete, insert, or update statement against a specified data provider. Write 
statements enable administrators to delete, insert, or update column values in a data provider from within 
a workflow.
The following procedures explain how to configure simple and advanced write statements
NOTE: Advanced write statements enable users with knowledge of SQL to write insert, update, or delete 
SQL statements.
To define a simple write statement 
1. Select the Query activity, click Properties and, after Write statement, click the Browse button.
2. Select Simple Write and select a Write Type from the drop-down list. Options vary by data provider.

3. After Table Name, select the table in the data provider against which the write statement is defined.

4. Under Column Name, select a column in the data provider against which the write statement is 
defined.

5. Under Value, select the data to be inserted into the data provider.

6. Under Where, select a column name. 

NOTE: 
– ‘Where’ statements display only if Delete or Update is selected
– The column names displaying in the list derive from the Table Name selected.

7. Select an operator from the drop-down list 

– =
– <>
– >
– <
– >=
– <=

8. From the third drop-down list, select or type the variables used to evaluate the information selected 
from the first column

9. To test the write statement, click Test Syntax.
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10. To empty column values, click Clear. To accept the write statement, click OK.

11. Click Save.

To define an advanced write statement 
1. Select the Query activity, click Properties.
2. After Write statement, click the Browse button and select the Advanced Write button.

3. Under Query, type the insert, update, or delete SQL statements to be run against the data provider 
and click Execute.

4. The Parameter name column will be populated with the column names in the data provider.

5. Under Variable Name, from the drop-down list, select the variables used to evaluate the information 
you selected from the first column.

6. To test the write statement, click Test Syntax.

7. To empty column values, click Clear. To accept the write statement, click OK.

8. Click Save.

Returning multiple results with queries

The Query activity supports returning multiple results from a query. When a Query activity returns multiple 
results from a query, the call is looped through the Success branch for each result unless it is interrupted 
by a caller-activated activity, such as Go To or Transfer. When there are no more results for the Success 
branch to loop, the call exits the Success branch of the Query activity and continues along the workflow.
Multiple result returning Query activities enable contact centers to build more complex workflow functions, 
such as providing callers access to an employee directory.
For more information on returning multiple results with queries, see the following Mitel Knowledge Base 
article: https://mitel.custhelp.com/app/answers/answer_view/a_id/1000706/loc/en_US..

Configuring the Queue activity

The Queue activity branches workflows based on real-time queue conditions, enabling you to route calls 
based on emerging queue conditions.The Queue activity supports Ring Group queue conditions.
For example, you can configure a Queue activity to check queue conditions and offer a Callback Request 
activity to callers experiencing long wait times. The Queue activity can help to lessen abandoned calls 
and manage Service Level objectives by routing calls based on emerging queue conditions.
You can add and edit branching conditions for queue activities and group queue conditions to determine 
how IVR Routing directs callers through the workflow. Queue group real-time condition definitions vary 
depending on the type of queue group. For more information, see "Real-time queue conditions and queue 
groups".
The Queue activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, UPiQ, Callback Inbound, and Agent subroutines

Applying queue conditions to the Queue activity

The following explains how to 

http://micc.mitel.com/kb/knowledgebasearticle51935.aspx
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• Associate queue conditions to a queue, queue group, or variable
• Associate queue conditions to a variable
• Edit and delete queue conditions
• Import and export queue conditions
• Group queue conditions

NOTE: 
• The actions that IVR Routing takes when queue conditions are met are determined by activities you 

insert into the Drop Activities Here section of the Workflows Canvas for that Queue condition.
• The workflow evaluates Queue conditions from left to right. For information on how to change the order 

of Queue conditions, see "Changing the order in which branches are evaluated".

To associate queue conditions to a queue or queue group 
1. Right-click the Queue activity and select Add.
2. Type a Name for the queue condition and, after Queue, click the ... button.

3. Select either Queue or Queue Group, select the queue or queue group; and click OK. 

NOTE: For information on how queue groups use queue real-time statistics, see "Real-time queue 
conditions and queue groups".

4. Click Add and, from the second column, select a real-time statistic from the drop-down list. 

NOTE: Expected Wait Time requires at least one call waiting in queue for IVR Routing to calculate 
an Expected Wait Time value.

5. In the third column, select an operator from the drop-down list. Options vary according to the variable 
chosen.

6. Click the fourth column and select either Value, Queue Stats, or Variable.

7. For Value, type in a numeric value or enable the check box for the value.

8. For Queue Stats, select a queue stat from the drop-down list.

9. For Variable, select a variable from the drop-down list.

10. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test.

11. Click OK.

12. To add another condition, click Add and repeat steps 4-11.

13. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

14. Click Save.

To associate queue conditions to a variable
NOTE: Associating queue conditions to a variable requires first inserting and configuring an activity on the 
Canvas capable of populating the Queue activity’s destination variable.
1. Right-click the Queue activity and select Add.
2. Type a Name for the queue condition and, after Queue, click the ...button.

3. Select the Variable tab, select a variable, and click OK. 

Only Numbers, Digits, Queue, and Unspecified variable types are available.
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4. Click Add and, from the second column, select a real-time statistic from the drop-down list.

5. In the third column, select an operator from the drop-down list. Options vary according to the variable 
chosen.

6. Click the fourth column and select either Value, Queue Stats, or Variable.

7. For Value, type in a numeric value or enable the check box for the value.

8. For Queue Stats, select a queue stat from the drop-down list.

9. For Variable, select a variable from the drop-down list.

10. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test.

11. Click OK.

12. To add another condition, click Add and repeat steps 4-11.

13. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

14. Click Save.

To edit and delete queue conditions 
1. To edit queue conditions, right-click the relevant branch in the Queue activity and select Edit Condi-

tion.
2. To delete a queue condition, select the row for the condition and click Delete.

To import and export queue conditions 
1. To import queue conditions, click the Import button and navigate to a *.xaml file, and click Open. 

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

2. To export queue conditions, click the Export button, navigate to a *.xaml file, and click Save.

3. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test.

To group conditions being compared 
• See "Grouping expressions".

Real-time queue conditions and queue groups

IVR Routing supports both queue conditions and queue group conditions. Queue group queue conditions 
are defined differently than queue conditions. Between reporting queue groups and virtual queue groups, 
however, there are some differences between how the queue conditions stats are calculated.The 
following table outlines how queue condition statistics are applied to reportingand virtual queue groups.
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Table 9.4: Queue Groups Queue Condition statistics definitions  (Sheet 1 of 2)

Queue condition statistic
Reporting Queue 
Group definition Virtual Queue Group definition

Agents Available The sum of the available 
agents in all member 
queues

The number of available agents 
found in the first Online queue

Agents Idle The sum of the idle 
agents in all member 
queues

The number of idle agents found in 
the first Online queue

Agents Unavailable The sum of the 
unavailable agents in all 
member queues

The number of unavailable agents 
found in the first Online queue

Average Time to Abandon The sum of the duration of the abandons divided by the sum of 
the abandons from all queues in the group

Average Time to Answer The sum of the answer duration of the calls divided by the sum 
of the calls answered from all queues in the group

Call Load The sum of Calls 
Waiting in all queues in 
the group divided by the 
sum of Agents Available 
in all queues in the 
group

The sum of the Calls Waiting in all 
queues in the group divided by the 
number of Agents Available in the 
first Online queue

Expected Wait Time If there are agents 
available, the expected 
wait time is the average 
talk time for the queues 
in the group multiplied 
by Calls Waiting in all 
Queues in the group, 
divided by all Available 
Agents in the group
If there are no agents 
available, the Expected 
Wait Time is the sum of 
the answer duration of 
the calls divided by the 
sum of the calls 
answered from all 
queues in the group

If there are agents available, the 
expected wait time is the average 
talk time for the queues in the group 
multiplied by Calls Waiting in all 
queues in the group, divided by the 
Available Agents in the first Online 
queue in the group
If there are no agents available, the 
Expected Wait Time is the sum of 
the answer duration of the calls 
divided by the sum of the calls 
answered from all queues in the 
group

Last Queue Update Received The last queue update received from any queue in the queue 
group
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Configuring the Queue Control activity

The Queue Control activity changes the queue’s state from Do Not Disturb or vice-versa. When a queue 
is put into Do Not Disturb with the Queue Control activity, its state will not change due to business hours. 
For example, if only one of the IVR Routing’s queues is experiencing issues, you can use the Queue 
Control activity to put that queue into Do Not Disturb.
A queue’s state can also be changed in Contact Center Client. For more information, see "Manually 
controlling queues".
The Queue Control activity is available in 
• Management Subroutines
To configure the Queue Control activity 
1. Select the Queue Control activity.
2. In the Properties pane, after Input variable, click the … button. 

The Input variable is the variable containing the queue’s dialable number.
3. Select an input variable and click OK.

4. If you want the queue to be put into Do Not Disturb, select QueueDNDState.

5. If you want the queue to be removed from Do Not Disturb, clear QueueDNDState.

6. Click Save.

Configuring the Record activity

The Record activity enables authorized callers to record a wave file over the phone as opposed to using 
a microphone in a computer. For example, a manager can call into IVR Routing from home and use the 
Record activity to record a wave file to populate a custom prompt for Play activities. The Default Manage-
ment Subroutine that ships with IVR Routing includes a Record activity for this purpose. You can use the 
Default Management Subroutine to record prompts for Play activities in your workflow. The Record 
activity is also used by callers to record a message to accompany their callback request in the Default 
Inbound Voice Callback subroutine. The Record activity increases the flexibility with which you can create 
custom prompts for your workflow and respond to after-hours conditions affecting the call center’s oper-
ations.
You can configure Record activities with prompts to determine the message authorized callers hear when 
they dial the IVR Routing system, and configure recording options for authorized users phoning into the 

Longest Wait Time The longest time that a call has been waiting in all of the 
queues in the queue group

Number of Calls Waiting The sum of the number of calls waiting in each member queue 
of the queue group

Path DND Checks if any member of the group is in Do Not Disturb

Service Level The service level of the queue group

Table 9.4: Queue Groups Queue Condition statistics definitions (Continued) (Sheet 2 of 2)

Queue condition statistic
Reporting Queue 
Group definition Virtual Queue Group definition
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system. You can also set the options by which an authorized caller reviews, accepts, or rejects a message 
they recorded.
The Record activity is available in
• Inbound workflows
• Inbound, Management, UPiQ, and Callback Inbound subroutines

Configuring Record activities with prompts

By default, the Record activity is automatically assigned an instruction prompt. This prompt can be 
changed to another prompt, but the Record activity must have an instruction prompt assigned to it. Option-
ally, a confirmation prompt can be assigned to the Record activity to inform callers that their recording is 
complete. If no confirmation prompt is assigned to a Record activity, users are directed to the Save 
branch.
To change the Record activity's Instruction prompt 
1. Select the Record activity and click Properties.
2. To configure recording instructions for authorized callers, after Instructions, click the drop-down list 

and select from the following: 

– Add a new prompt
– Quick Add Prompt
– Clear prompt
– Select from an existing prompt

3. If you are adding a new prompt, follow the appropriate steps under "Configuring an activity"s prompts". 

NOTE: Adding a prompt requires you to select a wave file in IVR Routing, which will be added to the 
system as a prompt.

4. If you are Quick Adding a prompt, follow the appropriate steps under "Configuring an activity"s 
prompts". 

NOTE: Quick Adding a prompt enables you to populate the recording instructions with a wave file 
saved on your machine. The prompt is created in IVR Routing and is given the file name.

5. If you are selecting an existing prompt, select the prompt from the list offered to you and click OK.

6. To remove a prompt from recording instructions, after Instructions, click the drop-down list and select 
Clear prompt.

7. Click Save.

To configure a Record activity with a confirmation prompt 
1. Select the Record activity and click Properties.
2. To configure recording instructions for authorized callers, after Confirmation Prompt, click the 

drop-down list and select from the following: 

– Add a new prompt
– Quick Add Prompt
– Clear prompt
– Select from an existing prompt

3. If you are adding a new prompt, follow the appropriate steps under "Configuring an activity"s prompts". 
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NOTE: Adding a prompt requires you to select a wave file in IVR Routing, which will be added to the 
system as a prompt.

4. If you are Quick Adding a prompt, follow the appropriate steps under "Configuring an activity"s 
prompts". 

NOTE: Quick Adding a prompt enables you to populate the recording instructions with a wave file 
saved on your machine. The prompt is created in IVR Routing and is given the file name.

5. If you are selecting an existing prompt, select the prompt from the list offered to you and click OK.

6. To remove a prompt from recording instructions, after Confirmation Prompt, click the drop-down list 
and select Clear prompt.

7. Click Save.

Clearing prompts from Record activities

The following explains how to remove prompts from Record activities.
To clear a prompt from the Record activity 
• Right-click the Record activity and select either Edit Instruction Prompt > Clear prompt or Edit 

Confirmation Prompt > Clear prompt.

Configuring recording options

You can configure the recording options for authorized users phoning in to the system.
1. Select the Record activity and click Properties.
2. To remove a date and time stamp from the wave file name, deselect the Append Date Time Stamp 

check box.

3. After Output Name, type a name for the wave file being recorded.

NOTE: The output name must be a valid file name but may contain variables enclosed between 
double angle brackets. For example: <<ANI>>. The text between the angle brackets will be replaced 
with the value of the variable currently executing in the workflow.

4. After Recording Timeout (sec), type the number of seconds an authorized caller has to record a 
message.

NOTE: This figure determines the amount of time before the Timeout branch is followed.
5. After Termination Digit, from the drop-down list, select a number that an authorized caller enters to 

end the recording.

6. Click Save.

Configuring the Save, Discard, and Review branches of the Record activity

The Record activity contains an embedded menu with three options. After recording a message, autho-
rized callers are presented with the option of pressing one to save their message, pressing two to discard 
and re-record their message, and pressing three to review their message before deciding to save or 
discard it.
You can reconfigure the digit options for the Save and Discard branches, configure options for the Review 
branch, and add additional branches to the Record activity’s Menu.
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NOTE: Go To activities in the Review branch direct authorized callers to the Save or Discard branches 
depending on the caller’s selection. If authorized callers choose Save, they hear a prompt confirming that 
their message has been saved. If they choose Discard, they are taken back to the Record activity.
The following procedures explain how to 
• Reconfigure the digit options for the Save and Discard branches
• Configure user options for reviewing messages
• Add branches to the Record activity’s Menu

To reconfigure the digit options for the Save and Discard branches 
1. In the Record activity, select the branch in the Menu activity.
2. In the Properties pane, after Condition, click the … button.

3. Select the existing digit option.

4. Enter the new digit option and click the Add button.

5. Click OK. 

NOTE: The Save and Discard branches in the Record activity’s Menu are named ‘1’ and ‘2’. You can 
change these names using the Properties pane, after selecting the relevant branch.

To configure user options for reviewing messages 
1. Select the Menu activity and click Properties.
2. To enable users to enter digits before a prompt completes, select the Barge In check box.

3. After In Between Digit Delay, type the number of seconds a user has between digit entries. 

NOTE: Taking longer than this time between digit entries constitutes a timeout and counts against 
the system’s configured Timeout Attempts.

4. After Invalid Attempts, type the number of times an authorized caller can select an invalid menu 
option before the system follows the Failure branch. 

NOTE: If users select invalid menu options but do not exceed this number, the system follows the 
Invalid branch.

5. After No digit timeout (sec), type the number of seconds a user has to make their first digit entry.

6. After Timeout Attempts, type the number of times the system can timeout before following the 
Failure branch.

7. To change the menu instructions an authorized caller hears, after Instructions, click the drop-down 
list and follow the appropriate steps under "Adding prompts to Plat activities. 

NOTE: These instructions are preprogrammed in IVR Routing. You must change these instructions 
if you reconfigure digit options or add branches to the Menu.

8. To enable reporting on all branches in this activity, select the Child Reporting Enabled check box.

9. Click Save.

Configuring the Redirect activity

The Redirect activity branches workflows based off a redirect value received in a call record and the 
number of the device from which the call was redirected. The Redirect activity provides an additional 
means of branching workflows so that calls can reach the appropriate queue. You can add branching 
conditions to Redirect activities to determine how IVR Routing directs callers through the workflow.
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The Redirect activity is available in 
• Inbound, Inqueue, and Agent workflows
• Inbound, Management, Callback Inbound, and Agent subroutines

NOTE: Redirects are achieved using the ACD routing system’s HCIRedirect or Name Tag hunt groups.

Adding branching conditions to Redirect activities

To add a branching condition to a Redirect activity
1. Right-click the Redirect activity and select Add condition.
2. To add a Redirect value, at the top of the dialog box, click Add and type the value or range of values 

for the Redirect condition.

3. Click the Add icon.

4. To import Redirect conditions in .csv format, click Import and navigate to the file name.

5. To export Redirect conditions, click Export and navigate to the file name.

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

6. To add more Redirect conditions, at the top of the dialog box, click Add.

7. If you want all Redirect conditions in the same branch, clear the Add each row in a separate branch 
check box.

By default, separate branches are added for each condition.
8. To enable reporting for the branch, select the Enable reporting for this Branch check box.

9. To test the Redirect conditions, under Utilities, enter a value or range of values.

If the test is successful, 'Pass' displays.
If the test is unsuccessful, 'Fail' displays.

10. Click OK to create the branch, or click Add to add the current branch to the workflow while leaving 
the dialog box open to create new branches.

11. Click Save.

Configuring the Retrieve Callback activity

The Retrieve callback activity enables a workflow to retrieve the next available callback request from the 
SQL database for use in the current workflow. The Retrieve Callback activity prioritizes callback requests 
by time, whether the request is new or if it was requeued. To route down the Success branch, there must 
be an active callback request in the SQL database. To see how the Retrieve Callback activity functions 
within a workflow, see "Default Outbound CallbackDefault SIP Outbound workflow".
The Retrieve Callback activity requires no configuration. You can optionally provide the activity with a 
name and system name.
The Retrieve Callback activity is available in 
• Outbound workflows
• Outbound subroutines
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Configuring the Rules activity

The Rules activity enables workflows to be branched according to multiple conditions, or routing rules, 
nested within a single activity. When an incoming call enters a workflow and encounters a Rules activity, 
the call is evaluated against the activity’s preconfigured routing rules. Calls will be directed through the 
workflow based on whether the call meets the activity’s routing rules. If a call meets the activity’s routing 
rules, it is routed to the Success branch and the activity will populate variables for the call based on 
pre-configured options in the rule. These variable values will determine the queue to which the call is 
directed. For example, you can assign a rule to a Rules activity that specifies the hours of operation and 
the ANI condition for a French-language queue. If a call enters IVR Routing and matches the ANI of a 
French-speaking region during the French queue’s hours of operation, that call will have an ANI variable 
populated with the French area code and will be routed to the appropriate branch. You can assign and 
edit rules for Rules activities to determine how IVR Routing directs callers through the workflow.
The Rules activity is available in 
• Inbound, Outbound, RAD,;Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ,;Callback Inbound, and Agent subroutines

NOTE: 
• Before creating a Success branch, configure a rule that will contain the conditions for a successful 

match. For information on rules and configuring rules, see "Configuring rules".
• If the call is evaluated against multiple routing rules, first routing rule to be matched will set the variable 

values.

Adding and editing rules for Rules activities

To assign a rule to a Rules activity
1. Right-click the Rules activity and select Configure....
2. From the Available members pane, select the rule to assign to the Rule activity and click the > button.

3. Click OK.

NOTE: 
– Rules are evaluated in the order they appear in the selected list. IVR Routing will evaluate all rules 

in order to find a match. By default, it will not stop at the first match.
– You can only configure one Success branch per Rules activity.

4. To edit a rule assigned to a Rules activity, right-click the activity and select Configure....

5. Change the rule assigned to the branch.

6. Click OK.

7. To stop evaluating rules at the first match, select Stop at First Match.

8. To enable reporting for this branch, in the Properties pane, select the Child Reporting Enabled 
check box.

9. Click OK.

10. Click Save.
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Configuring the Save Agent Greeting activity

The Save Agent Greeting activity instructs IVR Routing to save a recording as an agent greeting for a 
specific queue, or as a default greeting if not assigned to a specific queue.
The Save Agent Greeting activity only appears in the outbound Record Agent Greeting workflow. See 
"Default Record Agent Greeting Worflow" for more information.

Configuring the Save Callback activity

The Save Callback activity saves a callback request to the SQL database. This activity can be used to 
both save the information collected in the callback variables as a new callback request or save an existing 
callback request back to the SQL database with a reason of completed or requeued. The Global Callback 
monitor in Contact Center Client informs the supervisor which callback requests were saved and why.
Following are the reasons associated to saving callback requests and their expected behavior: 
• New Request—collects the information from the callback variables and throughout the workflow and 

compiles it as a callback request with the type specified
• In Progress—saves the callback request to the SQL database with an update on its progress, but 

does not remove it from the workflow.
• Completed—saves the callback request to the SQL database with the indicated reason and prevents 

it from being retrieved and offered to the queues and agents again.
• Requeued—saves the callback request back to the SQL database to be retrieved later. The callback 

handling count is modified based on the reason for requeue. In outbound callback subroutine work-
flows, callback requests may no longer be offered if they have been requeued a specified number of 
times without being completed. If there is a customer-based reason for the requeue (no answer, 
customer hang up, etc.), the handling count is increased. If the reason for requeue is due to an agent 
or other factor outside a client’s control, then the handling count is not modified.

The Save Callback activity has a Success and Pending branch. The activity routes down Pending when 
network issues prevent the callback from being submitted. When the network issues are resolved, the 
callback will be saved.
NOTE: Using a Save Callback activity in a workflow that routes callback requests enables the SQL records 
for callback requests to be updated when they leave the workflow. Otherwise, IVR Routing will treat the 
callback request as a callback request with the highest priority, potentially creating a loop.
For an example of how the Save Callback activity functions within a workflow, see "Default Outbound Call-
back subroutines".
The Save Callback activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, UPiQ, Management, Callback Inbound, and Agent, subroutines

To set the Save Callback request reason 
1. Select the Save Callback activity.
2. Select a Request Reason from the drop-down menu.

3. Click Save.

Configuring the Schedule activity

The Schedule activity branches workflows based on date and time conditions, enabling a workflow to 
respond to a business’ hours of operation.



322

CONFIGURING IVR ROUTING
CHAPTER 9 IVR ROUTING

For example, you can use the Schedule activity to route customers calling after hours to an after-hours 
voicemail and menu. The Schedule activity reduces workflow clutter by providing 'Open' and 'Closed' 
branching conditions within a single workflow.
NOTE: The Schedule activity applies schedules based on the local time of the IVR Routing server. If the 
IVR Routing server is located remotely in a different time zone than the contact center to which it is routing 
calls, the schedules for the Schedule activity should include offset time to compensate for time zone differ-
ences.
Administrator can set business hours for different time zones for a Schedule activity. By default, the value 
for the Time Zone Region is set to Local that is the Local Time of the Enterprise/Remote server on which 
the administrator is creating the workflow.
The Schedule activity is available to 
• Inbound, Outbound, Inqueue, Agent, and Media workflows
• Inbound, Outbound, Agent, Media, Management, UPiQ, and Callback Inbound subroutines

Adding and modifying business hour Schedule conditions

The business hour schedule conditions determine when IVR Routing executes business hours workflows 
and after hours workflows. These include the default Monday to Friday, 9:00 AM to 5:00 PM schedule and 
the default 24/7 schedule, as well as other user-created schedules. You can add these default Schedule 
conditions as is, or modify them to suit your contact center’s hours of operation.
To add a Business Hour Schedule condition 
1. Right-click the Schedule activity and select Add a schedule condition.
2. Type the Name of the schedule condition.

3. Click Add and select Schedule from the second drop-down list.

4. From the third drop-down list, select a schedule.

5. Click OK.

6. To test the conditions, under Testing, select a date and time and click Test. 

Pass or Fail displays, indicating whether the test was successful.
7. To enable reporting, select the Enable Reporting check box.

8. Click OK to create the branch, or click Add to add the current branch to the workflow while leaving 
the dialog box open to create new branches.

9. To edit schedule conditions, on the Workflows Canvas, right-click a branch and select Edit.

10. Click Save.

To modify a Business Hour Schedule condition 
1. Select YourSite > Schedules and select the default schedule you wish to modify.
2. Type a new Name for the schedule. For example, ‘Monday to Friday 8:00 AM to 6:00 PM’.

3. After Schedule exclusion list, click the Browse button.

4. Select a schedule exclusion list to apply to the schedule and click OK. 

NOTE: The Schedule exclusion list specifies days to be omitted from the schedule. To create a 
schedule exclusion list, or to edit an existing schedule exclusion list, see "Managing schedule exclu-
sion lists".
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5. After Start time, type the business day start time for each day of the week.

6. After End time, type the business day end time for each day of the week.

7. After Disable for day, select the check box for each day your business is closed.

8. Click Save.

To set Time Zone for Schedule Activities 
1. In YSE, select a schedule activity and drop on to the workflow
2. Select the schedule to modify and click Properties.

3. Select the required timezone from Timezone Region drop down box and click OK.

Adding and modifying time and day of the week conditions for Schedule activities

Adding time and day of week conditions to a Schedule activity specifies when calls are routed to queues 
based on a call center’s business hours.
To add or modify a time and day of the week condition for a Schedule activity
1. Right-click the Schedule activity and select Add a schedule condition.

The Schedule Dialog box opens.
2. After Name, type the name of the schedule condition.

3. At the top of the dialog box, click Add and select Time from the second drop-down list.

4. Using the third drop-down list, type your contact center’s Start time (hh/mm/ss) and End Time 
(hh/mm/ss) and click OK.

5. To add more time conditions follow steps 3-4.

6. To add a day of the week condition, at the top of the dialog box, click Add and select DOW from the 
first drop-down list.

7. Under <Value>, specify the days of the week your contact center is open by selecting the checkboxes 
for those days, and click OK.

8. To add more Day of the Week conditions follow steps 6-7.

9. To import schedule conditions, click the Import button and navigate to a *.csv file.

10. To export schedule conditions, click the Export button and navigate to a *.csv file.

NOTE: 
– Conditions on a single line and separated by a comma are added to a single branch.
– Conditions on multiple lines and separated by a comma are added to multiple branches.

11. To test the conditions, under Utilities, enter time and date information and click Test.

If the test is successful, 'Pass' displays beside the Test button.
If the test is not successful, 'Fail' displays beside the Test button.

12. To enable reporting, select the Enable reporting check box.

13. To delete a schedule condition, from the drop-down list to the left of the condition, select Delete.

14. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.
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15. To edit schedule conditions, on the Workflows Canvas, right-click the branch and select Edit 
Schedule condition.

16. Click Save.

Adding and modifying date or holiday conditions for Schedule activities

Adding date and holiday conditions to a Schedule activity specifies when calls are routed to a branch 
designed to handle calls when the contact center is closed. Use date conditions to specify exceptional 
days your contact center is closed. Add holiday conditions to specify Holiday closures.
To add and modify a date or holiday condition for a Schedule activity
1. Right-click the Schedule activity and select Add a schedule condition.

The Schedule Condition Designer opens.
2. After Name, type the name of the schedule condition.

3. At the top of the dialog box, click Add and select Date from the first drop-down list.

4. Using the second drop-down list, specify the date the contact center is closed and click OK.

If your contact center is regularly closed on this date, select the Reoccur every year check box.
5. To add more dates the contact center is closed, follow steps 3-4.

6. To add a holiday condition, click the Add button and select Holiday from the first drop-down list.

7. After <Select a holiday>, select the check box beside the holiday and click OK.

8. To add more holidays follow steps 6-7.

9. To import schedule conditions, click the Import button and navigate to a *.csv file.

10. To export schedule conditions, click the Export button and navigate to a *.csv file.

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

11. To test the conditions, under Utilities, enter the dates and click Test.

If the test is successful, 'Pass' displays beside the Test button.
If the test is not successful, 'Fail' displays beside the Test button.

12. To enable reporting, select the Enable reporting check box.

13. To delete a schedule condition, from the drop-down list to the left of the condition select Delete.

14. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

15. To edit schedule conditions, right-click the branch and select Edit Schedule.

16. Click Save.

Importing and exporting Schedule conditions

The following explains how to import and export Schedule conditions from *.csv files
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To import and export Schedule conditions
1. Right-click the Schedule activity and select Add a schedule condition.
2. Type a Name for the schedule condition.

3. To import schedule conditions, click the Import button, navigate to a *.csv file, and click Open.

4. To export schedule conditions, click the Export button, navigate to a *.csv file, and click Save.

NOTE: 
– Conditions on a single line and separated by a comma are added to a single branch.
– Conditions on multiple lines and separated by a comma are added to multiple branches.

5. To test the conditions, under Testing, select a date and time and click Test.

6. Click OK to create the branch, or click Add to add the current branch to the workflow while leaving 
the dialog box open to create new branches.

7. Click Save.

Grouping schedule conditions in Schedule activities

You can group conditions in Schedule activities using the 'Group AND' or 'Group OR' buttons in the 
Schedule Condition Designer. Grouping conditions by 'Group AND' means that every queue condition 
specified must be met to route the call to the Success branch. Grouping conditions by 'Group OR' means 
that only one of the queue conditions specified must be met to route the call to the Success branch.
NOTE: 
• The 'Group AND' and 'Group OR' buttons will be disabled unless you have at least two conditions to 

group.
• 'Group AND' is the default grouping for the Schedule activity.

To group Schedule conditions
• See "Grouping expressions".

Configuring the Set Device Mode of Operation activity

The Set Device Mode of Operation activity changes the mode of operation for a specific device server 
from Normal to Emergency or vice-versa. These devices include 
• Hunt Groups
• Extensions

For example, if only one extension is experiencing emergency conditions, you can use the Set Device 
Mode of Operation to put that port into Emergency mode without affecting the entire system’s operations.
The Set Device Mode of Operations activity is available in 
• Management subroutines

Configuring properties for Set Device Mode of Operation activities

To configure the properties for a Set Device Mode of Operation activity 
1. Select the Set Device Mode of Operation activity.
2. In the Properties pane, after Device Type, select device type from the drop-down list. 

NOTE: 
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– Device type refers to the type of device checked when searching a dialable number.
– Dialable number refers to the digit or series of digits a caller dials to reach an agent at an extension.

3. To set the variable containing the device dialable number, after Input Variable, click the … button. 

The Select a variable dialog box opens.
4. Select an input variable and click OK.

5. After Mode of operation, select either Normal or Emergency from the drop-down list.

6. To enable reporting on the activity or a branch, select the activity or branch and select the Child 
Reporting Enabled or Reportable check box.

7. Click Save.

Configuring the Set System Mode of Operation activity

The Set System Mode of Operation activity changes the mode of operation for IVR Routing from Normal 
to Emergency and vice-versa. For example, if the contact center is closed due to weather you can use 
the Set System Mode of Operation Activity to change IVR Routing to Emergency mode and route all work-
flows in accordance with an emergency plan.
The Set System Mode of Operation activity is available in
• Management subroutines

Configuring properties for Set System Mode of Operation activities

To configure properties for a Set System Mode of Operation activity
1. Select the Set System Mode of Operation activity.
2. In the Properties pane, after Mode of Operation, select either Normal or Emergency from the 

drop-down list.

3. To enable reporting on the activity or a branch, select the activity or branch and select the Child 
Reporting Enabled or Reportable check box.

4. Click Save.

Configuring the Set Variables activity

The Set Variables activity enables IVR Routing to take values generated within a workflow or static, 
predefined values and use them to populate variables for use later in the same workflow. For example, 
you can use the Set Variables activity to populate a variable with a caller’s choice of service language. 
IVR Routing can use this information later in the workflow to direct callers to a queue with service in the 
appropriate language. You can determine the variables to be populated in Set Variables activities.
For security and privacy reasons, variables that use any masking cannot be used with the Set Variables 
activity.
The Set Variables activity is available in
• Inbound, Outbound, RAD, and Inqueue workflows
• Inbound, Outbound, RAD, Management, UPiQ, and Callback Inbound subroutines

Populating the Set Variables activity with workflow data

The following explains how to retrieve workflow data and use it to populate Set Variables activities
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To populate the Set Variables activity with workflow data 
1. Right-click the Set Variables activity and select Edit Variable Settings.
2. Type a Name for the activity and click Add.

3. Select a variable from the drop-down list and click OK. 

To see a list of IVR Routing variables and their descriptions, go to 'IVR Routing > Variables'.
4. In the third column, either type a Value, an expression in Advanced Text, or select Variable and 

select a variable from the drop-down list. If selecting a value, note that options vary according to the 
variable selected. Advanced Text is only available with certain variables.

5. To add a variable row, click Add. To delete a variable row, select the row and click Delete.

6. Click OK.

7. Click Save.

Configuring the SMS activity

If you are licensed for Multimedia Contact Center and have an SMS media server, you can send SMS 
interactions with the SMS activity. For more information, see "Sending SMS with the SMS activity".
The SMS activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows.
• Inbound, Outbound, RAD, Management, UPiQ, and Callback Inbound subroutines

Configuring the Subroutine activity

The Subroutine activity represents a set of workflow steps that can be inserted at any point in a workflow 
or in multiple workflows. Editing the subroutine changes all instances of that subroutine in workflows, 
enabling you to edit multiple workflows using a single point of configuration. The Subroutine activity is an 
efficient means of replicating and configuring workflow segments. For information on subroutines, see 
"Building subroutines".
You can assign IVR Routing’s default Management or Callback subroutines to the activity, or build a 
subroutine to assign to the activity.
The Subroutine activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflow
• Inbound, Outbound, RAD, Management, UPiQ, and Callback Inbound subroutines

Assigning subroutines and variables to Subroutine activities

IVR Routing provides default Management and UPiQ subroutines. To build other subroutines see 
"Building subroutines".
The following section explains how to
• Assign subroutines to the Subroutine activity
• Assign variables to the Subroutine activity
• Expand subroutines in workflows

To assign a subroutine to a Subroutine activity
1. Right-click the Subroutine activity and click Assign….
2. Click the Subroutines tab, select a subroutine to assign and click OK.
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3. Click Save.

To assign a variable to the Subroutine activity
NOTE: Assigning a variable to the Subroutine activity requires first inserting and configuring an activity on 
the Canvas capable of populating the variable.
1. Right-click the Subroutine activity and click Assign…
2. Click the Variable tab, select a variable to assign and click OK.

To see a list of IVR Routing variables and their descriptions, go to 'IVR Routing > Variables'.
3. Click Save.

To expand a subroutine in a workflow
• Right-click the Subroutine activity and click Open...

Configuring parent workflow destinations for subroutine Go To activities

If a Go To activity is placed in a subroutine, it can route contacts to the parent workflow to which the 
subroutine is assigned by setting its destination as ‘Go To Parent Workflow’. A target destination must be 
set on the Subroutine activity to set where the contacts are routed to in the Parent workflow.
To configure a parent workflow destination for a subroutine Go To activity 
1. In the parent workflow, select the Subroutine activity.
2. In the Properties, after Target Activity select the activity to which the subroutine Go To activity 

returns contacts from the drop-down list.

3. Click Save.

Configuring the Swap Prompt activity

The Swap Prompt activity enables you to swap the contents of one prompt with the contents of another 
prompt in IVR Routing. For example, if an emergency greeting informs customers that the contact center 
is closed due to bad weather, in the event of an earthquake you can use Swap Prompt to change the 
contents of the emergency greeting. The Swap Prompt activity enables you to provide specialized 
prompts within a single workflow without inserting additional activities. You can set the prompts to be 
exchanged in Swap Prompt activities from existing prompts in IVR Routing or from prompts that you 
create.
The Swap Prompt activity is available in
• Management subroutines
NOTE: If you have switched the contents of one prompt with another, you may eventually need to switch 
the contents of prompts back again.

Setting prompts to be exchanged in Swap Prompt activities

To set the prompts to be exchanged in a Swap Prompt activity
1. Select the Swap Prompt activity.
2. After Source Prompt, click the  button and follow the applicable steps under "Configuring an 

activity"s prompts".

NOTE: The source prompt is the prompt that will be used to replace the target prompt.
3. After Target prompt, click the  button and follow the applicable steps under "Configuring an 

activity"s prompts".
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NOTE: The target prompt is the prompt that will be swapped with the source prompt.
4. Click Save.

Configuring the Transfer activity

The Transfer activity transfers a caller to a specified destination, enabling you to send callers to a queue, 
queue group, variable, or other specified destination. For example, you can use a Transfer activity to route 
calls across queues.
Transfers can be blind or supervised. Both types of transfer place the caller on hold and transfer the call 
to the activity’s destination. Blind transfers are considered completed when the destination begins ringing, 
while supervised transfers are considered completed when the destination answers. Callers cannot hear 
the phone ringing during the transfer unless the transfer time exceeds the timeout.
The Transfer activity contains three branches, which determine how the call is handled in the workflow 
after the attempted transfer. The three branches are: 
• Success—This branch determines how the workflow handles the call after the caller is transferred to 

the transfer destination. By default, the Success branch contains a Hang Up activity. A call routed 
through the Success branch is separated from the caller, who starts a new call at the transfer destina-
tion. The Hang Up activity ends the call remaining in the current workflow and clears the port for a new 
call. 

NOTE: Removing the Hang Up activity from the Success branch is not recommended as it may result in 
unnecessary port use.
• Abandon—This branch determines how the workflow handles the call when the original caller hangs 

up before a supervised transfer is completed. By default, the Abandon branch contains a Hang Up 
activity. A call routed through the Abandon branch is separated from the caller, who abandoned it when 
they hung up. The Hang Up activity ends the call remaining in the current workflow and clears the port 
for a new call. 

NOTE: Removing the Hang Up activity from the Abandon branch is not recommended as it may result in 
unnecessary port use.
• Failure—This branch determines how the workflow handles the call when the Transfer activity fails to 

connect to the destination. By default, the Failure branch contains a Hang Up activity. A call routed 
through the Failure branch is not separated from its caller and may continue in the workflow. By default, 
this branch contains a Hang Up activity that ends the call in the current workflow and clears the port 
for a new call.

You can configure the options for how and where a call is transferred, and add new devices to Transfer 
activities.
The Transfer activity is available in 
• Inbound, Outbound, and Inqueue workflows
• Inbound, Outbound, Management, and Callback Inbound subroutines

Configuring options and adding devices to Transfer activities

The following procedures tell you how to: 
• Set a destination
• Set a dialable number as the destination
• Add a new device as the destination
• Set the dialing properties
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• Set the reporting and timeout options

To set a destination 
1. Select the Transfer activity.
2. In the Properties pane, after Destination, click ....

3. Select a destination from one of the following tabs and click OK. 

– Extension
– Queue 

NOTE: Ring Groups can be set as destinations, but the workflow’s port must be located on the 
same media server as the Ring Groups.

– Queue Group 
NOTE: When transferring to a virtual queue group, the Transfer activity will route to the first 
queue on the same media server as the IVR port. If the status of this queue is Offline, it will 
route to the next local queue configured in the queue group. If all local queues are Offline, it 
will route to the first remote queue. Queues in Do Not Disturb are considered Online.

– Variable

4. Click Save.

To set a dialable number or SIP address as the destination 
1. Select the Transfer activity.
2. In the Properties pane, after Destination, type the dialable number or SIP address. 

A dialable number cannot include punctuation marks.
3. Click Save.

To add a new device as the destination 
1. Select the Transfer activity.
2. In the Properties pane, after Destination, click ....

3. Click Add.

4. Select one of the following from the drop-down list: 

– Extension
– Queue
– Queue group 

NOTE: Only unified queue groups containing a SIP queue are supported. For more information 
on unified queue groups, see the "Adding Unified queue groups".

– Variable

5. In the Extension,Queue, Queue Group, or Variable tab, at the top of the dialog box, click Add.

6. To add a new extension, see "Adding extensions for IVR Routing".

7. To add a new queue, in the Queue pane, follow the steps under "Adding queues". 

NOTE: 
– A new Ring Group can be used as a destination, but only if the workflow’s port is on the same media 

server as the Ring Group.
– To configure a new queue for web callbacks, see "Enabling web callbacks".
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– To configure a new queue for abandon callbacks, see "Enabling abandon callbacks".
– To associate a queue to an UPiQ workflow, see "Configuring InQueue routing". For information on 

setting up UPiQ workflows, see "Default InQueue UPiQ workflow and subroutine".

8. To add a new unified queue group, follow the corresponding steps in the "Adding Unified queue 
groups".

9. To add a new variable, follow the corresponding steps in "Adding variables".

10. Click Save.

To set the dialing properties 
1. Select the Transfer activity.
2. In the Properties pane, after Transfer Type, to instruct the activity to hold calls transferred to busy 

lines, in the Properties pane, select the Camp On Busy check box.

3. To append outbound calls with a prefix digit, in the Properties pane, select the External Transfer 
check box. 

The prefix digits appended to external transfers are defined on the media server.
4. Select Blind or Supervised from the drop-down list.

5. Click Save.

To configure the reporting and timeout options 
1. Select the Transfer activity.
2. To enable reporting, select the Child Reporting Enabled check box.

3. To set the duration that a call is put on hold during a transfer, after Timeout Duration, enter the time 
allotted for the transfer.

4. Click Save.

Configuring the Variable Compare activity

The Variable Compare activity routes calls through workflow branches by comparing information, stored 
in either custom or system variables, against specified conditions.
For example, you can use Variable Compare to create a priority branch for customers with Gold member-
ship. The Variable Compare activity compares a variable for Gold membership against a customer’s 
actual membership level. If the customer’s membership information compares positively against the 
criteria for the Gold branch then the caller is routed to the priority branch. Customers whose membership 
information does not match the criteria for the Gold branch are routed to the No Match branch.
You can apply branching conditions to Variable Compare activities, and you can group variable conditions 
to determine how IVR Routing directs callers through the workflow.
The Variable Compare activity is available in 
• Inbound, Outbound, RAD, Inqueue, and Agent workflows
• Inbound, Outbound, RAD, Management, UPiQ, Callback Inbound, and Agent subroutines

Applying branching conditions to Variable Compare activities

The following procedures explain how to
• Add conditions to be compared against workflow data
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• Edit conditions being compared
• Delete conditions being compared

To add a condition to be compared against workflow data
1. Right-click the Variable Compare activity and select Add Variable Compare condition.
2. Type a Name for the condition and click Add.

3. Select a variable from the drop-down list and click OK.

To see a list of IVR Routing variables and their descriptions, go to 'IVR Routing > Variables'.
4. Select an operator from the second drop-down list. Options vary according to the variable chosen.

5. In the third column, type or select a value for the variable. If selecting a value, note that options vary 
according to the variable selected.

NOTE: " means 'No Value'.
6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.

7. Click Save.

To edit a Variable Compare condition
1. Right-click the condition’s branch and select Edit.
2. Edit the condition, and click OK to create the branch or click Add to add the current branch to the 

workflow while leaving the dialog box open to create new branches.

3. Click Save.

To delete a Variable Compare condition
1. Right-click the condition's branch and select Delete.

Grouping variable compare conditions

You can group variables to be compared in the Variable Compare activity using the 'Group AND' or 'Group 
OR' buttons in the Variable Compare Condition Designer. Grouping variables by Group AND means that 
every variable condition specified must be met to route the call to the Success branch. Grouping variables 
by Group OR means that only one of the variable conditions specified must be met to route the call to the 
Success branch.
NOTE: 
• The 'Group AND' and 'Group OR' buttons will be disabled unless you have at least two conditions to 

group.
• Group AND is the default grouping for the Variable Compare activity.

To group variable compare conditions
• See "Grouping expressions".

Passing agents call information in screen pops

Screen pops pass call information to agents. When the system routes a call, information can be passed 
to agents as follows:
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You can configure Contact Center Screen Pop. Contact Center Screen Pop is applied uniformly across 
queues, providing all agents the same type of call information. For more information, see "Configuring 
Contact Center Screen Pop".
You can configure screen pops within an Inqueue workflow, programmed on a queue-by-queue basis. 
See "Populating screen pops with workflow variables".
NOTE: 
• Contact Center Screen Pop is hidden unless you are licensed for it.
• If Contact Center Screen Pop and screen pops configured via Inqueue workflows are both active, the 

workflow screen pop overrides Contact Center Screen Pop.

Populating screen pops with workflow variables

When a call is processed through a workflow, you can populate URLs or executable files with variables 
detected for the call. These URL and executable files, and the variable information they contain, can be 
passed to agents in the form of a screen pop.
Screen pops display when an interaction is ringing on the agent’s extension. Variables available to the 
workflow’s media type, which also contain the ‘Send to Agent’s desktop’ check box, can populate a screen 
pop with information. Populating URLs and executable files with workflow variables enables you to 
customize screen pops on a queue-by-queue basis.
For example, you can configure a workflow to query a database and retrieve a customer’s name and 
account number. When the call rings on an agent’s extension, a screen pop opens a web page delivering 
the customer information to the agent. The agent is immediately able to provide personalized, informed 
service.
Administrators must provide webcodes and servers for URLs and the executable codes behind execut-
able files. URLs must include 'http://' in the URL string.
Executable files may prompt a Windows security warning before popping. Administrators may disable this 
security setting in Internet Explorer. For more information, consult Microsoft documentation.
NOTE: 
• Agents using Ignite (WEB) may need to disable pop-up blockers for the Ignite URL in order for screen 

pops to display .
• Ignite (WEB) supports URL screen pops only. Executable file screen pops are not supported.
• If Contact Center Screen Pop and screen pops populated with workflow variables are both active, the 

workflow variable screen pop overrides Contact Center Screen Pop.

To populate a screen pop with a workflow variable 
1. Click IVR Routing > Variables, and select the ScreenPopOnRinging variable.
2. Select Send to agent desktop.

3. In an Inbound workflow, place a Set Variables activity on the Workflows Canvas. 

NOTE: We recommend placing the Set Variables activity quite close to the activity offering the call to 
an agent’s extension. This helps prevent the screen pop’s value from being overwritten by another 
variable query.

4. Right-click the Set Variables activity and select Edit Variable Settings.

5. Click Add and, from the <Select a variable> drop-down list, select ScreenPopOnRinging.

6. Click <Value> and, in the Value tab, enter a URL string or the path to an executable file. 
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NOTE: The paths to executable files must be accessible to any clients who require its use. For 
example, administrators can place the file on a network share.

7. To populate a web page screen pop with variable information, insert the variable’s name between 
double angle brackets where applicable in the URL string. 

For example, <<DNIS>>.
8. Click OK to close the variable dialog box and click OK to return to the workflow.

9. Click Save.

IVR Routing default workflows and subroutines
There are a number of default workflows and subroutines included in the IVR Routing installation. The 
workflows and subroutines are based on common scenarios and demonstrate IVR Routing’s enhanced 
functionality. They can be configured according to your business needs.
IVR Routing includes the following default workflows 
• Default UPiQ Inqueue workflow 

– Includes default UPiQ subroutine
• Default Management subroutine
• Default Callback Outbound workflow 

Includes the following subroutines
– Default Outbound Abandon Callback subroutine
– Default Outbound Voice Callback subroutine
– Default Outbound Web Callback subroutine

In addition, IVR Routing includes the following default Callback Inbound subroutine: 
• Default Inbound Voice Callback subroutine
The following sections summarize the default workflows and subroutines and explain how they operate. 
For ease of understanding, we also recommend you expand the entire workflow and all annotations.
To expand the workflow 
• Click the Expand All button
To expand all annotations 
• Right-click the workflow and select Annotations... > Show All.

Changes to callbacks and UPiQ

Version 7.0 introduced important changes to how callbacks and UPiQ are configured.
Prior to Version 7.0, callbacks and UPiQ were configured directly on the queue. Callbacks were config-
ured via callback plans, and UPiQ was configured by selecting from a set of predetermined options. In 
Version 7.0 and greater, callbacks and UPiQ are configured using default workflows and subroutines 
included with IVR Routing. These default workflows and subroutines replicate the functionality of call-
backs and UPiQ prior to Version 7.0 while enabling you to configure and customize the callback and UPiQ 
processes. This new configuration ensures that callbacks and UPiQ can be as simple or sophisticated as 
you require.
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Upgrading to MiContact Center Business Version 7.1 seamlessly migrates your existing Callback and 
UPiQ configuration from the Version 6.x configuration options into Version 7.1 workflows. This includes 
custom .wav files and any changes to the default options. For more information on how Callback and 
UPiQ function in workflows, see "Default callback workflow and subroutines", and "Default Inqueue UPiQ 
workflow and subroutine".
Note that the Callback Outbound workflow is now enabled or disabled by selecting the ‘Always run’ check 
box on the Workflows pane.
NOTE: Callback ports have been deprecated and are converted to Outbound ports during the migration 
process.

Customizing the default workflows and subroutines

If you want to create your own versions of IVR Routing’s default workflows, we recommend you do so by 
reconfiguring the default workflows. For more information, see "Copying workflows" and "Cutting, pasting, 
and copying workflow items".
Some default workflows require additional configuration to get them up and running for your business. For 
information on configuring the workflow activities to suit your contact center, follow the cross-references 
located throughout each summary.
The following requirements are shared among default workflows. You must 
• Validate the workflow and activity configuration and correct any errors detected. See "Troubleshooting 

workflow configuration with the Validation button".
• Associate Inbound workflows to an extension or hunt group, and associate Outbound workflows to an 

extension Inbound and Outbound workflows to a media server. See "Associating workflow to devices".
• Associate Inqueue workflows to at least one queue. See "Associating workflow to devices".

Default Inqueue UPiQ workflow and subroutine

This workflow instructs IVR Routing to obtain callers’ position in queue and executes a subroutine to play 
callers different UPiQ messages based on their position. Previously, UPiQ was turned on or off on a 
queue-by-queue basis and contained pre-programmed options from which to choose. UPiQ is now 
comprised of a configurable subroutine referenced within a dedicated Inqueue workflow. You can use the 
subroutine to choose how many customers on hold are updated, the frequency with which they are 
updated, and the specific messages they hear based on their queue position. You can assign the work-
flow to any Voice queue in your enterprise. This UPiQ Inqueue workflow enables you to create a custom-
ized, dynamic UPiQ experience for customers waiting in queue, helping you to meet your service level 
objectives by reducing abandoned calls.
To add the Default UPiQ subroutine to a queue’s Media workflow, add a Subroutine activity and assign 
this subroutine to the activity.
Expected Wait Time announcements are not included in the Default UPiQ subroutine, but can be added 
to the Default UPiQ subroutine. For more information, see "Playing Excepted Wait Time announcements".
To further illustrate the workflow’s activities and their operations, we recommend you expand the entire 
workflow and all annotations.
To expand the workflow 
• Click the Expand All button.
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To expand all annotations 
• Right-click the workflow and select Annotations… > Show All.
Description
The first step in this workflow is a Delay activity. The Delay activity determines the time until callers in 
queue hear the first UPiQ message. By default, the Delay activity is set to 10 seconds. To reconfigure this 
time, see "Configuring the Delay activity".
Next in the workflow is a Variable Compare activity, in this example named ‘Check Customer Position’. 
This activity determines the range of positions hearing UPiQ messages and compares it to a caller’s 
actual position in queue and expected wait time. If a caller is in position one through eight, and if their 
expected wait time is less than the last expected wait time reported, the 'Customers to update' branch is 
followed. To reconfigure the criteria determining whether callers hear UPiQ messages, edit the Variable 
Compare activity. See "Configuring the Variable Compare activity".
NOTE: Any additional position you configure in the Variable Compare activity must have a branch associ-
ated to it in the UPiQ subroutine’s Variable Compare activity (see below).
If callers do not meet this criteria, the No Match branch is followed and the system is continuously 
prompted to recheck queue positions against the UPiQ criteria. This enables callers moving into the range 
of UPiQ positions to hear their updated position. The frequency with which the system rechecks positions 
and estimated wait time is determined by a second Delay activity (see below). A Go To activity loops back 
to the Variable Compare activity to begin the process again (see below).
For callers within the range of UPiQ positions, a Connect to Caller activity, embedded within the Variable 
Compare activity and labeled ‘Default UPiQ’ in this example, prompts the UPiQ port to engage callers and 
executes the subroutine determining the messages different positions hear (see below).
If the Connect to Caller activity cannot find an available UPiQ port, the No Port Available branch is 
followed. If the Connect to Caller action fails, the Failure branch is followed. In each case, after an initial 
delay determined by the Delay activity (see below), a Go To activity loops back to the Variable Compare 
activity to begin the process again. A Set Variables activity, in this example named ‘Update Last Position 
and Wait time reported’, is configured so callers whose position has not changed do not hear their position 
read to them repeatedly. If you delete the Variable Compare activity, delete this activity also.
The subroutine contains activities enabling you to customize the experience of a caller waiting in queue.
To see the subroutine, go to IVR RoutingSubroutines > Default UPiQ.
The first step in the subroutine is an Answer activity. The Answer activity tells the UPiQ port to answer the 
call. The next step in the subroutine is a Language activity, which enables the prompt language to change, 
based on options previously selected by the customer. To change this language from English, see 
"Configuring the Language Activity". If the system language will remain English only, you can delete this 
activity.
Next is a Set Variables activity, configured to determine if the estimated wait time a caller hears should 
be rounded to the nearest minute. The default setting for this variable is ‘False’, meaning that the esti-
mated wait time is not rounded to the nearest minute. To round the estimated wait time to the nearest 
minute, you must reconfigure the setting to ‘True’. For more information, see Configuring the Set Vari-
ables activity".
Next is a Variable Compare activity. This activity compares a caller’s position in queue to those hearing 
UPiQ messages. If callers are in position one, the ‘UPiQ Position Equal 1’ branch is followed. Additional 
branches are followed for other caller positions. These branches contain Play activities informing callers 
of their position in queue. To alter the messages callers hear, see "Configuring the Play activity".
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If callers are outside the range of UPiQ positions, the No Match branch is followed. We recommend you 
configure this branch with activities to determine how the system behaves when the branch is followed.A 
Hang Up activity ends the subroutine. To reconfigure the Variable Compare activity, for example to add 
branches to incorporate additional queue positions, see "Configuring the Variable Compare activity".
NOTE: Callers are directed to the No Match branch in the subroutine only if you have not programmed a 
branch to incorporate their position in queue. If callers are being directed to the No Match branch, ensure 
you adjust the subroutine so these callers hear a message and stay in queue.
Following the subroutine is a Delay activity. The Delay activity determines how frequently the system 
compares queue positions to the range of callers hearing UPiQ messages. This Delay activity also deter-
mines how frequently the script to check position in queue is rerun after a Timeout or if the enterprise is 
down. By default the Delay activity is set to 20 seconds. To reconfigure this time, see "Configuring the 
Delay activity".
A Go To activity at the end of the workflow loops back to the ‘Check Position’ Variable Compare activity. 
This ensures the UPiQ messages run continuously, adjust to shifting caller position in queue, and incor-
porate new callers.

Default Management subroutine

When assigned to a Management activity in a workflow, the Default Management subroutine enables 
authorized callers to remotely perform management operations on their IVR Routing application. For 
example, authorized callers can switch the IVR Routing Mode of Operation between Normal and Emer-
gency mode and modify the prompts that callers hear.
This subroutine: 
• Enables you to change over from Normal to Emergency mode if extreme weather conditions or other 

events force the temporary, unforeseen closure of your contact center. In such conditions, it is often 
desirable and sometimes necessary to make such changes from a remote location.

• Enables authorized users to make changes to the IVR Routing system remotely. You can modify 
incoming caller options and record new prompts using a phone. This is useful when a commute to the 
site is either inconvenient or not possible.

The following figure displays the Management Subroutine.
Figure 9.8: Management subroutine

 

Description
The first step in this subroutine is a Menu activity, which prompts you to enter the Management Password. 
Authorized users enter their password (in this sample, 1234) in order to access the Management subrou-
tine.
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The next step in the subroutine is the Record Prompts or Set Mode of Operation Menu activity. Within this 
Menu activity there are two, numbered options that were added manually and complete the following 
actions: 
• Option 1: Record prompts or record new greeting
• Option 2: Select 1 for System; 2 for Device

If you press Option 1 in the Record Prompts or Set Mode of Operation Menu, you can record new prompts 
or record new greetings and swap prompts from one position to another within a workflow or subroutine.
If, after recording a Prompt, you want to continue recording Prompts, press 1 to record, press 2 to exit, or 
press any other key to return to the Record prompts or record new greeting Menu activity through a Go 
To activity.
If you press Option 2, you can record a new Greeting or swap a Prompt. For example, you can record an 
Emergency Closed Message during an emergency situation and then swap it for a traditional Open 
Message once the emergency has been resolved.
If you press Option 2 in the Record Prompts or Set Mode of Operation Menu, you can set the System or 
Device Mode of Operation to either Emergency or Normal mode. If you select 1 (for system) you are 
affecting the Mode of Operation for all for all media servers. If you select 2 (for device) you are affecting 
only the media server for which you enter a reporting number.
Additional configuration required
This subroutine must be associated to a Management activity in an Inbound workflow or an Inbound, 
Management, or Callback Inbound subroutine.
It is recommended that you incorporate access to the Default Management subroutine into your main 
workflows. There are various ways to do this. For example, you could use an ANI condition that refers to 
a list of authorized user numbers and gives them the option, when they call in, of accessing the Manage-
ment activity configured with the Default Management subroutine. You could alternatively add a DNIS 
condition and give users the appropriate number to call in to access the Default Management Plan. If your 
workflow has an ANI or DNIS branch, you can add the Default Management Plan ANI or DNIS branch as 
an additional branch in that location of the workflow. The menu option for accessing the Default Manage-
ment Plan should be hidden (unadvertised) meaning that it is not mentioned in your greeting message. 
The authorized user would input a set code to access the Default Management Plan.

Default Callback workflow and subroutines

IVR Routing includes the following default callback workflows: 
• Default Callback Outbound workflow 

Includes the following subroutines:
– Default Outbound Abandon Callback subroutine
– Default Outbound Voice Callback subroutine
– Default Outbound Web Callback subroutine

In addition, IVR Routing includes the following Callback Inbound subroutine: 
• Default Inbound Voice Callback subroutine

Default Outbound Callback workflow

This workflow manages retrieving callbacks and offering them to agents. This workflow runs continuously, 
searching SQL for submitted callback requests and offering them to queues. Depending on the kind of 
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callback submitted, this workflow leverages the appropriate Outbound callback subroutine so that the call-
back type is handled correctly and offers the agent relevant options.
This workflow must be associated to an Outbound port. See "Associating workflows to devices".
To further illustrate the workflow’s activity and operations, we recommend you expand the entire workflow 
and all annotations.
To expand the workflow 
• Click the Expand All button.
To show all annotations 
• Right-click the workflow and select Annotations… > Show all.
Description
The first step of this workflow is the Retrieve Callback activity. This activity looks in SQL for submitted 
callback request that are ready to be delivered to the callback destination. Retrieve Callback has two 
branches: Success and Failure. If the Retrieve Callback activity fails to retrieve a callback, such as if there 
are no submitted callback requests, it continues in the workflow to the Delay activity. If a callback request 
is detected, it is retrieved and routed to the Success branch.
The Success branch contains a Subroutine activity, which checks the <<CallbackOutboundWorkflowId>> 
variable in the callback request for the appropriate subroutine and then routes the request through the 
appropriate subroutine workflow. For an overview of the subroutines, see "Default Outbound Callback 
Subroutines". The next activity in the Success branch is a Hang Up activity, which ends the callback.
The final activity in the workflow is a Delay activity, which is configured with a five-second delay. This 
activity creates a buffer of time between each offering of a callback request. For information on modifying 
the Delay activity, see "Configuring the Delay activity".

Default Outbound Callback subroutines

IVR Routing includes the following three subroutines for Outbound callbacks: 
• Default Outbound Abandon Callback subroutine
• Default Outbound Voice Callback subroutine
• Default Outbound Web Callback subroutine

These subroutines are used by the Default Callback Outbound subroutine to offer callback requests to 
agents and manage outbound calls to customers. The three subroutines manage the state of the callback 
request, setting the frequency and number of times a callback request is offered to a queue. This prevents 
an unsuccessful callback request from being offered repeatedly. Using the Save Callback activities 
located throughout the subroutine at the various endpoints, callback requests are saved back to the SQL 
database with reason codes that inform the system whether or not the callback request is complete or if 
it needs to be requeued.
The subroutines handle the offering of the callback request to agents as well as managing the outbound 
call to the customer.
The subroutines are functionally identical with the exception of the Menu option for Branch 1. The voice 
callback enables the agent to listen to any message left by the customer when they made their voice call-
back request. The web callback enables the contact center agent to hear a text-to-speech reading of the 
customer’s submitted name. The abandon callback has no option for Branch 1.
If you are migrating from Version 6.0.x to Version 9.0, the Default Outbound Callback subroutines replace 
the voice, web, and abandon Callback Plan’s Routing Rules and Agent options. For guidance as to which 
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activities replace which elements of the callback plans, consult the notes placed throughout the following 
description.
Description
The first step in this subroutine is a Set Variable activity. This activity is configured with the maximum 
number of callback attempts and the interval for the next attempt at making this callback request, enabling 
you to control the frequency and number of times a callback will be offered to agents. The number of 
attempts is added to the callback request’s SQL record, depending upon which Save Callback activity 
reasons are applied to the callback request as it is routed through the subroutine. For information on 
configuring the Set Variable activity, see "Configuring the Set Variables activity".
Next in the subroutine sequence is a Subroutine activity. This subroutine is associated to the Migrated 
Queue Callback Workflow subroutine, which is populated with your pre-7.0 callback configuration. If you 
are not upgrading from a pre-7.0 version of Mi Contact Center Business, this activity can be deleted. For 
information on configuring a subroutine activity, see "Configuring the Subroutine activity".
If this is the Default Abandon Callback Subroutine, the next step is a Queue activity with two branches: 
Agents Greater than 0 and No Agents Available. This activity checks to see if there are any available 
agents in the destination queue. If there are no agents, the subroutine routes down the No Agents Avail-
able branch. This branch contains a Save Callback activity that saves the callback with the reason 
'Requeued - Queue conditions did not pass'. The branch continues to a Hang Up activity that ends the 
subroutine. If the queue has available agents, the subroutine routes down the Agents Greater than 0 
branch. The first activity of this branch is a Save Callback activity that saves the callback with the In Prog-
ress - Dialing agent reason. The branch then continues to a Make Call activity.
If this is the Default Voice or Email Callback Subroutine, the next step of the subroutine is a Save Callback 
activity. This activity saves the callback with the reason In Progress - Dialing agent.
The subroutine continues to a Make Call activity. This submits the callback request to the destination set 
in the <<CallbackDestination>> variable, usually the queue from which the caller made the callback 
request. Calls submitted to the queue remain in the queue for the time set in the Timeout duration property 
before following the Timeout branch. By default, the Timeout duration is set to 30 minutes. For details on 
configuring Make Call activity, see "Configuring the Make Call activity".
NOTE: The destination of the Make Call activity can be changed if there is an alternate destination, other 
than the queue of origin, from which you want to handle callback requests. For information on configuring 
the Make Call activity’s destinations, see "Configuring the Make Call activity".
The Make Call activity has five branches: Success, No Answer, Destination Busy, Invalid Destination, and 
Failure. Branches with a Save Callback Request activity are: No Answer Timeout, Destination Busy, 
Invalid Destination, and Failure.
Callback requests are routed to the No Answer branch when the timeout duration expires, where the Save 
Callback Request activity saves the callback request to SQL with the reason ‘Requeued – Agent did not 
answer’. This enables the outbound ports to re-offer it to the queue. If the destination that the callback 
request was routed to is busy, the callback request is sent to the Destination Busy branch. This branch’s 
Save Callback Request activity saves the callback request to SQL with the reason ‘Requeued – Agent 
was Busy’, which enables the outbound ports to re-offer it to the queue. If the destination in the <<Call-
backDestination>> variable is invalid, the callback request is routed to the Invalid Destination branch. This 
branch’s Save Callback Request saves the callback request to SQL with the reason ‘Completed – Invalid 
Agent Destination’, which prevents the callback from being re-offered to the queue. If there is a failure to 
queue the callback request, the callback request is routed to the Failure branch. This branch’s Save Call-
back Request saves the callback request to SQL with the reason ‘Requeued – PBX connection was lost’, 
which enables the outbound ports to reoffer it to the queue.
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NOTE: If you are migrating from Version 6.0.x to Version 9.0, the Make Call activity’s timeout duration 
corresponds to ‘No answer timeout (secs)’ field from the ‘Agent Options’ tab of the Callback Plans.
If the destination is valid and the callback request does not timeout, the request is routed through the 
Success branch and offered to the queue. The Success branch contains a Save Callback activity, which 
saves the callback with the 'In Progress - Agent' reason.
When the contact center agent answers the callback request, they are connected to the Menu activity in 
the subroutine. In the Voice and Web callback subroutines, the Menu activity plays an instruction prompt 
that tells the agent 'To listen to the caller’s message, press 1. To place this call, press 2. To requeue this 
request, press 3. To reject this request, press 4. To hear these options again, press 5.' In the Abandon 
callback subroutine, the Menu activity plays an instruction prompt that tells the agent 'To place this call, 
press 2. To requeue this request, press 3. To reject this request, press 4. To hear these options again, 
press 5.' The Menu activity has one branch for each menu option, as well as branches for Timeout, No 
Match, and Failure.
NOTE: If you are migrating from Version 6.0.x to Version 7.1+, the Menu activity’s prompts and branches 
correspond to the options in the ‘Digit Menu’ section of the ‘Agent Options’ tab of the Callback Plans.
In the Voice callback subroutine, 1 – Play Customers Message enables the employee handling the call-
back request to listen to the recorded message the customer left. The first activity of 1 – Play Customers 
Message is a Play activity that is configured to play to the agent the .wav file of the message the customer 
recorded with their callback request, stored in the <<CallbackClientRecording>> variable. The next 
activity in this branch is a Go To activity that returns the agent to the start of the Menu activity.
In the Web callback subroutine, 1 – Play Customers Message enables the employee handling the call-
back request to listen to a text-to-speech reading of the customer’s name. The first activity of 1 – Play 
Customers Message is a Play activity that is configured to play a text-to-speech reading of the customer’s 
name. After playing this, the branch continues to a Go To activity that returns the agent to the start of the 
Menu activity.
NOTE: In the Abandon callback subroutine, there is no option for 1 – Play Customers Message.
The 2 – Call the Customer Back enables the employee to callback the customer who made the callback 
request. The first activity in this branch is a Save Callback activity that saves the callback with the 'In Prog-
ress - Establishing connection to client'. The next activity in this branch is a Conference activity that is 
configured to call the number the customer left when making their callback request, stored in the <<Call-
backClientNumber>> variable. This activity has seven branches Success, Client Disconnect, Agent 
Disconnect, Destination Busy, Timeout, Invalid, and Failure.
NOTE: If you are migrating from Version 6.0.x to Version 9.0, the Conference activity’s timeout duration 
corresponds with the ‘No answer client timeout (secs)’ field in the ‘Routing Rules’ tab of the Callback 
Plans.
If the agent’s call is successful, it is routed to the Success branch of the Conference activity where a Play 
activity plays the following message 'Please wait while the call is established.' The agent is then 
connected to the caller. When the agent is finished with the callback, the subroutine continues to a Save 
Callback activity that saves the reason 'Completed', indicating that the request is complete and should no 
longer be offered to the queue.
If the customer hangs up on the callback attempt from the agent, the callback request is routed to the 
Client Disconnect branch of the Conference activity. This branch contains a Play activity that informs the 
agent that the conference has failed and the customer is not available and a Save Callback activity that 
saves the callback request with the reason ‘Requeued – Client did not answer’, which enables the 
outbound ports to be re-offered to the queue. The client disconnect is counted as an attempt for a call-
back, increasing the saved number of attempts for the callback by 1.
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If the agent hangs up on the callback attempt, the callback request is routed to the Agent Disconnect 
branch of the Conference activity. The Agent Disconnect branch contains a Save Callback activity that 
saves the callback request with the reason ‘Requeued – Agent did not answer’. This sets the callback 
request to be requeued to be tried again later and does not count as a callback attempt in the callback 
request’s record.
If the callback request rings on the customer’s phone for the configured Timeout duration, it is routed 
down the Timeout branch of the Conference activity. The Timeout branch contains a Play activity that 
informs the agent that the conference has failed and the customer is not available and a Save Callback 
activity that saves the callback request with the reason ‘Requeued – Client did not answer’. This sets the 
callback request to be requeued again later and does not count as a callback attempt in the callback 
request’s record.
If the customer’s phone is busy, the callback request is routed down the Destination Busy branch of the 
Conference activity. This branch contains a Play activity that informs the agent that the conference has 
failed and the customer is not available and a Save Callback activity saves the callback request with the 
reason ‘Requeued – Client was busy’, which is counted as a callback attempt.
If the callback request included an invalid phone number for the customer, the callback request is routed 
to the Invalid branch of the Conference activity. This branch contains a Play activity that informs the agent 
that the conference has failed and the customer is not available and a Save Callback activity saves the 
callback request with the reason ‘Completed – Invalid Client Destination’, which resolves the callback 
request and ensures it will no longer be offered to the queue.
If a failure occurs, the callback request is routed to the Failure branch of the Conference activity. This 
branch contains a Play activity that informs the agent that the conference has failed and the customer is 
not available and a Save Callback activity saves the callback request with the reason ‘Requeued – Failed 
to connect to agent or queue’, which does not count as a callback attempt.
The 3 - Requeue the Callback branch of the Menu activity requeues the callback request, offering it to the 
queue again after the retry interval duration expires. This branch contains a Save Callback activity that 
saves the callback request with the reason ‘Requeued – By an agent’, which ensures it is re-offered to 
the queue.
The 4 – Reject the Callback branch of the Menu activity rejects the callback and marks it as completed 
so it is no longer offered to the queue. This branch contains a Save Callback activity that saves the call-
back request with the reason ‘Completed – Rejected by agent’, which completes the callback request.
The 5 – Hear the Options Again branch enables the agent to listen to the Menu options again. This branch 
contains a Go To activity that sends the agent back to the start of the Menu activity in the subroutine.
If the agent does not choose an option after 5 seconds, they are routed down the Timeout branch. This 
branch contains a Go To activity that sends the agent back to the start of the Menu activity in the subrou-
tine.
If an agent pushes a number that is not programmed in the menu, they are routed down the Invalid branch. 
This branch contains a Go To activity that routes the agent back to the start of the Menu activity in the 
subroutine.
The Failure branch of the Menu activity contains a Hang Up activity. The agent is routed to this branch if 
the Menu activity times out three times. If the agent is routed to this branch, the callback attempt is deleted 
from the system.
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Default Inbound Voice Callback subroutine

This subroutine workflow is the default workflow for customers in queue to submit voice callbacks. Callers 
who leave queue when presented with the option from the Callback Request activity can use this workflow 
to leave a message and set a time to be contacted later.
NOTE: 
• If you change any of the activities in the workflow, ensure that the prompts used are still accurate and 

reflect the options offered to the callers.
• To further illustrate the workflow’s activity and their operations, we recommend you expand the entire 

workflow and all annotations.
• As of Version 7.0 and greater, this callback subroutine workflow replaces the Voice Callback Plan’s 

Callers Options tab.

To expand the workflow 
• Click the Expand All button.
To show all annotations 
• Right-click the workflow and select Annotations… > Show all.
Description
The first step in the workflow is a Collect Digits activity. This activity prompts callers to enter the phone 
number they would like to be reached at, which the workflow then stores in the <<CallbackClient-
Number>> variable. By default, callers must enter between four and ninety-nine digits and press # as the 
terminating digit, but these defaults may be altered. For information on changing the defaults, see "Config-
uring the Collect Digits activity".
NOTE: 
• If you are migrating from 6.0.x to Version 7.1+, the options in this activity correspond to the General 

options in the Callers Option tab for Voice Callback Plans.
• This activity is mandatory, but another activity that can obtain and store the caller’s number in the Call-

backClientNumber variable could be used instead of collect digits.

The Collect Digits activity has four branches: Phone Number Collected, Timeout, Invalid, and Failure. 
Callers are routed to the Timeout Branch if they do not enter anything after 5 seconds. This branch 
contains a Play activity, whose prompt informs callers that there was no input, and a Go To activity, which 
returns callers to this Collect Digits activity. Callers are routed to the Invalid branch if the phone number 
goes over or under the specified minimum and maximum number of digits. This branch is identical to the 
Timeout branch. Callers are routed to the Failure branch when their timeouts or invalid digit entries 
exceed the set number of Invalid attempts, which by default is 3. The Failure branch contains a Hang Up 
activity that terminates the workflow. For information on configuring Collect Digits activity options, see 
"Configuring the Collect Digits activity".
If a caller successfully enters their phone number, they are routed into the Phone Number Collected 
branch. This branch validates the caller’s phone number against a phone number exclusion list, ensuring 
contact center agents are only handling valid callback requests. The first activity of this branch is a Vari-
able Compare activity, which compares the <<CallbackClientNumber>> variable to a series of conditions 
in the activity’s Invalid Numbers condition. These numbers can be changed and additional numbers can 
be added to the exclusion list. For information on configuring the Variable Compare activity, see "Config-
uring the Variable Compare activity".
NOTE: If you are migrating from 6.0.x to Version 7.1+, the Variable Compare activity and its branches 
correspond to the ‘Exclusion Phone List’ from the ‘Callers Option’ tab for Voice Callback Plans.
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The Variable Compare activity contains two branches: Invalid Numbers and No Match. If the phone 
number collected in <<CallbackClientNumber>> matches any of the conditions of the exclusion list, then 
the caller is routed into the Invalid Numbers branch. This branch contains a Play activity, which informs 
callers they have input an invalid phone number. Next in this branch is a Go To activity, which returns the 
caller to the Collected Digits activity. If the phone number in the <<CallbackClientNumber>> does not 
match anything in the exclusion list, the caller is routed through the No Match branch to the next activity 
in the workflow.
The workflow’s next step is to capture the customer’s preferred date and time for the callback. The work-
flow continues with a Collect Digits activity, which prompts the caller to enter the requested date and time 
for their callback. The format for this is DDMMYYYYTTTTXX, where XX is either ‘26’ for AM or ’76’ for 
PM. IVR Routing will not offer the caller’s callback request to a queue until this date and time.
NOTE: 
• If you are migrating from 6.0.x to Version 7.1+, this activity and its branches correspond to the options 

under ‘Capture Preferred Time’ options in the ‘Callers Option’ tab for Voice Callback Plans. A 12-hour 
date-time format is used exclusively and can only be entered as DDMMYYYYTTTTXX, where XX is 
either ‘26’ for AM or ’76’ for PM.

• This activity and its branches are not mandatory and may be removed from the workflow if you do not 
want to enable callers to specify a date and time for a callback. If no date or time is entered by callers, 
the preferred date time of Now is set on the callback request by IVR Routing.

This activity has four branches: Success, Timeout, Invalid, and Failure. The Timeout and Invalid branches 
are standard Collect Digits branches. Callers are routed to the Timeout Branch if they do not enter 
anything after 12 seconds, while callers are routed to the Invalid branch if they enter too few digits or too 
many digits. Callers are routed to the Failure branch when their timeouts or invalid digit entries exceed 
the set number of Invalid attempts, which by default is 3. The Failure branch contains a Hang Up activity 
that terminates the workflow. For information on modifying the timeout duration of the Collect Digits 
activity, see "Configuring the Collect Digits activity".
If they enter valid digits, the caller is routed to the Success branch, where the Collect Digit activity reads 
back the date and time entered. The branch contains a Date Time Validation activity. This activity vali-
dates the entered date to ensure that the date and time are formatted correctly for use in the Outbound 
Callback workflow. This activity contains three branches: Success, Timeout, and Failure. Callers are 
routed to the Failure branch if the format of the date is not recognized as valid. This branch contains a Go 
To activity that returns the caller to this Collect Digits activity. The Success branch routes callers to the 
next activity in the workflow.
The Success branch contains a Set Variables activity that defines the window of opportunity the system 
has to offer a callback to a caller. By default it is configured to 30 minutes, so if the system is unable to 
contact the customer within 30 minutes of their preferred date and time, it will not try again. The time may 
be customized to match contact center requirements for callbacks. For information on modifying the Set 
Variables activity, see "Configuring the Set Variables activity".
Once the date and time have been saved, the workflow continues to a Record activity, so callers can leave 
a message with their callback request. The Record activity contains three branches: Save, Discard, and 
Review. Discard and Review branches are standard Record activity branches. The Record activity’s Save 
branch contains a Play activity, which informs callers that the recording has been saved. The branch 
continues to a Set Variables activity that links the .wav file to the submitted callback in SQL, ensuring that 
it is available to the agent when they receive this callback request. For information on configuring the 
Record activity and its branches, see "Configuring the Record activity".
NOTE: 
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• If you are migrating from 6.0.x to Version 7.1+, the Record activity and its options correspond to the 
‘Capture Recording’ section from Voice Callback Plans.

• This activity and its branches are not mandatory and may be removed from the workflow if you do not 
want to offer callers the ability to record a message.

The workflow continues with a Menu activity. This activity is the final step in the workflow for the caller, 
requesting that they either confirm or cancel their callback request. The instruction prompt informs the 
caller 'To submit this callback request, Press 1. To cancel this request and exit this system, please press 
the * key.' The Menu activity has five branches: 1. Confirm, *. Cancel, Timeout, No Match, and Failure. 
The Timeout and No Match branches are standard Menu branches with no additional configuration. The 
Failure branch contains no activities and routes callers through to the Save Callback to Requeue Activity, 
the *. Cancel branch, which contains a Play activity informing callers that their callback has been 
cancelled, and a Hang Up activity, which ends the workflow. The Confirm Branch contains no activities 
and routes the callers through to the Save Callback activity.
NOTE: 
• If you are migrating from 6.0.x to Version 7.1+, the Menu activity and its options correspond to the 

‘Capture Confirmation’ section from Voice Callback Plans.
• This activity and its branches are not mandatory and may be removed from the workflow if you do not 

want to offer callers to ability to confirm or cancel their callback request.

The final activity in this workflow is a Save Callback activity. This activity saves the callback request to the 
SQL database with the reason ‘New Request – Voice’, which enables the outbound port to detect it and 
offer it to the queue. This activity contains two branches: Success and Failure. The Success branch 
contains a Play activity that informs the caller that the callback has been submitted and routes the caller 
out of the workflow. The Failure branch has a Play activity that informs callers that the callback request 
submission failed, followed by a Go To activity that returns the callers to the Menu activity to attempt call-
back resubmission.

IVR Routing workflow samples
IVR Routing includes a variety of sample workflows. These workflow samples are based on common busi-
ness scenarios. They not only demonstrate how IVR Routing can be used to efficiently direct calls to 
appropriate queues but, because they can be imported directly into your IVR Routing application, they 
save you the time of creating your own introductory workflows.
The sample workflows create a basis upon which you add elements to fully customize your IVR Routing 
solution. For example, if you want to be able to access a database of customer phone numbers, you will 
need to create the database and make it available to your workflow. Each sample workflow description 
below includes recommendations for workflow configuration optimization.
Generic prompt messages are included for applicable workflow samples.
IVR Routing gives you access to the following sample workflows: 
• Schedule with Mode of Operation and Menu
• ANI and DNIS condition with unique menus and a callback option
• Schedule condition followed by DNIS and Language with Shared Menus
• Outbound workflow with Excel
• Workflow for PCI; Compliant systems
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Some sample workflow contain Menu activities. The Menu activity prompts callers with messages and 
manages routing based on caller input. Besides the options you configure and add in the Menu, there are 
three default branches included in all Menu activities: Timeout, Invalid, and Failure. These branches 
cannot be deleted and function as follows: 
• Timeout: Calls are routed to this option if the caller does not respond to a request within the time limit 

allowed, as configured for the Main Menu in the Properties pane, under Options. A default timeout 
message plays and the caller is returned to the Main Menu. You configure the number of times the call 
is returned to the Main Menu, after failing to respond to a request within the set time limit. If the caller 
exceeds the number of attempts, the call proceeds to the Failure branch.

• Invalid: This branch works similarly to the Timeout branch except that it channels callers that have 
entered invalid response digits. There is a default Invalid number message that plays.

• Failure: Calls are routed to this branch if the maximum Timeout or Invalid attempts are reached. Calls 
that enter the Failure branch are, in most samples, transferred to the Operator. If the Operator is 
unavailable, the call proceeds to the Hang up activity. If you want a message to play in this branch, 
you must configure and add one.

NOTE: After importing the sample workflows and assigning them to ports they will be 'live' in your system. 
Any modifications to the workflows will affect your IVR Routing system. For example, if you put a port into 
Emergency Mode using the Sample Management Plan workflow that port will indeed go into Emergency 
Mode.

Importing IVR Routing sample workflows

In order to have access to the sample workflows you must import them from the folder in which they are 
stored when you download our software.
To import IVR Routing sample workflows
1. Click IVR Routing > Workflows.
2. Click the Import button.

3. Navigate to the .xaml file you want to import and click Open.

NOTE: The sample workflows are located in C:\Program Files (x86)\Mitel\MiContact 
Center\Ivr\Sample Callflows.

4. Click Save.

NOTE: After importing a workflow, you must configure your own prompts and connect the workflow 
to devices that are specific to your system. If the prompts you configure or the connections you make 
to devices are invalid, a red exclamation mark icon displays on the Workflows Canvas indicating a 
validation error. For more information, see "Troubleshooting workflow configuration with the Valida-
tion button".

Associating sample workflows to extensions or hunt groups

After you import a sample IVR Routing workflow, you must associate it to extensions or hunt groups in 
order to make the workflow go 'live' in your system. For more information, see "Associating workflows to 
devices".
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Sample Schedule with Mode of Operation and Menu

This workflow instructs IVR Routing to direct calls that arrive during business hours, in normal conditions, 
to the appropriate queues based on the caller’s selection of menu options. Calls arriving during business 
hours when the contact center is closed due to emergency conditions are routed to an Emergency branch 
where they hear an emergency message explaining why the contact center is closed. Calls arriving 
outside business hours are routed to a Closed branch where they hear a prompt informing them that the 
contact center is closed.
This workflow: 
• Makes customers aware of business hours and channels their calls as applicable
• Enables calls to be routed during emergency closures, for example, in extreme weather conditions
• Routes callers to the appropriate queues, based on customer digit selection

The following figure displays this workflow as it appears when first imported.
Figure 9.9: Schedule with Mode of Operation and Menu

 

Description
The first step in this workflow is an Answer activity. The Answer activity tells the port to answer the call. 
Until this condition is met, the caller hears ringing.
Next in the workflow sequence is the Schedule condition (Mon-Fri, 9-5). There are two branches, Open 
and Closed, each containing activities, within the Schedule. A check is done to confirm that the date and 
time of the call falls within business hours (set as Monday – Friday, 9 AM – 5 PM).
If the call arrives outside of business hours, then the call is routed to the Closed branch, a Closed 
Message plays, and the call proceeds to the Hang up activity. The Hang up activity ends the workflow and 
disconnects the call. If you do not have a Hang up activity, the call will continue through the workflow until 
it reaches the end of all possible actions, at which point it will wait in silence until the port resets.
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If the call arrives within business hours, then the call is routed to the Open branch and the Mode of Oper-
ation activity is confirmed. The system checks if the ports or hunt groups assigned to the workflow are in 
Normal mode or Emergency mode. If they are found to be in Emergency mode, the Emergency Message 
plays and the call is directed to the Hang Up activity. If they are found to be in Normal mode, the call 
proceeds to the Main Menu activity.
The Main Menu activity prompts callers with messages and manages routing based on caller input. In this 
example, the Main Menu activity has been configured with three options and customers are prompted to 
press whichever option suits their needs. IVR Routing then directs the caller to the appropriate queue 
based on the number they pressed.
The three numbered options in the Main Menu activity were added manually to this sample workflow and 
complete the following actions: 
• Option 1: Transfers the caller directly to the Support Queue
• Option 2: Transfers the caller directly to the Sales Queue
• Option 3: Plays the Hours of Operation Message

Options 1 and 2 have a Failure branch. If the transfer destination is unavailable, the caller is routed to the 
Operator. We recommend you set up the Failure branch to redirect calls to a dependable, available 
endpoint.
The last step in this workflow is the Hang Up activity. We recommend you end workflows with a Hang Up 
activity to prevent errant calls from resting at the end of the workflow and tying up the port until it can reset 
and disconnect the call.
Additional configuration required
To get your workflow sample up and running, you must:
Associate the workflow to a port (extension) or a hunt group. See "Associating workflows to devices".
Configure Properties for Transfer Activities. In this sample, the Operator and the Sales and Support queue 
destination information needs to be added. To do this, simply right-click the Transfer activity in the work-
flow and specify the Destination in the Properties pane
Create prompts (messages) as needed. For example, in this workflow, generic prompts are included for 
the Greeting Message, Closed Message, Emergency Message, and Hours of Operation Message. If you 
want to customize these messages, you will need to create your own and add them to the workflow.

Sample ANI and DNIS Condition with unique Menus and a Callback option

This workflow instructs IVR Routing to direct calls to appropriate queues based on the caller’s telephone 
number (ANI), the number the caller dialed to reach the contact center (DNIS), and caller-entered 
responses to menu options. The menu options are unique to each branch, meaning that callers are 
presented with different menu options based on where their call originated or the number they dialed to 
reach the contact center. In addition, the customer is offered the option of requesting a callback rather 
than waiting in queue for an agent. In this example, callers are routed based on their customer status 
(derived from their ANI) or based on the number they called to reach your contact center, either the Enter-
prise Business Level or Entry Level Business Software contact number.
This workflow: 
• Shows you how to channel callers to queues based on the area from which they are calling. This type 

of call routing could be beneficial if, for example, you have a sales promotion that is targeted toward 
particular geographical markets, callers from those areas would be directed to a queue with promo-
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tional RADs and agents who have been trained to sell products specifically related to the current 
promotion. Another useful application for this workflow could be for companies who offer services that 
are specific to a certain area. For example, a flooring installation company with offices in cities across 
the country could direct callers based on the city from which they are calling to agents who book 
in-home flooring consultations.

• Demonstrates how you can set up your IVR Routing system using ANIs to help route customers with 
specific needs to the agents most suited to assist them. In this sample, a VIP customer calls in and is 
recognized as such by their ANI, which you have added to the ANI list. They are automatically trans-
ferred to an experienced agent with advanced customer relation skills.

• Allows you to send callers to queues based on the number they dialed to access your contact center. 
This enables callers to be more accurately routed to the services in which they are most interested. In 
this sample, callers are channeled to either the Enterprise Business Level or Entry Level Business 
Software queue based on the number they called to reach you.

• Gives callers the option of leaving a message and receiving a callback rather than waiting in queue. 
Customer satisfaction is improved when callers are offered this enhanced level of control. In addition, 
the call center operates more smoothly as some calls are diverted during busier periods to be handled 
during less busy hours

The following figure displays this workflow as it appears when first imported.
Figure 9.10: Sample ANI and DNIS Condition with unique Menus and Callback option

 

Description
The first step in this workflow is an Answer activity. The Answer activity tells the port to answer the call. 
Until this condition is met, the caller hears ringing.
Following the Answer activity, is an ANI condition that checks the caller’s phone number. We recommend 
placing the ANI condition near the beginning of the workflow as you can use this activity to initially filter 
calls based on whatever parameters work best for you, for example, you could filter based on VIP status 
or, conversely, based on a list of customers with a heightened need for immediate support, such as those 
with a recent history of dissatisfaction with your product. By filtering these calls based on ANI, you can 
configure the subsequent workflow sequence to channel these calls to queues that are best suited to their 
needs.
Within the ANI condition, there are three branches that evaluate the ANI and branch the call based on the 
results. In this example, the caller is branched, based on ANI, either to the Elevated Support Line branch, 
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VIP Customers branch, or a No Match branch. The Elevated Support Line branch (in this example, used 
for customers that are in need of immediate, skilled support, as they are currently experiencing difficulties 
with your product) and the VIP Customers branch each contain a Failure branch which routes the caller 
to the Operator if the transfer destination is unavailable. We recommend you set up the Failure branch to 
redirect calls to a dependable, available endpoint.
If the ANI is unrecognized (No Match), the system moves on to check the DNIS (the number the customer 
called to reach the contact center).
Within the DNIS condition, there are three branches that evaluate the DNIS and branch the call based on 
the results. In this example, the caller is branched, based on DNIS, either to the Enterprise Business Level 
Menu, the Entry Level Business Software Menu, or a No Match branch.
The Enterprise Business Level Menu prompts callers with messages and manages routing based on 
caller input. In this example, it has been configured with two options and customers are prompted to press 
whichever option suits their needs. IVR Routing then directs the caller to the appropriate queue based on 
the number they pressed.
The two numbered options in the Enterprise Business Level Menu activity were added manually to this 
sample workflow and complete the following actions: 
• Option 1: Transfers the caller directly to the Support Queue
• Option 2: Transfers the caller directly to the Sales Queue

Options 1 and 2 have a Failure branch. If the transfer destination is unavailable, the call goes to the Hang 
Up activity.
The Entry Level Business Software Menu activity prompts callers with messages and manages routing 
based on caller input. In this example, it has been configured with two options and customers are 
prompted to press whichever option suits their needs. IVR Routing then directs the caller to the appro-
priate queue based on the number they pressed.
A Queue Condition has been added to this branch to enable the callback request option. In this case, the 
Queue Condition checks if more than five calls are waiting in queue and if this is the case, the caller is 
offered the option of requesting a callback rather than waiting in queue. You can alter this Queue Condi-
tion as needed.
In the Offer Callback Menu, you configure a message that informs the customer about current call volume 
and wait times, based on the queue condition you set. There is a sample Default Callback Inbound Voice 
subroutine included with IVR Routing. You can either use this subroutine with the Callback Request 
activity or create your own callback subroutine to use with this workflow. For more information about call-
back plans, see "Configuring callbacks".
If the customer declines the request for a callback, the workflow progresses to the Entry Level Business 
Software Menu.
The two numbered options in the Entry Level Business Software Menu were added manually to this 
sample workflow and complete the following actions: 
• Option 1: Transfers the caller directly to the Support Queue
• Option 2: Transfers the caller directly to the Sales Queue

Options 1 and 2 have a Failure branch. If the transfer destination is unavailable, the call goes to the Hang 
Up activity.
If the DNIS is unrecognized, the caller is routed down the No Match branch and, subsequently, the Oper-
ator.
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The last step in this workflow is the Hang Up activity. We recommend you end workflows with a Hang Up 
activity to prevent errant calls from resting at the end of the workflow and tying up the port until it can reset 
and disconnect the call.
Additional configuration required
To get your workflow sample up and running, you must: 
• Associate the workflow to a port (extension) or a hunt group. See "Associating workflows to devices".
• Configure properties for all Transfer activities. For example, the Operator and the Sales and Support 

queue destination information needs to be added. To do this, simply right-click the Transfer activity in 
the workflow and specify the Destination in the Properties pane.

• In addition, for the Callback Request activity, you must designate a Callback Outbound subroutine and 
a destination queue.

• Create prompts (messages) as needed. Generic prompts are included in this workflow but if you want 
to customize these messages, you will need to create your own and add them to the workflow.

Sample Schedule Condition followed by DNIS and Language with Menus

This workflow instructs IVR Routing to direct calls that arrive on standard work days, during business 
hours, to language-specific queues based on the number the caller dialed. Callers are routed to a single 
menu, which presents prompts in the appropriate language.
This workflow enables you to: 
• Configure schedule conditions to route calls based on predefined holidays
• Offer services in more than one language based on the number dialed to reach your contact center
• Use the same Prompt but make it available to all configured languages

The following figure displays this workflow as it appears when first imported.
Figure 9.11: Schedule condition followed by DNIS and Language with Menus

 

Description
The first step in this workflow is an Answer activity. The Answer activity tells the port to answer the call. 
Until this condition is met, the caller hears ringing.
Next in the workflow sequence is the Schedule condition. There are three branches, Holidays, Mon-Fri, 
8-5, and No Match. Placing the Holiday branch on the far-left of the workflow ensures that this branch is 
checked first. If it is determined that the call is being received on a predefined holiday, a Closed Message 
plays and the call proceeds to the Hang Up activity.
NOTE: You must configure the workflow to check whether it is a holiday before checking whether it is within 
business hours. If a call enters the system between 8 AM and 5 PM on a Monday that is a statutory holiday 
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and you check the business hour schedule first, the system will erroneously determine that the call center 
is open and the call will proceed through the workflow, even though your office is closed.
If it is not a holiday, a check is done to confirm if the date and time of the call falls within business hours 
(set as Monday – Friday, 8 AM – 5 PM). If the call arrives within business hours, the call is routed to the 
DNIS check. If the call arrives outside of business hours, it is routed to the No Match branch and a Closed 
Message plays. The call then proceeds to the Hang Up activity. The Hang Up activity ends the workflow 
and disconnects the call. If you do not have a Hang Up activity, the call will continue through the workflow 
until it reaches the end of all possible actions, at which point it will wait in silence until the port resets.
If the call passes the Schedule criteria, it continues to the DNIS activity. This workflow sample contains 
three DNIS, each one representing a different language (French, English, and German, in this case). 
According to the DNIS, the call is routed through the appropriate Language activity to a Menu. The Menu 
is the same for each DNIS and has the same Prompt. The Prompt contains .wav files that are specific to 
each language. Depending on which language activity the call was channeled through, the matching 
language .wav file will play. This enables reuse of the same Prompt regardless of the number of language 
activities that are configured. If there is no DNIS match, the workflows to the No Match branch and is 
transferred to the Operator.
As noted above, the Menu options are the same for each DNIS – only the Language is different. The two 
numbered options in the Menu activity (Main Menu) were added manually to this sample workflow and 
complete the following actions:
• Option 1: Transfers the caller directly to the Support Queue
• Option 2: Plays the Shipping Instructions Message

Option 1 has a Failure branch. If the transfer destination is unavailable, the call goes to the Hang Up 
activity.
The last step in this workflow is the Hang Up activity. We recommend you end workflows with a Hang Up 
activity to prevent errant calls from resting at the end of the workflow and tying up the port until it can reset 
and disconnect the call.
Additional configuration required
To get your workflow sample up and running, you must: 
• Associate the workflow to a port (extension) or a hunt group. See "Associating workflows to devices".
• Configure properties for all Transfer activities. For example, the Support queue destination information 

needs to be added. To do this, simply right-click the Transfer activity in the workflow and specify the 
Properties in the Properties pane.

• Create prompts (messages) as needed. Generic prompts are included in this workflow but if you want 
to customize these messages, you will need to create your own and add them to the workflow.

Sample Outbound with Excel

This workflow queries a data provider, in this case an Excel spreadsheet, to retrieve customer contact 
information. The workflow then uses the contact information to make outbound calls to customers. If a call 
is not answered by the customer or if the line is busy, IVR Routing continues to attempt the call until it is 
connected. If the customer answers the ringing line or the call goes to the customer’s voicemail the work-
flow updates the call status as 'Completed' and the customer will not be called again. Customers who 
answer the outbound call are directed to a menu presenting them with routing options.
This workflow enables: 
• Contact centers to make outbound calls to customers by accessing an internal database
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The following figure displays this workflow as it appears when first imported.
Figure 9.12: Outbound workflow with Excel

 

Description
This sample workflow uses an Excel spreadsheet, called OutboundSample.xlsx. This file is located in the 
IVR\Sample Callflows folder on the Enterprise Server. You populate the Excel sheet with customer phone 
numbers that you access while making outbound calls.
The first step in this workflow is the Schedule condition. There are two branches, Open Hours 9-5 and No 
Match. If calls are executed during business hours, they progress to the Query. If calls are executed 
outside of configured business hours the workflow routes to the No Match branch and then to the Hang 
Up activity.
If during business hours, the workflow progresses to the Query. The Query references the Data Provider 
(in this case, Default Outbound Provider). In this sample, the Data Provider refers to the Excel sheet of 
customer phone numbers that is mentioned above. This Excel sheet has two columns – one for the 
customer’s phone number and one for the customer’s status. The Excel sheet and the Query can be modi-
fied as needed.
The first Query action is to run a Select statement to pull the first number with an 'Incomplete' status to 
call. The Select Query either goes to the Success branch (if it successfully finds/selects a customer phone 
number) or to the Failure branch if no customer phone number is found. When the call enters the Failure 
branch an email is sent to managers advising them that no 'Incomplete' calls remain in the database Excel 
sheet. Access to this functionality requires you to first configure the SMTP Server and the email template 
used for this example.
If an 'Incomplete' status call is selected, the workflow progresses to the Success branch and the Write 
statement executes, which changes the customer’s status from 'Incomplete' to 'In Progress', preventing 
other ports from simultaneously calling the same customer.
When the Query successfully pulls a customer phone number, it proceeds to the Make Call activity. The 
Make Call activity has a destination set for <<LastQueryResult>>, meaning it will dial the phone number 
that the Query pulled from the Excel spreadsheet.
The Make Call activity has several branches. When you successfully connect to a customer, the call goes 
down the Success branch, a query is executed and the customer status is updated to 'Completed', 
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ensuring that number is not called again. Following this action, the customer is presented with two 
options. They can choose to either be transferred to a queue to speak to an agent or listen to a message 
for more information. For example, you could record a message with details about a current sales promo-
tion.
If there is no answer, a Query is executed and the customer status is updated to 'No Answer', meaning 
that when this number is selected from the list the next time, the system will attempt to call it again.
If there is a busy signal (Destination Busy), a Query is executed and the customer status is updated to 
'Busy', meaning that when this number is selected from the list the next time, the system will attempt to 
call it again.
If the number is not in service (Invalid Destination), a Query is executed and the customer status is 
updated to 'Invalid', meaning that when this number is selected from the list the next time, the system will 
not attempt to call it again.
If the Make Call fails due to an issue with the telephone system, an email is sent to the manager(s) 
advising them of the communication failure. Access to this functionality requires you to first configure the 
SMTP Server and the email template used for this example.
The last step in this workflow is the Hang Up activity. We recommend you end workflows with a Hang Up 
activity to prevent errant calls from resting at the end of the workflow and tying up the port until it can reset 
and disconnect the call.
Additional configuration required
To get your workflow sample up and running, you must:
1. Associate the workflow to a port (extension). This workflow type cannot be assigned to a hunt group. 

See "Associating workflows to devices".
2. Configure properties for all Transfer activities. For example, the Transfer to queue destination infor-

mation needs to be added. To do this, simply right-click the Transfer activity in the workflow and 
specify the Properties in the Properties pane

3. Create prompts (messages) as needed. Generic prompts are included in this workflow but if you want 
to customize these messages, you will need to create your own and add them to the workflow.

4. In order to make the workflow active, you must select 'Always Run' in the Properties Pane, under 
Workflow. If you want to end the workflow activity, deselect this option.

5. We recommend adding a queue condition in the Success branch of this workflow so callers are 
directed to the queue only if, for example, a sufficient number of agents are available to take their call 
or the number of calls waiting in the queue is not excessive. Rather than making the caller wait to 
speak to an agent in this situation, it might be preferable to instead play the 'Play more information on 
offer' message.

6. We suggest adding a queue condition following the Schedule condition that sets calling times for the 
optimum times of the day, for example, you might only want to make outbound calls between 3 PM 
and 7 PM. By setting a condition in this way, you can ensure that you have sufficient agents available 
during that time to handle calls.

Workflow for PCI Compliant systems

The PCI Compliant workflow is an example of how contact centers can use IVR Routing to collect sensi-
tive information, such as credit card numbers, from contacts while ensuring their privacy. While handling 
an interaction, agents need the ability to collect sensitive information without being able to interact with 
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that information. The PCI Compliant workflow offers a demonstration workflow configuration that lever-
ages the Hold State activity to enable a contact to enter private information while on call with an agent.
NOTE: The PCI Compliant workflow itself is not PCI compliant but it implements PCI security requirements 
to protect the privacy of collected data. You are responsible for ensuring that your configuration, including 
its associated variables, queries, and web services, meets the standards of PCI Compliance.
In this workflow, the agent dials the port associated with this PCI Compliant workflow, starting a confer-
ence call with the workflow. The workflow puts the agent on hold and prompts the caller to enter their 
private information, which is stored in a masked variable. The information is routed to a Query activity, 
which uses it to perform a query transaction. The agent is then returned from hold and both contact and 
agent are informed via a Play activity if the PCI Compliant transaction was completed correctly. The work-
flow then hangs up, returning the agent and contact to a two party call.
To further illustrate the workflow’s activities and their operations, we recommend you expand the entire 
workflow and all annotations.
To expand the workflow 
• Click the Expand All button.
To expand all annotations 
• Right-click the workflow and select Annotations…>Show All.
Requirements
The workflow provides a framework and as such requires several devices be configured before the work-
flow can be used: 
• Prompts
• Variables
• Data provider
• Extension

This workflow uses a number of prompts. You require the following prompts containing the following 
messages: 
• Agent Notification: A message indicating to caller and agent that the agent is being placed on hold
• Collect Digits instructions: A message indicating to the caller what information they must enter
• Unable to Hold: a message indicating to caller and agent that the system was unable to place the 

agent on hold
• Request is being processed: A message informing the customer that their information has been 

entered and is being processed.
• Successful transaction: A message informing the caller and the agent that the caller’s information 

has been entered and processed correctly
• Failed transaction: A message informing the caller and the agent that the caller’s information was not 

entered correctly

For instructions on configuring prompts, see "Configuring prompts".
You require two variables configured for this workflow: a Secure Information variable and a Validation 
variable. The Secure Information Variable is used to store the private information entered by the caller. 
This variable must be set to FullMask to prevent the collected data from being viewed by others. The Vali-
dation variable is used by a Query activity to store the confirmation that the caller’s information was 
entered correctly and is used by a Variable Compare activity to inform both the caller and the agent that 
the transaction was completed successfully. For instructions on configuring variables, see "Configuring 
variables".
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This workflow requires that you have a data provider added to IVR Routing for use with this workflow’s 
Query activity that contains the information that the caller enters.
For instructions on configuring data providers, see "Configuring data providers".
This workflow also requires you to have a specific transaction that you want to perform using a Query or 
an Execute activity. The workflow includes a Query activity, but you must configure a query relevant to 
your business needs. The Query should use the information entered in the Secure Information variable 
and return any relevant information in other variables, as determined by your transaction’s function. At a 
minimum, the Query activity’s query must be configured to store a value in the Validation variable that will 
be used to confirm to both the agent and the caller that the caller’s private information was entered 
successfully.
The PCI Compliant workflow requires a port with which to be associated, so an agent can dial it while 
handling a caller.
Description
The first activity in this workflow is the Answer activity. The agent and contact are next routed to a Play 
activity. The purpose of this Play activity is to provide a message to the agent that they are being placed 
on hold. This activity should be configured with your ‘Agent Notification’ prompt. For more information, 
see "Configuring the Play activity".
After the workflow answers, the caller and agent are routed to the Hold State activity. This activity places 
the agent on hold for the duration of the Success Branch of the Hold State activity, preventing them from 
hearing the caller’s call as they enter their credit card information. This activity must not be removed or 
modified, otherwise PCI Compliance will be compromised. This activity has two branches: Success and 
Failure. If the agent is successfully placed on hold, the workflow routes down the Success branch. The 
agent remains on hold for the entirety of the Success branch. If the agent is not placed on hold, the work-
flow routes down the Failure branch.
The Failure branch contains a Play activity. The purpose of this Play activity is to provide a message 
informing the agent and caller that the system was unable to place the agent on hold. This activity should 
be configured with your ‘Unable to Hold' prompt. For more information, see "Configuring the Play activity".
The first activity of the Success branch is a Collect Digits activity. This activity, when configured, prompts 
the caller to enter the private information, which is stored in the Secure Information variable. By default, 
this activity has no preset configuration. Under the Variable Collection Settings, set the Variable as the 
Secure Information variable and set the Greeting as the ‘Collect Digits instruction’ prompt. You must also 
set the Minimum and Maximum digits to collect for the caller’s information. This activity can be configured 
with a Confirmation prompt to inform customers that their information has been entered. For more infor-
mation, see "Configuring the Collect Digits activity".
The Collect Digits activity has four branches: Success, Timeout, Invalid, and Failure. Callers are routed 
to the Timeout branch if they do not enter anything after 5 seconds. This branch contains a Play activity, 
whose prompt informs callers that there was no input, and a Go To activity, which returns callers to this 
Collect Digits activity. Callers are routed to the Invalid branch if the caller-entered information goes over 
or under the specified minimum or maximum digits specified during this activity’s configuration. This 
branch is identical to the Timeout branch. Callers are routed to the Failure branch when their timeouts or 
invalid digit entries exceed the set number of Invalid attempts, which by default is 3.
The Success branch contains a Play activity. The purpose of this Play activity is to provide a message 
informing callers that their information is being processed. This activity should be configured with your 
‘Request is being processed’ prompt. For more information, see "Configuring the Play activity".
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The next activity in the Success branch is a Query activity. This activity’s purpose is to query a customer 
database with the information from the Secure Information variable. The Query activity requires a data-
base provider and a Query statement so that the Secure Information variable can be used to retrieve 
confirmation information to populate the Validation variable. For more information on configuring a Query 
activity, see "Configuring the Query activity".
NOTE: 
• Depending on the complexity of your transaction logic you may need to add additional Query or 

Execute activities to complete your transaction and retrieve the desired information.
• This activity can be replaced with an Execute activity if you need to communicate with an external 

source, such as a web service. If executing a web service, ensure that you use HTTP Secure (https). 
The Execute activity must populate your Validation variable. For more information, see "Configuring 
the Execute activity".

The activity next continues to a Variable Compare activity, which should be configured to check if the Vali-
dation variable has the correct value stored. For more information, see "Configuring the Variable 
Compare activity".
The Variable Compare activity has two branches: Successful Transaction Condition and No Match. If the 
variable compare matches your configured conditions, the workflow routes down the Successful Trans-
action Condition branch. This branch contains a Play activity, which should be configured with the 
‘Successful Transaction’ prompt, informing caller and agent that the transaction was completed success-
fully. If the variable does not match your configured conditions, the workflow routes down the No Match 
branch. This branch contains a Play activity, which should be configured with the ‘Failed transaction’ 
prompt, informing caller and agent that the transaction was not completed.
The workflow continues to a Hang Up activity, ending the conference call with the workflow and returning 
the caller and the agent to a two party call.

IVR Routing complex workflow configuration
The following section describes how to configure two intricate workflows. You can use these instructions 
to create the workflows as described or as an educational exercise from which you can learn to build your 
own customized, unique workflows. Before attempting to configure these workflows you must be familiar 
with IVR Routing and able to proficiently configure intermediate to advanced level workflows using IVR 
Routing.
This document shows you how to construct:
• Outbound workflow: An outbound workflow that returns abandoned calls on a priority basis according 

to customer status
• Dial Active Directory workflow: A workflow that uses a LDAP connection to a Windows Active Direc-

tory domain to retrieve phone numbers and transfer the caller to the retrieved extension

Outbound workflow configuration

This example demonstrates how to build an outbound workflow that returns abandoned calls on a priority 
basis according to customer status. This workflow makes use of the delay activity, populates custom vari-
ables with a specific format type, demonstrates enhanced email activity by adding attachments, and 
sends custom variable information to agents via enhanced screen pop.
Consider the following scenario:
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Problem: A busy order desk is having trouble keeping up with customer requests. As a result, they are 
dealing with a high number of abandoned calls. Their customers are sorted into three priority levels: gold, 
silver, and bronze. Gold member callers are considered the highest priority and the order desk is obligated 
to return their calls expediently in order to meet service level agreements. Each day a SQL table is popu-
lated with all of the abandoned calls from the previous day including the customer’s priority levels. All gold 
customers must be called back.
Solution: The following outbound workflow is configured to search for customer numbers based on 
priority level, thus ensuring gold-level customer calls are returned expediently. In addition, customers are 
given options that can expedite call handling, resulting in a more efficient use of agent resources. For 
example, if callers are offered choices, besides the option of connecting with an agent, of being sent a 
PDF of their order status or listening to a message describing their balance and due date, some caller’s 
needs would be satisfied without having to speak to an agent. If callers choose to speak to an agent, 
specific caller information, for example, their status is delivered to the agent via a screen pop display when 
the agent connects to the call.
The following table depicts the final, post-configuration version of the Outbound workflow example 
described here.

Figure 9.13: Outbound workflow
 

Configuring a database provider

The first step in creating this workflow is to determine the source from where you will retrieve the numbers 
to call back. Typically the outbound call list is stored in a SQL database or an Excel spreadsheet. In this 
example, the following table was created in a SQL database. The example SQL database used in this 
sample workflow is named abandoned_caller. (See the following table.)
NOTE: We recommend following standard database design practices when setting up your database. The 
example database referred to in this document is for demonstration purposes only.

Table 9.5: SQL database example for abandoned caller list  (Sheet 1 of 2)

ID [Level] CallerID UserName Balance EMail

100 Gold 3001 Dave 21.32 dave@prairiefyre.c
om

101 Silver 6132221212 James 201.55 james@prairiefyre.
com
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The SQL data types used for this example are shown in the following figure.
Figure 9.14: SQL data types

The columns Processing and Contacted are added to the table to assist with call processing, as follows. 
The outbound workflow executes in an always-run fashion. If there are records present in the database 
and outbound ports are available, calls will be executed constantly. The processing column is used to flag 
a call as in progress. When a call is in progress, it means that the outbound port is currently calling that 
number. After the outbound workflow has completed, the contacted column is set to true. This process 
ensures callers, once contacted, are not called back.
A FailedAttempt column is added to indicate the reason the attempt to call failed, for example, due to No 
Answer, Destination Busy, or Invalid Destination. The following figure displays an example of failed 
attempts as they display in the workflow.

102 Bronze 6135990000 Curtis 30 curtis@prairiefyre.c
om

ID LastBill DueDate Processing Contacted FailedAttempt

100 \\share\bill
s\100bill.d
ocx

April 20, 2012 0 false NULL

101 \\share\bill
s\100bill.d
ocx

September 1, 2012 0 false NULL

102 \\share\bill
s\100bill.d
ocx

Dec 12, 2012 0 false NULL

Table 9.5: SQL database example for abandoned caller list (Continued) (Sheet 2 of 2)

ID [Level] CallerID UserName Balance EMail
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Figure 9.15: Failed attempt example

You must configure a database provider to supply outbound call records to the Outbound workflow. This 
example uses a Microsoft SQL server as a data provider and names the data provider Abandon DB. See 
"Adding a Microsoft SQL server as a data provider".

Creating outbound ports

Outbound workflows and IVR Routing callbacks are both executed by the existing MiContact Center 
Outbound Router Service. Outbound port 5020 IP are used to process outbound workflows and IVR 
Routing callbacks.
Refer to the procedure "Adding extensions" and add the appropriate number of outbound ports. If you 
have any questions regarding the number of ports you require, contact the Systems Engineering Team.

Defining variables

Before creating the workflow, define the variables that it will use. For this example, we have created the 
following variables from the above SQL database example table. Ensure the 'Send to Agent’s Desktop' 
check box is selected if you want customer-relevant database information to be available in a screen pop 
display for agents upon call receipt. (See the following figure.)

Figure 9.16: Suggested variable configuration
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Creating an outbound workflow

Now that you have populated the table in the SQL database with abandoned interaction information, 
added a database provider and outbound ports, and created applicable variables, you can create the 
outbound workflow
To create an outbound workflow 
1. Click IVR Routing > Workflows.
2. Click Add and select Mitel Voice > Outbound as the workflow type from the drop-down list.

3. In the Properties pane, configure the workflow properties as needed. 

NOTE: To make the workflow active, select the Always run check box. When you no longer want the work-
flow to be active, deselect this option.
4. Click Save.

Configuring the outbound workflow for abandoned interactions

The first steps in configuring the outbound workflow for use with abandoned interactions are to add a 
Query activity, a Make Call activity, and a Hang Up activity. The Make Call activity is used to place calls 
to external phone numbers that are typically stored in a data source, such as a SQL database or an Excel 
spreadsheet. The Query activity is used to retrieve the numbers from the database that are then stored 
in a variable which is accessed by the Make Call activity when dialing. The Make Call activity determines 
the location of the media server and provides the correct formatting for the external phone number before 
placing the call. In this example, the query looks for gold-level customers that require a return call.
To configure the outbound workflow for abandoned interactions 
1. Add a Query activity and a Hang Up activity into the Workflows Canvas.
2. Right-click the Query activity and select Edit Database Provider.

3. Select the Abandon DB database provider created earlier.

4. Click OK.

5. Right-click the Query activity and select Edit Query Definition.

6. Under Query type, select Advanced Query and, under Settings, enter the following SQL query(1): 

SELECT top 1 * from dbo.abandoned_caller where level = ‘gold’ and processing = ‘0’ and contacted 
= ‘False’
UPDATE dbo.abandoned_caller set processing = 1 where id in (select top 1 id from dbo.abandoned_-
caller where level = ‘gold’ and processing = ‘0’)

7. On the Variable Assignment tab, assign the appropriate variables to the parameters returned from 
the query(2). 

The following figure displays steps 5-7.
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Figure 9.17: Creating the advanced SQL query

8. In the Success branch of the Query activity, add a Make Call activity. 

See the following figure.
Figure 9.18: Make Call activity

9. Select the Make Call activity and configure the properties in the Properties pane.

10. For this example, beside Destination, select the variable <<OB_CallerID>> and click OK.

11. Select the External Call check box to indicate that these calls are external to the PBX. Outbound 
dialing digits are appended when dialing externally. 

NOTE: Outbound dialing digits must be programmed in YourSite Explorer for the media server upon 
which the outbound ports reside. This is configured in YourSiteMedia serversLocation tab.

Configuring the branches of the Make Call activity

If the query is successful, the outbound number variable will populate. The caller is then offered the option 
to speak with an agent, receive an email with account details, or listen to a message that includes their 
account balance and due date. If the query is unsuccessful, for example, if you are set up to call back 
gold-level callers and there are none available in the SQL database table, the failure branch is followed
In the Success branch of the Make Call activity three actions are performed: Delay, Menu, and Query. 
(See the following figure.)



363

IVR ROUTING COMPLEX WORKFLOW CONFIGURATION
CHAPTER 9 IVR ROUTING

Figure 9.19: Branches of the Make Call activity

To configure the success branch of the Make Call activity 
1. In the Success branch of the Make Call activity, add and configure properties for a Delay activity. 

The Delay action is used to give the customer time to answer the phone and greet the caller. The delay 
value is set in seconds.

2. Following the Delay activity, add a Menu activity.

3. Right-click the Menu activity and add the three digit options as follows: 1. Speak with Agent, 2. Mail 
Last Record, and 3. Listen to balance and due date. 

The customer will be able to select 1 to speak to an agent, 2 to receive an email containing their most 
recent account information, or 3 to hear a message regarding their account balance and due date.
See the following figure.

Figure 9.20: Menu activity options

4. Add a Transfer activity under option 1, an Email activity under option 2, and a Play activity under 
option 3.

5. Configure the Properties for the Transfer activity. Be sure to set the Destination to an ACD path.

6. Configure the Properties for the Email activity. Select the SMTP Server address from the SMTP 
servers that were configured in YourSite Explorer during the software installation process. 

For more information, see "Configuring the SMTP Server".
7. Right-click the Email activity and select Edit Email Template.

8. Right-click in the Configure email template window to see a list of available variables. 

NOTE: To ensure the email is sent to the customer, use the variables that were populated previously 
with the query action.

See the following figure.
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Figure 9.21: Configuring the email template

9. Configure the Properties for the Play activity.

10. Right-click the Play activity and select Greeting prompts > Add a new prompt. 

The Prompt window opens.
You will configure the activity to play two custom .wav files and two prompts. The customer will hear 
their account balance and due date, based on the variables you associate with the prompts.

11. Select the Variables tab. 

See the following figure.
Figure 9.22: Configuring the Play activity

In this example, the OB_Balance variable is set as type ‘Date Time’ and the variable OB_Balance is 
set as type ‘Dollars’. These variables have an associated format type. The variable type ‘Date Time’ 
must be formatted to suit the variable populated from the database query. The available options dis-
play in the following figure.
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Figure 9.23: Date format options

12. Select MMDDYYY as the Date Format for the due date variable (OB_DueDate). 

NOTE: The balance due variable (OB_Balance) can have either Currency Format selected. The currency 
format is only used when writing data to a database.
13. Configure the exception branches, Timeout, Invalid, and Failure, as needed.

14. As a final step in configuring the success branch of the Make Call activity, under the Menu activity, 
add a Query activity. 

This query updates the SQL table to indicate that the call has been completed, ensuring that number 
is not called again.

To configure the failure branch of the Make Call activity 
1. Under No Answer, add and configure a Query activity that updates the customer status in the data-

base to 'No Answer' when the customer does not answer the call. The next time this number is 
selected from the list, the system will attempt to call it again.

2. Under Destination Busy, add and configure a Query activity that updates the customer status in the 
database to 'Destination Busy' when the busy signal is encountered. The next time this number is 
selected from the list, the system will attempt to call it again.

3. Under Invalid Destination, add and configure a Query activity that updates the customer status in 
the database to 'Invalid' when the number called is out of service. The next time this number is 
selected from the list, the system will not attempt to call it.

4. Under Failure, add and configure a Subroutine activity that advises the Administrator when there are 
problems with the workflow. 

Adding this subroutine is recommended in order to help error proof the workflow.

After configuring the outbound workflow, associate it to a port. An outbound workflow cannot be associ-
ated to a hunt group. See "Associating workflows to devices".

Dial Active Directory workflow configuration

This section demonstrates how to build a workflow that uses an LDAP connection to a Windows Active 
Directory domain to retrieve phone numbers and transfer the caller to the retrieved extension.
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This example is composed of a main workflow and a subroutine that contains an LDAP query. The caller 
is presented with a menu that prompts them to enter the extension of the party they wish to reach. If they 
know the extension they can dial it at any time or they can dial by name (by pressing 1) or choose to speak 
to the operator (by pressing 0). When the caller chooses option 1, the workflow is directed to the Dial By 
Active Directory (DialByAD) subroutine. Subroutines are recommended when a call process contains 
many activities or repeating tasks. In this case, the DialByAD subroutine contains several activities. 
Segregating it from the main workflow simplifies the process.
The following figure depicts the final, post-configuration version of the Dial Active Directory workflow.

Figure 9.24: Dial Active Directory workflow
 

The following figure depicts the final, post-configuration version of the DialByAD subroutine.
Figure 9.25: DialByAD subroutine

Preliminary configuration

Before creating the workflow, you must configure the required variables and prompts.
Create the following list of variables along with their associated variable type. (See the following figure.)
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Figure 9.26: Required variables

After creating the variables, configure applicable prompts as shown in the following table.

Creating the main Dial Active Directory workflow

Now that you have created the variables and prompts, you can create the main Dial Active Directory work-
flow. 
1. Click IVR Routing > Workflows.
2. Click Add and select Voice > Inbound as the workflow type from the drop-down list.

3. In the Properties pane, configure the workflow properties as needed.

4. Add an Answer activity and a Hang Up activity onto the Workflows canvas.

5. After the Answer activity, add a Menu activity.

Table 9.6: Required prompts

Prompt Name Script

DialAD – Main Menu Thank you for calling. If you know the extension of the party you wish 
to reach, dial it now. To dial by name, press 1. For operator assistance, 
press 0.

DialAD – Name from 
Dialpad

Using your touchtone keypad, please type the last name of the person 
you wish to reach, followed by the pound (#) sign.

DialAD – Did you mean ...
NOTE: This prompt refer-
ences the variable DAD_-
TempWav created earlier

<DAD_TempWav> If this is the person you want to reach, press 1. If 
not, press star (*).
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6. Click Save.

The next step in creating the Dial Active Directory workflow is configuring the Menu activity.
To configure the Menu activity 
1. Select the Menu activity on the Workflows Canvas and, in the Properties pane, configure the Menu 

properties.
2. Enter an appropriate Name for the menu and add a Prompt to play a greeting message to the caller 

(DialAD – Main Menu, as shown in the following table). 

See the following figure for suggested configuration settings.
Figure 9.27: Main Menu activity properties configuration

3. Right-click the Menu activity and add the three digit options as follows: 1 - Dial by AD, 0 - Operator, 
and Any Characters. 

NOTE: The In Between Digit Delay function allows the system to wait for one second (default value) 
after hearing the first DTMF tone from the caller to see if another digit will be pressed before 
processing the call.

4. In the Properties pane, configure the Menu options. 

NOTE: It is important to give each menu option branch an appropriate name as doing so simplifies 
the troubleshooting process when interpreting log files.

See the following figure.



369

IVR ROUTING COMPLEX WORKFLOW CONFIGURATION
CHAPTER 9 IVR ROUTING

Figure 9.28: Menu option configuration

5. In the 0 – Operator and the Any Characters branches of the menu options, add a Transfer activity.

6. Right-click the Transfer activity that follows 0 – Operator and select Destination.

7. In the Properties pane, after Destination, type the extension that reaches the operator in your orga-
nization.

8. Right-click the Transfer activity that follows Any Characters and select Destination.

9. Configure the Destination as the variable <<LastMenuCollectedDigits>>. 

This sets the entry that is received by the Menu activity as the transfer point.
10. Name the Timeout, Invalid, and Failure branches of the Menu activity according to best practices. 

Use the nomenclature br<PARENT_MENU><OPT>. 

Following this naming convention simplifies the troubleshooting process when searching through log 
files. See the following table for an example of best practice naming conventions.

11. Click Save. 

Now that the main Dial Active Directory workflow has been configured, the DialByAD subroutine must be 
configured and added to the overall workflow.

Configuring the DialByAD subroutine

If the caller knows the last name of the person they are trying to reach, they enter the matching digits in 
their dial pad. The dial pad compare feature is used to support this search function. The first step in being 
able to access this functionality is to collect the digits. This is done via a Collect Digits activity within the 
subroutine.

Table 9.7: Best practice naming convention example

Menu branch Naming convention

Timeout brmnMain1OPTTIME

Invalid brmnMain1OPTINV

Failure brmnMain1OPTFAIL
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To configure the DialByAD subroutine 
1. Click Subroutines > Add > Voice > Inbound.
2. In the Properties pane, after Name, type DialByAD.

3. Add a Collect Digits activity to the subroutine.

4. Select the Collect Digits activity and, in the Properties pane, after Name, type Get Last Name and 
after System Name, type cdGetLastName.

5. Configure the Go To activities in the Timeout and Invalid branches to return to the Get Last Name 
Collect Digits activity. 

See the following figure.
Figure 9.29: Collect Digits activity

6. Name the Success, Timeout, Invalid, and Failure branches according to best practices, as shown 
in the following table. 

7. Right-click the Get Last Name Collect Digits activity and select Edit Variable Settings. 

The Collect Digits settings window opens.
8. Select the appropriate options for each value in the Collect Digits settings window. 

The Variable should be unique to this workflow and be of the Variable Type Number. In this case, 
the variable <<DAD_Ext-Lookup>> is used.

NOTE: This example uses a greeting that asks the caller to enter the last name of the person they 
are trying to reach by using their dial pad and pressing pound (#) when finished. The settings and 
greeting verbiage you choose are dependent on your environment and needs.

9. Click OK.

10. Click Save to save the subroutine.

Table 9.8: Best practice naming convention example

Menu branch Naming convention

Success brcdGetLastNameSUCC

Timeout brcdGetLastNameTIME

Invalid brcdGetLastNameINV

Failure brcdGetLastNameFAIL
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This example performs a lookup based on the last name of the employee in Active Directory. However, 
the procedure can easily be converted to use the first name or a different value altogether. When a caller 
successfully enters digits they are branched down the Success branch in the Collect Digits activity. In the 
Success branch, a Query to Active Directory is inserted to search for the requested employee. Prior to 
this action, a new data provider must be created.

Configuring the LDAP data provider

To configure the LDAP data provider 
1. Click Data providers > Add and select LDAP from the drop-down list.
2. Enter the appropriate settings for the Active Directory domain, including a user with read access.

3. Click Test Connection to attempt to connect to the domain. 

This example connects to a local domain labeled 'PFSE Domain'.
4. Click Save.

Configuring the Active Directory LDAP query

This example queries based on the employee’s last name and returns their extension to which the call is 
then transferred. The Last Name, Display name, and Telephone number fields from the user object in 
Active Directory are accessed. In addition, the objects will return a .wav file so the names can be read 
back to the caller. It is suggested that each employee record their name to use as a customized .wav file. 
In this example, the customized employee name .wav files are stored in the Telephones tab in Active 
Directory. Note that this location must be accessible from the IVR Routing instance performing the query 
and readback. (See the following figure.)

Figure 9.30: Customized .wav file storage in Active Directory
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To configure the Active Directory LDAP query 
1. Add a Query activity to the Success branch of the Get Last Name Collect Digits activity.
2. Select the Query activity and, in the Properties pane, enter an appropriate Name and System Name. 

This example uses 'Get User from AD – PFSE.LOCAL' and 'qrPFSEAD' respectively.
3. Name the Success and Failure branches in adherence with best practices. In this case, Success: 

brqPFSEADSUCC and Failure: brqrPFSEADFAIL.

4. Right-click the Query activity and select Edit Database Provider.

5. In the Select Connection window, choose the appropriate provider. 

This example uses PFSE Domain.
6. Right-click the Query activity and select Edit Query Definition.

7. Under Query Type, select Advanced Query and, under Settings, enter the following query: select 
info,telephoneNumber,CN from 'LDAP://PFSE.LOCAL where objectClass='user' AND sn = 
'@LastName'. 

An advanced query is necessary in this example to enable the return of multiple variables. If there was 
only a need for a single variable, a simple query would suffice.

8. Click Execute.

9. In the Parameters window, select the Value of ‘76’ for @LastName and select the Use Dialpad 
Compare check box. 

The value of ‘76’ is translated into the following when using the dialpad compare feature: p, pn, Po, 
Q, Qm, Qn, Qo, R, Rm, Rn, Ro, S, Sm, Sn, So.

10. Click Run. 

The command runs and the Database Lookup window for the Advanced Query opens.
11. Confirm correct configuration by clicking the Test Results tab and checking the info column to ensure 

the expected result(s) were returned.

12. In the Variable Assignment tab, select appropriate variables for the returned values. 

In this example, CN is used for the common name of the Active Directory object (display name in Ac-
tive Directory) and telephoneNumber for the extension of the user being queried. The information from 
the Telephones tab is also returned as it contains the location of the .wav file to be played. (See the 
following figure.)

Figure 9.31: Variable assignment

13. In the Parameter Assignment tab, select the variable that was populated in the Collect Digits activity, 
‘cdGetLastName’. In this case, DAD_Ext-Lookup. 

Configuring the parameter assignment with a variable replaces the query with the appropriate 
run-time information. (See the following figure.)
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Figure 9.32: Parameter Assignment

Configuring the Success branch of the query

Now that information has been retrieved via the LDAP query, the process loops through the results until 
the correct one is found. The customized employee name .wav file is played and the caller is asked if that 
is the individual they want to reach. Once the correct name is found, the caller is transferred to that desti-
nation and the workflow is terminated.
To configure the Success branch of the query 
1. Add a Menu activity into the Success branch of the Query activity (Get User from AD – 

PFSE.LOCAL).
2. Select the Menu activity and, in the Properties pane, enter appropriate information for the Name and 

System Name. 

This example uses 'Did you mean…?' and 'mnDidYouMeanQ', respectively.
3. Under Prompt, in the Properties pane, select Existing Prompt from the drop-down list and choose 

the prompt called DialAD – Did you mean …

4. Right-click the Menu activity and add a digit option for 1.

5. Name the Menu branches in accordance with best practices, as shown in the following table. 

6. In the Failure branch, add Hang Up activity

7. In the Timeout and Invalid branches, remove the default Play and Go To activities.

8. Removing these activities ensures that if the returned employee extension is not the correct one, the 
parent Query activity will move on to the next result found and offer it to the caller instead.

9. In the Digit option 1 branch, add a Play activity, a Transfer activity, and a Hang Up activity.

10. Name the activities, according to best practices, as shown in the following table. 

Table 9.9: Best practice naming convention example

Menu branch Naming convention

1 brmnDidYouMeanQOPT1

Timeout brmnDidYouMeanQTIME

Invalid brmnDidYouMeanQINV

Failure brmnDidYouMeanQFAIL
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11. Choose an applicable prompt for the Play activity. 

This example uses a prompt called 'DAD – Transferring' that plays a .wav file that says: 'Transferring 
your call now.'

12. Right-click the Transfer activity and select Destination.

13. In the Select a device window, select Variable and choose the appropriate variable assigned in the 
LDAP query.

14. Click Save.

Synchronizing IVR Routing Servers
IVR Routing servers across your enterprise are synchronized so that saved changes made to one or more 
remote servers are automatically applied to other servers. The IVR Sync status column in YourSite 
Explorer enables you to monitor synchronization across servers after saving changes to media servers, 
workflows, and subroutines. Prompts show synchronization status directly on the Prompts page.
All synchronization information displays in real-time. If synchronization is unsuccessful, a message 
displays in all applicable IVR Sync Status columns and in the device page header. Detailed information 
also displays in YourSite Explorer’s RSS feed. For more information on alarms in MiContact Center Busi-
ness, see "Monitoring and alarming subsystem" on page 1. For information on specific alarm messages, 
consult the following Mitel Knowledge Base article: http://micc.mitel.com/kb/KnowledgebaseArti-
cle51286.aspx.
Only one set of pending changes to a specific device can be saved at any time. If another user saves 
changes to the same device you are updating, before you save your changes, you will see the synchro-
nization in YourSite Explorer and will receive an error message when attempting to save your changes. 
In these instances you must refresh YourSite Explorer after the other user’s changes have been saved 
and synchronized. You may then re-enter and save your changes. We recommend you save changes to 
IVR Routing devices frequently, in order to avoid losing work.
Thee following table lists the IVR Routing synchronization states and the corresponding messages in 
each device’s IVR Sync Status column. The same information displays in the device page header.
NOTE: 
• If synchronization does not complete in one minute's time, you receive the synchronization failure 

message as listed in the following table.
• Only media servers running IVR Routing display the IVR Sync Status column.
• Prompts show synchronization status only when you add a new custom .wav file to an existing prompt. 

Otherwise, the synchronization status on the Prompts page displays as 'Sync Completed'.

Table 9.10:Option 1 activity naming example

Activity Name System Name

Play Transferring your call pfTransferring

Transfer Xfr To Extension xfrToExt

Transfer Branch Failure brxfrToExtFAIL

Hang Up Hangup After Transfer hgTransfer
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Configuring IVR Routing for hot fixes
Hot fixes are applied on the Enterprise Server and, if the hot fix applies to client applications, it is then 
distributed to remote clients via the MiContact Center Updater Service.
When you apply a hot fix to a single server configuration of IVR Routing, your extensions will become 
unavailable until the hot fix is complete. If you are running an IVR Routing configuration with one or more 
Remote Servers, however, you can distribute your extensions between your Enterprise Server and 
Remote Servers both before and during the application of the hot fix to minimize the impact on your 
contact center and preserve contact center functionality.
NOTE: You must close all instances of YourSite Explorer before installing a hot fix on the Enterprise 
Server, including instances of YourSite Explorer on Remote Servers. This ensures that Remote Servers 
are updated successfully.
For more information on IVR;Routing’s possible configurations, see "Appendix F".

Applying a hot fix in a single server configuration

When applying a hot fix on a single server configuration of IVR Routing, you download the hot fix and then 
run it.
For more information on single server configurations, see "Resilient Configuration".
CAUTION: While the hot fix is being applied, all active calls in your contact center will be lost. In a single 
server configuration, your IVR Routing extensions will be unavailable during the update process (approx-
imately up to 30 minutes).
To apply a hot fix on a single server configuration of IVR Routing
1. Run the hot fix.

If you have any active calls in queue, you will receive a pop-up warning that they will be dropped 
during the installation.

Table 9.11:Synchronization state and IVR Sync Status messages by device

Synchronization state IVR Sync Status Message Device

No synchronization taking place Sync Completed All

Currently synchronizing Syncing IVRs X/Y Completed
Synching <device name>

Workflow, 
prompt, 
subroutine
Server

All servers are synchronized Sync Completed All

Synchronization failure Failed <device name>
'Sync Incomplete. See the Server page to 
view the Status of Remove Servers.

Server
Workflow, 
prompt, 
subroutine

IVR Routing Service disruption IVR services are stopped or the server is 
offline

All
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2. Follow the installation wizard’s instructions.

Applying a hot fix in a single Remote Server configuration

If IVR Routing is configured with a single Remote Server, you can minimize contact center functionality 
loss while applying a hot fix.
Hot fixes are applied to your Enterprise Server first and then to Remote Servers. By moving extensions 
back and forth between your Enterprise Server and your Remote Server during the update process, you 
can minimize the loss of your contact center functionality by keeping your extensions on the server that 
is not currently being updated with a hot fix. The amount of time it takes to move extensions from your 
Enterprise Server to your Remote Server depends on the distance between your servers and the network 
communication speeds between them.
NOTE: You must close all instances of YourSite Explorer before installing a hot fix on the Enterprise 
Server, including instances of YourSite Explorer on Remote Servers. This ensures that Remote Servers 
are updated successfully.
For more information about single Remote Server configurations, see "Redundant Configuration".
To apply a hot fix on a single Remote Server configuration
CAUTION: Queue statistics will not be available while running the hot fix. If you have any conditions or 
announcements based on Mi Contact Center Business data, these will not function during the hot fix appli-
cation.
1. Run the hot fix.
2. Follow the installation wizard’s instructions.

3. Once the hot fix on the Enterprise Server is complete, click Finish.

4. In YourSite Explorer, disable the This is a remote port check box for the extensions on the Remote 
Server.

The extensions relocate to the Enterprise Server. The hot fix is automatically applied to the Remote 
Server.

5. When the hot fix is finished installing on the Remote Server, in YourSite Explorer, enable the This is 
a remote port check box for each extension that was originally located on the Remote Server before 
applying the hot fix.

6. Click the browse button beside the Remote Server field.

7. Select your Remote Server.

8. Click OK.

The extension will be moved back to your Remote Server.

Applying a Hotfix to a MiContact Center Business in High Availability or 
Upgrading to a Later Release

See the Neverfail documentation and the MiContact Center documentation for detailed instructions on 
how to upgrade.
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The Neverfail procedures are documented in the location: 
https://support.neverfail.com/hc/en-us/articles/115004919367-How-to-Update-Applications-on-a-Trio-of-
Servers-When-Neverfail-Heartbeat-Engine-is-Installed
When a pair of servers are in a high availability environment, the following sequence of events occurs: 
• The secondary MiContact Center Business is made active (which stops the MiContact Center Busi-

ness on the primary) and the Continuity Engine is stopped on both servers.
• The secondary MiContact Center Business is upgraded and stopped.
• The primary MiContact Center Business is made active.
• The primary MiContact Center Business is upgraded.
• The Continuity Engine is started on both servers.

When a trio of servers are in a high availability environment, the following sequence of events occurs: 
• The secondary MiContact Center Business is made active (which stops the MiContact Center Busi-

ness on the primary). The tertiary MiContact Center Business is already stopped and the Continuity 
Engine is stopped on all three servers.

• The secondary MiContact Center Business is upgraded and stopped.
• The tertiary MiContact Center Business is made active.
• The tertiary MiContact Center Business is upgraded and stopped.
• The primary MiContact Center Business is made active.
• The primary MiContact Center Business is upgraded.
• The Continuity Engine is started on all three servers. 

See the MiContact Center Installation and Administration Guide for instructions on upgrading MiCon-
tact Center Business.

When IVR Routing is part of a configuration with multiple Remote Servers, you can apply a hot fix with 
either a partial or minimal loss of contact center functionality during the update. Hot fixes are applied to 
Enterprise Servers first and then to Remote Servers. By moving extensions back and forth between your 
Enterprise Server and your Remote Server during the update process, you can limit or minimize the loss 
of your contact center functionality by keeping your extensions on the server that is not currently being 
updated with a hot fix. The amount of time it takes to move extensions from your Enterprise Server to your 
Remote Server depends on the distance between your servers and the network communication speeds 
between them.
With multiple Remote Servers, this can be a time consuming process. By accepting some loss of contact 
center functionality during the hot fix, you can minimize the time spent configuring and shifting IVR 
Routing’s extensions between your Enterprise Server and your Remote Servers during the update 
process. Alternatively, you can shift all extensions between the Enterprise Server and the Remote 
Servers during the application of the hot fix, losing none of your contact center functionality during the 
application of the hot fix.
NOTE: You must close all instances of YourSite Explorer before installing a hot fix on the Enterprise 
Server, including instances of YourSite Explorer on Remote Servers. This ensures that Remote Servers 
are updated successfully.
For more information about multiple Remote Server configurations, see "High Availability Configuration".
To apply a hot fix to a multiple Remote Server configuration with a partial loss of service 
1. Open YourSite Explorer.
2. Select IVR Routing > Extensions.

https://support.neverfail.com/portal/en/kb/articles/how-to-update-applications-on-a-trio-of-servers-when-neverfail-heartbeat-engine-is-installed
https://support.neverfail.com/portal/en/kb/articles/how-to-update-applications-on-a-trio-of-servers-when-neverfail-heartbeat-engine-is-installed
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3. For each IVR Routing extension on your Enterprise Server, under Port State, enable the This is a 
remote port check box. 

NOTE: For ease of reassigning extensions to their original configuration, it is recommended that you 
note the original configuration of your extensions before re-assigning them between the remote and 
Enterprise Servers.

4. Click the browse button beside the Remote Server field.

5. Select a Remote Server.

6. Click OK. 

The extension moves to your Remote Server.
7. Click Save in the ribbon.

8. Run the hot fix. 

If you have any active calls, you will be warned that they will be dropped during the installation.

Follow the installation wizard’s instructions.
In YourSite Explorer, disable the This is a remote port check box for the extensions on the Remote 
Server that were originally on the Enterprise Server.
The extensions relocate to the Enterprise Server. The hot fix is automatically applied to the Remote 
Server.
CAUTION: When you start applying the hot fix on your Remote Servers, you will lose any current calls to 
your contact center that are using the extensions on your Remote Servers. These IVR Routing extensions 
will remain unavailable during the update process (up to approximately 30 minutes).
Allow the MiContact Center Updater Service to update the Remote Servers.
To apply a hot fix to a multiple Remote Server configuration with a minimal loss of service 
1. Open YourSite Explorer.
2. Select IVR Routing > Extensions.

3. For each IVR Routing extension on your Enterprise Server, under Port State, enable the This is a 
remote port check box. 

NOTE: For ease of reassigning extensions to their original configuration, it is recommended that you 
note the original configuration of your extensions before re-assigning them between the Remote and 
Enterprise Servers.

4. Click the browse button beside the Remote Server field

5. Select a Remote Server. 

NOTE: It is easier to put the Enterprise Server extensions on a single Remote Server but you can 
distribute them amongst your Remote Servers if you choose.

6. Click OK. 

The extension moves to your Remote Server.
7. Click Save in the ribbon.

8. Run the hot fix. 

If you have any active calls, you will be warned that they will be dropped during the installation.
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Follow the installation wizard’s instructions. 
1. In YourSite Explorer, disable the This is a remote port check box for the extensions on the Remote 

Servers. 
The extensions relocate to the Enterprise Server. The hot fix is automatically applied to the Remote 
Server.

2. When the hot fix is finished installing on the Remote Servers, in YourSite Explorer, enable the This 
is a remote port check box for each extension that was originally located on the Remote Server 
before applying the hot fix.

3. Click the browse button beside the Remote Server field.

4. Select your Remote Server.

5. Click OK. 

The extension will be moved back to your Remote Server.
6. Repeat steps 11-14 for the other extensions from the Remote Server until all extensions are returned 

to their original configuration.

Upgrading applications and Reclone Secondary or Tertiary server in Neverfail

To upgrade applications in Neverfail software 
1. From Actions menu, click Upgrade applications. 

NOTE: This activity shuts down the Neverfail Engine.
The Application Upgrade window is displayed, follow the instructions in the window. The “You can 
then upgrade the application…” comment in the window below applies to an upgrade/full install/hotfix.
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To Reclone Secondary or Tertiary server 
1. Login into the Neverfail Engine Management Server (EMS) console and select the Primary server to 

be cloned. Click the Actionsbutton and then click theReclone Secondary or Tertiaryoption in the 
menu. 

NOTE: Please be aware that this first step is essential. If this first step is omitted then we will simply 
end up creating a copy of the Primary server instead of creating a secondary server.

2. Select clone type to be Assisted Cloning.
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3. We now must wait until the Primary server is reconfigured in order to be ready for cloning. This is 
displayed in EMS as below. Please focus on the Operations in progress status and on the Progress 
Bar showing the reconfiguration of the Primary server. When this is completed the Delete button will 
become available. 

4. When the Primary server is ready to be cloned, please launch Windows Server Backup and select 
Local Backup then click Backup Once. 
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5. In the Backup Once Wizard select Different options and click Next.                          

                                               

6. In the next window select Custom. Be sure Not to select “Full server” as this may result in a huge 
backup file. There is no need to include in the backup the data which will be replicated by Engine from 
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Primary to Secondary once the Secondary server is up and running.                           
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7. Click Next and choose Select Items for Backup. Click on Add items.                         
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8. In Select Items, check/enable the Bare metal recovery. This is essential. When you check this 
option then other options will be automatically checked for you: System state, System reserved, and 
all critical volumes which contain operating system files.                   

9. Notice that other driver (like E: in this case) was not automatically selected because this volume does 
not contain OS files. However there is other content on E: which might need to be included, for 
example if there’s a "Program Files" folder because this contains application binaries. When done 
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selecting items, click OK.                                                             
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10. Specify a destination type where the backup file will be saved. In this example we will backup to a 
directory on a network share for convenience. The backup file created on the Primary server can be 
also saved on an external disk too.                                 

NOTE: The network share or the external disk will need to be accessible during the restore on the 
Secondary.
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11. After completing all the steps above, please click Backup. The backup will take some time.         
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                                             And will report as “Completed” when finished.  
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12. Click Close.

 Next steps will be performed on the Secondary server.
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Remember that the Windows Server Install DVD needs to be inserted into the Secondary unit so that the 
Secondary machine will boot from the DVD and not from its local hard-disk. Once booted from the DVD 
you will see the screen below:



393

CONFIGURING IVR ROUTING FOR HOT FIXES
CHAPTER 9 IVR ROUTING

1. Click Next and choose the Repair your computer option.
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2. Click Troubleshoot.



395

CONFIGURING IVR ROUTING FOR HOT FIXES
CHAPTER 9 IVR ROUTING

3. Select System Image Recovery.
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4. Windows is going to search the Secondary server for the backup file to restore, but since the backup 
file is saved on a network share, click Cancel.
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5. Click Next.
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6. Click Advanced.
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7. Choose Search for a system image on the network.

8. Confirm that you want to connect to the network by clicking Yes.
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9. WinPE is bringing up the network here. You'll need a DHCP server.
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10. When the network is up, type the network folder location for the backup file and click OK.
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11. You'll probably need to type in credentials. Click OK.
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12. Select a backup location.
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13. Click Next.
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14. Click on Advanced.
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15. Uncheck/disable the Automatically check and update disk error information option, then click OK 
and click Next.
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16. Click OK and click Next once more.
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17. Click Finish.
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18. Confirm that you sure you want to continue by clicking Yes.
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19. When done, the computer asks for a restart. Click Restart Now.
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20. There will be some PnP action on the pre-login screen because some new devices are discovered 
and installed. Once that's completed, login in Windows by using the same administrator name and 
password as the Primary.
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21. The Neverfail system tray is showing the server as Secondary (S) and Passive (-). 
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22. Run an ipconfig /all command and check to make sure that one Network Adapter is configured with 
the Secondary channel IP address and the other Network Adapter shows an 169.254. IP address. 
This 169.254 IP address is to be expected because the Secondary server is passive.
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23. At this point you can click the Delete button in EMS so that the Primary server is reverted back to its 
normal settings.

24. Now the EMS should be showing the cluster up and running and replicating
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To Reclone Secondary or Tertiary server using automated Vmware.
1. From the Actions menu, select Reclone Secondary Tertiary server. All IPs configured for the 

secondary and tertiary are retained.
2. Select Automated cloning (requires vCenter)and then selectCreate and power-on the DR cloned 

VM automatically after cloning option and follow the instructions, if all the servers are on the same 
VMware.
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3. Click Full cluster reclone.

4. Enter the New locations and Finish.

For Assisted(maual) cloning, when the servers are not on the same VMware. 
1. Select clone type to be Assisted(maual) Cloning. 

NOTE: Assisted(maual) cloning cannot perform a full cluster reclone when a tertiary is configured. It 
clones only one at a time.
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2. If a Tertiary is configured, select Partial cluster reclone (requires Tertiary server)optionand then 
select Secondary. 
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3. Click Next and Enter the locations.

4. Select Finish.

5. When the Secondary clone is complete. Now clone the Primary server manually. Select Reclone 
Secondary or Tertiary server again.

6. Select Assisted(maual) Cloning again but select Partial cluster reclone and select Tertiary this 
time.

7. Select Finish to complete.
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Remote Server installation

A Remote Server, optionally installed at a remote site, performs many of the functions of the Enterprise 
Server without requiring you to install an additional Enterprise Server or upgrade your licensing.
Remote Servers collect and stream ACD/SMDR data from media servers to the Enterprise Server over 
TCP/IP. The Enterprise Server gathers, summarizes, and writes the data to a SQL database for moni-
toring and reporting purposes.
Should the link to the Enterprise Server go down, Remote Servers will buffer ACD/SMDR data until 
communication is restored and the data can be streamed. Note that if the link between the Enterprise 
Server and a Remote Server goes down, the managers and supervisors cannot view real-time data from 
the Remote Server until the connection is restored.
NOTE: 
• You require a Network License to collect data using a Remote Server. For more information, see the 

MiContact Center Business and MiVoice Analytics System Engineering Guide .
• A single Remote Server can collect ACD/SMDR data from up to 65 voice media servers. If attempting 

to collect data from more than 65 PBXs with a single Remote Server, customers can contact their 
approved vendor. Certified channel technicians can contact Mitel Technical Support for guidance.

Using a remote server, you can 
• Create a remote IVR Routing instance. This enables IVR Routing instances to continue to function if 

they lose access to the primary database or site. 
See "Configuring IVR Routing on Remote Servers".

NOTE: If the connection from Remote Servers to the Enterprise Server goes down, loss of real-time 
connectivity affects all workflow components that depend on data derived from real-time queue 
statistics including queue condition activities, Updated Position in Queue (UPiQ) messages, and 
prompts based on real-time statistics.

• Monitor MiContact Center Business services activity and collect data on alarms. 
The Remote Server can monitor its performance and notify the Enterprise Server when server states 
surpass configured alarm thresholds. You configure alarm thresholds and view alarms for Remote 
Servers in YourSite Explorer. For more information on server-side alarms, see "Monitoring and alarm-
ing subsystem".

• View the status of data collection on the Remote Server. 
You can view real-time ACD and SMDR data collection by clicking the Data Link button, located in the 
YourSite Explorer ribbon when a 3300 ICP media server has been selected.

• Display real-time performance statistics and text messages from the Remote Server on LED wall 
signs. 
You can run WallBoarder on Remote Servers to keep agents and employees throughout your contact 
center aware of enterprise-wide statistics and key messages. For more information, see "Configuring 
WallBoarder".

• Provide a software update source for the client computers or other Remote Servers. The Remote 
Servers will be prompted with an update by the MiContact Center Updater following the upgrade of the 
Enterprise Server. The MiContact Center Updater will download the files and place them in a virtual 
directory on the Remote Server. The clients and the other Remote Servers will then update using these 
files from the Remote Server.

This section 
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• Provides an overview of Remote Server installation
• Explains how to install the Remote Server software and modify installed components and features
• Explains how to configure IVR Routing on Remote Servers

The Remote Server installation includes 
• MiContact Center Data Collection Service
• MiContact Center MiTAI Proxy Service
• Remote Routing Services, for IVR Routing
• MiContact Center Wallboard Service
• MiContact Center Updater Service
• CCMWeb
• Contact Center Client
• YourSite Explorer

Overview of Remote Server installation
To install a Remote Server, you 
• Provision a Remote Server at a site and ensure any applicable media servers are configured. 

For more information on configuring media servers, see "Adding media servers".
• Install the Remote Server software. 

See "Installing the Remote Server software".
• Configure IVR Routing on the Remote Server, if desired. 

See "Configuring IVR Routing on Remote servers".
• Verify data is streaming from the Remote Server to the Enterprise Server. 

See "Verifying that ACD and SMDR data is streaming".

Installing the Remote Server software

You install the Remote Server software on a computer other than the Enterprise Server. The computer 
on which you install Remote Server software must meet the appropriate hardware and software require-
ments. See the MiContact Center Business and MiVoice Analytics System Engineering Guide for more 
information.
NOTE: If you have Remote Servers in your enterprise, they are prompted with an update by the MiContact 
Center Updater Service following the upgrade of the Enterprise Server.
To install the Remote Server software 
1. On the client computer, in a supported browser, type http://[your Enterprise Server IP 

address]/CCMWeb.
2. If prompted, type your username and password and click Login.

3. Hover over Help and select Software downloads/Installations.

4. Click Remote Server Pack.

5. Click Run. 

The MiCC Setup wizard opens.
6. Click Remote Server Pack.
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7. If you want to install the Remote Server Pack in an alternate folder, click Browse to select the location. 

The default destination folder is <drive>:\program files (x86)\Mitel\MiContact Center\.
8. Enter the IP address of the Enterprise Server.

9. If you use Secure Socket Layer, select the I want to use SSL check box. 

For more information on planning, deploying, and securing communications with MiContact Center 
Business, please refer to the "SSL Requirements".

10. Select the I want to specify a different Updater source check box and enter the IP address of the 
Remote Server you will use as a source for updating clients instead of the Enterprise Server. 

If you have clients that are connected from a remote site, to reduce traffic across the network, you can 
program these clients to update from a remote server instead of the Enterprise Server.

11. Click Next.

12. Toggle the switches to On or Off to select the features you want to enable on the Remote Server.

13. Click Next. 

The MiCC Set up wizard installs pre-requisite software and, if applicable, displays relevant warnings.
14. Click Next.

15. Enter the username and password that will be used to control Windows services.

16. Click Next. 

The MiCC Set up wizard installs the remote server software and, if applicable, displays relevant warn-
ings.

17. Click Next.

18. Select the appropriate check box to either launch YourSite Explorer now or on system start up.

19. Click Finish.

Modifying Remote Server installed components and features

The MiCC Setup wizard can be rerun at any time to modify the components and feature choices you 
selected during the installation of MiContact Center Business remote server software.
CAUTION: If the MiCC Setup wizard has already been run successfully, re-running it will undo the Remote 
Server configuration settings you previously specified. You must complete the MiCC Setup wizard each 
time you run it or the Remote Server will not function properly.
To modify Remote Server installed components and features 
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Repair Remote Server Pack.

3. Follow the steps as described in "Installing the Remote Server software", ignoring the download 
instructions and modifying components and features as needed during the installation process.
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Uninstalling Remote Server MiContact Center Business software

To uninstall Remote Server software 
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Uninstall Remote Server Pack.

3. When the warning displays, click Yes.

4. Click Finish.

Verifying name changes of remote servers

If you change the name of a remote server, you must perform several configuration steps to verify that 
YourSite Explorer recognizes the name change and points to the renamed remote server as expected.
To verify the name change of a remote server
1. On the Remote Server, after changing the Remote Server’s computer name, start Regedit.
2. Navigate to prairiefyre Software Inc\CCM\Common

The path is \HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\prairieFyreSoftware 
Inc\CCM\Common\ComputerName.

3. Right-click ComputerName and select Modify.

4. Under Value Data, enter the new name of the Remote Server.

5. Click OK.

6. On the Remote Server, start the Contact Center Management Configuration Wizard.

The Remote Server Configuration Wizard opens.
7. Run the Remote Server Configuration Wizard.

8. On the Enterprise Server, open YourSite Explorer.

9. Click Media servers.

Verify that media servers are pointing to the new remote server name.
10. Click Extensions.

Verify that remote ports are pointing to the new remote server name.
11. Click Servers

The renamed server is listed as a new entry. The server with the old name is listed as a separate entry.
12. Select the old server entry.

13. Click Delete.

14. Click OK.

Configuring IVR Routing on Remote Servers

Configuring IVR Routing instances on a Remote Server enables IVR Routing to run independently from 
the Enterprise Server. These IVR Routing servers can continue to function if they lose access to the 
Enterprise Server. IVR Routing servers throughout your enterprise are synchronized so that changes 
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made to one server are applied to other servers in real-time. After making changes to media servers, 
workflows, subroutines, or prompts, you can monitor the synchronization status of IVR Routing instances 
in YourSite Explorer.
Note that, in the rare event of an Enterprise Server outage, loss of real-time connectivity affects all work-
flow components that depend on data derived from real-time queue statistics, for example, queue condi-
tion activities and Updated Position in Queue (UPiQ) messages.
If you are licensed for one instance of IVR Routing only and configure IVR Routing on a Remote Server, 
the Enterprise Server remains available as a backup. If the Remote Server on which IVR Routing is 
configured goes offline and you are licensed for one instance of IVR Routing, you must reassign the IVR 
Routing ports back to the Enterprise Server in order for IVR Routing functionality to continue. See 
"Assigning IVR Routing Remote Server ports to the Enterprise Server".
NOTE: 
• The MiContact Center Inbound Router Service should be left running on the Enterprise Server. Option-

ally, if the Enterprise Server is not intended to use IVR Routing functionality, the Enterprise Server's 
memory usage can be decreased by disabling the following services on the Enterprise Server:
– MiContact Center Inbound Router Service
– MiContact Center Outbound Router Service
– MiContact Center UPiQ Service

• To replicate workflows and media on the IVR Routing Remote Server, we recommend that the Enter-
prise and Remote Servers are on the same domain.

• If the Enterprise and IVR Routing Remote Servers are in a workgroup, ensure that the workgroup 
names are identical, the user name and password for each server are identical, and that the IVR 
Routing instances on each server are running under the same administrative login credentials. To run 
the remote IVR Routing instance under the Enterprise Server's administrative login credentials, see 
"Configuring remote IVR Routing communication with the Enterprise Server".

• If the IVR Routing instance runs PowerShell, Executable Application, or Batch scripts, ensure the 
scripts are on a UNC share.

• You must have access to PowerShell scripts from the domain under which the MiContact Center 
Inbound Router Service is running. For optimal functionality, ensure you have permissions to access 
the UNC share where the PowerShell scripts are located. This is only relevant if you have not disabled 
the MiContact Center Inbound Router Service.

• You must install Excel on every Remote Server in your enterprise if your workflows execute Excel data-
base queries.

To install an IVR Routing instance on a Remote Server
1. Install the Remote Server software on the Remote Server. See "Installing the Remote Server soft-

ware".
2. See the configuration procedures for IVR Routing in "IVR Routing".

When you are configuring extensions, ensure you configure them as remote IVR Routing ports, as 
follows.

3. In YourSite Explorer, click on IVR Routing > Extensions.

4. Select every port you want to assign to the Remote Server.

You can select multiple ports by holding the Shift key.
5. From the Extension type drop-down list, select an extension type to assign to the ports.
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NOTE: If you have a single IVR Routing instance, ensure that your ports are assigned to the same 
server where the IVR instance resides, or you will exceed the licensed number of IVR Routing 
servers assigned to your ports.

6. Select the This is a remote port check box for all ports you want to assign to the Remote Server.

7. After Remote Server click the Browse button.

The Select a computer pane opens.
8. Select the computer that will act as the Remote Server and click OK.

9. On the ribbon, click Save.

Assigning IVR Routing Remote Server ports to the Enterprise Server

If you are licensed for one instance of IVR Routing only and the IVR Routing Remote Server ports go 
offline, the Enterprise Server remains available as a backup. In this case, you must re-assign ports from 
the offline IVR Routing Remote Server back to the Enterprise Server.
NOTE: If you disabled MiContact Center Inbound Router Service, MiContact Center Outbound Router 
Service, and MiContact Center UPiQ Service, you must re-enable them before assigning ports from the 
Remote Server back to the Enterprise Server.
To assign an IVR Routing Remote Server port to the Enterprise Server
1. In YourSite Explorer, click IVR Routing > Extensions and select every port to assign back to the 

Enterprise Server.
You can select multiple ports by holding the Shift key.

2. After Remote Server, click the Browse button.

3. Select the Enterprise Server and click OK.

4. Deselect the This is a remote port check box.

5. On the ribbon, click Save.

The ports are assigned back to the Enterprise Server.

Configuring remote IVR Routing communication with the Enterprise Server

For remote IVR Routing instances to communicate with the Enterprise Server in a workgroup configura-
tion, all remote Routing Services, for IVR Routing, must run under the Enterprise Server’s administrative 
login credentials.
To configure remote IVR Routing communication with the Enterprise Server
1. On the Remote Server, in Windows, navigate to Services.
2. Right-click MiContact Center Inbound Router Service and select Properties.

3. Click the Log On tab and select This account:.

4. After This account, type the administrator account's user name for the workgroup or click Browse to 
search for it.

5. If you click Browse, under Enter the object name to select:, type the user name for the adminis-
trator’s account and click OK.

6. After Password, enter the account’s password.

7. After Confirm password:, re-enter the account’s password.
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8. Click Apply and then click OK.

9. Repeat these steps for each MiContact Center Business Routing Service, for IVR Routing, on the 
Remote Server.
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CTI Developer Toolkit

NOTE: 
• If you require the calculations used to populate reports to use in your custom application built with the 

CTI Developer Toolkit, you can download these applications from Mitel Connect under Downloads > 
MiContact Center.

• In Version 7.0 and greater, the CTI toolkit application uses .NET Framework 4.5. When upgrading from 
a pre-7.0 version, any third-party products that use the CTI Toolkit will need to be recompiled using the 
latest CTI Toolkit dlls.

Mitel Computer Telephony Integration (CTI) Developer Toolkit is a programmable .NET C# Dynamic-link 
library (DLL) that can be used in any .NET Framework 4.5 application or website.
The CTI Developer Toolkit is offered in two forms: server side and client side license. The server side 
license provides the ability to insert custom real-time IVR collected data to each incoming call. It also uses 
the Contact Center Screen Pop infrastructure to deliver third-party data to agents (using either the client 
side license or Contact Center PhoneSet Manager). The client side license provides basic telephony func-
tions (answer, hang up, transfer, and hold), provides agent control (such as set/remove Make Busy) and 
delivers caller information such as ANI, DNIS, Collected Digits, and call notes in real time as calls arrive. 
The client side license may be used to display information in CRM, Microsoft Outlook, or custom applica-
tions.
If you want to route or screen pop on digits or other data sets collected from a third-party IVR, you must 
adhere to the following conditions: 
• You must have a CTI Developer Toolkit Server license
• The third-party vendor must be a Mitel MSA Development partner. As a Mitel MSA Development 

partner, they must have completed a MiTAI (API) integration that allows them to pass the collected 
digits or other data set, along with a unique call ID provided by this API, enabling Mitel's Contact Center 
software to associate the collected digits to a particular call with unique call ID matching.

• If you want to route or screen pop on ANI or DNIS or on digits collected within the Mitel IVR, the above 
are not required.

NOTE: Once you have installed the CTI Developer Toolkit, typically to <installation_drive>:\Program Files 
(x86)\Mitel\CTI Developer Toolkit 8.0.0.0\, you can access the DLLs required to create customized appli-
cations in the CTI Developer Toolkit\Redist folder. You must include the entire Redist folder with your final 
compiled custom application or it will not function properly.
The CTI Developer Toolkit includes a number of sample applications, including source code, that can be 
used to test CTI Developer Toolkit functionality. For a complete overview of the sample applications 
included, see "CTI Developer Toolkit sample applications".
The CTI Developer Toolkit is currently available with the following functionality: 
• Connect and disconnect from the MiContact Center Business Server with user authentication
• Retrieve devices from the MiContact Center Business configuration database, based on all 

– All agent devices for the user currently logged on to the system
– All agent devices associated with employees
– All extensions
– All queues
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• Set real-time monitors on agents, extensions, and queues to receive notification when 
– A call is received (including call detail information)
– A device state changes (for example, idle, ACD, and hold)

• Set phone monitors on agents and extensions to receive notification when 
– A call is received (including call detail notification)
– A call is made
– A call is cleared
– A call is transferred
– A call is conferenced
– A call is established
– A call fails

• Control a device (for example, set/remove Do Not Disturb or Make Busy)
• Make calls from agent or extension devices
• Place calls on hold
• Retrieve calls that are on hold
• Remove calls from queues
• Redirect calls from queues to agents/extensions
• Transfer or conference calls between agent and extension devices
• Clear calls for agent and extension devices
• Add call detail information from third-party IVRs and dialers. This information is available to client appli-

cations in the Call Received event

The following table lists the major areas of functionality exposed with each version of the CTI Developer 
Toolkit. The version specified indicates the most recent version, including any service packs available to 
customers.
Table 11.1:Supported functionality by version  (Sheet 1 of 3)

Functional Area Version 6.0.3 Version 7.0
Version 7.1 / 8.0 / 9.0 / 
9.1/9.2

Application events

Connection state 
changes

x x x

Configuration loaded x x x

Device Information

Get all devices x x x

Get all extension x x x

Get all agents x x x

Get all queues x x x

Get agents by login x x x
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Get agents for all 
employees

x x x

Device events1

Device state changed x x x

Voice events1

Call info received x x x

Call delivered x x x

Call received x x x

Call cleared x x x

Call transferred x x x

Call established x x x

Call failed x x x

Call diverted x x x

Call originated x x x

Call retrieved x x x

Extension events

Extension state 
changed

x x x

Agent events

Agent state changed x x x

Queue events

Queue Now statistics x x x

Queue totals statistics x x x

Interactive Visual 
Queue delta

x x x

Interactive Visual 
Queue snapshots

x x x

Voice control3

Make call x x x

Table 11.1:Supported functionality by version (Continued) (Sheet 2 of 3)

Functional Area Version 6.0.3 Version 7.0
Version 7.1 / 8.0 / 9.0 / 
9.1/9.2
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Clear call x x x

Answer call x x x

Hold call x x x

Retrieve held call x x x

Conference call x x x

Transfer call x x x

Make consultation call x x x

Transfer consultation 
call

x x x

Cancel consultation 
call

x x x

Trade call x x x

Agent control

Login x4 x4 x4

Logout x4 x4 x4

Set Make Busy x x x

Remove Make Busy x x x

Set Do Not Disturb x x x

Remove Do Not 
Disturb

x x x

Cancel Work Timer x x
x

Cancel reseize timer x5 x5 x5

Conference call x x x

Queue control

Redirect call x x x

Remove call x x x

IVR integration

Add call detail6 x x x

Table 11.1:Supported functionality by version (Continued) (Sheet 3 of 3)

Functional Area Version 6.0.3 Version 7.0
Version 7.1 / 8.0 / 9.0 / 
9.1/9.2
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1 Device events are supported by all device types.
2 Voice events are supported by extension and agent devices
3 Voice control is supported by extension and agent devices.
4 Supports External hot desk agent and External hot desk user functionality.
5 The Cancel reseize timer agent control function requires External hot desk agent functionality.
6 The AddCallDetail method requires a CTI Developer Toolkit server license.
NOTE: The CTI Developer Toolkit may also be referred to as the prairieFyre.CallControl.Toolkit name-
space throughout this chapter and in the CHM help file documentation, as the CHM help file included with 
the CTI Developer Toolkit is sourced from the source code, which refers to the namespace by this name.
The following table lists and describes the top level classes available with the CTI Developer Toolkit.
Table 11.2:Primary object classes

Class Description

DeviceManager This class contains functionality to manage the 
connection to the Enterprise Server and provides 
access to configured agents, extensions, and 
queues.

Device This abstract class includes the core properties 
for all device types. Objects of this class may not 
be directly instantiated.

Voice This class is derived from the Device class and 
serves as the base class for the agent and 
extension classes. It includes properties and 
functionality that is specific to devices with voice 
characteristics.

Agent This class is derived from the Voice class. It 
represents both traditional ACD and Hot Desking 
Agents. Specialized functionality handled in this 
class includes agent control operations, such as 
agent login and set/remove Make Busy.

Extension This class is derived from the Voice class. It 
represents configured extensions.

Queue This class is derived from the Device class. It 
represents configured queues. It includes 
properties and functionality that is specific to the 
queue device. Specialized functionality handled 
in this class includes set/remove Do Not Disturb, 
redirect call, and remove call.
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Installing the CTI Developer Toolkit
The CTI Developer Toolkit is included in the MiContact Center Business installation. Refer to the following 
section if you want to download and install the CTI Developer Toolkit before deploying the Enterprise 
Server.
Before installing the CTI Developer Toolkit, ensure 
• The version of the CTI Developer Toolkit you are installing is compatible with the version of the MiCon-

tact Center Business software you are using.
• You have access to the MiContact Center Business Server.
• The MiContact Center Business Server has been properly set up and configured with the extensions, 

agents, and queues that you will be using with your custom application.
• The telephone system(s) in your enterprise has been properly set up and configured with the exten-

sions, agents, and queues that you will be using with your custom application. See the Golden Rules 
documentation located in the Mitel Knowledge Base at: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002335/loc/en_US.

• You have a supported version of Microsoft .NET Framework installed on your workstation. See the 
MiContact Center Business and MiVoice Analytics System Engineering Guide for supported version 
information.

• You have an IDE installed on your workstation, either Visual Studio or SharpDevelop.

To download and install the CTI Developer Toolkit 
1. Log on to the Enterprise Server with a Windows administrator account. 

The account must have full administrative privileges.
2. Ensure all of the Windows programs are closed.

3. Using a web browser browse to http://www.mitel.com.

4. Click Login.

5. Type your Mitel Connect Username and Password and click Login.

6. Click Downloads.

7. Under Title, click MiContact Center.

8. Click the link of version you want to download and the Knowledge Base Article is displayed. Occa-
sionally, due to browser incompatibility, the link will not respond. If this happens, right-click the link 
and select Open in new tab.

9. In the Knowledge Base Article, click the link of version you want to download. 

10.

11. Under Optional Release Components, click CTI Developer Toolkit. 

Occasionally, due to browser incompatibility, the link will not respond. If this happens, right-click the 
link and select Open in new tab.

12. To download your software: 

– Click I Agree [Download using Software Download Manager (Recommended)] to download 
using the Software Download Manager.

– Click I Agree [Download using HTTP] to download using your browser. 
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NOTE: If you click I Disagree, you will be unable to download the software.
13. If you choose to download using the Software Download Manager, select the destination for the down-

load and click Save. When the file finishes downloading, click Launch.

14. If you choose to download using HTTP, depending on the options presented in your browser, select 
whether to Save or Run the installation file. 

– If you saved the file, browse to the downloaded installation file and run it. 
The CTI Developer Toolkit Setup Wizard opens.

– If you ran the file, the CTI Developer Toolkit Setup Wizard opens when the file finishes downloading.

15. Click Browse to select the location to which the install files will be extracted. 

We recommend you do not alter the default path to which the files are extracted.
16. Click Next. 

The End User License Agreement window opens.
17. To continue with the installation, select the I accept the terms in the License Agreement check box 

and click Next. 

The Custom Setup window opens.
18. To change the default location for the primary installation features (Documentation files, Redistribut-

able files, and Sample applications), click Browse, specify a new location, and click OK. 

NOTE: 
– The Sample applications feature, and all sub-features within the Sample applications, can be 

disabled by clicking the disk icon and choosing 'Entire feature will be unavailable'.
– When the default installation location is customized for any of these product features, the new loca-

tion is automatically used by the other product features.

19. Click Next. 

The Ready to install CTI Developer Toolkit window opens.
20. Click Install. 

The CTI Developer Toolkit is installed.
21. When the installation is complete, click Finish. 

Once the installation is complete, you should perform the steps listed below to ensure your develop-
ment environment and the servers you will be using are properly configured.

To verify your environment and servers are configured properly for the CTI Developer Toolkit 
1. Load the DeviceMonitor.sln sample in your IDE and build the application.
2. Run the DeviceMonitor.exe application, verifying the following operations

• Connect to a MiContact Center Business Server.
• Execute the Retrieve All Devices option on the Actions menu and verify that all programmed devices 

are displayed. 
Device level operations, such as SetMonitor, MakeCall, and Login will display a message in the status 
bar indicating the number of devices affected by the operation. Refer to this message and the device 
state image icon displayed next to the device when performing the following tests.

– Select an extension device and perform the following operations 
i. Set Monitor
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ii. Make Call
iii. Clear Call

– Select an agent device that is in the logged out state and perform the following operations 
i. Set Monitor
ii. Login
iii. Set Make Busy
iv. Remove Make Busy
v. Logout

Upgrading the CTI Developer Toolkit
When upgrading from a previous version of the CTI Developer Toolkit to the latest version of the CTI 
Developer Toolkit, we recommend you: 
• Download the latest version of the CTI Developer Toolkit and install it on a development machine.
• Locate the redistributable files under <installation directory>Redist and copy them over the existing 

files in the custom written application.
• Recompile any applications developed on top of the CTI Developer Toolkit and test the applications 

against the latest version of a MiContact Center Business Server to ensure that they behave as 
expected.

NOTE: Any applications being upgraded to current version that use call details, such as a customer screen 
pop application using variables from IVR, must replace the MiTAI call ID parameter with a global call ID. 
AddCallDetail(…) and AddClientCallDetailMonitor_NoDevice(…) in the DeviceManagerClass have been 
made obsolete and have been replaced with API calls that take the MiTAI global call ID instead. Global 
call ID can be obtained from CallReceivedEvent.

CTI Developer Toolkit sample applications
There are currently four sample applications, including source code, that are included with the CTI Devel-
oper Toolkit.
Device Monitor
The Device Monitor sample application provides a graphical user interface that enables developers to 
connect to the MiContact Center Business Server, retrieve a list of devices, perform agent control activi-
ties on the retrieved devices (for example, login/logout, set/remove Make Busy, etc.), perform call control 
activities (for example, make call, answer call, clear call, etc.), and retrieve call event notifications. (See 
the following figure.)

Figure 11.1: Device Monitor sample application
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To use the CTI Developer Toolkit Device Monitor sample application 
1. In Windows, navigate to the CTI Developer Toolkit and open Device Monitor.
2. Click File > Connect.

3. Type the IP address of the Enterprise Server, user name, and password and click OK.

4. Click Devices and select one of the following options: 

– Retrieve agents for current login
– Retrieve agents for all employees
– Retrieve all agents
– Retrieve all extensions
– Retrieve all queues
– Retrieve all devices

5. Once the devices you selected have loaded, you perform actions on the selected device(s) by clicking 
Actions and selecting an available action or by right-clicking and selecting an available action from 
the list: 

– Set monitor > Phone, Real time, All
– Remove monitor > Phone, Real time, All
– Login
– Logout
– Set Make Busy
– Remove Make Busy
– Set DND
– Remove DND
– Cancel Work Timer
– Make call
– Answer call
– Hold call
– Retrieve call
– Transfer call
– Conference call
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– Clear call
– Add call notes 

NOTE: Call notes are supported for inbound calls only.
– Make consultation call
– Transfer consultation call
– Cancel consultation call
– Trade call

Queue Monitor
The Queue Monitor sample application displays the functionality and support for queue device types 
included with the CTI Developer Toolkit. The Queue Monitor application is similar to the optional Interac-
tive Visual Queue monitor that is housed in Contact Center Client. It enables developers to connect to the 
MiContact Center Business Server, load a set of queues, and view real-time call activity (calls entering 
and exiting queues) and queue statistics (for example, calls waiting, number of agents available, longest 
waiting, etc.). (See the following figure.)

Figure 11.2: Queue monitor sample application

To use the CTI Developer Toolkit Queue Monitor sample application 
1. In Windows, navigate to the CTI Developer Toolkit and open Queue Monitor.
2. Click File > Connect.

3. Type the IP address of the Enterprise Server, user name, and password and click OK.

4. Click Actions.

5. Select one or more queues to open.

6. Click OK. 

If you selected multiple queues, you can toggle between them using the tabs at the bottom of the 
queue monitor.

7. Once the queues you selected have loaded, you perform actions on the selected device(s) by clicking 
Actions and selecting an available action or by right-clicking and selecting an available action from 
the list: 

– Open queue
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– Close queue
– Set DND
– Remove DND
– Redirect call
– Remove call

Console Call Monitor
The Console Monitor sample application displays call received information for either single or multiple 
agents or extensions in a simple console application window. It is intended to be a very brief example, 
with little error handling that can be used to demonstrate the basics of coding screen pop displays.
To use the CTI Developer Toolkit ConsoleCallMonitor sample application 
1. In Windows, open the command prompt window.
2. Type cd "<installation_drive>:\Program Files (x86)\Mitel\CTI Developer Toolkit 

8.0.0.0\\Samples\ConsoleCallMonitor\bin" and click Enter.

3. Type ConsoleCallMonitor.exe Device Number/Telephone System IP Address/Type and click 
Enter. 

The ConsoleCallMonitor application takes multiple parameters in the following form, Device Num-
ber/Telephone System IP Address/Type. For example, 2000/10.1.1.1/Agent 1800/10.1.1.10/Exten-
sion would invoke agent 2000 on telephone system 10.1.1.1 and extension 1800 on telephone system 
10.1.1.10.

Console Queue Monitor
The Console Queue Monitor sample application displays information on calls entering/exiting queues and 
queue statistics in a simple console application window. Similar to the Console Call Monitor application, 
it represents a minimal set of code required to build a real-time queue monitoring application.
To use the CTI Developer Toolkit Console Queue Monitor sample application 
1. In Windows, open the command prompt window.
2. Type cd "<installation_drive>:\Program Files (x86)\Mitel\CTI Developer Toolkit 

8.0.0.0\Samples\ConsoleQueueMonitor\bin" and click Enter.

3. Type ConsoleQueueMonitor.exe Queue/Telephone System IP Address and click Enter. 

The ConsoleQueueMonitor application takes multiple parameters, in the following form: Queue/Tele-
phone System IP Address. For example: P200/10.1.1.1 P180/10.1.1.10 would invoke monitoring calls 
on two queues, queue P200 on telephone system 10.1.1.1 and queue P180 on telephone system 
10.1.1.10.

Best practices for custom development
The following best practices must always be followed when developing custom developments to work in 
conjunction with MiContact Center Business software.
• When developing custom applications and integrations 

– Verify that what you are attempting to build is possible by attempting the functions from an alternate 
client application, such as Contact Center Client, the Device Monitor sample application, or MiTAI 
Browser.
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– Routinely check the log files of all related services, specifically the MiContact Center Business, 
MiContact Center Data Collection, and MiContact Center MiTAI Proxy Services to ensure there are 
no unusual or unexpected warnings or errors.

– Routinely check the log files of alternative client applications for any unusual or unexpected warn-
ings or errors (as listed in the previous bullet).

The following best practices must always be followed when developing custom connectors to third-party 
IVRs. 
• Third-party IVR ports and IVR Routing ports must all be programmed in YourSite Explorer as an exten-

sion type > Messaging Port or RAD Port. When configuring the extension as a port type, the disable 
real-time monitoring option will not be configurable.

• In addition to whatever custom data your third-party IVR is sending, it must also send the same data 
that IVR Routing does (using the same naming conventions). These are PFANI, PFCALLERNAME, 
and PFDNIS. This will ensure that the existing MiTAI record linking logic within the Mi Contact Center 
Business Server gets the correct information, which is typically at the first controller/port.

Common user scenarios and source code examples
This section details the following common user scenarios for developing custom integrations and appli-
cations using the CTI Developer Toolkit
• Click to dial
• Call received notification
• Add call detail (using a third-party IVR)

Click to dial

NOTE: This code sample is not included in the sample project that is included with the CTI Developer 
Toolkit.
The following C# code fragment provides sample source code that can be used to build a console appli-
cation with click-to-dial functionality.

static void Main()
{
DeviceManager dm = DeviceManager.Instance;
string pbxIpAddress = "10.1.1.10";
string server = "the-CCM-server-IP-address-here";
string username = "your-username-here";
string password = "your-password-here";
Voice extension;
if (!dm.Connect(server, 5024, username, password))
{
Console.WriteLine("Uable to connect to server");
return;
}
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extension = dm.GetDevice("1100", pbxIpAddress, DeviceType.Extension) as 
Voice;
if (extension == null)
{
Console.WriteLine("Unable to retrieve extension device");
return;
}
if (!extension.SetMonitor())
{
Console.WriteLine("Unable to monitor extension");
return;
}
extension.MakeCall("16135990045");
dm.ReleaseAllDevices();
dm.Disconnect();
Console.WriteLine("Exit application");
}

This source code will connect to the specific Enterprise Server using the supplied username and pass-
word. It then initiates a call from extension 1100 on the telephone system with IP address 10.1.1.10 to the 
phone number 16135990045.

Call received notification

The following C# code fragment shows a condensed version of the source code provided with the 
ConsoleCallMonitor sample application that is shipped with the CTI Developer Toolkit.

static void Main()
{
DeviceManager dm = DeviceManager.Instance;
string pbxIpAddress = "10.1.1.10";
string server = "the-CCM-server-IP-address-here";
string username = "your-username-here";
string password = "your-password-here";
Voice extension;
if (!dm.Connect(server, 5024, username, password))
{
Console.WriteLine("Unable to connect to server");
return;
}
extension = dm.GetDevice("1100", pbxIpAddress, DeviceType.Extension) as 
Voice;
if (extension == null)
{
Console.WriteLine("Unable to retrieve extension device");
return;
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}
if (!extension.SetMonitor())
{
Console.WriteLine("Unable to monitor extension");
return;
}
device.CallInfoReceived += CallInfoReceivedHandler;
Console.WriteLine("Listening for calls on extension 1100");
Console.WriteLine("Press any key to end application.");
while (!Console.KeyAvailable) ;
dm.ReleaseAllDevices();
dm.Disconnect();
Console.WriteLine("Exit application");
}
static void CallInfoReceivedHandler(object sender, 
CallInfoReceivedEventArgs e)
{
Console.WriteLine("-----------------------------------------------");
Console.WriteLine("Call Info Received:");
Console.WriteLine(" Caller Name : " + e.Info.CallerName);
Console.WriteLine(" Caller Number : " + e.Info.CallerNumber);
Console.WriteLine(" DNIS : " + e.Info.DNIS);
Console.WriteLine(" Collected Digits : " + e.Info.CollectedDigits);
}

Add call detail (using a third-party IVR)

The following C# code fragment shows a condensed version of using the AddCallDetail method so toolkit 
users can invoke to add custom key/value pairs into call information.
In summary, this code fragment does the following: 
• Device_CallReceived is an event handler that is invoked whenever a monitored IVR extension/port 

receives a call. This is needed to acquire the MiTAI Call ID which is used to link these extra information 
records (--w records in ACD data files) to other call records.

• When this event handler is invoked, it makes three sequential calls to the AddCallDetail method, 
adding call values for the following keys: PFANI, PFCALLERNAME, and PFDNIS.

• The keys used above are the ones that the default screen pop display recognizes but developers can 
easily make up their own key names as well, provided they have toolkit code on the client side to pull 
the custom information from the CallInfoReceivedEvent notifications.

public void Device_CallReceived(object sender, CallReceivedEventArgs e)
{
Device device = sender as Device;
DeviceManager.Instance.AddCallDetail(
e.CallingDevice.CallReferenceID, device.PBXIPAddress, device.DeviceID,
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"PFANI", "6135990045");
DeviceManager.Instance.AddCallDetail(
e.CallingDevice.CallReferenceID, device.PBXIPAddress, device.DeviceID,
"PFCALLERNAME", "John Smith");
DeviceManager.Instance.AddCallDetail(
e.CallingDevice.CallReferenceID, device.PBXIPAddress, device.DeviceID,
"PFDNIS", "8001");
}

Troubleshooting CTI Developer Toolkit issues
Diagnosing any issues experienced while using the CTI Developer Toolkit requires a high level of famil-
iarity with MiContact Center Business and MiVoice Analytics applications and CTI Developer Toolkit func-
tionality. This section details several troubleshooting tips and tricks when encountering issues with CTI 
Developer Toolkit functionality.
The CTI Developer Toolkit and any custom applications created using it rely heavily on the proper config-
uration and operation of the MiContact Center Business Server. Ensuring that the server is operating 
correctly is the first diagnostic step that should be taken when troubleshooting CTI Developer Toolkit 
issues. This includes: 
• Verifying that the CTI Developer Toolkit and MiContact Center Business software are compatible and 

that you are properly licensed for the desired functionality.
• Verifying that all MiContact Center Business software pre-installation and post installation steps have 

been completed.
• Checking the log files of all related services, specifically the MiContact Center Business, MiContact 

Center Data Collection, and MiContact Center MiTAI Proxy Services to ensure there are no unusual 
or unexpected warnings or errors.

• Attempting the same operation using an alternate client application. This can be any of the following, 
depending on the underlying issue: 
– Contact Center Client
– Device Monitor sample application
– MiTAI Browser

• Checking the log files of alternative client applications for any unusual or unexpected warnings or 
errors (as listed in the previous step).

• Confirming the telephone system conforms to the guidelines stated in the Golden Rules document. In 
particular, aspects of the CTI Developer Toolkit rely on the ability to set MiTAI monitors on devices. As 
such, the 'HCI Options' must be enabled for the Class of Service on all monitored devices. For more 
information, refer to the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002335/loc/en_US.

Troubleshooting specific issues

This section describes some specific problems that may be encountered when working with the CTI 
Developer Toolkit and provides any recommended steps for diagnosing issues and potential solutions.

http://micc.mitel.com/kb/TroubleshooterGuide50560.aspx
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Retrieve All commands does not display any devices

If any of the Retrieve All commands in the Device Monitor application return an empty list of devices, there 
may be a configuration problem with the IPAddress values stored in the CCMData database table named 
tblEnterpriseConfig_Node.
To troubleshoot this issue, run the following SQL query and pay particular attention to values in the [IP 
Address] column. This query simulates the query used by the CTI Developer Toolkit and will return a list 
of agents and extensions for all voice media servers.
SELECT node.Name AS [Node],
node.IPAddress AS [IP Address],
'Agent' AS [Type],
device.FirstName AS [First Name],
device.LastName AS [Last Name],
device.Reporting AS [Reporting Number]
FROM tblConfig_Agent device INNER JOIN tblEnterpriseConfig_Node node
ON device.FKNode = node.Pkey INNER JOIN tblLookup_NodeType NodeType
ON node.FKNodeType = NodeType.Pkey
WHERE FKNodeFamily = 1
UNION
SELECT
node.Name AS [Node],
node.IPAddress AS [IP Address],
'Extension' AS [Type],
'' AS [First Name], -- No first name on extensions
'' AS [Last Name], -- No last name on extensions
device.Reporting AS [Reporting Number]
FROM tblConfig_Extension device INNER JOIN tblEnterpriseConfig_Node node
ON device.FKNode = node.Pkey INNER JOIN tblLookup_NodeType NodeType
ON node.FKNodeType = NodeType.Pkey
WHERE FKNodeFamily = 1
ORDER BY [Node], [Type]
The [IP Address] values in the query results should contain the IP address of the telephone system that 
is associated with the voice media server. If this value is incorrect or blank, use YourSite Explorer to set 
the IP address to the correct value.

GetDevice method fails or returns null unexpectedly

If a custom applications calls the GetDevice method and returns null even though the device is valid and 
programmed in MiContact Center Business, there may be a timing issue with the Connect operation. 
When a custom application calls the Connect method in the CTI Developer Toolkit, the operation returns 
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as soon as an authenticated connection has been established with the Enterprise Server. However, there 
may still be some basic configuration loading occurring in the background, which must complete before 
calls to GetDevice can be successful.
An event named ConfigurationLoaded is provided in the CTI Developer Toolkit, which is used to notify 
custom applications that background configuration loading has completed. In previous versions, the 
Device Monitor sample application used a workaround method of issuing aSleep method call on the active 
thread to give background configuration loading time to complete.

Agent control actions succeed while call control actions fail

In this scenario, agent control actions (for example, login, logout, and set/remove Make Busy) succeed, 
while call control actions (for example, make call, answer call, and clear call) fail. The key difference 
between these two types of operations is that call control actions require a MiTAI monitor set on the device 
and agent control actions do not. Your investigation should start with an analysis of MiTAI related config-
uration, including:
• Verifying that the MitaiEnabled flag set properly for devices in the database
• Checking telephone system (for example, HCI Options enabled)
• Confirming the telephone system version is supported

Unable to set monitor on agent device

In some cases, using the Device Monitor to issue a Set Monitor operation on an agent will fail. If you have 
the Errors view open in the application, it displays a MiTAI error, indicating 'Operation failed: Messag-
eTag[8] ReturnCode [SXERR_FEATURE_NOT_ALLOWED]'
In this case, you should verify that the agent device is properly configured on the telephone system, 
including HCI Options enabled for the associated Class Of Service.

Web service errors occurring in log files

If you encounter Web service error messages in log files and an application built with the CTI Developer 
Toolkit is experiencing errors, check to ensure that the Microsoft.Web.Services3.dll file is present under 
the Windows system directory or in the custom application directory.
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Client installation

The first time you install MiContact Center Business, you must go to each client computer to install the 
client software. After the initial installation, the MiContact Center Updater Service will perform updates on 
client computers each time the Enterprise Server is updated.
Client software can also be installed silently. Refer to the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000648/loc/en_US.
If you are performing a client installation where connectivity to the Enterprise Server is not available, you 
must follow the instructions for a silent installation. See the following Mitel Knowledgebase article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000648/loc/en_US.
NOTE: 
• The date format for MiContact Center Business is tied to the regional settings on your client computer. 

For example, if you configure your computer to display the date as mm/dd/yyyy, when you browse to 
the MiContact Center Business Web UI the MiContact Center Businessapplications display the date 
as mm/dd/yyyy.

• The system administrator must provide all MiContact Center Business users with a user name and 
password.

• After an upgrade is performed on the Enterprise Server, any clients that use the MiVoice Border 
Gateway Connector to connect to the Enterprise Server should close MiVoice Border Gateway 
Connector to allow pending updates to be applied. Once the MiVoice Border Gateway Connector has 
been updated, it can be restarted.

• Launching client-side applications from the taskbar causes them to bypass the MiContact Center 
Updater Service process. To ensure successful updates from the Enterprise Server, after an upgrade 
close all client-side applications for 15 minutes or reopen them from the Start menu.

• We recommend you install the Client Component Pack on computers used to run and view reports. 
Without the Client Component Pack installed, users may experience errors caused by permissions or 
network security. These issues are outside the scope of Mitel Technical Support.

• We recommend using Adobe Reader to view documents and reports in .pdf format and to view online 
user guides and reports.

Client roles
MiContact Center Business client installation includes the Client Role Selector. It is an installation wizard 
that installs and enables the applications and components typically used by the following employee roles: 
• Supervisor 

The Supervisor role is designed for supervisors and managers who monitor devices (for example 
agents and queues) and schedule agents.

• Agent 
The Agent role is designed for agents who monitor themselves and, possibly, other agents and 
queues.

• Administrator 
The Administrator role is designed for employees who manage the Enterprise Server.

• Custom 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000648/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000648/loc/en_US
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The Custom role is designed for employees who may perform the functions of a supervisor, agent, 
and administrator and requires the use of a variety of applications.

After installing the Client Component Pack, you can re-run the MiCC Setup wizard on a client computer 
at any time to change the components and applications installed on the client computer. See "modifying 
available client applications and client roles".
The following table lists the components and applications available for installation with each client role 
installation.
NOTE: 
• If you want to customize the client installation, select Custom. For example, if a supervisor also 

performs administrative functions, select the Custom role and choose the components and applica-
tions the supervisor requires.

• The applications that display in the Client Component Pack installation are dependent on licensing.

Accessibility to components and applications is dependent on your licensing package. For more informa-
tion, see the licensing section in the MiContact Center Business and MiVoice Analytics System Engi-
neering Guide.
*Ignite is available as either a desktop or Web version. In our documentation, we refer to desktop Ignite 
and its features as Ignite (DESKTOP) and Web Ignite and its features as Ignite (WEB) or, where appro-
priate, as DESKTOP or WEB only.

Before running the client installation
Before running the client installation, read and adhere to the following notes: 

Table 12.1:Client role installations

Components 
/applications Supervisor Agent Administrator custom

Ignite* x x x

Contact Center 
Client

x x x x

Flexible Reporting x x

Contact Center 
Softphone

x x x

 MiVoice Border 
Gateway 
Connector

x x x

Workforce 
Scheduling

x x

YourSite Explorer x x

Employee Portal x x x x
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• Verify the hardware and software requirements for running MiContact Center Business on client 
computers, as detailed in the MiContact Center Business and MiVoice Analytics System Engineering 
Guide.

• To view reports, Microsoft Excel 2010+ or greater is required on all client computers. As a minimum, 
you may install Microsoft Excel Viewer, but clients will be unable to take advantage of distributing 
reports for printing. You can download Excel Viewer for free from Microsoft: http://www.micro-
soft.com/en-us/download/default.aspx. 

NOTE: Protected View is a Microsoft Office security feature that can impact the ability to view Excel reports 
in MiContact Center Business. If you use Excel 2010 to view reports, configure the following in Excel: 

– Ensure the following Protected View options are not enabled: 
• Enable Protected View for files originating from the Internet
• Enable Protected View for files located in potentially unsafe locations
• Enable Protected View for Outlook attachments
• Enable Data Execution Prevention mode

– Ensure that the following Trusted Location option is selected: 
• Allow Trusted Locations on my network (not recommended)

• Some group policy settings can disrupt the installation and upgrading process for client computers. We 
recommend all clients be configured with Local Administrators permission to install the Client Compo-
nent Pack.

• Ensure antivirus software is disabled before installing the Client Component Pack.

Client installation process
To set up MiContact Center Business, on the client computer 
1. Install prerequisite software. 

See "Before running the client installation".
2. Install Client Component Pack and client applications. 

See "Installing the Client Component Pack and client applications".

Installing the Client Component Pack and client applications

When you install Client Component Pack, you select the applications that will be installed on the client 
computer based on client roles. For more information on client roles, see "Client roles".
To install Client Component Pack 
1. On the client computer, in a supported browser, type http://[your Enterprise Server IP 

address]/CCMWeb.
2. If prompted, type your username and password and click Login.

3. Hover over Help and select Software downloads/Installations.

4. Click Client Component Pack.

5. Click Run. 

The MiCC Setup wizard displays.
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6. Click Client Component Pack.

7. If you want to install the Client Component Pack files in an alternate folder, click Browse to select the 
location. 

The default destination folder is <drive>:\program files (x86)\Mitel\MiContact Center\.
8. Enter the IP address of the Enterprise Server.

9. If you use Secure Socket Layer, select the I want to use SSL check box. 

For more information on planning, deploying, and securing communications with MiVoice Analytics, 
please refer to the MiContact Center Business and MiVoice Analytics System Engineering Guide.

NOTE: If you have previously installed the client with SSL disabled and now need to connect using the 
SSL, you have to launch the MiCC Setup from the Windows Start Menu and Repair Client Component 
Pack, then provide the new Enterprise address and SSL settings. Alternatively, download a new copy of 
the Client Component Pack from the CCMWeb.
10. Select the I want to specify a different Updater source check box and enter your Remote Server 

IP address if you want the Remote Server to act as the source for updating clients instead of the Enter-
prise Server. 

If you have clients that are connected from a remote site, to reduce traffic across the network, you can 
program these clients to update from a remote server instead of the Enterprise Server. Ignore this step 
if you do not have remote servers.

NOTE: Changes that result from selecting this option will be active when you upgrade to the next fix 
pack or full release.

11. Click Next.

12. If you want to install applications based on client roles, from the drop-down list beside Optional 
Template Role, select the appropriate client role. Otherwise, toggle the switches to On or Off to 
select the applications you want to install. 

– Supervisor—The Supervisor role installation is designed for supervisors and managers who 
monitor devices (for example agents and queues), run reports, and schedule agents.

– Agent—The Agent role installation is designed for agents who monitor themselves and, possibly, 
other agents and queues.

– Administrator—The Administrator role installation is designed for employees who manage the 
Enterprise Server.

– Custom—The Custom role installation is designed for employees who may perform the functions of 
a supervisor, agent, and administrator, and enables you to select any or all of the displayed applica-
tions for installation.

NOTE: Applications toggle on and off based on the role selected. For example, an agent does not 
typically access YourSite Explorer, so when you select Agent as a role, the YourSite Explorer toggle 
switches to Off, indicating that with an Agent role selected, YourSite Explorer will not be installed on 
the client computer. Selectable options depend on your licensing.

13. Click Next. 

The MiCC Setup wizard installs pre-requisite software and, if applicable, displays relevant warnings.
14. Click Next. 

The MiCC Setup wizard installs your selected applications.
15. Select the appropriate check box to either launch Contact Center Client now or on system start up.
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16. Click Finish.

Modifying available client applications and client roles

Client applications are installed and client roles are defined during the Client Component Pack installa-
tion. Modifications can be made at any time by re-running the Client Component Pack installation via the 
MiCC Setup wizard.
NOTE: If you have previously installed the client with SSL disabled and now need to connect using the 
SSL, you have to launch MiCC Setup from the Windows Start Menu and Repair Client Component 
Pack, then provide the new Enterprise address and SSL setting. Alternatively, download a new copy of 
the Client Component Pack from the CCMWeb.
To modify installed applications and client role selection 
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Repair Client Component Pack.

3. If you want to install the Client Component Pack files in an alternate folder, you must uninstall and 
reinstall the Client Component Pack. See "Uninstalling the Client Component Pack".

4. Enter the IP address of the Enterprise Server.

5. If you use Secure Socket Layer, select the I want to use SSL check box. 

For more information on planning, deploying, and securing communications with MiContact Center 
Business, please refer to the MiContact Center Business and MiVoice Analytics System Engineering 
Guide.

6. Select the I want to specify a different Updater source check box and enter your Remote Server 
IP address if you want the Remote Server to act as the source for updating clients instead of the Enter-
prise Server. 

If you have clients that are connected from a remote site, to reduce traffic across the network, you can 
program these clients to update from a remote server instead of the Enterprise Server. Ignore this step 
if you do not have remote servers.

7. Click Next.

8. If you want to install applications based on client roles, from the drop-down list beside Optional 
Template Role, select the appropriate client role. Otherwise, toggle the switches to On or Off to 
select the applications you want to install. 

– Supervisor—The Supervisor role installation is designed for supervisors and managers who 
monitor devices (for example agents and queues), run reports, and schedule agents.

– Agent—The Agent role installation is designed for agents who monitor themselves and, possibly, 
other agents and queues.

– Administrator—The Administrator role installation is designed for employees who manage the 
Enterprise Server.

– Custom—The Custom role installation is designed for employees who may perform the functions of 
a supervisor, agent, and administrator, and enables you to select any or all of the displayed applica-
tions for installation.

NOTE: Applications toggle on and off based on the role selected. For example, an agent does not 
typically access YourSite Explorer, so when you select Agent as a role, the YourSite Explorer toggle 
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switches to Off, indicating that with an Agent role selected, YourSiteExplorer will not be installed on 
the client computer. Selectable options depend on your licensing.

9. Click Next. 

The MiCC Setup wizard installs pre-requisite software and, if applicable, displays relevant warnings.
10. Click Next. 

The MiCC Setup wizard installs your selected applications.
11. Select the appropriate check box to either launch Contact Center Client now or on system start up.

12. Click Finish.

Uninstalling the Client Component Pack

The Client Component Pack can be uninstalled from a client computer using the MiCC Setup wizard.
To uninstall the Client Component Pack and previously installed applications
1. In Windows, open the Mitel program folder and launch MiCC Setup.
2. Click Uninstall Client Component Pack.

3. When the warning displays, if you want to continue, click Yes to uninstall the product.

4. Select the check box beside I want to remove MiContact Center data.

You are given options to remove all backup and/or log files. You may choose to retain either or both 
of these file types in order to reduce configuration time for your next deployment.

5. Click Next.

The MiCC setup wizard uninstalls the Client Component Pack and all associated installed applica-
tions.

6. Click Finish.
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Client configuration

This section focuses on client-specific configuration procedures, including: 
• Agent and agent group presence settings and best practices
• Ring group presence settings
• Soft phone setup
• Whisper Coach settings
• MiCollab Client and Ignite integration pre-installation notes and recommendations
• MiVoice Border Gateway setup to support remote agents and employees

Configuring agent and agent group presence settings
Agents can be assigned to multiple agent groups, which are associated with different queues. When 
agent groups are created, an employee’s agents are assigned a default group presence, either Present 
or Absent. Employees whose agents’ default presence is Absent, in all agent groups, will be set in the 
Logged In Not Present state when they log in to the system. To handle interactions the employees can 
make themselves present in their agent groups using either Contact Center Client or Ignite. Employees 
whose agents' default presence is Present are put in an Idle state when they log in and are able to receive 
interactions.
The Mitel 3300 ICP enables agents to be placed in or removed from multiple agent groups (up to 16 on 
the Mitel 3300 MXe II Controller and up to 30 on the Mitel 3300 MXe server). Agents can be added and 
removed from agent groups using Feature Access Codes (FAC), a Feature Access Key (FAK) 
programmed on their set, or using Interactive Contact Center or Ignite.
The agent group presence option is controlled by Class of Service. Once the appropriate Class of Service 
has been set, the agent group presence status can be changed in the following ways. 
• Feature Access Keys can be programmed on a Mitel multiline phone set. One button would be used 

to join or leave each agent group to which the agent is a member.
• Supervisors and agents can dial a feature access code followed by the group number to change their 

status for that group or to change their status for all groups to which they are a member.
• The desktop tool in the embedded system management can be used to make status changes.
• MiTAI controls are also available to make status changes.

Agent Group Presence has several licensing and configuration prerequisites: 
• For agents to use Agent Group Presence, Group Presence Control must be enabled for all agents on 

the Class of Service Options Assignment form on the Mitel 3300 ICP.
• For supervisors or system administrators to use Agent Group Presence, they must log into Contact 

Center Client as a non-administrative user. They also require a valid employee licenseand an associ-
ated device with Group Presence Control and Group Presence Third Party Control enabled on the 
Class of Service Options Assignment form on the Mitel 3300 ICP.

• For supervisors to control Agent Group Presence in Interactive Contact Center, the agent and at least 
one of the agent's dialable numbers must be enabled for Real-time monitoring. See "Adding agents". 
For information on enabling Real-time monitoring for multimedia agents, see the Multimedia Contact 
Center Installation and Deployment Guide.
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Agent Group Presence requires that specific security roles be enabled: 
• To control employee and extensionpresence status in Interactive Contact Center, you must enable 

'May change the real-time presence states of devices in Interactive Contact Center'.
• To control your own presence status in Interactive Contact Center, you must enable 'May control my 

real-time presence status in Interactive Contact Center'.

For more information, see "Configuring security Roles".
If the ACD Logout Agent No Answer Timer Class of Service option is enabled on your Mitel 3300 ACD 
routing system, when an agent in an agent group fails to answer a call offered to them after the logout 
time expires, the agent is removed by the ACD routing system from their agent group.
Agent group presence best practices
It is important to note that agents may join or leave agent groups but not queues. Agents become absent 
from a queue indirectly if they leave all agent groups associated with that queue. An agent who is present 
in an agent group which is associated to all queues would be disassociated from all queues simultane-
ously if they became absent in their agent group. Since the goal of agent group presence is to provide a 
dynamic response to varying queue activity, allowing agents to become absent from all queues simulta-
neously is counterproductive.
As a best practice, we recommend you associate agent groups to queues based on business groups 
within your organization. A unique agent group to business group queue association allows agents who 
leave an agent group associated to a particular business group to remain present in an agent group asso-
ciated to another business group.

Configuring Ring Group presence settings
The Ring Group presence option is controlled by Class of Service. Once the appropriate Class of Service 
has been set, the Ring Group presence status can be changed in the following ways. 
• Supervisors and agents can dial a feature access code followed by the group number to change the 

extension status for that group or to change their status for all groups to which they are a member.
• The desktop tool in the Embedded System Management can be used to make status changes.
• MiTAI controls are also available to make status changes.

Ring Group Presence has several licensing and configuration prerequisites: 
• For extensions to use Ring Group presence, Group Presence Control must be enabled for all exten-

sions on the Class of Service Options Assignment form on the Mitel 3300 ICP.
• Real-time monitoring must be enabled in YourSite Explorer for all extensions. For supervisors to 

control Ring Group presence in Interactive Contact Center, the Ring Group and at least one of the Ring 
Group’s extensions must be licensed for real-time monitoring. Extensions that have the option ‘ACD 
Enabled’ selected cannot be made present in a Ring Group. See "Adding extensions".

• The ability to modify Ring Group Presence can also be controlled using HCI options on your ACD 
routing system. It is recommended that your extension Class of Service conforms to the Golden Rules 
document available from the MiCC Knowledge Base at 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002335/loc/en_US..

Ring Group Presence also requires that specific security roles be enabled: 
• To control employee and extension presence status in Interactive Contact Center, you must enable 

'May change the realtime presence states of devices in Interactive Contact Center'.
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• To control your own presence status in Interactive Contact Center, you must enable 'May control my 
real-time presence status in Interactive Contact Center'.

For more information, see "Configuring security roles".

Setting up soft phones
NOTE: 
• Before you set up a soft phone on client computers, you must configure the soft phone as a 5020 IP 

phone on the telephone system. Refer to the Golden Rules when configuring your telephone system. 
See the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002335/loc/en_US.

• Contact Center Softphone and Contact Center PhoneSet Manager extensions must have Real-time 
and reporting enabled in YourSite Explorer. If they are programmed as Historical reporting only, the 
Directory Numbers will not display in the list of available soft phone extensions when you launch the 
soft phone.

• When an agent logs into their soft phone, they are prompted to enter a PIN. If the login PIN they 
entered is invalid the login will fail and they will be asked to enter a valid PIN. By default, users can 
attempt to log in 3 times before their PIN locks, requiring it to be reset with a new PIN. We recommend 
you increase the default number of failed attempts on your telephone system to prevent locking. For 
information on changing this setting, see the following Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_ id/1001243/loc/en_US.

• If you configure employees with the third party call control security setting, they will not be prompted 
to enter a PIN when logging into their soft phone

Soft phone comprises Contact Center Softphone and Contact Center PhoneSet Manager.
To set up a client computer to use the soft phone, on the client computer 
1. Run Client Component Pack. 

See "Modifying available client applications and client roles".
2. Ensure your headset is connected.

3. Configure sound and audio device properties. 

To configure sound and audio device properties for Windows operating systems, you must set the PC 
speakers as the default audio device and adjust the volume of the PC speakers, headset speakers, 
and headset microphone.

4. Launch Contact Center Client and select your soft phone extension.

Configuring Whisper Coach settings
NOTE: Whisper Coach requires MiVoice Business 7.0+ on a MiVoice Business for x86 platform, a Multi 
Instance Platform, or VMware for Virtual Appliance. Whisper Coach is not supported on Mxe platforms.
If you want the Coach On display in the Contact Center Softphone toolbar to appear in another language, 
you must configure the device on the ACD routing system to the display language. The translation is 
driven by the ACD routing system rather than MiContact Center Business.
Whisper Coach requires specific Class of Service options enabled for agents and supervisors: 
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• Agent COS 
– ACD Silent Monitor Accept
– ACD Silent Monitor Accept Monitoring Non-Prime Line
– ACD Silent Monitor Notification
– HCI/CTI/TAPI Call Control Allowed
– HCI/CTI/TAPI Call Monitor Allowed

• Supervisor COS 
– ACD Silent Monitor Allowed
– HCI/CTI/TAPI Call Control Allowed
– HCI/CTI/TAPI Call Monitor Allowed

Whisper Coach is supported with External Hot Desking Agents, Hot Desking Agents, and External Hot 
Desking Users
Only certain IP phones are supported with Whisper Coach. Consult your Mitel documentation for 
supported IP phones.

Configuring the MiCollab Client and Ignite integration 
(DESKTOP)
NOTE: The MiCollab and Ignite integration described in this section only applies to Ignite (DESKTOP). 
Ignite (WEB) integrates with MiCollab for inbound and outbound call handling and supports supervised 
transfers and conferences from MiCollab Client.
Before installing and running the MiCollab Client and Ignite integration, please read the following notes 
and recommendations.
To enable MiCollab Client and Ignite integration functionality: 
• When setting up the 'Feature Profile Details' in MiCollab Client Service, you must select the 'Desktop 

Client SDK' and 'Presence' check boxes.
• Choose ‘Custom Install’ and then select ‘MiCollab Client SDK’ in the Custom Setup window during the 

MiCollab Client installation process. You must be licensed for the MiCollab Client Desktop/Softphone. 
MiCollab Basic does not support full MiCollab Client and Ignite functionality and does not require the 
installation of the MiCollab Client SDK.

• Agents' first and last names must match between YourSite Explorer and MiCollab Client. If there are 
two agents with identical first and last names, ensure they have unique email addresses in both Your-
Site Explorer and MiCollab Client.

• MiCollab Client must be Version 6.0 SP3 or greater to support this integration.
• When running this integration, to prevent duplicate toaster displays, you can optionally disable the 

MiCollab Client incoming call toaster when an agent logs in. This is an Ignite configuration file setting.
• When running this integration in a Windows 8 environment, ensure the MiCollab Client process always 

runs as an administrator by selecting the ‘Run this program as an administrator’ option in the MiCollab 
Client properties settings.

• Ignite includes a toaster with basic call information but a more advanced screen pop can be configured 
using the workflow variable ‘ScreenPopOnRinging’ (available when licensed for IVR Routing or Multi-
media Contact Center). See "Populating screen pops with workflow variables".
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Providing MiVoice Border Gateway support to remote 
agents and employees
Using MiVoice Border Gateway, remote employees can connect to the Enterprise Server using a 
VPN-like connection, and use all MiContact Center Business applications as if they were in the office.
With the MiVoice Border Gateway Connector, customers can now optionally configure connections to 
multiple instances of the MiVoice Border Gateway. When employees connect to the system using the 
MiVoice Border Gateway Connector, they can specify which MiVoice Border Gateway they will connect 
to.
After remote employees attempt to connect to the system for the first time, a MiVoice Border Gateway 
system administrator must approve the MiVoice Border Gateway certificate from the MiVoice Border 
Gateway web application. Once approved, remote users are connected and have access to all of the 
MiContact Center Business applications for which they are licensed and have the required security 
permissions.
While active, the MiVoice Border Gateway Connector is visible in the Windows system tray and displays 
the name of the active connection. Only one connection can be made at a time. The name of the MiVoice 
Border Gateway connection will become the address in all application login windows and users sign in 
with their normal username and password.
The MiVoice Border Gateway Connector offers the same trusted characteristics as with a standard 
MiVoice Border Gateway deployment: local streaming, secure RTP, jitter buffering and packet handling 
QoS, and G.729 and G.711 encoding.
NOTE: 
• The following corporate firewall ports must be open in order to take advantage of the full features and 

functionality provided by the MiVoice Border Gateway Connector: 80, 443, 1433, 5024, 5025, 5026, 
5030, 7001, 7003, 8083, 8084, 36000-36004, 35001-35007, and 42440.

• You must disable IIS and SQL Server Reporting Service services as they consume port 80, which is 
required for the MiVoice Border Gateway Connector. Any other applications or services that consume 
port 80 and 443 should also be disabled or shut down.

• Ensure the Start button is enabled at all times on the MiVoice Border Gateway web application user 
interface or the MiVoice Border Gateway Connector will fail.

• The MiVoice Border Gateway Connector is not supported for use in conjunction with MiContact Center 
Business Windows Authentication sign-in model. Windows Authentication requires direct access to a 
domain controller on the network and therefore a VPN solution must be used if you want to use the 
MiVoice Border Gateway remotely.

• You must be logged in as an administrator on a client computer in order to configure a connection to 
a MiVoice Border Gateway. Once the connection has been made, any user on the computer can 
connect using the MiVoice Border Gateway Connector.

• The MiContact Center Business MiVoice Border Gateway Connector does not support TLS 1.2+ as 
the SSL Ciphers setting in MiVoice Border Gateway.

Setting up phones for remote agents and employees

If you are working at the office and select Remember my credentials when you log on to Contact Center 
Client, and then subsequently attempt to log on at home, your logon will fail. Contact Center Client does 
not recognize your office IP address when you log on remotely.
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NOTE: Before you set up the soft phone on your client computer, ensure your network administrator has 
configured your soft phone as a 5020 IP phone on the telephone system.
To set up Contact Center Softphone and Contact Center PhoneSet Manager to support the MiVoice 
Border Gateway Connector, you must 
1. Register your phones for use with MiVoice Border Gateway. 

When adding phones as MiNet devices: 
– For Contact Center Softphone device ID, type a1:21:00:00:xx:xx, where xx:xx is the extension.
– For Contact Center PhoneSet Manager device ID, type the MAC address located under the agent's 

Mitel phone.

2. Approve the MiVoice Border Gateway certificate.

3. Log in to client computers using an administrative account and set up the connection to the MiVoice 
Border Gateway from the MiVoice Border Gateway Connector. 

See "Running the MiVoice Border Gateway Connector".

For instructions on setting up phones for remote agents and employees and approving certificates, see 
the MiVoice Border Gateway documentation.

Running the MiVoice Border Gateway Connector

In order to use MiContact Center Business applications with MiVoice Border Gateway, you must run the 
MiVoice Border Gateway Connector and configure the connection to the MiVoice Border Gateway.
NOTE: A user with administrative credentials must be logged in to client computers when configuring 
connections to the MiVoice Border Gateway for the first time. After this is complete, any user can sign in 
to the computer, run the MiVoice Border Gateway Connector, and connect to a MiVoice Border Gateway.
To install and configure the MiVoice Border Gateway Connector 
1. Consult your network administrator to confirm your soft phone extension number.
2. Ensure your headphone is connected.

3. Run the MiCC Setup wizard and ensure you select MiVoice Border Gateway Connector and all 
other options you need, such as Contact Center Softphone on the Enable Features page installation. 

See "Installing the Client Component Pack and client applications".
4. In Windows, open the MiVoice Border Gateway Connector. 

Ensure you are logged in to the computer with administrative credentials.
5. Click New.

6. After Name, type a name for the connection to the MiVoice Border Gateway.

7. After IP address, type the IP address of the MiVoice Border Gateway.

8. After MAC address 

– If you have a desk phone, type the MAC address located on the sticker under your desk phone.
– If you have a soft phone, click Extension, type your soft phone extension number, and click OK.

9. Click OK. 

The connection to the MiVoice Border Gateway you just created will display in the MiVoice Border 
Gateway Connector list.
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To run the MiVoice Border Gateway Connector 
1. Start the MiVoice Border Gateway Connector.
2. Select a connection to a MiVoice Border Gateway from the list.

3. Optionally, enable the Connect automatically check box. 

Enabling this check box will automatically connect you to the configured MiVoice Border Gateway 
when you launch the MiVoice Border Gateway Connector.

4. Click Connect. 

A message displays stating 'Waiting for certificate approval'. If the request is rejected, contact your 
system administrator to approve the certificate.
Once your certificate has been approved, you can begin using all MiContact Center Business appli-
cations remotely as if you were in the office. Any user configured with administrative credentials on 
the computer can change the MiVoice Border Gateway connection settings and delete connections 
from the MiVoice Border Gateway Connector at any time.
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Data Mining

The data-mining tools comprise 
• ACD Inspector 

ACD Inspector searches for agent and ACD queue event records.
• SMDR Inspector 

SMDR Inspector searches through SMDR data to find specific contact center events.

You access ACD and SMDR Inspectors via the Contact Center Client ribbon. In order to access the ACD 
and SMDR Inspectors, your security role must have the 'May manage ACD Inspector' and 'May manage 
the SMDR Inspector' options enabled.
To access ACD and SMDR Inspectors 
1. Click Tools in the Contact Center Client ribbon.
2. In the Data Mining column, click Inspectors to open the Data Inspectors tool. The Data Inspectors 

window opens. 

See the following figure.
Figure 14.1: Data Inspectors window

 

ACD Inspector
ACD Inspector searches through raw data obtained from the ACD routing system, for agent (ACD path 
only) and queue (ACD paths and Ring Groups) event records. For example, using ACD Inspector, you 
can find the exact time an agent logs off at lunch. You can run a search and examine the activities of indi-
vidual agents or all of the agents in a particular agent group or customer service queue during that time 
interval. You can also search on specific agent states and other parameters, such as the number of calls 
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waiting and the number of active agents. The search follows a wild card format. Your specifications do 
not have to be exact. You can make the search as inclusive or exclusive as you wish. The results are 
placed in an easy-to-interpret grid that can be printed or saved to file. You can verify that your reports are 
valid by conducting searches against raw ACD routing system data.
NOTE: ACD Inspector Ring Group support extends to queue events only. Ring Group member (extension) 
events are not supported. Agent events, date events, and exception events do not apply to Ring Group 
data.
There are four types of search result tabs:
• Agent events
• Queue events
• Date events
• Exception events

Running searches in ACD Inspector

NOTE: When you run searches on queues in ACD Inspector, be sure to include a P preceding the queue 
number.
When you run a search, ACD Inspector searches through the raw ACD routing system data on the local 
hard drive. Each search requires the following information:
Select dates/Delete dates
The Select dates button specifies the date range within which you want to search. The Delete dates button 
deletes days within the range you selected. The date is displayed month first, then day, then year.
Select media servers
The Select media servers check boxes specify the origin of the data used in the search. Currently you can 
search on voice media servers only.
In addition to the date and media server parameters, the ACD Inspector has the following search criteria 
tabs:
• Agent events
• Queue events
• Option events

You can use the Reset criteria button to reset all of the search parameters to their default settings.

Agent events criteria for searches

NOTE: When conducting a search, if you accept the default settings—all check boxes—the search output 
will contain all of the event records. You can clear check boxes to narrow down your search. For example, 
if you clear all of the agent states except for the Agent login and Agent logout check boxes, the agent 
event search output will include log on and log off event records only.
When you click Tools > Inspectors > ACD Inspector, the Agent events tab opens. It displays the agent 
event criteria used in the search. (See the following figure.)

Figure 14.2: ACD Inspector main window - Agent events tab
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The Agent events tab has the following search criteria:
Agent information
The Agent information boxes specify the agent’s ID and extension number, and line numbers for one or 
more telephone lines to which the agent connects. You can search for agent information records for a 
particular agent, or for all of the agents. The agent information specifies the Agent ID for the media server 
you have already selected. For example, if you selected the media server Phone, ensure you select the 
Agent Login ID for the media server Phone. It is specified in YourSite Explorer > YourSite > Agents.
Agent events
The Agent events criteria are listed and automatically selected.
Idle event modifiers
The idle event modifier check boxes provide additional agent event searches. You can select one or more 
check boxes to include records for agents who are in the following states: unknown, idle, DND, Make 
Busy, and both DND and Make Busy.
NOTE: When conducting a search, if you accept the default settings the search output will contain all of 
the event records. You can clear check boxes to narrow down your search.
ACD queue
The ACD queue specifies the queue to which your agent belongs. For example, if the agent belongs to 
Tech Support, then you specify the Tech support queue. The agent’s queue is specified in YourSite 
Explorer > YourSite > Queues. When you enter an ACD queue number and an agent number (in the 
Agent ID box), the search results contain records for all of the calls the agent receives from the queue.
The following figure describes the ACD information provided by the Agent events tab.
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Table 14.1:ACD information provided by Agent event tab  (Sheet 1 of 5)

Agent events Description

Agent Login This record is produced whenever an agent 
successfully logs on.

Agent Logout This record is produced whenever an agent 
successfully logs off. If agent A is currently 
logged on extension X and agent B logs on to 
extension X, a log off record is automatically 
produced for A. This is followed by the log on 
record for B. Make Busy is automatically enabled 
on the extension when the agent logs out. No 
remove Make Busy record is produced. The 
extension number is the prime line of the ACD set 
which an agent is logged on.

Agent Set Do Not Disturb A record is not produced when a hunt group is 
placed in DND. The records do not differentiate 
between setting DND locally and remotely. The 
extension number reported is always the prime 
line of the ACD extension. A set DND record will 
be produced for the following conditions: 
• Setting DND locally by using the DND access 

code
• Setting DND remotely by using the remote 

DND access code
• Setting DND remotely by using the attendant 

console features key
• Setting DND locally on a SUPERSET 4 tele-

phone by pressing the select features hardkey 
and dialing the digit 2 or setting it on a 
SUPERSET 4DN or SUPERSET 430 tele-
phone by pressing the Do Not Disturb Feature 
Key
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Agent Remove Do Not Disturb The extension number is always the prime line of 
the ACD extension. A clear DND record will be 
produced for the following conditions: 
• Clearing DND locally by using an access code
• Clearing DND remotely by using the Cancel 

Remote DND access code
• Clearing DND remotely by using the attendant 

console feature key
• Clearing DND by using the Cancel All Features 

access code
• Clearing DND by using the Cancel All DND 

feature on the attendant console
• Agent logging in on an extension in DND

Agent Set Make Busy This record is produced whenever an extension is 
placed in the Make Busy state. A record is not 
produced when an agent logs out because Set 
Make Busy is implied when an agent log out 
record is received. The extension number is 
always the prime line of the ACD extension.

Agent Remove Make Busy This is similar to Set Make Busy. No record is 
produced when the agent logs on. The remove 
Make Busy is implied by the log in record. The 
extension number is always the prime line of the 
ACD extension.

Agent Answer ACD This record is produced whenever an agent 
answers a call that was directed to the ACD hunt 
group. The event record contains the Agent ID 
and extension number (hunt group pilot number 
to which the call was placed). The ACD extension 
that answered the call can be determined by 
using the last agent log in event for that 
extension. If the ACD set does not have a logged 
in agent, the Agent ID area is blank and the 
extension number is that extension’s prime line.

Agent Answer Personal A record of all of the Non ACD hunt group calls 
are included in this category. The extension 
number is always the prime line of the ACD 
extension that answered.

Table 14.1:ACD information provided by Agent event tab (Continued) (Sheet 2 of 5)

Agent events Description
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Agent Make Outbound This record is produced whenever an agent 
originates a call and enters an interaction. A 
record is not produced under the following 
conditions: entering a feature access code, 
dialing an invalid number, or hanging up before 
the called party answers. An agent extension 
number is always the prime line of the ACD set 
that originated the call.

Agent Idle If Work Timer is in effect, the Agent Idle record is 
produced when the Work Timer expires or when it 
is cancelled. If the agent enters Make Busy while 
Work Timer is in effect, an Agent Idle record is 
produced followed immediately by a set Make 
Busy record. A record is not produced to show 
the end of the call or the start of the Work Timer. 
This entire period is treated as part of the time to 
process the call.
If Work Timer is not in effect, the Agent Idle 
record is produced at the end of a call, not when 
the agent hangs up. For example, if the agent 
presses the HANG-UP softkey and remains off 
hook for 5 seconds, the record is produced when 
the HANG-UP is pressed, not when the agent 
actually goes on hook. The extension number is 
always the prime line of the ACD set that is now 
idle.

Agent Work Timer Stat This record is produced when an agent 
terminates an ACD call and the Work Timer is 
started for that agent. If the Work Timer cannot be 
started, an idle event record is produced instead.

Agent Remove Work Timer This record is produced when the Work Timer 
expires for that agent.

Agent Hold Active When an agent places a call on hold, a record is 
produced. If the agent places another call or 
answers a call on a second line, the second call 
will be recorded independently of the first.

Agent Hold Retrieve When the held call is retrieved, a record is 
produced, indicating that the agent is now busy 
on that line.

Agent Hold Abandon When the held call is abandoned, a record is 
produced for that line.

Table 14.1:ACD information provided by Agent event tab (Continued) (Sheet 3 of 5)

Agent events Description
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Agent Answer Remote ACD When an agent answers a remote ACD call, a 
record is produced. When you have networked 
ACD (more than one ACD routing system 
networked together), local calls are calls routed 
through the same ACD routing system that the 
agent’s extension is located, remote calls are 
calls routed through the other ACD routing 
system.

Agent Ringing ACD This record is produced when the telephone rings 
with an ACD call.

Interactive Contact Center Queue Set DND 
Request

This record is produced when the agent set the 
queue in DND.

Interactive Contact Center Queue Set DND A record is produced when the supervisor puts a 
queue in DND and when the MiContact Center 
Business system puts a queue in DND. In 
YourSite Explorer > Queues > Business Hours 
tab, you set the hours of operation for the 
business. The MiContact Center Business 
system reads these hours of operation and will 
put this queue in DND during off hours.

Interactive Contact Center Queue Remove DND 
Request

This record is produced when the agent removed 
the queue from DND.

Interactive Contact Center Queue Remove DND A record is produced when the supervisor 
removes the queue from DND and when the Mi 
Contact Center Business system removes the 
queue from DND. In YourSite Explorer > Queues 
> Business Hours tab, you set the hours of 
operation for the business. The MiContact Center 
Business system reads these hours of operation 
and will remove this queue from DND during 
business hours.

Interactive Contact Center Agent Login Request This record is produced when the agent logged 
on.

Interactive Contact Center Agent Login This record is produced when the supervisor 
logged on the agent.

Interactive Contact Center Agent Logout Request This record is produced when the agent logged 
off.

Interactive Contact Center Agent Logout This record is produced when the supervisor 
logged off the agent.

Table 14.1:ACD information provided by Agent event tab (Continued) (Sheet 4 of 5)

Agent events Description
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Queue events criteria for searches

When performing a queue events search, you can search on the following criteria: 
• Agent group statistics
• Queue statistics (ACD path and Ring Group)

Interactive Contact Center Set MKB with Reason 
Code Request

This record is produced when the agent sets 
himself as Make Busy.

Interactive Contact Center Set MKB with Reason 
Code

This record is produced when the supervisor sets 
the agent in Make Busy.

Interactive Contact Center Remove MKB 
Request

This record is produced when the agent sets 
himself in Make Busy.

Interactive Contact Center Remove MKB This record is produced when the supervisor 
removes the agent from Make Busy.

Interactive Contact Center Set DND Request This record is produced when the agent sets 
himself as DND.

Interactive Contact Center Remove DND This record is produced when the supervisor 
removes the agent from DND.

Interactive Contact Center Sync Queue This record is produced when Interactive Contact 
Center queues are synchronized to match the 
ACD routing system queues. In YourSite > 
Configuration > Queue, under Interactive Contact 
Center options, you can select this queue to be 
synchronized with the ACD routing system data 
each night. That means that the information in 
MiContact Center Business will be changed to 
reflect what is programmed on the ACD routing 
system.

Interactive Contact Center Sync Agent Group This record is produced when Interactive Contact 
Center agent groups are synchronized to match 
the ACD routing system queues.

Interactive Contact Center Sync Agent This record is produced when Interactive Contact 
Center agents are synchronized to match the 
ACD routing system queues.

Interactive Contact Center Sync Started This record is produced when the synchronization 
between the MiContact Center Business 
database and the ACD routing system is started.

Interactive Contact Center Sync Finished This record is produced when the synchronization 
between the MiContact Center Business 
database and the ACD routing system is finished.

Table 14.1:ACD information provided by Agent event tab (Continued) (Sheet 5 of 5)

Agent events Description



464

ACD INSPECTOR
CHAPTER 14 DATA MINING

• Date

The Queue events tab has the following search criteria:
Queue information
The Queue information box specifies the ACD queue or agent group used in the search. When you type 
an ACD queue or agent group number, the search results contain records specific to that ACD queue or 
agent group.
Queue event
When you select all three queue event check boxes (Agent Group statistics, Queue statistics, Date), the 
search results contain records for all of the agent groups and queues, and all of the ACD routing system 
refresh cycles. The ACD routing system performs a re-synchronization and generates a refresh record 
every time it notices the date or hour has changed (once an hour).
Agent information
NOTE: Not applicable to Ring Groups
The Agent information boxes specify the range of values for the Agents Available statistic used in the 
search. For example, if you select a range of 5 to 10, the search results contain records for all of the calls 
during periods when 5 to 10 agents were logged on to the ACD, but not in Make Busy or Do Not Disturb.
Calls waiting/Longest waiting settings
NOTE: Not applicable to Ring Groups
The Calls waiting settings and Longest waiting settings boxes specify ranges of values for the Calls 
waiting and Longest waiting statistics. For example, selecting a range from 10 to 999 in the Calls waiting 
box produces all of the records for calls received during periods when more than 10 callers waited in 
queue.
The Queue events tab displays the queue event criteria used in the search. (See the following figure.)

Figure 14.3: ACD search criteria - Queue events tab
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Option events criteria for searches

The Option events tab displays the ACD routing system refresh records, error, and information criteria 
used in the search. (See the following figure.)
The Option events tab has the following search criteria:
Time ranges
The Time ranges boxes specify the time interval used for the search. The time interval applies to searches 
on agent and queue events.
Exception records
MiContact Center Data Collection Service tags ACD routing system records that contain errors with an E 
(ACD routing system 1) or e (ACD routing system 2). Under Exception records, you select the Error 
records check box to include these records in the search output.
MiContact Center Data Collection Service writes a log record to the data stream upon start up. It tags the 
log record with an I to indicate it is an information record. You select the Information records check box 
to include log records in the search output. ACD Inspector displays the error and information search result 
records on the Exception records tab.
In contact centers that have two ACD routing systems, MiContact Center Data Collection Service tags 
records from the second ACD routing system with an S. The Com ports used by your ACD routing 
systems are specified in YourSite Explorer under Media Servers > Data collection.
Output record count
The Output record count specifies the maximum number of rows of records to display.

Figure 14.4: ACD search criteria - Option events tab
 

Running agent events searches

NOTE: When you run a search on Agent Answer ACD, type the Agent ID but do not type the agent’s exten-
sion. Once answered, an ACD call is not pegged as an extension but is pegged as ACD. You will get no 
data if you type the agent’s extension.
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The following procedure describes how to run an Agent events search to find all of the records of when 
agent 2005 was on ACD and used Set Make Busy.
To run an Agent events search
1. In Contact Center Client, click Tools > Inspectors > ACD Inspector.

TheAgent events tab of the ACD Inspector criteria tab opens.
2. Click Select dates and select March 3, 2004 to March 5, 2004.

3. Under Select media servers, Phone is preselected.

NOTE: When you run a search on Agent answer ACD, type the Agent ID but do not type the agent’s 
extension. Once answered, an ACD call is not pegged as an extension but is pegged as ACD. You 
will get no data if you type the agent’s extension

4. You can find the Agent ID by selecting YourSite > Configuration > Agent login > Agent login. The 
Agent ID is located under the Agent login ID heading. Ensure you select the Agent ID associated with 
the Phone media server.

5. Under Agent information, type the Agent ID, 2005.

6. Under Agent events, if you are not selecting all events, clear Select all.

7. Select the Agent event(s) you want to search on, in this case, Agent answer ACD, Set Make Busy, 
and Remove Make Busy.

8. You can leave the ACD queue blank.

9. Click Start search.

The ACD Inspector results - Agent events tab opens.

Agent events search results

This section describes the records produced when you run searches in ACD Inspector. The following 
table describes the ACD information provided by the Agent events tab. The Agent events tab displays the 
ACD activity and the Make Busy activity for agent 2005. (See the following figure.)

Figure 14.5: ACD search results - Agent events tab
 

Table 14.2:Agent events result information  (Sheet 1 of 2)

Column heading Description

Media server The Media server box identifies the ACD routing 
system (with or without MiTAI) that produced the 
event record.
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Narrowing an Agent events search

You can use the Options tab in conjunction with the Agent events search or the Queue events search. 
Using the Options tab, you narrow down the time frame for either search.
You can run an Agent events search to find all of the records for a specific agent who was on ACD and 
when that agent used Set Make Busy. Then you narrow the search with the Options tab to search 
between 9:00 A.M. and 11:00 A.M. only. The ACD Inspector results on the Agent events tab display the 
ACD activity and the Make Busy activity for agent 2005 between 9:00 A.M. and 11:00 A.M. (See the 
following figure.)
To run an Agent events/Options events search 
1. In Contact Center Client, click Tools > Data mining > ACD Inspector. 

The Agent events tab of the ACD Inspector criteria tab opens.
2. Click Select dates and select March 3, 2014 to March 5, 2014.

3. The Media server field is automatically populated. 

NOTE: When you run a search on Agent answer ACD, type the Agent ID but do not type the agent’s 
extension. Once answered, an ACD call is not pegged as an extension but is pegged as ACD. You 
will get no data if you type the agent’s extension.

4. Under Agent information, type the Agent ID, 2005.

Function/Event The Function/Event box displays the criteria for 
which you searched - in this case Agent answer 
ACD, Agent set Make Busy, Agent remove Make 
Busy.

Date The Date box displays the date of the event 
record (month/day/year).

Time The Time box displays the time the event 
occurred.

Extension Queue ID The Extension Queue ID displays the Extension 
or ACD queue used for the call. The Extension 
Agent ID column contains the extensions when a 
search involves the extension (such as Make 
Busy). It contains Queue IDs when no extension 
information is requested (such as Agent Answer 
ACD).

Agent ID The Agent ID box displays the agent number for 
the agent involved in the call.

Line The Line number box displays the telephone line 
the agent used to pick up or originate the call.

Idle Event Modifier The Idle Event Modifier box indicates when the 
agent is idle.

Table 14.2:Agent events result information (Continued) (Sheet 2 of 2)

Column heading Description
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5. Under Agent events, if you will are not selecting all events, clear Select all.

6. Select the Agent event(s) you want to search on, in this case, Agent answer ACD, Set Make Busy, 
and Remove Make Busy. 

You can leave the ACD queue blank.
7. Click the Options tab.

8. Under Time ranges, select the Start at and End at times to define the Agent events search param-
eters. 

In this example, the start time is 9:00 A.M. and the end time is 11:00 A.M.
9. Click Start search. 

The ACD Inspector results - Agent events tab opens.

Figure 14.6: ACD search results - Agent events tab
 

Running queue events searches

You can run a Queue events search to determine when you had too few queue members available to 
answer calls for a particular queue. You search for a maximum of two queue members and local calls that 
waited between one and three minutes.
NOTE: The following example represents an ACD path queue event search.
To run a Queue events search
1. In Contact Center Client, click Tools > Inspectors > ACD Inspector.

The Agent events tab of the ACD Inspector criteria tab opens.
2. Click the Queue events tab.

3. Click Select dates and select March 1, 2004 and March 4, 2004.

4. Under Select media servers, Phone is preselected.

5. Under Queue information, type the ACD Queue, p280.

6. Under Queue event, select Queue stats.
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7. Under Agent information, type 0-2 queue members.

NOTE: Not applicable to Ring Groups
In this example, you want to know when you have only two queue members scheduled to answer the 
queue.

8. Under Calls waiting setting, select 0-999 Local calls waiting.

NOTE: Not applicable to Ring Groups
In this example, you want to know the number of calls waiting on the ACD routing system to which 
your queue member is connected. If you have only one ACD routing system, you do not have any 
remote calls waiting.

9. Under Longest waiting settings, select 1-3 minutes.

NOTE: Not applicable to Ring Groups
In this example, you want to know the number of local calls that waited between 1-3 minutes. You 
think waiting up to a minute is acceptable, so you did not search for calls less than a minute. If you 
have only one ACD routing system, you do not search for the remote longest waiting.

10. Click Start search.

The ACD Inspector results - Agent events tab opens.
11. Click the Queue events tab.

Queue events search results

The Queue events tab displays the number of calls that waited between one and three minutes (one call), 
when there were a maximum of two queue members available, for the dates selected, for queue 280. (See 
the following figure.)

Figure 14.7: ACD search results - Queue events tab
 

The following table describes the ACD information provided by the Queue events tab for ACD paths.
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The following figure describes the ACD information provided by the Queue events tab for Ring Groups.

Table 14.3:Queue events search result information - ACD paths

Column heading Description

Media server Identifies the ACD routing system that produced 
the event record

Function/Event Indicates whether the event record is for a queue 
or an agent group

Date Displays the date of the event record 
(month/day/year)

Time Displays the time the event occurred

Queue/Agent group Displays the queue or agent group number

Agents available Displays the current number of queue members 
logged on to the ACD system, who are not in 
Make Busy or Do Not Disturb

CW (Number of local calls waiting) Displays the number of local callers waiting for an 
available queue member

LW (Longest local call waiting) The LW box displays the wait time for the caller 
waiting the longest in queue for an available 
queue member

Rem CW (Number of remote calls waiting) When you have networked ACD (more than one 
ACD routing system networked together), the 
Rem CW box displays the number of remote 
callers waiting for an available queue member

Rem LW (Longest remote call waiting) When you have networked ACD (more than one 
ACD routing system networked together), the 
Rem LW box displays the wait time for the caller 
waiting the longest in a remote queue for an 
available queue member

Table 14.4:Queue events search result information - Ring Groups  (Sheet 1 of 2)

Column heading Description

Media server Identifies the ACD routing system that produced 
the event record

Function/Event Indicates the specific event, as defined in (See 
the following table)

Date Displays the date of the event record 
(month/day/year)

Time Displays the time the event occurred
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The following table describes Function/Events column information for Ring Groups.

Narrowing a Queue events search

You use the Options tab in conjunction with the Agent events search or the Queue events search. Using 
the Options tab, you can narrow down the time frame for either search.
You can run a Queue events search to find when you have too few queue members available to answer 
calls for a particular queue. You search for a maximum of two queue members and local calls that waited 
between one and three minutes. Then you narrow the search with the Options tab to search between 9:00 
A.M. and 11:00 A.M. only.
NOTE: The following example represents narrowing an ACD path queue event search.
To run a Queue events/Options events search 
1. In Contact Center Client, click Tools > Inspectors > ACD Inspector. 

The Agent events tab of the ACD Inspector criteria tab opens.
2. Click the Queue events tab.

3. Click Select dates and select March 1, 2004 to March 4, 2004.

4. Under Select media servers, Phone is preselected.

5. Under Queue information, type the ACD Queue, p280.

6. Under Queue event, select Queue stats.

7. Under Agent information, type 0-2. 

Queue/Agent group Displays the queue on which the event took place

Agents available Not applicable to Ring Groups

CW (Number of local calls waiting) Not applicable to Ring Groups

LW (Longest local call waiting) Not applicable to Ring Groups

Rem CW (Number of remote calls waiting) Not applicable to Ring Groups

Rem LW (Longest remote call waiting) Not applicable to Ring Groups

Table 14.5:Function/Event column description - Ring Groups

Column heading Description

CallAnswered Indicates the call was answered by a queue 
member

CallDistributed Indicates the call was distributed to a queue 
member

CallOverflowed Indicates the call was sent to an alternate answer 
point, such as another queue or voicemail

Table 14.4:Queue events search result information - Ring Groups (Continued) (Sheet 2 of 2)

Column heading Description
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NOTE: Not applicable to Ring Groups
In this example, you want to know when you have only two queue members scheduled to answer the 
queue.

8. Under Calls waiting setting, select 0-999 Local calls waiting. 

NOTE: Not applicable to Ring Groups
In this example, you want to know the number of calls waiting on the ACD routing system to which 
your queue member is connected. If you have only one ACD routing system, you do not have any 
remote calls waiting.

9. Under Longest waiting settings, select 1-3 minutes. 

NOTE: Not applicable to Ring Groups
In this example, you want to know the number of local calls that waited between 1-3 minutes. You 
think waiting up to a minute is acceptable, so you did not search for calls less than a minute. If you 
have only one ACD routing system, you do not search for the remote longest waiting.

10. Click the Option tab.

11. Under Time ranges, select the Start at and End at times with which to narrow the Agent events 
search. 

In this example, the start time is 9:00 A.M. and the end time is 11:00 A.M.
12. Click Start search. 

The ACD Inspector results - Agent events tab opens.
13. Click the Queue events tab.

The Queue events tab displays the number of calls that waited between one and three minutes, when 
there were a maximum of two queue members available, for the dates selected, between 9:00 A.M. and 
11:00 A.M. for queue 280. There was only one call that waited between one and three minutes in the 
selected time frame and queue. (See the following figure.)

Figure 14.8: ACD search results - Queue events tab
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Running wild card queue events searches

When performing searches on the Queue Events tab, you can enter a P800 under Queue information and 
the search will produce records involving Queue 800 only. Alternatively, you can run wild card searches. 
When you perform wild card searches, you use * to represent the wild card. For example, if you enter '*00' 
under Queue information on the Queue events tab, the search will produce records for all of the Queues 
or Agent groups that end in '00' (for example, 200, 300).
NOTE: The following example represents an ACD path wild card queue event search.
To run a wild card Queue events search, where all of the queues end in '00'. 
1. In Contact Center Client, click Tools > Inspectors > ACD Inspector. 

The Agent events tab of the ACD Inspector criteria tab opens.
2. Click the Queue events tab.

3. Click Select dates and select February 9, 2004 and February 10, 2004.

4. Under Select media servers, Phone is preselected.

5. Under Queue information, type *00. 

In this example, you are searching for all of the queues that end in '00'.
6. Under Queue event, select Queue stats.

7. Under Agent information, type 0-2. 

In this example, you want to know when you have only two queue members scheduled to answer the 
queue.

8. Under Calls waiting setting, select 0-999 Local calls waiting. 

In this example, you want to know the number of calls waiting on the ACD routing system to which 
your queue member is connected. If you have only one ACD routing system, you do not have any 
remote calls waiting.

9. Under Longest waiting settings, select 1-3 minutes.

10. In this example, you want to know the number of local calls that waited between 1-3 minutes. You 
think waiting up to a minute is acceptable, so you did not search for calls less than a minute. If you 
have only one ACD routing system, you do not search for the remote longest waiting.

11. Click Start search. 

The ACD Inspector results - Agent events tab opens.
12. Click the Queue events tab. 

See the following figure.
Figure 14.9: ACD Wild card search results - Queue events tab
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Wild card queue events search results

The Queue events tab displays the Queue statistics when there were a maximum of two queue members 
available, for the dates selected, for all of the queues that end in '00'. The Queue statistic in this case are 
the records of the ACD routing system performing re-synchronization. A refresh record is produced every 
time the system notices the date or hour has changed (once an hour).

Running searches for error and information records

Using the Options tab, you can run a search for error and information records. The error messages are 
records of sequence errors. The information records are records of when the Collector restarts.
To run an exception events search
1. Click the ACD Inspector criteria tab.
2. Click the Options tab.

3. Click Select dates and select a date.

4. Under Select media servers, Phone is preselected.

5. Under Time ranges, type the Start at and End at times.

6. Under Exception records ensure the Error records and/or Information records check boxes are 
selected.

7. Under Output record count, select the maximum number of records you want to display.

8. Click Start search.

The ACD Inspector results - Agent events tab opens.
9. Click the Exception events tab.
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Exception events search results

The following table describes the ACD information provided by the Exception events tab.

SMDR Inspector
SMDR Inspector searches through SMDR data to find specific contact center events. For example, 
suppose you receive a complaint from a caller who waited 16 minutes in queue for a customer service 
agent, sometime between 1:00 P.M. and 1:30 P.M. sometime last week. In a single session, you can 
search through data from multiple days to find a specific event. The search follows a wild card format. 
Your specifications do not have to be exact. You can make the search as inclusive or exclusive as you 
wish. The results are placed in an easy-to-interpret grid that can be printed or saved to file. You can verify 
that your reports are valid by conducting searches against raw telephone system data.
The search result tabs consist of the following: 
• SMDR search results
• Exception results

Running searches in SMDR Inspector

When you run a search, SMDR Inspector searches through the raw telephone system data on the local 
hard drive. Each search requires the following information:
Select dates/Delete dates
The Select dates button specifies the date range within which you want to search. The Delete dates button 
deletes days within the range you selected. The date is displayed month first, then day, then year.
Select media servers
The Select media servers check boxes specify the origin of the data used in the search. Currently you 
You can search perform searches on telephone activity only. In the future, you will be able to search on 
email and chat phone activity.
In addition to the date and media server parameters, SMDR Inspector has the following search criteria 
tabs: 
• Call parties
• Call types
• Options

Table 14.6:Exception event result information

Column Heading Description

Media server The Media server box identifies the ACD routing 
system (with or without MiTAI) application that 
produced the event record.

Record The Function/Event box displays refresh records. 
The refresh event signifies the start of a new 
cycle of group and queue statistics.
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Call parties criteria for searches

The Call parties criteria helps you to find call events such as, what calls an agent received (Called party), 
what calls an agent made (Calling party), or what extension the call was transferred to (Third party). (See 
the following figure.)
The Call parties tab search options are as follows.
Digits dialed
The Digits dialed box specifies the queue number of the queue that picks up the call (for inbound calls). 
The ANI digits box specifies the area code and telephone number for an inbound call. The search results 
contain records that match the data the user typed in the ANI field.
The DNIS digits box specifies the phone number the caller dialed. The DNIS could be product specific or 
it could specify demographic variables or marketing targets.
The Account Code box specifies the Account Code number used in the search. Agents enter Account 
Code numbers to tag inbound and outbound calls.
Outbound calls
The Outbound calls box specifies telephone number the agent dials (for outbound calls).
Call parties
The Calling party box specifies the extension or agent number (for an outbound call) or the trunk number 
(for an inbound call) used in the search.
The Called party box specifies the answering extension or the trunk number (for an outbound call) used 
in the search.
The Third party box searches for call records on the extension number used in a transfer.
Call identification
The Call identification box specifies the Mitel call IDs assigned to a call segment.
The Sequence ID box specifies the sequence number assigned to the call record by the telephone 
system.
The Associated ID box specifies the number attached to associated data records of the call assigned by 
the telephone system.

Figure 14.10: SMDR search criteria - Call parties tab
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Call types criteria for searches

The Call types tab displays the types of calls the agent receives, for example, ACD or Non ACD, aban-
doned, interflowed, requeued, unavailable, or outbound calls. (See the following figure.)
The Call types tab search options are as follows.
Call types
The Call types check boxes specify one or more categories of calls used in the search. The telephone 
system generates an Unavailable (Queue unavailable calls) event record when a caller dials a queue and 
the queue is not available (in DND) or there are no agents logged on to handle the call.
Answer supervision
The Answer supervision check box searches for instances where calls were answered by the called party. 
If you have answer supervision and you make an outbound call but the called party does not answer (you 
hang up) then an SMDR record is generated with no duration. If you do not have answer supervision then 
no SMDR record is generated at all.
Busy call
The Busy call check box searches for call records on queues or extensions the caller dials but finds busy.
Error by caller
The Error by caller check box searches for call records on numbers the caller dials that are not recognized 
by the telephone system.
TAFAS answered
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The TAFAS Answered check box searches for call records that involve calls manually picked up by agents 
at alternate extensions. In a TAFAS answered call, an employee hears another employee's phone ring 
and dials a number to pick up the call.
Internal call
The Internal call check box searches for call records on calls between employees that do not involve 
trunks.
Blank
The Blank check box searches for call records that have no data in the Call completion box. That is, when 
the check box is selected, the search output contains records where there is nothing recorded in the Call 
completion box.
Attendant involved
The Attendant involved options specify whether or not call records for calls involving an automated atten-
dant are used in the search.
Transfer/Conference
The Transfer/Conference check box searches for records on transferred or conferenced calls.
Speed call/Forward
The Speed call/Forward check boxes search for call records involving a speed dial and/or conference 
function. When the Blank check box is selected, the search output contains records where there is nothing 
recorded in the Speed or Fwd check boxes.
System ID
The System ID check box searches for call records that pertain to a specific telephone system. In a 
multi-site enterprise, you program each telephone system with a 3-digit system ID number. You can distin-
guish records by their system ID number. The telephone system appends it to all of the SMDR records.
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Figure 14.11: SMDR search criteria - Call types tab

Options criteria for searches

When you click Tools > Inspectors > SMDR Inspector, the Options tab opens. The Option criteria work in 
conjunction with the Call parties criteria and the Call types criteria to narrow down the search. (See the 
following figure.)
The Options tab search options are as follows.
Time ranges
The Time ranges boxes specify the time interval used for the search.
Call duration
The Call duration boxes specify a range of values for the Call duration statistic used in the search.
Time to answer
The Time to answer boxes specify a range of values for the Time to answer statistic used in the search. 
For example, if you select a time to answer of 240 to 999 seconds, the search records include calls that 
were answered by an agent after waiting at least 240 seconds to be answered.
Exception records
The MiContact Center Data Collection Service tags telephone system records that contain errors with an 
E (telephone system 1) or e (telephone system 2). You select the Error records check box to include these 
records in the search output.
The MiContact Center Data Collection Service writes a log record to the data stream upon start up. It tags 
the log record with an I to indicate it is an information record. You select the Information records check 
box to include log records in the search output.ACD Inspector displays the error and information search 
result records on the Exception Records tab.
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In businesses with two telephone systems, the MiContact Center Data Collection Service tags records 
from the second telephone system with an S. You specify the Com ports used by your telephone systems 
on the Data collection tab in YourSite Configuration.
Output record count
The Output record count specifies the maximum number of rows of records to display.

Figure 14.12: SMDR search criteria - Options tab

SMDR search results information

The SMDR Search results tab shows the search results for Call parties, Call types, and Options searches. 
The following table describes the SMDR information provided by the SMDR Search results tab.
Table 14.7:SMDR search results information  (Sheet 1 of 7)

Column heading Description

Media server The Media server box identifies the source of the 
event record.

Start time The Start time of a call is reported in hours and 
minutes in either a 12- or 24-hour format. If a 
12-hour clock is used, the letter P indicates P.M. 
(HH:mmp)

Date The Date box displays the date of the event 
record (month/day/year).

Total duration The duration of a call is reported in hours, 
minutes and seconds (hh:mm:ss). Leading zeros 
are output (Maximum time = 99 hours, 59 
minutes, 59 seconds). If the call duration exceeds 
100 hours, a call duration of 99 hours, 99 
minutes, 99 seconds will be recorded.
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Calling party The Calling party is the identity of the party 
that/who originated the call. It may be a station, 
an attendant, or an incoming trunk, as described 
below:
(a) Station number as Calling party (cccc). A 
station number (extension number or agent ID) 
may be one to four digits (0-9, *, #) which are 
left-justified (that is, no leading zeros).
(b) Attendant as Calling party (ATTm). Calls 
originated by an attendant that do not involve a 
third party are reported as a calling party by ATT, 
followed by the console number. When the 
console number is in the range of 10 through 99, 
the format is modified to be ATmm. If an 
attendant calls an outside party on behalf of a 
station or trunk, that station or trunk is reported as 
the caller but the attendant flag symbol [*] is 
shown in the Attendant was Involved box.
(c) Trunk number as Calling party (Tnnn or Xnnn). 
When the originating party is an incoming CO 
trunk, Tnnn is shown on the record, where nnn is 
the number of the trunk. If the trunk number is 
less than three digits long, it is left-padded with 
zeros. If the extended digit length option is 
enabled, the trunk number nnnn may be up to 
four digits long, left-justified and without leading 
zeros. When the originating party is an incoming 
non-CO trunk, Xnnn is shown in the trunks 
record. The T or X ensures that CO trunks and 
CO Attendant trunks can be distinguished from 
tie trunks. The trunk number is the trunk ID 
specified during customer data entry in the Trunk 
Assignment form.

Attendant flag This 1-digit box contains an asterisk [*] when a 
call is assisted by, or initially answered by, an 
attendant. This flag will not be shown if a call is 
transferred to an attendant.

Table 14.7:SMDR search results information (Continued) (Sheet 2 of 7)

Column heading Description
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Time to answer (Time to Ans) This is the number of seconds from the time an 
incoming external call rings the destination until 
the call is answered. If a call is never answered, 
this box displays three asterisk [***]. Leading 
zeros are output and the box remains at 999 
when an overflow is reached. If the Call 
Distribution (MCD) feature package is installed, 
and the MCD report transfers option is enabled, 
this box contains the total time to answer 
regardless of the number of times the call is 
rerouted. This box does not apply to Internal 
SMDR.
NOTE: Time to answer does not include the dura-
tion the request waits in queue outside of regular 
business hours.

Digits dialed External SMDR
External SMDR records the digits dialed on the 
outgoing trunk. A maximum of 26 digits is 
recorded. This number is reduced to 20 when the 
Report Meter Pulses option is selected in CDE. 
This box does not include the trunk group access 
code on outgoing calls. The digits recorded are 
the actual digits outpulsed on the trunk after digit 
modification has been performed. On incoming 
calls, the digits dialed in on the trunk are 
recorded. The digits dialed field contains the 
digits the telephone system used to route the call. 
For an incoming call this could be the extension 
or the path to which the call is being routed. For 
outgoing calls this is the number the caller dialed. 
When more than 26/20 digits are dialed, the 
remaining digits are ignored.
If the MCD option is enabled, each device is 
listed whenever the call is rerouted, rather than 
the last device as in non-MCD loads. To reflect 
the MCD option, the Digits dialed on the Trunk 
box displays dd1 ddd2 ddd3.
Internal SMDR
Internal SMDR records the digits dialed on an 
internal line. Up to 26 digits are recorded.

Table 14.7:SMDR search results information (Continued) (Sheet 3 of 7)

Column heading Description
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Call completion flag External SMDR (Outgoing calls)
This reports the completion status of an outgoing 
call in so far as the telephone system is able to 
determine it. When an outgoing call fails toll-deny 
checking and is dropped, this box contains a T. 
When the trunk group is programmed to receive 
Answer Supervision and a supervision is 
received, an A is reported. When the trunk group 
is programmed for Toll Reversal and a 
supervision is received, a T is reported.
External SMDR (Incoming calls)
The telephone system can monitor the outcome 
of a call and can provide a comprehensive report 
on call completion. When the station or hunt 
group to which a call is directed is busy, a B is 
recorded. When an incoming trunk accesses an 
invalid number and receives reorder tone, an E is 
reported. An E is also reported for incomplete 
calls. A T is reported if the incoming trunk is 
answered with Trunk Answer From Any Station 
(TAFAS) and if an outgoing trunk call is toll 
denied, or if the call is Pickup answered.
When an incoming call is forwarded by an 
attendant to a busy station, a B is shown in the 
call completion status box, the number called is 
shown as the third party, and the Attendant is 
shown as the called party.
Internal SMDR
An I indicates that an internal call was completed.
Speed Call or Call forward flags (S or F)
This box contains an S when the number is 
speed dialed, and an F when an external call is 
forwarded through the external call forward 
feature
If Internal SMDR is enabled, an F is also 
recorded when an internal call is forwarded 
through the call forward feature. However, for 
internal calls the Third Party box does not contain 
the number of the station that initiated the call 
forward feature. The Third Party box is left blank 
because the Digit dialed box identifies the station 
that has call forward enabled.

Table 14.7:SMDR search results information (Continued) (Sheet 4 of 7)

Column heading Description
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Speed call forward The Speed call/Forward check boxes search for 
call records involving a speed dial and/or 
conference function. When the Blank check box 
is selected, the search output contains records 
where there is nothing recorded in the Speed or 
Fwd check boxes.

Called party A Called party can be a station number, an 
attendant, or for outgoing calls, the outgoing trunk 
number. The Called party output format is 
identical to that used for the Calling party. See 
Calling party. For incoming calls to an attendant, 
the called party is recorded as the attendant 
unless the attendant transfers a call to a station. 
For direct-in-lines, it would be the station number. 
On outgoing calls handled by an attendant, the 
called party would be the outgoing trunk’s ID.

Transfer/Conference call (Trans Conf) This box identifies calls involving three or more 
parties. It contains a T for supervised transfers, X 
for unsupervised transfers (that is, transfer in to 
busy reports a T, transfer in to ringing reports an 
X), and a C for 3-way interactions or conferences.

Third party The Third party box contains the number of the 
station to which a trunk call has been transferred. 
When several transfers take place during a trunk 
call, the first party is the only one reported, as 
long as MCD Report transfers = No, and Record 
transfers = No.
If an external call is made to a station whose call 
forwarding is set to an external number, the Third 
party box contains the number of the station that 
initiated the call forward feature. For internal 
calls, the Third Party box is left blank because the 
Digit dialed box identifies the station that has 
external call forward enabled.

Account Code Enabling the report Account Codes option in the 
SMDR Options Assignment form allows an 
Account Code of two to 12 digits to be recorded 
here, if one is used to make a call. Leading zeros 
are reported if they are entered.

Table 14.7:SMDR search results information (Continued) (Sheet 5 of 7)

Column heading Description
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Route optimization flag At the starting and end nodes of a network call a 
flag will be shown in this box if route optimization 
has taken place. A route optimized call involves 
two trunks to the same party: the pre-optimization 
trunk and the post-optimization trunk. An SMDR 
record will be produced for both trunks, which will 
be distinguished by a lower case r for the 
pre-optimization trunk, and an upper case R for 
the post-optimization trunk. Route optimization is 
available with the MSDN/DPNSS Voice IV feature 
package only.

ANI/DNIS ANI/DNIS digits are recorded in this box. ANI and 
DINS numbers can be up to 10 digits in length, 
and are recorded for incoming calls on ANI/DNIS 
trunks. COS option ANI/DNIS reporting must be 
enabled.

System identifier This optional 3-digit box may contain values from 
000 to 999. 000 indicates that no identifier has 
been entered. In the absence of a System 
identifier, a Node identifier is printed (when 
programmed). When more than one node 
identifier exists, the first one on the programmed 
list is printed. When both a System ID and a Node 
ID are programmed, the System ID takes 
precedence. Programming of System Identifiers 
and Node Identifiers is described in the Customer 
data entry volume.

Call ID The Call ID box specifies the call number to 
which the record relates.

Call ID seq The Sequence ID box specifies the sequence 
number assigned to the call record.

Assoc call ID The Associated ID box specifies the number 
attached to associated data records of the call.

Table 14.7:SMDR search results information (Continued) (Sheet 6 of 7)

Column heading Description
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SMDR record boxes

This section describes the SMDR search output records available.
The telephone system records SMDR data in table format. The following table provides information used 
to interpret the SMDR Inspector search output. It summarizes the SMDR record boxes and provides the 
meaning of the symbols used.

System ID This optional 3-digit box may contain values from 
000 to 999. 000 indicates that no identifier has 
been entered. In the absence of a System 
identifier, a Node identifier is printed (when 
programmed). When more than one node 
identifier exists, the first one on the programmed 
list is printed. When both a System ID and a Node 
ID are programmed, the System ID takes 
precedence. Programming of System Identifiers 
and Node Identifiers is described in the Customer 
data entry volume.

Record See "SMDR record boxes".

Table 14.8:Summary of boxes in SMDR records  (Sheet 1 of 4)

Name Format Definition Notes

Date mm/dd mm = Month
dd = Day

mm = 01 - 12
dd = 01 - 31

Start time hh:mmp hh = Hours
mm = Minutes
p = pm

hh = 00 - 12 or 00 - 23
mm = 00 - 59
p = P.M. (12-hour 
clock)

Duration of call hh:mm:ss hh:mm:ss = duration in 
hours:minutes:seconds

hh = 00 - 99
mm = 00 - 99
ss = 00 - 99
hhhh hh hh = 0000 - 
9999
mm = 00 - 99
ss = 00 - 99

hhhh:mm:ss hhhh:mm:ss = duration 
in 
hours:minutes:seconds

Table 14.7:SMDR search results information (Continued) (Sheet 7 of 7)

Column heading Description
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Calling party
pppp

cccc = Extension #
Tnnn = Trunk # (CO)
Xnnn = Trunk # 
(non-CO)
ATTm = Attendant

c = 0 - 9, *, #
nnn = 000 - 999

m = Console # (ATmm 
for
Attendant 00 - 99)
c = 0 - 9, *, #
nnnn = 0000 - 9999

mm = Console #

ppppppp
ccccccc = Extension #
Tnnnn = Trunk # (CO)
Xnnnn = Trunk # 
(non-CO)
ATTmm = Attendant

Attendant f * = Attendant
-- = Attendant not 
involved

Attendant answered or 
initiated the call, then 
transferred it to an 
extension

Time to answer ttt ttt = time in seconds 
(000 - 999) *** = Call 
unanswered)

*** = Call unanswered

Leading zeros output. 
Incoming calls only.

Digits dialed on the 
trunk

xx...x
x...x y...y
or
Tx...x y...y
(Network Format)

Up to 26 (20 if 
metering) digits dialed 
on the trunk
Network Format: up to 
26 digits (20 if 
metering) in total

x = 0 - 9, *, #
y = 0 - 9, *, #
x...x = Node ID & 
Extension # (up to 14 
digits); y...y = actual 
digits dialed
y...y = actual digits 
dialed
Tx...x = Node ID & 
Trunk #

Call completion status h A = Answer 
supervision
B = Called party busy
E = Caller error
I = Internal call
R = re-queue call
T = Toll-denied, TAFAS 
answered, or Pickup 
answered

Outgoing
Incoming Direct/Dial-in
Incoming/Dial-in 
incoming
Incoming/Outgoing

Table 14.8:Summary of boxes in SMDR records (Continued) (Sheet 2 of 4)

Name Format Definition Notes
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Speed call or Call fwd 
flags

S or F S = Number was 
Speed called
F = External call 
forwarded through 
External call fwd 
feature or internal call 
forwarded through Call 
forward feature

Outgoing

Called party qqqq cccc = Extension #
Tnnn = Trunk # (CO)
Xnnn = Trunk # 
(non-CO)

ATTm = Attendant

c = 0 - 9, *, #
nnn = Range specified 
in telephone system 
form programming
m = Console # (ATmm 
for Attendant 00 - 99)
c = 0 - 9, *, #
nnnn = 0000 - 9999

mm = Console #

qqqqqqq ccccccc = Extension #
Tnnnn = Trunk # (CO)
Xnnnn = Trunk # 
(non-CO)
ATTmm = Attendant

Transfer/ Conference 
call

K T = Supervised transfer
X = Unsupervised 
transfer
C = 3-Way or 
Conference
R = re-queue call
U = Path unavailable
I = Interflow

U and I only apply to
ACD 
TELEMARKETER® 
2000.

Third party rrrr
rrrrrrr

cccc = Extension #
cccccccc = Extension #

c = 0 - 9, *, #
c = 0 - 9, *, #

Account Code (opt.) aa....a Length of 2 to 12 digits a = 0 - 9, space-filled

Route optimization flag 
(opt.)

s r = pre-optimization 
trunk
R = post-optimization 
trunk
- = Space (no route 
optimization)

Table 14.8:Summary of boxes in SMDR records (Continued) (Sheet 3 of 4)

Name Format Definition Notes
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Running call parties searches

You run a Call parties search to find out who/what phone numbers an extension called within a selected 
date range.
To run a Call parties search
1. Click the SMDR Inspector criteria tab.

The Options tab opens.
2. Click the Call parties tab.

3. Click Select dates and select the dates for which to run the search, for example, September 27, 2004 
to October 07, 2004.

4. Under Select media servers, select the MiVoice Analytics server, for example, 3300 ICP.

5. Under Call parties, type the Called Calling party, for example, agent ID 2005 extension 1104.

6. Click Start search.

The SMDR Inspector results - SMDR Search results window screen opens.

Call parties search results

The SMDR Search results tab displays the results of who extension 1104 called agent 2005. The agent’s 
extension is 1106. He answers calls that come to queue 280 and dial zeros (which is extension 

System identifier 
(optional)

iii Entered by System ID i = 0 - 9
iii = 000 - 999
000 = No code entered
In the absence of a 
System ID, a Node ID 
is printed (if 
programmed). When 
both System ID and 
Node ID are 
programmed, System 
ID takes precedence.

ANI/DNIS xx...xxxxxxx Format:
-aaaaaaaaaa-ddddddd
ddd
- = blank
a = ANIS digit
d = DNIS digit

Extended digit length 
format:
-aaaaaaaaaa-ddddddd

For Extended digit 
length format only the 7 
right most DNIS digits 
are recorded.

Table 14.8:Summary of boxes in SMDR records (Continued) (Sheet 4 of 4)

Name Format Definition Notes
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1290Calling Party). On line one of the results, an outside call dialed the agent’s extensionextension 1104 
called 592-2122 (Digits dialed). On line twofive, the agent answered a call from extension 1104 checked 
his queue voice mail (P28070). On line threesix, we see that extension 1107 1104 called the agent. On 
line four, we see that extension 1112 called his extension1124. (See the following figure.)

Figure 14.13: SMDR search results tab - Call parties search
 

Running call types searches

You run a Call types search when you want to narrow down the a Call parties search. Previously, If you 
have completed a Call parties search for all calls made by an extension, for agent 2005 (Call parties tab). 
Now a selected date range, you want to can now narrow the search to include only Answer Non ACD call 
types. outbound calls.
To run a Call types search
1. Click the SMDR Inspector criteria tab.

The Options tab opens.
2. Click the Call parties tab.

3. Click Select dates and select March 10, 2004.

4. Under Select media servers, Phone is preselected.

5. Click Select dates and select the dates on which to run the search, for example, September 27, 2004 
to October 7, 2004.

6. Under Select media servers, select the MiVoice Analytics server, for example, 3300 ICP.

7. Under Call parties, type the Called Calling party, for example, agent ID 2005 extension 1104.

8. Click the Call types tab.

9. Under Call types, clear the check boxes for all of the criteria but Answer Non ACD Outbound.

10. Click Start search.

The SMDR Inspector results - SMDR Search results window screen opens.
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Call types search results

The SMDR search results tab displays the call parties/call type results. All of the Non ACD calls received 
by agent 2005 on March 10, 2004 are displayed. They included external and internal calls where the caller 
dialed the agent’s extension (1106), and all of the dial zero calls. (ACD calls are calls that are sent through 
the queue.)

Figure 14.14: SMDR search results - Call types search
 

Running option searches

You run Option searches to further narrow down Call types and Call parties searches. Previously, you ran 
a Call parties search for agent 2005 and then a Call types search to include only Answer Non ACD calls. 
Now you want to search for Answer Non ACD calls for agent 2005 that occurred between 9:00 A.M. and 
1:00 P.M.
To run an Options search 
1. Click the SMDR Inspector criteria tab.
2. The Call parties tab opens.

3. Click Select dates and select March 10, 2004.

4. The Media server field is automatically populated.
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5. Under Call parties, type the Called party, agent ID 2005.

6. Click the Call types tab.

7. Under Call types, clear the check boxes for all of the criteria but Answer Non ACD.

8. Click the Options tab.

9. Under Time ranges, after the Start At time, type 9:00:00.

10. Under Time ranges, after the End At time, type 12:59:59.

11. Click Start search. 

The SMDR Inspector results - SMDR Search results window opens.

Options search results

The SMDR search results tab displays the call parties/call type/options results. All of the Non ACD calls 
received by agent 2005 on March 10, 2004 between 9:00 A.M. and 1:00 P.M. are displayed. They 
included external and internal calls where the caller dialed the agent’s extension (1106), and all of the dial 
zero calls. (ACD calls are calls that are sent through the queue.) (See the following figure.)

Figure 14.15: SMDR Search result - Options search
 

Running searches for error and information records

Using the Option tab you can run a search for error and information records. The error messages are 
records of sequence errors. The information records are records of when the Collector restarts.
Previously, you ran a Call parties search for agent 2005, and then a Call types to include Answer Non 
ACD that occurred between 9:00 A.M. and 1:00 P.M.
To run an Exception event search 
1. Click the SMDR Inspector criteria tab. 

The options tab opens.
2. Click the Call parties tab.

3. Click Select dates and select March 10, 2004.
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4. Under Select media servers, Phone is preselected.

5. Under Call parties, type the Called Calling party, agent ID 2005.

6. Click the Call types tab.

7. Under Call types, clear the check boxes for all of thecriteria but Answer Non ACD.

8. Click the Options tab.

9. Under Time ranges, after the Start At time, type 9:00:00.

10. Under Time ranges, after the End At time, type 12:59:00.

11. Under Exceptions, select the Error records and Information records.

12. Click Start search. 

The SMDR Inspector results - SMDR Search results window opens.

Exception search results

There was an information record produced every five minutes. Either the alarm is set incorrectly (the 
system thinks it should be receiving data because the business hours indicate the business is open) or 
the connection has died. The Exception results tab displays error and information records. (See the 
following figure.)
The Exception search has the following results information:
Media server
The Media server box identifies the source of the event record.
Record
The Data record box displays detailed information about the exception record.
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SMDR search results - Exception results tab

Wild card searches

NOTE: 
• To search for a string of numbers within a digits dialed string, enclose the string of numbers in paren-

thesis, such as '8905'. The search will produce only records that include 8905 only in the digits dialed 
string.

• To search for records where the calling, called or third party involved a trunk (BOTH T and X in one 
search), put a C in the calling, called or third party box.

When performing searches on the Queue Events tab, you can enter a P800 under Queue information and 
the search will produce records involving Queue 800 only. Alternatively, you can run wild card searches. 
When you perform wild card searches, you use * to represent the wild card. For example, if you enter '*00' 
under Queue information on the Queue events tab, the search will produce records for all of the Queues 
or Agent groups that end in '00' (for example, 200, 300).

Exporting search results

You can save the ACD Inspector andSMDR Inspector search results in the following formats: 
• HTML
• Microsoft Excel
• XML
• Text
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To export the search results 
1. Click Save search. 

The Inspector Search Results Export window opens.
2. Select the format in which you want the search results saved: HTML, Microsoft Excel, Microsoft 

Access, XML, or Text.

3. Click Next.

4. Click the ellipses to select the location where you wantto save the file.

5. After File name, type the file name.

6. Click Save.

7. Click Next.

8. Click Next to confirm the format in which you want to save the file and the location of the file. 

A window opens with the message 'Inspector Search Results export to [export type] complete.'
9. Click OK.

10. Click Finish. 

A window opens with the message 'Would you like to view/open this file now?'
11. If you want to view the file immediately, click Yes. 

The file opens.
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Installing MiContact Center Business on 
VMware

This section provides detailed instructions on deploying VMware Ready .ova virtual machines preloaded 
with MiContact Center Business. Pre-loaded .ova virtual machines enhance the speed and ease of 
installing and deploying MiContact Center Business. The applications are pre-loaded on a Windows 
Server 2016 operating system, configured with SQL Server Express 2016 and all other prerequisites so 
the installation setup can be run with minimal configuration changes required.

OVA file specifications
The following table lists the default hardware specifications for the OVA files when shipped.

NOTE: The values shown in the above table describe the hardware specifications for the vApp when 
shipped. After deployment, you can edit the virtual machine settings so that there are more or less CPU 
and RAM resources allocated, as necessary. The applications to which you have access are dependent 
on your licensing options.
For optimum performance, it is recommended that the following power management settings be set for 
MiContact Center Business .ova files: 
• On your VMware vSphere host, the CPU Power Management Policies should be set to High Perfor-

mance.
• On your client, the Windows Power Option should be set to High Performance.

Installation overview
Installing the MiContact Center Business or MiContact Center Business and MiVoice Call Recording vApp 
is a two-step process. First you must deploy the MiContact Center Business or MiContact Center Busi-
ness and MiVoice Call Recording Server, which is an .ova virtual machine that is installed on a supported 

Table 15.1:vApp hardware specifications

vApp
Virtual 
CPUs

CPU 
Rese
rvati
on

RAM 
(GB)

RAM
Reservati
on

Hard Disk 
Space 
(GB)

Small 2 2000 
Mhz

8 8192 MB 120

Medium 4 4000 
Mhz

16 16384 MB 120

Large 8 8000 
Mhz

32 32768 MB 120
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VMware server. Once the virtual machine has been deployed, there are several post-deployment instal-
lation and configuration steps that must be completed to get your business up and running. These include: 
• Licensing the virtual machine's copy of Windows Server 2016
• Creating the administrator account credentials for the server
• Configuring a computer name and IP address for the server
• Installing MiContact Center Business
• Licensing MiContact Center Business
• For MiContact Center Business 

– Configure media servers
– Synchronize the telephone system(s) with the YourSite database

• For MiVoice Call Recording 
– Adjust settings in MiVoice Call Recording Network Config application

The following sections detail how to deploy MiContact Center Business MiVoice Analytics .ova virtual 
machines and the post-deployment installation and configuration changes required for all applications.

Virtual machine download

To download the MiContact Center Business virtual machine 
1. Log on to the Enterprise Server with a Windows administrator account.
2. The account must have full administrative privileges.

3. Ensure all of the Windows programs are closed.

4. Using a web browser browse to https://www.mitel.com.

5. Click Login.

6. Type your Mitel Connect Username and Password and click Login.

7. Click Downloads.

8. Under Title, click MiContact Center.

9. Click the link of version you want to download and the Knowledge Base Article is displayed. Occa-
sionally, due to browser incompatibility, the link will not respond. If this happens, right-click the link 
and select Open in new tab.

10. In the Knowledge Base Article, click the link of version you want to download.

11. Click the link for the MiCC OVA file you want to download. 

The Disclaimer appears.
12. To download your software: 

– Click I Agree [Download using Software Download Manager (Recommended)] to download 
using the Software Download Manager.

– Click I Agree [Download using HTTP] to download using your browser.

NOTE: If you click I Disagree, you are unable to download the software.
13. If you are downloading with the Software Download Manager, select the destination for the download 

and click Save. When the file finishes downloading, click Launch.

https://www.mitel.com/
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14. If you are downloading using HTTP, depending upon the options presented in your browser, choose 
to save or run the installation file.

Enterprise Server deployment and installation on VMware
This section includes detailed instructions on how to deploy your MiContact Center Business or MiContact 
Center Business and MiVoice Call Recording vApp and all of the post-deployment installation and config-
uration changes required to get your contact center up and running.

Before running the deployment

Before deploying either MiContact Center Business on a VMware server, you must have configured your 
VMware server accordingly. For details on installing and configuring your VMware server(s), please 
consult your VMware documentation.
In order to deploy either or MiContact Center Business and MiVoice Call Recording MiVoice Analytics 
.ova file, you must have installed and configured vSphere Client.
MiContact Center Business virtual machines require that both a Small business configuration of MiVoice 
Business and MiVoice Border Gateway be previously configured before deploying MiContact Center 
Business.
NOTE: Please refer to the MiContact Center Business and MiVoice Analytics System Engineering Guide 
for a list of supported VMware vSphere versions.

Deploying MiContact Center Business virtual machines

To deploy MiContact Center Business virtual machines 
1. In vSphere Client, click File > Deploy OVF Template.
2. After Deploy from a file or URL, click Browse and navigate to the location to which you downloaded 

the file.

3. Click Next.

4. Verify the .ova template details and click Next.

5. Review the End User License Agreement and click Accept.

6. Click Next.

7. Type a name for the deployed template.

8. Click Next.

9. Select the type of configuration: Small, Medium, or Large.

10. Click Next.

11. If you are using vCenter, under Inventory Location, select the data center to which you want to 
deploy the image.

12. Click Next.
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13. If you have more than one host or a cluster, on the Host/Cluster window, specify the host/cluster IP 
address.

14. Click Next.

15. If you have more than one datastore, select the datastore in which to store the virtual machine files 
from the list.

16. Click Next.

17. Select the type of disk formatting you will use: Thick or Thin. 

For more information regarding thick and thin disk formatting, see the Mitel Virtual Appliance Deploy-
ment Solutions Guide.

18. Map the networks.

19. Click Next.

20. Verify the .ova template options and click Finish. 

VMware will deploy your virtual machine.

Post-deployment installation and configuration

This section details all of the post-deployment installation and configuration instructions required to make 
MiContact Center Business operational once you have deployed your .ova virtual machine.

Installing and configuring MiContact Center Business

To install and configure MiContact Center Business 
1. From vSphere Client, power on and launch the newly created virtual machine. 

Windows will begin setting up your computer, then reboot, and then finish setting up your computer.
2. On the Settings screen, select Country or Region, App language, and Keyboard layout.

3. Click Next.

4. Enter the Microsoft Windows product key.

5. Click Next.

6. Review the Microsoft Windows license terms and select Accept.

7. When prompted to enter the Administrator password, enter and reenter the password.

8. Click Finish.

9. On the login screen, log in as an Administrator. 

The Initial Configuration Tasks window opens.
10. Under Provide Computer information, click Configure networking and configure an IP address for 

the server.

11. Click OK.

12. Under Provide Computer information, click Provide computer name and domain, give the 
computer a meaningful name, and, optionally, join a domain.
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13. Click OK.

14. Under Activate Windows, click Activate Windows.

15. Under MiContact Center, click Install MiContact Center.

16. Click Deploy Enterprise Server.

17. Review the product announcements and click Next.

18. Select the installation path and click Next.

19. On the Product Registration window, the wizard prompts you to select one of the following licensing 
options, then click Next. 

NOTE: To ensure you are able to register online, any firewalls and proxies must be configured to allow 
traffic over port 80 to IP address 142.46.199.66. 

– If an active Internet connection is available and you can access the license server, you must register 
online. Select I would like to register now. The license key will be provided over the phone or by 
email by Mitel during the purchasing and registration process. After License key, paste the entire 
license key. You must submit your registration information to Mitel and implement your license files 
within thirty days to complete your software registration

– If you do not have access to the Internet or if you cannot access our license server, select I would 
like to register later. Selecting this option will install a temporary demo license. To obtain the 
licensing key, customers can contact their approved vendor. Certified channel technicians can 
contact Mitel Technical Support.

20. Select the features and click Next.

21. Configure the IP Address, language, country, and time zone.

22. Click Next.

23. Select the SQL Server instance and credentials.

24. Click Next.

25. Enter the Administrator account password and select the method of authentication.

26. Click Next.

27. The installation begins.

28. Click Finish.

29. Log on to YourSite Explorer.

30. Add and configure your media servers.

31. Configure the YourSite database using synchronization. 

NOTE: Before running synchronization, you must either disable Windows Firewall or add appgw.exe 
to the firewall exclusion list.
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Real-time Monitors

The Enterprise Server continuously updates the real-time applications with gateway data and simultane-
ously updates connected clients through Transmission Control Protocol-Internet Protocol (TCP/IP). 
Real-time monitors are automatically updated to reflect device and device group changes made in Your-
Site Explorer. Supervisors and agents are provided with point-and-click access to real-time performance 
statistics for their contact center, enabling them to identify issues in contact center performance and see 
who is available to answer or assist with calls.
The real-time applications include Contact Center Client, Ignite (WEB), and WallBoarder. In Contact 
Center Client and Ignite (WEB), supervisors and agents can view real-time voice statistics and the phone 
availability of contact center agents and employees. In contact centers that have the Multimedia Contact 
Center optional application, supervisors and agents can view real-time voice, email, chat, SMS, and open 
media statistics. WallBoarder displays text messages and contact center statistics on one or more Spec-
trum Light Emitting Diode (LED) reader boards (wall signs). WallBoarder administration details are 
included in the MiContact Center Business Installation and Administration Guide.
Call recordings are initiated in Contact Center Client and are appended to specific Lifecycle reports.
In addition to real-time monitors, Contact Center Client includes the following application areas: 
• Interactive Contact Center 

Using Interactive Contact Center, you can control the availability of agents and ACD queues. Agents 
can log themselves on or off, and place themselves in or remove themselves from Make Busy or Do 
Not Disturb.
See "Interactive Contact Center".

• Auditor 
Using Auditor, supervisors can view the historical real-time events that occurred on a particular date, 
in the sequence they occurred, at your own pace.
See "Auditor".

• Management Console 
Using Management Console, System Administrators can restart services, administer the database, 
and perform maintenance functions.
System administration is described in the MiContact Center Business Installation and Administration 
Guide.

• Data-mining 
The ACD Inspector searches for agent and ACD queue event records. The SMDR Inspector searches 
through SMDR data to find specific contact center events.
Data mining is described in the MiContact Center Business Installation and Administration Guide.

• Contact Center Chat 
Contact Center Client provides instant messaging capabilities for employees. Contact Center Chat 
provides the online chat presence of employees, including Online, Offline, and Away. Employees can 
view the availability and presence of other employees before they transfer calls or send online chat 
messages. With Microsoft Skype for Business Server, Contact Center Chat integrates with Skype for 
Business to provide enhanced presence.
See "Using Contact Center Chat".

The following applications and features reside in Contact Center Client: 
• Interactive Visual Queue 
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Interactive Visual Queue is an optional application that enables agents to monitor calls within queues, 
move calls from busy queues to less active queues, and call back abandoned callers.
See "Interactive Visual Queue".

• Contact Center PhoneSet Manager and Contact Center Softphone 
Contact Center PhoneSet Manager and Contact Center Softphone are optional applications that en-
able employees to use their desktop computers as IP-based phones.
See "Contact Center PhoneSet Manager and Contact Center Softphone".

• Contact Center Screen Pop 
Contact Center Screen Pop is an optional application that launches applications or webpages. In ad-
dition, it enables agents to automatically receive caller and account information via pop-ups on their 
computer monitors every time they receive calls.
Contact Center Screen Pop configuration and details are included in the MiContact Center Business 
Installation and Administration Guide.

• Contact Center Chat with Skype for Business 
With the addition of Microsoft Skype for Business Server, employees and supervisors use Skype for 
Business as their default instant messaging client. The presence of all company employees is natively 
delivered in Contact Center Client. Contact center employees can view the presence of both internal 
and external contacts to determine if they are available to communicate. In addition to Available, Of-
fline, and Away, employees see In a Meeting, Busy, In a call, Do Not Disturb, Be Right Back, and other 
presence indicators.
See "Using Contact Center Chat with Skype for Business".

Contact Center Client
NOTE: 
• Your ability to view real-time monitors and devices in Contact Center Client is dependent on adminis-

trative security settings.
• An employee must be a member of an employee group in order for you to view the employee on the 

employee group monitors in Contact Center Client. A queue must be a member of a queue group in 
order for you to view the queue on the queue group monitors in Contact Center Client.

• The number of employees extensions logged on at any time must be consistent with your software 
license.

Contact Center Client uses ribbons for device and monitor control. (See the following figure.)
Figure 16.1: Contact Center Client ribbon

 

Some tabs that display in the ribbon are dependent upon which monitor is active. These are referred to 
as context sensitive tabs. When you enable context sensitivity for monitors, the associated context sensi-
tive tab for the active monitor automatically becomes the active tab. See the following table for a list of the 
associated context sensitive tabs for each monitor. See the following figure for an example of context 
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sensitivity enabled for the Agent State by Position monitor. Note that the Agent and Monitor Control tabs 
display in the ribbon.
NOTE: The options that display in the Contact Center Client ribbon are dependent upon your individual 
security settings. Options which you are not given access to will not display.

Table 16.1:Context sensitivity options display per monitor

Monitor Associated context sensitive tabs

Agent State by Position Agent and Monitor Control tabs

Extension State by Position Extension and Monitor Control tabs
NOTE: When an agent is logged into an extension, 
the context sensitivity tab displays 'Agent Control'. 
When no agent is logged into the extension, the 
context sensitivity tab displays 'Extension 
Control'.

Extension Now Monitor Options tab

Agent State by Time Agent and Monitor Control tabs

Agent State by Time for Queue Agent and Monitor Control tabs

Employee State by Time Employee and Monitor Control tabs

Agent Shift Agent and Monitor Control tabs

Queue by Period Monitor Options tab

Queue Now Monitor Options tab

Queue Group Now Monitor Options tab

Queue Performance Chart Options tab

Queue Group Performance Chart Options tab

Queue Chart Options tab

Queue Group Chart Options tab

Interactive Visual Queue n/a
NOTE: Context sensitivity is not supported for the 
Interactive Visual Queue monitor
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Figure 16.2: Context sensitivity example - Agent Control tab

Starting Contact Center Client

You start Contact Center Client to access real-time functionality.Supervisors and agents can view 
real-time voice statistics. In contact centers that have the optional Multimedia Contact Center application, 
supervisors and agents can view real-time voice, email, chat, SMS, and open media statistics. After 
starting Contact Center Client, you can choose to minimize it to either the system tray or the taskbar, 
depending on your operating system.
NOTE: Launching client-side desktop applications from the task bar causes them to bypass the MiContact 
Center Updater Service process. To ensure successful updates from the Enterprise Server, after an 
upgrade close all client-side applications for 15 minutes or reopen them from the Start menu/Start screen.
To start Contact Center Client 
1. Open Contact Center Client.
2. If prompted, type your Username and Password and verify the Enterprise Server IP address.

3. If you use Secure Socket Layer, select SSL.

4. Optionally, select Remember my credentials.

5. Click Login.

To display Contact Center Client in the taskbar 
1. In Contact Center Client, click the File tab.
2. Click Options.

3. Clear the Hide when minimized check box and click OK. 

Contact Center Client, when minimized, will display in the taskbar.
4. To save the profile, click File > Save as.

5. Type a Name for the profile and click OK. 

The profile is saved and will automatically be applied each time you open Contact Center Client.
When your System Administrator changes device settings (such as changes to naming or associa-
tions between devices), they will be automatically reflected in your Contact Center Client user profile.
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Configuring Contact Center Client options

You can customize the Contact Center Client user interface and real-time monitor device control and 
display options by accessing the Options menu.
To configure Contact Center Client options 
1. In the ribbon, click the File tab.
2. Click Options. 

The Options window displays.
See the following figure.

3. Under User interface display, select a Toolbar style, Real-time icon type, Background color, 
Page size, and whether you want to hide Contact Center Client when the window is minimized.

4. Select Context Sensitivity for Monitors if you want the context sensitive tab to automatically become 
the active tab when you select a monitor. 

NOTE: Monitor context sensitivity is enabled by default.
5. Select Context Sensitivity for Soft phone if you want the soft phone tab to automatically become 

the active tab when a call is received. 

If the Soft phone toolbar is floating, context sensitivity does not apply. Soft phone context sensitivity 
is disabled by default.

6. Select the Display monitor device control option check box if you want to be able to see the option 
for monitor control when you right-click cells in a real-time monitor. 

NOTE: Monitor control enables you to simultaneously control all of the agents on a monitor and is 
only available if you have appropriate permissions.

7. Configure Time format options. 

The options you select will display in the real-time monitor cells.
8. Under Full name format, select how you want agent and employee first and last names to display in 

real-time monitors.

9. Click OK.

Figure 16.3: Contact Center Client options
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Adjusting the Contact Center Client view

You can adjust the way you view Contact Center Client features on your desktop.
To adjust the view 
1. Click View in the Contact Center Client ribbon. 

The View options ribbon opens.
See the following figure.

Figure 16.4: View options ribbon
 

2. To change the way monitors display inside Contact Center Client, select from the options in the 
Window Docking column.

3. To adjust the position of the Contact Center Client window on your desktop, select from the options 
in the Screen Docking column.

4. If you want Contact Center Client to always display on top of other applications on your desktop, click 
Always on top.

5. Enable the Status Bar if you want the status bar to be visible at the bottom of the Contact Center 
Client window. 
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See the following figure.
Figure 16.5: Status bar

6. To open Voice, Email, Chat, or SMS legends, select from the options in the Legends column.

Employee and Agent states

NOTE: 
• If Contact Center Client becomes disconnected from the server, upon re-connection the following 

states will automatically be synchronized with the server.
The following table lists the employee states and their corresponding icons.
The following table lists the agent states and their corresponding icons.
Table 16.2:Employee states  (Sheet 1 of 3)

Term Icon Meaning

Ringing
 

An ACD interaction ringing on 
the employee, waiting to be 
handled

ACD An employee handling an ACD 
interaction

ACD Hold An employee who has placed 
an ACD interaction on hold

Idle An employee logged on and 
waiting to receive an interaction

Non ACD An employee involved in an 
incoming Non ACD interaction 
or employee-originated voice 
interaction

Non ACD Hold An employee who has placed a 
Non ACD voice interaction on 
hold

Outbound An employee on an outgoing 
voice interaction
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Outbound Hold An employee who has placed 
an outgoing voice interaction on 
hold

Do Not Disturb An employee who has activated 
Do Not Disturb and is not 
available to receive any ACD or 
Non ACD interactions

Make Busy An employee who is not 
available to receive ACD 
interactions but can receive 
transferred interactions and 
voice interactions dialed directly 
to the employee
This icon also displays when an 
agent is in the Reseize Timer 
state. When voice agents fail to 
answer a voice interaction, 
agents are placed in Make Busy 
(Reseize Timer)
This icon also displays when an 
external hot desk agent is in the 
Reseize Timer state

System Make Busy An employee that the system 
has put into a state where they 
cannot receive ACD contacts. 
For example, if an employee is 
offered a communication and 
does not answer, they will be 
put into System Make Busy for 
a predetermined length of time.

Work Timer An employee who is completing 
post-contact work, such as 
paperwork, and is unavailable 
to receive interactions of that 
media type

Logged Off An employee not currently 
logged in to any queue

Table 16.2:Employee states (Continued) (Sheet 2 of 3)

Term Icon Meaning
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Logged In Not Present An employee logged in but not 
present in any of their agent 
groups, and employees not 
present in a media type across 
all groups.

Unavailable An employee who has not 
generated any activity since Mi 
Contact Center Business was 
started

Table 16.3:Agent states  (Sheet 1 of 3)

Term Voice Email Chat SMS Meaning

Ringing An ACD interaction 
ringing on an 
agent, waiting to 
be handled

ACD An agent handling 
an ACD interaction

ACD Hold An agent who has 
placed an ACD 
interaction on hold

Idle An agent logged 
on and waiting to 
receive an 
interaction

Non ACD - - - An agent involved 
in an incoming Non 
ACD interaction or 
agent-originated 
voice interaction

Non ACD 
Hold

- - - An agent who has 
placed a Non ACD 
voice interaction 
on hold

Outbound - - - An agent on an 
outgoing voice 
interaction

Table 16.2:Employee states (Continued) (Sheet 3 of 3)

Term Icon Meaning
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Outbound 
Hold

- - - An agent who has 
placed an outgoing 
voice interaction 
on hold

Do Not 
Disturb

An agent who has 
activated Do Not 
Disturb and is not 
available to receive 
any ACD or Non 
ACD voice 
interactions

Make Busy An agent who is 
not available to 
receive ACD 
interactions but 
can receive 
transferred 
interactions and 
voice interactions 
dialed directly to 
the agent
This icon also 
displays when an 
external hot desk 
agent is in the 
Reseize Timer 
state

System 
Make Busy

An employee that 
the system has put 
into a state where 
they cannot 
receive ACD 
contacts. For 
example, if an 
employee is 
offered a 
communication 
and does not 
answer, they will 
be put into System 
Make Busy for a 
predetermined 
length of time.

Table 16.3:Agent states (Continued) (Sheet 2 of 3)

Term Voice Email Chat SMS Meaning
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Extension states

NOTE: 
• If your Contact Center Client becomes disconnected from the server, upon re-connection the extension 

states will automatically be synchronized with the server.
• If an agent is logged into the extension, agent state icons will display. See "Employee and Agent 

states".

The following table lists the extension states and their corresponding icons.

Work Timer An agent who is 
completing 
post-contact work, 
such as 
paperwork, and is 
unavailable to 
receive 
interactions of that 
media type

Unknown An agent who has 
not generated any 
activity since Mi 
Contact Center 
Business was 
started

Logged Off An agent not 
currently logged in 
to any queue

Logged In 
Not Present

An agent logged in 
but not present to 
any of their agent 
groups, and agents 
not present to a 
media type across 
all groups

Table 16.4:Extension states  (Sheet 1 of 3)

Term Icon Meaning

Ringing Call is ringing on the extension 
and waiting to be handled

Table 16.3:Agent states (Continued) (Sheet 3 of 3)

Term Voice Email Chat SMS Meaning
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Idle Extension is waiting to receive a 
call

Non ACD Extension is involved in an 
incoming call or an internal 
extension-originated call

Non ACD Hold Extension has placed an 
incoming call or an internal 
extension-originated call on 
hold

Outbound Call Extension is on an outgoing call

Outbound Hold Extension has placed an 
outgoing call on hold

Forwarded to Extension has set all incoming 
calls to be forwarded to an 
alternate answer point

Camp on Extension is on a call and an 
incoming call is camped on 
(waiting to be answered)

Off Hook Extension's phone is off the 
hook, so cannot receive calls

Do Not Disturb Extension has activated Do Not 
Disturb and is not available to 
receive calls

Logged Off Extension is not currently 
logged on and is unavailable to 
take calls

Logged In Not Present Extension is removed from its 
Ring Groups

Table 16.4:Extension states (Continued) (Sheet 2 of 3)

Term Icon Meaning
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Understanding Contact Center Client features

Contact Center Client has agent, queue, queue chart, and call note monitors. For information on adding 
and viewing call notes, see "Adding call notes to a call".
You can perform the following tasks on the monitors by either right-clicking within the monitor or selecting 
options via the Contact Center Client ribbon: 
• Call recording
• Open monitors
• Dock monitors
• Add and remove device IDs
• Sort monitor devices
• Rearrange cells
• Set monitor dimensions
• Freeze and unfreeze columns
• Hide and show columns
• Filter device variables
• Set alarms
• Clear alarms
• Define monitor styles
• Group data
• Print monitors
• Arrange windows
• Modify the view
• Build marquee monitors to broadcast statistics and messages
• Chat online with other employees

Contact Center Client options

The following options apply to real-time monitors.
Call recording
On the Agent State by Time, Agent State by Position, Agent State by Queue by Time, and Extension by 
Position monitors, the Call recording option enables you to start, stop, and restart call recording at any 
time during a call. See "Recording calls".
Clear alarms
The Clear alarms command clears any current performance variable threshold alarms.
Set alarms

Unknown Extension has not generated 
any activity since MiVoice 
Analytics was started

Table 16.4:Extension states (Continued) (Sheet 3 of 3)

Term Icon Meaning
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The Set alarms command specifies performance thresholds for queues, extensions, and agents.
Add/Remove devices
The Add/Remove devices command adds or removes devices or device groups from the monitor. If you 
add agents, they are added to the bottom of the monitor.
Set table dimensions
On the Agent State by Position, Extension State by Position, and Employee State by Position monitors, 
the Set table dimensions command adds or deletes columns or rows. If you delete devices, they are 
deleted them from the lower-right side of the monitor.
Size table to frame
On all monitors, the Size table to frame command adjusts the table to fit within the frame
Sort monitor
On the Agent State by Position, Extension State by Position, and Employee State by Position monitors, 
the Sort monitor by Agent ID, name, state, or extension command sorts agents by Agent ID, name, state 
and time in state, or extension.
Note that you cannot drag and drop devices between monitors.
Filter device variables
On the Extension Now, Agent Shift, Queue by Period, and Queue Now monitors the Filter device variables 
command filters the data based on conditions you specify and displays a subset of data on the monitor.
General
On all monitors, under Properties, the General option specifies the monitor name and enables the hori-
zontal and vertical scroll bars.
On the queue monitors, you can also enable grouping.
On the extension, agent, and employee monitors you can also display tool tips, display a pattern upon 
failover, and display instant messaging online presence indicators.
On the Agent and Employee State by Time monitors, you can also sort logged off agents by the longest 
logged off first.
Print monitor
The Print monitor command prints the current monitor.
Enable grouping
Under Properties, the Enable grouping option displays a grouping panel to which users can drag columns. 
The grouping order determines the order in which the rows display. The Enable grouping option affects 
all monitors that contain columns.
Row settings
Under Properties > Layout, the Row settings option specifies the background color and font color of rows, 
and the font type and text alignment.
Row alternate settings
Under Properties > Layout, the Row alternate settings option specifies the background color and font 
color of alternate rows, and the font type and text alignment.
Column settings
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Under Properties > Layout, the Column settings option specifies the background color and font color of 
columns, and the font type and text alignment.
Column dimensions
Under Properties > Layout, the Column dimensions option specifies the column height and width.
Column order
Under Properties > Layout, the Column order option hides or displays individual columns, and specifies 
the order of columns across the monitor.
Monitor style
Under Properties > Layout, the Monitor style option specifies styles and skins (sets of styles) for the 
monitor, and the Card design option specifies how information is displayed in the cells of extension, agent, 
and employee monitors.
Cascade
When you right-click a monitor tab, under Windows, the Cascade command distributes active monitors 
down and across the Contact Center Client window.
Tile vertically
When you right-click a monitor tab, under Windows, the Tile vertically command distributes active moni-
tors across the Contact Center Client window.
Tile horizontally
When you right-click a monitor tab, under Windows, the Tile horizontally command distributes active 
monitors down the Contact Center Client window.
Dock Contact Center Client
When you right-click a monitor tab, under Windows, the Dock Contact Center Client command docks 
Contact Center Client at the top, bottom, left, or right of your desktop.
Always on top
When you right-click a monitor tab, under Windows, and select the Always on top command, Contact 
Center Client always displays on your desktop on top of all other open applications.
View
The View command hides or displays the main menu, status bar, real-time monitors, voice, email, chat, 
SMS, and open media legends.

Diagnostics monitor

The log and error monitors are accessed via Contact Center Client.
To access log and error monitors
1. Click Tools in the Contact Center Client ribbon.
2. Click either Log Monitor or Error Monitor, depending on what kind of log information you want to 

review. 

See the following figure
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Diagnostics Monitor

Viewing agent availability

Contact Center Client provides instant messaging capabilities for both supervisors and agents and is typi-
cally used by contact center employees. Contact Center Chat provides the online chat presence of 
contact center employees, including Online, Offline, and Away. On the agent, employee, and extension 
monitors, agents can view the availability and presence of other contact center employees before they 
transfer calls or send online chat messages. (See the following figure.) If an agent cell in a monitor is 
grayed out, the phone is not connected to the network and considered out of service. The out of service 
state applies to phones that are not connected to the network, remote agents and employees that have 
lost their Internet connection, phones that are physically disconnected or malfunctioning, or employees 
that are not logged into their soft phone.

Figure 16.6: Agent State by Position - viewing agent availability and online presence
 

With the addition of Microsoft Skype for Business Server, agents and supervisors use Skype for Business 
Client as their default instant messaging client. The presence of all company employees is natively deliv-
ered in Contact Center Client. Contact center employees can view the presence of both internal and 
external contacts to determine if they are available to communicate. In addition to Available, Offline, and 
Away, employees see In a Meeting, Busy, In a call, Do Not Disturb, Be Right Back, and other presence 
indicators. (See the following figure.)

Figure 16.7: Employee State by Position - viewing employee availability and enhanced 
presence

The following monitors display agent activities: 
• Agent State by Position
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• Employee State by Position
• Extension State by Position
• Agent State by Time
• Employee State by Time
• Agent Shift

Extension, Agent, and Employee State by Position

The Extension, Agent, and Employee State by Position monitors provide real-time information in cells 
that you can arrange to mirror your floor plan: you can view extensions, agents, or employees by their 
physical position in your contact center. In addition, these monitors enable you to view the current status 
of general business extensions. Card designs enable you to customize the information displayed in the 
cells. See "Customizing the information displayed on position and time monitors".
Agents can join multiple agent groups and therefore answer for multiple queues. However, each agent 
has only one ID and displays in a single cell of each applicable monitor. The agent activity that displays 
in the monitor cell reflects their current overriding action.
When you first open a monitor, you can select a card design: 
• The Classic card displays the agent state, time in the state, presence, agent/employee name, agent 

login ID/employee ID, and extension number (or queue name for voice agents on ACD or on ACD 
Hold).

• The Caller ID card displays the caller name and number (ANI), the number the caller/employee dials 
for incoming/outgoing calls, the state, time in the state, presence, agent/employee name, agent login 
ID/employee ID, and extension number (or queue name for voice agents on ACD or on ACD Hold).

• Custom cards you create and share display customized extension/agent/employee and/or caller infor-
mation

Caller ID information is displayed when 
• Extensions, Agents, and employees are in the following real-time states: ACD, ACD Hold, Ringing, 

Non ACD, Non ACD Hold, Out, and Out Hold Time
• Extensions are in the following real-time states: Inbound and Outbound

You can set alarms for all real-time statistics and for caller ID information, such as the caller name and 
number.
NOTE: Before you can select the Caller ID card on the Add devices window of monitors, you must make 
the card available. To do so, right-click an open monitor, select the Caller ID card under Properties, Layout 
> Card design and click Apply.
In a fault tolerant setup, if a network outage occurs the cells in the agent, employee, and extension moni-
tors display a crisscrossed pattern to identify agents who have homed to their secondary controllers.
If an agent cell in a monitor is grayed out, the phone is not connected to the network and considered out 
of service. The out of service state applies to phones that are not connected to the network, remote agents 
and employees that have lost their Internet connection, phones that are physically disconnected or 
malfunctioning, or employees that are not logged into their soft phone.

Viewing the activities of agents who can log on to multiple voice queues

In the following figure, the Agent State by Position monitor shows three cells for Andre Bourque, each with 
a different agent ID. The first two cells show Andre logged off of the telephone system. The third cell 
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shows Andre’s current state. Andre is logged on to Queue 151 using Agent ID 2013. He has been on an 
ACD call for 12 minutes and 50 seconds.

Figure 16.8: Agent State by Position - viewing multiple agent IDs
 

Agents can log on to the telephone system using only one agent ID at a time. If your agents have multiple 
voice IDs (and therefore multiple cells) the Agent State by Position monitor becomes cluttered.
If you have agents who are cross trained to answer calls for different departments (and log in and out of 
various voice queues) the telephone system requires you assign the agents multiple IDs. You can use the 
Agent State by Position monitor to view the activities of each department. You create an Agent State by 
Position monitor for each department. When you arrange the cells for the agents in the same order for 
each department, you can easily compare the activities of one department with another.

Viewing the current logged on states of agents who log on to multiple queues

If you have voice agents who are cross trained to answer calls for different departments (and log in and 
out of several queues) the telephone system requires you assign the agents multiple IDs. If a voice agent 
has multiple agent IDs and you want to view the agent’s current logged on state only, you use the 
Employee State by Position monitor.
To view the monitor, you open the Employee State by Position monitor and select employees to add to 
the monitor. The monitor shows one cell for Andrew, listing his current state and agent ID. (See the 
following figure.)

Figure 16.9: Employee State by Position - viewing the ID to which the agent is logged on
 

Andrew is currently logged on to Extension 1564 using Agent ID 1559. Sometime later you notice Andrew 
is logged on to Extension 1059 using Agent ID 1788. (See the following figure.)

Figure 16.10: Employee State by Position
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Agent State and Employee State by Time

The Agent State by Time and Employee State by Time monitors provide real-time agent information under 
ACD, Idle, Non ACD, Unavailable, and Logged Off column headings. They display the same real-time 
information as that of the Extension State by Position, Agent State by Position, and Employee State by 
Position monitors. See "Extension, Agent, and Employee State by Position".
If an agent is in an email, chat, or SMS agent state, the monitors display the queue number to which the 
agent is logged on. Each column lists agents in order of time in state. You can specify which columns of 
agent statistics are displayed, and the order in which they are displayed. You can sort logged off agents 
by the longest logged off first. (See the following figure.)
If you have agents who are cross trained to answer calls for different departments (and log in and out of 
various voice queues) the ACD routing system requires you assign the agents multiple IDs. You use the 
Employee State by Time monitor to view the activities of voice agents with multiple agent IDs. See 
"Viewing the current logged on states of agents who log on to multiple queues".

Figure 16.11: Agent State by Time
 

The following table lists the Agent State by Time and Employee State by Time column headings and their 
associated agent states.
Table 16.5:Agent State by Time and Employee State by Time column headings  (Sheet 1 of 2)

Category Associated agent states

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non ACD includes agents in Non ACD, in Non ACD Hold, 
Outbound agents, and Outbound Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, 
Work Timer, Reseize Timer, and Unknown

Logged in not present includes agents logged in but not present to any 
of their agent groups, and agents not present to a 
media type across all groups
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Agent State by Time for Queue

The Agent State by Time for Queue monitor is a Contact Center Client real-time monitor designed specif-
ically for contact centers using Agent Group Presence functionality. However, the Agent State by Time 
for Queue monitor is available for all media server types.
The Agent State by Time for Queue monitor is accessed from the Real Time tab in Contact Center Client 
and displays all agents configured in a specific queue and agents who are on ACD calls, idle, on Non ACD 
calls, unavailable, logged on to the system (but not present in the queue being monitored), and logged 
off. (See the following figure).
NOTE: 
• Virtual queue groups are shown under the Virtual queue groups section of the Agent State by Time for 

Queue monitor. Any Agent State by Time for Queue monitors that are monitoring virtual queues are 
marked in the title as (virtual).

• The Agent State by Time for Queue monitor does not support viewing Ring Groups.

Figure 16.12: Agent State by Time for Queue
 

The following table lists the Agent State by Time and Employee State by Time column headings and their 
associated agent states.

Log Off includes agents in the Logged Off and Offline 
(Ignite, WEB) states

Table 16.6:Agent State by Time for Queue column headings  (Sheet 1 of 2)

Category Associated agent states

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non ACD includes agents in Non ACD, in Non ACD Hold, 
Outbound agents, and Outbound Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, 
and Work Timer, and Reseize Timer

Table 16.5:Agent State by Time and Employee State by Time column headings (Continued) (Sheet 2 of 

Category Associated agent states
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To view the Agent State by Time for Queue monitor 
1. In the Contact Center Client ribbon, click the Real Time tab.
2. In the State by Time column on the ribbon, click Agent by Queue.

3. Select the queues to monitor. You can optionally sort members in either ascending or descending 
order.

4. Click OK.

Agent Shift

The Agent Shift monitor provides running totals of statistics on individual agents for the day. You can 
specify which columns of statistics are displayed, rearrange columns, and sort individual columns in 
ascending or descending order. (See the following figure.)

Figure 16.13: Agent Shift
 

Agent Shift column heading definitions

The following table describes the Agent Shift column headings.

Logged in not present includes agents logged in but not present to any 
of their agent groups, and agents not present to a 
media type across all groups

Log Off includes agents in the Logged Off, Unknown, and 
Offline (Ignite, WEB) states

Table 16.7:Agent Shift column headings  (Sheet 1 of 4)

Term Abbreviated Name Meaning

Agent State The agent's media type and 
current state

Table 16.6:Agent State by Time for Queue column headings (Continued) (Sheet 2 of 2)

Category Associated agent states
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Media Server Media Server The media server to which the 
agent is associated

Agent Shift Name Name The name of the agent being 
monitored

Agent login ID Agent login ID The login ID of the agent being 
monitored

Extension Number Extn # The extension where the agent 
logged in (voice only)

Logged On Log In The most recent time the agent 
logged in

Last Event Received Last Event Recd The most recent time an agent 
event occurred

Shift Time Shift Time The total elapsed time logged 
for the agent, calculated based 
on the difference between log in 
and last event received

ACD Time ACD Time The duration of ACD 
interactions handled, from 
agent pickup to completion (not 
including hold time)

ACD Hold Time ACD Hold Time The duration of time ACD 
interactions spent on hold

Non ACD Time Non ACD Time The duration of Non ACD 
interactions handled, from 
agent pickup to completion (not 
including hold time) (voice only)

Non ACD Hold Time Non ACD Hold Time The duration of time Non ACD 
interactions spent on hold

Outbound Time Out Time The duration of time agents 
spent handling outbound calls 
(voice only)

Outbound Hold Time Out Hold Time The duration of time outbound 
calls spent on hold, for agents 
(voice only)

Do Not Disturb Time DND Time The duration of time the agent 
entered the Do Not Disturb 
State

Table 16.7:Agent Shift column headings (Continued) (Sheet 2 of 4)

Term Abbreviated Name Meaning
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Make Busy Time MKB Time The number of times the agent 
entered the Make Busy state

Wrap Up Time Wrap Up Time The duration of time where 
Wrap Up Time was the 
overriding state for the agent. 
Wrap up time does not include 
any time spent making or taking 
interactions during the wrap up 
timer.

Do Not Disturb Count DND Cnt The number of times the agent 
entered the Do Not Disturb state

Make Busy Count MKB Cnt The number of times the agent 
entered the Make Busy state

ACD Count ACD Cnt The number of ACD interactions 
handled by the agent

Short ACD Count Shrt ACD Cnt The number of ACD interactions 
handled by the agent where the 
handle time was less than the 
Short Handle parameter

Non ACD Count Non ACD Cnt The number of Non ACD 
interactions handled by the 
agent (voice only)

Hold ACD Count Hold ACD Cnt The number of times ACD 
interactions were placed on 
hold (voice only)

Non ACD Hold Count Non ACD Hold Cnt The number of times Non ACD 
interactions were placed on 
hold

Outbound Count Out Cnt The number of outbound calls 
made by the agent (voice only)

Outbound Hold Count Out Hold Cnt The number of times outbound 
calls were placed on hold (voice 
only)

Contacts Per Hour Contacts Per Hour The total ACD interaction count 
minus the ACD short handle 
count, divided by the shift time 
for the agent

Table 16.7:Agent Shift column headings (Continued) (Sheet 3 of 4)

Term Abbreviated Name Meaning
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Viewing Agent and Extension Availability and Resiliency

Contact Center Client’s Agent, Employee, and Extension real-time monitors provide a visual indication if 
agents fail over to a resilient media server. In an Agent monitor (Agent State by Position, Agent State by 
Time, and Agent State by Queue by Time), if an agent fails over to the secondary voice media server, a 
cross-hatch pattern displays in the agent’s cell in the monitor. (See the following figure.)

Figure 16.14: Agent monitor with failed over agents
 

In an Employee monitor (Employee State by Position and Employee State by Time), if an employee’s 
agent fails over to the secondary voice media server, a cross-hatch pattern displays in the employee’s 
cell in the monitor. (See the following figure.)

On Failover On failover Indicates whether the primary 
media server is offline and has 
failed over to the secondary 
media server (voice only)

Agent Unavailable Percent Agt Unavail % The percentage of shift time for 
which the agent was 
unavailable to receive 
interactions

Logged In Not Present Time Logged In Not Present Time The duration of time the agent 
was logged into but not present 
to any of their agent groups, 
and the duration of time the 
agent was not present in a 
media type across all groups

Average Handle Avg Hndl The average amount of time the 
agent spent handling ACD 
interactions (ACD Time divided 
by ACD Count, excluding ACD 
Hold Time)

Occupancy Occp The duration of time the agent 
spent processing interactions, 
including ringing time

Table 16.7:Agent Shift column headings (Continued) (Sheet 4 of 4)

Term Abbreviated Name Meaning



525

CONTACT CENTER CLIENT
CHAPTER 16 REAL-TIME MONITORS

Figure 16.15: Employee monitor with failed over agents

In an Extension monitor, if a logged in agent who is associated to an extension fails over to the secondary 
voice media server, then a cross-hatch pattern is applied to the agent’s associated extension in the exten-
sion monitor. (See the following figure.)
NOTE: Extensions that fail over to the secondary voice media server do not have a cross-hatch pattern 
applied to their cell.

Figure 16.16: Extension monitor with failed over agents

Modifying visual indicator settings for agents failing over

By default, monitors are configured to display a pattern if agents fail over to a secondary media server. 
This setting is optional, however, and can be disabled on a monitor-by-monitor basis.
The following procedures explain how to
• Disable visual indicators for agents failing over
• Enable visual indicators for agents failing over

To disable visual indicators for agents failing over
1. Right-click in an open monitor and select Properties.
2. In the General tab, clear Display pattern when on failover.

3. Click OK.

To enable visual indicators for agents failing over
1. Right-click in an open monitor and select Properties.
2. In the General tab, select Display pattern when on failover.

3. Click OK.

Viewing extensions availability

In your business, you may be monitoring 
• Traditional or hot desking ACD agents who sit at different desks each day and who log on using their 

agent ID
• General business, traditional extensions (non-contact center employees) who sit at the same desks 

each day, are assigned their own desk phone extensions, and do not log on to their phones (their 
phones are programmed with their personal settings and are always active)
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• General business, hot desking extensions (non-contact center employees) who log on to any phone in 
the enterprise with a virtual extension configured with their personal settings. When the employee logs 
on the extension becomes active. When the employee logs off of the extension it goes out of service. 
(See the following figure.)

The following monitors are available for viewing extensions: 
• Extension State by Position
• Extension Now

Figure 16.17: Extension State by Position
 

You can set up your real-time monitor profile to include two or more Extension by Position monitors: one 
with cells that are arranged to show the whereabouts of agents employees in your contact center, and 
another that shows the status of general business extensions: active/inactive, inbound/outbound.
The Extension State by Position monitor shows the state of agents who are not logged into the system. 
You can use the Extension State by Position monitor to view the Non ACD activity of employees and the 
current state of general business extensions.
When a phone is out of service, the extension and employee cells in real-time monitors are grayed out. 
The out of service state applies to phones that are not connected to the network, remote employees that 
have lost their Internet connection, phones that are physically disconnected or malfunctioning, or 
employees that are not logged into their soft phone.
Extension Inbound
Extension Inbound refers to a general business extension on an inbound call.
Extension Outbound
Extension Outbound refers to a general business extension on an outbound call.
General business active extension
General business active extension refers to a Mitel desk phone/Contact Center PhoneSet 
Manager/Contact Center Softphone that is live with no ACD agents logged on (active extension), or an 
extension to which a general business hot desking user is logged on. The user is an active extension not 
logged on to any ACD queue.
General business inactive extension
General business inactive extension refers to a Mitel desk phone that has been unplugged or is damaged, 
or a soft phone that is not running because the computer is turned off or Contact Center Client is not 
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running, or a hot desking extension to which nobody is logged onan extension that is not active because 
the computer is turned off or Contact Center Client is not running.
Traditional or hot desking ACD agents who sit at different desks each day
If you have traditional or hot desking ACD agents who sit at different desks each day, you use the Exten-
sion State by Position monitor to view where they are sitting in the contact center. After you add Regis-
tration Directory Numbers (RDNs)/desk phone extensions to the monitor, you can arrange the cells to 
match the layout of your contact center.
When nobody is logged on to a particular extension, the monitor cell displays the General business active 
icon and the phone set RDN ID. When an agent logs on to the desk phone, the monitor cell displays the 
ACD agent status, (which can include information such as the time in state, queue reporting number, and 
Make Busy status), the agent ID, the agent name, and the RDN (at the bottom of the cell). Depending on 
the agent’s current state you may see additional information, such as the time in state, queue reporting 
number, or Make Busy status. If the Caller ID card design is selected, you will also see the caller name 
and phone number. (See the following figure.)
If you would prefer that Extension State by Position monitor cells be blank when there are no agents 
logged on to the telephone system, you can right-click the monitor, select Properties, and clear the Enable 
the general business view check box.
If an agent cell in a monitor is grayed out, the phone is not connected to the network and considered out 
of service. The out of service state applies to phones that are not connected to the network, remote agents 
or employees that have lost their Internet connection, phones that are physically disconnected or malfunc-
tioning, or employees that are not logged into their soft phone.

Figure 16.18: Extension State by Position

General business, traditional extensions who sit at the same desks each day
If you have general business, traditional extensions who sit at the same desks each day, you use the 
Extension State by Position monitor to view where they are sitting in the contact center. After you add their 
extensions to the monitor, you can arrange the cells to match the layout of your business, or arrange them 
alphabetically or by department.
When a general business employee is in Idle, the cell for the employee’s phone extension in the Extension 
State by Position monitor displays the employee’s name and extension number, and the General busi-
ness active icon. When the employee is on an incoming/outgoing call, the cell displays the Extension 
Inbound/Extension Outbound icon, the employee’s name and extension number, and the time in state. If 
the Caller ID card design is selected, you will also see the caller name and phone number. Either card 
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enables you to readily determine the online and phone availability of general business subject matter 
experts.
If you prefer that Extension State by Position monitor cells be blank when there are no agents logged on 
to the system, you can right-click the monitor, select Properties, and clear the Enable the general busi-
ness view check box.
General business hot desking employees who sit at different desks each day
General business, hot desking extensions can log on to any phone in the enterprise and access their 
personal settings. When adding extensions to the Extension State by Position monitor, you can arrange 
them alphabetically or by department.
When an employee is logged on, the monitor cell displays the General business active icon, icon and the 
employee’s name and extension. When the employee is on an incoming/outgoing call, the cell displays 
the Extension Inbound/Extension Outbound icon and the time in state. If the Caller ID card design is 
selected, you will also see the caller name and phone number. When the employee logs off, the monitor 
cell is grayed out (inactive). (See the following figure.)

Figure 16.19: Extension State by Position

Extension Now

The Extension Now monitor enables supervisors to view extension statistics in real time. The Extension 
Now monitor provides visibility to extensions. If an agent logs out of an extension displayed in this monitor, 
the extension will go out of service and will not be updated in real time. In the Extension Now monitor, you 
can specify which columns of statistics are displayed, rearrange columns, and sort individual columns in 
ascending or descending order. (See the following figure.)
NOTE: Extensions must be licensed to display statistics.

Figure 16.20: Extension Now monitor
 

Extension Now column heading definitions

The following table indicates the current status of the extension and describes the real-time and 
over-the-business-day Extension Now extension statistics.
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Table 16.8:Extension Now extension statistic column headings  (Sheet 1 of 2)

Term Meaning

Media Server The extension’s media server

Name The extension name

Reporting The extension’s reporting number
NOTE: The extension reporting number is also its dialable number.

Last Event Recd The most recent time an extension event occurred

ACD Time The duration of ACD(Ring Group) interactions handled, from extension 
pickup to completion (not including hold time)

ACD Hold Time The duration of time ACD(Ring Group) interactions spent on hold

Non ACD Time The duration of Non ACD interactions handled, from extension pickup to 
completion (not including hold time)

Non ACD Hold Time The total time for Non ACD calls put on hold

Out Time The number of outbound calls made by the extension

Out Hold Time The duration of time outbound calls spent on hold for extensions

DND Time The duration of time where Do Not Disturb was the overriding state for 
the extension

 DND Cnt The number of times the extension entered the Do Not Disturb state

ACD Cnt The total number of ACD(Ring Group) calls answered by the extension

Shrt ACD Cnt The total number of ACD(Ring Group) calls answered by the extension 
that lasted less than the Short Handle parameter

ACD Hold Cnt The number of times the extension put ACD(Ring Group) calls on hold

Non ACD Cnt The total number of Non ACD calls answered by the extension

Non ACD Hold Cnt The number of times Non ACD calls were put on hold

Out Cnt The total number of outgoing calls the extension made

Out Hold Cnt The total number of times the extension put outgoing calls on hold

Calls Per Hour The average number of incoming ACD calls answered by the extension 
per hour since the extension was logged in

On Failover Indicates whether or not the extension has failed over to the secondary 
media server

Not Present Time The duration of time the extension was in service but not present in a 
Ring Group
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Viewing queue statistics

NOTE: If an agent fails to answer an ACD call after X seconds or X rings or refuses a voice interaction, the 
agent is placed in Reseize Timer state instead of System Make Busy state. This default behavior can be 
reset to place agents into System Make Busy state rather than the Reseize Timer state. The system then 
re-queues the call, in the same queue, and offers it to the next available agent. 
The following monitors display queue statistics: 
• Queue by Period
• Queue Now
• Queue Group Now

Queue by Period

The Queue by Period monitor collates queue statistics by 15-minute intervals over a 24-hour period. The 
monitor refreshes each time there is a change in a statistic and each 15-minute interval. The Queue by 
Period monitor always displays the current 15 minute interval at the top of the monitor. You can specify 
which columns of statistics are displayed, rearrange columns, and sort individual columns in ascending 
or descending order. (See the following figure.)

Figure 16.21: Queue by Period
 

Queue by Period column heading definitions

The following table describes the Queue by Period column headings.
NOTE: Statistics that do not support Ring Groups display as '0'.

Avg Handl The average amount of time the extension spent handling ACD 
interactions (ACD Time divided by ACD Count, excluding ACD Hold 
Time)

Occp The total time the extension spent in an occupied state (occupied state 
excludes idle time)

Table 16.9:Queue by Period column headings  (Sheet 1 of 4)

Term Abbreviated Name Meaning

Interval time Interval The 15 minute interval of time

Table 16.8:Extension Now extension statistic column headings (Continued) (Sheet 2 of 2)

Term Meaning
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Offered Offr The total number of calls offered 
to the queue during the 
15-minute interval

Handled Hndl The total number of calls 
answered by members during 
the 15-minute interval

Short Abandoned Shrt Abn During the 15-minute interval, 
the total number of calls 
abandoned before the short 
abandon time configured 
against the queue in YourSite 
Explorer

Abandoned Abn The total number of calls 
abandoned during the 
15-minute interval before being 
answered by members

Interflowed Intrfl The total number of calls 
interflowed during the 
15-minute interval

Requeued Re Q The total number of calls 
re-queued during the 15- minute 
interval
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

% Handled by 1-4 % Hndl by 1-4 A count of all of the calls 
answered by the first, second, 
third, and fourth answer points 
during the 15-minute interval
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Table 16.9:Queue by Period column headings (Continued) (Sheet 2 of 4)

Term Abbreviated Name Meaning
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#Handled by 1-4 # Hndl by 1-4 The number of calls answered 
by the first, second, third, and 
fourth answer points during the 
15-minute interval
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Total Conversation Time Ttl Conv Time The total time members spent 
talking to callers during the 
15-minute interval

Average Conversation Time Avg Conv time The average time members 
spent talking to callers during 
the 15-minute interval

Average Time to Handle Avg Time Hndl The average amount of time 
callers waited in queue before 
members answered their calls 
during the 15-minute interval

Average Time to Abandon Avg Time Abn The average amount of time 
callers waited in queue during 
the 15-minute interval before 
they abandoned their calls

Average Time to Interflow Avg Time Intrfl The average amount of time 
callers waiting in queue during 
the 15-minute interval before 
being interflowed

Service Level % Today Scv Lvl % Tday During the 15-minute interval, 
the percentage of calls 
answered within the Service 
Level Time specified for the 
queue

% Handled % Hndl During the 15-minute interval, 
the percentage of calls 
answered compared to the total 
number of calls offered to the 
ACD queue for the day

Table 16.9:Queue by Period column headings (Continued) (Sheet 3 of 4)

Term Abbreviated Name Meaning
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Queue Now and Queue Group Now

The Queue Now monitor enables supervisors to view queue statistics in real time, as well as expand 
individual queues in the monitor to view statistics on each queue’s associated member agents or exten-
sions. When you expand the Queue Now monitor to display the Name column, the monitor also displays 
member presence in the queue. Presence is indicated by a colored star in the Present column. A green 
star indicates the member is present in the queue. A gray star indicates the member is not present in 
the queue. A gray row indicates that the member is not logged in (for agents and hot desk users) or out 
of service (for extensions).
The Queue Group Now monitor enables supervisors to view aggregated statistics for Reporting, Virtual, 
and Unified queue groups in real-time, as well as expand individual queue groups in the monitor to view 
statistics for the queue group’s associated queues.
On the Queue Now monitor, you can specify which columns of statistics are displayed, rearrange 
columns, and sort individual columns in ascending or descending order. You can expand a queue and 
view statistics on the members associated with the queue. (See the following figure.)
NOTE: Prior to Version 7.1, Queue Now monitors displayed the agent groups belonging to the queues with 
agent group statistics. As of Version 7.1, this functionality has been removed. Instead, queue members 
are grouped by agent group.

Figure 16.22: Queue Now

Wrap Up Wrap Up The total time the agent spent in 
the Work Timer state during the 
15-minute interval
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Make Busy Make Busy The total time the agent spent in 
the Make Busy state during the 
15-minute interval
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Occupancy Occp The total time the queue 
members spent in an occupied 
state during the 15-minute 
interval (occupied state 
excludes idle time)

Table 16.9:Queue by Period column headings (Continued) (Sheet 4 of 4)

Term Abbreviated Name Meaning
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NOTE: 
• Contact Center Client updates Longest Waiting statistics every fifteen seconds, or more frequently as 

records are received from the ACD routing system.
• If the ACD routing system has not updated MiContact Center Business with real-time statistics for 

Contacts Waiting and Agents Available within the last 90 seconds, question marks display in place of 
these statistics.

• Agents present in the queue and idle whose extensions are ringing are included in 'Available' statistics. 
Agents whose extensions are ringing are not included in Unavailable statistics.

• The Average Handling Time is the Average interaction Time plus the Average Hold Time. If the call is 
put on hold, transferred, or conferenced, these times are added to the Average Handling time value.

• If an agent fails to answer an ACD call after X seconds or X rings or refuses a voice interaction, the 
agent is placed in Reseize Timer state instead of System Make Busy state. This default behavior can 
be reset to place agents into System Make Busy state rather than the Reseize Timer state. The system 
then re-queues the call, in the same queue, and offers it to the next available agent.

• The abandoned media column in the Interactive Visual Queue monitor displays all abandoned calls. 
The abandoned column in the Queue Now monitor does not include short abandons as abandoned 
calls. Because of this difference, you may notice discrepancies between the abandoned call informa-
tion in these two monitors.

• Statistics that do not support Ring Groups display as '0'.

Queue Now and Queue Group Now column heading definitions

The following table describes the real-time and over-the-business-day Queue Now and Queue Group 
Now queue and queue group statistics.
NOTE: Statistics that do not support Ring Groups display as '0'.
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Table 16.10:Queue Now and Queue Group Now queue statistic column headings  (Sheet 1 of 9)

Term Abbreviated Name Meaning

Queue Status Queue Status The current status of the 
queue—either Open, Do Not 
Disturb (DND) or Closed.
Open indicates that the queue 
is available to queue calls.
Closed indicates that the queue 
is not available to queue calls. 
This is because it is outside of 
Business Hours or because of a 
Queue Control Plan condition.
Do Not Disturb indicates that 
the queue has been closed 
manually using the Set DND 
command. If the queue also 
meets the criteria above for a 
Closed queue, the status will 
show Closed instead of Do Not 
Disturb.
If licensed for IVR Routing, an 
additional queue status, Offline, 
is available. Offline indicates 
that IVR Routing failed to 
receive a real-time status from 
the queue after a set period of 
time.

Queue Number Queue # The queue's reporting number

Queue Group Number Queue Group # The queue group reporting 
number (Queue Group Now 
only)

Media Server Media Server The queue’s media server

Queue Name Name The queue or queue group 
name

Contacts Waiting Contacts Wtg The current number of 
interactions in queue waiting for 
a member to become available, 
including those listening to 
silence, music, or recorded 
announcements

Longest Waiting Long Wtg The current duration, in minutes 
and seconds, of the interaction 
waiting the longest in queue or 
queue group
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Available (Queue Now)
Agents Available (Queue Group 
Now)

Avail
Agts Avail

The total number of members 
logged in and not in Do Not 
Disturb, Make Busy, Work 
Timer, Ringing, Reseize Timer, 
Unknown, and Offline (Ignite, 
WEB) 
NOTE: This statistic updates only 
when members are present to 
the queue

ACD ACD The current number of 
members handling ACD 
interactions 
NOTE: This statistic updates only 
when members are present to 
the queue

Idle Idle The current number of 
members logged on and ready 
to receive interactions 
NOTE: This statistic updates only 
when members are present to 
the queue

Non ACD Non ACD The current number of 
members handling Non ACD 
calls (voice only) 
NOTE: This statistic updates only 
when members are present to 
the queue

Outbound Out The current number of 
members on outgoing calls 
(voice only) 
NOTE: This statistic updates only 
when members are present to 
the queue

Unavailable Unavail The current number of 
members in Do Not Disturb, 
Make Busy, Work Timer, or 
Unknown

Offered Off The total number of interactions 
offered to the queue / queue 
group

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 2 of 

Term Abbreviated Name Meaning
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Handled Hndl The total number of ACD 
interactions handled by 
members

Abandoned Abn The total number of interactions 
abandoned before being 
answered by members
NOTE: Abandoned does not peg 
short abandons as abandoned 
interactions in the Queue Now 
monitor. The Abandoned 
column in the Interactive Visual 
Queue monitor displays all 
abandoned interactions. 
Because of this difference, you 
may notice discrepancies 
between the abandoned call 
information in these two moni-
tors.

Interflowed Intrfl The total number of ACD 
interactions interflowed. 
Interflow is a mechanism that 
directs an interaction waiting in 
queue to another answer point.
NOTE: If an interaction waiting in 
queue is redirected before the 
queue’s short abandon time has 
elapsed, the queue is pegged 
with a Queue Unavailable count 
rather than an Interflowed count. 
In order for the Interflowed peg 
to occur, the redirection must 
occur after the short abandon 
time has elapsed.

Requeued Re Q The total number of ACD 
interactions requeued
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Average Time to Handle Avg Time Hndl The average time it takes for the 
interaction to be taken out of 
queue by a member

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 3 of 

Term Abbreviated Name Meaning
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Average Time to Abandon Avg Time Abn The current average amount of 
time customers wait in queue 
before abandoning interactions

Average Conversation Time Avg Conv Time The current average time 
members spent communicating 
with interactions

Service Level % Svc Lvl % For a queue, this is the 
percentage of interactions 
handled within the queue’s 
Service Level Time value over 
the day
For a queue group, this is the 
lowest percentage of 
interactions handled within the 
queue’s Service Level Time 
value over the day across all 
queues

% Handled % Hndl For a queue, this is the 
percentage of interactions 
handled compared to the total 
number of interactions offered 
to the queue for the day
For a queue group, this is the 
lowest percentage of 
interactions handled compared 
to the total number of 
interactions offered to the 
queue for the day across all 
queues

% Handled by 1-4 % Hndl by 1-4 For a queue, this is the 
percentage of all of the 
interactions answered by the 
first, second, third, and fourth 
agent groups
For a queue group, this is the 
highest percentage of all of the 
interactions answered by the 
first, second, third, and fourth 
agent groups
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 4 of 

Term Abbreviated Name Meaning
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Total Conversation Time Ttl Conv Time The current total time members 
spend talking to callers

Total Queue Unavailable Ttl Q Unavail The total number of times 
during the day that interactions 
are rerouted because the queue 
is in Do Not Disturb or has no 
members logged in

Current Queue Unavailable Curr Q Unavail The current number of 
interactions are rerouted 
because no members are 
logged in or the queue is in Do 
Not Disturb. Once the queue 
becomes available, this value 
resets to 0

Offered Last Hour Offr Last Hour The total number of interactions 
offered to the queue during the 
last hour of business

Time to Handle Last Hour Time Hndl Last Hour The time interactions waited in 
queue during the last hour of 
business before being handled 
by a member

 % Handled Last Hour % Hndl Last Hour For a queue, this is the 
percentage of interactions 
handled in the last hour of 
business, compared to the total 
number of interactions offered 
to the ACD queue for the day
For a queue group, this is the 
lowest percentage of 
interactions handled in the last 
hour of business, compared to 
the total number of interactions 
offered to the ACD queue for 
the day

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 5 of 

Term Abbreviated Name Meaning
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Service Level % Last Hour Svc Lvl % Last Hour For a queue, this is the 
percentage of interactions 
answered or picked within your 
Service Level Time value in the 
last hour
For a queue group, this is the 
lowest percentage of 
interactions answered or picked 
within your Service Level Time 
value in the last hour

Handled Last Hour Hndl Last Hour The total number of interactions 
handled by members during the 
last hour of business

Abandoned Last Hour Abn Last Hour The total number of interactions 
abandoned during the last hour 
of business

Interflowed Last Hour Intrfl Last Hour The total number of interactions 
interflowed during the last hour 
of business. Interflow is a 
mechanism that directs an 
interaction waiting in queue to 
another answer point

Unavailable Last Hour Unavail Last Hour The total number of times, in the 
last hour of business, 
interactions were rerouted 
because the queue they tried to 
access was in Do Not Disturb or 
had no members logged in
See Current Queue Unavailable

Average Handling Time Last 
Hour

Avg Hndl Last Hour The average duration of 
interactions from member pick 
up to client hang up (including 
hold time) during the last hour of 
business

Offered Last 15 Minutes Offr Last 15 Min The total number of interactions 
offered to the queue in the last 
15 minutes of business

Time to Handle Last 15 Minutes Time Hndl Last 15 Min The time interactions waited in 
queue during the last 15 
minutes of business before 
being handled by a member

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 6 of 

Term Abbreviated Name Meaning
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% Handled Last 15 Minutes % Hndl Last 15 Min For a queue, the percentage of 
interactions answered in the last 
15 minutes of business, 
compared to the total number of 
interactions offered to the ACD 
queue for the day
For a queue group, the lowest 
percentage of interactions 
answered in the last 15 minutes 
of business, compared to the 
total number of interactions 
offered to the ACD queue for 
the day

Service Level % Last 15 
Minutes

Svc Lvl % Last 15 Min For a queue, this is the 
percentage of interactions 
answered or picked within your 
Service Level Time value in the 
last 15 minutes of business
For a queue group, this is the 
lowest percentage of 
interactions answered or picked 
within your Service Level Time 
value in the last 15 minutes of 
business

Handled Last 15 Minutes Hndl Last 15 Min The total number of interactions 
handled by members during the 
last 15 minutes of business

Abandoned Last 15 Minutes Abn Last 15 Min The total number of interactions 
abandoned during the last 15 
minutes of business

Interflowed Last 15 Minutes Intrfl Last 15 Min The total number of interactions 
interflowed during the last 15 
minutes of business. Interflow is 
a mechanism that directs an 
interaction waiting in queue to 
another answer point.

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 7 of 

Term Abbreviated Name Meaning



542

CONTACT CENTER CLIENT
CHAPTER 16 REAL-TIME MONITORS

Unavailable Last 15 Minutes Unavail Last 15 Min The total number of times, in the 
last 15 minutes of business, 
interactions were rerouted 
because the queue they tried to 
access was in Do Not Disturb or 
had no agents logged in
See Current Queue Unavailable

Average Handling Time Last 15 
Minutes

Avg Hndl Last 15 Min The average handling duration 
of interactions from interaction 
pickup to interaction 
completion, including hold time, 
during the last 15 minutes of 
business

% Abandoned % Abn For a queue, this is the 
percentage of interactions that 
were abandoned (% 
Abandoned = Interactions 
Abandoned ÷ Interactions 
Offered)
For a queue group, this is the 
highest percentage of 
interactions that were 
abandoned (% Abandoned = 
Interactions Abandoned ÷ 
Interactions Offered)

% Abandoned Last Hour % Abn Last Hour For a queue, this is the 
percentage of interactions that 
were abandoned in the last hour 
of business
For a queue group, this is the 
highest percentage of 
interactions that were 
abandoned in the last hour of 
business

% Abandoned Last 15 Minutes % Abn Last 15 Min For a queue, this is the 
percentage of interactions that 
were abandoned in the last 15 
minutes of business
For a queue group, this is the 
highest percentage of 
interactions that were 
abandoned in the last 15 
minutes of business

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 8 of 

Term Abbreviated Name Meaning
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The following table describes the real-time and over-the-business-day Queue Now and Queue Group 
Now member statistics.
NOTE: Some statistics in the Queue Now monitor display in the Queue Group Now monitor as member 
statistics.

Wrap Up Wrap Up The total time that agents spent 
in the Work Timer state
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Make Busy Make Busy The total time that agents spent 
in the Make Busy state
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Occupancy Occp The total time that members 
spent in an occupied state 
(occupied state excludes idle 
time)

# Handled by 1-4 # Hndl by 1-4 The number of interactions 
answered by the first, second, 
third, and fourth agent groups
NOTE: This statistic displays 
information for ACD paths only. 
Statistics for Ring Groups 
display as '0'.

Logged Out Logged out The number of members 
associated with the queue but 
not logged in to the system
NOTE: For Ring Groups, this 
statistic displays either the 
number of extensions out of 
service or hot desk users logged 
out.

Members Not Present Not Present The number of members that 
are logged into the ACD routing 
system, but not present in the 
queue being monitored

Table 16.10:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 9 of 

Term Abbreviated Name Meaning
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Table 16.11:Queue Now and Queue Group Now member statistic column headings  (Sheet 1 of 3)

Term Meaning

State The queue member's agent or extensionstate 
(Queue Now only)
For a list of agent and extensionstates, see  and .

Name The name of the member being monitored. The 
icon beside the name indicates the media type 
the member handles

Present Indicates whether the member is present in the 
queue
Presence is indicated by a colored star. A green 
star indicates the agent or extensionis present in 
the queue. A gray star indicates the agent is not 
present in the queue

Media Server The media server to which the member is 
associated

Reporting The reporting number of the member being 
monitored.

Extn # The base extension where the member logged in 
(voice agentor hot desk user only)

Log In The first login of the member’s shift.
NOTE: This statistic displays information for ACD 
path members only and is not calculated for Ring 
Group members.

Last Event Recd The most recent time a member event occurred

Shift Time The total elapsed time logged for the member, 
calculated based on the difference between log in 
and last event received
NOTE: This statistic displays information for ACD 
path members only and is not calculated for Ring 
Group members.

DND Time The duration of time where Do Not Disturb was 
the overriding state for the member

MKB Time The duration of time where Make Busy was the 
overriding state for the member
NOTE: This statistic displays information for ACD 
paths only. Statistics for Ring Groups display as 
'0'.
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Wrap Up Time The duration of time where Wrap Up Time was 
the overriding state for the member. Wrap up time 
does not include any time spent making or taking 
interactions during the wrap up timer.
NOTE: This statistic displays information for ACD 
paths only. Statistics for Ring Groups display as 
'0'.

ACD Time The duration of ACD interactions handled, from 
member pickup to completion (not including hold 
time)

Hold ACD Time The duration of time ACD interactions spent on 
hold

Non ACD Time The duration of Non ACD interactions handled, 
from member pickup to completion (not including 
hold time) (voice only)

Hold Non ACD Time The duration of time Non ACD interactions spent 
on hold

Out Time The duration of time members spent handling 
outbound calls (voice only)

Out Hold Time The duration of time outbound calls spent on 
hold, for members (voice only)

DND Cnt The number of times the member entered the Do 
Not Disturb state

MKB Cnt The number of times the member entered the 
Make Busy state
NOTE: This statistic displays information for ACD 
paths only. Statistics for Ring Groups display as 
'0'.

ACD Cnt The number of ACD interactions handled by the 
member

Shrt ACD Cnt The number of ACD interactions handled by the 
member where the handle time was less than the 
Short Handle parameter

Hold ACD Cnt The number of times ACD interactions were 
placed on hold (voice only)

Non ACD Cnt The number of Non ACD interactions handled by 
the member (voice only)

Table 16.11:Queue Now and Queue Group Now member statistic column headings (Continued) (Sheet 2 

Term Meaning
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Viewing queue chart statistics

The following charts display queue statistics: 

Hold Non ACD Cnt The number of times Non ACD interactions were 
placed on hold

Out Cnt The number of outbound calls made by the 
member (voice only)

Out Hold Cnt The number of times outbound calls were placed 
on hold (voice only)

Avg Handl The average amount of time queue members 
spent handling ACD interactions (ACD Time 
divided by ACD Count, excluding ACD Hold 
Time)

Agt Grp The agent group to which the agent belongs
NOTE: This statistic displays information for ACD 
paths only. Statistics for Ring Groups display as 
'0'.

Occupancy The duration of time the member spent 
processing interactions

Contacts per Hour The total ACD interaction count minus the ACD 
short handle count, divided by the shift time for 
the member

On failover Indicates whether the primary media server is 
offline and has failed over to the secondary media 
server (voice only)

Unavail% The percentage of time for the shift that the 
member was in Do Not Disturb, Make Busy, and 
Work Timer states

 Not Present Time The duration of time the member was logged into 
but not present in an agent groupor Ring Group

External handle time The duration of time the member spent handling 
external calls (voice only)

External inbound cnt The number of incoming external calls (voice 
only)

External outbound cnt The number of outgoing external calls (voice 
only)

Table 16.11:Queue Now and Queue Group Now member statistic column headings (Continued) (Sheet 3 

Term Meaning
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• Queue Now
• Queue Group Now
• Queue Performance by Period
• Queue Group Performance by Period

Queue Now and Queue Group Now

The Queue Now monitor enables supervisors to view queue statistics in real time, as well as expand 
individual queues in the monitor to view statistics on each queue’s associated member agents or exten-
sions. When you expand the Queue Now monitor to display the Name column, the monitor also displays 
member presence in the queue. Presence is indicated by a colored star in the Present column. A green 
star indicates the member is present in the queue. A gray star indicates the member is not present in 
the queue. A gray row indicates that the member is not logged in (for agents and hot desk users) or out 
of service (for extensions).
The Queue Group Now monitor enables supervisors to view aggregated statistics for Reporting, Virtual, 
and Unified queue groups in real-time, as well as expand individual queue groups in the monitor to view 
statistics for the queue group’s associated queues.
On the Queue Now monitor, you can specify which columns of statistics are displayed, rearrange 
columns, and sort individual columns in ascending or descending order. You can expand a queue and 
view statistics on the members associated with the queue. (See the following figure.)
NOTE: Prior to Version 7.1, Queue Now monitors displayed the agent groups belonging to the queues with 
agent group statistics. As of Version 7.1, this functionality has been removed. Instead, queue members 
are grouped by agent group.

Figure 16.23: Queue Now
 

NOTE: 
• Contact Center Client updates Longest Waiting statistics every fifteen seconds, or more frequently as 

records are received from the ACD routing system.
• If the ACD routing system has not updated MiContact Center Business with real-time statistics for 

Contacts Waiting and Agents Available within the last 90 seconds, question marks display in place of 
these statistics.
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• Agents present in the queue and idle whose extensions are ringing are included in 'Available' statistics. 
Agents whose extensions are ringing are not included in Unavailable statistics.

• The Average Handling Time is the Average interaction Time plus the Average Hold Time. If the call is 
put on hold, transferred, or conferenced, these times are added to the Average Handling time value.

• If an agent fails to answer an ACD call after X seconds or X rings or refuses a voice interaction, the 
agent is placed in Reseize Timer state instead of System Make Busy state. This default behavior can 
be reset to place agents into System Make Busy state rather than the Reseize Timer state. The system 
then re-queues the call, in the same queue, and offers it to the next available agent.

• The abandoned media column in the Interactive Visual Queue monitor displays all abandoned calls. 
The abandoned column in the Queue Now monitor does not include short abandons as abandoned 
calls. Because of this difference, you may notice discrepancies between the abandoned call informa-
tion in these two monitors.

• Statistics that do not support Ring Groups display as '0'.

Queue Performance by Period and Queue Group Performance by Period

The Queue Performance by Period and Queue Group Performance by Period charts offer visual repre-
sentations of Queue and Queue Group Performance by Period statistics, grouped by the type of statistic 
displayed. Three different series of statistics are available to view in charts: 
• Integer—displays numerically-based real-time statistics
• Percentage—displays percentage-based statistics
• Time—displays time-based statistics

The following figure displays a Queue Performance by Period chart displaying the default statistics of the 
Integer series.

Figure 16.24: Queue Performance by Period chart
 

The Integer series shows the following statistics across 15 minute intervals for queues or queue groups: 
• Handled (Default)
• Interflowed (Default)
• Offered
• Short Abandoned
• Abandoned
• Requeue
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• # Handled by 1-4

The Percentage series shows the following statistics across 15 minute intervals for queues or queue 
groups, by default: 
• % Handled by 1-4
• Service Level % Today
• % Handled

The Time series show the following statistics across 15 minute intervals for queues or queue groups, by 
default: 
• Average Time to Handle
• Average Time to Abandon
• Average Time to Interflow
• Ttl Talk Time
• Average Talk Time
• Total work timer minutes
• Total make busy minutes
• Total occupancy minutes

For more information for the definitions of these statistics, see "Queue by Period column heading defini-
tions".
NOTE: The following statistics are for ACD path voice queues only and will not display information for Ring 
Groups: 
• Requeue
• # Handled by 1, 2, 3, 4
• % Handled by 1, 2, 3, 4
• Total work timer minutes
• Total make busy minutes

Navigating charts

You can zoom in and out of charts to change how the data is displayed in the chart, expanding or 
compressing the displayed data. If the range of data displayed exceeds the boundary of the chart window 
in Contact Center Client, you can use the horizontal scroll bar to move back and forth across the displayed 
data.
To zoom in on a chart
1. Hold your mouse over the edge of the horizontal scroll bar until the cursor turns into a double-arrow 

(<->) icon.
2. Click and drag the edge of the horizontal scroll bar towards the opposite side of the scroll bar.

The chart zooms in and the horizontal scroll bar shrinks in size.
NOTE: To undo the zoom function, click Zoom Out.
To zoom out of a chart
1. Hold your mouse over the edge of the horizontal scroll bar until the cursor turns into a double-arrow 

(<->) icon.
2. Click and drag the edge of the horizontal scroll bar and drag to zoom out.

To show the entire chart in the window
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• If you are zoomed in, in the chart window click Show All.
To scroll across the chart
• Click and drag the horizontal scroll bar in the direction you wish to scroll the chart.

Viewing callback lists with the Global callback monitor

When licensed for IVR, the Global callback monitor enables you to monitor callback states in real time 
and displays the callbacks currently available. Using the Global callback monitor, you can requeue and 
delete callbacks. (See the following figure.)

Figure 16.25: Global callback monitor
 

To access the global callback monitor 
1. Click the Real Time tab in the Contact Center Client ribbon.
2. Click the Callbacks icon. 

The Monitor Callback List displays.
The following table describes the Global callback monitor column headings.

Table 16.12:Global callback column headings  (Sheet 1 of 2)

Column heading Definition

Caller number the phone number provided by the caller

Caller name the name of the caller

Status the state of the callback — new request, in progress, requeued, 
completed, unknown

Priority the importance level of the callback.
Callback priority levels are:
• Voice — Normal
• Web — Normal
• Caller abandoned — Low

Type the type of callback — voice, web, or caller abandoned

Reason lists why the callback is in a particular status

Attempted Calls to Agent the number of times the callback was offered to an agent in queue

Last Time Agent Attempted the last time the agent attempted the callback

Request Time the specific time at which the callback is scheduled to be processed; 
this field is populated when the callback is requeued

Time Received the specific time the caller submitted the callback request
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Managing callbacks in the Global Callback monitor

The Global callback monitor enables users to requeue, reject, and delete callbacks within the monitor. 
Requeued callbacks are re-entered into their queue. Rejected callback are removed from the queue are 
will not be offered to employees. Deleted callbacks are removed from the monitor, but are not removed 
from the system.
Users can also adjust a callback’s priority. Callback priority determines the order of which callbacks will 
be offered to agents. Callbacks are offered to agents in order of their priority and then by the longest 
waiting callback of that priority. For example, High priority callbacks are offered before Normal priority call-
backs, even if the Normal priority callbacks have been in queue longer.
The following procedures explain how to:
• Requeue a callback
• Reject a callback
• Delete a callback
• Change a callback’s priority

To requeue a callback
1. Right-click a callback and select Requeue.
2. Select Yes.

Web IP Address the IP address of the caller who submitted the callback request

Last Attempted Call to Client the specific time the last callback attempt to the caller was made

Attempted Calls to Client the number of times the callback was attempted

Client Available From the earliest time the caller is available to receive the callback

Client Available To the latest time the caller is available to receive the callback

ANI the phone number of the caller

DNIS the phone number the caller dialed

Dialable the dialable number of the device that will handle the callback

Device Name the name of the device that will handle the callback

Device Type the type of device that will handle the callback — agent,or queue, or 
extension

Recorded Message contains a hyperlink to the voice callback .wav file left by the caller

Area the province/state or other area the call originated from

Country the country the call originated from

Endpoint the endpoint attempting to perform the callback

Region the region the call originated from

Table 16.12:Global callback column headings (Continued) (Sheet 2 of 2)

Column heading Definition
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To reject a callback
1. Right-click a callback and select Reject.
2. Select Yes.

To delete a callback
1. Right-click a callback and select Delete.
2. Select Yes.

To change a callback’s priority
• Right-click a callback and select Change priority > [priority level].

Viewing ports

NOTE: 
• You can monitor port states in real time and view currently executing workflows.
• You can select the ports you want to monitor individually or by hunt group.
• You can remove ports from Do Not Disturb.

The Port Status monitor displays port information.

Port status monitor

The Port Status monitor enables you to monitor port states in real time and displays the workflows that 
are currently executing on ports. Using the Port Status monitor, you can take ports out of Do Not Disturb 
and playback historical port events in Auditor mode. (See the following figure.)
To access the port status monitor 
1. Click the Real Time tab in the Contact Center Client ribbon.
2. Click the Ports icon. 

The Port status monitor displays.
Figure 16.26: Port status monitor

 

The following table describes the Port Status monitor column headings.
Table 16.13:Port Status column headings  (Sheet 1 of 2)

Column heading Definition

Name the name of the port

Dialable the port's dialable number

Extension Type  the type the extension — RAD, messaging, 
callback, or UPiQ
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Viewing webpages

While using Contact Center Client, you can view webpages using the Web browser monitor.
To view a webpage within Contact Center Client
1. Click the Real Time tab in the Contact Center Client ribbon.
2. Click the Web icon.

The Web Browser Properties window opens.
3. After Monitor title, type a name for the monitor.

4. After Start URL, type the address of the website to view.

NOTE: The website address must begin with http:// or you will not be able to view the monitor.
5. Optionally, select a value for the Web Browser Refresh Rate.

6. Click OK.

Viewing historical real-time events with Auditor

Using Auditor you can view historical, multimedia real-time events, at your own pace. Auditor makes it 
easy for you to analyze when and why past service problems occurred. By understanding the series of 
events you can prevent such issues from recurring.
For example, you notice that on July 15 you have 12 interactions abandon between 10:00 AM and 10:15 
AM. You can review the interactions and the agents’ actions on that date for that time period with Auditor. 
Did all of the interactions arrive at the same time? Did all of the agents go on break at the same time? If 

Media Server the media server to which the port is associated

Hunt Group Name the name of the hunt group the port is associated 
with. A port can be associated with more than 
one hunt group

Hunt Group Dialable the dialable number of the hunt group

Phone state the state of the phone — idle, dialing, talking, 
ringing, or unknown

Workflow name the name of the executing workflow

Phone Display displays the MiAUDIO state (that is displayed on 
the phone)

ANI the phone number of the caller

DNIS the phone number dialed by the caller

Redirect the number of the device the call was directed 
from

Table 16.13:Port Status column headings (Continued) (Sheet 2 of 2)

Column heading Definition
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all of the interactions arrived at once, you need to schedule more people. If all of the agents went on break 
at the same time, you need to adjust their break schedule.
Using Auditor you can also track when employees log on and log off the system. It is easy to determine 
if any of the employees consistently start late or finish early.
With Auditor, you can use existing profiles, including alarm thresholds, when viewing past days run in real 
time.
Your access to Auditor is determined by administrator-set security roles.
The first toolbar consists of real-time monitors that provide information on agent availability, queue statis-
tics, and graphic displays on queues. (See the following figure.)

Figure 16.27: Auditor toolbar
 

Auditor icons

Using Auditor’s second toolbar you select the date of the historical real-time events that you want to view 
and the speed at which to play the events. The icons are described in the following table.
Table 16.14:Auditor Icons  (Sheet 1 of 3)

Icon Term Meaning

 

Calendar You can select the date of the 
historical real-time events that 
you want to view by clicking the 
calendar.

Speed of audit The Speed of audit is expressed 
as a ratio of real-time to play 
speed. You can select the 
speed from a list of ratios that 
opens when you click the clock: 
1:1, 1:2, 1:5, 1:10, 1:30, 1:60, 
and 1:120. If you select the 
ratio1:1, it will take you one 
second to view one second of 
the past day. If you select 1:60, 
it will take you one second to 
view one minute of the past day.

Rewind If you click Rewind when the 
play is stopped, you jump back 
to the beginning of the day.
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Stop You can stop the real-time 
historical events from playing, 
and jump back to the beginning 
of the day, by clicking Stop.

Pause You can pause the real-time 
historical events by clicking 
Pause.

Play You can play the real-time 
historical events by clicking 
Play.

Step forward You can select the increment (in 
seconds) you will advance from 
a list that opens when you click 
the down arrow to the right of 
Step forward: 1 sec, 2 sec, 5 
sec, 10 sec, 15 sec, 30 sec, and 
45 sec. If you select 30 
seconds, then when the play is 
stopped, you can step forward 
in 30 second increments each 
time you click Step forward. 
When you reach the end of data 
for that day, you will 
automatically jump to the end of 
the day.

Jump forward You can select the increment (in 
minutes) you will advance from 
a list that opens when you click 
the down arrow to the right of 
Jump forward: 1 min, 2 min, 5 
min, 10 min, 15 min, 30 min, 
and 60 min. If you select 10 
minutes, then when the play is 
stopped, you can jump forward 
in 10 minute increments each 
time you click Jump forward. 
When you reach the end of data 
for that day, you will 
automatically jump to the end of 
the day.

Table 16.14:Auditor Icons (Continued) (Sheet 2 of 3)

Icon Term Meaning
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Starting and using Auditor

You start Contact Center Client to gain access to Auditor functionality.
To view historical real-time events, you must 
1. Start Contact Center Client.
2. Open the grids in which you want to view historical events.

3. Start Auditor.

NOTE: If you are using the Contact Center Client marquee, Contact Center PhoneSet Manager, Contact 
Center Softphone, or Interactive Visual Queue applications (which function in real time only), open Auditor 
in another instance of Contact Center Client.
To start and use Auditor 
1. In the Contact Center Client ribbon, click Auditor Controls.
2. Click Auditor Mode in the toolbar ribbon. 

The Auditor toolbar displays.
3. Click the calendar icon and select a date. 

The date displays on the left of the slider.
4. Click the speed icon and select the speed of the audit. 

The speed of the audit, expressed as a ratio of real time to play speed, displays on the right of the 
speed icon.

5. Move the slider to select the time of day at which you want to start monitoring.

6. Click the play button to play the real-time events of the selected date. 

The historical real-time events play at the speed you selected.

Viewing and customizing real-time monitors

NOTE: 
• Contact Center Client has a tabbed interface for managing and arranging windows. You can dock 

themonitors, displaying them on overlapping tabbed panels to maximize real estate. This enables you 
to readily navigate between monitors.

Slider As you view the events of the 
day, the slider indicates the time 
at which the events occurred. 
The length of the slider 
represents the length of the day 
for which you are viewing 
historical real-time events.

Table 16.14:Auditor Icons (Continued) (Sheet 3 of 3)

Icon Term Meaning
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• You can save threshold settings and display characteristics you define for monitors. When you click 
File > Save, Contact Center Client saves all open monitors under one profile name. You can click File 
> Open to open another profile, or File > New to create a new profile.

Opening monitors

To open a monitor in Contact Center Client 
1. In the Contact Center Client ribbon, click Real time to view the Contact Center Client monitor icons.
2. In the State by Position column on the ribbon, click Agent. 

This selects the Agent State by Position monitor and the Add/Remove device IDs window opens.
See the following figure.

3. Under Agent groups, select agent groups to monitor and/or under Agents, select agents to monitor.

4. Under Card designs, select a card design. 

Card designs specify the information displayed on extension, agent, and employee monitors.
5. Click OK.

Figure 16.28: Add/Remove devices
 

Docking monitors

You can dock monitors and readily navigate between them. You can dock a monitor to the top, bottom, 
left, or right of another monitor. Alternatively, you can dock a monitor on the top, bottom, left, or right side 
of the Contact Center Client window. You can dock monitors on top of one another, displaying them on 
overlapping tabbed panels to maximize real estate.
To dock a monitor on top of another monitor 
1. Right-click the title bar of an open monitor and select Dock.
2. Repeat step 1 for all open monitors. 
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Click the title bar of a monitor and drag the monitor on top of a second monitor placing your cursor in 
the center of the four-headed arrow that displays.
See the following figure.

Figure 16.29: Docking monitors

3. Release the mouse button. 

Your monitors are displayed on overlapping tabbed panels.
See the following figure.

Figure 16.30: Docked monitor

Adding and removing devices

You can add and remove devices from all of the Contact Center Client monitors except for the chart moni-
tors.
To add devices to the bottom of a monitor 
1. Right-click an open monitor and click Add/Remove devices.
2. Under Agent/Employee/Queue groups, select additional agent, employee, or queue groups to add 

to the monitor, or under Agents/Employees/Queues, select additional agents, employees, or queues 
to add to the monitor.

3. Click OK. 

On the State by Position monitors a blank row of cells separates the original agents from those you 
just added. To remove the blank row you must sort the monitor.
See "Sorting monitor devices".
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To remove devices from a monitor 
1. Right-click an open monitor and click Add/Remove devices.
2. Under Agents/Employees/Queues, clear the check boxes of the agents, employees, or queues to 

be removed.

3. Click OK.

NOTE: You can alternatively add and remove devices via the Monitor Options tab in the Contact Center 
Client ribbon for the Queue by Period, Queue Now, and Queue Group Now monitors.

Sorting monitor devices

When you select devices to display on a monitor, you can specify the devices be sorted by media server 
(on agent monitors only), ID or name (alphabetically) in ascending or descending order. When the monitor 
opens, the devices display in the order you selected.
To sort the devices displayed on a monitor 
• In the left pane of the Add/Remove devices window, click Media server to sort the members by media 

server, click Name to sort the members alphabetically, or click Reporting to sort the members by ID, 
in either ascending or descending order.

You can sort information by state, name, or agent ID, or extension on the State by;Position monitors.
To sort agents or employees by state 
• Right-click a monitor and click Sort monitor > By state.
If you sort agents by state, Contact Center Client displays the agents by state and time in state across the 
monitor in the following order: 
• Ringing
• ACD
• ACD Hold
• Idle
• Non ACD
• Non ACD Hold
• Outbound
• Outbound Hold
• Do Not Disturb
• Make Busy
• System Make Busy
• Work Timer
• Unknown
• Logged Off

To sort agents or employees by name 
• Right-click a monitor and click Sort monitor > By name.
To sort agents or employees by agent ID 
• Right-click a monitor and click Sort monitor > By agent ID.
To sort agents or employees by extension 
• Right-click a monitor and click Sort monitor > By extension.
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Rearranging cells

You can rearrange cells on the State by Position monitors.
To rearrange cells 
• On an open monitor, drag a cell to a different position on the monitor.
You can rearrange columns on the Agent Shift, Queue by Period, Queue Now, and Queue Group Now 
monitors.
To rearrange columns 
1. Right-click an open monitor and click Properties.
2. Click the Layout folder.

3. Click Column order.

4. Click a column header and click the up or down arrow key to change the position of the column relative 
to other columns on the monitor.

NOTE: You can alternatively rearrange cells via the Monitor Options tab in the Contact Center Client ribbon 
for the Queue by Period, Queue Now, and Queue Group Now monitors.

Setting monitor dimensions

You can specify the numbers of rows and columns of cells to display on the State by Position monitors.
To set table dimensions 
1. Right-click a monitor and click Set table dimensions.
2. After Columns, type a number.

3. After Rows, type a number.

4. Click OK. 

Columns or rows are added or deleted from the monitor. You can redistribute the cells using a 
drag-and-drop operation.

To size the table to fit the frame 
• Right-click in any real-time monitor and select Size table to frame.

Hiding monitor columns

On the Agent Shift, Queue by Period, Queue Now, and Queue Group Now monitors, you can hide specific 
columns of statistics.
To hide columns
1. Right-click an open monitor and click Properties.
2. Click the Layout folder.

3. Click Column order.

4. In the Visible column, clear the check boxes of the columns you want to hide from view.

NOTE: You can alternatively hide monitor columns via the Monitor Options tab in the Contact Center Client 
ribbon for the Queue by Period, Queue Now, and Queue Group Now monitors.
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Filtering device variables

On the Queue Now, Agent Shift, Queue by Period, and Queue Group Now monitors, you can filter specific 
device variables. For example, on the Queue by Period monitor, you could filter the Calls Offered variable 
and display statistics for the intervals during which the queue was offered five or more calls.
To filter device variables
1. Right-click a monitor and click Filter device variables.
2. Click Filter data to show, select a variable, select an operand, and type a number.

3. Click OK.

A subset of the data is displayed based on the conditions defined in the filter.

Configuring chart characteristics

Individual charts have a range of configurable characteristics and options that enable users to customize 
their chart display.
You can right-click charts to access the following options or select them via the Chart Options tab:
• Change the chart types
• Configure the legend
• Configure the color scheme
• Define queue chart properties
• Enable points labels
• Modify Properties

Changing chart type

Contact Center Client enables you to configure the type of chart, either column or line, used for your 
Queue and Queue Group Performance by Period charts.
Queue and Queue Group Now charts display as bar charts.
1. Right-click on an open By Period chart and click Chart Type.
2. Select the type of chart you want your chart to display.

NOTE: Alternatively, you can change the chart type by selecting an open By Period chart, and 
choosing Column or Line from the drop-down list beside Type in the Chart Options tab.

Configuring the legend

You can choose if your chart has a legend, as well as configure where the legend displays.
To configure the legend
1. Right-click on an open queue chart and click Legend box.
2. Select or deselect Enabled to either display or remove the legend.

3. Right-click on an open queue chart and click Legend box.

4. Click Left, Top, Right, or Bottom to determine where you want the legend box to display.

NOTE: Alternatively, you can configure the legend by selecting an open queue monitor and accessing 
options from the Legend section of the Chart Options ribbon.
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Configuring the color scheme

You can select the color scheme for the chart.
To configure the color scheme for a chart
1. Right-click on an open queue chart and click Color.
2. Select the color scheme you want to apply to the chart from the list.

NOTE: Alternatively, you can configure the color scheme by selecting an open queue chart and selecting 
color options from the drop-down list beside Color in the Chart Options ribbon.

Defining queue chart properties

Under Chart properties, you can select general chart characteristics, such as colors and stacked effects. 
You can define series characteristics, such as the type of chart, the fill properties, and the shape of the 
bars. In addition, you can define y axis characteristics.
To define queue chart properties
1. Right-click an open queue monitor and click Chart properties.
2. On the General tab, specify general chart characteristics (colors, effects, and 3D).

3. Click the Series tab.

4. Specify series characteristics (chart style, fill style, bar type, and border style).

5. Click the Y Axis tab.

6. Specify axis scale characteristics, label characteristics, and the width and color of the axis line.

7. Click OK.

NOTE: Alternatively, you can configure queue chart properties by selecting an open queue monitor and 
clicking Properties located in the Chart Options ribbon.

Enabling point labels

You can enable labels for each point in your chart.
To enable point labels
• Right-click on an open queue chart and click Points labels.
NOTE: Alternatively, you can enable point labels by selecting an open queue chart and clicking Enabled 
in the Points Label section of the Chart Options ribbon.

Modifying Properties

Properties controls the way chart data displays. Under Properties, you can
• Specify the queue chart title
• Highlight statistics
• Configure 2D and 3D displays
• Animate charts
• Select call statistics to display
• Create and modify Constant lines
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NOTE: You can either right-click an open queue chart to modify properties or select an open queue chart 
and choose options via the Properties section of the Chart Options tab.
Specifying the queue chart title
Under Properties, you can specify the title of the queue chart.
To specify the queue chart title
1. Right-click on an open queue chart and click Properties.
2. After Monitor title, select and delete the old chart title and type a new name for the queue chart.

3. Click OK.

Highlighting statistics
Under Properties, you can enable the highlight feature. When the highlight feature is enabled, and when 
you move your cursor over a bar representing a specific call statistic, that bar is highlighted and the other 
bars, representing other call statistics, are dimmed.
To highlight statistics
1. Right-click on an open queue chart and click Properties.
2. Expand the Chart properties tree and click General.

3. Select the Highlight check box.

4. Click OK.

Configuring 2D or 3D chart displays
Under Properties, you can configure whether your chart displays bars in 2D or 3D. By default, your charts 
display in 3D.
1. Right-click on an open queue chart and click Properties.
2. Expand the Chart properties tree and click General.

3. Select the 3D check box to enable or disable 3D charts.

4. Click OK.

Animating charts
Under Properties, you can enable the animated feature. When the animated feature is enabled, changes 
to chart values actively display. The animated feature is disabled by default.
CAUTION: Enabling the animated feature will result in additional CPU load on the affected workstation.
To animate charts
1. Right-click on an open queue chart and click Properties.
2. Expand the Chart properties tree and click General.

3. Select the Animated check box.

4. Click OK.

Selecting call statistics to display
Under Properties, you can select call statistics to display. For example, you can add Calls Waiting, Agents 
Available, Idle, and Requeued statistics to the Queue Group Now (Integer) chart.



564

CONTACT CENTER CLIENT
CHAPTER 16 REAL-TIME MONITORS

To select call statistics to display
1. Right-click on an open queue chart and click Properties.
2. Expand the Chart properties tree and click Series data.

3. Select the Series data type radio button to define the types of data visible in the chart.

– Integer
– Percentage
– Time

4. If you are selecting call statistics for a Queue or Queue Group Performance by Period chart, click 
Time Interval. Select the radio button for the interval you want to use and set the time.

5. Under Visible, select the check box of the data you want to add to the chart.

6. Alternatively, under Visible, clear the check box of the data you want to remove from the chart.

7. Click OK.

Creating and modifying Constant lines
Under Properties, you can configure Constant lines. Constant lines are horizontal lines you configure to 
display across your chart at set values on the Y-axis, enabling you to clearly see how the data being 
displayed in the chart meets with desired values.
To create Constant lines
1. Right-click on an open queue chart and click Properties.
2. Click Chart properties.

3. Click Constant lines.

4. Click Add.

5. Click in the Color box to choose a color.

NOTE: The default constant line color is red.
6. After Text, type the name you want to display beside the constant line in the chart.

7. After Value, type the value you want the constant line to mark.

8. After Width, select the thickness of the line.

9. Click OK.

The Constant line will be added to the list of active Constant lines.

To modify a Constant line
1. Select the Constant line you want to modify and click Edit.
2. After Text, type the name you want to display beside the Constant line in the chart.

3. After Value, type the value you want the Constant line to mark.

4. After Width, select the thickness of the line.

5. Click OK.

To delete a Constant line
• Select the Constant line you want to delete and click Delete.
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Setting alarms

You can define alarms to alert you to significant changes in contact center activity. Using the alarms, you 
specify performance thresholds for contact center elements, such as queues and agents, and customize 
the visual, auditory, or email delivery of alarms. If any availability or performance issues arise, your alarms 
deliver a notification enabling you to instantly change agent and queue availability to adjust to unplanned 
call volumes.
Client alarms are specific to each computer. To notify you that performance thresholds are not being met, 
you can configure alarms so that 
• Monitor cells and statistics change color.
• A pop-up notification appears on your desktop.
• A sound prompt, such as a beep or .wav file, plays.
• You are notified by email.
• Contact Center Client appears on top of all open applications.

To configure alarms for real-time monitors 
1. Determine whether you want to monitor all extensions, or some extensions.
2. Add performance variables to monitor.

3. Specify alarm threshold .

Adding performance thresholds

To add performance thresholds so you can monitor alarms 
1. Right-click a monitor and click Set alarms. 

Alternatively, select an open monitor and click Set alarms in the Alarms column, found in the Monitor 
or Chart Options tab in the Contact Center Client ribbon.
The Set alarms window appears.

NOTE: You can select the Apply the alarm thresholds to all devices displayed on the monitor check 
box to apply the threshold settings for performance variables across all queues or agents. Alternately, you 
can select Apply the alarm thresholds to a specific list of devices to apply the threshold settings for 
a performance variables to a list of queues or agents.
2. Under Devices, select one or more queues or agents or select the Select all check box to select all 

queues or agents.

3. In the Performance variables list, select a variable.

4. Under Alarm Thresholds, click Add threshold and type a value for the upper boundary of the 
threshold. 

The lower boundary cannot be modified. The lower boundary of the next threshold is always slightly 
greater than the upper boundary of the previous threshold.

5. Click OK.

Specifying performance threshold colors

To configure performance threshold colors
1. For the alarm threshold for which you want to specify colors, under Background, click the arrow.

A color palate appears.
2. Select a color.
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3. Under Font color, click the arrow.

A color palate appears.
4. Select the font color for the alarm threshold.

5. Click OK.

Specifying threshold notification

You can configure performance threshold sound and pop-up window notifications
To configure performance threshold sound notification 
1. For the alarm threshold for which you want to be notified by a sound, under Sound, select the check 

box. 
The Sound window opens.

2. Specify the alarm triggering properties.

3. Specify the sound you want played when the alarm is triggered.

4. Click Save.

To configure performance threshold pop-up window notification 
1. For the alarm threshold for which you want to be notified by a pop-up window, under Pop-up, select 

the check box. 
The Pop-up window opens.

2. After Duration, type the number of seconds you want the pop-up alarm to be displayed when 
threshold conditions are satisfied.

3. If you want to display the pop-up alarm on top of all of the other applications, select the Keep this 
message visible on mouse over check box.

4. Optionally, click the Format font button to specify font attributes for the pop-up alarm message.

5. In the text box, type the message for the performance threshold and click the Add a variable button 
to insert performance variables. (for example, type CW P001 = <calls waiting variable>).

6. Click Save.

To specify that Contact Center Client opens on top of all other applications when a performance threshold 
is satisfied 
• For the alarm threshold for which you want to be notified, under Bring to front, select the check box.
To configure performance threshold email notification 
1. For the alarm threshold for which you want to be notified, or notify others by email, under Email, select 

the check box. 
The Email window opens.

2. After Distribution, specify which contacts are to be notified by email when threshold conditions are 
satisfied.

3. After Subject, type the subject of the email to be sent (for example, type Calls Wtg in Sales Queue 1 
>10!).

4. In the message box, type the body of the email.

5. Click Save.



567

CONTACT CENTER CLIENT
CHAPTER 16 REAL-TIME MONITORS

Consider the threshold programming in the following figure. When the number of agents available in the 
technical support queue is between 0 and 2, the cell housing the Agents Available statistic is red. When 
the number of agents available is between 3 and 4, the cell turns orange. When the number of agents 
available is 5 or greater, the cell turns white. In addition, audible alarms and pop-up alarms display.
To clear any current client alarms in Contact Center Client 
• Right-click the monitor and click Clear alarms. 

Figure 16.31: Set alarms window
 

Customizing the information displayed on position and time monitors

On the agent, employee, and extension by position and by time monitors, real-time information is 
displayed in cells (cards). You can select from available card designs, or customize cards to display 
specific information.
When you first open an agent, employee, and extension monitor, you can select a card design on the 
Add/Remove device IDs window: 
• The Classic card displays the agent state, time in the state, presence, agent/employee name, and 

agent login ID/employee ID, and extension number (or queue name for voice agents on ACD or on 
ACD Hold)) and presence.

• The Caller ID card displays the caller name and number (ANI), the number the caller/employee dials 
for incoming/outgoing calls, the state, time in the state, presence, agent/employee name, agent login 
ID/employee ID, and extension number (or queue name for voice agents on ACD or on ACD Hold.

• Custom cards you create and share

The Caller ID card is the default card design. You can use this card design, or select the Classic card or 
a customized card. You can create new card designs or copy existing card designs and modify them. For 
example, you can add or remove text and variables from cards and rearrange the information displayed. 
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You can share card designs with other employees. When you select a card design for an 
agent, employee, or extension monitor, it is applied to all monitors of that type.

Selecting and customizing card designs

To select a card design 
1. Right-click an open position or time monitor and click Properties.
2. Click Layout > Card design.

3. Under Design name, select a card design.

4. Click OK.

To customize cards for position and time monitors 
1. Under Card design, 

– If you want to create a card design, click New.
– If you want to edit an existing card design, select a card design and click Edit.
– If you want to create a card design based on the Classic card, select it and click Copy.

2. On the New card design window, type the name of the new card design.

3. If you want to share the design with other agents, select Share design.

4. Click OK.

5. Select the card and click Edit. 

See the following figure.
6. After State, select a state for the card design. 

You can use the same card design for all states or you can customize cards for specific states, such 
as ACD, Idle, Make Busy, and Unknown.

7. Under Fields, select a field type and drag and drop it to the card design.

8. If you want to resize the field, click the field and use your pointer to move or resize the field.

9. If you want to change the properties for a field, click the field and change the properties in the right 
pane of Card Designer.

10. If you want to change the size of the card design preview, after Zoom, select a different magnification 
value from the list.

11. Add additional fields to the card.

12. Select Copy to if you want to copy the current design to the card of a different state.

13. Click OK. 

The new card design appears on the Card design list.
14. Click OK.

Figure 16.32: Card design window
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Defining monitor styles

You can customize the appearance of individual monitor elements. For example, you can configure the 
font size and color of column headings or apply a skin of predefined colors and font attributes to the entire 
monitor.
To customize the appearance of monitor elements
1. Right-click an open monitor and click Properties.
2. Click General > General settings.

3. If you want to change the title of the monitor, after Title, type a name.

4. If you want to scroll horizontally on the monitor, select the Enable horizontal scroll bars check box.

5. If you want to scroll vertically on the monitor, select the Enable vertical scroll bars check box.

6. If you want to group monitor headings, select the Enable grouping check box.

7. If you want to apply a skin to the monitor, click Layout > Monitor style.

8. Click Load style and select a skin.

9. Otherwise, under Properties, manually configure the column settings, column font, row settings, and 
row-alternate settings.

10. Click OK.

Adding text to card designs

You can use a text box to add custom text to a card.
To edit text that you have added to a card
1. Select the text box.

Properties appear on the right.
2. Under Properties, in the box to the right of Text, type the text to be added to the card.

3. Click OK.

4. Click OK.
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Grouping data

You can group rows of data in the Queue Now monitor, and other monitors that contain columns. For 
example, you can group the data by the ACD count statistic and readily see which agents handled the 
most calls, and which agents handled the least calls, as illustrated in the following figure.

Figure 16.33: Enable grouping
 

The Enable grouping option displays a grouping panel to which users drag columns. The grouping order 
determines the order in which the rows display.
To enable grouping 
1. Right-click an open monitor and click Properties.
2. Select the Enable grouping check box.

3. Click OK. 

The monitor displays a grouping panel.
4. Drag a column heading to the panel to group by the column heading.

Building marquee monitors

You can build a marquee monitors to broadcast real-time statistics and messages and alarm on real-time 
contact center performance statistics. With marquee monitors and wall-mounted marquee displays, such 
as LCD monitors or LED reader boards, you can offer your supervisors and agents access to important 
contact center performance metrics.
To build a marquee monitor, you must
• Specify styles for the marquee monitor.
• Configure marquee text and variables.
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Configuring marquee monitor styles

To specify attributes for the marquee background 
1. Click the Marquee icon. 

The Configure marquee window appears.
2. Click Add message. 

The Add message window displays.
3. Type a name for the message.

4. Under Position, select Top, Right, Left, Center, or Bottom to specify how the message is to be 
displayed on the marquee.

5. Click Format marquee. 

The Format marquee window appears.
6. After Background color, select a color for the background.

7. After Cell color, select a color for the marquee cells.

8. After Cell size, specify a value for the size of the marquee cells.

9. After Cell spacing, select a value for the space between marquee cells.

10. To specify the marquee text font type and color, click Format font. 

The Font window displays.
11. Select font attributes.

12. Click OK.

13. If you want the message and the background of the message to be displayed using pixels, select the 
Matrix style check box.

14. Click OK.

15. Click OK. 

The marquee displays.
NOTE: You must configure marquee text and variables. See "Configuring marquee text and vari-
ables".

Configuring marquee text and variables

To configure text and variables for the marquee
1. Right-click the marquee and click Configure marquee.

The Configure marquee window displays.
2. In the Message editor text box, type a message to display on the marquee (for example, type Calls 

Wtg =).

3. Under Message editor, click the Add variable button.

The Add/Edit variable window displays.
4. Click Add.

The Configure variable window displays.
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5. Under Variable types, click the monitor type to which the variable applies.

6. Under Variables, click a variable.

NOTE: The following queue variables will not supply information for Ring Groups:
– % Handled by 1, 2, 3, 4
– Dial Out of queue
– Requeued

NOTE: The Extension variable is available in the list, when you add this variable, this will be displayed 
blank in the marquee as extensions are not reported on a SIP platform.

7. Under Devices, select the check box of a device.

8. Under Thresholds, click Add threshold and specify a value for the upper boundary of the first 
threshold.

9. Click OK.

10. For the threshold, under Variable, select a color to be displayed in the marquee message string.

11. For the threshold, under Message, select a color for the text that will precede the variable in the 
marquee text string.

12. After Type a name for the variable, type a name.

13. Click OK.

14. On the Configure marquee window, in the Message editor text box, position your pointer where you 
want to add the variable.

15. You can add variables at the beginning, middle, or end of message strings.

16. On the Add/Edit variable window, double-click the variable to add it to the message string.

Click the Add variable button.
The Add/Edit variable window displays.

17. Click the Configure transition effects button and select the check boxes for the transition effects to 
be included.

18. Click OK.

The marquee displays, showing the text you typed and a real-time value for the performance variable. 
You can define additional thresholds for the performance variable, and add additional variables to the 
marquee.

Using Contact Center Chat

Contact Center Client provides instant messaging capabilities for both supervisors and agents and is typi-
cally used by contact center employees only. Contact Center Chat provides the online chat presence 
of contact center employees, including Online, Offline, and Away. Agents can view the availability and 
presence of other contact center employees before they transfer calls or send online chat messages.
Using Contact Center Chat, you can communicate essential information to one or 
more agents, agent groups, or supervisors quickly and securely. You can coach agents and send timely 
messages, such as asking an agent to delay going on break when it is busy.
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NOTE: 
• You must have a security role that does not restrict you from gaining access to Contact Center Chat.
• You must log on to Contact Center Client in order to send and receive online messages.
• When you receive a message it is displayed immediately on top of all open windows.

Sending a Contact Center Chat message

On an extension, agent, or employee monitor you can right-click an agent’s cell and click Send instant 
message to send an online message to the agent.
To send a chat message 
1. Double-click your presence indicator in Contact Center Client’s Status Bar. 

Contact Center Chat opens. (See the following figure.)
Figure 16.34: Contact Center Chat

 

2. Right-click a contact and select Send an instant message. 

Alternatively, double-click the contact.
The Conversation window opens.

3. Type a message.

4. Click Send.

To send a chat message while viewing an extension, agent, or employee monitor
1. Right-click a cell in an open monitor and click Send instant message. Alternatively, double-click the 

presence indicator in the extension, agent, or employee's cell in the monitor. 
The Conversation window displays.

2. Type a message.

3. Click Send.
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Adding someone to an interaction

To add someone to an interaction
1. On the Conversation window, click the Add Participants button to join this conversation icon.
2. Double-click a contact to add the contact to the interaction.

3. Click Send.

Responding to a Contact Center Chat message

Agents and supervisors can receive Contact Center Chat messages only if they are logged on to Contact 
Center Client. When someone sends a Contact Center Chat message to you, the Conversation window 
opens and a desktop notification appears in the bottom-right of your monitor. The desktop notification 
shows the name and presence of the employee contacting you and their message. The following figure 
illustrates a chat notification.

Figure 16.35: Desktop Chat notification
 

To respond to a chat message 
1. Type a message.
2. Click Send. 

Contact Center Chat sends your response to all chat session participants.

Using Contact Center Chat with Skype for Business

With the addition of Microsoft Skype for Business Server agents and supervisors use Skype for 
Business as their default instant messaging client. The presence of all company employees is natively 
delivered in Contact Center Client. Contact center employees can view the presence of both internal and 
external contacts to determine if they are available to communicate. In addition to Available, Offline, and 
Away, employees see In a Meeting, Busy, In a call, Do Not Disturb, Be Right Back, and other Skype for 
Business presence indicators.
NOTE: In order to use Contact Center Chat with Skype for Business, you must enable Contact Center Chat 
and have Skype for Business open and running.
If an agent views an employee on a real-time monitor and notes the employee is online, the agent can 
right-click the employee and send an instant message.
The following table provides details on the presence indicators that are available when Contact Center 
Client is used in conjunction with Skype for Business Client and Contact Center Chat with Skype for Busi-
ness.
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Table 16.15:Skype for Business presence indicator icons  (Sheet 1 of 2)

2013 
Presence 
Icon (Large)

2013 
Presence 
Icon 
(Small)

Status 
Text Description

 Available The contact is online and can participate in interactions. 
Users can manually set this status, but the next automatic 
state change will override this setting.

Busy The contact is available, but is engaged by another 
activity. Busy contacts will not be routed ACD calls, but 
may receive Non ACD calls. Possible activities include the 
following:
In a Call—the contact is in a phone, voice, or video 
interaction.
In a Meeting—the Outlook calendar shows that the 
contact has a scheduled meeting.
Users can manually set this status.

Do Not 
Disturb

The contact is engaged by another activity and is 
unavailable. Contacts in Do Not Disturb will neither 
receive ACD or Non ACD calls. Users can manually set 
this status.
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Sending an instant message

On an agent or employee monitor, you can right-click an agent or employee’s cell and click Send instant 
message to send an online message to the agent or employee. You can also send instant messages 

Away / 
Inactive
Be Right 
Back
OffWork

The contact is likely unavailable. Possible reasons include 
the following:
The contact’s computer has been idle for more than the 
away time period setting (5 minutes by default).
NOTE: By default, the transition from Available to Inactive 
occurs after 5 minutes. Then, after five more minutes, the 
status changes to Away if there is still no activity on the 
computer. 
The contact’s Outlook calendar or Out of Office Assistant indi-
cates that they are out of the office.
The contact is temporarily unavailable
NOTE: As soon as activity is detected on the contact’s 
computer, Ignite automatically resets the presence status 
to the appropriate state. 
The contact has locked their computer.
The contact has manually set their presence to Away or Be Right 
Back.
Users can manually set this status.
NOTE: When a user manually sets themselves as Away, 
they are still available to receive calls, such as from a 
transfer.

Offline The contact is not available. Possible reasons for this 
include the following:
The contact has manually set their presence status to 
Appear Offline.
The contact has not signed into Skype for Business.
The contact has blocked you from seeing their presence 
status.
Skype for Business is not running on the contact’s 
computer.

Presence 
unknown

 Skype for Business cannot determine the status of the 
contact. This status is typically displayed because the 
contact’s presence status is unavailable to Skype for 
Business, such as for a contact who is part of an 
organization that is not a federated partner.

Table 16.15:Skype for Business presence indicator icons (Continued) (Sheet 2 of 2)

2013 
Presence 
Icon (Large)

2013 
Presence 
Icon 
(Small)

Status 
Text Description
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using Microsoft Skype for Business. Using Skype for Business, you can send instant messages to indi-
viduals or multiple contacts. After initiating an interaction, you can invite additional contacts to the inter-
action. For instruction in using Skype for Business, consult your Microsoft Skype for Business 
documentation.
NOTE: Supervisors send instant messages to contacts or groups of contacts using Contact Center Client.
To send an instant message while viewing agents on an extension, agent, or employee monitor
• Right-click a cell in an open monitor and click Send instant message. 

A Skype for Business Conversation window opens.

Hot desking profile settings

When an agent is configured as a Mitel hot desking agent, the agent can sit at any extension on the 
network and log on to the extension. After the agent is logged on, the agent takes control of the extension. 
The agent's Contact Center Client and soft phone real-time profile settings are available. Any previous 
associations with the extension are taken out of service. When an agent logs off, the agent disconnects 
from the extension and the default settings for the extension are restored automatically.
WARNING: If an external hot desk agent is using a personal phone to handle calls, incoming calls that are 
not answered could reach their personal voicemail.

Posting feedback and viewing our forums

Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on https://micon-
tactcenter.uservoice.com. When you post an idea to our feedback forum, others will be able to subscribe 
to it and make comments.
Our forums enable you to send feedback directly to the people building the product. While we cannot 
comment on every suggestion, feedback is analyzed and considered for future releases.
NOTE: Please do not use the forums to submit product defects. To submit product defects, please contact 
your administrator or dealer.
Feedback can also be submitted directly to Mitel without posting the suggestion on the forums. For more 
general feedback, you can also provide a rating of your experience with MiContact Center Business.
NOTE: Please do not use feedback for requesting customer assistance. For assistance with MiContact 
Center Business, please contact your dealer or Mitel Customer Support.
To post feedback and view our forums 
1. In YourSite Explorer, click File > Feedback.
2. Click Got an idea? Tell us. 

or
Access the following URL: https://micontactcenter.uservoice.com.

To submit feedback directly 
1. In YourSite Explorer, click File > Feedback.
2. Click Contact Us.

To rate your Mitel experience 
1. In YourSite Explorer, click File > Feedback.
2. Click Rate us.

https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
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Accessing real-time information with Ignite (WEB)
Ignite (WEB) enables real-time monitoring of employees, agents, queues, and callback requests. The 
Ignite (WEB) real-time monitors do not duplicate those available in Contact Center Client but, instead, 
offer a succinct set of the most essential statistics in the highly accessible online format of Ignite (WEB).
The following real-time monitors are available in Ignite (WEB): 
• Employee State
• Agent State
• Queue Now
• Callback Requests

To access the real-time monitors in Ignite (WEB) 
1. In Ignite (WEB), click Dashboards.
2. Click the down arrow and select the dashboard from the list that contains the monitor you want to 

display.

NOTE: 
• Alarms are not supported for real-time monitors in Ignite (WEB).
• Access to real-time monitors is determined by administrator-set security roles.

To learn how to add and configure settings for real-time monitors in Ignite (WEB), see "Configuring Ignite 
(WEB) dashboards".

Monitoring employee state in Ignite (WEB)

The Employee State monitor available in Ignite (WEB) enables you to view activity and, if enabled for 
Interactive Contact Center, adjust presence for individual employees in your contact center.
You can view the following real-time employee information:
• Employee name, reporting number, and avatar
• ACD availability and state (with colored state icon)
• Busy duration for the day
• Do Not Disturb duration for the day
• Number of interactions handled for the day (voice, email, chat, SMS, open media as applicable)
• Date/Time of first login
• Total shift duration

NOTE: Only one employee at a time can display in the Employee State monitor but you canoptionally add 
several employee monitors to a dashboard to access information for multiple employees.
The Employee State monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn 
how to add and configure settings for the Employee State monitor in Ignite (WEB), see "Configuring Ignite 
(WEB) dashboards".

Monitoring agent state in Ignite (WEB)

The Agent State monitor available in Ignite (WEB) enables you to view the real-time state of agents in 
your contact center and, if enabled for Interactive Contact Center, adjust agent presence.
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Each column lists agents in order of time in state, with the longest in state at the top. For example, the 
agent at the top of the Idle column is the next longest idle agent and should receive the next inbound inter-
action.
The following table lists and describes real-time agent state information that displays in the Agent State 
monitor in Ignite (WEB).

The Agent State monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn how 
to add and configure settings for the Agent State monitor in Ignite (WEB), see "Configuring Ignite (WEB) 
dashboards".

Monitoring queues in Ignite (WEB)

The Queue Now monitor available in Ignite (WEB) enables supervisors to view queue or queue group 
statistics and a summary of current agent states for each queue or queue group in real time.
Queue statistics include Offered, Service Level %, Interactions Waiting, Requeued, and Longest Waiting. 
Handled, Interflowed, and Abandoned counts can also be accessed by hovering over ‘Offered’ for each 
queue or queue group.
The following table lists and describes queue statistics that display in the Queue Now monitor in Ignite 
(WEB).

Table 16.16:Agent State monitor statistics - Ignite (WEB)

STATISTIC DESCRIPTION

ACD includes agents in ACD and ACD Hold

Idle includes agents who are available for ACD but 
currently not handling any interactions 

Non ACD includes agents in Non ACD, Non ACD Hold, 
Outbound, and Outbound Hold

Unavailable includes agents in Do Not Disturb, Busy, Work 
Timer, and Reseize Timer

Not Present includes agents who are logged in as an agent 
but not present in any agent groups

Offline includes agents who are logged in as an ACD 
agent

Table 16.17:Queue Now monitor statistics - Ignite (WEB)  (Sheet 1 of 2)

STATISTIC DESCRIPTION

Offered the total number of interactions offered to the 
queue or queue group
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The current number of agents, by state, also displays for each queue or queue group for the following 
agent states: 

Service Level % for a queue, this is the percentage of interactions 
handled within the queue’s Service Level Time 
value over the day
for a queue group, this is the lowest percentage 
of interactions handled within the queue’s Service 
Level Time value over the day across all queues

Contacts Waiting the current number of interactions in queue 
waiting for a member to become available, 
including those listening to silence, music, or 
recorded announcements

Requeued the total number of ACD interactions requeued 
NOTE: This statistic displays information for ACD 
paths only. Statistics for Ring Groups display as '0'

Longest Waiting the current duration, in minutes and seconds, of 
the interaction waiting the longest in queue or 
queue group

Handled the total number of ACD interactions handled by 
members

Interflowed the total number of ACD interactions interflowed 
interflow is a mechanism that directs an 
interaction waiting in queue to another answer 
point 
NOTE: If an interaction waiting in queue is redi-
rected before the queue's short abandoned time 
has elapsed, the queue is pegged with a Queue 
Unavailable count rather than an interflowed 
count. In order for the Interflowed peg to occur, the 
redirection must occur after the short abandoned 
time has elapsed

Abandoned the total number of interactions abandoned 
before being answered by members 
NOTE: Abandoned does not peg short abandons 
as abandoned interactions in the Queue Now 
monitor. The Abandoned column in the Interactive 
Visual Queue monitor displays all abandoned 
interactions. Because of this difference, you may 
notice discrepancies between the abandoned call 
information in these two monitors

Table 16.17:Queue Now monitor statistics - Ignite (WEB) (Continued) (Sheet 2 of 2)

STATISTIC DESCRIPTION
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• Idle: includes agents who are available for ACD but not currently handling any interactions 
• ACD: includes agents in ACD and ACD Hold
• Non-ACD: includes agents in Non ACD, Non ACD Hold, Outbound, and Outbound Hold
• Unavailable: includes agents in Do Not Disturb, Busy, and Work Timer

The Queue Now monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn how 
to add and configure settings for the Queue Now monitor in Ignite (WEB), see "Configuring Ignite (WEB) 
dashboards".

Viewing and managing callbacks in Ignite (WEB)

When licensed for IVR, the Callback Requests monitor, available in Ignite (WEB), enables you to interact 
with callbacks and monitor their state in real time.
The Callback Requests monitor enables users to requeue, reject, and delete callbacks from within the 
monitor. Requeued callbacks are re-entered into their queue. Rejected callbacks are removed from the 
queue and will not be offered to employees. Deleted callbacks are removed from the monitor, but are not 
removed from the system.
To requeue, reject, or delete a callback 
• In the row of the call you want to interact with, in the Actions column, left-click either Requeue, Reject, 

or Delete.
The following table lists and describes the statistics available in the Callback Requests monitor.
Table 16.18:Callback Requests monitor statistics - Ignite (WEB)

STATISTIC DESCRIPTION

Name the name of the caller

Number the phone number provided by the caller

Status the status of the callback

Offer At the specific time the callback will be executed

Received the specific time the caller submitted the callback 
request

Preferred Time the time the caller is available to receive the 
callback (if the caller does not enter a preferred 
time, this column will be blank)

Destination the queue, agent, and extension for which the 
callback is intended

# of Attempts the number of times the callback has been 
attempted

Last Attempted the specific time the last callback attempt to the 
caller was made

Actions within this column, you can choose to requeue, 
reject, or delete a callback
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The Callback Requests monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn 
how to add and configure settings for the Callback Requests monitor in Ignite (WEB), see "Configuring 
Ignite (WEB) dashboards".
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Forecasting

Forecasting is the basis of estimating required resources to handle a contact center’s workload. Using 
historical data generated by the ACD routing system for both voice and other media types, forecasting 
allows you to adjust key modifiers to predict the number of agents required, by interval, to handle the 
predicted workload.
The Forecasting tool available in Contact Center Client and Workforce Scheduling enables users to 
quickly choose historical data from both voice and multimedia queues or queue groups to use in the fore-
cast, providing average transaction traffic by day of week, by media, as well as by historic manned agents 
and handling statistics for user-selected intervals of time. Supervisors can create forecasts based on 
historic contact center volumes and manually adjust various modifiers to generate hypothetical or future 
anticipated traffic scenarios, optimizing the balance between the agents required to handle the anticipated 
traffic with the expected handling time, wrap up time and Service Level objectives. The Forecasting tool 
lets you adjust key statistics together with intra-day contact volumes rather than only daily statistics which 
provides a much more accurate output of agents required per interval. For example, you may have a situ-
ation where calls coming into your call center are more complex earlier in the day and/or earlier in the 
week creating a higher demand for agents to be available at these times. It is possible that handling time 
drops throughout the day and the demand for agents reduces, allowing for alternate options for agents 
such as off line work, team meetings or performance reviews.
Your ability to forecast is limited only by the available ACD routing data collected and available in your 
SQL database. For example you may choose to take the last few weeks to help predict the next few weeks 
or you could take the last year to help predict the average traffic per week, or you might want to only take 
the period of time in the past where you ran a particular campaign/season to anticipate the amount of 
traffic to expect for a similar upcoming campaign/season, etc. After you run a forecast, you could examine 
the data and make adjustments based on current or anticipated contact center conditions. You could then 
tweak the forecast as required.
NOTE: Ring Groups are not supported with Forecasting, either as queues or as a member of a reporting 
queue groups.

Forecasting terms
Conducting a forecast involves accurately estimating Time to Handle, Wrap Up Time, and Contacts 
Offered values. The following terms are used in forecasting resource requirements: 
• Service Level percent 

Service Level Percent = Service Level Count ÷ ACD offered
For calls and chats, the Service Level Percent is the number of interactions that are handled, aban-
doned, and interflowed before a defined threshold time (Service Level time), compared to the total 
number of Multimedia Contact Centers handled, abandoned, and interflowed. The Service Level Per-
cent = (Handled + Abandoned (long) + Interflowed (long)) within the Service Level time ÷ Total (Han-
dled + Abandoned (long) + Interflowed (long)).
For email and SMS, the Service Level Percent is the number of interactions that are handled and in-
terflowed before a defined threshold time (Service Level time), compared to the total number of inter-
actions handled and interflowed. The Service Level Percent = (Handled + Interflowed (long)) within 
the Service Level time ÷ Total (Handled + Interflowed (long)).

• Service Level time 
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Service Level Time is the time used in calculating the Queue Service Objective. For example, your 
Queue Service Objective may require queue members to handle 80% of interactions within 120 sec-
onds. 120 seconds is the Service Level Time. Queue Service Objectives, which includes Service Lev-
el Time, are specified for individual queues.

• Wrap Up time 
Wrap Up Timeis a real-time and reporting statistic detailing the total time an agent spends in the Work 
Timer state. The Wrap Up Time is a standardized period. If an agent requires additional time to com-
plete paperwork or online transactions, the agent can leave the ACD queue temporarily for this pur-
pose.

• Agent Efficiency percent 
Agent Efficiency percent is the percentage of time agents spend on ACD interactions relative to the 
time agents are scheduled to work. Agent efficiency is calculated using a straight linear relationship. 
For example, 50% agent efficiency means that two more agents are required to handle the forecasted 
workload. An Agent efficiency percentage of 100 is unrealistic. Agents routinely take breaks, perform 
other Non ACD duties, make outgoing calls, and place themselves in Make Busy.

• Contacts Offered 
You can predict the queue member requirement for your Service Level percent and Service Level time 
targets by applying the Erlang C equation to the estimated Call Load and average ACD Handling 
Time.

• Manned Agents 
Manned Agents is the average number of agents who were logged on for the interval of time being 
forecasted.

• Average Handle Time 
Average Handle Time is the average time queue members spend handling interactions, and is deter-
mined by comparing the interaction duration to the number of interactions offered.

NOTE: 
– The Average Handle Time in the Forecasting tool is calculated differently than the Average Handling 

Time in CCMWeb reports, which is determined by comparing interaction duration to the number of 
interactions answered.

– The Daily Average Handle Time in the Forecasting tool is calculated from the interval rows in the 
forecast and may differ from the Average Handling Time for that day in contained in a report.

• Time to Handle 
Time to Handle is the average time calls wait in queue before being handled.

• ACD Handling Time 
ACD Handling time is the talk time plus the hold time. If a queue member calls a supervisor in search 
of more information (while the caller is on hold) and/or transfers or conferences the call, the system 
adds these times to the ACD Handling Time value.

• Call Load 
The term Call Load is to the combined effect of the number of interactions received by the ACD queue 
and their duration, or the calls offered x (average ACD Handling Time + average Wrap Up Time).

Forecasting tool
The Forecasting tool is accessed via Contact Center Client. If you are licensed for Workforce Scheduling, 
you can also access it in that application under the Tools tab. In order to access the Forecasting tool, your 
security role must have the 'May manage Forecasting' option enabled.
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You use the Forecasting tool to create forecasts based on historical contact center traffic volumes. After 
loading historical data into the tool, you can perform 'what-if' scenarios and optimize the balance between 
the agents scheduled and your Service Level objectives.
The Forecasting tool offers a tabbed interface for viewing and setting historical data for each day of the 
week. If more than one media type has been included in the historical data, each day’s tab will have a 
section for each media type included in the historic data. The forecast grid is divided into rows based on 
the interval time selected when loading historical data, enabling users to adjust statistics by 15, 30, or 60 
minute intervals. The statistics have Historic and Current values, which display the original values from 
the loaded historical data and the current values after user modification respectively.
After a forecast has been performed, each day lists the agents required for each interval. The follwoing 
figure shows the Forecasting tool.

Figure 17.1: Forecasting window
 

To forecast resource requirements you 
1. Load historical data. 

See "Loading historical data".
2. Modify historical data if required. 

See "Modifying historical data".
3. Perform a forecast. 

See "Performing forecasts".
4. Export the forecast. 

See "Exporting forecasts".

To access the Forecasting tool 
1. Click Tools in the Contact Center Client ribbon.
2. In the Data Mining section, click Forecasting.

Loading historical data

When you load historical data, you include data from a queue or queue group over a historical period that 
best represents the contact center activity for the time period for which you are trying to forecast. You can 
select one or more specific dates and/or date ranges when loading historical data. You can select sequen-
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tial or non-sequential dates (for example, Monday, Wednesday, and Friday) to use in the forecast. You 
can also exclude specific dates from within your date range.
NOTE: 
• Users should identify and exclude any outliers or extreme values from the time period from which they 

are loading historical data, as these may give artificial values.
• Historical data for agents can be validated by comparing it to the queue and queue group by period 

reports for the same periods.
• Ring Groups are not supported with Forecasting, either as queues or as a member of a reporting queue 

groups.

The following procedure takes place in an open Forecasting tool window.
To load historical data
1. Click Load historical data.

The Forecasting window opens.
2. Under Queues or Queue groups, click on the queue or queue groups you want to use as the source 

of historical data.

NOTE: You can load historical data for a queue or queue group. If you are using the forecast to build 
a schedule, select historical data from the same queue group with which the schedule is associated. 
This data will best represent the agents required for your schedule.

3. If you want to include or exclude data from a specific date, under Historical date(s) for the forecast, 
select Specific day and then select a date.

4. If you want to include or exclude data from a date range, click Date range and specify a range of 
dates.

5. If you are including the data from the specified date(s), click Include dates.

6. If you are excluding the data from the specified date(s), click Exclude dates.

7. Repeat steps 3-6 until you have specified the date(s) or date range(s) from which you will derive your 
historical data.

8. After Start hour and End hour, select the time frame for historical data.

9. After Interval, select the schedule interval: 15, 30, or 60 minutes.

The Interval value, in minutes, is the time increment by which the forecast will be displayed. It is rec-
ommended that you select an interval that matches the increments in which you schedule your em-
ployees. For example, if you schedule your employee shifts in 30 minute increments, select 30 
minutes as the Interval value.

10. Click Submit.

Modifying historical data

After loading your historical data, you can modify the values of Contacts Offered and Average Handle 
Time to generate different forecast results based on the modified values. You can also modify values after 
performing forecasts to obtain different forecasts of required agents. The historical values for data are 
always displayed, regardless of modifications, for comparison.



587

FORECASTING TOOL
CHAPTER 17 FORECASTING

Modifying Average Handle Time

You can modify the Average Handle Time value for an interval, a day, or several days simultaneously. 
When you select a modification to apply to a value, either the Historic or Current value, it is applied as the 
new Current value. You cannot change the Daily Average Handle Time, but you can use it to modify the 
Average Handle Time of other intervals.
The following procedures outline how to 
• Modify the Average Handle Time parameter on the forecast grid
• Modify an interval’s Average Handle Time parameter
• Modify the Average Handle Time parameter using the Historic Daily Average Handle Time parameter

The following procedures take place in an active Forecasting tool window.
To modify the Average Handle Time parameter on the forecast grid 
1. Click Modify... > Average Handle Time. 

Alternatively, select an interval row, click the cell for Current Average Handle Time, and click the … 
button.
See the following figure.

2. Under Specify the Average Handle Time value(s), specify how you want to modify Average Handle 
Time: 

– Increase or decrease Average Handle Time by a specific number of seconds
– Increase or decrease Average Handle Time by a specific percentage
– Set the Average Handle Time to a specific number of seconds

3. Under Apply the changes to the following data source, specify if you want to have the modification 
applied to the original value or the current grid value.

4. Under Apply to days, select the days for which you want to modify Average Handle Time.

5. Under Apply to media type, select the media types for which you want to modify Average Handle 
Time.

6. Click Apply.

To modify an interval’s Average Handle Time parameter 
• Select an interval row, click the cell for Current Average Handle Time.
• Set the Average Handle Time parameter for the interval.

To modify the Average Handle Time parameter using the Historic Daily Average Handle Time parameter 
1. Click the … button after Historic Daily Average Handle Time.
2. Under Specify the Average Handle Time value(s), specify how you want to modify the Historic Daily 

Average Handle Time: 

– Increase or decrease Average Handle Time by a specific number of seconds
– Increase or decrease Average Handle Time by a specific percentage
– Set the Average Handle Time to a specific number of seconds

3. Under Apply to days, select the interval(s) for which you want to apply the modified Historic Daily 
Average Handle Time.

4. Click Apply.
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Figure 17.2: Average Handle Time window
 

Modifying Contacts Offered

You can modify the Contacts Offered value for one or several time intervals simultaneously. When you 
select to modify a value, either Historic or Current, it is applied as the new Current value.
This section explains how to: 
• Modify the Contacts Offered parameter on the forecast grid
• Modify an interval’s Contact Offered parameter

The following procedures take place in an active Forecasting tool window.
To modify the Contacts Offered parameter on the forecast grid 
1. Click Modify... > Contacts Offered. 

See the following figure.
2. Under Specify how you want to change the Contacts Offered value(s), specify how you want to 

modify Contacts Offered: 

– Increase or decrease Contacts Offered by a specific number of calls
– Increase or decrease Contacts Offered by a specific percentage
– Set the Contacts Offered to a specific number of call

3. Under Apply the changes to the following data source, specify if you want to modify the original 
value or the current grid value.

4. Under Apply to times, select the days and time interval for which you want to modify Contacts 
Offered.

5. Under Apply to media type, select the media types for which you want to modify Contacts Offered.

6. Click Apply.
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To modify an interval’s Contacts Offered parameter 
1. Select an interval row, click the cell for Current Contacts Offered.
2. Set the Current Contacts parameter for the interval.

Figure 17.3: Contacts Offered window
 

Modifying the weekly total for Contacts Offered

You can modify the Contacts Offered values for an entire week simultaneously. Modifying these values 
changes the number of Contacts Offered while maintaining the same proportion of calls across all time 
intervals. For example, if you increase the weekly total by 10 percent, an interval with 10 calls will change 
to 11. However, an interval with zero calls will remain zero.
The following procedure takes place in an active Forecasting tool window.
To modify the Contacts Offered parameter on the forecast grid 
1. Click Modify... > Weekly total. 

See the following figure.
2. Under Specify how you want to change the weekly total, specify how you want to modify Contacts 

Offered over the week: 

– Increase or decrease the weekly total of Contacts Offered by a specific number of contacts
– Set the weekly total of Contacts Offered to a specific number of contacts

3. Under Apply to totals, specify if you want to modify the original values or the current grid values.

4. Click Apply. 

Figure 17.4: Weekly total for Contacts Offered window
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Performing forecasts

When you perform a forecast, you receive the required agents based on both the historical and current 
values. If you adjust any of the values in your historical data, you must perform the forecast again.
NOTE: It is recommended that you save your forecast as an Excel file to preserve your settings to use or 
compare with the next forecast you make.
To run a forecast
1. Specify the Service Level %, Service Level Time, Wrap Up Time, and Agent Efficiency % you expect 

for the queue or queue group.
2. Click Perform forecast.

You can perform what-if scenarios on the historical data using different Service objectives statistics 
until you are satisfied with the forecast.

Exporting forecasts

After performing a forecast, you can export it as a Microsoft Excel spreadsheetor export the forecast to 
Workforce Scheduling.

Saving forecasts as Excel files

After you generate forecast data you can export it to a Microsoft Excel .xlsx worksheet. If your forecast 
has different media types, each media type will have its own worksheet in the .xlsx file.
To export a forecast as an Excel file
1. Click Export Forecast.
2. Click Microsoft Excel.

3. Click Export.
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The forecast opens in a Microsoft Excel spreadsheet you can modify and save.

Exporting forecasts to Workforce Scheduling

If you are licensed for Workforce Scheduling, after you generate forecast data, you can export it into a 
Workforce Scheduling schedule.
When scheduling for agents who handle a particular media type, it is recommended that you export fore-
casts that use solely data from that media type. For example, if you are forecasting based on historical 
data from an email queue, the forecast should be exported into a Workforce Scheduling schedule that 
only handles email ACD interactions.
To export a forecast into a Workforce Scheduling schedule
1. Click Export Forecast.
2. Select Workforce.

3. For each media type, select the schedule for which to apply the forecast.

NOTE: Each media type must be exported to a different schedule.
4. Click Export.
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Interactive Contact Center

Interactive Contact Center is a feature that enables supervisors to control the availability of agents, exten-
sions, and queues, and enables agents to control their own availability.
Access to Interactive Contact Center abilities is determined by security role settings. Employees must be 
associated with the 'May control my real-time status in Interactive Contact Center' security role setting in 
order to change their state using applicable MiContact Center Business client applications.

Supervisors and Interactive Contact Center
Using Interactive Contact Center, supervisors can 
• Control the availability of agents and ACD queues
• Log agents on and off of the system
• Have agents leave their agent groups and join other agent groups. Agent groups are assigned to 

queues so, in this way, agents can be moved from one queue to another as needed
• Have extensions leave their Ring Groups and join other Ring Groups
• Place agents in Make Busy
• Place agents in Do Not Disturb
• Place extensions into Do Not Disturb
• Place queues in Do Not Disturb
• Cancel Work Timer
• Cancel Reseize Timer

An employee's agent can be assigned to multiple agent groups, which can be associated to multiple 
queues. In order to move the agent from one queue to another queue, the supervisor has the agent leave 
one agent group and join another agent group.

Agents and Interactive Contact Center
Using Interactive Contact Center, agents can 
• Log themselves on and off of the system
• Remove themselves from agent groups and place themselves into other agent groups. Agent groups 

are assigned to queues so, in this way, agents can move themselves from one queue to another as 
needed

• Place themselves in Make Busy
• Place themselves in Do Not Disturb

Every time agents leave their desks they must set themselves into either Make Busy or Do Not Disturb 
and apply the applicable reason code. This enables supervisors to track agents' Do Not Disturb and Make 
Busy activity in reports.
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Employee and Agent control
Using Interactive Contact Center and Contact Center Client, you can control agents on the following moni-
tors: 
• Agent State by Position and Employee State by Position
• Agent State by Time and Employee State by Time
• Agent Shift

Agent control gives you control over individual agents. Monitor control gives you control over all of the 
agents on a monitor. All of the agents on the monitor are affected simultaneously by the action you take.
If you have Context Sensitivity enabled for monitors, the Agent Control and Monitor Control tabs display 
in the Contact Center Client ribbon when you have any of the above monitors open. You can perform 
actions using either a right-click and select method within the monitor or by selecting an agent or an empty 
cell (monitor control) and accessing the action menu in the Agent or Monitor Control tab views. (See the 
following figure.)
Using Interactive Contact Center and Ignite (WEB), you can control agents and employees in the following 
monitors: 
• Employee State
• Agent State

NOTE: Context sensitivity and monitor control are not supported with Ignite (WEB). You can only alter the 
state for one employee or agent at a time.

Figure 18.1: Agent Shift - Agent Control tab options
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Agents and Agent Group Presence

Agents can be assigned to multiple agent groups, which are associated with different queues. When 
agent groups are created, an employee’s agents are assigned a default group presence, either Present 
or Absent. To handle interactions the employee can make themselves present in their agent groups using 
either Contact Center Client or Ignite.
It is important to note that agents may join or leave agent groups but not queues. Agents become absent 
from a queue indirectly if they leave all agent groups associated with that queue. An agent who is present 
in an agent group which is associated to all queues would be disassociated from all queues simultane-
ously if they became absent in their agent group

Hiding the Monitor control option

Interactive Contact Center enables you to manage the presence of all devices in a monitor using Monitor 
Device Control. If you do not want to use monitor control, you can hide this option so it is not accessible.
To hide the Monitor control option
1. In Contact Center Client, click File > Options.
2. Under Device control, clear the Display monitor device control option check box.

3. Click OK.
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Logging on an agent - Contact Center Client

NOTE: 
• An ACD Hot Desking Agent must enter an extension number each time the agents logs on to the ACD 

routing system using Interactive Contact Center. The agent cannot rely on the extension number last 
used when logging on. This is because the ACD data stream unifies the agent ID and the extension. 
After a Hot Desking Agent logs on or off of the ACD routing system using Interactive Contact Center, 
sometimes the Interactive Contact Center agent controls are not available to the agent for two to five 
minutes.

• You will be unable to log on an agent to the system if there are no available user licenses.
• If your contact center participates in the use of PINs, supervisors with the correct Class of Service do 

not require an agent’s PIN to interactively log in a Hot Desking Agent.
• Depending on security roles and telephone switch settings, employees who are licensed as Advanced 

Supervisor or System Administrator may not be prompted to enter a PIN when logging into Interactive 
Contact Center, Softphone, or PhoneSet Manager.

• If a Hot Desking Agent logs into an extension that serves as the overflow point for a Ring Group, calls 
to that Ring Group will not be offered to the extension and will remain queued or ringing until aban-
doned or answered.

• Hot desking users logging into a Ring Group extension must also be a member of the Ring Group to 
ensure accurate reporting.

You log employee voice agents in and out in either an open Employee or Agent Monitor in Contact Center 
Client. Multimedia agents are not logged in with voice agents.
To log in an agent in an open Employee monitor 
• Right-click the cell of an employee and click Employee control > Log in > voice agent. Alternatively, 

select the employee cell in an open monitor, click Log in from the Employee Control tab on the 
Contact Center Client ribbon, and select the voice agent. 

NOTE: When you log in an employee’s voice agent, you must enter the extension for the agent. See 
the procedure below.

To log in an agent by extension in an open Employee monitor 
1. Right-click the cell of an employee and click Employee control > Log in > By extension.
2. If the employee has multiple voice agents, select the agent to log in from the drop-down list.

3. Type the Agent’s extension.

4. Click OK.

To log in an agent in an open Agent monitor 
• Right-click the cell of a voice agent who is not logged into and click Agent Control > Log in > voice 

agent. Alternatively, select the agent cell in an open monitor and click Log in from the Contact Center 
Client ribbon. 

NOTE: When you log in a voice agent, you must enter the extension for the agent. See the procedure 
below.

To log in an agent by extension in an open Agent monitor 
1. Right-click the cell of a voice agent and click Agent control > Log in > By extension.
2. If the employee has multiple voice agents, select the agent to log in from the drop-down list.

3. Type the Agent’s extension.
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4. Click OK.

Logging off an agent - Contact Center Client

You can log off an employee from all media in an Employee monitor or Agent monitor. Logging off an 
agent logs off the employee’s voice agent and sets the employee’s multimedia agents to Absent in all their 
agent groups. If the employee is logged into their soft phone in Contact Center Client, they will also be 
logged out of the soft phone.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To log off all of an employee's agents in an open Employee monitor 
• Right-click the cell of an employee and click Employee control > Log off. Alternatively, select the 

employee cell in an open monitor and click Log Off from the Employee Control tab on the Contact 
Center Client ribbon.

To log off an agent in an open Agent monitor
NOTE: Logging off an employee's agent logs off all of the employee's agents simultaneously.
• Right-click the cell of an agent and click Agent control > Log off. Alternatively, select the agent cell 

in an open monitor and click Log Off from the Agent Control tab on the Contact Center Client ribbon.
To log off all employees' agents in an open Employee monitor 
1. Right-click the monitor and click Monitor control > Log off. 

Alternatively, click the Monitor Control tab in the Contact Center Client ribbon and select Log Off.
2. Click Yes.

To log off all agents in an open Agent monitor 
1. Right-click the monitor and click Monitor control > Log off. 

Alternatively, click the Monitor Control tab in the Contact Center Client ribbon and select Log Off.
2. Click Yes.

Logging on an agent - Ignite (WEB)

When you log on an agent in Ignite (WEB), you make them available to receive voice interactions.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To log on a voice agent
1. In the monitor, select the agent you want to log on.
2. Click State > Available.

3. Enter the agent’s extension and PIN (if enabled) and click Login.

NOTE: This step is not required if the agent is set to automatically log in when the ‘Available’ state is 
selected.

Logging off an agent - Ignite (WEB)

When you log off an agent in Ignite (WEB), you make them unavailable to receive all media interactions, 
including voice, email, chat, SMS, and open media.
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The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To log off an agent
1. In the monitor, select the agent you want to log off.
2. Click State > Offline.

Joining and leaving agent groups - Contact Center Client

After logging into Contact Center Client, agents can use Interactive Contact Center to control their pres-
ence status in agent groups. Optionally, supervisors can use Interactive Contact Center to control the 
presence status of agents in specific agent groups.
NOTE: 
• An agent's ACD hot desk line remains in service while they are logged in as an ACD hot desk user 

even if they are not present in any ACD groups and not receiving ACD calls.
To join an agent to or have an agent leave an agent group in an open Employee monitor 
1. Right-click the cell of an employee and click Employee control > Join/Leave Agent Group > 

[Agent]. 
Alternatively, select the cell of an employee and in the Employee Control tab of the Contact Center 
Client ribbon, click Join/Leave agent group > [Agent].

2. Select the agent group(s) to which you want the employee’s agent(s) to join or deselect the agent 
group(s) to have the employee’s agent(s) leave the agent groups.

3. Click OK.

To join an agent to or have an agent leave an agent group in an open Agent monitor 
1. Right-click the cell of an agent who is logged on and click Agent control > Join/Leave Agent Group. 

Alternatively, select the cell of an agent and click Join/Leave Agent Group from the Agent Control 
tab in the Contact Center Client ribbon.

2. Select the agent group(s) to which you want the agent(s) to join or deselect the agent group(s) to 
which you want the agent(s) to leave.

3. Click OK.

Joining and leaving agent groups - Ignite (WEB)

After signing into Ignite (WEB) and logging into their phone, agents can use interactive Contact Center to 
control their presence in agent groups. Optionally, supervisors can use Interactive Contact Center to 
control the presence status of agents in specific agent groups from within the Agent and Employee State 
monitors in Ignite (WEB).
The following procedures take place in either an Agent State or Employee State monitor in Ignite (WEB).
To join an agent to an agent group 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. Hover over the agent group's avatar and select Join All.

4. Click Update.
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To remove an agent from an agent group 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. Hover over the agent group’s avatar and select Leave All.

4. Click Update.

To join an agent to or remove an agent from all agent groups 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. To join an agent to all agent groups, click Join All > Update.

4. To remove an agent from all agent groups, click Leave All > Update.

To make an agent available or unavailable to answer interactions of a specific media type 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. To become available to answer interactions of a specific media type, click the media icon in the agent 
group so the icon displays in blue.

4. To become unavailable to answer interactions of a specific media type, click the media icon in the 
agent group so the icon displays in grey.

5. Click Update.

Placing employees in Make Busy - Contact Center Client

NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
Placing employees into Make Busy places both employees and all of their agents into Make Busy.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To place an employee in an open Employee monitor in Make Busy 
• Right-click the cell of an employee and click Employee control > Set Make Busy > reason code. 

Alternatively, select an empty cell in an open monitor and click Set Employee Make Busy > reason 
code from the Employee Control tab in the Contact Center Client ribbon.

To place all employees in an open Employee monitor in Make Busy 
1. Right-click the monitor and click Monitor control > Set Make Busy > reason code. Alternatively, 

select an empty cell in an open monitor and click Set Make Busy > reason code from the Monitor 
Control tab in the Contact Center Client ribbon.

2. Click Yes.

To place an employee in an open Agent monitor in Make Busy 
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• Right-click the cell of an agent and click Agent control > Set Employee Make Busy > reason code. 
Alternatively, select the agent cell in an open monitor and click Set Employee Make Busy > reason 
code from the Agent Control tab in the Contact Center Client ribbon.

To place all employees in an open Agent monitor in Make Busy 
1. Right-click the monitor and click Monitor control > Set Employee Make Busy > reason code. Alter-

natively, select an empty cell in an open monitor and click Set Make Busy > reason code from the 
Monitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

Removing employees from Make Busy - Contact Center Client

Removing employees from Make Busy removes both employees and all of their agents from Make Busy.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To remove an employee in an open Employee monitor from Make Busy 
• Right-click the cell of an employee whose agents are in Make Busy and click Employee control > 

Remove Make Busy. Alternatively, select an empty cell in an open monitor and click Remove Make 
Busy from the Employee Control tab in the Contact Center Client ribbon.

To remove all employees in an open Employee monitor from Make Busy 
1. Right-click the cell of an employee who is in Make Busy and click Monitor control > Remove Make 

Busy. Alternatively, select an empty cell in an open monitor and click Remove Make Busy from the 
Monitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

To remove an employee in an open Agent monitor from Make Busy 
• Right-click the cell of an agent in Make Busy and click Agent control > Remove Make Busy. Alter-

natively, select the agent cell in an open monitor and click Remove Make Busy from the Agent 
Control tab in the Contact Center Client ribbon.

To remove all employees in an open Agent Monitor from Make Busy 
1. Right-click the cell of an employee and click Monitor control > Remove Make Busy. Alternatively, 

select an empty cell in an open monitor and click Remove Make Busy from the Monitor Control tab 
in the Contact Center Client ribbon.

2. Click Yes.

Placing employees in Busy - Ignite (WEB)

NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
Placing an employee into Busy places them in Busy across all media types for which they answer inter-
actions. While in Busy, they can receive transferred multimedia interactions, however, inbound multi-
media interactions will not be routed to them. They can also receive Non ACD voice interactions and pick 
interactions waiting in queue.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
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To place an employee in Busy
1. In the monitor, select the employee you want to place in Busy.
2. Click State > Busy….

3. Choose a Busy code.

Removing employees from Busy - Ignite (WEB)

Removing employees from Busy re-enables them to answer inbound multimedia interactions and ACD 
calls.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To remove an employee from Busy
1. In the monitor, select the employee you want to remove from Busy.
2. Under State, select an alternate state, or, click X button next to Busy... to remove the busy code.

NOTE: Select Available if you want to make them available to receive interactions.

Placing employees in Do Not Disturb - Contact Center Client

NOTE: 
• If an agent on an ACD calls puts themselves into MKB or DND, Work Timer events are not received 

for that call.
• Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 

until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification 
Code will be applied to the call..

Placing employees into Do Not Disturb places employees and all of their agents into Do Not Disturb.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To place an employee in an open Employee monitor in Do Not Disturb 
• Right-click the cell of an employee and click Employee Control > Set Do Not Disturb > reason code. 

Alternatively, select the employee cell in an open monitor and click Set Employee Do Not Disturb > 
reason code.

To place all employees in an open Employee Monitor in Do Not Disturb 
1. Right-click the monitor and click Monitor control > Set Do Not Disturb > reason code. Alternatively, 

select an empty cell in an open monitor and click Set Do Not Disturb from the Monitor Control tab 
in the Contact Center Client ribbon.

2. Click Yes.

To place an employee in an open Agent monitor in Do Not Disturb 
• Right-click the cell of an agent who is logged on and click Agent control > Set Employee Do Not 

Disturb > reason code. Alternatively, select the agent cell in an open monitor and click Set Do Not 
Disturb > reason code from the Agent Control tab in the Contact Center Client ribbon.
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To place all employees in an open Agent monitor in Do Not Disturb 
1. Right-click the monitor and click Monitor control > Set Do Not Disturb > reason code. Alternatively, 

select an empty cell in an open monitor and click Set Do Not Disturb from the Monitor Control tab in 
the Contact Center Client ribbon.

2. Click Yes.

Removing employees from Do Not Disturb - Contact Center Client

Removing employees from Do Not Disturb removes employees and all of their agents from Do Not 
Disturb.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To remove an employee in an open Employee monitor from Do Not Disturb
• Right-click the cell of an employee who is in Do Not Disturb and click Employee control > Remove 

Do Not Disturb. Alternatively, select the employee cell in and click Remove Do Not Disturb from the 
Employee Control tab in the Contact Center Client ribbon.

To remove all of a monitor’s employees in an open Employee monitor from Do Not Disturb
• Right-click the monitor and click Monitor control > Remove Do Not Disturb. Alternatively, select an 

empty cell in an open monitor and click Remove Do Not Disturb from the Monitor Control tab in the 
Contact Center Client ribbon.

To remove an employee in an open Agent monitor from Do Not Disturb
• Right-click the cell of an agent who is in Do Not Disturb and click Agent control > Remove Do Not 

Disturb. Alternatively, select the agent cell in an open monitor and click Remove Do Not Disturb from 
the Agent Control tab in the Contact Center Client ribbon.

To remove all of a monitor’s employees in an open Agent monitor from Do Not Disturb
• Right-click the monitor and click Monitor control > Remove Do Not Disturb. Alternatively, select an 

empty cell in an open monitor and click Remove Do Not Disturb from the Monitor Control tab in the 
Contact Center Client ribbon.

Placing employees in Do Not Disturb - Ignite (WEB)

NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
Placing an employee into Do Not Disturb places them in Do Not Disturb across all media types for which 
they answer interactions. While in Do Not Disturb, they are unable to receive inbound multimedia interac-
tions and internal voice interactions, including transfers.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To place an employee in Do Not Disturb
1. In the monitor, select the employee you want to place in Do Not Disturb.
2. Under State, click Do Not Disturb….

3. Choose a DND code.
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Removing employees from Do Not Disturb - Ignite (WEB)

Removing employees from Do Not Disturb re-enables them to receive interactions for all applicable media 
types.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To remove an employee from Do Not Disturb
1. In the monitor, select the employee you want to remove from Do Not Disturb.
2. Under State, select an alternate state, or, click X button next to Do Not Disturb... to remove the DND 

Reason code.

NOTE: Select Available if you want to make them available to receive interactions.

Canceling Work Timer for employees - Contact Center Client

NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
In an Employee monitor or Agent monitor, you can cancel Work Timer for one or more employees. The 
following procedures take place in either an open Employee monitor or an open Agent monitor in Contact 
Center Client.
To cancel Work Timer in an open Employee monitor
• Right-click the cell of an employee who is in Work Timer and click Employee control > Cancel Work 

Timer. Alternatively, select the employee cell in an open monitor and click Cancel Work Timer in the 
appropriate media section of the Employee Control tab in the Contact Center Client ribbon.

To cancel Work Timer for all employees in an open Employee monitor
• Right-click the monitor and click Monitor control > Cancel Work Timer. Alternatively, select an empty 

cell in an open monitor and click Cancel Work Timer in the media type’s section of the Monitor 
Control tab in the Contact Center Client ribbon.

To cancel Work Timer for an employee in an open Agent monitor
• Right-click the cell of an agent who is in Work Timer and click Agent control > Cancel Work Timer. 

Alternatively, select the agent cell in an open monitor and click Cancel Work Timer from the Agent 
Control tab in the Contact Center Client ribbon.

To cancel Work Timer for all employees in an open Agent monitor
• Right-click the monitor and click Monitor control > Cancel Work Timer. Alternatively, select an empty 

cell in an open monitor and click Cancel Work Timer from the Monitor Control tab in the Contact 
Center Client ribbon.

Canceling Work Timer for employees - Ignite (WEB)

NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
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To remove an employee from Work Timer
1. In the monitor, select the employee you want to remove from Work Timer.
2. Click State and select an alternate state.

NOTE: Select Available if you want to make them available to receive interactions.

Canceling the Reseize Timer for external hot desk agents

If an external hot desk user is unavailable and the ACD path attempts to deliver a call to them the ACD 
routing system will initiate the Reseize Timer, preventing further ACD call delivery attempts until the timer 
expires or is canceled by the agent or supervisor. Value settings for reseize timers are a minimum of four 
seconds, a default of 180 seconds, and a maximum of 60 minutes. These values are configured on the 
ACD routing system. When an agent is in the Reseize Timer state, the applicable real-time monitors in 
Contact Center Client display the Make Busy icon as well as text denoting the agent’s current state as 
'Reseize Timer'.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To cancel Reseize Timer for an employee’s voice agent in an open Employee monitor
• Right-click the cell of an employee who is in Reseize Timer and click Employee control > Cancel 

Reseize Timer. Alternatively, select the employee cell in an open monitor and click Cancel Reseize 
Timer in the appropriate media section of the Employee Control tab in the Contact Center Client 
ribbon.

To cancel Reseize Timer for all employee voice agents in a monitor in an open Employee monitor
• Right-click the monitor and click Monitor control > Cancel Reseize Timer. Alternatively, select an 

empty cell in an open monitor and click Cancel Reseize Timer from the Monitor Control tab in the 
Contact Center Client ribbon.

To cancel Reseize Timer for an employee’s voice agent in an open Agent monitor
• Right-click an agent who is in Reseize Timer and click Agent control > Cancel Reseize Timer. Alter-

natively, select the agent cell in an open monitor and click Cancel Reseize Timer in the appropriate 
media section of the Agent Control tab in the Contact Center Client ribbon.

To cancel all of the voice agents on a monitor in the Reseize Timer state in an open Agent monitor
• Right-click the monitor and click Monitor control > Cancel Reseize Timer. Alternatively, select an 

empty cell in an open monitor and click Cancel Reseize Timer from the Monitor Control tab in the 
Contact Center Client ribbon.

Extension Control
Using Interactive Contact Center and Contact Center Client, you can control extensions on the following 
monitors: 
• Extension State by Position
• Extension Now

Extension Control gives you control over individual extensions. Monitor Control gives you control over all 
the extensions on a monitor. All of the extensions on the monitor are affected by the action you take. You 
can perform actions using either a right-click and select method within the monitor or by selecting an 
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extension or an empty cell (monitor control) and accessing the action menu in the Extension or Monitor 
Control tabs in the ribbon. (See the following figure.)

Figure 18.2: Extension State by Position – Extension Control tab
 

Figure 18.3: Extension State by Position – Extension Control tab

Ring Group presence

If you are licensed for Ring Groups, extensions can join and leave Ring Groups via Interactive Contact 
Center.
Extensions can be assigned to multiple Ring Groups. Within a Ring Group, an extension can be set to 
Present, enabling it to receive calls, or Absent, ensuring that calls are not offered to the extension. By 
default, extensions are set to Present. Supervisors can manually change the extension presence in 
Contact Center Client.

Joining and leaving Ring Groups

Interactive Contact Center can be used to control the presence of extensions in Ring Groups.
The following procedures take place in an open Extension monitor in Contact Center Client.
To join an extension to or remove an extension from a Ring Group
1. Right-click the cell of an extension and click Extension control > Join/Leave.

Alternatively, select the cell of an extension and in the Extension Control tab of the Contact Center 
Client ribbon, click Join/Leave.
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2. Select the Ring Group(s) to which you want the extension to join or deselect the Ring Group(s) to have 
the extension leave the Ring Group(s).

3. Click OK.

Placing an extension in Do Not Disturb

The following procedures take place in an open Extension monitor in Contact Center Client.
To place an extension in Do Not Disturb
• Right-click the cell of an extension and click Extension control > Set Do Not Disturb > reason code. 

Alternatively, select the Extension Control tab and select Set Do Not Disturb > reason code.
To place all extensions into Do Not Disturb in an open monitor
1. Right-click the cell of an extension and click Monitor control > Set Do Not Disturb > reason code.

Alternatively, select the Monitor Control tab and select Set Do Not Disturb > reason code.
2. Click Yes.

Removing an extension from Do Not Disturb

The following procedures take place in an open Extension monitor in Contact Center Client.
To remove an extension from Do Not Disturb
• Right-click the cell of an extension in Do Not Disturb and click Extension control > Remove Do Not 

Disturb.
Alternatively, select the Extension Control tab and select Remove Do Not Disturb.

To remove all extension from Do Not Disturb in an open monitor
• Right-click the cell of an extension and click Monitor control > Remove Do Not Disturb.

Alternatively, select the Extension Control tab and select Remove Do Not Disturb.

Queue Control
You can manually place queues in or out of Do Not Disturb using the Queue Now monitor in Contact 
Center Client.
Queues can be automatically set to open and close or go in and out of Do Not Disturb using queue sched-
ules and queue control plans. These are administrative settings. For more information see the MiContact 
Center Business Installation and Administration Guide.

Manually controlling queues

Queue control enables you to control individual queues. Monitor control enables you to control all of the 
queues on a monitor.
The Monitor Options tab displays in the ribbon for the Queue Now monitor. You can perform actions using 
either a right-click and select method in the open monitor or by accessing the action menu in the Monitor 
Options ribbon. (See the following figure.)
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NOTE: Manual queue control overrides administrative settings for queue schedules and queue control 
plans.

Figure 18.4: Queue Now monitor - Monitor Options tab
 

Placing queues in Do Not Disturb

Using manual queue control, you can place queues in and remove queues from Do Not Disturb on the 
Queue Now monitor. A contact will not enter a queue that is in Do Not Disturb. Instead the contact is sent 
to an unavailable answer point if one is configured for the queue.
NOTE: Putting a Ring Group into Do Not Disturb removes the presence of all of its members.
To place a queue in Do Not Disturb 
• Right-click the cell of an active queue and click Queue control > Set Do Not Disturb. Alternatively, 

select the queue in an open Queue Now monitor and click Set Do Not Disturb from the Monitor Option 
tab in the Contact Center Client ribbon. 
See the following figure.

Figure 18.5: Placing a queue in Do Not Disturb
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To place all of the queues on a monitor in Do Not Disturb 
• Right-click the monitor and click Monitor control > Set Do Not Disturb. Alternatively, select an open 

Queue Now monitor and click Set Do Not Disturb from the Monitor Option tab in the Contact Center 
Client ribbon.

Removing queues from Do Not Disturb

To remove a queue from Do Not Disturb
• Right-click the cell of a queue that is in Do Not Disturb and click Queue control > Remove Do Not 

Disturb. Alternatively, select the queue in an open Queue Now monitor and click Remove Do Not 
Disturb from the Monitor Option tab in the Contact Center Client ribbon.

To remove all of the queues on a monitor from Do Not Disturb
• Right-click the monitor and click Monitor control > Remove Do Not Disturb. Alternatively, select an 

open Queue Now monitor and click Remove Do Not Disturb from the Monitor Option tab in the 
Contact Center Client ribbon.
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Interactive Visual Queue

Interactive Visual Queue is a Contact Center Client real-time monitor that enables supervisors to both 
monitor and control the content in contact center queues. With Interactive Visual Queue monitors open, 
supervisors can monitor the contents of queues and queue groups, easily move interactions between 
queues, assign interactions to agents, and proactively remove unwanted interactions from the queues.
Interactive Visual Queue includes a Queued media grid and an Abandoned media grid. In the Queued 
media grid, supervisors and agents can view calls within queues and then use a drag-and-drop operation 
to move calls from busy queues to less active queues. In the Abandoned media grid, supervisors can view 
abandoned call information, including the caller name, phone number, and time of the abandoned call. 
Agents can use the Abandoned media grid to call back abandoned callers.
Ring Groups are not supported with Interactive Visual Queue and any queue groups displayed in Inter-
active Visual Queue will not display calls in the Ring Group queues.
The following sections explain how to use Interactive Visual Queue to monitor call activity, redirect calls, 
manage abandoned calls, configure alarms, and view callback information. For information on using Inter-
active Visual Queue to manage multimedia interactions, see the Multimedia Contact Center Installation 
and Deployment Guide.

Accessing Interactive Visual Queue
You access Interactive Visual Queue by logging on to Contact Center Client and then opening the 
Real-time toolbar.
To open an Interactive Visual Queue monitor 
1. Log on to Contact Center Client.
2. In the Contact Center Client ribbon, click Real time.

3. Click Interactive Visual Queue. 

The Add/Remove device IDs window opens.
4. Select a queue from the Queues list and click OK. 

See the following figure.
NOTE: Virtual queue groups are shown in the Queue groups list.

Figure 19.1: Interactive Visual Queue monitor
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Interactive Visual Queue monitor grids
The Interactive Visual Queue monitor includes the Queued media grid and the Abandoned media grid. 
The Queued media grid lists the calls that are currently in the selected queues or queue groups. The 
Abandoned media grid lists abandoned calls. The calls are listed in order of priority and the columns can 
be sorted. You can configure the column headings and specify which columns are displayed. Depending 
on licensing, Interactive Visual Queue includes the Callback to be processed grid, which lists callbacks.
NOTE: The abandoned calls column in the Interactive Visual Queue monitor displays all abandoned calls 
except those abandoned while ringing an agentor extension. The abandoned column in the Queue Now 
monitor does not peg short abandons as abandoned calls, but does peg calls that are abandoned while 
ringing an agentor extension if they do not peg as a short abandon. Because of these differences, you 
may notice discrepancies between the abandoned call information in these two monitors.
The following list provides descriptions of the column headings available in the Queued media grid: 
• Position (#) displays the answer position relative to other interactions in the queue
• Media icon displays the media type
• Queue Name is the name of the queue
• Queue Dialable displays: 

– Voice—the dialable number of the queue
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– Chat—Queue Auto Response User Name
– Email—Email address of the queue
– SMS--the dialable number of the queue

• Priority is the priority of the interaction in the queue (the lower the number, the higher the priority)
• Time in Queue is the interaction's total time in the current queue
• Time Offered to System is the time the interaction first entered the system
• Time in System is the interaction's total time in the system
• Queue Hops is the number of times an interaction has changed queues
• ANI (Contact ID) displays: 

– Voice—caller # / ANI
– Chat—Chat email address from pre-chat form
– Email—From email address
– SMS—caller # / ANI

• Subject displays 
– Voice—blank
– Chat—Chat subject from pre-chat form
– Email—Email subject
– SMS—blank

• Is Callback indicates if the queued media is a callback request (voice only)
• Service level countdown provides a countdown in seconds when the contact will exceed the target time 

to meet the service level
• Contact Name is the name associated with the contact (if available) 

– Voice—caller ID
– Chat—Chat name from pre-chat form
– Email—Email “From” name, if available
– SMS—caller #

• Time Offered to Queue is the time the contact entered the current queue
• DNIS (To Address) displays 

– Voice—DNIS Number
– Chat—blank
– Email—receiver's email address
– SMS—blank

• To Name displays 
– Voice—DNIS Name, if configured in YourSite Explorer for the associated DNIS number
– Chat—blank
– Email—Email “To” name, if available
– SMS—blank

• Collected Information displays the single or series of collected results provided by IVR Routing. 
Collected information requires IVR Routing and, optionally, Remote Database Verification or CTI 
Developer Toolkit 

• Queue Reporting is the queue’s reporting number
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The following list provides descriptions of the column headings available in the Abandoned media grid: 
• ANI (Contact ID) displays caller # / ANI
• Contact Name is the caller ID associated with the contact (if available)
• Queue Name is the name of the queue
• Queue Dialable displays the dialable number of the queue
• Time Abandoned is the time at which the contact abandoned the queue
• Time Since Abandoned is the elapsed time since the contact abandoned the queue
• Last Callback Employee is the employee name and employee ID associated with the most recent call-

back attempt
• Last Callback Time is the time at which the most recent callback was attempted
• Time Since Last Callback is the elapsed time since the most recent callback attempt
• Time Offered to Queue is the time the contact entered the current queue
• Time in Queue is the contact's total time in the current queue
• Time Offered to System is the time the contact first entered the system
• Time in System is the contact's total time in the system
• Queue Hops is the number of times a contact has changed queues
• Is Callback indicates if the queued media is a callback request (voice only)
• Service level countdown provides a countdown in seconds when the interaction will exceed the target 

time to meet the service level
• DNIS (To Address) displays the DNIS number
• To Name displays the DNIS name, if configured in YourSite Explorer for the associated DNIS number
• Subject displays DNIS
• Collected Information displays the single or series of collected results provided by IVR Routing. 

Collected information requires IVR Routing, Verified Collected Digits and, optionally, Remote Data-
base Verification or CTI Developer Toolkit

• Queue Reporting is the queue’s reporting number
• Media icon displays the media type

The following list provides descriptions of the column headings available in the Callback to be processed 
grid: 
• Caller # displays the phone number provided by the contact
• Caller Name displays the contact’s name
• Status displays the state of the callback 

– New request
– In progress
– Requeued
– Completed
– Unknown

• Priority the importance level of the callback 
– Voice—Normal
– Web—Normal
– Abandoned—Low

• Type displays the type of callback  
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– Voice
– Web
– Abandoned

• Reason displays the callback’s reason for its current status
• Attempted Calls to Agent displays the number of times the agent attempted the callback
• Last Time Agent Attempted displays the last time the agent attempted the callback
• Request Time the specific time at which the callback is scheduled to be processed; this field is popu-

lated when the callback is requeued
• Time Received displays the specific time the caller submitted the callback request
• Web IP Address displays the IP address of the contact who submitted the callback request
• Last Attempted Call To Client displays the specific time the last callback attempt to the caller was made
• Attempted Calls To Client displays the number of times the callback was attempted
• Client Available From displays the earliest time the contact is available to receive the callback
• Client Available To displays the latest time the caller is available to receive the callback
• ANI displays the phone number of the caller
• DNIS displays the phone number the caller dialed
• Dialable displays the number of the device that will handle the callback
• Device Name displays the name of the device that will handle the callback
• Device Type displays the type of device that will handle the callback – extension,agent, or queue
• Recorded Message displays a hyperlink to the voice callback request .wav file left by the caller
• Area displays the state, province, or other area the call originated from
• Country displays the country the call originated from
• Endpoint displays the endpoint attempting to perform the callback
• Region displays the region the call originated from

Sorting contacts by columns

Monitor columns can be used to sort contacts in Interactive Visual Queue. You can only sort by one 
column in a grid at a time. By default, the Queued media grid is sorted by Position number. Sort prefer-
ences are preserved in your Contact Center Client profile.
To sort contacts by columns in the Interactive Visual Queue monitor
• Click on the column heading by which you want to sort.

To reverse the sort order, click on the column again.

Redirecting calls
A call can move between queues automatically (interflow) or manually (redirection).
Interflow
You can configure queue settings on the telephone system to automatically move a call from one queue 
to another after a specific duration. For example, you can configure your system to move a call from 
Queue 1 to Queue 2 if the call has not been answered within 30 seconds. Interflow occurs without any 
user interaction.
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Redirection
Using Interactive Visual Queue, you can manually redirect a call from a queue to another queue or a dial-
able number.
There are two ways a call can be removed from the system. If a call is moved more than 10 times, either 
by redirection or by interflow, the call is dropped from the system. You can see the current number of 
times a call has moved between queues in the Queue Hops column. A call will also be automatically 
removed from the system if its total time in the system exceeds 24 hours. The Total Time column lists the 
call’s duration in the system.
You can manually redirect a call in the Queued media grid using the following methods: 
• Drag and drop a call between queues
• Use the right-click menu to move a call between queues
• Use the right-click menu to send a call to a specific dialable number

You may notice that the first two methods perform the same action. However, the second method is 
convenient when queue monitor is maximized and you want to move a call without having to resize one 
or more monitors.
NOTE: If you right-click and redirect a call to a device other than a queue, the call will no longer be consid-
ered an ACD call for reporting purposes. If you redirect a call using either of the other two methods, the 
call remains an ACD call.
When you manually redirect (drag and drop) a call in Interactive Visual Queue, MiContact Center Busi-
ness changes the way the call is pegged on the Queue Performance reports. If you redirect a call before 
the short abandon time set for the queue, the call is pegged as Unavailable. If you redirect a call after the 
short abandon time set for the queue, the call is pegged as Interflowed. An internal ACD call is pegged 
as Abandoned if the call is redirected at any time.

Redirecting calls between queues

To redirect a call from one queue to another queue using a drag-and-drop operation
1. In the Queued media grid, click anywhere in the row of the call you want to move.
2. Use a drag-and-drop operation to move the call from its original queue monitor to a new queue 

monitor.

To redirect a call from one queue to another queue using the menu
1. In the Queued media grid, right-click the row of the call you want to redirect and click Send to.

A list of available queues appears.
NOTE: You can select multiple rows to move multiple calls to a new queue.

2. Click the name of the queue to which you want to move the call.

Redirecting voice interactions to specific agents

You can transfer voice interactions in queue directly to agents who are available or in Make Busy/Over-
loaded states. Agents in Do Not Disturb cannot receive transferred interactions and will not appear in the 
list of available agents.
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To redirect voice interactions to agents
1. In the Queued media grid, right-click the row of the interaction you want to redirect and click Send to 

> Agent.
A list of available agents who can handle the voice interaction displays.

NOTE: You can use the search button to locate a specific agent, either by name or reporting number.
2. Click the name of the agent to which you want to send the interaction.

3. Click OK.

Redirecting calls to specific numbers

Using the Send to menu option, you can redirect calls in Interactive Visual Queue to any dialable number, 
including your own phone.
To redirect a call to a dialable number 
1. In the Queued media grid, right-click the row of the call you want to redirect and click Send to > 

[Extension]. 
When you click [Extension], it changes to a text box.

2. Type a number in the text box and press Enter. 

See the following figure.
NOTE: You cannot use the Extension option if you have multiple calls selected. Only one call can be 
sent to a dialable number at a time.

Figure 19.2: Redirecting a call to an extension
 

To redirect a call to your phone 
1. In the Queued media grid, right-click the row of the call you want to redirect.
2. Click Send to > Me 

NOTE: This option is only available when you have Contact Center Softphone installed and config-
ured on your computer.
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Removing calls

To remove a call from Interactive Visual Queue
1. Right-click the row of the call you want to remove.
2. Click Delete.

The call is removed from Interactive Visual Queue.

NOTE: Deleting a call from an Interactive Visual Queue monitor will not remove it from the actual queue. 
This will just cause Interactive Visual Queue to stop tracking the call.

Calling back abandoned callers
The Abandoned media grid displays abandoned call information and enables agents to call back aban-
doned callers.
NOTE: 
• Abandoned call information is automatically deleted from the Abandoned media grid after 24 hours.
• Abandoned calls cannot be transferred to agents.

To call back an abandoned caller
1. Right-click the row of the abandoned call you want to call back, and select Call to automatically dial 

the abandoned caller.
NOTE: Each time an agent attempts to call back an abandoned caller, their name and ID are attached 
to the call record and display in the Last callback employee column of the Abandoned media grid.

2. After you have contacted the abandoned caller, right-click the row associated with that call, and select 
Delete to remove the abandoned call record from the Abandoned media grid.

Configuring alarms
You set alarms on Interactive Visual Queue monitors similar to the way you set alarms on Contact Center 
Client monitors. The main difference is that some of the variables you can monitor, Caller Number, Caller 
Name, DNIS Number, DNIS Name, Collected Digits, and Collected Information, use a string for their value 
as opposed to a threshold boundary. For example, you can set an alarm that is triggered when a specific 
name appears in the Caller Name column.
The value you type for Caller Number or Caller Name alarms is a wildcard, which means the alarm will 
trigger if that value appears in any form. For example, if you configure a Caller Name alarm for the value 
John, the alarm will trigger for the values John Smith, Johnathan, longjohn, and so on.
To configure alarms:
1. Right-click an Interactive Visual Queue monitor and click Set alarms.

The Set Alarms window appears.
2. Under Performance variables, select the variable you want to monitor.

NOTE: You cannot set Alarm Thresholds for "Callback to be Processed" within the Interactive Visual 
Queue, but you can set them for "Queued Media" and "Abandoned Media".

3. Under Alarm thresholds, click Add value and select a boundary (or value) for the variable you 
selected as well as the alarm type(s) that will indicate when the variable exceeds those boundaries.
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4. If you want to add further alarms for the variable, repeat step 3.

5. Click OK to save the alarms.

For more information on configuring monitor alarms, see "Setting alarms".

Understanding call priority
Each queue has a default priority level. When a call enters the system for the first time, the call adopts 
the default priority of whichever queue it enters. If all calls in a queue have the same priority, the position 
of the calls are based on each call’s total time in the current queue. If a queue contains calls that have 
multiple priority levels, higher priority calls will have a higher position in the queue than lower priority calls.
As long as a call remains in a queue, it maintains its priority. However, if a call moves from one queue to 
another queue, the call’s priority may change, based on the method used to move the call.
When you redirect a call manually, the call always adopts the default priority level of the destination 
queue. For example, suppose Queue 1 has a priority of 1 and Queue 2 has a priority of 15. When a call 
first enters Queue 1, it has a priority of 1. However, if you manually move that call to Queue 2, using either 
a drag-and-drop operation or the right-click menu, the call priority lowers to 15. The rules work the same 
in reverse. If you manually move a priority 15 call from Queue 2 to Queue 1, the call priority increases to 
1 when it enters Queue 1.
Calls interflowed automatically retain the original call priority, or adopt the priority of the new queue based 
on telephone system settings.

Viewing callback information in Interactive Visual Queue
When licensed for IVR, Interactive Visual Queue also provides the Callback to be processed grid, which 
displays all callbacks in the displayed queues in the Interactive Visual Queue monitor. Users can access 
the Callback to be processed grid to manage callbacks in queue. For more information, see "Managing 
callbacks in Interactive Visual Queue callback monitors".
The following list provides descriptions of the column headings available in the Callback to be processed 
grid: 
• Caller # displays the phone number provided by the contact
• Caller Name displays the contact’s name
• Status displays the state of the callback 

– New request
– In progress
– Requeued
– Completed
– Unknown

• Priority the importance level of the callback. 
– Voice—Normal
– Web—Normal
– Abandoned—Low
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• Type displays the type of callback 
– Voice
– Web
– Abandoned

• Reason displays the callback’s reason for its current status
• Attempted Calls to Agent displays the number of times the agent attempted the callback
• Last Time Agent Attempted displays the last time the agent attempted the callback
• Request time displays the specific time at which the callback is scheduled to be processed; this field 

is populated when the callback is requeued
• Time Received displays the specific time the caller submitted the callback request
• Web IP Address displays the IP address of the contact who submitted the callback request.
• Last Attempted Call To Client displays the specific time the last callback attempt to the caller was made
• Attempted Calls To Client displays the number of times the callback was attempted
• Client Available From displays the earliest time the contact is available to receive the callback
• Client Available To displays the latest time the caller is available to receive the callback
• ANI displays the phone number of the caller
• DNIS displays the phone number the caller dialed
• Dialable displays the number of the device that will handle the callback
• Device Name displays the name of the device that will handle the callback
• Device Type displays the type of device that will handle the callback – extension,agent, or queue
• Recorded Message displays a hyperlink to the voice callback request .wav file left by the caller
• Area displays the state, province, or other area the call originated from
• Country displays the country the call originated from
• Endpoint displays the endpoint attempting to perform the callback
• Region displays the region the call originated from

Managing callbacks in Interactive Visual Queue callback monitors

Using Interactive Visual Queue’s Callback to be processed grid, users can requeue, reject, and delete 
callbacks from monitors. Requeued callbacks are re-entered into their queue. Rejected callbacks are 
removed from the queue and will not be offered to employees. Deleted callbacks are removed from the 
current monitor, but are not removed from the system.
Users can also adjust a callback’s priority. Callback priority determines the order of which callbacks will 
be offered to agents. Callbacks are offered to agents in order of their priority and then by the longest 
waiting callback of that priority. For example, High priority callbacks are offered before Normal priority call-
backs, even if the Normal priority callbacks have been in queue longer.
The following procedures explain how to:
• Requeue a callback
• Reject a callback
• Delete a callback
• Change a callback’s priority
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To requeue a callback
1. Right-click a callback and select Requeue.
2. Select Yes.

To reject a callback
1. Right-click a callback and select Reject.
2. Select Yes.

To delete a callback
1. Right-click a callback and select Delete.
2. Select Yes.

To change a callback’s priority
• Right-click a callback and select Change priority > [priority level].
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Contact Center Client

The Contact Center PhoneSet Manager and Contact Center Softphone applications are designed for 
provide employees with the 3300 ICP telephone system. They provide ACD agent functions and enable 
agents ability to use their desktop computers as IP-based phones. Contact Center PhoneSet Manager 
and Contact Center Softphone are designed for the 3300 ICP telephone system.

Using Contact Center PhoneSet Manager and Contact 
Center Softphone
Contact Center PhoneSet Manager and Contact Center Softphone enable agents to use their desktop 
computers as IP-based phones. Contact Center PhoneSet Manager automates Mitel IP phone sets from 
the computer desktop. An agent who uses Contact Center PhoneSet Manager has a headset connected 
to a desk phone. Contact Center Softphone provides complete phone set functionality from the computer 
desktop. A computer and wired or wireless USB headset deliver calls to the agent.

Starting Contact Center Client

NOTE: Launching client-side desktop applications from the task bar causes them to bypass the MiContact 
Center Updater Service process. To ensure successful updates from the Enterprise Server, after an 
upgrade close all client-side applications for 15 minutes or reopen them from the Start menu/Start screen.
You use Contact Center Client to access real-time monitors and functionality. Supervisors can view 
real-time voice, email, chat, SMS, and open media statistics. After starting Contact Center Client, super-
visors can choose to minimize it to either the system tray or the taskbar.
To start Contact Center Client
1. Open Contact Center Client.
2. If prompted, type your Username and Password and verify the Enterprise Server IP address.

3. If you use Secure Socket Layer, select SSL.

4. Optionally, select Remember my credentials.

5. Click Login.

Setting up the soft phone

The functionality of Contact Center PhoneSet Manager and Contact Center Softphone is similar. For 
simplicity, we will use soft phone when referring to features and functionality common to both applications.
NOTE: Before you set up the soft phone on your client computer, ensure your network administrator has 
configured your soft phone as a 5020 IP phone on the telephone system.
To set up a client computer to use the soft phone
1. Consult your network administrator to confirm your soft phone extension number.
2. Ensure your headset is connected.
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3. Configure sound and audio device properties.

See "Configuring sound and audio device properties".

NOTE: Contact Center Client's PhoneSet Manager function is not supported for use in conjunction with 
MiCollab SIP Softphone.

Configuring sound and audio device properties

To configure sound and audio device properties for Windows operating systems, you must set the PC 
speakers as the default audio device and adjust the volume of the PC speakers, headset speakers, and 
headset microphone.

Opening the soft phone

To open the soft phone 
1. In the Contact Center Client ribbon, click Soft Phone
2. Click the Soft Phone icon in the toolbar ribbon. 

The Soft phone configuration window opens.
See the following figure.

Figure 20.1: Soft phone configuration window
 

3. Click Add Extensions to search and select from all internal standard extensions, hot desk exten-
sions, and external hot desk user extensions.

4. Click Add External Agents to search and select from all external hot desk agent extensions.

5. Select your phone extension from the list of extensions.

6. If you have Contact Center PhoneSet Manager, click Desk phone. If you have Contact Center Soft-
phone, click Soft phone.
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7. If you want toTo log on automatically to the soft phone with your phone extension the next time you 
open the current profile, select the Remember my extension check box. 

You must save the current profile before you quit the soft phone for this option to work.
If you are a hot desk user who participates in the use of PINs, the PIN login dialog box opens. If you 
are a hot desk user who does not participate in the use of PINs, go to step 10.

NOTE: When logging in as an External Hot Desking Agent or a hot desking user who is not set up to use 
a PIN login, if the PIN entry window displays, do not enter a PIN just click Login.
8. Type your Login PIN. 

If you want Contact Center Client to remember your Login PIN, select the Remember your credentials 
check box. This option is not available if your Contact Center Client profile is shared. Depending on 
their security role settings, employees may not be prompted to enter a PIN.

9. Click Login. 

NOTE: If the Login PIN you entered is invalid the login will fail and you will be asked to enter a valid 
Login PIN. If you exceed the configured number of failed login attempts, your PIN will lock and you 
will need to contact your System Administrator to reset your PIN.

10. If you want Contact Center Client to be the top-most window on ringing, select the Bring to front on 
ringing check box.

11. If you do not want the screen pop windows to display in Contact Center Client when calls are ringing 
on the desktop, select the Disable toaster on ringing check box.

12. If you selected Soft phone in step 6, under Soft phone settings, configure soft phone options. 

NOTE: For the relevant configuration information, contact your supervisor or system administrator.
13. After Address book source for contacts, select YourSite contacts. 

Contact Center PhoneSet Manager and Contact Center Softphone users can access YourSite data-
base phone extensions or Global Address List phone numbers when they handle calls.

14. To automatically log off the agent from the telephone system when closing the soft phone, select the 
Automatically log off this ACD agent when closing the soft phone check box. 

15. To automatically launch Ignite (DESKTOP) when logging into Contact Center Softphone or PhoneSet 
Manager, select the Automatically launch the Ignite Client on ACD login check box. 

NOTE: This option only applies to voice agents who use Ignite (DESKTOP) to handle multimedia 
interactions.

16. To synchronize online presence indicators with ACD agent states in real-time monitors, select the 
Synchronize my Lync presence with myACD phone state check box. 

When this option is selected an agent's state changes in sync with Skype for Business presence.
17. To display call notes in the soft phone and on the Call Notes monitor, select the Display call notes 

check box.

18. Click OK. 

The Contact Center Client window displays the Soft Phone, Phone and Functions toolbars.
See the following figure.

Figure 20.2: Soft phone toolbars
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19. If you want to be able to position the soft phone toolbar elsewhere on your desktop, enable the Float 
check box.

20. To move the soft phone toolbar, hover the mouse over the perforated line on the left-side of the toolbar 
until the four-headed arrow displays. Then click, drag, and drop it to the desired position on your 
desktop. To re-anchor the toolbar to the ribbon, drag and drop it into position under the ribbon.

21. If you want to modify the soft phone configuration, click the Configuration icon in the toolbar to 
reopen the Soft phone configuration window.

Changing soft phone IP addresses

If you are required to change the IP address for your soft phone, consult the following procedure:
1. In the Contact Center Client ribbon, click Soft Phone.
2. Click the Soft Phone icon in the toolbar ribbon.

3. In the Soft phone configuration window, click Soft phone settings.

4. After Use IP address: select the new IP address from the drop-down list and click OK.

NOTE: For information on what address to select, contact your supervisor or system administrator.
5. In the Soft Phone configuration window, under ‘This extension is a’, click Desk phone and then click 

Soft phone.

NOTE: Clicking ‘Desk phone’ is required to unbind your soft phone from the previous IP address.
6. Click OK.

7. On the ribbon, click Save.

Thumbnail soft phone toolbar

The thumbnail soft phone toolbar enables agents to quickly perform soft phone actions when other appli-
cations are open on the desktop. The thumbnail toolbar gives agents access to Answer, Hang up, Cancel, 
and Dial functions and is particularly helpful when the Contact Center Client application is minimized and 
you want to perform a quick soft phone action. To see the toolbar options, hover over it with your mouse. 
(See the following figure.)

Figure 20.3: Thumbnail soft phone toolbar
 

NOTE: 
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• To enable the thumbnail soft phone toolbar, your Windows operating system must support Windows 
AERO functionality.

• Because of Windows limitations, this toolbar may not always display when Contact Center Client has 
focus on the desktop.

Logging on to the ACD

Agents can log on to the ACD in a number of ways, such as selecting the Superkey button in Contact 
Center Softphone, or using the agent control function in Interactive Contact Center.
We recommend that soft phone users who are hot desking agents log on to the ACD using the soft phone 
Actions menu. This enables the soft phone to identify agents.
NOTE: If you are an External Hot Desking Agent or a hot desking user who logged in internally, logged out, 
and then chose to log back in externally, you will not be able to log on with the soft phone Actions menu. 
In order to access this functionality, you must first close and reopen the soft phone toolbar.
To log a standard agent onto ACD 
• On the soft phone Functions toolbar, click Actions > Log on > Agents and select an agent ID.
To log an external hot desking user onto ACD 
• On the soft phone Functions toolbar, click Actions > Log on > Hot Desking Users.
To log an External Hot Desking Agent on to ACD 
• On the soft phone Functions toolbar, click Actions > Log on > Agent ID.
NOTE: When a hot desk agent logs in to the ACD a user license is taken from the available licensing pool 
and when the agent logs out the license is released back to the licensing pool. Agents are notified upon 
login attempt if the number of concurrent logins exceeds the number of available user licenses. If there 
are no available user licenses the login attempt will fail.

Phone and Functions toolbars

The Phone toolbar displays your 
• Extensions (gray oval buttons)
• Hold button (red oval button)
• Superkey button (blue oval button, for Contact Center Softphone only)
• Current phone state (Idle, Dialing, Talking)box with a down arrow that displays a call details window
• Dial box (field for dialing extensions or phone numbers)
• Dial button (Contact Center PhoneSet Manager only)
• Redial button (Contact Center Softphone only)
• Cancel button (Contact Center Softphone only)
• Message button (for retrieving voice mail messages, Contact Center Softphone only)

The Functions toolbar displays 
• Your current ACD state (Logged On/Off, in Make Busy, in Do Not Disturb)
• The ACD actions currently available
• Telephony buttons
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Phone functions

You can readily answer calls or forward them to extensions or phone numbers using the soft phone. You 
can select people from contact and speed dial lists, and perform the following actions: Redial (Contact 
Center Soft phone only), Transfer, Conference, Mute, Forward, Request help, Hold, Retrieve, Split, Swap, 
Camp on, Leave a message, Retrieve a message, Call me back, Hang up, and Cancel.
NOTE: External hot desk agents access the 'Answer' and 'Hang up' functions using their external device 
and not the soft phone toolbar.
The following table lists the soft phone telephony options and their corresponding meanings.
Table 20.1:Agent Extension actions  (Sheet 1 of 3)

Icon Meaning

 

Account Code tags a call with an Account 
Code

Answer answers a ringing call

Auto answer if enabled, answers a ringing 
call without you having to click 
Answer

Call me back notifies you as soon as the 
extension number you are trying 
to call is available

Camp on notifies an employee you are 
attempting to call with a series 
of audible beeps

Cancel terminates your connection to a 
caller

Conference connects three or more people 
together for an interaction

Dial pad enables you to dial a number 
using a keypad

Forward forwards a call to a phone 
number or extension

Hang up terminates a call
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Hold places the current call on hold

Leave a message leaves a message waiting 
notification on an employee’s 
extension

Mute if you have Contact Center 
Softphone, disables your 
microphone so you can consult 
privately with another employee 
while on a call

Request help calls an employee who can click 
Answer and listen to an 
in-progress call without the 
caller knowing

Retrieve picks up a call that is held or 
camped on to your extension

Speed dial enables you to make a call to a 
specified number with one 
mouse click

Split disconnects one person from a 
conference call

Swap swaps between the current and 
the held party

Transfer forwards an in-progress call to 
another answer point

Transfer/Conference places a caller on hold and 
makes a consultation call

Volume if you have Contact Center 
Softphone, adjusts the volume 
of your speakers and/or 
microphone

Table 20.1:Agent Extension actions (Continued) (Sheet 2 of 3)

Icon Meaning
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Customizing the soft phone

The following section describes how you can further customize your soft phone.

Selecting audio devices

To select audio devices
1. Click Configure next to the phone icon in the Soft Phone ribbon.
2. After Input audio device, select an audio device for your microphone.

3. After Output audio device, select an audio device for your speakers or headset.

NOTE: You can configure the soft phone to use the “Default Communication Device” by selecting the 
option. When idle or during a call or while on hold, you can switch the audio device and the config-
ured “Default Communication Device” temporarily changes to an available device, which is usually 
the “Default Audio Device”. After you switch back to the your audio device, it switches the “Default 
Communication Device” back to the configured device.

4. Click OK.

Specifying the address book source for contacts

To specify the address book the soft phone uses for contacts (the YourSite database.) 
1. Right-click the Phone toolbar and click Configure.
2. After Address book source for contacts, select YourSite contacts.

3. Click OK.

Resizing toolbar buttons

To resize toolbar buttons
1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.

3. After Functions toolbar, select a size for displaying the Functions toolbar buttons.

4. After Phone toolbar, select a size for displaying the Phone toolbar buttons.

5. Click OK.

Call Notes enables you to view 
the notes associated with the 
current call and add notes. Call 
notes are supported for inbound 
calls only.

Table 20.1:Agent Extension actions (Continued) (Sheet 3 of 3)

Icon Meaning
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Displaying, hiding, and retiring toolbar buttons

You can display telephony buttons, hide them so they appear on the Functions toolbar only when 
required, and retire them for actions you rarely perform, such as Camp on and Request help.
To display telephony buttons 
1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.

3. Under Selected buttons, select the check boxes of the telephony buttons you want to display.

4. Click OK.

To hide telephony buttons 
1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.

3. Under Selected buttons, clear the check boxes of the telephony buttons you want to hide from view.

4. Click OK.

To retire telephony buttons 
1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.

3. Under Selected buttons, select the telephony buttons you want to retire and click the left arrow to 
add these buttons to the Available buttons list.

4. Click OK.

To restore telephony buttons 
1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.

3. Under Available buttons, select the telephony buttons you want to restore and click the right arrow 
to add these buttons to the Selected buttons list.

4. Click OK.

Repositioning toolbar buttons

To specify the order in which telephony buttons appear
1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.

3. Under Selected buttons, select a telephony button.

4. Click the up or down arrow to change the position of the button relative to other buttons on the Func-
tions toolbar.

5. Click OK.

Configuring sounds and notifications

You can configure sounds for individual phone events for incoming calls, secondary incoming calls, 
and/or the digits dialed on your primary extension, or on all extensions. A primary incoming call is a call 
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you receive while you are in the idle active state and are available to take the call. A secondary incoming 
call is a call you receive while you are on a call on another extension and are not available to take the call.
Every time you receive a call a pop-up window notifies you the call has arrived. You can disable the 
pop-up notification.
To configure a sound for a phone event 
1. Right-click the Phone toolbar and click Configure.
2. Click the Sounds tab.

3. Select the Incoming calls, Secondary incoming calls, and/or Play sounds when dialing digits 
check boxes.

4. After Phone events, select a phone event.

5. After Sound file name, click Browse and select a sound file.

6. If you want to play the sound file when the phone event occurs on any of your extensions, click Apply 
to all lines.

7. Click OK.

To disable the call arrival pop-up notification 
1. Right-click the Phone toolbar and click Configure.
2. Click the Sounds tab.

3. Under Phone events, click a phone line.

4. Clear the Display pop-up notification for incoming calls check box.

5. Click OK.

Enabling and disabling Contact Center Screen Pop

Depending on administrative settings, Contact Center Screen Pop can launch applications or webpages 
when calls are received and enable agents to automatically receive caller and account information via 
pop-ups on their desktops for incoming calls.
When you enable or disable Contact Center Screen Pop, the settings you select determine Contact 
Center Screen Pop accessibility on a per-agent profile basis.
To enable or disable Contact Center Screen Pop
1. Click Soft Phone > Configure.

The Soft phone configuration window opens.
2. Click the Screen pop tab.

3. To enable Contact Center Screen Pop, select the Display Contact Center Screen Pop check box.

4. To disable Contact Center Screen Pop, clear the Display Contact Center Screen Pop check box.

5. Click OK.

Making calls ring through your computer speakers

You can make calls ring through your computer speakers instead of your headset.
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To make calls ring through your computer speakers
1. Right-click the Phone toolbar and click Configure.
2. Click the Sounds tab.

3. After Play the rings sounds on select the sound output device for your computer speakers.

Adjusting the volume of your speakers and microphone

If you have Contact Center Softphone, you can adjust the volume of your speakers and microphone.
To adjust the volume of your speakers
1. Right-click the Phone toolbar and click Configure.
2. Click the Sounds tab.

3. Adjust the volume by moving the speaker slider.

To adjust the volume of your microphone
1. Right-click the Phone toolbar and click Configure.
2. Click the Sounds tab.

3. Adjust the volume by moving the microphone slider.

Configuring call forward destinations

You can forward calls manually to pre-configured call forward destinations. In addition, you can configure 
and enable call forwarding so the telephone system forwards calls to other answer points when you are 
temporarily unavailable or away from the office. For example, you could specify all External call busy calls 
(external calls to your extension when you are unavailable) you receive be forwarded to a co-worker’s 
extension. Rather than directing these calls to voice mail, the telephone system would forward these calls 
to your co-worker.
NOTE: MiContact Center Business and MiVoice Analytics Version 9.0 do not support Call Forward Always 
from Ring Groups. Call Forward Always to Ring Groups is supported.
To configure call forward destinations for calls you will forward manually 
1. Right-click the Phone toolbar and click Configure.
2. Click the Call forward tab.

3. Under Name, type the name of the person to whom you will forward calls.

4. Under Number, type an extension or phone number (preceded by a number you dial to access an 
outside line).

5. Click OK.

To configure and enable call forward destinations for calls the telephone system will forward
NOTE: MiContact Center Business and MiVoice Analytics Version 9.0 do not support Call Forward Always 
from Ring Groups. Call Forward Always to Ring Groups is supported.
1. Right-click the Phone toolbar and click Configure.
2. Click the Call forward tab.

3. Specify the source for call forwarding.

4. Specify destinations for the following call types: 
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– All calls (all calls you receive)
– External call busy (external calls to your extension when you are unavailableon an extension 

inbound or extension outbound call)
– External call no answer (external calls to your extension that you do not answer)
– Internal call busy (internal calls to your extension when you are unavailableon an extension inbound 

or extension outbound call)
– Internal call no answer (internal calls to your extension that you do not answer)

5. To activate the call forwarding rules immediately, select the Enabled check boxes of the call 
forwarding types to be activated.

6. Click OK.

Configuring speed dial numbers

When you pre-configure speed dial numbers in Contact Center Softphone, these contacts are available 
in drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the Functions 
toolbar.
You can display a button for each speed dial number or display one button with a down arrow that lists all 
of the speed dial numbers you have configured. You can speed dial calls manually to pre-configured 
extensions and phone numbers.
To configure a speed dial number
1. Right-click the Phone toolbar and click Configure.
2. Click the Speed dial tab.

3. Under Name, type the name of the person to whom you will speed dial calls.

4. Under Number, type an extension or phone number (preceded by a number you dial to access an 
outside line).

5. Click OK.

Configuring shortcut keys

You can assign a shortcut key to a telephony function to perform it with a simple keystroke. This enables 
you to perform telephony functions while the soft phone is minimized or another application is currently 
selected.
To configure a shortcut key for a telephony function
1. Right-click the Phone toolbar and click Configure.
2. Click the Shortcut keys tab.

3. Under Shortcut key, select a telephony function.

4. Click the down arrow, select Ctrl, Alt, Shift, or Win, and select a keyboard number, letter, or function 
from the list.

5. Click OK.

Configuring pre-announcement messages

Agents who have Contact Center PhoneSet Manager or Contact Center Softphone can record introduc-
tions that are played to callers (for example, 'Hi. This is Paul Jones in Customer Support. Could you 
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please tell me your customer site key?') The introduction that is played is based on the queue the call 
arrives on and the time of day it is received. The recorded introduction provides customers with a consis-
tent greeting and gives the agent extra time to retrieve customer information. You can stop pre-announce-
ment messages at any time.
You can configure more than one pre-announcement rule. For each rule, you specify the conditions in 
which the soft phone will play a particular pre-announcement message. If one or more conditions is satis-
fied for a particular rule, the soft phone will play the associated pre-announcement message. You can 
order the rules on the Pre-announcement rules table to establish their priority. Pre-announcement rules 
are evaluated in the order shown in the table. If one pre-announcement rule is satisfied, the associated 
sound file is played and no other rules are evaluated.
To use pre-announcement messages with Contact Center PhoneSet Manager, you must have a Mitel 
ACD desk phone (for example, 5212) and a PCTI adaptor. The PCTI adaptor enables the audio being 
played from the agent PC and the audio from the agent desk phone to be mixed.
To connect a PCTI adapter to your computer for use with Contact Center PhoneSet Manager 
1. Set the PCTI switch to Both.
2. Set the PCTI switch to HeadSet.

3. Plug the Mic/Audio cable of the headset into the appropriate Mic/Audio inputs on the PCTI adapter.

4. Unplug the handset from the deskphone and plug it into the handset plug on the PCTI adapter.

5. Plug the telephone input cable of the PCTI adapter into the telephone base.

6. Plug the computer input of the PCTI adapter into the appropriate Mic/Speaker inputs on the PC. 

NOTE: Ensure the headset is turned on, on the deskphone base.

To configure a pre-announcement rule for Contact Center PhoneSet Manager 
1. Right-click the Phone toolbar and click Configure.
2. Under This extension is a, select Desk phone.

3. To use audio devices for pre-announcements, select Use audio devices for pre-announcements 
and specify the input and output audio device.

4. Click the Pre-announcement tab.

5. Click Add rule. 

The Add / Edit pre-announcement rule window opens.
6. Select the conditions that determine when the pre-announcement message will play.

7. Specify parameters for each condition.

8. Select or record a wave file to play when the above conditions are met.

9. Type a name for the pre-announcement rule.

10. If you want to hear ringing on your desk phone, select Enable ringing sound in desk phone.

11. Click OK.

To configure a pre-announcement rule for Contact Center Softphone 
1. Right-click the Phone toolbar and click Configure.
2. Under This extension is a, select Soft phone.
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3. Click the Pre-announcement tab.

4. Click Add rule. 

The Add / Edit pre-announcement rule window opens.
5. Select the conditions that determine when the pre-announcement message will play.

6. Specify parameters for each condition.

7. Select or record a wave file to play when the above conditions are met.

8. Type a name for the pre-announcement rule.

9. Click OK.

To re-order pre-announcement rules 
1. Select a rule.
2. Click the up or down arrow to change the priority of the rule.

3. Click OK.

NOTE: You can alternately configure whisper announcements using agent workflows in IVR. See the 
MiContact Center Business Installation and Administration Guide for more information.

Making and terminating calls using Contact Center PhoneSet Manager

When you make calls, on the Functions toolbar you can readily select contacts you pre-configure in 
CCMWeb, or speed dial numbers you configure in Contact Center PhoneSet Manager. See "Configuring 
speed dial numbers" and "Displaying, hiding, and retiring toolbar buttons".
You can dial any extension number or phone number. Contact Center PhoneSet Manager typically uses 
your primary extension to make calls. You can optionally select a different extension on the Phone toolbar 
to make calls.

Making calls

To dial by phone number or extension number using Contact Center PhoneSet Manager 
1. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the dial box and type a number or extension 
on the dial pad.

2. Click Dial.

3. If you want To view the call details window, click the down arrow adjacent to the box that displays your 
current phone state. 

See the following figure.

To dial internally from a real-time monitor using Contact Center PhoneSet Manager 
• From any real-time monitor, right-click an agent, employee, or extension cell and click Call.

Figure 20.4: Making a call
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Making calls to your contacts

To make a call to an extension in your contact list
1. Click the arrow adjacent to the dial box and click the Contacts tab.
2. Select a contact in the list.

3. Click Dial.

Making calls using speed dial

To dial using speed dial
• Click Speed dial and select a name in the list.

Terminating calls

To terminate a call
• Click Hang up.

Forwarding and answering calls using Contact Center PhoneSet Manager

You can forward calls manually to pre-configured call forward destinations without having to speak to the 
caller first. In addition, you can configure and enable call forwarding so the telephone system forwards 
calls to other answer points when you are temporarily unavailable or away from the office. See "Config-
uring call forward destinations".
If a call is ringing on your extension and you click the Forward button, the call will be forwarded to the 
default call forward destination configured in the telephone system. If you click the down arrow adjacent 
to the Forward button, you can select an extension or phone number for call forwarding.

Forwarding calls

When a call is ringing on your extension, to forward the call using Contact Center PhoneSet Manager
1. Click Forward.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Forward button and select a contact.
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3. Click Dial.

Answering calls

When an agent receives a call with Contact Center Softphone, detailed caller information is displayed on 
the desktop. (See the following figure.)Agents can choose to answer the call or forward it to another agent. 
Additionally, the display can provide access to call notes, which are notes an agent adds to the call before 
transferring it. See "Adding call notes to a call".
If configured and available the following information is provided in the soft phone display 
• Caller name—name of the caller
• ANI—telephone number of the caller
• DNIS—telephone number the caller dials
• DNIS name—the name associated to the DNIS number in YourSite database
• Agent ID—agent who transferred the call
• Extension—extension from which the call was transferred
• Queue—queue from which the call originated
• Collect Caller Entered Digits—digits the caller enters for identification purposes, such as a customer 

site key
• Customer Collected Information—information collected from a third party OBDC database
• Call notes—notes added by an agent 

NOTE: Call notes are supported for inbound calls only.

You can answer calls by right-clicking the Contact Center Softphone system tray icon and selecting 
Answer, or by clicking the Answer toolbar button.

Figure 20.5: Contact Center Softphone display
 

To answer a call using Contact Center Softphone 
• Click Answer.

Handling calls using Contact Center PhoneSet Manager

You can handle calls by right-clicking the Contact Center PhoneSet Manager system tray icon and 
selecting telephony functions, or by selecting telephony buttons on the Functions toolbar. The telephony 
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buttons available depend on the action you last performed. You can configure the toolbar buttons so they 
are always visible, or visible only when required. See "Displaying, hiding, and retiring toolbar buttons".
When you pre-configure speed dial numbers in Contact Center PhoneSet Manager, these contacts are 
available in drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the 
Functions toolbar. See "Configuring speed dial numbers".

Placing calls on hold

To place a call on hold
• Click Hold (red oval button).

Retrieving calls

You can retrieve a held call, or retrieve a call when a call is camped on to your extension.
When an agent is on a call and another caller camps on to their extension, the Retrieve button is enabled. 
When the agent presses the Retrieve button, they can talk to the held party. From that point on, the agent 
uses the Swap button to switch back and forth between the two callers (current and held parties).
To retrieve a call
• Click Retrieve.

Adding call notes to a call

When employees are speaking with customers, they can add notes to calls to share with other employees 
involved in the call. This ensures all employees have context on calls and know what information has been 
provided to customers upon call transfer.
When a call is being transferred to an employee, the soft phone display shows the most recent note asso-
ciated with the call. When the employee answers the call, Contact Center Client appears on top of all other 
open applications and displays the Call Notes monitor. The monitor includes all of the call notes associ-
ated with the current call.
Employees can add notes each time a call is transferred, and employees on conference calls can add 
notes simultaneously. Each set of notes includes the employee's name and a date/time stamp. When an 
employee completes a call and answers a new call or closes the Call Notes monitor, all call note informa-
tion is saved and included in the Lifecycle reports. Call notes are not preserved when a call is parked.
NOTE: 
• Call notes are supported for inbound calls only.
• On the Soft phone configuration window, you can clear the Enable call notes check box to hide the Call 

Notes monitor and prevent call notes from being displayed. Optionally, you can enable the Bring to 
front check box to ensure call notes display on top of all other windows when calls are received.

• You must have Contact Center PhoneSet Manager or Contact Center Softphone open in order to view 
or add call notes.

• Time stamps are based on the 3300 ICP telephone system clock.

To add a call note
1. As a call is ringing on your extension, on the soft phone display click Answer to answer the call.

Contact Center Client appears on top of all open applications and displays the Call Notes monitor.
2. After Enter a new call note, type a note.

Call notes can include a maximum of 100 characters.
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3. Click Add.

The call note is added to the Call notes text box and is included in the soft phone display upon call 
transfer.

Transferring calls

You can perform a blind transfer or a supervised transfer.
To perform a blind transfer 
1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line if required). Otherwise, click the down arrow adjacent to the Trans/Conf button and select 
a contact.

3. Click Hang up.

To perform a supervised transfer 
1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact. 

The system places the caller on Hold.
3. Wait for the called party to answer. If you receive a busy signal or a voice mail greeting, click Cancel 

to return to the initial party. Otherwise, speak to the agent and identify the caller.

4. Click Transfer to transfer the call.

Conferencing calls

You can include up to eight people in a conference call. The following example illustrates a three-way 
conference call.
To set up a conference call 
1. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line).
2. Click Dial.

3. After you speak with the person who answers, click Trans/Conf to add a person to an in-progress call. 

The system places the person on hold.
4. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.

5. Click Dial.

6. Speak to the person who answers.

7. Click Conference to initiate a three-way conference call.

To split a conference call 
1. Click Split. 

The last person you added to the conference call is placed on hold, and you can speak privately with 
the first person.
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Consulting with people while on calls

To consult with a person while on a call
1. Click Trans/Conf to conference in the person.

The system places the initial party on Hold.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.

3. Click Dial.

4. After you consult with the person, either click Conference to conference in the person, click Cancel 
to hang up on the person, click Transfer to transfer the call to the person, or click Swap to talk to the 
initial party.

Requesting help while on calls

To request help while on a call 
1. Click Request help.
2. On the dial pad, type the extension number of the employee you want to call. Otherwise, click the 

down arrow adjacent to the Request help button and select a contact.

3. Click Dial. 

The system calls the employee. The employee can click Answer and listen in on the call without the 
caller knowing and can click Conference to join the interaction at any time.

Using Camp on

The Camp on feature is available when you make a call to an extension and receive a busy signal 
because the employee is already on a call. Camp on notifies the employee you are attempting to call with 
a series of audible beeps.
NOTE: 
• Callers cannot camp on to your extension if you have call forwarding or voice mail configured on the 

extension.
• You cannot camp on to an extension that is in Make Busy or Do Not Disturb.

To camp on to an extension
1. In the dial box, type an extension number.
2. Click Dial.

3. If you receive a busy signal, click Camp on.

The employee you called will hear a series of beeps and can click Retrieve to place the caller on hold 
and speak with you. After speaking with you, the employee can click Swap to return to the caller.

Leaving and retrieving messages

The Leave a message feature is available when you make a call to an extension that is idle or on a call. 
You must use the dial pad to type a number when you are retrieving a message.
To leave a message 
1. In the dial box, type an extension number.
2. Click Dial.
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3. If the employee does not answer, click Leave a message. 

The telephone system leaves a message waiting notification on the employee’s extension and the 
Contact Center Client icon flashes red and white in the employee’s system tray.

To retrieve a message 
1. Click Dial pad and type the number configured in the telephone system for message retrieval.
2. Press Enter. 

The automated attendant will ask you for your password.
3. Type your password on the dial pad.

4. Follow the instructions provided by the automated attendant to retrieve the message.

NOTE: If agents leave Call me back messages you must use your physical phone set to retrieve the 
messages.

Using Call me back

The Call me back feature is available when you make a call to an extension that is idle or on a call. When 
you select the Call me back button, the telephone system monitors the called employee’s other extension. 
When the employee’s other extension returns to idle, your phone rings. If you pick up the call, the 
employee’s phone will ring. If you do not pick up the call, the callback will expire.
To leave a callback message 
1. In the dial box, type an extension number.
2. Click Dial.

3. If the employee does not answer, click Call me back. 

The telephone system monitors the called employee’s extension. Your phone will rings when the 
called employee’s other extension returns to the idle state.

4. When your phone rings, click Answer to pick up the call and speak with the employee.

Tagging calls with Account Codes

If your system is set up to use Account Codes, you can apply them during a call. Classification Codes are 
a type of Account Code, but differ in that you can apply them during or after a call. Classification Codes 
can only to be applied to ACD calls. If you are set up to use Account Codes, you are not necessarily also 
set up to use Classification Codes.
To tag an in-progress call with an Account Code or a Classification Code 
• Click the down arrow adjacent to the Account Code button and select a traditional Account Code or 

a Classification Code.
After hanging up, while in Work Timer mode, you can tag calls with Classification Codes.
To tag a call, after hanging up, with a Classification Code 
1. Click the down arrow adjacent to the Account Code button.
2. Select After Call Classification and select the appropriate Classification Code from the drop-down 

list.
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Making and terminating calls using Contact Center PhoneSet Manager

When you make calls, on the Functions toolbar you can readily select contacts you pre-configure in 
CCMWeb, or speed dial numbers you configure in Contact Center PhoneSet Manager. See "Configuring 
speed dial numbers" and "Displaying, hiding, and retiring toolbar buttons".
You can dial any extension number or phone number. Contact Center PhoneSet Manager typically uses 
your primary extension to make calls. You can optionally select a different extension on the Phone toolbar 
to make calls.

Making calls

To dial by phone number or extension number 
1. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the dial box and type a number or extension 
on the dial pad.

2. If you want to view the call details window, click the down arrow adjacent to the box that displays your 
current phone state. 

See the following figure.

To dial internally from a real-time monitor 
• From any real-time monitor, right-click an agent, employee, or extension cell and click Call.

Figure 20.6: Making a call
 

Making calls to your contacts

To make a call to an extension in your contact list
1. Click the arrow adjacent to the dial box and click the Contacts tab.
2. Double-click a contact in the list.

Making calls to contacts who have called you recently

To make a call to a contact who has called you recently
1. Click the arrow adjacent to the dial box and click the Recent tab.
2. Double-click a contact in the list.
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Making calls using speed dial

To dial using speed dial
• Click Speed dial and select a name in the list.

Redialing numbers

To dial the contact who last called you
• Click Speed dial and select a name in the list.

Terminating calls

To terminate a call
• Click Hang up.

Alternatively, on the Phone toolbar, click Cancel.

Forwarding and answering calls using Contact Center Softphone

You can forward calls manually to pre-configured call forward destinations without having to speak to the 
caller first. In addition, you can configure and enable call forwarding so the telephone system forwards 
calls to other answer points when you are temporarily unavailable or away from the officeinactive. See 
"Configuring call forward destinations".
If a call is ringing on your extension and you click the Forward button, the call will be forwarded to the 
default call forward destination configured in the telephone system. If you click the down arrow adjacent 
to the Forward button, you can select an extension or phone number for call forwarding.

Forwarding calls

When a call is ringing on your extension, to forward the call
1. Click Forward.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Forward button and select a contact.

Answering calls

When an agent receives a call with Contact Center Softphone, detailed caller information is displayed on 
the desktop. (See the following figure.)Agents can choose to answer the call or forward it to another agent. 
Additionally, the display can provide access to call notes, which are notes an agent adds to the call before 
transferring it. See "Adding call notes to a call".
If configured and available the following information is provided in the soft phone display 
• Caller name—name of the caller
• ANI—telephone number of the caller
• DNIS—telephone number the caller dials
• DNIS name—the name associated to the DNIS number in YourSite database
• Agent ID—agent who transferred the call
• Extension—extension from which the call was transferred
• Queue—queue from which the call originated
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• Collect Caller Entered Digits—digits the caller enters for identification purposes, such as a customer 
site key

• Customer Collected Information—information collected from a third party OBDC database
• Call notes—notes added by an agent 

NOTE: Call notes are supported for inbound calls only.

You can answer calls by right-clicking the Contact Center Softphone system tray icon and selecting 
Answer, or by clicking the Answer toolbar button.

Figure 20.7: Contact Center Softphone display
 

To answer a call using Contact Center Softphone 
• Click Answer.

Handling calls using Contact Center Softphone

You can handle calls by right-clicking the Contact Center Softphone system tray icon and selecting tele-
phony functions, or by selecting telephony buttons on the Functions toolbar. The telephony buttons avail-
able depend on the action you last performed. You can configure the toolbar buttons so they are always 
visible, or visible only when required. See "Displaying, hiding, and retiring toolbar buttons".
When you pre-configure speed dial numbers in Contact Center Softphone, these contacts are available 
in drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the Functions 
toolbar. See "Configuring speed dial numbers".

Placing calls on hold

To place a call on hold
• Click Hold (red oval button).

Retrieving calls

You can retrieve a held call, or retrieve a call when a call is camped on to your extension.
When an agent is on a call and another caller camps on to their extension, the Retrieve button is enabled. 
When the agent presses the Retrieve button, they can talk to the held party. From that point on, the agent 
uses the Swap button to switch back and forth between the two callers (current and held parties).
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To retrieve a call
• Click Retrieve.

Using Mute

To use Mute
1. Click Mute.

The system disables your microphone so you can consult privately with another employee.
2. To restore your microphone, click Resume.

Transferring calls

You can perform a blind transfer or a supervised transfer.
To perform a blind transfer 
1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line if required). Otherwise, click the down arrow adjacent to the Trans/Conf button and select 
a contact.

3. Click Hang up.

To perform a supervised transfer 
1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact. 

The system places the caller on Hold.
3. Wait for the called party to answer. If you receive a busy signal or a voice mail greeting, click Cancel 

to return to the initial party. Otherwise, speak to the agent and identify the caller.

4. Click Transfer to transfer the call.

Conferencing calls

You can include up to eight people in a conference call. The following example illustrates a three-way 
conference call.
To set up a conference call 
1. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line).
2. Click Dial.

3. After you speak with the person who answers, click Trans/Conf to add a person to an in-progress call. 

The system places the person on hold.
4. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.

5. Click Dial.

6. Speak to the person who answers.

7. Click Conference to initiate a three-way conference call.
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To split a conference call 
1. Click Split. 

The last person you added to the conference call is placed on hold, and you can speak privately with 
the first person.

Consulting with people while on calls

To consult with a person while on a call
1. Click Trans/Conf to conference in the person.

The system places the initial party on Hold.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access an 

outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select a contact.

3. Click Dial.

4. After you consult with the person, either click Conference to conference in the person, click Cancel 
to hang up on the person, click Transfer to transfer the call to the person, or click Swap to talk to the 
initial party.

Requesting help while on calls

To request help while on a call 
1. Click Request help.
2. On the dial pad, type the extension number of the employee you want to call. Otherwise, click the 

down arrow adjacent to the Request help button and select a contact.

3. Click Dial. 

The system calls the employee. The employee can click Answer and listen in on the call without the 
caller knowing and can click Conference to join the interaction at any time.

Using Camp on

The Camp on feature is available when you make a call to an extension and receive a busy signal 
because the employee is already on a call. Camp on notifies the employee you are attempting to call with 
a series of audible beeps.
NOTE: 
• Callers cannot camp on to your extension if you have call forwarding or voice mail configured on the 

extension.
• You cannot camp on to an extension that is in Make Busy or Do Not Disturb.

To camp on to an extension
1. In the dial box, type an extension number.
2. Click Dial.

3. If you receive a busy signal, click Camp on.

The employee you called will hear a series of beeps and can click Retrieve to place the caller on hold 
and speak with you. After speaking with you, the employee can click Swap to return to the caller.
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Leaving and retrieving messages

The Leave a message feature is available when you make a call to an extension that is idle or on a call. 
You must use the dial pad to type a number when you are retrieving a message.
To leave a message 
1. In the dial box, type an extension number.
2. Click Dial.

3. If the employee does not answer, click Leave a message. 

The telephone system leaves a message waiting notification on the employee’s extension and the 
Contact Center Client icon flashes red and white in the employee’s system tray.

To retrieve a message 
1. Click Dial pad and type the number configured in the telephone system for message retrieval.
2. Press Enter. 

The automated attendant will ask you for your password.
3. Type your password on the dial pad.

4. Follow the instructions provided by the automated attendant to retrieve the message.

NOTE: If agents leave Call me back messages you must use your physical phone set to retrieve the 
messages.

Using Call me back

The Call me back feature is available when you make a call to an extension that is idle or on a call. When 
you select the Call me back button, the telephone system monitors the called employee’s other extension. 
When the employee’s other extension returns to idle, your phone rings. If you pick up the call, the 
employee’s phone will ring. If you do not pick up the call, the callback will expire.
To leave a callback message 
1. In the dial box, type an extension number.
2. Click Dial.

3. If the employee does not answer, click Call me back. 

The telephone system monitors the called employee’s extension. Your phone will rings when the 
called employee’s other extension returns to the idle state.

4. When your phone rings, click Answer to pick up the call and speak with the employee.

Tagging calls with Account Codes

If your system is set up to use Account Codes, you can apply them during a call. Classification Codes are 
a type of Account Code, but differ in that you can apply them during or after a call. Classification Codes 
can only to be applied to ACD calls. If you are set up to use Account Codes, you are not necessarily also 
set up to use Classification Codes.
To tag an in-progress call with an Account Code or a Classification Code 
• Click the down arrow adjacent to the Account Code button and select a traditional Account Code or 

a Classification Code.
After hanging up, while in Work Timer mode, you can tag calls with Classification Codes.
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To tag a call, after hanging up, with a Classification Code 
1. Click the down arrow adjacent to the Account Code button.
2. Select After Call Classification and select the appropriate Classification Code from the drop-down 

list.

Controlling your availability

You can log yourself on or off, cancel Work Timer, cancel Reseize Timer, and place yourself in or remove 
yourself from Make Busy with reason or Do Not Disturb with reason using the soft phone.
To log on to the ACD
• Click Actions > Log on and select an agent ID.
To log off of the ACD
• Click Actions > Log off.
To set Make Busy with reason
• Click Actions > Set Make Busy and select a Make Busy Reason Code.
To remove Make Busy with reason
• Click Actions > Remove Make Busy.
To set Do Not Disturb with reason
• Click Actions > Set Do Not Disturb and select a Do Not Disturb Reason Code.
To remove Do Not Disturb
• Click Actions > Remove Do Not Disturb.
To cancel Work Timer
• Click Actions > Cancel Work Timer.
To cancel Reseize Timer
• Click Actions > Cancel Reseize Timer.

Making and handling calls using Contact Center Client

You can open an agent, employee or extension monitor, or the Queue Now monitor and either right-click 
an agent and select telephony functions or access telephony functions by selecting an agent and 
accessing the options in the Contact Center Client ribbon. For example, when you are on a call you can 
consult with an idle employee by right-clicking the employee’s cell and clicking Transfer/Conference, or 
by sending the employee an instant message. (See the following figure.)

Figure 20.8: Consulting with a person while on call
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Making calls

To call an agent using Contact Center Client 
• Right-click the cell of an idle agent and click Call.
Alternatively: 
1. Select an idle agent in an open monitor.
2. Click the Softphone button under the Extension Control tab in the Contact Center Client Real Time 

ribbon.

3. Choose the Call menu item.

Forwarding calls

If a call is ringing on your extension, to forward the call using Contact Center Client 
• Right-click the cell of an idle agent and click Forward.

Answering calls

If a call is ringing on another agent’s extension, to pick up the call using Contact Center Client
• Right-click the cell of the agent and click Pick up.

Adding call notes

When agents are speaking with customers, they can add notes to calls to share with other contact cente-
remployees involved in the call. This ensures agents and supervisors have context on calls and know 
what information has been provided to customers upon call transfer. If the call is transferred, call notes 
are preserved. Call notes are not preserved when calls are parked. See "Adding call notes to a call".
NOTE: 
• Before adding call notes, ensure the 'Display call notes' option is enabled in the Softphone configura-

tion window. This option is disabled by default.
• Call notes are supported for inbound calls only.



647

USING CONTACT CENTER PHONESET MANAGER AND CONTACT CENTER SOFTPHONE
CHAPTER 20 CONTACT CENTER CLIENT

To add a call note 
1. As a call is ringing on your extension, on the soft phone display click Answer to answer the call. 

Contact Center Client appears on top of all open applications and displays the Call Notes monitor.
2. After Enter a new call note, type a note. 

Call notes can include a maximum of 100 characters.
3. Click Add. 

The call note is added to the Call notes text box and is included in the soft phone display upon call 
transfer.

Recording calls

There are occasions when a user wants to temporarily stop recording a call for confidentiality reasons, or, 
if the call is not currently being recorded, the user may want to start recording if the interaction becomes 
hostile or sensitive in nature and a call record may be required. On the Agent State by Time, Agent State 
by Position, Agent State by Queue by Time, and Extension Now monitors, the Call recording option 
enables you to start, stop, and restart call recording at any time during a call, using MiVoice Call 
Recording functionality. Requirements for this on-demand call recording feature are Contact Center 
PhoneSet Manager or Contact Center Softphone, and the MiVoice Call Recording Connector .
To record a call 
• Right-click the associated cell of an agent or extension and select Call Recording > Start Recording.
To stop recording a call 
• To stop recording, right-click the cell and select Call Recording > Stop Recording.
Alternatively: 
1. Select the cell of an agent or extension in a monitor whose call you want to record.
2. In the Contact Center Client Real Time ribbon, under the Agent Control tab, select Start Recording 

from the drop-down list in the Call Recording column.

3. To stop recording, select Stop Recording from the drop-down list in the Call Recording column. 

See the following figure.

Figure 20.9: Call recording
 

Silent monitoring calls

Silent monitoring is the process of listening to the voice interactions of internal or external calls between 
agents orextensions and callers. Silent monitoring enables you to track call handling techniques and 
determine where improvements can be made in individual performance. If required, supervisors can 
conference into the call they are silently monitoring to talk to the customer. For more information, see 
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"Conferencing calls" for Contact Center Softphone or see "Conferencing calls" for Contact Center 
PhoneSet Manager.
Silent monitoring is a MiVoice Business feature leveraged by MiContact Center Business. With MiVoice 
Business 7.0+, supervisors can select an agent or extension for silent monitoring at any time, but the 
monitoring does not begin until the agent or extension answers or makes a call. The monitoring is main-
tained so long as the agent or extension remains on the call. The supervisor hears everything the agent 
hears during the course of the call, including conferences and voicemail. If the agent moves to a call on 
another line, silent monitoring will follow the agent over to that line. Up to six supervisors can silently 
monitor an agent or extension. MiVoice Business 7.0+ also enables supervisors to coach agents on call. 
For more information, see "Coaching agents on call with customers".
Silent Monitor can be accessed through Contact Center Client or, if programmed on your 3300 media 
server, through entering a Feature Access Code (FAC) on your phone or in MiCollab Client. For more 
information about silent monitor and its features and enhancements, consult your Mitel Mi Voice Business 
documentation.
NOTE: 
• The monitoring extension and the extension being monitored must coexist on the same telephone 

system.
• The monitoring extension must be permitted by security role to interactively control other agents.
• The monitoring extension’s soft phone toolbar must be open.

The following procedures explain how to 
• Silently monitor a call using Contact Center Client
• Silently monitor a call using Contact Center Client and a Feature Access Code

The following procedures take place in an open real-time agent or extension monitor
To silently monitor a call using Contact Center Client 
• Right-click the cell of an agent or extension and select Silent Monitor.
Alternatively: 
1. Select the cell of an agent or extension in a monitor whose call you want to silent monitor.
2. In the Contact Center Client Real Time ribbon, under theAgent Control or Extension Control tab, 

click the Softphone button and click Silent Monitor. 

NOTE: If the telephone system settings are incorrect or the monitoring extension and the extension 
being monitored are on separate telephone systems, you will be unable to Silent monitor and will 
instead see 'Not Allowed' when you right-click the cell. If the extension you want to monitor is not 
currently on a call, you will see 'Waiting' when you right-click the cell.

To silently monitor a call using Contact Center Client and a Feature Access Code 
1. In the dial box, type the Feature Access Code followed by the agent or extension number.
2. Click Dial.

Coaching agents and extensions on a call with customers

Supervisors can communicate with agents or extensions they are silently monitoring while they are on a 
call with a customer through Whisper Coach. Whisper Coach is a feature of silent monitor, enabling super-
visors monitoring agents extensions to talk to the agent extension and coach them through their call, 
without letting the customer hear what the supervisor is saying. Supervisors can also coach agents exten-
sions who are not actively handling a call. If required, supervisors can conference into an active call while 



649

USING CONTACT CENTER PHONESET MANAGER AND CONTACT CENTER SOFTPHONE
CHAPTER 20 CONTACT CENTER CLIENT

coaching to talk to the customer. For more information, see "Conferencing calls" for Contact Center Soft-
phone or see "Conferencing calls" for Contact Center PhoneSet Manager.
Once a supervisor starts silent monitoring an agent, they have the option of toggling coaching on and off 
through their IP hardset or the Contact Center Softphone toolbar. Whisper Coach is not automatically 
disabled when the agent completes the call or switches to a different call. If the supervisor does not stop 
coaching, the Whisper Coach feature automatically activates the next time the agent makes or answers 
a call. Only one supervisor can whisper coach an agent at a time. A supervisor can also whisper coach 
another supervisor, including supervisors actively whisper coaching an agent. If a supervisor whisper 
coaches another supervisor who is coaching an agent, the supervisor will hear the coached supervisor 
and the agent, but only the coached supervisor will hear you.
For more information on Whisper Coach, consult your Mitel documentation.
The following procedures explain how to 
• Whisper to an agent or extension that you are silent monitoring with Contact Center PhoneSet 

Manager
• Stop whispering to an agent or extension that you are silent monitoring with Contact Center PhoneSet 

Manager
• Whisper to an agent or extension that you are silent monitoring with Contact Center Softphone
• Stop whispering to an agent or extension that you are silent monitoring with Contact Center Softphone

To whisper to an agent or extension that you are silent monitoring with Contact Center PhoneSet Manager 
• On your hardset, press Coach On.
To stop whispering to an agent or extension that you are silent monitoring with Contact Center PhoneSet 
Manager 
• On your hardset, press Coach Off.
To whisper to an agent or extension that you are silent monitoring with Contact Center Softphone 
• In the Softphone toolbar, click Coach On. 

See the following figure.
Figure 20.10: Softphone coach on

 

To stop whispering to an agent or extension that you are silent monitoring with Contact Center Softphone 
• In the Softphone toolbar, click Coach Off.

Transferring calls

To perform a blind transfer using Contact Center Client 
• While on a call, right-click the cell of an idle agent active extension and click Transfer call.
Alternatively:
1. Select the cell of an idle agent in a monitor.
2. In the Contact Center Client Real Time ribbon, under the Agent Control tab, click the Softphone 

button and click Transfer call.
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Consulting with employees while on calls

To consult with an employee while on a call using Contact Center Client 
1. Right-click the cell of an idle agent and click Transfer/Conference. 

The system places the initial party on hold.
2. In the dial box, type an extension or phone number. Otherwise, click the down arrow adjacent to the 

Transfer/Conference button and select a contact.

3. Click Dial.

4. After you consult with the employee, either click Conference to conference in that person, click 
Transfer to transfer the call to the employee, click Swap to talk to the other party, or click Cancel to 
end the consultation call.

Requesting help while on calls

To request help while on a call using Contact Center Client 
• Right-click the cell of an idle agent and click Request help. 

The system calls the employee. The employee can click Answer in the soft phone and listen in on the 
call without the caller knowing. The employee can click Conference in the soft phone to join the inter-
action at any time.
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MiCollab and Ignite integration (DESKTOP)

NOTE: The MiCollab and Ignite integration described in this section only applies to Ignite (DESKTOP). 
Ignite (WEB) integrates with MiCollab for inbound and outbound call handling and supports supervised 
transfers and conferences from MiCollab Client. Users requiring the full range of MiCollab and Ignite inte-
gration features are recommended to use Desktop Ignite.
Ignite is a flexible, intuitive, and efficient tool for handling email, chat, and SMS interactions and for 
performing basic call handling. Ignite enables agents to handle multiple interactions simultaneously, see 
the agent groups of which they are members, receive screen pop notifications of incoming interactions, 
set Account Codes and Classification Codes, view personal performance statistics and those of the 
queues and queue groups for which they answer, affect personal state indicators, and be advised of the 
presence of other agents in their agent group(s).
In this integration, Ignite can be used for basic call handling. (See "Handling calls in Ignite".) More sophis-
ticated scenarios, such as supervised transfers and conferencing, require iCollab Client.Depending upon 
your gateway, you can deploy and integrate iCollab with Ignite. In this integration, Ignite can be used for 
call handling, but more sophisticated scenarios, such as Supervised Transfer or Conferencing, MiCollab 
Client is recommended. For instructions related to the voice handling abilities of the iCollab Client appli-
cation, refer to the MiCollab Client documentation available on Mitel Online or via the Webhelp within the 
iCollab Client. For information on which gateways support iCollab , see the MiContact Center Business 
System Engineering Guide .
The MiCollab Client and Ignite integration offers Enterprise presence (Non ACD) and extended ACD pres-
ence indicators, informing co-workers of your real-time availability.
Contact Center Client is used as a supervisory tool in this integration, enabling real-time monitoring and 
alarming, forecasting, data mining, agent and ACD queue control, abandoned caller callbacks, and effi-
cient call handling by moving items from busy to less active queues.
NOTE: MiCollab cannot initiate Silent Monitor or Whisper Coach. For this feature supervisors require either 
PhoneSet Manager, Contact Center Softphone, or a hard set Contact Center Client.
This chapter describes voice handling using Ignite and MiCollab Client. For information regarding 
handling email, chat, SMS, and open media interactions using Ignite, see the Multimedia Contact Center 
Installation and Deployment Guide "Ignite".
For installation and configuration details, see the MiContact Center Business Installation and Administra-
tion Guide.

MiCollab and Ignite integration (WEB)
The MiCollab and Ignite integration described in this section only applies to Ignite (WEB). Ignite (WEB) 
integrates with MiCollab for inbound and outbound call handling and supports supervised transfers and 
conferences from MiCollab Client.
Ignite is a flexible, intuitive, and efficient tool for handling email, chat, and SMS interactions and for 
performing basic call handling. Ignite enables agents to handle multiple interactions simultaneously, see 
the agent groups of which they are members, receive screen pop notifications of incoming interactions, 
set Account Codes and Classification Codes, view personal performance statistics and those of the 
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queues and queue groups for which they answer, affect personal state indicators, and be advised of the 
presence of other agents in their agent group(s).
In this integration, Ignite can be used for basic call handling. (See "Handling calls in Ignite".) More sophis-
ticated scenarios, such as supervised transfers and conferencing, require iCollab Client.Depending upon 
your gateway, you can deploy and integrate iCollab with Ignite. In this integration, Ignite can be used for 
call handling, but more sophisticated scenarios, such as Supervised Transfer or Conferencing, MiCollab 
Client is recommended. For instructions related to the voice handling abilities of the iCollab Client appli-
cation, refer to the MiCollab Client documentation available on Mitel Online or via the Webhelp within the 
iCollab Client. For information on which gateways support iCollab , see the MiContact Center Business 
System Engineering Guide .
Contact Center Client is used as a supervisory tool in this integration, enabling real-time monitoring and 
alarming, forecasting, data mining, agent and ACD queue control, abandoned caller callbacks, and effi-
cient call handling by moving items from busy to less active queues.
MiCollab cannot initiate Silent Monitor or Whisper Coach. For this feature supervisors require either 
PhoneSet Manager, Contact Center Softphone, or a hard setContact Center Client.
This chapter describes voice handling using Ignite and MiCollab Client. For information regarding 
handling email, chat, SMS, and open mediainteractions using Ignite, see the Multimedia Contact Center 
Installation and Deployment Guide "Ignite".
For installation and configuration details, see the MiContact Center Business Installation and Administra-
tion Guide.

MiCollab Basic and Ignite integration (DESKTOP)
There are some features described in this chapter that do not apply for customers running the MiCollab 
Basic application. Refer to the following list of exceptions: 
• Agents must use their deskphone for hot desking and cannot hot desk log in from MiCollab Client.
• Instant messaging is not supported.
• Extended ACD presence is not supported.

MiCollab Client and Ignite user interface (DESKTOP)
Ignite, when started, automatically docks to the MiCollab Client application, creating one client interface 
for voice and multimedia. (See the following figure.)

Figure 21.1: MiCollab Client and Ignite integration
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The MiCollab Client and Ignite integration offers you the flexibility to access as much or as little of the 
interface as needed in order to optimize desktop real estate.
For example, you can choose to collapse the main Ignite window and only access the Ignite Sidebar and 
MiCollab Client (recommended for voice-only agents) or expand the Ignite panes if you will also handle 
non-voice media. If you are transferring a call, it is beneficial to check recipient agent availability before 
transferring. (See the following figure.)
Given enough space on the screen, MiCollab Client automatically docks to the right of the Ignite window. 
If there is not enough space to the right, MiCollab Client docks to the left of the Ignite window. If the agent 
repositions the MiCollab Client on the desktop, Ignite will automatically re-dock to MiCollab Client in its 
new position.
You can minimize and restore the iCollab Client and Ignite applications independently or together. When 
both windows are full size, you can minimize the individual application. When the Ignite window is 
collapsed, minimizing the MiCollab Client window also minimizes Ignite.

Figure 21.2: Accessing agent availability in the Ignite Transfer window when transferring a call

Handling voice Interactions with the MiCollab Client and 
Ignite integration
The following table lists agent actions and the application in which they are performed.
Table 21.1:Agent actions by application  (Sheet 1 of 3)

Agent action MiCollab Client Ignite (DESKTOP) Ignite (WEB)

Voice ACD log on and 
log off

Yes Yes Yes

Set or remove Make 
Busy with Reason 
Code

Yes Yes

Set or remove Do Not 
Disturb with Reason 
Code

Yes Yes
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Cancel Work Timer Yes Yes

Chat (IM) Yes

Join/Leave Agent 
Group

Yes Yes

Answer Yes Yes Yes

Auto Answer * Yes Yes

Hang Up Yes Yes Yes

Conference Yes Yes

Merge

Cancel Yes Yes

Account Code Yes Yes

Classification Code Yes Yes

Call me back Yes

Call forwarding Yes

Camp on Yes

Forward Yes

Leave a message Yes

Mute Yes

Retrieve Yes Yes

Split Yes

Silent Monitor Yes

Transfer (blind) Yes Yes Yes

Transfer (supervised) Yes Yes

Transfer/Conf Yes Yes

Volume Yes

Dial Pad Yes Yes

Dial Contacts Yes Yes

Table 21.1:Agent actions by application (Continued) (Sheet 2 of 3)

Agent action MiCollab Client Ignite (DESKTOP) Ignite (WEB)
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*For the auto answer feature to work for an agent using a deskphone, the deskphone must have an auto 
answer key appearance set and auto answer must be enabled in the agent’s Class of Service. For an 
agent using a MiCollab softphone, auto answer must be enabled using the MiTAI browser.
The following features continue to be available in Contact Center Client (Contact Center Softphone or 
Contact Center PhoneSet Manager) but are not currently supported in the MiCollab Client and Ignite inte-
gration:
• Whisper Coach
• Custom ring tones
• Speed Dial
• Call notes
• External Hot Desking Agents

If these features are necessary to your business, you can continue to use Contact Center Softphone or 
Contact Center PhoneSet Manager but these applications do not support an integration with Ignite.

Agent state indicators

MiCollab Client displays Enterprise presence (Non ACD) and extended ACD presence.
Extended ACD presence displays in MiCollab Client for all agents who are members of the same agent 
group(s) as the logged in employee. These states are: 
• Logged out
• Not available for ACD (not present in any agent groups)
• Available for ACD (logged in and idle)
• Busy <reason> (logged in and busy) 

– Busy – Outbound (making an outbound call)
– Busy – ACD (receiving an ACD call)
– Busy <Make Busy reason code name> (in MKB, including system MKB)
– Busy – Non-ACD (receiving a Non ACD call, such as a consultation call (pre-transfer) or a direct call 

to their agent DN)

• Do Not Disturb - <DND reason code name> (logged in and in DND)
• Unknown – this indicator may display following an MiContact Center Enterprise Service restart

Agent state indicators enable you to determine agent availability and display in both MiCollab Client and 
Ignite. When transferring calls, you can check the agent state indicator to see if the receiving agent is 
available before completing the transfer.

ACD Hot desk login x
(with Mi Voice 
Business 6.0 SP3+) 
and with SIP

Yes

Table 21.1:Agent actions by application (Continued) (Sheet 3 of 3)

Agent action MiCollab Client Ignite (DESKTOP) Ignite (WEB)
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NOTE: Ignite may remove voice agent presence if communication between the MiCollab Client and the 
MiCollab Client Server is lost. If this occurs, agents must manually reset presence once communication 
is restored.
Ignite displays the agent’s overriding state and the time spent in that state. If the length of time exceeds 
24 hours, Ignite displays by days:hours:minutes:seconds. See "Getting started with Ignite (DESKTOP)" 
for an example of the Ignite Sidebar interface.
Agent overriding states, and their associated colors, include: 
• Ringing (Red)
• ACD (Red)
• ACD Hold (Red)
• Non-ACD/Outbound (Blue)
• Work Timer (Yellow)
• DND (Red)
• Make Busy (Yellow)
• Not present in any agent group (Yellow)
• Idle (Green)
• Unknown (Gray)
• Logged out (Gray)

MiCollab Client

Voice handling instructions for MiCollab Client are described in the MiCollab Client documentation avail-
able on Mitel Online or via the Web help within the MiCollab Client.

Logging into MiCollab Client

If you start Ignite before logging into MiCollab Client, you will be prompted to register and log in your voice 
agents in MiCollab Client before signing into Ignite. We recommend you start and log into MiCollab Client 
before starting and logging into Ignite.
To log into MiCollab Client as a Hot Desking Agent 
1. Right click on the Agent in the Active Calls window.
2. Select Hot-Desk In. 

A new dialog window opens.
3. In the Base DN text box, enter your base extension.

4. If your business uses PINs, enter your PIN.

5. Click Hot-Desk In. Your hot desk agent is now logged in and your base extension is out of service. 

NOTE: By default, Ignite is configured to detect voice agent logout. If you are running Ignite and you 
exit MiCollab Client, your employee and all associated agents are signed out of Ignite.
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Flexible Reporting

Flexible Reporting enables you to create customized reports. Access to Flexible Reporting is determined 
by your security role.
With Flexible Reporting you can:
• Use a wizard interface to create customized reports with existing statistics (column headings)
• Create custom calculations using expressions
• Select column headings to build custom reports
• Select only the columns you want to view
• Select like data for two or more device types and combine them in one report
• Arrange the columns in the order in which you want to view them
• Customize the names of statistics (column headings) so they are meaningful to your department, busi-

ness, and industry
• Save the reports in Excel and .pdf formats

NOTE: 
• Flexible reporting supports a maximum of 256 columns per report.
• Security role settings are not supported in Flexible Reporting.

Using Flexible Reporting
In Flexible Reporting you can
• Create new reports
• Modify standard MiContact Center Business report templates
• Modify existing Flexible Reporting report templates
• Design reports
• Manage your Flexible Reporting reports
• Run reports

Starting Flexible Reporting

NOTE: Launching client-side desktop applications from the task bar causes them to bypass the MiContact 
Center Updater Service process. To ensure successful updates from the Enterprise Server, after an 
upgrade close all client-side applications for 15 minutes or reopen them from the Start menu/Start screen.
To start Flexible Reporting
1. Open Flexible Reporting.
2. If prompted, type your Username and Password and verify the Enterprise Server IP address.

3. If you use Secure Socket Layer, select SSL.

4. Optionally, select Remember my credentials.

5. Click Login.
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The Welcome to Flexible Reporting dialog box opens.
6. Select from: Run a report, Create a new report, Redesign a standard report, Modify an existing 

report, or Do not show this dialog box again.

NOTE: The Created Language column for existing reports displays your current language prefer-
ence.

7. If you want to initiate a procedure, click OK and see the associated section in this chapter. Otherwise, 
close the dialog box.

Viewing the Flexible Reporting user interface

The Flexible Reporting user interface includes the following. (See the following figure.): 
• Report Designer wizard
• Layout designer window
• Flexible Reporting button
• Ribbon
• Toolbox window

Figure 22.1: Flexible Reporting user interface
 

You can customize the position of the windows in the following ways: 
• Dock to the left, right, top, or bottom of the user interface
• Float
• Hide
• Auto-hide
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Report Designer wizard

Whether you are building a new report or modifying an existing report, the Report Designer wizard leads 
you through the following steps to select data for the report:
• Create a new report based on an existing one, or design a new report
• Select a report type
• Select the device types
• Select the statistics (column headings), and the order in which you want them displayed
• Specify the time frame options

Layout designer window

The layout designer window comprises two tabs: design and preview. The window displays the report 
header and data grid. You can perform the following functions in the layout designer window.
On the Design tab you can
• Add images to report headers
• Edit the report header titles
• Adjust the placement of the report header titles and values
• Remove report header titles and values
• Add existing or custom columns
• Move columns
• Delete columns
• Edit column heading names
• Specify column width and row height
• Specify row colors
• Freeze and unfreeze columns
• Save report templates

On the Preview tab you can
• Run and preview reports
• Save reports
• Export reports
• Print reports

The File tab

The File tab is a tab located in the upper left corner of the window. The following options are available 
from the Flexible Reporting button: New, Open, Save, Save As, Close, Feedback, About, Log Out, Exit, 
and Exit and Log Out.

Ribbon

The ribbon provides the same functionality as traditional toolbars. Use the tools on the ribbon to help you 
design your reports. The ribbon comprises the Home, Insert, and View tabs.
On the Home tab of the ribbon, you will find the tools to help you
• Change the font type, size, and style
• Select text justification
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• Specify column width, auto-fit column width, and row height
• Change row colors

On the Insert tab of the ribbon, you will find the tools to help you
• Insert and remove images from the report header
• Select the report header titles to open in the report header
• Add existing or custom columns
• Remove columns
• Freeze and unfreeze columns
• View or modify expressions

On the View tab of the ribbon, you will find the tools to help you
• Show and hide the Toolbox window
• Manage reports

Toolbox window

The Toolbox window contains the following:
• Report header

Report header is a list of report header titles that are currently not included in the report header. If the 
Report Header list is empty, all of the report header titles will be applied to the report. When report 
header titles are removed from a report they are shown in the Report headers list.

• Column heading
Column heading displays a list of all of the column headings (for only those devices selected for the 
report) that are not currently included in the report grid. When you add a column heading to the report, 
it is removed from the list. Similarly, if you remove a column heading from the report, it displays in the 
Column headings list.

Creating new reports

Using the Report Designer wizard you can build new reports with existing column headings. Use the 
Report Designer wizard to select the data for the report.
NOTE: Reports generate in the language they were created in, regardless of the current employee 
language setting.
The Report Designer wizard guides you through the following steps:
• Select how you want to display the report data
• Select the device(s) on which you want to report
• Select the statistics (column headers) that will be shown in the report
• Select the time frames over which you want to run the report

To create a new report
1. Click File > New to launch the Report Designer wizard.
2. Click Next.

3. Click Create a new report and follow the steps in the wizard.

At the end of the Report Designer wizard, the new report opens automatically on the Design tab.
4. Design the report.
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See "Designing reports".
5. Click File > Save.

Modifying standard MiContact Center Business report templates

Using the Report Designer wizard you can modify standard MiContact Center Business voice report 
templates. In the wizard, you can remove data (column headings) and add new data (additional devices 
and column headings).
You can modify the following standard reports in the Report Designer Wizard:
• Agent by Make Busy Code
• Agent Group by Make Busy Code
• Agent Group Performance by Period
• Agent Performance by Account Code
• Agent Performance by Period
• Agent Shift by Period
• DNIS Group Performance by Period
• DNIS Performance by Period
• Employee Group Performance by Employee
• Employee Performance by Agent ID
• Extension Group Performance by Period
• Extension Performance by Period
• Queue ANI by Area Code
• Queue Group Performance by Period
• Queue Group Performance by Queue
• Queue Performance by Account Code
• Queue Performance by Member
• Queue Performance by Period
• Trunk group Performance by Period

The Report Designer wizard guides you through the following steps:
• Select the report you want to modify from a list of standard MiContact Center Business reports
• Select the time frames over which you want to be able to run the report

Choosing options on this page enables you to select time frames when submitting or previewing re-
ports. The start and end times enable you to run the report for a specific time frame for each day in 
the report. For example, you can run the report for your hours of operation only, 8 A.M. to 6 P.M.
The days of the week time frame enables you to run the report for specific days. For example, every 
Friday over the last two months.

To modify a standard MiContact Center Business report template
1. Click File > New.
2. Click Next.

3. Select the Redesign a standard report option and follow the steps in the wizard.

At the end of the Report Designer wizard, the new report template opens automatically on the Design 
tab.
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NOTE: On the Select an existing report template page of the wizard, under Filter by device type, 
select All devices if you want to see all available reports for all devices.

4. Design the report.

See "Designing reports".
5. Click File > Save.

Modifying existing Flexible Reporting report templates

To modify an existing Flexible Reporting report template
1. Click File > Open.

The Reports List window opens, giving you access to all personal and shared Flexible Reporting re-
ports.

2. Select the report you want to modify.

3. Click Open.

NOTE: 
– If ‘Do not show this dialog box again’ was selected on the Welcome to Flexible Reporting dialog box, 

the report will open to whichever tab, Design or Preview, was open last.
– Shared reports that have no owner will prompt you to optionally take ownership of the report when 

opened.

4. Modify the report.

See "Designing reports".
5. Click File > Save to save the changes to the report template.

Click File > Save As to save the report as a new template.
6. If you want to run the report, click the Preview tab.

Designing reports

Using the options available on the ribbon, design the report by modifying the report header, columns, and 
rows.
NOTE: 
• You can open and edit report templates you previously created in Flexible Reporting.
• When right-clicking a column to bring up the column’s context menu, do not right-click the column 

header cell. This is an editable field and will not bring up the column context menu.

Adding images to report headers

To add an image to a report header
1. On the Insert tab of the ribbon, click the Insert button.
2. Select an image file and click Open.

The image displays on the report header.
3. Drag the image to where you want it to be shown on the report header.
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Deleting images on report headers

To delete an image
1. Select an image on the report header.
2. On the Insert tab of the ribbon, click the Remove button.

Editing report header titles

Report headers comprise titles and values. Edit the report header titles to customize the look of your 
reports.
You can edit the font type, size, and style of report header titles.
You can edit the titles of the following report headers:
• Report
• Site
• Device
• Date range
• Date created
• Created by

NOTE: You cannot edit the report header values as these are driven by the options selected when 
the report is submitted.

To edit a report header title
1. Click a report header title.
2. Edit the text in the box.

Moving report header titles and values

You can drag and drop report header titles and values independently.
To move a report header title or value
• Drag and drop the report header title or value to where you want it to be shown on the report header.

Removing report header titles and values

All report header titles and values are shown on a report when it is first created. If you remove a report 
header title, the corresponding value will also be removed from the header. For example, if you remove 
the Date range title, the date range will not be shown on the report.
To remove a report header title and value
• On the Insert tab of the ribbon, click the Header button and deselect the check box of the report header 

title you want to remove. You can optionally drag and drop the report header title from the report to the 
Report header list.
Report header titles removed from the report are shown in the Report header list in the Toolbox win-
dow.

Adding report header titles and values

To add a report header title and value to a report
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• On the Insert tab of the ribbon, click the Header button and select the check box of the report header 
title you want to add. You can optionally drag and drop the report header title from the Report header 
list to the report.

Adding existing columns

To add an existing column
1. On the Insert tab of the ribbon, click Add > Existing.

Optionally, right-click the report and select Insert column > Existing from the drop-down list.
The Add columns window opens.

NOTE: You can also drag and drop items from the Column heading list in the Toolbox window to add 
existing columns to your report.

2. Select the columns you want to add to the report.

3. Click OK.

Adding custom columns

You can add custom columns to create custom calculations using expressions or blank columns. The 
ability to create custom calculations using expressions enables you to further customize report data to 
suit your specific business needs. Blank columns can be used as spacers to make reports easier to read, 
or as placeholders for importing third-party data after a Flexible Reporting report has been generated.
NOTE: 
• Adding columns containing custom calculations requires a thorough understanding of Microsoft Excel 

and regular expressions.
• We recommend you preview reports containing custom calculations in Flexible Reporting before 

saving the changes and generating the report in CCMWeb.

To add a column containing custom calculations 
1. On the Insert tab of the ribbon, click Add > Custom. 

Optionally, right-click the report and select Insert column > Custom from the drop-down list.
A blank column displays in the report.

2. Right-click a cell in the blank column and select Expression. 

The Edit expression window opens.
NOTE: You cannot create calculations using expressions in a header cell.

3. Select an option in the Options list to view the associated Item list.

4. Select an item in the Item list to view the associated item Description and expression Example.

5. Double-click the item in the Item list to insert its expression into the Expression box.

6. Repeat steps 3 to 5 until the complete calculation is entered in the Expression box and click OK. 

The expression displays in row two of the blank column in the report.
7. If you want to edit the expression you created, right-click the cell and select Expression to return to 

the Edit expression window.

After adding a column containing custom calculations you can choose to view or modify the expression.
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To view or modify an expression 
1. Select the cell in the report, for which you want to view or modify the expression.
2. On the Insert tab of the ribbon, click Expression. 

Optionally, right-click the column and select Expression from the drop-down list.
The Edit expression window opens.

3. Select an option in the Options list to view the associated Item list.

4. Select an item in the Item list to view the associated item Description and Expression example.

5. Double-click the item in the Item list to insert its expression into the Expression box.

6. Repeat steps 3 to 5 until the complete calculation is entered in the Expression box and click OK. 

The expression displays in row two of the blank column in the report.

You can restrict the number of decimal places that will display for results. As an example, setting the 
number of decimal places that will display for the Average Manned Agent statistic is described below.
To set the number of decimal places that display for results 
1. In the Design view, right-click the Average Manned Agent column in the report and select Expres-

sion from the drop-down list.
2. Change the current value of =Fields!AgentGroupEventAvgMannedAgents.Value to =Format-

Number(Fields!AgentGroupEventAvgMannedAgents.Value,1).

3. Click OK.

4. Click Save. 

The column is formatted to display one decimal place. To alter the number of decimal places dis-
played, enter the appropriate number in place of 1.

To add a blank column 
1. On the Insert tab of the ribbon, click Add > Custom. 

Optionally, right-click the report and select Insert column > Custom from the drop-down list.
A blank column displays in the report.

2. Optionally, click the header cell of the blank column and type a name for the column.

Moving columns

To move a column
• On the report grid, drag and drop the column to where you want it on the grid.

Deleting columns

NOTE: Some statistics require specific columns to ensure a report is meaningful. These statistics are asso-
ciated with the required columns and cannot be deleted on their own. For example, in by period reports, 
you cannot delete the interval; in by device reports, the reporting number cannot be deleted.
To delete a column
1. Click a column on the report grid.
2. On the Insert tab of the ribbon, click the Remove button.

Optionally, right-click the column and select Delete column from the drop-down list.
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Editing column heading names

You can edit the names of column headings so they are meaningful to your department, business, and 
industry. You can change the font type, size, and style as well as edit the text.
To edit a column heading name
1. Click a column heading on the report grid.
2. On the Home tab of the ribbon, use the font options to change

– the font type, size, and style
– the justification

3. Optionally, edit the name of the column heading.

If, after renaming a column heading, you want to see the original column heading name, hover over 
the column heading. The original column heading name displays after Name.

Specifying column width

To specify the column width
1. Click a column.
2. On the Home tab of the ribbon, after Column width, type the width (in pixels).

Optionally, right-click the column and select Column width from the drop-down list.

To auto-fit the column width
1. Click a column.
2. On the Home tab of the ribbon, after Scale to fit, click Auto.

Optionally, right-click the column and select Auto-fit Column width from the drop-down list.

Specifying row height

You can specify a different row height for the header row than the body rows.
To specify the header row height
1. Click the header row.
2. On the Home tab of the ribbon, after Row height, type the height (in pixels).

To specify the body row height
1. Click a body row.
2. On the Home tab of the ribbon, after Row height, type the height (in pixels).

Optionally, right-click the body row and select Row height from the drop-down list.
All of the body rows will be the same height.

Specifying row colors

You can alternate row colors to make report data easier to read.
1. On the Home tab of the ribbon, select the primary and alternate colors.
2. After Alt row count, type the number of rows for each color.
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Freezing columns

Frozen columns remain stationary when you scroll to view columns to the right.
To freeze a column heading
1. On the report grid, click the column to the right of the ones you want to freeze.
2. On the Insert tab of the ribbon, click the Freeze column button.

Optionally, right-click the column and select Freeze column from the drop-down list.

Unfreezing columns

To unfreeze a column heading
1. On the report grid, click the column to the left of the frozen column.
2. On the Insert tab of the ribbon, click the Unfreeze column button.

Optionally, right-click the column and select Unfreeze column from the drop-down list.

Managing your Flexible Reporting reports

You manage your Flexible Reporting reports on the My Reports window. My Reports gives you access to 
all of the reports you have created.
You can access all the reports you have created and all shared reports created by others, by clicking the 
File > Open.
NOTE: Shared reports that have no owner will prompt you to optionally take ownership of the report when 
opened.
In the My Reports window you can
• Change access properties: Shared or not Shared
• Rename reports
• Delete reports

Changing access properties

To change the access properties of a report
1. On the View tab of the ribbon, click My reports.
2. Select the report(s).

3. If you want to share the report(s), under Shared, select the check box. Otherwise, clear the check box 
and the report(s) will be available to you only.

4. Click OK.

Renaming reports

To rename a report
1. On the View tab of the ribbon, click My reports.
2. Select a report and click Rename.

3. Edit the name.

4. Click OK.
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Deleting reports

You can only delete the reports you create.
To delete a report
1. On the View tab of the ribbon, click My reports.

NOTE: You cannot delete a report that is open in Flexible Reporting.
2. Select the report(s) you want to delete and click Delete.

3. Click Yes to delete the selected report(s).

4. Click OK.

Running Flexible Reports

You can run Flexible Reporting reports in CCMWeb or in Flexible Reporting. However, you can schedule 
reports in CCMWeb only.
From CCMWeb, you can run Flexible Reporting reports on demand, or schedule them, the same way you 
run standard reports.
In Flexible Reporting you can run, save, and print reports on the Preview tab. After you run a report, 
printing options enable you to view the print layout, and configure page setup and printer properties.
NOTE: 
• Flexible Reporting will run reports only when there is data to generate the report.
• If you run a report on the Preview tab and the report data is all zeros, ensure you selected a device on 

which to run the report. If you selected a device, ensure the selected time period is one that would have 
incurred activity.

• Custom reports created in Flexible Reporting can only be generated in the language that was used 
when they were created and saved.

Running reports in CCMWeb

To run an on-demand report in CCMWeb
• Hover over Reporter, select Flexible Reporting, and run the report.

You will have access to all Flexible Reporting reports created by you and shared Flexible Reporting 
reports created by others.

NOTE: When a report supports more than one device type, click on each tab to select the devices on which 
you want to report.
To schedule a report in CCMWeb
1. Hover over Reporter and select Scheduled Reports.
2. If you want to create a new schedule, click Next. Otherwise, select an existing schedule and click 

Manage schedule properties.

3. Configure the schedule properties and distribution attributes.

4. Click Add a report.

5. Click Flexible Reporting and select a report to add to the schedule.
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Running reports in Flexible Reporting

To run reports in Flexible Reporting 
1. On the Preview tab, under Devices, select the device(s).
2. Specify the date and time parameters.

3. Click Run report. 

Flexible Reporting generates the report and displays it in the preview pane.

Saving templates and reports

In Flexible Reporting you can save
• Templates

The report templates you create in Flexible Reporting are saved on the Enterprise Server so you can 
run them from Flexible Reporting and CCMWeb.

NOTE: Report templates are not saved automatically. You must save your report template before you 
exit Flexible Reporting if you want to use it to run reports or modify the template later.

• Reports
After you run a report in Flexible Reporting, you can save the output (report) on your computer or else-
where on your network. Reports can be saved or, optionally, exported in Excel (.xsl and .xslx), Word 
(.doc), or .pdf formats.

To save a report template as a new document
1. Click the File > Save As.
2. After File name, type the name of the new template.

NOTE: Only you can run and view reports you have created and designated as not shared. Shared 
reports can be run and viewed by others.

3. If you want to allow others to run the report, select the Shared check box.

4. Click Save.

To save modifications to a report template
• Click File > Save.
To export a report in Excel (.xsl or .xslx) format
• In the Preview window, above the generated report, click the Save button, select Excel, and specify 

the location to save the report in Excel (.xsl) format.
Optionally, in the View tab of the ribbon, click the Export report button, select Excel (.xsl) or Excel 
2007 (.xslx) and specify the location to save the report in an Excel format.

To export a report in Word (.doc) format
• In the Preview window, above the generated report, click the Save button, select Word, and specify 

the location to save the report in Word (.doc) format.
To export a report in .pdf format
• In the Preview window, above the generated report, click the Save button, select PDF, and specify the 

location to save the report in .pdf format.
Optionally, click the Export report button on the View tab of the ribbon, and select PDF, and specify 
the location to save the report in .pdf format.
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Printing reports

To print a report you ran on the Preview tab
• On the Preview window toolbar, click the Print button.

Posting feedback and viewing our forums

Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on https://micon-
tactcenter.uservoice.com. When you post an idea to our feedback forum, others will be able to subscribe 
to it and make comments.
Our forums enable you to send feedback directly to the people building the product. While we cannot 
comment on every suggestion, feedback is analyzed and considered for future releases.
NOTE: Please do not use the forums to submit product defects. To submit product defects, please contact 
your administrator or dealer.
Feedback can also be submitted directly to Mitel without posting the suggestion on the forums. For more 
general feedback, you can also provide a rating of your experience with MiContact Center Business.
NOTE: Please do not use feedback for requesting customer assistance. For assistance with MiContact 
Center Business, please contact your dealer or Mitel Customer Support.
To post feedback and view our forums 
1. In YourSite Explorer, click File > Feedback.
2. Click Got an idea? Tell us. 

or
Access the following URL: https://micontactcenter.uservoice.com.

To submit feedback directly 
1. In YourSite Explorer, click File > Feedback.
2. Click Contact Us.

To rate your Mitel experience 
1. In YourSite Explorer, click File > Feedback.
2. Click Rate us.

https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
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Workforce Scheduling

Workforce Scheduling is an optional application that enables you to create employee schedules. Using 
historical data, Workforce Scheduling forecasts the number of employees required to meet your contact 
center's Service Level objectives.
NOTE: Access to Workforce Scheduling features is dependent on your administrative-set security role.
Using Workforce Scheduling in conjunction with MiContact Center Business, you can
• Customize schedules
• Forecast scheduling requirements
• Match an employee’s skills to those skills required for jobs in each schedule
• View the distribution of employees across each schedule
• Print schedule reports

There are two optional applications that work in conjunction with Workforce Scheduling: Schedule Adher-
ence and Employee Portal. For more information on these applications, see "Schedule Adherence" and 
"Employee Portal".

Understanding Workforce Scheduling
Before you start using Workforce Scheduling read the following sections on how to
• View the Workforce Scheduling user interface
• Understand forecasting concepts
• Understand the Workforce Scheduling process

Viewing the Workforce Scheduling user interface

The following figure displays scheduling information, such as the employees who are scheduled, 
employee shift start and end times, the time interval shift totals, and the shift details for each employee.
NOTE: The Scheduling and Forecasting buttons in the Tools>Administration window are used to toggle 
between these two views.
The Workforce Scheduling user interface is comprised of the following panes: 
• People pane
• Time bar pane
• Totals pane
• Schedule details pane

Figure 23.1: Scheduler window
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People pane

The people pane is located in the upper-left portion of the scheduler window. The people pane lists the 
employees included in the schedules you are viewing. (See the following figure.)

Figure 23.2: People pane
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Time bar pane

The time bar pane is located in the upper-right portion of the scheduler window. The time bar pane 
displays a time bar for each scheduled employee. Time bars display the shifts, breaks, jobs, time off, and 
unavailable periods for employees listed in the people pane. You can view the time bar pane in the 
following time intervals: 6 hours, 12 hours, 1 day, 2 days, 1 week, 2 weeks, and 1 month. (See the 
following figure.)
You can view previous or upcoming dates using the horizontal scroll bar under the time bar pane. If you 
reach the end of the month and want to view dates for the next month, you can click the arrow on the scroll 
bar to load the schedule for the next month (as indicated by the red square in the following image).

Figure 23.3: Time bar pane

Totals pane

The totals pane appears when you select event totals to view. The totals pane is located in the center of 
the scheduler window. Each value represents the total number of employees scheduled for an event. (See 
the following figure.)

Figure 23.4: Totals pane
 

You can view the following event totals:
Forecasted
The Forecasted total displays after you apply a forecast to the schedule. This total represents the fore-
casted number of employees required to handle interaction requests and meet the Service Level objec-
tives you specify. You can optionally adjust the Forecasted total in the totals pane. See "Modifying 
forecast totals in the event totals pane".
NOTE: When the user sets View to greater than 6 hours, each cell value in the Totals View is the maximum 
value of the composite 15-minute values. The Over/Under value displayed is also the maximum of the 
composite values. As a result, in this view, the displayed value for the Over/Under does not align with the 
value that would be obtained from adding the At Work and forecasted values.
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Scheduled
The Scheduled total represents the number of employees scheduled for the time you are viewing.
On break
The On break total represents the number of employees scheduled for a break at a specific time.
On ACD Job
The On ACD Job total represents the number of employees scheduled to perform ACD work.
On Non ACD Job
The On Non ACD Job total represents the number of employees scheduled to perform Non ACD work.
At work
The At work total represents the number of employees scheduled to handle interaction requests.
Over/Under
The Over/Under total represents the difference between the number of employees at work compared to 
the number of employees forecasted. A value of 4 means 4 additional employees are working compared 
to the forecasted requirement. A value of (4) means 4 fewer employees are working compared to the fore-
casted requirement. When you book annual leave for employees, you can preview the result on shift 
coverage by using the over / under function, before updating changes.
Overtime
The Overtime total represents the number of employees scheduled to perform overtime work.

Schedule details pane

The schedule details pane is located at the bottom of the scheduler window. It displays details on sched-
uled employees. You can modify the start and end times of scheduled events in the schedule details pane. 
For example, you can adjust the length of a scheduled break. See "Modifying event times and notes in 
the schedule details pane". (See the following figure.)

Figure 23.5: Schedule details pane
 

You can sort the information in the schedule details pane by organizing the headings. The schedule 
details column headings are as follows: 
• Employee name—the employee to which the specified time event is scheduled
• Schedule—the schedule to which the specified time event is scheduled
• Event type—the events to which the specified time event is scheduled
• Start date—the start date of each scheduled event. You can modify this parameter in the schedule 

details pane. Changes are immediately reflected in the time bar pane
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• Start time—the start time of each scheduled event. You can modify this parameter in the schedule 
details pane. Changes are immediately reflected in the time bar pane

• End time—the end time of each scheduled event. You can modify this parameter in the schedule 
details pane. Changes are immediately reflected in the time bar pane

• Paid hours—the total number of paid hours for the scheduled shift
• Budget—the total cost of the scheduled shift
• Notes—the notes on scheduled events you enter in this field

Understanding forecasting concepts

Workforce Scheduling assists you in scheduling employees for work and holiday periods. It offers an inte-
grated forecasting component that uses historical data to partially automate the scheduling process. 
Scheduling is not entirely automated. You may have to modify employee schedules and enter shift and 
employee variables manually after creating a schedule based on forecasted data.
You schedule employees so the number of incoming calls at any given time typically exceeds the number 
of employees currently available. This ensures callers experience a slight delay before employees answer 
their calls. The expected number of incoming calls forecasted for the time of day and day of the week 
influence scheduling decisions when trying to find the right balance between call volume and available 
staff.
For information on accessing historical data to assist when making schedules, see "Expecting forecasts 
to workforce scheduling".
For information on forecasting variables and how to improve forecasting accuracy, see "Step#3 Forecast 
the Call Load".
For information on Service Level variables and how to calculate the Service Level Percent, see "Under-
standing the Service Level".

Understanding the Workforce Scheduling process

Employees, agent IDs, agent groups, queues, queue groups, overtime types, time off types, holidays, and 
skills are configured by the System Administrator in YourSite Explorer. After these devices are configured, 
you must decide if you will use forecasted data to build your schedules. When you build a schedule in 
Workforce Scheduling using forecasted data, we recommend you associate the schedule with the queue 
group you will use to perform the forecast. You must ensure that the employees you want to schedule are 
associated with the queue group you associate to the schedule. You can optionally associate a schedule 
to a queue group with different employees, which can be useful for scheduling a new group of employees 
based on the forecasted data of other employees.
As soon as you start Workforce Scheduling, you can begin creating your schedules. After you log in, you 
are asked to create or select a schedule. You create a schedule by assigning it a name. If you are using 
a forecast to build the schedule, you associate the schedule with a queue group.
After you create the schedule, you configure schedule parameters, such as shifts, breaks, jobs, and 
scheduling preferences/options for each employee.
You can automate the schedule building process with the Schedule Builder tool. It helps you quickly build 
a schedule, with or without a forecast. If you build schedules using forecasted data, we recommend you 
use Schedule Builder. Alternately, you can build a schedule manually. This involves inserting or removing 
events (shifts, breaks, jobs, time off, unavailable periods) and making events recur. You can manually 
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build a schedule based on forecast totals in the Totals pane. After you build a schedule using Schedule 
Builder, you may need to make a few adjustments.

Workforce Scheduling and your contact center
Using Workforce Scheduling, you can schedule your employees to best suit your contact center needs. 
You can
• Customize schedules for your contact center groups
• Forecast scheduling requirements
• Match employee skills to the skills required for each schedule
• View the distribution of employees across schedules
• Print schedule reports

For information on scheduling considerations, and how to calculate the Shrinkage Factor and optimize 
scheduling, see "Step #5 Schedule agents".
Using Workforce Scheduling, you can create schedules for your contact center using a variety of options. 
Depending on your contact center, some options may be more suitable than others. To help your 
company use Workforce Scheduling most effectively, we have created configuration scenarios that 
describe how to implement Workforce Scheduling, based on the type of scheduling used in your contact 
center.
Each Workforce Scheduling configuration scenario provides a description of the scheduling method and 
an example of contact centers that typically use that method. Each scenario also provides some tips on 
how to configure Workforce Scheduling for each style of scheduling. The scenarios include the following 
scheduling configurations:
• Assigned shift
• Availability
• Rotational
• Forecast

Assigned shift-based scheduling configuration scenario

The assigned shift scheduling method uses fixed shifts staffed by employees who are permanently 
assigned to specific shifts. Contact centers that use assigned shift scheduling have consistent call 
volumes. Employees are primarily full-time staff and are guaranteed a specific number of hours of employ-
ment per week. Typically, you plan a schedule three to six months in advance with assigned shift sched-
uling.
Contact centers ideal for assigned shift scheduling
Assigned shift scheduling is best suited to contact centers that have a steady and predictable call volume, 
such as a contact center that runs a conventional nine to five operations. Examples of contact centers 
that use assigned shift scheduling include banks and government offices.
To configure Workforce Scheduling for an assigned shift scheduling environment
• Create fixed shifts
• Use shift names that describe a shift's purpose, such as '9 to 5 shift' or '1st shift'
• Use mass recurrence to repeat scheduled events for multiple weeks
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• Configure employee hours using shift assignment by day of week

Availability-based scheduling configuration scenario

The availability scheduling method uses fixed shifts, but unlike assigned shift scheduling, the employees 
that work a given shift are not permanently attached to that shift. Contact centers that use availability 
scheduling fill shifts using a pool of employees.
A contact center supervisor sets staff availability based on day of week and time of day. When staffing a 
shift, the supervisor can assign any employee who is listed as available for that date and time to the shift. 
Typically, you plan a schedule two to four weeks in advance when you use availability scheduling.
Contact centers ideal for availability scheduling
Availability scheduling is best suited to contact centers driven by shifts, such as hotels or companies that 
focus on catalog sales. These contact centers have a specific number of shifts that can be filled by any 
qualified employees who are available. This type of schedule is frequently used with contact centers that 
operate 24/7.
To configure Workforce Scheduling for an availability scheduling environment
• Primarily use fixed shifts, but do not assign employees to specific shifts
• Assign employees all of the possible shifts they can work
• Set employee availability by day of week and time of day
• Use filters to assign the best employee available for a shift, based on skill set, seniority, or personal 

priority number

Rotational-based scheduling configuration scenario

The rotational scheduling method consists of two or more unique schedules that recur at defined intervals. 
For example, if a contact center rotates four schedules, the week one schedule repeats in week five, week 
nine, and so on. The rotational scheduling method enables contact center schedules to be consistent in 
the long-term, while allowing shifts to vary from week to week.
Contact centers ideal for rotational scheduling
Rotational scheduling is best suited to contact centers that require specific employees to cover unique 
periods of time, such as medical clinics that are open on weekends. If each contact center employee is 
required to work one weekend a month, a rotational schedule can ensure an even distribution of weekend 
work for each employee.
To configure Workforce Scheduling for a rotational scheduling environment
• Primarily use assigned shifts with defined employees. The staff changes from one schedule rotation 

to the next ensure fair coverage on nights, weekends, and holidays
• Recur the shifts multiple times based on the number of rotations
• Manually track and adjust which employees are assigned to each rotation; Workforce Scheduling does 

not create a balanced schedule so you will need to make changes if you want to ensure the schedule 
is fair

• Optionally use rotational scheduling in conjunction with other schedule types. For example, create a 
schedule that uses the assigned shift method to cover Monday to Friday shifts and a second schedule 
that uses the rotational shift method to cover shifts such as weekends or holidays
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Forecast-based scheduling configuration scenario

The forecast scheduling method references historical data to create schedules. Contact centers that use 
forecast scheduling have call volumes that can change considerably over relatively short periods of time, 
resulting in inconsistent scheduling.
Forecast scheduling provides more flexibility than other scheduling methods since shifts are not defined. 
A contact center that uses forecast scheduling does not have a fixed staff or fixed hours, as both change 
based on the expected call volume. Typically, you plan a schedule one to two weeks in advance with fore-
cast scheduling.
Contact centers ideal for forecast scheduling
Forecast scheduling is best suited to contact centers driven by call volume, such as companies that focus 
on sales campaigns, promotions, or seasonal sales.
To configure Workforce Scheduling for a forecast scheduling environment
• Generate historical data specific to the type of event you are scheduling (for example, to create a 

schedule for a winter sales campaign, use historical data from a previous winter campaign)
• Create shifts with flexible start and end times to provide Schedule Builder with the greatest number of 

options when populating the shifts with employees
• Remember that shift variables, such as start/end times and breaks, will vary for employees on a 

day-to-day basis
• Due to the variety of shift start and end times, create breaks based on the Time to qualify variable
• Do not configure availability or shift assignment

Selecting a scheduling method
You can build schedules in Workforce Scheduling:
• Using a forecast
• Manually

The setup you require depends on the scheduling method you choose. If you incorporate forecast data 
when you build a schedule, you must build the schedule using Schedule Builder.

Scheduling using forecast data

When you use forecast data to build a schedule, you can apply historical data from any queue or queue 
group to the schedule. It is recommended to use historical data from the queue group with which the 
schedule is associated. Forecast data is simply the number of required agents. It can be used in sched-
ules which are not associated with a queue or queue group.
Before you build a schedule using a forecast, as a best practice, we recommend you associate your 
schedule with a queue group. You should also ensure that the employees to be scheduled are associated 
with this queue group.
Ensure your System Administrator
1. Associates the agent IDs with an agent group.
2. Associates the agent group with a queue.
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3. Associates the queue with the queue group (that you will associate with the schedule).

Instructions for configuration and association of agents, agent groups, queues, and queue groups are 
located in the MiContact Center Business Installation and Administration Guide .

Scheduling manually

You have the most flexibility when you build a schedule manually. However, this can be time consuming 
if you must schedule a large number of employees or if you must create a schedule covering a long time 
period where shift assignments do not recur. You can also use manual scheduling to tweak schedules 
you build with Schedule Builder. See "Creating and adjusting schedules manually".

Schedule setup and customization
In order to build a schedule in Workforce Scheduling, whether you build your schedule with forecasting 
or you build it manually, you must perform the following tasks to set up and customize your schedule:
1. Start Workforce Scheduling.
2. Configure schedule options.

3. Configure shifts, breaks, and jobs.

4. Assign shifts to schedules.

5. Assign shifts to employees.

6. Specify scheduling preferences/options for each employee in the schedule.

7. Specify schedule warnings.

Starting Workforce Scheduling on a client computer

To log on to Workforce Scheduling
1. Open Workforce Scheduling.

The Login window appears.
2. If prompted, type your Username and Password and verify the Enterprise Server IP address.

3. If you use Secure Socket Layer, select SSL.

4. Optionally, select Remember my credentials.

5. Click Login.

The first time you log on, or if you have not created any schedules, the scheduler window displays. 
See "Configuring schedule options".
Otherwise, if schedules exist, the Load schedule window displays.
See "Loading schedules".

Configuring schedule options

NOTE: 
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• If you associate a schedule with a queue group, only those employees included in the selected queue 
group can be configured in the schedule. (Agents are members of agent groups, which are associated 
with queues that are members of queue groups.)

• If you do not associate a schedule with a queue group, you can schedule any employee whose profile 
enables you to schedule them in Workforce Scheduling.

Before you can build a schedule, either manually or using Schedule Builder, you must create a new 
schedule.
On the New Schedule window, you must:
• Name the schedule
• Associate the schedule with a queue or queue group (optional)
• Add employees to the schedule
• Configure business hours for the schedule
• Activate/Deactivate the schedule

You can create new schedules and configure all Workforce Scheduling options using the Schedule 
wizard. Optionally, use the Schedule tool to add, delete, rename, and activate/deactivate schedules. 
Within the Schedule configuration window, you can click Apply at any time to apply changes to the 
schedule without closing the Schedule configuration window.

Configuring scheduling options using the Schedule wizard

You can create new schedules and configure all Workforce Scheduling options using the Schedule 
wizard.
To configure scheduling options using the Schedule wizard
1. Click the Configuration tab.
2. In the Schedules group, click Schedule wizard.

3. Follow the steps in the Schedule wizard to configure schedules, business hours, employees, 
fixed/variable shifts, fixed/variable breaks and jobs, and fixed/variable shift assignments.

4. Click Finish.

Creating schedules

To create a schedule
1. On the Application menu or ribbon, click New schedule.
2. After Schedule name, type a name for the schedule.

3. Under Employee association, select either All employees, Employees associated with this 
queue group only, or Employees associated with this queue only.

– If you select Employees associated with this queue group, select a queue group from the list.
– If you select Employees associated with this queue, select a queue from the list.

4. If this schedule will be an active schedule, select the This schedule is active check box. Otherwise, 
select the This schedule is used for planning purposes only check box.

5. Click OK.

6. Select the check boxes of the employees to add to the schedule.
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7. Click OK.

Adding employees to schedules

Schedules that contain fewer than 100 employees are easiest to manage. Each employee should belong 
to one active schedule only. However, if employees belong to more than one schedule, you can still view 
the shifts for which they are scheduled.
To add an employee to a schedule
1. Click the Configuration tab.
2. In the Schedules group, click Select employees.

3. After Schedule, select a schedule.

4. If you want to group employees in the list by supervisor, select the Group by supervisor check box.

5. Select the check boxes of the employees to add to the schedule.

6. Click OK.

Configuring business hours for schedules

You can specify different business hours for each schedule. By default, you are warned if you try to 
schedule shifts outside business hours.
To configure the business hours of a schedule 
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, select Schedules.

4. Under Schedules, select the schedule to modify.

5. After First day of the schedule week, specify the day that the schedule will begin.

6. After Annual calendar start date, specify the date the calendar year begins. 

The information in this field is used to calculate annual minimum and maximum hours for employees. 
January 1st is the default date.

7. Specify business hours for the schedule. 

– If you want to schedule employees 24 hours a day, seven days a week, under Business hours, click 
Open 24/7.

– After Open, select the check boxes of the days of the week to schedule.
– After From, specify the start times for each day of the week to schedule.
– After To, specify the end times for each day of the week to schedule.

8. Click OK.

Renaming schedules

You can rename a schedule without losing any information associated with the schedule.
To rename a schedule
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.
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3. Under Schedules, select the schedule to rename.

4. Click Rename.

5. After Name, type a new name for the schedule.

6. Click Rename.

7. Click OK.

Deleting schedules

CAUTION: Deleting a schedule deletes all of the information associated with that schedule. This cannot be 
undone.
To delete a schedule
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. Under Schedules, select the schedule to delete.

4. Click Delete.

5. Click Yes.

6. Click OK.

Activating / De-activating schedules

You can activate or deactivate a schedule at any time. Deactivating schedules is useful for performing 
'what-if' scenarios, for seasonal schedules, and for retaining schedules to be used at a later time.
To activate or deactivate a schedule
1. Click File=>Activate. 

The Activate / Deactivate Schedule dialog box opens.
2. Select the schedule that you want to activate / deactivate.

You can load multiple active schedules. However, if you load an inactive schedule, all other schedules 
close.

3. Click Activate to activate an inactive schedule or Deactivate to deactivate an active schedule.

4. Click Close.

Configuring shifts

A shift represents work hours on a given day for an employee. You can assign shifts to specific employees 
for any day of the week. You can create several shifts for one or more schedules. There are two types of 
shifts: fixed shifts and variable shifts. Fixed shifts have a fixed start time and duration. Variable shifts are 
based on the following shift variables:
Typical hours—the number of work hours for the shift
Minimum hours—the minimum number of hours for the shift
Maximum hours—the maximum number of hours for the shift
Minimum start—the time of day after which the shift must start
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Maximum start—the time of day by which the shift must start
Color—the color in which the shift appears in the time bar pane.
You configure the following shift options using the Schedule tool:
• Add fixed shifts
• Add variable shifts
• Rename shifts
• Delete shifts

Adding fixed shifts

To add a fixed shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Shifts.

4. In the right pane, click the Fixed Shifts tab.

5. In the right pane, click Add.

6. After Name, type a name for the fixed shift.

7. Click Create.

8. Under Start time, type the start time of the fixed shift.

9. Under Duration, type the duration of the fixed shift.

10. Under Color, select a color for the fixed shift.

11. Click OK.

Adding variable shifts

To add a variable shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Shifts.

4. In the right pane, click the Variable Shifts tab.

5. In the right pane, click Add.

6. After Name, type a name for the variable shift.

7. Click Create.

8. Under Minimum hours, type the minimum number of hours in a day you can schedule the shift.

9. Under Typical hours, type the typical number of hours in a day you can schedule the shift.

10. Under Maximum hours, type the maximum number of hours in a day you can schedule the shift.

11. Under Minimum start, type the time of day after which the shift must start.

12. Under Maximum start, type the time of day by which the shift must start.
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13. Under Color, select a color for the variable shift.

14. Click OK.

Renaming shifts

You can rename fixed/variable shifts without losing any information associated with the shifts.
To rename a shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. Click the Shifts tab.

4. If you want to rename a fixed shift, click the Fixed shifts tab. Otherwise, to rename a variable shift, 
click the Variable shifts tab.

5. Under Name, click the name of the shift to rename.

6. Type a new name for the shift.

7. Click OK.

Deleting shifts

CAUTION: Deleting a shift deletes all of the instances of that shift, including those inserted in schedules.
To delete a shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. Click the Shifts tab.

4. If you want to delete a fixed shift, click the Fixed shifts tab. Otherwise, to delete a variable shift, click 
the Variable shifts tab.

5. Under Name, select the shift to delete.

6. Click Delete.

7. Click Yes.

Configuring breaks

You configure the following break options using the Schedule tool:
• Add fixed breaks
• Add variable breaks
• Rename breaks
• Delete breaks

Examples of common breaks are morning break, lunch, afternoon break, and dinner break.
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Adding fixed breaks

To add a fixed break
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Breaks.

4. In the right pane, click the Fixed Breaks tab.

5. Click Add.

6. After Name, type a name for the break.

7. Click Create.

8. If the break is a paid break, enable the check box under Is paid.

9. Under Time into Shift, type the time from the beginning of the shift at which the break must start.

10. Under Duration, type the amount of time allotted for the break.

11. Under Color, select a color for the break.

12. Click Ok.

Adding variable breaks

To add a variable break
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Breaks.

4. In the right pane, click the Variable Breaks tab.

5. Click Add.

6. After Name, type a name for the variable break.

7. Click Create.

8. Under Duration, type the amount of time allotted for the break.

9. If the break is a paid break, select the check box under Paid.

10. Under Time to qualify, type the minimum duration of a shift before you can schedule the break.

11. Under Must start time into shift, type the amount of time from the beginning of the shift that 
employees must work before they are entitled to the break.

12. Under Must end time into shift, type the amount of time from the beginning of the shift by which 
employees must complete the break.

13. Under Minimum time before end of shift, type the amount of time before the end of the shift that the 
break must end.

14. Under Color, select a color for the shift.

15. Click OK.
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Renaming breaks

You can rename a break without losing any information associated with the break.
To rename a break
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Breaks.

4. If you want to rename a fixed break, in the left pane, click the Fixed Breaks tab. Otherwise, to rename 
a variable break, click the Variable Breaks tab.

5. Under Name, click the name of the break to rename.

6. Type a new name for the break.

7. Click OK.

Deleting breaks

CAUTION: Deleting a break deletes all of the instances of the break, including those inserted in schedules.
To delete a break
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. If you want to delete a fixed break, in the left pane, click Fixed shifts. Otherwise, to delete a variable 
break, click Variable shifts.

4. Click the Breaks tab.

5. Under Name, select the name of the break to delete.

6. Click Delete.

7. Click Yes.

8. Click OK.

Configuring jobs

Use jobs in a schedule to differentiate the Non ACD tasks that employees perform. You create jobs for a 
specific shift. If the job requires a specific set of skills, you can associate skills to jobs. After you associate 
skills to jobs, you can compare the skill (and skill level) of the employees to the skill required to perform 
a job. This will ensure the employees you schedule have the appropriate skills for their assigned jobs.
You configure the following job options using the Schedule tool:
• Add fixed jobs
• Add variable jobs
• Rename jobs
• Delete jobs
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Adding fixed jobs

To add a job for a fixed shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Jobs.

4. In the right pane, click the Fixed Jobs tab.

5. Click Add.

6. After Name, type the name of the job.

7. Click Create.

8. If the job involves work on ACD calls, ensure the check box under Is ACD is selected.

9. Under Time into Shift, type the time from the beginning of the shift at which the job must start

10. Under Duration, type the duration of the job.

11. Under Color, select a color for the job.

12. Click OK.

Adding variable jobs

To add a job for a variable shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Jobs.

4. In the right pane, click the Variable Jobs tab.

5. Click Add.

6. After Name, type the name of the job.

7. Click Create.

8. If the job involves work on ACD calls, ensure the check box under Is ACD is selected.

9. Under Color, select a color for the job.

10. Click OK.

Renaming jobs

You can rename a job without losing any information associated with the job.
To rename a job
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Jobs.
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4. If you want to rename a fixed job, click the Fixed Jobs. Otherwise, to rename a variable job, click the 
Variable Jobs tab.

5. Under Name, click the name of the job to rename.

6. Type a new name for the job.

7. Click OK.

Deleting jobs

CAUTION: Deleting a job deletes all of the instances of the job, including where it is inserted in schedules.
To delete a job
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Jobs.

4. If you want to delete a fixed job, click the Fixed Jobs. Otherwise, to delete a variable job, click the 
Variable Jobs tab.

5. Under Name, select the name of the job to delete.

6. Click Delete.

7. Click Yes.

Adding breaks or jobs to shifts

To add a break or a job to a shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. Click Assignments.

4. In the right pane, click the Breaks and Jobs tab.

5. Under Shifts, select the shift for which you will add shifts to.

6. Under Breaks, select the break to add to a shift.

7. Click > to assign the break to the shift.

8. Under Jobs, select the job to add to a shift.

9. Click > to assign the job to the shift.

10. Click OK.

Removing breaks and jobs from shifts

To remove a break or a job from a shift
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. Click Assignments.
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4. In the right pane, click the Breaks and Jobs tab.

5. Under Shifts, select the shift for which you will remove breaks/jobs from.

6. Under Breaks, select the break to remove from the shift.

7. Click < to remove the break from the shift.

8. Under Jobs, select the job to remove from the shift.

9. Click < to remove the job from the shift.

10. Repeat steps 5-9 to remove additional breaks and/or jobs from shifts.

11. Click OK.

Assigning shifts to schedules

NOTE: Schedule Builder uses the shifts you assign, combined with the employees’ availability and shift 
assignment, to schedule shifts (or variations of them).
To assign shifts to schedules
1. Click the Configuration tab.
2. In the Schedules group, click Schedule.

3. In the left pane, click Assignments.

4. In the right pane, click the Shifts tab.

5. Under Schedules, select the schedule to which you will add shifts.

6. Under Fixed Shifts, select the fixed shift to add to the schedule.

7. Click > to assign the shift to the schedule.

8. Under Variable Shifts, select the variable shift to add to the schedule.

9. Click > to assign the shift to the schedule.

10. Repeat steps 6-9 for each shift you want to add to a schedule.

11. Click OK.

Assigning shifts to employees

To assign a shift to an employee
1. Click the Configuration tab.
2. In the Schedules group, click Configure employees.

3. In the left pane, under Schedules, select the schedule containing the employee(s) to which you will 
assign shifts.

4. Under Employees, select the employee to which you will add shifts.

5. Under Shift Assignment, select the check boxes of the shifts that will be available to this employee.

6. Repeat steps 4-6 for each employee to which you will assign shifts.



690

SCHEDULE SETUP AND CUSTOMIZATION
CHAPTER 23 WORKFORCE SCHEDULING

7. Click OK.

Configuring event display preferences

To make events easy to identify at a glance, you can specify how you want to display the scheduled 
events.
You can specify the following event display preferences:
• Time bar content display— provides descriptions, notes, or icons for scheduled events in the time 

bar pane
• Smallest scheduling interval— the smallest increment with which you insert events into the time bar 

pane
• Default shift color— the color for all of the shifts in the time bar pane. To override the default shift 

color, see "Configuring shifts".
• Default break color— the color for all of the breaks in the time bar pane. To override the default break 

color, see "Renamig breaks".
• Default job color— the color for all of the jobs in the time bar pane. To override the default job color, 

see "Configuring jobs".
• Default time off color— the color for all of the time off types in the time bar pane. Your System Admin-

istrator is responsible for setting and changing the default time-off color.
• Unavailable color— the color for unavailable periods in the time bar pane
• Tool tip display— provides event information in tool tips on the time bar pane. The tool tip appears 

as a series of brackets depending on the information criteria you select
• Time display— the time format of the time bar pane. For example, 3 o’clock in the afternoon appears 

as 3 P.M. if you select 12 Hours, or 15 if you select 24 Hours

Configuring the time bar display

You can select from the following three time bar display options:
• Icon— refers to the icons of the scheduled shifts, time off events, and unavailable periods in the time 

bar pane
• Type name— refers to the names of the scheduled jobs in the time bar pane
• Type notes— refers to the notes of the scheduled jobs in the time bar pane

To specify how events display in the time bar
1. On the application menu, click Preferences.
2. Click the Display tab.

3. Under Time bar content, select the time bar content to display for Shifts, Jobs, Breaks, Time off, and 
Unavailable periods.

4. Click OK to save and close the Preferences window.

Configuring the smallest scheduling time interval

By default, events are snapped to the time bar grid in 30 minute increments. However, you can adjust the 
snap-to-grid interval to 5, 15, 30, or 60 minutes. Set the smallest scheduling time interval to the minimum 
number of minutes you want to insert events into a schedule. For example, if you select 15 minutes as 
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the smallest scheduling interval, you cannot insert events for an employee in increments smaller than 15 
minutes.
The default scheduling interval is 15 minutes, which we recommend, as changing this to a smaller interval 
will increase the amount of time it takes for Schedule Builder to build schedules.
To configure the smallest scheduling time interval
1. On the application menu, click Preferences.
2. Click the General tab.

3. Under Scheduling preferences, after Smallest scheduling interval, select the snap-to-grid time 
interval.

4. If you want to prevent the user from manually making any change that would trigger a warning, select 
the Warnings are hard limits for the user check box.

5. Click OK to save and close the Preferences window.

Preventing users from manually making changes that trigger warnings

You can configure Workforce Scheduling to prevent users from making changes that trigger warnings.
To prevent users from manually making changes that trigger warnings
1. On the application menu, click Preferences.
2. Click the General tab.

3. Select the Warnings are hard limits for the user check box.

4. Click OK to save and close the Preferences window.

Configuring the default colors on the time bar

To configure the default colors used for events on the time bar
1. On the application menu, click Preferences.
2. Click the Display tab.

3. Under Default Timebar Colors, after Default Shift Color, select a color.

4. Repeat step 3 for Default Break Color, Default Job Color, Default Time Off Color, and Unavail-
able Color.

5. Click OK to save and close Preferences window.

Configuring the time format

There are two time formats you can select from: the 24 hour international format or the 12 hour format 
which uses A.M. and P.M. to indicate morning and afternoon. For example, 3 o’clock in the afternoon 
appears as 15 if you select the 24 hour time format or 3 P.M. if you select the 12 hour time format.
To configure the time format
1. On the application menu, click Preferences.
2. Click the General tab.

3. After Hour Format, select either 12 Hours or 24 Hours.

4. Click OK.
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Configuring tool tip display

You can specify the following information in tool tips for shifts, jobs, breaks, time off events, unavailable 
periods, and shadow events:
• Schedule name— provides the name of the schedule in which the event appears.
• Is recurring —displays if the event recurs.
• Type— provides the name of the event.
• Type name— states if the event is a shift, job, break, time off event, unavailable period, or shadow 

event.
• Start/End Time— provides the start and end time of the event.
• Event Notes— provides any notes from the detail grid for the event.

To configure the tool tip display
1. On the application menu, click Preferences.
2. Click the Display tab.

3. Under Tooltip Display, select the check boxes for the tool tips to display.

4. Click OK.

Configuring warnings

Warnings notify you when you try to schedule events outside of your scheduling parameters.
You can set the following warnings:
• Schedule warnings
• Shift warnings
• Break warnings
• Job warnings
• Overtime warnings
• Time Off warnings
• Employee scheduling warnings
• Schedule Builder warnings
• Employee selection warnings

To configure warnings
1. On the application menu, click Preferences.
2. Click the Warnings tab.

3. Ensure the check boxes of the warnings you want to configure are selected.

See the following table.
4. Click OK.
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Table 23.1:Warnings  (Sheet 1 of 2)

Warning Description

Scheduling work on company holidays notifies you when events are scheduled on 
company holidays

Scheduling work outside business hours notifies you when you try to schedule events 
outside of your contact center’s business hours

When scheduling outside employee's availability notifies you when you try to schedule employees 
who are not available at the specified time

Violates Length of Service Qualifications notifies you when an employee has worked fewer 
or more months required to qualify for a specific 
type of time off

Exceeds accrued hours notifies you when an employee is scheduled for 
more time off hours than is available to that 
employee at that time

Exceeds Maximum Scheduling Limit notifies you when an employee is scheduled for 
more time off hours than specified for that type of 
time off

Less than Minimum Scheduling Limit notifies you when an employee is scheduled for 
fewer time off hours than specified for that type of 
time off

Employee does not have required skills notifies you when an employee does not have the 
required skills for the job for which they are 
scheduled

Exceeds Daily Maximum Work Hours notifies you when an employee is scheduled for 
more hours in a day than defined by the 
parameter for that shift

Below Daily Minimum Work Hours notifies you when an employee is scheduled for 
fewer hours in a day than defined by the 
parameter for that shift

Exceeds Weekly Maximum Work Hours notifies you when an employee is scheduled for 
more hours in a week than defined by the 
parameter for that shift

Below Weekly Minimum Work Hours notifies you when an employee is scheduled for 
fewer hours in a week than defined by the 
parameter for that shift

Exceeds Yearly Maximum Work Hours notifies when an employee is scheduled for more 
than the annual maximum hours required

Below Yearly Minimum Work Hours notifies you when an employee is scheduled for 
less than the annual minimum hours required



694

FORECASTING DATA FOR SCHEDULES
CHAPTER 23 WORKFORCE SCHEDULING

Forecasting data for schedules
After setting up and customizing your schedule, if you are building a schedule from forecasted data, you 
must run the Forecasting tool and export the forecast into your schedule before you can select this option 
in the schedule builder or schedule builder wizard.
For information on the Forecasting tool, see "Forecasting tool".
To access the Forecasting tool
1. Click Tools in the Workforce Scheduling ribbon.
2. In the Data Mining section, click Forecasting.

Schedule creation
You can create and customize schedules in Workforce Scheduling using specific parameters that suit the 
needs of your contact center. You can build schedules manually or with the Schedule Builder tool. 
Schedule Builder automates the schedule building process. It uses pre-defined employee and schedule 
options to create schedules. See "Schedule setup and customization".

Start time outside of specified range notifies you when an employee’s shift is 
scheduled to start before (minimum) or after 
(maximum) the parameters defined for that shift

Within Minimum Time Between Shifts notifies you when an employee is scheduled to 
start another shift too soon following the one 
previously completed

Below hours worked to qualify notifies you when an employee is scheduled for a 
break before working enough hours after the last 
break in that shift to qualify for another break

Starting before earliest start time notifies you when an employee is scheduled for 
the first break in a shift before a break can be 
taken

Ending after latest end time notifies you when an employee is scheduled for 
the last break in a shift after a break can be taken

Removing an employee from a schedule notifies you when you attempt to delete an 
employee from the schedule

Accepting a generated schedule notifies you when you attempt to save a schedule 
you have built

Scheduled shift will cause overtime notifies you when a shift qualifies an employee for 
overtime

Table 23.1:Warnings (Continued) (Sheet 2 of 2)

Warning Description
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Schedule Builder helps you build a schedule with or without forecast data. If you are building a schedule 
with forecast data, you must export the forecast data into your schedule before running the Schedule 
Builder if you want to build a schedule with forecast data. See "Forecasting data for schedules".
You can also use manual scheduling to modify schedules you build with Schedule Builder. See "Creating 
and adjusting schedules manually".
NOTE: After you generate a schedule with Schedule Builder, you must accept or reject schedule changes 
before you can generate another schedule.
Schedule Builder uses the following parameters to create a schedule automatically:
• Date/time range
• Shifts
• Breaks
• Forecast data
• Business hours
• Employees
• Employee scheduling preferences
• Scheduling options
• Shift options
• Schedule algorithm options

Building schedules with Schedule Builder

NOTE: After you generate a schedule with Schedule Builder, you must accept or reject schedule changes 
before you can generate another schedule.
To build a schedule with Schedule Builder
1. Click the Tools tab
2. In the Schedule Builder group, click Manual.

3. Under Schedule name, select a schedule.

4. Specify the scheduling parameters on each tab of the Schedule Builder tool.

5. Click Build.

A dialog box appears reminding you that changes to the schedule will not be committed to the data-
base until you click Accept Schedule.

6. Click OK.

The Accept Schedule and Reject Schedule buttons appear in the toolbar.
7. Verify the schedule.

8. Make any required modifications manually.

9. Click Accept schedule to save the new schedule.

NOTE: 
– After you click Accept Schedule, the schedule is live in the database and the Accept Schedule button 

disappears. If you click Reject Schedule, the automatically generated schedule and any manual 
modifications are deleted from the schedule. See "Creating and adjusting schedules manually".
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– If there are any conflicts, a dialog box appears stating the number of conflicts. You cannot save a 
schedule with conflicts. Click Yes to delete the conflicts and accept the schedule, or click No to adjust 
the schedule. When you have resolved the conflicts, click Accept Schedule again to save the 
schedule.

Configuring the date and time range

To configure the date and time range for a schedule using Schedule Builder
1. In Schedule Builder, click the General tab.
2. Under Dates and times, on the Date / Time tab, select the date range of the schedule.

3. Under Time, select either Use business hours, 24/7, or Custom.

4. If you selected Custom in the previous step, select the time the schedule starts and ends each day.

5. If you want to exclude dates from the schedule, click the Exclusion tab.

6. Hold down CTRL and then click the dates to exclude.

Scheduling shifts

To schedule shifts using Schedule Builder
1. In Schedule Builder, click the General tab.
2. Under Schedule/Optimize, select the Shifts check box.

3. Under Event selection, on the Shift selectiontab, select the check boxes of the shifts to add to the 
schedule.

4. Click the Shift, Break, & Job options tab.

5. Under Shift options, specify how shifts will be distributed.

– If you want to count existing shifts when determining the number of employees to be scheduled, 
select the The Schedule Builder counts existing shifts when determining the number of 
employees which must be scheduled check box.

– If you want to optimize existing unlocked shifts, select the Allow Schedule Builder to optimize 
existing unlocked shifts check box.

– If you want to optimize existing locked shifts, select the Allow Schedule Builder to optimize 
existing locked shifts check box.

– If you want to schedule unassigned shifts for times when there are not enough employees available 
to satisfy the scheduling requirements, select the Generate unassigned shifts when not enough 
employees are available to satisfy the schedule requirements check box.

– If you want to ignore employee shifts assignments when building the schedule, select the Ignore 
employee shift assignments check box.

Scheduling jobs

To schedule jobs using Schedule Builder
1. In Schedule Builder, click the General tab.
2. Under Schedule/Optimize, select the Fixed Jobs check box.

3. Under Event selection, on the Fixed Job selection tab, select the check boxes of the job types to 
add to the schedule.



697

SCHEDULE CREATION
CHAPTER 23 WORKFORCE SCHEDULING

4. Click the Shift, Break, & Job options tab.

5. Under Schedule fixed jobs on, select the check boxes of the job types to apply shifts.

Generating schedules with forecast data

To build a schedule with forecast data using Schedule Builder
1. In Schedule Builder, click the General tab.
2. Under Schedule Builder method, after Method, select Forecasted data.

3. If you want fewer employees scheduled than are forecasted, move the slider towards Under-
schedule.

4. If you want more employees scheduled than are forecasted, move the slider towards Overschedule.

5. If you want to adjust the number of forecasted employees, next to Increase/decrease the number 
of forecasted employees by, enter a number.

Generating schedules without forecast data

To build a schedule without forecast data using Schedule Builder
1. In Schedule Builder, click the General tab.
2. Under Schedule Builder method, after Method, select Explicit requirements.

3. After Number of employees to schedule, enter a number.

4. If you want fewer employees scheduled than are forecasted, move the slider towards Under-
schedule.

5. If you want more employees scheduled than are forecasted, move the slider towards Overschedule.

Generating schedules for your entire workforce

To build a schedule for your entire workforce using Schedule Builder, regardless of employee availability
1. In Schedule Builder, click the General tab.
2. Under Schedule Builder method, after Method, select Entire workforce.

3. If you want to enable employee filtering, select the Enable employee filtering check box.

Selecting employees

To select the employees you want to schedule using Schedule Builder
1. In Schedule Builder, click the Employee filtering tab.
2. If you want to filter employees by agent group, under Agent group, select the check boxes of the 

agent groups to schedule.

3. If you want to filter employees by their skills, under Skill, select the check boxes of the required skills. 
Otherwise, skip to step 6.

4. Under the list of available skills, select an operand.

– If the employees must have a skill level greater or equal to the skill level required, select >=.
– If the employees must have a skill level lower or equal to the skill level required, select <=.
– If the employees must have a skill level exactly equal to the skill level required, select =.
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5. If you want to filter employees by name, under Select employees with this name, type an 
employee’s name.

6. If you want to select specific employees, under Selected employees, select the check boxes of the 
employees to schedule.

7. Click the Employee sorting tab.

NOTE: You must configure the employee payroll information in order to select the seniority and pay 
rate parameters.

8. If you want to prioritize how shifts are distributed to employees, select the Use employee sorting 
check box, and select the criteria with which to sort employees.

9. If you want to assign or edit employee priority numbers, under Employee priority, select an 
employee.

10. Under Priority, type a personal priority number.

11. Click the Overrides tab.

12. If you want to override employee work hour preferences, under Work hours, select the check boxes 
to override daily work hours, weekly work hours, and the minimum time between shifts.

13. If you want to override employee availability, under Availability, select the check boxes to override 
employee availability and unavailable events currently applied to the schedule.

14. If you want to override scheduled time off, under Time off, select the Override time off events 
currently applied to the schedule check box.

15. If you want to override an employee's skills required to do the fixed job, under Fixed Jobs, select the 
Override an employee's skills required to do the fixed job.

Configuring scheduling options

To configure schedule options Schedule Builder uses to create a schedule
1. In Schedule Builder, click the Advanced options tab.
2. Under Schedule algorithm performance, specify the settings Schedule Builder will use to build the 

schedule.

3. If you want to optimize break distribution, under Optimization types, select the Optimize break 
distribution check box.

4. If you want to optimize shift placement, select the Optimize shift placement check box.

5. If you want to optimize shift size, select the Optimize shift size check box.

6. If you want to balance the distribution of employee shifts over the week, select the Balance over the 
week check box.

Selecting this option ensures that Schedule Builder does not completely fill the requirements of the 
first few days of the schedule and understaff employee requirements by the end of the week.

Creating and adjusting schedules manually

You can create entire schedules manually. However, if you must schedule a large number of employees 
it can be quite complicated and time consuming. Schedule Builder automates the process and builds 
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schedules for you. You can manually adjust schedules created with Schedule Builder. You can create and 
adjust schedules manually in the following ways:
• Load a schedule
• Populate a schedule with events
• Drop insert an event
• Drag insert an event
• Recur an event
• Mass recur an event
• Mass delete an event
• Mass apply time off
• Modify a forecast total
• Modify event times or notes

Loading schedules

NOTE: Your access rights determine which schedules you can view, modify, or manage.
To load a schedule
1. Click File > Load schedules.
2. Select the schedule(s) to load.

3. If you want to load all active schedules, select the Select all active schedules check box.

4. Click Load.

Populating schedules with events

NOTE: 
• Your access rights determine which schedules you can view, modify, or manage.
• For ease of use and accuracy when inserting events, select a schedule view of less than 1 week (View 

> Schedule View) prior to insertion.

You can manually insert the following events into a schedule: 
• Shifts
• Breaks
• Jobs
• Time off
• Unavailable periods

You can insert events in a schedule by either dropping or dragging them on an employee’s time line on 
the time bar pane. You can optionally drop insert breaks or jobs into already existing fixed shifts. Drop 
inserting events is most useful for fixed events, as the duration of the shift is predefined. Drag inserting 
events is most useful for variable shifts, as the duration can vary depending on the defined parameters 
for a specific event.
NOTE: To accommodate for last minute scheduling changes, you can optionally schedule time off and 
unavailable events in the middle of scheduled shifts or schedule a shift in the middle of time off and 
unavailable events.
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Drop inserting events

To drop insert an event
1. Click the Insert tab.
2. Click Drop.

3. Under Event, select the event to add to the schedule.

4. Under Schedule, select the schedule to add events to.

5. Under Event name, select the name of the event to add to the schedule.

6. On the time bar pane, click the employee’s time line to insert the event.

The event is added to the schedule.
7. Repeat steps 3-6 for every event to add to the schedule.

Drag inserting events

NOTE: Drag insert is not available in the 1 month schedule view.
To drag insert an event
1. Click the Insert tab.
2. Click Drag.

3. Under Event, select the event to add to the schedule.

4. Under Schedule, select the schedule to add events to.

5. Under Event name, select the name of the event to add to the schedule.

6. On the time bar pane, click the employee’s time line and drag the cursor from the start time to the end 
of the event.

7. Repeat steps 3-6 for every event to add to the schedule.

Recurring events

You can recur shifts, time off, and unavailable events.
To make an event recur
1. On the time bar pane, on the employee’s time line, right-click the event to recur.
2. Click Recurring.

3. Click Daily, Weekly, or Monthly recurring.

4. Specify the pattern and range of the recurrence.

5. Click OK.

Mass recurring events

You can use the Mass recurrence wizard to create multiple recurrences for several events automatically. 
The wizard allows you to mass recur shifts, time off, and unavailable periods based on either a daily or 
weekly template.
NOTE: Manual or mass deletion is required to remove the generated events.
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To mass recur events
1. Click the Tools tab.
2. In the Bulk operations group, click Recurrence.

The Mass Recurrence wizard opens.
3. Click Next.

4. Follow the steps in the wizard to specify the parameters of the events to mass recur.

5. Click Finish.

6. Click Yes.

Mass deleting events

You can delete one or more scheduled events (shifts, time off periods, unavailable periods, breaks, and 
jobs) at a time with the Mass delete option. Only the selected events are deleted from the schedules.
To mass delete scheduled events
1. Click the Tools tab.
2. In the Bulk operations group, click Delete.

3. Specify the date range affected, event types to delete, and the schedules to delete events from.

4. Click OK.

Mass applying time off

You can apply time off to any or all agents in a schedule simultaneously.
To mass apply time off
1. Click the Tools tab.
2. In the Bulk Operations group, click Time Off.

The Timeoff Mass Insert dialog box opens.
3. Select a schedule from the Schedules drop-down list.

4. Hold down CTRL and then click the agents to which you want to apply the time off type. If you want 
to select all agents, click Select All.

5. Under Time off, select the time off type from the list.

6. Select the start and end dates, days of the week, and start and end times for the time off type.

7. After selecting the time off time, select Mark remaining periods of the day as unavailable if you 
want the hours outside of the start and end times to be unavailable for scheduling.

8. Click OK.

Modifying forecast totals in the event totals pane

If you build schedules with forecast data, you can adjust the forecast totals on the event totals pane. On 
the events totals pane, you can change forecast totals in time intervals as small as 15 minutes. The 
schedule view you select determines the time interval of the forecast totals. See "Changing the time 
interval of the time bar pane".
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For example, if you select the 8 hour schedule view, you can change the forecast data in 15 minute inter-
vals. However, if you select the 1 day schedule view, you can change the forecast data in 1 hour time 
intervals. When you change the forecast data in an interval larger than 15 minutes and then change the 
view to smaller intervals, you will notice that the change applies to each of the smaller intervals.
NOTE: Schedule Builder uses the latest forecast data to calculate the number of employees required.
To change the forecast totals in the events totals pane
1. After Totals, click +.
2. Select the Forecast check box and the check boxes of any other event totals to view.

3. Click -.

4. Click the View tab.

5. Under Schedule view, select a time interval.

See "Schedule views and corresponding event total".
6. Click the + before Forecasted to expand the forecast tree.

The event totals for the loaded schedules appear.
NOTE: You can use the Tab key to select cells to the right, and the Shift+Tab keys to select cells to 
the left.

7. Click a cell in the forecast event total grid and type the new forecast total for this time interval.

Modifying event times and notes in the schedule details pane

The changes you make to event start times and end times in the schedule details pane are immediately 
reflected in the time bar pane.
To modify the start and end times of events in the schedule details pane
1. On the schedule Details pane, click the Start Time or End Time of an event.
2. Type the new time.

The new time is immediately reflected in the time bar pane.
3. Repeat for any other event times to modify.

To modify the start and end times of events in the time bar pane
1. Click the Insert tab.
2. Click Select.

3. On the time bar pane, select the event to modify.

4. Drag and drop the event to adjust its start and end times.

The new time is immediately reflected in the time bar pane.
5. Repeat for any other event times to modify.

To add/edit a note for a scheduled employee
1. On the schedule Details pane, click the note field for an employee.
2. Click the ... button.

The Notes editor appears.
3. Type/edit a note.

4. Click OK.



703

SCHEDULE DISTRIBUTION
CHAPTER 23 WORKFORCE SCHEDULING

Schedule distribution
You can specify viewing preferences, specify access rights to schedules, and run and print reports.

Viewing schedules

You can specify how you view the time bar pane. Use the scroll bar to view other days and times in the 
schedule. If you reach the end of the month and want to view dates for the next month, you can click the 
arrow on the scroll bar to load the schedule for the next month. By default, events you insert into a 
schedule are snapped to the grid in 30 minute increments.
To view a specific date
1. From any tab in Workforce Scheduling, click Select date.
2. Click the date to view.

The time bar will display the date you selected to view.

Viewing scheduled events

You select how event time bars appear in File > Preferences. You can isolate shifts, time off, and unavail-
ability to view them separately in the time bar pane. You must view breaks and jobs with shifts. You cannot 
isolate breaks and jobs in the time bar pane. See "Configuring event display preferences". You can select 
what information displays in the Tooltip in Preferences. For more information, see "Configuring tool tip 
display".
If employees belong to more than one schedule and you are viewing only one of the schedules to which 
the employees belong, any events scheduled in the other schedule will appear as a shadow event (gray 
bar) in the time bar view. Shadow events will not display for inactive schedules.
To view shifts
• On the View tab, in the Show/Hide group, select the Shift check box.
To view jobs
• On the View tab, in the Show/Hide group, select the Job check box.
To view breaks
• On the View tab, in the Show/Hide group, select the Break check box.
To view time off
• On the View tab, in the Show/Hide group, select the Time off check box.
To view unavailable periods
• On the View tab, in the Show/Hide group, select the Unavailable check box.
To view shadow events
• On the View tab, in the Show/Hide group, select the Shadow check box.

Changing the time interval of the time bar pane

You can view schedules in the time bar pane over 8 hour, 12 hour, 1 day, 2 day, 1 week, 2 week, or 1 
month time intervals. The default view is the 12 hour view.



704

SCHEDULE DISTRIBUTION
CHAPTER 23 WORKFORCE SCHEDULING

To change the time interval in the time bar pane to one week 
1. Click the View tab.
2. In the View options group, under Schedule view, select the interval to view.

3. Optionally, under Group view, select Supervisor to group employees in the time bar pane by 
schedule.

Viewing event totals

Event totals represent the total number of employees for an event. You can view event totals in 15 minute, 
30 minute, 1 hour, 4 hour, or 1 day time intervals. The following table displays the event total time intervals 
that correspond to the schedule views.

You can select from the following event totals:
Forecast—appears only after you have applied a forecast to a schedule. This total represents the number 
of employees required to meet your specified Service Level objectives.
Scheduled—represents the number of employees scheduled at that time
Over/Under—represents the excess (over) or inadequate (under) number of employees scheduled when 
compared to the number of employees forecasted.
On Break—represents the number of employees scheduled for a break at a certain time
ACD Jobs—represents the number of employees scheduled to perform ACD jobs
Non ACD Jobs—represents the number of employees scheduled to perform Non ACD jobs
At work—represents the number of employees scheduled to handle interaction requests
Overtime—represents the number of employees scheduled for overtime
To view event totals
1. In the Totals pane, click +.
2. Select the check boxes of the event totals to view.

3. Click -.

The totals pane appears with the event totals you selected.

Table 23.2:Schedule views and corresponding event total time intervals

Schedule view Event totals time interval

8 hour 15 minute

12 hour 30 minute

1 day 1 hour

2 day 4 hour

1 week 1 day

2 week 1 day

1 month 1 day
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Viewing schedule details

To group information in the schedule details pane
• On the schedule details pane, drag and drop the column header to organize to the Drag a column 

header here to group by that column area on the window.
To sort information in the schedule details pane alphabetically
• On the schedule details pane, click the header of the column to sort alphabetically.
To filter information in the schedule details pane
1. On the schedule details pane, click the arrow on a column header.
2. Select the filter criteria.

Synchronizing views

You can synchronize the people pane, time bar pane, and totals pane with the order of the information in 
the schedule details pane. Once you have organized the details of your schedules (sorting, filtering, and 
grouping) in the schedule details pane, synchronize views to reflect the order you have selected. For infor-
mation on how to sort, filter, or group schedule details, see "Viewing schedule details".
To synchronize views
1. Click the View tab.
2. Select the Synchronize time bar view with details view check box.

3. Optionally, select the Vertical scrolling check box.

Running Workforce Scheduling reports

The Workforce Scheduling reports are produced in Microsoft Excel format. You run and print the following 
Workforce Scheduling reports from CCMWeb. For more information, see the Reports Guide appropriate 
to your Mi Contact Center Business licensing level.
You can produce on-demand reports and scheduled reports for the following reports:
• Detailed Schedule by Employee with Totals
• Schedule by Employee by Time Off by Day of Week
• Employee Configuration
• Summary Schedule by Employee
• Schedule Coverage Totals by Type
• Work Hours Summary Schedule by Employee

Workforce Scheduling reports are found in CCMWeb, under Reporter > Workforce Scheduling > 
Schedules.

Schedule Adherence
Mitel Schedule Adherence is an optional application that works in conjunction with MiContact Center Busi-
ness and Workforce Scheduling. Schedule Adherence resides in the Contact Center Client real-time 
monitors and enables you to view the real-time state of contact center employees scheduled in Workforce 
Scheduling. Schedule Adherence compares the current activities of employees to the configured 
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schedule and alerts you in real time when employees are out of adherence. Employees are considered 
out of adherence if they are early or late for their scheduled events or if they are not performing scheduled 
events.
Once you have configured a schedule in Workforce Scheduling, you
• Configure adherence preferences in Workforce Scheduling
• View adherence monitors in Contact Center Client
• Set adherence alarms on the Employee State by Position/Time monitors (optional)
• Run reports on employee adherence to scheduled events

Configuring adherence preference

You can configure adherence thresholds for shifts, breaks, and jobs. You can set parameters for each 
event type to suit the needs of your business. You select employee states and assign them to relevant 
events and specify event time tolerance levels. You can optionally configure groups of employee states 
and then associate them to relevant employee events.
NOTE: 
• Schedule Adherence will handle two or more overlapping adherence thresholds in one of the following 

ways. If only one of the events is valid for the current employee state, that event will be used. If more 
than one event is valid for the current employee state, the first event, using start time, will be used.

• If no states are specified for an event type, all states will be considered in adherence.

Configuring adherence parameters

To configure adherence parameters
1. In Workforce Scheduling, click the Configuration tab.
2. In the Adherence group, click Adherence Configuration.

The Adherence Parameters window opens.
3. In the left pane, expand the event type list and select the event to which you want to add relevant 

adherence states.

4. Under Event start tolerance (hh:mm) , specify the times before and after which an employee state 
will be reported on as out of adherence.

5. Under Event end tolerance (hh:mm), specify the times before and after which an employee state 
will be reported on as out of adherence.

6. Under Available states, select the states which are relevant for the specified event type and click > 
to move the state to the Assigned states list.

7. Repeat the above steps for each event type for which you want to configure adherence parameters.

8. Click OK.

Configuring state groups

To configure a state group
1. In Workforce Scheduling, click the Configuration tab.
2. In the Adherence group, click State groups.

The State groups window opens.
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3. Click Add.

4. Type a name for the state group and click Create.

5. Under Available states, select the states that are relevant for the state group and click > to move the 
state to the Assigned states list.

6. Repeat steps 2-5 for each state group you want to configure.

7. Click OK.

Viewing adherence monitors in Contact Center Client

Schedule Adherence includes two Contact Center Client monitors that enable you to monitor employee 
adherence to schedules in real time. The Schedule Adherence monitors alarm on employees who are not 
adhering to schedules based on the thresholds you specify in Workforce Scheduling and the alarms you 
configure in Contact Center Client. You can optionally set adherence alarms on the Employee State by 
Position/Time monitors.

Adherence Detail Grid monitor

The Adherence Detail Grid monitor displays employee scheduled events, expected states, and event 
totals. It enables you to easily compare expected employee states and actual employee states in real 
time.
There are three levels to the Adherence Detail Grid monitor. The first level provides a high level overview 
of employee adherence. The second level has two grids. The first lists all of the embedded events (breaks 
and jobs) for the shift and the associated adherence information. The second grid lists the out of adher-
ence record for the shift. The final level has only one grid, which represents the out of adherence record 
for the embedded events.
The following table provides column heading definitions for the Adherence Detail Grid monitor.
Table 23.3:Adherence Detail Grid monitor headings  (Sheet 1 of 2)

Heading Definition

Employee the name of the employee being monitored

Is in Adherence the check box is enabled when the employee is 
adhering to the schedule

Scheduled the type of event (shift, break, or job) the 
employee is performing, whether in or out of 
adherence

Expected States the employee states that are relevant for the type 
of scheduled event the employee is scheduled to 
perform

Actual State the current employee state. If this is one of the 
expected states, the employee is adhering to the 
schedule
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You can set alarms on the Adherence Grid monitor to alarm on employee adherence. For example, in an 
adherence grid monitor, you could set an alarm on the Scheduled variable and set the value to Unsched-
uled and have it display as red text, enabling you to clearly see when an employee is not adhering to the 
shift as expected.
You can alarm on the following performance variables in the adherence detail grid monitor: 
• Out of adherence
• Scheduled 

NOTE: To alarm for when the employee is in Time off or Unavailable states, set the value to Unsched-
uled.

• Expected states

Scheduled Start the time at which the employee is scheduled to 
start the scheduled event

Actual Start the time at which the employee started the 
scheduled event. This column may be blank if the 
employee has not come into adherence for the 
scheduled event

Scheduled End the time at which the scheduled event is to end

Current Out Of Adherence the amount of time the employee has been out of 
adherence since the last scheduled event, minus 
any tolerances configured. This column will be 
blank if the employee is adhering to the schedule

Total Out Of Adherence the total amount of time the employee has been 
out of adherence for all scheduled events for the 
current shift

Shift Time the duration of time the employee has been 
working the current shift

% Out Of Adherence the percent of time the employee has been out of 
adherence for the elapsed portion of the 
scheduled shift

Shift the name of the shift for which the employee is 
scheduled

Embedded the name of the embedded event type (break or 
job)

Start the time at which the employee went out of 
adherence

End the time at which the employee came back into 
adherence

Table 23.3:Adherence Detail Grid monitor headings (Continued) (Sheet 2 of 2)

Heading Definition
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• Actual state
• Actual start
• Current Out of Adherence
• Total Out of adherence
• Shift time
• % Out of adherence

To open the Adherence Detail Grid monitor 
1. Click the Real Time tab in the Contact Center Client ribbon.
2. From the drop-down arrow in the Adherence column, select Detail Grid. 

The Add/Remove device IDs window opens.
3. Select the Employees or Schedules for which you want to review Adherence.

4. Click OK. 

The Adherence Details monitor opens.
See the following figure.

Figure 23.6: Adherence Detail Grid monitor
 

To alarm on schedule adherence in an Adherence Detail Grid monitor 
1. Right-click anywhere in the monitor and click Set alarms.
2. Under Performance variables, select the variable you want to monitor.

3. Under Alarm thresholds, click Add and select a value for that variable you selected as well as the 
alarm notification options that will indicate when the variable exceeds those boundaries. 

For more information on configuring monitor alarms, see "Setting alarms".
4. If you want to add further alarms for the variable, repeat step 3.

5. If you want to add an alarm for another variable, repeat steps 2-5.

6. Click OK to save the alarms.

Adherence Timebars monitor

The Adherence Timebars monitor provides a schedule time bar, based on the employee time bar and 
event colors configured in Workforce Scheduling, for each employee's scheduled events. The current 
time is identified by a green line on the employee time bar and past events are shaded purple.
You can set alarms on the Adherence Grid monitor to alarm on employee adherence. The following 
performance variables can be alarmed on in the adherence timebars monitor: 
• Shift out of adherence
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• Break out of adherence
• Job out of adherence

To open the Adherence Timebar monitor 
1. Click the Real Time tab in the Contact Center Client ribbon.
2. From the drop-down arrow in the Adherence column, select Timebars. 

The Add/Remove device IDs window opens.
3. Under Schedules, select a schedule to include in the monitor or under Employees, select the 

employees to monitor.

4. Click OK. 

The Adherence Timebars monitor opens.
See the following figure.

Figure 23.7: Adherence Timebars monitor
 

To alarm on schedule adherence in an Adherence Timebar monitor 
1. Right-click anywhere in the monitor and click Set alarms.
2. Under Performance variables, select the variable you want to monitor.

3. Under Alarm thresholds, click Add and select a value for that variable you selected as well as the 
alarm notification options that will indicate when the variable exceeds those boundaries. 

For more information on configuring monitor alarms, see "Setting alarms".
4. If you want to add further alarms for the variable, repeat step 3.

5. If you want to add an alarm for another variable, repeat steps 2-5.

6. Click OK to save the alarms.

Employee State by Position/Time monitors

You can alarm on employees who are not adhering to schedules on the Employee State by Position/Time 
monitors using the Out of adherence performance variable. This variable measures the duration of time 
an employee is out of adherence, enabling more targeted alarming on the time and degrees for which an 
employee is out of adherence.
To set an adherence alarm on the Employee State by Position/Time monitors
1. Right-click an Employee State by Position/Time monitor and click Set Alarms.

NOTE: You can select the Apply the alarm thresholds to all devices displayed on the monitor option 
to apply the threshold settings for performance variables across all employees. Alternatively, you 
can select Apply the alarm thresholds to a specific list of devices to apply the threshold settings for 
performance variables to a list of employees.

2. If you selected Apply the alarm thresholds to a specific list of devices, under Devices, select the 
employee(s) to which you want to apply the alarm thresholds.
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3. Under Performance variables, select Out of adherence.

4. Under Alarm threshold, click Add and specify the boundary for alarming and set the options for the 
background color, font color, sound, pop-up, bring to front, and email.

5. To add an additional threshold for alarming, repeat step 4.

6. Click OK.

Alarming on schedule adherence

Supervisors can set alarms on adherence monitors in Contact Center Client to alarm on employee adher-
ence by configuring an alarm in Contact Center Client using the Scheduled Performance Variable set to 
a specific value (such as unscheduled).
For example, in an adherence grid monitor, you could set an alarm on the Scheduled variable and set the 
value to Unscheduled and have it display as red, enabling you to clearly see when an employee is not 
adhering to the shift as expected.
You can alarm on the following performance variables in the adherence detail grid monitor: 
• Out of adherence
• Scheduled
• Expected states
• Actual state
• Actual start
• Current Out of Adherence
• Total out of adherence
• Shift time
• % out of adherence

You can alarm on the following performance variables in the adherence timebars monitor: 
1. Shift Out of adherence
2. Break Out of adherence

3. Job Out of adherence

To alarm on schedule adherence 
1. Right-click anywhere in the monitor and click Set alarms.
2. Under Performance variables, select the variable you want to monitor.

3. Under Alarm thresholds, click Add and select a value for that variable you selected as well as the 
alarm type(s) that will indicate when the variable exceeds those boundaries.

4. For more information on configuring monitor alarms, see "Setting alarms".

5. If you want to add further alarms for the variable, repeat step 3.

6. If you want to add an alarm for another variable, repeat steps 2-5.

7. Click OK to save the alarms.
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Running Schedule Adherence reports

The Schedule Adherence reports are produced in Microsoft Excel format. You run and print the following 
Schedule Adherence reports from CCMWeb. For more information, see the Reports Guide appropriate to 
your MiContact Center Business licensing level.
You can produce on-demand reports and scheduled reports for the following reports:
• Employee and Employee Group Adherence Trace
• Employee Group Time Out of Adherence by Employee by Day of Week
• Employee Group Time Out of Adherence by Day of Month
• Employee Group Adherence by Period

Schedule Adherence reports are found in CCMWeb, underReporter > Workforce Scheduling > 
Schedule Adherence.

Employee Portal
Mitel Employee Portal enables employees to view and trade shifts online and request changes to sched-
ules for time off, shifts, and availability. Employee Portal enables schedulers to view employee requests, 
perform what-if scenarios, quickly approve or deny requests, and automatically update schedules.
Access to Employee Portal features is dependent on your administrative-set security roles.

Employee Portal and employees

Using Employee Portal, employees can
• View their currently scheduled shifts and the shifts of other employees who share their schedule
• View messages from supervisors and employees and receive updates about the status of their 

requests on the home page
• Offer shifts to the bulletin board for other employees to take or trade
• Remove shifts from the bulletin board
• Propose to take shifts from the bulletin board
• Propose to trade shifts from the bulletin board
• Accept or reject employee proposals to take or trade your shift
• Request time off
• Request changes to your availability

The Employee Portal home page provides links to the bulletin board, view and offer your scheduled shifts 
for take or trade, view your pending offers, request time off, and request availability changes. Any 
Employee Portal alerts that require your attention also display on the home page. These include
• You have approved shift requests
• You have denied shift requests
• You have shift requests pending supervisor approval
• You have shift proposals pending your acceptance
• You have shift proposals pending acceptance or that have been rejected
• You have time off requests pending supervisor approval
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• You have notes regarding your availability

If a home page alert is red, it requires your attention. Click View to view the alert and any employee or 
supervisor notes in detail.

Starting Employee Portal

To start Employee Portal
1. Open Employee Portal.
2. Type your Username and Password.

3. Click Login.

Creating a desktop shortcut to Employee Portal

To create a desktop shortcut to Employee Portal
1. Open Employee Portal.
2. Type your Username and Password.

3. Click Login.

4. Drag and drop the Employee Portal web address from the address bar to your computer desktop.

Viewing currently scheduled shifts

To view your currently scheduled shifts
1. In Employee Portal, click My shifts.
2. If you want to view shifts starting on a specific calendar day, select the start date from the calendar.

3. Optionally, to view the break and job details for a specific shift, under Details, click Select.

Viewing the shifts of other employees in your schedule

You can view the shifts for other employees in your schedule to help you determine potential shift swaps.
To view the shifts of other employees in your schedule
1. Click My Schedules.
2. To view shifts starting on a specific day, select the start date from the calendar.

3. Click Select next to the employee for which you want to view the shift.

The break and job details for the shift display below.

Offering shifts for other employees to take or trade

You can offer shifts to the bulletin board for other employees to take or trade. You can remove shifts from 
the bulletin board at any time as long as no employees have proposed to take or trade the shift. Shifts 
that have already begun cannot be posted to the bulletin board for other employees to take or trade.
To offer a shift for other employees to take or trade
1. Click Offer my shifts.
2. Next to the shift you want to offer for other employees to take or trade, click Select.

The shift details display.
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3. Click Continue.

4. Optionally, type a note to accompany your offer.

5. Click Submit.

Removing shifts from the bulletin board

You can remove shifts from the bulletin board at any time as long as no employees have proposed to take 
or trade the shift. If a proposal has been made, you will need to reject it first before you can remove the 
shift from the bulletin board.
To remove a shift from the bulletin board
1. Click My pending offers.
2. Next to the shift you want to remove from the bulletin board, click Select.

The shift details display.
3. Click Continue.

The shift offer is removed from the bulletin board.

Proposing to take shifts

To propose to take a shift
1. Click Bulletin board.
2. Next to the shift you want to take, click Select.

The shift details display.
3. Click Continue.

4. Click Next.

5. Optionally, add a note to accompany your proposal.

6. Click Next.

7. Click Submit.

Proposing to trade shifts

To propose to trade a shift
1. Click Bulletin board.
2. Next to the shift you want to take, click Select.

The shift details display.
3. Next to the shift you want to propose for trade, click Select.

4. Optionally, add a note to accompany your proposal.

5. Click Next.

6. Click Submit.



715

EMPLOYEE PORTAL
CHAPTER 23 WORKFORCE SCHEDULING

Accept or reject an employee proposal to take or trade your shift

To accept or reject an employee proposal to take or trade your shift
1. On the Employee Portal home page, next to You have <#> shift proposals pending your accep-

tance, click View.
The Proposals window displays.

2. Next to the proposal you want to view, click Select.

The proposal details display with any relevant employee notes.
3. Click Accept to accept the proposed shift change. Otherwise, click Reject to reject the proposed shift 

change.

Requesting time off

To request time off
1. Click Request time off.

The Request time off window displays, including a list of any time off you have already scheduled.
2. Click Request time off.

3. Select a time off type from the list.

4. Click Next.

5. Specify the time off start and end times.

6. Click Next.

7. Optionally, add a note to accompany the time off request.

8. Click Next.

The time off request summary displays.
9. Click Submit.

Requesting availability changes

NOTE: You can click Clear request at any time to reset the Request availability change window to your 
currently configured availability.
To request an availability change
1. Click Request availability change.

The Request availability change window displays with your current availability.
2. If you need to change existing availability, under Update current availability, select a day of the 

week and click Remove. Otherwise, continue to step 3.

3. Under Change availability, specify the dates and times you are available to work.

– After Day of week, specify the day of week you are available.
– If you are only available during certain hours, selectPart of the day, and specify the times at which 

you are available.
– If you are available to work at any time during the day, select Full day.

4. Click Add to add the new availability to the request.
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5. You can optionally select a currently configured availability day or time in the Update current avail-
ability list and click Remove to remove it from the list.

NOTE: The Add button is for adding new availability to the Update current availability list only and not 
for replacing specific dates and times from the currently configured availability list.

6. Optionally, under Employee note, add a note to accompany your request.

7. Click Accept.

The Confirm availability change window displays.
8. Specify the date that your requested availability will take effect.

9. Click Submit.

Employee Portal and Supervisors

Using Employee Portal, supervisors can 
• View employee scheduling requests
• Preview the effect of approving or denying employee shift change requests
• Approve or deny employee proposals to take or trade shifts
• Approve or deny employee requests for time off
• Approve or deny employee requests for availability changes

Handling employee scheduling requests

NOTE: If you attempt to approve an employee's request for time off for a period where a schedule has yet 
to be built, time off will not be decremented properly and the time off will be entered as an unavailable 
event in the schedule.
To view, approve, or deny employee scheduling requests
1. Open Workforce Scheduling.
2. Log on to Workforce Scheduling.

3. Load an active schedule.

4. Click the Employee Portal tab.

5. Click the Request mode icon.

6. In the details pane, click the Shift changes,Time off, and Availability tabs to view any employee 
scheduling requests pending your approval.

7. Next to Approve, click the + to view the scheduling request details.

8. If you are viewing the Shift change tab, click View timebar to view the scheduled shift.

9. In the Employee requests group, click Preview to view the effect of approving the request.

10. In the Employee requests group,

– Click Approve to approve the request.
– Click Deny to deny the request.

The schedule is automatically updated and employees are notified of the schedule request status.
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Running Employee Portal reports

The Employee Portal reports are produced in Microsoft Excel format. You run and print the following 
Employee Portal reports from CCMWeb. For more information, see the Reports Guide appropriate to your 
MiContact Center Business licensing level.
The following reports are available with Employee Portal:
• Employee Portal Availability Requests
• Employee Portal Time Off Requests
• Employee Portal Shift Requests
• Employee Portal Shift Change Status

Employee Portal reports are found in the CCMWeb, underReporter > Workforce Scheduling > 
Employee Portal.

Posting feedback and viewing our forums
Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on https://micon-
tactcenter.uservoice.com. When you post an idea to our feedback forum, others will be able to subscribe 
to it and make comments.
Our forums enable you to send feedback directly to the people building the product. While we cannot 
comment on every suggestion, feedback is analyzed and considered for future releases.
NOTE: Please do not use the forums to submit product defects. To submit product defects, please contact 
your administrator or dealer.
Feedback can also be submitted directly to Mitel without posting the suggestion on the forums. For more 
general feedback, you can also provide a rating of your experience with MiContact Center Business.
NOTE: Please do not use feedback for requesting customer assistance. For assistance with MiContact 
Center Business, please contact your dealer or Mitel Customer Support.
To post feedback and view our forums 
1. In YourSite Explorer, click File > Feedback.
2. Click Got an idea? Tell us. 

or
Access the following URL: https://micontactcenter.uservoice.com.

To submit feedback directly 
1. In YourSite Explorer, click File > Feedback.
2. Click Contact Us.

To rate your Mitel experience 
1. In YourSite Explorer, click File > Feedback.
2. Click Rate us.

https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
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Managing a Multimedia Contact Center

Mitel Multimedia Contact Center enables contact centers to handle email, chat, SMS, and open media 
interactions from customers. Agents handle voice, email, chat, SMS, and open media interactions using 
Ignite.
Within Ignite, agents and supervisors can monitor contact center activity and interactively manage inter-
actions. Supervisors can monitor and interact with contacts and employees using Contact Center Client, 
Interactive Contact Center, and Interactive Visual Queue.
Multimedia interactions are routed using workflows, created using a visual, intuitive interface. Also 
included in Multimedia Contact Center is a Contact Us page that can be used by contact center website 
administrators to add live wait time statistics to their corporate website page, enabling customers to select 
their preferred communication method based on media type availability. Multimedia reports and charts 
provide valuable information by summarizing agent, employee, queue, and contact center performance.
To know more about how to manage a multimedia Contact Center, see Multimedia Contact Center Instal-
lation and Deployment Guide.

System Administrators - Installing, configuring, and main-
taining a multimedia contact center
System Administrators are responsible for upgrading their contact center to the latest release and for 
configuring all devices to ensure the business can run smoothly and efficiently.
MiContact Center version 7.0 introduced a new multimedia contact center product that eases configura-
tion. Routing of contacts is optimized through the use of visual workflows. Visual workflow configuration 
presents contact routing elements in an intuitive user interface. Using a drag and drop process, workflows 
can be customized to suit the individual needs of your contact center.
NOTE: 
• As a best practice, system administrators should always apply the latest Windows component updates 

are to all servers and client machines. For more information on updating Windows products, consult 
Microsoft documentation.

• For MiContact Center Business/MiVoice Analytics, the enterprise server should not be installed on a 
publicly accessible network.

Fax and Historical SMS limitations

In Version 8.1, fax is supported as an email media type. However, when you upgrade to Version 8.1, if 
you need access to historical fax reports, you must generate such reports prior to upgrading as you will 
not be able to do so afterward.
Incoming fax capability can be implemented in Version 8.1 by using email attachments for fax delivery. 
For more information, see the Mitel Knowledge Base article located here: http://micc.mitel.com/kb/Knowl-
edgebaseArticle51941.aspx
SMS is supported in 8.0+. Historical SMS data from a pre-8.0 instance of Multimedia Contact Center will 
be available after an upgrade because in previous versions SMS was treated as email.
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Upgrading your multimedia contact center to MiContact 
Center Business version 9.2
The following versions are supported for upgrade to Version .9.2
• Version 8.1.x
• Version 8.0.x
• Version 7.1.3.3

When upgrading from MiContact Center version 7.x or 8.x to MiContact Center Business version 9.2 
cases are automatically created for emails (beginning with the most recent email and ending with the 
oldest email). Emails that are associated to a particular customer interaction are grouped within a single 
case to consolidate information.
In addition, contact information based on historic emails is added to the MiContact Center Business data-
base. For MiContact Center version 8.1 customers who implemented the Omni Channel Tech Preview 
cases are also created for SMS and Chat during an upgrade to MiContact Center Business version 9.2.

Upgrading - A simplified process

Version 7.0 introduced Simplified Configuration, a tool designed to ease the upgrade process and limit 
manual intervention while ensuring your existing configuration of agents, employees, and queues remains 
intact.
Simplified Configuration reduces Multimedia Contact Center setup time significantly but requires that the 
voice only portion of the system be configured first. The voice organization is used by Simplified Config-
uration as a template for enabling multimedia functionality.
The Simplified Configuration process creates Unified Queue Groups, which are used to organize queue 
and agent groups by the service for which they answer contacts. For example, a Unified Queue Group for 
the Sales department would contain only those queue and agent groups that handle Sales related 
contacts, either by email, chat, SMS, or open media. Unified Queue Groups are based on a service group, 
not on the media type handled. Unified Queue Groups can contain queues of any supported media type. 
Agent groups can contain agents of any supported media type.
NOTE: The Simplified Configuration feature is not available in the Version 8.0+ installer. Using this feature 
decreases the time spent upgrading and simplifies multimedia device configuration by auto-creating 
devices based on the current setup for voice. Upgrading from Version 6.0.3.0 to Version 7.1 before 
upgrading to Version 8.0+ enables you to take advantage of the Simplified Configuration option in the 
Version 7.1 installer.

Upgrade scenarios

This section of the guide describes upgrading from either a voice-only contact center or a contact center 
that is enabled for both voice and multimedia.

Upgrade methods

You can choose to either upgrade directly onto your current system or provision a new server and 
upgrade in a side by side fashion.
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Direct upgrades

Direct upgrades are supported when upgrading from Version 7.0.x, or 7.1.x, or 8.0.x to Version 8.1.
Due to the significant architectural changes introduced in Version 7.0, we strongly recommend using a 
side by side migration method when upgrading from Version 6.0.3.0 to Version 7.1. This will help ensure 
a smooth transition as well as reducing setup time and minimizing downtime during and following the 
upgrade.
If you choose to upgrade on top of an existing Version 6.0.3.0 server, please note the following:
In a direct upgrade, Version 7.1 is installed onto your existing Version 6.0.3.0 server. This method
In a direct upgrade, there are post-upgrade steps that must be completed before you will regain full Multi-
media Contact Center functionality. Multimedia Contact Center functionality is lost while you configure 
your new email settings. See "Creating mail servers" and "Configuring the email media server" for more 
information. If your contact center hosted chat configuration files on your corporate web server, you must 
enable chat to use them. See "Hosting chat files on your corporate web server" for more information.
If you currently use Multimedia Contact Center and choose to upgrade using your existing Version 6.0.3.0 
server, you will be given the choice during the upgrade to either migrate your existing multimedia config-
uration or program the new multimedia portion of the software manually. Programming the multimedia 
software manually enables you to take advantage of the configuration options included with Version 7.1.

Side by side Migration

In a side by side migration, a new Enterprise Server is created, separate from the current production 
Enterprise Server. This recommended practice facilitates thorough testing and staged client updates and 
supports rollback, if required, by retaining the old platform.
A side by side migration carries the lowest level of risk in upgrading but may require purchasing additional 
hardware depending on your current configuration.
Additional licensing is not required when running a second Enterprise Server for the purposes of migration 
or to create a sandbox environment. To mitigate risk, consult a certified technician before configuring a 
second server. Once a license has been migrated, support will be provided for the latest release only. 
Support will not be provided for the older server with the previous release or the sandbox server.
A side by side migration is strongly recommended when upgrading an environment that currently uses 
voice and other media types. With a direct upgrade, Multimedia Contact Center functionality is lost while 
you configure your new email settings. In a side by side migration, where you install the new version on 
a new server, this situation is mitigated. There is only a temporary loss of functionality when you move 
your live data from the old system to the new system.
In a side by side upgrade, contact centers must implement a new version 8.1 Chat or Contact Us config-
uration using the new files in version 8.1 and add their previous chat and Contact Us settings to the 8.1 
files. For information on Chat and Contact Us configuration, see "Enabling chat" and "Enabling Contact 
Us".
After restoring the configuration backup to the new server, data collection, synchronization, and voice 
contact control on the production PBXs begins. This ensures a minimal gap in reporting data. If the data 
directory is copied and the database restored outside of business hours, there is no reporting data gap.
Synchronization is enabled and changes to the telephone system will be reflected in both the new and 
production servers after the maintenance cycle or upon completion of a manual summarization. If write 
back is enabled, settings take effect on the other server only after synchronization is complete.
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We recommend testing your new configuration by creating a test email queue, a test chat queue, a test 
SMS queue, and a test agent on the new server and validating that email, chat, SMS, and open media 
are being correctly routed to queues and agents. Run reports to verify accuracy. Confirm that email 
aliases or distribution groups and URL redirects for chat have been correctly implemented.
In a side by side migration, once the new server is installed and all of the devices configured we recom-
mend you then proceed to upgrade one client and ensure the system is functioning correctly before 
upgrading all other clients. If you choose to upgrade on top of your current system, the clients are auto-
matically updated during the upgrade process.
Consider the following notes regarding a side by side migration: 
• By default, MiVoice Business supports three ACD and three SMDR connections to the same PBX. The 

existing system and the new system use one ACD and one SMDR connection each. When migrating 
servers, data collection will resume on the new server upon restoration of the configuration backup. As 
a result, two connections to the SMDR and ACD ports will be used until one of the servers has been 
decommissioned. Ensure the number of connected devices to these ports does not exceed three per 
IP port. 

NOTE: MiVoice Business supports 3 ICP connections by default, but the number of supported ICP 
connections can be increased. Exceeding the number of supported connections will impact the 
collection of data on the server.

• When using voice contact control through MiContact Center Business for business hours queues may 
be closed by the new server if business hours are reconfigured. To ensure no voice contact control is 
performed until testing or migration, stop the MiContact Center Business MiTAI Proxy Server service 
on the Enterprise Server.

• You must ensure queue schedules are identical on both systems.
• Reporting discrepancies can occur due to differences between software versions or if data collection 

is interrupted.
• IVR Routing services must be shut off on the new server until you are ready to switch over or assign 

new ports.

For more information, see 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1011100/loc/en_US.

Multimedia Contact Center backup and restore recommendations

We recommend backing up Enterprise Server data on a regular basis as a preventive measure in case 
of events that could cause loss of data and necessitate system restoration. The frequency of backups 
depends on how important the data is to your business. If losing one week of data is acceptable, then 
backing up once a week is sufficient. If losing more than one day of data is unacceptable, then a daily 
backup strategy should be implemented.
NOTE: We strongly recommend storing backup files in a location outside of the Enterprise Server in order 
to maintain essential data in the case of a hardware failure or catastrophic event.
The following data files must be considered:
• YourSite Database configuration data files – These files contain all device configuration for your 

contact center (including IVR Routing and Multimedia Contact Center workflows and prompts) and are 
backed up automatically during nightly maintenance. They are located in the SQL Server database as 
part of the CCMData files. During nightly maintenance, the data is backed up as an .xml file and 
retained for the last 30 days, enabling you to restore a previous configuration if necessary. You can 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1011100/loc/en_US
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also backup configuration data manually using the Backup and Restore Wizard in Contact Center 
Client.

• Raw data files – These files contain all raw data from the media servers, including ACD and SMDR 
historical data and a flat file multimedia repository for all media, excluding voice. The multimedia repos-
itory stores multimedia messages and SMS and chat transcripts. These files are not backed up during 
nightly maintenance and must be backed up manually using your corporate backup solution.

• Reply template data files – These files include the packaged responses for email, chat, SMS, and 
open media. The reply template data files from the default folder and all user-specified folders are 
backed up automatically during nightly maintenance. Reply template data files are also included in 
manual backups using the Backup and Restore Wizard in Contact Center Client.

• SQL Server data files (CCMData and CCMStatisticalData) – The data that is stored in the SQL 
Server database is not automatically backed up during nightly maintenance. Consult Microsoft docu-
mentation for more information regarding backup and restore processes.

Following is a list of folders and locations for data that should be backed up using your corporate backup 
solution. Suggested backup tools include Symantec Backup Exec and Microsoft System Center Data 
Protection Manager:
• Configuration backups: <drive>:\Program Files (x86)\Mitel\MiContact Center Business\BackupFiles

This folder contains the nightly .xml backups of configuration data and IVR Routing and Multimedia 
Contact Center workflows and prompts that are created during nightly maintenance.

• Raw data: <drive>:\Program Files (x86)\Mitel\MiContact Center Business\DataDirectory
This folder stores all raw data from the media servers. Using this data you can re-summarize your raw 
data to enable reporting. This folder also contains the multimedia repository for all media, excluding 
voice.

To restore your system with the backed up data, you must stop the MiContact Center Business services 
and use the backup tools to restore the folders that you previously backed up. After these folders have 
been restored, restart the MiContact Center Business services. For more information, see "Restoring tele-
phone system and configuration data".

Pre-upgrade notes and planning

Version 9.2 is supported for use with 64-bit server-side and client-side Operating Systems.
Some manual device configuration is requiredfor those devices that were introduced in version 7.0 and 
version 8.1. We recommend you gather the following information before beginning the upgrade process: 
• Mail server name
• IMAP port information for the mail server
• Email username and password for each mail server
• SMTP Server for email replies
• Chat URL (the public URL used to request a chat)
• Twilio SMS phone numbers, Account SID, and Account Authentication for SMS media servers
• Interflow configuration if required
• Customized in business or out of business auto-acknowledgment messages

CRM 2007 is not supported with version 9.1. If workflows contain Execute activities that point to CRM 
2007, the preinstall checker will stop the upgrade. Microsoft CRM 2011 and 2013 are supported for use 
with Mi Contact Center Business version 9.1.
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Prior to upgrading, we recommend you consider the following regarding chat: 
• Choose the corporate web pages on which you want the Contact Us page to display 

– Determine what service(s), contact information, and business hours to display
– Determine whether a chat request from this page needs to route to a specific queue
– Customize the page to suit the look and feel of your current website

• Before upgrading, integrate the chat request(s) and/or the Contact Us page onto your corporate 
website. We recommend setting up a temporary chat unavailable page, as chat will be unavailable 
during the upgrade.

Hardware and software server and client specifications

For information regarding hardware and software server and client specifications, and for information 
regarding virtualization support, see the MiContact Center Business and MiVoice Analytics System Engi-
neering Guide  .

Upgrading a voice-only system

When upgrading a voice-only system, your current voice organization forms the basis for adding multi-
media. The employees, queues, and agent groups within your voice organization are extended to handle 
multimedia.– in version 7.0 and 7.1 this includes email and chat. Support for SMS was added in version 
8.1.
Employees handling inbound interactions for each service organization can be enabled to handle email, 
chat, SMS, and open media. Agent groups handling interactions for a service organization can be 
expanded to handle email, chat, SMS, and open media for the same service. Each voice queue repre-
senting a service organization will be contained within a Unified Queue Group to which email, chat, SMS, 
and open media queues are added. The Unified Queue Groups represent each service organization and 
route any media inbound interaction intended for that particular service.
NOTE: Unified Queue Groups are optional. You can alternatively use standard queue groups, depending 
on your business organization and needs.
The following steps must be followed to successfully upgrade a voice-only system: 
1. Adhere to all pre-upgrade planning notes. 

See "Pre-upgrade notes and planning".
2. Ensure all hardware and software specifications are met for the server and clients. 

See the MiContact Center Business and MiVoice Analytics System Engineering Guide for specifica-
tion details.

3. Migrate SQL databases. (Side by side migration method only) 

See "Migrating SQL databases".
4. Back up telephone system and configuration data. 

See "Backing up telephone system and configuration data".
5. Install MiContact Center Business version 9.2 on the Enterprise Server. 

See "Enterprise Server installation".
6. Restore telephone system and configuration data. 

See "Restoring telephone system and configuration data".
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7. Configure the multimedia system: Create mail servers, add email media servers, add chat media 
servers, add SMS media servers, enable employees for multimedia, define employee Workload, add 
agent groups and set default login agent group presence, add multimedia queues, create queue 
groups, modify default inbound, response, and Inqueue workflows, and convert to visual workflow 
routing. 

See "Configuring a multimedia system".
8. Install client applications on employee desktops. 

See "Installing client applications".

Migrating SQL databases

Please note that this section relates only to a side by side migration upgrade method.
Before upgrading, we recommend migrating the SQL databases, CCMdata and CCMStatisticalData, to 
the new server. By doing so, the installation configuration wizard will update the database schema when 
the new software version is installed.
Migrating the SQL databases enables you to preserve your previous reporting data. If you do not migrate 
the SQL databases, a new database will be created to which you can copy over the raw data, restore the 
database from the backup files, and, then, re-summarize the data. However, the data you will be 
re-summarizing will be for the current configuration so the reporting data may not match that of your 
previous system.
The two most common methods for migrating SQL databases are:
• Dropping the database files from the SQL instance and making a physical copy of the .mdf and .ldf files
• Using SQL Server Management tools to generate backup files or scripts

See the applicable Microsoft documentation for more information on migrating SQL databases.
To migrate SQL databases
1. Copy the SQL database .mdf and .ldf files or use MS SQL Server Management tools to make backup 

files or scripts.
2. Provision a new SQL server or new instance of SQL server.

3. Restore the SQL databases to the new SQL server or instance of SQL server.

Backing up telephone system and configuration data

Before installing the new version of software on the designated new server, you must back up telephone 
system and configuration data on the old Enterprise Server. If you are installing on top of an existing 
Enterprise Server, store the backup files in a location outside of the Enterprise Server in order to maintain 
essential data in the case of a hardware failure or catastrophic event.
The Enterprise Server configuration backup includes configuration items such as employees, agents, 
agent groups, queues, and security roles.
NOTE: You must be licensed as a System Administrator to back up telephone system and configuration 
data.
To back up telephone system and configuration data
1. In Contact Center Client, click Tools > Management.
2. In Management Console, click Configuration > Back up/Restore configuration data.

3. Select Back up and click Next.
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4. Next to Save, click the drop-down button and select Save as.

5. Select a location to save the file and click Save.

6. Close the View Downloads window and, in the Backup and Restore Wizard, click Finish.

A .zip file is created that contains an XML file with the entire configuration. The file size will vary de-
pending on the amount of data that needs to be backed up, but will typically be between 1 and 20 MB. 
This .zip file name contains the date on which the file was created. For example, a backup file created 
on June 24, 2015 will contain ‘20150624’.

Enterprise Server installation

Install version 9.2 on the existing Enterprise Server (direct upgrade) or on the designated Enterprise 
Server (side by side upgrade). See the 'Enterprise Server installation' section in the MiContact Center 
Business Installation and Administration Guide.

Restoring telephone system and configuration data

After installing the new version of software on the existing Enterprise Server (direct upgrade) or on the 
designated Enterprise Server (side by side upgrade), restore the previously backed-up data from the loca-
tion where it was stored (direct upgrade) or from the old server to the new server (side by side upgrade). 
NOTE: Remote restores are not supported.

To restore telephone system and configuration data 
1. In Contact Center Client, click Tools > Management.
2. In Management Console, click Configuration > Back up/Restore configuration data .

3. Select Restore.

4. To restore a file from the server backup directory, select from the server backup directory, select a 
file, and click Next.

5. To restore a file saved to another location, select from this file > Browse, open the backup file, and 
click Next.

6. When prompted to restart Contact Center Client, click Yes.

7. Optionally, you can synchronize the Enterprise Server’s IP address and computer name after 
restoring data. Do so by selecting the appropriate check box and entering the Enterprise Server’s IP 
address in the field provided.

After restoring a backup, check the IP addresses configured in YourSite Explorer and the computer 
names associated to all media servers to ensure the local media servers are set to the local server 
nameand remote collectors are also set correctly.

Configuring a multimedia system

To enable your voice-only contact center to handle other media types, you must configure devices and 
components within YourSite Explorer in the following order:
1. Create mail servers
2. Add email media servers

3. Add chat media servers
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4. Add SMS media servers

5. Add open media media servers

6. Enable employees for multimedia

7. Define employee Workload

8. Add agent groups and set default login agent group presence

9. Add multimedia queues

10. Create queue groups

11. Modify default inbound, response, and Inqueue workflows

12. Convert to visual workflow routing

Creating mail servers

Email media servers require one or more mail servers to be configured. A mail server is used to receive 
and send mails to the corporate mail server and defines the IMAP connection to a single email account. 
Email aliases or distribution groups, depending on the mail server type, are used to associate multiple 
email addresses for the contact center to a single email account. This minimizes the number of mail 
servers required.
After creating a mail server, we recommend using the test button to verify both the SMTP and mail server 
are connected.
For more information and configuration details, see "Integrating Multimedia Contact Center with mail".

Adding Email media servers

Media servers must be created for each media type supported by your contact center. Optionally, each 
media server is assigned a default Inbound workflow that you configure to route inbound interactions to 
designated endpoints.
For media server configuration details, see "Adding email to Multimedia Contact Center".

Adding Chat media servers

Media servers must be created for each media type supported by your contact center. Each media server 
is assigned a default Inbound workflow that you configure to route inbound interactions to designated 
endpoints.
Chat media servers require the chat server URL and auto-response username to be specified. The chat 
server URL is the public URL invoked when a customer requests a chat. When a chat server URL is 
configured, the system performs an auto test to determine if the URL redirect is properly configured.
For more information and configuration details, see "Adding chat to Multimedia Contact Center".

Adding SMS media servers

Media servers must be created for each media type supported by your contact center. Each media server 
is assigned a default Inbound workflow that you configure to route inbound interactions to designated 
endpoints.
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To send and receive SMS interactions, SMS media servers require an SMS Gateway Provider. Multi-
media Contact Center supports Twilio as an SMS Gateway Provider. You must have a Twilio account to 
add SMS handling capabilities to Multimedia Contact Center.
For more information on integrating with an SMS Gateway Provider, see "Integrating Multimedia Contact 
Center with an SMS Gateway Provider". For information on configuring an SMS media server, see 
"Adding SMS to Multimedia Contact Center".

Enabling employees for multimedia

You enable employees for multimedia by assigning the appropriate licensing and adding multimedia 
capabilities to existing voice-only employees.
For additional information and configuration details, see "Adding multimedia capabilities to employees".
To enable employees for multimedia
1. Use the multi-select method to select the employees who will be upgraded to Multimedia Contact 

Center licensing.
2. Click the General tab and enable employees for the media their agents will support.

Additional agents are created for the media specified. The agent uses the same name and reporting 
number as the employee.
Agents that are newly created in the Employee device page will only be added to the employee's 
agent group if the employee's agent groups are enabled for the relevant media type and the Unified 
Queue Group Wizard is used.

3. Click Save.

Defining employee workload

A Workload descriptor, which determines the number and type of media interactions that can be pushed 
to an agent at any one time, must be assigned to each employee. If needed, refer to the notes regarding 
contact priority and Smart Algorithms that you were advised to make in the pre-upgrade notes and plan-
ning section of this document as a guide when defining Workloads.
During the upgrade, default Workloads are created and assigned to existing employees who are licensed 
for Multimedia Contact Center. Newly created employees must have Workloads manually assigned to 
them. You can also choose to create customized Workloads and assign them to employees, rather than 
using the included, default Workloads.
For information on defining employee Workload, see "Managing Employee Workload". For information on 
configuring Workloads, see "Configuring Workload".

Adding agent groups

No additional agent groups are required to enable voice-only employees for multimedia. As part of Simpli-
fied Configuration, existing voice agent groups are automatically enabled for multimedia during the 
upgrade, if the Unified Queue Group Wizard is used.
If you have agents who handle non-voice media interactions only, you will need to add agent groups 
accordingly.
You add agent groups and then associate employees to these groups.
Agent group presence, previously only available to voice agents, is now also available for multimedia 
agents. Agents and supervisors can adjust a member’s presence in an agent group. By default, on login, 
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agents are present in all of their agent groups. You can adjust this setting in the Agent group device page 
of YourSite Explorer. See "Managing agent group membership, presence, and skill level".
For more information and configuration details, see "Adding agent groups" in the "Configuring your multi-
media contact center" section of this guide.

Adding multimedia queues

When you create a multimedia queue, it is automatically associated to the existing media server for that 
media type.
If you use the Unified Queue Group Wizard, you do not need to add multimedia queues. Voice queues 
will be used by the Unified Queue Group Wizard as the basis for creating Unified queue groups that will 
handle all inbound interactions for a service group.
For more information and configuration details, see "Adding multimedia queues" in the 'Configuring your 
multimedia contact center' section of this guide.

Creating queue groups

Administrators can group queues for common purposes. There are three kinds of queue groups available: 
Reporting, Mitel Virtual, and Unified Queue Groups.
Unified Queue Groups are used to enable the media queues for a service organization to be grouped 
together. They are called ‘Unified’ Queue Groups because they unify a group of media queues, for 
example, email, chat, SMS, and open media, that handle interactions for a service group (i.e., Sales or 
Customer Support) within a business.
The Unified Queue Group wizard uses current voice queues to represent the service groups that will be 
expanded to handle multimedia. The System Administrator is asked to select voice queues and the media 
types that are to be enabled in the organization. The wizard then uses the voice queue name and 
reporting ID to create media queues, with the same name and reporting ID, and groups them into a Unified 
Queue Group. Each media queue is assigned a default Inqueue workflow.
NOTE: 
• Unified Queue Groups are restricted to one media queue for each type of media.
• Individual queue priorities are used to specify the priority for media and queue routing. The default 

priority assigned is 64.
• Default Inqueue workflows have four levels of offer to agent group activities (to support multiple over-

flow conditions). The wizard populates the default Inqueue workflows with the same agent group order 
used by the voice queue member of the Unified Queue Group.

• Unified Queue Groups are optional. If you choose not to use them, then you must create individual 
email, chat, SMS, and open media queues and enable agent groups for multimedia.

For more information and configuration details, see "Adding queue groups".

Modifying default Inbound, Response, and Inqueue workflows

NOTE: There is no default email response workflow.
During the upgrade, a default response workflow is assigned to relevant media servers. Default Inqueue 
workflows are assigned to each media queue. You can choose whether to enable default Inbound work-
flows on the Media Server configuration page in YourSite Explorer.
The default workflows must be modified after the upgrade, as follows:
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• Typical Inbound workflow modifications include:
– Emails: modifying the email address and destination queues
– Chat: modifying the queue ID and destination queues
– SMS: No modifications are required, but queue ID and destination queues can be modified

• Typical Response workflow modifications include:
– Sending chat transcripts to clients

• Typical Inqueue workflow modifications include:
– Associating the handling agent groups to the queue
– Customizing the auto-acknowledgment messages

For more information, see "Multimedia Contact Center default workflows".

Converting to visual workflow routing

When upgrading from version 6.0.3.0 to version 7.1, you have the option of converting to visual workflow 
routing. Visual workflow routing directs incoming interactions to queues and agent groups via routing 
rules, which are determined by Inbound and Inqueue workflows.
The first step in converting to visual workflow routing is enabling inbound routing for your media servers. 
Enabling inbound routing associates the appropriate default Inbound workflow to the server. Administra-
tors can modify these default workflows to suit the contact center’s needs.
The following explains how to convert to visual workflow routing by enabling the Inbound Routing tab on 
YourSite Explorer’s Media Servers page. For more information on working with visual workflows and 
applying routing rules to interactions, see:
• "Multimedia routing using visual workflows"
• "Multimedia Contact Center default workflows"

NOTE: If version 6.0.3.0 customers upgrading to a version 7.1 system do not convert to visual workflow 
routing via the following procedure, multimedia interactions will continue to route directly to queues 
without routing rules applied through Inbound workflows. In cases where inbound interactions have 
multiple addresses in the To and/or CC fields, the interaction will only be routed by the first address in the 
To field.
To apply inbound routing rules to interactions
1. Select Multimedia > Media servers and select the media server.
2. Click the Inbound tab.

The default Inbound workflow will be applied to your media server.
NOTE: If you do not want to convert to visual workflow routing, do not save the media server.

Installing client applications

Before performing client installations, ensure the hardware and software requirements are met. See the 
MiContact Center Business and MiVoice Analytics System Engineering Guide for specification details.

Running the Client Role Selector and installing Ignite (DESKTOP)

The MiContact Center Business client installation includes the Client Role Selector. Within the Client Role 
Selector, you choose the applications and components of MiContact Center Business that you want to 
install on the desktop. In order to install Ignite (DESKTOP), an application that enables employees to 
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handle multimedia interactions, you must select it from the list of available options in the Client Role 
Selector window.

Upgrading a system that currently includes voice and multimedia

This section describes upgrading an existing voice and multimedia contact center to version 9.2.

Installation options

In Version 6.0.3.0, service groups are organized using unique agent groups per media type. As of Version 
7.0, Unified Queue Groups can be created for each service organization. Unified Queue Groups can 
contain queues for each media type and a single agent group assigned to all of the queues. During the 
upgrade this reorganization does not happen automatically.
At the beginning of the upgrade from Version 6.0.3.0 to Version 7.1, the install wizard offers the option of 
the recommended normal upgrade or manually creating your Multimedia Contact Center Version 7.1 
configuration from scratch. Read further to learn about the advantages of each choice.
If you select the recommended normal upgrade option, the installation wizard will not attempt to create 
new agent IDs, agent groups, and queues. Such configuration must be done following the upgrade. The 
advantage of choosing manual configuration is that it enables you to use the Simplified Configuration tool. 
Simplified Configuration eases the configuration process by creating blended queues and agent groups 
around each service group. It uses the already existing voice system as a base from which to enable 
multimedia. After the Simplified Configuration process is complete, each service group in the organization 
will have a Unified Queue Group that contains the media queues supporting the service group and a 
blended agent group(s) containing all of the employees who provide support for the service group. If 
another media type is required for a service group, another media queue can be added to the Unified 
Queue Group and the employees who are members of the agent group can be enabled for the additional 
media type.
CAUTION: We do not recommend manually upgrading as doing so requires devices to be reconfigured. If 
you choose to upgrade manually instead of auto-upgrading, your existing devices will be designated as 
historical and you will need to create new ones.
If you select to manually configure your Multimedia Contact Center, all of your existing devices will be 
designated as historical. New agent devices, agent groups, and queues will be auto-created to align as 
well as possible with your pre-existing configuration settings and routing behavior. After the upgrade it 
may be necessary to adjust device configuration, for example, you may want to consolidate agent groups 
or create Unified Queue Groups, to better align with the new model of Multimedia Contact Center. The 
advantage of choosing auto-upgrade is that it is faster than the manual upgrade. If you want to re-enable 
your system quickly to minimize downtime and do more refined configuration later, then this may be the 
best choice for you.
NOTE: The Simplified Configuration feature is only applicable to upgrades from Version 6.0.3.0.

Addition of default workflows

During the upgrade, Response and Inqueue workflows are added. Optionally, Inbound workflows can be 
enabled on the email media server device configuration page in YourSite Explorer. Inqueue workflows 
control the routing of queued contacts to agents. The database conversion installs default Inqueue work-
flows for each queue. By default, each Inqueue workflow supports one primary, three overflow, and one 
interflow group (to be used if the overflow groups fail to route). Whenever possible, workflow data is 
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auto-filled to reduce the upgrade effort. To avoid the need to reconfigure Inbound workflows, the existing 
routing configuration that media servers use to route to queues is applied.

Maintaining historical data

During the upgrade from Version 6.0.3.0 to Version 7.1, all pre-existing multimedia media servers are 
designated as historical. All queues, agent groups, and agents associated to the multimedia media 
servers are, consequently, also designated as historical.
The Summarize process has been modified to regenerate data for historical agents if the employee asso-
ciated to the agents remains licensed for Multimedia Contact Center. This ensures all pertinent historical 
agent records continue to be accessible.
• During the upgrade, device reporting numbers may change. For example, if you choose the 

auto-upgrade option, similar groups will be automatically aligned, potentially altering their reporting 
numbers. This will affect your report data interpretation.

• After upgrading to Version 7.1, all multimedia reports will be generated from the new devices on the 
active media servers. If you want to run pre-upgrade multimedia reports, their data must be generated 
from the historical media servers. You cannot consolidate historical and new data into a single report.

Migrating the email repository

To enable archived email searches following the upgrade, you must migrate your old emails by copying 
the Multimedia Contact Center Exchange Repository from the old system to the flat file repository on your 
new system.
NOTE: This section is only applicable if you are upgrading from Version 6.0.3.0.
To migrate the email repository
1. Navigate to C:\Program Files (x86)\Mitel\Mi Contact Center Business\DataDirectory, create two 

folders, and name them 'Originals' and 'Replies'.
2. Within Outlook, access the MCC Exchange repository and drag and drop (copy) the mail contents 

from FoldersPublic FoldersCyberAEDRepositoryOriginals and FoldersPublic FoldersCyberAEDRe-
positoryReplies into the matching folders you created in step 1.

3. After the contents have been copied over, stop and start the MiContact Center Storage service.

4. Stopping and starting the Storage Service initiates the Repository Conversion tool. The Repository 
Conversion tool enables email compatibility with the updated Multimedia Contact Center search tool. 
The Conversion Tool converts and moves all mail items to two new folders: 'ProcessedOriginal' and 
'ProcessedReply', for original and reply items respectively. After the conversion is complete, the items 
are moved to the 'SearchStorage' folder. You can delete the 'ProcessedOriginal' and 'Processe-
dReply' folders after confirming all Exchange repository items have been successfully moved to the 
search repository.

Migrating the email repository can be quite time consuming. Depending on the number of items being 
moved, this process may take several hours. Migration must take place after the upgrade is finished as 
the C:\Program Files (x86)\Mitel and SearchStorage folders must be created before the migration can 
occur. You will be able to run Multimedia Contact Center while migrating the email repository. Any histor-
ical data that resides in Exchange will not be accessible from Ignite for searching purposes until the migra-
tion is complete.
Migrating the email repository breaks the link with real-time data. If you use preferred agent settings to 
route email, any contacts from before the upgrade will not retain their preferred agent history. To asso-
ciate an agent with a reply, a manual search of SMDR records will be required.
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Upgrade process recommendations

The following steps must be followed to successfully upgrade an existing voice and multimedia system: 
1. Adhere to all pre-upgrade planning notes. 

See "Pre-upgrade notes and planning".
2. Ensure all hardware and software specifications are met for the server and clients. 

See the MiContact Center Business and MiVoice Analytics System Engineering Guide for specifica-
tion details.

3. Migrate SQL databases. (Side by side migration method only) 

See "Migrating SQL databases".
4. Back up telephone system and configuration data. 

See "Backing up telephone system and configuration data".
5. Install Mi Contact Center Business version 9.2 on the Enterprise Server. 

See "Enterprise Server installation".
6. Restore telephone system and configuration data. 

See "Restoring telephone system and configuration data".
7. Migrate existing emails from SearchStorage to Elasticsearch. 

See "Migrating existing emails from SearchStorage to Elasticsearch".
8. Configure devices. 

See "Configuring devices".
9. Install client applications on employee desktops. 

See "Installing client applications".

CPU utilization when migrating multimedia messages to Elasticsearch

During upgrades, the installer migrates in-queue and in-progress multimedia messages to Elasticsearch. 
This migration uses a large share of the processor resources and, as such, may adversely affect system 
stability for Remote Desktop Sessions. After the migration process is complete, the installation continues 
and processor resources return to normal consumption levels.
NOTE: If system monitoring or management systems are configured to alarm on high resource utilization, 
a false flag may present during upgrades.
After installation is complete, multimedia interactions continue to be processed in the background and 
placed into the Elasticsearch archive. Multimedia messages are not searchable via Ignite until the 
message has been archived. Messages are archived, beginning with the most recent interactions, at a 
rate of approximately 8000 items per hour. The processing rate depends on your processor, available 
system resources, and number of historical multimedia interactions to be migrated.
Migration speed can be decreased if the server is under high load and you want to prioritize production 
operations. Migration speed should only be decreased if the system is in a high performance production 
environment and there is no immediate need to search older archived items. Default settings should 
provide appropriate performance for the majority of multimedia implementations. For information 
regarding modifying migration speed, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002083/loc/en_US.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1002083/loc/en_US
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Migrating SQL databases

Please note that this section relates only to a side by side migration upgrade method.
Before upgrading, we recommend migrating the SQL database to the new server. By doing so, the instal-
lation configuration wizard will update the database schema when the new version of software is installed.
Migrating the SQL databases enables you to preserve your previous reporting data. If you do not migrate 
the SQL databases, a new database will be created to which you can copy over the raw data, restore the 
database from the backup files, and, then, re-summarize the data. However, the data you will be 
re-summarizing will be for the current configuration so the reporting data may not match that of your 
previous system.
The two most common methods for migrating SQL databases are:
• Dropping the database files from the SQL instance and making a physical copy of the .mdf and .ldf files
• Using SQL Server Management tools to generate backup files or scripts

See the applicable Microsoft documentation for more information on migrating SQL databases.
To migrate SQL databases
1. Copy the SQL database .mdf and .ldf files or use MS SQL Server Management tools to make backup 

files or scripts.
The SQL databases are CCMData and CCMStatisticalData.

2. Provision a new SQL server or new instance of SQL server.

3. Restore the SQL databases to the new SQL server or instance of SQL server.

Backing up telephone system and configuration data

Before installing the new version of software on the designated new server, you must back up telephone 
system and configuration data on the old Enterprise Server. If you are installing on top of an existing 
Enterprise Server, store the backup files in a location outside of the Enterprise Server in order to maintain 
essential data in the case of a hardware failure or catastrophic event.
The Enterprise Server configuration backup includes configuration items such as employees, agents, 
agent groups, queues, and security roles.
NOTE: You must be licensed as a System Administrator to back up telephone system and configuration 
data.
To back up telephone system and configuration data
1. In Contact Center Client, click Tools > Management.
2. In Management Console, click Configuration > Back up/Restore configuration data.

3. Select Back up and click Next.

4. Next to Save, click the drop-down button and select Save as.

5. Select a location to save the file and click Save.

6. Close the View Downloads window and, in the Backup and Restore Wizard, click Finish.

A .zip file is created within which is an XML file that contains the entire configuration. The file size will 
vary depending on the amount of data that needs to be backed up, but will typically be between 1 and 
20 MB. This .zip file name contains the date on which the file was created. For example, a backup file 
created on June 24, 2015 will contain ‘20150624’.
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Enterprise Server installation

Install version 9.2 on the existing Enterprise Server (direct upgrade) or on the designated Enterprise 
Server (side by side upgrade). See the 'Enterprise Server installation' section in the MiContact Center 
Business Installation and Administration Guide.

Restoring telephone system and configuration data

After installing the new version of software on the existing Enterprise Server (direct upgrade) or on the 
designated Enterprise Server (side by side upgrade), restore the previously backed-up data from the loca-
tion where it was stored (direct upgrade) or from the old server to the new server (side by side upgrade). 
NOTE: Remote restores are not supported.

To restore telephone system and configuration data 
1. In Contact Center Client, click Tools > Management.
2. In Management Console, click Configuration > Back up/Restore configuration data .

3. Select Restore.

4. To restore a file from the server backup directory, select from the server backup directory, select a 
file, and click Next.

5. To restore a file saved to another location, select from this file > Browse, open the backup file, and 
click Next.

6. When prompted to restart Contact Center Client, click Yes.

7. Optionally, you can synchronize the Enterprise Server’s IP address and computer name after 
restoring data. Do so by selecting the appropriate check box and entering the Enterprise Server’s IP 
address in the field provided.

After restoring a backup, check the IP addresses configured in YourSite Explorer and the computer 
names associated to all media servers to ensure the local media servers are set to the local server 
nameand remote collectors are also set correctly.

Migrating existing emails from SearchStorage to Elasticsearch

In a side by side migration upgrade from 7.x, after restoring the backup on the new server, you must run 
a migration tool to migrate existing emails from the old SearchStorage directory to Elasticsearch on the 
newly installed version 9.2 Enterprise Server.
To migrate existing interactions in a side by side upgrade scenario
1. On the 8.0+ Enterprise Server, in Windows, navigate to Services.
2. Right-click MiContact Center Storage and click Stop.

3. On the 7.x Enterprise Server, copy all .msg files from the SearchStorage location in CCM\DataDi-
rectory.

4. On the 8.0+ Enterprise Server, paste them in the new SearchStorage location (set during installa-
tion).

5. Launch the command prompt.

6. Run the following command: cd “<drive>:\Program Files (x86)\Mitel\MiContact 
Center\Services\StorageServices\ElasticsearchMigration”, replacing <drive> with the appro-
priate drive chosen during installation.
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7. Run the command StorageService.ElasticsearchMigration.exe /r.

8. When the message Migration finished for storage directory appears, close the command prompt.

9. Navigate to Services.

10. Right-click MiContact Center Storage and click Start.

Configuring devices

After upgrading the Enterprise Server, some manual device configuration is required to make your version 
9.2 multimedia contact center fully functional.
NOTE: Whether you need to perform each of the following procedures depends on the version of MiCon-
tact Center Business software you are upgrading from and your multimedia settings prior to upgrade. All 
procedures are included here but may not all apply to your specific upgrade.
1. Create mail servers
2. Configure Email media server

3. Configure Chat media server

4. Configure SMS media server

5. Configure Open Media media server

6. Configure employees

7. Define employee Workload

8. Configure queues

9. Configure queue groups

10. Set default login agent group presence

11. Modify default inbound, response, and Inqueue workflows

12. Convert to visual workflow routing

Creating mail servers

Email media servers require one or more mail servers to be configured. A mail server is used to receive 
and send mails to the corporate mail server and defines the IMAP connection to a single email account. 
Email aliases or distribution groups, depending on the mail server type, are used to associate multiple 
email addresses for the contact center to a single email account. This minimizes the number of mail 
servers required.
After creating a mail server, we recommend using the test button to verify both the incoming and outgoing 
connections are functioning as expected.
When email servers are copied over during the upgrade, they retain the SMTP information for outbound 
mails, if it was configured in the previous system.
For more information and configuration details, see "Integrating Multimedia Contact Center with mail 
servers".

Configuring the Email media server

For more information and configuration details, see "Adding email to Multimedia Contact Center".
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Configuring the Chat media server

For more information and configuration details, see "Adding chat to Multimedia Contact Center".

Configuring the SMS media server

SMS media servers will be made historical during an upgrade from version 7.0 or version 7.1. MultiTech 
SMS modems are not supported in version 8.0+. Historical SMS media servers and their data will be avail-
able for reporting, post upgrade. Pre-8.0 SMS messages will be migrated and treated as emails.
If you are upgrading from pre-version 8.0, you must add a new SMS media server, add SMS handling 
capabilities to employee and agent groups, and add new SMS queues. In version 8.0+, SMS media 
servers require an SMS Gateway Provider. As of version 8.0, Multimedia Contact Center supports Twilio 
as an SMS Gateway Provider. You must have a Twilio account to add SMS handling capabilities to Multi-
media Contact Center.
For more information on integrating with an SMS Gateway Provider, see "Integrating Multimedia Contact 
Center with an SMS Gateway Provider". For information on configuring an SMS media server, see 
"Adding SMS to Multimedia Contact Center".

Configuring employees

Employees can only have one agent for each of the types of multimedia supported by the contact center. 
In addition, employees handling multimedia interactions must have the appropriate licensing.
NOTE: Historical multimedia agents associated with employees can only be seen and deleted from Your-
Site > Agents.
For information and configuration details, see "Adding multimedia capabilities to employees".

Defining employee Workload

For information on defining employee Workload, see "Managing Employee Workload".
For information on configuring Workloads, see "Configuring Workload".

Configuring queues

When you create a multimedia queue, it is automatically associated to the existing media server for that 
media type.
For more information and configuration details, see "Adding multimedia queues".

Configuring queue groups

Administrators can group queues for common purposes. There are three kinds of queue groups available: 
Reporting, Mitel Virtual, and Unified Queue Groups.
Unified Queue Groups are optional but are beneficial in organizing media types for each service organi-
zation within your business and are a preferred method of multimedia queue configuration.
For more information and configuration details, see "Adding queue groups".
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Setting default login agent group presence

Agents and supervisors can adjust a member’s presence in an agent group. By default, on login, agents 
are present in all of their agent groups. You can adjust this setting in the Agent group device page of Your-
Site Explorer. See "Managing agent group membership, presence, and skill level".

Modifying default Inbound, Response, and Inqueue workflows

NOTE: There is no default email response workflow.
During the upgrade, a default response workflow is assigned to relevant media servers. Default Inqueue 
workflows are assigned to each media queue. You can choose whether to enable default Inbound work-
flows on the email media server device configuration page in YourSite Explorer.
The default workflows must be modified after the upgrade, as follows:
• Typical Inbound workflow modifications include:

– Emails: modifying the email address and destination queues
– Chat: modifying the queue ID and destination queues
– SMS: No modifications required, but queue ID and destination queues can be modified

• Typical Response workflow modifications include:
– Sending chat transcripts to clients

• Typical Inqueue workflow modifications include:
– Associating the handling agent groups to the queue
– Customizing the auto-acknowledgement messages

Default upgrade settings use an Offer to Agent activity to select the next available agent. If you require 
preferred agent support, then you must replace the Offer to Agent activity with an Offer to Preferred Agent 
activity in the Inqueue workflow.
For more information, see "Multimedia Contact Center default workflows".

Converting to visual workflow routing

When upgrading from Version 6.0.3.0 to Version 7.1, you have the option of converting to visual workflow 
routing. Visual workflow routing directs incoming contacts to queues and agent groups via routing rules, 
which are determined by Inbound and Inqueue workflows.
The first step in converting to visual workflow routing is enabling inbound routing for your media servers. 
Enabling inbound routing associates the appropriate default Inbound workflow to the server. Administra-
tors can modify these default workflows to suit the contact center’s needs.
The following explains how to convert to visual workflow routing by enabling the Inbound Routing tab on 
YourSite Explorer’s Media Servers page. For more information on working with visual workflows and 
applying routing rules to contacts, see:
• "Multimedia routing using visual workflows".
• "Multimedia Contact Center default workflows".

NOTE: If Version 6.0.3.0 customers upgrading to a Version 7.1 system do not convert to visual workflow 
routing via the following procedure, multimedia contacts will continue to route directly to queues without 
routing rules applied through Inbound workflows. In cases where inbound contacts have multiple 
addresses in the To and/or CC fields, the contact will only be routed by the first address in the To field.
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To apply inbound routing rules to contacts
1. Select Multimedia > Media servers and select the media server.
2. Click the Inbound tab.

The default Inbound workflow will be applied to your media server.
NOTE: If you do not want to convert to visual workflow routing, do not save the media server.

Installing client applications

Before performing client installations, ensure the hardware and software requirements are met. See the 
MiContact Center Business and MiVoice Analytics System Engineering Guide for specification details.

Running the Client Role Selector and installing Ignite (DESKTOP)

The MiContact Center Business client installation includes the Client Role Selector. Within the Client Role 
Selector, you choose the applications and components of MiContact Center Business that you want to 
install on the desktop. Ignite enables employees to handle multimedia interactions. If you want to install 
Ignite (DESKTOP);on the client desktop, select it from the list of available options in the Client Role 
Selector window.

Removing Multimedia Contact Center WebChat Server software

If chat was supported in your Version 6.0.3.0 Multimedia Contact Center environment, remove the 
WebChat Server software that was previously installed on the corporate Web server.

Bringing the system online

NOTE: This section is only applicable if you are upgrading from Version 6.0.3.0.
Create a test email queue, a test chat queue, a test SMS;queue, and a test agent on the new server and 
validate that email, chat, SMS, and open media are being correctly routed to queues and agents. Run 
reports to verify accuracy. Confirm that email aliases or distribution groups and URL redirects for chat 
have been correctly implemented.
Before moving to the new system, advise agents to complete all outstanding items on the old system. 
Advise agents to empty their public folders.
When moving email addresses from your old server to the new server, we recommend you enable email 
addresses one at a time, beginning with those that experience the lowest traffic.
Mail-disable the email address from the existing public folder. Add the address as an alias or distribution 
group to the generic email address inbox that your mail server is pulling from in the Version 8.1 environ-
ment. Continue with this process until all email addresses have been enabled in the new system.
NOTE: When you mail-disable the email address in the public folder, mails will not be delivered and mail 
senders will receive an undeliverable message until the email address has been created in the new 
system as an alias or distribution group.
Optionally, you can similarly migrate the chat items. We recommend you do so in a staggered fashion by 
only exposing the request to chat from the corporate Web page for a specific service group. We also 
recommend that, during migration, you add a maintenance message that explains chat is temporarily 
unavailable.
Deploy the updated corporate Web pages with the Contact Us page on the corporate website. Remove 
the chat temporary unavailable page.
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Disable the old system and instruct agents to log onto the new system.

Exchange Server migration recommendations

NOTE: This section is only applicable if you are upgrading from Version 6.0.3.0.
Support is provided for migrating the Exchange repository to the new flat file repository. This migration is 
expected to take a significant amount of time and is dependent on the amount of data to be migrated. This 
migration can occur after the new system is operational. After migrating to the flat file repository, stopping 
and restarting the Storage Service is required and will tag new entries for the search tool.
NOTE: Due to Windows' limitations, you will be unable to migrate emails whose file names exceed 260 
characters.
Migrating data will break the link with real-time data and preferred agent status for any contacts from 
before the upgrade will be lost. The migrated data will be fully indexed and searchable. To associate an 
agent to a reply will require a manual search of SMDR records.
There are several possible, existing Exchange Server deployment scenarios to consider when upgrading. 
The high level upgrade steps are similar regardless of the version of Exchange currently being used. See 
the following table for a description of four possible migration scenarios.
NOTE: For minimum downtime, we recommend migrating email addresses after all installation and config-
uration is complete. In that way, when you mail-disable the public folders and add email addresses, as 
aliases or distribution groups, agents will be already be configured and prepared to answer emails in the 
new system.

Table 24.1:Exchange Server migration recommendations  (Sheet 1 of 2)

Exchange Server deployment 
scenario During migration Post-upgrade

Exchange is installed on its own server 
and is not collocated with MiContact 
Center Business. This Exchange 
Server is only used to host public 
folders for the Multimedia Contact 
Center.

Leave the 
Exchange Server 
intact.

Decommission the Exchange Server. 
It is no longer required. The public 
folder structure can be migrated to any 
other public folder store using public 
folder replication.

Exchange is installed on its own server 
and is not collocated with MiContact 
Center Business. This Exchange 
Server is used for corporate and 
Multimedia Contact Center data.

Leave the 
Exchange Server 
intact.

Leave the Exchange Server intact for 
corporate use.
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High-level migration steps for the Exchange Server are as follows:
• Stop and disable the Mi Contact Center Business Services on the Exchange Server (Setup and 

Objects service).
• Create a new mailbox on the mail server that is going to host the new Multimedia Contact Center mail-

boxes.
• Use a primary SMTP address that does not match any of the queue’s SMTP addresses.
• Using the Exchange Public Folder Management Tool, mail-disable all of the Queue Public Folders.

NOTE: When you mail-disable email addresses in the public folder, mails will not be delivered and mail 
senders will receive an undeliverable message until the email addresses have been created in the new 
system as an alias or distribution group. We recommend you disable email addresses one at a time to 
minimize disruption.
Create a distribution group containing email addresses used to route to queues.
Distribution Groups are recommended in order to associate multiple email addresses to a single mailbox. 
It may take up to 15 minutes before the email addresses are available.
Enable the IMAP service and set it to automatic startup on the CAS server that is servicing the new 
mailbox.

Exchange is collocated with MiContact 
Center Business and is only used to 
host Multimedia Contact Center data.

A new server 
should be built for 
MiContact Center 
Business Version 
7.1. The Exchange 
Server should be 
left intact with 
MiContact Center 
Business installed 
as a part of the 
rollback plan.

Decommission the Exchange Server. 
It is no longer required. The public 
folder structure can be migrated to any 
other public folder store using public 
folder replication. Uninstall the 
MiContact Center Business software.

Exchange is collocated with MiContact 
Center Business and is used for 
corporate and Multimedia Contact 
Center data.

A new server 
should be built for 
MiContact Center 
Business Version 
7.1. The Exchange 
Server should be 
left intact with 
MiContact Center 
Business installed 
as a part of the 
rollback plan.

Leave the Exchange Server intact for 
corporate use. Uninstall the MiContact 
Center Business software.

Table 24.1:Exchange Server migration recommendations (Continued) (Sheet 2 of 2)

Exchange Server deployment 
scenario During migration Post-upgrade
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Configuring your multimedia contact center
Multimedia Contact Center is configured in the YourSite Explorer application in the Multimedia tab, which 
contains the relevant MiContact Center Business devices for Multimedia Contact Center.

YourSite Explorer configuration notes and tips

For ease of use and efficiency, YourSite Explorer uses standard Windows CTRL and Shift button conven-
tions for selecting multiple objects.
NOTE: 
• Only one set of pending configuration changes can be saved at any time. If another user saves 

changes to the same element of YourSite Explorer that you are updating, you receive an error 
message when attempting to save your changes. In these instances you must refresh YourSite 
Explorer after the other user’s changes have been saved. You may then re-enter and save your 
changes. We recommend you save your configuration changes frequently, in order to avoid losing 
work.

• YourSite Explorer enables you to have multiple device tabs open simultaneously. As a best practice, 
we recommend you only have the device tabs open that you are currently using.

• When you configure numbers for groups in YourSite Explorer, use numerical characters only, such as 
1 (for Queue Group 1). Do not insert symbols, such as a star [*] or pound sign [#], in the number.

• If you attempt to add a device or device group to YourSite Explorer that is already in the database, the 
system notifies you that the device or device group is already present. When you add a series of 
devices or device groups to YourSite, such as Queues 5001 to 5005, if the system detects you have 
already added Queue 5002, then it will not add Queue 5002 or any subsequent queues in the series 
(that is, Queues 5003 to 5005) to the database.

For detailed information regarding YourSite Explorer, consult the "Configuration".

Applying changes to multiple devices at a time

Administrators can apply a change to multiple devices at a time using the multi-select feature. This feature 
saves administrators from having to apply the same change to multiple devices of the same type.
To apply changes to multiple devices at a time
1. Click Multimedia and select the device.
2. Select multiple devices by holding CTRL or Shift and clicking the devices.

3. Select the configuration changes.

NOTE: Only information common across devices of the same type can be changed in one action.
4. Click Save.

Viewing devices by category or type

Administrators can selectively view devices by category or type by applying filters to the device page. For 
example, administrators can view only the contact center’s Email Inbound workflows by applying the 
Email Inbound filter to the Workflows page.
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Multiple filters can be applied at a time, enabling administrators to selectively view devices by multiple 
categories or types. For example, administrators can view only Email, Chat, SMS, or Open Media vari-
ables by applying these filters to the Variables page.
The following devices may be viewed by category or type
• Queues
• Subroutines
• Variables
• Workflows

To view variables by category or type
1. Click Multimedia and select the device.
2. After Filter, select a device category or type from the drop-down list.

NOTE: Filters remain in place until a category is deselected. Selecting ‘None’ removes all filters.

Organizing devices by shared criteria

Organizing devices by shared criteria will group devices for ease of identification and configuration. For 
example, grouping media servers by Site will, in the device pane, group all media servers associated to 
a site. After selecting grouped devices, administrators can change information common to those devices 
in one action. See "Applying changes to multiple devices at a time".
In Multimedia Contact Center, administrators can organize the following devices by criteria
• Agents
• Employees
• Media servers

To organize a device type by criteria
1. Click Multimedia and select the device to group.
2. Click Group by and select an organizing criterion or criteria.

NOTE: Additional grouping criteria are nested under the original criterion selected.

To remove organizing criteria
1. Click Multimedia and select the device.
2. Click Group by and deselect the criteria to remove.

NOTE: To remove all grouping criteria, ensure no criteria remain selected under Group by.

Required information

To configure Multimedia Contact Center, you require the following information:
• Mail server name
• IMAP port information for mail server
• Email username and password
• SMTP Server for email replies
• Chat server URL (the public URL used to request chat)
• SMS gateway provider account
• Interflow configuration
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For multimedia queues, interflow is conducted by the Interflow activity in Inqueue workflows. See 
"Routing interactions with the Interflow activity".

• Customized auto-acknowledgment messages
Multimedia Contact Center default workflows contain a number of default auto-acknowledgment mes-
sages. For an overview of the default workflows and their messages that may need to be modified to 
suit your contact center’s needs, see "Multimedia Contact Center default workflows".

Configuring multimedia enterprise settings

The Enterprise Server is the computer on which MiContact Center Business is installed. When program-
ming the enterprise, you configure Enterprise Server general settings, some maintenance services, and 
email alarms, as well as settings for Contact Center Screen Pop andMultimedia Contact Center.
Configuration steps specific to Multimedia Contact Center include: 
• Configuring email settings
• Configuring the Multimedia storage path

For more information concerning non-multimedia enterprise settings, see the "Configuring enterprise 
settings".

Configuring email settings

You configure email alarms so you are notified by email about Enterprise Server and real-time perfor-
mance issues. You must have configured a mail server before configuring your email settings. See 
"Adding mail servers".
To configure email alarms 
1. Click YourSite > Enterprise.
2. Click the Email settings tab.

3. After Mail Server Address, click the Browse button.

4. Select a mail server and click OK.

5. After Email notification interval minutes, select the interval (in minutes) that the Enterprise will 
check for alarms and send out email notifications. 

NOTE: Notifications of critical alarms are sent immediately after the issue is detected.
6. After Send Enterprise Server alarms to the following address(es), type the email address of the 

employee(s) who will receive the email notification. 

Separate multiple email addresses with commas.
7. Click Save.

Adding sites

A site is an office location with one or more media servers. It can be the office where the Enterprise Server 
is installed or a branch office.
Your site structure determines how you view statistics and reports. When you add a site, you add the 
name of the site and the time zone. By making each site distinct, you can restrict user access to sites. For 
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more information on restricting user access, see "Configuring security roles". The site’s language deter-
mines the default language setting for new employees associated to it.
Administrators can limit whether or not the Make Busy and Do Not Disturb reason codes used by 
employees are visible in communication tools such as MiCollaband Microsoft Skype for Business.
Administrators can also enable agent greeting and whisper announcement functionality for all agents in 
the site. Agents record messages from Ignite (DESKTOP) and assign them to specific queues, so that 
they are played on each incoming ACD call. The Agent Greeting feature enables agents to record 
messages (as .wav files) that play automatically to callers when the agent answers an inbound ACD call. 
The greeting can provide a consistent experience for each caller and free the agent from having to repeat 
the same introductory phrase for every call. For information on configuring agent greeting workflows, see 
"Configuring the Record Agent Greeting workflow" and "Configuring agent workflow settings".
Administrators can also restrict the site’s use of Contact Center Client’s Chat Integration, which enables 
employees to chat with each other in Contact Center Client. Prior to version 7.0, there was an option to 
use Microsoft Skype for Business as the default chat client instead of Contact Center Chat. In version 7.0 
and greater, YourSite Explorer automatically detects if you have Microsoft Skype for Business Server and 
enables it as the default chat client. If your contact center is a mixed environment where some users 
have Skype for Business and others do not, you may want to use Contact Center Chat to ensure all 
employees can communicate. For information on using Contact Center Chat in an environment 
with Skype for Business on some systems, see the following Mitel Knowledge Base 
article:https://mitel.custhelp.com/app/answers/answer_view/a_id/1000736/loc/en_US
o add a site 
1. Click Multimedia> Site.
2. Click Add.

3. After Site Name, type the name of the site.

4. After Time Zone, select the time zone and closest location from the drop-down list.

5. After Site Language, select the site language from the drop-down list.

6. After Default Server, click the Browse button.

7. Select a server and click OK.

8. If you want Make Busy and Do Not Disturb reason codes to display in communication tools, select 
Display Make Busy and DND Reason Codes in Communication Tools.

9. To enable agent greeting and whisper announcement functionality for the site, check Enable Agent 
Greetings. 

The system displays an information message advising you to ensure that the appropriate Class of 
Service options are configured for agents on the MiVoice Business PBX.

10. To disable Contact Center Client Chat Integration, clear Chat Enabled. 

11. Click Save.

Configuring the Multimedia storage path

During installation you select the multimedia storage path, which sets the email storage location. The 
storage path can be either local drive or a network drive (UNC path). The Local administrator account set 
during installation must have read/write permission to that path. Once specified, the following folder struc-
ture will be created within the storage path:

../configuring_agent_greeting_recording_workflow.dita#Configuring_the_Record_Agent_Greeting_workflow
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000736/loc/en_US
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\<SiteKey>\<Year>\<Month>\
Year and Month folders are named numerically to correspond to the year and month of the stored 
messages and transcripts. If you used the default storage path, the folder structure is <drive>:\Program 
Files (x86)\Mitel\MiContact Center\DataDirectory\SearchStorage\<SiteKey>\ <Year>\<Month>\.
NOTE: 
• Chat and SMS transcripts are stored in the Elasticsearch index, at <drive>:\Program Files 

(x86)\Mitel\MiContact Center\Database\Elasticsearch\. For more information on Elasticsearch, see the 
MiContact Center Business and MiVoice Analytics System Engineering Guide.

• The \<SiteKey>\<Year>\<Month> folders are only added the first time an email is indexed during the 
corresponding year and month.

The multimedia storage path can be changed to store new messages in a different location. Old files must 
be copied to the new location manually. For instructions on changing the multimedia storage path, see 
the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000794/loc/en_US.
Certain email .msg files can be deleted from the email storage location to free up disk space. While Ignite 
will return deleted .msg files in search results, attachment viewing will be limited and embedded images 
will not display. For information, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1013096/loc/en_US.

Enabling a new multimedia contact center

You must configure the following enterprise-level items before you can configure your devices.
1. Create mail servers. 

Mail servers will need to be created for your email media server. They are used to receive and send 
mails to the corporate mail server. It is recommended that email aliases or distribution groups, de-
pending on your mail server type, be used to map multiple email accounts to a single email account 
as this will reduce the number of mail servers that need to be configured.
See "Adding mail servers".

2. Create media servers. 

Media servers will need to be created for each media supported by the contact center. Email media 
servers require one or more mail servers to be specified. Chat media servers require the chat server 
URL. SMS media servers require an integration with Twilio, a third-party SMS gateway service pro-
vider.
See "Adding email to Multimedia Contact Center" and "Adding Chat to Multimedia Contact Center" 
and "Adding SMS to Multimedia Contact Center".

The order for configuring your multimedia devices depends on whether or not the administrator is creating 
multimedia queues using the Unified Queue Group wizard. The Unified Queue Group wizard enables 
rapid configuration of new multimedia queues linked with existing voice queues. If a contact center does 
not intend to have their multimedia queues mirror voice queues, they can be added manually. For detailed 
information on configuring individual Multimedia Contact Center devices, see "Multimedia Contact Center 
device configuration".

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000794/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1013096/loc/en_US
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If you are creating your multimedia queues using the Unified Queue Group wizard, configure your devices 
in the following order: 
1. Create Workloads. 

Workloads determine the number and type of media interactions that can be pushed to an agent at 
any one time.
See "Configuring Workload".

2. Upgrade employees. 

Employees must be assigned the appropriate Multimedia Contact Center licensing, Workloads, and 
the media types they can handle.
See "Adding multimedia capabilities to employees".

3. Create Unified Queue Groups from the voice queues with the Unified Queue Group wizard to repre-
sent the service groups in the organization. 

See "Adding queue groups".
4. Modify default Inbound, Response, and Inqueue workflows. 

The default workflows included with Multimedia Contact Center require additional configuration to 
customize them for your contact center.
See "Multimedia Contact Center default workflows".

5. Configure agent groups for default Agent Group Presence. 

See "Adding agent groups".

If you are not using the Unified Queue Group wizard to create your multimedia queues, configure your 
devices in the following order: 
1. Create Workloads. 

See "Configuring Workload".
2. Upgrade employees. 

Employees must be assigned the appropriate Multimedia Contact Center licensing, Workloads, and 
the media types they can handle.
See "Adding multimedia capabilities to employees".

3. Configure agent groups and set default presence. 

See "Adding agent groups".
4. Create multimedia queues. 

Multimedia queues can be created individually on a queue-by-queue basis or created as parts of a 
Unified Queue Group.
See "Adding multimedia queues".
See "Adding queue groups".

5. Create Unified Queue Groups or queue groups to tie queues representing the same service groups 
in the organization together. 

See "Adding queue groups".
6. Modify Inbound, Response, and Inqueue workflows. 

The default workflows included with Multimedia Contact Center require additional configuration to 
customize them for your contact center.
See "Multimedia Contact Center default workflows".
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Multimedia Contact Center device configuration

Devices in Multimedia Contact Center can be configured using three different methods: 
• Quick Setup—Quick Setup enables administrators to add ranges of employees with identical settings. 

See the "Configuring devices and device groups using Quick Setup".
• .csv files—YourSite Explorer can add new devices by importing device setting information using 

comma-separated value (.csv) files. See the "Configuring devices using .csv files".
• Manually—Devices can be added one-by-one without automated assistance or importing.

Integrating Multimedia Contact Center with mail servers

NOTE: Email routing to blind-copied queues is not supported.
Multimedia Contact Center integrates with mail servers using SMTP and IMAP or EWS connections.
NOTE: SMTP, IMAP or EWS connections through web proxies are not supported.
The following servers are considered to be supported infrastructures for Multimedia Contact Center 
routing: 
• Exchange Server
• Exchange Online (Office 365)
• Google Apps for Business
• IBM Domino
• BlueHost

NOTE: For Office365 user accounts created in October 2020 and later, Basic Authentication is disabled by 
default. Currently, MiContact Center Business supports only Basic Authentication. Therefore, if Office365 
is used as an email server, Basic Authentication must be manually enabled.
Verified versions for mail servers are described in the MiContact Center Business and MiVoice Analytics 
System Engineering Guide  :
Multimedia Contact Center supports IMAP providers that use non-empty Namespace as mail servers. For 
information on the general requirements for mail servers, see "Mail server requirements".
We recommend configuring a single mail server connection with outgoing and incoming connections.
On the mail server, administrators must first configure a master email account to receive the email 
messages that Multimedia Contact Center copies. For these configuration procedures, please consult the 
appropriate third-party documentation. See also the Knowledge Base article appropriate to the server, 
listed below.
We recommend that, in addition to configuring a single, master email account to receive incoming 
messages for Multimedia Contact Center to copy, administrators configure aliases or, in the case of 
Exchange, distribution groups for the different multimedia service groups receiving ACD emails. For 
Exchange Server users, we recommend that the master email account from which Multimedia Contact 
Center copies emails is not the Domain Administrator account, due to Windows Security restrictions. An 
inbound workflow should route emails from this master account to service groups in the contact center, 
based on the ‘To’ addresses to which emails were sent. For example, administrators can create a master 
email account called ‘MyCompany@domain.com’, and create aliases or distribution groups for the 
contact center’s service groups.
NOTE: Using aliases or distribution groups ensures that emails sent to multiple addresses in the contact 
center generate a single case number. If, instead of using aliases or distribution groups, email addresses 
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are associated to different mail servers, a single email sent to these addresses will have different case 
numbers.
We recommend that the master account’s address is discrete from email aliases and distribution groups, 
and is not associated to any queues. For information on configuring your mail server with an email 
account and aliases or distribution groups, consult the following Mitel Knowledge Base article appropriate 
to the server.
• Exchange Server 2007 –  

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000717/loc/en_US
• Exchange Server 2010 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000718/loc/en_US
• Exchange Server 2013 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000717/loc/en_US
• Exchange Online – https://mitel.custhelp.com/app/answers/answer_view/a_id/1000713/loc/en_US
• Google Apps for Business – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000712/loc/en_US
• IBM Domino – https://mitel.custhelp.com/app/answers/answer_view/a_id/1000743/loc/en_US

NOTE: For Exchange Server users, Multimedia Contact Center requires that the master account has Send 
As permissions to the distribution groups. See "Specifying Send As permissions in Active Directory".
For information on configuring email workflows to route based on specific addresses, see "Default Email 
Inbound workflow" and "Routing contacts with the To activity".
Once the contact center’s email client is connected to a supported server and an email account for the 
contact center is created, administrators can configure the mail server’s outgoing and incoming settings 
in YourSite Explorer.
NOTE: Multimedia Contact Center supports the Exchange Web Services (EWS) protocol. The EWS 
protocol is supported only on Microsoft Exchange and Microsoft Office 365 and on the following servers: 
• Microsoft Exchange 2007 and all service packs
• Microsoft Exchange 2010 and all service packs
• Microsoft Exchange 2013 and all service packs
• Microsoft Exchange 2016 and all service packs
• Microsoft Office 365 online servers

NOTE: Mitel is not responsible for any folder size restrictions on mail servers. If there are file size restric-
tions on your mail server, it is strongly recommended that the Processed folder created during Multimedia 
Contact Center mail server configuration be exempted from those restrictions or else routing functionality 
may be affected.
Note that, occasionally, mail servers incorrectly mark valid emails as spam. We recommend that admin-
istrators periodically check their mail servers’ spam folder to avoid losing important contacts.
For information on migrating from one mail server to a new mail server, see the following Mitel Knowledge 
Base article: https://mitel.custhelp.com/app/answers/answer_view/a_id/1000737/loc/en_US.
The following procedures tell administrators how to 
• Add a mail server to Multimedia Contact Center
• Configure SMTP connections to Multimedia Contact Center
• Configure IMAP connections to Multimedia Contact Center
• Configure EWS connections to Multimedia Contact Center

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000717/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000718/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000719/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000713/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000712/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000743/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000737/loc/en_US
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• Delete a mail server from Multimedia Contact Center

NOTE: Integrating Multimedia Contact Center with mail servers requires SMTP and IMAP or EWS server 
names and port information. Administrators must retrieve and enable this information before configuring 
SMTP and IMAP or EWS connections to Multimedia Contact Center. See the Knowledge Base article, 
listed above, appropriate to the server.

Adding mail servers

To add a mail server 
• Click YourSite > Mail servers > Add.
After adding the mail server, you must configure SMTP connections to MiContact Center Business.

Configuring SMTP connections to Multimedia Contact Center

The following configurations take place in Multimedia > Mail servers > Outgoing.
Configuring an SMTP connection enables Multimedia Contact Center to send outgoing mail through a 
contact center’s email server. The following explains how to configure an SMTP connection between 
Multimedia Contact Center and email servers. The outgoing settings you configure are applied to any 
email your system sends, such as server alarms, reports, and outgoing email interactions to customers.
For information on locating the required information from the contact center’s email server, consult the 
following Mitel Knowledge Base article appropriate to the server.
• Exchange Server 2007 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000717/loc/en_US
• Exchange Server 2010 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000718/loc/en_US
• Exchange Server 2013 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000719/loc/en_US
• Exchange Online – https://mitel.custhelp.com/app/answers/answer_view/a_id/1000713/loc/en_US
• Google Apps for Business – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000712/loc/en_US
• IBM Domino – https://mitel.custhelp.com/app/answers/answer_view/a_id/1000743/loc/en_US

Configuring an SMTP connection requires you to 
• Add the mail server to YourSite Explorer 

If the mail server has not already been added, see "Adding mail servers".
• Specify the server information for outgoing emails 

See the KB article appropriate to the media server, listed above
• Specify the email account’s ‘From’ name and address
• Specify the email account's aliases.
• If required by the SMTP server, request logon credentials to send outgoing mail
• Test the server’s SMTP socket connection to Multimedia Contact Center 

NOTE: To test the connection, administrators must have an email address configured for them in the 
Employees page. This email address receives notification of whether the test was successful.

To specify the server information for outgoing emails 
1. After SMTP Server, type the server’s IP address or name.
2. Select the Use SSL check box if the server uses Secure Sockets Layer.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000717/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000718/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000719/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000713/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000712/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000743/loc/en_US
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3. After SMTP Port, type the server’s SMTP port number. 

NOTE: 
– Google Apps for Business' port 465 is not supported.
– When using EWS, port 443 is frequently used.

4. After Connection Timeout, type how many seconds the system has to connect to the server before 
timing out.

To specify the email account’s ‘From’ name and address 
1. After From Name, type the name that appears on outgoing mail. 

For example, ‘XYZ Company Sales’.
2. After From Email Address, type the email address that appears on outgoing mail. 

For example, ‘xyzsales@email.com’.
NOTE: This must be a valid email address. Add a queue email address that agents will select as the 
‘From’ address in email responses and outbound emails, if this queue is not configured as an ‘Alias’ 
for the mail server.

To specify the email account's aliases. 
1. After Aliases, click the Browse button. 

NOTE: 
– Include all queue email addresses that agents will select as the ‘From’ address in email responses 

and outbound emails, if these queues are not configured as the ‘From Email Address’ for the mail 
server.

– Failure to include all aliases will impact the ability of the Transfer activity to route inbound emails to 
all queues when using the <<DestinationQueues>> variable. For more information, see "Routing 
contacts with the Transfer activity".

2. Type the mail server’s alias and click Add. 

NOTE: An alias can only be associated to a single mail server.
3. If you want to associate additional aliases for the mail server, for each additional alias, type the alias 

and click Add.

4. Click Ok

To request logon credentials to send outgoing mail
1. Select the SMTP Authentication Required check box.
2. Enter the Username, Password, and, in the case of Exchange, Domain information for the server’s 

email account. 

NOTE: If you use Google’s 2-step verification, enter the password specific to Multimedia Contact 
Center.

3. Click Save.

To test the server’s SMTP socket connection to Multimedia Contact Center
• Click Test Outgoing Mail. If an error message is received, verify that the Outgoing Server, User, and 

Logon information is entered accurately. To troubleshoot, the default installation location for verbose 
logs is C:\Users\<current user>\Documents\CCMLogs\YourSiteExplorer.txt.
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Configuring IMAP connections to Multimedia Contact Center

The following configurations take place in Multimedia > Mail servers > Incoming.
IMAP connections enable Multimedia Contact Center to retrieve messages from a specified account on 
a mail server and define the folder from which Multimedia Contact Center retrieves messages. The 
following explains how to configure an IMAP connection between Multimedia Contact Center and a mail 
server.
For information on locating the required information from the contact center’s email server, consult the 
following Mitel Knowledge Base article appropriate to the server.
• Exchange Server 2007 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000717/loc/en_US
• Exchange Server 2010 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000718/loc/en_US
• Exchange Server 2013 – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000719/loc/en_US
• Exchange Online – https://mitel.custhelp.com/app/answers/answer_view/a_id/1000713/loc/en_US
• Google Apps for Business – 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000712/loc/en_US
• IBM Domino – https://mitel.custhelp.com/app/answers/answer_view/a_id/1000743/loc/en_US

Configuring IMAP connections requires administrators to 
• Enable incoming server settings in YourSite Explorer
• Specify the server information for incoming emails
• Specify the email account’s username and password
• Test the server’s IMAP connection to Multimedia Contact Center

NOTE: 
• If you have not added a mail server in YourSite Explorer or configured its SMTP settings, see "Adding 

mail servers", and "Configuring SMTP connections to Multimedia Contact Center".
• If you are editing information for an existing server, select the media server and click the ‘Incoming’ tab.

To enable incoming server settings in YourSite Explorer 
1. Select the mail server and click the Incoming tab.
2. Select the Enable Incoming Server Settings check box.

To specify the server information for incoming emails 
1. Select the Use TLS check box if the server uses Transport Layer Security.
2. After Incoming Server, type the server’s IP address or name.

3. After Incoming Port, type the server’s IMAP port number.

4. After Connection Timeout, type how many seconds the system has to connect to the server before 
timing out.

5. After Incoming Folder, specify the email account folder from which Multimedia Contact Center 
retrieves email. 

NOTE: If the system should retrieve email from the Inbox, leave this setting as the default. If the 
system should retrieve email from a subfolder of the Inbox, specify the folder name. Multimedia 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000717/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000718/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000719/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000713/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000712/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000743/loc/en_US
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Contact Center can retrieve email from a single folder only. Ensure emails to aliases and distribution 
groups are also routed to this folder.

To specify the email account’s username and password
NOTE: Specifying the email account’s username and password authenticates Multimedia Contact Center 
to the mail server
1. Select the Same as Outgoing Server check box if the email account logon information is shared 

between the SMTP and incoming server.
2. If the logon information for the email account is discrete, enter the Username, Password, and 

Domain information required to receive mail.

3. Click Save.

To test the server’s IMAP connection to Multimedia Contact Center
• Click Test Incoming Connection. If an error message is received, verify that the Incoming Server and 

Logon information is entered accurately. To troubleshoot, the default installation location for verbose 
logs is C:\Users\<current user>\Documents\CCMLogs\YourSite Explorer.txt.

Deleting mail servers

CAUTION: Deleting a mail server prevents emails dependent on the server from routing, including 
• Multimedia Contact Center email routing
• Report distribution
• Error reporting

Before deleting the mail server, we recommend first disassociating it from the email media server several 
days in advance. This allows pending emails to clear the system before the mail server is deleted. See 
"Disassociating mail servers from email media servers" for more information.
To delete a mail server 
1. Click YourSite > Mail servers.
2. Select the mail server and click Delete.

3. When prompted, click OK.

4. Click Save.

Specifying Send As permissions in Active Directory

For Exchange Server users, the master account from which Multimedia Contact Center retrieves emails 
requires Send As permissions for the applicable distribution groups.
Before specifying Send As permissions, ensure that
• A master account has been created in Exchange. This is the account from which Multimedia Contact 

Center will retrieve emails
• SMTP and IMAP or EWS connections to Multimedia Contact Center are configured
• Distribution groups are created for the contact center’s service groups

To specify Send As permissions in Exchange
1. In Windows, open Active Directory and select Users and Computers.
2. Right-click the distribution group and select Properties.

3. Select the Security tab and click Add.
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NOTE: If the Security tab does not display, go to View and select Advanced features.
4. Add the master account created in Exchange.

5. Under Permissions, after Send As, select the Allow check box.

6. Click Apply and then OK.

7. Repeat these steps for all applicable distribution groups.

Specifying Send As permission using PowerShell

For Exchange Online users, the master account from which Multimedia Contact Center retrieves emails 
requires Send As permission for the applicable distribution groups.
Before specifying Send As permissions, ensure that
• A master account has been created in Exchange Online. This is the account from which Multimedia 

Contact Center will retrieve emails.
• SMTP and IMAP or EWS connections to Multimedia Contact Center are configured.
• Distribution groups are created for the contact center’s service groups.

To specify Send As permission for a distribution group using PowerShell
1. In Windows, open PowerShell.
2. To create the PowerShell connection to the remote Exchange Online, run the following credentials:

$LiveCred = Get-Credential
$Session = New-PSSession -ConfigurationName Microsoft.Exchange - ConnectionUri https://ps.out-
look.com/powershell/ -Credential $LiveCred -AuthenticationBasic -AllowRedirection
Import-PSSession $Session

3. Enter the credentials for the Exchange Online administrator.

4. To add the Send As permission to the list

Add-RecipientPermission -Identity distributiongroup@example.com -Trustee mailbox@example.com 
-AccessRights SendAs

NOTE: Identify corresponds to the distribution group. Trustee corresponds to the mailbox.
5. Repeat Step 3 for each distribution group.

Mail server requirements

Contact centers using mail servers other than Exchange Server, Exchange Online, or Google Apps for 
Business must confirm that 
• The mail server supports IMAP version 4
• The mail server can maintain a reliable connection to the Enterprise Server

In addition, we recommend that 
• The mail account from which Multimedia Contact Center retrieves emails supports aliases. 

NOTE: To simplify deployment, we recommend administrators configure a single email account from 
which Multimedia Contact Center retrieves contacts, and configure additional email addresses as 
aliases to this account. For more information, see "Integrating Multimedia Contact Center with mail 
servers".

Multimedia Contact Center supports non-empty Namespace IMAP providers. For information on config-
uring a mail server, other than Exchange Online, Google Apps for Business, or Exchange Server, consult 
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the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002584/loc/en_US.
NOTE: IMAP or SMTP connections through web proxies are not supported.
For a list of supported Exchange versions, see the MiContact Center Business and MiVoice Analytics 
System Engineering Guide.

Integrating Multimedia Contact Center with an SMS Gateway Provider

Multimedia Contact Center integrates with the third party SMS gateway provider Twilio to support SMS 
routing. With Twilio, Multimedia Contact Center supports long codes (60 SMS messages per minute per 
mobile number). Short codes are unsupported. Mi Contact Center Business does not support Multimedia 
Messaging Service (MMS). You must have an account with Twilio to handle SMS messages with Multi-
media Contact Center.
To ensure SMS interactions route to the Enterprise Server, for each SMS number associated to your 
Twilio account, you must set the Request URL to the following: http://twimlets.com/echo?Twiml=%3CRe-
sponse%3E%3C%2FResponse%3E&. Consult your SMS gateway service provider documentation for 
information on configuring your account.
SMS gateway provider SMS phone numbers are added to Multimedia Contact Center as a part of config-
uring SMS media servers.
Multiple SMS numbers from an SMS gateway service provider can be added to your SMS media 
server. Do the following to add Multiple SMS numbers: 
1. Go to General tab > SMS Media Server.
2. Click the SMS Provider and on the list page select the multiple numbers you want add.

3. Click OK.

When adding Twilio SMS phone numbers to your SMS media server, you require, in addition to the SMS 
phone number, the Twilio Account SID and the Account Authentication Token. For more information, see 
"Adding SMS to Multimedia Contact Center".
A single SMS number can be used with multiple queues, provided the SMS Inbound workflow is modified 
to route SMS messages through a method other than by the <<DestinationQueues>> variable, such as 
with an Ask activity. For more information on the default SMS workflow, see "Default SMS Inbound work-
flow".

Adding media types to Multimedia Contact Center

Adding media types to Multimedia Contact Center applies Inbound, Inqueue, and Response routing rules 
to email, chat, SMS, and open media interactions, directing them to the agents best suited to respond.
Administrators add media types to Multimedia Contact Center by adding and configuring media servers 
in YourSite Explorer. Media servers are accessed via the Multimedia tab. Multimedia Contact Center 
supports one media server for each type of multimedia. When a multimedia media server is added to 
YourSite Explorer, that media type becomes unavailable in the Add drop-down list in the Media Server 
tab. If you want to add a new media server of that type, you must either delete the current media server 
of that type or make it historical.
NOTE: When adding media servers, administrators must indicate if the contact center operates over 
midnight. If not, reporting over midnight may not be accurate, and agent shifts are closed after the last 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1002584/loc/en_US
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agent events before midnight. For more information, see "Extending reporting and agent shifts over 
midnight".
For information on configuring specific media types see 
• "Adding email to Multimedia Contact Center"
• "Adding chat to Multimedia Contact Center"
• "Adding SMS to Multimedia Contact Center"
• "Adding Open Media to Multimedia Contact Center"

For information on configuration options shared among media types, see 
• "Deleting multimedia media servers"
• "Applying inbound routing rules to contacts"
• "Configuring Advanced options for media servers"
• "Extending reporting over midnight"
• "Specifying when Make Busy and Do Not Disturb timers begin"
• "Configuring response templates for email and chat"
• "Enabling Conversation Detail reporting"

Deleting multimedia media servers

When an administrator deletes a multimedia media server, all data associated with the media server and 
all devices configured and associated to that media server are deleted. Employee agent IDs for that media 
type are deleted and removed from their agent groups. Queues are deleted and removed from their asso-
ciated queue groups. Multimedia workflows are not deleted but Inbound and Response workflows are 
disassociated from the deleted media server and Inqueue workflows are disassociated from the deleted 
queues.
To delete a multimedia media server
1. Click Multimedia > Media servers.
2. Select the media server you want to delete and click Delete.

3. Click OK.

Applying inbound routing rules to interactions

Adding media requires administrators to apply routing rules to inbound interactions retrieved from media 
servers. The Inbound Routing tab enables administrators to view and modify the workflows and activities 
defining inbound routing rules.
New media servers are associated to the appropriate default workflows. For example, when an adminis-
trator adds an email media server, the system automatically associates the Default Email Inbound work-
flow to it. Administrators can customize these default workflows to suit the contact center’s needs. The 
workflow displaying on a media server's Inbound Routing tab is associated to that media server.
For more information on working with visual workflows and applying routing rules to interactions, see
• "Multimedia routing using visual workflows".
• "Multimedia Contact Center default workflows".
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Applying response routing rules to interactions

Response routing determines how the system handles completed interactions. For example, chat 
response workflows can mail interaction transcripts to customers, post-chat. Email response workflows 
can send customers surveys after email exchanges or supervisors copies of agent email responses. SMS 
response workflows can store the transcript of an SMS interaction and the handling agent in a CRM data-
base. Open media response workflows could send SMS messages with promotional codes or provide a 
web link for customized deals or recommendations.
Response routing is configured via Response workflows, located on the Response Routing tab of the 
media server.
New chat media servers are associated to a default Response workflow. Administrators can customize 
this workflow to suit the contact center’s needs. For more information on the Default Chat Response work-
flow, see "Default Chat Response workflow".
Default Response workflows are not provided for email or SMS media servers. Administrators must create 
these workflows.
NOTE: 
• Variables in Response workflows/subroutines are based on the agent’s reply, not the customer’s orig-

inal interaction. For example, in Inbound and Inqueue workflows/subroutines the <<From>> variable 
populates with the customer’s sending address. The <<To>> variable populates with the queue’s 
address.

• If you have a valid email response workflow and the Validate workflow option is selected, the workflow 
executes every time an email response is sent in Ignite.

• Email content inserted via the <<Body>> variable in the Email activity is limited to 2MB. After 2 MB, 
content inserted via the <<Body>> variable is truncated.

For more information on working with visual workflows and applying routing rules to interactions, see
• "Multimedia routing using visual workflows".
• "Multimedia Contact Center default workflows".

Configuring Advanced options for media servers

NOTE: For information on configuring advanced options specific to email, chat, SMS, or open media media 
servers, see "Configuring Advanced options for email media servers", "Configuring Advanced options for 
chat media servers", and "Configuring Advanced options for SMS media servers"
Configuring Advanced media server options enables administrators to
• Disable alarm reporting for the media server
• Configure intervals for generating queue statistics (for real-time purposes)
• Enable or disable previews of contacts

The following configurations take place in Multimedia > Media servers.
To disable alarm reporting for the media server
1. Select the media server and click the Advanced tab.
2. Deselect Enabled for alarms.

3. Click Save.

To configure intervals for generating queue statistics
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NOTE: This option determines, for real-time purposes, how frequently the system generates a queue 
statistics record.
1. Select the media server and click the Advanced tab.
2. To generate a new queue statistics record as statistics change, select Report on Change.

3. To generate a new queue statistics record every minute, select Report Every 60 Seconds.

4. Click Save.

To enable or disable previews of interactions
NOTE: The option enables administrators to control whether agents can preview interactions that are in 
queue or ringing in the Inbox.
1. Select the media server and click the Advanced tab.
2. To enable agents to preview messages, select Allow agent preview.

3. Click Save.

Extending reporting and agent shifts over midnight

Administrators at contact centers operating over midnight should select ‘This enterprise operates 24 
hours a day’ for the media server. This option provides more accurate reporting over midnight and deter-
mines when and how agent shifts are opened and closed after midnight.
If this option is selected, the system automatically closes and re-opens agent shifts at midnight. All agents 
remain logged into the system. Agent shift reporting is uninterrupted over this period.
If this option is not selected, the system closes agent shifts after the last agent event before midnight. The 
system re-opens agent shifts after the first agent event after midnight. All agents remain logged into the 
system. Agent shift reporting is not extended between the time agent shifts close and the time they 
re-open.
NOTE: Contact centers operating over midnight and rebooting their servers overnight should consult the 
following Mitel Knowledge Base article, to enable agents to retain their states post-reboot: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000594/loc/en_US.
To extend reporting and agent shifts over midnight 
1. Select Multimedia > Media servers.
2. Select the media server and click the Data Summary Options tab.

3. Select This enterprise operates 24 hours a day.

4. Click Save.

Specifying when Make Busy and Do Not Disturb timers begin

Agents can enter Make Busy (MKB) or Do Not Disturb (DND) while handling interactions to ensure that, 
once they are finished, they are not offered another message. By default, the real-time MKB and DND 
timers begin after the message is handled and agents do not appear in MKB or DND until this time. This 
enables agents to take scheduled breaks while remaining in adherence.
Administrators can set the MKB and DND timers to begin as soon as the agent enters MKB or DND.
To specify when the MKB and DND timer begins
1. Select Multimedia > Media servers.
2. Select the media server and click the Data Summary Options tab.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000594/loc/en_US


758

CONFIGURING YOUR MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

3. To start MKB and DND when the agent ends the interaction, select Reset Make Busy and Do Not 
Disturb time after conversation ends.

4. To start MKB and DND duration when the agent enters either state, deselect Reset Make Busy and 
Do Not Disturb time after conversation ends.

Configuring Reply templates for email, chat, SMS, and open media

Administrators can configure templates to be applied to email, chat, SMS, and open media responses. 
Reply templates enable efficient and uniform responses to common questions and requests.
Email templates must be in .msg or .txt format, and .msg email templates may contain images. Do not 
copy content containing images in .msg files directly from Outlook. Save this content as .msg files in the 
Reply Templates folder and leverage from there. Chat and SMS templates must be in .txt format.
Administrators store templates in either the default template folder created during installation, or in a 
folder on a network share. A network share is required if agents are permitted to create and modify 
templates and therefore must access them.
The default Reply Templates folder created during installation is located at <installation drive>:\<installa-
tion folder>\Templates\ReplyTemplates. This folder contains the subfolders Email, Chat, and SMS in 
which there are sample templates for the corresponding media type.
If agents are permitted to create and modify templates, administrators must create a folder in network 
share to house the sample templates. We recommend that you create a folder structure to organize the 
templates by media type and area of business. By default, the server points to the default Reply Template 
folder created during installation. The administrator must ensure that media servers point to the folder that 
they created on network share instead of the default Reply template folder.
To point the media server to a folder on a network share, complete the following procedure.
NOTE: Everyone' and/or 'Users' permissions are required for the folder in which the reply templates are 
stored. If the you have permissions for the reply template files, but do not have permissions to folder in 
which the reply templates are stored, YourSite Explorer displays an error.
If templates are housed on a network share, you must perform the following: 
• Configure identity settings for the CCMWa, MCCWa, and MiCCSDK web applications
• Configure security permissions for CCMWa, MCCWa, and MiCCSDK
• Point the media server to a network share folder

To configure identity settings for the CCMWa, MCCWa, and MiCCSDK web applications 
1. On the Enterprise Server, navigate to Internet Information Services (IIS) Manager.
2. Under Connections, select Application Pools.

3. Right-click CCMWa and select Advanced Settings….

4. Under Process Model, for Identity click the … button.

5. Select Custom account: and click Set….

6. On the Set Credentials window, enter the Windows credentials for the identity under which the 
MiContact Center Business Configuration Manager service runs and click OK. 

NOTE: 
– You can retrieve this identity by navigating to Windows' Services list.
– Domain names must be included in the username. E.g. Domain\Username
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7. Click OK.

8. In the Advanced Settings window, under Process Model, set the value for Load User Profile to 
True.

9. Click OK.

10. Repeat the above steps for MCCWa, and MiccSDK.

To configure security permissions for CCMWa, MCCWa, and MiccSDK 
1. On the Enterprise Server, navigate to Internet Information Services (IIS) Manager.
2. Under Connections, expand Sites > Default Web Site.

3. Right-click CCMWa and select Edit Permissions....

4. Click the Security tab and, for Users, set 'Allow' for the following permissions only: 

– Read & execute
– List folder contents
– Read

5. Repeat the above steps for MCCWa and MiccSDK.

To point the media server to a network share folder 
1. Click YourSite > Media servers, and select the Advancedtab.
2. Under Reply template, click the Browse button. 

Alternatively, enter the path in the Location field and click the Browse button. This redirects the 
Browse dialog to the specified path.

3. Navigate to the network folder housing the templates and click OK. Alternatively, type the network 
share folder path in the Location field. 

NOTE: 
– Only network share folder paths are supported. For example, the folder path should look like 

\\ServerName\SharedFolderName. Standard paths are not supported.
– To point the server back towards the default folder, delete the network share path.

4. Click Save.

Enabling Conversation Detail reporting

NOTE: 
• Conversation Detail reporting is available for email, chat, SMS, and open media only. Multimedia Trace 

reports provide commensurate data on voice, email, chat, SMS, and open media.
• After enabling Conversation Detail reporting, data must be summarized for the applicable date ranges.

Conversation Detail reports illustrate, by device, how interactions transition through your system and 
provide a high-level view of how customer interactions were handled. For more information on Conversa-
tion Detail reporting, see the reports guide appropriate to your MiContact Center Business licensing level.
To populate Conversation Detail reports with data, you must enable Conversation Detail reporting for the 
media server.
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To enable Conversation Detail reporting 
1. Select Multimedia > Media servers.
2. Select the media server and click the Data Summary Options tab.

3. Select Conversation detail reporting.

4. Click Save.

Adding email to Multimedia Contact Center

Adding email enables Multimedia Contact Center to retrieve a contact center’s email from an email server 
and route interactions to the appropriate queues and agents. To see supported mail servers and mail 
server requirements, see "Integrating Multimedia Contact Center with mail servers" and "Mail server 
requirements".
Administrators can add only a single email media server to YourSite Explorer. Before deleting an existing 
media server, see "Deleting multimedia media servers" for important information.
NOTE: Administrators must configure SMTP and IMAP or EWS connections to Multimedia Contact Center 
before adding email. See the appropriate sections of this guide for relevant information and procedures.
To add email to Multimedia Contact Center, administrators must 
• Add an email media server to YourSite Explorer
• Specify the media server's name and site
• Apply inbound routing rules to contacts retrieved from the email server
• Associate mail servers to the email media server, to begin routing

See below for the corresponding procedures. To disassociate mail servers from the email media server, 
see "Disassociating mail servers from email media servers".
Optionally, administrators can 
• Create Response workflows 

See "Applying response routing rules to interactions".
• Specify Data Summary Options, such as indicating that the contact center operates 24 hours a day 

See "Extending reporting and agent shifts over midnight".
• Specify advanced configuration options for handling email, such as customizing case and ticket 

number information in email subject lines 
See "Configuring Advanced options for email media servers".

To add an email media server to YourSite Explorer 
• Click the Multimedia tab and select Media servers > Add > Email.
To specify the media server’s name and site 
1. Select the email media server and click the General tab.
2. Type a Name to identify the server for management and reporting purposes. 

NOTE: The Media Server ID field is populated with a unique number after the media server is saved.
3. After Site, click the Browse button and select the media server’s location. 

To add a new site, see "Adding sites".
4. Click Save.

To apply inbound routing rules to contacts retrieved from the email server 
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• See "Applying inbound routing rules to interactions".
To associate mail servers to the email media server 
1. On the General tab, after Mail Server(s), click the Browse button.
2. Select any email accounts to associate to Multimedia Contact Center and click OK. 

NOTE: All outgoing email is sent through these accounts, and the system retrieves emails from the 
accounts' associated Inboxes.

3. Click Save.

Configuring Advanced options for email media servers

Configuring Advanced email options enables administrators to
• Customize case and ticket number information in email subject lines

NOTE: Using aliases or distribution groups ensures that an email sent to two contact center 
addresses will share the same case number. A single email sent to addresses on different mail 
servers will generate different case numbers. For more information, see "Integrating Multimedia 
Contact Center with mail servers".

• Remove case and ticket numbers from email subject lines

The following configurations take place in Multimedia > Media servers.
To customize case and ticket number information in email subject lines
NOTE: 
• This option must be enabled for preferred agent routing to function. See "Routing contacts with the 

Offer to Preferred Agent activity".
• This option must be enabled to search contact history by case in Ignite.

1. Select the media server and click the Advanced tab.
2. Deselect Disable auto case and ticket number generation.

3. After Case Prefix:, specify the prefix identifying case numbers.

4. After Ticket Prefix:, specify the prefix identifying ticket numbers.

5. Click Save.

To remove case and ticket numbers from email subject lines
1. Select the media server and click the Advanced tab.
2. Select Disable auto case and ticket number generation.

3. Click Save.

Disassociating mail servers from email media servers

If administrators intend to delete a mail server, we recommend first disassociating it from the email media 
server several days in advance. This allows pending emails to clear the system, before the mail server is 
deleted.
To disassociate a mail server from an email media server
1. Click YourSite > Media servers and select the email media server.
2. On the General tab, after Mail Server(s), click the Browse button.

3. Select the check boxes beside the mail servers to be disassociated from the email media server.
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4. Click OK.

5. Click Save.

Adding chat to Multimedia Contact Center

NOTE: If you are using Contact Center Messenger Chat, for more information see "Adding Contact Center 
Messenger to Multimedia Contact Center".
Adding chat enables Multimedia Contact Center to route chat sessions to the appropriate queues and 
agents. The chat media server resides as a service within the CCMWa web application, which is used to 
manage chat sessions and is automatically installed on the Enterprise Server at http://<Enterprise 
Server>/CCMWa (visible in a chat server’s ‘Internal URL for chat root’ field).
To offer chat, the chat media server requires that a reverse proxy be set up to offer CCMWa from the 
Enterprise Server to the contact center’s web server. A chat media server can be added and configured 
and be tested internally without a reverse proxy by using the Internal URL for chat root as the External 
URL for chat root, but it will not be available for a contact center’s customers. For information on offering 
chat, setting up reverse proxies, and configuring chat request and chat session settings, see "Enabling 
chat". For information on setting up CCMWa with a reverse proxy, see "Publishing Chat and Contact Us 
to the Internet using reverse proxies".
CCMWa is made available from the Enterprise Server to the contact center’s web server through a 
reverse proxy. Before adding the chat media server to Multimedia Contact Center, you must have first set 
up the reverse proxy for http://<enterprise server>/CCMWa. This external-facing URL must be entered in 
the ‘External URL for chat root’ field, which validates the URL and confirms that the reverse proxy has 
been applied correctly. Valid URLs are confirmed with a green checkmark icon. Invalid URLs are indicated 
with a red X icon. URLs that the system cannot confirm are marked with a question mark icon.
To add chat to Multimedia Contact Center, administrators must 
• Add a chat media server
• Specify information for the chat media server, including name, site, URL, and auto response username
• Modify the Default Inbound Chat workflows 

See "Applying inbound routing rules to interactions".
• Modify the Default Response routing rules to Chat 

See "Applying response routing rules to interactions".

Optionally, administrators can 
• Make the chat media server historical
• Specify Data Summary options 

See "Extending reporting and agent shifts over midnight" and "Specifying when Make Busy and Do 
Not Disturb timers begin".

• Specify advanced configuration options for chat servers, such as enabling alarms and configuring 
reporting intervals for queues 
See "Configuring Advanced options for chat media servers".

To add a chat media server 
• Click the Multimedia tab and select Media servers > Add > Chat. 

NOTE: Default Inbound and Response Chat workflows are assigned to the server. Modify these 
workflows to specify routing rules for the contact center. See "Default Chat Inbound workflow" and 
"Default Chat Response workflow".
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To specify the chat media server’s name, site, external URL for chat root, Auto Response Username, and 
configure default workflow email activities 
1. After Name, type the name of the media server. 

NOTE: To distinguish between the various types of media for management and reporting purposes, 
you must give each media server a unique name when setting up your site.

2. After Site, click the Browse button to select the site where the chat server resides. 

To add a site, see "Adding sites".
3. Enter the External URL for chat root. 

The External URL for chat root is the URL used with the reverse proxy to make chat externally avail-
able. Valid URLs are confirmed with a green checkmark icon. Invalid URLs are indicated with a red X 
icon. URLs that the system cannot confirm are marked with a question mark icon.

NOTE: The Invalid URL icon may display until a complete and valid URL is entered.
4. After Auto Response Username, enter the name to be used for sending automated messages to 

contacts.

5. Click the Inbound Routing tab and add an SMTP and To: email address destination for all email activ-
ities in the workflow. 

See "Sending emails with the Email activity".
6. Click the Response Routing tab.

7. Right-click the Email activity and select Edit SMTP server.

8. Select a mail server and click OK.

9. Click Save.

To make a chat server historical 
1. Select a Chat media server and click the General tab.
2. Click Make historical.

3. Click Save.

Configuring Advanced options for chat media servers

Configuring Advanced chat options enables administrators to 
• Choose to use employees’ nicknames in chat interactions. 

NOTE: By default, employees are identified by their first name (as configured in the Employee device 
page in YourSite Explorer) in chat sessions. If employees have nicknames associated with them in 
their Employees entry, these can be used instead.

• Set the amount of time a closed chat session can remain idle before being terminated 
NOTE: If customers accidentally exit the browser or close the chat window, this configuration deter-
mines how long they have to return to the live chat session. Customers can re-access the session 
by returning to the business site and re-entering the chat request.

• Change the reply template location from the default 
For more information on reply templates, see "Configuring response templates for email and chat".

The following configuration takes place in Multimedia > Media servers.
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To use employee nicknames in chat interaction public interactions 
1. Select the chat media server and click the Advanced tab.
2. Select the Use agent nickname for public interaction check box. 

Employee nicknames are configured in Multimedia > Employees in the Profile tab.
3. Click Save.

To configure how long closed chat sessions remain idle before being terminated
NOTE: If customers accidentally exit the browser or close the chat window, this configuration determines 
how long they have to return to the live chat session. Customers can re-access the session by returning 
to the business site and re-entering the chat request
1. Select the chat media server and click the Advanced tab.
2. After Terminate closed chat sessions that are idle for longer than the specified minutes, set the 

number of minutes. 

NOTE: For Contact Center Messenger Chat media server, you can set the number of minutes to 0 which 
specifies the session is disabled or to 10 minutes or higher.
3. Click Save.

To change the location of the reply templates 
1. Select the chat media server and click the Advanced tab.
2. After Location, click the Browse button.

3. Select the folder and click OK. 

NOTE: The reply template folder must be located on a UNC (Universal Naming Convention) path, 
also known as a shared network path.

Configuring Contact Center Messenger in YourSite Explorer

To use Contact Center Messenger, you must complete the configuration process as described below:

Connecting CloudLink

1. In YourSite Explorer, go to Enterprise and select the CloudLink tab.
2. Click the Connectto CloudLink button. 
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3. The Cloudlink log-in page is displayed. 
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4. Enter the username and password and click the log in button. 

NOTE: If the log in fails, the system displays an error message.
5. On successful log in, the YourSite Explorer displays the Disconnect button. 

NOTE: The Disconnect is not displayed in the following scenarios: 
– If you provide the wrong credentials.
– If you click the Cancel button in the Cloudlink log in page before entering the credentials.

Configuring Contact Center Messenger Media Server

After integrating Cloudlink with chat, the Chat media server user interface must be modified.
NOTE: Users must have a valid email address before enabling the Contact Center Messenger Media 
Server.
Creating new CloudLink Chat Media Server
To enable a Contact Center Messenger Media Server, do the following: 
1. In YourSite Explorer, go to Media servers and create a new chat media server. 

For more information on adding a chat media server, see MultimediaContactCenter Installation and 
Deployment Guide.

2. Select the Enabled for CloudLink check box to enable chat media for CloudLink.

3. Click Save to save your changes. 

 After the Enabled for CloudLink check box is selected, the External URL for Chat root and Internal 
URL for chat root fields are not displayed. These fields are displayed only when the Enabled for 
CloudLink check box is cleared. 
NOTE: 

• The Enabled for CloudLink check box is grayed out after you save the chat media server configura-
tion.

• Once the Contact Center Messenger is enabled, the existing CCMWa chat media server stops func-
tioning.
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Enabling Cloudlink for an existing CCMWa chat media server
The administrator can enable Cloudlink for an existing CCMWa chat media server. The administrator can 
use the Enable For Cloudlink button, which is available when MiCC-B is connected to Cloudlink to 
convert the existing CCMWa chat media server to Cloudlink chat media server. 

 Following is the procedure for an administrator to convert CCMWa Chat media server to Cloudlink Chat 
media server: 
1. In YourSite Explorer, go to Media servers > Chat Media Server.
2. Click the Enable For Cloudlink button. A pop-up is displayed for the administrator to confirm conver-

sion of the existing CCMWa chat media server to Cloudlink chat media server. 

NOTE: The Enable For Cloudlink button is available only if MiCC-B is connected to Cloudlink.
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3. Click OK to confirm. 

YourSite Explorer checks the CCMWa for active chats in the IVR, and chats in queue, in an inbox, or 
on hold.
YourSite Explorer terminates the process if there are any active chats in the IVR, or chats in a queue, 
in an inbox, or on hold. The administrator is notified that the active chats must be cleared before the 
conversion can be processed.
After the chats are cleared, YSE converts the media server, queues associated with the media server, 
and the employees who have active real time agents associated with the media server.
After completion of the process, a pop-up dialog opens confirming that the existing CCMWa chat me-
dia server is converted to Cloudlink chat media server.

Configuring Chat Queue

After the new chat media server is created in YourSite Explorer and the chat media is enabled for 
Cloudlink, the External URL for Chat root and Internal URL for chat root fields disappear from the 
Chat options tab.

Disconnecting Cloudlink

After successful log in of the Client in the CloudLink platform, YourSite explorer displays Disconnect 
from CloudLink button.
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Click the Disconnect from CloudLink button to terminate the connection between the CloudLink plat-
form and the MiCC-B. The CloudLink Client is logged out and CloudLink features are disabled for all the 
users.

After CloudLink is successfully disconnected, the CloudLink tab again displays Connect from CloudLink 
button.

Adding SMS to Multimedia Contact Center

Adding SMS enables Multimedia Contact Center to route SMS interactions to a contact center’s SMS 
numbers to the appropriate queues and agents. The SMS media server integrates with a third-party SMS 
gateway service provider to enable SMS interactions.
Administrators may add only a single SMS media server to YourSite Explorer. Before deleting an existing 
media server, see "Deleting multimedia media servers" for important information.
Optionally, SMS handling for agents in Ignite can be modified through editing JavaScript files. See 
"Configuring the agent configuration JavaScript file".
NOTE: SMS media servers require a Twilio account. For more information, see "Integrating Multimedia 
Contact Center with an SMS Gateway Provider".
To add SMS to Multimedia Contact Center, administrators must 
• Add an SMS media server to YourSite Explorer 

See the procedures below.
• Specify the media server’s connection to an SMS gateway services provider 

See the procedures below.
• Apply inbound routing rules to interactions retrieved from the email server. 

See “"Applying inbound routing rules to contacts".

Optionally, administrators can 
• Create Response workflows 

See "Applying response routing rules to contacts".
• Specify advanced configuration options for handling SMS, such as enabling alarms and configuring 

reporting intervals for queues. 
See "Configuring Advanced options for media servers" and see "Configuring Advanced options for 
SMS media servers".

• Specify Data Summary options, such as indicating that the contact center operates 24 hours a day. 
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See "Extending reporting and agent shifts over midnight","Specifying when Make Busy and Do Not 
Disturb timers begin", and "Enabling Conversation Detail reporting".

The following procedures explain how to 
• Add an SMS media server
• Specify information for an SMS media server
• Add an SMS Provider
• Modify an SMS Provider
• Remove an SMS Provider
• Make an SMS media server historical

The following configuration takes place in Multimedia > Media servers.
To add an SMS media server 
• Click Add > SMS. 

NOTE: Default Inbound are assigned to the server. Modify these workflows to specify routing rules 
for the contact center. See "Default SMS Inbound workflow".

To specify information for an SMS media server 
1. Type the Name of the media server. 

NOTE: The media server ID field is populated with a unique number after the media server is saved.
2. After Site, click the Browse button to select the site where the SMS server resides.

3. Click Save.

To add an SMS Provider 
1. In the General tab, after SMS Provider, click the Browse icon.
2. Click Add.

3. Enter a Name for the SMS Provider.

4. Enter the PhoneNumber (including country code) for the Twilio SMS phone number. 

NOTE: You must include country and area code
5. If this SMS number handles inbound SMS interactions, set Retrieve incoming SMS messages to 

True.

6. If this SMS number only sends outbound SMS messages, set Retrieve incoming SMS messages 
to False.

7. Enter your Twilio AccountSid.

8. Enter your Twilio Authentication Token,

9. After Days to Search, set how many days back Twilio will check for new SMS interactions. 

The recommended default is 3.
10. After Messages/page, set how many pages of messages MiContact Center Business downloads 

when checking for new messages. 

The recommended default is 25.
11. Click Save.

12. Repeat steps 2-11 for each additional SMS Provider you want to add to your SMS media server.
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13. For each SMS Provider that you are adding, confirm that its checkbox is selected.

14. Click OK.

15. Click Save.

To modify an SMS Provider 
1. In the General tab, after SMS Provider, click the Browse icon.
2. Select the SMS Provider and click Edit.

3. Modify the settings.

4. Click Save.

5. Click OK.

6. Click Save.

To remove an SMS Provider 
1. In the General tab, after SMS Provider, click the Browse button.
2. Clear the checkbox beside the SMS Provider.

3. Click OK.

4. Click Save.

To make an SMS media server historical 
1. Select an SMS media server and click the General tab.
2. Click Make historical.

3. Click Save.

Configuring Advanced options for SMS media servers

Configuring Advanced SMS options enables administrators to 
• Set the amount of time an SMS session can remain idle before being terminated. 

NOTE: This configuration determines how long a customer or agent cannot participate in an SMS 
session before the system ends the SMS session. Customers can continue their SMS interactions 
with an agent by sending a new SMS interaction to the contact center.

• Change the reply template location from the default 
For more information on reply templates, see "Configuring response templates for email, chat, SMS, 
and open media".

The following configuration takes place in Multimedia > Media servers.
To set the amount of time an SMS session can remain idle before being terminated 
1. Select the SMS media server and click the Advanced tab.
2. After Terminate SMS sessions idle for longer than the specified minutes, set the amount of time 

an SMS session can remain idle.

3. Click Save.

To change the location of the reply templates 
1. Select the SMS media server and click the Advanced tab.
2. After Location, click the Browse button.



772

CONFIGURING YOUR MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

3. Select the folder and click OK. 

NOTE: The reply template folder must be located on a UNC (Universal Naming Convention) path, 
also known as a shared network path.

4. Click Save.

Configuring Workload

Employees handling multimedia interactions must be associated with a Workload. Workload determine 
the number and type of media interactions that can be pushed to an agent at any one time. When 
employees become licensed for Multimedia Contact Center, they are automatically assigned the default 
Workload, which allows concurrent handling of 1 interaction from each media type.
When an employee reaches their maximum Workload for a media type, their agent is put into Make Busy 
with the Overloaded reason code. When an employee is Overloaded, the employee will not be offered 
inbound interactions for that media type. This state is automatically removed when they are no longer at 
their maximum Workload. Employees in Ignite who have reached their maximum concurrent interactions 
in one type of media are still able to pick interactions from the corresponding media’s queues and receive 
transfers from other agents.
A default Workload is provided with Multimedia Contact Center. The default Workload can be modified, 
but not deleted. The following figure shows the default Workload.

Figure 24.1: Default Workload
 

Administrators can create Workloads and assign them to employees as necessary. There are two areas 
of configuration required for Workloads for each media type: 
• Concurrent contacts: This column of drop-down menus allows an administrator to set how many 

interactions of each type of media an employee can handle concurrently.
• Avoid routing to this media type when current media type is active: This matrix enables adminis-

trators to prevent certain media types from being offered to employees when they are handling a higher 
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priority of media. When an employee is handling a media that filters another kind of media, the 
employee’s agents for the blocked media are set into Make Busy. The disallowing of media is recip-
rocal, so that if Chat is disabled when handling Voice, then Voice would be disabled when handling 
Chat. 

NOTE: 
– Agents can still pick and receive transferred interactions of the disallowed media type.
– If you do not want agents to receive multiple ringing interactions of different media types, configure 

this option

The following configuration takes place in Multimedia > WorkLoad.
The following procedures explain how to: 
• Create a new Workload
• Modify an existing Workload
• Delete a Workload

NOTE: We recommend disassociating a Workload from all employees before deleting it.
To create a new Workload 
1. Click Add.
2. Type a Name for the Workload.

3. To apply the Workload to outgoing voice calls, select Apply rule to outgoing voice calls.

4. For each media type, under Concurrent contacts, select the maximum number of connections of that 
media type that can be handled concurrently.

5. For each media type, click the icons of the media you do not want employees to concurrently handle 
when handling that type of media.

6. Click Save.

To modify an existing Workload 
1. Select a Workload
2. When you are done modifying the Workload, click Save.

To delete a Workload 
1. Select a Workload and click Delete.
2. Click OK.

Adding multimedia capabilities to employees

Contact center employees handing multimedia must be licensed for Multimedia Contact Center.
Administrators can add multimedia capabilities to employees on an employee-by-employee basis, or they 
can select a number of existing employees and add multimedia capabilities to multiple employees at the 
same time.
For more information on employee licensing or for instructions on creating new employees in YourSite 
Explorer, consult the "Adding employees".
The following sections explain 
• Licensing requirements for employee multimedia capabilities
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• How to configure Multimedia Contact Center employee licensing
• How to assign employee Workload
• How to manage the media types an employee can handle
• How to restrict supervisors from seeing all the queues

Licensing requirements for employee multimedia capabilities

Employees consume a Multimedia Agent license when they are enabled to handle email, chat, or SMS. 
Employees handling multiple multimedia types do not consume additional Multimedia Agent licenses. 
Removing an employee’s ability to handle multimedia unlicenses the employee. For information on 
enabling employees to handle multimedia types, see "Managing the media types an employee can 
handle".
Employees licensed as Advanced supervisors or System Administrators may search Ignite’s entire repos-
itory. This includes Ignite's In Progress folder (DESKTOP), which enables supervisors to see interactions 
currently in agent Inboxes. This search capability does not require Multimedia Contact Center licensing. 
However, to view and search interactions in queue using Ignite, employees must have a Multimedia 
Contact Center license and multimedia agents assigned to the queue.

Managing the media types an employee can handle

Employees handle media through their associated agents. The General tab of an employee contains 
buttons representing each media type that has a configured media server. When a button is selected, an 
agent of that media type is automatically created and associated to the employee. The following table 
contains an explanation of which buttons correspond to which media type.
Table 24.2:Media Buttons  (Sheet 1 of 2)

MEDIA TYPE MEDIA BUTTON

Voice

Chat

Email

SMS



775

CONFIGURING YOUR MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

NOTE: Employees must be licensed to handle non-voice media. See "Configuring employee 
licensing"and  "Licensing requirements for employee multimedia capabilities".
When you remove the employee's ability to handle non-voicemedia, the employee's agents are made 
historical. Historical agents are disabled for real-time monitoring and data collection. If the employee is 
re-enabled to handle thatnon-voice media, then their agent will be made active again. Multimedia agents 
can be deleted to be removed entirely from the system.
NOTE: Failover media servers for voice agents must be configured on your telephone system and synchro-
nized into YourSite Explorer. Workgroup does not support Contact Center resiliency. You cannot program 
failover media servers for ACD agents and extensions.
The following procedures explain how to: 
• Enable an employee to handle voice media
• Edit an employee’s voice agent
• Enable an employee's voice agent for external hot desking
• Enable an employee to handle voice media using an existing agent
• Remove a voice agent from an employee
• Enable an employee to handle multimedia
• Remove an employee's ability to handle multimedia
• Delete a multimedia agent

The following configuration takes place in YourSite > Employees.
To enable an employee to handle voice media 
1. Select an employeeand click the General tab.
2. Under Devices, click the Voice button 

A voice agent and extension are automatically created for the employee.
By default, the extension type is voice softphone, which emulates a 5020 IP set.
For information on configuring extensions for employees, see Managing employee extensions and 
Account Codes for employees
By default, the extension reporting number/dialable is populated with the employee’s business phone.

3. Optionally, change the agent’s First name.

4. Optionally, change the agent’s Last name.

5. Optionally, after Agent login ID, enter the reporting number for the voice agent.

6. After Media server, click the Browse button.

7. Select a media server and click OK.

8. If you want to disable real-time monitoring and data collection for this agent, select Disable real-time 
monitoring and data collection on this device.

Open Media

Table 24.2:Media Buttons (Continued) (Sheet 2 of 2)

MEDIA TYPE MEDIA BUTTON
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9. If a 3300 media server was selected, after COS, select a Class of Service from the list.

10. If a 3300 media server was selected, optionally, after COR, select a Class of Restriction from the list.

11. Select a media server and click OK.

12. Click Save.

13. Click Save.

To edit an employee’s voice agent 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside the Voice button and click <agent ID> > Edit.

3. Edit the agent’s fields.

4. Click Save.

5. Click Save.

To enable an employee’s voice agent for external hot desking 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside the Voice button and click <agent ID> > Edit.

3. Select External hot desk user enabled.

4. After External dialing prefix, type the dialing prefix for the device to which calls will be routed.

5. After External dialing number, type the dialing number for the device to which calls will be routed.

6. Click Save.

7. Click Save.

To enable an employee to handle voice media using an existing agent 
1. Select an employee and click the General tab.
2. Under Devices, click the down arrow beside the Voice button and click Associate existing voice 

agent.

3. Select an unassigned agent and click OK.

4. Click Save.

To remove a voice agent from an employee 
1. Select an employee and click the General tab.
2. Click the down arrow beside the Voice icon and click <agent ID> > Delete.

3. Select the delete option: 

– Make the device historical—sets the agent as historical, but leaves it associated to this employee
– Disassociate the device—disassociates the agent so it can be used with another employee
– Remove the device from the system—deletes the agent

4. Click OK.

5. Click Save.
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To enable an employee to handle multimedia 
1. Select an employee.
2. Under Devices, click the media button to select which media this employee can handle.

3. Click Save.

To remove an employee's ability to handle multimedia 
1. Select an employee.
2. Under Devices, click the enabled media button.

3. Click Save.

To delete a multimedia agent 
1. Select an employee.
2. Click the down arrow beside the media button and click Delete.

3. Click Save.

Managing Employee Workload

Employees handling multimedia interactions must be associated with a Workload. Workloads determine 
the number and type of media interactions that can be pushed to an agent at any one time. When 
employees become licensed for Multimedia Contact Center, they are automatically assigned the default 
Workload, which allows concurrent handling of 1 interaction from each media type. For more information 
on Workloads, see "Configuring Workload".
The following configuration takes place in YourSite > Employee.
The following procedures explain how to: 
• Associate a Workload to an employee
• Associate a new Workload to an employee
• Edit an existing Workload
• Delete a Workload 

NOTE: We recommend disassociating a Workload from all employees before deleting it.

To associate a Workload to an employee 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Select a Workload. 

Alternatively, if you want to create a new Workload to associate to the employee, click Add.
4. Click OK.

5. Click Save.

To associate a new Workload to an employee 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Click Add.

4. Type a Name for the Workload.
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5. To apply the Workload to outgoing voice calls, select Apply rule to outgoing voice calls.

6. For each media type, under Concurrent contacts, select the maximum number of connections of that 
media type that can be handled concurrently.

7. For each media type, click the icons of the media you do not want employees to concurrently handle 
when handling that type of media. 

NOTE: If you do not want agents to receive multiple ringing interactions of different media types, 
configure this option.

8. Click Save.

To edit an existing Workload 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Select a Workload and click Edit.

4. When you are done modifying the Workload, click Save.

To delete a Workload 
1. Select an employee and click the Advanced tab.
2. After Workload Descriptor, click the Browse button.

3. Click Delete.

4. Click OK.

Setting permissions for supervisors to view queues

By default a supervisor can view all queues. However, for security reasons there can be the need to 
restrict a supervisor from viewing all queues.
NOTE: 
• An Administrator with "System Administrator " or "Advanced" license can restrict viewing of queues by 

setting permissions for viewing queues.
• This restriction can be applied only to employees with "Supervisor" license.

1. Select an employee and click the Advanced tab.
2. Clear the May see all queues check box. 

By default this check box is selected.
3. Click OK.

4. Click Save.

NOTE: 
• If the May see all queues check box is not selected for a supervisor, then in Web Ignite, the supervisor 

can view only the queued interactions, historical interactions, and cases that the supervisor is associ-
ated with.

• It is strongly recommended to program at least one supervisor who can see all queues so that 
outbound interactions that could not be sent or have bounced will be detected when the agent is not 
available to handle.
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Adding employee groups

After adding employees, you add employee groups and associate employees to these groups. Employee 
groups enable you to report on specific groups of employees.
If you intend to use security roles to restrict employees from elements of Ignite, it is recommended that 
you create employee groups whose membership duplicates that of your agent groups. For more informa-
tion on Multimedia Contact Center and security roles, see "Multimedia Contact Center security settings".
The following procedures explain how to:
• Add an employee group
• Associate an employee with an employee group
• Remove an employee from an employee group

To add an employee group
1. Click Multimedia > Employee groups.
2. Click Add.

3. Type the employee group’s Name.

4. Type the Employee group ID.

5. Click Save.

To associate an employee with an employee group
1. Click Multimedia > Employee groups.
2. Select an employee group from the list.

3. On the Membership tab, under Available members, select an employee and click > to move the 
employee to the Selected members list.

4. Click Save.

To remove an employee from an employee group
1. Click Multimedia > Employee groups.
2. Select an employee group from the list.

3. On the Membership tab, under Selected members, select an employee and click < to move the 
employee to the Available members list.

4. Click Save.

Adding voice agent IDs

Agent IDs enable employees to handle different media and to be reported on and tracked in real time. 
When an administrator enables an employee to handle a type of media, the employee has an agent ID of 
that media type automatically created. A contact center employee can have multiple voice agent IDs, but 
requires a unique agent ID for each of the other media types (email, chat, SMS, and open media) that 
they handle.
Voice and multimedia agent IDs are added in the Employee section of Multimedia Contact Center. To add 
different media agent IDs to an employee, see "Managing the media types an employee can handle". 
Voice agents can be created in the Agent section of Multimedia Contact Center, but it is recommended 
to create agents within the Employee section. The Agent section also enables administrators to delete 
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agent IDs. Deleting an active multimedia agent removes an employee's capabilities to handle the corre-
sponding media. Historical multimedia IDs can only be deleted in the Agent section.
In Multimedia Contact Center > Agents, administrators 
• Add voice agent IDs
• Delete agent IDs
• Associate unassociated voice agent IDs to employees
• Specify 3300 ICP Class of Service, Class of Restriction, and Failover media server options for voice 

agent IDs
• Enable a voice agent for external hot desking

To add a voice agent ID 
1. Click Multimedia > Agents.
2. Click Add.

3. If you want to associate the new voice agent ID to an employee, click the Browse button after 
Employee. 

Selecting an employee will automatically fill in the First name and Last name fields with the employ-
ee’s name.

4. Type the voice agent ID's First name.

5. Type the voice agent ID's Last name.

6. After Agent login ID, enter the reporting number for the voice agent ID.

7. After Media Server, click the browse button.

8. Select a media server and click OK.

9. Click Save. 

NOTE: The Disable real-time monitoring and data collection on this device check box is automatically 
selected if the employee that is associated to this agent has their licensing attribute set to 'None'.
To configure 3300 ICP options for a voice agent ID 
1. Click Multimedia > Agents.
2. Select an agent from the list.

3. Under 3300 ICP Options, after COS, select a Class of Service from the list.

4. After COR, select a Class of Restriction from the list.

5. After Failover media server, click the Browse button.

6. Select a failover media server from the list and click OK. 

Workgroup does not support Contact Center resiliency. You cannot program failover media servers 
for ACD agents and extensions.

7. Click Save.

To enable a voice agent for external hot desking 
1. Click Multimedia > Agents.
2. Select an agent from the list.

3. Select External hot desk user enabled.
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4. After External dialing prefix, type the dialing prefix for the device to which calls will be routed.

5. After External dialing number, type the dialing number for the device to which calls will be routed.

6. Click Save.

To delete an agent ID 
1. Click Multimedia > Agents.
2. Select an agent.

3. Click Delete.

4. Click OK.

To associate an unassociated voice agent to an employee 
1. Click Multimedia > Agents.
2. Select an unassociated voice agent ID.

3. After Employee, the Browse button.

4. Select an employee and click OK.

5. Click Save.

Adding agent groups

Administrators must add agent groups to the YourSite database and associate employees to these agent 
groups. An employee and their agents can be associated to more than one agent group.
When agent groups are created, an employee’s agents are assigned a default group presence, either 
Present or Absent. Employees whose agents’ default presence is Absent will be set in the Logged In Not 
Present Agent state when they join their agent group. To handle that media type, the employee must 
change their agent state manually in Ignite or Contact Center Client. Employees whose agents’ default 
presence is Present will be set in the Idle Agent state when they join their agent group. For details about 
Agent States, see "Employee and Agent state indicators".
If you are upgrading to Multimedia Contact Center version 8.1, agent groups can be modified automati-
cally through the Unified Queue Group Wizard to support new types of media. The Unified Queue Group 
Wizard, located in the Queue device page in YourSite Explorer, if selected, updates agent groups that are 
associated to selected voice queues and adds the ability for these agent groups to also handle, for 
example, chat and email queues. For more information on the Unified Queue Group Wizard, see "Adding 
a Unified queue group".
NOTE: 
• If an administrator attempts to add a group to YourSite that is already in the database the system noti-

fies the administrator that the group is already present. When an administrator adds a series of groups 
to YourSite, such as Queue Groups 1 to 5, if the system detects the administrator has already added 
Queue Group 3, then it will not add Queue Group 3 or any subsequent queues in the series (that is, 
Queue Group 4 or 5) to the database.

• Deleting an agent group that is currently the last member of a voice or multimedia queue will invalidate 
that queue. Deleting an agent group that is associated to an activity in an Inqueue workflow will create 
a validation error. The queue will not be able to be saved until another agent group is associated to it. 
It is recommended that you disassociate agent groups from queues and their associated Inqueue 
workflows before deleting the agent group.
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• Workgroup does not support Contact Center resiliency. You cannot program failover media servers for 
ACD agents and extensions.

To set up an agent group, administrators must: 
• Add an agent group
• Manage agent group membership, presence, and skill level
• Specify agent group options for the 3300 ICP media server

The following procedures explain how to: 
• Add an agent group
• Disable monitoring and device collection for an agent group
• Specify if the agent group uses skills

The following configuration takes place in Multimedia > Agent groups.
To add an agent group 
1. In Agent groups, click Add.
2. Type a Name for the agent group.

3. Type a Reporting number for the agent group.

4. Select the media type(s) the agent group will handle. 

See the following table.

5. If you select voice media, select the voice media server and click OK. 

Table 24.3:Media icons

Media Type Media Icon

Voice

 

Chat

Email

SMS

Open Media
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NOTE: If this agent group is not handling voice interactions, then this option will not be available.
6. Click Save.

To disable monitoring and device collection for an agent group 
1. Select an agent group.
2. Select Disable real-time monitoring and data collection on this device.

3. Click Save.

To specify if the agent group uses skills 
1. Select an agent group
2. Select The group uses skills.

3. Click Save.

Managing agent group membership, presence, and skill level

After configuring an agent group, administrators must associate employees to the agent groups and 
specify the default presence for each of the employee’s agent IDs for the media types the agent is config-
ured to handle. If the agent group uses skills, skill levels must be set for each employee. Skill levels range 
from 1, which is the most skilled, to 255, which is the least skilled. The skill level assigned to the employee 
is applied to each media the employee is capable of handling.
Some employees may have multiple voice agents associated to them. When these are added to an agent 
group, they are highlighted in yellow. Administrators can select which of an employee’s voice agents are 
in the agent group. It is recommended that an employee only have one voice agent associated to an agent 
group.
The following procedures explain how to 
• Add employees to an agent group
• Specify which of an employee’s multiple voice agents are in an agent group
• Specify a member's default presence in an agent group
• Specify a member's skill level
• Edit a member employee
• Remove a member from an agent group

The following configuration takes place in Multimedia > Agent groups.
To add employees to an agent group 
1. Select an agent group and click the Membership tab.
2. To add employees to the agent group, click Add.

3. Select the employees to add to the agent group and click OK.

4. Click Save.

To specify which of an employee’s multiple voice agents are in an agent group 
1. Select an agent group and click the Membership tab.
2. Under Selected members, select the employee with multiple voice agents.

3. Click Voice agent options.

4. Select the voice agent to be present in this agent group and click OK.
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5. Click Save.

To specify a member’s default presence in the agent group 
1. Select an agent group and click the Membership tab.
2. In the Default <media type> Presence column of the member's row, click the cell and select the 

default presence. 

– Absent—the employee’s agent ID will be put into the Logged in Not Present agent state when they 
join the agent group.

– Present— the employee’s agent ID will be put into Idle when they join the agent group.

3. Repeat Step 2 for each media type the member can handle in the agent group.

4. Click Save.

To specify a member’s skill level 
1. Select an agent group and click the Membership tab.
2. In the Skill level column of the member's row, select a skill level from the drop-down list.

3. Click Save.

To edit a member employee 
1. Select an agent group and click the Membership tab.
2. Select an employee and click Edit. 

For information on configuring employees, see the "Adding employees".
3. When you are done editing the employee, click Save.

To remove a member 
1. Select an agent group and click the Membership tab.
2. Select a member and click Delete.

3. Click Save.

Specifying 3300 ICP options for agent groups

The following configuration takes place in Multimedia > Agent groups
To specify 3300 ICP options for an agent group
1. Select an agent group from the list.
2. On the 3300 ICP options tab, if you want to change your Skill Group ID, after Skill Group ID, enter a 

new ID.

3. Click Browse and select a failover media server.

Workgroup does not support Contact Center resiliency. You cannot program failover media servers 
for ACD agents and extensions.

4. Specify if the agent group uses skills and if calls are to be queued to the agent group when no agents 
are logged in.

5. Click Save.
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Adding multimedia queues

When you create a multimedia queue, it is automatically associated to the existing media server for that 
type of media. Your multimedia media servers must already be configured before you can add a multi-
media queue of that media type.
When adding a queue, administrators must 
• Configure general multimedia queue settings
• Configure multimedia queue membership and routing
• Configure multimedia queue performance settings
• Configure queue spectrum settings for multimedia queues

Depending on the media type, administrators must also 
• Configure email options 

– Apply signatures to email queues
• Configure chat options
• Configure SMS options
• Configure open media options

To add a multimedia queue 
1. Click Multimedia > Queues.
2. Click Add and select <media type> Queue.

Configuring general settings for multimedia queues

When configuring general information for multimedia queues, administrators configure the basic settings 
for the queue that are required to be configured before the queue can be saved.
NOTE: For email queues not automatically requeuing interactions on agent logout, emails are put on hold 
until the agent logs back in and removes hold. Once the hold requeue time expires, interactions are 
requeued whether the agent is logged in or not.
To configure general settings for a multimedia queue
1. Select a queue and click the General tab.
2. Type a Name for the queue.

3. Type a Reporting number for the queue.

NOTE: For Unified queue groups, when the reporting number is the same for all queues in the group, 
the queue ID must be entered in this field instead of the queue reporting number.

4. The Members field is auto-populated after an agent group has been added as a destination to the 
Inqueue workflow. Clicking the link opens the applicable agent group page, enabling you to make 
changes or view the configuration.

5. For Email queues, after Email address, click the Browse button.

6. Type the queue's email address and click Add.

The Email queue’s email address identifies the queue to which the system will route the email. The 
email address can correspond to an email address included in a mail server distribution list or it can 
be internal to the Multimedia Contact Center. For information on configuring mail servers, see "Inte-
grating Multimedia Contact Center with mail servers".
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NOTE: 
– We do not recommend assigning the same email address to multiple queues.
– Using the <<DestinationQueues>> variable for routing with the Transfer activity requires email 

queues to have an associated email address. For more information on the <<DestinationQueues>> 
variable, see "Routing contacts with the Transfer activity".

– If you use the <<DestinationQueues>> variable for routing with the Transfer activity and have 
multiple queues associated to the same email address, the system routes emails to the first config-
ured queue only. We do not recommend assigning the same email address to multiple queues.

– For agents to select queue email addresses as the ‘From’ address in email responses and outbound 
emails, the addresses must be associated to a mail server which is associated to the media server 
for the queue. Administrators must configure primary and secondary queue email addresses as 
either the mail server’s ‘From Email Address’ or ‘Alias’. See "Configuring SMTP connections to Multi-
media Contact Center".

– An Email queue can be saved without an email address added, in which case the queue uses the 
SMTP email address assigned to the mail server as the "from" email address. To ensure proper 
response functionality, however, an email address must be set for the Email queue.

– If the queue email address uses an alias, ensure that the alias has been added to the mail server. 
An alias can be used with only one queue. For more information about adding aliases to the mail 
server, see "Configuring SMTP connections to Multimedia Contact Center".

7. If you want to associate additional email addresses to the email queue, for each additional email 
address, type the address and click Add.

Alternatively, to import all of the email addresses and aliases associated to the mail servers associat-
ed to your enterprise, click Pull From Mail Server(s).
The first email address in the list is always considered the primary email address for the queue that 
is used as the From address when an agent responds to an email address in this queue. Each sub-
sequent email address is considered an alternative email address.
You can adjust the order of the email addresses by selecting an address and clicking the Up and 
Down buttons.

8. Click Ok.

9. For Chat queues, type a Username.

The Chat queue’s auto response username is used with workflow activities that provide automated 
responses to interactions in queue.

10. For SMS queues, type a Phone number.

SMS numbers must not use dashes or parentheses and must include both a country and area code. 
SMS queues can only have one SMS phone number associated to them. An SMS;number can be 
used for multiple queues, with some restrictions. For more information, see "Integrating Multimedia 
Contact Center with an SMS Gateway Provider".

11. If you do not want the queue to be viewed in Contact Center Client and Ignite, select Disable 
real-time monitoring and data collection on this device.

12. Click Save.

To edit an email queue’s email addresses
1. Select an email queue and click the General tab.
2. After Email address, click Browse.
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3. To add an email address to the queue, enter the email address and click Add.

4. To change the order of email addresses, select an email address and click the Up or Down buttons.

The first email address is the queue’s primary email address.
5. To remove an email address, select the email address and click Remove.

6. Click OK.

7. Click Save.

Configuring multimedia queue membership and routing

When a queue is created, a copy of the Default Inqueue email, chat, SMS, or open media workflow is 
created and assigned to the queue. In each of the Offer to Agent Group activities in these workflows, the 
handling agent groups must be specified. An agent group can only be associated with one Offer to Agent 
Group activity in an Inqueue workflow. For more information on configuring Offer to Agent Group activi-
ties, see "Routing contacts with the Offer to Agent Group activity".
If your default Inqueue workflow uses Email activities as auto responses, you will need to specify the 
SMTP servers as well. The default email messages assigned to Email activities in the Inqueue workflow 
should be reviewed and customized as required. After assigning agent groups in the Inqueue workflow, 
administrators can review them in the General tab. Agent groups are listed, in the order from the Inqueue 
workflow, in the Members field. Administrators can click the name of the agent group to open that agent 
group’s page in YourSite Explorer.
Once you have configured your Inqueue workflow, you must enable validation for the workflow. Validation 
prevents workflows with invalid or incomplete configuration from being used.
If you have an existing Inqueue workflow you would like to use for routing, you can assign it to the queue 
from Workflows. For information on assigning Inqueue workflows to queues, "Associating workflows to 
queues".
For more information about the Default Inqueue workflows, see "Multimedia Contact Center default work-
flows".
The following procedures explain how to: 
• Set which agent group handles interactions
• Enable workflow validation
• Set the SMTP servers in an Email activity
• Prevent overflow on the final Offer to Agent Group activity

The following procedures take place in Multimedia > Queues.
To set which agent group handles interactions 
1. Select a queue and click the Inqueue workflow tab.
2. Right-click on the Offer to Primary Agent Group activity and select Agent group.

3. Select the agent group who will handle this queue and click OK.

4. For each subsequent Offer to Agent Group activity in the workflow, repeat steps 2-3 to set all of the 
answering agent groups.

5. Click Save.
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To enable workflow validation 
1. Select a queue and click the Inqueue workflow tab.
2. In the Properties pane, select Validate workflow.

3. Click Save

To set the SMTP servers in an Email activity 
1. Select a queue and click the Inqueue workflow tab.
2. Right-click on the Email activity and select Edit SMTP Server.

3. Select a SMTP server and click OK.

4. Click Save.

To prevent overflow on the final Offer to Agent Group activity 
1. Select a queue and click the Inqueue workflow tab.
2. Select the final Offer to Agent Group activity.

3. In the Properties pane, select Do Not Allow Overflow.

4. Set the Overflow Time to 0:00:00.

5. Click Save.

Configuring multimedia queue performance settings

When configuring a multimedia queue, administrators set the priority of the queue, the queue’s business 
hours, the Queue Work Timer options, set the Service Level objectives, and set the queue handling times. 
Note that Multimedia Queue Work Timer functions independently of Class of Service Work Timer. Queue 
Work Timer options enable queues to change their Work Timer duration to be different than the Class of 
Service Work Timer.
The following procedures explain how to: 
• Set queue priority
• Configure the business hours for a queue
• Apply the business hours to all queues on the same media server
• Configure the Queue Work Timer options
• Set the queue service level objectives
• Set the queue handling times
• Enable and Disable Auto Answer

To set the priority level for the queue 
1. Select a queue and click the Performance tab.
2. After Priority, select the priority level for the queue. 

The highest priority level is 1. The lowest priority level is 64.
3. Click Save.

To configure the business hours for a queue. 
1. Select a queue and click the Performance tab.
2. After Business-hour schedule, click the Browse button.

3. Select a schedule and click OK.
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4. If you want to restrict the production of real-time statistics and reports to only during business hours, 
select Generate statistics and reports only within business hours.

5. Click Save.

To apply the business hours to all queues on the same media server 
1. Select a queue and in the ribbon, click the Queue Tools tab.
2. Select Apply business hours to all.

To configure the Queue Work Timer options 
1. Select a queue and click the Performance tab.
2. If you want to add Contact Center Work Timer to handling time in reports, select Include Queue Work 

Timer as part of handling time. 

NOTE: When 'Include queue work timer as part of handling time' is enabled, the ACD handling time 
durations for reporting purposes span from ACD pick up to the end of the Work Timer time.

When this option is disabled, the ACD handling time duration spans from ACD pick up to hang up.
3. To enable the queue for Work Timer, select Use Queue Work Timer and set the duration of Queue 

Work Timer. 

The default duration is 00:05:00.
4. Click Save.

To set the queue service level objectives 
1. Select a queue and click the Performance tab.
2. Specify the Service Level goal and Service Level time for the queue.

3. Click Save.

To set the queue handling times 
1. Select a queue and click the Performance tab.
2. After Short handle less than, type the duration that will define a call as a short handle call. 

For example, type 3 to define a short handle call as one that lasts less than 3 seconds. Short talk calls 
are included in call statistics.

3. After Short abandon less than, type the duration that will define an abandoned call as ‘Abandoned 
(Short)’. 

For example, type 5 to define a short abandon call as one that is abandoned in less than 5 seconds.
NOTE: Short abandon less than’ is not applicable for Email queues.

4. Click Save

To enable Auto Answer for Agents 
1. Select a queue and click the Performance tab.
2. Select the Agent Auto Answer check box. 

This check box is cleared by default.
3. Click Save.

NOTE: 
• If the Agent Auto Answer check box is selected, the Accept button is not displayed in Web Ignite 

because the incoming conversation is auto answered.
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• The Agent Auto Answer option can be enabled for voice, chat, email, sms, and, open media queue 
types, but not for the Ring Groups.

Configuring queue spectrum settings for queues

Queue spectrum reports provide valuable information on how emails are dispersed in your contact center. 
You configure thresholds for answer, abandon, interflow, handle, and ringing thresholds for queues in 
YourSite Explorer. The answer, abandon, interflow, and talk statistics will be distributed across the queue 
spectrum reports in the time intervals you specify.
The following procedures explain how to:
• Configure queue spectrum settings for a queue
• Apply queue spectrum settings to all queues on the same media server

The following procedures take place in Multimedia > Queues.
To configure queue spectrum settings for a queue
1. Select a queue and click the Queue Spectrum tab.
2. Select the spectrum value(s) you want to include in reports and specify thresholds for each.

3. Click Save.

To apply queue spectrum settings to all queues on the same media server
1. Select a queue and in the ribbon, click the Queue Tools tab.
2. Select Apply queue spectrum to all.

Configuring email options for multimedia queues

The Email options tab contains email queue-specific options. The Email options tab enables you to control 
if email interactions in the Ignite inbox are requeued when the agent logs out of Ignite, how long interac-
tions can remain on hold for before being requeued, and whether or not agents can select the From 
address of the email response to interactions. The Email options tab also contains options for email signa-
tures. For information on configuring email signatures, see "Applying signatures to email queues".
NOTE: For email queues not automatically requeuing interactions on agent logout, emails are put on hold 
until the agent logs back in and removes hold. Once the hold requeue time expires, interactions are 
requeued whether the agent is logged in or not.
The following procedures explain how to:
• Set whether email interactions in the Inbox requeue on employee logout
• Set how long an email interaction can be on hold before being requeued
• Enable agents to pick the From address on responses

To set whether email interactions in the Inbox requeue on employee logout
1. Select a queue and click the Email options tab.
2. To requeue email interactions on employee logout select the Requeue on logout checkbox.

3. To keep email interactions on employee logout, deselect the Requeue on logout checkbox.

4. Click Save.

To set how long an interaction can remain on hold or in the Inbox after logout before being requeued
NOTE: When the 'Minutes an interaction can be on hold before being requeued' timer expires, the interac-
tion is returned to the queue as the longest waiting interaction and the employee (if logged into Ignite) is 
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put into System Make Busy. For emails, any text the agent entered is visible to the agent who handles the 
requeued interaction.
1. Select a queue and click the Email options tab.
2. Under Requeue options, enter the number of Minutes a contact can be on hold before being 

requeued.

NOTE: Once the 'Minutes an interaction can be on hold before being requeued' timer expires, inter-
actions are requeued whether the agent is logged in or not.

3. Click Save.

To enable agents to pick the From address on responses
1. Select a queue and click the Email options tab.
2. Select Allow Pick From Address.

3. Click Save.

Applying signatures to email queues

NOTE: 
• Do not copy signatures containing images in .msg files directly from Outlook. Save these signatures 

as .msg files in the Reply Templates folder and leverage from there.
• The size of email signatures contributes to email file size. By default, the maximum file size for emails, 

including attachments, signatures, and images, is 25 MB.
• Email queue signatures are limited to 150 000 characters. To increase this number, consult the 

following Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000752/loc/en_US.

• Email queue signatures are not inserted in workflow automatic email responses.

Administrators can apply signatures to email queues. These signatures are automatically inserted into 
agent email responses. Signatures are configured and applied on a queue-by-queue basis. Queue signa-
tures enable custom signatures to be deployed uniformly across the responses of agents answering for 
the queue.
Email signatures must be in .msg or .txt format. .msg signatures can contain images. Unsupported file 
types cannot be saved to the queue.
Administrators can either store signature files in the default Reply Template folder location created on the 
server during installation, or they can move the Reply Templates folder to a network share. Using the 
Reply Templates folder ensures that signature files are included in database backups. A network share 
is required for signatures to be created and modified on client computersor remote servers. If the network 
drive is unavailable to the server, the queue signature is not automatically inserted in agent replies. 
However, agents can manually insert signatures in their responses from the Reply Templates folder.
The default Reply Templates folder location is
• <installation drive>:\<installation folder>\CCM\Templates\ReplyTemplates\Email.
Administrators must ensure that media servers are pointed to the Reply Templates folder and that queues 
are pointed to the signature file in that folder. By default, media servers point to the Reply Templates 
folder. To point the media server to a Reply Templates folder housed on a network share, see "Config-
uring Reply templates for email, chat, SMS, and open media".

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000752/loc/en_US
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If agents are permitted to use personalized signatures, they must use response templates configured for 
that purpose. Administrators must configure the templates for agents to apply as signatures. See "Config-
uring Reply templates for email, chat, SMS, and open media".
The following procedure explains how to 
• Apply signatures to email queues
• Disable or remove signatures on email queues

To apply signatures to email queues 
1. Select a queue and click the Email options tab.
2. Select Enable Email Signature.

3. Click the Browse button and navigate to the folder housing the signatures. 

NOTE: This folder must the same folder to which the media server points.
4. Select the email signature file and click Open. 

NOTE: Reply templates only in .msg and .txt files can be inserted into the Email Signature field.
5. Click Save.

To disable or remove signatures on email queues 
1. Select a queue and click the Email options tab.
2. To disable the signature, deselect Enable Email Signature.

3. To remove the signature, click Clear.

4. Click Save.

Configuring chat options for multimedia queues

The following procedures explain how to:
• Set the queue hold requeue time

NOTE: Once the hold requeue time expires, interactions are requeued whether the agent is logged 
in or not

• Configure chat queue transcript options

The chat options tab for chat queues enables you to email chat transcripts to interactions as a part of the 
Chat Response workflow and view the internal and external URL for that specific chat queue.
A queue’s internal URL has the queue’s GUID built into the URL, removing the potential need for 
customers to select the queue they want from the chat request page and, if the Inbound workflow is 
configured to route based on queue IDs, automatically identify the destination queue so that customers 
are routed directly to the appropriate queue. There are two fields for chat URLs, the external URL for 
Queue and the internal URL for Queue. The internal URL for Queue is the Public URL used internally by 
the system <Enterprise Server>/chat/GUID. The external URL for Queue is the Public URL used exter-
nally with the reverse proxy applied and is the URL to link interactions to specific queues.
The following procedures take place in Multimedia > Queues.
To set the queue hold requeue time
1. Select a queue and click the Chat options tab.
2. Under Requeue options, set the Hold requeue time.



793

CONFIGURING YOUR MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

NOTE: Once the hold requeue time expires, interactions are requeued whether the agent is logged 
in or not

3. Click Save.

To configure chat queue transcript options
1. Select a chat queue and click the Chat options tab.
2. Select Email chat transcript.

3. Type the email address that will sends the transcript.

NOTE: The email address must be your SMTP server’s main address or an alias. For more informa-
tion on SMTP servers, see "Configuring SMTP connections to Multimedia Contact Center".

4. Click Save.

Configuring SMS options for multimedia queues

The SMS options tab for SMS queues enables you to set how long interactions remain on hold before 
being requeued.
The following procedures explain how to
• Set the hold requeue timeout time
To set the hold requeue timeout time
1. Select an SMS queue and click the SMS options tab.
2. Set the Hold requeue timeout time.

3. Click Save.

Setting a multimedia queue as historical

Multimedia queues can be set as historical, disabling real-time monitoring and data collection for the 
queue. Historical multimedia queues retain their data for reporting, as well as any emails or transcripts, 
but cannot handle interactions and are removed from Contact Center Client and Ignite. Emails and tran-
scripts associated to the queues will still be visible in the History folder in Ignite. Historical chat queues 
cannot be linked to directly and will not appear in the default chat request form.
To set a queue as historical or to reactivate a historical queue
1. Select a queue and click the General tab.
2. If you are setting the queue as historical, select Disable real-time monitoring and data collection 

on this device.

3. If you are reactivating the queue, clear Disable real-time monitoring and data collection on this 
device.

4. Click Save.

Deleting a multimedia queue

Emails and transcripts from a deleted queue will still be visible in Ignite, but will not have a queue asso-
ciated to them. Emails and transcripts will not be associated to a new queue that matches the configura-
tion of the deleted queue.
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To delete a queue
1. Click Multimedia > Queues.
2. Select a queue and click Delete.

3. Click OK.

Adding queue groups

Administrators can group queues for common purposes. There are three kinds of queue groups available: 
• Reporting—groups queues together for reporting and viewing their activities in real-time
• Mitel Virtual—groups queues across telephone switches that load balance ACD calls between 

multiple queues
• Unified Queue Group—groups queues of different media types that handle interactions for the same 

service group in a contact center

Adding Reporting queue groups

Reporting queue groups enable administrators to run reports on activities for the grouped queues and 
view queue group activities in real-time.
The following procedures explain how to:
• Add a Reporting queue group
• Associate a queue to a Reporting queue group
• Remove a queue from a Reporting queue group

To add a Reporting queue group
1. Click Multimedia > Queue groups.
2. Click Add > Reporting.

3. Type a Name.

4. Type a Reporting number.

5. Click Save.

To associate a queue to a Reporting queue group
1. Click Multimedia > Queue groups.
2. Select a Reporting queue group from the list.

3. On the Membership tab, under Available members, select a queue and click > to move the queue 
to the Selected members list.

4. Click Save.

To remove a queue from a Reporting queue group
1. Click Multimedia > Queue groups.
2. Select a Reporting queue group from the list.

3. On the Membership tab, under Selected members, select a queue and click < to move the queue 
to the Available members list.

4. Click Save.
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Adding Virtual queue groups

Virtual queue groups are comprised of two or more queues across one or more telephone switches that 
all send ACD voice interactions to the same pool of agent groups, balancing loads across queues. 
Queues within a virtual queue group must have the same reporting numbers, the same agent groups, and 
different dialable numbers. For example, in the following figure, the virtual queue group is made from two 
queues on two different telephone systems: 
• PBX 1: Queue 7000: reporting number P700, dialable 7000 on PBX1, queue 700, 701, 702 assigned
• PBX 2: Queue 7001: reporting number P700, dialable 7001 on PBX2, queue 700, 701, 702 Assigned 

Virtual queue group

Virtual queue groups provide the ability to merge multiple queues into a single visual representation in 
Interactive Visual Queue and provide callers with an accurate position in queue through the Updated Posi-
tion in Queue service.
NOTE: Although Virtual queue groups are added and configured under Queue Groups in YourSite 
Explorer, a virtual queue group is treated as a singular entity.
The following procedures explain how to: 
• Add a Virtual queue group
• Associate queues to a Virtual queue group
• Remove queues from a Virtual queue group

To add a Virtual queue group 
1. Click Multimedia > Queue groups.
2. Click Add > Mitel Virtual.

3. Type a Name.
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4. Type a Reporting number.

5. Click Save.

To associate queues to a Virtual queue group 
1. Click Multimedia > Queue groups.
2. Select a Virtual queue group from the list.

3. On the Membership tab, under Available members, select a queue and click > to move the queue 
to the Selected members list. 

Repeat as necessary.
4. Click Save.

To remove queues from a Virtual queue group 
1. Click Multimedia > Queue groups.
2. Select a Virtual queue group from the list.

3. On the Membership tab, under Selected members, select a queue and click < to move the queue 
to the Available members list. 

Repeat as necessary.
4. Click Save.

Adding Unified queue groups

Unified queue groups are used to consolidate a group of queues of different media types that handle inter-
actions for the same service organization within a contact center, such as sales or support. A Unified 
queue group can only have one queue for each of the media types it supports. Individual queue priorities 
are used within a Unified queue group to specify the priority of the media types and queues for handling. 
The queues within a Unified queue group can be viewed together in Ignite.
Unified queue groups can be created using a wizard or may be created manually. The Unified Queue 
Group wizard takes an existing voice queue and then uses its configuration settings to input information 
into new multimedia queues. The wizard also enables all agent groups associated with the voice queue 
to support the multimedia type selected during queue creation.
NOTE: 
• The Unified Queue Group Wizard does not create new agents for employees belonging to the associ-

ated agent groups. Employees must be enabled to handle new media types manually. See "Managing 
the media types an employee can handle".

• Employees already enabled to handle the new queues’ media types will be set as Present in their agent 
groups for those media types. For information on changing the default presence, see "Managing agent 
group membership, presence, and skill level".

• A default queue priority of 64 is assigned to queues created by the Unified Queue Group Wizard. 
These may be altered after the wizard has finished.

• Business hours are copied over from the business hours configured for the voice queue. Default auto-
mated responses for business hours are provided for multimedia.

• The wizard will populate the Offer to Agent Groups activities in the default Inqueue workflows with the 
same agent group order used by the voice queue member of the Unified queue group.

When manually creating a Unified queue group, administrators can create new queues to associate with 
the Unified queue group. When you create these new queues, they are automatically assigned the name 
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and reporting number of the existing Unified queue group. Users manually creating a Unified queue group 
can also associate existing queues to a Unified queue group. Virtual queue groups may be associated to 
the voice media of a Unified queue group.If an administrator disables a media type for a Unified queue 
group, the associated queue will become historical.
The following procedures explain how to: 
• Add a Unified queue group using the Unified Queue Group Wizard
• Add a Unified queue group
• Associate new queues to the Unified queue group
• Associate an existing queue to the Unified queue group
• Associating an existing virtual queue group to the Unified queue group
• Replace an associated queue with a new queue
• Replace an associated queue with an existing queue
• Remove a media type from a Unified queue group and set the associated queue as historical

To add a Unified queue group using the Unified Queue Group Wizard 
1. Click Multimedia > Queues.
2. Select the voice queue(s) for which you want to create a Unified queue group(s).

3. In the Queue Tools tab of the ribbon, click Create unified queue group.

4. Click the icons for the multimedia queues you want to create. 

See the following table.

5. If you want to create a corresponding reporting queue group, select Create reporting queue group 
and type a Reporting number.

6. Click Create.

Table 24.4:Unified Queue Group Wizard media icons

Media Type Media Icon

Chat

 

Email

SMS

Open Media
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7. Click Save.

To add a Unified queue group 
1. Click Multimedia > Queue groups.
2. Click Add > Unified.

3. Type a Name.

4. Type a Reporting number.

5. Click Save.

To associate new queues to the Unified queue group 
1. Click Multimedia > Queue groups and select a Unified queue group.
2. Click on the media type icons to select which media types the queue group can handle. 

A queue configuration window opens.
For instructions on configuring an email, chat, SMS, or open media queue, see "Adding multimedia 
queues".
See the following table.

NOTE: 
– Queue Inqueue workflows cannot be configured when adding new queues as members of Unified 

queue groups. Inqueue workflows for new queues must be configured in YourSite > Queues after 
the Unified queue group is saved.

– By default, new queues added this way will use the name of the Unified queue group and the 
reporting number.

Table 24.5:Unified queue group media type icons  (Sheet 1 of 2)

Media Type Icon

Voice

Chat

Email

SMS
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3. When you are done configuring the new queue, click Save.

4. Repeat steps 2 and 3 for each media type you want the Unified queue group to handle.

5. Click Save.

To associate an existing queue to the Unified queue group 
1. Click Multimedia > Queue groups and select a Unified queue group.
2. Click the down arrow button beside the media type icon and click Associate existing <media type> 

queue.

3. Select a queue and click OK.

4. Click Save.

To associate an existing virtual queue group to the Unified queue group 
1. Click Multimedia > Queue groups and select a Unified queue group.
2. Click the down arrow button beside the voice media icon and click Associate existing Virtual queue 

group.

3. Select a virtual queue group and click OK.

4. Click Save.

To replace an associated queue with a new queue 
1. Click Multimedia > Queue groups and select a Unified queue group.
2. Click the down arrow button beside the media type icon and click Replace with new <media type> 

queue, click on the media type icons to select which media types the queue group can handle. 

A queue configuration window opens.
For instructions on configuring an email, chat, SMS, or open media queue, see "Adding multimedia 
queues".

NOTE: 
– Queue Inqueue workflows cannot be configured when adding new queues as members of Unified 

queue groups. Inqueue workflows for new queues must be configured in YourSite > Queues after 
the Unified queue group is saved.

– By default, new queues added this way will use the name of the Unified queue group and the 
reporting number.

3. When you are done configuring the new queue, click Save.

4. Click Save.

Open Media

Table 24.5:Unified queue group media type icons (Continued) (Sheet 2 of 2)

Media Type Icon
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To replace an associated queue with an existing queue 
1. Click Multimedia > Queue groups and select a Unified queue group.
2. Click the down arrow button beside the media type icon and click Replace with existing <media 

type> queue.

3. Select a queue and click OK.

4. Click Save.

To remove a media type from a Unified queue group and set the associated queue as historical 
1. Click Multimedia > Queue groups and select a Unified queue group.
2. Click on a selected media type icon.

3. Click Save.

Configuring Holidays

You configure holiday options in the Holidays section of Multimedia Contact Center for the dates that 
affect your contact center operations. In Multimedia Contact Center, Holidays are used in the Schedule 
activity. For more information on the Schedule activity, see "Routing interactions with the Schedule 
activity". Multimedia Contact Center includes default holidays for the USA, UK, and Canada.
To enable an existing holiday
1. In YourSite Explorer, click Multimedia > Holidays.
2. From the list of holidays, select the holiday you want to enable.

3. Select This holiday is a company holiday. Notify me if I attempt to schedule an employee on 
this day.

4. Click Save.

To add a new holiday
1. In YourSite Explorer, click Multimedia > Holidays.
2. Click Add.

3. After Name, type the name of the holiday.

4. If you wish to enable this holiday immediately, select This is a company holiday. Notify me if I 
attempt to schedule an employee on this day.

5. Specify the pattern of the holiday

– If the holiday always falls on the same day of the month, select Every and specify the month and 
date the holiday falls on.

– If the holiday has a pattern of falling on a certain day, week, and month, select The and specify the 
pattern, day of week, and month.

– If the holiday is a calculated holiday, such as Good Friday or Easter Monday, select Calculated 
holiday and specify the holiday.

6. Click Save.
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To delete a holiday
1. Select the holiday you want to delete from the holidays list.
2. Click Delete.

3. Click OK.

Configuring business hour schedules

Multimedia Contact Center performs certain tasks during business hours and other tasks after hours. For 
example, the system can send auto-response messages to interactions received after hours, informing 
customers that the contact center is closed and to expect a response during business hours. Applying a 
business hours schedule to workflows tells the system when to send this message.
Multimedia Contact Center ships with a default 24/7 business hour schedule and a default Monday to 
Friday 9:00 AM to 5:00 PM business hour schedule. Administrators can
• Modify the default business hours schedules
• Create new business hour schedules
• Manage business hour schedule exclusion lists to omit days from schedules, such as national holi-

days.
• Apply business hour schedules to workflows

Modifying default business hour schedules

Administrators can modify the default 24/7 and default Monday to Friday 9:00 AM to 5:00 PM business 
hour schedule to suit their business’ needs.
To modify a default business hours schedule
1. Click YourSite > Schedules and select a default schedule.
2. Type a new Name for the schedule. For example, 'Monday to Friday 8:00 AM to 6:00 PM'.

3. To apply a Schedule exclusion list, click the Browse button, select an exclusion list and click OK.

NOTE: To create a schedule exclusion list, or to edit an existing schedule exclusion list, see 
"Managing schedule exclusion lists".

4. Specify the business day Start time and End time for each day of the week.

5. Select the Disable for day check box for each day the business is closed.

6. Click Save.

Creating new business hour schedules

Administrators can create new business hour schedules to apply to Multimedia Contact Center devices 
and to use in workflows.
To create a new business hour schedule
1. Click YourSite > Schedules > Add.
2. Type a Name for the new schedule.

3. To apply a Schedule exclusion list, click the Browse button, select an exclusion list and click OK.

NOTE: To create a schedule exclusion list, or to edit an existing schedule exclusion list, see 
"Managing schedule exclusion lists".

4. Specify the business day Start time and End time for each day of the week.
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5. Select the Disable for day check box for each day the business is closed.

6. Click Save.

Managing schedule exclusion lists

The following configurations take place in YourSite > Schedules.
Managing schedule exclusion lists enables administrators to omit days from business hour schedules. For 
example, administrators can use a schedule exclusion list to omit national holidays from a business’ 
yearly schedule.
The following procedures tell you how to 
• Create and apply new exclusion lists to schedules
• Apply existing exclusion lists to schedules
• Remove exclusion lists from schedules
• Edit and remove dates from schedule exclusion lists
• Delete exclusion lists from YourSite Explorer

To create and apply a new exclusion list to a schedule 
1. Select the schedule and click Manage schedule exclusion list.
2. Type a Name for the exclusion list. 

NOTE: To create a new list for a schedule with an exclusion list already applied to it, click Add and follow 
step 2 onward.
3. Select the dates to exclude from the schedule and click Save.

4. To apply the exclusion list to the selected schedule, click Apply. Otherwise, close the schedule exclu-
sion list designer window.

5. On the ribbon, click Save.

To apply an existing exclusion list to a schedule 
1. Select the schedule and, after Schedule exclusion list, click Browse.
2. Select a schedule exclusion list and click OK

3. Click Save.

To edit and remove dates from an exclusion list 
1. Select a schedule with an exclusion list applied to it and click Manage Schedule exclusion list.
2. Click Edit.

3. To add new dates, select them from the calendar.

4. To remove dates, select the dates from the list and click Remove.

5. To remove all dates, click Clear.

6. Click Save.

7. To apply these changes to the schedule, click Apply.

8. On the ribbon, click Save.
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To delete an exclusion list from YourSite Explorer 
1. Select a schedule that has the exclusion list to be deleted and click Manage Schedule exclusion list. 

NOTE: If deleting exclusion lists as part of clean-up, select any schedule with an exclusion list applied 
to it and follow these steps.

2. From the drop-down list, select the exclusion list you want to delete and click Delete.

3. Close the schedule exclusion list designer and, on the ribbon, click Save.

Applying business hour schedules to workflows

Administrators can apply business hour schedules to workflows via the Schedule activity.
For example, an administrator applies a Monday to Friday, 7:00 AM to 7:00 PM business hour to a 
Schedule activity in a Chat Inqueue workflow. Chat messages arriving after hours follow the ‘After Hours’ 
branch. This branch is configured to send an automatic response informing customers of the contact 
center’s business hours and to expect a reply during that time.
To apply business hour schedules to workflows, see "Routing interactions with the schedule activity".

Configuring security roles

You create security roles if you want to restrict employees from specific devices and MiContact Center 
Business application areas that their licensing would enable them to access.
NOTE: In order for you to assign security roles, your account must be associated with a security role that 
has ‘May manage security’ enabled.
MiContact Center Business has two default security settings, Local administrator and Enterprise admin-
istrator. These settings provide employees full access to all MiContact Center Business applications (to 
which the contact center and employees are licensed) and devices, and allow Write Back for synchroni-
zation.
Employee access to applications is limited by their security role and their licensing. An employee’s secu-
rity role defines the application areas an employee can access and licensing limits what applications an 
employee can access. For example, an employee with the Enterprise administrator security role but no 
supervisor license would not be able to access YourSite Explorer.
When you install MiContact Center Business, a default user is created. This ensures there is at least one 
account with which you can access YourSite Explorer.
The default user name and password are: 
• Username: _admin
• Password: _password
• Security Role: Local Administrator

Security roles have two components:
Basic—Basic security controls user access to specific areas of MiContact Center Business, Flexible 
Reporting, Workforce Scheduling and Schedule Adherence.
Advanced—Advanced security controls user access to customized lists of devices, real-time monitors, 
profiles, reports, sites, and users.
For detailed information regarding creating and applying security roles and creating security lists, see the 
"Security roles".
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Multimedia Contact Center security settings

Many of the features in Multimedia Contact Center are advanced; administrators may want to restrict their 
multimedia employees from having access to select devices or applications. Employees using Ignite for 
Multimedia Contact Center require several specific security role settings to control their access to parts 
of the Ignite.
Security roles can be applied to restrict which devices agent can view in Ignite, so that they are limited to 
both handling and viewing only the queues associated to their agent group. Employees can be restricted 
from controlling their Agent Group Presence, so their presence in agent groups can be entirely controlled 
by the system. Employees can be restricted from picking interactions out of queue. Employees can be 
restricted from transferring interactions from the queue and their Inbox. Employees can be restricted from 
marking interactions as Junk. Employees can also be restricted from accessing Ignite.
NOTE: Users currently logged on are not affected by changes to their associated role until the next time 
they log on.
To restrict access to Ignite, disable the following Basic security option:
• May access Contact Center Client/Ignite
To restrict the devices an employee can view in Ignite, enable the following Advanced security options:
• May view real-time information on devices contained in this list only <device list>.

The device list must contain the following members:
– All the queue groups that contain queues the employee handles
– All the agent groups to which the employee has agents
– Employee groups that mirror the composition of the agent groups’ employee membership

To restrict control of presence in Ignite, such as Join and Leave, disable the following Advanced security 
option:
• May control my real-time presence status in Interactive Contact Center
To restrict the ability to pick interactions out of queue, disable the following Basic security option
• May Pick/Pick & Reply Interactions
To restrict the ability to transfer interactions from the queue and Inbox, disable the following Basic security 
option
• May Transfer Interactions
To restrict the ability to mark interactions as Junk, disable the following Basic security option
• May Junk Interactions
To restrict access to Ignite, disable the following Basic security option
• May access Contact Center Client/Ignite

Configuring Multimedia Contact Center web features
Multimedia Contact Center includes web applications and features that require configuration by qualified 
web administrators and IT personnel to ensure successful deployment. These features consist of:
• Chat

For information on offering chat through your corporate website, see "Enabling chat".
• Contact Us

For information on offering Contact Us through your corporate website, see "Enabling Contact Us".
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The following is the suggested order of configuration for Multimedia Contact Center web features.
To set up Multimedia Contact Center web features
1. Configure chat media servers.

See "Adding chat to Multimedia Contact Center".
2. Configure chat queues.

See "Adding multimedia queues".
3. Add reverse proxy.

Reverse proxies enable /CCMWa to be published as a part of your corporate website.
See "Publishing Chat and Contact Us to the Internet using reverse proxies".

4. Add SSL (optional)

See "Publishing Chat and Contact Us to the Internet with SSL".
5. Update chat media server with external URL for chat root.

See "Adding chat to Multimedia Contact Center".
6. Configure chat customizations.

See "Enabling chat"
7. Configure Contact Us.

See "Enabling Contact Us".

For information on troubleshooting the deployment of Multimedia Contact Center web features, see "Trou-
bleshooting Multimedia Contact Center web features".

Multimedia Contact Center proficiency requirements

Contact centers are responsible for the deployment of Multimedia Contact Center web features on their 
corporate web servers. You must have web administrator and IT personnel with knowledge of the 
following to deploy and customize Chat and Contact Us:
• IT administrator proficiencies for Chat and Contact Us deployment

– Reverse proxy configuration
– Network and Firewall configuration and troubleshooting
– End-to-End SSL deployment (optional)

• Basic web proficiencies for Chat customization
– JavaScript: Manipulating JavaScript file with a list of variables
– HTML: Adding URL link to corporate web site

NOTE: These are the minimum proficiencies required. More complicated integrations will 
require more enhanced skills.

• Basic web proficiencies for Contact Us customization
– JavaScript: Manipulating JavaScript file with a list of variables
– HTML: Add a JavaScript call to a corporate website
– CSS: Ability to integrate complex CSS file to integrate with corporate website.
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Publishing Chat and Contact Us to the Internet using reverse proxies

Chat can be published to the internet using reverse proxies, either with or without SSL. Multimedia 
Contact Center only supports End-to-End SSL deployments. For more information, see the MiContact 
Center Business and MiVoice Analytics System Engineering Guide.
Chat and Contact Us both use CCMWa, a web application installed on the Enterprise Server at 
http://<Enterprise Server IP Address>/CCMWa to route interactions to your queues. Using a reverse 
proxy enables requests to your corporate website to be served from CCMWa through your corporate 
website, proxying requests through the web server to CCMWa on the Enterprise Server.
Setting up a reverse proxy requires setting up Inbound and Outbound routing rules on your web server. 
The Inbound rule configures the directory on the web server that routes the requests to the Enterprise 
Server. The Outbound rule modifies the responses from the Enterprise Server to match the corporate 
website URL format.
For example, if http://www.contactcenter.com/Chat was configured as the directory that reverse proxies 
http://<enterprise server>/CCMWa/chat, then when a customer arrives on http://www.contact-
center.com/Chat, the web server makes the request to http://<enterprise server>/CCMWa/chat on the 
customer’s behalf. The Enterprise Server’s response is then sent back to the web server which then 
publishes it to the customer as if it had been generated by the corporate web server.
The method for configuring a reverse proxy depends on if your organizational web server is an Apache 
or an IIS web server. The Mitel MiContact Center Knowledge Base contains guidelines for reverse proxy 
deployment: 
• IIS web servers: http://micc.mitel.com/kb/KnowledgebaseArticle52451.aspx
• Apache web servers: https://mitel.custhelp.com/app/answers/answer_view/a_id/1007039/loc/en_US

Publishing Chat and Contact Us to the Internet with SSL

Multimedia Contact Center Chat and Contact Us support SSL on both IIS and Apache web servers in an 
End-to-End SSL deployment. Due to the variance in possible deployment models for End-To-End SSL 
and the unique configurations of different corporate websites, it is the responsibility of contact centers to 
determine how to best configure their own End-to-End SSL deployments. See the MiContact Center Busi-
ness and MiVoice Analytics System Engineering Guide for more information on the supported SSL 
deployment.

Enabling chat

The first step in enabling chat is deciding how to provide access to chat. You must determine how chat 
will be offered within your corporate website and published to the Internet as well as how your interactions 
access offered chat services.
During the installation of Multimedia Contact Center, the chat server CCMWa (Internal URL http://<enter-
prise server>/ccmwa) and the customer-facing chat request form (default URL http://<enterprise 
server>/ccmwa/chat) are installed on the Enterprise Server. Individual queues include an Internal URL for 
direct access to them: http://<enterprise server>/CCMWa/chat/<queue GUID>. The configuration and 
customization of your chat request forms are handled in a single JavaScript file, chat.public.config.js.
NOTE: As of version 9.2, it is recommended to use the chat files on the Enterprise Server rather than 
hosting them on your corporate web server. For more information, see "Hosting chat files on your corpo-
rate web server".

http://micc.mitel.com/kb/KnowledgebaseArticle52451.aspx
https://mitel.custhelp.com/app/answers/answer_view/a_id/1007039/loc/en_US
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Enabling chat takes place in five steps: 
1. Determine how to offer chat to contacts. 

Multimedia contacts to select a queue to which their chat will be submitted, through a queue-specific 
chat request form, through activities in an Inbound workflow, or through a user-made chat request 
page.
For more information, see "Determining how to offer chat"

2. Publish chat to the Internet with reverse proxies. 

Reverse proxies enable /CCMWa to be published as a part of your corporate website.
For more information, see "Publishing Chat and Contact Us to the internet using a reverse proxy".

3. Customize your chat request forms. 

Chat request forms can be customized in chat.public.config.js to display corporate branding, show 
and hide different form properties, and display avatars in chat sessions.
For more information on customizing your chat request forms, see "Customizing public-facing chat".

4. (Optional) Customize Ignite chat and SMS agent options. 

Agent options for handling chat and SMS messages can be configured to change Ignite handling op-
tions and display avatars in chat sessions. For more information on customizing your agent chat and 
SMS session in Ignite, see "Customizing Ignite chat and SMS agent options".

5. Integrating chat with your website. 

You must determine how chat is offered through your website so that your contacts can access it. For 
suggestions on how to integrate chat with your corporate website, see "Offering chat through your cor-
porate website".

Determining how to offer chat

When setting up chat, administrators and IT administrators must decide how their contact center is going 
to use the customer-facing chat page to offer chat to their interactions. The customer-facing chat page 
can be modified to integrate with your organization’s website standards. All inbound chats must route 
through the chat media server’s Inbound workflow without exception. By default, this workflow is set to 
route chat requests using the queue selected by the customer in the chat request form.
There are four options for offering chats to your contact center: 
• By the root chat request form
• By the queue chat queue form
• By the Inbound workflow
• By a user-created chat request form

NOTE: Multimedia Contact Center's chat request forms do not support Internet Explorer's Compatibility 
View.
Each of these methods requires the configuration of a reverse proxy between the Enterprise Server and 
your corporate website. For more information, see "Publishing Chat and Contact Us to the internet using 
a reverse proxy".
All four methods for offering chat can be used when offering chat through the Contact Us sample contact 
page. For more information on using Contact Us, see "Enabling Contact Us".
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Offering chat by the root chat request form

The default CCMWa/chat root chat request form offers interactions the ability to choose the queue desti-
nation for their chat request from all chat queues configured by a contact center. When an interaction 
selects a queue, by default, the root chat request form loads the queue chat request form for that queue, 
displaying the Estimated Wait Time for the queue. Other queue statistics can be optionally used as well. 
For more information, see "Configuring the public-facing Chat.Config JavaScript file".
After filling out the chat request form, interactions are routed through the default Inbound workflow using 
the selected queue. The following figure shows the chat request form. When an interaction selects a 
queue from the automatically populated drop-down list of your contact center’s chat queues, they are 
routed through the default Inbound workflow using the selected queue.
The root chat request form is accessible from http://<enterprise server>/ccmwa/chat. If you want to offer 
it in another supported language, the format is http://<enterprise server>/ccmwa/<language desig-
nator>/chat. For more information, see "Offering chat in different languages".

Figure 24.2: Root chat request form
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Offering chat by the queue chat request form

If a contact center has multiple contact webpages for specific products or services, the contact center may 
want to link to specific chat queues when offering chat. Chat queues have their own internal and external 
URL that can be used to take interactions directly to a version of the chat request form that has the queue 
pre-selected. The following figure shows the chat request form for a chat queue. The Estimated Wait Time 
for the queue is also displayed in the chat request form. Other queue statistics can be optionally added 
as well. For more information, see "Configuring the public-facing chat JavaScript file".
After filling out the chat request form, interactions are automatically routed through the Inbound workflow 
by the queue ID and transferred to the appropriate queue.
A queue’s chat request form is accessible from http://<enterprise server>/ccmwa/chat/<queue GUID>. 
Chat queue URLs are available from the chat queue’s entry in YourSite Explorer. If you want to offer it in 



810

CONFIGURING MULTIMEDIA CONTACT CENTER WEB FEATURES
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

another supported language, the format is http://<enterprise server>/ccmwa/<language desig-
nator>/chat/<queue GUID>. For more information, see "Offering chat in different languages".

Figure 24.3: Queue chat request form
 

Offering chat by Inbound workflow

As an alternative to offering chat to contacts by a chat request form or by links to specific chat queues, 
contacts can be routed or route themselves to their destination queues using activities such as Ask or 
Compare Variables in an Inbound workflow. For example, a general chat queue could be created and the 
external URL could be used to present chat to contacts. Once the customer is in the Inbound workflow, 
Ask activities could be used to pose questions to the customer and route them based on the answers. 
When using the chat queue URL, the drop-down queue selection field is removed from the chat request 
form.
To offer a chat request form with no drop-down for queue selection, simply use any of the external URLs 
for one of your queues and do not route by queue ID in the Inbound workflow. For more information about 
Inbound workflows, see "Applying inbound routing rules to interactions". To remove any queue statistics 
for your selected queue, update your chat request form to exclude those features. For more information, 
see "Configuring the public-facing chat JavaScript file".
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For more information on chat Inbound workflows, see "Default Chat Inbound workflow". For information 
on chat request forms for queues, see "Offering chat by the queue chat request form".

Offering chat by a user-created chat form

For contact centers with advanced web development resources, Multimedia Contact Center supports 
user-created request or authentication pages. These chat request pages must submit name and email to 
chat, and, optionally, a topic, which are populated into chat when the user-made request page submits a 
chat request.
User-created chat request or authentication pages require advanced web development resources. For 
more information on the requirements for user-made chat request forms, see the following Knowledge 
Base article: http://micc.mitel.com/kb/KnowledgebaseArticle52373.aspx.

Customizing chat

Chat is customized through configuring JavaScript file settings. You can configure the public-facing chat 
request pages and the chat experience of your customers as well as the chat experience of agents and 
supervisors using Ignite.
Chat is customized through the configuration of three different JavaScript files:
• chat.public.config.js

See "Customizing public-facing chat".
• chat.agent.config.js

See "Customizing Ignite chat and SMS agent options".
• chat.supervisor.config.js

See "Customizing Ignite chat and SMS agent options".

Multimedia Contact Center maintains three default version of these files:
• Chat.ui.public.config.DEFAULT.js
• Chat.ui.agent.config.DEFAULT.js
• Chat.ui.supervisor.config.DEFAULT.js

During upgrades, these default files update the chat customization files with any new fields and populates 
them with the default values. On every start/restart of the CCMWa application on the Enterprise Server, 
if the customization files are not found, they are recreated automatically from the default files.
CAUTION: Do not make any changes to the default chat configuration files.
NOTE: 
• If you are hosting your chat configuration files on your corporate web server, they will not be automat-

ically updated during an upgrade and must be manually upgraded.
• Chat configuration must be consistent for the fields shared between the different JavaScript files used 

to customize chat. If you want to use a default public Gravatar image for a queue, for example, you 
must ensure that the same image is set in both chat.public.config.js and chat.agent.config.js.

Customizing public-facing chat

Multimedia Contact Center enables contact centers to customize both the contact-facing and agent-facing 
chat experience.
Public customizations add options to the chat request form as well as providing avatar options for contacts 
chatting with contact center agents. For information on customizing contact-facing chat options, see 
"Customizing chat request forms and chat sessions".

http://micc.mitel.com/kb/knowledgebasearticle52373.aspx


812

CONFIGURING MULTIMEDIA CONTACT CENTER WEB FEATURES
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Agent-facing customizations modify chat and SMS handling options in Ignite and provide avatar options 
for agents handling chat and SMS options. For information on customizing agent-facing chat options, see 
"Customizing Ignite chat and SMS agent options".
NOTE: Chat configuration must be consistent for the fields shared between the different JavaScript files 
used to customize chat. If you want to use a default public Gravatar image for a queue, for example, you 
must ensure that the same image is set in both chat.public.config.js and chat.agent.config.js.
Customizing chat request forms and chat sessions
Chat request forms and chat sessions can be customized to match your organizational style and provide 
different options to contacts. You can customize your chat offering at the contact center level and at the 
level of individual queues. Chat options are configured using a single JavaScript file, chat.public.config.js, 
that contains a series of JavaScript variables and properties. This file is hosted in CCMWa’s folder on the 
Enterprise Server (<drive>\Program Files (x86)\Mitel\MiContact Center\Website\CCMWa\Scripts\).
You can make the following customizations to your chat request forms and chat sessions: 
• Show or hide Estimated Wait Time, Number of Available Agents, Number of Idle Agents, Number of 

Chats Waiting, and Business Hours queue statistics
• Enable chats to be submitted after hours
• Enable chat requests to be submitted when the queue is closed or unavailable
• Enable chats to be submitted when there are no available agents
• Enable Gravatar avatars
• Add a corporate logo and customize its placement on the chat request form
• Provide a description for the queue that appears both on the chat request form and in the browser title 

bar
• Change both the background color and if it displays as a solid color or a gradient
• Show or hide the topic field, make topics mandatory, and set specific topic choices
• Set up Gravatar avatars for contacts
• Configure queue closed messages
• Configure the LumaThreshold for light or dark icons

To customize chat request forms 
• Configure the chat JavaScript file. 

See "Configuring the public-facing Chat.Config JavaScript file".

NOTE: If you customized your chat request form in version 7.0, your customizations will not be retained 
after an upgrade to version 8.1. For more information, see "Updating chat customization from Version 7.0 
to Version ".
Configuring the public-facing chat JavaScript file
Configuration settings for chat request forms are controlled through a single JavaScript file, 
chat.public.config.js, which can be found at <drive>:\Program Files (x86)\Mitel\MiContact 
Center\Website\CCMWa\Scripts.
chat.public.config.js settings can be grouped into three categories: 
• Global settings—control chat request form settings and options. These settings are applied univer-

sally across chat request forms or are required to enable features at a queue level. The following table 
outlines the global fields.

• Queue settings—control chat request form settings for the queue as well as chat session settings for 
queues. Queue settings are configured in both DefaultConfig and ChatQueues sections of 
chat.public.config.js. DefaultConfig settings are applied to all queues while ChatQueues settings, 
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available in the advanced version of the Chat.Config file, are applied to individual specific queues. The 
following table outlines DefaultConfig and ChatQueues settings.

• Logging and connection settings—provide troubleshooting options as well as set connection retry 
limits. The following table details the fields available for logging and connection settings.

When adding field values based on the following tables, ensure that they use correct JavaScript format-
ting and punctuation. If you configure your customized chat request forms using the basic 
chat.public.config.js and later decide that you want to customize the chat request form for individual 
queues, you can add the ChatQueues fields to your chat.public.config.js file using a text editor.
Table 24.6:Global settings fields  (Sheet 1 of 4)

Field name Field value Field Description

EnableEstimateWaitTime True or False This field controls whether or 
not Estimated Wait Time is 
available to all chat request 
forms.
If set to False, the Estimated 
Wait Time statistic does not 
display in any chat request 
form.
If set to True, the value 
configured under 
ShowEstimatedWaitTime 
determines if Estimated Wait 
Time displays or not.

EnableNumberOfAvailableAgen
ts

True or False This field controls whether or 
not Number of Available Agents 
is available to all chat request 
forms.
If set to False, the Number of 
Available Agents statistic does 
not display in any chat request 
form.
If set to True, the value 
configured under 
ShowNumberOfAvailableAgent
s determines if Number of 
Available Agents displays or 
not.
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EnableNumberOfIdleAgents True or False This field controls whether or 
not Number of Idle Agents is 
available to all chat request 
forms.
If set to False, the Number of 
Idle Agents statistic does not 
display in any chat request 
form.
If set to True, the value 
configured under 
ShowNumberOfIdleAgents 
determines if Number of Idle 
Agents displays or not.

EnableNumberOfChatsWaiting True or False This field controls whether or 
not Number of Chats Waiting is 
available to all chat request 
forms.
If set to False, the Number of 
Chats Waiting statistic does not 
display in any chat request 
form.
If set to True, the value 
configured under 
ShowNumberOfChatsWaiting 
determines if Number of Chats 
Waiting displays or not

EnableBusinessHours True or False This field controls whether or 
not queue business hours are 
available to all chat request 
forms when the queue is 
outside of business hours.
If set to False, no business 
hours display for the queue 
when outside business hours.
If set to True, the value 
configured under 
ShowBusinessHours 
determines if business hours 
display or not.

Table 24.6:Global settings fields (Continued) (Sheet 2 of 4)

Field name Field value Field Description
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EnableQueuingWhenNoAgents
Login

True or False This field controls whether or 
not contacts can submit chat 
requests when no agents are 
available.
If set to False, no chat requests 
can be submitted when no 
agents are logged in.
If set to True, the value 
configured under 
AllowQueuingWhenNoAgentsL
ogin determines if chat requests 
can be submitted when no 
agents are logged in.

EnableQueuingInAfterHours True or False This field controls whether or 
not contacts can submit chat 
requests outside of business 
hours
If set to False, no chat requests 
can be submitted outside of 
business hours.
If set to True, the value 
configured under 
AllowQueuingInAfterHours 
determines if chat requests can 
be submitted when no agents 
are logged in.

EnablePublicGravatar True or False This field controls whether or 
not public users will use avatars 
provided through Gravatar.
If set to True, Chat sessions will 
use any Public Gravatar user 
image associated to the email 
addresses used in the chat 
session.
If set to False, no Public 
Gravatar user images will be 
used in the chat session.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

Table 24.6:Global settings fields (Continued) (Sheet 3 of 4)

Field name Field value Field Description
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EnableAgentGravatar True or False This field controls whether or 
not Chat will use Gravatar for 
Agents.
If set to True, Chat sessions will 
use any Gravatar user image 
associated to the email 
addresses used in the chat 
session or the image configured 
with DefaultAgentGravatarUrl.
If set to False, no agent 
Gravatar user images will be 
used in the chat session.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

Table 24.7:Queue setting fields  (Sheet 1 of 6)

Field name Field Value Field description

Enabled True or False This field enables or disables this configuration record.
If you set to False, the queue’s chat form will use the 
values from the default file in <drive>\Program Files 
(x86)\Mitel\MiContact Center\WebSites\CCMWa\Scripts\ 
Chat.ui.public.config.DEFAULT.js.

QueueId (ChatQueues 
only)

The queue’s 
GUID, such as 
‘26F1A5C3-D
D2C-45FF-BE
75-2BC7B850
12D0’

The GUID for the chat queue to which you want the 
associated settings to apply. You can use YourSite 
Explorer to obtain a queue’s GUID. See "Obtaining 
Queue GUIDs".

LogoImgPath The path to the 
logo’s image 
file

The path to the image file containing your organization’s 
logo. Logo files should be located in the following folder:
<InstallDir>\MiContact 
Center\WebSites\CCMWa\Content\images\logo\ and 
must be set in the JavaScript file as 
/CCMWa/images/<image_file>.gif .
NOTE: It is recommended that you keep a copy of your 
logo image file in a separate location to prevent your logo 
from being lost during an upgrade or installation in the 
future.

Table 24.6:Global settings fields (Continued) (Sheet 4 of 4)

Field name Field value Field Description
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ShowLogo True or False If set to True, the Logo image file specified in 
LogoImgPath will display in the chat request form.
If set to False, the Logo image file specified in 
LogoImgPath will not display in the chat request form.

QueueLabel The text you 
want to display 
as the queue’s 
label, such as 
‘Sales Chat’

The queue label is text that will render both on the chat 
request form and in the title bar of the browser window 
title bar

ShowQueueLabel True or False If set to True, the QueueLabel will display on the chat 
request form
If set to False, the QueueLabel will not display on the 
chat request form.

AppendQueueLabelToP
ageTitle

True or False If set to True, the QueueLabel value is added to the html 
document title for the page the chat is hosted in.
If set to False, the QueueLabel value is not added to the 
html document title.

FormatPrechatLogoToF
orm

True or False This field controls where the logo, if a logo is used, 
displays.
If set to True, the logo is formatted to be centered to the 
form fields on the chat request form and match the width 
of the fields (approximately 220 px).
If set to False, the logo will display statically in the top left 
corner of the page and its size will not be modified.

Gradient True or False This field controls whether or not the background uses a 
gradient or solid color.
If set to True, the values in GradientStartColor and 
GradientEndColor are used to render a gradient 
background.
If set to False, the value in GradientStartColor is used to 
render a solid background.

GradientStartColor The color’s 
value, such as 
‘#000000’

The start color for the background’s gradient or the solid 
color used for the background
NOTE: Depending on the background color selected, the 
fonts and buttons/icons will automatically render in a dark 
or light form based on the background color implemented 
for optimal legibility.

GradientEndColor The color’s 
value, such as 
‘#000000’

The end color for a gradient background

Table 24.7:Queue setting fields (Continued) (Sheet 2 of 6)

Field name Field Value Field description
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ShowEstimatedWaitTim
e

True or False Shows or hides the Estimated Wait Time statistic on the 
chat form.
NOTE: EnableEstimatedWaitTime must be set to True.

 
ShowNumberOfAvailabl
eAgents

True or False Shows or hides the Number of Available Agents statistic 
on the chat request form.
If set to True and there are no available agents, a 
message stating that ‘No agents are available to answer 
this request’ displays in place of the queue statistic.
NOTE: EnableNumberOfAvailableAgents must be set to 
True.

ShowNumberOfIdleAge
nts

True or False Shows or hides the Number of Idle Agents statistic on 
the chat request form.
NOTE: EnableNumberOfIdleAgents must be set to True.

ShowNumberOfChatsW
aiting

True or False Shows or hides the Number of Chats Waiting statistic on 
the chat request form.
NOTE: EnableNumberOfChatsWaiting must be set to 
True.

ShowBusinessHours True or False Shows or hides the queue business hours on the chat 
request form.
NOTE: EnableBusinessHours must be set to True.

AllowQueuingWhenNoA
gentsLogin

True or False If set to True, chat requests can be submitted when there 
are no agents logged in.
If set to False, when there are not agents logged in, 
contacts cannot submit chat requests and receive the 
message ‘No agents are available to answer this 
request’.
NOTE: EnableQueuingWhenNoAgentsLogin must be set 
to True.

AllowQueuingInAfterHo
urs

True or False If set to True, chat requests can be submitted outside of 
the queue’s business hours.
If set to False, contacts are unable to submit chat 
requests to a queue outside of its business hours and 
receive a message which states ‘The office is now 
closed, please contact us during our office hours.’ and 
lists the business hours for the queue

ShowTopic True or False Show/hide the topic form field on the chat request form

RequireTopic True or False If set to True, a topic is required for a chat request to be 
made.
If set to False, contacts may optionally enter or select a 
topic.

Table 24.7:Queue setting fields (Continued) (Sheet 3 of 6)

Field name Field Value Field description
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Topic Null or the text 
you want to 
display as the 
topic(s)

If set to null, the Topic field display as a freeform field.
If a single value is entered, the Topic field appears as a 
static, non-editable value.
If a comma separated list is entered, the Topic field 
appears as a drop-down list of selectable topics.

DefaultPublicGravatarU
RL

URL of image This field is used to set the Default Public Gravatar 
image to be used for contacts without Gravatar accounts 
in chat sessions.
This image must be hosted on a public website.
Images being used for the Default Public Gravatar image 
must meet the following requirements: 
• It must be publicly available
• It must be accessible via HTTP or HTTPS on ports 80 

and 443
• It must be a .jpg, .jpeg, .gif, or .png image file
• It must not include a querystring

DefaultAgentGravatarU
RL

URL of image This field is used to set the Gravatar image to be used for 
all agents in all chat sessions.
The image must be hosted on a public website.
Images being used for the Gravatar image must meet 
the following requirements: 
• It must be publicly available
• It must be accessible via HTTP or HTTPS on ports 80 

and 443
• It must be a .jpg, .jpeg, .gif, or .png image file
• It must not include a querystring.
  

UseDefaultPublicGravat
arForAllPublicUsers

True or False This field is used to determine whether or not all contacts 
will use the default Gravatar image.
If set to True, all public users will use the image set in 
DefaultPublicGravatarURL.
If set to False, users will only use the Default Public 
Gravatar if they have no Gravatar associated to their 
email address.

UseDefaultAgentGravat
arForAllAgents

True or False This field is used to determine whether or not all users 
will use the default Gravatar image.
If set to True, all agents will use the image set in 
DefaultAgentGravatarURL (or 
DefaultSupervisorGravatarURL).
If set to False, users will only use the Default Agent 
Gravatar (or Default Supervisor Gravatar) if they have no 
Gravatar associated to their email address.

Table 24.7:Queue setting fields (Continued) (Sheet 4 of 6)

Field name Field Value Field description
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GravatarSize The size, in 
pixels, of the 
Gravatar 
image

This field is used to set the size of the Gravatar, in pixels.

DisableChatRequestIfQ
ueueisNotOpen

True or False This field controls whether or not chat requests can be 
submitted when the queue is not available.
If set to True, chat requests cannot be submitted when 
the queue is closed or unavailable.
If set to False, chat requests can be submitted when the 
queue is closed or unavailable.

OutOfBusinessHoursMs
g

The text you 
want to display 
as the Out of 
Business Hour 
message

The text entered in this field displays as the Out of 
Business Hour message.
NOTE: ShowBusinessHours must be set to True

QueueStatusDNDMsg The text you 
want to display 
when the 
queue is in Do 
Not Disturb

The text entered in this field displays when the queue is 
in Do Not Disturb.

 
QueueStatusOutOfServi
ceMsg

The text you 
want to display 
as the Status 
Out of Service

The text entered in this field displays when the queue is 
Out of Service.

UsePrechatArea True or False This field controls whether or not chat uses the default 
chat request form.
If this field is set to True, the chat will use the default chat 
request form.
If this field is set to False, the chat will use the 
user-created chat request form specified under 
PrechatDataFromUrl
For more information on configuring user-made chat 
request pages, see the following KB article: 
https://mitel.custhelp.com/app/answers/answer_view/a_i
d/1000792/loc/en_US.

PrechatDataFromUrl URL or False If UsePrechatArea is set to False, this field sets the URL 
of the user-created Prechat form.
For more information on configuring user-made chat 
request pages, see the following KB article: 
https://mitel.custhelp.com/app/answers/answer_view/a_i
d/1000792/loc/en_US.

Table 24.7:Queue setting fields (Continued) (Sheet 5 of 6)

Field name Field Value Field description

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000792/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000792/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000792/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000792/loc/en_US
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LumaThreshold The luma 
threshold 
value

This determines the threshold to determine, based on 
the luma of the background color, whether or not to use 
dark or light icons.
If the luma value is equal to or greater than the specified 
luma threshold value, then dark icons will be used. If the 
luma value is less than the luma threshold value, light 
icons will be used.

Table 24.8:Logging and connection fields  (Sheet 1 of 2)

Field name Field value Field description

ChatClientSidelogging True or False This field controls whether or 
not a log for chat is available in 
the client’s browser.
If set to False, there is no 
client-side log created.
If set to True, a client-side log is 
created.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

MobileDeviceConnectionRetryL
imit

The number of connections This field controls how many 
times a mobile device can 
attempt to connect to chat.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

ConnectionRetryLimit The number of connections This field controls how many 
times a desktop device can 
attempt to connect to chat.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

Table 24.7:Queue setting fields (Continued) (Sheet 6 of 6)

Field name Field Value Field description
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The following procedures outline how to 
• Set up public-facing chat settings using chat.public.config.js
• Add ChatQueues fields to the chat.public.config.js file

To set up public-facing chat settings using chat.public.config.js 
1. Navigate to <drive>\Program Files (x86)\Mitel\MiContact Center\Website\CCMWa\Scripts\
2. Open chat.public.config.js in a text editor.

3. Customize your chat request form settings. 

For a description of the settings and their fields, see the above tables.
4. Save and close the editor.

To add ChatQueues to chat.public.config.js 
1. In YourSite Explorer, obtain the queue IDs of the chat queues for which you want to customize 

settings. 
For more information, see "Obtaining Queue GUIDs".

2. Open your copy of chat.public.config.js file in a text editor.

3. Locate ChatQueues: [ ] and copy and paste the following fields within ChatQueues’s brackets: 

{
Enabled: true,
QueueId: '',
LogoImgPath: '',
ShowLogo: false,
QueueLabel: '',
ShowQueueLabel: false,
AppendQueueLabelToPageTitle: true,
FormatPrechatLogoToForm: false,
Gradient: true,
GradientStartColor: '#000000',
GradientEndColor: '#444460',
ShowEstimatedWaitTime: true,

ConnectionRetryIterationCount The count limit This field sets the number of 
times a device can attempt to 
connect before prompting the 
user that it is unable to connect 
and that a refresh will occur.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

Table 24.8:Logging and connection fields (Continued) (Sheet 2 of 2)

Field name Field value Field description
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ShowNumberOfAvailableAgents: false,
ShowNumberOfIdleAgents: false,
ShowNumberOfChatsWaiting: false,
ShowBusinessHours: true,
AllowQueuingWhenNoAgentsLogin: true,
AllowQueuingInAfterHours: false,
ShowTopic: true,
RequireTopic: true,
Topic: null,
DefaultPublicGravatarURL:'',
DefaultAgentGravatarURL:'',
UseDefaultPublicGravatarForAllPublicUsers: false,
UseDefaultAgentGravatarForAllAgents: false,
GravatarSize: 32,
DisableChatRequestIfQueueisNotOpen: true,
OutOfBusinessHoursMsg: 'Sorry but we are currently closed. Please contact 
us during regular business hours.',
QueueStatusDNDMsg: 'Sorry but we are currently unavailable. Please try 
again later.',
QueueStatusOutOfServiceMsg: 'Sorry but we are currently unavailable. 
Please try again later',
UsePrechatArea: true,
PrechatDataFromUrl: false,
LumaThreshold:140
},

4. Customize the chat queue settings.

5. For each chat queue’s chat request form you want to customize, add the above fields. 

See the following figure for the proper formatting.
Figure 24.4: DefaultConfig with ChatQueues fields
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6. Save and close the text editor.

Hosting chat files on your corporate web server
With enhancements to chat in version 8.1, it is no longer recommended to host chat files on your corpo-
rate web server. By default, version 8.1 will use the configuration on the Enterprise Server. It is recom-
mended that you change your configuration to use chat.public.config.js located on the Enterprise Server.
If you do continue to maintain chat files in your corporate website’s file directory, you must manually 
update it with new fields and settings after every upgrade and you must enable Web.config to use an 
externally hosted file.
For information on hosting chat files on your Enterprise Server and referencing hosted chat with Contact 
Us, consult the version 9.2 Multimedia Contact Center Installation and Deployment Guide available at 
edocs.mitel.com.
To enabled externally hosted chat files 
1. Navigate to <drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\CCMWa.
2. Open Web.config in an editor.

3. Locate UseCcmwaHostedChatPublicClientConfig and set it to false.

4. Save and close the editor.

Updating chat customization from version 7.0 to version 8.1
Customizations to chat done in version 7.0 within Index.cshtml must be added to the chat.public.config.js 
to preserve them in version 7.1 and greater.
If you changed the background color in version 7.0, make note of the colors used in the theme Back-
ground and theme Background Color css classes in the Chat.public.css file and add them to Gradient-
StartColor and GradientEndColor in chat.public.config.js as appropriate after the upgrade.
If you added a logo, copy your logo image file to the <drive>\Program Files (x86)\Mitel\MiContact 
Center\WebSites\CCMWa\CCMWa\Content\images\logo\ and configure the LogoImgPath, ShowLogo, 
and FormatPrechatLogoToForm fields in chat.public.config.js.
For information on configuring your customization in chat.public.config.js, see "Configuring the chat 
JavaScript file".

Customizing Ignite chat and SMS agent options

Multimedia Contact Center enables contact centers to optionally modify how Ignite enables agents to 
handle chat and SMS sessions in a single JavaScript file. Contact centers can also set agent avatar 
options for agents in this file.
You can make the following customizations to chat and SMS sessions in Ignite: 
• Configure avatar settings for agents
• Configure whether or not CTRL+Enter sends a message or enters a carriage return
• Configure whether or not clicking End Your Chat ends a chat or SMS session or first prompts agents 

to confirm the ending of their session
• Choose to enable agents to view chats that they have not accepted or have not been offered to them
• Configure icon theme

NOTE: If you modify the default handling, it is your responsibility to inform agents of changed handling 
behavior.

https://www.mitel.com/document-center
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To customize Ignite chat and SMS sessions 
• Configure the agent and supervisor configuration JavaScript files. 

See "Configuring the agent and supervisor configuration JavaScript file".

Configuring the agent and supervisor configuration JavaScript files
Configuration settings for agent chat and SMS sessions in Ignite are controlled through two JavaScript 
files located in <drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\CCMWa\Scripts\: 
• chat.agent.config.js
• chat.supervisor.config.js

Chat.agent.config.js controls agent settings in Ignite. chat.supervisor.config.js controls how chat displays 
in Contact Center Client when a supervisor is previewing a chat session.
chat.agent.config.js and chat.supervisor.config.js settings can be grouped into three categories: 
• Global settings—control agent handling behavior of chat and SMS in Ignite. These settings are 

applied universally or are required to enable features at a queue level. The following table outlines the 
global fields.

• Queue settings—are controlled in DefaultConfig and ChatQueues. These two sections share the 
same fields. DefaultConfig fields apply the default settings for queues while ChatQueues fields are 
applied to individual specific queues. The following table outlines DefaultConfig and ChatQueues 
settings.

• Logging and connection settings—provide troubleshooting options as well as enable connection 
limits for devices. The following table outlines the logging and connection settings.

When adding field values based on the following tables, ensure that they use correct JavaScript format-
ting and punctuation.
Table 24.9:Global setting fields  (Sheet 1 of 3)

Field name
Field 
value Field Description

EnableAgentGravatar True or 
False

This field controls whether or not Chat will 
use Gravatar for Agents.
If set to True, Chat sessions will use any 
Gravatar user image associated to the 
email addresses used in the chat session 
or the image configured with 
DefaultAgentGravatarUrl.
If set to False, no agent Gravatar user 
images will be used in the chat session.
NOTE: This field must have the same value 
in chat.public.config.js, 
chat.agent.config.js, and chat.super-
visor.config.js.
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EnableSupervisorGravatar True or 
False

This field controls whether or not Chat will 
use Gravatar for Agents.
If set to True, Chat sessions will use any 
Gravatar user image associated to the 
email addresses used in the chat session 
or the image configured with 
DefaultAgentGravatarUrl.
If set to False, no agent Gravatar user 
images will be used in the chat session.
NOTE: This field must have the same value 
in chat.public.config.js, 
chat.agent.config.js, and chat.super-
visor.config.js.

EnablePublicGravatar True or 
False

This field controls whether or not Chat will 
use Public Gravatar for agents.
If set to True, Chat sessions will use any 
Public Gravatar user image associated to 
the email addresses used in the chat 
session or the image configured with 
DefaultAgentGravatarUrl.
If set to False, no Public Gravatar user 
images will be used in the chat session.
NOTE: This field must have the same value 
in chat.public.config.js, 
chat.agent.config.js, and chat.super-
visor.config.js.

UseCtrlEnterForGlobalSend True or 
False

This field controls whether or not 
CTRL+Enter enters a carriage return or 
sends a message in Ignite.
If set to True, in a Chat or SMS session in 
Ignite, pressing CTRL+Enter sends a 
message and pressing Enter adds a 
carriage return.
If set to False, CTRL+Enter will add a 
carriage return and Enter will send a 
message.

Table 24.9:Global setting fields (Continued) (Sheet 2 of 3)

Field name
Field 
value Field Description
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EnableAgentPromptForEndConversation True or 
False

This field controls whether or not agents 
will be prompted to confirm the closing of a 
chat or SMS session.
If set to True, when the End Your Chat 
button is pressed, agents will be prompted 
to confirm that they want to close the 
current chat or SMS session.
If set to False, when the End Your Chat 
button is pressed, the chat or SMS session 
closes.

EnableSupervisorPromoptForEndConvers
ation

True or 
False

This field controls whether or not agents 
will be prompted to confirm the closing of a 
chat or SMS session.
If set to True, when the End Your Chat 
button is pressed, agents will be prompted 
to confirm that they want to close the 
current chat or SMS session.
If set to False, when the End Your Chat 
button is pressed, the chat or SMS session 
closes.

Table 24.10:DefaultConfig and ChatQueues fields  (Sheet 1 of 4)

Field name Field value Field Description

Enabled True or False This field enables or disables 
this configuration record.
If you set to False, the queue’s 
chat form will use the values 
from the default file in 
<drive>:\Program Files 
(x86)\Mitel\MiContact 
Center\WebSites\CCMWa\Scrip
ts\ 
Chat.ui.agent.config.DEFAULT.j
s or 
Chat.ui.supervisor.config.DEFA
ULT.js.

Table 24.9:Global setting fields (Continued) (Sheet 3 of 3)

Field name
Field 
value Field Description
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QueueId (ChatQueues only) The queue’s GUID, such as 
‘26F1A5C3- DD2C-45FFBE75- 
2BC7B85012 D0’

The GUID for the chat queue to 
which you want the associated 
settings to apply. You can use 
YourSite Explorer to obtain a 
queue’s GUID. See "Obtaining 
Queue GUIDs".

DefaultAgentGravatarURL URL of image This field is used to set the 
Gravatar image to be used for 
all agents in all chat sessions.
The image must be hosted on a 
public website.
Images being used for the 
Gravatar image must meet the 
following requirements: 
• It must be publicly available
• It must be accessible via 

HTTP or HTTPS on ports 80 
and 443

• It must be a .jpg, .jpeg, .gif, or 
.png image file

• It must not include a querys-
tring.

DefaultSupervisorGravatarURL URL of image This field is used to set the 
Gravatar image to be used for 
all agents in all chat sessions.
The image must be hosted on a 
public website.
Images being used for the 
Gravatar image must meet the 
following requirements: 
• It must be publicly available
• It must be accessible via 

HTTP or HTTPS on ports 80 
and 443

• It must be a .jpg, .jpeg, .gif, or 
.png image file

• It must not include a querys-
tring.

Table 24.10:DefaultConfig and ChatQueues fields (Continued) (Sheet 2 of 4)

Field name Field value Field Description
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UseDefaultAgentGravatarForAll
Agents

True or False This field is used to set whether 
or not all users will use the 
default Gravatar image.
If set to True, all agents will use 
the image set in 
DefaultAgentGravatarURL (or 
DefaultSupervisorGravatarURL)
.
If set to False, users will only 
use the Default Agent Gravatar 
(or Default Supervisor Gravatar) 
if they have no Gravatar 
associated to their email 
address.

UseDefaultSupervisorGravatar
ForAllSupervisors

True or False This field is used to set whether 
or not all users will use the 
default Gravatar image.
If set to True, all agents will use 
the image set in 
DefaultAgentGravatarURL (or 
DefaultSupervisorGravatarURL)
.
If set to False, users will only 
use the Default Agent Gravatar 
(or Default Supervisor Gravatar) 
if they have no Gravatar 
associated to their email 
address.

UseDefaultPublicGravatarForAll
PublicUsers

True or False This field is used to set whether 
or not all contacts will use the 
default Gravatar image.
If set to True, all public users 
will use the image set in 
DefaultPublicGravatarURL.
If set to False, users will only 
use the Default Public Gravatar 
if they have no Gravatar 
associated to their email 
address.

GravatarSize The size, in pixels, of the 
Gravatar image

This field is used to set the size 
of the Gravatar, in pixels.

Table 24.10:DefaultConfig and ChatQueues fields (Continued) (Sheet 3 of 4)

Field name Field value Field Description
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PeekModeAllowed True or False This field controls whether or 
not agents can view chats that 
they have not accepted or have 
not been offered.

IconTheme Light or Dark IconTheme determines if the 
icons appear as light or dark, to 
better suit the selected 
background color. The 
IconTheme value can be Light 
or Dark.

Table 24.11:Logging and connection fields  (Sheet 1 of 2)

Field name Field value Field Description

ChatClientSidelogging True or False This field controls whether or 
not a log for chat is available in 
the client’s browser.
If set to False, there is no 
client-side log created.
If set to True, a client-side is 
created.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

MobileDeviceConnectionRetryL
imit

The number of connection 
attempts

This field controls how many 
times a mobile device can 
attempt to connect to chat.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

ConnectionRetryLimit The number of connection 
attempts

This field controls how many 
times a desktop device can 
attempt to connect to chat
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

Table 24.10:DefaultConfig and ChatQueues fields (Continued) (Sheet 4 of 4)

Field name Field value Field Description



833

CONFIGURING MULTIMEDIA CONTACT CENTER WEB FEATURES
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

After customizing your agent chat and SMS sessions, your changes will be applied to Ignite.
The following procedures outline how to: 
• Set the agent chat and SMS settings using chat.agent.config.js
• Add ChatQueues fields to chat.agent.config.js
• Set the supervisor settings using chat.supervisor.config.js
• Add ChatQueues fields to chat.supervisor.config.js

chat.supervisor.config.js must have the same settings configured as chat.agent.config.js. For 
agent-specific fields such as DefaultAgentGravatarURL, add the value to the supervisor-specific equiva-
lent, such as DefaultSupervisorGravatarURL.
To set the agent chat and SMS settings using chat.agent.config.js 
1. On the Enterprise Server, navigate to <drive>:\Program Files (x86)\Mitel\MiContact 

Center\WebSites\Ccmwa\Scripts.
2. Open chat.agent.config.js in a text editor.

3. Customize your agent chat settings. 

For a description of the settings and their fields, see the above tables.
4. Save and close the editor.

To add ChatQueues fields to chat.agent.config.js 
1. In YourSite Explorer, obtain the queue IDs of the chat queues for which you want to customize 

settings. 
For more information, see "Obtaining Queue GUIDs".

2. Open chat.agent.config.js in a text editor.

3. Locate ChatQueues:[ ] and copy and paste the following fields within ChatQueues’s brackets. 

See the following figure for the proper formatting.
{
Enabled: true,
QueueId: ‘’,
DefaultAgentGravatarURL: 
encodeURIComponent(window.ccmwa.shared.getCCMWaBaseUrl() + 
'/content/images/gravatar/defaultagent.png'),

ConnectionRetryIterationCount The count limit This field sets the number of 
times a device can attempt to 
connect before prompting the 
user that it is unable to connect 
and that a refresh will occur.
NOTE: This field must have the 
same value in 
chat.public.config.js, 
chat.agent.config.js, and 
chat.supervisor.config.js.

Table 24.11:Logging and connection fields (Continued) (Sheet 2 of 2)

Field name Field value Field Description



834

CONFIGURING MULTIMEDIA CONTACT CENTER WEB FEATURES
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

UseDefaultAgentGravatarForAllAgents: false,
GravatarSize: 32,
PeekModeAllowed: true,
IconTheme: 'Dark'
},

chat.agent.config.js formatting

4. Customize your ChatQueues field settings. 

For a description of the settings and their fields, see the above table.
5. For each additional queue you want to configure agent Ignite settings for, repeat steps 2-3.

6. Save and close the text editor.

To set the supervisor settings using chat.supervisor.config.js 
1. On the Enterprise Server, navigate to <drive>:\Program Files (x86)\Mitel\MiContact 

Center\WebSites\Ccmwa\Scripts.
2. Open chat.supervisor.config.js in a text editor.

3. Customize your supervisor chat settings. 

For a description of the settings and their fields, see the above tables.
4. Save and close the editor.

To add ChatQueues fields to chat.supervisor.config.js 
1. In YourSite Explorer, obtain the queue IDs of the chat queues for which you want to customize 

settings. 
For more information, see "Obtaining Queue GUIDs".

2. Open chat.supervisor.config.js in a text editor.
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3. Locate ChatQueues:[ ] and copy and paste the following fields within ChatQueues’s brackets. 

See the following figure for the proper formatting.
{
Enabled: true,
QueueId: ‘’,
DefaultSupervisorGravatarURL:'',
DefaultPublicGravatarURL: '',
UseDefaultSupervisorGravatarForAllSupervisors: false,
UseDefaultPublicGravatarForAllPublicUsers: false,
GravatarSize: 32,
PeekModeAllowed: true,
IconTheme: 'Dark'
},

Figure 24.5: chat.supervisor.config.js formatting

4. Customize your ChatQueues field settings. 

For a description of the settings and their fields, see the above table.
5. For each additional queue you want to configure agent Ignite settings for, repeat steps 3-4.

6. Save and close the text editor.
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Offering chat through your corporate website

A contact center can offer chat through a number of means on their corporate website. Some suggested 
methods for offering chat include:
• Offering chat via a basic hyperlink

See "Offering chat via a basic hyperlink".
• Offering chat via a containing page

See "Offering chat in a containing page in your own site".
• Offering chat via a pop-up window

See "Offering chat in a pop-up window".

Multimedia Contact Center includes sample files demonstrating these suggested methods. Samples can 
be found in <drive>:\Program Files (x86)\Mitel\MiContact Center\Support\BasicSamples.

Offering chat via a basic hyperlink

In this method, a link is offered to the default CCMWa/chat on the Enterprise Server. Contacts clicking the 
link open the chat request page. With this method, you link to the default reverse proxied chat application 
on CCMWa.
NOTE: If a subdomain is being used to access chat, such as chat.example.com, consult the following Mitel 
Knowledge Base article: https://mitel.custhelp.com/app/answers/answer_view/a_id/1013097/loc/en_US.
The following HTML is an example of offering chat to a specific queue via a basic hyperlink in a page in 
your own website.

<!DOCTYPE html>
<html xmlns="http://www.w3.org/1999/xhtml">
<head>
<title>Basic Chat</title>
</head>
<body>
<a 
href="http://localhost:8082/ccmwa/en-CA/chat/26F1A5C3-DD2C-45FF-BE75-2BC
7B85012D0">chat now</a>
</body>
</html>

Offering chat in a containing page in your own site

In this method, the CCMWa/Chat is rendered within an HTML page on your own site. This can be done 
by rendering CCMWa/Chat within the body of the page or within a container on the page.
For an example of chat embedded within the body of a webpage, with usable HTML and JavaScript, see 
chat.basic.embedAsPage.html in <drive>:\Program Files (x86)\Mitel\MiContact 
Center\Support\BasicSamples. Adjust as needed to match your storage of scripts and chat queue GUIDs.
For an example of chat embedded within the body of a webpage as a widget, with usable HTML and 
JavaScript, see chat.basic.embedAsWidget.html in the Samples folder at <drive>:\Program Files 
(x86)\Mitel\MiContact Center\Support\BasicSamples. Adjust as needed to match your storage of scripts 
and chat queue GUIDs.
NOTE: If you use these HTML, do not modify the variable names for queueId or targetContainer. Do not 
modify the name or value of the hdr variable. Doing so will cause issues for rendering the chat session.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1013097/loc/en_US


837

CONFIGURING MULTIMEDIA CONTACT CENTER WEB FEATURES
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Offering chat in a pop-up window

Chat can be offered through a pop-up window. For an example of how to offer chat in a pop-up window, 
see chat.basic.popup.html in the Samples folder at <drive>:\Program Files (x86)\Mitel\MiContact 
Center\Support\BasicSamples. Adjust as needed to match your storage of scripts and chat queue GUIDs.

Offering chat in different languages

Different language versions of the chat request form can be accessed by adding the language designator 
between /CCMWa/ and /chat. For example, the French Canadian chat request form would be accessed 
through http://<enterprise server>/ccmwa/fr-CA/chat. The following table contains a list of the different 
supported languages and the corresponding designator.

Enabling Contact Us

Contact Us is Multimedia Contact Center’s contact tool for contact center corporate websites, presenting 
access to queues grouped by business lines. Designed to integrate into existing corporate websites, 
Contact Us can be customized to reflect an organization’s specific service groups or business lines and 
their corresponding queues. Like chat, Contact Us uses CCMWa, a web application installed on the Enter-
prise Server at http://<Enterprise Server IP Address>/CCMWa to route interactions to your multimedia 
queues.

Table 24.12:Language designators

Language Designators

Simplified Chinese zh-CN

Dutch nl-NL

English (US) en-US

English (UK) en-GB

French (Canadian) fr-CA

French (France) fr-FR

German de-DE

Italian it-IT

Norwegian nb-NO

Portuguese (Brazilian) pt-BR

Russian ru-RU

Spanish (Latin American) es-CL

Spanish (Spain) es-ES

Swedish sv-SE

Welsh cy-GB
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The WickedTix sample website included with Multimedia Contact Center showcases an integration of 
Contact Us within a corporate website. For more information, see "Corporate Website Example: Wick-
edTix". There is also a basic sample website included called BasicSamples, focusing on basic Chat and 
Contact Us integrations, available in the Samples folder at <drive>:\Program Files (x86)\Mitel\MiContact 
Center\Support\BasicSamples.
The following figure displays Contact Us. By default, all the business lines display as collapsed, showing 
only the business line name and hours. The footer of Contact Us contains a link that can be configured to 
send customers to relevant information concerning the contact center.

Figure 24.6: Contact Us
 

When clicked, a business line expands to display the queues configured with it. You can configure the 
specific contact information for each queue so that customers can contact the business line by that media 
type. (See the following figure.)
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Figure 24.7: Contact Us (Expanded)

Contact Us can also be configured to use a horizontal display of business lines and their queues. (See 
the following figure.)
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Figure 24.8: Contact Us (horizontal)

In Contact Us, each queue media icon can be configured to launch a contact session. Icons can be 
disabled and greyed out or hidden if that media type is not applicable to a business line. Clicking the 
phone icon will make a call if the device is able to make calls. Clicking an email icon will either launch an 
email form (see the following figure) or, if the customer is using a mobile device, it will open the phone’s 
email application with the icon’s configured email address in the To: field.
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Figure 24.9: Email Us form

Clicking a chat icon launches a chat session with the configured chat queue. Clicking an SMS icon 
launches an SMS form (see the following figure) or, if the customer is using a mobile device, it will open 
the phone’s SMS application with the icon’s configured SMS number. When the customer clicks Send on 
the form, an SMS will be send to the queue by Contact Us with the customer’s number.
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Figure 24.10: SMS form

If the contact center is licensed for IVR, the web callback icon can be configured to submit callback 
requests for customers. When clicked, a web callback request form is opened for customers to fill in call-
back details and submit a callback request. See the following figure shows the options in the web callback 
form. For more information on web callbacks, see the MiContact Center Business Installation and Admin-
istration Guide .
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Figure 24.11: Web callback
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Determining how to offer Contact Us

When implementing Contact Us, you must determine how you want to offer Contact Us. Contact Us is a 
flexible tool that can be offered to contact center customers in multiple separate instances, as either a 
standalone webpage in a corporate website or as an integration within an existing webpage. Depending 
on the method for integrating Contact Us, you will be required to configure different Contact Us files and 
decide how to host them.
Contact Us has several samples available to help guide decisions on how to offer Contact Us. For basic 
deployments, see the files available within <drive>:\Program Files (x86)\Mitel\MiContact 
Center\Support\BasicSamples. These include a sample file showing Contact Us as a standalone 
webpage and a file showing Contact Us embedded as a slider. For an example of a more integrated 
deployment of Contact Us, Multimedia Contact Center includes a sample website, WickedTix, which 
provides an example implementation of Contact Us. WickedTix files are available in <drive>:\Program 
Files (x86)\Mitel\MiContact Center\Support\WickedTix. For more information on WickedTix, see "Corpo-
rate Website Example: WickedTix".

Corporate Website Example: WickedTix

WickedTix is an example corporate webpage integrated with Multimedia Contact Center. Contact Us has 
been added as a slider on the right side of the page. The following figure shows the webpage with the 
Contact Us tab. When clicked, it expands and offers customers the contact options for the company. The 
following figure shows the expanded slider. WickedTix can be found at <drive>:\Program Files 
(x86)\Mitel\MiContact Center\Support\WickedTix.
The main WickedTix landing page shows Contact Us integrated in the horizontal mode within a targeted 
container within the page. Other pages in the site integrate Contact Us using the vertical layout, 
auto-centering it within the viewable area of the page. The following figure shows WickedTix with Contact 
Us expanded.

Figure 24.12: WickedTix with open slider
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Implementing Contact Us

After having decided how to offer Contact Us, Contact Us can be configured and implemented. Contact 
Us is implemented using a single script reference to render it and another to configure the queues and 
media types. Additional customization can be made using a CSS stylesheet.
To implement Contact Us 
1. Configure your business lines and queues for Contact Us. 

Contact Us uses a JavaScript file, contactus.config.js, to manage business line and queue informa-
tion.
Configurations can be reused if you want to show the same contact options on multiple pages (or a 
single configuration referenced in a header/footer, for example). A separate configuration file is re-
quired for any alternate configurations you want to render, where the contact options are different.
See "Configuring your business lines and queues for Contact Us".

2. Configure Contact Us style. 

Contact Us uses CSS to implement its styling. All of the visual components are set by ContactUs.css 
in <drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\Ccmwa\Content. You can copy this 
file and host it in your own website with any style modifications.
See "Configuring Contact Us style".

3. Configure the email 
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– Configure the email form 
For the Contact Us email from, the information captured is sent as an email to a queue for routing. 
Therefore, the From address must not be same as the To address submitted in the form; otherwise, 
the message is flagged as a no-reply and is not routed. To prevent this, in YourSite Explorer applica-
tion, configure an alias email address that is valid for the SMTP server to send an email.

NOTE: Do not set as this email address as the dial-to address for any queue in the system.
Edit the CCMWa web.config file using any text or XML editor. The file location is: C:\Program Files 
(x86)\Mitel\MiContact Center\WebSites\Ccmwa\. In the appSettings section of Web.config, set the 
value to the email address that you configured. Save and close the file.

NOTE: Editing the CCMWa web.config file causes the CCMWa process to restart. Hence we 
recommend that you configure this setting during a downtime.

These settings do not affect mobile clients because they use the native email client instead of the 
web form.

– Configure the email form with Exchange 
This step is only required if your mail server uses Exchange.
See "Configuring the email form with Exchange".

4. Host Contact Us files on your corporate web server (optional) 

If you are using multiple configuration files for Contact Us, you must host them externally on your cor-
porate web server and then enable Contact Us to use the external files.
See "Hosting Contact Us files on your corporate web server".

5. Add Contact Us to your corporate website. 

Add the necessary files to your corporate website’s web directory on the web server and add the Ja-
vaScript references to add Contact Us as either a standalone webpage or embedded within an exist-
ing corporate webpage.
See "Adding Contact Us to your corporate website".

Configuring your business lines and queues for Contact Us

Business line and queue information, as well as the settings for how Contact Us displays, are set in the 
JavaScript file contactus.config.js. This file can be found at <drive>:\Program Files (x86)\Mitel\MiContact 
Center\WebSites\Ccmwa\Scripts.
If you intend to offer multiple instances of Contact Us on your corporate website with different business 
line and queue information, you will require multiple copies of contactus.config.js. Copies of 
contactus.config.js can be renamed and stored in different locations, but script references to Contact Us 
must be updated to renamed file in the script reference’s parameters. For more information, see "Adding 
Contact Us to your corporate website".
Business line or service group sections can be added or removed and the available media types for each 
of these sections can be modified. The media type layout is fluid so that if one media type icon is removed, 
the others flow together.
The following procedures describe how to: 
• Configure the header and footer
• Hide the header or footer
• Apply a light or dark icon theme
• Use the horizontal Contact Us layout
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• Configure contactus.config.js with business lines and media types
• Remove media types from a service group or business line in an instance of contactus.config.js
• Configure logging and connection options

To configure the header and footer 
1. Open the instance of contactus.config.js in a text editor.
2. Locate the field HeaderHTML.

3. Replace field’s content with your header content.

4. Locate the field FooterHTML.

5. Replace the field’s content with your footer content.

6. Save and close the text editor.

To hide the header or footer 
1. Open the instance of contactus.config.js in a text editor.
2. If you want to hide the header, locate the line ShowHeader: true and set it to false.

3. If you want to hide the footer, locate the line ShowFooter: true and set it to false.

4. Save and close the text editor.

To use a light or dark icon theme 
1. Open the instance of contactus.config.js in a text editor.
2. If you want a light icon theme, locate the line IconTheme and set it to Light.

3. If you want a dark icon theme, locate the line IconTheme and set it to Dark.

4. Save and close the text editor.

To use the horizontal Contact Us layout 
1. Open your instance of contactus.config.js in an editor.
2. Set UseVerticalBusinessLinesFirst to true.

3. Save and close the editor.

To configure contactus.config.js with business lines and media types 
1. Open the instance of contactus.config.js in a text editor.
2. Replace the existing values in the service group/business line fields. 

See the following table for a description of each field.
See the following figure for a labeled diagram of what fields correspond to which elements in Contact 
Us.

Table 24.13:Business Line fields  (Sheet 1 of 2)

contactus.config.js fields Description

BusinessLineName The name of the business line or service group

HoursOfOperation The hours of operation for the contact center 
handing the queues for this business line or 
service group
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Figure 24.13: Contact Us contactus.config.js fields
 

3. Under MediaTypes, configure the MediaTypes fields to correspond to the queues for your own service 
groups or business lines. 

See the following table for a description of each field.
See the following figure for a labeled diagram of what fields correspond to which elements in Contact 
Us.

UnifiedQueueIdOrNameOrReporting The service group/business line’s Unified Queue 
Group GUID, Name, or Reporting Number

EstimatedWaitTimeLabel The Estimated Wait Time label text that displays 
when a mouse hovers over

ShowIconCaptions If True, Contact Us will display the caption 
configured in Caption. If False, it hides the caption

MediaTypes The supported media types that display in the 
business line or service group

Table 24.13:Business Line fields (Continued) (Sheet 2 of 2)

contactus.config.js fields Description
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Table 24.14:MediaTypes fields  (Sheet 1 of 3)

Contact.Config.js fields Function

Enabled Controls whether or not the media type can be 
interacted with 
• If set to True, the media type’s icon and text are 

clickable
• If set to False, the icon is greyed out and cannot 

be interacted with

OnMouseHoverMessage The text that displays when a mouse hovers over 
an icon

CssClass The CSS class used for the media type. By 
default, these are: 
• Voice: lobMediaTypePhone
• Chat: lobMediaTypeChat
• Email: lobMediaTypeEmail
• Callback: lobMediaTypeCallback
• SMS: lobMediaTypeSms

Caption The caption text. Used in conjunction with 
ShowIconCaptions.

ContactDisplayInfo The text displaying the contact information for the 
queue, such as email address or phone number

Icon The type of icon used for this media type. 
Supported icon values are: 
• Phone
• Chat
• Email
• SMS
• Callback

QueueIdOrNameOrReporting The queue’s GUID
This unique identifier enables Contact Us to 
identify this Contact Us queue with a queue on the 
media server
For instructions on how to obtain a queue's GUID, 
see "Obtaining Queue GUIDs".
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ClickToContactInfo The queue’s dialable phone number, email 
address, chat queue external URL, or SMS 
number.
NOTE: 
• Phone numbers and SMS numbers must be 

entered with no spaces or other characters
• If you enter the external URL for CCMWa/chat 

instead of an external URL for a queue, then no 
chat Estimate Wait Time will display as no 
queue has been selected.

Handler The type of media. The Handler can be: 
• Call
• Chat
• Email
• SMS
• Callback
NOTE: It is not recommended to change or edit this 
field, unless you are adding or removing an entire 
media type.

SupportedProtocols The protocols your business can support for the 
media type contact mechanism. Protocols can be 
added for voice queues. The following protocols 
are supported:
Voice: 
• ‘tel’ – calls the number configured in ClickTo-

ContactInfo using the telephone application

EwtPrefix It is not recommended to change or edit this field, 
unless you are adding or removing an entire media 
type.
If the media type is voice, email, chat, or SMS, set 
EwtPrefix value to "ewt"
If the media type is callback, set the EwtPrefix 
value to "ewt_wcb"

Table 24.14:MediaTypes fields (Continued) (Sheet 2 of 3)

Contact.Config.js fields Function
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4. Save and close the text editor.

To add media types to a service group or business line in an instance of contactus.config.js: 
1. Open the instance of contactus.config.js in a text editor.
2. If the media type is email, chat, or SMS, locate the service group or business line’s section in 

contactus.config.js and add the following under MediaType: 

Enabled: true,
OnMouseHoverMessage: "",
CssClass: "",
Caption: "",
ContactDisplayInfo: "",
Icon: "",
QueueIdOrNameOrReporting: "",
ClickToContactInfo: "",
Handler: ""
EwtPrefix: ""
},

3. If the media type is callback, locate the service group or business line’s section in the 
contactus.config.js and add the following under MediaType: 

{
Enabled: true,
OnMouseHoverMessage: "",
CssClass: "lobMediaTypeCallback",
Caption: "Callback",
ContactDisplayInfo: "Callback",
Icon: "Callback",
QueueIdOrNameOrReporting: "",
ClickToContactInfo: "Callback",
Handler: "Callback",
EwtPrefix: "ewt_wcb",

OutboundWorkflowId • The GUID for OutboundWorkflow subroutine.
• Contact Us can now be configured with a 

WebCallback subroutine at the queue level. 
Obtain the GUID for the subroutine and update 
the associated configuration file for Contact Us. 
This enables Contact Us to pass along the 
correct subroutine to be used to initiate a call-
back routing for the given queue.

• For instructions on how to obtain a subroutine 
GUID, see "Obtaining Subroutine GUIDs".

Table 24.14:MediaTypes fields (Continued) (Sheet 3 of 3)

Contact.Config.js fields Function
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OutboundWorkflowId: ""
},

4. If the media type is voice, locate the service group or business line’s section in contactus.config.js and 
add the following under MediaType: 

Enabled: true,
OnMouseHoverMessage
CssClass: " lobMediaTypePhone ",
Caption: "",
ContactDisplayInfo: "",
Icon: "",
QueueIdOrNameOrReporting: "",
ClickToContactInfo: "",
SupportedProtocols "tel",
Handler: "Call"
EwtPrefix: "ewt"
},

5. Configure the fields.

6. Save and close the editor.

To remove media types from a service group or business line in an instance of contactus.config.js 
1. Open the instance of contactus.config.js in a text editor.
2. To remove a media type, delete that media type’s lines from under MediaTypes, 

To delete chat, for example, you would delete the following lines:
{
Enabled: true,
OnMouseHoverMessage: "Chat with Sports Support",
CssClass: "lobMediaTypeChat",
Caption: "Chat",
ContactDisplayInfo: "",
Icon: "Chat",
QueueIdOrNameOrReporting: "d596e70f-526d-4c94-aa86-faa0e8bdb9db",
ClickToContactInfo: 
"http://localhost/ccmwa/chat/d596e70f-526d-4c94-aa86-faa0e8bdb9db",
SupportedProtocols: "",
Handler: "Chat",
EwtPrefix: "ewt"
},

3. Save and close the text editor.

To configure logging and connection options 
1. Open the instance of contactus.config.js in a text editor.
2. After ClientSidelogging, type True if you want to enable a log for Contact Us to be available in the 

client’s browser.
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3. After ConnectionRetryLimit, set the number of times a desktop device can attempt to connect to 
Contact Us.

4. After MobileDeviceConnectionRetryLimit, set the number of times a mobile device can attempt to 
connect to Contact Us.

5. After ConnectionRetryIterationCount, set the number of times a device can attempt to connect 
before prompting the user that it is unable to connect and that a refresh will occur.

6. Save and close the text editor.

Configuring Contact Us style

Optionally, you can alter the style of Contact Us to match your corporate website’s style. By default, 
Contact Us uses ContactUs.css, located at <drive>:\Program Files (x86)\Mitel\MiContact 
Center\WebSites\Ccmwa\Content. This default stylesheet can be customized and have multiple copies 
made of it for use with different instances of Contact Us. If custom instances of ContactUs.css are being 
used, JavaScript references to Contact Us require parameters specifying the .css file’s location. For more 
information, see "Adding Contact Us to a webpage" and "Adding Contact Us with the default slider".
If Contact Us is to be integrated within an existing corporate webpage, CSS can be overridden Contact 
Us’s stylesheet and use the webpage’s CSS stylesheet instead.
NOTE: 
• It is recommended to only configure colors and fonts. Changing other stylesheet settings, such as 

icons, may impact Contact Us functionality.
• Copies of ContactUs.css can be stored in different folders, but must keep the name ContactUs.css.

To configure Contact Us to use the integrated webpage’s CSS
1. On your Enterprise Server, navigate to <drive>:\Program Files (x86)\Mitel\MiContact 

Center\WebSites\Ccmwa\Content.
2. Create a copy of ContactUs.css and add it to a folder within your website.

3. Update ContactUs.css to match your site’s style.

4. Add a reference to the copy of ContactUs.css in your JavaScript call to MiccContactUs.js or MiccSide-
Slider.js.

For information, see "Adding Contact Us to a webpage" and "Adding Contact Us with the default slid-
er".

Configuring the email form with Exchange

The email form automatically uses the email media server’s mail server configured in YourSite Explorer 
to submit emails to queues. To ensure Exchange uses the customer-entered email address in the form 
for responses and not the email mail server or queue email address, you must disable Outgoing SMTP 
Authentication in YourSite Explorer and configure authentication on the Exchange server.
For instructions on the specific Exchange configuration, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1001226/loc/en_US.
NOTE: For Office365 user accounts created in October 2020 and later, Basic Authentication is disabled by 
default. Currently, MiContact Center Business supports only Basic Authentication. Therefore, if Office365 
is used as an email server, Basic Authentication must be manually enabled.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1001226/loc/en_US
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To disable Outgoing SMTP Authentication 
1. Click Multimedia > Mail server.
2. Select the Exchange mail server and click the Outgoing tab.

3. Under Outgoing Logon Information, clear SMTP Authentication Required.

4. Click Save.

Hosting Contact Us files on your corporate web server

By default, Contact Us uses files hosted on the Enterprise Server. If you are using multiple 
contactus.config.js files for different business lines, you will need to host them externally on your corpo-
rate web server.
You can store Contact Us JavaScript and CSS files on your corporate web server within the corporate 
website’s directory. Files stored within your website’s directory on your corporate web server can be 
located anywhere within the directory at your discretion. If you store Contact Us files on your corporate 
web server, you must manually update your files with any new fields and settings after every upgrade.
To enabled externally hosted Contact Us files
1. Navigate to <drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\CCMWa.
2. Open Web.config in an editor.

3. Locate UseCcmwaHostedContactUsClientConfig and set it to false.

4. Save and close the editor.

Adding Contact Us to your corporate website

Contact Us can be offered from your corporate website through a number of different methods.
Multimedia Contact Center includes a preconfigured JavaScript file that renders Contact Us in the spec-
ified container on a webpage. This can be used to render Contact Us as a standalone webpage, embed 
Contact Us within a page, or render Contact Us in a pop-up or slider. For more information, see "Adding 
Contact Us to a webpage".
For integrations with existing webpages, Multimedia Contact Center includes a preconfigured JavaScript 
slider containing Contact Us that can be added to your webpages. For more information, see "Adding 
Contact Us with the default slider".
For either resource, you must decide whether you want to host Contact Us’s JavaScript files and CSS 
files on your corporate web server within the corporate website’s directory or store the files within CCMWa 
on the Enterprise Server. Files stored within your website’s directory on your corporate web server can 
be located anywhere within the directory at your discretion.
NOTE: Optionally, you can store Contact Us JavaScript and CSS files on your corporate web server within 
the corporate website’s directory. Files stored within your website’s directory on your corporate web 
server can be located anywhere within the directory at your discretion. If you store Contact Us files on 
your corporate web server, you must manually add new fields to the files after every upgrade.
Ensure that you specify the locations in the script reference parameters discussed in "Adding Contact Us 
to a webpage" and "Adding Contact Us with the default slider".
Adding Contact Us to a webpage
Contact Us can be offered using a script reference. Multimedia Contact Center includes a JavaScript file, 
MiccContactUs.js, to render Contact Us within an optional target on a webpage. If you want to render 
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Contact Us as a stand-alone webpage, create an empty HTML file and add a reference to this script. For 
an example of this implementation, see contact.basic.stacked.html or contact.basic.horizontal.html in 
<drive>:\Program Files (x86)\Mitel\MiContact Center\Support\BasicSamples.
By default, this script uses the default contactus.config.js and ContactUs.css. To use different business 
lines’ contactus.config.js files or CSS files with MiccContactUs.js, different parameters can be added to 
the script reference. The following is an example of a MiccContactUs script with all parameters applied to 
the script reference.
<script
src="ccmwa/scripts/micccon-
tactus.js?embedded=false&target=contactus&vmode=false&csspath=assets/css/&jspath=assets/js/&co
nfig= contactus.config "></script>
The following table describes the different parameters
Table 24.15:MiccContactUs.js parameters  (Sheet 1 of 2)

Parameter Name

Param
eter 
Value Default Value Parameter Description

embedded True 
or 
False

False Controls whether or not 
Contact Us will embed itself 
in the container specified 
with the target parameter.
If set to True, Contact Us will 
be embedded in the target.
If set to False, Contact Us 
renders within the body of 
the page in the upper-left 
corner.

target The ID 
attribut
e of 
the 
target

none Sets the target in which 
Contact Us renders.
If the target is not present or 
empty, the Contact Us will 
render as the last item on the 
page.
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There are various other integration options based on a combination of the parameters used and what kind 
of container is targeted. For more information, see the basic samples website located in <drive>:\Program 
Files (x86)\Mitel\MiContact Center\Support\BasicSamples. The following procedure details how to 
configure Contact Us as a standalone webpage. It assumes that you have: 
• Added your business lines and queues to a copy of contactus.config.js
• Optionally updated the style in ContactUs.css
• Placed your JavaScript and CSS files in the desired location on either the Enterprise Server or corpo-

rate web server.

vmode True 
or 
False

True Controls whether or not 
Contact Us renders in the 
standard display or the 
horizontal display.
If set to True, Contact Us 
renders in the default 
display.
If set to False, Contact Us 
renders in the horizontal 
display.
NOTE: vmode overrides the 
value set in UseVerticalBusi-
nessLinesFirst in 
contactus.config.js.

csspath File 
path

<drive>:\Program Files 
(x86)\Mitel\MiContact 
Center\WebSites\Ccmwa\Co
ntent\

Path to ContactUs.css. If left 
blank or excluded, the 
default ContactUs.css in 
<drive>:\Program Files 
(x86)\Mitel\MiContact 
Center\WebSites\Ccmwa\Co
ntent is used.

jspath Folder 
path

<drive>:\Program Files 
(x86)\Mitel\MiContact 
Center\WebSites\Ccmwa\Sc
ripts\

Path to folder containing 
contactus.config.js. If left 
blank or excluded, the 
default folder will be used.

config File 
path

contactus.config.js Path to the 
contactus.config.js file to be 
used with Contact Us.
If left blank, the default 
contactus.config.js file in the 
folder specified in jspath will 
be used.

Table 24.15:MiccContactUs.js parameters (Continued) (Sheet 2 of 2)

Parameter Name

Param
eter 
Value Default Value Parameter Description
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To configure Contact Us as a stand-alone webpage 
1. Open the webpage in which you want to render standalone Contact Us with an editor.
2. Add the following script reference to the Body: 

<script src="ccmwa/scripts/micccontactus.js"></script>
3. If you are using JavaScript and CSS files other than the defaults, update the script reference with 

parameters indicating the file locations. 

For information on MiccContactUs.js parameters, see the above table.
4. Save and close the text editor.

Adding Contact Us with the default slider
Contact Us can be added to your corporate webpages as a slider using MiCCSideSlider.js. By default, 
MiccSideSlider.js renders Contact Us as a slider on the right-hand side of your webpage, centered in the 
viewable area. The default MiccSideSlider can be added to your existing corporate webpage by adding 
the following script within the body of your webpage.
<script src="ccmwa/scripts/miccsideslider.js"></script>
By default, MiccSideSlider.js uses the default contactus.config.js located at <drive>:\Program Files 
(x86)\Mitel\MiContact Center\WebSites\Ccmwa\Scripts and the default ContactUs.css located at 
<drive>:\Program Files (x86)\Mitel\MiContact Center\WebSites\Ccmwa\Content.
To use different business lines’ contactus.config.js files or CSS files with MiccSideSlider, different param-
eters can be added to the script reference. The following is an example of a MiccSideSlider with all param-
eters applied to the script reference as guidance for formatting:
<script 
src="ccmwa/scripts/miccsideslider.js?embedded=false&target=contactslider&vmode=false&csspath=as
sets/css/&imgpath=images/&imgmod=_wt&jspath=assets/js/&config=contactus.config&promp-
tafter=30000"></script>
The following table describes the different parameters.
Table 24.16:MiCCSideSlider JavaScript options  (Sheet 1 of 3)

Parameter Name
Paramet
er Value

Default 
Value Parameter Description

embedded True or 
False

True Controls whether or not the slider 
will embed itself in the document in 
the default right-side, 
vertically-centered position.
If set to True, Contact Us will be 
embedded in the default location.
If set to False, Contact Us will be 
embedded in the location specified 
in the target parameter.
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target The ID 
attribute 
of the 
target

contactslider Sets the target in which Contact Us 
renders. By default, this value is 
contactslider.
If the target is not present or 
empty, the slider is created in the 
center of the viewable area.

vmode True or 
False

True Controls whether or not Contact 
Us renders in the standard display 
or the horizontal display.
If set to True, Contact Us renders 
in the standard display.
If set to False, Contact Us renders 
in the horizontal display.
NOTE: vmode overrides the setting 
of UseVerticalBusinessLinesFirst 
in contactus.config.js

csspath File path <drive>:\Prog
ram Files 
(x86)\Mitel\Mi
Contact 
Center\WebSi
tes\Ccmwa\C
ontent\

Path to ContactUs.css. If left blank 
or excluded, the default 
ContactUs.css in 
<drive>:\Program Files 
(x86)\Mitel\MiContact 
Center\WebSites\Ccmwa\Content 
is used.

imgpath Folder 
path

<drive>:\Prog
ram Files 
(x86)\Mitel\Mi
Contact 
Center\WebSi
tes\Ccmwa\C
ontent\image
s

Path to where slider button images 
are stored on your corporate web 
server.
If left blank or excluded, the default 
images on the Enterprise from 
<drive>:\Program Files 
(x86)\Mitel\MiContact 
Center\WebSites\Ccmwa\Content\
images\ will be used.
For more information on custom 
images, see "Adding custom 
images".

Table 24.16:MiCCSideSlider JavaScript options (Continued) (Sheet 2 of 3)

Parameter Name
Paramet
er Value

Default 
Value Parameter Description
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The following procedure assumes you have already added your business lines and queues to a copy of 
contactus.config.js, optionally updated the style in ContactUs.css, and placed your JavaScript and CSS 
files in the desired location.
To add the slider to an existing webpage 
1. Open the webpage you are adding the slider to in an HTML editor.
2. Add the following script reference in the body of the webpage: 

<script src="ccmwa/scripts/miccsideslider.js"></script>
3. If you are using JavaScript and CSS files other than the default, update the script references with 

parameters indicating the file locations. 

For information on MiccContactUs.js parameters, see the above table.
4. Save and close the HTML editor.

Adding custom images

imgmod suffix Blank Text to append to the end of the 
standard image name used for the 
slider in/out images so you can 
implement custom versions. 
Images must be .png files. For 
more information on custom 
images, see "Adding custom 
images".

jspath File path <drive>:\Prog
ram Files 
(x86)\Mitel\Mi
Contact 
Center\WebSi
tes\Ccmwa\S
cripts\

Path to folder containing 
contactus.config.js. If left blank or 
excluded, the default folder will be 
used.

config File path <drive>:\Prog
ram Files 
(x86)\Mitel\Mi
Contact 
Center\WebSi
tes\Ccmwa\S
cripts\contact
us.config.js

The file path to the 
contactus.config.js file to be used 
with Contact Us.
If left blank, the default 
contactus.config.js file in the folder 
specified in jspath will be used.

promptafter Number 
in 
millisecon
ds

0 The amount of time before the 
slider automatically slides out.
If set to 0 or omitted, the slider will 
not automatically slide out.

Table 24.16:MiCCSideSlider JavaScript options (Continued) (Sheet 3 of 3)

Parameter Name
Paramet
er Value

Default 
Value Parameter Description
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MiccSideSlider can use custom images, either through replacing the default images on the Enterprise 
Server or by using parameters on the JavaScript call to MiccSideSlider.js to instruct us different images. 
The following images can be customize with MiccSideSlider.js: 
• Contact_Us_Slider_Expand.png
• Contact_Us_Slider_Minimize.png

Custom images must have the same name as the original images or else have the same name with the 
imgmod suffix applied. Custom images must be stored in the same folder.

Obtaining Queue GUIDs

Each queue in your contact center has a unique identifier that Contact Us requires to connect the func-
tions of queue icons with the individual queues they represent.
To obtain a queue GUID 
1. In YourSite Explorer, click Multimedia > Queues.
2. Select a queue.

3. In the ribbon, click Queue Tools.

4. Click Copy queue ID. 

The queue GUID is copied to your clipboard.

Obtaining Subroutine GUIDs

Contact Us can now be configured with a WebCallback subroutine at the queue level. Obtain the GUID 
for the subroutine and update the associated configuration file for Contact Us. This identifier enables 
Contact Us to pass along the correct subroutine to be used to initiate a callback routing for the given 
queue.
To obtain web callback subroutine information from SQL 
1. Open SQL Server Management Studio or any other SQL management program.
2. Query the following select statement: 

select Pkey, Name from tblConfig_VWM_Subroutine.
3. Find the value of Pkey, to obtain the Subroutine GUID.

Troubleshooting Multimedia Contact Center web features

When troubleshooting Multimedia Contact Center web features, the following method is recommended 
for verifying if issues are with the Multimedia Contact Center deployment or with the deployment of SSL, 
reverse proxies, or firewalls.
To troubleshoot Multimedia Contact Center web features
1. Test Chat and/or Contact Us locally on the Enterprise Server with no reverse proxy, SSL, or firewall.
2. If your deployment uses SSL, add SSL and test Chat and/or Contact Us on the Enterprise Server with 

no reverse proxy or firewall.

3. Add your reverse proxy and test Chat and/or Contact Us externally.

4. Add your firewall and test Chat and/or Contact Us externally.
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Multimedia routing using visual workflows
Multimedia Contact Center enables routing using a visual workflow designer. Administrators can 
configure Inbound, Inqueue, and Response workflows by dragging and dropping activities onto a Work-
flow Canvas.
Workflows enable flexible routing of email, chat, SMS, and open media interactions to the queues and 
agents best suited to handle them. For examples of how Inbound, Inqueue, and Response workflows 
create the routing rules for email, chat, SMS, and open media interactions, see "Multimedia Contact 
Center default workflows". For information on configuring the activities that comprise workflows, see 
"Activity list".

Workflow types

The following workflow types are available in Multimedia Contact Center.
Inbound workflows – Determine the first paths interactions follow to reach destinations in an organiza-
tion. Inbound workflows can search the properties of incoming interactions and determine the destinations 
to which these interactions should be directed, for example a sales team or a support team. Inbound work-
flows also support other actions such as sending response messages, running executable scripts, and 
performing database queries.
Inqueue workflows – Determine the conditions for routing interactions in queue to agents. Examples 
include when to overflow interactions to different queues, when to requeue an interaction, when to inter-
flow interactions to different agent groups, and when to transfer interactions to available agents. Inqueue 
workflows are executed once interactions have been delivered from the Inbound workflow to their queue 
destinations.
Inqueue workflows support push, pick, and mixed routing models.
• In push models, the system offers interactions waiting in queue to available agents
• In pick models, agents select their interactions from queues
• In mixed models, agents select their interactions from queues, but interactions waiting in queue past 

a specified time are offered to available agents

Response workflows – Enable post-contact options and activities. Performed by queues after an inter-
action has been handled, Response workflows enable the automation of processes such as removing 
fields from the system or writing data to an external source, inserting information about the handled inter-
action into the database, or emailing a transcript from a chat session.

Workflow layouts in Multimedia Contact Center

Administrators can easily view and navigate workflows and workflow layouts in Multimedia Contact 
Center using the following features, as described in this section: 
• A customizable workspace
• The Outline pane
• The Search field
• Focusing and breadcrumbs
• The Overview window and Pan function
• The Zoom feature
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• The Expand All, Collapse All, and Restore buttons

The following takes place in Multimedia > Workflows.

Customizing the multimedia workspace

New workflows open as separate tabs in Multimedia Contact Center, freeing up visual space and show-
casing individual workflows on-screen. Administrators can open an existing workflow in a dedicated tab 
by double-clicking the workflow, by right-clicking the workflow and selecting 'Open', or by selecting the 
workflow and clicking 'Edit'. This maximizes the space devoted to viewing workflows.
Toolbar, Properties, and Outline panes can be minimized, expanded, or pinned to the workspace. This 
enables administrators to choose how much of the screen is comprised of the workflow versus configu-
ration panes. These enhancements enable administrators to customize their workspaces and manage 
screen space to better facilitate their work.

Viewing workflows at a glance: The Outline pane

The Outline pane displays workflows in a binary search tree format. Administrators can selectively view 
the workflow and the parent-child relationships of activities and conditions by expanding or minimizing 
individual items in the tree. By providing an overview of the workflow in a compact space, the Outline pane 
enables administrators to efficiently view complex workflows and the relationships between activities.
Administrators can configure activities or branches directly from the Outline pane by selecting the activity 
in the tree and clicking the Properties pane and by right-clicking the activity in the search tree. 
Right-clicking also highlights the activity in the workflow, providing a clear means of referencing a specific 
activity being configured. If, for example, the workflow has several similar activities, highlighting minimizes 
errors by helping administrators confirm they are configuring the correct activity.

Locating workflow items: The Search field

Administrators can locate specific activities and branches in workflows using the Outline pane’s Search 
field. The Search field returns results based on workflow items’ names and system names.
Searches can be performed based on complete or partial search terms. For example, searching ‘sched’ 
will return results for all workflow items containing ‘Schedule’ in the name or system name.
After locating an item in the Search field, administrators can edit the item either by right-clicking it or by 
toggling to the Properties pane.
To locate workflow items using the Search field
1. Click Multimedia > Workflows.
2. Select a workflow and click Outline.

3. In Search Outline, type the search term and click the Search icon.

Viewing specific portions of a workflow: Focusing and the Breadcrumb view

Administrators can devote the entire Canvas to viewing specific portions of a workflow by double-clicking 
activities or branches on the Canvas. This feature enables focusing on precise elements of complicated 
workflows and minimizes the need to use subroutines solely to conserve viewing space.
When focusing on an activity or branch, the Workflow Canvas opens in a Breadcrumb view. Breadcrumbs 
at the top of the Canvas indicate the portion of the workflow being viewed and the parent elements of 
those portions. After focusing on a specific portion of the workflow, the view of the workflow can be incre-
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mentally expanded by tracing back through parent relationships using breadcrumbs. Administrators can 
also right-click an activity and select ‘Go To Parent’. The Breadcrumb view provides an ordered way of 
redirecting focus in the workflow from precise elements to the bigger picture.
Note that when working in the Breadcrumb view, only the items in focus can be configured. In order to 
configure other items in the workflow, select the breadcrumb that brings the item into focus. (See the 
following figure.)

Figure 24.14: Focusing and the Breadcrumb view
 

Navigating the Workflow Canvas: The MiniMap window and the Pan mode

The MiniMap window and the Pan mode enable administrators to navigate to sections of a workflow 
without manipulating the horizontal and vertical scroll bars. The MiniMap window displays the workflow in 
a pop-out that can be used to navigate the Workflow Canvas.
To navigate the Workflow Canvas using the MiniMap window
1. Click Multimedia > Workflows, and select a workflow.
2. Click the MiniMap button, located to the right of the plus sign at the bottom of the window.

3. Click and drag the highlighted section over the workflow, as it appears in the MiniMap window.

4. To exit out of the MiniMap window, click the MiniMap button.

The Pan mode enables administrators to ‘grab’ the Workflow Canvas and, using the mouse, choose what 
portion of the workflow is centered on the Canvas without worrying about dragging activities around the 
workflow in the process.
To navigate the Workflow Canvas using the Pan mode
1. Click Multimedia > Workflows, and select a workflow.
2. Click the Toggle Pan Mode button, located to the left of the ‘100%’ at the bottom of the window.

The cursor displays as a hand icon.
3. Click anywhere on the Workflow Canvas to ‘grab’, and move the mouse to re-center the workflow.

4. To exit out of Pan, click the Toggle Pan Mode button.
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Resizing workflows: The Zoom feature

You can adjust how large or small a workflow appears in the Workflow Canvas by manipulating the slider 
bar at the bottom of the Canvas or by pressing the plus and minus signs alongside the bar. Using this 
feature, administrators can zoom in to focus on precise elements of the workflow or zoom out to get a 
bird’s eye view. Expressed as a percentage, the zoom feature also determines the expanse of the high-
lighted section of the Overview window. For more information, see "Navigating the Workflow Canvas: The 
MiniMap window and the Pan mode".

Manipulating all activities in a workflow: The Expand All, Collapse All, and Restore 
buttons

Administrators can expand or collapse every activity and its corresponding branches in a single operation 
by clicking the Expand All or Collapse All buttons. Clicking the Restore button returns the workflow to the 
condition it was in before the activities were expanded or collapsed, enabling administrators to resume 
their work efficiently.

Designing and managing workflows: Common procedures

Several procedures for designing and managing workflows are common across workflow types. For 
example, common procedures include creating workflows, naming workflows, deleting workflows, and 
importing and exporting workflows. See the following sections for common workflow procedures in Multi-
media Contact Center.
We recommend that administrators perform actions for designing workflows from the 
• Inbound Routing and Response Routing tabs on the Media servers page, for Inbound and Response 

workflows
• Routing tab on the Queues page, for Inqueue workflows

We recommend that administrators perform actions for managing workflows from the Workflows page, 
located by selecting Multimedia > Workflows.

Creating workflows in Multimedia Contact Center

We recommend administrators modify the default workflows that ship with Multimedia Contact Center. 
However, in some instances, administrators may be required to create new workflows.
NOTE: When creating Inbound email workflows, ensure they contain either a Transfer, a Junk Email, or a 
No Reply Email activity. If they do not, email contacts will remain in system storage, using system memory 
and causing performance issues.
To create a workflow in Multimedia Contact Center 
1. Click Multimedia > Workflows > Add.
2. Select the media and workflow type. 

For example, ‘Email > Inbound’.
3. In the Properties pane, provide a Name and a System Name for the workflow. The Name and 

System Name must be unique.

4. Click Save.
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Copying workflows

Administrators can reuse workflows as templates by copying and pasting them in Multimedia Contact 
Center. A copied workflow retains all activities and branching conditions of the original workflow, but is 
not assigned to a media server. Administrators can assign workflows to media servers and queues in the 
Workflows page. See "Associating workflows to queues" and "Associating workflows to media servers".
To copy a workflow
1. Click Multimedia > Workflows.
2. Right-click the workflow and select Copy.

3. Right-click anywhere in the workflow list and select Paste.

4. Click Save.

Deleting workflows

Deleting workflows removes the workflow and all its activity configurations from Multimedia Contact 
Center. Deleting live Inbound workflows stops interactions from routing to queues, and deleting live 
Inqueue workflows stops interactions from reaching agents.
To delete a workflow
1. Click Multimedia > Workflows.
2. Select the workflow and click Delete.

3. When prompted, click OK.

Importing and exporting workflows

Administrators can import workflows to Multimedia Contact Center from a machine or network. After 
importing a workflow, administrators must configure its activities with information specific to the contact 
center and assign the workflow to a media server.
Administrators can export workflows from Multimedia Contact Center to save on a machine or network. 
Exported and saved workflows can be imported. Administrators should assess any validation errors, to 
ensure the workflow is fully configured. See "Validating workflows" for more information.
To import a workflow
1. Click Multimedia > Workflows.
2. Click the Import button, browse to the workflow .xaml file, and click Open.

3. Click Save.

To export a workflow
1. Click Multimedia> Workflows.
2. Click the Export button, browse to the workflow .xaml file and select it.

3. Browse to the location to which the workflow will be saved and click Save.

Naming workflows

For administrative and reporting purposes, you must give workflows unique names and system names. 
A system name is used by Multimedia Contact Center to identify the workflow. A name labels the workflow 
for the user to see.
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To name a workflow associated to a media server
1. Click Multimedia > Media servers.
2. Select the Media server and select either Inbound Routing or Response Routing.

3. In the Properties pane, provide a Name and System Name for the workflow. The Name and System 
Name must be unique.

4. Click Save.

To name a workflow associated to a queue
1. Click Multimedia > Queues.
2. Select the queue and select Routing.

3. In the Properties pane, provide a Name and System Name for the workflow. The Name and System 
Name must be unique.

4. Click Save.

To name a workflow not associated to a media server or queue
1. Click Multimedia > Workflows and select the workflow.
2. Click Properties and type a Name for the workflow. The Name must be unique.

3. Type a System Name for the workflow. The System Name must be unique.

4. Click Save.

Validating workflows

Multimedia Contact Center validates workflows to ensure they do not contain programming or configura-
tion errors before going live. To execute a workflow, workflow validation must be enabled. Workflow vali-
dation is also required to successfully offer email, chat, SMS, and open media interactions to agents. By 
default, workflow validation is not enabled. This allows administrators to configure and save workflows in 
progress.
If validation is enabled, workflows with errors cannot be saved until the errors are corrected. If validation 
is not enabled, workflow with errors can be saved.
Red exclamation marks on activities indicate configuration errors to be corrected. Yellow exclamation 
marks on activities indicate warnings. Clicking the ‘Validation’ button opens a pane explaining the work-
flow’s errors and warnings.
The pane lists the number of errors and warnings, the activity to which the error or warning is associated, 
and what is required to fix the problem. Double-clicking the error and warning information in the Validation 
pane brings the specific activity into focus, for ease of identification. For more information on focusing, 
see "Viewing specific portions of a workflow: Focusing and the Breadcrumb view".
To validate a workflow
1. Select Multimedia > Workflows.
2. Select the workflow and, in the Properties pane, select the Validate workflow check box.

3. Click Save.
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Saving and copying workflows as images

Administrators can save workflows as images in JPG, PNG, GIF, and XPS formats. Workflow images can 
also be copied onto the clipboard, to be pasted into other programs. Saving or copying workflows enables 
administrators to easily reference, share, and print workflow designs.
To save workflows as images 
1. Right-click on the active portion of the Workflows Canvas and select Save as Image….
2. Select the desired image type for the workflow.

3. Navigate to the location to which the image will be saved, and click Save.

To copy workflows as images 
• Right-click on the active portion of the Workflows Canvas and select Copy as Image. 

The workflow can be pasted into another program.

Associating workflows to media servers

Inbound and Response workflows must be associated to a media server of an appropriate type in order 
to go live in the system.
We recommend building inbound and response workflows from the Inbound Routing and Response 
Routing tabs on the Media servers page. This automatically associates the workflow to the server. 
However, workflows built from the Workflows page can be associated to the server as follows.
NOTE: Workflows execute once validation is enabled and any programming and configuration errors are 
corrected. For more information, see "Validating workflows".
To associate a workflow to a media server
1. Click Multimedia > Workflows, and select the Inbound or Response workflow.
2. Click Media Server Membership.

3. Under Available members, select the media server and click >.

4. Click Save.

Associating workflows to queues

Inqueue workflows must be associated to at least one queue in order to go live in the system. We recom-
mend associating a single Inqueue workflow to a single queue. This avoids the potential confusion of 
having changes to an Inqueue workflow reflected in multiple queues. If you associate an Inqueue work-
flow to a queue that already has an Inqueue workflow associated to it, the newly associated Inqueue work-
flow replaces the existing Inqueue workflow.
We also recommend modifying an Inqueue workflow from the Routing tab of a selected queue. This auto-
matically associates the workflow to the queue. Workflows built from the Workflows page can be associ-
ated to queues as follows.
NOTE: Workflows execute once validation is enabled and any programming and configuration errors are 
corrected. For more information, see "Validating workflows".
To associate a workflow to one or more queues
1. Select Multimedia > Workflows, and select the Inqueue workflow.
2. Click Queue Membership.

3. Under Available members, select the queues to which the workflow is associated and click >.
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To associate all queues to the workflow, click '>>'.
4. Click Save.

Building subroutines

Subroutines represent a sequence of routing conditions in a workflow. Using subroutines, administrators 
can efficiently apply a set of activities multiple times within a single workflow and across workflows of the 
same media and workflow type. For example, an administrator can implement an Email Inqueue subrou-
tine in multiple Email Inqueue workflows.
To build subroutines, administrators drag and drop activities on a Canvas and configure them with routing 
conditions. Activity availability varies by media type. For more information on activities in multimedia 
routing, see "Building visual workflows in Multimedia Contact Center: Activities".
The following procedures explain how to
• Implement subroutines in workflows
• Edit and delete subroutines
• Import and export subroutines

NOTE: Variables in Response workflows/subroutines are based on the agent’s reply, not the customer’s 
original interaction. For example, in Inbound and Inqueue workflows/subroutines the <<From>> variable 
populates with the customer’s sending address. The <<To>> variable populates with the queue’s 
address.

Implementing subroutines in workflows

Subroutines are implemented in workflows via Subroutine activities. Administrators can implement a 
single subroutine at multiple points in a workflow and across multiple workflows. However, subroutines 
must be of the same workflow and media type. For example, an administrator can only implement an 
Inbound Email subroutine in an Inbound Email workflow.
Administrators must first add a Subroutine activity to a workflow. A subroutine of the appropriate media 
type can then be assigned to the activity. When the workflow reaches the Subroutine activity, the subrou-
tine executes. For more information, see "Executing subroutines with the Subroutine activity".

Editing and deleting subroutines

Administrators should note the following:
• Edits to subroutines implemented in workflows are applied to each subroutine instance in each work-

flow.
• Subroutines implemented in workflows cannot be deleted. To delete subroutines, administrators must 

first remove the subroutine from all workflows using it.

To edit a subroutine
1. Click Multimedia > Subroutines.
2. Select the subroutine, and click Edit.

3. Make any changes to the subroutine and click Save.
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To delete a subroutine
1. Click Multimedia > Subroutines.
2. Select the subroutine, and click Delete.

3. When prompted, click OK.

Importing and exporting subroutines

Administrators can import subroutines to Multimedia Contact Center from a machine or network. After 
importing a subroutine, administrators must configure its activities with information specific to the contact 
center. Imported subroutines display on the Multimedia tab’s Subroutines page.
Administrators can export subroutines from Multimedia Contact Center to save on a machine or network. 
Exported and saved subroutines can be imported.
To import a subroutine
1. Click Multimedia > Subroutines.
2. Click the Import button, browse to the subroutine .xaml file, and click Open.

3. Click Save.

To export a subroutine
1. Click Multimedia > Subroutines.
2. Click the Export button, browse to the subroutine .xaml file and select it.

3. Browse to the location to which the subroutine will be saved and click Save.

Viewing subroutines by type

Administrators can view subroutines selectively by type, by applying filters to the Subroutines page. For 
more information, see "Viewing devices by category or type".

Configuring data providers

You can create a connection to a data provider located on a local or an external server to access infor-
mation about incoming callers. For example, the data providers query can be configured to retrieve 
customer information based on variables.
Multimedia Contact Center can add the following as data providers to query for data: 
• Microsoft Excel worksheets
• Microsoft SQL servers
• Lightweight Directory Access Protocol (LDAP)

Multimedia Contact Center also supports the following platforms as generic data providers to query for 
data: 
• SAP
• Salesforce
• Microsoft Dynamics CRM
• Sugar CRM
• NetSuite
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Multimedia Contact Center can also import ODBC connections configured using the Windows ODBC 
Data Source Administrator. Multimedia Contact Center supports the following reference platforms for 
ODBC connections: 
• IBM DB2
• Oracle Database
• MySQL
• Microsoft Access
• PostgreSQL

Adding a Microsoft Excel worksheet as a data provider

Administrators can add Microsoft Excel worksheets as data providers the system can query.
To add a Microsoft Excel worksheet as a data provider 
1. In the left pane, click Multimedia > Data providers.
2. Click Add and select Excel from the drop-down list. 

A new data provider is added to the data provider list.
3. After Name, type a name for the data provider.

4. Click Select File and browse to the Excel worksheet you want to use as a data provider. 

NOTE: The Excel worksheet must be shared as a workbook and located on a UNC (Universal 
Naming Convention) path, also known as a shared network path. The syntax for a UNC path 
is \\ComputerName\SharedFolder\Resource. Locating the worksheet on a UNC enables Multimedia 
Contact Center to access the data provider remotely.

5. Click Open.

6. Click Test Connection.

7. Click Save.

Adding a Microsoft SQL Server as a data provider

Administrators can add Microsoft SQL Servers as data providers the system can query.
To add a Microsoft SQL Server as a data provider
1. In the left pane, click Multimedia > Data providers.
2. Click Add and select Microsoft SQL Server from the drop-down list.

3. After Name, type a name for the data provider.

4. After Server Name, enter the server name.

5. Under Log on credentials, select Windows Authentication or SQL Server Authentication.

6. If you select SQL Server Authentication, enter a Username and Password.

7. Click Test Connection.

8. After Database Name, select a database name from the drop-down list.

9. Click Save.
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Adding a LDAP as a data provider

Administrators can add LDAP as a data provider the system can query.
To add a LDAP as a data provider
1. In the left pane, click Multimedia > Data providers.
2. Click Add and select LDAP from the drop-down list.

A new data provider is added to the data provider list.
3. After Name, type a name for the data provider.

4. After Domain, type the domain of the LDAP.

5. After Username, enter the username for the LDAP.

6. After Password, enter the password for the LDAP.

7. Click Test Connection.

8. On the ribbon, click Save.

Adding a generic data provider

Salesforce, Microsoft Dynamics CRM, SAP, Sugar CRM, and NetSuite can be added as generic data 
providers in YourSite Explorer. Generic data providers have certain limitations on the SQL language for 
queries. Consult the following KB articles for the SQL language supported for these data providers: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1013095/loc/en_US.
To add a generic data provider 
1. Click Multimedia > Data providers.
2. Click Add and select Generic from the drop-down list.

3. Type a Name for the data provider.

4. After Type, select a data provider.

5. Type the User Name of the data provider.

6. Type the Password for the data provider

7. After Other Settings, enter the data provider-specific information. 

– SAP: Enter the client number, the system number, and the connection type, separating the values 
by semi-colons. For example: 250;25;SOAP

– Salesforce: Enter your Salesforce security token. 
Contact your Salesforce administrator to obtain the Salesforce security token.

– Dynamics CRM: Enter the CRM version. For example, CRM Online Office 365.
– Sugar CRM: Enter your Sugar CRM credentials.
– NetSuite: Enter your NetSuite credentials.

8. Enter the connection’s Url.

9. To test the connection, click Test Connection.

10. Click Save

https://mitel.custhelp.com/app/answers/answer_view/a_id/1013095/loc/en_US


873

MULTIMEDIA ROUTING USING VISUAL WORKFLOWS
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Adding an ODBC as a data provider

ODBC connections can be added as a data provider through the Windows ODBC Data Source Adminis-
trator. After adding an ODBC using ODBC Data Source Administrator, the ODBC will automatically 
appear in data source providers and will be made available for the Query activity.
You cannot edit an ODBC data provider in Multimedia Contact Center.
NOTE: When adding an ODBC connection for Multimedia Contact Center, you must use the 32-bit 
Windows Server tool. For more information, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1001249/loc/en_US.

Deleting data providers

NOTE: Multimedia Contact Center is unable to delete ODBC data providers from the data providers list.
To delete a data provider
1. Select the data providers you want to delete from the data providers list.
2. Click Delete.

3. When prompted, click OK.

Working with variables in Multimedia Contact Center

Variables populate subroutines and incoming workflows with data related to inbound interactions. Admin-
istrators can use variables to flag incoming interactions, store information for later use, collect customer 
data, perform database queries, and build simple or complex conditions to route interactions.
Multimedia Contact Center ships with System variables relevant to all media types and variables specific 
to media types. To view these variables and see a description of each, open YourSite Explorer and go to 
Multimedia > Variables.
Administrators can
• Create custom variables
• Edit and delete variables
• View variables by category

NOTE: Variables in Response workflows/subroutines are based on the agent’s reply, not the customer’s 
original interaction. For example, in Inbound and Inqueue workflows/subroutines the <<From>> variable 
populates with the customer’s sending address. The <<To>> variable populates with the queue’s 
address.

Creating Custom Variables

Administrators can create new, customized variables for use in workflows and subroutines.
To create a custom variable
1. Click Multimedia > Variables > Add.
2. Type a Name for the variable.

NOTE: 
– Variable names must be unique and cannot contain spaces.
– A variable's name cannot be changed after you save.

https://mitel.custhelp.com/app/answers/answer_view/a_id/1001249/loc/en_US
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3. Type a Description explaining the variable’s function.

4. Select a Variable Type from the drop-down list.

NOTE: The Variable Type cannot be changed once saved.
5. If Mask Type is available to this type of variable, select the variable’s mask from the dropdown list.

– NoMask– The variable will not be masked within Multimedia Contact Center and associated screen 
pops, databases, etc.

– FullMask– The entire variable will be masked within Multimedia Contact Center and associated 
screen pops, databases, etc.

– MaskAllExceptLastX– The variable will be masked except for the specified number of final charac-
ters

– MaskAllExceptFirstX– The variable will be masked except for the specified number of first charac-
ters.

6. If you selected MaskAllExceptLastX or MaskAllExceptFirstX, specify the number of characters to 
be left unmasked.

7. To enable this variable to display in a toaster notification or screen pop select the Send to agent 
desktop check box.

8. To enable this variable to display in a web Ignite toaster notification select the Show on agent toaster 
check box.

NOTE: The Show on agent toaster check box is disabled if the Send to agent desktop check box is not 
selected.
9. After Display Name, type the name this variable has when it appears in a toaster notification or screen 

pop.

10. If you selected Dollars, Euros, or Pounds as the variable type, after Currency Format, select the 
format from the drop-down list.

11. If you selected Date Time as the variable type, after Date Format, select the date format from the 
drop-down list. After Time Format, select the time format from the drop-down list.

12. Click Save.

Editing and deleting variables

Administrators should note the following limitations:
• ‘Variable Type’ cannot be edited for previously saved variables.
• System variables cannot be deleted.

To edit a variable
1. Click Multimedia > Variables.
2. Select the variable, and click Edit.

3. Edit the variable and click Save.

To delete a variable
1. Click Multimedia > Variables.
2. Select the variable, and click Delete.
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3. When prompted, click OK.

Viewing variables by category

Administrators can view variables selectively by category, including System, Custom, and media type, by 
applying filters to the Variables page. For more information, see "Viewing devices by category or type".

Building visual workflows in Multimedia Contact Center: Activities

Multimedia Contact Center’s activities are used to build workflows and configure routing conditions for 
interactions. For example, activities can send automatic responses to incoming interactions, transfer 
interactions to queues, and offer interactions to the agents best suited to answer them. The following 
sections describe the activities in Multimedia Contact Center and how to configure them.
Note that activity availability varies by media and workflow type. For example, administrators can use the 
Ask activity in a Chat workflow but not in an Email workflow. The Offer to Agent Group activity can be used 
in an Inqueue workflow but not in an Inbound workflow.
Multimedia Contact Center ships with default workflows. We recommend administrators create workflows 
by duplicating and modifying reconfiguring, adding, and deleting activities in the default workflows to suit 
the contact center’s needs. For more information, see "Multimedia Contact Center default workflows".

Common configuration procedures

This section explains configuration procedures common to activities, branches, and branching conditions.
NOTE: Branches route interactions to different portions of a workflow. Branching conditions represent the 
circumstances an interaction must match to follow a particular branch.
Common activity options include
• Adding and removing expressions
• Selecting expressions
• Grouping expressions
• Adding activities to workflows
• Cutting, copying, and pasting activities and branches
• Deleting activities and branches from workflows
• Naming activities and branches
• Editing branching conditions
• Changing the order in which branches are evaluated
• Reporting on branches and branching conditions
• Annotating activities and branches

Building conditions

Many features in Multimedia Contact Center require users to configure conditions. These include:
• Schedule conditions
• Queue conditions
• Variable compare conditions
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While the individual types of expressions that can be added to conditions and their configuration may vary 
between the conditions being built, Multimedia Contact Center’s interface for adding, deleting, and 
grouping expressions remains consistent throughout Multimedia Contact Center.

Adding and removing expressions

To add an expression
• Click the Add button.

An expression is added to the condition.
NOTE: When an expression is added, it is highlighted in red if it requires additional configuration.

The expression will remain highlighted in red until completely configured.

To remove an expression
• Select the expression you want to delete and click the Delete button.

The expression is removed from the condition.

Selecting expressions

The following explains how to select expressions when building conditions.
To select an expression
1. Click the expression's drop-down menu button.
2. Choose Select/Deselect Row.

Alternatively,
• Click the expression's selector column on the left side of the expression's row.

Understanding operators

Multimedia Contact Center offers a number of different operators to use when building conditions. The 
following table outlines the operators available with Multimedia Contact Center.
Table 24.17:Operators

Operator Use

!= With this operator the expression will only look for value that do not match 
the exact value entered. This operator is case-sensitive.

= With this operator the expression will looks only for the exact value entered 
in the expression. This operator is case-sensitive. If this operator is being 
used in a comparison, then the expression will look for an exact string match 
between the two items being compared.

Contains With this operator, the expression matches values that contain the entered 
string. It is not case-sensitive.

Length With this operator the expression will look for a value with the specified 
number of characters.

Starts With With this operator, the expression will look for any value that starts with the 
entered value.
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Grouping expressions

Multimedia Contact Center enables users to group expressions, facilitating construction of detailed and 
specific conditions. While grouping is associated with a number of different activities, configurations, and 
dialogs, the grouping clauses are consistent throughout Multimedia Contact Center. Expressions within 
a group may also be grouped together to create nested levels of sub-groups within a single group.
NOTE: We recommend you do not exceed eight levels of grouping within a group of expressions even 
though Multimedia Contact Center is capable of handling greater than eight levels of grouping.
Expressions may be grouped by one of two clauses: 
• AND: Expressions grouped by the AND clause require that all the expressions in a group be met to 

successfully meet the condition. 
NOTE: If no grouping is selected, the AND clause is applied by default.

• OR: Expressions grouped by the OR clause require that only one of the expressions in a group be met 
to successfully meet the condition.

To group expressions 
1. Press the CTRL or Shift key and select the expressions you want to group. Clicking 'CTRL' enables 

you to select items one at a time and omit items from selection. Clicking 'Shift' selects a span of items.
2. Click either the Group AND or Group OR buttons. 

NOTE: You can change the grouping clause by selecting the drop-down beside 'And' or 'Or', and 
changing your selection.

To ungroup grouped expressions 
1. Click the group’s drop-down menu button.
2. Select Ungroup.

To add a new expression to a group 
1. Click the group’s drop-down menu button.
2. Select Add. 

NOTE: If you cannot add an expression to an existing group, ungroup the expression and then 
regroup it with the expression you want to add.

To remove a single expression from a group 
1. Click the expression’s drop-down menu button.
2. Select Ungroup.

Adding activities to workflows

Administrators add activities to workflows by dragging and dropping activities onto the Workflows Canvas. 
Activity availability varies by media and workflow type. We recommend administrators add activities to 
Inbound and Response workflows via the Inbound Routing and Response Routing tabs on the Media 
servers page. We recommend administrators add activities to Inqueue workflows via the Routing tab on 
the Queues page.
NOTE: Administrators can also access workflows by selecting Multimedia > Workflows.
The following explains how to add activities to Inbound, Response, and Inqueue workflows
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To add an activity to an Inbound or Response workflow
1. Click Multimedia > Media servers and select the media server associated to the workflow.
2. Drag the activity from the Toolbox to the Workflows Canvas.

3. Configure the activity and validate any configuration errors. For more information, consult the config-
uration procedures for specific activities in this guide. See also "Validating workflows".

4. Click Save.

To add an activity to an Inqueue workflow
1. Click Multimedia > Queues and select the queue associated to the workflow.
2. Drag the activity from the Toolbox to the Workflows Canvas.

3. Configure the activity and validate any configuration errors. For more information, consult the config-
uration procedures for specific activities in this guide. See also "Validating workflows".

4. Click Save.

Cutting, copying, and pasting activities and branches

Administrators can cut, paste, and copy activities within and between workflows. Administrators can also 
copy or cut a branch from one activity and paste it into other activities within and between workflows. This 
functionality enables administrators to create and edit workflows efficiently by duplicating preconfigured 
activities and their branches.
NOTE: Some activities are specific to media and workflow types. For example, a Say activity is used in 
Chat workflows but not Email workflows. The Offer to Agent group activity is used in Inqueue workflows 
but not Inbound workflows. Only cut and paste activities and branches into the appropriate media, work-
flow, and activity types.
To cut an activity or branch from a workflow
• Right-click the activity or branch and select Cut.
To paste an activity inside a workflow
1. Right-click the activity and select either Copy or Cut.
2. Right-click the activity that will precede the pasted activity, and select Paste.

To paste a branch inside an activity
1. Right-click the branch and select either Copy or Cut.
2. Right click a different branch inside the activity and select Paste.

The copied branch is inserted to the right.

Deleting activities or branches from workflows

The following explains how to remove activities or branches from workflows by deleting them.
To delete an activity or branch
1. Right-click the activity or branch and select Delete.
2. When prompted, click OK.

Naming activities and branches

For administrative and reporting purposes, give activities and branches unique names and system 
names. A system name is used by Multimedia Contact Center to identify the item and within reporting to 
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identify branches and branching conditions. A name labels an activity, branch, or branching condition for 
the user to see.
To name an activity, branch, or branching condition
1. Select the activity, activity configuration, or branch.
2. In the activity, configuration, or branch header, type a Name.

3. With the item still selected, in the Properties pane, type a System Name. The System Name must 
be unique.

NOTE: If a system name is not provided, activities and branches are given sequential system names 
by default. For example, TerminateActivity1, TerminateActivity2.

4. Click Save.

Editing branching conditions

Editing branching conditions changes what is required for an interaction to follow the branch.
To edit a branching condition
1. Expand the activity, right-click the branch, and select Edit.
2. Select the value to edit and perform one of the following actions

– Change the condition and value by typing or using the drop-down lists.
– Add a new condition by clicking Add and typing the desired values.
– Delete a condition by selecting the condition and clicking Delete.

3. Click OK.

4. Click Save.

Changing the order in which branches are evaluated

Administrators change the order in which they system evaluates branches by places the branches in 
sequence. The highest priority branch should be in the left-most position, as Multimedia Contact Center 
evaluates branches in the order of left to right.
To change the order in which branches are evaluated
1. Expand the relevant activity.
2. Drag and drop the branches into the desired position.

3. Click Save.

Reporting on branches and branching conditions

Reporting on branches and branching conditions enables supervisors to analyze workflow traffic and 
determine how interactions are moving through workflows.
You must select ‘Child Reporting Enabled’ for any branches and conditions on which you want to run 
Workflow Condition reports. For more information on Workflow reports, see the reports guide appropriate 
to your MiContact Center Business licensing level.
Note that system names are used to report on branches and branching conditions. For this reason, we 
recommend naming branches and branching conditions with unique and easily identifiable system 
names. For more information on naming, see "Naming activities and branches".
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To configure an activity or branch for reporting 
1. Select the branch or branching condition and, in the Properties pane, select the Reportable or the 

Child Reporting Enabled check box. 
NOTE: Selecting 'Child Reporting Enabled' on parent activities selects all child activities.

2. Click Save.

Annotating activities and branches

Administrators can tag activities and branches with notes using the annotation field. Similar to a sticky 
note, annotations enable administrators to mark an activity with descriptive information. For example, 
administrators can annotate a Timeout branch to indicate, at a glance, how long before the system times 
out and where interactions are directed in the workflow once a timeout occurs.
For an example of annotating activities, see the default workflows included with Multimedia Contact 
Center.
To annotate an activity 
1. Click the Notepad icon on the activity.
2. Type the annotation in the field provided.

3. Click Save.

To delete an entire annotation 
• Right-click the activity and select Annotations… > Delete.
To display or hide an individual annotation 
• Click the Notepad icon on the activity. This closes an open annotation and opens a closed annotation.
To expand all annotations in a workflow 
• Right-click an activity and select Annotations… > Show All.
To hide all annotations in a workflow 
• Right-click an activity and select Annotations > Hide All.

Activity list

This section describes Multimedia Contact Center activities.
NOTE: Red exclamation marks on activities indicate configuration errors to be corrected. Yellow exclama-
tion marks on activities indicate warnings. Clicking the ‘Validation’ button opens a pane explaining the 
workflow’s Errors and Warnings.

Asking questions with the Ask activity

The Ask activity enables a workflow to automatically ask questions of contacts and route them based on 
their responses. The Ask activity is configured with a single question that will be asked by the media 
server or queue auto response username in a chat session or the media server name or queue phone 
number in an SMS session. Depending upon their response, the contact is routed down the configured 
response branches. For example, if you wanted to route a contact in an Inbound chat workflow depending 
upon what product they were interested in, the question might be set to “Welcome to the Sales queue. If 
you are interested in Product X, type Product X. If you are interested in Product Y, type Product Y.” 
Depending upon the answer, the contact could be routed down the Product X branch or down the Product 
Y branch.
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The Ask activity can also be used to collect information from contacts. Contact responses are stored in 
the <<LastDataCollected>> variable. Using a Set Variable activity, this information can be set into other 
variables for use elsewhere or saved to a database with a Query activity. For more information on Set 
Variable activities, see "Populating variables with the Set Variables activity". For more information on 
Query activities, see "Querying data providers with the Query activity".
URLs entered into the Message field are turned into hyperlinks. Some website content can be embedded 
into chat sessions using the Ask activity. If a link to a supported website’s content, such as a link to a 
YouTube video, is entered into the Message field, the content is embedded directly into the chat session. 
The following websites are supported for embedded content in chat: 
• "https://twitter.com/"
• "https://soundcloud.com/"
• "http://www.youtube.com/"

NOTE: 
• Ignite supports embedding content from Google Maps in chat sessions. However, this requires the use 

of embed maps URL, available from Google Maps, to embed a Google map, such as: <iframe 
src="https://www.google.com/maps/embed?pb=!1m18!1m12!1m3!1d2804.500978803945!2
d-
75.90911198444678!3d45.3386984790996!2m3!1f0!2f0!3f0!3m2!1i1024!2i768!4f13.1!3m3!1m2!1s0
x4cd1fff1517da8a9%3A0xe6bc8a721e90f2a5!2sMitel+Net-
works!5e0!3m2!1sen!2sus!4v1445531227487" width="600" height="450" frameborder="0" 
style="border:0" allowfullscreen&gt;&lt;/iframe>

• SMS does not support embedded content.
• Ignite supports embedding Twitter content in chat sessions, however this is only possible when you 

use the Copy link to Tweet in the More menu option available from the Twitter site. The Embed 
Tweet menu option will not work in the chat window.

To configure the Ask activity, you must 
• Configure the question to be asked
• Configure the accepted responses from the contact

The Ask activity is available to Chat and SMS Inbound and Inqueue workflows.
Configuring the question to be asked
The Ask activity poses questions to contacts from the automatic response username for the media server 
or the queue. It is recommended that the question be clearly worded and that if it requires specific 
responses, that these be listed.
By default, the user can respond incorrectly three times before they are routed down the Failure branch. 
The Invalid branch informs them that their response was invalid using a Say activity. By default, the user 
has 30 seconds to respond before they are routed down the Timeout branch and informed, using a Say 
activity, that they timed out and to try again. By default, users can timeout three times before being routed 
down the failure branch. For information on configuring the Say activity, see "Responding to interactions 
with the Say activity".
The following procedures explain how to 
• Configure the question being asked
• Set how many times the contact can respond incorrectly
• Set how long the user has to respond to the question
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To configure the question to be asked 
1. Select the Ask activity and click Properties.
2. After Question, click ....

3. Type the question and click OK. 

In a chat session, the question will be asked using the chat media server’s auto response username 
or the chat queue’s username. In an SMS session, the question will be asked using the SMS media 
server's name or the SMS queue's phone number.

4. Click Save.

To set how many times the contact can respond incorrectly 
1. Select the Ask activity and click Properties.
2. Set the number of Invalid Attempts allowed.

3. Click Save.

To set how long the user has to respond to the question 
1. Select the Ask activity and click Properties.
2. Set the Timeout (sec) duration, in seconds.

3. Set the number of Timeout Attempts that can occur.

4. Click Save.

Creating response branching conditions
After configuring the question, you must configure the accepted responses the contact may enter to be 
used as branching conditions. Responses can be a set value or the can be a variable. When using a vari-
able as a response, the Ask activity compares the <<LastDataCollected>> variable to the selected vari-
able as if it were a Variable Compare activity. For more information on the Variables Compare activity, 
see "Routing interactions with the Variable Compare activity". An answer branch may have multiple condi-
tions applied to it. All conditions configured together in a single branch have the ‘Boolean And’ applied to 
them.
The following procedures explain how to 
• Route contacts by their answer
• Edit a response branching condition
• Delete a response branching condition

To route contacts by an answer 
1. Right-click on an Ask activity and click Add Branch.
2. Enter the Name of the branch.

3. Click Add.

4. In the second column select one of the following operators from the drop-down list: 

– != Not Equal
– = Equal 

NOTE: This operator is case-sensitive. If this operator is being used in a comparison, then the 
expression will look for an exact string match between the two items being compared.

– Contains
– Length
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– Starts With

5.   

6. In the third column, set the Value for the answer or select a Variable.

7. Repeat steps 2-4 for each additional answer value you want to route down this branch.

8. To enable reporting for this branch, select Enable reporting.

9. If you want to add another branch, click Add at the bottom of the window.

10. Click OK.

11. Click Save.

To edit a response branching condition 
• Right-click on a branching condition and click Edit.
To delete a response branching condition 
• Right-click on a branching condition and click Delete.

Suspending workflows with the Delay activity

The Delay activity suspends a workflow for a predetermined time. For example, an administrator uses a 
Delay activity to suspend a workflow, enabling a third-party application to process a command before the 
workflow continues to an activity requiring that the processing be complete.
The Delay activity is available to all Multimedia Contact Center workflows.
Setting the duration of Delay activities
Setting the duration of Delay activities specifies how long Multimedia Contact Center suspends a work-
flow.
To specify how long Multimedia Contact Center suspends a workflow 
1. Select the Delay activity and click Properties.
2. Set the Duration of the Delay activity, in seconds.

3. Click Save.

Sending emails with the Email activity

The Email activity sends emails from within a workflow, with or without attachments, to recipients via an 
SMTP server connection configured in YourSite Explorer. For example, an administrator can use the 
Email activity to send auto-acknowledgement messages to inbound emails.
Email activity templates support HTML and text-based content. Template fields can be populated with 
variables, and attachments can be populated with variables or files.
You can set email properties to avoid sending multiple auto- response emails when an incoming email is 
requeued or transferred.
The Email activity is available to all Multimedia Contact Center workflows.
Adding and editing SMTP server information to the Email activity
The following explains how to add and edit the connection between Multimedia Contact Center and the 
email account on the SMTP server sending emails.
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To add an SMTP server to an Email activity 
1. Right-click the Email activity and select Edit SMTP Server.
2. Select a SMTP server and click OK.

3. Click Save.

To edit SMTP server information using the Email activity 
1. Right-click the Email activity and select Edit SMTP Server.
2. Select the SMTP server and click Edit.

3. Follow the appropriate steps under "Configuring SMTP connections to Multimedia Contact Center".

Populating Email activity templates
The following explains how to populate email templates.
NOTE: To see a list of Email variables and their descriptions, go to Multimedia > Variables.
To populate an Email template NOTE: Email content inserted via the <<Body>> variable in the Email 
activity is limited to 2MB. After 2 MB, content inserted via the <<Body>> variable is truncated. 
1. Right-click the Email activity and select Edit Email Template.
2. Configure all email fields as applicable. 

NOTE: In the To:, Cc:, and Bcc: fields, separate multiple addresses with semi-colons.
3. In the body of the email, type the template’s text.

4. To populate fields with variables, right-click the field and select the variable from the drop-down list. 

NOTE: When an email with multiple recipients arrives at an Email activity, if the <<To>> variable is 
used in the From field, no email response will be sent by the Email activity.

5. To indicate the importance of the email message, after Priority: select a level from the drop-down list. 

NOTE: This option sets a visual indicator of the message’s importance in supporting email clients 
only.

6. Click OK.

7. Click Save.

To add attachments 
1. Right-click the Email activity and select Edit Email Template.
2. After Attachments, click the Browse button.

3. To add a variable, click Attachments and select the variable.

4. Click Add.

5. To add additional variables, repeat steps 3-4.

6. To add a file, click Browse.

7. Navigate to the file and click Open.

8. To add additional files, repeat steps 6-7.

9. To change the order of the attachments, select the attachment and click Up or Down.

10. To remove an attachment, select the attachment and click Remove.
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11. Click OK.

12. Click OK.

13. Click Save.

Configuring email send settings
By default, every time a contact reaches an Email activity in a workflow, an email is sent. Email activities 
can be configured to only send an email once per contact, so that if that contact reaches the same Email 
activity again, as a result of a requeue or transfer, the Email activity will not send a second email. New 
contacts from the same source will still trigger the Email activity to send an email.
To configure auto-response email settings 
1. Select the Email activity and click Properties.
2. Select the Only Send Once check box to avoid sending more than one email to the same contact with 

this activity.

3. Click Save.

Ending chat and SMS sessions with the End Session activity

The End Session activity ends an active chat or SMS session without terminating the workflow. For the 
contact, the interaction ends, but the workflow may continue to post-interaction activities. A Terminate 
Workflow activity is required to terminate a workflow after the End Session activity.
For example, an administrator uses the End Session activity in an Inqueue chat workflow that only has 
automated responses from Ask and Say activities to end the interaction’s chat session with the queue 
while enabling the workflow to continue to a Query activity that writes a transcript of the interaction's back 
to SQL.
The End Session activity requires no configuration. Administrators can optionally provide the activity with 
a name and system name. See "Naming activities and branches" for more information.
The End Session is available in all Chat and SMS Inbound and Inqueue workflows.

Running external processes with the Execute activity

The Execute activity enables Multimedia Contact Center to interact with external systems by running the 
following four processes: 
• Executable/Script – Runs an *.EXE file or *.BAT script on the server and delivers return values or 

parameters if the script executes successfully. 
NOTE: The Execute activity requires *.EXE files and *BAT scripts to be on a UNC path.

• PowerShell – Runs a PowerShell script on the server and delivers return values or parameters if the 
script executes successfully. 

NOTE: 
– The Execute activity requires PowerShell scripts to be on a UNC path.
– The Execution Policy for PowerShell scripts must be set in the command prompt window of Power-

Shell to Set-ExecutionPolicy RemoteSigned.

• Web Service – Enables the Execute activity to retrieve an XML response from an external web service 
using SOAP or REST and delivers return values if the script executes successfully. 
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NOTE: The data being returned must be valid XML characters. Any invalid characters (such as &, <, 
or >) will not return successfully and the workflow will route down the Failure branch. The XMLNode 
object type is not supported.

• CRM Service – Sends user defined queries to a Microsoft CRM 2011, Microsoft CRM 2013, or Micro-
soft CRM Online system and delivers return values if the script executes successfully.

For example, an administrator uses the Execute activity to retrieve customer information from a Web 
Service database. This information is stored in a custom variable for use within the workflow or to pass 
on to agents in a screen pop for enhanced customer service.
For an example of a workflow that uses the Execute activity to execute PowerShell and perform a web 
service SOAP call to a publicly accessible web service, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000724/loc/en_US. Although the workflow is 
for IVR Routing, the configuration of the Execute activity is the same for Multimedia Contact Center work-
flows.
The Execute activity is available to all Multimedia Contact Center workflows.
NOTE: A success return value indicates the process executed without errors, and the Success branch is 
followed. A failure return value indicates the process exited with errors and did not complete as expected, 
and the Failure branch is followed.
Specifying the external processes to execute in workflows
The following procedures explain how to instruct the Execute activity to run 
• Executable/Script processes
• PowerShell processes
• Web Service processes
• CRM Service processes

To set an Executable/Script or PowerShell process 
1. Right-click the Execute activity and select New Process > Executable/Script or PowerShell script.
2. For Executable/Script processes, after Path, click the Browse button and navigate to the *.EXE or 

*BAT script. The script must be on a UNC path.

3. For Executable/Script processes, select the Separator required by the .exe file. The separator is the 
character separating the parameters in the process’ command line statement.

4. For PowerShell processes, navigate to the PowerShell script.

5. To add a set of Input Parameters, click Add and select the Parameter the process uses to execute. 

NOTE: If batch files or Executable/Script processes require delimiters, they must be entered manu-
ally in the Parameter column.

6. Under Value, select a variable or type a static value. 

NOTE: 
– The variable is replaced when a contact progresses through the workflow.
– To configure the process to use a value not linked to a parameter, select a variable from the Value 

field and leave the Parameter field blank.

7. Repeat steps 5 and 6 for each set of input parameters the process uses. To delete a set of parame-
ters, click the arrow to the left of Parameter and click Remove.

8. Under Test Value, enter values to test the process and click Execute. 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000724/loc/en_US
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NOTE: 
– For Executable/Script processes, the Results dialog box lists return values and output pipeline 

values.
– For PowerShell processes, the Results dialog box lists return values and PSObject[X] values.

9. Click OK to auto-populate the Output Mappings pane with Output values.

10. Leave the Process Setup window open and complete the steps under "Storing retrieved data as vari-
ables".

To set a SOAP Web Service process 
1. Right-click the Execute activity and select New Process > Web Service.
2. Type the Web Service URI and, for the Web Service Type, select SOAP.

3. If using a SOAP Web Service, click the Scan button to verify the Web Service.

4. Select a Web Method from the drop-down list. The Web Method populates the Parameters field. 

NOTE: SOAP Web Services populate the Web Methods field with a drop-down list of available func-
tions.

5. Under Value, select a variable or type a static Value.

6. Under Test Value, enter values to test the process and click Execute.

7. On the results dialog box, click OK.

8. Click OK to auto-populate the Output Mappings pane with Output values.

9. Leave the Process Setup window open and complete the steps under "Storing retrieved data as vari-
ables".

To set a REST Web Service process 
1. Right-click the Execute activity and select New Process > Web Service.
2. Type the Web Service URI and, for the Web Service Type, select REST. 

CAUTION: If you are using the Execute activity with a web service as a part of a PCI compliant work-
flow, ensure that you

– Use an HTTP Secure (https) address.
– If the return or input fields of the REST call contain sensitive information, use masked variables in 

the Input and Output parameters of the Execute activity.

Failure to do so could invalidate your PCI compliance.
3. Type the Username and Password for the Web Service. Login credentials might not be necessary 

depending on the Web Service used.

4. To add a set of Headers, click Add and type the Parameter the process uses to execute.

5. Under Value, select a variable or type a static value.

6. Repeat steps 4 and 5 for each set of headers the REST Web Service process uses.

7. To add a set of Input Parameters, click Add and type the Parameter the process uses to execute.

8. Under Value, select a variable or type a static Value.
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9. Repeat steps 7 and 8 for each set of input parameters the REST Web Service process uses. To delete 
a set of parameters, click the arrow to the left of Parameter and click Remove.

10. To test the headers and input parameters, enter values under Test Value in Headers and Input 
Parameters and click Execute.

11. In the XML Output pane of the Results dialog box, select the node containing the information the 
Execute activity retrieves.

12. After Selected Node, click the Show Results button.

13. Click OK to auto-populate the Output Mappings pane with Output values.

14. Leave the Process Setup window open and complete the steps under "Storing retrieved data as vari-
ables".

To configure a CRM Service process 
1. Right-click the Execute activity and select New Process > Microsoft CRM.
2. Type the CRM URI used to communicate with the CRM system.

3. Select the CRM Version.

4. Complete the following fields: 

– Domain – Type the domain name of the CRM site. 
NOTE: Domain name is only required for CRM 2011 or 2013.

– Operation – Select the operation the Execute activity is performing
– Username – Type the username for the CRM site login.
– Password – Type the password for the CRM site login.
– Entity Name – Select the name of the CRM entity that the Execute activity queries.

5. To add a set of Input Parameters, click Add and select the Parameter the process uses to execute. 

The parameters depend on the Entity Name selected.
6. Under Value, select a variable or type a static Value.

7. Repeat steps 5 and 6 for each set of input parameters the CRM Service process uses. To delete a 
set of parameters, click the arrow to the left of Parameter and click Remove.

8. Under Test Value, enter values to test the process and click Execute. 

The results dialog shows mappings of the parameters to values.
9. Click OK.

10. Click Mapping to assign the output to variables, and click OK to store the data as variables.

11. Click Save.

Storing retrieved data as variables
The following procedure explains how to store data retrieved by the Execute activity as a variable. These 
variables can be used later in the workflow.
To store retrieved data as a variable 
1. In the Process Setup window, under Mapping, select a variable from the drop-down list to corre-

spond to each Output value.
2. Click OK. 
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When a contact progresses through the workflow, each variable in the Mapping field is assigned the 
value indicated in the Output field.

3. Click Save.

Specifying options for following the Success, Timeout, and Failure branches
The following procedure explains how to 
• Instruct the system to follow the Success branch before a process completes
• Specify how long a process has to complete successfully before the Failure branch is followed

To specify routing options for the Execute activity’s Success, Timeout, and Failure branches 
1. Select the Execute activity and click Properties.
2. After Timeout (sec), type the duration for an associated process to complete successfully before the 

Failure branch is followed.

3. Click Save.

Routing contacts with the From activity

The From activity checks the From: field of inbound emails and performs actions based on specified 
branching conditions.
For example, an administrator configures a From activity to recognize the email addresses of Platinum 
customers and route their emails to a Priority queue.
The From activity is available to Email workflows.
Applying branching conditions to the From activity
Applying branching conditions to the From activity enables administrators to 
• Direct emails based on specified values
• Direct emails based on variables

To direct an email based on specified values
NOTE: To route based on specific email addresses in the ‘From:’ field, we recommend selecting ‘Contains’ 
and typing an email address for the activity to identify. This option identifies a wide range of content in 
email ‘From:’ fields. For example, <<From>> Contains sales@email.com.
1. Right-click the From activity and select Add From Condition.
2. Type a Name for the branching condition and click Add.

3. From the second column, select one of the following: 

– NotEqual (!=) 
For example, administrators can specify that emails not sent from 'prioritysales@email.com' are 
not sent to the priority sales branch.

– Equal (=) 
For example, administrators can specify that emails sent from 'prioritysales@email.com' are direct-
ed to the priority branch.

NOTE: If selecting ‘Equal’, administrators must specify an email address as the ‘<Value>’.
– Contains 

For example, administrators can specify that emails with 'priority' in the From: field are directed to 
the priority branch.
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– Length 
For example, administrators can specify that emails sent from addresses longer than 25 characters 
are directed to a branch for spam.

– StartsWith 
For example, administrators can specify that emails sent from addresses starting with 'priority' are 
sent to the priority sales branch.

4. Click <Value> and enter a criterion to branch emails, for example, ‘priority’.

5. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

6. Click Save.

To direct an email based on variables
NOTE: Directing emails based on variables requires first inserting and configuring an activity on the 
Canvas capable of populating the From activity’s destination variable. For a list of Email variables, go to 
Multimedia > Variables.
1. Right-click the From activity and select Add From Condition.
2. Type a Name for the branching condition and click Add.

3. From the second column, select an operator. See the procedure above for a description of each 
option. 

NOTE: To route based on specific variables in the ‘From:’ field, we recommend selecting ‘Contains’ 
and selecting a variable for the activity to identify. This option identifies a wide range of content in 
email ‘From:’ fields.

4. From the third column, select Variable.

5. Select the variable used to branch emails and click OK.

6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

7. Click Save.

Routing interactions with the Go To activity

The Go To activity sends interactions to an alternate point in the workflow.
For example, an administrator is configuring the Offer to Agent Group activity for an Email Inbound work-
flow. The Go To activity, embedded in the Offer to Agent Group activity, is set with a destination of the 
Offer to Agent Group activity. If the system cannot offer an email to an agent, the Go To activity directs 
the email back to the Offer to Agent Group activity and the system searches again for an agent.
The Go To activity is available to all Multimedia Contact Center workflows.
Specifying the target activity for the Go To activity
The following procedure explains how to specify where the Go To activity sends contacts
To specify where the Go To activity sends contacts 
1. Right-click the Go To activity and select Target….
2. Select the activity to which the Go To activity sends contacts and click OK.
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3. If you do not want to increase the repeat count of your workflow, for example if your workflow uses 
embedded menus or the Collect Digits activity, in the Properties pane, select the Reset Repeat 
Count check box to give callers an unlimited number of attempts to enter information.

4. Click Save.

Configuring parent workflow destinations for subroutine Go To activities
If a Go To activity is placed in a subroutine, it can route contacts to the parent workflow to which the 
subroutine is assigned by setting its destination as ‘Go To Parent Workflow’. A target destination must be 
set on the Subroutine activity to set where the contacts are routed to in the Parent workflow.
To configure a parent workflow destination for a subroutine Go To activity 
1. In the parent workflow, select the Subroutine activity.
2. In the Properties, after Target Activity select the activity to which the subroutine Go To activity 

returns contacts from the drop-down list.

3. Click Save.

Routing interactions with the Interflow activity

The Interflow activity transfers messages that have been waiting in queue for a designated time to an 
alternate queue, a queue group, or to a variable. Configuring the Interflow activity to direct interactions 
based on variables in the workflow enables the activity to dynamically route messages in queue to appro-
priate interflow points.
The Interflow activity is available to Inqueue workflows for all media types.
Interflowing interactions to queues, queue groups, external addresses, and variables
The following procedures explain how to 
• Interflow interactions from one queue to another queue or queue group
• Interflow interactions to an external destination
• Interflow interactions to a variable 

NOTE: This variable must be a queue reporting number, dialable number, or name associated to the 
queue.

To interflow an interaction from one queue to another queue or queue group 
1. Select the Interflow activity.
2. Click Properties and, after Destination, click the … button.

3. Select either Queue or Queue group, select the queue or queue group, and click OK. 

NOTE: 
– To add a queue to the list, click Add and follow the appropriate steps under "Adding multimedia 

queues".
– To add a queue group to the list, click Add and follow the appropriate steps under "Adding queue 

groups".

4. Optionally, to keep the current queue's priority for the interflowed interaction in the destination, select 
Maintain Queue Priority.

5. After Timeout Duration, set the time allotted for the interflow before the call is routed down the Failure 
branch.
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6. Click Save.

To interflow an interaction to an external destination 
1. Select the Interflow activity.
2. Click Properties and, in the Destination field, type the external phone number to which interactions 

are transferred.

3. Select External Transfer.

4. Click Save.

To interflow an interaction to a variable
NOTE: Interflowing an interaction to a variable requires first inserting and configuring an activity on the 
Canvas capable of populating the Interflow activity’s destination variable.
1. Select the Interflow activity.
2. Click Properties and, in the Destination field, click the … button.

3. Click Variable, select a variable, and click OK. 

NOTE: This variable must be a queue reporting number, dialable number, name, or email address 
associated to the queue. The variable cannot be a personal email address.

4. Optionally, to keep the current queue's priority for the interflowed interaction in the destination, select 
Maintain Queue Priority.

5. After Timeout Duration, set the time allotted for the interflow before the call is routed down the Failure 
branch.

6. Click Save.

Tagging interactions with the Junk Email activity

The Junk Email activity, used in conjunction with other activities, tags inbound emails as junk and 
prevents them from reaching a queue.
For example, an administrator configures a Variable Compare activity to identify spam keywords found in 
emails. Emails containing these words are directed to a branch containing a Junk Email activity. The Junk 
Email activity removes the interaction from the workflow, preventing spam from reaching the queue.
The Junk Email activity requires no configuration. Administrators can optionally add a name and system 
name to the activity. See "Naming activities and branches" for more information.
The Junk Email activity is available to Email Inbound and Inqueue workflows.

Tagging inbound interactions with the No Reply Email activity

The No Reply Email activity, used in conjunction with other activities, tags inbound emails as not requiring 
a reply and prevents them from reaching a queue.
For example, an administrator configures a Variable Compare activity to identify the words ‘Out of Office’ 
in email subject fields. Interactions meeting these conditions are directed to a branch containing a No 
Reply Email activity. The No Reply Email activity removes the interaction from the workflow. The No Reply 
Email activity prevents messages not requiring a response from taking up space in queues and being sent 
to agents.
The No Reply Email activity requires no configuration. Administrators can optionally add a name and 
system name to the activity. See "Naming activities and branches" for more information.
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The No Reply Email activity is available to Email Inbound and Inqueue workflows.

Routing interactions with the Offer to Agent Group activity

The Offer to Agent Group activity specifies the agent groups that are offered interactions in queue, estab-
lishing a primary response agent group and overflow agent groups.
If an agent in the group is available, the Agent Available branch is followed and the agent is offered the 
interaction. If the agent accepts, the Success branch is followed. If the agent does not accept, the Failure 
branch is followed and the system checks again for an available agent. If an interaction terminates in the 
queue before reaching an agent, the Completed branch is followed. This activity also offers overflow 
options if agents are unavailable, if interactions wait in queue too long, and if agents in the primary group 
are logged out. Configuring the Offer to Agent Group activity also enables administrators to implement 
push, pick, and mixed model routing.
An agent group can only be associated with an Offer to Agent Group activity once per Inqueue workflow. 
Attempting to associate an agent group with additional Offer to Agent Group activities returns a validation 
error.
The Offer to Agent Group activity is available to Inqueue workflows for all media types.
The following procedures explain how to configure routing options for offering interactions to agent 
groups.
NOTE: To enable mixed model routing, where agents select their interactions from queues, but interactions 
waiting in queue past a specified time are offered to available agents, see "Enabling mixed model routing".
Configuring routing options for offering interactions to agent groups
The following procedures explain how to 
• Specify the agent groups offered interactions
• Set the time limit for accepting interactions
• Enable overflow to additional agent groups
• Disable overflow to additional agent groups
• Overflow interactions instantly if agents are logged out
• Instruct the system to push interactions to agents
• Enable agents to pick interactions out of queue
• Specify how frequently the Interval branch is followed

CAUTION: If an Offer To Agent Group activity is enabled for overflow and there are no activities in either 
the Overflowed branch of the Offer to Agent Group activity or following the Offer to Agent Group activity 
in the workflow, interactions will be lost when they are routed down the Overflowed branch.
To specify the agent groups offered interactions 
1. Select the Offer to Agent Group activity and click Properties.
2. After Answering Agent group, click ....

3. Select the agent group to handle interactions and click OK. 

NOTE: In the Properties pane, the workflow must have ‘Validate workflow’ selected to successfully 
offer interactions to the agent group. See "Validating workflows" for more information.

4. Click Save.
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To set the time limit for accepting interactions 
1. Select the Offer to Agent activity and click Properties.
2. After Requeue Time, type a length of time in hh:mm:ss.

3. Click Save.

To enable overflow to additional agent groups 
1. Select the Offer to Agent Group activity and click Properties.
2. After Overflow Time, type the time interactions wait in queue before the Overflow branch is followed. 

NOTE: If the Inqueue workflow contains activities that can take a significant amount of time to 
execute such as: Ask, Delay, Query, or Subroutine, then the Overflow Time duration entered in the 
Offer to Agent Group activity must include the time spent within these activities in addition to the 
specified duration of time the interaction will be offered to the group. For example: Offer to Agent 
Group activity (Overflow Time: 10 seconds) > Delay activity (Delay: 1 minute) > Offer to Agent Group 
activity (desired Overflow Time: 10 seconds). The second Offer to Agent Group activity would set 
its Overflow Time to 1 minute and 20 seconds.

3. Click Save.

To disable overflow to additional agent groups 
1. Select the Offer to Agent Group activity and click Properties.
2. Select Do Not Allow Overflow and set the Overflow Time to 00:00:00.

3. Ensure there are no subsequent Offer to Agent Group activities on the Canvas.

4. Click Save.

To overflow the interaction instantly if agents are logged out
NOTE: This option also instantly overflows interactions if the preferred agent is logged off. For more infor-
mation, see "Routing contacts with the Offer to Preferred Agent activity".
1. Select the Offer to Agent Group activity and click Properties.
2. Select the Overflow item when all agents are logged out check box. 

NOTE: Ensure 'Do Not Allow Overflow' is not selected.
3. Click Save.

To instruct the system to push interactions to agents
NOTE: A push model instructs the system to evaluate all agents within a skill level and direct the interaction 
to agent longest idle. To assign skill levels to agents, see "Managing agent group membership, presence, 
and skill level".
1. Select the Offer to Agent Group activity and click Properties.
2. Select the Push Items to Agent check box.

3. Click Save.

To enable agents to pick interactions out of queue
NOTE: A pick model enables agents to select interactions from the queue using Ignite.
1. Select the Offer to Agent Group activity and click Properties.
2. Deselect the Push Items to Agent check box.

3. Click Save.
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To specify how frequently the Interval branch is followed
NOTE: The workflow follows the Interval branch to perform additional activities, at set intervals, while inter-
actions are routed. For example, in a pick routing model, the Interval branch can check interactions’ time 
in queue and, after a time, push them to agents. Administrators can add activities to the Interval branch 
to determine actions the system takes when this branch is followed.
1. In the Offer to Agent Group activity, select the Interval branch activity.
2. After Interval Time, type how often the Interval branch is followed.

3. Click Save.

Routing interactions with the Offer to Preferred Agent activity

The Offer to Preferred Agent activity directs ongoing interactions to the agent who either handled interac-
tion the previously or wrote the original outbound email. If an incoming interaction is part of an ongoing 
interaction, the system automatically populates the preferred agent variable with the agent that last 
handled the interaction.
For example, if a support agent is handling an ongoing issue with a customer, the Offer to Preferred Agent 
activity directs all incoming interactions from the customer to that agent. If the agent is not available, the 
system waits until the Overflow Time is reached and follows the Overflow branch. Administrators can 
configure the activity to overflow interactions instantly if the agent is logged out.
The Offer to Preferred Agent activity offers the interaction to the preferred agent only if their Workload 
permits handling this interaction. The activity can also be configured to offer the interaction to the 
preferred agent only if that agent is currently answering for the queue the interaction came in on.
Preferred Agent is not set for agents handling emails that originated internally within a contact center. If 
an agent is responding to an email from another internal queue, Multimedia Contact Center does not set 
that agent as the Preferred Agent. For example, if a customer addressed an email to two different queues, 
the Preferred Agent would only be set for the email sent from the customer, rather than emails sent from 
the agents.
The Offer to Preferred Agent activity is available to all multimedia Inqueue workflows.
For information on configuring this activity’s Overflow Time, Interval Time, and the option to overflow inter-
actions instantly if the preferred agent is logged out, see "Routing contacts with the Offer to Agent Group 
activity".
NOTE: 
• Offer to Preferred Agent functionality requires that auto case and ticket number generation for the 

email media server is not disabled. See "Adding email to Multimedia Contact Center" for more infor-
mation.

• If contact centers use preferred agent routing, we recommend that agents do not adjust case and ticket 
numbers in email subject lines. Removing or otherwise altering case and ticket numbers in subject 
lines can interfere with preferred agent routing.

• If the Preferred Agent is deleted or moved to another agent group, they will no longer be considered 
to be the Preferred Agent.

To set the time limit for accepting interactions 
1. Select the Offer to Agent activity and click Properties.
2. After Requeue Time, type a length of time in hh:mm:ss.

3. Click Save.
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To only route interactions to preferred agents currently answering for this queue 
• Select Only offer to agents answering for this queue.

Routing interactions with the Overflow activity

The Overflow activity sends interactions immediately to overflow agent groups.
For example, an administrator wants emails waiting in queue for four hours to overflow to a secondary 
agent group. The administrator adds an Offer to Agent Group activity to a workflow, and configures the 
Interval branch with a Queue activity reading the queue’s Agents Available. The administrator places an 
Overflow activity after the Queue activity. Once the Queue activity registers that the queue has less than 
2 available agents, the email moves to the Overflow activity and is directed to the secondary agent group.
The Overflow activity requires no configuration. Administrators can optionally provide the activity with a 
name and system name. See "Naming activities and branches" for more information.
The Overflow activity is available to Inqueue workflows for all media types.

Querying data providers with the Query activity

The Query activity reads and writes information through an MS SQL connection, ODBC connection, Excel 
sheet, or LDAP provider. Administrators can use the Query activity to retrieve information and store it in 
custom variables for use within workflows. Advanced queries return multiple records of information that 
can be stored in multiple variables.
For example, an administrator uses a Query activity in an Inbound Email workflow to retrieve customer 
account balances from a SQL database. The administrator populates an Email activity template with a 
variable that will contain this information, retrieved from the Query activity. The workflow responds with 
balance information to customers inquiring via email.
The Query activity is available to all Multimedia Contact Center workflows.
NOTE: 
• By default, the query result is stored within the <<LastQueryResult>> system variable. Each subse-

quent Query action overwrites this variable. It is not recommended to use the LastQueryResult variable 
when expecting protected information to be contained within this variable.

• For information on configuring data providers, see "Configuring data providers".

Connecting Query activities to data providers
Connecting Query activities to data providers enables the Query activity to access data and use this infor-
mation to route interactions. See "Configuring data providers" for more information.
1. Select the Query activity and click Properties.
2. After Data Provider, click the Browse button.

3. Select a data provider and click OK. 

NOTE: The Query activity cannot be saved without a query or write statement configured.

Running simple queries in workflows
Running simple queries enables administrators to retrieve information from a database and store it in a 
variable.
To run a simple query in a workflow 
1. Select the Query activity and click Properties.
2. After Query statement, click the Browse button and, under Query Type, select Simple Query.
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3. After Database Table Name, from the drop-down list, select the table to query. 

'Database table names' refer to the tables in the data source from which the Query activity retrieves 
information.

4. After Column Return Name, from the drop-down list, select the column of data to query. 

'Column return names' refer to the columns in the selected table, from which the Query activity re-
trieves information.

5. After Variable Return Name, from the drop-down list, select the variable to populate with the return 
value. 

'Variable return names' refer to the variables populated as a result of the query.
6. After Column Where Name, from the drop-down list, select the name of the column of data to 

compare against. 

'Column where names' refer to the columns in the data source against which the Query activity com-
pares information.

7. After Variable Where Name, from the drop-down list, select the variable to use for comparison. 

'Variable where names' refer to the variables against which the Query activity compares.
8. To test the query, after Test with a value equal to, enter an existing value from the data provider and 

click Test Query. 

The Raw SQL window displays the SQL statement based on the selections from the drop-down lists.
9. To clear all fields and return to the Canvas, click Clear. To accept the query, click OK.

10. Click Save.

Running advanced queries in workflows
Advanced queries enable administrators with knowledge of SQL to write SQL statements retrieving infor-
mation from a database provider. Advanced queries also support LDAP syntax for LDAP providers, and 
advanced queries for MS SQL Server and ODBC data providers support stored procedures.
Administrators can use an advanced query to retrieve single or multiple records from a database provider.
To run an advanced query in a workflow 
1. Select the Query activity and click Properties.
2. After Query statement, click the Browse button, and under Query Type, select Advanced Query.

3. Under Query, type the SQL statements to be run directly against the data provider and click Execute. 

The Execute window opens displaying a list of detected input and output parameters.
4. Under Value, type the numbers corresponding to the values contained in the data provider.

5. Click Run.

6. To assign variables to store information returned by the SQL statements, click the Variable Assign-
ment tab. 

Return Column will be populated with the column names in the data provider.
7. Under Variable Name, select the variables to store information returned by the SQL statements.

8. To assign values to the parameters filled by the SQL statements, click the Parameter Assignment 
tab. 

Parameter Name will be populated with the SQL parameters used to query the data provider.
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9. After Variable Name, select a variable from the drop-down list to store the information retrieved by 
the SQL parameter.

10. To view the values returned from the query, click the Test Results tab.

11. To clear the variables and their parameters, click Clear. To accept the query, click OK.

12. Click Save.

Defining write statements
Write statements define a delete, insert, or update statement against a specified data provider. Write 
statements enable administrators to delete, insert, or update column values in a data provider from within 
a workflow.
The following procedures explain how to configure simple and advanced write statements
NOTE: Advanced write statements enable users with knowledge of SQL to write insert, update, or delete 
SQL statements.
To define a simple write statement 
1. Select the Query activity, click Properties and, after Write statement, click the Browse button.
2. Select Simple Write and select a Write Type from the drop-down list. Options vary by data provider.

3. After Table Name, select the table in the data provider against which the write statement is defined.

4. Under Column Name, select a column in the data provider against which the write statement is 
defined.

5. Under Value, select the data to be inserted into the data provider.

6. Under Where, select a column name. 

NOTE: 
– ‘Where’ statements display only if Delete or Update is selected
– The column names displaying in the list derive from the Table Name selected.

7. Select an operator from the drop-down list 

– =
– <>
– >
– <
– >=
– <=

8. From the third drop-down list, select or type the variables used to evaluate the information selected 
from the first column

9. To test the write statement, click Test Syntax.

10. To empty column values, click Clear. To accept the write statement, click OK.

11. Click Save.

To define an advanced write statement 
1. Select the Query activity, click Properties.
2. After Write statement, click the Browse button and select the Advanced Write button.
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3. Under Query, type the insert, update, or delete SQL statements to be run against the data provider 
and click Execute.

4. The Parameter name column will be populated with the column names in the data provider.

5. Under Variable Name, from the drop-down list, select the variables used to evaluate the information 
you selected from the first column.

6. To test the write statement, click Test Syntax.

7. To empty column values, click Clear. To accept the write statement, click OK.

8. Click Save.

Returning multiple results with queries
The Query activity supports returning multiple results from a query. When a Query activity returns multiple 
results from a query, the Success branch is followed for each result. When there are no more results, the 
message exits the Success branch of the Query activity and continues along the workflow.
Multiple result returning Query activities enable contact centers to build more complex workflow functions, 
such as providing callers access to an employee directory.

Routing interactions with the Queue activity

The Queue activity branches workflows based on real-time queue conditions, enabling administrators to 
route interactions based on emerging queue conditions.
For example, an administrator building an Email Inbound workflow configures the Queue activity to send 
emails waiting in queue four hours or longer to a secondary queue. This enables the contact center to 
meet its service level goals.
The Queue activity is available to all Multimedia Contact Center workflows.
Applying queue conditions to the Queue activity
The following explains how to 
• Associate queue conditions to a queue or queue group
• Associate queue conditions to a variable
• Add queue condition to an existing branch
• Edit queue conditions
• Delete queue conditions
• Import and export queue conditions
• Group queue conditions

NOTE: Multimedia Contact Center evaluates Queue conditions from left to right. To change the order in 
which the activity evaluates conditions, see "Changing the order in which branches are evaluated".
To associate queue conditions to a queue or queue group 
1. Right-click the Queue activity and select Add.
2. Type a Name for the queue condition and, after Queue, click the ... button.

3. Select either Queue or Queue Group, select the queue or queue group and click OK.

4. Click Add and, from the second column, select a real-time statistic from the drop-down list.
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5. In the third column, select an operator from the drop-down list. Options vary according to the variable 
chosen.

6. Click the fourth column and select either Value, Queue Stats, or Variable.

7. For Value, type in a numeric value or enable the check box for the value.

8. For Queue Stats, select a queue stat from the drop-down list.

9. For Variable, select a variable from the drop-down list.

10. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test.

11. Click OK.

12. To add another condition, click Add and repeat steps 4-11.

13. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

14. Click Save

Associate queue conditions to a variable
NOTE: Associating queue conditions to a variable requires first inserting and configuring an activity on the 
Canvas capable of populating the Queue activity’s destination variable.
1. Right-click the Queue activity and select Add.
2. Type a Name for the queue condition and, after Queue, click the ... button.

3. Select the Variable tab, select a variable, and click OK. 

To see a list of Multimedia Contact Center variables and their descriptions, go to Multimedia > Vari-
ables.

4. Click Add and, from the second column, select a real-time statistic from the drop-down list.

5. In the third column, select an operator from the drop-down list. Options vary according to the variable 
chosen.

6. Click the fourth column and select either Value, Queue Stats, or Variable.

7. For Value, type in a numeric value or enable the check box for the value.

8. For Queue Stats, select a queue stat from the drop-down list.

9. For Variable, select a variable from the drop-down list.

10. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test.

11. Click OK.

12. To add another condition, click Add and repeat steps 4-11.

13. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

14. Click Save

To edit queue conditions 
1. Right-click the relevant branch in the Queue activity and select Edit Condition.
2. Click Add and, from the second column, select a real-time statistic from the drop-down list.
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3. In the second column, select an operator from the drop-down list. Options vary according to the vari-
able chosen.

4. Click the third column and select either Value, Queue Stats, or Variable.

5. For Value, type in a numeric value or enable the check box for the value.

6. For Queue Stats, select a queue stat from the drop-down list.

7. For Variable, select a variable from the drop-down list.

8. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test.

9. Click OK.

10. To add another condition, click Add and repeat steps 2-9.

11. Click Save.

To delete queue conditions 
• To delete a queue condition, select the row for the condition and click Delete.
To import and export queue conditions 
1. To import queue conditions, click the Import button and navigate to a *.csv file. 

NOTE: 
– Conditions on a single line and separated by a comma will be added to a single branch.
– Conditions on multiple lines and separated by a comma will be added to multiple branches.

2. To export queue conditions, click the Export button and navigate to a *.csv file.

3. To test the conditions, click Test Parameters, enter a value in the relevant fields and click Test.

To group conditions being compared 
• See "Grouping expressions".

Submitting callbacks with the Save Callback activity

The Save Callback activity saves a callback request to the SQL database. This activity works with IVR 
Routing to submit callback requests from Multimedia Contact Center to submit callback requests to IVR 
Routing. The Save Callback activity is included if you are licensed for IVR but not available if you are 
licensed for Messaging and Routing.
The Save Callback activity requires the following variables be set with information for the callback request 
to be submitted correctly: 
• CallbackClientNumber—This variable must be populated with the phone number to which the callback 

request will be made.
• CallbackDestination—This variable must be populated with dialable number of the voice queue to 

which the callback request will be submitted.
• CallbackOutboundWorkflowId—This variable must be populated with the Outbound callback subrou-

tine you want to use to submit callbacks to agents. 
NOTE: It is recommended that you use the default abandon outbound callback subroutine as call-
backs submitted by a Multimedia Contact Center workflow will not contain a message to be played 
for agents.

For additional information on the Save Callback activity and callbacks, see "Configuring callbacks".

newimport/visual_workflow_manager/configuring_callbacks_and_callback_plans.dita#Configuring_callbacks
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The Save Callback activity has a Success and Pending branch. The activity routes down Pending when 
network issues prevent the callback from being submitted. When the network issues are resolved, the 
callback will be saved.
The Save Callback activity is available to all Multimedia Contact Center workflows.
To set the Save Callback request reason 
1. Select the Save Callback activity.
2. After Request Reason, select New Request from the drop-down menu. 

NOTE: If you are using this activity to submit a callback, you should use New Request.
3. Click Save.

Responding to interactions with the Say activity

The Say activity sends messages to interactions.
For example, if a chat message is sent to the contact center after hours, the Say activity can respond with 
the message 'Thank you for contacting us. Our chat queues are currently closed. Please try again 
Monday through Friday 9am – 5pm.'
URLs entered into the Message field are turned into hyperlinks and will open in another window or tab of 
the interaction’s browser when the customer clicks on them. Some website content is embeddable into 
chat sessions using the Say activity. If a link to a supported website’s content, such as a link to a YouTube 
video, is entered into the Message field, the content is embedded directly into the chat session. The 
following websites are supported for embedded content in chat: 
• https://twitter.com
• https://soundcloud.com
• http://www.youtube.com

NOTE: 
• Ignite supports embedding content from Google Maps in chat sessions. However, this requires the use 

of embed maps URL, available from Google Maps, to embed a Google map, such as: <iframe 
src="https://www.google.com/maps/embed?pb=!1m18!1m12!1m3!1d2804.500978803945!2
d-
75.90911198444678!3d45.3386984790996!2m3!1f0!2f0!3f0!3m2!1i1024!2i768!4f13.1!3m3!1m2!1s0
x4cd1fff1517da8a9%3A0xe6bc8a721e90f2a5!2sMitel+Net-
works!5e0!3m2!1sen!2sus!4v1445531227487" width="600" height="450" frameborder="0" 
style="border:0" allowfullscreen&gt;&lt;/iframe>

• SMS does not support embedded content.

The Say activity is available to Chat and SMS Inbound and Inqueue workflows.
To customize Say activity messages 
1. Select the Say activity.
2. After Message, click ....

3. Type the content of the auto-response message and click OK. 

In a chat session, the message will be said using the chat media server’s auto response username or 
the chat queue’s username. In an SMS session, the message will be said using the SMS media serv-
er's name or the SMS queue's phone number.

4. Click Save.
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Routing interactions with the Schedule activity

The Schedule activity branches workflows based on date and time conditions, enabling a workflow to 
respond to a business’ hours of operation.
For example, an administrator uses a Schedule activity to route chat messages arriving after hours to an 
after-hours branch. Interactions following this branch receive a response indicating that the contact center 
is closed and to send the chat again during business hours.
The Schedule activity is available to all Multimedia Contact Center workflows.
Applying branching conditions to the Schedule activity
The following procedures explain how to 
• Route interactions by time of day
• Route interactions by day of the week
• Route interactions by date and holiday
• Modify schedule conditions
• Route interactions by schedule
• Import and export Schedule conditions
• Route interactions by grouped Schedule conditions

To route interactions by time of day 
1. Right-click the Schedule activity and select Add a schedule condition.
2. Type a Name for the time condition.

3. Click Add, and, from the second drop-down list, select Time.

4. Click 00:00:00-00:00:00, specify the Start Time and End Time for the business (hh:mm:ss), and click 
OK.

5. To test the conditions, under Testing, select a date and time and click Test.

6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

7. Click Save.

To route interactions by day of the week 
1. Right-click the Schedule activity and select Add a schedule condition.
2. Type a Name for the day of the week condition.

3. Click Add and, from the second drop-down list, select DOW.

4. Click <Value>, select the days of the week the business is open, and click OK.

5. To test the conditions, under Testing, select a date and time and click Test.

6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

7. Click Save.

To route interactions by date and holiday 
1. Right-click the Schedule activity and select Add a schedule condition.
2. Type a Name for the date or holiday condition.
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3. Click Add and, from the second drop-down list, select either Date or Holiday.

4. From the third drop-down list, select the date or holiday that the contact center is closed and click OK. 

NOTE: Administrators may select ‘Reoccur every year’ for date conditions if the business is regularly 
closed on that date.

5. To test the conditions, under Testing, select a date and time and click Test.

6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

7. Click Save.

To modify Schedule conditions 
1. Right-click the branch to modify and click Edit.
2. Change the branch as required.

3. To test the conditions, under Testing, select a date and time and click Test.

4. Click OK to create the branch, or click Add to add the current branch to the workflow while leaving 
the dialog box open to create new branches.

5. Click Save.

To route interactions by schedule
NOTE: The default schedule conditions determine when Multimedia Contact Center executes business 
hour workflows and after hour workflows. These conditions include the default Monday to Friday, 9:00 AM 
to 5:00 PM schedule and the default 24/7 schedule. These default Schedule conditions can be used as 
is or modified to suit specific hours of operation. See also "Modifying default business hour schedules".
1. Right-click the Schedule activity and select Add a schedule condition.
2. Type a Name for the schedule condition.

3. Click Add and, from the second drop-down list, select Schedule.

4. From the third drop-down list, select a schedule.

5. To test the conditions, under Testing, select a date and time and click Test.

6. Click OK to create the branch, or click Add to add the current branch to the workflow while leaving 
the dialog box open to create new branches.

7. Click Save.

To import and export Schedule conditions 
1. Right-click the Schedule activity and select Add a schedule condition.
2. Type a Name for the schedule condition.

3. To import schedule conditions, click the Import button, navigate to a *.csv file, and click Open.

4. To export schedule conditions, click the Export button, navigate to a *.csv file, and click Open. 

NOTE: 
– Conditions on a single line and separated by a comma are added to a single branch.
– Conditions on multiple lines and separated by a comma are added to multiple branches.

5. To test the conditions, under Testing, select a date and time and click Test.
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6. Click OK to create the branch, or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

7. Click Save.

To route interactions by grouped Schedule conditions 
• See "Grouping expressions".

Populating variables with the Set Variables activity

The Set Variables activity takes values generated within a workflow, and populates variables with this 
data for use later in the same workflow.
For example, an administrator configures a Set Variables activity to retrieve customer data from incoming 
emails. This information is used in an Email activity’s template for automatic responses to the customer.
The Set Variables activity is available to all Multimedia Contact Center workflows.
Populating the Set Variables activity with data
The following explains how to retrieve workflow data and use it to populate Set Variables activities.
To populate the Set Variables activity with workflow data 
1. Right-click the Set Variables activity and select Edit Variable Settings.
2. Type a Name for the activity and click Add.

3. Select a variable from the drop-down list and click OK. 

To see a list of Multimedia Contact Center variables and their descriptions, go to 'Multimedia > Vari-
ables'.

4. In the third column, either type a Value, an expression in Advanced Text, or select Variable and 
select a variable from the drop-down list. If selecting a value, note that options vary according to the 
variable selected. Advanced Text is only available with certain variables.

5. Click OK.

6. To add a variable row, click Add. To delete a variable row, select the row and click Delete.

7. Click Save.

Sending SMS with the SMS activity

The SMS activity sends SMS interactions from within a workflow to recipients via the SMS Gateway 
connection configured in YourSite Explorer. For example, an administrator can use the SMS activity to 
send auto-acknowledgement messages to inbound SMS interactions.
SMS activity templates support text-based content. Template fields can be populated with variables.
The SMS activity is available to all Multimedia Contact Center workflows.
To add an SMS template to an SMS activity 
1. Select the SMS activity.
2. After SMS template, click ….

3. After From, click ….

4. Select an SMS Provider and click OK.

5. After To, type the dialable number or a variable containing the dialable number of the SMS recipient. 
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Dialable numbers must not contain punctuation or special characters.
6. Type the body of the message. 

The body can have up to 320 characters.
7. Click OK.

8. Click Save.

Executing subroutines with the Subroutine activity

The Subroutine activity represents a set of workflow steps that can be inserted at any point in a workflow 
or in multiple workflows. Editing the subroutine changes all instances of that subroutine in workflows, 
enabling administrators to edit multiple workflows using a single point of configuration. The Subroutine 
activity is an efficient means of replicating and configuring workflow segments. For information on subrou-
tines, see "Building subroutines".
The Subroutine activity is available to all Multimedia Contact Center workflows.
NOTE: Go To activities nested in subroutines can have a target activity in either the subroutine or the 
parent workflow.
Assigning subroutines to workflows
The following section explains how to 
• Assign subroutines to the Subroutine activity
• Assign variables to the Subroutine activity
• Expand subroutines in workflows

To assign a subroutine to the Subroutine activity 
1. Right-click the Subroutine activity and click Assign….
2. Click the Subroutines tab, select a subroutine to assign and click .

3. Click Save.

To assign a variable to the Subroutine activity
NOTE: Assigning a variable to the Subroutine activity requires first inserting and configuring an activity on 
the Canvas capable of populating the variable.
1. Right-click the Subroutine activity and click Assign….
2. Click the Variable tab, select a variable to assign and click OK. 

To see a list of Multimedia Contact Center variables and their descriptions, go to Multimedia > Vari-
ables.

3. Click Save.

To expand a subroutine in a workflow 
• Right-click the Subroutine activity and click Open….
Configuring parent workflow destinations for subroutine Go To activities
If a Go To activity is placed in a subroutine, it can route contacts to the parent workflow to which the 
subroutine is assigned by setting its destination as ‘Go To Parent Workflow’. A target destination must be 
set on the Subroutine activity to set where the contacts are routed to in the Parent workflow.
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To configure a parent workflow destination for a subroutine Go To activity 
1. In the parent workflow, select the Subroutine activity.
2. In the Properties, after Target Activity select the activity to which the subroutine Go To activity 

returns contacts from the drop-down list.

3. Click Save.

Ending workflows with the Terminate Workflow activity

The Terminate Workflow activity ends a workflow at any stage.
For example, an administrator uses a Terminate Workflow activity to end an Inqueue workflow once an 
interaction requires no further routing to an agent.
The Terminate Workflow activity requires no configuration. Administrators can optionally provide the 
activity with a name and system name. See "Naming activities and branches" for more information.
The Terminate Workflow activity is available to all Multimedia Contact Center workflows.

Routing interactions with the To activity

NOTE: Email routing to blind-copied queues is not supported.
The To activity checks the 'To:' and 'Cc:' fields of inbound emails. The activity performs actions based on 
specified branching conditions. Administrators can specify whether the To activity checks one or all of the 
above fields for email.
For example, an administrator configures the To activity to route an email to the Sales queue if the email 
contains sales@email.com in its To: or Cc: field.
The To activity is available to all Email workflows.
Applying branching conditions to the To activity
Applying branching conditions to the To activity enables administrators to 
• Direct emails based on specified values
• Direct emails based on variables
• Group the conditions used to direct emails

To direct emails based on specified values
NOTE: To route based on specific email addresses in the ‘To:’ and 'Cc:' fields, we recommend selecting 
‘Contains’ and typing an email address for the activity to identify. This option identifies a wide range of 
content in email ‘To:’ fields. For example, <<To>> Contains sales@email.com.
1. Right-click the To activity and select Add a Condition.
2. Type a Name for the branching condition and click Add.

3. Under <Select a variable>, select one of the following: 

– CC
– To

4. From the third column, select one of the following: 

– NotEqual (!=) 
For example, administrators can specify that emails not interested to 'sales@email.com' are not di-
rected to a Sales branch.

mailto:sales@email.com
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– Equal (=) 
For example, administrators can specify that emails addressed to 'sales@email.com' are directed to 
a Sales branch.

NOTE: If you select ‘=Equal to’, you must specify an email address as the ‘<Value>’.
– Contains 

For example, administrators can specify that emails containing 'sales' in the To: field are directed to 
a Sales branch.

NOTE: If your organization uses email addresses containing the same words, add them to the 
‘Contains’ condition in order of longest address to shortest address. For example, add techni-
calsupport@email.com before adding support@email.com. This ensures that the system eval-
uates the addresses correctly and route interactions to the correct destinations.

– Length 
For example, administrators can specify that emails sent to an address exceeding 25 characters are 
directed to a branch for spam.

– Starts With 
For example, administrators can specify that emails sent to an address starting with 'Sales' are di-
rected to a Sales branch.

NOTE: Starts With reads the first address in the To: field only.

5. Click <Value> and enter a criterion to branch emails. 

For example, ‘sales@email.com’.
6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.

7. Click Save.

To direct emails based on variables
NOTE: Directing emails based on variables requires first inserting and configuring an activity on the 
Canvas capable of populating the To activity’s destination variable. For a list of Email variables, go to 
Multimedia > Variables.
1. Right-click the To activity and select Add a Condition.
2. Type a Name for the branching condition and click Add.

3. From the second column, select an operator. See the procedure above for a description of each 
option. 

NOTE: To route based on specific variables in the ‘To:’ field, we recommend selecting ‘Contains’ and 
selecting a variable for the activity to identify. This option identifies a wide range of content in email 
‘To:’ fields.

4. From the third column, select Variable.

5. Select the variable used to branch emails and click OK.

6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 
dialog box open to create new branches.

7. Click Save.
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Routing interactions with the Transfer activity

The Transfer activity directs inbound messages to queues and queue groups. Administrators can 
configure the activity to dynamically route messages, either using the <<DestinationQueues>> variable 
or by routing according to database lookups For example, an administrator configures the workflow to 
query a database containing customer statuses. Based on the results of this query, the Transfer activity 
transfers Platinum customers to a priority queue.
By default, Transfer activities added to an email Inbound workflow have the <<DestinationQueues>> vari-
able set as a destination. This variable instructs the Transfer activity to compare all addresses in the To 
and CC fields of the inbound email to the email addresses configured for contact center’s email queues. 
A copy of the email is transferred to queues matching the addresses in the To or CC fields of the inbound 
email. For information on associating email addresses to queues, see "Configuring general multimedia 
queue information".
NOTE: If your contact center will be transferring emails between mail servers, ensure that all aliases are 
entered on the mail server page. For more information about adding aliases to the mail server, see 
"Configuring SMTP connections to Multimedia Contact Center".
If you use a destination other than the <<DestinationQueues>> variable in an email Inbound workflow, 
the email will be transferred according to the configured destination and will ignore the email addresses 
in the To and CC fields of the email.
The Transfer activity is available to Inbound workflows for all media types.
Transferring messages to queues, queue groups, external addresses, or variables
The following procedures explain how to transfer interactions 
• Transfer interactions to a queue or queue group
• Transfer interaction to an external email address
• Transfer interaction to a variable 

NOTE: This variable must be a queue-reporting number, dialable number, name, or an email address 
associated with the queue. The variable cannot be a personal email address. 

If you transfer an interaction to a queue that you are not associated with, you will still be able to view the 
interaction in your Cases folder. Note that, to view the case details, you have to un-check the “Only show 
my items” option as you are no longer responsible for this case. Another agent associated with this queue 
will also be able to see this case.

To transfer an interaction to a queue or queue group 
1. Select the Transfer activity.
2. Click Properties and, after Destination, click the … button.

3. Select either Queue or Queue group, select the queue or queue group, and click OK. 

NOTE: 
– To add a queue to the list, click Add and follow the appropriate steps under "Adding multimedia 

queues".
– To add a queue group to the list, click Add and follow the appropriate steps under "Adding queue 

groups".

4. Click Save.
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To transfer an interaction to an external email address 
1. Select the Transfer activity.
2. Click Properties and, in the Destination field, type the external email address to which interactions 

are transferred.

3. Select External Transfer.

4. Click Save.

To transfer an interaction to a variable
NOTE: Transferring an interaction to a variable requires first inserting and configuring an activity capable 
of populating the Transfer activity’s destination variable.
1. Select the Transfer activity.
2. Click Properties and, in the Destination field, click the … button.

3. Click Variable, select a variable to identify in the interaction's contents, and click OK. 

NOTE: This variable must be a queue reporting number, dialable number, name, or email address 
associated to the queue. The variable cannot be a personal email address.

4. To add a variable to the list, click Add and follow the appropriate steps under "Creating Custom Vari-
ables".

5. Click Save.

Routing interactions with the Variable Compare activity

The Variable Compare activity routes interactions through workflow branches by comparing information, 
stored in either custom or system variables, against specified conditions.
For example, an administrator uses the Variable Compare activity to filter and prevent automatic email 
responses from reaching a queue. The Variable Compare activity compares a variable for automatic 
responses against an email’s Subject line. If ‘Automatic Reply’ or ‘Out of Office’ is present in the Subject 
line, the email follows a branch configured to receive junk emails. If neither is present, the email follows 
the No Match branch and continues through the workflow.
The Variable Compare activity is available to all Multimedia Contact Center workflows.
Applying branching conditions to the Variable Compare activity
The following procedures explain how to 
• Add conditions to be compared against workflow data
• Edit conditions being compared
• Delete conditions being compared
• Group conditions being compared

To add a condition to be compared against workflow data 
1. Right-click the Variable Compare activity and select Add Variable Compare Condition.
2. Type a Name for the condition and click Add.

3. Select a variable from the drop-down list and click OK. 

To see a list of Multimedia Contact Center variables and their descriptions, go to Multimedia > Vari-
ables.

4. Select an operator from the second drop-down list. Options vary according to the variable chosen.
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5. In the third column, type or select a value for the variable. If selecting a value, note that options vary 
according to the variable selected. 

NOTE: “ means ‘No Value’.
6. Click OK to create the branch or click Add to add the current branch to the workflow while leaving the 

dialog box open to create new branches.

7. Click Save.

To edit a Variable Compare condition 
1. Right-click the condition’s branch and select Edit.
2. Change the condition, and click OK to create the branch or click Add to add the current branch to the 

workflow while leaving the dialog box open to create new branches.

3. Click Save.

To delete a Variable Compare condition 
• Right-click the condition’s branch and select Delete.
To group Variable Compare conditions 
• See "Grouping expressions".

Enabling mixed model routing

In mixed model routing agents pick interactions out of queue, but items in queue that remain unpicked for 
a specified time are pushed to agents’ Inboxes.
Enabling a mixed model requires administrators first to configure two agent groups, each containing the 
same agents. Administrators must then add two Offer to Agent Group activities, one after the other, to the 
Workflow Canvas. One of the agent groups is assigned to each activity. The first Offer to Agent Group 
activity enables a pick routing model, and allows overflow to a secondary agent group. The second Offer 
to Agent Group activity enables a push routing model, and does not allow overflow. When interactions 
overflow from the first Offer to Agent Group activity to the second, they overflow to an agent group with 
the same agents and are pushed to the agents’ Inboxes.
For example, Support agents pick the emails they handle, but their supervisor wants to push emails 
waiting in queue over 30 minutes to the agents’ Inboxes. The administrator creates one agent group, 
called Support Group 1, containing the contact center’s Support agents. The administrator then creates 
a second agent group, called Support Group 2, containing the same Support agents.
The administrator adds an Offer to Agent group activity to the workflow and assigns it Support Group 1. 
The activity is configured to follow a pick model and to overflow emails waiting longer than 30 minutes in 
queue. The administrator adds the second Offer to Agent group activity, configures it to follow a push 
routing model, disables overflow, and assigns Support Group 2. If emails remain unpicked in the Support 
queue for more than 30 minutes, they overflow to the same Support agents and are pushed to the Inboxes 
of available agents.
The following procedures explain how to enable mixed routing models. For information on creating agent 
groups, see "Adding agent groups".
To enable a mixed routing model
1. Place an Offer to Agent Group activity on the Canvas and click Properties.
2. Deselect the Push Items to Agent check box.
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3. After Answering Agent Group, click the drop-down and select Agent Group.

4. Select the agent group to handle interactions and click OK.

5. After Overflow Time, type the time interactions wait in queue before the Overflow branch is followed 
and a push routing model begins.

NOTE: Ensure ‘Do Not Allow Overflow’ is not selected.
6. Place a second Offer to Agent Group activity on the Canvas and, in the Properties pane, select the 

Push Items to Agent check box.

7. After Answering Agent Group, click the drop-down and assign the second agent group to handle 
interactions.

NOTE: This group must contain the agents that are in the first agent group, assigned above.
8. Select Do Not Allow Overflow and set the Overflow Time to 00:00:00.

9. Click Save.

Populating screen pops with workflow variables

When an interaction is processed through a workflow, administrators can populate URLs or executable 
files with variables. These URL and executable files, and the variable information they contain, can be 
passed to agents in the form of a screen pop. Workflow-generated screen pops display when agents 
select ringing interactions in Ignite.
Any variable available to the workflow’s media type, which also contains the ‘Send to Agent’s desktop’ 
check box, can populate a workflow screen pop with information. Populating URLs and executable files 
with workflow variables enables administrators to customize screen pops on a queue-by-queue basis.
For example, an administrator can configure a workflow to query a database and retrieve a customer’s 
name and account history. When the interaction rings in the agent’s Inbox, a web page pops on the 
agent's desktop, displaying the customer's information. The agent is immediately able to provide person-
alized, informed service.
Administrators must provide webcodes and servers for URLs and the executable codes behind execut-
able files. URLs must include 'http://' in the URL string.
Executable files may prompt a Windows security warning on client desktops before popping. Administra-
tors may disable this security setting in Internet Explorer. For more information, consult Microsoft docu-
mentation.
NOTE: 
• Agents using Ignite (WEB) may need to disable pop-up blockers for the Ignite URL in order for screen 

pops to display .
• Ignite (WEB) supports URL screen pops only. Executable file screen pops are not supported.
• If Contact Center Client and Ignite are used on the same agent desktop and screen pops are populated 

with workflow variables in voice, email, chat, SMS, and open media, then administrators should disable 
Contact Center Screen Pop in Contact Center Client. For information on enabling and disabling 
Contact Center Screen Pop, see the MiContact Center Business User Guide.

• If Contact Center Client and Ignite are used on the same agent desktop and screen pops are populated 
with workflow variables in voice, email, chat, SMS, and open media, then Administrators should 
disable toaster notifications in Contact Center Client. This prevents screen pops and toaster notifica-
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tions from Contact Center Client and Multimedia Contact Center from appearing on an agent’s monitor 
at the same time.

To populate a screen pop with a workflow variable 
1. Click Multimedia > Variables and select the ScreenPopOnRinging variable.
2. Select Send to agent Desktop.

3. Click Workflows and, in an Inbound or Inqueue workflow, place a Set Variables activity on the Work-
flows Canvas. 

NOTE: If values change after a screen pop has been sent to an agent’s desktop, the screen pop will 
not refresh. We therefore recommend placing the Set Variables activity in close proximity to the 
Offer to Agent Group activity. This provides optimally current values and helps prevent the screen 
pop’s value from being overwritten by another variable query in the workflow.

4. Right-click the Set Variables activity and select Edit Variable Settings.

5. Click Add and, from the <Select a variable> drop-down list, select ScreenPopOnRinging.

6. Click <Value> and, in the Value tab, enter a complete URL string or the path to an executable file. 

NOTE: The paths to executable files must be accessible to any clients who require its use. For 
example, administrators can place the file on a network share.

7. To populate a web page screen pop with variable information, insert the variable’s name between 
double angle brackets where applicable in the URL string. 

For example, <<DestinationQueueName>>.
8. Click OK to close the variable dialog box and click OK to return to the workflow.

9. Click Save.

Multimedia Contact Center default workflows

MiContact Center Business includes a number of default workflows. These workflows are based on 
common business scenarios and demonstrate how administrators can route email, chat, SMS, and open 
media from customers to the agents best suited to respond. These default workflows are generated by 
the system once media servers and queues are created. The workflows are located in Multimedia Contact 
Center’s Media servers and Queues panes, under the routing tabs, and can be modified according to the 
contact center’s business needs.
Multimedia Contact Center includes the following default workflows
• Default Email Inbound
• Default Email Inqueue
• Default Chat Inbound
• Default Chat Inqueue
• Default Chat Response
• Default SMS Inbound
• Default SMS Inqueue
• Default Open Media Inbound
• Default Open Media Inqueue
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The following sections summarize the default workflows and explain how they operate. For ease of under-
standing, we recommend expanding the entire workflow and all annotations.
To expand the workflow
• Click the Expand All button.
To expand all annotations
• Right-click the workflow and select Annotations… > Show All.

Customizing the default workflows

To create customized versions of these workflows, we recommend modifying the default workflows. To 
create multiple workflows of the same type, multiple copies of the default workflows can be made and 
reconfigured. See "Copying workflows".
Each default workflow requires additional configurations to get up and running. For information on config-
uring the workflow activities to suit the contact center, follow the cross-references throughout each 
summary.
NOTE: Inbound Email workflows must contain either a Transfer, a Junk Email, or a No Reply Email activity. 
If they do not, email interactions will remain in system storage, using system memory and causing perfor-
mance issues.
The following requirements are shared among default workflows. Administrators must
• Validate the workflow and activity configuration and correct any errors detected

See "Validating workflows".
• Associate Inbound and, optionally, Response workflows to a server

See "Associating workflows to media servers".
NOTE: Inbound workflows modified from the Inbound Routing tab of the Media servers pane and 
Response workflows modified from the;Response Routing tab are already associated to that media 
server.

• Associate Inqueue workflows to at least one queue
See "Associating workflows to queues".

NOTE: Inqueue workflows modified from the Routing tab of the Queues page are already associated 
to that queue.

Default Email Inbound workflow

This workflow instructs Multimedia Contact Center to route inbound emails to appropriate queues. Admin-
istrators can specify the queues to which inbound emails are directed and can prevent automatic reply 
messages from reaching the queue. This default Email Inbound workflow provides a template for effi-
ciently routing inbound email interactions to the appropriate queues.
To further illustrate the workflow’s activities and their operations, we recommend expanding the entire 
workflow and all annotations.
To expand the workflow 
• Click the Expand All button.
To expand all annotations 
• Right-click the workflow and select Annotations… > Show All.
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Description

The first step in the workflow is a Variable Compare activity. This activity is configured to stop automatic 
responses from reaching the queue. The Variable Compare activity checks an incoming email’s Subject 
line. If the Subject line contains ‘Automatic Reply’, or ‘Out of Office’, but does not contain ‘RE,’ the email 
follows a branch for the matched condition identifying the email as ‘auto response’. A No Reply Email 
activity marks the email as requiring no reply, and a Terminate activity stops the workflow so that the email 
is not directed to a queue. This prevents automatic reply messages from bouncing back and forth between 
a customer’s email account and the email media server. You can modify or add to these ‘auto response’ 
conditions based on responses received by agents. To configure the Variable Compare activity to branch 
emails based on a different set, or an additional set, of conditions, see "Routing contacts with the Variable 
Compare activity".
If the email’s Subject line contains neither Automatic Reply nor Out of Office, the email follows a branch 
with activities routing emails to appropriate queues. In this default workflow, the branch is named ‘Email 
is not an Auto Response’.
This branch contains a Transfer activity. By default, the destination of this activity is set to the <<Destina-
tionQueues>> variable, which compares all addresses in the To and CC field of incoming email to existing 
queue email addresses. For example, emails directed to the Sales branch would be transferred to the 
Sales queue, and emails directed to the Support branch would be transferred to the Support queue. 
Emails failing to transfer to a queue follow the Failure branch. We recommend administrators configure 
the Failure branch with activities so that a course of action is taken if a transfer fails. Emails transferred 
to the appropriate queue follow the Success branch. Once an email is transferred to the appropriate 
queue, a Terminate activity ends the Email Inbound workflow, and the Email Inqueue workflow executes. 
To configure the Transfer activity to direct emails to queues and queue groups in the contact center, see 
"Routing contacts with the Transfer activity".
The default workflow ends with three activities designed to notify administrators when emails are not 
successfully routed.
The first is an Email activity. Inbound emails reaching this activity have failed to reach a queue. For 
example, an email might reach this activity if the address in the email’s To: field was not recognized by 
the system. The Email activity is intended to notify an administrator that an interaction failed to reach a 
queue. To configure the Email activity with the administrator’s email address and to assign the Email 
activity to an SMTP server, see "Enabling mixed model routing".
The second is a Transfer activity. We recommend configuring this Transfer activity with a destination to 
receive emails not successfully routed to a queue. For example, an administrator can specify their email 
address as the Transfer activity’s destination. See "Routing contacts with the Transfer activity".
The third is another Email activity, nested in the Transfer activity’s Failure branch. This Email activity 
contains a message indicating that the final routing activity in this workflow has failed and that the inter-
action can be reviewed as a Failed item in Ignite. To configure the Email activity with an administrator’s 
email address and to assign the Email activity to an SMTP server, see "Sending emails with the Email 
activity". See also "Rerouting Failed emails".
NOTE: <<WorkflowName>> indicates a variable populated by the workflow’s name as configured in Your-
Site Explorer. For a list of Multimedia Contact Center variables, go to Multimedia > Variables. For infor-
mation on renaming the workflow, see "Naming workflows".

Default Email Inqueue workflow

This workflow is executed once an inbound email is transferred to a queue. The workflow offers the email 
to agents within a primary agent group or, if necessary, overflow agent groups. Administrators can specify 
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the first and any subsequent agent groups to be offered interactions. This default Email Inqueue workflow 
provides a template for efficiently routing emails to the agents best suited to answer them.
To further illustrate the workflow’s activities and their operations, we recommend expanding the entire 
workflow and all annotations.
To expand the workflow 
• Click the Expand All button.
To expand all annotations 
• Right-click the workflow and select Annotations… > Show All.

Description

The first step in the workflow is a Schedule activity. The Schedule activity contains a Business Hours and 
an After Hours branch. If an email hits the queue from Monday to Friday between 9:00 AM and 5:00 PM, 
the Business Hours branch is followed. If an email is received after business hours, the After Hours 
branch is followed. To configure the Schedule activity with the contact center’s business hours, see 
"Routing contacts with the Schedule activity".
The Business Hours and After Hours branches contain Email activities programmed with a dedicated auto 
response message. The subject line of the Business Hours branch contains ‘Auto Response [<<CaseId-
Prefix>><<CaseId>> <<TicketIdPrefix>><<TicketId>>]’. The subject line of the After Hours branch 
contains ‘After Hours Auto Response [<<CaseIdPrefix>><<CaseId>> <<TicketIdPrefix>><<TicketId>>]’. 
This populates the email subject line with the customer’s case and ticket number and indicates that the 
message is an automatic response. By default, each Email activity’s template is set with the From field to 
<<QueuePrimaryEmailAddress>>, which uses the queue’s primary email address in responses. For more 
information on email queue email addresses, see "Configuring general settings for multimedia queues".
NOTE: Emails will not be sent by the email activity if the <<To>> variable is used in the From field and an 
inbound email that is addressed to multiple queues arrives in the workflow.
Customers emailing during business hours receive a response message saying 'Hello <<From>>, Thank 
you for your email. We have received your message and it is being handled by one of our agents. Please 
expect a reply shortly. Thank you'. Customers emailing after business hours receive a response message 
saying 'Hello << From>>, You’ve contacted us outside our regular hours of operation. Please expect a 
response during our regular business hours. Thank you'. To configure custom response messages for 
these branches and to connect the activity to an SMTP server, see "Sending emails with the Email 
activity".
NOTE: 
• <<From>> indicates a variable populated by the name appearing in the customer’s email address. For 

a list of Multimedia Contact Center variables, go to Multimedia > Variables.
• The <<CaseIdPrefix>>, <<CaseId>>, <<TicketIdPrefix>>, and <<TicketId>> variables are only popu-

lated if the email media server has been configured to send case and ticket number information. See 
"Configuring Advanced options for media servers" for more information.

• To include Case and Ticket number prefixes in auto-responses from the Email activity, insert the 
<<CaseIdPrefix>> variable before the <<CaseId>> variable, and insert the <<TicketIdPrefix>> variable 
before the <<TicketId>> variable.

• Each time an email arrives in an Inqueue workflow, an auto-acknowledgment email is sent to the 
customer. To prevent multiple identical auto-acknowledgment messages when emails move between 
queues, you can tailor the auto-acknowledgment messages to be queue specific or remove the Busi-
ness Hours Auto Response Email activity and place Email activities with similar messages in the 
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Inbound workflow before the Transfer activities to each queue. For more information, see "Default 
Email Inbound workflow".

The first activity in this workflow is an Offer to Agent Group activity. This activity offers the interaction to 
a specified agent group, in this example named ‘Offer to Primary Agent Group’. If an agent in the primary 
agent group is available to receive an email, the Agent Available branch is followed. An Offer to Agent 
activity sends the email to an agent’s Inbox. The system evaluates which available agents have the 
highest skill level and, of these, pushes the email to the agent longest idle. If the email is successfully 
offered to an agent, the Success branch is followed and a Terminate activity ends the Inqueue workflow. 
If the system cannot offer the email to an agent, or if an agent does not accept the interaction, then the 
Failure branch is followed. A Go To activity nested in the Failure branch loops back to the Offer to Agent 
Group activity and the system searches again for an available agent in the group. If an agent or supervisor 
picks the email from the queue, the Completed branch is followed and a Terminate activity ends the work-
flow. To specify agent groups to be offered emails for the queue, see "Routing contacts with the Offer to 
Agent Group activity". For information on configuring push, pick, or mixed routing models, see "Config-
uring routing options for offering contacts to agent groups", and "Enabling mixed model routing". To 
specify a different end point for the Go To activity, see "Routing contacts using the Go To activity".
If agents in the primary agent group are not available, emails sitting in queue for five minutes follow the 
Overflow branch. Now the system searches for available agents in the second Offer to Agent Group 
activity, named ‘Offer to Overflow Agent Group 1’ in this example. The process repeats itself, and emails 
are overflowed to the third and fourth Offer to Agent Group activities if an available agent cannot be found 
in the first overflow agent group. The fourth and final Offer to Agent Group activity is configured to disallow 
overflow. This is to prevent emails from failing to route to an agent group, in the event that an agent in the 
final Offer to Agent Group activity is not available. Verify that, for the final Offer to Agent Group activity, 
the ‘Do Not Allow Overflow’ check box is selected in the Properties pane.
To disallow all overflow, delete the second, third, and fourth Offer to Agent Group activities from the work-
flow and follow the instructions on disabling overflow in "Configuring routing options for offering contacts 
to agent groups". See this procedure also to maintain overflow but to adjust the Overflow Time.
NOTE: The default workflow does not make use of the Interval branch. For more information on this 
branch, see "Configuring routing options for offering contacts to agent groups".

Default Chat Inbound workflow

This workflow instructs Multimedia Contact Center how to route inbound chat requests to the appropriate 
chat queues. By default, this workflow uses the <<DestinationQueue>> variable to route chats to the 
appropriate queues during business hours. Outside business hours, interactions receive an automated 
response informing them that the contact center is unavailable.
To better illustrate the workflow’s activities and operations, we recommend you expand the workflow and 
all annotations.
To expand the workflow
• Click the Expand All button.
To show all annotations
• Right-click the workflow select Annotations… > Show all.

Description

The first activity in this workflow is a Transfer activity. This activity is configured to route chats using the 
<<DestinationQueues>> variable, which is filled automatically when either a queue is selected from the 
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drop-down list in the chat request page or when a customer uses the chat queue’s Public URL to start a 
chat session. If the transfer is successful, the chat is sent to the destination queue and a Terminate activity 
ends the workflow. If the transfer fails, the chat request is sent down the Failure branch.
The next activity in the workflow is an Email activity. If the transfer failed, this activity sends an email to 
an administrator to notify them that an emergency routing has occurred for a chat. This activity must be 
have an SMTP server added to it. The email’s template must also be altered for sender and destination. 
The template may be customized, but changing the variables within the template is not recommended. 
For more information on configuring the Email activity, see "Sending emails with the Email activity".
This activity is followed by a Transfer activity. This activity is intended to transfer chats that do not route 
correctly by <<DestinationQueue>> to be routed to a specified chat queue. This activity requires that a 
destination queue be selected. For more information on configuring a Transfer activity, see "Routing 
contacts with the Transfer activity". The Success branch of this activity contains a Terminate activity that 
ends the workflow.
The Failure branch contains an Email activity that sends another email to the administrator, indicating that 
the final routing activity in this workflow has failed and that the interaction can be reviewed as a Failed 
item in Ignite. The template must have a destination added. The template may be customized, but 
changing the variables within the template is not recommended. For more information on configuring the 
Email activity, see "Sending emails with the Email activity".
The failed chat session is then routed to the final activity of the workflow, a Terminate activity, which ends 
the workflow.

Default Chat Inqueue workflow

This workflow is executed when an inbound chat is transferred to a queue. This workflow offers the chat 
session to idle agents within the primary agent group or, if necessary, an overflow agent group. You can 
specify the first and any subsequent agent group(s) to be offered the interaction. This default Chat 
Inqueue workflow provides a template for efficiently routing chat sessions to the agents best suited to 
handle them.
To better illustrate the workflow’s activities and operations, we recommend you expand the workflow and 
show all annotations.
To expand the workflow 
• Click the Expand All button.
To show all annotations 
• Right-click the workflow and select Annotations... > Show all.

Description

The first activity in the Chat Inqueue workflow is a Schedule activity. The schedule activity contains a Busi-
ness Hours and an After Hours branch. If a chat arrives in queue from Monday to Friday between 9:00 
AM and 5:00 PM, the Business Hours branch is followed. If a chat is received after business hours, the 
After Hours branch is followed. To configure the Schedule activity with the contact center’s business 
hours, see "Routing interactions with the Schedule activity".
The After Hours branch contains a Say activity programmed with a dedicated auto-response message. 
The Say activity sends a greeting to the interaction that states: “Hello, and thank you for contacting us. 
Our chat queues are currently closed. Please try again during our regular business hours. Thank you.” To 
reconfigure the Say activity’s message, see "Responding to interactions with the Say activity". The next 
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activity in the After Hours branch is an End Session activity, which ends the chat session with the inter-
action. The branch continues to a Terminate workflow activity, which ends the workflow.
The Business Hours branch contains a Say activity. The Say activity sends a greeting to the interaction 
that states: “One moment while we check for an available agent.” To reconfiguring the Say activity’s 
message, see "Responding to interactions with the Say activity".
The next activity in this workflow is the Offer to Agent Group activity. This activity offers the chat session 
to the configured agent group for the activity, in this example named ‘Primary Agent Group’. After you 
configure this activity with an agent group, it will offer the chat to that group first. An agent group must be 
associated to the activity. To specify agent groups to be offered chat sessions for the queue, see "Routing 
interactions with the Offer to Agent Group activity".
NOTE: The default workflow does not make use of the Interval branch. For more information on this 
branch, see "Routing interactions with the Offer to Agent Group activity".
If there are available agents in the primary agent group, the chat request is routed to the Agent Available 
branch. This branch contains an Offer to Agent activity that sends the chat to the agent’s Ignite client. The 
system evaluates which available agents have the highest skill level and, of these, pushes the chat to the 
agent who has been the longest idle. If the chat is successfully offered to the agent, the Success branch 
is followed and a Terminate activity ends the Inqueue workflow. If it fails to be offered to an agent, it is 
routed to the Failure branch which contains a Go To activity that loops back to the Offer to Agent Group 
activity and the system searches for another available agent in the group.
If the overflow timer for the Offer to Primary agent group activity is exceeded, the chat session is routed 
down the Overflowed branch to the next Offer to Agent Group activity.
By default, the Overflow Time in the Properties pane is set to 5 minutes. If you do not want to direct chats 
to an overflow group, set the Offer to Agent Group’s Overflow Timer to 0, select the ‘Do Not Allow Over-
flow’ check box, and delete the following Offer to Agent Group activities. For more information on modi-
fying the overflow timer, see "Routing interactions with the Offer to Agent Group activity".
If the chat session is removed while sitting in queue before reaching an agent, the Completed branch is 
followed and a Terminate activity ends the workflow.
The next three activities in this workflow are Offer to Agent Group activities. There are three Offer to Agent 
Group activities in the workflow, the agent groups configured with each activity functioning as 1st to 3rd 
Overflow groups. These activities are identical in configuration to the first Offer to Agent Group activity. 
The third and final Offer to Agent Group activity is configured to prevent overflow, preventing chats from 
failing to route to an agent group. These activities can be safely deleted from the workflow, if desired. The 
fourth and final Offer to Agent Group activity is configured to prevent overflow, preventing chats from 
failing to route to an agent group. Verify that the ‘Do Not Allow Overflow’ check box is selected in the Prop-
erties pane and that the Overflow Time is set to 0:00:00.

Default Chat Response workflow

The default chat response workflow runs after a chat session has been terminated. It confirms if the chat 
queue is configured to send transcripts and, if so, emails the transcript to the email address entered by 
the customer when filling out the chat request form.
To further illustrate the workflow’s activities and operations, we recommend you expand the workflow and 
show all annotations.
To expand the workflow
• Click the Expand All button.
To show all annotations,
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• Right-click the workflow select Annotations… > Show all.

Description

The first step in this workflow is a Variable Compare activity. This activity checks to see if the chat queue 
is configured to send transcripts. If it is, it routes down the “Queue is configured to send transcript” branch. 
If it is not configured to send transcripts, the workflow routes down the “Queue is not configured to send 
transcript” branch, which continues directly to the Terminate activity at the end of the workflow.
The “Queue is configured to send transcript” branch contains an Email activity. This activity is configured 
with the variables required to send the transcript back to the customer. The template may be customized, 
but changing the variables within the template is not recommended. This activity requires the assignment 
of a SMTP server. For information on configuring the Email activity, see "Sending emails with the Email 
activity".
The final step in the workflow is a Terminate activity. This activity completes the workflow.

Default SMS Inbound workflow

This workflow instructs Multimedia Contact Center how to route inbound SMS interactions to the appro-
priate SMS queues. By default, this workflow uses the phone number of SMS queues to route SMS inter-
actions to the appropriate queues.
To better illustrate the workflow’s activities and operations, we recommend you expand the workflow and 
all annotations.
To expand the workflow 
• Click the Expand All button.
To show all annotations 
• Right-click the workflow and select Annotations… > Show all.

Description

The first activity in this workflow is a Transfer activity. The activity is configured to route SMS interactions 
using the <<DestinationQueues>> variable, which is filled in automatically with the phone number the 
SMS interaction used and is compared to the phone numbers of the SMS queues. If the transfer is 
successful, the SMS interaction is sent to the destination queue and a Terminate activity ends the work-
flow. If the transfer fails, the SMS interaction is send down the Failure branch.
The Failure branch continues to an Email activity. If the transfer failed, this activity sends an email to an 
administrator to notify them that the Transfer activity failed to route and that the interaction can be 
reviewed as a Failed item in Ignite. The template must have a destination added to it and the Email activity 
must have an SMTP server added to it. The template may be customized, but changing the variables 
within the template is not recommended. For more information on configuring the Email activity, see 
"Sending emails with the Email activity".
The next activity in the branch is a Transfer activity. This activity is intended to transfer SMS interactions 
that do not route correctly by <<DestinationQueues>> to be routed to a specified SMS queue. This activity 
requires that a destination queue be selected. For more information on configuring a Transfer activity, see 
"Routing interactions with the Transfer activity". The Success branch of this activity contains a Terminate 
activity that ends the workflow.
The Failure branch continues to a Terminate Workflow activity, which ends the workflow.
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Default SMS Inqueue workflow

This workflow is executed once an inbound SMS interaction is transferred to a queue. The SMS interac-
tion is offered to agents within a primary agent group or, if necessary, overflow agent groups. Administra-
tors can specify the first and any subsequent agent groups to be offered interactions. This default SMS 
Inqueue workflow provides a template for efficiently routing SMS to the agents best suited to answer 
them.
To further illustrate the workflow’s activities and their operations, we recommend expanding the entire 
workflow and all annotations.
To expand the workflow 
• Click the Expand All button.
To expand all annotations 
• Right-click the workflow and select Annotations… > Show All.

Description

The first step in the workflow is a Schedule activity. The schedule activity contains a Business Hours and 
an After Hours branch. If a SMS arrives in queue from Monday to Friday between 9:00 AM and 5:00 PM, 
the Business Hours branch is followed. If a SMS is received after business hours, the After Hours branch 
is followed. To configure the Schedule activity with the contact center’s business hours, see "Routing 
interactions with the Schedule activity".
The After Hours branch contains a Say activity programmed with a dedicated auto-response message. 
The Say activity sends a greeting to the interaction that states: “Hello, and thank you for contacting us. 
Our SMS queues are currently closed. Please try again during our regular business hours. Thank you.” 
To reconfigure the Say activity’s message, see "Responding to interactions with the Say activity". The 
next activity in the After Hours branch is an End Session activity, which ends the SMS session with the 
interaction. The branch continues to a Terminate workflow activity, which ends the workflow.
The Business Hours branch routes to an Offer to Agent Group activity. This activity offers the interaction 
to a specified agent group, in this example named ‘Offer to Primary Agent Group. After you configure this 
activity with an agent group, it will offer the SMS interaction to that group first. An agent group must be 
associated to the activity. To specify agent groups to be offered for the queue, see "Routing interactions 
with the Offer to Agent Group activity".
NOTE: The default workflow does not make use of the Interval branch. For more information on this 
branch, see "Routing interactions with the Offer to Agent Group activity".
If an agent in the primary agent group is available to receive an SMS, the Agent Available branch is 
followed. This branch contains an Offer to Agent activity that sends the SMS interaction to the agent’s 
Ignite client. The system evaluates which agents have the highest skill level and, of these, pushes the 
SMS interaction to the agent who has been idle the longest. If the SMS interaction is successfully offered 
to an agent, the Success branch is followed and a Terminate activity ends the Inqueue workflow. If it fails 
to be offered to an agent, it is routed to the Failure branch, which contains a Go To activity that loops to 
the Offer to Agent Group activity and the system searches for another available agent in the group.
If the overflow timer for the Offer to Agent Group activity is exceeded, the SMS activity is routed down the 
Overflowed branch to the next Offer to Agent Group activity. By default, the Overflow Time in the Proper-
ties pane is set to 1 hour. If you do not want to direct SMS interactions to an overflow group, set the Offer 
to Agent Group’s Overflow Timer to 0, select the ‘Do Not Allow Overflow’ check box, and delete the 
following Offer to Agent Group activity. For more information on modifying the Overflow Timer, see 
"Routing interactions with the Offer to Agent Group activity".
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If the SMS session is removed while sitting in queue before reaching an agent, the Completed branch is 
followed and a Terminate activity ends the workflow.
The next activity in this workflow is an Offer to Agent Group activity. This activity offers SMS interactions 
to the overflow agent group. This activity is identical in configuration to the first Offer to Agent Group, 
except that it is configured to prevent overflow, preventing SMS from failing to route to an agent group. 
Verify that the ‘Do Not Allow Overflow’ check box is selected in the Properties pane and that the Overflow 
Time is set to 0:00:00.

Managing Ignite
Administrators can manage Ignite to improve agent experiences and productivity.
To manage Ignite, administrators can
• Add items to and clear items from Ignite’s global spell checking dictionary
• Configure bounced email detection settings
• Configure maximum email message size
• Accessing diagnostics reports sent from Ignite (WEB)

Adding items to Ignite's global spell checking dictionary

NOTE: The following pertains to email only.
Administrators can configure Ignite's global dictionary to include words that are used by agents across 
your contact center but are not included in the default dictionary. Examples include product names and 
services.
Adding items to Ignite’s global dictionary eliminates the need for each agent to add these words to their 
local dictionary while ensuring agents spell the words correctly.
For information on adding items to Ignite’s global dictionary, consult the following Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1002633/loc/en_US.

Configuring bounced email detection settings

NOTE: You must use SSL to send emails in order to fully support bounce detection settings.
Ignite can be configured to filter bounced emails and either automatically junk them or place them in: 
• DESKTOP - the Auto Replies/Failed Delivery subfolder (contained in the Failed folder) of the agent 

who last handled the email and the global failed route folder (where supervisors can view and process 
bounced emails when agents are absent).

• WEB - the Inbox of the agent who last handled the email and History > Failed (where supervisors can 
view and process bounced emails when agents are absent).

Emails are considered bounced if: 
• The email recipient had a vacation or out of office response configured
• The email recipient had no more space in their mail box
• The message to be delivered to the recipient was delayed by the mail server
• Some of the addresses in the delivery list (To, CC, BCC) were invalid 

https://mitel.custhelp.com/app/answers/answer_view/a_id/1002633/loc/en_US


923

SUPERVISORS - MANAGING A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

This applies only when the contact center mail server is configured to operate in SSL mode

For configuration setting details, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000650/loc/en_US.

Configuring maximum email message size

Maximum email message size can be configured on your system to provide visibility to contact center 
agents and supervisors when they attempt to send oversized emails. Size restriction settings are applied 
globally to all of your mail servers so must be set to meet the requirements of the mail server with the 
lowest supported message size. When set accurately, and an agent attempts to send an oversized email, 
an error message displays and they are given the option of editing the email size and resending.
For configuration setting details, see the following Mitel Knowledge Base article: 
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000649/loc/en_US.
NOTE: You must use SSL to send emails in order to fully support maximum email message size setting 
associated behavior.

Accessing diagnostics reports sent from Ignite (WEB)

Administrators can access diagnostics reports sent from Ignite. Employees can report specific issues, and 
Ignite can be automated to send continuous information to the Enterprise Server.
NOTE: You may experience higher than normal bandwidth use, depending on the number of agents 
enabling continuous logging from Ignite.
A single file is created per employee. Additional reports append to this file. Reports contain log lines from 
employees’ browsers and, for on-demand reports, any details added.
To access diagnostics reports from Ignite (WEB)
• On the Enterprise Server, navigate to <installation drive>:\Mitel\MiContact Center\Logs\Clients 

and select a file.

Supervisors - Managing a multimedia contact center
Supervisors use the following applications in order to effectively manage contact center employees.
• Contact Center Client
• Ignite
• CCMWeb

Within Contact Center Client, supervisors can access and oversee real-time customer activity and agent 
response using a series of desktop monitors, as well as review historical activity. They can affect service 
levels by manipulating agent group presence and distributing interactions among queues. Using monitor 
alarms they can be notified when agents are inappropriately inactive or queues become inordinately busy 
and react to these situations quickly and effectively to improve the customer experience and optimize 
agent productivity.
Ignite is available as either a desktop or Web version. They share much of the same functionality but also 
offer unique agent and supervisor experiences enabling you to choose the application that suits your indi-

https://mitel.custhelp.com/app/answers/answer_view/a_id/1000650/loc/en_US
https://mitel.custhelp.com/app/answers/answer_view/a_id/1000649/loc/en_US
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vidual needs. In our documentation, we refer to desktop Ignite and its features as Ignite (DESKTOP) and 
Web Ignite and its features as Ignite (WEB) or, where appropriate, as DESKTOP or WEB only.
When circumstances dictate, supervisors licensed for Multimedia Contact Center can use Ignite to tempo-
rarily handle interactions, alleviating customer wait times and ensuring a satisfactory service level is main-
tained. Searching email, chat, SMS, and open media history can also be done in Ignite. This sort of 
information is essential when building a case history, following a trail to investigate a customer complaint 
or compliment, or to track agent performance.
With Ignite (WEB), supervisors can access real-time monitors to view current queue statistics and call-
back requests. They can also view agent and employee statistics and interact with agent presence to 
improve service levels.
NOTE: Supervisors have unrestricted access to search email, chat, SMS, and open media history items 
with an Advanced Supervisor or System Administrator license.
Assessing the statistical information that is found in the wide array of multimedia reports available is an 
essential part of effective contact center supervision. Reports can be generated, viewed, and scheduled 
in CCMWeb, your center for reports, setting preferences, and accessing the Help resource documenta-
tion.

Setting alarms to monitor agent performance and customer service

You can define alarms to alert you to changes in contact center activity. Using the alarms, you specify 
performance thresholds for contact center elements such as queues and agents and can customize the 
visual, auditory, or email delivery of alarms. If any availability or performance issues arise, your alarms 
deliver a notification enabling you to react to and adjust agent and queue availability.
You can set alarms to notify you when there are a specified number of emails, chats, SMS, or open media 
waiting or when agents have been in an unavailable state, such as Make Busy, for a specified length of 
time. If alarms indicate a queue is overloaded with interactions or understaffed, you can join that queue 
as an agent (dependent on licensing) or find an agent who is capable of handling the media type for that 
queue and use the Agent Group Presence controls to place them in the group associated to that queue. 
If an alarm demonstrates to you that an agent has been unavailable for an extended period of time, you 
can remove the agent from Do Not Disturb or Make Busy, if appropriate.
Client alarms are specific to each computer. To notify you that performance thresholds are not being met, 
you can configure alarms so that 
• Monitor cells and statistics change color.
• A pop-up notification opens on your desktop.
• A sound prompt, such as a beep or.wav files plays.
• You are notified by mail.

For more information on setting alarms, see "Setting alarms".

Accessing real-time information with Contact Center Client

You use Contact Center Client to access real-time contact center agent, queue, and interaction informa-
tion.
The following section describes typical supervisor usage of the monitors available in Contact Center 
Client. For more detailed information regarding Contact Center Client, see "Real-time Monitors".
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Starting Contact Center Client

NOTE: Launching client-side desktop applications from the task bar causes them to bypass the MiContact 
Center Updater Service process. To ensure successful updates from the Enterprise Server, after an 
upgrade close all client-side applications for 15 minutes or reopen them from the Start menu/Start screen.
You use Contact Center Client to access real-time monitors and functionality. Supervisors can view 
real-time voice, email, chat, SMS, and open media statistics. After starting Contact Center Client, super-
visors can choose to minimize it to either the system tray or the taskbar.
To start Contact Center Client
1. Open Contact Center Client.
2. If prompted, type your Username and Password and verify the Enterprise Server IP address.

3. If you use Secure Socket Layer, select SSL.

4. Optionally, select Remember my credentials.

5. Click Login.

Hiding monitor control

Interactive Contact Center enables you to manage the presence of all devices in a monitor using Monitor 
Device Control. If you do not want to use monitor control, you can hide this option so it is not accessible.
To hide the Monitor control option
1. In Contact Center Client, click the Contact Center Client button > Options.
2. Under Device control, clear the Display monitor device control option check box.

3. Click OK.

Employee and Agent state indicators

The following icons display in agent or employee monitors and indicate the current agent/employee state 
and media type with which they are engaged. You can choose to display the icons as shown in the 
following tables or select the Classic view (Contact Center Client tab > Options > Real-time icons).
NOTE: If Contact Center Client becomes disconnected from the server, upon re-connection agent states 
will be automatically synchronized with the server.
The following table displays Employee state icons and their meanings.
The following table displays Agent state icons and their meanings.
Table 24.18:Employee states  (Sheet 1 of 3)

Term Icon Meaning

Ringing

 

An ACD interaction ringing on 
the employee, waiting to be 
handled

ACD An employee handling an ACD 
interaction
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ACD Hold An employee who has placed 
an ACD interaction on hold

Idle An employee logged on and 
waiting to receive an interaction

Non ACD An employee involved in an 
incoming Non ACD interaction 
or employee-originated voice 
interaction

Non ACD Hold An employee who has placed a 
Non ACD voice interaction on 
hold

Outbound An employee on an outgoing 
voice interaction

Outbound Hold An employee who has placed 
an outgoing voice interaction on 
hold

Do Not Disturb An employee who has activated 
Do Not Disturb and is not 
available to receive any ACD or 
Non ACD interactions

Make Busy An employee who is not 
available to receive ACD 
interactions but can receive 
transferred interactions and 
voice interactions dialed directly 
to the employee
This icon also displays when an 
employee’s external hot desk 
agent is in the Reseize Timer 
state

Table 24.18:Employee states (Continued) (Sheet 2 of 3)

Term Icon Meaning
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System Make Busy An employee that the system 
has put into a state where they 
cannot receive ACD contacts. 
For example, if an employee is 
offered a communication and 
does not answer, they will be 
put into System Make Busy for 
a predetermined length of time.

Work Timer An employee who is completing 
post-contact work, such as 
paperwork, and is unavailable 
to receive interactions of that 
media type

Logged Off An employee not currently 
logged in to any queue

Logged In Not Present An employee logged in but not 
present in any of their agent 
groups, and employees not 
present in a media type across 
all groups

Unavailable An employee who has not 
generated any activity since Mi 
Contact Center Business was 
started

Table 24.19:Agent states  (Sheet 1 of 3)

Term Voice Email Chat SMS Meaning

Ringing An ACD interaction 
ringing on an agent, 
waiting to be handled

ACD An agent handling an 
ACD interaction

Table 24.18:Employee states (Continued) (Sheet 3 of 3)

Term Icon Meaning
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ACD Hold An agent who has placed 
an ACD interaction on 
hold

Idle An agent logged on and 
waiting to receive an 
interaction

Non ACD - - - An agent involved in an 
incoming Non ACD 
interaction or 
agent-originated voice 
interaction

Non ACD Hold - - - An agent who has placed 
a Non ACD voice 
interaction on hold

Outbound - - - An agent on an outgoing 
voice interaction

Outbound Hold - - - An agent who has placed 
an outgoing voice 
interaction on hold

Do Not Disturb An agent who has 
activated Do Not Disturb 
and is not available to 
receive any ACD or Non 
ACD interactions

Make Busy An agent who is not 
available to receive ACD 
interactions but can 
receive transferred 
interactions and voice 
interactions dialed directly 
to the agent
This icon also displays 
when an external hot 
desk agent is in the 
Reseize Timer state

Table 24.19:Agent states (Continued) (Sheet 2 of 3)

Term Voice Email Chat SMS Meaning
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Overriding states in real-time monitors

An overriding state is a state that ‘trumps’ another state as the state that appears in an Agent or Employee 
monitor. The states by order of priority are:
• Ringing
• ACD
• ACD Hold
• Non ACD

System Make 
Busy

If an agent is a 
multimedia agent and is 
logged on to two or more 
media servers 
simultaneously, the 
system sends the agent 
only one incoming 
communication at a time. 
For example, when the 
agent answers a voice 
interaction, the system 
places the agent ID(s) for 
the other media server 
types in System Make 
Busy

Work Timer An agent who is 
completing post-contact 
work, such as paperwork, 
and is unavailable to 
receive interactions of 
that media type

Unknown An agent who has not 
generated any activity 
since Mi Contact Center 
Business was started

Logged Off An agent not currently 
logged in to any queue

Logged In Not 
Present

An agent logged in but 
not present to any of their 
agent groups, and agents 
not present to a media 
type across all groups

Table 24.19:Agent states (Continued) (Sheet 3 of 3)

Term Voice Email Chat SMS Meaning
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• Non ACD Hold
• Outbound
• Outbound Hold
• Work Timer
• Do Not Disturb
• Make Busy
• System Idle
• Idle

Monitoring agents and queues

The real-time monitors in Contact Center Client are automatically updated to reflect current contact center 
activity and device and device group configuration changes. Supervisors can use the following monitors 
to access up-to-the-minute statistics and information to assist in identifying performance issues and 
dealing with such situations immediately as they arise.
You can customize the card design to display information in the monitors to suit your work environment. 
For more information on customizing Contact Center Client monitors, see "Customizing the information 
displayed on position and time monitors".
Contact Center Client real-time monitors and charts are briefly described in the following section. If you 
require a more detailed description of the monitors and charts available with Contact Center Client, see 
"Real-time Monitors".

Workload and monitors

Employee Workload can affect the value displaying in real-time monitors for ACD, Ringing, Hold, and 
Work Timer if employees are handling multiple interactions that are in the same state. If an employee is 
handling multiple interactions at the same time in the same state, the Agent or Employee monitor will 
display the time of the oldest interaction. When the oldest interaction changes its state, the time will 
change to the time of the next oldest interaction.
For example, if an email agent in ACD was handling two emails, one at 5:30 and the other at 1:30, the 
displayed ACD time would be 5:30. If the employee finished handling the oldest email, the time would 
change to 1:30.
For more information on Workload, see "Configuring Workload".

Agent or Employee State by Position monitor

The Agent and Employee State by Position monitors provide real-time information in cells that you can 
arrange to mirror your floor plan, enabling you to view employees by their physical position in your contact 
center. (See the following figures.)

Figure 24.15: Agent or Employee State by Position monitor
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Agent or Employee State by Time monitor

The Agent or Employee State by Time monitors provide real-time agent information under ACD, Idle, Non 
ACD, Unavailable, and Logged Off column headings. The difference between this monitor and the State 
by Position monitor is that the Agent or Employee State by Time monitors list agents in order of the time 
spent in the applicable state. You can specify which columns of agent statistics display and in what order 
they display. For example, you can sort logged off agents by designating the longest logged off agent to 
display first in the list. (See the following figure.)

Figure 24.16: Agent or Employee State by Time monitor
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The following table lists the Agent or Employee State by Time column headings and their associated 
agent states.

Agent State by Time for Queue monitor

The Agent State by Time for Queue monitor is designed specifically for contact centers who use Agent 
Group Presence functionality. This monitor is accessed from the Time menu in Contact Center Client and 
displays all agents configured in a specific queue and agents who are on ACD interactions, Idle, on Non 
ACD voice interactions, unavailable, logged onto the system but not present in the queue being moni-

Table 24.20:Agent State by Time and Employee State by Time column headings

Category Associated agent states

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non ACD includes agents in Non ACD, in Non ACD Hold, 
Outbound agents, and Outbound Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, 
Work Timer, Reseize Timer, and Unknown

Logged in not present includes agents logged in but not present to any 
of their agent groups, and agents not present to a 
media type across all groups

Log Off includes agents in the Logged Off and Offline 
(Ignite, WEB) states
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tored, and logged off. Virtual queue groups are shown under the Virtual queue groups section of this 
monitor and are marked in the title as (virtual).(See the following figure.)

Figure 24.17: Agent State by Time for Queue monitor
 

The following table lists the Agent State by Time for Queue column headings and their associated agent 
states.
Table 24.21:Agent State by Time for Queue column headings  (Sheet 1 of 2)

Category Associated agent states

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non ACD includes agents in Non ACD, in Non ACD Hold, 
Outbound agents, and Outbound Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, 
Work Timer, and Reseize Timer

Logged in not present includes agents logged in but not present to any 
of their agent groups, and agents not present to a 
media type across all groups
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Agent Shift monitor

The Agent Shift monitor provides running daily totals of statistics for individual agents. You can specify 
which columns of statistics display and the order in which they display. (See the following figure.)

Figure 24.18: Agent Shift monitor
 

The following table lists the Agent Shift column headings and their definitions.

Log Off includes agents in the Logged Off, Unknown, and 
Offline (Ignite, WEB) states

Table 24.22:Agent Shift column headings  (Sheet 1 of 4)

Term Abbreviated Name Meaning

Agent State The agent's media type and 
current state

Media Server Media Server The media server to which the 
agent is associated

Agent Shift Name Name The name of the agent being 
monitored

Table 24.21:Agent State by Time for Queue column headings (Continued) (Sheet 2 of 2)

Category Associated agent states
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Agent login ID Agent login ID The login ID of the agent being 
monitored

Extension Number Extn # The extension where the agent 
logged in (voice only)

Logged On Log In The most recent time the agent 
logged in

Last Event Received Last Event Recd The most recent time an agent 
event occurred

Shift Time Shift Time The total elapsed time logged 
for the agent, calculated based 
on the difference between log in 
and last event received

ACD Time ACD Time The duration of ACD 
interactions handled, from 
agent pickup to completion (not 
including hold time)

ACD Hold Time ACD Hold Time The duration of time ACD 
interactions spent on hold

Non ACD Time Non ACD Time The duration of Non ACD 
interactions handled, from 
agent pickup to completion (not 
including hold time) (voice only)

Non ACD Hold Time Non ACD Hold Time The duration of time Non ACD 
interactions spent on hold 
(voice only)

Outbound Time Out Time The duration of time agents 
spent handling outbound calls 
(voice only)

Outbound Hold Time Out Hold Time The duration of time outbound 
calls spent on hold, for agents 
(voice only)

Do Not Disturb Time DND Time The duration of time the agent 
entered the Do Not Disturb 
State

Make Busy Time MKB Time The number of times the agent 
entered the Make Busy state

Table 24.22:Agent Shift column headings (Continued) (Sheet 2 of 4)

Term Abbreviated Name Meaning
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Wrap Up Time Wrap Up Time The duration of time where 
Wrap Up Time was the 
overriding state for the agent. 
Wrap up time does not include 
any time spent making or taking 
interactions during the wrap up 
timer.

Do Not Disturb Count DND Cnt The number of times the agent 
entered the Do Not Disturb state

Make Busy Count MKB Cnt The number of times the agent 
entered the Make Busy state

ACD Count ACD Cnt The number of ACD interactions 
handled by the agent

Short ACD Count Shrt ACD Cnt The number of ACD interactions 
handled by the agent where the 
handle time was less than the 
Short Handle parameter

Non ACD Count Non ACD Cnt The number of Non ACD 
interactions handled by the 
agent (voice only)

Hold ACD Count Hold ACD Cnt The number of times ACD 
interactions were placed on 
hold

Non ACD Hold Count Non ACD Hold Cnt The number of times Non ACD 
interactions were placed on 
hold (voice only)

Outbound Count Out Cnt The number of outbound calls 
made by the agent (voice only)

Outbound Hold Count Out Hold Cnt The number of times outbound 
calls were placed on hold (voice 
only)

Contacts Per Hour Contacts Per Hour The total ACD interaction count 
minus the ACD short handle 
count, divided by the shift time 
for the agent

On Failover On failover Indicates whether the primary 
media server is offline and has 
failed over to the secondary 
media server (voice only)

Table 24.22:Agent Shift column headings (Continued) (Sheet 3 of 4)

Term Abbreviated Name Meaning
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Queue by Period monitor

The Queue by Period monitor collates queue statistics by 15-minute intervals over a 24-hour period. The 
monitor refreshes each time there is a change in a statistic and at 15-minute intervals. The current 
15-minute interval always displays at the top of the monitor. (See the following figure.)

Figure 24.19: Queue by Period monitor

Agent Unavailable Percent Agt Unavail % The percentage of shift time for 
which the agent was 
unavailable to receive 
interactions

Logged In Not Present Time Logged In Not Present Time The duration of time the agent 
was logged into but not present 
to any of their agent groups, 
and the duration of time the 
agent was not present in a 
media type across all groups

Average Handle Avg Hndl The average amount of time the 
agent spent handling ACD 
interactions (ACD Time divided 
by ACD Count, excluding ACD 
Hold Time).

Occupancy Occp The duration of time the agent 
spent processing interactions, 
including ringing time

Table 24.22:Agent Shift column headings (Continued) (Sheet 4 of 4)

Term Abbreviated Name Meaning
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The following table lists the Queue by Period column headings and their definitions.
Table 24.23:Queue by Period column headings  (Sheet 1 of 4)

Term Abbreviated Name Meaning

Interval time Interval The 15 minute interval of time

Offered Offr The total number of interactions 
offered to the queue during the 
15-minute interval

Handled Hndl The total number of interactions 
answered by agents during the 
15-minute interval
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Short Abandoned Shrt Abn During the 15-minute interval, 
the total number of interactions 
abandoned before the short 
abandon time configured in 
YourSite

Abandoned Abn The total number of interactions 
abandoned during the 
15-minute interval before being 
answered by members

Interflowed Intrfl The total number of interactions 
interflowed during the 
15-minute interval

Requeued Re Q The total number of interactions 
re-queued during the 15-minute 
interval
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

% Handled by 1-4 % Hndl by 1-4 A count of all of the interactions 
answered by the first, second, 
third, and fourth agent groups 
during the 15-minute interval
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Average Time to Handle Avg Time Hndl The average number of minutes 
interactions waited to be taken 
out of queue (answered or 
picked) by an members during 
the 15-minute interval

Average Time to Abandon Avg Time Abn The average number of minutes 
interactions waited during the 
15-minute interval before they 
abandoned their interactions

Table 24.23:Queue by Period column headings (Continued) (Sheet 2 of 4)

Term Abbreviated Name Meaning
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Average Time to Interflow Avg Time Intrfl The average number of minutes 
interactions waited during the 
15-minute interval before being 
interflowed

Total Conversation Time Ttl Conv Time The total time members spent 
communicating (talking, 
chatting, or replying) with 
interactions during the 
15-minute interval

Average Conversation Time Avg Conv time The average time members 
spent communicating with 
interactions during the 
15-minute interval

Service Level % Level Scv Lvl % Tday During the 15-minute interval, 
the percentage of interactions 
answered within the Service 
Level Time specified for the 
queue

% Handled % Hndl During the 15-minute interval, 
the percentage of interactions 
answered compared to the total 
number of interactions offered 
to the ACD queue for the day
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Wrap Up Wrap Up The total time the agent spent in 
the Work Timer state during the 
15-minute interval
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Table 24.23:Queue by Period column headings (Continued) (Sheet 3 of 4)

Term Abbreviated Name Meaning
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Queue Now and Queue Group Now monitors

The Queue Now monitor enables supervisors to view queue statistics in real-time, as well as expand indi-
vidual queues in the monitor to view statistics on each queue’s associated member agents or extensions. 
When you expand the Queue Now monitor to display the Name column, the monitor also displays 
member presence in the queue. Presence is indicated by a colored star in the Present column. A green 
star indicates the member is present in the queue. A gray star and gray row indicate the agent is not 
present in the queue. (See the following figure.)
NOTE: 
• Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and Ignite 

are not included in queue Handled, Completed, and Offered counts.
• Prior to version 7.1, Queue Now monitors displayed queue’s member agent groups with agent group 

statistics. As of version 7.1, this functionality has been removed. Instead, queue members are grouped 
by agent group.

Figure 24.20: Queue Now monitor

Make Busy Make Busy The total time the agent spend 
in the Make Busy state during 
the 15-minute interval
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Occupancy Occp The total time the agent spent in 
an occupied state during the 
15-minute interval (occupied 
state excludes idle time)

# Handled by 1-4 # Hndl by 1-4 The number of interactions 
answered by the first, second, 
third, and fourth agent groups 
during the 15-minute interval
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Table 24.23:Queue by Period column headings (Continued) (Sheet 4 of 4)

Term Abbreviated Name Meaning
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The Queue Group Now monitor enables supervisors to view aggregated statistics for Reporting, Virtual, 
and Unified queue groups in real-time, as well as expand individual queue groups in the monitor to view 
statistics for the queue group’s associated queues. (See the following figure.)
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Figure 24.21: Queue Group Now monitor

The following table lists the real-time and over-the-business-day Queue Now and Queue Group Now 
queue and queue group statistics and their definitions.
NOTE: Some statistics in the Queue Now monitor display in the Queue Group Now monitor as member 
statistics.

Table 24.24:Queue Now and Queue Group Now queue statistic column headings  (Sheet 1 of 10)

Term Abbreviated Name Meaning

Queue Status Queue Status The current status of the 
queue—either Open, Closed, or 
Do Not Disturb (voice only)

Queue Group Number Queue Group # The queue group reporting 
number (Queue Group Now 
only)
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Media Server Media Server The queue’s media server

Queue Number Queue # The queue's reporting number

Queue Name Name The queue or queue group 
name

Contacts Waiting Contacts Wtg The current number of contacts 
in queue waiting for an member 
to become available, including 
those listening to silence, 
music, or recorded 
announcements

Longest Waiting Long Wtg The current duration, in minutes 
and seconds, of the contact 
waiting the longest in queue or 
queue group

Available (Queue Now)
Agents Available (Queue Group 
Now)

Avail (Queue Now)
Agts Avail (Queue Group Now)

The total number of members 
logged in and not in Do Not 
Disturb, Make Busy, Work 
Timer, Ringing, Reseize Timer, 
Unknown, and Offline (Ignite, 
WEB)

ACD ACD The current number of 
members handling ACD 
interactions

Idle Idle The current number of 
members logged on and ready 
to receive interactions

Non ACD Non ACD The current number of 
members handling Non ACD 
calls (voice only)

Outbound Out The current number of 
members on outgoing calls 
(voice only)

Unavailable Unavail The current number of agents in 
Do Not Disturb, Make Busy, 
Work Timer, or Unknown

Offered Offr The total number of interactions 
offered to the queue / queue 
group

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 2 of 

Term Abbreviated Name Meaning
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Handled Hndl The total number of ACD 
interactions handled by 
members

Abandoned Abn The total number of interactions 
abandoned before being 
answered by members
NOTE: Abandoned does not peg 
short abandons as abandoned 
interactions while the Aban-
doned column in the Interactive 
Visual Queue monitor displays 
all abandoned interactions. 
Because of this difference, you 
may notice discrepancies 
between the abandoned call 
information in these two moni-
tors.

Interflowed Intrfl The total number of ACD 
interactions interflowed. 
Interflow is a mechanism that 
directs an interaction waiting in 
queue to another answer point.

Requeued Re Q The total number of ACD 
interactions requeued
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Average Time to Handle Avg Time Hndl The average time it takes for the 
interaction to be taken out of 
queue (answered or picked) by 
a member

Average Time to Abandon Avg Time Abn The current average amount of 
time customers wait in queue 
before abandoning interactions

Average ConversationTime Avg Conv Time The current average time 
members spent communicating 
(talking, chatting, or replying) 
with contacts

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 3 of 

Term Abbreviated Name Meaning
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Service Level % Svc Lvl % For a queue, this is the 
percentage of interactions 
handled within the queue’s 
Service Level Time value over 
the day.
For a queue group, this is the 
lowest percentage of 
interactions handled within the 
queue’s Service Level Time 
value over the day across all 
queues.

Handled % % Hndl For a queue, this is the 
percentage of interactions 
handled compared to the total 
number of interactions offered 
to the queue for the day.
For a queue group, this is the 
lowest percentage of 
interactions handled compared 
to the total number of 
interactions offered to the 
queue for the day across all 
queues.

% Handled by 1-4 % Hndl by 1-4 For a queue, this is the 
percentage of all of the 
interactions answered by the 
first, second, third, and fourth 
agent groups.
For a queue group, this is the 
highest percentage of all of the 
interactions answered by the 
first, second, third, and fourth 
agent groups.
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Total Conversation Time Ttl Conv Time The current total time members 
spent communicating (talking, 
chatting, or replying) with 
contacts

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 4 of 

Term Abbreviated Name Meaning
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Total Queue Unavailable Ttl Q Unavail The total number of times 
during the day that interactions 
are rerouted because the queue 
is in Do Not Disturb or has no 
members logged in

Current Queue Unavailable Curr Q Unavail The current number of 
interactions are rerouted 
because no members are 
logged in or the queue is in Do 
Not Disturb. Once the queue 
becomes available, this value 
resets to 0.

Offered Last Hour Offr Last Hour The total number of interactions 
offered to the queue during the 
last hour of business

Time to Handle Last Hour Time Hndl Last Hour The time interactions waited in 
queue during the last hour of 
business before being handled 
by an agent

% Handled Last Hour % Hndl Last Hour For a queue, this is the 
percentage of interactions 
handled in the last hour of 
business, compared to the total 
number of interactions offered 
to the ACD queue for the day.
For a queue group, this is the 
lowest percentage of 
interactions handled in the last 
hour of business, compared to 
the total number of interactions 
offered to the ACD queue for 
the day.

Service Level % Last Hour Svc Lvl % Last Hour For a queue, this is the 
percentage of interactions 
answered or picked within your 
Service Level Time value in the 
last hour.
For a queue group, this is the 
lowest percentage of 
interactions answered or picked 
within your Service Level Time 
value in the last hour.

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 5 of 

Term Abbreviated Name Meaning
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Handled Last Hour Hndl Last Hour The total number of interactions 
handled by members during the 
last hour of business

Abandoned Last Hour Abn Last Hour The total number of interactions 
abandoned during the last hour 
of business

Interflowed Last Hour Intrfl Last Hour The total number of interactions 
interflowed during the last hour 
of business. Interflow is a 
mechanism that directs an 
contacts waiting in queue to 
another answer point.

Unavailable Last Hour Unavail Last Hour The total number of times, in the 
last hour of business, 
interactions were rerouted 
because the queue they tried to 
access was in Do Not Disturb or 
had no members logged in
See Current Queue 
Unavailable.

Average Handling Time Last 
Hour

Avg Hndl Last Hour The average duration of 
interactions from agent pick up 
to client hang up (including hold 
time) during the last hour of 
business

Offered Last 15 Minutes Offr Last 15 Min The total number of interactions 
offered to the queue in the last 
15 minutes of business

Time to Handle Last 15 Minutes Time Hndl Last 15 Min The time interactions waited in 
queue during the last 15 
minutes of business before 
being handled by a member

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 6 of 

Term Abbreviated Name Meaning
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% Handled Last 15 Minutes % Hndl Last 15 Min For a queue, the percentage of 
interactions answered in the last 
15 minutes of business, 
compared to the total number of 
interactions offered to the ACD 
queue for the day
For a queue group, the lowest 
percentage of interactions 
answered in the last 15 minutes 
of business, compared to the 
total number of interactions 
offered to the ACD queue for 
the day.

Service Level % Last 15 
Minutes

Svc Lvl % Last 15 Min For a queue, this is the 
percentage of interactions 
answered or picked within your 
Service Level Time value in the 
last 15 minutes of business.
For a queue group, this is the 
lowest percentage of 
interactions answered or picked 
within your Service Level Time 
value in the last 15 minutes of 
business.

Handled Last 15 Minutes Hndl Last 15 Min The total number of interactions 
handled by members during the 
last 15 minutes of business

Abandoned Last 15 Minutes Abn Last 15 Min The total number of interactions 
abandoned during the last 15 
minutes of business

Interflowed Last 15 Minutes Intrfl Last 15 Min The total number of interactions 
interflowed during the last 15 
minutes of business. Interflow is 
a mechanism that directs an 
interaction waiting in queue to 
another answer point.

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 7 of 

Term Abbreviated Name Meaning



950

SUPERVISORS - MANAGING A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Unavailable Last 15 Minutes Unavail Last 15 Min The total number of times, in the 
last 15 minutes of business, 
contacts were rerouted because 
the queue they tried to access 
was in Do Not Disturb or had no 
members logged in
See Current Queue 
Unavailable.

Average Handling Time Last 15 
Minutes

Avg Hndl Last 15 Min The average handling duration 
of interactions from interaction 
pickup to interaction 
completion, including hold time, 
during the last 15 minutes of 
business

% Abandoned % Abn For a queue, this is the 
percentage of interactions that 
were abandoned (% 
Abandoned = Interactions 
Abandoned ÷ Interaction 
Offered)
For a queue group, this is the 
highest percentage of 
interactions that were 
abandoned (% Abandoned = 
Interactions Abandoned ÷ 
Interactions Offered)

% Abandoned Last Hour % Abn Last Hour For a queue, this is the 
percentage of interactions that 
were abandoned in the last hour 
of business
For a queue group, this is the 
highest percentage of 
interactions that were 
abandoned in the last hour of 
business

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 8 of 

Term Abbreviated Name Meaning
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% Abandoned Last 15 Minutes % Abn Last 15 Min For a queue, this is the 
percentage of interactions that 
were abandoned in the last 15 
minutes of business
For a queue group, this is the 
highest percentage of 
interactions that were 
abandoned in the last 15 
minutes of business

Wrap Up Wrap Up The total time that agents spent 
in the Work Timer state
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Make Busy Make Busy The total time that agents spent 
in the Make Busy state
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Occupancy Occp The total time that members 
spent in an occupied state 
(states other than Idle)

# Handled by 1-4 # Hndl by 1-4 The number of interactions 
answered by the first, second, 
third, and fourth agent groups
NOTE: This statistic displays 
information for ACD paths and 
multimedia queues only. Statis-
tics for Ring Groups display as 
'0'.

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 9 of 

Term Abbreviated Name Meaning
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The following table lists the real-time and over-the-business-day Queue Now and Queue Group Now 
member statistics and their definitions.

Logged Out Logged out The number of agents 
associated with the queue but 
not logged in to the system. 
(Queue Now only)
NOTE: For Ring Groups, this 
statistic displays either the 
number of extensions out of 
service or hot desk users logged 
out.

Logged In Not Present Not Present The number of agents that are 
logged in, but not present in the 
queue.

Table 24.25:Queue Now and Queue Group Now member statistic column headings  (Sheet 1 of 4)

Term Meaning

State The queue member's agent or extension state
For a list of agent states, see "Employee and 
Agent state indicators".

Name The name of the member being monitored. The 
icon beside the name indicates the media type 
the member handles

Present Indicates whether the member is present in the 
queue
Presence is indicated by a colored star. A green 
star indicates the agent or extension is present in 
the queue. A gray star and gray row indicates the 
agent is not present in the queue.

Media Server The media server to which the member is 
associated

Reporting The reporting number of the member being 
monitored

Extn # The extension where the member logged in 
(voice only)

Log In The most recent time the member logged in
NOTE: This statistic displays information for ACD 
path and multimedia queue members only and is 
not calculated for Ring Group members.

Table 24.24:Queue Now and Queue Group Now queue statistic column headings (Continued) (Sheet 10 

Term Abbreviated Name Meaning
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Last Event Recd The most recent time a member event occurred

Shift Time The total elapsed time logged for the member, 
calculated based on the difference between log in 
and last event received 
NOTE: This statistic displays information for ACD 
paths and multimedia queues only. Statistics for 
Ring Groups display as '0'.

DND Time The duration of time where Do Not Disturb was 
the overriding state for the member

MKB Time The duration of time where Make Busy was the 
overriding state for the member
NOTE: This statistic displays information for ACD 
paths and multimedia queues only. Statistics for 
Ring Groups display as '0'.

Wrap Up Time The duration of time where Wrap Up Time was 
the overriding state for the member. Wrap up time 
does not include any time spent making or taking 
interactions during the wrap up timer.
NOTE: This statistic displays information for ACD 
paths and multimedia queues only. Statistics for 
Ring Groups display as '0'.

ACD Time The duration of ACD interactions handled, from 
member pickup to completion (not including hold 
time)

Hold ACD Time The duration of time ACD interactions spent on 
hold

Non ACD Time The duration of Non ACD interactions handled, 
from member pickup to completion (not including 
hold time) (voice only)

Hold Non ACD Time The duration of time Non ACD interactions spent 
on hold (voice only)

Out Time The duration of time members spent handling 
outbound calls (voice only)

Out Hold Time The duration of time outbound calls spent on 
hold, for agents (voice only)

DND Cnt The number of times the member entered the Do 
Not Disturb state

Table 24.25:Queue Now and Queue Group Now member statistic column headings (Continued) (Sheet 2 

Term Meaning
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MKB Cnt The number of times the member entered the 
Make Busy state
NOTE: This statistic displays information for ACD 
paths and multimedia queues only. Statistics for 
Ring Groups display as '0'.

ACD Cnt The number of ACD interactions handled by the 
member

Shrt ACD Cnt The number of ACD interactions handled by the 
member where the handle time was less than the 
Short Handle parameter

Hold ACD Cnt The number of times ACD interactions were 
placed on hold

Non ACD Cnt The number of Non ACD interactions handled by 
the member (voice only)

Hold Non ACD Cnt The number of times Non ACD interactions were 
placed on hold (voice only)

Out Cnt The number of outbound calls made by the 
member (voice only)

Out Hold Cnt The number of times outbound calls were placed 
on hold (voice only)

Avg Hndl The average amount of time the members spent 
handling ACD interactions (ACD Time divided by 
ACD Count, excluding ACD Hold Time).

Agt Grp The agent group to which the agent belongs
NOTE: This statistic displays information for ACD 
paths and multimedia queues only. Statistics for 
Ring Groups display as '0'.

Occupancy The duration of time the member spent 
processing interactions

Contacts per Hour The total ACD interaction count minus the ACD 
short handle count, divided by the shift time for 
the member

On failover Indicates whether the primary media server is 
offline and has failed over to the secondary media 
server (voice only)

Table 24.25:Queue Now and Queue Group Now member statistic column headings (Continued) (Sheet 3 

Term Meaning
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Interactive Visual Queue monitor

The Interactive Visual Queue monitor enables supervisors to monitor and control traffic in contact center 
queues. The Interactive Visual Queue monitor is described in detail in "Interacting with customer interac-
tions to improve service levels".
Interactive Visual Queue works in conjunction with Contact Center Client. Before you use Interactive 
Visual Queue, ensure your configuration in YourSite Explorer mirrors that of your telephone system.
NOTE: In order to use Interactive Visual Queue, you must enable all HCI options on Class of Service 
Assignment form 1 (COS 1).
Configuring options in YourSite Explorer
In YourSite Explorer, for each queue you want to monitor, you must configure the priority level and the 
method for handling interflowed contacts.
NOTE: If the telephone system settings and Interactive Visual Queue settings do not match, Interactive 
Visual Queue will not display the correct voice contact activity. For example, if Queue 1 is set to a priority 
of 10 on the telephone system and a priority of 20 in YourSite Configuration, Interactive Visual Queue will 
display voice contacts in Queue 1 as priority 20. However, the actual queue will handle the voice contacts 
as priority 10.

Queue Now and Queue Group Now charts

The Queue Now and Queue Group Now charts offer visual representation of Queue Now and Queue 
Group Now real-time statistics, grouped by the type of statistics displayed. Three different series of statis-
tics are available to view in charts: 
• Integer—displays numerically-based real-time statistics

Unavail % The percentage of time for the shift that the 
member was in Do Not Disturb, Make Busy, and 
Work Timer states

Not Present Time The duration of time the member was logged into 
but not present in an agent group or Ring Group

External handle time The duration of time the member spent handling 
external calls (voice only)

External inbound cnt The number of incoming external calls (voice 
only)
NOTE: This statistic displays information for ACD 
paths and multimedia queues only. Statistics for 
Ring Groups display as '0'.

External outbound cnt The number of outgoing external calls (voice 
only)
NOTE: This statistic displays information for ACD 
paths and multimedia queues only. Statistics for 
Ring Groups display as '0'.

Table 24.25:Queue Now and Queue Group Now member statistic column headings (Continued) (Sheet 4 

Term Meaning
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• Percentage—displays percentage-based statistics
• Time—displays time-based statistics

Users can specify which statistics display in their charts. The following figure shows a Queue Now Integer 
Chart
NOTE: Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and 
Ignite are not included in queue Handled, Completed, and Offered counts.

Figure 24.22: Queue Now (Integer chart)
 

The Integer chart shows: 
• Handled (Default)
• Abandoned (Default)
• Interflowed (Default)
• Calls Waiting
• Agents Available
• ACD
• Idle
• Non ACD
• Outbound
• Unavailable
• Offered
• Requeue
• Total Hour
• Interflowed Last Hour
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• Unavailable Last Hour
• Offered Last 15 Minutes
• Handled Last 15 Minutes
• Abandoned Last 15 Minutes
• Interflowed Last 15 Minutes
• Unavailable Last 15 Minutes
• Logged out
• Logged in not present
• # Handled by 1-4

The Percentage chart shows, by default: 
• Service Level %
• Handled %
• % Handled by 1-4
• % Handled Last Hour
• Service Level % last Hour
• % Handled Last 15 Minutes
• Service Level % Last 15 Minutes
• %Abandoned
• %Abandoned Last Hour
• %Abandoned Last 15 Minutes.

Time charts show, by default: 
• Longest Waiting
• Average Time to Handle
• Average Time to Abandon Minutes
• Average Talk Time
• Ttl Talk Time
• Time to Handle Last Hour
• Average Time to Handle Last Hour
• Hdnl Last 15 Min
• Average Handling Time Last 15 Minutes
• Rmt Long Wtg
• Total Work Timer minutes
• Total make busy minutes
• Total occupancy minutes

For descriptions of the statistics, see "Queue Now and Queue Group Now monitors".
NOTE: The following statistics are for ACD path voice queues and multimedia queues only and will not 
display information for Ring Groups:
• Requeue
• # Handled by 1, 2, 3, 4
• % Handled by 1, 2, 3, 4
• Total Work Timer Minutes
• Total Make Busy minutes
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Queue Performance by Period and Queue Group Performance by Period charts

The Queue Performance by Period and Queue Group Performance by Period charts offer visual repre-
sentations of Queue and Queue Group Performance by Period statistics, grouped by the type of statistic 
displayed. Three different series of statistics are available to view in charts: 
• Integer—displays numerically-based real-time statistics
• Percentage—displays percentage-based statistics
• Time—displays time-based statistics

The following figure displays a Queue Performance by Period chart displaying the default statistics of the 
Integer series.
NOTE: Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and 
Ignite are not included in queue Handled, Completed, and Offered counts.

Figure 24.23: Queue Performance by Period chart
 

The Integer series shows the following statistics across 15 minute intervals for queues or queue groups: 
• Handled (Default)
• Interflowed (Default)
• Offered
• Short Abandoned
• Abandoned
• Requeue
• # Handled by 1-4
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The Percentage series shows the following statistics across 15 minute intervals for queues or queue 
groups, by default: 
• % Handled by 1-4
• Service Level % Today
• % Handled

The Time series show the following statistics across 15 minute intervals for queues or queue groups, by 
default: 
• Average Time to Handle
• Average Time to Abandon
• Average Time to Interflow
• Ttl Talk Time
• Average Talk Time
• Total Work Timer minutes
• Total make busy minutes
• Total occupancy minutes

For more information for the definitions of these statistics, see "Queue by Period monitor".
NOTE: The following statistics are for ACD path voice queues and multimedia queues only and will not 
display information for Ring Groups:
• Requeue
• # Handled by 1, 2, 3, 4
• % Handled by 1, 2, 3, 4
• Total Work Timer Minutes
• Total make busy minutes

Interacting with agent presence to improve service levels

Interactive Contact Center is a feature that enables supervisors to control the availability of employees 
and their agents.
Using Interactive Contact Center, supervisors can 
• Log employees and their agents in and out of their voice and multimedia applications
• Have agents join or leave their agent groups
• Place employees in and remove them from Make Busy
• Place employees in and remove them from Do Not Disturb
• Cancel the employee Work Timer
• Cancel the employee Reseize Timer

Using Interactive Contact Center with Contact Center Client, you can control agents on the following 
monitors: Agent and Employee State by Position, Agent and Employee State by Time, and Agent Shift.
Using Interactive Contact Center with Ignite (WEB), you can control agents on the following monitors: 
Employee State and Agent State.
Individual supervisors can be restricted through security roles from managing particular monitors and 
devices. For more information, consult your System Administrator.
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Agent and Agent Group Presence

Employees can be enabled to handle voice, email, chat, SMS, or open media media. When an employee 
is enabled to handle a media type, YourSite Explorer automatically creates a corresponding agent. These 
multimedia agents can be assigned to agent groups, which are in turn are associated to queues.
When agent groups are created, an employee’s agents are assigned a default group presence, either 
Present or Absent. If an employee's default presence is Absent will be set in the Logged In Not Present 
agent state when they log in. To handle that media type, the employee has to manually change their agent 
presence in Ignite or Contact Center Client. Employees whose agents default presence is Present will be 
set in the Idle agent state when they log in. For details about agent states, see "Employee and Agent state 
indicators".

Controlling employees and agents in real-time monitors

Interactive Contact Center enables supervisors, depending on their security settings, to control 
employees via the Contact Center Client and Ignite (WEB) employee and agent monitors. For example, 
if a supervisor notices a dramatic increase in the number of incoming emails in the Sales email queue, 
they can, using the agent monitor, remove the employee’s chat agent from their agent group in the Sales 
chat queue, ensuring that the employee can focus entirely on incoming emails.
Depending on whether an employee or an agent monitor is open, Contact Center Client displays two tabs 
in the Contact Center Client ribbon for controlling employees or their agents. Supervisors can perform 
actions using either a right-click and select method within the monitor or by accessing the action menu in 
the Employee, Agent, or Monitor Control tab views. If they have Context Sensitivity enabled for monitors, 
the Agent or Employee tab automatically becomes the active tab when an employee or agent is selected. 
If an empty cell is selected, the Monitor Control tab becomes the active tab. The following tabs are 
displayed with employee or agent real-time monitors: 
• Employee or Agent Control—Employee Control gives you control over individual employees and 

their agents. Employee monitor controls offer supervisors the greatest flexibility in controlling an 
employee and all of their agents. Supervisors can manage an employee`s availability, and all of an 
employee`s agents, or manage specific agents belonging to individual employees. (See the following 
figure.)

• Monitor Control—Monitor Control gives you control over all of the employees or agents on a monitor, 
enabling simultaneous management of presence for all employees or agents. (See the following 
figures.)

NOTE: Context sensitivity and monitor control are not supported with Ignite (WEB). You can only alter the 
state for one employee or agent at a time.

Figure 24.24: Employee State by Position - Employee Control tab options
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Supervisors can control employees on the following Contact Center Client monitors: 
• Employee State by Position
• Employee State by Time

Supervisors can control employees on the following Ignite (WEB) monitor: 
• Employee State
Agent Control gives you control over individual agents in an agent monitor. Agent monitor controls enable 
supervisors a more targeted look at specific aspects of an employee`s presence, enabling supervisors to 
limit their influence to specific agents or media types. Since agent monitors enable supervisors to view 
agents by agent group, Agent Control enables supervisors to better manage their agent groups. (See the 
following figure.)



962

SUPERVISORS - MANAGING A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Figure 24.25: Agent State by Position - Agent Control tab options

Supervisors can control agents on the following Contact Center Client monitors: 
• Agent State by Position
• Agent State by Time
• Agent State by Time for Queue
• Agent Shift

Supervisors can control agents on the following Ignite (WEB) monitor: 
• Agent State
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Figure 24.26: Employee State by Position - Monitor Control tab options
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Figure 24.27: Agent State by Position - Monitor Control tab options

Logging on an agent - Contact Center Client
NOTE: 
• An ACD Hot Desking Agent must enter an extension number each time the agents logs on to the ACD 

routing system using Interactive Contact Center. The agent cannot rely on the extension number last 
used when logging on. This is because the ACD data stream unifies the agent ID and the extension. 
After a Hot Desking Agent logs on or off of the ACD routing system using Interactive Contact Center, 
sometimes the Interactive Contact Center agent controls are not available to the agent for two to five 
minutes.

• You will be unable to log on an agent to the system if there are no available user licenses.
• If your contact center participates in the use of PINs, supervisors with the correct Class of Service do 

not require an agent’s PIN to interactively log in a Hot Desking Agent.
• Depending on security roles and telephone switch settings, employees who are licensed as Advanced 

Supervisor or System Administrator may not be prompted to enter a PIN when logging into Interactive 
Contact Center, Softphone, or PhoneSet Manager.

• If a Hot Desking Agent logs into an extension that serves as the overflow point for a Ring Group, calls 
to that Ring Group will not be offered to the extension and will remain queued or ringing until aban-
doned or answered.

• Hot desking users logging into a Ring Group extension must also be a member of the Ring Group to 
ensure accurate reporting.
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You log employee voice agents in and out in either an open Employee or Agent Monitor in Contact Center 
Client. Multimedia agents are not logged in with voice agents.
To log in an agent in an open Employee monitor 
• Right-click the cell of an employee and click Employee control > Log in > voice agent. Alternatively, 

select the employee cell in an open monitor, click Log in from the Employee Control tab on the 
Contact Center Client ribbon, and select the voice agent. 

NOTE: When you log in an employee’s voice agent, you must enter the extension for the agent. See 
the procedure below.

To log in an agent by extension in an open Employee monitor 
1. Right-click the cell of an employee and click Employee control > Log in > By extension.
2. If the employee has multiple voice agents, select the agent to log in from the drop-down list.

3. Type the Agent’s extension.

4. Click OK.

To log in an agent in an open Agent monitor 
• Right-click the cell of a voice agent who is not logged into and click Agent Control > Log in > voice 

agent. Alternatively, select the agent cell in an open monitor and click Log in from the Contact Center 
Client ribbon. 

NOTE: When you log in a voice agent, you must enter the extension for the agent. See the procedure 
below.

To log in an agent by extension in an open Agent monitor 
1. Right-click the cell of a voice agent and click Agent control > Log in > By extension.
2. If the employee has multiple voice agents, select the agent to log in from the drop-down list.

3. Type the Agent’s extension.

4. Click OK.

Logging off an agent - Contact Center Client
You can log off an employee from all media in an Employee monitor or Agent monitor. Logging off an 
agent logs off all of the employee’s voice agents and sets the employee’s multimedia agents to Absent in 
all their agent groups. If the employee is logged into their soft phone in Contact Center Client, they will 
also be logged out of the soft phone.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To log off all of an employee's agents in an open Employee monitor 
• Right-click the cell of an employee and click Employee control > Log off. Alternatively, select the 

employee cell in an open monitor and click Log Off from the Employee Control tab on the Contact 
Center Client ribbon.

To log off an agent in an open Agent monitor
NOTE: Logging off an employee's agent logs off all of the employee's agents simultaneously. 
• Right-click the cell of an agent and click Agent control > Log off. Alternatively, select the agent cell 

in an open monitor and click Log Off from the Agent Control tab on the Contact Center Client ribbon.
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To log off all employees' agents in an open Employee monitor 
1. Right-click the monitor and click Monitor control > Log off. 

Alternatively, click the Monitor Control tab in the Contact Center Client ribbon and select Log Off.
2. Click Yes.

To log off all agents in an open Agent monitor 
1. Right-click the monitor and click Monitor control > Log off. 

Alternatively, click the Monitor Control tab in the Contact Center Client ribbon and select Log Off.
2. Click Yes.

Logging on an agent - Ignite (WEB)
When you log on an agent in Ignite (WEB), you make them available to receive voice interactions.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To log on a voice agent 
1. In the monitor, select the agent you want to log on.
2. Click State > Available.

3. Enter the agent’s extension and PIN (if enabled) and click Login. 

NOTE: This step is not required if the agent is set to automatically log in when the ‘Available’ state is 
selected.

Logging off an agent - Ignite (WEB)
When you log off an agent in Ignite (WEB), you make them unavailable to receive all media interactions, 
including voice, email, chat, SMS, and open media.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To log off an agent 
1. In the monitor, select the agent you want to log off.
2. Click State > Offline.

Joining and leaving agent groups - Contact Center Client
After logging into Contact Center Client, agents can use Interactive Contact Center to control their pres-
ence status in agent groups. Optionally, supervisors can use Interactive Contact Center to control the 
presence status of agents in specific agent groups.
NOTE: 
• An agent's ACD hot desk line remains in service while they are logged in as an ACD hot desk user 

even if they are not present in any ACD groups and not receiving ACD calls.
To join an agent to or have an agent leave an agent group in an open Employee monitor 
1. Right-click the cell of an employee and click Employee control > Join/Leave Agent Group > 

[Agent]. 
Alternatively, select the cell of an employee and in the Employee Control tab of the Contact Center 
Client ribbon, click Join/Leave agent group > [Agent].

2. Select the agent group(s) to which you want the employee’s agent(s) to join or deselect the agent 
group(s) to have the employee’s agent(s) leave the agent groups.

3. Click OK.
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To join an agent to or have an agent leave an agent group in an open Agent monitor 
1. Right-click the cell of an agent who is logged on and click Agent control > Join/Leave Agent Group. 

Alternatively, select the cell of an agent and click Join/Leave Agent Group from the Agent Control 
tab in the Contact Center Client ribbon.

2. Select the agent group(s) to which you want the agent(s) to join or deselect the agent group(s) to 
which you want the agent(s) to leave.

3. Click OK.

Joining and leaving agent groups - Ignite (WEB)
After signing into Ignite (WEB) and logging into their phone, agents can use interactive Contact Center to 
control their presence in agent groups. Optionally, supervisors can use Interactive Contact Center to 
control the presence status of agents in specific agent groups from within the Agent and Employee State 
monitors in Ignite (WEB).
The following procedures take place in either an Agent State or Employee State monitor in Ignite (WEB).
To join an agent to an agent group 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. Hover over the agent group's avatar and select Join All.

4. Click Update.

To remove an agent from an agent group 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. Hover over the agent group’s avatar and select Leave All.

4. Click Update.

To join an agent to or remove an agent from all agent groups 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. To join an agent to all agent groups, click Join All > Update.

4. To remove an agent from all agent groups, click Leave All > Update.

To make an agent available or unavailable to answer interactions of a specific media type 
1. In the monitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.

3. To become available to answer interactions of a specific media type, click the media icon in the agent 
group so the icon displays in blue.

4. To become unavailable to answer interactions of a specific media type, click the media icon in the 
agent group so the icon displays in grey.

5. Click Update.

Placing employees in Make Busy - Contact Center Client
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NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
Placing employees into Make Busy places both employees and all of their agents into Make Busy.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To place an employee in an open Employee monitor in Make Busy 
• Right-click the cell of an employee and click Employee control > Set Make Busy > reason code. 

Alternatively, select an empty cell in an open monitor and click Set Employee Make Busy > reason 
code from the Employee Control tab in the Contact Center Client ribbon.

To place all employees in an open Employee monitor in Make Busy 
1. Right-click the monitor and click Monitor control > Set Make Busy > reason code. Alternatively, 

select an empty cell in an open monitor and click Set Make Busy > reason code from the Monitor 
Control tab in the Contact Center Client ribbon.

2. Click Yes.

To place an employee in an open Agent monitor in Make Busy 
• Right-click the cell of an agent and click Agent control > Set Employee Make Busy > reason code. 

Alternatively, select the agent cell in an open monitor and click Set Employee Make Busy > reason 
code from the Agent Control tab in the Contact Center Client ribbon.

To place all employees in an open Agent monitor in Make Busy 
1. Right-click the monitor and click Monitor control > Set Employee Make Busy > reason code. Alter-

natively, select an empty cell in an open monitor and click Set Make Busy > reason code from the 
Monitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

Removing employees from Make Busy - Contact Center Client
Removing employees from Make Busy removes both employees and all of their agents from Make Busy.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To remove an employee in an open Employee monitor from Make Busy 
• Right-click the cell of an employee whose agents are in Make Busy and click Employee control > 

Remove Make Busy. Alternatively, select an empty cell in an open monitor and click Remove Make 
Busy from the Employee Control tab in the Contact Center Client ribbon.

To remove all employees in an open Employee monitor from Make Busy 
1. Right-click the cell of an employee who is in Make Busy and click Monitor control > Remove Make 

Busy. Alternatively, select an empty cell in an open monitor and click Remove Make Busy from the 
Monitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

To remove an employee in an open Agent monitor from Make Busy 
• Right-click the cell of an agent in Make Busy and click Agent control > Remove Make Busy. Alter-

natively, select the agent cell in an open monitor and click Remove Make Busy from the Agent 
Control tab in the Contact Center Client ribbon.
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To remove all employees in an open Agent Monitor from Make Busy 
1. Right-click the cell of an employee and click Monitor control > Remove Make Busy. Alternatively, 

select an empty cell in an open monitor and click Remove Make Busy from the Monitor Control tab 
in the Contact Center Client ribbon.

2. Click Yes.

Placing employees in Busy - Ignite (WEB)
NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
Placing an employee into Busy places them in Busy across all media types for which they answer inter-
actions. While in Busy, they can receive transferred multimedia interactions, however, inbound multi-
media interactions will not be routed to them. They can also receive Non ACD voice interactions and pick 
interactions waiting in queue.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To place an employee in Busy 
1. In the monitor, select the employee you want to place in Busy.
2. Click State > Busy….

3. Choose a Busy code.

Removing employees from Busy - Ignite (WEB)
Removing employees from Busy re-enables them to answer inbound multimedia interactions and ACD 
calls.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To remove an employee from Busy 
1. In the monitor, select the employee you want to remove from Busy.
2. Under State, select an alternate state, or, click X button next to Busy... to remove the busy code. 

NOTE: Select Available if you want to make them available to receive interactions.
Placing employees in Do Not Disturb - Contact Center Client
NOTE: 
• If an agent on an ACD calls puts themselves into MKB or DND, Work Timer events are not received 

for that call.
• Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 

until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification 
Code will be applied to the call..

Placing employees into Do Not Disturb places employees and all of their agents into Do Not Disturb.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To place an employee in an open Employee monitor in Do Not Disturb 
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• Right-click the cell of an employee and click Employee Control > Set Do Not Disturb > reason code. 
Alternatively, select the employee cell in an open monitor and click Set Employee Do Not Disturb > 
reason code.

To place all employees in an open Employee Monitor in Do Not Disturb 
1. Right-click the monitor and click Monitor control > Set Do Not Disturb > reason code. Alternatively, 

select an empty cell in an open monitor and click Set Do Not Disturb from the Monitor Control tab 
in the Contact Center Client ribbon.

2. Click Yes.

To place an employee in an open Agent monitor in Do Not Disturb 
• Right-click the cell of an agent who is logged on and click Agent control > Set Employee Do Not 

Disturb > reason code. Alternatively, select the agent cell in an open monitor and click Set Do Not 
Disturb > reason code from the Agent Control tab in the Contact Center Client ribbon.

To place all employees in an open Agent monitor in Do Not Disturb 
1. Right-click the monitor and click Monitor control > Set Do Not Disturb > reason code. Alternatively, 

select an empty cell in an open monitor and click Set Do Not Disturb from the Monitor Control tab in 
the Contact Center Client ribbon.

2. Click Yes.

Removing employees from Do Not Disturb - Contact Center Client
Removing employees from Do Not Disturb removes employees and all of their agents from Do Not 
Disturb.
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To remove an employee in an open Employee monitor from Do Not Disturb 
• Right-click the cell of an employee who is in Do Not Disturb and click Employee control > Remove 

Do Not Disturb. Alternatively, select the employee cell in and click Remove Do Not Disturb from the 
Employee Control tab in the Contact Center Client ribbon.

To remove all of a monitor’s employees in an open Employee monitor from Do Not Disturb 
• Right-click the monitor and click Monitor control > Remove Do Not Disturb. Alternatively, select an 

empty cell in an open monitor and click Remove Do Not Disturb from the Monitor Control tab in the 
Contact Center Client ribbon.

To remove an employee in an open Agent monitor from Do Not Disturb 
• Right-click the cell of an agent who is in Do Not Disturb and click Agent control > Remove Do Not 

Disturb. Alternatively, select the agent cell in an open monitor and click Remove Do Not Disturb from 
the Agent Control tab in the Contact Center Client ribbon.

To remove all of a monitor’s employees in an open Agent monitor from Do Not Disturb 
• Right-click the monitor and click Monitor control > Remove Do Not Disturb. Alternatively, select an 

empty cell in an open monitor and click Remove Do Not Disturb from the Monitor Control tab in the 
Contact Center Client ribbon.

Placing employees in Do Not Disturb - Ignite (WEB)
NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..



971

SUPERVISORS - MANAGING A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Placing an employee into Do Not Disturb places them in Do Not Disturb across all media types for which 
they answer interactions. While in Do Not Disturb, they are unable to receive inbound multimedia interac-
tions and internal voice interactions, including transfers.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To place an employee in Do Not Disturb 
1. In the monitor, select the employee you want to place in Do Not Disturb.
2. Under State, click Do Not Disturb….

3. Choose a DND code.

Removing employees from Do Not Disturb - Ignite (WEB)
Removing employees from Do Not Disturb re-enables them to receive interactions for all applicable media 
types.
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To remove an employee from Do Not Disturb 
1. In the monitor, select the employee you want to remove from Do Not Disturb.
2. Under State, select an alternate state, or, click X button next to Do Not Disturb... to remove the DND 

Reason code. 

NOTE: Select Available if you want to make them available to receive interactions.
Canceling Work Timer for employees - Contact Center Client
NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
In an Employee monitor or Agent monitor, you can cancel Work Timer for one or more employees. The 
following procedures take place in either an open Employee monitor or an open Agent monitor in Contact 
Center Client.
To cancel Work Timer in an open Employee monitor 
• Right-click the cell of an employee who is in Work Timer and click Employee control > Cancel Work 

Timer. Alternatively, select the employee cell in an open monitor and click Cancel Work Timer in the 
appropriate media section of the Employee Control tab in the Contact Center Client ribbon.

To cancel Work Timer for all employees in an open Employee monitor 
• Right-click the monitor and click Monitor control > Cancel Work Timer. Alternatively, select an empty 

cell in an open monitor and click Cancel Work Timer in the media type’s section of the Monitor 
Control tab in the Contact Center Client ribbon.

To cancel Work Timer for an employee in an open Agent monitor 
• Right-click the cell of an agent who is in Work Timer and click Agent control > Cancel Work Timer. 

Alternatively, select the agent cell in an open monitor and click Cancel Work Timer from the Agent 
Control tab in the Contact Center Client ribbon.

To cancel Work Timer for all employees in an open Agent monitor 
• Right-click the monitor and click Monitor control > Cancel Work Timer. Alternatively, select an empty 

cell in an open monitor and click Cancel Work Timer from the Monitor Control tab in the Contact 
Center Client ribbon.

Canceling Work Timer for employees - Ignite (WEB)
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NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
The following procedure takes place in either an Agent State or Employee State monitor in Ignite (WEB).
To remove an employee from Work Timer 
1. In the monitor, select the employee you want to remove from Work Timer.
2. Click State and select an alternate state. 

NOTE: Select Available if you want to make them available to receive interactions.
Canceling Reseize Timer for voice agents
The following procedures take place in either an open Employee monitor or an open Agent monitor in 
Contact Center Client.
To cancel Reseize Timer for an employee’s voice agent in an open Employee monitor 
• Right-click the cell of an employee who is in Reseize Timer and click Employee control > Cancel 

Reseize Timer. Alternatively, select the employee cell in an open monitor and click Cancel Reseize 
Timer in the appropriate media section of the Employee Control tab in the Contact Center Client 
ribbon.

To cancel Reseize Timer for all employee voice agents in a monitor in an open Employee monitor 
• Right-click the monitor and click Monitor control > Cancel Reseize Timer. Alternatively, select an 

empty cell in an open monitor and click Cancel Reseize Timer from the Monitor Control tab in the 
Contact Center Client ribbon.

To cancel Reseize Timer for an employee’s voice agent in an open Agent monitor 
• Right-click an agent who is in Reseize Timer and click Agent control > Cancel Reseize Timer. Alter-

natively, select the agent cell in an open monitor and click Cancel Reseize Timer in the appropriate 
media section of the Agent Control tab in the Contact Center Client ribbon.

To cancel all of the voice agents on a monitor in the Reseize Timer state in an open Agent monitor 
• Right-click the monitor and click Monitor control > Cancel Reseize Timer. Alternatively, select an 

empty cell in an open monitor and click Cancel Reseize Timer from the Monitor Control tab in the 
Contact Center Client ribbon.

Controlling the availability of voice queues

Using Interactive Contact Center and Contact Center Client, you can control the availability of voice 
queues on the Queue Now or Queue Group Now monitor. Multimedia queues cannot be controlled using 
Interactive Contact Center and Contact Center Client. For information on controlling voice queues, see 
the Interactive Contact Center chapter of the MiContact Center Business User Guide.

Interacting with customer interactions to improve service levels

Interactive Visual Queue is a Contact Center Client real-time monitor that works in conjunction with Your-
Site Explorer and Interactive Contact Center to enable supervisors to both monitor and control the content 
in contact center queues. With Interactive Visual Queue monitors open, supervisors can monitor the 
contents of queues and queue groups, easily move interactions between queues, assign interactions to 
agents, and proactively remove unwanted interactions from the queues.
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Interactive Visual Queue is comprised of a Queued media grid and, for voice media, an Abandoned media 
grid and a Callback to be processed grid. The Interactive Visual Queue Queued media grid displays all 
types of media interactions that are currently queued. It does not display items that have already been 
offered to agents or are currently being handled by agents.
Using a drag-and-drop operation, supervisors can balance traffic by moving interactions from busy 
queues to less active queues and ensure optimum customer service by directing high priority interactions 
to experienced agents. Supervisors can pick interactions from the queue and handle them, and can tag 
email interactions as junk or no reply needed to remove them from the queue. Supervisors can also 
preview email interactions.
For information on using Interactive Visual Queue with voice media, see "Interactive Visual Queue".

Opening Interactive Visual Queue

You access Interactive Visual Queue by logging on to Contact Center Client and then opening the 
Real-time toolbar.
To open an Interactive Visual Queue monitor 
1. Log on to Contact Center Client.
2. In the Contact Center Client ribbon, click Real Time.

3. Click Interactive Visual Queue. 

The Add/Remove device IDs window opens.
4. Select the queue group(s) or queue(s) that you want to monitor and click OK. 

See the following figure.
NOTE: 

– Virtual,Reporting, and Unified Queue Groups are shown in the Queue groups list.
Figure 24.28: Interactive Visual Queue monitor
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Accessing queue and interaction information and statistics

To access detailed multimedia queue information, including voice, refer to the Interactive Visual Queue 
Queued media grid. Here you will find the statistics you need to make informed decisions to ensure inter-
actions are being handled efficiently within your business.
The following list provides descriptions of the column headings available in the Queued media grid: 
• Position (#) displays the answer position relative to other interactions in the queue
• Media icon displays the media type
• Queue Name displays the name of the queue
• Queue Dialable displays: 

– Voice—the dialable number of the queue
– Chat—Queue Auto Response User Name
– SMS—the dialable number of the queue
– Email—Email address of the queue

• Priority is the priority of the interaction in the queue (the lower the number, the higher the priority)
• Time in Queue is the interaction's total time in the current queue
• Time Offered to System is the time the interaction first entered the system
• Time in System is the interaction's total time in the system
• Queue Hops is the number of times an interaction has changed queues
• ANI (Contact ID) displays: 

– Voice—caller # / ANI
– Chat—Chat email address from pre-chat form
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– SMS—From mobile number
– Email—From email address

• Subject displays 
– Voice—blank
– Chat—Chat subject from pre-chat form
– SMS—blank
– Email—Email subject

• Is Callback indicates if the queued media is a callback request (voice only)
• Service level countdown provides a countdown in seconds when the contact will exceed the target time 

to meet the service level
• Contact Name is the name associated with the contact (if available) 

– Voice—caller ID
– Chat—Chat name from pre-chat form
– SMS—blank
– Email—Email “From” name, if available

• Time Offered to Queue is the time the contact entered the current queue
• DNIS (To Address) displays 

– Voice—DNIS Number
– Chat—blank
– SMS—blank
– Email—receiver's email address

• To Name displays 
– Voice—DNIS Name, if configured in YourSite Explorer for the associated DNIS number
– Chat—blank
– SMS—blank
– Email—Email "To" name, if available

• Collected Information displays the single or series of collected results provided by IVR Routing or Intel-
ligent Queue. Collected information requires IVR Routing or Intelligent Queue, Verified Collected Digits 
and, optionally, Remote Database Verification or CTI Developer Toolkit

• Queue Reporting is the queue’s reporting number

For information on other Interactive Visual Queue grids that are voice media only, see "Interactive Visual 
Queue monitor grids". For information on hiding or making columns visible, sorting data in a column, or 
re-arranging columns, see "Real-time Monitors".

Understanding interaction priority

Each queue has a default priority level. When an interaction enters the system for the first time, the inter-
action adopts the default priority of whichever queue it enters. If all interactions in a queue have the same 
priority, the position of the interactions are based on each interaction’s total time in the current queue. If 
a queue contains interactions that have multiple priority levels, higher priority interactions will have a 
higher position in the queue than lower priority interactions.



976

SUPERVISORS - MANAGING A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

As long as an interaction remains in a queue, it maintains its priority. However, if an interaction moves 
from one queue to another queue, the interaction’s priority may change, based on the method used to 
move the interaction.
When you redirect an interaction manually, the interaction always adopts the default priority level of the 
destination queue.
When you redirect an interaction manually, the interaction always adopts the default priority level of the 
destination queue. For example, suppose Queue 1 has a priority of 1 and Queue 2 has a priority of 15. 
When an interaction first enters Queue 1, it has a priority of 1. However, if you manually move that inter-
action to Queue 2, using either a drag-and drop operation or the right-click menu, the interaction priority 
lowers to 15. The rules work the same in reverse. If you manually move a priority 15 interaction from 
Queue 2 to Queue 1, the interaction priority increases to 1 when it enters Queue 1.
Interactions interflowed automatically retain the original interaction priority.

Redirecting interactions

An interaction can move between queues automatically (interflow) or manually (redirection).
Interflow
You can configure Inqueue workflows to automatically move an interaction from one to queue to another 
after a specific duration through the Interflow activity. For example, you could configure your system to 
move an interaction from Queue 1 to Queue 2 if the interaction has not been answered within 30 seconds. 
For more information on the Interflow activity, see "Routing interactions with the Interflow activity".
Redirection
Using Interactive Visual Queue, you can manually redirect an interaction from a queue to another queue, 
to an agent, or, if it is a voice interaction, a dialable number.
There are two ways a voice interaction can be removed from the system. If a voice interaction is moved 
more than 10 times, either by redirection or by interflow, the interaction is dropped from the system. You 
can see the current number of times an interaction has moved between queues in the Queue Hops 
column. A voice interaction will also be automatically removed from the system if its total time in the 
system exceeds 24 hours. The Total Time column lists the interaction’s duration in the system. Email, 
SMS and chat interactions are removed from the system if they are offered to agents over 50 times.
If an interaction is an email interaction, it can also be set to No Reply or Junk and removed from the 
system.
You can manually redirect an interaction in the Queued media grid using the following methods: 
• Drag and drop an interaction between queues.
• Use the right-click menu to move an interaction between queues.
• Use the right-click menu to send an interaction to a specific dialable number or email address

You may notice that the first two methods perform the same action. However, the second method is 
convenient when a queue monitor is maximized and you want to move an interaction without having to 
resize one or more monitors.
You can remove interactions in the Interactive Visual Queue Monitor in the following ways: 
• Delete voice interactions from the monitor (voice only)
• Tag emails as No Reply needed
• Tag emails as Junk
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When you manually redirect (drag and drop) an interaction in Interactive Visual Queue, Mi Contact Center 
Business changes the way the voice interaction is pegged on the Queue Performance reports. If you redi-
rect an interaction before the short abandon time set for the queue, the interaction is pegged as Unavail-
able. If you redirect an interaction after the short abandon time set for the queue, the interaction is pegged 
as Interflowed. An internal ACD interaction is pegged as Abandoned if the interaction is redirected at any 
time.
Redirecting multimedia interactions between queues
To drag and drop interactions between queues 
1. In the Queued media grid, click anywhere in the row of the interaction you want to move.
2. Use a drag-and-drop operation to move the interaction from its original queue monitor to a new queue 

monitor. 

NOTE: 
– You can only drag an interaction from one Interactive Visual Queue monitor to another if the desti-

nation monitor has the same media type (such as email to email, chat to chat, etc.).
– Only one interaction can be moved over at a time.
– If the destination monitor has multiple queues for the same media type, the system will assign the 

redirected interaction to the queue with the fewest interactions in queue.

To redirect an interaction between queues using the menu 
1. In the Queued media grid, right-click the row of the interaction you want to redirect and click Send to 

> Queue. 
A list of available queues displays.

NOTE: You can use the search button to locate a specific queue, either by name or reporting number.
2. Click the name of the queue to which you want to redirect the interaction.

3. Click OK.

Alternatively, to redirect an interaction from one queue to another queue 
1. In the Queued media grid, right-click the row of the interaction you want to redirect and click Send to.
2. In the list of queues beneath Queue, select a queue.

Redirecting multimedia interactions to agents
You can transfer interactions in queue directly to agents who are available or in Make Busy/Overloaded 
states. Agents who are logged out, in DND, Offline (WEB), or whose presence is Unknown cannot receive 
transferred interactions and do not appear in the list of available agents.
To redirect multimedia interactions to agents 
1. In the Queued media grid, right-click the row of the interaction you want to redirect and click Send to 

> Agent. 
A list of available agents who can handle the interaction’s media type displays.

NOTE: You can use the search button to locate a specific agent, either by name or reporting number.
2. Click the name of the agent to which you want to send the interaction.

3. Click OK.

Redirecting email interactions to specific email addresses
Using the Send to menu option, you can redirect interactions in Interactive Visual Queue to any email 
address.
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To redirect an email interaction to another email address 
1. In the Queued media grid, right-click the row of the email interaction you want to redirect and click 

Send to > [Destination].
2. When you click [Destination], it changes to a text box.

3. Type an email address into the text box and press Enter. 

You can enter multiple email addresses, separating each with a semi-colon (e.g. recipi-
ent1@email.com;recipient2@email.com).

NOTE: If you are licensed to access multimedia functionality in Ignite, you can alternatively redirect 
interactions directly to an agent by forwarding or transferring. See "Handling emails in Ignite" and 
"Handling chats in Ignite".

Tagging emails and SMS as Junk
Supervisors can mark email or SMS interactions in an Interactive Visual Queue monitor as junk, removing 
junk interactions from the queue.
To tag an email or SMS interaction as Junk 
1. In the Queued media grid, select the interaction(s) you want to tag as Junk. 

Select multiple emails by holding CTRL or Shift and clicking the emails.
2. Right-click the row of the interaction you want to tag as Junk.

3. Click Junk Conversation.

4. Click Yes.

NOTE: 
• Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and Ignite 

are not included in queue Handled, Completed, and Offered counts.
• If you are licensed to access multimedia functionality in Ignite, you can alternatively tag emails as Junk 

using Ignite. See "Marking emails as No Reply and Junk".

Tagging email and SMS interactions as No Reply Needed
Supervisors can mark email and SMS interactions in an Interactive Visual Queue monitor as requiring no 
reply, such as out of office emails, removing them from the queue.
To tag an email and SMS interaction as No Reply needed 
1. In the Queued media grid, select the interaction you want to tag as No Reply needed. 

Select multiple interactions by holding CTRL or Shift and clicking the emails.
2. Right-click the row of the interaction you want to tag as No Reply needed.

3. Click No Reply.

NOTE: 
• Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and Ignite 

are not included in queue Handled, Completed, and Offered counts.
• If you are licensed to access multimedia functionality in Ignite, you can alternatively tag email and SMS 

interactions as No Reply Needed using Ignite. See "Marking emails as No Reply and Junk" and 
"Marking SMS contacts as No Reply and Junk".
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Previewing queued multimedia interactions

Supervisors monitoring queues in Interactive Visual Queue can preview the contents of queued email, 
SMS and chat interactions. The following figure shows a previewed email. Previewed emails display in a 
new window that shows the contents of the email. Supervisors can preview embedded files in the email 
and download attachments, such as images and e-signatures, but they cannot edit previewed emails, 
however, nor can they preview an email in an agent’s inbox. A supervisor can only have one email 
preview open at a time.

Figure 24.29: Previewed email
 

The following figure shows a previewed chat session. Previewed chats show the content of the chat 
session. Supervisors can open links in the previewed chat session, but they cannot view embedded 
media or participate in the chat. A supervisor can only preview one chat at a time. Supervisors previewing 
chats must have an associated chat agent.



980

SUPERVISORS - MANAGING A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Figure 24.30: Previewed chat

The following figure shows a previewed SMS interaction. Previewed SMS interactions show the content 
of the SMS session. Supervisors can open links in the previewed SMS session, but they cannot view 
embedded media or participate in the SMS interaction. A supervisor can only preview one SMS interac-
tion at a time. Supervisors previewing SMS interactions must have an associated SMS agent.
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Figure 24.31: Previewed SMS

While the preview window is open, no other actions can be taken in Contact Center Client, although you 
can still answer phone calls from the desktop notification. Previewing a multimedia interaction does not 
impact the ability of that multimedia interaction to interflow to another queue, to be offered to or picked by 
an agent, or any other activity in Multimedia Contact Center.
The following procedures take place in an open Interactive Visual Queue monitor in Contact Center Client.
To preview a multimedia interaction 
• Right-click the email, SMS or chat you want to preview and select Preview.
To print an email preview window 
• Click the printer icon in the email preview.
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Removing interactions from Interactive Visual Queue monitors

Interaction can be removed from Queued and Abandoned media monitors. Deleting an interaction from 
Interactive Visual Queue does not remove the interaction from the actual queue. Instead, it removes the 
interaction from the monitor and stops Interactive Visual Queue from tracking it.
To remove an interaction from Interactive Visual Queue
1. Right-click the row of the interaction you want to remove.
2. Click Delete.

The interaction is removed from Interactive Visual Queue

Forecasting multimedia contact center staffing requirements

The Forecasting tool built into Contact Center Client and Workforce Scheduling enables supervisors to 
take historical data generated by their contact center’s ACD routing systems and multimedia servers and 
use it to predict future traffic volumes and patterns to estimate required resources to handle their contact 
center’s workload.
The Forecasting tool forecasts for each media separately when generating forecasts and does not adjust 
for agent Workload. Agents allowed to handle simultaneous interactions are likely to be more efficient 
than those handling a single call due to their ability to multitask. As a result, the number of required agents 
in a forecast may be met by fewer agents if their Workload permits them to handle different media inter-
actions and numbers of interactions concurrently. Supervisors should adjust their forecast statistics to 
compensate for the Workload of the agents being forecasted. It is recommended that Workload be the 
same for all members in an agent group being forecasted.
For more information on forecasting, see the Forecasting chapter of the MiContact Center Business User 
Guide. For information on using the Forecasting tool within Workforce Scheduling to schedule your 
employees based on multimedia queue traffic needs, see the Workforce Scheduling chapter of the 
MiContact Center Business User Guide.

Accessing historical real-time information with Contact Center Client

Using Auditor you can view historical, multimedia real-time events, at your own pace. Auditor makes it 
easy for you to analyze when and why past service problems occurred. By understanding the series of 
events you can prevent such issues from recurring.
For example, you notice that on July 15 you have 12 interactions abandon between 10:00 AM and 10:15 
AM. You can review the interactions and the agents’ actions on that date for that time period with Auditor. 
Did all of the interactions arrive at the same time? Did all of the agents go on break at the same time? If 
all of the interactions arrived at once, you need to schedule more people. If all of the agents went on break 
at the same time, you need to adjust their break schedule.
Using Auditor you can also track when employees log on and log off the system. It is easy to determine 
if any of the employees consistently start late or finish early.
With Auditor, you can use existing profiles, including alarm thresholds, when viewing past days run in real 
time.
Your access to Auditor is determined by administrator-set security roles.
The first toolbar consists of real-time monitors that provide information on agent availability, queue statis-
tics, and graphic displays on queues. (See the following figure.)
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Figure 24.32: Auditor toolbar
 

Auditor icons

Using Auditor’s second toolbar you select the date of the historical real-time events that you want to view 
and the speed at which to play the events. The icons are described in the following table.
Table 24.26:Auditor Icons  (Sheet 1 of 2)

Icon Term Meaning

 

Calendar You can select the date of the 
historical real-time events that 
you want to view by clicking the 
calendar.

Speed of audit The Speed of audit is expressed 
as a ratio of real-time to play 
speed. You can select the 
speed from a list of ratios that 
opens when you click the clock: 
1:1, 1:2, 1:5, 1:10, 1:30, 1:60, 
and 1:120. If you select the 
ratio1:1, it will take you one 
second to view one second of 
the past day. If you select 1:60, 
it will take you one second to 
view one minute of the past day.

Rewind If you click Rewind when the 
play is stopped, you jump back 
to the beginning of the day.

Stop You can stop the real-time 
historical events from playing, 
and jump back to the beginning 
of the day, by clicking Stop.

Pause You can pause the real-time 
historical events by clicking 
Pause.
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Play You can play the real-time 
historical events by clicking 
Play.

Step forward You can select the increment (in 
seconds) you will advance from 
a list that opens when you click 
the down arrow to the right of 
Step forward: 1 sec, 2 sec, 5 
sec, 10 sec, 15 sec, 30 sec, and 
45 sec. If you select 30 
seconds, then when the play is 
stopped, you can step forward 
in 30 second increments each 
time you click Step forward. 
When you reach the end of data 
for that day, you will 
automatically jump to the end of 
the day.

Jump forward You can select the increment (in 
minutes) you will advance from 
a list that opens when you click 
the down arrow to the right of 
Jump forward: 1 min, 2 min, 5 
min, 10 min, 15 min, 30 min, 
and 60 min. If you select 10 
minutes, then when the play is 
stopped, you can jump forward 
in 10 minute increments each 
time you click Jump forward. 
When you reach the end of data 
for that day, you will 
automatically jump to the end of 
the day.

Slider As you view the events of the 
day, the slider indicates the time 
at which the events occurred. 
The length of the slider 
represents the length of the day 
for which you are viewing 
historical real-time events.

Table 24.26:Auditor Icons (Continued) (Sheet 2 of 2)

Icon Term Meaning
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Viewing historical real-time events

You start Contact Center Client to gain access to Auditor functionality. For more information on Contact 
Center Client real-time monitoring, see "Contact Center Client" chapter of the MiContact Center Business 
User Guide.
To view historical real-time events, you must 
1. Start Contact Center Client.
2. Open the grids in which you want to view historical events. 

NOTE: When viewing a Queue or Queue Group monitor, emails in queue that arrived from a previous 
day in the auditing period will not show up in the monitor statistics until an action is taken on them 
during the auditing period.

3. Start Auditor.

Starting and using Auditor

You start Contact Center Client to gain access to Auditor functionality.
To view historical real-time events, you must
1. Start Contact Center Client.
2. Open the grids in which you want to view historical events.

NOTE: When viewing a Queue or Queue Group monitor, emails in queue that arrived from a previous 
day in the auditing period will not show up in the monitor statistics until an action is taken on them 
during the auditing period.

3. Start Auditor.

NOTE: If you are using the Contact Center Client marquee, Contact Center PhoneSet Manager, Contact 
Center Softphone, or Interactive Visual Queue applications (which function in real time only), open Auditor 
in another instance of Contact Center Client.
To start and use Auditor
1. In the Contact Center Client ribbon, click Auditor Controls.
2. Click Auditor Mode in the toolbar ribbon.

The Auditor toolbar displays.
3. Click the calendar icon and select a date.

The date displays on the left of the slider.
4. Click the speed icon and select the speed of the audit.

The speed of the audit, expressed as a ratio of real time to play speed, displays on the right of the 
speed icon.

5. Move the slider to select the time of day at which you want to start monitoring.

6. Click the play button to play the real-time events of the selected date.

The historical real-time events play at the speed you selected.
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Accessing real-time information with Ignite (WEB)

Ignite (WEB) enables real-time monitoring of employees, agents, queues, and callback requests. The 
Ignite (WEB) real-time monitors do not duplicate those available in Contact Center Client but, instead, 
offer a succinct set of the most essential statistics in the highly accessible online format of Ignite (WEB).
The following real-time monitors are available in Ignite (WEB): 
• Employee State
• Agent State
• Queue Now
• Callback Requests

To access the real-time monitors in Ignite (WEB) 
1. In Ignite (WEB), click Dashboards.
2. Click the down arrow and select the dashboard from the list that contains the monitor you want to 

display.

NOTE: 
• Alarms are not supported for real-time monitors in Ignite (WEB).
• Access to real-time monitors is determined by administrator-set security roles.

To learn how to add and configure settings for real-time monitors in Ignite (WEB), see "Configuring Ignite 
(WEB) dashboards".

Monitoring employee state in Ignite (WEB)

The Employee State monitor available in Ignite (WEB) enables you to view activity and, if enabled for 
Interactive Contact Center, adjust presence for individual employees in your contact center.
You can view the following real-time employee information:
• Employee name, reporting number, and avatar
• ACD availability and state (with colored state icon)
• Busy duration for the day
• Do Not Disturb duration for the day
• Number of interactions handled for the day (voice, email, chat, SMS, open media as applicable)
• Date/Time of first login
• Total shift duration

NOTE: Only one employee at a time can display in the Employee State monitor but you canoptionally add 
several employee monitors to a dashboard to access information for multiple employees.
The Employee State monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn 
how to add and configure settings for the Employee State monitor in Ignite (WEB), see "Configuring Ignite 
(WEB) dashboards".

Monitoring agent state in Ignite (WEB)

The Agent State monitor available in Ignite (WEB) enables you to view the real-time state of agents in 
your contact center and, if enabled for Interactive Contact Center, adjust agent presence.
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Each column lists agents in order of time in state, with the longest in state at the top. For example, the 
agent at the top of the Idle column is the next longest idle agent and should receive the next inbound inter-
action.
The following table lists and describes real-time agent state information that displays in the Agent State 
monitor in Ignite (WEB).

The Agent State monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn how 
to add and configure settings for the Agent State monitor in Ignite (WEB), see "Configuring Ignite (WEB) 
dashboards".

Monitoring queues in Ignite (WEB)

The Queue Now monitor available in Ignite (WEB) enables supervisors to view queue or queue group 
statistics and a summary of current agent states for each queue or queue group in real time.
Queue statistics include Offered, Service Level %, Interactions Waiting, Requeued, and Longest Waiting. 
Handled, Interflowed, and Abandoned counts can also be accessed by hovering over ‘Offered’ for each 
queue or queue group.
The following table lists and describes queue statistics that display in the Queue Now monitor in Ignite 
(WEB).

Table 24.27:Agent State monitor statistics - Ignite (WEB)

STATISTIC DESCRIPTION

ACD includes agents in ACD and ACD Hold

Idle includes agents who are available for ACD but 
currently not handling any interactions

Non ACD includes agents in Non ACD, Non ACD Hold, 
Outbound, and Outbound Hold

Unavailable includes agents in Do Not Disturb, Busy, Work 
Timer, and Reseize Timer

Not Present includes agents who are logged in as an agent 
but not present in any agent groups

Offline includes agents who are logged in as an ACD 
agent

Table 24.28:Queue Now monitor statistics - Ignite (WEB)  (Sheet 1 of 2)

STATISTIC DESCRIPTION

Offered the total number of interactions offered to the 
queue or queue group
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The current number of agents, by state, also displays for each queue or queue group for the following 
agent states: 

Service Level % for a queue, this is the percentage of interactions 
handled within the queue’s Service Level Time 
value over the day
for a queue group, this is the lowest percentage 
of interactions handled within the queue’s Service 
Level Time value over the day across all queues

Contacts Waiting the current number of interactions in queue 
waiting for a member to become available, 
including those listening to silence, music, or 
recorded announcements

Requeued the total number of ACD interactions requeued 
NOTE: This statistic displays information for ACD 
paths only. Statistics for Ring Groups display as '0'

Longest Waiting the current duration, in minutes and seconds, of 
the interaction waiting the longest in queue or 
queue group

Handled the total number of ACD interactions handled by 
members

Interflowed the total number of ACD interactions interflowed 
interflow is a mechanism that directs an 
interaction waiting in queue to another answer 
point 
NOTE: If an interaction waiting in queue is redi-
rected before the queue's short abandoned time 
has elapsed, the queue is pegged with a Queue 
Unavailable count rather than an interflowed 
count. In order for the Interflowed peg to occur, the 
redirection must occur after the short abandoned 
time has elapsed

Abandoned the total number of interactions abandoned 
before being answered by members 
NOTE: Abandoned does not peg short abandons 
as abandoned interactions in the Queue Now 
monitor. The Abandoned column in the Interactive 
Visual Queue monitor displays all abandoned 
interactions. Because of this difference, you may 
notice discrepancies between the abandoned call 
information in these two monitors

Table 24.28:Queue Now monitor statistics - Ignite (WEB) (Continued) (Sheet 2 of 2)

STATISTIC DESCRIPTION
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• Idle: includes agents who are available for ACD but not currently handling any interactions 
• ACD: includes agents in ACD and ACD Hold
• Non-ACD: includes agents in Non ACD, Non ACD Hold, Outbound, and Outbound Hold
• Unavailable: includes agents in Do Not Disturb, Busy, and Work Timer

The Queue Now monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn how 
to add and configure settings for the Queue Now monitor in Ignite (WEB), see "Configuring Ignite (WEB) 
dashboards".

Viewing and managing callbacks in Ignite (WEB)

When licensed for IVR, the Callback Requests monitor, available in Ignite (WEB), enables you to interact 
with callbacks and monitor their state in real time.
The Callback Requests monitor enables users to requeue, reject, and delete callbacks from within the 
monitor. Requeued callbacks are re-entered into their queue. Rejected callbacks are removed from the 
queue and will not be offered to employees. Deleted callbacks are removed from the monitor, but are not 
removed from the system.
To requeue, reject, or delete a callback 
• In the row of the call you want to interact with, in the Actions column, left-click either Requeue, Reject, 

or Delete.
The following table lists and describes the statistics available in the Callback Requests monitor.
Table 24.29:Callback Requests monitor statistics - Ignite (WEB)

STATISTIC DESCRIPTION

Name the name of the caller

Number the phone number provided by the caller

Status the status of the callback

Offer At At the specific time the callback will be executed

Received the specific time the caller submitted the callback 
request

Preferred Time the time the caller is available to receive the 
callback (if the caller does not enter a preferred 
time, this column will be blank)

Destination the queue, agent, and extension for which the 
callback is intended

# of Attempts the number of times the callback has been 
attempted

Last Attempted the specific time the last callback attempt to the 
caller was made

Actions within this column, you can choose to requeue, 
reject, or delete a callback
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The Callback Requests monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard, To learn 
how to add and configure settings for the Callback Requests monitor in Ignite (WEB), see "Configuring 
Ignite (WEB) dashboards".

Managing a multimedia contact center with Ignite

As a supervisor, there may be situations where you want to access Ignite's agent features. For example, 
you may want to occasionally log in to alleviate contact center congestion by handling interactions.
Ignite is also useful for directly transferring interactions to specific agents or as an alternative method for 
tagging interactions as Junk or No Reply Needed. In addition, supervisors access Ignite to search email, 
chat, SMS, and open media history.
Supervisors can use the real-time monitors available in the Ignite (WEB) Dashboard to view real-time 
queue, agent, and employee statistics as well as interact with agent presence to improve service levels. 
You can also view callback requests and choose to requeue, reject, or delete items from the list.
NOTE: Employees must be licensed for Multimedia Contact Center to access the full multimedia features 
in Ignite. For more information, see "Adding multimedia capabilities to employees".

Handling multimedia interactions

When traffic levels necessitate, supervisors with appropriate licensing can log into Ignite and alleviate 
congestion by handling interactions. Emails can be configured to overflow to a supervisor after a specified 
length of time in queue. If a supervisor primarily uses Contact Center Client, they can minimize Ignite and 
be notified when they receive an overflow email.
See the Ignite section of this guide for information regarding handling interactions in Ignite.

Searching email, chat, and SMS history

Building a case history is an essential part of investigating situations that result from a customer complaint 
or a customer commendation. Searching email, chat, SMS, and open media history helps you to follow 
the trail of activity, enabling you to react appropriately in an informed way.
See "Searching Ignite’s folders" and "Reviewing contact history" for more information.

Accessing real-time monitors in Ignite (WEB)

Real-time monitoring of employees, agents, queues, and callback requests is available via the dash-
boards in Ignite (WEB).
For more information, see "Configuring Ignite (WEB) dashboards", "Accessing real-time information with  
(WEB)", and "Interacting with agent presence to improve service levels".

Agents - Handling customer interactions in a multimedia 
contact center
Agents in a multimedia contact center are enabled to handle interactions of various media types, including 
voice, email, chat, SMS, and open media. Ignite enables agents to interact with customers, view and 
adjust their Agent Group Presence and Busy/Make Busy and Do Not Disturb states, and view statistics 
in real time to determine availability of other agents and to be aware of current contact center conditions.
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Agent preferences, such as login ID and language, can be modified in CCMWeb, your online center for 
personal settings and accessing the Help resource documentation.

Managing agent preferences

Agents can manage their preferences in CCMWeb, a web-based application that provides agents with the 
ability to view and change settings associated with their login ID. Using the options under CCMWeb’s My 
options tab, agents can set their language preferences, view their security roles, change their password, 
and manage lists of contacts for emailing reports. Via options under the Help tab, agents can access help 
documentation, view software information, and download the Client Component Pack installation file.
See "Setting up user preferences" to learn how to set user preferences, view security roles, and configure 
email contacts.

Ignite

Ignite is used by agents to handle all types of media, including voice, email, chat, SMS, and open media.
NOTE: The Desktop Ignite application is not supported on MiCC Business for Open SIP. Agents must use 
Web Ignite for all agent functionality.
Ignite is available as either a desktop or Web version. They share much of the same functionality but also 
offer unique agent and supervisor experiences enabling you to choose the application that suits your indi-
vidual needs. In our documentation, we refer to desktop Ignite and its features as Ignite (DESKTOP) and 
Web Ignite and its features as Ignite (WEB) or, where appropriate, as DESKTOP or WEB only.
If you want access to the following features, we recommend using Ignite (DESKTOP): 
• Fully supported integration with MiCollab Client, including: 

– State indicator collaboration (state changes in either Ignite or MiCollab are reflected in each appli-
cation)

– Ability to dock Ignite to MiCollab Client and minimize/maximize both applications simultaneously
– Auto-logout from MiCollab Client when agent logs out of Ignite
– Recording and implementing pre-announce and agent greetings
– Requesting help from other agents or supervisors while on a call
– Viewing agents' Inbox contents
– Being notified by email of Enterprise Server alarms
– Using the ‘Next Longest button’ to access longest-waiting Chat and SMS interactions with a single 

click
– Grouping, sorting, and organizing interactions using the card and grid views

If you want access to the following features, we recommend using Ignite (WEB): 
• Accessing Ignite from any supported, Web-enabled device 

– Full support for tablets (Apple, Android, and Microsoft)
– Partial support for mobile phones (Apple, Android, and Microsoft), including the ability to log in and 

out, view dashboards, change ACD state, set and remove Make Busy and Do Not Disturb, remove 
Work Timer, and interact with agent states via dashboards

• Viewing multiple windows simultaneously to enable greater, immediate access to different types of 
information
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• Switching between desktop, tablet, and mobile device, while maintaining consistent access to all rele-
vant information

• Logging into Ignite, without necessarily being available in queues, enabling employees to access Ignite 
without being presented with ACD calls

• Accessing supervisor-light version of Contact Center Client’s Interactive Contact Center capabilities, 
including interacting with agent states and agent group presence, and moving interactions from 
queues to agents, based on agent availability and queue activity levels

NOTE: Using MiCollab Client in conjunction with Ignite, to handle voice interactions, but without integration 
functionality, such as collaborative state updates, docking, minimizing/maximizing together, click to IM 
other agents and supervisors, and MiCollab Client auto-logout when logging out of Ignite
The following sections describe Ignite's functionality and include procedures for working in Ignite, with a 
focus on non-voice media types. If your contact center also handles voice interactions, we recommend 
implementing the MiCollab and Ignite integration described in the MiContact Center Business User Guide.

Getting started with Ignite (DESKTOP)

The following sections provide a walkthrough of Ignite’s interface. While this section contains some proce-
dures for viewing and orienting Ignite, agents can access in-depth information on how to use Ignite by 
following the cross-references throughout.
The following figure illustrates Ignite’s UI, in the My Folders view. This is the view where agents perform 
most of their tasks related to handling multimedia interactions.
NOTE: If you display taskbars on multiple monitors, maximizing Ignite on the secondary display does not 
cover the taskbar and in some instances causes the taskbar to obscure a portion of Ignite. To correct this, 
see the following Mitel Knowledge Base article: http://micc.mitel.com/kb/KnowledgebaseArti-
cle52017.aspx.

Figure 24.33: The Ignite UI for handling multimedia interactions
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Agent state and statistics (DESKTOP)

The Status bar displays the employee’s overriding state, including:
• Time in Ringing – Displays when an employee has ACD interactions ringing in the Inbox
• Time in ACD – Displays when an employee has placed ACD interactions in reply mode
• Time in ACD Hold – Displays when an employee has placed ACD interactions on hold
• Time in Non ACD – Displays when an employee is handling Non ACD interactions
• Time in Non ACD Hold – Displays when an employee has placed Non ACD interactions on hold
• Time in Outbound – Displays when an employee has placed an outgoing call
• Time in Work Timer – Displays after the employee has handled an interaction, provided none of the 

employee’s agents are in an ACD, Non ACD, Outbound, Make Busy, or Do Not Disturb state
• Time in Do Not Disturb – Displays when the employee is in a Do Not Disturb state
• Time in Make Busy – Displays when an employee is in a Make Busy state
• Time Logged in Not Present – Displays when an employee is not present in any of their agent groups
• Time in Reseize Timer – Displays when an call fails to route to an employee
• Time in Idle – Displays when an employee does not have contacts in the Inbox
• Time in Idle – Displays when the employee does not have interactions in the Inbox

NOTE: For Voice, Available includes agents whose devices are off hook or who have Non ACD calls 
ringing. These agents will not be offered ACD calls.
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An overriding state is a state that supersedes other states. States higher in the list override the states 
appearing lower in the list. Note that all of the employee’s agents are considered when the system calcu-
lates overriding state.
The oldest length for a state supersedes other times for the same state if an agent is handling multiple 
interactions. For example, if an employee had two emails in ACD, the displayed value in the status bar 
would be the time of the oldest email. When the oldest email is completed, the displayed value in the 
status bar would switch to the other email’s Time in ACD.
You can display agent handling statistics by clicking the ^ button on the right-hand side of the Status bar. 
Ignite’s Status bar also contains statistics on agent performance as it relates to handling multimedia inter-
actions. See the Multimedia Contact Center Installation and Deployment Guide for more information.
NOTE: The Status bar is only visible to employees with associated voice, email, chat, SMS, or open media 
agents.

Agent handling statistics by media type (DESKTOP)

Agents can view statistics related to their performance via the Sidebar. If you are enabled for media types 
other than voice, you can toggle between media-specific statistics using the icon directly above the 
statistic display. Select the headphone icon for voice, the envelope icon for email, the interaction icon for 
chat, or the phone icon for SMS statistics.
By default, the Sidebar displays Shift Time, DND Time, and MKB Time. However, you can select any 
three agent shift statistics from the Sidebar Stats tab under the Settings menu. See "Sidebar Stats 
settings" for more information.
If the statistic name is too long to display in full, you can hover over the statistic and read the tooltip or 
left-click the statistic to view the full name in the fly-out menu.

Logging into and out of Ignite (DESKTOP)

You can open Ignite from the Windows Start menu, Programs menu, Taskbar, or from a Desktop shortcut.
We recommend that agents using Ignite in conjunction with MiCollab Client log into their voice agent in 
MiCollab Client before logging into Ignite. If you choose to log into Ignite prior to logging into MiCollab 
Client, you will be prompted during the Ignite login process to register your voice agent in MiCollab Client.
Depending on administrative settings, agents may find that, after logging into their phone and into Ignite, 
they are placed in Make Busy across all agent capabilities. After logging into Ignite the agent can remove 
Make Busy and become available to receive ACD calls.
When you log in to Ignite, you become available to answer interactions for your associated queues and 
will receive items based on routing rules and your agent workload.
To log into Ignite 
1. Start Ignite.
2. Enter your Username and Password. 

NOTE: If your system uses Windows Authentication, you will be logged in automatically.
3. If you want the system to remember your login credentials, click Remember Me.

4. Click Login.

To log out of Ignite and restart the program to the login screen 
• In the Sidebar, click the Sign Out or Exit button and select Sign Out. 

The agent is logged out of Ignite, and Ignite restarts to the login screen.
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To log out of Ignite and close the application 
• In the Sidebar, click the Sign Out or Exit button and select Exit Application. 
NOTE: You can also close Ignite from the Sign In screen by clicking the Exit Application button.

The agent is logged out of Ignite, and the application closes.

The Sign In screen (DESKTOP)

Agents access Ignite via the Sign In screen.
Agents with multimedia and voice capabilities should follow best practices for logging into voice and multi-
media. For more information, see "Logging in and out of Ignite".
For information on exiting Ignite, see "Opening and closing Ignite".
Note that the availability of Ignite’s functionality depends on employee licensing. If you log into Ignite and 
are not able to access its functionality, or if you receive a message saying you are not configured for ACD, 
contact your supervisor or system administrator.

The Agent Group Presence Status screen (DESKTOP)

The Agent Group Presence Status screen is where agents can view
• The Agent Groups for which the agent handles interactions.
• Whether the agent is present in or absent from these groups.
• The default presence settings configured in YourSite Explorer.

If permitted, agents can adjust their agent group presence on this screen.
For information on accessing the Agent Group Presence Status screen, see "Viewing Agent Group Pres-
ence in Ignite".
For information on using the Agent Group Presence Status screen to become present in, or absent from, 
agent groups, see "Adjusting Agent Group Presence in Ignite".

The Folders pane (DESKTOP)

The Folders pane contains the media folders and the queues for which the employee’s agent groups 
handle interactions. For more information, see "The Media Folders view (DESKTOP)" and "The Queue 
Folder view (DESKTOP)".
Agents can expand or collapse Ignite’s Folders pane to give more or less space to the Media Folder and 
Queue Folders views. By default, the Folders pane is expanded.
To expand or contract Ignite’s Folders pane, click the arrow button beside Folders, at the top of the 
Folders pane.

The Sidebar (DESKTOP)

Ignite’s Sidebar displays the following agent controls. (See the following figure.) 
• Agent Group Presence 

See "Viewing Agent Group Presence in Ignite" and "Adjusting Agent Group Presence in Ignite".
• Make Busy 

See "Setting and removing Make Busy in Ignite".
• Do Not Disturb 

See "Setting and removing Do Not Disturb in Ignite".
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• Remove Work Timer (displays when Work Timer is active) 
See "Work Timer".

• Set Account Code 
See "Tagging contacts with Account Codes".

• Classify 
See "Tagging calls with Classification Codes".

• Request help 
See "Requesting Help"

• Agent Handling Statistics by Media Type 
Agents can select up to three agent handling statistics, by media type, to display in the Sidebar. If you 
are enabled for multiple media types, you can toggle between media-specific statistics using the icon 
directly above the statistical displays. Select the headphone icon for voice, the envelope icon for 
email, the interaction icon for chat, or the phone icon for SMS statistics. By default the Sidebar dis-
plays Shift Time, DND Time, and MKB Time. However, using the 'Settings' button in the Sidebar, you 
can select any agent statistics to display.

• Settings 
See "Your Ignite profile (DESKTOP)".

• Sign Out or Exit 
See "Logging in and out of Ignite (DESKTOP)" and "Opening and closing Ignite (DESKTOP)".

• Expand Ignite / Collapse Ignite 
Clicking the 'Expand Ignite / Collapse Ignite' button toggles the view based on your configured set-
tings. See "Your Ignite profile (DESKTOP)".

Figure 24.34: Ignite's Sidebar and controls
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The Action bar (DESKTOP)

Ignite’s Action bar displays multimedia interaction handling options, which vary by an interaction's media 
type and the stage at which the interaction is being handled.
For information on handing multimedia using the Action bar, see "Handling multimedia contacts in Ignite", 
"Handling emails in Ignite", "Handling chats in Ignite", and "Handling SMS in Ignite".

The Status bar (DESKTOP)

NOTE: The Status bar is only visible to employees with associated multimedia agents. For example, super-
visors without an associated voice, email, chat, or SMS agent do not see the Status bar in Ignite.
Ignite’s Status bar displays the employee’s overriding state, including 
• Time in Ringing – Displays when an employee has ACD interactions ringing in the Inbox
• Time in ACD – Displays when an employee has placed ACD interactions in reply mode
• Time in ACD Hold – Displays when an employee has placed ACD interactions on hold
• Time in Non ACD – Displays when an employee is handling Non ACD interactions
• Time in Non ACD Hold – Displays when an employee has placed Non ACD interactions on hold
• Time in Outbound – Displays when an employee has placed an outgoing call
• Time in Work Timer – Displays after the employee has handled an interaction, provided none of the 

employee’s agents are in an ACD, Non ACD, Outbound, Make Busy, or Do Not Disturb state 
For more information, see "Work Timer".

NOTE: If Work Timer is the overriding state, the Status bar displays the Work Timer state that the 
agent has been in longest.

• Time in Do Not Disturb – Displays when the employee is in a Do Not Disturb state 
For more information, see "Setting and removing Do Not Disturb in Ignite".

• Time in Make Busy – Displays when the employee is in a Make Busy state 
For more information, see "Setting and removing Make Busy in Ignite".

• Time Logged in Not Present – Displays when an employee is not present in any of their agent groups 
For more information, see "Adjusting Agent Group Presence in Ignite".

• Time in Idle – Displays when an employee does not have interactions in the Inbox

An overriding state is one that ‘trumps’ another state, as represented by the list above. States higher in 
the list override the states appearing lower in the list. Note that all of the employee’s agents are consid-
ered when the system calculates overriding state.
For example, if an employee’s Chat agent is Idle, but their Email agent is ACD, the Status bar displays 
ACD. In this example, ACD is the overriding state. If the employee’s Chat agent is in Work Timer, and 
their Email agent is in Make Busy, the Status bar displays Work Timer until Work Timer expires or is 
removed. In this example, Work Timer is the overriding state.
The oldest time for a state ‘trumps’ other times for the same state if an agent is handling multiple interac-
tions. For example, if an employee had two emails in ACD, the displayed value in the status bar would be 
the time of the oldest email. When the oldest email is completed, the displayed value in the status bar 
would switch to the other email’s Time in ACD.
Ignite’s Status bar also contains statistics on agent performance, offering agents quick access to their 
current handling statistics across media types. Icons indicate the media type to which the following statis-
tics pertain. 
• Average Handling Time (mins) – The average time the agent has taken to handle interactions of 

each media type
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• Workload (current + Work Timer / maximum) – Displays active interactions, and any Work Timer 
states, against the maximum number of interactions an agent can be pushed per media type, as 
defined by the agent’s Workload. Note that Work Timer states count against Workload, and will affect 
whether agents are pushed interactions. For more information, see "Work Timer".

• ACD (count / duration) – Displays the number of ACD interactions the agent has handled for a media 
type, and the time spent handling interactions of that media type

• Non ACD (count / duration) – Displays the number of Non ACD interactions the agent has handled 
for a media type, and the time spent handling the interaction.

• Unavailable % – Displays the percentage of time the agent is unavailable during their shift, including 
DND, MKB, Unknown, and Work Timer states, and when the agent is logged in but not available to 
receive ACD interactions.

Agents access their handling statistics by clicking the ^ button on the right-hand side of the Status bar. 
(See the following figure.)
The color of the multimedia icons in the Status bar indicates the agent’s state. 
• Green – Indicates an Idle state
• Red – Indicates an ACD or Do Not Disturb state
• Yellow – Indicates either a Make Busy or Work Timer state, or that the agent is logged in but not 

present in any of their agent groups.
• Blue – Indicates the agent is in a Non ACD state
• Gray – Indicates the agent is logged out or otherwise Unavailable

The following figure displays agent handling statistics in Ignite.
Figure 24.35: Agent handling statistics as displayed in Ignite's Status bar

 

The My Folders view (DESKTOP)

The My Folders view is where agents perform the majority of their contact-related tasks, including viewing 
media folders, queues, and handling interactions.
A red banner indicates the number of interactions ringing in the agent's Inbox. For more information, see 
"Ringing states in Ignite".
In addition to the above functions, supervisors can use My Folders to view 
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• Interactions in agent Inboxes
• Interactions sent to the queue
• Outbound emails and agent replies to interactions (email only)
• Interactions in the process of being sent (email only)
• Interactions that failed to route

The My Folders view is divided into the Folder, List, and Preview panes. (See the following figure.)
For more information, see "The Folders pane", "The List pane", and "The Preview Pane".
To access the My Folders view 
• At the top of Ignite, click the My Folders tab.

Figure 24.36: Ignite's My Folders view
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Viewing media folders (DESKTOP)
The following procedures explain how to 
• View the My Folders folder, which includes the Inbox, Drafts and Drafts subfolders, My History and My 

History subfolders, and Failed folder.
• View the Processed folder, which includes the In Progress (supervisors only), History and History 

subfolders, and Failed folder.
• View the Failed folder.

The My History and Processed folders pertain only to email, chat, SMS, and open media interactions. For 
more information on Ignite's folders, see "The Media Folders view (DESKTOP)".
For information on the specific interactions agents can view in Ignite’s media folders, see "Viewing and 
organizing contacts in Ignite (DESKTOP)".
To view the My Folders folder 
• Expand the Folders pane and expand the My Folders folder.
To view the Processed folder 
• Expand the Folders pane and expand the Processed folder.
To view the Failed folder 
• Expand the Folders pane and expand the Failed folder.
Viewing interactions in Ignite's folders (DESKTOP)
Ignite's List pane has two views: Card view and Grid view. Card view is the default view. Expanding the 
Card view’s borders converts it to the Grid view.
The Card view indicates when an interaction entered the Inbox and how long an agent has to handle an 
interaction before the Service Level timer expires. (See the following figure.)
Agents can customize how data displays in the Card view. For more information, see "Choosing how 
contact data displays in the Card view (DESKTOP)".

Figure 24.37: Data displayed in the List pane's Card view Inbox

In the Grid view, agents can see extended interaction information and customize the data displayed. For 
more information, see "Choosing how contact data displays in the Grid view (DESKTOP)".
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The Media Folders view (DESKTOP)

Ignite's Media Folders view displays folders containing interactions dealt with by the queues’ agent 
groups.
The Media Folders view is divided into three main folders: My Folders, Processed, and Failed. Each is 
comprised of several subfolders.
NOTE: The My History and Processed folders pertain only to email, chat, SMS, and open media interac-
tions.
My Folders – The agent’s ‘Personal’ folder. This folder contains multimedia interactions being offered to 
the Inbox, multimedia interactions the agent has handled, the agent’s email replies, and multimedia inter-
actions that were unable to route. My Folder is organized into the following subfolders.
• Inbox – Contains interactions being offered to the agent and interactions on which the agent is 

working. The Inbox indicates the number of ringing interactions, in red. When a customer responds to 
a chat, the number of chat interactions awaiting the agent's response is indicated, in orange. An inter-
action selected in the Inbox becomes the active interaction.

• Drafts – Contains the agent's emails in progress. These interactions are organized into the following 
subfolders:
– Inbox – Contains replies in progress to inbound emails
– New Emails – Contains outbound emails in progress
– Forward – Contains email forwards in progress

• My History – Contains email, chat, and SMS interactions that the agent has worked on. These inter-
actions are organized into the following subfolders:
– Handled – Contains the email, chat, and SMS interactions to which the agent has replied or trans-

ferred from reply mode
NOTE: For email, the Handled folder displays only the original, inbound emails.

– Sent – Contains outbound emails and agent replies to email interactions
– No Reply – Contains email interactions designated as needing no reply, such as out of office 

messages
– Junk – Contains email interactions and chat transcripts designated as Junk

• Failed – Contains email, chat, and SMS interactions that were unable to route

Processed – A queue-level folder. This folder contains email, chat, SMS, and open media interactions 
that agents answering for the queue have worked on and are currently working on.;Processed also 
includes email interactions in the process of being sent, and email and chat interactions that were unable 
to route. Processed is organized into the following subfolders.
• In Progress – Available only to supervisors. This folder contains email interactions currently in agent 

Inboxes. By searching agent names, supervisors can identify all interactions in an agent’s Inbox.
NOTE: Supervisors cannot see agent replies in progress.

• History – This folder contains email and chat interactions that agents have worked on. These interac-
tions are organized into the following subfolders.
– Handled – Contains the email, chat, and SMS interactions to which the agent has replied or trans-

ferred from reply mode
NOTE: For email, the Handled folder displays only the original, inbound emails.

– Sent – Contains outbound emails and agent replies to email interactions
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– No Reply – Contains email interactions designated as needing no reply, such as out of office 
messages

– Junk – Contains email interactions and chat transcripts designated as Junk
– Outbox – Contains outbound emails and agent email replies in the process of being sent. If send 

attempts exceed the default limit of five, the interaction’s media icon flashes and displays in red.

Failed – Contains email, chat, and SMS interactions that were unable to route in the queues the agent or 
supervisor have permission to view.
Failed is organized into the following subfolders.
• Failed – Contains email, chat, and SMS interactions that were unable to route
• Failed to Send – Contains emails that failed to send because they exceeded the supported email 

message size for the mail server
• Auto Replies/Failed Delivery – Contains emails that failed because the recipient had no more space 

in their inbox, the recipient had an out of office reply configured, the message was delayed by the recip-
ient's mail server, or there were invalid addresses in the delivery list

The interactions contained in each folder can be searched and sorted according to various criteria. For 
more information, see "Searching Ignite’s folders".

The Queue Folder view (DESKTOP)

The Queue Folder view displays the Unified Queues, Reporting Queues, and Individual Queues for which 
an employee’s agent group answers interactions.
Unified Queues – A collection of queues of different media types receiving interactions for a single 
service group. For example, a Unified Queue Group called ‘Technical Support’ can contain a voice, a 
chat, an email, and an SMS queue receiving tech support interactions. You can view these queues in a 
single folder, ‘Unified Queues’, in Ignite. You can control which queues are visible under Unified Queues 
in Settings. For more information, see "Queue selection settings (DESKTOP)".
Reporting Queues – A collection of queues, typically of a single media type, created for reporting 
purposes. For example, a collection of queues called ‘Email Technical Support’ can contain all email 
queues receiving tech support interactions. You can view these queues in a single folder, ‘Reporting 
Queues’, in Ignite. You can control which queues are visible under Reporting Queues in Settings. For 
more information, see "Queue selection settings (DESKTOP)".
Individual Queues – Queues of a single media type, either voice, email, chat, or SMS, which are not part 
of a Unified Queue. Individual Queues that are grouped into Reporting Queues also display here. You can 
control which queues are visible under Reporting Queues in Settings. For more information, see "Queue 
selection settings (DESKTOP)".
Viewing Unified Queue Groups, Reporting Queues, and Individual Queues (DESKTOP)
You must be licensed for Multimedia Contact Center to view queues. Supervisors must also be configured 
as agents answering for the queue in order to see its contents.
Selecting a specific queue folder updates Ignite to display the interactions in queue. See "Viewing 
contacts in Ignite’s folders (DESKTOP)" for more information. You can organize your queues and queue 
groups in alphabetical or reverse-alphabetical order for ease of viewing.
Agents can choose which queues display in Ignite. For more information, see "Queue selection settings 
(DESKTOP)". Supervisors can restrict the devices that agents can view in Ignite. For more information, 
see "Configuring security roles".
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Each queue indicates 
• The number of agents available in each queue’s answering agent groups. For Reporting Queues and 

Unified Queue Group folders, the total number of agents available for the queues is displayed.
• The number of interactions in queue, or 'InteractionsWaiting', for the queue and the queue groups
• The time that the longest waiting interaction has been in queue
• The queue or queue group’s Service Level. This Service Level is color-coded to give an indication of 

how the queue is faring. 75% or greater is green, 50% to 74% is orange, and less than 50% is red.

The following figure illustrates where each statistic displays.
Figure 24.38: Queue statistics displayed in the Queue Folder view

 

The following procedures explain how to 
• View Reporting Queues and Unified Queue Groups
• View queues within Reporting Queues and Unified Queue Groups
• View Individual Queues
• Sort queues and queue groups

To view Reporting Queues and Unified Queue Groups 
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, expand either Reporting Queues or Unified Queues.
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To view the queues within Reporting Queues and Unified Queue Groups 
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, expand either Reporting Queues or Unified Queues.

3. Expand the queues for which you want to see members.

To view Individual Queues 
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, expand Individual Queues.

To sort queues and queue groups 
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, expand Reporting Queues, Unified Queues, and Individual Queues.

3. Click the Sort Ascending/Descending button. 

See the following figure.
NOTE: An upward-facing triangle indicates alphabetical sorting (Ascending). A downward-facing 
triangle indicates reverse-alphabetical sorting (Descending).

Figure 24.39: Ignite's Sort Ascending/Descending button

The List pane (DESKTOP)

Ignite’s List pane displays the contents of folders selected in the Folders pane. You can view the List pane 
in Card view and Grid view.
Each view can display different interaction details. For information on customizing the data displaying in 
the List pane’s Card and Grid views, see "Choosing how contact data displays in the Card 
view (DESKTOP)" and "Choosing how contact data displays in the Grid view (DESKTOP)".
Viewing the List pane's Grid and Card views (DESKTOP)
The following procedures explain how to 
• Expand or collapse the List pane
• View the List pane in Grid view
• View the List pane in Card view

To expand or collapse the List pane, click the arrow beside the Search box at the top of the List pane. By 
default, the Line pane is expanded.
To view the List pane in Grid view 
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• When in Card view, expand the right-hand border of the List pane until it displays in Grid view.
To view the List pane in Card view 
• When in Grid view, reduce the right-hand border of the List pane until it displays in Card view.

The Preview pane (DESKTOP)

Ignite’s Preview pane serves a number of functions. If administrative configurations permit, the contents 
of email, chat, and SMS interactions selected in a folder or in queue are displayed in the Preview pane 
before an agent handles them. Unpreviewed interactions display a blue line beside them.
Requeued emails contain any response text drafted. This text is visible to other employees who handle 
the email. Agents can choose to include the drafted content when previewing requeued emails in queue.
Requeued chat and SMS interactions contain all of the previous interaction between contact and agent.
For voice interactions, the Preview pane displays call information such as the caller’s ANI. The Preview 
pane is the location for formatting replies, applying Account Codes, and viewing historical transcripts of 
communications. Functions available in the Preview pane vary by a interaction’s media type.
NOTE: In this guide, ‘reply mode’ refers to the state of the Preview pane when an agent has selected an 
interaction in their Inbox or in queue and has clicked either ‘Reply’, ‘Reply all’, or ‘Pick & Reply’. ‘Preview 
mode’ refers to the state of the Preview pane when an agent has selected an interaction without clicking 
reply.

The Realtime Monitor view (DESKTOP)

The Realtime Monitor view displays current statistics for the following devices: 
• Queue Groups
• Queues
• Agent Groups
• Agents
• Employees

Agents can customize which devices within a group display in the Monitor. For more information, see 
"Ignite’s Realtime Monitor (DESKTOP)" and "Viewing device statistics in Realtime Monitor (DESKTOP)".
To access the Realtime Monitor 
• At the top of Ignite, click Realtime Monitor.

Accessing Ignite (DESKTOP)

The following procedures explain how to 
• Open and close Ignite
• Log in and out of Ignite

Voice agents should consult "Logging in and out of Ignite (DESKTOP)" for important instructions on 
logging into Ignite in conjunction with Contact Center Softphone, PhoneSet Manager, or hard set desk 
phones.
For information on accessing the Ignite web client, see "Logging into Ignite (WEB)".
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Opening and closing Ignite (DESKTOP)

Accessing Ignite and its features requires employees to be licensed for Multimedia Contact Center and 
to have specific security roles enabled. Employees experiencing difficulty accessing Ignite should consult 
their supervisors or system administrators.
NOTE: Employees without Multimedia Contact Center licensing can be licensed to use Ignite but will have 
access to voice interactions only.
The following procedures explain how to
• Open Ignite
• Close Ignite

NOTE: When Ignite closes, it logs the agent out of all associated devices.

To open Ignite
• Ignite can be opened from Windows’ Start menu, Programs menu, Taskbar, or from a Desktop 

shortcut.
NOTE: 

– Launching client-side desktop applications from the task bar causes them to bypass the MiContact 
Center Updater Service process. To ensure successful updates from the Enterprise Server, after an 
upgrade close all client-side applications for 15 minutes or reopen them from the Start menu/Start 
screen.

– If MiContact Center Business applications are configured to use Windows Authentication, opening 
Ignite also logs agents into the program.

To close Ignite
• In the Sidebar, click the Sign Out or Exit button and select Exit Application.

Logging in and out of Ignite (DESKTOP)

The following provides important information on logging in and out of Ignite in conjunction with voice 
devices and with interactions in the Inbox.
We recommend that agents using Ignite log into their voice device before logging into Ignite. Once logged 
into their voice device, the agent can minimize Contact Center Client to the system tray and log into Ignite.
Agents can configure Contact Center Client to launch Ignite when logging into the phone, so the agent 
only has to launch one application to handle voice and multimedia. If you choose the ‘Remember Me’ 
option on the Ignite Sign In screen, Ignite launches and automatically logs you in. For more information, 
see "Automatically launching Ignite upon voice login (DESKTOP)". This option is available for Contact 
Center Softphone and PhoneSet Manager only.
Agents may find that, after logging into their phone and into Ignite, they are placed in Make Busy across 
all agent capabilities. This is a recommended administrative configuration. After logging into Ignite the 
agent can remove Make Busy and become available to receive ACD voice and multimedia interactions.
When an employee logs out of Ignite, all agents representing the employee are logged out, including voice 
agents. However, voice agents on active calls are not logged out until the call is complete. Logging out of 
the voice device logs multimedia agents out of Ignite and may requeue items in the Inbox, depending on 
administrative configurations.
Agents logging out of Ignite with interactions in the Inbox are notified if active interactions will requeue. 
Interactions that requeue are indicated in Ignite’s List pane and display a larger media icon than interac-
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tions that do not requeue. To avoid losing work on these items, agents should finish their reply or transfer 
the items to a queue before logging out.
The following procedures explain how to 
• Log into Ignite
• Log out of Ignite

To log into Ignite 
1. Start Ignite.
2. If prompted, type your Username and Password and verify the Enterprise Server IP address.

3. If you use Secure Socket Layer, select SSL.

4. Optionally, select Remember my credentials.

5. Click Login.

To log out of Ignite and restart the program to the login screen 
• In the Sidebar, click the Sign Out or Exit button and select Sign Out. 

The agent is logged out of Ignite, and Ignite restarts to the login screen.

To log out Ignite and close the application 
• In the Sidebar, click the Sign Out or Exit button and select Exit Application. 

The agent is logged out of Ignite, and the application closes.

Automatically launching Ignite upon voice login (DESKTOP)
If you use both Contact Center Client and Multimedia Contact Center, you can instruct Contact Center 
Client to automatically launch Ignite after you log into your phone. This enables you to launch one appli-
cation to handle both voice and multimedia. If you choose the ‘Remember Me’ option on the Ignite Sign 
In screen, Ignite launches and automatically logs you in.
This option can be saved to your Contact Center Client profile. However, the option is only available when 
using PhoneSet Manager and Contact Center Softphone.
To automatically launch Ignite upon voice login 
1. Open Contact Center Client and click the File icon.
2. Select your profile name and click OK. 

NOTE: If you have not configured a profile, see "Setting up the soft phone" in the MiContact Center 
Business User Guide.

3. In the ribbon, select Soft Phone and click the Soft Phone icon.

4. In the Soft phone configuration window, select the Automatically launch the Ignite Client on ACD 
login check box.

5. Click OK.

6. On the ribbon, click Save.

NOTE: If you are running the MiCollab Client Ignite integration, when you log into MiCollab Client, Ignite is 
automatically launched. You can set your profile to also automatically launch MiCollab Client when you 
start and log into Ignite. See "General settings (DESKTOP)".
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Viewing and organizing interactions in Ignite (DESKTOP)

Agents can view, organize, and search for interactions using Ignite’s Folders pane and List pane.
Selecting a folder in the Folders pane displays its contents in the List pane. Agents can organize how 
Folder content displays in the List pane. These options vary depending on whether the List pane is in Card 
view or Grid view.
Under My Folders, agents can only view interactions that they personally have handled. For queues, 
agents can only view interactions sent to the queues for which the agent answers. To view interactions 
handled by other agents in the queue you must search the Processed folder.
Employees licensed as Advanced supervisors or System Administrators may search Ignite’s entire repos-
itory. This includes Ignite's In Progress folder (DESKTOP), which enables supervisors to see interactions 
currently in agent Inboxes. This search capability does not require Multimedia Contact Center licensing. 
However, to view and search interactions in queue using Ignite, employees must have a Multimedia 
Contact Center license and multimedia agents assigned to the queue.
Descriptive information on folders in Ignite can be found in "Getting started with Ignite (DESKTOP)".
The following sections explain 
• Choosing how interaction data displays in the List pane’s Card view
• Choosing how interaction data displays in the List pane’s Grid view
• Searching Ignite's folders

Choosing how interaction data displays in the Card view (DESKTOP)

By default, interactions in the List pane Card View are sorted in the following order:
1. By media type – voice, email, chat, SMS, or open media
2. By Service Level – Expired first, then in order of the least amount of time remaining to the highest 

amount of time remaining

3. By time waiting in queue

This order prioritizes real-time interactions, and places interactions with the lowest Service Level time or, 
if expired, the longest waiting time, at the top of the list.
Agents can choose how and what interaction data displays in the List pane’s Card view.
The following procedures explain how to
• Group interactions in a selected folder
• Ungroup interactions in a selected folder
• Sort interactions by a single condition and remove this condition
• Sort interactions by multiple conditions and remove these conditions
• Restore default sorting conditions
• Filter interactions in a folder and remove filters

To group interactions in a selected folder
1. From the Folders pane, select a folder in which to group interactions.
2. In the List pane’s Card view, after No Group, select the drop-down list.

3. Select a grouping condition from the drop-down list. Beside each condition, Ignite indicates the 
number of items currently displayed. To display more, click Show more results ….
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4. Expand individual rows to see interactions matching the grouping criteria. Expand all rows by clicking 
the plus icon beside the grouping conditions drop-down list.

To ungroup interactions in a selected folder
1. From the Folders pane, select a folder for which you want to remove grouping conditions.
2. In the List pane’s Card view, after No Group, select the drop-down list.

3. Select No Group.

To sort interactions by a single condition and remove this condition
1. From the Folders pane, select a folder in which to sort interactions.
2. In the List pane’s Card view, after Custom, select the drop-down list.

3. Select a sorting condition from the drop-down list.

4. Optionally, order the sorted interactions in ascending or descending order by selecting the Sort 
Ascending or Sort Descending buttons.

5. To remove the sorting condition, select the drop-down from which you selected the sorting condition 
and select No Sort.

To sort interactions by multiple conditions and to remove these conditions
1. From the Folders pane, select a folder in which to sort interactions.
2. In the List pane’s Card view, click Custom Sorting.

3. From the drop-down lists, select sorting conditions. Ignite prioritizes the conditions you select by the 
order in which they display in this pane.

4. Optionally, for each condition, order the sorting interactions in ascending or descending order by 
selecting the Sort Ascending or Sort Descending buttons.

5. Click Apply.

6. To remove custom sorting conditions, click Custom Sorting > Clear.

7. Click Close.

To restore default sorting conditions
1. From the Folders pane, select the folder to restore default sorting conditions.
2. In the List pane’s Card view, click Custom Sorting.

3. Click Defaults.

NOTE: For the Processed folder, clicking ‘Defaults' removes all sorting conditions.
4. Click Close.

To filter interactions in a folder and remove filters
1. From the Folders pane, select a folder in which to filter interactions.
2. In the List pane’s Card view, type filter keywords over the ghost text in Filter and press Enter.

3. Remove filters by clicking the x button.
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Choosing how interaction data displays in the Grid view (DESKTOP)

In the Grid view, agents can choose the interaction data displaying for the selected folder and can 
customize the order of columns appearing in the grid. Agents can sort and filter column data to further 
customize the data displaying for the selected folder.
NOTE: To complete the following procedures, expand the Card view’s right-hand borders until the List 
pane displays in Grid view.
The following procedures explain how to 
• Choose the data columns that display
• Restore data columns to the default view
• Change data column order
• Group column data using drag-and-drop functionality

To choose the data columns that display 
1. From the Folder pane, select a folder.
2. Click the Show column chooser button.

3. Select data columns to display. Deselecting data columns removes them from display. 

The following figure lists the interaction statistics you can choose to see in the Grid view.
NOTE: Column availability depends on the folder selected.

4. When finished, click Close.

To restore data columns to the default view 
• Click the Reset grid to defaults button.
Table 24.30:Column data in the List pane's Grid view  (Sheet 1 of 3)

Column heading Data displayed

Agent Received The time at which the interaction arrived in the agent's Inbox

Agent Time How long since the interaction arrived in the agent’s Inbox

Case ID The case number associated to the interaction
Not applicable to voice or chat

Collected Information Digits collected from the caller, such as an account number
Not applicable to email and chat

From Address Email: The interaction’s ‘From’ email address
Chat: The interaction’s ‘From’ email address as entered on the chat request 
form
SMS: The interaction's 'From' SMS number

From Name Voice: The Caller ID, if supported by the customer
Email: The name associated to the interaction’s ‘From’ email address
Chat: The name as entered on the chat request form
SMS: The interaction's 'From' SMS number

Dialable The dialable number of the queue
Not applicable to email, chat, or SMS
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Last Agent Action The last action taken by the agent on the interaction
Not applicable to voice

Last Agent ID 
Response

The reporting number of the agent who last responded to the interaction

Last Agent Response The time since the agent last responded to the interaction

Last Agent Response 
Date/Time

The date and time since the agent last responded to the interaction

Last Customer 
Response

The time since the customer last responded to the agent

Last Handled Agent 
Name

The name of the agent who last handled the interaction

Media The interaction’s media type

Position The interactions position in queue

Priority The priority level of the queue the interaction is in. 64 is the default

Queue The queue in which the interaction is sitting

Queue Received The time at which the interaction entered the queue

Queue Reporting The reporting number associated to the queue

Queue Time How long interaction has been waiting in queue

Reporting The queue’s reporting number

Retries Exceeded Whether the interaction’s maximum send attempts have been exceeded
Not applicable to voice, chat, or SMS

SL Countdown The amount of time in which an agent has to respond to an interaction 
before the Service Level timer expires
The timer begins counting down once an interaction arrives in an agent’s 
Inbox. The timer stops counting once an agent clicks ‘Reply’

State The current state of the interaction
Also indicates if a server request is pending. For example, this column 
indicates if the server is processing a request to transfer the interaction to a 
different agent or queue

Subject Email: The subject line of the email
Chat: The pre-chat topic as entered on the chat request form
SMS: The first 40 characters of the SMS message
Not applicable to voice

Table 24.30:Column data in the List pane's Grid view (Continued) (Sheet 2 of 3)

Column heading Data displayed
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To change data column order 
• Drag and drop a column into the desired position. Animated arrows display when a column can be 

dropped into position.
To group column data using the drag-and-drop functionality
NOTE: When grouping with the drag-and-drop method, animated arrows indicate when an item can be 
dropped into position. 
1. From the Folders pane, select a folder.
2. In the List pane’s Grid view, drag and drop a column to the Drag columns here to group section of 

the Ignite UI.

3. Expand or close the data rows by clicking the arrow button beside the rows of filtered data. To expand 
all rows, click the Expand group headers button. 

See the following figure.
4. To remove a row, drag the column header from the Drag columns here to group section back to the 

column headers in the Grid view.

Figure 24.40: The Expand group headers button
 

System Received For inbound email interactions, the date/time that an interaction was 
received by the mail server
For inbound chat and SMS interactions, the date/time that an interaction 
was received by the media server
For outbound interactions, the date/time that an interaction was initiated by 
an agent

System Time How long since the interaction entered Multimedia Contact Center

Ticket ID The ticket number associated to the interaction
Not applicable to voice

Transfers How many times an interaction has been transferred, interflowed, or 
re-queued

Table 24.30:Column data in the List pane's Grid view (Continued) (Sheet 3 of 3)

Column heading Data displayed
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Ignite's Realtime Monitor (DESKTOP)

Ignite’s Realtime Monitor displays current statistics for devices including queue groups, queues, agent 
groups, agents, and employees. Ignite’s Realtime Monitor enables you to navigate efficiently through a 
hierarchy of devices and see associations among them. Pinning items to the Realtime Monitor lets you 
see only the items associated to the pinned item.
Color bars on each device statistic window indicate the device’s state. You can use these bars to view 
device availability. To see the states indicated by each color, see "The Status bar (DESKTOP)".
The following procedures explain how to 
• Viewing device statistics in Realtime Monitor
• Pinning items in the Realtime Monitor

NOTE: For a description of statistics viewable in the Monitor, see "Realtime Monitor statistics available in 
Ignite (DESKTOP)".

Viewing device statistics in the Realtime Monitor (DESKTOP)

The following procedures explain how to
• Toggle through multimedia devices
• View real-time statistics for select items and clear selections
• Search for device items
• Clear searches

To toggle through multimedia devices
• Select the Realtime Monitor tab and select either Queue Group, Queue, Agent Group, Agent, or 

Employee.
To view real-time statistics for select items and clear selections
1. Select the Realtime Monitor tab and select either Queue Group, Queue, Agent Group, Agent, or 

Employee.
2. Select the radio-button for the item you want to display.

NOTE: Select multiple devices by holding 'Shift'. Optionally, display all items by clicking Select All.
3. To clear selections, deselect the associated radio buttons. Optionally, clear all selections by clicking 

Deselect All.

To search for a device item
NOTE: You can only search within, not between, multimedia devices.
1. Select the Realtime Monitor tab.
2. In the Search field, type the search keywords and click the Search icon.

3. Select the radio button for the item you want to display. Select multiple items by holding Shift. Option-
ally, display all items by clicking Select All.

NOTE: Icons beside media-specific devices identify an item's media type. For example, an email icon 
identifies an email queue.

To clear a search
• In the Search pane, select the x button.



1016

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Pinning items in the Realtime Monitor (DESKTOP)

You can pin items in Ignite’s Realtime Monitor. Once an item is pinned, the Monitor displays only the other 
items associated to the pinned item.
For example, when the contact center is busy, the agent group answering emails for the Training queue 
is offered emails from the Support queue. An agent in Training wants to transfer a support-related email 
back to the Support agent group, but needs to see who is available to take the email. In the Realtime 
Monitor, the agent pins the ‘Support’ agent group. When the agent toggles the Monitor to agent statistics, 
only agents in the Support group display. The Training agent can see who is available in Support to 
receive the transfer.
The following procedure explains how to pin items to the Monitor and remove pins.
To pin an item to the Monitor and remove pins 
1. Click Realtime Monitor and select either Queue Group, Queue, Agent Group, Agent, or 

Employee.
2. Click the pin icon on a device item. Toggling devices displays only items associated to the pinned 

item. 

NOTE: To view statistics for additional items, select them in the device pane. To revert back to 
viewing only statistics associated to the pinned item, click ‘Select Related Only’.

3. To remove a pin, click the pin icon again. Alternatively, click the X button in the device pane. 

See the following figure.

Figure 24.41: Device pane button to unpin an item
 

Realtime Monitor statistics available in Ignite (DESKTOP)

See the following tables for definitions of the real-time statistics available by device.
Statistics in the Realtime Monitor dynamically update as device conditions change. Color bars on each 
device statistic window indicate the device’s state. You can use these bars to view device availability. To 
see the states indicated by each color, see "The Status bar (DESKTOP)".
NOTE: 
• The specific statistics displaying in the Agent Realtime Monitor vary by media type.
• Interflow statistics include interactions manually transferred from one queue to another.
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Table 24.31:Queue Group Statistics

Monitor field Statistic

Available Agents The number of agents available in the 
queue group's answering agent groups

Offered The number of interactions sent to the 
queue that were completed, interflowed, 
or abandoned

Handled The number of interactions dealt with by 
agents in the queue group's answering 
agent groups

Interflowed The number of interactions redirected 
from queues in the group to an alternate 
answer point, such as another queue or, 
for email, an external email address

Abandoned The number of interactions sent to queues 
in the group, where the customer 
disconnected before reaching an agent
Not applicable to email and SMS

Requeued The number of interactions sent back to 
the queues after being offered to an agent 
answering for the queues

Table 24.32:Queue statistics  (Sheet 1 of 2)

Monitor field Statistic

Contacts Waiting The number of interactions waiting in queue to be handled

Longest Waiting The amount of time an interaction has been waiting in queue the longest

Offered The number of interactions sent to the queue that were completed, 
interflowed, or abandoned

Handled The number of interactions dealt with by agents in the queue’s answering 
agent groups

Interflowed The number of interactions redirected from the queue to an alternate 
answer point, such as another queue or, for email, an external email 
address

Abandoned The number of interactions received by the queue where the customer 
disconnected before reaching an agent
Not applicable to email and SMS

Service Level % The percentage of interactions handled, abandoned (voice and chat only) 
and interflowed before the defined Service Level time
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Employee statistics
The following employee statistics display in the Realtime Monitor 
• Employee name
• Employee ID

Abandoned % The percentage of interactions affecting Service Level that were 
abandoned
Not applicable to email and SMS

Requeued The number of interactions sent back to the queue after being offered to 
an agent

Table 24.33:Agent Group statistics

Monitor field Statistic

ACD The number of ACD interactions handled by agents in the agent group.

Non ACD The number of Non ACD interactions handled by agents in the agent 
group. Not applicable to email, chat, SMS, and open media.

MKB The number of times agents in the agent group went into Make Busy

DND The number of times agents in the agent group went into Do Not Disturb

Hold The number of times agents in the agent group put interactions on hold

Table 24.34:Agent statistics

Monitor field Statistics

ACD Count The number of ACD interactions handled by the agent

Non ACD Count The number of Non ACD interactions handled by the agent
Not applicable to email, chat, SMS, and open media.

ACD Time The amount of the agent’s shift spent handling ACD interactions

Average Handled The average amount of time taken to handle ACD interactions

Outbound The number of outbound interactions made
Not applicable to email, chat, SMS, or open media

Outbound Duration The time spent on outbound interactions
Not applicable to email, chat, SMS, or open media

MKB Count The number of times the agent went into Make Busy

DND Count The number of times the agent went into Do Not Disturb

Table 24.32:Queue statistics (Continued) (Sheet 2 of 2)

Monitor field Statistic
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• The number of interactions handled for each media type 
NOTE: These statistics reset at midnight

• The employee's overriding state
• The time at which the employee first logged on, or the time at which the employee logged off 

NOTE: This data resets at midnight
• How long the employee has been logged on, or how long the employee has been logged off

Your Ignite profile (DESKTOP)

Ignite enables you to customize, organize, and change display elements to satisfy both personal prefer-
ences and work needs. The customizations and changes constitute your Ignite profile, associated to the 
username used to access Ignite.
Each time you close Ignite your profile is automatically saved. When Ignite is reopened with your user-
name, your most recent profile settings are reloaded. If Ignite shuts down suddenly, it resumes your last 
saved profile on restart.
Ignite always opens to the Inbox in the My Folders view. Ignite remembers the device monitors you had 
open in the Realtime Monitor view, if the Realtime Monitor view was open when Ignite was closed. Your 
profile does not reopen folders that were active when you last shut down Ignite.
Ignite remembers your changes to the following elements of Ignite:
• Ignite window size
• Position of Ignite on your screen
• Pane size
• Folder view:

– Queue folder sorting
– Selected queues to display

• Grid view:
– Displayed columns
– Column order
– Grouping

• Card view:
– Grouping
– Filtering
– Custom sorting

• Realtime Monitor:
– Device monitor last open
– Selected devices
– Pinned devices

You can reset your profile to Ignite’s default settings when logging into Ignite. Resetting your profile 
restores all elements to their default display.
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To reset your profile to the default settings
1. Log in to Ignite with your username and password.
2. As Ignite is signing you in, press and hold CTRL+ R. Hold these keys until Ignite indicates it is 

restoring your profile and loading the configuration.

In addition to auto-settings, Ignite offers general and Sidebar stats configuration options via the Settings 
button in the Sidebar.

General settings (DESKTOP)

By clicking the Settings button in the Sidebar and then clicking the General settings tab, you can 
customize Ignite display and behavior.
• Launch MiCollab Client if installed but not running when signing into Ignite: This setting is 

selected by default and automatically opens MiCollab Client, if not currently running, when an agent 
signs into Ignite.

NOTE: You will be prompted to register and log in your voice agents in MiCollab Client before signing 
into Ignite.

• Always show Sidebar: This setting is checked by default. If unchecked, you will not have access to 
the options listed below and you will need to use the arrow icon to show or hide the Sidebar.

• Expand Ignite when a multimedia item is accepted: This setting is checked by default. When 
selected, if the main Ignite window is collapsed and an email, chat, SMS, or open media is accepted 
via the toaster, the main Ignite window automatically expands. If not selected, Ignite will not automat-
ically expand when an email, chat, SMS, or open media is accepted and the agent must expand it 
manually by clicking the arrow at the bottom of the Sidebar.

• Expand Ignite when a voice item is accepted: This setting is not checked by default and if the main 
Ignite window is collapsed and a call is accepted via the toaster, Ignite does not automatically expand. 
We recommend deselecting this setting as the main Ignite window is not essential for handling voice 
interactions. If selected, if the main Ignite window is collapsed and a call is accepted via the toaster, 
Ignite automatically expands.

• Collapse Ignite on startup: This setting is not checked by default. When you start Ignite, the main 
window will not collapse. If this check box is selected, only the Ignite Sidebar displays at startup. You 
can use the arrow icon at the bottom of the Sidebar to expand the main Ignite window. If this setting is 
not selected, when you start Ignite the main window and the Sidebar will display.

• Collapse Ignite when inbox is emptied: This setting is not checked by default. When selected, and 
your inbox empties, the main Ignite window collapses. If not selected, the main Ignite window does not 
collapse when your inbox has been emptied.

Sidebar stats settings (DESKTOP)

By clicking the Settings button in the Sidebar and then clicking the Sidebar Stats settings tab, you can 
select which three agent handling statistics you want to display in the Ignite Sidebar.

Queue selection settings (DESKTOP)

You can select which queues are visible by clicking the Settings button in the Sidebar and clicking Queue 
Selection. You are still offered interactions for the queues to which you are assigned, even though they 
may not be visible.
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Ignite can display a maximum of 64 queues. If your profile is new, from an upgrade, or has been restored 
from a reset, Ignite automatically loads the maximum number of queues, starting with Unified Queues and 
then Individual Queues. Queues under Reporting Queues are never loaded by default.

Agent Greeting settings (DESKTOP)

The Agent Greeting feature enables agents to record messages (as .wav files) that play automatically to 
callers when the agent answers an inbound ACD call. The greeting can provide a consistent experience 
for each caller and free the agent from having to repeat the same introductory phrase for every call.
Agents can record multiple greeting messages in Ignite and assign them to different queues or use the 
same recorded greeting on all queues. The agent greeting is a two-way playback, where both the caller 
and the agent hear the recording.
Agents record and manage their greetings on the Agent Greeting tab on the Settings page.
NOTE: 
• When the agent greeting is playing, the caller is able to hear the agent speaking. To prevent the caller 

from hearing the agent or other contact center background noise during the agent greeting, mute the 
agent's headset for the duration of the greeting.

• Administrative settings determine whether you have access to Agent greeting functionality. If your 
contact center is not enabled for agent greetings, the Agent Greeting tab will not display in Ignite.

On the Agent Greeting tab, you can: 
• Record greetings
• Assign greetings to specific queues
• Designate a recording as the default greeting
• Play or re-name an existing greeting
• Re-record or delete an existing greeting

Recording agent greetings (DESKTOP)
When you click the Record button to create a recording, the system's Record Agent Greeting workflow is 
triggered. The Record Agent Greeting workflow instructs the system to call your DN and prompts you to 
record and save a greeting.
NOTE: When recording messages, your voice agent is in a Non ACD state, and is not offered calls from 
any incoming queues.
To record your first agent greeting 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. Hover over the Add New Recording label to make the Record button visible on the right-hand side.

3. Click the Record button.

4. Enter a name for the recording and click OK. 

The Record Agent Greeting workflow is triggered and instructs the system to call your DN.
5. Answer the incoming call and follow the system prompts to record and save your greeting. 

The new greeting displays under the Default Recording heading.

By default, the system selects the first recording as your default recording. The default recording is played 
on all incoming calls, regardless of the originating queue, unless there is a specific recording assigned to 
the queue. For more information, see "Assigning a recorded greeting to a queue (DESKTOP)".



1022

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

You can record additional greetings and designate any one of your saved recordings as the default 
recording, or you can choose not to use a default recording.
To record additional greetings 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. Click on the down arrow beside the Advanced Options heading to expand the section.

3. Hover over the Add New Recording label to make the Record button visible on the righthand side.

4. Click the Record button.

5. Enter a name for the recording and click OK. 

The Record Agent Greeting workflow is triggered and instructs the system to call your DN.
6. Answer the incoming call and follow the system prompts to record and save your greeting. 

The new recorded message displays under the Recordings heading.
7. Repeat steps 3 to 6 to record additional greetings.

Assigning a recorded greeting to a queue (DESKTOP)
By default, the recording listed under the Default Recording heading on the Agent Greeting tab is played 
on all incoming calls, regardless of the originating queue. However, you can assign different recordings 
to different queues if you want to customize your greeting for certain inbound calls.
NOTE: If you do not have a designated default recording, you must assign a recording to each queue 
explicitly. If there is no default recording, and a queue does not have a recording assigned to it, no 
greeting is played to customers on incoming calls from that queue.
The Queues section of the Agent Greeting (under Advanced Options) lists all of the queues to which you 
are assigned. The recorded greeting that plays on incoming calls from a queue is shown to the right of 
the queue name.
To assign a recording to a queue 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. Click on the down arrow beside the Advanced Options heading to expand the Advanced Options 

section.

3. Under the Queues heading, select the queue to which you want to assign a recording by selecting 
the check box beside it. 

– You can search for a specific queue by typing the name in the Search box.
– You can filter the list of queues to show only the queues that do not have the default recording 

assigned to them by clicking the Only Show Non-Default option.

4. Click the Apply Recording button. 

The Apply Recording window opens. The selected queue is displayed at the top, and a list of available 
recordings displays below.

5. Hover over the recording you want to assign to the queue to make the check mark visible on the 
right-hand side.

6. Click on the check mark to apply the selection. 

The check mark turns green and the new recording displays beside the selected queue in the Queues 
list on the main Agent Greeting tab.
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7. To remove the custom greeting from the queue and revert back to using the default recording, click 
the X button beside the recording you just assigned to the queue. 

The Default Recording label displays beside the queue.

Managing recorded greetings (DESKTOP)
You can review, modify, and delete existing recordings in Ignite. You can: 
• Play a greeting
• Re-record a greeting
• Rename a greeting
• Designate a greeting as the default greeting
• Delete a greeting

To play a greeting 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. To select a non-default greeting, click the down arrow beside the Advanced Options heading to 

expand the section.

3. Under the Recordings section, hover over the name of the recording in the list to make the row of 
icons visible on the right-hand side.

4. Click the Play button (second icon from the left). 

The system plays the recorded greeting on your PC.

To re-record a greeting 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. Click on the down arrow beside the Advanced Options heading to expand the section.

3. Under the Recordings section, hover over the name of the recording in the list to make the row of 
icons visible on the right-hand side.

4. Click the Record button. 

The Record Agent Greeting workflow is triggered and instructs the system to call your DN.
5. Answer the incoming call and follow the system prompts to record and save your greeting. 

The changes are saved to your existing recording.

NOTE: You can also re-record the default greeting. Hover over the greeting listed under the Default-
Greeting header and click the Record button (as noted above) to re-record the greeting.
To rename a greeting 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. Click on the name of the recording you want to rename (either in the Default Greeting section or the 

Recordings section). 

The name field becomes editable.
3. Type the new name of the recording in the name field, then click Rename. 

The recording displays in the list with the new name.
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To designate a greeting as the default greeting 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. Hover over the name of the recording in the list to make the row of icons visible on the righthand side.

3. Click the Pin button to make the greeting the default greeting. 

The newly-designated greeting displays in the Default Recording section.
4. To clear the default recording designation, hover over the name of the default recording to make the 

row of icons visible, and click the Pin button. 

The greeting is removed from the Default Recording section.

To delete a greeting 
1. Click the Settings button in the Sidebar, then click the Agent Greeting tab.
2. Hover over the name of the recording in the list to make the row of icons visible on the righthand side.

3. Click the Trash button to delete the greeting. 

The system displays a confirmation dialog.
4. Click Yes to confirm that you want to delete the greeting. 

The greeting is removed from the system.

Getting started with Ignite (WEB)

The following sections provide a walkthrough of Ignite’s interface. While this section contains some proce-
dures for viewing and orienting Ignite, agents can access in-depth information on how to use Ignite by 
following the cross-references throughout.

Feedback (WEB)

The Feedback button enables you to submit feedback and suggestions to Mitel. (See the following figure.) 
For information about submitting feedback, see "Posting feedback and viewing our forums (WEB)".

Figure 24.42: Feedback button
 

Ignite Icons

Use the Ignite Web icons to perform actions on contacts, cases, and interactions. The icons are described 
in the the following table.
Table 24.35:Ignite icons  (Sheet 1 of 4)

Icon term

 

Add
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Accept

Apply Code

Associate Participant

Cases Inqueue

Case

Call

Conference

Cut from case

Decline

Dissociate Participant

Edit

Email

Export to csv

Table 24.35:Ignite icons (Continued) (Sheet 2 of 4)

Icon term
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Flag for follow up

Follow up Calendar

Forward

Go to

Hold

Import Contacts

Invite

Junk

Merge

No Reply

Pending

Print

Reply

Table 24.35:Ignite icons (Continued) (Sheet 3 of 4)

Icon term
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Contacts (WEB)

The Contacts button enables you to search for contacts and communicate with them by Voice, Email, 
Chat, or SMS.

Figure 24.43: Contacts button
 

Using the Contact button in Ignite, agents can search for employees who are configured in YourSite 
Explorer and Active Directory as well as contacts who have been added as customers. They can also 
search for queues. By default, when clicking the Contact button all contacts are available to be searched 
but agents can filter their search by Employees, Queues, Active Directory, and External.
NOTE: For an Active Directory contact to be displayed in a Web Ignite contact search, at least one of the 
following must be configured for the contact: email, phone number, or mobile phone number.
Contacts that you have often contacted are listed under Contact History. You can edit or delete a contact 
that is listed in Contact History. Hover over the contact avatar and click Edit to modify the contact infor-
mation, or click the X button to remove the contact from Contact History.
Agents can view cases associated with a contact thus enable them to have an overview about the 
customer’s calls before handling the customer issue.

Reply All

Request Help

Resolve

Send

Swap

Text

Transfer

Table 24.35:Ignite icons (Continued) (Sheet 4 of 4)

Icon term
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For information on using Contacts, see "Sending outbound emails", "Sending outbound SMS contacts", 
or "Making calls".
The following section explains how to 
• Add new contact information
• Edit an existing contact information
• Import contacts from .CSV files
• View cases associated with a contact
• Merge Contacts

To add contact information 
1. Click Contacts, and click Add Contact.
2. Provide all necessary information and click Save.

To edit an external contact information 
1. Click Contacts. In the Search field, type the external contact name you want to edit. A list of contacts 

matching the search are displayed.
2. Hover over the contact avatar and click Edit, or click the contact and then click Edit.

3. In the Edit Contact window, under Details tab, modify contact information and click Update. 

If history information is available for the selected contact. You can view information such as old phone 
numbers or old email addresses, are listed under History tab.

NOTE: Agents can also edit contact information during an interaction. For example, an agent in the 
Sales queue is on a call with a customer and updates the customer’s email address or mobile 
number. The agent can now view the updated contact information and, if required, can transition to 
an alternate interaction type, such as email.

To import contacts from CSV file 
1. Click Contacts and then click Import Contacts.
2. In the Import Contacts window, click Browse to select a .csv file and import all contacts from it. 

NOTE: .csv file contains a list of personal contacts in the “Name, Email, Phone number, Mobile 
number” format.

For example: Jon Doe,jon.doe@email.com,6137109876,6137658765
Scott Alan,scott.alan@express.com,,5879856541
Jon Doe,,5096308945

3. Click Import. 

Ignite confirms the import by displaying the following message “Contacts imported successfully”.

NOTE: If the CSV file contains duplicate records, the system alerts you; based on the preferences set in 
the Customization page, the import action is either terminated or continued. Ignite confirms the import 
status by displaying a message; for example, “Process completed. 10 successful, 2 already exists, 3 
unknown”.
To view cases associated with a contact 
1. Click Contacts. In the Search field, type the contact name you want. A list of contacts matching the 

search are displayed.
2. Hover over the contact avatar and click Cases. 

The Cases that the employee is associated to are displayed.
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Merge External Contacts
As an agent or supervisor, you can manually merge two external contacts to clean up duplicate contacts.
For example, you can merge duplicate contacts with the following information:

After you merge two contacts, the resultant contact is as shown below:

To merge external contacts 
1. Click Contacts, and in the Search field, type the contact name. 

Ignite displays a list of contacts matching the search.
2. Under Results, hover over the source contact avatar and click Merge. Alternately, click the source 

contact and then click the Merge icon. 

The Merge Contacts window is displayed with details for the selected source contact.
3. In the Merge Contacts window, in the Search field, type the target contact name. 

Ignite displays the contact you have searched for.
4. Hover over the target contact avatar and click to select it and click OK. 

In the Merge contacts window, the source and target contact details are displayed.
5. In the Merge Contacts window, from Select Fields, select the contact details you want to display in 

the merged contact. The selected details are displayed under Result Contact. A dialog box appears, 
displaying the message: “Are you sure you want to merge these contacts?”.

6. In the dialog box, click OK to merge the contacts. 

NOTE: When you merge external contacts, the changes are updated in cases and their associated 
calls.

Avatar and agent state (WEB)

The avatar displays your agent avatar, your agent’s first name, your current state, and how long you have 
been in that state. (See the following figure.)

Figure 24.44: Avatar and agent state

CONTACT 
NAME EMAIL PHONE

EXTENS
ION MOBILE PHONE

Juan 4556677999 333 9454345444

Juan Mata Juan.matta@as.com 4556677999 334 ;

CONTACT NAME EMAIL PHONE
EXTENSI
ON MOBILE PHONE

Juan Mata Juan.matta@as.com 4556677999 334 9454345444
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The color of the circle over the avatar indicates your current presence. 
• Green—Indicates an Available state
• Red—Indicates an ACD or Do Not Disturb state
• Yellow—Indicates a Make Busy or Work Timer state, or that the agent is logged in, but not present in 

any of their agent groups
• Blue—Indicates that the agent is in a Non ACD state
• Gray—Indicates the agent is logged out or otherwise unavailable

If you have been enabled to adjust your agent group presence and agent state, you can click your avatar 
to both view and change your agent group presence or agent state. For information on your agent state, 
see "Viewing agent state and state statistics (WEB)".
For information on changing your agent group presence and status, see "Managing agent group presence 
and agent states".
For information on changing your avatar, see "Your Ignite profile (WEB)".
Viewing agent state and state statistics (WEB)
The agent state section of the Avatar displays the employee’s overriding state, including: 
• Ringing – Displays when an employee has interactions ringing in the Inbox
• ACD– Displays when an employee is handling ACD interactions
• ACD Hold – Displays when an employee has placed ACD interactions on hold or have themselves 

been placed on hold during an ACD call
• Non ACD – Displays when an employee is handling Non ACD interactions
• Non ACD Hold – Displays when an employee has placed Non ACD interactions on hold or have them-

selves been placed on hold during a Non ACD call
• Outbound – Displays when an employee has placed an outgoing call
• Outbound Hold – Displays when an employee has placed an outgoing call on hold or have them-

selves been placed on hold during an Outbound call
• Work Timer – Displays after an employee has handled an interaction, provided none of an employee’s 

agents are in an ACD, Non ACD, Outbound, Make Busy, or Do Not Disturb state
• Do Not Disturb – Displays when the employee is in a Do Not Disturb state
• Busy – Displays when an employee is in a Make Busy state
• Away (Not Present) – Displays when an employee is not present in any of their agent groups
• Offline – Displays when an employee is signed in, but their agents are logged out
• Reseize Timer – Displays when a call fails to route to an employee
• Available – Displays when an employee does not have inbound interactions in the Inbox

 
An overriding state is a state that supersedes other states. States higher in the list override the states 
appearing lower in the list. Note that all an employee’s agents are considered when the system calculates 
the overriding state.
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The oldest length for a state supersedes other times for the same state if an agent is handling multiple 
interactions. For example, if an employee had two emails in ACD, the displayed value in the status bar 
would be the time of the oldest email. When the oldest email is completed, the displayed value in the 
status bar would switch to the time of the other email.
Agent states by media are available in the Inbox. For more information, see "Viewing agent handling 
statistics (WEB)".

List pane (WEB)

Ignite’s List pane displays the contents of folders selected in the Folders pane.
In the Inbox, the History, and the Queues pages, you can switch between Grid view and List view. In Grid 
view, all interactions for the selected page are displayed in a grid format.
Click Grid on the page to display interactions in Grid view.
NOTE: Grid view is not supported on mobile devices
The following procedures explain how to 
• View data in each column
• Choose columns to display in the grid
• Restore data columns to the default view
• Change data column order
• Sort column data in Ascending or Descending order
• Remove Ascending / Descending sort
• Hide column(s) from grid
• Group column data by specific column headers
• Ungroup column data

To view data in each column
You can click anywhere on the row for that interaction to select an interaction, select the check box for 
that interaction. You can select multiple interactions. You can also customize the order in which columns 
appear in the grid. This allows you to view all the interaction properties at once and to sort or group by 
specific interaction properties.
To choose columns to display in the grid: 
1. Select a page and in Grid view, click the Show column chooser button at the top-right of the grid. A 

list of available columns displays.
2. Click the columns you want to display in the grid. A tick mark against the column name indicates that 

it is selected, and an X mark indicates that it is not selected. 

NOTE: An administrator can enable a custom variable in the YSE application by selecting the Send to 
agent desktop check box. For more information about custom variable creation, see "Creating Custom 
Variables".
To restore the grid data columns to the default setting 
1. Click Options > Customization.
2. Under Grid settings reset, click the page button (i.e. Inbox, History, Queue) to reset.

To change data column order 
• Drag and drop a column to the desired position.
To sort column data in Ascending or Descending order 
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• On the column header, click the drop-down arrow, and select Sort Ascending/ or Descending. 
The selected column’s data are sorted in ascending or descending.

To remove ascending / descending sort 
• On the column header, click the drop-down arrow and select Remove Sort. 

The column data are restored to the default.

To hide column(s) from the grid 
• On the column header, click the drop-down arrow, and select Hide Column. 

The selected column is hidden from the grid.

To group column data by column headers 
1. On the column header, click the drop-down arrow, and select Group. 

The selected column data are grouped.
2. Click Expand button to expand all rows of the grouped column data. 

NOTE: You cannot group the following column headers: Interaction Id, System Received, Action 
Time.

To ungroup column data 
• On the column header, click the drop-down arrow and select Ungroup. The column data are 

ungrouped and restored to the default.

Dashboards

The Dashboards page enables you to customize different dashboard displays of information relevant to 
your agent. You can add the following widgets to a dashboard:
• Employee State
• Callback Request
• Queue Now
• Agent State
• Web Browser

For more information on creating dashboards, see "Configuring Ignite (WEB) dashboards".

Inbox (WEB)

Ignite’s Inbox displays all interactions currently handled by the employee, ringing the employee, drafts, as 
well as failed send and autoreply items belonging to the employee.
When there is an active interaction or draft in the Inbox, a red badge appears over the Inbox icon, indi-
cating how many interactions and drafts there are in the Inbox.
When you select an interaction in Inbox, in addition to the handling options, you can quickly access the 
case details, notes, calls, all the participants of the case, other cases from the same customer, and URLs 
by using the corresponding tabs. This saves time when you are interacting with a customer. For more 
information about these tabs, see the "Cases (WEB)".
An agent can view any call’s variable values that contain a URL under a separate tab, URLs. The URLs 
tab consists of a drop-down with all the variables and their associated value (URL). By default, the first 
URL is displayed in the frame. To open the URL in a new window, click Open.
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Additionally, the Inbox displays current real time agent handling statistics. For more information, see 
"Viewing agent handling statistics (WEB)".
Viewing interactions in Inbox (WEB)
Interactions in the Inbox provide you with relevant information for handling the interaction. (See the 
following figure).

Figure 24.45: Interaction in Inbox
 

If the interaction is a draft, it will be labeled as such. When you select an interaction in your inbox, in addi-
tion to the handling options, you can quickly access the case details, notes, interactions, all the partici-
pants of the case, and other cases from the same customer by using the corresponding tabs. This saves 
time when you are interacting with a customer. For more information about these tabs, see the "Cases 
(WEB)".
If an interaction consists of an URL, an agent can view the URL under a separate tab, URLs. The URLs 
tab consists of a drop down with all the variables and their associated value(URL). By default, the first 
URL is displayed in the frame. To open the URL in a new window, click Open.
You can choose to view the interactions in List view or in Grid view by clicking the respective option. Also, 
you can choose to view the case details in the additional pane that appears in the Inbox when you click 
the down arrow in the top header of the Inbox. (See the following figure).

Figure 24.46: Active interaction

You can expand or collapse the navigation pane using the < and > buttons.
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Viewing agent handling statistics (WEB)
The Inbox contains agent handling statistics for each of the media types the agent handles. The following 
figure displays agent handling statistics across media types.

Figure 24.47: Inbox agent handling statistics (Average Handling Time)

Each media type’s icon indicates the corresponding state of the employee’s agents. The following table 
outlines the different states.
Table 24.36:Agent states  (Sheet 1 of 2)

STATE VOICE CHAT EMAIL SMS
OPEN 
MEDIA DESCRIPTION

Ringing An ACD interaction 
ringing on an agent, 
waiting to be handled

ACD An agent handling an 
ACD interaction

ACD Hold An agent who has 
placed an ACD 
interaction on hold

Idle An agent logged on 
and waiting to receive 
an interaction 

Non ACD -- -- -- -- An agent involved in 
an incoming Non 
ACD interaction or 
agent originated voice 
interaction

Non ACD 
Hold

-- -- -- -- An agent who has 
placed a Non ACD 
voice interaction on 
hold

Outbound -- -- -- -- An agent on an 
outgoing voice 
interaction

Outbound 
Hold

An agent who has 
placed an outgoing 
voice interaction



1035

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

The Inbox offers five different types of handling statistics: 
• ACD (Count / Duration) -- Displays the number of ACD interactions the agent has handled for a media 

type, and the time spent handling interactions of that media type
• Non-ACD (Count / Duration) -- Displays the number of Non ACD interactions the agent has handled 

for a media type, and the time spent handling the interaction
• Average Handling Time (hours:mins:secs) – The average time the agent has taken to handle inter-

actions of each media type
• Unavailable % -- Displays the percentage of time the agent is unavailable during the shift, including 

Do Not Disturb, Make Busy, Unknown, and Work Timer states, and when the agent is logged in but 
not available to receive ACD interactions. (See the following figure.)

By clicking the More button, agents can change the statistics being displayed. (See the following figure.)

Do Not 
Disturb

An agent who has 
activated Do Not 
Disturb and is not 
available to receive 
any ACD or Non ACD 
voice interactions

Make Busy An agent who is not 
available to receive 
ACD interactions but 
can receive 
transferred 
interactions and voice 
interactions dialed 
directly to the agent

 Work Timer An agent who is 
completing 
post-contact work, 
such as paperwork, 
and is unavailable to 
receive interactions of 
that media type

Offline An agent unavailable 
to handle interactions

Away (Not 
Present)

An agent whose 
presence is removed 
from an agent group 
or media type

Table 24.36:Agent states (Continued) (Sheet 2 of 2)

STATE VOICE CHAT EMAIL SMS
OPEN 
MEDIA DESCRIPTION



1036

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

Figure 24.48: Inbox real-time statistics

History (WEB)

The History page contains a searchable archive of all calls handled by an agent as well as calls sent to 
the queues for which the agent answers. Agents can filter these historical interactions by type, limit the 
display interactions to items the agent has handled, or search for specific interactions.
Supervisors can filter all the interactions by type and also view the interactions that are being handled by 
agents and are in agent’s Inbox, or put on hold, or are in draft state. This gives the supervisor a better 
visibility into the interactions that are being handled by the agents.
NOTE: Supervisors will not be able view agents’ SMS interactions that are in draft state.
You can also reply to participants of all interactions (except Chat) from History. When you select an inter-
action in History, in addition to the handling options, you can quickly access the case details, notes, inter-
actions, all the participants of the case, other cases from the same customer, and URLs by using the 
corresponding tabs. This saves time when you are interacting with a customer. For more information 
about these tabs, see the "Cases (WEB)".
An agent can view any interaction’s variable values that contain a URL under a separate tab, URLs. The 
URLs tab consists of a drop-down with all the variables and their associated value (URL). By default, the 
first URL is displayed in the frame. To open the URL in a new window, click Open.
You can choose to view the interactions in List view or in Grid view by clicking the respective option. See 
the "List pane (WEB)".
For more information on filtering historical interactions, see "Filtering historical contacts (WEB)".
For more information on searching interactions in History, see "Searching ’s folders"
For more information on reviewing interaction history, see "Reviewing interaction history".
For more information on sending replies to participant(s), see "Replying to participant(s) of a case from 
History (WEB)".
Replying to participant(s) of a case from History
From the History tab, you can reply to email, SMS, or voice interaction without manually entering the 
participant’s contact details.
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The following are the important details you must note while sending email, SMS, and voice replies to the 
participants: 
• You can reply to a participant of a single case at a time.
• Participant’s contact details must be available.
• The interaction thread and Case Id are preserved.
• The ‘From’ address is pre-selected if and only if the last interaction is an email.
• The subject of the new interaction is prepended by ‘RE: the subject of the last interaction [case and 

ticket information]’ (i.e. RE: Test e-mail [CSE: Case: Ticket Information]) if and only if the last interac-
tion is an email.

• By default, the status of the case is “Waiting For Customer”, if the case requires more follow-up, the 
agent has to manually change the state of a case to “Follow up required”.

To send email replies to participant(s) of a case from History 
1. Click History and, optionally, select a Filter:.
2. From the list of interactions, click any interaction you want, or, optionally search for the interaction.

3. To select a participant, in the Participants tab, highlight the participant record you want and click 
Email button

4. To select all or some participants, in the Participants tab, hover over the participant’s avatar and click 
to select all or some participants and click Email button. 

In the email reply editor, the participant’s email address is automatically inserted in the To field. The 
subject of that email is prepended by ‘RE: the subject of the last email interaction [case and ticket in-
formation]’.

5. Type the content and click Send.

To send an SMS reply to a participant of a case from History 
1. Click History and, optionally, select a Filter:.
2. From the list of interactions, click any interaction you want, or, optionally search for the interaction.

3. In the Participants tab, highlight the participant record you want, or, hover over the participant’s 
avatar and select.

4. Click Text button. 

The participant’s phone number is automatically inserted in To field. Click From to select the SMS 
queue before sending the reply message.

5. Type the reply message and press Enter.

To call back a participant of a case from History 
1. Click History and, optionally, select a Filter:.
2. From the list of interactions, click any interaction you want, or, optionally search for the interaction.

3. In the Participants tab, highlight the participant record you want to dial to, or, hover over the partici-
pant’s avatar and select.

4. Click Call button.
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Cases (WEB)

The Case page contains searchable details for all cases that the employee can access. Agents and 
supervisors can quickly review all the key information related to case records without the need to select 
individual interaction.
For example, an agent in the Sales queue handling an email can review the interaction history for that 
case, or preview other interaction to that case. Agents can also move an interaction to or merge interac-
tions from another case.
NOTE: When upgrading from MiContact Center 7.x or 8.x or 9.x to MiContact Center Business 9.2 cases 
are automatically created for emails (beginning with the most recent email and ending with the oldest 
email). Emails that are associated to a particular customer calls are grouped within a single case to 
consolidate information.
In addition, contact information based on historic emails is added to the MiContact Center Business data-
base. For MiContact Center version 8.1 customers who implemented the Omni Channel Tech Preview 
cases are also created for SMS and Chat during an upgrade to MiContact Center Business version 9.2.
Cases are deleted when the email interaction related to the customer are all Junked. If an email is acci-
dentally set as ‘Junked’ and it would be the only item in a case, you must find and forward it to the 
customer to enable it to display in the list of cases.
For more information on handling cases in Ignite (WEB), see "Working with cases in Ignite(WEB)".

Queues (WEB)

Queues displays the queues and queue groups from which an employee’s agent handles interactions. 
Queues groups the display by queues groups and queues. There are three kinds of queue groups: 
• Unified Queue Groups—A collection of queues of different media types receiving interactions for a 

single service group. For example, a Unified Queue Group called ‘Technical Support’ can contain a 
voice, a chat, an email, and an SMS queue receiving tech support contacts.

• Reporting Queue Groups—A collection of queues, typically of a single media type, created for 
reporting purposes. For example, a collection of queues called ‘Email Technical Support’ can contain 
all email queues receiving tech support contacts.

• Virtual Queue Group—A collection of voice queues that offer calls to the same pool of agent groups, 
providing resiliency. For example, a collection of queues called ‘Sales’ can contain voice queues all 
routing calls to the same pool of agents handling sales calls.

Queues displays queues, both queues not associated to a queue group as well as queues belonging to 
queue groups. You can search for queues and queues to display or you can set queues and queue groups 
as favorites so that they always display when you go to Queues.
The Queues page contains a searchable archive of all calls sent to the queues for which the agent 
answers.
When you select a call in Queues, in addition to the handling options, you can quickly access the case 
details, notes, calls, all the participants of the case, other cases from the same customer, and URLs by 
using the corresponding tabs. This saves time when you are interacting with a customer. For more infor-
mation about these tabs, see the "Cases (WEB)".
An agent can view any interaction’s variable values that contain a URL under a separate tab, URLs. The 
URLs tab consists of a drop-down with all the variables and their associated value (URL). By default, the 
first URL is displayed in the frame. To open the URL in a new window, click Open.



1039

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

You can choose to view the interactions in List view or in Grid view by clicking the respective option. See 
the "List pane (WEB)".
Viewing queue groups and queues (WEB)
You must be licensed to handle a media type to view queues of that media type. Supervisors must also 
be configured as agents answering for the queue in order to see its contents.
Agents can pin queues and queue groups as favorites so that your most handled queues are always 
readily available. By selecting a pinned queue or queue group in the Queues page, agents can view inter-
actions in queue. Each queue and queue group indicate 
• The number of agents available in each queue’s answering agent groups. For reporting queue groups 

and unified queue groups, the total number of agents available for their component queues is 
displayed.

• The number of interactions in queue, or ‘interactions Waiting’, for the queue and the queue groups.
• The queue or queue group’s Service Level percentage.

Agents can search for pinned queues and queue groups by keyword. Ignite displays all queues and queue 
groups matching the keyword. The search remains until you navigate away from the Queues page. You 
can sort search results and favorites by name or queue media type. Sorting by name sorts the queues 
and queue groups alphabetically. Sorting by media arranges queues in the order of Chat, Email, SMS, 
and Voice and sorts queue groups in the order of Unified, Virtual, and Reporting.
The following procedures explain how to 
• Pin queues and queue groups as favorites
• Set queues and queue groups as favorites
• Sort queues by name
• Sort queues by media
• View Queues interactions

To pin queues or queue groups as favorites 
1. Click Queues.
2. Click the Select Favorite Queues button.

3. Select the queues and queue groups you want to favorite.

4. Click Save.

To search for a queue or queue group 
1. Click Queues.
2. In the Search field, enter the keyword.

To sort queues by name 
1. Click Queues.
2. Click Name.

To sort queues by media 
1. Click Queues.
2. Click Media.
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To view Queues interactions 
1. Click Queues.
2. From the queue groups, click the queue of your choice to view its interactions. 

A list of interactions for the selected queue is displayed.
NOTE: You can flip between List and Grid view.
3. Click the interaction of your choice to view its details in the right pane. 

NOTE: A Back link is available for you to navigate back to the Queues page.

Options (WEB)

The Options page enables you to customize your Ignite profile, set Ignite defaults, configure your exten-
sion, customize your email editor, and report performance issues. For more information, see "Your Ignite 
profile (WEB)", "Set email editor options", "Reporting performance issues in Ignite (WEB)", "Agent 
greeting settings (WEB)", and "Recording agent greetings (WEB)". When you click the Record button to 
create a recording, the system's Record Agent Greeting workflow is triggered. The Record Agent Greeting 
workflow instructs the system to call the dialed number and prompts you to record and save a greeting.
Agent greeting settings (WEB)
The Agent Greeting feature enables agents to record messages (as .wav files) that play automatically to 
callers when the agent answers an inbound ACD call. The greeting can provide a consistent experience 
for each caller and free the agent from having to repeat the same introductory phrase for every call.
Web Ignite allows the agents to record a single default agent greeting that can be assigned on all queues. 
The agent greeting is a two-way playback, where both the caller and the agent hear the recording.
Agents record and manage their default greeting on the Options > Phone page.
NOTE: 
• When the agent greeting is playing, the caller is able to hear the agent speaking. To prevent the caller 

from hearing the agent or other contact center background noise during the agent greeting, mute the 
agent's headset for the duration of the greeting.

• Administrative settings determine whether you have access to Agent greeting functionality. If your 
contact center is not enabled for agent greetings, the Agent Greeting options will not display in Ignite.

Recording agent greetings (WEB)
When you click the Record button to create a recording, the system's Record Agent Greeting workflow is 
triggered. The Record Agent Greeting workflow instructs the system to call your DN and prompts you to 
record and save a greeting.
NOTE: When recording messages, your voice agent is in a Non ACD state, and is not offered calls from 
any incoming queues.
To record your first agent greeting 
1. Under the Options > Phone, click the Record button. The Record Agent Greeting workflow is trig-

gered and instructs the system to call your DN.
2. Answer the incoming call and follow the system prompts to record and save your greeting. After you 

have finished recording, you can see the Click when finished recording button under Agent 
Greeting section.

3. Press the Click when finished recording button. 
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Under Agent Greeting section, Record and Play buttons are now visible. You can click the Play but-
ton to verify the agent greeting using your computer’s speakers. To re-record the agent greeting, click 
Record.

4. To disable your agent greeting, use the slider option under Agent Greeting section.

To record your first agent greeting 
1. Go to, Options > Phone, click Record.
2. Answer the incoming call and follow the system prompts to record and save the greeting. Recording 

is initiated and Recording in Progress text is displayed, after the recording is complete the system 
will save the recording.

3. Go to Agent Greeting and click Play to verify the agent greeting. To re-record the agent greeting, 
click Record.

4. To disable your agent greeting, use the slider option under Agent Greeting section.

NOTE: Internet Explorer does not support .wav file playback. While using the Agent Recording feature, for 
playback of your recording, use any of the browsers supported by MiContact Center Business.
Set email editor options
You can customize the email editor in Ignite.
To set the email editor 
1. Click Options > Email to view options.
2. Set the options. Available options: 

– Mobile view—If this option is enabled, the email editor is optimized for the hand-held device and the 
text formatting icons are not displayed.

– Use last reply template folder location—If this option is enabled and when you browse for a reply 
template, you can directly access the folder location where the last used reply template is stored.

– Quick reply templates—If this option is enabled, you can access and apply an existing template 
when replying to emails.

– Clear Quick reply templates view after Insert—If this option is enabled, the quick reply templates 
view will be cleared after you have inserted the template.

– Expand Headers—If this option is disabled, all the header fields are collapsed except the top-level 
header. To expand or collapse the header fields, click the down arrow or up arrow buttons.

3. Click Save.

Tools (WEB)

In the Tools page, you can create a personal email reply template that can include plain text, images, or 
links to provide standardized email responses to common questions and requests. You can also insert 
variables in your reply templates, which can dynamically change their value depending on the email call’s 
supplemental details.
Creating personal reply templates
You can create, preview, edit, and delete existing personal reply templates.
To create a personal reply template 
1. Click Tools > Email.
2. To insert text, in the reply template editor, type or copy and paste the text.
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3. To insert a variable, type the variable name in the following format: <<VariableName>>. You can 
insert multiple variables. In the email reply, Ignite replaces the variable with the actual value of the 
variable defined in YourSite Explorer (YSE). 

NOTE: The variable name used in the reply template must match the variable name defined in YSE 
and Send to agent desktop must be selected in YSE. Otherwise, the email reply will leave the text 
as it is enclosed within quotes. (that is, “<<VaribleName>>”). Consult with the system administrator 
to obtain a list of variables, from which you can choose the variables you want to insert in a personal 
reply template.

4. To insert an image, click Insert picture and browse to the image you want to insert.

5. To insert a link, click Insert/edit link and copy and paste the text for the link you want to insert.

6. Type the name you desire for the reply template.

7. Click Save.

To preview a personal reply template 
1. Click Tools > Email.
2. In the reply template editor, click the Browse button. 

A list of personal reply templates displays.
3. From the list of personal reply templates, select the reply template you want and click Preview.

To edit a personal reply template 
1. Click Tools > Email.
2. In the reply template editor, click the Browse button. 

A list of personal reply templates displays.
3. From the list of personal reply templates, select the reply template you want to edit and click Open.

4. Make changes to the reply template and click Save. 

The Save Personal Reply Template window displays.
5. To save changes to the selected reply template, click the template in the list, and click Save.

6. Click OK in the confirmation dialog.

7. To save changes to a different reply template, type the name of the reply template in the text field and 
click Save.

8. Click OK in the confirmation dialog box.

To delete a personal reply template 
1. Click Tools > Email.
2. In the Reply Template editor, click the Browse button. 

A list of personal reply templates displays.
3. From the list of personal reply templates, select the reply template you want to delete and click Delete.

4. Click OK in the confirmation dialog box.
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Viewing and organizing Interactions in Ignite (WEB)

Agents can view, organize, and search for current interactions in Inbox and Queues. Agents can view and 
search for historical interactions in History.
In Inbox, agents can view interactions they are handling or are currently ringing them. For Queues, agents 
can view interactions sent to the queues for which the agents answer.
Employees licensed as Advanced supervisors or System Administrators may search all interactions in the 
History tab of Ignite. This search capability does not require the supervisor be licensed to handle multi-
media.
For more information on Inbox, History, and Queues, see "Inbox (WEB)", "History (WEB)", and "Queues 
(WEB)".

Filtering historical interactions (WEB)

There are six filters for interactions in History: 
• All—All interactions.
• Handled—All interactions to which the agent has replied or transferred from reply mode. 

NOTE: For email, the Handled folder displays only the original, inbound emails
• Sent—All outbound emails and SMS interactions and agent replies to email interactions.
• No Reply—Contains email and SMS interactions designated as needing no reply, such as out of office 

messages.
• Junk—Contains email and SMS interactions designated as Junk.
• Failed—Contains voice, email, chat, SMS, and open media interactions that were unable to route.

Historical interactions can also be limited to only interactions you have handled or sent display, rather than 
all interactions for the queues you handle.
Supervisors can filter all the interactions by type and also view the interactions that are being handled by 
agents and are in agent’s Inbox, or put on hold, or are in draft state. This gives the supervisor a better 
visibility into the interactions that are being handled by the agents.
Supervisors are provided with these additional filters: 
• Inbox—All interactions that are in the Inbox state.
• Hold—All interactions that agents have put on hold.
• Draft—All interactions that are in the Draft state. Supervisors can further view the type of draft state: 

New Draft, Inbox Draft, Hold Draft, or Forward Draft

NOTE: 
• Supervisors will not be able view agents’ SMS interactions that are in Draft state.
• Agents will be able to Reply and Reply All to the email interactions that are in Handled, Sent, No 

Reply, and Junk historical states.
• Agents will not be able to Reply and Reply All to the email interactions that are in Inbox and Failed 

historical states.

The interactions contained in each filter can be searched for more specific interactions. For more infor-
mation, see "Searching Ignite".
The following procedures explain how to 
• Filter historical interactions
• Limit displayed interactions to only your items
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To filter historical interactions 
1. Click History.
2. Select the Filter.

To limit displayed interactions to only your items 
1. Click History.
2. Select Only show my items.

NOTE: The agent who has worked last on a particular call gets the ownership of the calls and is displayed 
in that agent’s call history when the Only show my items option is checked.
For example, if Agent A answers a call and then transfers to Agent B, this call is not displayed in Agent 
A’s history if the Only show my items option is checked. It is displayed in Agent B’s history when the 
Only show my items option is checked.

Selecting multiple email and SMS interactions in Ignite (WEB)

You can select multiple email and SMS interactions in Ignite to perform a single action on several items 
at once. For example, a supervisor can select multiple emails in queue and classify them all as ‘Junk’.
You can multi-select email and SMS interactions using either the Ignite (WEB) UI or Windows’ CTRL+ or 
SHIFT+ functionality.
Once multi-select is invoked, handling options and the option to select all items display.
NOTE: The option to multi-select displays only on the History and Queues pages.
The following procedures explain how to:
• Select multiple email and SMS interactions
• Select all email and SMS interactions on the page
• Deselect all email and SMS interactions on the page

To select multiple email and SMS interactions
1. Select either History or Queues.
2. Hover over the item avatar and select the check mark that displays. Repeat this step for any additional 

items.

3. Once multiple items are selected, at the top of the items list choose an action to perform.

NOTE: On the History page you may only perform an action across items that failed to route.

To select all email and SMS interactions on the page
1. Select either History or Queues.
2. Hover over the item avatar and select the check mark that displays.

3. At the top of the items list, click the 'master' check mark.

4. Once multiple items are selected, at the top of the items list choose an action to perform.

NOTE: On the History page you may only perform an action across items that failed to route.

To deselect all email and SMS;interactions on the page
1. Once multi-select is active, at the top of the items list, select the ‘master’ check mark. If all items are 

selected, disregard this step.
2. Once all items are selected, at the top of the items list, select the 'master' check mark.
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Logging into Ignite (WEB)

Launch the browser and sign into the application to log into Ignite. See "Signing into and out of Ignite 
(WEB)".
NOTE: 
• The intended users of Ignite (WEB) are employees connected either locally on the LAN or to the 

network via VPN.
• Ignite (WEB) does not support Compatibility Mode.
• Ignite (WEB) requires JavaScript be enabled on your browser. For more information, consult your 

browser documentation.
• When configuring screen pop notifications to be used with Ignite (WEB), you can execute only web 

URLs. Direct file execution (for example, .EXE or .BAT files) does not work in Ignite (Web) as the 
browser considers it as a security risk.

Launch Ignite by typing the following URL into a supported web browser: 
• http://<EnterpriseServerName >/Ignite 

OR
• http://<EnterpriseServerIP>/Ignite 

NOTE: If your system uses SSL, type ‘https’ in place of ‘http’ and insert a valid domain or FQDN in 
place of an IP address.

For a list of supported web browsers, contact your supervisor or system administrator. Ignite supports 
default browser configuration settings.
NOTE: 
• We recommend that you do not use the Ignite (WEB) and Ignite (DESKTOP) applications simultane-

ously.
• Editing responses across multiple, open browsers simultaneously is not supported.
• If you are drafting an email response and change browsers, hit 'Refresh' to pull down your drafted 

content.

Signing into and out of Ignite (WEB)

NOTE: After signing into Ignite and becoming Available, you may be placed in Busy across all agent capa-
bilities. This is an administrative configuration. To remove Busy, see "Setting and removing Make Busy 
in Ignite".
Your default sign-in state is Offline. This means you are signed into Ignite but your ACD agents are logged 
out. You cannot receive ACD interactions until your state is Available. To change states, see "Adjusting 
agent states in Ignite (WEB)".
If you are enabled for voice, you can set Ignite to log you into your phone. See ‘To sign into Ignite and log 
into the phone’, below. Otherwise, we recommend you log into your phone before signing into Ignite so 
that your agents may become Available.
Logging out of the phone or exiting MiCollab will only log out the voice agent (multimedia agents are not 
affected). Logging out of Ignite will log out all agents (voice and multimedia) and may requeue items in 
the Inbox, depending on administrative configurations. To avoid losing work on these items, agents 
should finish their replies or transfer inbox items to a queue before logging out.
The following procedures explain how to
• Sign into Ignite
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• Sign into Ignite and log into the phone
• Sign out of Ignite

To sign into Ignite 
1. Launch a supported web browser and type: http://EnterpriseServerName>/Ignite. 

OR
http://<Enterprise Server IP>/Ignite.

NOTE: If your system uses SSL, type ‘https’ in place of ‘http’ and insert a valid domain or FQDN in 
place of an IP address.

2. Enter your Username and Password. 

NOTE: If you use Windows Authentication, enter your DOMAIN\Username and your domain pass-
word.

3. Click Sign in. 

– You can set or change phone settings from Ignite’s Options page.
To sign into Ignite and log into the phone
NOTE: 
• This feature is supported for hot desk and external hot desk agents only
• You can set or change phone settings from Ignite’s Options page.

1. Launch a supported web browser and type: http://EnterpriseServerName>/Ignite. 
OR
http://<Enterprise Server IP>/Ignite.

NOTE: If your system uses SSL, type ‘https’ in place of ‘http’.
2. Enter your Username and Password. 

NOTE: If you use Windows Authentication, enter your DOMAIN\Username and your domain pass-
word.

3. Click Sign in.

4. On the Log in to a phone dialog window, specify your Extension and PIN (if applicable).

5. To log into your phone once your sign-in is complete, select the Automatic login checkbox and click 
Login. 

NOTE: 
– Clicking ‘Save’ dismisses the dialog window and signs you in as Offline. However, the phone infor-

mation is saved to your profile and you are logged into your phone once your state is Available.
– Clicking ‘Cancel’ dismisses the dialog window and signs you in as Offline across all media types.

To sign out of Ignite 
• Click your avatar and select State > Log out. 

NOTE: 
– Voice agents on active calls are not logged out until the call is complete.
– Directly closing the browser does not log you out of Ignite (Web); you must manually logout of Ignite 

(Web).
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Reconnecting Ignite (WEB)

If Ignite experiences connectivity issues, a ‘Reconnecting’ message displays. If Ignite cannot reconnect 
within the time allotted, a ‘Connection lost’ dialog pops with the option to Reconnect.
Once the connection is reestablished Ignite refreshes and functionality is restored.
To reconnect Ignite
• Under Connection lost, click Reconnect.

Posting feedback and viewing our forums (WEB)

Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on https://micon-
tactcenter.uservoice.com. When you post an idea to our feedback forum, others will be able to subscribe 
to it and make comments.
Our forums enable you to send feedback directly to the people building the product. While we cannot 
comment on every suggestion, feedback is analyzed and considered for future releases.
NOTE: Please do not use the forums to submit product defects. To submit product defects, please contact 
your administrator or dealer.
To post feedback and view our forums 
• Click the Feedback button 

OR
Access the following URL: https://micontactcenter.uservoice.com.

Your Ignite profile (WEB)

Ignite provides each user with a profile, associated to the username used to log into Ignite. You can adjust 
several of the profile's default settings to customize your Ignite experience.
Ignite remembers your changes to the following elements: 
• History
• Favorited queues
• Dashboard
• Default landing page
• Phone settings, including Extension, PIN, and automatic login to your phone 
• Automated diagnostics reporting
• Filter selection preference

You cannot delete your profile; however you can reset the above to Ignite’s default settings.
The following procedures explain how to: 
• Set an avatar image
• Clear or change your avatar image
• Specify your language preference
• Set Ignite's default landing page
• Configure notification display duration
• Configure phone settings, including Extension, PIN, and automatic log-in to the phone
• Enable automated diagnostics reporting from Ignite
• Reset your profile to Ignite’s default settings

https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
https://micontactcenter.uservoice.com
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To set an avatar image 
1. Click Options > Profile.
2. Click Change Photo.

3. Under Upload, click to upload a photo or drag-and-drop a photo to the space provided.

4. Click Save.

To clear or change your avatar image 
1. Click Options > Profile.
2. Click Change Photo and select Clear.

3. To change the image, follow the steps in ‘To set an avatar image’ above.

To specify your language preference 
1. Click Options > Profile.
2. After Language, select a language from the drop-down.

3. Click Save.

To set Ignite's default landing page 
1. Click Options > Customization.
2. Under Default landing page, select a page from the drop-down.

3. Click Save.

To configure the notification duration (in seconds)
An agent can configure the durations (in seconds) for the following notifications: new interactions, follow 
up, and info/error messages displayed on the Ignite screen.
To configure Notification display duration 
1. Click Options > Customization to view the options.
2. Under Notification Settings, set the Interaction toaster display time (seconds) in the range 5 - 60 

seconds; default value is 5 seconds.

3. Under Notification Settings, set the Follow up toaster display time (seconds) in the range 5 - 60 
seconds; default value is 10 seconds.

4. Under Notification Settings, set the Info/ error toaster display time (seconds) in the range 5 - 60 
seconds; default value is 5 seconds.

5. Click Save.

NOTE: Notification durations can also be reset in Reset Application Options.
To configure phone settings
NOTE: These settings enable login to your phone from Ignite. This feature is supported for hot desk and 
external hot desk agents only.
1. Click Options > Phone.
2. Specify your Extension and, if applicable, PIN.

3. To be logged into your phone after making yourself Available, select the Automatic login checkbox.

4. Click Save. 
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The next time you sign into Ignite and set your state to Available, you will be logged into your phone.

To enable automated diagnostics reporting from Ignite
NOTE: You can send on-demand reports in addition to automated reporting. See "Reporting performance 
issues in Ignite (WEB)".
1. Click Options > Diagnostics.
2. Under Continuously send diagnostics information, toggle the switch to blue.

To reset your profile to Ignite's default settings 
1. Click Options > Customization.
2. Under Factory reset, click Reset Application Options.

3. When prompted, click Reset.

NOTE: Resetting your profile to Ignite's default settings resets the Clear quick reply templates view after 
insert option.

Filter selection preference (WEB)

You can configure filter selection behavior and enable selection of multiple filters at a time. This setting 
applies to the History, Case, Case interactions and Contacts tabs in Ignite (WEB).
To set the multi-select filter option
1. Click Options > Customization to view options.
2. Set the ‘Allow filter multiselect’ option.

3. Click Save.

Reporting performance issues in Ignite (WEB)

You can report performance issues in Ignite on-demand, to be reviewed by a supervisor or system admin-
istrator. Reports include log lines from your browser and any details you enter.
On-demand reports are sent in addition to Ignite's automated diagnostics reporting. For information on 
enabling automated diagnostics reporting, see "Your Ignite profile (WEB)".
Supervisors looking to access diagnostics reports should consult "Accessing diagnostics reports from 
Ignite (WEB)".
To report a performance issue in Ignite
1. Click Options > Diagnostics.
2. In the field provided, describe the issue experienced.

3. Click Send.

Configuring Ignite (WEB) dashboards

Real-time monitoring of employees, agents, queues, and callback requests is available via the dash-
boards in Ignite (WEB). You can create multiple dashboards, customize the widgets that display in each, 
and give them meaningful names to indicate their purpose.
NOTE: The real-time monitors in Ignite (WEB) are known as ‘widgets’ in the dashboard user interface.
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Adding and configuring dashboards

Upon first use of Ignite (WEB), a default dashboard is created, containing the Employee State widget only. 
You can rename this dashboard and include additional widgets to display.
See "Accessing real-time information with Ignite (WEB)" for information on how to use the real-time moni-
tors.
To access the dashboards 
1. In Ignite (WEB), click Dashboards.
2. Click the down arrow to see a list of dashboards, with the number of widgets you have added for each 

one 

NOTE: If this is your first use of Ignite (WEB), only the Default Dashboard will display.
3. Open a dashboard by selecting it from the list.

To create a new dashboard 
1. Click Dashboards.
2. Click the Add Dashboard button.

3. Click Save.

To modify a dashboard’s title and display format 
1. In a dashboard, click the Edit Dashboard button.
2. Click Options.

3. Optionally, rename the dashboard by entering text in the field under Title.

4. Optionally, reorganize the template by selecting from the choices under Layout.

5. Click Close.

6. Optionally, click Undo to revert changes or click Save to accept changes.

To delete a dashboard 
1. In the dashboard you want to delete, click the Delete Dashboard button. 

NOTE: The dashboard you want to delete must be one that was previously saved. If not, then you 
must save it first before deleting.

2. Click Delete to delete the dashboard or click Cancel to retain the dashboard.

Adding and configuring dashboard widgets

The following widgets can be added to dashboards:
• Employee State—Displays employee presence and shift information
• Callback Requests—Displays a list of callback requests
• Queue Now—Displays queue and queue group statistics
• Agent State— Displays agents organized by time spent in the following states: ACD, Idle, Non-ACD, 

Unavailable, Not Present, and Offline
• Web Browser— Displays the website content that is embedded in the widget

To add widgets to a dashboard
1. In a dashboard, click Add Widget.
2. Select the widget you want to add to the dashboard.
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3. Repeat steps 1-2 to select additional widgets if desired.

4. Click Save.

5. If you want to add more widgets after saving, select the dashboard to which you want to add widgets 
and click the Edit Dashboard button.

When a dashboard is in edit mode, you can edit the content within widgets, collapse widgets, change the 
widgets’ location on the dashboard, or remove widgets from the dashboard.
NOTE: When you are editing a Web Ignite Dashboard that includes a Web Browser widget you will not see 
the webpage in the widget while in edit mode.
NOTE: You can collapse or expand the widget at any time (you do not have to be in edit mode).
The following procedure describes the editable features that are common to all widgets.
To modify a widget (common procedures)
1. In the dashboard, click the Edit Dashboard button.
2. In the widget toolbar:

– Click the Settings button to edit the content within the widget (see the relevant procedures for each 
widget for specific details).

– Click the Collapse button to collapse the widget or the Expand button to expand the widget.
– Select the Move button to drag and drop the widget to a different position on the dashboard.
– Click the Delete button to remove the widget from the dashboard.

3. If you edited the content within the widget, click Apply.

4. Click Save to save the changes to the dashboard or Undo to revert the change to the dashboard.

Configuring options in the Employee State widget

When you configure options in the Employee State widget, you optionally change the name of the monitor 
and add an employee to be monitored.
To configure options in the Employee State widget
1. In the dashboard, click the Edit Dashboard button.
2. In the Employee State widget, click the Settings button.

3. Optionally, under Title, type a new name for the monitor.

4. Under Employees, either select from the displayed list or type the employee ID in the search field to 
find the employee you want to monitor.

5. Click Apply.

6. Click Save to save the change to the dashboard or Undo to revert the change to the dashboard.

Configuring options in the Callback Requests widget

The only option available to be configured in the Callback Requests widget is the monitor name.
When you configure options in the Callback Requests widget, you can change the name of the monitor 
and add or remove the device to be monitored.
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To rename the Callback Requests widget
1. In the dashboard, click the Edit Dashboard button.
2. In the Callback Requests widget, click the Settings button.

3. Under Title, type a new name for the monitor.

4. Click Apply.

5. Click Save to save the change to the dashboard or Undo to revert the change to the dashboard.

Configuring options in the Queue Now widget

When you configure options in the Queue Now widget, you can change the name of the monitor and add 
or remove the device to be monitored.
To configure options in the Queue Now widget
1. In the dashboard, click the Edit Dashboard button.
2. In the Queue Now widget, click the Settings button.

3. Optionally, under Title, type a new name for the monitor.

4. Click the drop-down beside Queue and select either Queue or Queue Group.

5. Optionally, enter text into the Search field to search for queues or queue groups.

6. Select the check box beside each queue or queue group you want to monitor, or select the check box 
beside ID to select all queues or queue groups.

7. Click Apply.

8. Click Save to save the change to the dashboard or Undo to revert the change to the dashboard.

Configuring options in the Agent State widget

When you configure options in the Agent State monitor, you can change the name of the monitor and add 
or remove the device to be monitored.
To configure options in the Agent State widget
1. In the dashboard, click the Edit Dashboard button.
2. In the Agent State widget, click the Settings button.

3. Optionally, under Title, type a new name for the monitor.

4. Optionally, type content into the Search text box to filter the agents that display in the list.

5. Select the check box beside each agent you want to monitor, or select the check box beside each 
media icon to select all agents who are configured to handle that media type.

NOTE: You can optionally select multiple voice agents for each employee, if applicable, by selecting 
the check boxes located under the voice (telephone) icon, beside the employee name.

6. Click Apply.

7. Click Save to save the change to the dashboard or Undo to revert the change to the dashboard.
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Configuring options in the Web Browser widget

When you configure options in the Web Browser widget, you optionally change the name of the widget, 
the height of the widget, and URL of the website you want to display.
To configure options in the Web Browser widget
1. In the dashboard, click the Edit Dashboard button.
2. In the Web Browser widget, click the Settings button.

3. Optionally, under Title, type a new name for the web browser.

4. In URL field, enter the URL of the website you want to display.

5. Optionally, enter the height of the widget in the range 50—5000.

6. Click Apply.

7. Click Save to save the change to the dashboard or Undo to revert the change to the dashboard.

NOTE: When you are editing a Web Ignite Dashboard that includes a Web Browser widget you will not see 
the webpage in the widget while in edit mode.

Searching Ignite

You can search Ignite to view interactions. Please note the following.
Agents may only search interactions sent to queues for which the agents answer.
DESKTOP - Employees licensed as Advanced supervisors or System Administrators may search Ignite’s 
entire repository. This includes Ignite's In Progress folder (DESKTOP), which enables supervisors to see 
interactions currently in agent Inboxes. This search capability does not require Multimedia Contact Center 
licensing. However, to view and search interactions in queue using Ignite, employees must have a Multi-
media Contact Center license and multimedia agents assigned to the queue.
WEB - Agents may only search interactions sent to queues for which the agents answer. Employees 
licensed as Advanced supervisors or System Administrators may search all interactions in the History tab 
of Ignite (WEB). This search capability does not require the supervisor be licensed to handle multimedia.
Time stamps on interactions reflect the Ignite client time. To search interactions by date or time, use the 
date or time for the Ignite client.
Interactions that are removed from the queue are removed from queue folder search results.
New interactions in queue matching search criteria will not be displayed until the search is executed 
again.
DESKTOP - You cannot search for voice interactions, but you can filter voice interactions to view them 
selectively. See "Choosing how interaction data displays in the Card view (DESKTOP)" on page 315, and 
"Choosing how interaction data displays in the Grid view (DESKTOP)" on page 316 for more information.
WEB - You can search for voice interactions in Ignite Web version 9.1.
The following procedures explain how to 
• Perform keyword searches of Ignite's folders
• Search Ignite using search filters

Performing keyword searches

DESKTOP - Performing keyword searches of Ignite's folders enables you to search for interactions.
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WEB - You can perform a keyword search for either historical interactions or interactions in queue.
To perform keyword searches of Ignite's folders (DESKTOP) 
1. From the Folders pane, select a folder. If necessary, expand the My Folders, Processed, Unified 

Queues, Reporting Queues, or Individual Queues folder.
2. In the Search or Filter field, type keywords over the ghost text. 

NOTE: To display more search results, click Show more results ….
3. To clear searches, click the x button.

To perform keyword searches for historical interactions in Ignite (WEB) 
1. Click History.
2. Optionally, select a Filter.

3. Optionally, select Only show my items.

4. In the Search interactions field, type the keyword(s). To clear search texts, click Clear.

To perform advanced searches for historical interactions in Ignite (WEB) 
1. In the Search interactions field, click Advanced Search. 

Use the following search criteria in any combination to search for historical interactions.
– Media—Select the media type you want
– Date—Select a date and a date range
– Interaction Id—Type the interaction id you want
– Case—Type the case details as search keywords
– Queue—Type the queue name, the system displays a predictive list of results based on the letters 

you type, and select the record
– Employee—Type the employee name, the system displays a predictive list of results based on the 

letters you type, and select the record

2. Click Search. To clear searches, click Reset.

To perform keyword searches for interactions in queue in Ignite (WEB) 
1. Click Queues and select a queue or queue group.
2. In the Search interactions field, type the search text. To clear search texts, click Clear.

To perform advanced searches for in queue interactions in Ignite (WEB) 
1. Click Queues and select a queue or queue group
2. In the Search interactions field, click Advanced Search. 

Use the following search criteria in any combination to search for in queue interactions.
– Media—Select the media type you want
– Date—Select a date and a date range
– Interaction Id—Type the interaction id you want
– Case—Type the case details as search keywords
– Queue—Type the queue name, the system displays a predictive list of results based on the letters 

you type, and select the record
– Employee—Type the employee name, the system displays a predictive list of results based on the 

letters you type, and select the record

3. Click Search. To clear searches, click Reset.
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Searching Ignite using search filters

Agents may only search interactions sent to queues for which the agents answer. Users can search 
Ignite's folders by entering filters into Ignite’s Search fields. Employees licensed as Advanced supervisors 
or System Administrators may search Ignite's entire repository.
DESKTOP - This includes Ignite's In Progress folder, which enables supervisors to see interactions 
currently in agent Inboxes. This search capability does not require Multimedia Contact Center licensing. 
However, to view and search interactions in queue using Ignite, employees must have a Multimedia 
Contact Center license and multimedia agents assigned to the queue.
If administrative configurations permit, selecting the search result previews them.
The following explains how to use filters to search Ignite. This information does not apply to voice inter-
actions.
NOTE: 
• Time stamps on interactions reflect the Ignite client time. To search interactions by date or time, use 

the date or time for the Ignite client.
• To display more search results, click 'Show more results….

Using the filters in the following table, you can perform the following searches in Ignite.
NOTE: DESKTOP - The following search filters cannot be applied to the Inbox.

Table 24.37:Ignite search filters  (Sheet 1 of 4)

Filter Explanation

No filter Finds interactions containing a specific word
E.g. order

AND Finds interactions containing one word and another
E.g. sales AND order

Space Finds interactions containing one word and another
E.g. sales order

; Finds interactions containing one word and another
E.g. sales;order

NOT Finds interactions containing one word as long as they do not also 
contain another
E.g. order NOT closed

- Finds interactions containing one word but not another
E.g. order -closed

OR Finds interactions containing either of the words specified
E.g. sales OR order

Quotation marks Finds interactions containing the exact phrase
E.g. “sales order”

date Finds interactions received on specific dates
E.g. date:01/15/2014
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Today Finds interactions received today
E.g. date:Today

Yesterday Finds interactions received yesterday
E.g. date:Yesterday

This week Finds interactions received this week
E.g. date:This week

This month Finds interactions received this month
E.g. date:This month

This year Finds interactions received this year
E.g. date:This year

Month name
NOTE: Ignite will search the 
month by the current year, 
if no year is specified.

Finds interactions received on a specific month. You can also search by 
a specific date in the month.
E.g. date:August, or date:August 2013, or date:August 18, or date: 
August 18 2013

Abbreviated month 
name

Finds interactions received on a specific month, by a three letter 
abbreviation
E.g. date:Aug, or date:Aug 2013, or date:Aug 18, or date:Aug 18 2013

Day name Finds interactions received on a specific day of the week
E.g. date:Monday

> (for searches by date 
or attachment size)

Finds interactions by dates after the specified date or date keyword
E.g. date:>August 18 2013, or date:>August, or date:>August 18
Find email interactions by attachments larger than the attachment size
E.g. attachments:>200KB

>= (for searches by date 
or attachment size)

Finds interactions by dates after or on the specified date or date keyword
E.g. date:>=August 18 2013, or date:>August, or date:>=August 18
Finds email interactions by attachments larger than or equal to the 
attachment size
E.g. attachments:>=200KB

< (for searches by date 
or attachment size)

Finds interactions by dates before the specified date or date keyword
E.g. date:<August 18 2013, or date:<August, or date:<August 18
Finds email interactions by attachments smaller than the attachment 
size
E.g. attachments:<200KB

<= (for searches by date 
or attachment size)

Finds interactions by dates before or on the specified date or date 
keyword
E.g. date:<=August 18 2013, or date:<=August, or date<=August 18
Finds email interactions by attachments smaller than or equal to the 
attachment size
E.g. attachments:<=200KB

Table 24.37:Ignite search filters (Continued) (Sheet 2 of 4)

Filter Explanation
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AND or space (for 
searches by date)

Finds interactions received on two or more dates
E.g date:Today AND Yesterday, or date:Today Yesterday

NOT or - (for searches 
by date)

Finds interactions received on one date but not another
E.g. date:This month NOT Last week, or date:This month -Last week

OR (for searches by 
date)

Finds interactions received on either of the dates specified
E.g. date:Today OR August 25

subject: Finds interactions containing text by subject
E.g. subject:sales AND order

from: Finds interactions received from a specific sender. You can search by 
the sender's first name, last name, full name, or email address.
E.g. from:Renee

to: Finds interactions sent to a specific recipient. You can search by the 
recipient’s first name, last name, full name, or email address.
E.g. to:jane@gmail.com

cc: Finds interactions cc’d to a specific recipient. You can search by the 
recipient’s first name, last name, full name, or email address.
E.g. cc:jane@email.com

bcc: Finds interactions bcc’d to a specific recipient. You can search by the 
recipient’s first name, last name, full name, or email address.
E.g. bcc:jane@gmail.com

case: Finds interactions tagged with a specific case ID
E.g. case:kxPKez

ticket: Finds interactions tagged with a specific ticket number
E.g. ticket:pAsMDc

media: Finds interactions of a specific media type
E.g. media:email

agent: Finds interactions last handled by a specific agent. You can search by 
the agent’s first name, last name, full name, or by reporting number.
E.g. agent:Renee
or
agent:1000

queue: Finds interactions last sent to a specific queue
E.g. queue:sales

Table 24.37:Ignite search filters (Continued) (Sheet 3 of 4)

Filter Explanation
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You can perform the following types of searches in Ignite:
General searches – Any keywords can be typed in the search field, and the search returns interactions 
containing the keywords.
For example, if an agent types ‘sales order’ in the Filter field, Ignite searches for interactions in the 
selected folder containing the terms sales and order.
In the Inbox, the History, and the Queues pages, while you type the search keywords in the Queue box, 
the system displays a predictive list of results based on the letters you type.
For example, if an agent types ‘a’ letter in the Queue box, Ignite (Web) displays any queue names that 
contain ‘a’ (i.e. chat_queue12, email_queue33) as a predictive list of results.
Targeted searches – You can limit searches to fields and folders by inserting a colon between the field 
and the search term.
For example, an agent searching interactions’ Subject fields for the word ‘order’ can type ‘subject:order’. 
In this example, Ignite searches the ‘Subject’ fields of interactions in the selected folder for the term 
‘order’.
Multiple targeted searches – You can limit searches to more than one field using semi-colons.
For example, an agent searching for an order placed by a specific customer can type 
‘subject:order;from:Renee’. Ignite interprets this as (Subject contains Order) AND (From contains Renee). 
In this example, the program searches the Subject fields of contacts to find orders from Renee.
NOTE: 
• If at least one of the filters ends with ‘:’, you must separate all filters with “;”. For example, 

'from:Renee;date:yesterday'.
• If at least one of the filters ends with ‘:’, you cannot use ‘NOT’, ‘-‘, and ‘OR’ between the filters. For 

example, typing ‘order:Renee OR from:Tom to retrieve orders placed by either Renee or Tom is 
invalid. Typing ‘order;from:Renee OR from:Tom’ is valid and will retrieve orders placed by either Renee 
or Tom.

Complex targeted searches – You can perform complex searches to further narrow results returned.
For example, an agent searching for a completed order, placed by a specific customer, can type 
‘completed;subject:sales order;from:Renee’. Ignite interprets this as: Completed AND (Subject = (Sales 
AND Order)) AND (From contains Renee). In this example, Ignite searches the Subject fields of contacts 
for completed sales orders placed by Renee.
Email attachment size searches - You can search emails by attachment size. Searches by bytes (‘b’), 
kilobytes (‘KB’), and megabytes (‘MB’) are supported. If no size unit is specified, the default search unit 
is bytes. If searching for attachments by size, specifying "attachments.size:" in your query returns results 
more efficiently.

attachments: Finds email interactions by attachment. You can search by attachment 
name, size, content, or type.
E.g. attachments:docx
or
attachments:<200KB
NOTE: If no size unit is specified, the default search unit is bytes.

Table 24.37:Ignite search filters (Continued) (Sheet 4 of 4)

Filter Explanation
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Managing agent group presence and agent states

Agent group presence refers to whether an ACD agent is present in or absent from an agent group.
Agents present in an agent group can receive interactions in the Inbox, pick interactions out of queue, and 
be sent interactions from a supervisor. Agents absent from an agent group cannot handle interactions for 
the queue.
Agent states refers to an agent’s availability to receive ACD interactions. Examples of agent states include 
Available, Busy/Make Busy and Do Not Disturb. An agent’s state determines Ignite handling options avail-
able to them.
WEB - An agent in the Offline state is logged into Ignite but their ACD agents are not logged into the 
system. In this state interactions cannot be handled for the queue.
NOTE: When you configure Agent Group Presence for agents who use an ACD softphone, you must set 
the default presence to Absent. If the presence is set to Present, agents will receive ACD calls when they 
log in to MiCollab, without logging in to Ignite.

Viewing Agent Group Presence in Ignite

Agents can view the agent groups of which they are members. Viewing Agent Group Presence helps 
agents verify that they are able to handle interactions for the appropriate queues.
Agents can view Agent Group Presence on a group-by-group basis across media types. If administrative 
configurations permit, agents may also make themselves present in and absent from agent groups and 
the media types that the group handles.
To view Agent Group Presence (DESKTOP) 
• In the Sidebar, click the Agent Group Presence button. 

Check marks display beside agent groups to which the agent is present. Media types that an agent is 
present in handle display a blue background. Media types that an agent is not present in handle dis-
play a white background.

To view Agent Group Presence (WEB) 
• Click your avatar and select Agent Groups. 

Media types that an agent is present in handle display in blue. Media types that an agent is not present 
in handle display in grey.

Adjusting Agent Group Presence in Ignite

If agents have the required permissions, they can make themselves present in, or absent from, agent 
groups.
Adjusting Agent Group Presence enables agents to make themselves available or unavailable for inter-
actions of different media types. For example, an agent belongs to the Sales (voice and chat) and the 
Training (email) agent groups. This agent makes herself available to answer only email interactions by 
becoming absent from the Sales group.
Agents can also make themselves available or unavailable to answer interactions of specific media types. 
For example, the agent makes herself available to answer only Sales voice interactions by becoming 
absent from chat in the Sales agent group.
Agents can also make themselves available or unavailable to all agent groups of which they are members, 
in one action.
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DESKTOP - When agents are not present in any of their agent groups, Ignite’s Status bar displays a ‘Time 
Logged in Not Present’ status. See "The Status bar (DESKTOP)" for more information.
WEB - When agents are not present in any of their agent groups, their state becomes Away (Not Present). 
See "Viewing agent state and state statistics (WEB)".
NOTE: Agents may be made automatically present in their agent groups upon logging into Ignite, with 
multimedia interactions routing as soon as the login is complete. This is an administrative configuration 
and is not controlled by the agent. However, without this administrative configuration, agents must make 
themselves present in agent groups in order to be offered interactions.
The following procedures explain how to 
• Become present to an agent group
• Become absent from an agent group
• Become either present in or absent from all agent groups
• Become available or unavailable to answer interactions of a specific media type
• Apply default Agent Group Presence settings (DESKTOP)

To become present in an agent group (DESKTOP) 
1. In the Sidebar, click the Agent Group Presence button.
2. Select the group or groups from the Agent Group Presence screen and click Apply. Multimedia 

interactions begin routing.

To become present in an agent group (WEB) 
1. Click your avatar and select Agent Groups.
2. Hover over the agent group’s avatar and select Join <Agent Group name>.

3. Click Update.

To become absent from an agent group (DESKTOP) 
1. In the Sidebar, click the Agent Group Presence button.
2. Deselect the group or groups from the Agent Group Presence screen and click Apply.

To become absent from an agent group (WEB) 
1. Click your avatar and select Agent Groups.
2. Hover over the agent group’s avatar and select Leave <Agent Group name>.

3. Click Update.

To become either present in or absent from all agent groups (DESKTOP) 
1. In the Sidebar, click the Agent Group Presence button.
2. To become present to all agent groups, click Select All.

3. Click Apply. 

You become present in all agent groups and media types within the group.
4. To become absent from all agent groups, click Clear All.

5. Click Apply. 

You become absent from all agent groups and media types within the group.
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To become either present in or absent from all agent groups (WEB) 
1. Click your avatar and select All Agent Groups.
2. To become present in all agent groups, click Join All > Update.

3. To become absent from all agent groups, click Leave All > Update.

To become available or unavailable to answer interactions of a specific media type (DESKTOP) 
1. In the Sidebar, click the Agent Group Presence button.
2. To become available to answer interactions of a specific media type, click the media icon in the agent 

group so the icon displays a blue background.

3. To become unavailable to answer interactions of a specific media type, click the media icon in the 
agent group so the icon displays a white background.

4. Click Apply.

To become available or unavailable to answer interactions of a specific media type (WEB) 
1. Click your avatar and select Agent Groups.
2. To become available to answer interactions of a specific media type, click the media icon in the agent 

group so the icon displays in blue.

3. To become unavailable to answer interactions of a specific media type, click the media icon in the 
agent group so the icon displays in grey.

4. Click Update.

To apply default agent group presence settings (DESKTOP) 
1. On the Agent Group Presence screen, click Defaults.
2. Click Apply.

Adjusting agent states in Ignite (WEB)

Agents can adjust their states to make themselves available or unavailable to receive ACD interactions 
without logging out of the application.
Agents can set the following states in Ignite: 
• Available: Agents are logged into Ignite and their ACD agents are available to receive ACD interac-

tions.
• Offline: Agents are logged into Ignite and can peruse the interaction repository, but their ACD agents 

are offline and cannot receive ACD interactions. 
NOTE: Time in Offline does not count towards shift duration.

• Busy: See "Setting and removing Make Busy in Ignite".
• Do Not Disturb: See "Setting and removing Do Not Disturb in Ignite".

To adjust your agent state 
1. Click your avatar and select State.
2. Select a state

Setting and removing Busy/Make Busy in Ignite

When agents must become temporarily unavailable for inbound multimedia interactions, they can put 
themselves into Busy/Make Busy and choose a code indicating why they are unavailable.
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Setting Busy/Make Busy for one agent capability applies a Busy/Make Busy status status to all of the 
employee’s agents. Inbound multimedia interactions are not routed to the agent; however, agents in 
Busy/Make Busy can receive transferred interactions. While in Busy/Make Busy, voice agents are able to 
receive Non ACD voice interactions without being removed from Busy/Make Busy and can pick interac-
tions waiting in queue.
Entering Busy/Make Busy while handling interactions ensures that agents are not offered more once 
finished. However, existing voice, email, chat, SMS, and open media interactions continue until one of the 
parties ends the interaction.
Agents also enter Reseize Timer when they decline an interaction, fail to answer a ringing interaction 
within the allotted time, and place an item on hold for longer than is permitted. In each instance, the agent 
is automatically put into Busy/Make Busy across all media capabilities, and a System Make Busy is regis-
tered for the employee. For information on the time allotted to answer a ringing interaction and the dura-
tion for which interactions can be on hold, contact your supervisor or system administrator.
The following procedures explain how to 
• Set Busy/Make Busy and change Busy/Make Busy codes
• Remove Busy/Make Busy 

NOTE: Agents must remove Busy/Make Busy to become available to receive inbound multimedia 
interactions and internal voice interactions.

• Change to a Do Not Disturb (DND) state while in Busy/Make Busy

To set Make Busy and change Make Busy codes (DESKTOP) 
1. In the Sidebar, click the Make Busy button.
2. Select a MKB code and click Apply. 

NOTE: Agents cannot program MKB codes and can only select from the list provided.
3. To change a Make Busy code assigned to you, follow the above steps.

To set Busy and change Busy codes (WEB) 
1. Click your avatar.
2. Under State, click Busy.

3. Choose a Busy code.

To remove Make Busy (DESKTOP) 
• In the Status bar, click the X button.
To remove Busy (WEB) 
1. Click your avatar.
2. Under State, click the X button next to Busy.

To change to a Do Not Disturb state while in Make Busy (DESKTOP)
NOTE: Do Not Disturb and Busy/Make Busy states layer. If an agent in Busy/Make Busy changes their 
state to Do Not Disturb, the agent will remain in Busy/Make Busy once Do Not Disturb is removed. This 
prevents agents from receiving interactions when switching states between Busy/Make Busy and Do Not 
Disturb.
1. In the Sidebar, click the Do Not Disturb button.
2. Select a DND code and click Apply.

NOTE: To remove DND and revert to Make Busy, click your avatar, click the X button next to Do Not 
Disturb
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To change to a Do Not Disturb state while in Make Busy (WEB)
NOTE: Do Not Disturb and Busy/Make Busy states layer. If an agent in Busy/Make Busy changes their 
state to Do Not Disturb, the agent will remain in Busy/Make Busy once Do Not Disturb is removed. This 
prevents agents from receiving contacts when switching states between Busy/Make Busy and Do Not 
Disturb.
1. Click your avatar.
2. Under State, click Do Not Disturb.

3. Select a Do Not Disturb reason code.

4. To remove DND and revert to Make Busy, click your agent name and click X button next to Do not 
Disturb.

Setting and removing Do Not Disturb in Ignite

When agents must become temporarily unavailable for receiving inbound multimedia interactions and 
internal voice interactions, including transfers, they can put themselves into Do Not Disturb (DND) and 
choose a code indicating why they are unavailable.
Agents in DND can receive external voice interactions, and existing chat and inbound/internal voice inter-
actions continue until one of the parties ends the interaction.
Setting DND for one agent capability applies a DND status to all of the employee’s agents.
The following procedures explain how to 
• Set DND and change DND codes
• Remove DND 

NOTE: Agents must remove DND to become available to receive inbound multimedia interactions or 
internal voice interactions

• Change to a Busy/Make Busy (MKB) state while in DND

To set DND and change DND codes (DESKTOP) 
1. In the Sidebar, click the Do Not Disturb button.
2. Select a DND code and click Apply. 

NOTE: Agents cannot program DND codes and can only select from the list provided.
3. To change a DND code, follow the above steps.

To set DND and change DND codes (WEB). 
1. Click your avatar.
2. Under State, click Do Not Disturb ….

3. Choose a DND code.

To remove DND (DESKTOP) 
• In the Status bar, click the X button.
To remove DND (WEB) 
1. Click your avatar.
2. Under State , click the X button next to Do Not Disturb ….

To change to a MKB state while in DND (DESKTOP)
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NOTE: If an agent changes their DND state to MKB, the agent remains in DND until this state is removed.
1. In the Sidebar, click the Make Busy button.
2. Select a Make Busy code and click Apply.

3. In the Status bar, click the X button to remove yourself from DND and enter MKB.

To change to a Busy state while in DND (WEB)
NOTE: If an employee applies a MKB state while in DND, the employee remains in DND until the DND 
state is removed.
1. Click your avatar.
2. Under State choose Busy....

3. Choose a Busy code.

4. Click your avatar.

5. Under State, click the X button next to Do Not Disturb.

Work Timer

NOTE: 
• When agents are in Work Timer, Interactions remain in the Inbox until Work Timer is removed .
• Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 

until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification 
Code will be applied to the call..

DESKTOP - Interactions in Work Timer are marked with yellow.
WEB - Interactions in Work Timer are marked with yellow and a clock icon.
If administrative configurations permit, agents are placed in a Work Timer state after completing an inter-
action. During Work Timer agents can complete after-contact work, such as speaking with a supervisor, 
without having this downtime affect their performance statistics.
Work Timer counts against an agent’s Workload, and can determine whether agents are pushed interac-
tions. If agents are in a Work Timer state for the maximum number of interactions they can handle for a 
media type, they are not offered another interaction of that media type until Work Timer expires or is 
removed. For example, an agent permitted to handle two emails at a time is in Work Timer for both. Until 
one Work Timer state expires or is removed, the agent is not offered another inbound email. However, 
this agent will be pushed chat interactions, unless they are also in Work Timer for the maximum number 
of chat interactions their Workload permits them to receive.
Ignite displays Workload statistics, including the number of Work Timer states the agent is in for each 
media type. See "The Status bar (DESKTOP)" for more information. See "Viewing agent handling statis-
tics (WEB)". For more information on Workload, see "Handling multimedia contacts in Ignite".
The duration of Work Timer is configured on a queue-by-queue basis. To determine this duration, contact 
your supervisor or system administrator.
When Work Timer is the overriding state, agents can remove Work Timer and put themselves back into 
an overriding state across all media capabilities. Once agents have removed Work Timer, they cannot put 
themselves back into this state.
The following procedures explain how to remove Work Timer.
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To remove Work Timer (DESKTOP) 
• In the Sidebar, click the Remove Work Timer button. 

NOTE: Alternatively, remove Work Timer via the Action bar.

To remove Work Timer (WEB) 
• Click Clear Work Timer. 

Alternatively, click your avatar, select State, and choose an alternate state.

Handling multimedia interactions in Ignite

NOTE: To retain the integrity of Excel charts pasted in Ignite, first copy the Excel table to Word and then 
copy/paste it in Ignite.
Multimedia Contact Center supports skills-based routing. When an agent is available, they receive inter-
actions based on the following criteria 
1. Highest queue priority (optional)
2. Highest skill priority (optional)

3. Longest idle

Agents can handle multiple interactions at a time. However, an employee's Workload determines the 
number and type of media interactions that can be pushed to an agent at any one time. For example, 
agents may not be permitted to receive voice and chat interactions concurrently. Or, agents may be 
permitted to receive a maximum of five emails and two chats at one time.
When traffic levels necessitate, supervisors with appropriate licensing can log into Ignite and alleviate 
congestion by handling interactions. Emails can be configured to overflow to a supervisor after a specified 
length of time in queue. If a supervisor primarily uses Contact Center Client, they can minimize Ignite and 
be notified when they receive an overflow email.
If you are not being pushed interactions, it may be that you have reached the maximum number of inter-
actions your Workload permits you to handle. For more information on viewing your Workload status, see 
"The Status bar (DESKTOP)".
Note also that agents who have reached their Workload maximum for a media type can pick items out of 
queue and can receive transferred interactions of that type.
To provide context on how interactions reach queues and agents, this section explains 
• Overflowing and interflowing interactions
• Routing models in Multimedia Contact Center
• Receiving notifications of new interactions
• Receiving information in screen pops

In addition, the following sections explain general interaction handling procedures, including 
• Reviewing interaction history
• Tagging interactions with Account Codes
• Sending interactions back to the queue

For information on procedures specific to handling different media types, see "Handling calls in Ignite", 
"Handling emails in Ignite", and "Handling chats in Ignite".
Transition from one interaction type to other can be done. For more information on Transition to other 
type, See "Transitioning from one conversation type to another (WEB)".
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Overflowing and interflowing interactions

The following section explains the concepts of overflow and interflow for multimedia interactions.
Once an interaction has reached a queue, it is offered to an agent group. Agents in the group are respon-
sible for accepting the interaction. Interactions wait in queue until an agent from an assigned agent group 
accepts them. Overflow and interflow are two routing methods designed to reduce the length of time that 
interactions wait in queue
Overflowing interactions
Overflow is the process of offering an interaction, already offered to one agent group, to additional agent 
groups after the interaction has been waiting in queue past a set time. The amount of time before an inter-
action overflows is determined by an administrative configuration, and the system overflows the interac-
tion without agent intervention.
Interflowing interactions
Interflow is the process of taking an interaction out of one queue and routing it to a different answer point, 
such as another queue or an external email address. Interflow is an administrative configuration occurring 
under specified queue conditions, and occurs without agent intervention.

Routing models in Multimedia Contact Center

Push, Pick, and Mixed routing models determine how agents receive interactions in queue. Note that 
administrative configurations determine the routing models that your contact center uses and that the 
routing model can vary by queue. For more information, consult your supervisor or system administrator.
NOTE: Push, Pick, and Mixed routing models determine how agents receive email and chat interactions 
in queue. Delivery of voice interactions is determined by programming on the 3300 ICP. For more infor-
mation, contact your supervisor or system administrator.
Push model
In Push model interactions in queue are sent to an available agent’s Inbox. The number of interactions 
that can be pushed to an agent’s Inbox at one time depends on the agent’s Workload, as configured in 
the system, and can vary by media type. For example, the system may be permitted to push five emails 
at a time to an agent’s Inbox but only two chats.
Interactions are also pushed to agents on the basis of Agent Skills (as configured in the system), Queue 
Priority, and Preferred Agent. A Preferred Agent is one who is engaging in an ongoing interaction with a 
customer.
With the exception of transferred interactions, agents do not receive items in their Inbox if the Inbox 
contains ringing interactions of the same media type.
Picking interactions out of queue is permitted in a Push model.
Pick model
In Pick model agents pick interactions out of queue exclusively. Agents in Do Not Disturb cannot pick 
interactions out of queue.
Mixed model
In Mixed model agents pick interactions out of queue, but items sitting in queue past a set time are pushed 
to agents’ Inboxes. Workload determines the number and type of media interactions that can be pushed 
to an agent at any one time. For more details, see ‘Push model’, above.
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With the exception of transferred interactions, agents do not receive items in their Inbox if the Inbox 
contains ringing interactions of the same media type.

Receiving notifications of new interactions

Agents receive notifications of new interactions in one of two ways. An interaction can ‘ring’ in the Inbox 
and agents can receive toaster notifications of new interactions.

Ringing states in Ignite

When interactions reach an agent’s Inbox, the interactions are in a ringing state until the agent puts them 
into reply mode or until the requeue timer expires.
Ignite indicates a ringing interaction as follows: 
• DESKTOP - Ignite marks ringing interactions in red, and indicates in red the number of interactions 

ringing in the Inbox.
• WEB - Ignite marks ringing interactions with a ‘ringing’ icon, and the agent’s state indicates ‘Incoming’.

NOTE: 
• With the exception of transferred interactions, in Push and Mixed routing models agents do not receive 

items in their Inbox if the Inbox contains ringing interactions of the same media type. Once ringing inter-
action is put into reply mode, another interaction of that media type is pushed to the Inbox in a ringing 
state if the agent's Workload permits. This behavior continues until an agent's Workload is met.

• For MiVoice Connect phones, if the ring count for ACD calls exceeds the requeue timer, which is set 
to 30 seconds by default, calls will directly connect to agent's voice mail.

Receiving toaster notifications of new interactions

Ignite sends agents toaster notifications of interactions offered to the Inbox.
Toaster notifications indicate the interaction’s media type and display information such as originating 
phone number, subject, and queue name. Information displayed varies by media type.
Agents can accept or decline the interaction by selecting the appropriate option on the toaster notification. 
Option availability varies by the interaction's media type.
NOTE: Accepting emails sends them to the agent's Inbox. Agents can open them in reply mode with Cc'd 
recipients included in the reply.
Please note the following behavior:
DESKTOP
• If agents are permitted to preview interactions, clicking anywhere within the notification opens Ignite 

with the item ringing in the Inbox. Agents are then able to preview the interaction.
• If the agent does not act on the notification by accepting, declining, or previewing the interaction, the 

Ignite icon flashes in the taskbar and eventually remains a solid color until the application is selected.

WEB
• When Ignite is in focus, the toaster notification pops with options to Accept and, depending on the inter-

action's media type, Decline the interaction. If Ignite is not in focus, a notification indicates a ringing 
interaction. Clicking a notification takes you to the relevant interaction.

NOTE: Internet Explorer does not pop notifications when Ignite is not in focus.
• When Ignite is minimized, clicking the notification opens Ignite with the item ringing in the Inbox. 

Agents are then able to handle the interaction.
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• When accepting open media interactions, the link that displays depends on TargetUri settings and, as 
such, may display as embedded content within Ignite (WEB) or as a new page in the browser. Please 
note that some web applications do not support iframe embedded content, such as is used with Ignite 
(WEB). If you want content to be embedded in Ignite (WEB), you must enable iframe embedding in 
such 3rd party web applications.

Receiving information in screen pops

When interactions are ringing in the Inbox, agents may receive screen pops on their desktops.
Screen pops differ from toaster notifications. Toaster notifications alert agents to ringing interactions and 
indicate basic information such as the interaction’s media type. A screen pop displays information rele-
vant to handling a specific interaction.
For example, a screen pop may display a web page listing a customer’s recent interaction history. Agents 
use screen pops to provide more personalized, informed customer service. It is the agent’s responsibility 
to close the screen pop once the information is no longer required.
Screen pops open on agents’ desktops when a ringing item is selected in the Inbox.
If you are receiving two screen pops and/or two toaster notifications for a single interaction, consult your 
supervisor or system administrator.For more information on toaster notifications, see "Receiving toaster 
notifications of new interactions".
NOTE: 
• If you receive a security warning when your screen pop displays, consult your supervisor or system 

administrator about disabling the warnings.
• WEB - By default, screen pops open in a new tab but obey browser configuration and may therefore 

open in a new window.
• WEB - If screen pops are not displaying you may need to disable pop-up blockers for this site.

Reviewing interaction history

Ignite stores transcripts of email, chat, and SMS multimedia interactions and enables agents to review 
these transcripts by case and customer.
For example, an agent gets a response from a customer saying, 'How do I do that?'. However, the 
customer has deleted all prior communication in the email chain. The agent can retrieve transcripts of 
previous interactions with the customer in order to answer the question.
If an interaction’s history is not visible via the History function, we recommend searching Ignite’s reposi-
tory. For more information on searching, see "Searching Ignite".
The following procedures explain how to 
• Review interaction history by case 

NOTE: This function is only available if the system has case and ticket numbers enabled. This is an 
administrative configuration and cannot be adjusted by agents.

• Review interaction history by customer

To review interaction history by case or customer (WEB)
NOTE: You can pare down the list of interactions displaying on the History page using filters. For informa-
tion, see "Searching Ignite using search filters".
1. Select an interaction or hover over the item’s avatar and select History.
2. Select either Case or Customer and select the interaction to review. 
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You can display specific interactions by entering search criteria in the ‘Search interactions’ field.
3. To exit out of this view, click Back to <page>.

To review interaction history by case (DESKTOP) 
1. In the Folders pane, select a folder and select an interaction in the folder.
2. In the Preview pane, select History and Account Codes, and select By Case.

3. To see more items, double-click Show more results....

4. Optionally, sort items in each pane in ascending or descending order by clicking the column headers.

5. To view a transcript of the communication, double-click the interaction in the pane.

To review interaction history by customer (DESKTOP) 
1. In the Folders pane, select a folder and select an interaction in the folder.
2. In the Preview pane, select History and Account Codes, and select By Customer.

3. To see more items, double-click Show more results....

4. Optionally, sort items in each pane in ascending or descending order by clicking the column headers.

5. To view a transcript of the communication, double-click the interaction in the pane.

Tagging interactions with Account Codes

Account Codes are used for reporting purposes. They are numbers identifying services, departments, or 
other elements of the contact center. Agents can tag interactions with Account Codes in Ignite to indicate 
in reports what the interaction was about.
For example, an agent handling chats for three catalog companies enters an Account Code of ‘01’ to indi-
cate that the customer is inquiring about Company A. Later in the same chat interaction the agent enters 
an Account Code of ‘06’ to indicate that the customer is inquiring about Company A’s mail-out services.
Agents can only apply Account Codes when replying to interactions. Agents can tag interactions with 
multiple Account Codes but cannot configure Account Codes in Ignite.
Please note the following limitations regarding tagging voice interactions with Account Codes in Ignite 
• Voice interactions handled in Ignite can only be tagged with non-verified Account Codes. Verified 

Account Codes are entered before an outbound voice interaction and can be applied via Contact 
Center Client. For more information on verified Account Codes in your contact center, contact your 
system administrator.

• Tagging interactions with Classification Codes is supported from Ignite for voice interactions only. 
Classification codes associate the entire interaction handling duration to the Account Code selected. 
This includes transfer time. It also includes Work Timer duration if 'Include queue work timer as part of 
handling time' is enabled on the queue. To learn more about applying Classification Codes to 
voice interactions, see "Tagging calls with Classification Codes".

NOTE: Classification Codes are not supported for multimedia interactions, only Account Codes may be 
used on multimedia interactions.
NOTE: Account Codes on emails are terminated after employee logout. Agents logging into Ignite to 
resume work on emails must re-enter their last Account Code.
To tag an interaction with an Account Code (DESKTOP) 
1. In the Preview pane, expand History and Account Codes and select Account Codes.
2. Expand any Account Code groups, if required.
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3. Beside the Account Code you are using to tag the interaction, click Apply. 

Account Codes applied to an interaction are marked in bold.
NOTE: Alternatively, apply Account Codes via the Account Code button that displays in theSidebar.

To tag an interaction with an Account Code (WEB) 
1. Select an interaction or hover over the item avatar and click Apply Code. The account codes/catego-

ries are displayed in tree view (as configured in YSE) in the Apply Classification/Account Code 
window.

2. Select an Account Code. You can type the name or number of a code in the Search field. Optionally, 
use the Expand or Collapse buttons to view account codes and select the required account code. 

NOTE: If you enter a number or the name in the search field, and the system returns only one result, 
you can apply the Code by pressing Enter.

Sending interactions back to the queue

When interactions reach an agent’s Inbox, the interactions are in a ringing state until the agent clicks the 
Reply button and Ignite goes into reply mode.
Interactions can be sent back to the queue for several reasons. First, interactions requeue when declined 
by an agent. Second, ringing interactions in the Inbox requeue when the ringing timer expires. Third, inter-
actions on hold requeue when the hold timer expires, including emails automatically placed on hold after 
agent's logout. Fourth, interactions in the Inbox can requeue on employee logout. However, administra-
tive configuration determines requeue behavior for email interactions in the Inbox.
In each instance, the interaction is returned to the queue as the longest waiting. Unless logged out, the 
employee is put into a Busy/Make Busy state across all agent capabilities, and a System Make Busy is 
registered.
Agents logging out of Ignite with interactions in the Inbox are notified whether relevant interactions will be 
requeued (DESKTOP). However, in these instances a System MKB is not registered against the 
employee.
Requeued emails contain any response text drafted. This text is visible to other employees who handle 
the email. Agents can choose to include the drafted content when previewing requeued emails in queue.
Requeued chat and SMS interactions contain all of the previous interaction between contact and agent.
If the system immediately requeues interactions on logout, to avoid losing work we recommend that 
agents either complete their work or transfer the item to a queue before logging out.
NOTE: 
• The time allotted to answer ringing interactions, the duration for which interactions can be on hold 

before requeuing, and requeue behavior for email interactions on employee logout is determined by 
administrative configuration. For more information, contact your supervisor or system administrator.

• Logging in and logging out of Ignite does not reset the duration interactions can be on hold before 
requeuing.

Transitioning from one conversation type to another (WEB)

During an interaction, agents can transition between interaction types. For example, an agent in the 
Support queue who is in a chat interaction with a customer can transition to voice.
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The agent can transition to an alternate interaction type only if the agent is associated with that media 
type and if the customer’s relevant contact details are available. Agents can also edit contact information 
during an interaction.
NOTE: Agents cannot transition from other media types to a chat interaction, as chats are inbound only.
The following explains how to
• Transition interactions to an alternate interaction type
• Update contact details during an interaction

To transition to an alternate interaction type
1. Click Inbox and select the interaction or hover over the item avatar.
2. Click the action icon based on the interaction type.

For example, with an email interaction, click Reply, or with a chat interaction, reply to the chat mes-
sages.

3. From the handling icons, click the interaction type icon to which you want to transition. Optionally, you 
can hover over the item avatar in the Inbox to view the handling icons.

NOTE: You can edit the contact information for the customer during the interaction and you can view 
the updated contact information and, if required, can transition to an alternate interaction type.

4. Continue the interaction in the transitioned interaction type.

Update contact information during a conversation

Agents can also edit contact information during an interaction. For example, an agent in the Sales queue 
is on a call with a customer and updates the customer’s email address or mobile number. The agent can 
now view the updated contact information and, if required, can transition to an alternate interaction type, 
such as email.
To update contact information during an interaction
1. Click Contacts and search for the applicable customer.
2. In the Contacts window, under Contact Details, click Edit Contact.

Optionally, you can hover over the avatar to view the Edit icon.
3. In the Edit Contact window, update the contact details, and click Update.

The handling icons are refreshed to reflect the updated details.

Working with cases in Ignite(WEB)

The Cases page contains searchable details for all cases that the employee can access. Agents and 
supervisors can quickly review all the key information related to case records without the need to select 
individual interactions.
The following sections explain how to
• View case details
• Search and filter cases
• Add notes for a case
• Edit the subject of a case
• Flag a case for follow-up
• Flag a case as resolved
• Merge interactions from two different cases
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NOTE: You cannot edit a case that is being edited by another agent or supervisor. A lock icon displays 
next to the action icons to indicate that a case is being edited by another agent or supervisor. Only one 
person can perform the following actions at a time in Ignite—edit the subject of the case, change the state 
of the case, add or edit notes, cut from case, or merge cases.

View case details

For each of the case records, you can view the state of the case, notes, interactions, customer details, 
and other cases that are associated with the customer.
1. Click Cases to display a list of all cases.
2. Locate and click the case title.

If you know the case details, you can use the search and filter capabilities to locate the required case.
The following case details are displayed: 
• Case details—Displays case details such as customer details, subject, details of the agent who 

handled the last interaction in the case, or the queue details, date modified, and the state.
• Notes—Lists the notes entered for the selected case. You can search for notes by entering the string 

in the search field in the Notes tab.
• Interactions—Lists all interactions related to the selected case. You can filter and search for interac-

tions in this tab.
• Participants—Lists the contact details of all participants.
• Other cases for this customer—Lists the other cases associated with this customer(s). You can filter 

and search for cases in this tab.
• State—Indicates the current state of the case. Possible values include 

– Pending—Cases are indicated by  icon. Cases are automatically assigned this state when 
inbound interactions are received by the system. This state is assigned even if the linked case was 
previously closed. The only exception is when a new interaction is already linked to an existing case 
whose state is marked as ‘Follow up required’. You can see cases in the pending state only for the 
queues to which you are assigned.

– In Progress—Cases are automatically assigned this state when you accept interaction associated 
with that case. The only exception is when a new interaction is already linked to an existing case 
whose state is marked as ‘Follow up required’.

– Follow up required—Cases are indicated by a red badge. When an agent handles an interaction, 
and wants to mark the interaction for further follow up, the case can be flagged as ‘Follow up 
required’.

– Follow up required now—Cases are indicated by a red badge. When an agent marks an interac-
tion for a follow up at a specific date and time, just before the specified date and time, the interaction 
is which is flagged as ‘Follow up required’ changes to ‘Follow up required now’, a notification icon 
on the top panel prompts the agent to take action on the interaction.

– Waiting for customer—Cases are indicated by an orange badge. When an agent completes an 
interaction, or marks the interaction as ‘No Reply’, the case’s state is set to ‘Waiting for customer’ 
unless it was previously set to ‘Follow up required’ or ‘Resolved’, in which case it remains 
unchanged. When an agent sends an unsolicited outbound email or SMS to a customer, a new case 
is automatically created and assigned with this state.
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– Resolved—Cases are indicated by a blue check mark  icon. You can set the case to ‘Resolved’ 
when you no longer need to interact with or track it. Cases in ‘Waiting for customer’ state are auto-
matically moved to ‘Resolved’ state after the configured number of days (by default, it is 14 days) 
when no interactions are added or actions are taken.

– Closed—Indicated by  icon. Cases in ‘Resolved’ state are automatically moved to ‘Closed’ state 
after the configured number of days (by default, it is 7 days) when no interactions are added, or 
actions are taken.

Edit the subject of a case

To edit the subject of a case
1. Click Cases to display a list of all cases,
2. Locate and click the required case from the list.

The details are displayed in the right pane. The default subject is based on the most recent interaction 
associated to the case, relevant to the interaction media type.

3. Click Edit Subject icon.

4. Enter the subject in the text box.

5. Click Save.

Search and filter cases

To search and filter cases 
1. Click Cases, and in the Search cases field, enter a search string.
2. For a more detailed search, click the Advanced Search in the Search cases field and enter specific 

details in the fields displayed. For Media, Queue, and Employee fields, you can use the Only search 
most recent check box next to fields to search for cases having the particular media, queue, or 
employee as their last one. 

For example, let us assume that there is a case linked to two interactions; a chat (first interaction) and 
a voice call (second and last interaction). If you select “chat” in the Media drop-down menu and:

– Do not select the Only search most recent check box next to Media, Ignite will find this case 
because it will search for all cases that have a chat interaction.

– Select the Only search most recent check box next to Media, Ignite will only search for cases 
whose most recent interaction type is “chat”, hence, the above case is not found as the last interac-
tion for the above case is not “chat”, but is “voice”.

3. Click Search to display the search results.

4. Click the filter name to filter the search results based on case states. The available filters are All, 
Pending, In progress, Waiting for customer, Follow up required, Resolved and Closed. 

NOTE: 
– If an agent selects the Only show my items check box, Ignite displays only cases associated with 

that agent.
– In Case folder, agents will be able to Reply and Reply All to the email interactions only in Waiting 

for Customer, Follow up required, Resolved, and Closed case states.
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– In Case folder, agents will not be able to Reply and Reply All to the email interactions in Pending 
and In progress case states.

Export the case details to a CSV file

To Export a case details to a .csv file 
1. Click Cases to display a list of all cases.
2. Click the required case from the list. 

The details are displayed in the right pane.
3. Click the Export to csv icon. The case details are downloaded in a .csv file format.

Flag a case for follow up

To flag a case for follow up
1. Click Cases to display a list of all cases.
2. Click the required case from the list.

The details are displayed in the right pane.
NOTE: This state can only be set for cases that are currently in an ‘In Progress’, ‘Waiting for 
customer’, or ‘Resolved’ state.

3. Click the Flag for follow up icon. The Case Follow-up screen is displayed.

4. Select the notification date and time. If you are a supervisor, you can choose an agent you want to 
notify.

5. Click OK. You will receive a reminder notification at the set date and time. You can review the case 
by clicking the notification toaster from your Inbox.

In case you want to edit the notification details, click the Follow up Reminder icon and make the 
changes.

Flag a case as resolved

To flag a case as resolved
1. Click Cases to display a list of all cases.
2. Locate and click the required case from the list.

The details are displayed in the right pane. Any new case that is responded to, is flagged as Waiting 
for customer and denoted by an orange badge.

3. Click the Resolve icon. A confirmation window is displayed.

4. Click OK.

Merge Cases

When a customer is associated with more than one case, some or all of the cases, and their interactions 
and notes, can be merged into a single case to consolidate information.
To merge cases (and their associated interactions and notes) into a single target case
1. Click Cases.
2. From the list of cases, click the case you want to merge into the target case.



1075

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

3. In the Other Cases for this customer tab, click Merge.

4. In the Confirm the merge of case dialog box, click OK.

NOTE: When merged, all notes and interactions from the original case are moved to the target case and 
the original case is deleted. If the target case was closed before the merge, it is only reopened after the 
merge if the original case was neither closed nor reopened, and its new state will match the state of the 
original case.

Notes associated with cases

The Notes page lists the notes entered by the agent for the selected case. You or any other agent asso-
ciated with the case can refer to these notes during the resolution of the case. You can also view notes 
that are automatically generated by the system when the following events occur—state change, case 
merger, and calls are cut and pasted into a new or an existing case.
To search notes
• In the Notes tab, type the text in the Search notes field. Optionally, you can include the system notes 

to your search by clicking Show system notes option.
To add notes
1. Click Cases to display a list of all cases.
2. Locate and click the required case from the list.

The details are displayed in the right pane.
3. Click the Notes tab.

Notes related to the selected case are displayed.
4. Click Add Note.

5. Enter the note in the text box.

6. Click Save.

To edit notes
1. In the Notes tab, and click Edit.
2. Edit the information that is displayed and click Save.

NOTE: You can only edit the most recent note that you have created.

Interactions associated with cases

The Interactions tab present under History, Inbox, Case or Inqueue pages displays all the calls related to 
the selected case. Each interaction is assigned with a case ID. Ignite automatically reuses the last Case 
ID for all the inbound* or outbound interactions associated with the same customer. This helps to keep 
the related case information together so that the agent doesn’t have to manually merge related cases 
later. Interactions are assigned to a previous Case ID only if the previous case is not closed and not older 
than the defined default number of days.
*: When a customer sends an email without a case ID in the subject to the contact center, a new case is 
always created (Ignite does not reuse an existing case ID).
NOTE: When you initiate an outbound email, the previous case ID is not automatically reused, but Ignite 
displays the reusable case found and you can choose to reuse the Case ID if you wish to.
You can enable or disable the option to search for reusable cases on the Options > Customization page.
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You can filter, search, view the status of the interactions, move interactions from a case to another case, 
and go to the corresponding folders(Inbox, History or Inqueue) from the cases page.
Search and filter interactions
To search and filter interactions 
1. Click Cases to display a list of all cases.
2. Locate and click the required case from the list. 

The details are displayed in the right pane.
3. Click the Interactions tab, enter the string in the Search interactions field. The search results are 

displayed.

4. For a more detailed search: 

Click the down arrow in the Search field and enter the specific details.
Click the Search icon to display the results.
Optionally, you can filter based on case state – All, Draft, Inqueue, Ringing, Inbox, Handled, Sent, No 
Reply, Junk, and Failed. You can also select the Only show my items check box to filter your inter-
actions.
You can also view all the cases, or the customer related to an interaction by clicking Case tab or Cus-
tomer tab next to the Search interaction field.

Pick or Pick and Reply inqueue conversation
You can pick or pick and reply all to an Inqueue multimedia interaction from a case.
NOTE: An agent can only Pick or Pick and Reply All to one interaction at a time from a case. Pick, Pick 
and Reply All are available for Multimedia interactions, whereas only Pick is available for Voice and Open 
Media interactions (replying to those can only be performed from the Inbox).
To activate Reply, Reply All buttons in the Inbox 
1. Click Options > Customization.
2. Click Show 'Reply' button to activate reply button or click Show 'Reply All' button to activate reply 

all button in the Inbox.

3. Click Save.

To reply to a picked Inqueue interaction from Inbox 
1. In the Inbox, identify and select the Inqueue interaction you just picked.
2. On the right pane, click either Reply or Reply All. 

NOTE: If the email to which you are replying has an existing draft, the To:, CC:, and BCC: fields are 
cleared and refilled with the default addresses based on the reply type selected
3. The interaction opens in reply mode with all recipients copied. Type the content and click Send.

To activate Pick or Pick and Reply All buttons in the Interactions tab 
1. Click Options > Customization.
2. Click Show 'Pick' button to activate pick button or click Show 'Pick and Reply All' button to activate 

pick and reply all button in the Interactions tab.

3. Click Save.
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To pick an Inqueue interaction from within a case 
1. Click Cases, and from the list of cases, select the case of the Inqueue interaction.
2. In the Interactions tab, click Pick to assign the Inqueue interaction to yourself.

3. Click OK.

To pick and automatically reply to an Inqueue interaction of a case 
1. Click Cases, and, from the list of cases, select the case of the Inqueue interaction.
2. In the Interactions tab, click Pick and Reply All to assign the Inqueue interaction to yourself and 

reply. 

NOTE: If the email to which you are replying has an existing draft, the To:, CC:, and BCC: fields are 
cleared and refilled with the default addresses based on the reply type selected
3. The Interaction opens in reply mode with all recipients copied. Type the content and click Send.

Navigate using the Go to button
You can select an interaction listed in the Interactions tab present under Inbox, History, Cases, or 
Queues folders and navigate to the interaction in the folder it is currently located in.
For example, for an interaction in your Inbox that contains a related interaction in the History folder, you 
can navigate to the interactions tab and use the Go to icon next to this related interaction to navigate to 
the History folder and view the related interaction.
NOTE: 
• The Go to button is not displayed for the currently selected interaction in the Inbox, but is displayed 

only for the other related interactions for the same customer.
• The Go to button is not displayed for the inbox items, that do not belong to you.

To navigate using the Go to icon from cases 
1. Click Cases to display a list of all cases.
2. Click the required case from the list. 

The details are displayed in the right pane.
3. In the Interactions tab, click Go to icon to navigate to the interaction’s current folder.

Moving conversations to other cases
Moving interactions from one case to another might be needed to fix incorrect case linking. You can move 
one or more interactions from a case to an existing or new case of the same customer.
The following are the important points you must be familiar with before moving interactions from the 
source case to other cases: 
• If the source case is the only case the customer is associated with, you can select one or many inter-

actions to cut from that case, but not “all” of them. The selected interactions will be moved to a new 
case.

• When the customer has more than one case, you can select one, many, or all interactions from the 
source case and move them to an existing target case of the same customer.

• The state of the new case will be same as the source case.
• The subject for a case is based on the last interaction associated with the case. Therefore, after inter-

actions are moved from one case to another, the subject of the latter case might change.
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Ignite(Web) will automatically re-close a case in the following scenario: 
1. Case A was auto-closed after being resolved for a long time.
2. Ignite automatically reopened Case A when a new email with the same case in the subject line was 

received.

3. Additional interactions may get associated with Case A (i.e. An agent may respond to that email).

4. An agent or supervisor may decide to move all the interactions that were associated with the case 
(case A) since it was closed to a new case (case B) or another existing case (case C).

5. Case A is auto-closed again.

To move interactions from one case to another case: 
1. Click Cases.
2. From the list of cases, select the case that contains the interaction(s) you want to move.

3. In the Interactions tab, select the interaction from the list. Optionally, you can select multiple interac-
tions from this list.

4. Click Cut from Case icon next to the interaction or hover over the interaction avatar and click the Cut 
from Case icon. 

If you want to move multiple interactions, click the avatar and select many or all interactions, and click 
Cut from Case icon at the top.

5. Paste the selected interactions to a new case or to an existing case: 

– To paste to a new case, click the Paste to new case button. A new case is created containing the 
interaction you moved there.

– To paste to an existing case (if there is one for this customer), click the Paste to other case button, 
and search and select the target case in the dialog box that displays.

NOTE: 
– If you selected all interactions from a case to be moved, all the notes from the case are moved to 

the target case and the source case is deleted.
– If the selected interactions are not the only interactions for the source case, Ignite will display a list 

of notes that were created after the first interaction you want to cut, and you can decide which notes 
(if any) you want to cut and paste it into the target case.

6. Click OK.

Forwarding an interaction listed in a case
You can forward an interaction to others if you no longer wish to track the interaction.
To forward an interaction from a case 
1. Click Cases to display a list of all cases.
2. Click the required case from the list. 

The details are displayed in the right pane.
3. Click the Interactions tab. 

Interactions related to the selected case are displayed.
4. In the Interaction tab, click Forward icon.
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5. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

6. Type the required content and click Send.

Participants

You can view the list of participants associated with each case. The participants list includes employees 
and external contacts.
NOTE: Participants list can also contain contact information derived from Active Directory. Active directory 
is only supported in single-tenant configuration.
To view the participants associated with a case 
1. Click Cases to display a list of all cases.
2. Click the required case from the list. 

The details are displayed in the right pane.
3. Click the Participants tab to view the list of associated participants for the case.

In the Participants tab, you can do the following: 
• Search for the participants associated with a case using the search field
• Edit external participants’ contact information by clicking on the Edit icon. Note that you cannot edit 

employee or active directory records. For information on editing external contacts, see "Contacts 
(WEB)".

• View all the cases that the participant is associated with by clicking on the Case icon. For information 
on viewing case information related to participants, see "Contacts (WEB)".

• Associate or dissociate external contacts from cases by using the Associate and the Dissociate 
icons. For information on associating and dissociating external contacts from a case, see "Associating 
or disassociating participants to a case".

• Merge external contacts by clicking on the Merge icon. For information on merging external contacts, 
see "Merge External Contacts".

Associating or disassociating participants to a case
You can associate participants with a case if they are relevant to that case. If a participant’s association 
with a case is incorrect, you can disassociate that participant from the case. An alert appears on the 
participant tab, when a participant is not associated to a call.
To associate a participant with a case 
1. Click Cases to display a list of all cases.
2. Click the required case from the list. 

The details are displayed in the right pane.
3. In the Participants tab, click the Associate Participant icon. 

The Associate Participant window is displayed.
4. In the Associate Participant window, you can: 

– Search for an existing contact and associate the contact with the case—In the Search field, type the 
contact name. Under Results, hover over the contact avatar and click to select it and click OK.

– Add a new contact and then associate that contact—Click the Add Contact icon. The Create and 
Associate Contact window is displayed. Enter the contact details and click Save.
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NOTE: When you create a contact in Ignite(WEB), you must add an extension to the phone number 
if multiple contacts share the same phone number.

The contact you associated with the case is listed in the Participants tab.

To disassociate a participant from a case 
1. Click Cases to display a list of cases.
2. Click the required case from the list. 

The details are displayed in the right pane.
3. In the Participants tab, click the Dissociate icon for the participant you want to dissociate.

4. Click OK to disassociate the participant from the case.

Other cases for this customer

The Other cases for this customer page lists other cases associated with this customer(s).You also can 
filter, search, view the status of the interactions, and move calls from a case to another case.

Handling emails in Ignite

Handling emails in Ignite mirrors common email client behavior, offering agents and supervisors a familiar 
and user-friendly environment. Ignite supports both HTML and plain text emails.
NOTE: Removing or otherwise altering case and ticket numbers in subject lines before handling emails can 
interfere with preferred agent routing. Agents should contact their supervisors or system administrators 
before editing case and ticket numbers in email subject lines.
The following explains how to
• Preview emails
• Preview drafted content for emails in queue (DESKTOP)
• Pick emails out of queue
• Reply to emails
• Forward emails
• Add attachments to emails
• Insert images in emails
• Preview and save attachments
• Transfer emails to internal and external destinations
• Decline emails
• Mark emails as ‘No Reply’ and ‘Junk’
• Place emails on hold and retrieve emails from hold
• Transition to alternate interaction types
• Correct spelling in email responses
• Create personal reply templates
• Apply personal reply templates to emails
• Apply reply templates to emails
• Apply personalized signatures to emails
• Apply quick reply templates to emails
• Reroute Failed emails
• Handle oversized emails



1081

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

• Handle bounced emails
• Send outbound emails

NOTE: DESKTOP - To complete the following procedures, you must be in Ignite’s My Folder’s View.

Previewing emails

If administrative configurations permit, agents can preview interactions before picking them out of queue 
or handling them.
The following explains how to 
• Preview emails in queue
• Preview emails in the Inbox

To preview an email in queue (DESKTOP) 
1. In the Folders pane, select a queue.
2. In the List pane, select an email.

To preview an email in queue (WEB) 
1. Click Queues and select a queue.
2. Select an email to preview.

To preview an email in the Inbox (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select an email.

To preview an email in the Inbox (WEB) 
• Click Inbox and select an email to preview. In addition to handling options, you can quickly access the 

case details, notes, calls, all the participants of the case, and other cases from the same customer. 
This can save time when you are interacting with a customer.

To preview emails in Cases (WEB) 
• Click Cases and select the email to preview.

Previewing drafted content for emails in queue (DESKTOP)

If administrative configurations permit previewing emails in the Preview Pane before picking emails out of 
queue, agents can also choose to preview content drafted by other agents in requeued emails.
Normally agents only see the original content of the email interaction when viewing emails in the List pane 
or the Preview pane. Requeued emails, however, may contain content drafted by employees for use by 
other agents in the contact center. Agents can choose to filter the List pane’s contents for a queue to only 
show the emails in queue that have drafted content from other agents and include the drafted contents in 
the List pane and in the Preview pane. If agents navigate away from the queue to another queue, the filter 
is removed.
NOTE: Previewing drafted content for emails in queue in Ignite requires agent previews to be enabled on 
the media server. See "Configuring Advanced options for media servers" for more information.
The following procedures explain how to
• Preview drafted content for emails in queue
• Revert to viewing all emails in queue
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To preview drafted content for emails in queue
1. In the Folders pane, right-click the email queue for which you want to preview drafted content.
2. Select Drafts.

The List pane displays the requeued emails in queue that have drafted content. The Folder pane dis-
plays the queue name in orange and italics.

To revert to viewing all emails in queue
1. In the Folders pane, right-click the email queue.
2. Select the queue name.

The List pane displays all emails in queue. Drafted content is not displayed.

Picking emails out of queue

Pick behavior occurs in the following ways: First, agents can pick interactions out of queue and send them 
to the Inbox. When the interactions ring in the Inbox, agents can handle them. Second, agents can choose 
to pick and reply to an interaction. Choosing to pick and reply to an interaction sends the interaction to the 
agent's Inbox from where the agents can handle the interaction. Cc'd recipients are included in the reply.
Emails picked out of queue ring in the agent’s Inbox until the interaction is put into reply mode. For more 
information on ringing behavior, see "Ringing states in Ignite".
NOTE: 
• Agents cannot pick or pick and reply to interactions from the queue if they are in Do Not Disturb.
• Agents may only pick or pick and reply to interactions from the queue if they have the appropriate 

permissions.

The following procedures explain how to
• Pick an email out of queue and handle the email
• Pick and automatically reply to an email

To pick an email out of queue and handle the email (DESKTOP)
1. From the Folders pane, select the queue from which the email will be picked.
2. From the List pane, select an email from the queue and, from the Action bar, click the Pick button.

The email is transferred to your Inbox.
3. To handle the email, select Inbox and, in the List pane, select the email.

NOTE: Additional handling options display in the Action bar. For information on handling the email, 
see the appropriate procedures in this section.

To pick an email out of queue and handle the email (WEB)
1. Click Queues and select the appropriate queue.
2. Select an interaction or hover over the item avatar and click Pick > Pick.

The email is transferred to your Inbox.
3. To handle the email, click Inbox and select the email or hover over the item avatar.

4. Select either Reply or Reply all.

To pick and automatically reply to an email (DESKTOP)



1083

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

NOTE: This action functions as 'reply all' if there are recipients Cc’d on the original email.
1. In the Folders pane, select the queue from which an email will be picked.
2. In the List pane, select an email from the queue and, from the Action bar, click the Pick & Reply 

button.

The email is transferred to your Inbox and opens in reply mode, with all recipients copied.
NOTE: 

– Additional handling options display in the Action bar. For information on handling the email, see the 
appropriate procedures in this section.

– If the email to which you are replying has an existing draft, the To:, CC:, and BCC: fields are cleared 
and refilled with the default addresses based on the reply type selected.

To pick and automatically reply to an email (WEB)
1. Click Queues and select the appropriate queue.
2. Select an interaction or hover over the item avatar and click Pick > Pick and Reply.

The interaction is transferred to your Inbox and opens in reply mode with all recipients copied.

Replying to emails

Once an email is in the Inbox, agents can write and send a response. Agents can reply to the email’s 
sender only, reply to all email recipients, insert additional addresses in their email’s To: field, and, if 
enabled for the email queue, select a From address from one of the email queues they handle. Agents 
can also copy and blind-copy other email addresses on replies.
NOTE: When replying to an email, you can select the Paste as Text button to paste the content into the 
email message as plain text. When you click Paste as Text for the first time, Ignite displays the message, 
“Paste is now in plain text mode. Contents will now be pasted as plain text until you toggle this option off. 
The latest state of the toggle button is saved to your profile.
DESKTOP - Emails to which an agent has replied display under ‘Handled’, in the Folders pane.
Formatted URLs entered by agents in email responses will become links when the agent sends the email 
reply.
Note that, by default, the maximum file size for emails, including attachments, signatures, and images, is 
25 MB.
To reply to an email (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select an email and, in the Action bar, click Reply or Reply All. 

NOTE: If the email to which you are replying has an existing draft, the To:, CC:, and BCC: fields are 
cleared and refilled with the default addresses based on the reply type selected.

3. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

4. If enabled for this queue, you can select a different From address by clicking From and selecting the 
email address. 

By default, From is set to the email address of the last queue the email was handled from.
5. Type the email’s contents and, in the Action bar, click Send . An icon displays over the Preview pane, 

indicating the email is being sent. 
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NOTE: Additional handling options display in the Action bar. For more information, see the appro-
priate procedures in this section.

To reply to an email (WEB) 
1. Click Inbox and select an email or hover over the item avatar.
2. Click Reply and select either Reply or Reply All. 

NOTE: If the email to which you are replying has an existing draft, the To:, CC:, and BCC: fields are 
cleared and refilled with the default addresses based on the reply type selected.

3. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons. 

NOTE: If you want to initiate an email to multiple customers without manually entering the addresses, 
select the interaction in Inbox, in the preview pane, click Participants tab, click the avatars of the desired 
contacts, a check mark is displayed against the selected contacts, now click the email icon next to the 
Contacts Selected text. A new draft with all the selected customer email addresses in the To field is initi-
ated.
4. If enabled for this queue, you can select a different From address by clicking From and selecting the 

email address. 

By default, From is set to the email address of the last queue the email was handled from.
5. Type the email's contents and click Send.

Forwarding emails

You can forward emails to multiple parties with additional recipients copied and blind-copied on forwarded 
mails.
DESKTOP - You can forward emails from the My History folder and its subfolders, the History folder and 
its subfolders, and the Failed folders. Forwards in progress are housed in the agent's personal Drafts 
folder, in the Forward subfolder. When forwarding an email that failed to route, the options to reroute or 
junk the email will not be available.
WEB - You can forward emails from the History page. Forwards in progress are housed as drafts in the 
Inbox.
Agents cannot forward emails from reply mode. Instead, agents can transfer emails to internal and 
external destinations. For more information, see "Transferring emails to internal and external destina-
tions" and "Replying to emails".
NOTE: When replying to an email, you can select the Paste as Text button to paste the content into the 
email message as plain text. When you click Paste as Text for the first time, Ignite displays the message, 
“Paste is now in plain text mode. Contents will now be pasted as plain text until you toggle this option off. 
The latest state of the toggle button is saved to your profile.
The following procedures explain how to 
• Forward an email
• Discard forwards in progress

To forward an email (DESKTOP) 
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, select either the History, My History, the Failed folder, or their subfolders.

3. In the List pane, select the email and, in the Action bar, click Forward.
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4. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

5. Click Send.

To forward an email (WEB) 
1. Click History and, optionally, select a Filter:.
2. Select an email or hover over the item avatar and click Forward.

3. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

4. Click Send.

NOTE: When you forward an email to an external email address, the contact information is automatically 
added to the associated case and in the database. Also, the state of the case is updated to "Waiting for 
customer".
To discard a forward in progress (DESKTOP) 
1. In the My Folders view, expand the Folders pane .
2. In the Folders pane, click Drafts. If necessary, expand the My Folders folder first.

3. Expand the Drafts folder and select Forward.

4. In the List pane, select the email and, in the Action bar, click Discard Draft.

To discard a forward in progress (WEB) 
• Click Inbox and either select the forward in progress or hover over the item avatar and click Discard.

Adding attachments to emails

When replying to or forwarding an email, agents can add attachments. Agents can either drag and drop 
attachments into emails or add attachments by following the steps below. When dragging and dropping 
attachments, you must drop the attachment into the area of the User Interface that displays the To:, CC:, 
and Bcc: fields. Note that files attached by drag-and-drop are not embedded in the body of the email. To 
embed an image in the body of an email, see "Inserting images in emails".
Note that, by default, the maximum file size for emails, including attachments, signatures, and images, is 
25 MB.
To add an attachment to an email (DESKTOP and WEB)
1. When replying to an email, click the Add attachment icon. This icon displays as a paperclip.
2. Navigate to the file and click Open. You can select multiple files.

3. To remove an attachment, click the X button beside the attachment.

Inserting images in emails

You can insert images in emails using Ignite’s Insert Image button, or can drag-and-drop or copy/paste 
images into email responses.
Inserting an image into an email embeds the image in the body of the email at the cursor point. Dragging 
and dropping an image adds the image as an attachment. Copying and pasting an image into an email 
embeds the image in the body of the email.
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50 inserted images will be visible in Ignite email responses. After 50 the images will show as an X in Ignite, 
but will display to the recipient in full.
Note that, by default, the maximum file size for emails, including attachments, signatures, and images, is 
25 MB.
To insert images in emails (DESKTOP and WEB)
1. When replying to an email, click the Insert picture icon.
2. Navigate to the image and click Open. You can select multiple files.

3. To remove an image from an email, select the image and press the Delete key.

Previewing, saving, and removing attachments

NOTE: Previewing and saving attachments are currently available in Ignite desktop only. The Ignite web 
client allows for downloading attachments only.
Agents can preview the following attachments on incoming emails: PDF, Word, Excel, and Windows 
Media files (.wma). Note that these applications are not included with Ignite and must be installed on the 
agent’s desktop for previewing to function. Agents can also save attachments to their hard drives, and 
remove attachments from received emails.
The following procedures explain how to
• Preview PDF, Word, Excel, and Windows Media files attachments
• Save attachments
• Remove attachments

To preview an attachment (DESKTOP)
1. In the Preview pane, click the attachment and select Open.

NOTE: If the list of attachments exceeds two lines, use the scroll bar to navigate attachments.

To save an attachment (DESKTOP)
1. In the Preview pane, click the attachment and select Save. If the list of attachments exceeds two 

lines, use the scroll bar to navigate attachments.
2. Browse to a save location and click Save.

NOTE: Save dialog options may vary depending on your operating system. If more information is 
required, please consult Microsoft Windows documentation.

To remove attachments (DESKTOP and WEB)
1. To remove an attachment, click the X button beside the attachment.
2. To remove all attachments, to the right of the attachments, click the Remove All Attachments button.

Transferring emails to internal and external destinations

Agents can transfer emails to both internal and external destinations. For example, agents in the Support 
queue receiving requests for account renewals can transfer these contacts to the Sales queue. Transfers 
include any email attachments.
Agents transfer emails internally to other agents and to queues. To receive transfers, devices must be 
enabled to handle the interaction’s media type.
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Agents who are logged out, in DND, Offline (WEB), or whose presence is Unknown cannot receive trans-
ferred emails. Agents who are either in Busy/Make Busy or at their email Workload limit can receive trans-
ferred emails.
When agents transfer emails from their Inbox, the email retains any text entered. This enables agents 
receiving transferred mails to see and build on responses other agents have drafted.
NOTE: 
• You may only transfer interactions if you have the appropriate permissions.
• If you are transferring an email with drafted content, the To:, CC:, and BCC: fields will be cleared and 

replaced by the default addresses when another agent chooses to Reply or Reply All to the email.

The following explains how to 
• Transfer emails to an agent or queue
• Transfer emails to an external address

To transfer an email to an agent or queue (DESKTOP) 
1. In the Folders pane, click Inbox. 

NOTE: To transfer directly from the queue, select the email from the queue and, in the Action bar, 
click ‘Transfer’. Follow steps 4 onward.

2. In the List pane, select an email and, in the Action bar, click Reply.

3. In the Action bar, click Transfer.

4. Select the Internal Transfer radio button and select an agent or queue. Expand the device list if 
necessary. You can search for an internal transfer destination by typing the name of an agent or 
queue in the ‘Search’ field.

5. Click Transfer.

To transfer an email to an agent or queue (WEB) 
1. Click Inbox and select an email or hover over the item avatar and click Accept. 

To transfer directly from the queue, click Queues.
To transfer from the Cases page, under Interactions tab, select the inqueue or inbox email and click 
Goto icon. The Queues page is displayed. You can now transfer the email from the Queues page. 
Follow steps 4 onward.

2. Click Reply and select either Reply or Reply All.

3. Click Transfer.

4. Select the email or hover over the item avatar and click Transfer icon. 

NOTE: Optionally you can select multiple emails from the Inbox or the Queues page and click Transfer. 
The Transfer window is displayed. The list of available Employees and Queues are displayed in the 
Results section.
5. To transfer to an agent, in the Transfer window click Employees and select an employee from the list.

6. To transfer to a queue, in the Transfer window click Queues and select a queue from the list.

7. In the Transfer window, click Employees and type an email address. Separate multiple addresses 
with semi-colons.

8. To transfer the email, select the name of the appropriate agent or queue.
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To transfer an email to an external address (DESKTOP) 
1. In the Folders pane, click Inbox. 

NOTE: To transfer directly from the queue, select the email from the queue and, in the Action bar, 
click ‘Transfer’. Follow steps 4 onward.

2. In the List pane, select an email and, in the Action bar, click Reply.

3. In the Action bar, click Transfer.

4. Select the External Transfer radio button and, in the Transfer To: field, type an email address. Sepa-
rate multiple addresses with semi-colons. 

NOTE: Invalid entries return an error message. Re-type a valid entry and click ‘Transfer’.
5. Click Transfer.

To transfer an email to an external address (WEB) 
1. Click Inbox and select an email or hover over the item avatar and click Accept. 

To transfer directly from the queue, click Queues,
To transfer from the Cases page, under Interactions tab, select the inqueue or inbox email and click 
Goto icon. The Queues page is displayed. You can now transfer the email from the Queues page. 
Follow steps 4 onward.

2. Click Reply and select either Reply or Reply All

3. Click Transfer.

4. Select the email or hover over the item avatar and click Transfer icon. 

NOTE: Optionally you can select multiple emails from the Inbox or the Queues page and click Transfer. 
The Transfer window is displayed. The list of available Employees and Queues are displayed in the 
Results section.
5. To transfer to an agent, in the Transfer window click Employees and select an employee from the list.

6. To transfer to a queue, in the Transfer window click Queues and select a queue from the list.

7. In the Transfer window, click Employees and type an email address. Separate multiple addresses 
with semi-colons.

8. To transfer the email, select the appropriate email address(es).

Declining emails

Agents can decline offered emails, sending interactions back to the queue as the longest waiting.
NOTE: When an agent declines an interaction, they are automatically put into Busy/Make Busy across all 
media capabilities. A System Make Busy and a requeue count is registered for the employee . For more 
information, see "Setting and removing Busy/Make Busy in Ignite".
To decline an email (DESKTOP)
1. In the Folders pane, click Inbox.
2. In the List pane, select an email and, in the Action bar, click Decline.

To decline an email (WEB)
• Click Inbox and select an email or hover over the item avatar and click Decline.
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Marking emails as No Reply and Junk

Occasionally emails requiring no reply, like an out of office message, and junk mail, like spam, reach 
queues and agents’ Inboxes. Agents can mark these emails either as requiring no reply or as junk.
Agents can also junk emails directly from 'Failed' rather than attempting to reroute them.
Marking interactions as No Reply and Junk removes the interactions from Ignite. If the item is in queue or 
the Inbox, responses in progress are deleted.
NOTE: 
• Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and Ignite 

are not included in queue Handled, Completed, and Offered counts.
• Agents may only Junk interactions if they have the appropriate permissions.

To mark an email as No Reply or Junk (DESKTOP) 
1. In the Folders pane, either click Inbox, select the queue in which the email is waiting, or select a 

Failed folder.
2. In the List pane, select an email and, in the Action bar, click either No Reply or Junk.

To mark an email as No Reply or Junk from the Inbox (WEB) 
• Click Inbox and select an email or hover over the item avatar and click either No Reply or Junk.
To mark an email as No Reply or Junk from the queue (WEB) 
1. Click Queues and select an email queue.
2. Select an email or hover over the item avatar and click either No Reply or Junk.

Placing emails on hold and retrieving emails from hold

Agents may have to stop working on one email in order to work on other items. In these cases, agents 
can put the active email on hold. Interactions on hold are marked with a 'pause' icon.
Note that administrative configurations may limit how long interactions may be on hold before being 
requeued and a System Make Busy is registered for the employee. For information on this limit, contact 
your supervisor or system administrator.
The following procedures explain how to
• Place an email on hold
• Retrieve an email from hold

To place an email on hold (DESKTOP)
• When replying to an email, click the Hold button.
To place an email on hold (WEB)
• Click Inbox and select an email, or hover over the item avatar, and click Hold.
To retrieve an email from hold (DESKTOP)
1. In the Folders pane, click Inbox and, in the List pane, select the email on hold.
2. In the Action bar, click Remove Hold.

To retrieve an email from hold (WEB)
• Click Inbox and select an email on hold or hover over the item avatar and click Remove Hold.
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Transition to alternate conversation types

During an interaction, agents can transition to an alternate interaction type if the agent is associated with 
that media type and if the customer’s relevant contact details are available. Agents can also edit contact 
information during an interaction.
See the "Transitioning from one conversation type to another (WEB)" section in this guide.

Correcting spelling in email responses

Ignite provides automatic spell checking of email responses. Incorrectly spelled words are underlined in 
red and can be corrected via a right-click menu.
Ignite’s spell check button is located in the formatting toolbar, along with additional formatting options. 
Ignite’s spell checking function assists agents in sending polished responses to customers.
NOTE: 
• Russian and Mandarin Chinese are not supported.
• Grammar checking is not supported.

The following explains how to 
• Correct spelling in email responses
• Ignore flagged words
• Undo spell checking changes
• Change the dictionary’s language
• Add words to your personal dictionary
• Clear additions to your personal dictionary
• Toggle spell checking on or off

To correct spelling in an email response 
• Right-click an underlined word and select the correct spelling from the list provided.
To ignore flagged words 
• Right-click an underlined word and select Ignore.
To undo spell checking changes
NOTE: This function reverts words to their original spelling. It does not clear additions made to the dictio-
nary.
• In the Ignite formatting toolbar, click the Undo button.
To change the dictionary’s language 
• In the Ignite formatting toolbar, from the dictionary language drop-down list, select a language. See the 

following figure. 
NOTE: Ignite remembers this selection for future replies.

To add words to your personal dictionary 
• Right-click an underlined word and select Add to personal dictionary.
To clear additions to your personal dictionary
NOTE: This option clears all additions to your personal dictionary.
1. In the Ignite formatting toolbar, click the Delete Personal Dictionary button. (See the following 

figure.)
2. Either refresh the page or log out of Ignite and log back in for the changes to take effect.
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To toggle spell checking on or off 
• Click the Spellcheck As You Type button. (See the following figure.) 

NOTE: Ignite remembers this selection for future replies.

Figure 24.49: Spell check options
 

Applying reply templates to emails

Agents can apply reply templates to emails, providing standardized responses to common questions and 
requests. Once applied, responses can be edited as required. Also, click refresh to view and apply the 
recently created reply templates.
The following procedures explain how to 
• Apply reply templates to emails using file name or predictive text
• Apply reply templates by browsing and selecting

To apply reply templates to emails using file name or predictive text 
1. When an email is in reply mode, place the cursor in the body of the email response.
2. On the formatting toolbar, click the Insert Reply Template button.

3. In the Insert Reply Template window, begin typing the file name or the text that the template 
contains. Templates matching the file name or the text will display.

4. To insert the template, in the Insert Reply Template window, click the template you want to insert 
and click Insert. The text is inserted in the email, at the cursor point.

5. Optionally, delete the text from the window and repeat the above steps.

To apply reply templates by selecting the templates from the list (WEB) 
1. When an email is in reply mode, place the cursor in the body of the email response.
2. On the formatting toolbar, click the Insert Reply Template button.

3. From the Insert Reply Templates window, select the reply template you want to apply from the list 
and click Insert button.

4. Reply template is inserted in the email, at the cursor point.
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5. Optionally, delete the text from the window and repeat the above steps.

To apply reply templates by browsing and selecting (DESKTOP) 
1. When an email is in reply mode, place the cursor in the body of the email response.
2. On the formatting toolbar, click the Reply Template button.

3. In the Reply Template window, click the Browse Reply Templates button. 

See the following figure.
4. From the Browse Reply Templates window, select the template from the options listed.

5. To insert the text, in the Reply Template window, click the check mark icon. The text is inserted in 
the email, at the cursor point.

6. Optionally, delete the text from the window and repeat the above steps.

NOTE: 
• The image must be in .jpg format while using a messaging file in the reply template.
• The Chat reply templates must be saved in UTF-8 encoding or Unicode encoding.

Figure 24.50: Browse Reply Templates button
 

Applying personal reply templates to emails

Applying personal reply templates to emails enables you to provide standardized responses to common 
questions and requests. For information on creating a personal reply template, see "Tools (WEB)"
To apply reply templates to emails
1. When an email is in reply mode, place the cursor in the body of the email response.
2. On the formatting toolbar, click the Insert Reply Template button.

3. In the Insert Reply Template window, from the list of reply templates, type to search for a reply 
template that you want to insert, or, click the reply template you want to select from the list.

4. Optionally, click Preview to preview the selected reply template before inserting.

5. Click Insert.
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The reply template is inserted in the email, at the cursor point.

Applying personalized signatures to emails

If allowed, agents can apply personalized signatures to emails. Personalized signatures can be created 
as templates, which can then be applied to email responses. For more information, see "Applying reply 
templates to emails". Once applied, signatures can be edited as required. Agents can also cut-and-paste 
signatures into emails.
NOTE: Creating templates is an administrative configuration. For information on whether personalized 
signatures are allowed, contact your supervisor or system administrator.

Applying quick reply templates to emails

When responding to an email interaction, you can quickly access an existing reply template used. When 
using Ignite from the desktop, you can select from the five most recently used templates. When using 
Ignite from a hand-held device, only the three most recently used templates are available.
To apply a recently used template to an email response
1. Click Inbox, select an email, or hover over the item avatar, and click Reply or Reply All.

The most recently used templates display at the bottom of the window.
2. Click the reply template you want to insert into the email response.

To disable quick reply templates
1. Click Options > Email.
2. Under Quick reply templates, toggle the switch to gray.

NOTE: Quick reply templates is enabled by default, The Clear quick reply templates view after 
insert is disabled when you disable the quick reply templates.

Rerouting failed emails

If emails fail to route, they are stored in Ignite’s Failed folder (DESKTOP) or in the History page under 
Failed (WEB). Ignite’s Reroute button removes emails from these locations and attempts to transfer them 
back to the queue.
Agents may also mark these emails as Junk or forward the email. Forwarding emails from Failed does 
not remove the original copy from these locations. Forwards in progress are housed in the agent's 
personal Drafts folder (DESKTOP), in the Forward subfolder (DESKTOP) or in the Inbox (WEB). If you 
reroute an email that has existing forward drafts, the drafts will be deleted.
For information on handling bounced and oversized emails, see "Handling bounced emails" and 
"Handling oversized emails".
We recommend that agents and supervisors check Ignite frequently in order to reroute emails that failed 
to route.
• DESKTOP - Under Processed, supervisors may see all emails that failed to route. Agents may only 

see emails sent to the queues for which they answer.
• WEB - In History > Failed, supervisors will see all emails that failed to route. Agents may only see 

emails sent to the queues for which they answer.
• While rerouting emails removes them from Failed immediately, there may be a delay before the emails 

are transferred back to the queue.
• Agents may only Junk interactions if they have the appropriate permissions.
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To reroute emails in the Failed folder (DESKTOP) 
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, select a Failed folder.

3. In the List pane, select an email and, in the Action bar, click Reroute. Alternatively, click Junk to 
mark the email as Junk and remove it from the Failed folder or click Forward to send the email to a 
recipient.

To reroute emails from Failed (WEB) 
1. Click History > Failed.
2. Select an email or hover over the item avatar and click either Reroute, Junk, or Forward. 

If you select 'Forward,' the interaction is delivered to the Inbox where you can specify recipients.

Handling oversized emails

Depending on administrative settings, an error message displays if you attempt to send an email that 
exceeds the maximum message size. You can then edit the email to reduce its size and attempt to resend 
the email.
If administrative settings do not match the limits of your organization’s mail server, you may not receive 
the error message. Subsequently, Ignite displays the following behavior:
• DESKTOP - The email fails to send and displays in the Failed to Send subfolder (contained in the 

Failed folder), where it can be selected, edited to reduce its size, and re-sent. Failed to Send emails 
also display in the supervisor’s Failed to Send folder, where they can optionally edit and resend them 
if the associated agent is inactive.

• When there are items in the Failed to Send subfolder, the font color of this folder name, and of the 
parent Failed folder, display in red, followed by a number indicating how many active items currently 
reside in the folder.

• WEB - The email fails to send and displays in the Inbox where it can be selected, edited to reduce its 
size, and re-sent. Items that fail to send are marked in red and a failure message displays. Supervisors 
can also view these items in History.

Handling bounced emails

Depending on administrative settings, you may be required to handle bounced emails. These are sent 
emails that failed to route due to out of office auto-responses, lack of space in the receiver’s inbox, delays 
caused by the mail server, and invalid addresses.
If your system is configured to support bounced email detection, and you have one or more bounced 
emails pending, Ignite displays the following behavior:
• DESKTOP - The number of bounced items displays beside your Auto Replies/Failed Delivery 

subfolder (contained in the Failed folder). The font color of this folder name, and of the parent Failed 
folder, displays in red. You can select an item and either Junk or forward it.

• WEB - Bounced items display in the Inbox and are marked in red, with 'Auto-Reply' text. You can select 
an item and either Junk or forward it. Supervisors can also view these items in History.

Sending outbound emails

NOTE: 
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• Real-time and reporting statistics are not available for outbound email activity at this time. We recom-
mend instead that agents put themselves into Busy/Make Busy, with an ‘Outbound email’ Reason 
Code applied, when drafting outbound emails. Make Busy reports and real-time queue statistics will 
then display time spent drafting outbound emails.

• If contact centers use preferred agent routing, we recommend that agents do not adjust case and ticket 
numbers in email subject lines. Removing or otherwise altering case and ticket numbers in subject 
lines can interfere with preferred agent routing.

DESKTOP - Outbound emails in progress are housed in the agent's personal Drafts folder, in the New 
Emails subfolder. This functionality is available to employees with email agents answering for queues. 
Agents can only send outbound emails from the email queues for which they answer.
WEB - Outbound emails in progress are housed in the Inbox, marked as 'Draft'.
By default, the maximum file size for emails, including attachments, signatures, and images, is 25 MB.
Queue signatures are automatically inserted in outbound emails, if signatures are configured for the 
queue. Queue signatures are inserted each time a queue is selected as the ‘From’ address.
If you are permitted to use personalized signatures in outbound emails, see "Applying personalized signa-
tures to emails".
Agents can perform common email functions when sending outbound emails, including inserting images, 
attachments, and applying reply templates to email drafts. See the appropriate topics in this guide for 
applicable procedures.
Outbound email functionality supports preferred agent routing, to enable ongoing interactions between 
agents and email recipients.
The following procedures explain how to 
• Send outbound emails
• Discard outbound emails in progress
• Search for outbound emails

To send an outbound email (DESKTOP)
NOTE: Account codes are not supported for outbound emails.
1. In the My Folders view, expand the Folders pane.
2. In the Action bar, click New Email.

3. In the Preview pane, click From… and select an email queue. 

NOTE: Queue signatures are inserted each time a queue is selected as the ‘From’ address.
4. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-

priate fields. Separate multiple addresses with semi-colons.

5. Type the email’s contents and, in the Action bar, click Send . An icon displays over the Preview pane, 
indicating the email is being sent. 

The email queue signature is inserted in the draft email.

To send an outbound email (WEB) 
1. Click Contacts.
2. If the email destination is not a recent contact, type the email address in the Search field.

3. Hover over the appropriate address and click the Email icon. For emails to agents, a colored dot on 
the avatar indicates its availability. 
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The system checks if the selected contact is associated with any open cases and if there is an existing 
open case, the Reusable case found dialog is displayed with the details of the most recent open case 
for that contact. You can view the case information such as Case ID, subject and the email body and 
decide if you want to reuse the existing Case ID for this email. To reuse the Case ID, click Yes, else, 
click No.

NOTE: If you do not wish to search for reusable cases in future, click the Disable searching for reusable 
cases in the future check box. You can enable or disable the option to search for reusable cases on the 
Options > Customization page.
4. In the new draft, click From… and select an email queue. 

NOTE: Queue signatures are inserted each time a queue is selected as the ‘From’ address. Agents 
are responsible for deleting non-applicable queue signatures from outbound email drafts.

5. You can alternatively search for contacts and their associated email addresses by clicking the To:, 
CC:, or Bcc: buttons. In the Contacts dialog box, select the required contacts, the email address are 
auto-entered in the appropriate fields.

6. Type the email’s contents and click Send. 

NOTE: If Contacts is open, click Contacts again to close the window and expose the desired controls.

To discard an outbound email in progress (DESKTOP) 
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, click Drafts. If necessary, expand the My Folders folder first.

3. Expand the Drafts folder and select New Emails

4. In the List pane, select the outbound email and, in the Action bar, click Discard Draft.

5. To search for an outbound email in the Drafts folder, see the procedure below.

To discard an outbound email in progress (WEB)
NOTE: If Contacts is open, click Contacts again to close the window and expose the desired controls.
• Click Inbox and select a draft or hover over the item avatar and click Discard.
To search for an outbound email in the Drafts folder (DESKTOP)
NOTE: The Drafts folder contains the agent's emails in progress. To search for sent outbound emails, 
search the Sent folder.
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, click Drafts. If necessary, expand the My Folders folder first.

3. Expand the Drafts folder and select New Emails.

4. If required, in the Search field, click the x button to clear the pane.

5. In the Search field, type keywords over the ghost text. 

See "Searching Ignite" for detailed search information and procedures.

To search for an outbound email (WEB) 
1. Click History and select Sent.
2. In the search field, type keywords over the ghost text. 

See "Performing keyword searches" for detailed search information and procedures.
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Handling chats in Ignite

NOTE: If you are using Contact Center Messenger Chat, for more information see "Handling Contact 
Center Messenger in Ignite"
Handling chats in Ignite mirrors common instant messaging applications, providing a familiar and 
user-friendly experience. Chat sessions are initiated by customers via your contact center’s chat request 
page or corporate website.
Interactions are automatically sent to your Inbox if you are the longest idle agent, the preferred agent, or 
the agent with the highest skill level in your agent group, if your agent group uses skill levels. Agents can 
also pick chat interactions out of queue.
The following explains how to:
• Preview chat interactions
• Pick chat requests out of queues
• Join chat sessions
• Decline chat interactions
• Chat with customers
• Transition to alternate interaction types
• Correct spelling in chat responses
• Apply reply templates to chat responses
• Place chat sessions on hold and retrieve chat sessions from hold
• Join the longest waiting active chat session (DESKTOP)
• Transfer chats
• Leave chat sessions
• Forward chat transcripts
• Remove Failed chat transcripts from Ignite

NOTE: DESKTOP - To complete the following procedures, you must be in Ignite’s My Folder’s View.

Previewing chat interactions

If administrative configurations permit, agents can preview interactions before picking them out of queue 
or handling them.
The following explains how to
• Preview chat interactions waiting in the Inbox
• Preview chats waiting in queue

To preview a chat interaction in your Inbox (DESKTOP)
1. From the Folders pane, click Inbox.
2. From the List pane, select the chat interaction to preview.

The chat interaction displays in the Preview pane.

To preview a chat interaction in your Inbox (WEB)
• Click Inbox and select a chat to preview.
To preview a chat interaction waiting in queue (DESKTOP)
1. From the Folders pane, click a queue.
2. From the List pane, select the chat interaction to preview.
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The chat interaction displays in the Preview pane.

To preview a chat interaction waiting in queue (WEB)
1. Click Queues and select a queue.
2. Select a chat interaction to preview.

Picking chat requests out of queue

Pick behavior occurs in the following ways: First, agents can pick interactions out of queue and send them 
to the Inbox. When the interactions ring in the Inbox, agents can handle them. Second, agents can choose 
to pick and reply to an interaction. Choosing to pick and reply to an interaction sends the interaction to the 
agent's Inbox from where the agents can handle the interaction.
Chat interactions picked out of queue ring in the Inbox until the interaction is accepted. For more informa-
tion on ringing behavior, see "Ringing states in Ignite".
NOTE: 
• Agents cannot pick or pick and reply to interactions from the queue if they are in Do Not Disturb.
• Agents may only pick or pick and reply to interactions from the queue if they have the appropriate 

permissions.

The following procedures explain how to
• Pick a chat request out of a queue
• Pick and automatically join a chat session

To pick a chat request out of a queue (DESKTOP)
1. From the Folders pane, select the queue from which an interaction will be picked.
2. From the List pane, select a chat from the queue and, from the Action bar, click the Pick button.

The chat is transferred to your Inbox.
3. To handle the chat, select Inbox and, in the List pane, select the chat.

NOTE: Additional handling options display in the Action bar. For information on handling the chat, 
see the appropriate procedures in this section.

To pick a chat request out of a queue (WEB)
1. Click Queues and select a queue.
2. Select an interaction or hover over the item avatar and click Pick > Pick.

The chat is transferred to your Inbox.
3. To handle the chat, click Inbox and select the chat or hover over the item avatar.

To pick and automatically join a chat session (DESKTOP)
1. In the Folders pane, select the queue from which a chat will be picked.
2. In the List pane, select a chat from the queue and, from the Action bar, click the Pick & Reply button.

The chat is transferred to your Inbox.
3. In the Preview pane, agents can respond to the chat, transfer the chat to another destination, or put 

the chat session on hold.

NOTE: Additional handling options display in the Action bar. For information on handling the chat, 
see the appropriate procedures in this section.
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To pick and automatically join a chat session (WEB)
1. Click Queues and select a queue.
2. Select an interaction or hover over the item avatar and click Pick > Pick and Reply.

The interaction is transferred to your Inbox and opens in reply mode.

Joining chat sessions

When a chat session arrives in an agent’s Inbox, agents can join the session and start responding to the 
interaction.
Agents can join sessions via Ignite's toaster or UI.
To join a chat session (DESKTOP)
1. In the Folders pane, click Inbox.
2. In the List pane, select a chat session and, in the Action bar, click Reply.

3. In the Preview pane, agents can respond to the chat, transfer the chat to another destination, or put 
the chat session on hold.

NOTE: Additional handling options display in the Action bar. For information on handling the chat, 
see the appropriate procedures in this section.

To join a chat session (WEB)
• Click Inbox and select a chat session or hover over the item avatar and click Accept.

Declining chat interactions

Agents can decline a chat interaction in their Inbox, sending the chat back to the queue where it retains 
its queue priority.
Agents can decline sessions via Ignite's toaster or UI.
NOTE: When an agent declines an interaction, they are automatically put into Busy/Make Busy across all 
media capabilities. A System Make Busy and a requeue count is registered for the employee . For more 
information, see "Setting and removing Busy/Make Busy in Ignite".
To decline a chat interaction (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select a chat and, in the Action bar, click Decline.

To decline a chat interaction(WEB) 
• Click Inbox and select a chat or hover over the item avatar and click Decline.

Chatting with customers

After you join a chat session, Ignite goes into Reply mode and the Input pane appears, enabling you to 
chat with the customer.
The following figure presents the Input pane during a chat session.

Figure 24.51: Chat Input pane
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Ignite indicates to agents and customers that the other is typing a response. Ignite indicates that 
customers have sent a response in an active chat as follows: 
• DESKTOP - When the Inbox is not in focus and a customer sends a message in an active chat, an 

orange indicator alerts agents and displays a number listing how many interactions are waiting for 
replies.

• WEB - When Ignite is not in focus, a notification indicates that the customer has entered a response. 
When Ignite is in focus but the active chat is not selected, an exclamation mark displays beside the 
interaction and a notification displays. Clicking a notification takes you to the relevant interaction. 

NOTE: Internet Explorer does not pop notifications when Ignite is not in focus.

Ignite permits content to be copied and pasted from other sources and turns URLS into hyperlinks.
Ignite supports embedding content from Google Maps in chat sessions. However, this requires the use of 
embed maps URL, available from Google Maps, to embed a Google map, such as: 

<iframe 
src="https://www.google.com/maps/embed?pb=!1m18!1m12!1m3!1d2804.50097880
3945!2d- 
75.90911198444678!3d45.3386984790996!2m3!1f0!2f0!3f0!3m2!1i1024!2i768!4f
13.1!3m3!1m2!1s0 
x4cd1fff1517da8a9%3A0xe6bc8a721e90f2a5!2sMitel+Networks!5e0!3m2!1sen!2su
s!4v144553122 7487" width="600" height="450" frameborder="0" 
style="border:0" allowfullscreen&gt;&lt;/iframe>

Ignite also supports the 'Share' link from the following websites. Cutting and pasting URLs from the 
following sites embeds the content in a chat session. 
• https://twitter.com/
• https://soundcloud.com
• http://www.youtube.com

If your message fails to send, a red icon displays beside the unsent message. To resend the message, 
you can copy and paste the message from your chat window or you can retype it.
To chat with an interaction (DESKTOP and WEB) 
• Type a message in the Input pane and either press Enter or click the Send Message button.
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Transition to alternate conversation types

During an interaction, agents can transition to an alternate interaction type if the agent is associated with 
that media type and if the customer’s relevant contact details are available. Agents can also edit contact 
information during an interaction.
See the "Transitioning from one conversation type to another (WEB)" section in this guide.

Correcting spelling in chat responses

Ignite provides automatic spell checking of chat responses. Incorrectly spelled words are underlined in 
red and can be corrected via a right-click menu.
Ignite’s spell check button is located in the formatting toolbar, along with additional formatting options. 
Ignite’s spell checking function assists agents in sending polished responses to customers.
NOTE: 
• Russian and Mandarin Chinese are not supported.
• Grammar checking is not supported

The following explains how to 
• Correct spelling in chat responses
• Ignore flagged words
• Undo spell checking changes
• Change the dictionary’s language
• Add words to your personal dictionary
• Clear additions to your personal dictionary
• Toggle spell checking off or on

To correct spelling in a chat response 
• Right-click an underlined word and select the correct spelling from the list provided.
To ignore flagged words 
• Right-click an underlined word and select Ignore.
To undo spell checking changes
NOTE: This function reverts words to their original spelling. It does not clear additions made to the dictio-
nary.
• In the Ignite formatting toolbar, click the Undo button.
To change the dictionary’s language 
• In the Ignite formatting toolbar, from the dictionary language drop-down list, select a language. (See 

the following figure.) 
NOTE: Ignite remembers this selection for future chat sessions.

To add words to your personal dictionary 
• Right-click an underlined word and select Add to personal dictionary.
To clear additions to your personal dictionary
NOTE: This option clears all additions to your personal dictionary. 
• In the Ignite formatting toolbar, click the Delete Personal Dictionary button. (See the following figure.)
• Either refresh the page or log out of Ignite and log back in for the changes to take effect.
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To toggle spell checking on or off 
• Click the Spellcheck As You Type button. (See the following figure.) 

NOTE: Ignite remembers this selection for future chat sessions.

Figure 24.52: Spell check options in the Input pane
 

Applying reply templates to chat responses

Agents can apply templates to their chat responses, providing standardized responses to common ques-
tions and requests.
To apply a reply template to a chat response
1. When a chat is in reply mode, place the cursor in the body of the chat response.
2. Click the Reply Template button.

3. Type the text that the template contains.

Templates matching the text display.
4. Select a template text from the list provided.

5. Press Enter.

Template mode changes back to Reply mode.
6. Click Reply to send the message with the template.

Placing chat sessions on hold and retrieving chat sessions from hold

Agents may have to stop participating in one chat session in order to work on other items. In this case, 
agents can put the active chat session on hold. Interactions on hold are marked with a 'pause' icon.
Note that administrative configurations may limit how long interactions may be on hold before being 
requeued and a System Make Busy is registered for the employee. For information on this limit, contact 
your supervisor or system administrator.
The following procedures explain how to
• Place a chat session on hold
• Retrieve a chat session from hold

To place a chat session on hold (DESKTOP)
• When participating in a chat session, in the Action bar, click the Hold button.
To place a chat session on hold (WEB)
• Click Inbox and select the chat or hover over the item avatar and click Hold.
To retrieve a chat session from hold (DESKTOP)
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NOTE: You can also retrieve a session from hold by sending a response.
1. Select your Inbox and, in the List pane, select the chat on hold.
2. In the Action bar, click Remove Hold.

The chat session becomes active again.

To retrieve a chat session from hold (WEB)
NOTE: You can also retrieve a session from hold by sending a response.
• Click Inbox and select a chat on hold or hover over the item avatar and click Remove Hold.

Joining the longest waiting active chat session (DESKTOP)

Agents can switch between active chat sessions according to how long they have been waiting for a 
response by using the ‘Next Longest’ button in the Action bar. The ‘Next Longest’ button applies to all 
active interactions in the agent’s Inbox, directing agents to the chat session that has been open and unfin-
ished the longest.
For example, an agent is handling three different chat sessions. Clicking ‘Next Longest’ highlights the 
active chat session to the chat session that has been waiting the longest for an agent response and 
switches that interaction back into the Active Contact pane.
When switching between active interactions, the chat session indicates that the agent is joining and 
leaving the chat session as appropriate.
To reply to the longest waiting chat session
1. In the Folders pane, select Inbox.
2. In the List pane, select an active chat.

An active chat is one that is no longer ringing and has been joined.
3. In the Action bar, click Next Longest.

The system takes you to the next longest waiting active chat session in the Inbox.

Transferring chats

Chat sessions can be transferred to other destinations within a contact center. For example, agents in the 
Support queue receiving enquiries about a product invoice can transfer these interactions to the Sales 
queue.
Agents transfer chat sessions to other agents and to queues. To receive transfers, devices must be 
enabled to handle the interaction’s media type.
Agents who are logged out, in DND, Offline (WEB), or whose presence is unknown cannot receive trans-
ferred chats. Agents who are either in Busy/Make Busy or at their chat Workload limit can receive trans-
ferred chats.
NOTE: You may only transfer interactions if you have the appropriate permissions.
To transfer a chat (DESKTOP)
1. In the Folders pane, click Inbox.
2. In the List pane, select a chat and, in the Action bar, click Reply.

3. In the Action bar, click Transfer.

4. Select an agent or a queue.
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NOTE: You can search for a transfer destination by typing the name of an agent or queue in the 
Search field.

5. Click Transfer.

To transfer a chat (WEB)
1. Click Inbox and select a chat or hover over the item avatar and click Accept.

To transfer directly from the queue, click Queue.
To transfer from the Cases page, under Interactions tab, select the inqueue or inbox chat and click 
Goto icon. The Queues page is displayed. You can now transfer the chat from the Queues page.

2. Select the chat or hover over the item avatar and click Transfer icon.

NOTE: Optionally you can select multiple interactions from the Queues page and click Transfer. The 
Transfer window is displayed. The list of available Employees and Queues are displayed in the Results 
section.
3. To transfer to an agent, in the Transfer window click Employees, select an employee from the list.

4. To transfer to a queue, in the Transfer window click Queues and select a queue from the list.

5. To transfer the chat, select the name of the appropriate person or queue.

Leaving chat sessions

When an agent is finished with an interaction, the agent can end the chat session. When an agent leaves 
a chat session, a message is sent in the chat session stating that the session is complete.
To leave a chat session (DESKTOP AND WEB)
1. When participating in an active chat session, click the End Your Session button.

The End Your Session button displays as an X.
2. When prompted, click Yes.

Forwarding chat transcripts

You can forward chat transcripts to multiple parties as an email with additional recipients copied and 
blind-copied.
Forwards in progress are housed in the agent's personal Drafts folder (DESKTOP), in the Forward 
subfolder (DESKTOP) or in the Inbox (WEB).
The following procedures explain how to
• Forward a chat transcript
• Discard forwards in progress

To forward a chat transcript (DESKTOP)
1. In the Folders pane, select either History, My History, one of the Handled subfolders, or one of the 

Failed folders.
2. In the List pane, select a chat transcript and, in the Action bar, click Forward.

3. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

4. Click Send. An icon displays over the Preview pane, indicating the transcript is being sent.
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NOTE: If you attempt to forward a transcript and receive a warning that the email address is invalid, 
the queue that handled the chat may not have been configured for sending transcripts. Contact your 
supervisor or system administrator.

To forward a chat transcript (WEB)
1. Click History and, optionally, select a Filter:.
2. Select a chat transcript or hover over the item avatar and click Forward.

3. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

4. Click Send.

To discard a forward in progress (DESKTOP)
NOTE: You can also discard forwards in progress by clicking ‘Discard Draft’ in the Action bar instead of 
‘Send’.
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, click Drafts. If necessary, expand the My Folders folder first.

3. Expand the Drafts folder and select Forward.

4. In the List pane, select the transcript and, in the Action bar, click Discard Draft.

To discard a forward in progress (WEB)
• Click Inbox and either select the forward in progress or hover over the item avatar and click Discard.

Removing failed chat transcripts from Ignite

Occasionally, chat transcripts may route to 'Failed' in Ignite. You can remove these transcripts from Failed 
using Ignite’s Junk and Forward buttons.
NOTE: Agents may only Junk interactions if they have the appropriate permissions.
To remove a failed chat transcript from Ignite (DESKTOP)
1. In the Folders pane, select a Failed folder.
2. In the List pane, select a chat transcript and, in the Action bar, click either Junk or Forward.

To remove a failed chat transcript from Ignite (WEB)
1. Click History > Failed.
2. Select a chat transcript or hover over the item avatar and click either Junk or Forward.

If you select Forward, the interaction is delivered to the Inbox where you can specify recipients.

Handling Contact Center Messenger in Ignite

Contact Center Messenger simplifies the deployment of chat support in Contact Centers’ web sites.
Handling Contact Center Messenger is similar as legacy Chat.
The agent will get similar notification for the incoming chat as in the legacy chat. If the agent accepts the 
incoming chat, both agent and customer will see a system message that the agent has joined.
NOTE: 
• Agents are not allowed to use desktop Ignite if Contact Center Messenger is configured for the chat.
• Administrator must enable contact center messenger for the agent to accept incoming chats.
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As with any normal chat, an agent or supervisors can transfer chats from the Web Ignite and from the 
Interaction Visual Queue.

Logging in to and Logging out from Ignite

• You can log in to Web Ignite using either basic authentication or Windows authentication and then use 
Contact Center Messenger.

• If the log in fails, Web Ignite displays an error message and chat presence will be disabled. But agents 
will still be allowed to use all other media types.

• If agents are configured to use Contact Center Messenger for chat, then the agents will not be able to 
log in to desktop Ignite. If they try to connect to desktop Ignite, an error message will be displayed 
recommending them to use Web Ignite.

• If the agent accepts the incoming chat, both agent and customer will see a system message that the 
agent has joined.

Logging out of Contact Center Messenger is same as legacy Chat.

Reply Templates

Agent can create, edit, delete personal chat reply templates using a Reply Template editor.
NOTE: Reply template editor is visible only if Contact Center Messenger is enabled.
1. To create new templates, go to Tools > Chat Personal reply template editor.
2. Enter the reply content in the text box and click Save.

3. If you want to use an existing template to create a new template, then click Insert reply template.

4. Choose the existing template that you would like to use, the content will appear in the editor, you can 
make the required changes and click Save.

5. To edit or delete an existing template, click Browse and choose the template you want to edit or delete 
from the list of templates.

Searching Reply Templates

You can accept a chat and click  icon to insert a reply template to the chat window. 
• You can toggle Use reply template button to use the last reply template to the new chat; otherwise 

the agent can select a template form the Reply Templates list.
• The Chat reply template is inserted into the chat dialogue line. Agents can preview the message before 

sending the conversation.

Ending a Chat

For Contact Center Messenger Chats, an End Session icon is added to the left of the Hold button.
The Chat UI component is replaced with the entire chat transcript during worktimer or after you end or 
transfer a chat.
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Handling Agent Assist Suggestions

In Ignite, if Agent Assist is enabled in CC-Admin, then the system displays the suggestion side pane. 
This pane is displayed only for the interactions in the inbox. The suggestions appear automatically as the 
conversation progresses.
The system displays the default suggestions for the customer conversation. However, you can also 
change it for show agent messages to be displayed.
The suggestions have the following details displayed: 

• Click the message  icon to navigate the message in the interaction pane and to view a list of 
suggestions.

• The time stamp for each suggestion that you received from Google Agent Assist is displayed.
• The message from the conversation for which the suggestion given is also displayed.

• Click the  button, by clicking which you can expand the relevant Frequently Asked Questions and 
Articles. 

• Articles: 
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– You can have multiple articles as suggestions; the total number of articles is displayed at the top.
– Articles are arranged based on the priority of recommendation; the most recommended article 

appears first.

– Click  buttons to views next or previous suggestions. Click  buttons to navi-
gate to the first and last suggestions.

– The articles displayed will contain a title and a snippet. If there is no title, then the system displays 
only the snippet.

– Click the Send Snippet icon to send the snippet as a message in the conversation.
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– Click the  icon to send the pdf link of that article as a message in the conversation.

– Click the  icon to open an article in a new browser tab, which can be used to view the full 
article.

– Click the  icon to provide feedback for the article suggestion. The system displays the 
following options: 
• Correct
• Partially
• Wrong

Feedback helps to refine the suggestions, if the context of the conversation is similar.

• FAQs: 
– You can have multiple FAQs as suggestions; the total number of FAQs are displayed at the top.
– FAQs are arranged based on the priority of recommendation; the most recommended FAQ appears 

first.

– Click  buttons to views next or previous suggestions. Click  buttons to navi-
gate to the first and last suggestions.

– The FAQs have answers listed. Click the Send Answer button to send the answer as a message in 
the conversation.

– Click the  icon to provide feedback for an FAQ suggestion. The system displays the 
following options: 
• Correct
• Partially
• Wrong

Feedback helps to refine the suggestions, if the context of the conversation is similar.

 NOTE: If there are more than 50 suggestions for a conversation, when you close the conversation or 
refresh the browser, by default the system displays the last 50 suggestions with the recent suggestions 
towards the bottom. 
To view the previous suggestions, scroll up to load 50 previous suggestions.

Handling Smart Suggestions

Smart Suggestions is a new feature supported in MiContact Center Business. This feature provides 
Agents real-time suggestions for interacting with customers. It also helps the Agents to reuse suggestions 
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coming from historical data and reply templates in a new interaction. The suggestions are picked from the 
database based on matching keywords found in case notes, global reply templates, and chat, email, and 
SMS interactions.
This feature is available as the Suggestions drop-down menu in Web Ignite. A text box for manual search 
is also available. 

NOTE: By default, the Smart Suggestions feature is enabled in YSE for a customer. An administrator can 
disable the Smart Suggestions feature in YSE > Enterprise > Smart Suggestions and select the Enable 
Smart Suggestions check box for customers who do not want to use it.
An administrator can enable or disable Smart Suggestions for particular Agents and Supervisors. To do 
this, go to YSE > Security Roles, and select a security role. Select the Ignite tab, and toggle May See 
Suggestions, to enable and to disable the feature. This option is set to ON by default.
NOTE: If an administrator sets the Enable Smart Suggestions option in YSE to ON and sets the May see 
suggestions option to OFF or vice versa for an Agent or Supervisor, the Web Ignite UI for Smart Sugges-
tions does not appear for that Agent or Supervisor. Agent and Supervisor must logout and login if the UI 
elements were already loaded on the browser.

Adding Suggestions

If an agent responds to an interaction and the response becomes available in the Web Ignite history, it 
can be offered as a possible suggestion.
An agent or supervisor can also add a user note in a Case, or a supervisor can create a Global Reply 
Template. For more information on Global Reply Templates, see Global Reply Template section.
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Deleting Suggestions

Only a Supervisor can remove suggestions from a list of suggestions. The Supervisor can review cases 
and interactions and if there is any warning, or sensitive or irrelevant content in the suggestion, the Super-

visor can click the dislike  icon to remove that suggestion from the list of suggestions.

Influencing Suggestions

Supervisors and Agents can alter the popularity of suggestions in two ways:
• Click Like or Insert Response (when available) for suggested responses presented in the Web Ignite 

Inbox or Queues sections.
• Find corresponding responses in the Web Ignite History or Cases sections and Click the Like button. 

In addition to text-based search, users can use the Advanced Search feature to find responses based 
on the number of likes or reuses, disliked responses, or responses having warnings.

Popular responses get a minor score boost when they are suggested.

Anonymizing Suggestions

Content from the interactions that are marked as suggestions may be masked based on the sensitivity of 
the data. Customer details that include customer name, credit card details, phone numbers, carrier 
tracking numbers, email addresses, and Social Security Numbers are masked from suggested 
responses.
The system reminds the Agent that there could be sensitive data in a suggestion and that the Agent must 
check before proceeding to present it as a response. The following disclaimer is displayed for every 
suggested response:
WARNING: This may contain sensitive information about other customers

Rating Smart Suggestions

Every suggestion will be rated with a score, which is based on its relevancy (depending on how well it 
matches with the content found in the interactions or the keywords manually entered during a search) and 
its popularity (if you reuse or mark a like for any of the existing suggestions, the system will increase the 
reuse count of a suggestion). Hover over the reuse icon to see who reused a suggestion and when.
• Like: Agents and Supervisors can like an interaction or case in the inbox suggestion response window, 

history, or in the case it is associated with. If they click the like icon for a suggestion, the score of the 
suggestion will receive a minor boost, which will increase the popularity of the suggestion.

• Warning: Agents can mark a warning for a suggestion. If they do so, a Supervisor can see the warning 
and take the necessary action for that suggestion. If the warning can be ignored, Supervisors can 
remove it by pressing the "x" button on it.

NOTE: 
– The other agents will see these warnings too and they cannot use the suggestions that contain warn-

ings. If you ignore a warning associated with a suggestion and decide to reuse the suggested 
response anyway, Web Ignite displays a message to confirm the decision so that warning is consid-
ered.

– Warning reasons are configured in YourSite Explorer by the Administrator. To add Warning reasons, 
an Administrator must go to YSE > Enterprise > Smart Suggestions and click Managing Warning 
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reasons. Administrator will see a list of preconfigured warning reasons, the list includes Ambig-
uous, Contains Sensitive data, Contains typos, Incorrect, Obsolete by default.
To add new warning, click Add and enter the new warning reason and click Save.
To edit a warning, select a warning reason and click Edit; update the warning and click Save.
Supervisors can also edit or delete an existing warning reason.

• Dislike: Only a Supervisor can dislike a response. The response is then not presented in any list of 
suggestions.

Using Smart Suggestions

Agents can use these suggestions in Web Ignite for their responses while handling interactions.
1. Select an interaction from the inbox or from the queue. The system searches the content of email, 

chat and SMS interactions, and on finding a match for the text entered by the customer, lists a set of 
suggestions.  

For any media the Agent can search multimedia interactions, case user notes, and reply templates by 
entering relevant text in the Suggestions text box displayed.

2. Select a suggestion and click the See Response  icon to view the suggested response.

3. Select the Response to use the suggested response and click Insert response. This will insert the 
selected suggestion as your response to the interaction you opened.

NOTE: The Response check box is only for suggested chat, SMS, and notes and not for email or 
templates. If you edit the response, the check box is automatically selected. 
For presenting an email response, click View entire thread link to view the entire email thread and use 
the response inline.
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Stop Terms

Stop terms are the words or phrases that must be ignored in the incoming text when scoring occurs. Only 
an administrator can manage Stop Terms. 
1. Go to YSE > Enterprise > Smart Suggestions.
2. Click the Manage scoring stop terms button.

3. Click Add and enter the terms (words or phrases) that you want to add. 

You can also edit or delete an existing stop term.

Global Reply Templates

Global Reply Templates are some basic and standard reply templates that are created by supervisors 
and can be used by anyone. Global Reply Templates can be managed by supervisors in Web Ignite > 
Tools > Global Reply Templates.

Global Reply Templates may be managed by supervisors depending if the May see all queues checkbox 
is checked in the advanced tab of the Supervisor's Employee record in YSE
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• If May see all queues checkbox is not checked, supervisors can only see templates that are not asso-
ciated to any queue or templates that are associated to queues that the supervisors are allowed to see.

• If May see all queues checkbox is checked, supervisors can see all templates.

NOTE: Agents cannot like or add warnings for templates, Supervisors cannot dislike templates.
Supervisor can Search, Add, Edit, or Delete Global Reply Templates in Web Ignite.
Each Template displays the following fields:
• Question/concern field – Displays the relevant question or concern the template belongs to, this is the 

text that is analysed by the system when it provides suggestions in the Inbox.
• Template – Displays the reply text of the selected Reply Template
• Media – Displays the media type of the template.
• Tags – Displays the Keywords associated with the Template.

NOTE: During a system upgrade, old templates present in the system (in the form of txt or msg files) are 
migrated to the new format. When that happens, the path of the old template is used to created tags. For 
example, if an old template was found under the “English\Support” directory structure, the tags will be 
“English > Support”.
If there are more than one listed template, by default it shows in descending order based on date modified. 
You can display results by the date, question/concern, Media, and Tags. If there are more than 10 
templates listed, then click Show more button to see more templates. 

The Search textbox allows you to search for templates (matching keywords found in either the Ques-
tion/Concern, template, or tags). The results are displayed in the paged list.
Adding Global Reply Template
Do the following:

1. Click icon to add new templates.
2. Optionally, add tags and select a media.

3. Optionally, click Associate to associate queues to new templates. 
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NOTE: Templates that are associated with queues can only be seen by agents who are assigned to 
these queues.

4. Enter the Question.

5. Enter the Template content. You can add images in the Template, and also add a template inside a 
template.

6. Click Save. 

NOTE: If you enter a search keyword before creating a new template, and that search keyword 
doesn't match the Question/Concern, template or tags in the new template you're creating, After you 
save, you will not find that template in the list (you must first remove the search string before you 
see that new template in the list).

Editing Global Reply Template
If you select a template to edit, you will see two tabs as described below:
• Details tab - Allows you to add tags, media, question/concern, and the template content with text.
• Queues tab – Displays the queues associated with that template. Click Disassociate button to disso-

ciate a queue if needed, and Click “Associate" button to associate new queues. 
NOTE: 

– If queues are specified, only agents associated with those queues will be able to see those templates 
in their inbox
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– You can only see queues that you are associated with if the new May see all queues checkbox is 
not checked in the advanced tab of the supervisor's Employee record in YSE.

– You can associate new queues and dissociate existing queues.

If there were no associated queues or if you disassociate all the queues a warning "No queues are 
associated with this global reply template: all agents will have access to it" is displayed and if you as-
sociate at least one queue, the warning displayed above disappears.

Deleting Global Reply Templates

Click the "Delete" icon to delete the reply template. You will see a warning message to confirm or 
cancel the delete action. 



1117

AGENTS - HANDLING CUSTOMER INTERACTIONS IN A MULTIMEDIA CONTACT CENTER
CHAPTER 24 MANAGING A MULTIMEDIA CONTACT CENTER

If the reply template is deleted, a pop-up message temporarily indicates success:

• If the deleted template was linked to an interaction, you can convert the interaction again to a template. 
This interaction does not remain in a disliked state.

• If the deleted template was linked to a case, you can convert the case again without seeing a warning 
about the fact that a template already exists. This case remains in a disliked state because the case 
could have been disliked using the dislike button.

Saving a Global Reply Template

Click this  icon to save your changes to the template. You can save your changes to the template 
for the following actions:
• adding/removing tags
• updating the "Question/Concern" text
• updating the template text
• updating the media
• associating or dissociating any queue 

NOTE: 
– You cannot save a template with blank text in the Question/Concern or Template section else an 

error message is displayed.
– You will get an error message and the changes will not be saved, if you forget to save and try to do 

one of the following actions: 
• selecting another template
• searching a template
• selecting an Order filter
• clicking the Back button
• Select another menu on the left (like "Cases" or "Options" for example).

– You can revert your action (and click Save) if you click the Cancel button.

Converting Multimedia Interaction to a Global Reply Template
Supervisor can convert a multimedia interaction into a Global Template. This is allowed for Handled 
Chats or SMS and for Sent emails but not for Handled Emails.

1. Go to Web Ignite > History section, select a valid interaction, then click  icon in the Chat, 
SMS or Email tab. 

– For Email Interaction: You will see Customer Question/Concerns and Response.
– For Chat and SMS: You will see Customer Question/Concerns and Response with a checkbox to 

include each section in Final Template.

2. Click Next. 
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NOTE: You must select at least one Question/Concern and one response, else you will not be able 
to click Next.

3. Preview the entered content.

4. Optionally, you can add Tags, click icon and enter required tags.

5. Click Save and click OK.

Converting User Notes to a Global Reply Template
Supervisor can convert Notes into a Global Reply Template, if the case has at least one user note set. If 
the "Customer Questions/Concerns" field is not set the Notes cannot be converted to Reply Template.

1. Go to Cases, select a case and in the Notes tab, click  icon.
2. Select one Question/Concern and a Note, Click Next.

3. Preview the entered content.

4. Optionally, you can add Tags, click icon and enter required tags.

5. Click Save and click OK.

Handling SMS in Ignite

Handling SMS in Ignite mirrors common instant messaging applications, providing a familiar and 
user-friendly experience.
SMS sessions are initiated by customers using contact information or, optionally, through the contact 
center’s SMS request page or corporate website. SMS interactions are then routed to appropriate 
queues.
Interactions are automatically sent to your Inbox if you are the longest idle agent or the agent with the 
highest skill level in your agent group, if your agent group uses skill levels. Agents can also pick SMS 
interactions out of queue.
NOTE: 
• SMS agent responses cannot contain more than 320 characters.
• Preferred agent routing is not supported.

The following explains how to:
• Preview SMS interactions
• Pick SMS interactions out of queues
• Join an SMS session
• Reply to SMS interactions
• Decline SMS interactions
• Correct spelling in SMS responses
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• Apply reply templates to SMS responses
• Place SMS sessions on hold and retrieve SMS sessions from hold
• Transition to alternate interaction types
• Join the longest waiting active SMS session (DESKTOP)
• Transfer SMS interactions
• End SMS sessions
• Forward SMS transcripts
• Remove Failed SMS transcripts from Ignite
• Mark SMS interactions as No Reply and Junk
• Send outbound SMS interactions

NOTE: DESKTOP - To complete the following procedures, you must be in Ignite’s My Folder’s View.

Previewing SMS interactions

If administrative configurations permit, agents can preview interactions before picking them out of queue 
or handling them.
The following explains how to
• Preview SMS interactions in the Inbox
• Preview SMS interactions in queue

To preview an SMS interaction in the Inbox (DESKTOP)
1. From the Folders pane, click Inbox.
2. From the List pane, select the SMS interaction to preview.

The SMS interaction displays in the Preview pane.

To preview an SMS interaction in the Inbox (WEB)
• Click Inbox and select an SMS to preview.
To preview an SMS interaction in queue (DESKTOP)
1. From the Folders pane, click a queue.
2. From the List pane, select the SMS interaction to preview.

The SMS interaction displays in the Preview pane.

To preview an SMS interaction in queue (WEB)
1. Click Queues and select a queue.
2. Select an SMS to preview.

Picking SMS interactions out of queue

Pick behavior occurs in the following ways:
First, agents can pick interactions out of queue and send them to the Inbox. When the interactions ring in 
the Inbox, agents can handle them.
Second, agents can choose to pick and reply to an interaction. Choosing to pick and reply to an interaction 
sends the interaction to the agent's Inbox from where the agents can handle the interaction.
SMS interactions picked out of queue ring in the Inbox until the interaction is accepted. For more informa-
tion on ringing behavior, see "Ringing states in Ignite".
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NOTE: 
• Agents cannot pick or pick and reply to interactions from the queue if they are in Do Not Disturb.
• Agents may only pick or pick and reply to interactions from the queue if they have the appropriate 

permissions.

The following procedures explain how to 
• Pick an SMS interaction out of queue and handle the SMS
• Pick and automatically reply to an SMS

To pick an SMS out of queue and handle the SMS (DESKTOP) 
1. From the Folders pane, select the queue from which an interaction will be picked.
2. From the List pane, select an SMS interaction from the queue and, from the Action bar, click the Pick 

button. 

The SMS interaction is transferred to your Inbox.
3. To handle the SMS interaction, select Inbox and, in the List pane, select the SMS interaction. 

NOTE: Additional handling options display in the Action bar. For information on handling the SMS 
interaction, see the appropriate procedures in this section.

To pick an SMS out of queue and handle the SMS (WEB) 
1. Click Queues and select the appropriate queue.
2. Select an interaction or hover over the item avatar and click Pick > Pick. 

The SMS is transferred to your Inbox.
3. To handle the SMS, click Inbox and select the SMS or hover over the item avatar.

To pick and automatically reply to an SMS (DESKTOP) 
1. In the Folders pane, select the queue from which an SMS interaction will be picked.
2. In the List pane, select an SMS interaction from the queue and, from the Action bar, click the Pick 

& Reply button. 

The SMS interaction is transferred to your Inbox.
3. In the Preview pane, agents can respond to the SMS interaction, transfer the SMS interaction to 

another destination, or put the SMS interaction on hold. 

NOTE: Additional handling options display in the Action bar. For information on handling the SMS 
interaction, see the appropriate procedures in this section.

To pick and automatically reply to an SMS (WEB) 
1. Click Queues and select the appropriate queue.
2. Select an interaction or hover over the item avatar and click Pick > Pick and Reply. 

The SMS is transferred to your Inbox and opens in reply mode.

Joining SMS sessions

When an SMS interaction arrives in an agent’s Inbox, agents can join the session and start responding to 
the interaction.
Agents can join sessions via Ignite's toaster or UI.
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To join an SMS session (DESKTOP)
1. In the Folders pane, click Inbox.
2. In the List pane, select an SMS interaction and, in the Action bar, click Reply.

3. In the Preview pane, agents can respond to the SMS interaction, transfer the SMS interaction to 
another destination, or put the SMS session on hold.

NOTE: Additional handling options display in the Action bar. For information on handling the SMS 
interaction, see the appropriate procedures in this section.

To join an SMS session (WEB)
• Click Inbox and select an SMS session or hover over the item avatar and click Accept.

Replying to SMS interactions

Once an SMS interaction is in the Inbox, agents can reply to or otherwise handle it.
After you join an SMS session, Ignite goes into Reply mode and the Input pane displays, enabling you to 
reply to the interaction. Send responses using the arrow button.

Declining SMS interactions

Agents can decline an offered SMS interaction, sending the interaction back to the queue where it retains 
its queue priority.
Agents can decline sessions via Ignite's toaster or UI.
NOTE: When an agent declines an interaction, they are automatically put into Busy/Make Busy across all 
media capabilities. A System Make Busy and a requeue count is registered for the employee . For more 
information, see "Setting and removing Busy/Make Busy in Ignite".
To decline an SMS interaction (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select an SMS interaction and, in the Action bar, click Decline.

To decline an SMS interaction (WEB) 
• Click Inbox and select an SMS interaction or hover over the item avatar and click Decline.

Correcting spelling in SMS responses

Ignite provides automatic spell checking of SMS responses, assisting agents in sending polished, profes-
sional, and consistent content to customers. Incorrectly spelled words are underlined in red and can be 
corrected using a right-click menu.
The spell check button is located in the formatting toolbar, along with additional formatting options.
NOTE: 
• Russian and Mandarin Chinese are not supported.
• Grammar checking is not supported.

The following explains how to 
• Correct spelling in SMS responses
• Ignore flagged words
• Undo spell checking changes
• Change the dictionary's language
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• Add words to your personal dictionary
• Clear additions to your personal dictionary
• Toggle spell checking on or off

To correct spelling in an SMS response 
• Right-click an underlined word and select the correct spelling from the list provided.
To ignore flagged words 
• Right-click an underlined word and select Ignore.
To undo spell checking changes
NOTE: This function reverts words to their original spelling. It does not clear additions made to the dictio-
nary.
• In the Ignite formatting toolbar, click the Undo button.
To change the dictionary’s language 
• In the Ignite formatting toolbar, from the dictionary language drop-down list, select a language. See the 

following figure. 
NOTE: Ignite remembers this selection for future SMS sessions.

To add words to your personal dictionary 
• Right-click an underlined word and select Add to personal dictionary.
To clear additions to your personal dictionary
NOTE: This option clears all additions to your personal dictionary. 
1. In the Ignite formatting toolbar, click the Delete Personal Dictionary button. (See the following 

figure.)
2. Either refresh the page or log out of Ignite and log back in for the changes to take effect.

To toggle spell checking on or off 
• Click the Spellcheck As You Type button. (See the following figure.) 

NOTE: Ignite remembers this selection for future SMS sessions.

Figure 24.53: Spell check options in the Input pane
 

Applying reply templates to SMS responses

Agents can apply templates to their SMS responses, providing standardized responses to common ques-
tions and requests.
To apply a reply template to an SMS response
1. When an SMS interaction is in reply mode, place the cursor in the body of the response.
2. Click the Browse Reply Templates button.
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The Browse Reply Template button displays as a magnifying glass in the formatting toolbar.
3. Type the text that the template contains.

Templates matching the text display.
4. Select a template text from the list provided.

5. Press Enter and click Insert Template.

Template mode changes back to Reply mode.
6. Click Send Message to send the message with the template.

Placing SMS sessions on hold and retrieving SMS sessions from hold

At times, agents may have to stop participating in an SMS session in order to work on other items. In these 
cases, agents can put the active SMS session on hold. Interactions on hold are marked with a 'pause' 
icon.
Note that administrative configurations may limit how long interactions may be on hold before being 
requeued and a System Make Busy is registered for the employee. For information on this limit, contact 
your supervisor or system administrator.
The following procedures explain how to 
• Place an SMS session on hold
• Retrieve an SMS from hold

To place an SMS session on hold (DESKTOP) 
• When participating in an SMS session, click the Hold button.
To place an SMS session on hold (WEB) 
• Click Inbox and select the SMS or hover over the item avatar and click Hold.
To retrieve an SMS session from hold (DESKTOP)
NOTE: You can also retrieve a session from hold by sending a response.
1. Select the Inbox and, in the List pane, select the SMS interaction on hold.
2. In the Action bar, click Remove hold.

To retrieve an SMS session from hold (WEB)
NOTE: You can also retrieve a session from hold by sending a response.
• Click Inbox and select an SMS on hold or hover over the item avatar and click Remove Hold.

Transition to alternate conversation types

During an interaction, agents can transition to an alternate interaction type if the agent is associated with 
that media type and if the customer’s relevant contact details are available. Agents can also edit contact 
information during an interaction.
See the "Transitioning from one conversation type to another (WEB)" section in this guide.

Joining the longest waiting active SMS session (DESKTOP)

Agents can switch between active SMS sessions according to how long the customer has been waiting 
for a response by using the ‘Next Longest’ button in the Action bar. The ‘Next Longest’ button applies to 
all active interactions in the agent’s Inbox, directing agents to the SMS session that has been open and 
unfinished the longest.
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For example, an agent is handling three different SMS sessions. Clicking ‘Next Longest’ highlights the 
active SMS session that has been waiting the longest for a response and switches that interaction back 
into the Active Contact pane.
When switching between active interactions, the SMS session indicates that the agent is joining and 
leaving the SMS session as appropriate.
To reply to the longest waiting active SMS session
1. In the Folders pane, select Inbox.
2. In the List pane, select an active SMS session.

An active SMS session is one that is no longer ringing and has been joined.
3. In the Action bar, click Next Longest.

The system takes you to the next longest waiting active SMS session in the Inbox.

Transferring SMS interactions

SMS interactions can be transferred to agents and queues. For example, agents in the Support queue 
receiving inquiries about a product invoice can transfer these interactions to the Sales queue. To receive 
transfers, devices must be enabled to handle the interaction’s media type.
Agents who are logged out, in DND, Offline (WEB), or whose presence is unknown cannot receive trans-
ferred SMS interactions. Agents who are either in Busy/Make Busy or at their SMS Workload limit can 
receive transferred SMS interactions.
NOTE: You may only transfer interactions if you have the appropriate permissions.
To transfer an SMS interaction (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select an SMS interaction and, in the Action bar, click Reply.

3. In the Action bar, click Transfer.

4. Select an agent or a queue. 

NOTE: You can search for a transfer destination by typing the name of an agent or queue in the Search 
field.
5. Click Transfer.

To transfer an SMS interaction (WEB) 
1. Click Inbox and select an SMS interaction or hover over the item avatar and click Accept. 

To transfer directly from the queue, click Queues.
To transfer from the Cases page, under Interactions tab, select the inqueue or inbox SMS and click 
Goto icon. The Queues page is displayed. You can now transfer the SMS from the Queues page. 
Follow steps 3 onward.

2. Select the SMS or hover over the item avatar and click Transfer icon. 

NOTE: Optionally you can select multiple SMS from the Inbox or the Queues page and click Transfer. 
The Transfer window is displayed. The list of available Employees and Queues are displayed in the 
Results section.
3. To transfer to an agent, in the Transfer window click Employees, select an employee from the list 

and proceed to step 5.

4. To transfer to a queue, in the Transfer window click Queues and select a queue from the list.
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5. To transfer the SMS interaction, select the name of the appropriate person or queue.

Ending SMS sessions

When an agent is finished handling an interaction, the agent can end the SMS session.
To end an SMS session (DESKTOP and WEB)
1. When participating in an active SMS session, click the End Your Session button.

The 'End Your Session' button displays as an X.
2. When prompted, click Yes.

Forwarding SMS transcripts

You can forward SMS transcripts to multiple parties as an email with additional recipients copied and 
blind-copied.
Forwards in progress are housed in the agent's personal Drafts folder (DESKTOP), in the Forward 
subfolder (DESKTOP) or in the Inbox (WEB).
DESKTOP - You can only forward SMS transcripts from the My History folder and its Handled subfolder, 
from the History folder and its Handled subfolder, and from the Failed folders.
WEB - You can forward SMS transcripts from the History page.
The following procedures explain how to
• Forward an SMS transcript
• Discard forwards in progress

To forward an SMS transcript (DESKTOP)
1. In the Folders pane, select either History, My History, one of the Handled subfolders, or one of the 

Failed folders.
2. In the List pane, select an SMS transcript and, in the Action bar, click Forward.

3. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

4. Click Send. An icon displays over the Preview pane, indicating the transcript is being sent.

NOTE: If you attempt to forward a transcript and receive a warning that the email address is invalid, 
the queue that handled the SMS interaction may not have been configured for sending transcripts. 
Contact your supervisor or system administrator.

To forward an SMS transcript (WEB)
1. Click History and, optionally, select a Filter:.
2. Select an SMS transcript or hover over the item and click Forward.

3. Insert addresses in the To: field, and copy or blind-copy additional recipients by filling in the appro-
priate fields. Separate multiple addresses with semi-colons.

4. Click Send.

To discard a forward in progress (DESKTOP)
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NOTE: You can also discard forwards in progress by clicking ‘Discard Draft’ in the Action bar instead of 
‘Send’.
1. In the My Folders view, expand the Folders pane.
2. In the Folders pane, click Drafts. If necessary, expand the My Folders folder first.

3. Expand the Drafts folder and select Forward.

4. In the List pane, select the transcript and, in the Action bar, click Discard Draft.

To discard a forward in progress (WEB)
• Click Inbox and either select the forward in progress or hover over the item avatar and click Discard.

Removing failed SMS transcripts from Ignite

Occasionally, SMS transcripts may route to 'Failed' in Ignite. You can remove these transcripts using 
Ignite’s Junk button.
NOTE: Agents may only Junk interactions if they have the appropriate permissions.
To remove a failed SMS transcript from Ignite (DESKTOP)
1. In the Folders pane, select a Failed folder.
2. In the List pane, select an SMS transcript and, in the Action bar, click either Forward or Junk.

3. To remove a failed SMS transcript from Ignite (WEB)

4. Click History > Failed.

5. Select an SMS transcript or hover over the item avatar and click either Junk or Forward.

If you select 'Forward,' the interaction is delivered to the Inbox where you can specify recipients.

Marking SMS interactions as No Reply and Junk

Occasionally, SMS interactions requiring no reply reach queues and agents’ Inboxes. Agents can mark 
these SMS interactions either as requiring no reply or as junk.
Agents can also junk SMS interactions directly from 'Failed', rather than attempting to reroute them.
Marking interactions as No Reply and Junk removes the interactions from Ignite. If the item is in queue or 
the Inbox, responses in progress are deleted.
NOTE: 
• Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and Ignite 

are not included in queue Handled, Completed, and Offered counts.
• Agents may only Junk interactions if they have the appropriate permissions.

To mark an SMS interaction as No Reply or Junk (DESKTOP) 
1. In the Folders pane, either click Inbox, select the queue in which the SMS message is waiting, or 

select a Failed folder.
2. In the List pane, select an SMS message and, in the Action bar, click either No Reply or Junk.

To mark an SMS interaction as No Reply or Junk from the Inbox (WEB) 
• Click Inbox and select an SMS interaction or hover over the item avatar and click either No Reply or 

Junk.
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To mark an SMS interaction as No Reply or Junk from the queue (WEB) 
1. Click Queues and select an SMS queue.
2. Select an SMS interaction and click either No Reply or Junk.

Sending outbound SMS interactions

Agents can send outbound SMS interactions in Ignite. When an agent sends an outbound SMS interac-
tion, they may not be the agent who receives the customer response.
• You cannot send an SMS to multiple recipients.
• Account codes are not supported for outbound SMS interactions.
• Real-time and reporting statistics are not available for outbound SMS activity. We recommend instead 

that agents put themselves into Busy/Make Busy, with an ‘Outbound SMS’ Reason Code applied, 
when drafting outbound SMS interactions. Make Busy reports and real-time queue statistics will then 
display time spent drafting outbound SMS interactions.

WEB– Outbound SMS interactions in progress are housed in the Inbox, marked as 'Draft'.
To send an outbound SMS interaction (DESKTOP)
1. In the My Folders view, expand the Folders pane.
2. In the Action bar, click New SMS.

3. After From, select an SMS queue.

4. After To, type the recipient’s number.

5. Type the SMS interaction's contents and click Send.

To send an outbound SMS interaction (WEB)
1. Click Contacts
2. If the destination is not a recent interaction, type its name or number in the Search field.

3. Hover over the destination's avatar and click the SMS icon. For SMS;interactions to agents, a colored 
dot on the avatar indicates its availability.

4. Under From (queue), select an SMS queue.

NOTE: Queue signatures are inserted each time a queue is selected as the ‘From’ address. Agents 
are responsible for deleting non-applicable queue signatures from outbound SMS drafts.

5. Type the SMS interaction’s contents and click Send.

A new case is automatically created and assigned with "Waiting For Customer" state.
NOTE: If Contacts is open, click Contacts again to close the window and expose the desired controls.

To discard an outbound SMS interaction in progress (WEB)
NOTE: If Contacts is open, click Contacts again to close the window and expose the desired controls.
• Click Inbox and select a draft or hover over the item avatar and click Discard.

Handling calls in Ignite

In addition to email, chat, SMS, and open media handling, you can handle calls in Ignite.
MiCollab Client is recommended for performing advanced call handling functions. For information about 
handling voice Interactions in MiCollab Client, see the MiContact Center Business User Guide .
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The following procedures explain how to 
• View call information
• Pick calls out of queue
• Answer and end calls
• Make calls
• Perform in-call actions

To perform other call handling functions such as conferencing and supervised transfers, agents must use 
Contact Center Softphone, PhoneSet Manager, MiCollab, or a hard set. See the appropriate sections in 
the MiContact Center Business User Guide for more information on Contact Center Softphone and 
PhoneSet Manager.
DESKTOP—For important information about logging on to and out of Ignite in conjunction with Contact 
Center Softphone, PhoneSet Manager, orhard sets, see "Logging in and out of Ignite (DESKTOP)".
WEB—For important information about signing in and out of Ignite for voice agents, see "Signing into and 
out of Ignite (WEB)".
NOTE: 
• DESKTOP - Ignite provides call control for Inbound ACD interactions only. Agents must make 

outbound calls using Contact Center Softphone, PhoneSet Manager, or a hard set or use Web Ignite.
• DESKTOP - If your contact center focuses on voice interaction handling, we recommend that you 

implement the MiCollab Client and Ignite integration described in the .
• Ignite’s phone functionality does not support multiple lines.
• Ignite’s phone controls are not supported for External Hot Desking Agents.

Viewing call information

You can view basic call information in Ignite before picking a call out of queue or handling it from the Inbox. 
Note that information displayed may vary based on administrative configuration.
The following explains how to
• View information for calls in queue
• View information for calls in the Inbox

To view information for calls in queue (DESKTOP) 
1. In the Folders pane, select a queue.
2. In the List pane, select a call. 

Call information displays in the Preview pane.

To view information for calls in queue (WEB) 
1. Click Queues and select the appropriate queue.
2. Select a call from the queue.

To view information for calls in the Inbox (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select a call. 

Call information displays in the Preview pane.

To view information for calls in the Inbox (WEB) 
• Click Inbox and select a call.
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Picking calls out of queue

Agents can pick calls out of queue and send them to the Inbox. Once ringing in the Inbox, the call can be 
answered.
NOTE: 
• Agents cannot pick or pick and reply to interactions from the queue if they are in Do Not Disturb.
• Agents may only pick or pick and reply to interactions from the queue if they have the appropriate 

permissions.

To pick a call from the queue (DESKTOP) 
1. From the Folders pane, select the queue from which a call will be picked.
2. From the List pane, select a call from the queue and, from the Action bar, click the Pick button. 

The call is transferred to your Inbox.
3. Pick up your desk phone to answer the call.

4. Answer the call using MiCollab Client.

5. To answer the call, select Inbox and, in the List pane, select the call and click Reply. 

NOTE: Additional handling options display in the Action bar. For more information, see the appro-
priate procedures in this section.

To pick a call from the queue (WEB)
1. Click Queues and select the appropriate queue.
2. Select a call from the queue or hover over the item avatar and click Pick. 

The call is transferred to your Inbox.

Answering and ending calls

NOTE: 
• You cannot explicitly decline a ringing call.
• Agents can request help from other agents, as well as from supervisors. When you answer an 

incoming request for help, the Ignite toaster displays "Request Help" and the name of the person 
requesting help. Accepted requests are entered in Silent Monitor mode. Supervisors must use Contact 
Center Client or their headsetto escalate to Coach mode.

• When supervisor receives an ACD help request and chooses to answer the call through Web Ignite, 
the call will be directly connected to the agent and the supervisor can coach the agent. Supervisor do 
not need to specifically press the Coach button on the desk phone to coach an agent.

For more information on silent monitoring, see the MiContact Center Business User Guide. For more 
information on the Request Help feature, see the appropriate section in this guide.
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You can answer incoming calls from Ignite. Ignite displays a toaster for each incoming call and allows you 
to accept the call from the toaster.
When you answer a call, Ignite displays call information.
To answer a call (DESKTOP) 
• In the Ignite toaster, click Accept, select the call in the List pane and, in the Action bar, click Reply.
To answer a call
• In the Ignite toaster, click Accept. Alternatively, select the call or hover over the item avatar and click 

Accept.
You can end calls from Ignite.
To end a call (DESKTOP) 
• In the Action bar, click Hang Up. 

Alternatively, in the Conversation window, in the bottom toolbar, click the Hang Up button.

To end a call (WEB) 
• Click Inbox and select a call or hover over the item avatar and click Hang Up.

Making calls

DESKTOP - We recommend you use MiCollab Client to make calls, although you can make calls using 
Contact Center Softphone or Contact Center PhoneSet Manager. This recommendation applies to 
internal and external destination calls, and calls to dialable queues.
DESKTOP — You can place a call in Ignite by either searching for a destination or entering the destination 
in the dial pad.
WEB — You can place a call in Ignite by searching for a destination.
To make a call (DESKTOP) 
1. In the Action bar, click New Call.
2. In the New Call window, in the Search field, type the dialable number or the name of the employee 

to call. You can also click the dial pad button to enter numbers. Only voice-enabled employees can 
be searched for by name. 

NOTE: The system supports partial matching on names and numbers. For example, if you type ‘12’, 
the system returns a list of employees whose IDs start with ‘12’.
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3. In the New Call window, to the right of the destination, click the phone button to place the call. Note 
that the phone icon is disabled if the contact is an agent who is in DND. 

If the destination is available, the system places the call. The call is transferred to your Inbox and your 
desk phone rings. Answering the call connects you to the destination.
If the call fails, a failure message displays in the New Call window.

To make a call (WEB) 
1. Click Contacts.
2. If the destination is not a recent contact, type its name or number in the Search field. 

NOTE: You can also create external contacts or import contacts from the Contacts page. For more 
details, see "Contacts (WEB)" in this document.

3. Hover over the destination’s avatar and click Call.If applicable, hover over multiple Call avatars to 
select the appropriate dialable number. For calls to agents, a colored dot on the avatar indicates its 
availability. 

NOTE: If Contacts is open, click Contacts again to close the window and expose the desired controls.

Optionally, you can also make a call using the New Call button (Phone icon). You can choose the name 
and number that should be displayed on the external phone when making a call to an external destination.
To specify name and number when making calls 
1. Click New Call, the Voice Contacts page is displayed.
2. Click the From button. The From page is displayed with all the CLIP (Calling Line Identification 

Presentation) numbers. The number with a bold font is your reporting number or the line URI. 

NOTE: The outbound CLIP numbers are populated from the DNIS device list in YourSite Explorer.
3. Select the number from the list. The customer sees the selected name and number on their display 

when they are contacted.

Performing in-call actions

While on active calls you can: 
• Put calls on hold and retrieve calls from hold
• Tag calls with Account Codes.
• Tag calls with Classification Codes
• Transfer calls (DESKTOP)
• Initialize Conference calls
• Transition to alternate interaction types
• Merge calls (DESKTOP)
• Contact agents before transferring calls and requesting help

Putting calls on hold and retrieving calls from hold
At times, agents may have to put a call on hold. Ignite displays a paused icon over calls on hold so they 
can be easily identified.
NOTE: Calls on hold may not be transferred until hold is removed.
The following explains how to 
• Put a call on hold
• Retrieve a call from hold
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To put a call on hold (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select the active call.

3. In the Action bar, click the Hold button.

To put a call on hold in the Conversation window (DESKTOP) 
• In the Conversation window, click Hold.
To put a call on hold (WEB) 
• Click Inbox and select a call, or hover over the item avatar, and click Hold.
To put a call on hold (MiCollab Client) 
• Click Inbox and select a call, or hover over the item avatar, and click Hold.
To retrieve a call from hold (DESKTOP) 
1. In the Folders pane, click Inbox.
2. In the List pane, select the call on hold.

3. In the Action bar, click Remove Hold.

To retrieve a call from hold in the Conversation window (DESKTOP) 
• In the Conversation window, click the Remove Hold button.
To retrieve a call from hold (WEB) 
• Click Inbox and select a call or hover over the item avatar and click Remove Hold.
Tagging calls with Account Codes
Account Codes identify services, departments, or other elements of the contact center. They are numer-
ical codes with predefined meanings that are used for reporting purposes. You can apply multiple Account 
Codes during an interaction. The duration of each Account Code is measured from when the Account 
Code is entered until either the end of the call or the time a new Account Code is entered. Agents tag calls 
with Account Codes in Ignite to indicate in reports what the interaction segment was about.
For example, an agent handling calls for three catalog companies enters an Account Code of ‘01’ to indi-
cate the customer is inquiring about Company A. Later in the interaction, the agent enters an Account 
Code of ‘06’ to indicate that the customer is now inquiring about Company A’s mail-out services.
Agents can tag calls with multiple Account Codes. Account Codes must be entered during the call and 
cannot be entered after the call has ended.
NOTE: 
• Ignite (WEB) enables agents to filter Account Codes rather than sorting them by categories.
To tag a call with an Account Code (WEB) 
1. Select a call or hover over the item avatar and click Classify.
2. Select an Account Code. You can type the name or number of a Code in the Search field. 

NOTE: If you enter a number in the search field, you can apply the Code by pressing ‘Enter’ when 
prompted.

Tagging calls with Classification Codes
Classification Codes are a type of Account Code but differ in the following ways: 
• You can apply multiple Classification Codes, and this can be done at any point during the (call or inter-

action) or its Work Timer. All Classification Codes applied to a call are pegged with the full call duration, 
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from the time the call arrives until the call ends. This includes transfer time. It also includes Work Timer 
duration if 'Include queue work timer as part of handling time' is enabled on the queue. If the same 
code is entered twice, it is not double pegged in reporting statistics.

• Classification Codes can be ‘forced’, meaning the agent must enter a Classification Code either during 
the call or when in Work Timer to remain within compliance.

• Account Codes can only be entered during a call, but Classification Codes can be entered during or 
after a call (while in Work Timer). There are often scenarios within which you set single or multiple 
Account Codes during a call and then set a Classification Code when the call terminates.

NOTE: Classification Codes are only supported for ACD voice (calls or interactions).
NOTE: During a call, apply Classification Codes as you would Account Codes, using the list of Account 
Codes in the ‘Set Account Code’ rolling panel in the Sidebar or in the 'History and Account Code' section 
of the Preview pane.
To tag a call with a Classification Code after a call ends (DESKTOP) 
1. In the Sidebar, click the Classify button to open the Classify rolling panel. 

When the call ends, the Classify button displays (and flashes if forced Classification Codes are en-
abled) and Work Timer is activated.

2. Select the applicable Classification Code from the list that displays and click Apply. 

NOTE: If you are handling more than one item in the Inbox, for example, one email and one call, and 
you apply a Classification Code during the call, it will be applied to the call regardless of which item 
is currently selected in the Inbox. If you apply a Classification Code after the call when in Work 
Timer, the voice interaction stays in your Inbox and you must use the ‘Classify’ button in the Sidebar 
to apply a Classification Code to the voice interaction.

3. If Work Timer has not been configured to automatically cancel after entering a Classification Code, 
cancel Work Timer by clicking the Remove Work Timer button in the Sidebar. 

NOTE: Forced Classification Codes prevent canceling Work Timer until a Code is entered. Failing to 
enter a Classification Code before Work Timer expires or is removed by entering Busy/Make Busy 
or DND can result in a default Classification Code of ‘-1 Non-Compliant’ applied automatically.

To tag a call with a Classification Code after a call ends (WEB)
NOTE: During a call, apply Classification Codes as you would Account Codes, but select ‘Classification’ in 
the Classify dialog window.
1. Click Enter a Classification Code.
2. Select a Classification Code. You can type the name or number of a Code in the Search field. 

NOTE: If you enter a number in the search field, you can apply the Code by pressing ‘Enter’ when 
prompted.

Transferring calls (DESKTOP)
You can transfer calls to internal and external destinations. Internal transfer destinations include destina-
tions programmed in the voice media server or in a cluster of voice media servers. External transfer desti-
nations include dialable numbers not programmed in the voice media server or in the cluster of voice 
media servers. For example, agents in the Support queue receiving calls concerning account renewals 
can transfer these calls internally to the Sales queue, or agents can transfer calls externally to a super-
visor’s cell phone.
To receive transfers devices must be enabled to handle the interaction's media type.
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Agents who are logged out, in DND, Offline (WEB), or whose presence is Unknown cannot receive trans-
ferred calls, but the call can be transferred to their voicemail. Agents who are either in Busy/Make Busy 
or at their call Workload limit can receive transferred calls.
Call transfers in Ignite are always blind transfers. In blind transfers, there is no communication with 
transfer destinations before sending calls. Calls are transferred immediately, and the system does not 
monitor the outcome.
To perform a supervised transfer, you must use MiCollab Client, Contact Center Softphone, Contact 
Center PhoneSet Manager or Ignite Web. See the MiContact Center Business User Guide for more infor-
mation.
NOTE: 
• You cannot transfer calls on hold. Hold must be removed before the call can be transferred.
• You may only transfer interactions if you have the appropriate permissions.

The following procedures explain how to 
• Blind transfer calls to a voice-enabled employee or queue
• Blind transfer calls to a dialable number 

NOTE: This option is only available with Click to Call. For more information, see "Contacting agents 
before transferring calls".

• Perform a supervised transfer using Merge (DESKTOP)
• Perform a supervised transfer using Click to Call and Merge (DESKTOP) 

NOTE: This option is only available with Click to Call. For more information, see "Contacting agents 
before transferring calls".

To blind transfer a call to a voice-enabled employee or queue (DESKTOP) 
1. When on a call, in the Action bar, click Transfer.
2. Select the Internal Transfer radio button and select a voice-enabled employee or queue. Expand the 

device list if necessary. You can search for an internal transfer destination by typing the name of a 
voice-enabled employee or queue in the ‘Search’ field.

3. Click Transfer. 

To blind transfer a call to a dialable number (DESKTOP) 
1. When on a call, in the Action bar, click Transfer.
2. Select the External Transfer radio button and, in the Transfer To: field, type a dialable number. Enter 

this number as you would on a phone, including any digits required for outbound dialing. 

NOTE: Invalid entries return an error message. Re-type a valid entry and click ‘Transfer’.
3. Click Transfer. 

Transferring calls (WEB)
You can perform either a blind or a supervised transfer of a voice call from Web Ignite. To perform either 
type of transfer, you make a consultation call to another party (the available queues, employees, external, 
or Active Directory contacts) and then decide whether you want to transfer the call immediately (blind 
transfer) or wait to talk to the other party before you transfer the call (supervised transfer). You can also 
modify the call to make it a conference while talking to the consultative party.
Transition to alternate conversation types
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During an interaction, agents can transition to an alternate interaction type if the agent is associated with 
that media type and if the customer’s relevant contact details are available. Agents can also edit contact 
information during an interaction.
See the "Transitioning from one conversation type to another (WEB)" section in this guide.
Requesting help
You can request help from other voice-enabled employees by clicking the Request Help Call Control 
button in the Sidebar. When you click the button, you can enter either a valid DN in the free form text box 
or select an employee from a pre-populated list. The system dials the DN, and the employee is added to 
the call when they accept.
Employees who accept requests for help join the call in Silent Monitor mode and are not audible unless 
they escalate to Coach or Barge.
Help requests to queues or to external numbers are not supported
The Request Help button is available as soon as a call is delivered to your Inbox. You can send multiple 
requests for help during a call, but you can only send one request at a time. Requests sent to employees 
in unavailable states fail.
The Request Help button is not available when a call is on hold.
To request help on a call (Desktop) 
1. ln the Sidebar, click the Request Help button 

Ignite displays a list of voice-enabled employees and enables you to look up contacts in the Active 
Directory (AD)

2. In the Request Help window, do one of the following: 

– Select a voice-enabled employee from the list
– In the Search box, enter a voice-enabled employee or AD contact's dialable number
– In the Search box, enter the name of a voice-enabled employee or AD contact

3. Click Call. 

NOTE: You cannot cancel requests in progress. The Request Help button is disabled (turns gray) 
while the call is being established. Hover over the button with your mouse to view the connection 
status in a tool tip.

– If the request is answered within 180 seconds, notification that the request help is established is 
displayed, and the Request Help icon is displayed next to the caller's icon and on the Inbox item. 
The Request Help Call Control button is no longer available until the employee that answered the 
Request Help call hangs up.

– If the request is declined or times out, a notification that the request help was declined is displayed. 
The Request Help Call Control button is available, and the employee can make a new Request 
Help call.

To request help on a call (WEB) 
1. Click the Request Help icon in the handling icons. 

Ignite displays a list of voice-enabled employees and their ACD status.
2. In the Request Help window, do one of the following: 

– Select a voice-enabled employee from the list
– In the text box, enter a voice-enabled employee's dialable number
– In the Search box, type the name or dialable number of a voice-enabled employee
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3. Click Call. 

NOTE: You cannot cancel requests in progress. 
– If the request is answered within 180 seconds, a notification that the request help is established is 

displayed, the Request Help icon is displayed next to the caller's icon and on the Inbox item. The 
Request Help icon is no longer available till the employee that answered the Request Help call 
hangs up

– If the request for help is not answered within 180 seconds, the request times out and you can make 
another request for help.

NOTE: The length of time a request help call rings for is defined in the Ignite configuration. By default, dura-
tion is set to 180. See the KB article SO3146 in Mitel Knowledge Management System for information on 
how to change this, and how it interacts with the Agent COS.
Contacting agents before transferring calls
You can choose to instant message or call other employees(DESKTOP and WEB) to alert them of an 
incoming transfer.
DESKTOP - The Click to Call option is not displayed when agents are in Do Not Disturb or absent from 
their agent groups.
NOTE: 
• If an agent has multiple voice agents, Ignite provides call control for the number associated with the 

currently active voice agent
• DESKTOP - Click to IM does not support group IM sessions.

To Click to Call or Click to IM (DESKTOP) 
1. In the Transfer window, select an available agent.
2. Select Click to IM to initiate an IM session or select Click to Call to initiate a voice call. See the 

following figure

NOTE: The recipient's presence displays, advising of their availability to receive your call or instant 
message.

Figure 24.54: Click to IM and Click to Call
 

To Click to Call (WEB) 
1. Click Contacts.
2. If the destination is not a recent contact, type its name or number in the Search field.

3. Hover over the destination’s avatar and click Call.

Handling calls using the Active Call window (WEB)
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When on a call, agents can use the Active Call window for basic call handling options.
For procedures on specific call handling actions supported in the Active Call window, see the appropriate 
sections of this guide.
For procedures on using Contacts to reach another person, see the appropriate sections of this guide.
To handle a call using the Active Call window 
1. When on a call, click the Phone button.
2. Choose a call handling option.

3. To close the Active Call window, click the Phone button.

To perform a supervised transfers

1. Click Inbox and select a call or hover over the item avatar and click Accept.
2. Select the call or hover over the item avatar and click Transfer. 

Transfer window lists all the numbers from available queues, employees, external, or Active Directory 
contacts.

3. To select a contact to transfer the call, hover over the contact. This enables the Blind Transfer and 
Consultation Call buttons.

4. Hover over the Consultation Call button to list the dialable numbers associated with the contact. 

– If the contact has only one associated dialable number, you can select the dialable number or click 
on the Consultation Call button to transfer the call.

– If the contact has more than one dialable number, select a dialable number to transfer the call.

The call now is ringing the other party and the caller is placed on hold.
5. Before the other party accepts the transfer, you can do the following: 

– Click Cancel Transfer to cancel the call with the other party whom you consulted and connect back 
to the caller.

– Click Complete Transfer to complete the transfer.

6. After the other party accepts the transfer, you can do one of the following: 

– Click Cancel Transfer to cancel the call with the other party whom you consulted and connect back 
to the caller.

– Click Complete Transfer to complete the transfer.
– Click Conference to connect the three parties together.
– Click Swap to swap the hold. (Applicable to MiVB only).
– Click Hold to put both parties on hold. (Applicable to SIP Only).
– Click RemoveHold to remove hold. (Applicable to SIP Only).

After you leave the call, the conversation will stay in your inbox if a Work Timer applies to it.

Initialize Conferencing calls
While you are on a call with a customer, you can invite other parties into the call to create a conference. 
You cannot transfer a call that is in a conference. You can hang up to leave the conference or put the call 
on hold, muting the person who puts it on hold, and keeps them from hearing the conference. Other 
parties in the conference can also invite others to the conference.
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You can initiate a conference through a supervised transfer. See the “Transfer calls” section for details.
To conference a call (DESKTOP) 
1. When on a call, in the Conversation window, click the Invite More People button
2. Type the name or number of the participant you want to invite.

3. Select a participant and click the Invite button. 

The system calls the specified participant. When the participant answers, they are added to the call.
4. To invite additional participants, repeat the above steps.

To create a conference call (WEB) 
1. While on a call, click the Invite button. The Invite window opens.
2. In the Invite window, you can search and filter to find the required contacts from the available queues, 

employees, or external or Active Directory contacts.

3. Click the avatar. You can include up to five parties in a conference call. 

The first agent who answered the call will be in ACD state during the conference and if the call was 
transferred to another agent, the second agent will be in Non ACD state. You can view all the partic-
ipants of the conference under the Participants list in Ignite.

To perform a blind transfer

1. Click Inbox and select a call or hover over the item avatar and click Accept.
2. Select the call or hover over the item avatar and click Transfer. 

Transfer window lists all the numbers from available queues, employees, external, or Active Directory 
contacts.

3. To select a contact to transfer the call, hover over the contact. This enables the Blind Transfer and 
Consultation Call buttons.

4. Hover over the Blind Transfer button to list the dialable numbers associated with the contact. 

– If the contact has only one associated dialable number, you can select the dialable number or click 
on the transfer button to transfer the call.

– If the contact has more than one dialable number, select a dialable number to transfer the call.

The call is now ringing the other party and you are disconnected. The conversation will stay in your inbox 
if a Work Timer applies to it.

Conferencing calls

While you are on a call with a customer, you can invite other parties into the call to create a conference. 
You cannot transfer a call that is in a conference. You can hang up to leave the conference or put the call 
on hold, muting the person who puts it on hold, and keeps them from hearing the conference. Other 
parties in the conference can also invite others to the conference.
You can invite other participants into an existing call to create a multi-party conference call. You can leave 
a conference call after initiating it without ending the call for the other participants.
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To create a conference call (WEB) 
1. While on a call, click the Invite button. The Invite window opens.
2. In the Invite window, you can search and filter to find the required contacts from the available queues, 

employees, or external or Active Directory contacts.

3. Click the avatar. You can include up to five parties in a conference call. 

The first agent who answered the call will be in ACD state during the conference and if the call was 
transferred to another agent, the second agent will be in Non ACD state. You can view all the partic-
ipants of the conference under the Participants list in Ignite.

Removing Work Timer

NOTE: When agents are in Work Timer, Interactions remain in the Inbox until Work Timer is removed
DESKTOP - Interactions in Work Timer are marked with yellow.
WEB - Interactions in Work Timer are marked with yellow and a clock icon.
Agents use the time spent in Work Timer to complete post-interaction work, such as consulting with a 
supervisor, without having this downtime affect their performance statistics.
When Work Timer is the overriding state in Ignite, agents can remove Work Timer and put themselves 
back into an overriding state across all media capabilities. Once agents have removed Work Timer, they 
cannot put themselves back into this state.
According to queue configuration settings, agents can be placed in a Work Timer state for a set period of 
time after completing a call. The Work Timer can optionally be configured to cancel automatically after a 
Classification Code has been entered. If the Work Timer is not set to cancel automatically, you must 
cancel it manually after entering a Classification Code.
NOTE: Employees in Work Timer can apply Busy/Make Busy or DND, but will remain in a Work Timer state 
until the Work Timer expires or is cancelled. If Classification Codes are required for the queue and the 
Work Timer expires without a Classification Code being entered, a Non-Compliant Classification Code 
will be applied to the call..
If Work Timer is not configured to cancel automatically when a Classification Code has been entered and 
you end the call and do not manually cancel it you will be unable to receive calls until the Work Timer 
duration, as configured on the queue, has expired.
If you are handling voice and other media interactions simultaneously, one agent being in Work Timer will 
not prevent you from being offered an interaction of a different media type. For example, if you are in Work 
Timer after handling a voice call, you may still be offered an email from the email queue, and you can 
accept it and handle it normally.
To remove Work Timer (DESKTOP) 
• In the Sidebar, click the Remove Work Timer button. 

NOTE: Alternatively, remove Work Timer via the Action bar.

To remove Work Timer (WEB) 
• Click Clear Work Timer. 

Alternatively, click your avatar, select State, and choose an alternate state.
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Call handling using the Action bar (DESKTOP)

Agents can optionallyperform call handling activities, such as transferring a call, placing a call on hold, 
and hanging up a call, from the Ignite Action barinstead of using the MiCollab Client call control window. 
They can also remove Work Timer from the Action bar instead of the Sidebar, which may be preferable 
for multimedia agents who do not use voice and, as a result, benefit more from the Ignite main window 
than from the Sidebar. Multimedia agents may choose to collapse the Sidebar and expand Ignite’s main 
window to more efficiently handle emails and chats.

Handling open media interactions

Open media interactions are automatically sent to your Inbox if you are the longest idle agent or the agent 
with the highest skill level in your agent group, if your agent group uses skill levels. Agents can also pick 
open media interactions out of queue.
When an open media item is routed to the desktop and accepted by an agent, depending on the settings 
for the variables used for the API request (TargetUri and TargetUriEmbedded), one of the following 
occurs:
• A URL launches as an external tab
• An HTTP interface is embedded into Ignite

The following explains how to
• Preview open media interactions
• Pick open media interactions out of queue
• Reply to open media interactions
• Transfer open media interactions
• Decline open media interactions
• Mark open media interactions as No Reply and Junk
• Place open media interactions on hold and retrieve open media interactions from hold

Previewing open media contacts

If administrative configurations permit, agents can preview interactions before picking them out of queue 
or handling them. The information available when previewing items in the queue depends on the Preview 
Url settings used for the API request.
The following explains how to 
• Preview open media interactions in queue
• Preview open media interactions in the Inbox

To preview an open media interaction in queue 
1. Click Queues and select a queue.
2. Select an open media interaction to preview.

To preview an open media interaction in the Inbox 
• Click Inbox and select an open media interaction to preview.

Picking open media contacts out of queue

Pick behavior occurs in the following ways: First, agents can pick interactions out of queue and send them 
to the Inbox. Once ringing in the Inbox, the interaction can be accepted. Second, agents can choose to 
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pick and reply to an interaction in one motion. Choosing to pick and reply sends the interaction to the 
agent's Inbox and immediately opens the interaction in reply mode.
For more information on ringing behavior, see "Ringing states in Ignite".
NOTE: 
• Agents cannot pick or pick and reply to interactions from the queue if they are in Do Not Disturb.
• Agents may only pick or pick and reply to interactions from the queue if they have the appropriate 

permissions.

The following procedures explain how to 
• Pick an open media interaction out of queue and handle the open media interaction
• Pick and automatically reply to an open media interaction

To pick an open media interaction out of queue and handle the open media interaction 
1. Click Queues and select the appropriate queue.
2. Select an interaction or hover over the item avatar and click Pick. 

The open media interaction is transferred to your Inbox.
3. To handle the open media interaction, click Inbox and select the open media interaction or hover over 

the item avatar.

To pick and automatically reply to an open media interaction 
1. Click Queues and select the appropriate queue.
2. Select an interaction or hover over the item avatar and click Pick and Reply. 

The interaction is transferred to your Inbox and opens in reply mode.

Replying to open media contacts

Once an open media interaction is in the Inbox, agents can reply to or otherwise handle it.
To reply to an open media interaction 
• Click Inbox and select an open media interaction or hover over the item avatar and click Accept.

Transferring open media contacts

Open media interactions can be transferred to queues or other agents within a contact center.
To receive transfers, devices must be enabled to handle the interaction’s media type. Agents who are 
logged out, in DND, Offline (WEB), or whose presence is unknown cannot receive transferred open media 
interactions. Agents who are either in Busy/Make Busy or at their open media Workload limit can receive 
transferred open media interactions.
NOTE: You may only transfer interactions if you have the appropriate permissions.
To transfer an open media interaction 
1. Click Inbox and select an open media interaction or hover over the item avatar and click Accept. 

To transfer directly from the queue, click Queues,
To transfer from the Cases page, under Interactions tab, select the inqueue chat and click Goto icon. 
The Queues page is displayed. You can now transfer the chat from the Queues page.

2. Select the open media interaction or hover over the item avatar and click Transfer icon. 
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NOTE: Optionally you can select multiple interactions from the Inbox or the Queues page and click 
Transfer. The Transfer window is displayed. The list of available Employees and Queues are displayed 
in the Results section.
3. To transfer to an agent, in the Transfer window click Employees, select an employee from the list 

and proceed to step 5.

4. To transfer to a queue, in the Transfer window click Queues and select a queue from the list. 

To search queues, type the name of the queue in the Search field.
5. To transfer the open media interaction, select the name of the appropriate person or queue.

Declining open media contacts

Agents can decline offered open media interactions, sending the interaction back to the queue as the 
longest waiting.
NOTE: When an agent declines an interaction, they are automatically put into Busy/Make Busy across all 
media capabilities. A System Make Busy and a requeue count is registered for the employee. For more 
information, see "Setting and removing Busy/Make Busy in Ignite".
To decline an open media interaction 
• Click Inbox and select an open media interaction or hover over the item avatar and click Decline.

Marking open media contacts as No Reply and Junk

Occasionally, open media interactions requiring no reply reach queues and agents’ Inboxes. Agents can 
mark these open media interactions either as requiring no reply or as junk.
Agents can also junk open media interactions directly from 'Failed', rather than attempting to reroute them.
Marking interactions as No Reply and Junk removes the interactions from Ignite. If the item is in queue or 
the Inbox, responses in progress are deleted.
NOTE: 
• Multimedia interactions in queue tagged as Junk or No Reply from Interactive Visual Queue and Ignite 

are not included in queue Handled, Completed, and Offered counts.
• Agents may only Junk interactions if they have the appropriate permissions.

To mark an open media interaction as No Reply or Junk from the Inbox 
• Click Inbox and select an open media interaction or hover over the item avatar and click either No 

Reply or Junk.
To mark an open media interaction as No Reply or Junk from the queue 
1. Click Queues and select an open media queue.
2. Select an open media interaction and click either No Reply or Junk.

Placing open media contacts on hold and retrieving open media contacts from hold

Agents may have to stop working on one open media interaction in order to work on other items. In these 
cases, agents can put the active open media item on hold. Interactions on hold are marked with a 'pause' 
icon.
Note that administrative configurations may limit how long interactions may be on hold before being 
requeued and a System Make Busy is registered for the employee. For information on this limit, contact 
your supervisor or system administrator.
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The following procedures explain how to 
• Place an open media interaction on hold
• Retrieve an open media interaction from hold

To place an open media interaction on hold 
• Click Inbox and select an open media interaction, or hover over the item avatar, and click Hold.
To retrieve an open media interaction from hold 
• Click Inbox and select an open media interaction on hold or hover over the item avatar and click 

Remove Hold.
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Appendix A

Installation and upgrade checklists
The following checklists are meant to provide dealers and installers who are familiar with MiContact 
Center Business software with a quick reference to the procedures required for installing and upgrading.
Included in the appendix are: 
• A list of prerequisite and pre-installation notes for installations and upgrades
• A condensed list of steps for installing or upgrading MiContact Center Business
• A more detailed list, for installing MiContact Center Business 7.1 or upgrading from Version 6.x to 7.1

PROGRAMMING TRAFFIC DATA COLLECTION FOR THE 
3300 ICP
This section describes the options you must program on the Mitel 3300 ICP Traffic Options Assignment 
form in order to collect traffic data and produce reports with the Traffic Analysis application.
The Traffic Options Assignment form is a form-driven method to obtain time-based traffic reports on tele-
phone system usage. You can generate reports that cover attendant usage, channel utilization, system 
activity, data station usage, delay to dial tone, extension-to-extension calls, feature usage, and trunk use.

Traffic Options Assignment form

The Traffic Options Assignment form gives the communications site manager a form-driven method of 
obtaining time-based traffic reports on the usage of the system. Reports may be generated as required, 
covering attendant usage, channel utilization, system activity, data station usage, delay to dial tone, 
extension-to-extension calls, feature usage, and trunk utilization.
NOTE: 
• You can define up to six different time slots.
• If the start and stop time are blank while the time slot is active, an error message is displayed when 

the commit operation is attempted; in this case, the changes will not be committed.
• No two traffic slot stops should be less than 5 minutes apart. This time is required for the system time 

to generate the previous report.
• Making changes to the data in this form and recommitting interrupts a traffic report that is running.

To program the Traffic Options Assignment form 
1. Log onto the 3300 ICP telephone system.
2. Browse to the Traffic Options Assignment form.

3. Click Change.

4. Configure the traffic options as described in the following table.
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Table 25.1:Traffic Options Assignment form  (Sheet 1 of 2)

Option Value

Time Slot Active Select Yes to start a traffic session at the time 
specified in Start Time field and finish at the Stop 
Time field for each of up to six different slots. The 
report is resumed the next day at the same time. 
Select No to suspend the traffic report for the 
associated time slot. The traffic report will not run 
until Yes is entered and the form recommitted. 
Default is No. There can be no overlapping of 
ACTIVE time slots.
Select: Yes

Start Time
(-Hours, -Minutes)

Select the time the traffic report is to start running. 
Default is blank. The start time must be assigned 
for active time slots; it can be blank for inactive 
time slots. If the start time equals the stop time 
then the time period is 24 hours.
Select: 00:00

Stop Time
(-Hours, -Minutes)

Select the stop time for the report. If the session 
is to run for 24 hours, enter the same time as the 
start time. Default is Blank. The stop time must be 
assigned for active time slots; it can be blank for 
inactive time slots. If the start time equals the stop 
time then the time period is 24 hours.
Select: 23:59

Period Length Select the length of time (15, 30, or 60 minutes) 
that data is to be collected for the session before 
a traffic report is formatted and output. Default is 
60 minutes.
Select: 15

Usage Units Select the type of units (Erlangs or CCS) the 
report is to use. Default is Erlangs.
Select: Erlangs

Autoprint Select Yes to spool the traffic report to the printer 
assigned to this function in the Application 
Logical Port Assignment form. Default is No. We 
will be using the LPR1 Port 1754 to output traffic.
Select: Yes

Maximum Number of Traffic Files Enter the maximum number of traffic reports to be 
stored in disk. Default is 10.
Select: 10
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Assigning a port

You must assign a port to the 3300 ICP to output traffic data.
To enable traffic data output
1. Log on to the 3300 ICP telephone system.
2. Browse to Application Logical Port Assignment.

3. Select Traffic Report Port.

4. Click Change.

5. Under Port Physical Name, type LPR1.

6. Click Save.

Sections to include in Traffic Report
Select Yes to enable the collection of data for each resource group that is to be included in the traffic 
report. Default is No

Route Plans Yes

Route Lists Yes

Routes Yes

Trunk Groups Yes

Trunks Yes

Links No

Groups of Links No

Channels No

DTMF Receivers Yes

Data Transceivers No

Modem Groups No

Data Station Groups No

Attendant Groups Yes

Attendant Consoles Yes

Attendants Yes

Table 25.1:Traffic Options Assignment form (Continued) (Sheet 2 of 2)

Option Value
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Testing traffic output

To test that traffic is being output through port 1754 
1. Click Start > Programs > Accessories > Communications > Hyperterminal.
2. After Name type Traffic.

3. Ensure that the red telephone icon is selected. 

See the following figure.
Figure 25.1: Red Telephone Icon

 

4. Click OK.

5. After Connect using, select TCP/IP.

6. After Host address, type the IP address of the 3300 ICP

7. After Port number, type 1754.

8. Click OK.

9. Wait the Period Length you selected in the Traffic Options Assignment form, for example 15, 30 or 60 
minutes. The traffic should then output to your screen.

10. After the output is complete, you can disconnect and close the hyper terminal window.

Configuring traffic options in MiContact Center Business

To configure the traffic collection options in MiContact Center Business 
1. Start YourSite Explorer.
2. Click Media Servers.

3. Select a 3300 ICP media server. 

NOTE: Make note of the Media Server ID. You will need this ID number later.
4. Click the Data Collection tab.

5. Verify the Traffic Analysis check box is selected and the port is 1754.

6. Click Save.

7. Wait the interval you selected in the Traffic Options Assignment, for example 15, 30 or 60 minutes.

8. Browse to <installation drive:>\Program Files (x86)\Mitel\MiContact Center\DataDirec-
tory\Node_[Media Server ID]. 

This is the directory of the media server for which you configured traffic options.
You should see a new file with the following naming convention, TYYYYMMDD.txt. For example, 
T20050127.txt, where YYYY is the year, MM is the month, and DD is the date.

9. Double-click the file to open it and view the traffic data.
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Appendix B

IVR Routing Architecture
IVR Routing can operate in different configurations depending on your scalable, resilient, and redundant 
business environment requirements.

Scalability
IVR Routing provides scalability by distributing call loads across multiple IVR;Routing instances, 
managed from a single user interface. Scalability enables you to increase your IVR Routing instances as 
your business grows, supporting geographically distributed instances and reducing the number of ports 
required for common IVR;Routing tasks.

Resilient Configuration
IVR Routing also provides resiliency, with multiple live systems and redundant ports that compensate 
when one system goes down and resilient ports across controllers. In a resilient configuration, calls are 
routed through the secondary telephone switch if the primary telephone switch fails. IVR Routing func-
tionality then fails over to the secondary phone switch to continue routing calls.
NOTE: You cannot make any major provisioning changes, for example, create new devices or make 
changes to existing devices and their relations to workflow associations while in failover mode.
The following figure displays an example of IVR Routing configured with multiple MiVoice Business 
controllers, providing ACD resiliency.
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Figure 26.1: Resilient 

Configuration

Redundant Configuration
Resilient and reliable redundant IVR Routing environments are configured using multiple instances of live 
IVR Routing servers, with redundant ports to compensate when one system is impacted by hardware or 
software issues, network outages, or other unforeseen circumstances. Ports are resilient across multiple 
telephone systems and self-sufficient remote instances of IVR Routing will continue to function even if 
they lose connectivity to the primary database or site.
In the redundant IVR Routing configuration, the primary IVR Routing instance resides with the MiContact 
Center Business Server, which the secondary IVR Routing instance resides on a separate Remote 
Server. Each IVR Routing instance is assigned 50% of the ports and a matching set of redundant ports. 
If one server instance fails, it can use the redundant ports to handle the full call load.
NOTE: When using IVR Routing in a remote configuration, the Enterprise Server and all remote 
IVR;Routing servers must be in the same workgroup or domain to synchronize workflows correctly.
The following figure displays the redundant IVR Routing configuration.

Figure 26.2: Redundant configuration
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High Availability Configuration
IVR Routing high availability configuration consists of fully resilient controllers with dedicated highly avail-
able IVR Routing instances. Remote IVR Routing instances can be geographically dispersed to provide 
an added level of redundancy. In this configuration, we suggest IVR Routing not be installed on the Enter-
prise Server to avoid overloading the Enterprise Server hardware components. Each IVR Routing 
instance is on a dedicated server with a mirror of the Enterprise Server configuration information. If the 
Enterprise Server fails, all IVR Routing instances are unaffected. By making the telephone systems 
redundant in this configuration, if one IVR Routing instance fails, the remaining instances will pick up 
traffic from the telephone systems (up to the limitations of the hardware).
NOTE: When using IVR Routing in a remote configuration, the Enterprise Server and all remote IVR 
Routing servers must be in the same workgroup or domain to synchronize workflows correctly.
The following figure displays the resilient controller, dedicated high availability IVR Routing configuration.
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Figure 26.3: High availability 
configuration
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Terms and definitions

This section includes terms that may not be applicable to your software licensing level.
Abandoned call
An abandoned call is a call that the caller ends before the call is answered.
Account Code
Account Codes are classifiers that can be applied to call records and used to identify unique attributes 
about the caller or call for individual departments, projects, or services to generate reports on them. As 
well, they can be used by agents as classification codes for incoming calls. Account codes can be verified, 
non-verified, fixed length, or forced.
See Classification Codes, Fixed Length Account Codes, Forced Account Codes, Non-Verified Account 
Codes, Verified Account Codes.
ACD (Automatic Call Distribution)
ACD (Automatic Call Distribution) is a call distribution mechanism that distributes calls to a pool of avail-
able queue members.
ACD (state)
ACD is a state applied to a queue member while they are handling an ACD call.
ACD calls handled
See Calls Handled.
ACD calls interflowed
See Interflowed.
ACD calls offered
See Calls offered.
ACD calls requeued
See Calls requeued.
ACD handling time
ACD handling time is a parameter for MiContact Center Business that provides the sum of all events from 
answer to hang up of an ACD call.
ACD path
An ACD path is a predefined route that a call follows before reaching an agent. ACD paths direct callers 
to the agents or agent groups best suited to handle the calls. For example, a contact center can have an 
ACD path for sales, which routes callers to the agents taking sales orders.
Active Directory
Active Directory is a directory service created by Microsoft that is used for managing a domain. In MiCon-
tact Center Business, Active Directory is synchronized with YourSite Explorer to align Active Directory 
security groups and users with MiContact Center Business employees and employee groups within 
selected organizational units.
Agent



1153

CHAPTER 27 TERMS AND DEFINITIONS

An agent is a contact center employee, assigned an Agent ID, who receives calls routed to ACD paths.
Agents available
Agents available is a real-time statistic indicating the current number of agents who are logged in and not 
in Make Busy or Do Not Disturb. If an agent is configured as a part of an agent group and is logged in, 
the agent is counted as available, even if they are not present in that agent group. This statistic can be 
used as a queue condition in IVR Routing.
ANI (Automatic Number Identification)
ANI (Automatic Number Identification) is a service that provides receivers of telephone calls with the caller 
information. ANI can be used to create screen pops for agents or to route calls by caller phone numbers. 
Answered by
Answered by is the real-time name for the number of calls answered by the first, second, third, and fourth 
answer points
Answering points
An answering point is a single point of communication available to callers where they can contact a 
contact center, such as a queue, voice mail, or extension.
ASA
See Average Speed of Answer
Average Speed of Answer
Average speed of answer (ASA) is an ACD statistic that measures how long the average caller waits on 
hold before the call is picked up by a queue member (including time in queue and ringing time).
Average abandon time
The average abandon time is the average number of seconds callers wait in queue before they abandon 
a call.
Blocked call
A blocked call is a call that is unable to get into the contact center's telephone system because there are 
no trunks available. The caller receives a busy signal.
Busy hour
Busy hour is a statistic that highlights the busiest hour of operation of a business day.
Call abandoned parameter
The Call abandoned parameter is a queue configuration that defines short abandoned calls, determining 
what abandoned calls are included as abandoned in call statistics. The default the short abandon is 
configured at 6 seconds.
Call routing
Call routing is the set of instructions configured in Mi Contact Center Business to automate the movement 
of calls to their intended answering points.
Call type
Call type categorizes calls queue members receive, enabling them to be looked up in SMDR Inspector. 
Call types include ACD or Non ACD, abandoned, interflowed, requeued, unavailable, or outbound.
Callback
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Callback is an optional feature of telephone systems that enables callers who are unable to reach an 
agent in a contact center to be called back by the contact center. Mi Contact Center Business and IVR 
Routing offer several methods of providing callbacks, including Call me back, voice callbacks, web call-
backs, and abandon callbacks.
Calls abandoned
Calls abandoned is a report field detailing the total number of calls that abandoned in queue or while the 
phone was still ringing at an extension. Calls abandoned ignores calls that were abandoned before the 
short abandoned parameter had been passed.
See Abandoned calls.
Calls abandoned (long)
Calls abandoned (long) are abandoned calls where the caller hung up after the short abandon parameter 
had been passed. By default, the short abandon is configured to be 6 seconds.
Calls abandoned (short)
Calls abandoned (short) are abandoned calls where the caller hung up before the short abandon param-
eter had been passed and are not included in the call statistics.
Calls answered
See Calls handled.
Calls handled
A handled call is a call that has been picked up answered by a queue member. A call that listens to 
in-queue RAD messages is not considered handled until it is answered by a queue member.
Calls interflowed
See Interflowed.
Calls offered 
1. Calls offered are all calls received, regardless of how they are handled or routed, including calls 

handled and both short and long abandoned calls.
2. Calls offered is a forecasting parameter used to determine the queue member requirement for a 

contact center’s Service Level percent and Service Level time targets through applying the Erlang C 
equation to the estimated Call Load and average ACD Handling Time.

Calls requeued
Requeued calls are all calls replaced back into the same queue and offered to another agent when an 
agent receives an ACD call and fails to answer it after a pre-configured duration or number of rings.
Calls waiting
Calls waiting is the number of callers in a queue waiting for a queue member to become available, 
including those listening to Music on hold or queue announcements.
Camp on
Camp on is a notification tool that enables callers to notify an employee, who is currently on a call, that 
they are waiting to be answered. The employee is notified by a series of audible beeps.
Classification codes
Classification codes are classifiers appended to calls to categorize them, enabling reporting to examine 
specific categories of calls, such as those relating to specific products or services.
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Clustered environment
A clustered environment is a network environment where multiple telephone systems are linked together 
to function as a single system.
Computer Telephony Integration
Computer Telephony Integration (CTI) are technologies that merge computer functions and telephone 
systems, enabling PC-based telephone systems to deliver functions such as synchronized voice and data 
delivery, voice and data conferencing, automatic information retrieval for calls, caller-based messaging 
and routing, and desktop productivity tools.
CTI
See Computer Telephony Integration
Customer Relationship Management
Customer Relationship Management (CRM) is a model for customer management that relies on tech-
nology to streamline and manage interactions with customers.
Date stamp
See Date/Time stamp.
Date/Time stamp
A date/time stamp is an indicator attached to a record or statistic detailing when it was created.
Delayed call
A delayed call is a call placed in the ACD queue because it cannot be immediately answered by a queue 
member. The ACD queue allows the client to wait for an available member rather than blocking the client 
from entering the system.
Dialable number
The dialable number is a digit or series of digits dialed by a caller to reach an answering point, such as 
an a queue member, an extension, a queue, or voice mail.
Dialed Number Identification Service (DNIS)
Dialed Number Identification Service (DNIS) is a telecommunication service that identifies the phone 
numbers dialed by inbound callers. DNIS can be used to route calls, enabling contact centers managing 
multiple product lines or businesses to direct calls to the appropriate endpoint.
Division
A division is a grouping of several employee or extension groups that enable a single report to be run for 
several groups simultaneously.
DND
See Do Not Disturb (state).
DNIS
See Dialed Number Identification Service.
Do Not Disturb (state)
Do Not Disturb (DND) is a state that prevents queue members from receiving inbound interactions and 
transfers. For agents, Do Not Disturb is an employee-level configuration. When an employee is in Do Not 
Disturb, they enter Do Not Disturb across all agent capabilities.
Employee
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An employee is a person who is employed by an organization and configured as an employee in MiCon-
tact Center Business so that they have access to MiContact Center Business applications and may have 
their associated devices reported on.
Enterprise
An enterprise is both the single site where the Enterprise Server is installed and all the connected branch 
offices that comprise a company.
Enterprise Server
The Enterprise Server is the central server upon which MiContact Center Business is installed and from 
which MiContact Center Business runs.
Erlang
An Erlang is a unit of measure for telephone traffic equal to one hour or 3,600 seconds of telephone inter-
action, such as a single call lasting one hour or six calls lasting 10 minutes.
Erlang B
Erlang B is an equation used to estimate the number of trunks required by a contact center.
Erlang C
Erlang C is a forecasting equation that uses historical Call Load data, Service Level Percentage, Service 
Level Time, and Wrap up Time Used to predict the resources required to keep wait times within a contact 
center ‘s Service Level objective for the time interval and data range selected in a forecast.
External Hot Desking Agent
See Hot Desking Agent.
Extension
An extension is an endpoint for answering calls. Extensions can be assigned to Ring Groups., or can be 
logged into by agents.
Fixed Length Account Codes
Fixed Length Account Codes are verified and non-verified Account Codes that are automatically 
submitted to the system when the correct number of digits has been entered.
Forced Account Codes
Forced Account Codes are verified and non-verified account codes that must be entered at a specific time 
in a call. Forced verified account codes must be entered as soon as the phone is off the hook. Forced 
non-verified Account Codes must be entered after the phone number is dialed. Systems may be config-
ured to avoid the requirement of entering a forced non-verified Account Code when making a call that 
must not be charged (for example, dialing a leading digit such as 8 to make a call without entering an 
Account Code and dialing a leading digit such as 9 to make a call that requires an Account Code).
Grade of service
The grade of service (GOS) is a measure of the likelihood of an attempted call receiving a busy signal. 
GOS compares the number of trunks to the level of traffic and expresses the result as a decimal fraction. 
A GOS of P.02, for example, indicates that a caller would have a two percent chance of receiving a busy 
signal.
Handled by
Handled by is the real-time statistic for the number of calls answered by the first, second, third, and fourth 
answer points.
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Handled %
Handled % is the real-time statistic comparing the calls handled to the calls offered.
Handling time
Handling time is the measure of how long a call took to be handled by a queue member, from when the 
call is answered when the call is finished. Handling time includes talk time, hold time, as well as transfers 
and conferences on the call.
Hot Desking Agent
Hot Desking Agents are employees configured with a Hot Desking Agent ID that enables them to sit at 
any extension in a network and log on to that extension with all their regular work settings available. 
External Hot Desking Agents can hot desk remotely using any phone or headset.
Hunt group
A hunt group is a series of telephone lines grouped by the telephone system that rotates incoming calls 
through the lines until an available line is found and the caller is connected.
Inbound
Inbound is a descriptive term applied to forms of interaction or communication, such as a phone call, to 
indicate that it is being sent to a contact center from an external source.
Inbound calls
See Inbound.
Interflowed
Interflow is a mechanism that redirects interactions from queues to alternate answering points (for 
example, to another queue or to voicemail). Interflow statistics include interactions manually transferred 
from one queue to another. Interactions routed from queues to other answering points before the Short 
Abandon time are not included in Interflow statistics.
Interactive Voice Response
Interactive Voice Response (IVR) is a technology that enables callers to interact with a contact center’s 
phone system by pressing keys or speech recognition while following IVR dialog.
Internal calls
Internal calls are calls made from within a system to other answering points within the same system.
LAN
A Local Area Network (LAN) connects multiple computers together over short distances. LANs typically 
operate within a building. The computers share information, applications, and peripherals, such as 
printers.
Logged on
Logged on is an agent state applied to agents who have signed into the ACD system.
Logged off
Logged off is an agent state applied to agents who have signed out of the ACD system.
Longest waiting
Longest waiting is the duration, in minutes and seconds, of the call that has been waiting the longest in 
queue.
Make Busy (state)
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Make Busy is an agent presence state applied to prevent an agent who is busy from receiving ACD calls. 
Agents in Make Busy are able to receive Non ACD calls. Make Busy is an employee-level configuration. 
When an employee is in Make Busy, they enter Make Busy across all agent capabilities.
Media servers
A media server is a server or system, such as a telephone system, used to organize and distribute 
communications throughout a contact center.
MiTAI
MiTAI is a Mitel implementation of TAPI that is used to connect the telephone system/PCs running 
windows to external applications, such as ACD controllers.
Mitel OPS Manager
Mitel OPS Manager is a Mitel software application that provides network-wide administration and main-
tenance for MiVoice Business and 3300 Network Elements or Nodes.
Non ACD (state)
Non ACD is a state applied to queue members involved in an incoming personal contact, a member-orig-
inated call, or a call dialed directly to their extension.
Non-verified Account Codes
Non-verified Account Codes are numbers entered onto the SMDR record for billing and call management. 
During a call, non-verified Account Codes can be entered as often as required.
Outbound calls
Outbound calls are calls made from within a contact center to external answering points.
Overflow
Overflow is a call distribution mechanism that queues calls against two or more agent groups to limit the 
delay faced by callers. If a call in an ACD queue is not answered after the configured Overflow time, then 
it is placed into the queue of a second agent group in addition to the first queue.
PBX
See Telephone system.
Pooling principle
The pooling principle refers to the increased contact center efficiency gained by consolidating contact 
center resources.
Port
A port is a communications endpoint in MiContact Center Business used to link services.
Probability of delay
The probability of delay is a statistic that measures the likelihood of a call being delayed in the ACD queue, 
comparing the number of queue members to the level of traffic carried by the trunks.
PSTN
See Public Switched Telephone Network.
Public Switched Telephone Network (PSTN)
The Public Switched Telephone Network is a global collection of Central Offices (CO) interconnected by 
long distance telephone switching systems.
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Quality of service
Quality of service is a reflection of an agent's ability to provide excellent assistance to each customer. 
Quality of service can be evaluated and managed through silent monitoring systems, IT support systems, 
CTI, ANI, and DNIS.
Queue number
A queue number is the address of a queue or other answering point used in the telephone system. The 
programming associated with the queue number defines the routing and timing options available to the 
call.
Queue member
A queue member is an individual answering for the queue. For ACD paths, ‘members’ refers to agents in 
the queue’s answering agent groups. For Ring Groups, ‘members’ refers to the extensions assigned to 
the queue’s Ring Groups.
Queue unavailable 
1. Queue unavailable is a routing option that reroutes calls to an unavailable answer point/overflow point. 

Queues are unavailable when the call enters the system outside business hours, when all queue 
members have removed their presence, when all queue members are in DND, or when the queue has 
been placed in DND. Calls interflowed before the Short Abandon time are included in Queue Unavail-
able statistics.

2. Queue unavailable is a real-time statistic that counts how many calls were re-rerouted to other queues 
due to the queue being unavailable.

RAD
See Recorded Announcement Device.
Readerboard
See Wall sign.
Real-time adherence
Adherence refers to whether or not agents are performing the activities for which they are scheduled. 
Workforce management tools enable supervisors to be notified of discrepancies between agents' work 
schedules and the actual activities they perform.
Reason Code
Reason codes are descriptive classifiers applied to Make Busy and Do Not Disturb states to provide more 
detailed information as to why the queue member applied the code.
Recorded Announcement Device
Recorded Announcement Device is an IVR Routing feature that provides prerecorded messages to 
callers waiting in the ACD queue.
Reporting number
A reporting number is the unique number assigned by the system to contact center resources for reporting 
purposes.
Ring Group
A Ring Group is a collection of extensions, or a single dialing point for a collection of extensions, in a busi-
ness. Ring Groups are typically used to reach back office extensions. For example, a business with 
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agents taking sales orders may also have several phone extensions in the warehouse. These warehouse 
phone extensions are compiled into a Ring Group, which can be reached via a single dialing point.
Service Level percent
The Service Level percent is the number of calls that are handled, abandoned, and interflowed before the 
Service Level time, compared to the total number of calls handled, abandoned, and interflowed.
Service Level time
The Service Level time is the specified time used in calculating the queue service objective in conjunction 
with the Service level percent, such as 80% (Service Level percent) of interactions answered within 120 
seconds (Service Level time).
Silent monitoring
Silent monitoring is a MiContact Center Business feature that facilitates the tracking of agent extension 
call handling techniques by enabling supervisors to listen to the voice interactions of internal or external 
calls between agents and callers.
Site
A site is a physical location of a contact center with one or more media servers. It may be the same loca-
tion where the Enterprise Server is installed or a branch office.
Spectrum
Spectrum is a reporting feature configured for queues that provides a frequency distribution of calls aban-
doned, answered, or interflowed based on a defined time scale.
SQL
SQL is a standard query language used to enter, query, and change data in a database, as well as create 
and administer databases. Administration of YourSite Explorer is done using Microsoft's SQL Server.
Subroutines
Subroutines are portions of workflows that can be reused in multiple workflows.
Talk time
Talk time is the measure of the time an employee agent spends talking to callers, excluding time spent 
on hold.
TCP/IP
TCP/IP is the basic communication protocol of the Internet and is used as a communication protocol in 
private networks (intranets).
Telephone system
A telephone system is a private branch exchange (PBX) or business telephone switch used to process 
incoming and outgoing calls to a contact center.
Time to answer
Time to answer is the measure, in seconds, of how long an incoming call remained in queue before it was 
answered. It is primarily used as an SMDR data mining criteria.
Time stamp
See Date/Time stamp.
True talk time
See Talk Time.
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Trunk
A trunk is a communication line between two telephone systems.
Trunk load
Trunk load is the duration of time from when a trunk receives a call to when the queue member finishes 
handling the call and disconnects. Trunk load does not include Wrap Up Time.
Unavailable
Unavailable is an agent and employee state real-time column in Contact Center Client that includes 
agents unavailable to take calls due to being in Do Not Disturb, Make Busy, Work Timer, Reseize Timer, 
or Unknown.
Updated Position in Queue (UPiQ)
Updated Position in Queue (UPiQ) is a notification feature that provides messages to callers informing 
them of their position in queue and keeps them informed of their position if it changes, at preset intervals.
UPiQ
See Updated Position in Queue.
Verified Account Codes
Verified Account Codes are numbers entered before making a call to change the Class of Service or Class 
of Restriction at the station. When the call ends, the station returns to normal. Verified Account Codes can 
be tracked with SMDR for long-distance billing purposes and may be reported in Internal SMDR logs.
Wall board
See Wall sign.
Wall sign
A wall sign is an electronic sign used to display real-time ACD statistics to employees in a contact center.
WAN
Wide Area Network (WAN) connects multiple computers over a wide geographic area. WANs operate 
over telephone carrier lines through bridges or routers. Router options enable communication between 
high speed LAN links and slower speed WAN links, which tie LAN segments together.
Whisper Coach
Whisper Coach is a silent monitor feature that enables supervisors to converse with and coach agents 
handling calls without callers hearing the supervisor.
Workflow
Workflows are programed pathways in IVR Routing and Multimedia Contact Center, which control how 
interactions are routed to queue members.
Workforce management
Workforce management is the scheduling of contact center agents to meet forecasted resource require-
ments and the managing of agents to ensure they adhere to their scheduled activities.
Wrap Up Time
Wrap Up Time is a real-time and reporting statistic detailing the total time an agent spends in the Work 
Timer state.
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Workflows

If you are configuring IVR Routing workflows, see "Building workflows".
If you are configuring Multimedia Contact Center workflows, see "Multimedia routing using visual work-
flows".
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Subroutines

If you are configuring IVR Routing subroutines, see "Building subroutines"
If you are configuring Multimedia Contact Center subroutines, see "Building subroutines"
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Variables

If you are configuring variables for IVR Routing, see "Adding variables".
If you are configuring variables for Multimedia Contact Center, see "Working with variables in Multimedia 
Contact Center".
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Adding a Microsoft SQL data provider

If you are configuring a Microsoft SQL data provider for IVR;Routing, see "Adding a Microsoft SQL server 
as a data provider".
If you are configuring a Microsoft SQL data provider for Multimedia Contact Center, see "Adding a Micro-
soft SQL server as a data provider".
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Adding a Microsoft Excel worksheet data 
provider

If you are configuring a Microsoft Excel worksheet data provider for IVR Routing, see "Adding a Microsoft 
Excel worksheet as a data provider".
If you are configuring a Microsoft Excel worksheet data provider for Multimedia Contact Center, see 
"Adding a Microsoft Excel worksheet as a data provider".
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Adding a LDAP data provider

If you are configuring a LDAP data provider for IVR;Routing, see "Adding a LDAP as a data provider".
If you are configuring a LDAP data provider for Multimedia Contact Center, see "Adding a LDAP as a data 
provider".
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